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Introduction

The Introduction part contains information on the purpose
of this guide, how this guide is organized, where to find
more information, and information on regulatory notices.
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1 About This Guide
1.1 Purpose of This Guide

1.1

Purpose of This Guide
This guide provides information about protocols, devices, external editors, and
servers in Building Operation. This information includes technical information and
troubleshooting information, as well as concepts and procedures.
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1.2 How This Guide is Organized

1.2

How This Guide is Organized
This Building Operation Guide is divided into the following parts:

Introduction
The Introduction part contains information on the purpose of this guide, how this
guide is organized, where to find more information, and information on regulatory
notices.

Reference
The Reference part contains conceptual information, procedures, user interface
descriptions and troubleshooting information. If you want more information, see
WebHelp or the other Building Operation Reference Guides.
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1.3

Typographical Conventions
Building Operation Guides use the following specially marked texts:

Tip
Helps you understand the benefits and capabilities of the product.

Note
Provides you with supplementary information.

Important
Alerts you to supplementary information that is essential to the completion of a
task.

Caution
Alerts you to a condition that can cause loss of data.

Warning
Alerts you to a condition that can cause product damage or physical harm.
Bold texts:
User interface items, such as property names and buttons, are written in bold, for
example "On the File menu, select New."
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2 Additional Information
2.1 Where to Find Additional Information

2.1

Where to Find Additional Information
All the technical Building Operation information is available online, on WebHelp.
WebHelp is a web-based help system for StruxureWare Building Operation and
Automation Server Family products, the software and hardware that powers
SmartStruxure solution.
By pressing F1 or clicking a Help button in the StruxureWare Building Operation
software your web browser opens WebHelp with the latest, up-to-date, technical
documentation.

Figure: Help in StruxureWare Building Operation

Some StruxureWare Building Operation software products give you contextsensitive help by opening a WebHelp page that explains the view or dialog box you
have in focus. Some programs open up an overview page. From these pages, you
can follow the links to get more detailed information.
WebHelp contains all the technical information that is in the guides, specification
sheets, and installation instructions.

The WebHelp site
One of the advantages with WebHelp is that you can reach Help without having the
StruxureWare Building Operation software installed on your computer. By entering
the URL address help.sbo.schneider-electric.com you can access WebHelp from
any computer, smartphone, or tablet connected to the internet.

Finding information
The easiest way to find information on WebHelp is to search for it.

Figure: Home page search

All technical information is gathered in one place, so you do not need to know
which guide, specification sheet, or installation instruction the information is in.

Filtering the information
To narrow down the search results, you can use these filters:
• Product
• Functionality
• Information type
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Figure: Search filters
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2.2

Regulatory Notices
UL 916 Listed products for the Unites States and Canada, Open
Class Energy Management Equipment.

WEEE - Directive of the European Union (EU)
This equipment and its packaging carry the waste of electrical and electronic
equipment (WEEE) label, in compliance with European Union (EU) Directive
2002/96/EC, governing the disposal and recycling of electrical and electronic
equipment in the European community.

CE - Compliance to European Union (EU)
2004/108/EC Electromagnetic Compatibility Directive
This equipment complies with the rules, of the Official Journal of the European
Union, for governing the Self Declaration of the CE Marking for the European Union
as specified in the above directive(s) per the provisions of the following standards:
IEC/EN 61326-1 Product Standard, IEC/EN 61010-1 Safety Standard.

Industry Canada
ICES-003
This is a Class B digital device that meets all requirements of the Canadian
Interference Causing Equipment Regulations.

C-Tick (Australian Communications Authority (ACA))
AS/NZS 3548
This equipment carries the C-Tick label and complies with EMC and radio
communications regulations of the Australian Communications Authority (ACA),
governing the Australian and New Zealand (AS/NZS) communities.

Federal Communications Commission
FCC Rules and Regulations CFR 47, Part 15, Class B
This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference. (2) This
device must accept any interference received, including interference that may cause
undesired operation.
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Reference

The Reference part contains conceptual information,
procedures, user interface descriptions and troubleshooting
information. If you want more information, see WebHelp or
the other Building Operation Reference Guides.
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3 Building Operation Servers
3.1 Server Overview

3.1

Server Overview
Building Operation servers are used to engineer and supervise building automation
systems.
There are three types of Building Operation servers:
• Project Configuration Server
• Enterprise Server
• Automation Server
The Project Configuration Server is the engineering platform, whereas the
Enterprise Server and Automation Server are live servers, engineered an
commissioned to supervise live building automation systems.
The Project Configuration Server and Enterprise Servers run on the PC platform,
while Automation Servers run on Building Operation hardware. Servers are
accessed through WorkStation on IP network.

Figure: Server overview

The Project Configuration Server can be installed on a PC laptop for off site
engineering and on site deployment. Alternatively the Project Configuration Server
can be installed both off site, and on site, while moving projects back and fourth on
portable memory.
The Project Configuration Server can perform all engineering tasks, but no live
tasks. The Enterprise Server and the Automation Server can perform different live
tasks and some engineering tasks. The following table shows which Building
Operation server can be used to perform each task:
Table: Distinguishing Tasks Table
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Project
Configuration
Server

Create Projects

X

Enterprise Server

Automation
Server
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Continued
Task
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Project
Configuration
Server

Enterprise Server

Automation
Server

Create and configure X
objects (programs,
graphics, alarms,
trend logs,
schedules)

X

X

Bind values

X

X

X

Use binding
templates

X

X

X

Create Enterprise
Server

X

Create Automation
Server

X

X

-

Set up user groups & X
domains

X

-

Discover and create
Building Operation
servers

X

X

-

Discover and create
field bus devices

X

X

X

Discover and create
I/O modules

X

X

X

Download,
commission, and
upload device
configuration

X

X

View and access
remote servers

X

-

Run programs

X

X

View live data

X

X

Store logs

X

X

Store multiserver logs

X

-

Monitor field bus
devices

X

X

Control I/O

-

X
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Task

3.1.1

Project
Configuration
Server

Enterprise Server

Automation
Server

Project Configuration Server
The Project Configuration Server is used for off-site engineering, project
configuration, and deployment of the project configuration to the on-site servers.
You create the project configuration, such as servers, networks, devices, and
schedules. When you connect the Project Configuration Server to the server (either
locally or remotely), you deploy the project to the Enterprise Server or the
Automation Server.
For more information, see section 5.2 “Project Configuration Server” on page 193.

3.1.2

Enterprise Server
The Enterprise Server is a hierarchical top server that is primarily used for system
supervision and engineering. As the dedicated top server, the Enterprise Server
provides you with a system entry point. Through the Enterprise Server, you can
view and access all resources in the system.
For more information, see section 3.2 “Enterprise Server” on page 136.

3.1.3

Automation Server
Automation Servers constitute the server base tier in automation systems, and are
typically supervised through an Enterprise Server. The primary function of the
Automation Server is to control I/O and to monitor field bus devices.
For more information, see section 3.6 “Automation Server” on page 142.

3.1.4

Server System
The server system consists of one top Enterprise Server, and a number of lower tier
Automation Servers.
For more information, see section 3.3 “Server System” on page 138.

3.1.5

Automation Server Web Configuration Page
The Automation Server Web Configuration page can only be accessed through
Webstation. In the Automation Server Web Configuration page, you can change
TCP/IP settings, download logs, and check the version of the Automation Server.
For more information, see section 13.1 “Automation Server Web Configuration
Page” on page 393.
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3.2

Enterprise Server
The Enterprise Server is a hierarchical top server that is primarily used for system
supervision and engineering. As the dedicated top server, the Enterprise Server
provides you with a system entry point. Through the Enterprise Server, you can
view and access all resources in the system.

Important
Ensure that you have a working and available Enterprise Server license. A working
license is required to start the Enterprise Server. For more information, see the
Licenses topic on WebHelp.

3.2.1

Engineering
You can log into the Enterprise Server and engineer the entire system. Through the
Enterprise Server you can access and engineer any resource, any Automation
Server, and any resource that resides under an Automation Server.
You can also log into to an Automation Server directly, and perform engineering
tasks locally. However, the Automation Server has a lesser range of engineering
features, and you can only access the resources of that specific Automation Server.

3.2.2

Features
The Enterprise Server provides features for system supervision, and tools for
engineering.

Live Features
These are the live features of the Enterprise Server:
• Global view and access
• Program runtime environment
• Centralized alarms and data management:
– Manage alarms from multiple servers
– View extended trend logs from multiple server
– View event logs from multiple servers
– Store historical data from multiple servers
• Capable of monitoring field bus:
– Connects to Lon field bus through RNI, L-IP, or NIC network interface
– Connects to BACnet field bus through a BACnet/IP router

Engineering Features
These are the engineering features of the Enterprise Server:
• Automation Server management
• Tools for device discovery and commissioning
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• Programming editors
• Binding tool
• Graphic Editor
• User management
• Domain management
• Windows Active Directory integration

3.2.3

The Enterprise Server in Context
The Enterprise Server provides a global view of the system. If connected directly to
an Automation Server you are only given local view and local access: the server
itself, its I/O, and field bus devices.
You can use the Enterprise Server to gather and view all alarms, trend logs, and
event logs in list and chart viewers, and store it all in a central database. Connected
to the Automation Server, you can only monitor local alarms and local data.
The Enterprise Server facilitates more engineering features than the Automation
Server. For example, you can use the Enterprise Server to set up new Automation
Servers in the system. An Automation Server cannot create another peer. Also, you
can use the Enterprise Server to set up domains, user groups, and permissions,
which is outside the scope of the Automation Server.
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3.3

Server System
The server system consists of one top Enterprise Server, and a number of lower tier
Automation Servers.

Figure: The server topology

The Enterprise Server is the top server and is the system entry point from the user
point of view. You log into the Enterprise Server, and from there you can view,
navigate, and access all Automation Servers in the System Tree pane. You can use
the Enterprise Server to manage, supervise, and perform live engineering on the
system in an efficient manner:
• Single sign on
• Global view and access
• Global search
• Global engineering, such as bindings between servers
• Global server management
• Centralized alarms and data management:
– Manage alarms from multiple servers
– View trend logs from multiple server
– View event logs from multiple servers
– Store historical data from multiple servers
• Building Operation management:
– Domains
– User groups
• Windows integration
– Windows domains
– Active Directory user groups
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3.3.1

Server Communication
You configure communication parameters when you add a Building Operation
server. The Enterprise Server distributes the communication parameters to the
other servers so that they know how to communicate with the newly added server.
For more information, see section 4.1 “Server Communication” on page 173.

3.3.2

Server Status
The status of a server can be either online or offline. Being online or offline depends
on the operational situation of the server and its connectivity with other servers. A
server can actually be online and communicating with one server, while at the same
time appear to be offline to another server.
Server status has implications on server management. A server needs to be online
to be configured. Another consideration is that configuring a server, while another
server is offline, can cause the offline server to come out of synch when it comes
back online again.
For more information, see section 4.2 “Server Status” on page 177.

3.3.3

Server Management
You can use the Enterprise Server to create new Automation Servers. Automation
Servers are created and accessed in the Server folder. You cannot move servers
from the Server folder.
For more information, see section 3.4 “Server Management” on page 140.
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3.4

Server Management
You use the Enterprise Server to manage Automation Servers, which includes
adding, configuring, and removing Automation Servers.
You create Automation Servers in the Server folder in the System Tree pane. You
can remove Automation Servers from the Server folder, but you cannot move them
from that folder to another location in the System Tree pane.
When you change an address or port of an Automation Server, that information
must be updated in the Communication tab of the Automation Server peers. You
can update this information manually in the Communication tab of the Automation
Server peers. You can also delete the Automation Server that has changed and
then adding it again. The Enterprise Server automatically collects and distributes
information about added servers to the other servers.
Task

Automation
Server online,
peers online

Automation
Server online,
peers offline

Automation
Server offline

Add server

Yes

Yesa

No

Configure server

Yes

Yes

No

Move server

No

No

No

Rename server

Nob

Nob

Nob

Remove server

Yes

Yesa

Yes

a) Not recommended.
b) A server can be renamed if it is a stand-alone server in the system. You can rename the Enterprise
Server as long as you have not yet added any Automation Servers.

Note
When changing the name of a folder or server, you also have to reconfigure users
and user groups path permissions to this server or folder. For more information,
see the Path Permissions topic on WebHelp.

Automation Server Online, Peers Online
You can use the Enterprise Server to add, configure, and remove an Automation
Server that is online without consequence if all of the Automation Server peers are
also online.

Automation Server Online, Peers Offline
You can use the Enterpise Server to add, configure, and remove an automation
Server that is online but has Automation Server peers that are offline.
However, adding or removing an Automation Server while other Automation Servers
are offline can result in broken references or communication when those offline
servers come back online.
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3.5

Device Discovery
You use the Device Discovery to discover and create devices in the Building
Operation System Tree pane.
You typically create an object in the System Tree that represents a device, then
discover the physical hardware in the Device Discovery and associate it to the
object representation in the System Tree.
You can also discover a physical hardware in the Device Discovery and create an
object representation automatically as you drag the discovered device to the
System Tree.
There are several scenarios where you use the Device Discovery:
• Discover a LonWorks interface on a Building Operation server.
• Discover LonWorks devices on the field bus of a Building Operation server.
• Discover BACnet devices on the field bus of a Building Operation server.
• Discover I/O modules on an Automation Server.
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3.6

Automation Server
Automation Servers constitute the server base tier in automation systems, and are
typically supervised through an Enterprise Server. The primary function of the
Automation Server is to control I/O and to monitor field bus devices.
Automation Servers provide distributed intelligence around a building. This is in
contrast to centralizing all control into one building mainframe. Distributing the logic
makes the different automation systems in the building autonomous and fault
tolerant. In the the process, Automation Servers also make the physical installation
and wiring more manageable.
Install Automation Servers and deploy the logic as close as possible to the
apparatus that they monitor and control. This way, most parts of the system
function autonomously and continue to function as a whole, even if communication,
individual servers, or devices fail or go offline.

3.6.1

Central I/O and Field Busses
Automation Servers can have direct control of automation apparatus through its
central I/O modules. Central I/O implies it is connected directly to the Automation
Server backplane, and that relevant logic and programs are deployed and reside
directly in the Automation Server.
An Automation Server can also connect to intelligent, more autonomous devices by
the means of a field bus, such as when integrating Xenta and b3 devices. These
field bus devices run their own programs and control their own subordinate
automation apparatus. The Automation Server assumes more of a monitoring role
towards these field bus devices.

Technical
144

04-16006-04-en, March 2015

3 Building Operation Servers
3.6 Automation Server

Figure: Automation Server system view

3.6.2

Features
The Automation Server facilitates features for automation control, monitoring, and
tools and services that you can use for local engineering.

Live Features
These are the live features of the Automation Server:
• Local view and access
• Program runtime environment
• Alarms and data management:
– Manage local alarms
– View local trend logs
– View local event logs
– Store historical data in local database
• Capable of controlling central I/O
• Capable of monitoring field bus
– Connects to the LonWorks field bus through port
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– Connects to the BACnet field bus through port

Live Engineering Features
These are the live engineering features of the Automation Server:
• Tools for device discovery and commissioning
• Programming editors
• Binding tool
• Graphic Editor

3.6.3

SNMP
Simple Network Management Protocol (SNMP) is an Internet-standard protocol for
managing devices on IP networks.
SNMP traps enable an agent to notify the management station of significant events
by way of an unsolicited SNMP message.
The Automation Server supports the following SNMP traps:
• ColdStart: The Automation Server is restarted.
• LinkUp: The Automation Server is up and running.
• AuthenticationFailure: Someone has made unsuccessful attempts to log on to
the Automation Server.
To be able to use SNMP for supervising Automation Server, you must use a
management information base (mib) file. The mib-file translates the binary
information from the Automation Server to readable text. The mib-file for Building
Operations is called sboProductMib.mib, and can be found on Download Center.
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Figure: The SNMP user, the MIB-file and the SNMP manager tool.

To be able to send information from the Automation Server to the SNMP managing
system, you must create a user on the Automation Server that the SNMP manager
system uses to connect to the Automation Server.
You can log all access attempts to the SNMP server in the System log.

3.6.4

Automation Server Upgrade
You upgrade the Automation Server using Device Administrator.
For more information, see section 3.23 “ Automation Server Upgrade ” on page
166.
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3.7

Creating an Automation Server
You use this procedure to add an empty Automation Server to the system.
For more information, see section 3.6 “Automation Server” on page 142.

To create an Automation Server
1. In WorkStation, in the System Tree pane, select the Servers folder.
2. On the File menu, point to New and then click Server.
3. In the Name box, type a name for the server.

4. In the Description box, type descriptive information about the server.
5. Click Next.
6. In the Address box, type the IP address or fully qualified domain name of the
Automation Server.

Important
• If the Automation Server has been assigned a dynamic IP
address, use the fully qualified domain name of the server
instead of the IP address.
Continued on next page
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7. In the Protocol box, select a protocol for the server. For more information,
see section 4.1 “Server Communication” on page 173.
8. In the Port box, enter a port number.
9. Click Create.
10. In the Password box , type the custom password if required.

11. Click OK.
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3.8

Creating an Automation Server from a
Backup Set
You create an Automation Server from a backup set to reuse configuration data
from an existing Automation Server when adding a new Automation Server to the
system.

Important
You have to backup the Automation Server whose backup set you want to reuse
before starting to create the new Automation Server.
For more information, see section 3.6 “Automation Server” on page 142.

To create an Automation Server from a backup set
1. In WorkStation, in the System Tree pane, select the Servers folder.
2. On the File menu, point to New and then click Server.
3. In the Name box, type a name for the server.

4. In the Description box, type descriptive information about the server.
5. Click Next.
Continued on next page
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6. In the Address box, type the IP address or fully qualified domain name of the
Automation Server.

Important
• If the Automation Server has been assigned a dynamic IP
address, use the fully qualified domain name of the server
instead of the IP address.
7. In the Protocol box, select a protocol for the server. For more information,
see section 4.1 “Server Communication” on page 173.
8. In the Port box, enter a port number.
9. Click Next.
10. In the Password box , type the custom password if required.

11. Click OK.
Continued on next page
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12. In the File box, enter the path to the backup set file.

13. Click Create.
You have created an Automation Server containing the configuration data from the
backed up Automation Server. You can manually customize the configuration data
for the new server to meet your requirements.
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3.9

Deleting an Automation Server
You use this procedure to delete Automation Servers. You can delete both online
and offline servers.
For more information, see section 3.4 “Server Management” on page 140.

To delete an Automation Server
1. In WorkStation, in the System Tree pane, in the Servers folder, select the
server that you want to delete.
2. On the Edit menu, click Delete.
3. In the Confirm Delete dialog box, click Yes.
You would typically update references and repair server communication, if any has
been broken.
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3.10

Renaming a Server
You use this procedure to rename an Enterprise Server or a standalone Automation
Server.

Note
When changing the name of a folder or server, you also have to reconfigure users
and user groups path permissions to this server or folder. For more information,
see the Path Permissions topic on WebHelp.

Important
You can rename a server only if it is the only server in the system.
For more information, see section 3.4 “Server Management” on page 140.

To rename a server
1. In WorkStation, in the System Tree pane, select the server that you want to
rename.
2. On the Edit menu, click Rename.
3. In the Object Name box, type a new name for the server.

4. Click OK.
5. In the Confirm Rename dialog box, click Yes.
6. Click OK.

7. Log on to WorkStation and update references, if any have been broken.
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3.11

Connecting to an Automation Server
Using the USB Device Port
You connect to an Automation Server using the USB device port to upgrade or
install new software and to assign the IP address of the device. For more
information, see the Automation Server Software topic on WebHelp.

To connect to an Automation Server using the USB device port
1. Start Device Administrator.
2. Connect a USB 2.0 type A /B Male to Male (maximum length 3 m) cable to the
USB device port on the Automation Server and a USB port on the PC.

Important
• If the Found New Hardware Wizard dialog box is displayed,
follow the instructions to install the Automation Server driver.

3. In the Connection column for the Automation Server, ensure that usb is
displayed.
Now you can upgrade or install new software and assign the IP address of the
device.
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3.12

Connecting to an Automation Server
Using the IP Network
You connect to an Automation Server using the IP network to upgrade or install
new software and to assign the IP address or host name of the device. For more
information, see the Automation Server Software topic on WebHelp.

To connect to an Automation Server using the IP network
1. In Device Administrator, click the Add network device to list button

.

2. In the Connect to Device box, type the IP address or the host name of the
Automation Server. For more information, see section 3.17 “Identifying the
Automation Server IP Address” on page 159.

3. Enter the user name and password in one of the following ways:
• Type the user name and password for this Automation Server.
• Select Use default device log on to log on using the user name and
password specified in the Device log on options dialog box.
4. Click OK.
Now you can upgrade or install new software and assign the IP address of the
device.
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3.13

Saving a List of Automation Servers
You save a list of Automation Servers in the Device Administrator so that you can
restore the list.
For more information, see section 3.14 “Restoring a List of Automation Servers” on
page 156.

To save a List of Automation Servers
1. In the Device Administrator, on the File menu, click Save as.
2. Enter a name and location for the list file.

3. Click Save.

Note
The list of Automation Servers does not include anything connected through the
USB device port, only servers that are connected through the IP network.
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3.14

Restoring a List of Automation Servers
You restore and alternate between lists of Automation Servers.
For more information, see section 3.13 “Saving a List of Automation Servers” on
page 155.

To restore a List of Automation Servers
1. In the Device Administrator, on the File menu, click Open.
2. Select the list of servers that you want to restore.

3. Click Open.
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3.15

Setting Device Log On Options
When an Automation Server is upgraded, you have to enter the correct user name
and password. If several Automation Servers have the same user name and
password, it is convenient to set these as default values to be used by Device
Administrator when adding or upgrading devices.

To set the device log on options
1. In Device Administrator, on the Tools menu, click Default Device Log on
Options.
2. In the User name box, type the user name.

3. In the Password box, type the password.
4. In the Verify password box, type the password again.
5. Click OK.
The user name and password appear as default values when you connect to an
Automation Server with the Device Administrator.
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3.16

Getting Automation Server Debug
Information
Debug information is retrieved through the IP network or USB device port. The
debug information contains a lot of different files and detailed information. However,
for the ordinary user this information is too complex so after the debug information
has been retrieved, the files are normally sent to product support. The debug
information is enclosed in a zip file. If you choose to get debug information from
many Automation Server at the same time all information is enclosed in one zip file.

Note
If the Automation Server does not respond to normal communication, you must
reset the Automation Server and connect through the USB device port. For more
information, see the Resetting the Automation Server topic on WebHelp.

To get Automation Server debug information
1. In the Device Administrator, select the Automation Server.

2. On the Tools menu, click Get Debug Information

.

3. In the Save as dialog box, select where to save the debug information file.

Technical
160

04-16006-04-en, March 2015

3 Building Operation Servers
3.17 Identifying the Automation Server IP Address

3.17

Identifying the Automation Server IP
Address
In Device Administrator, you can identify the Automation Server IP address in two
different ways:
• Use a configuration drawing to identify the IP address.
• Use the USB connection to determine the IP address and/or the host name
(the name assigned to the Automation Server).

To identify the Automation Server IP address
1. Start the Device Administrator and connect to the USB device port. For more
information, see section 3.11 “Connecting to an Automation Server Using the
USB Device Port” on page 153.
2. Select the Automation Server with the usb connection at the top of the list.

3. Click the Properties button

.

4. Note the IP address and/or the Host name. For more information, see
section 11.11 “Device Administrator Properties – General Tab” on page 376.
5. Click Cancel.
6. Disconnect the USB cable from the Automation Server to enable upgrading
through the network.
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3.18

Setting the Automation Server IP
Address
You use Device Administrator to set a static IP address for an Automation Server.
For more information, see section 3.23 “ Automation Server Upgrade ” on page
166.

To set the Automation Server IP address
1. In Device Administrator, select the Automation Server for which you want to
set an IP address.
2. On the View menu, click Network Settings.
3. Clear Enable DHCP.

4. In the Static IP address box, type an IP address for the server.
5. In the Host name box, type a unique host name for the Automation Server.
6. In the Domain box, type the name of the domain.
7. In the Netmask box, type the prefix of the subnet.
8. In the Primary DNS box, type the address to the primary DNS server.
9. In the Secondary DNS box, type the address to the secondary DNS server.
10. In the Tertiary DNS box, type the address to the tertiary DNS server.
Continued on next page
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11. In the Gateway box, type the address to the router.

12. Click OK.
13. In the IP changes dialog box, click OK.
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3.19

Configuring an Automation Server to
Use DHCP
You use Device Administrator to configure the Automation Server to use DHCP.
For more information, see section 3.23 “ Automation Server Upgrade ” on page
166.

To configure an Automation Server to use DHCP
1. In Device Administrator, select the Automation Server that you want to use
DHCP.
2. On the View menu, click Network Settings.
3. Select Enable DHCP.

4. In the Host name box, type a unique host name for the Automation Server.
5. Click OK.
6. In the IP changes dialog box, click OK.
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3.20

Configuring the Time for an Automation
Server with Factory Settings
An Automation Server with factory settings does not have the correct time. To avoid
obsolete time stamps on the events in the event log, use the Set time on device
function to transfer the time from the computer that runs Device Administrator.
For more information, see section 3.23 “ Automation Server Upgrade ” on page
166.

To configure the time for an Automation Server with factory
settings
1. In Device Administrator, select the Automation Server.
2. On the View menu, click Properties.
3. Click Time.
4. Select Set time on device.
5. Click OK.
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3.21

Restoring the Software of a Damaged
Automation Server
When you connect the PC to the Automation Server by the USB device port, the
Device Administrator automatically identifies the Automation Server. However, if the
Automation Server software is damaged, you need to reset the Automation Server.
When the Automation Server is reset, you have to upgrade the software using the
USB device port. You cannot use the network to upgrade a damaged Automation
Server that has been reset.
For more information, see section 3.23 “ Automation Server Upgrade ” on page
166.

To restore the software of a damaged Automation Server
1. Start Device Administrator.
2. Connect a USB 2.0 type A /B Male to Male (maximum length 3 m) cable to the
USB device port on the Automation Server and a USB port on the PC.
3. Perform a DFU mode restart by pressing the Reset button three times within
two seconds. For more information, see the Reset Functions topic on
WebHelp.
4. In Device Administrator, wait for the Device Status to show DFU mode.

5. Click the Upgrade Device(s) button

.

6. Select the type of database upgrade. For more information, see the Uploading
and Upgrading an Automation Server topic on WebHelp.
7. Wait for the Device Status to show Ready.
Now you can assign the IP address and host name of the Automation Server and
download the software.
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3.22

Creating an SNMP User
You create an SNMP user for Automation Server so that an SNMP Manager can
access the SNMP information on the Automation Server.
For more information, see section 3.6 “Automation Server” on page 142.

To create a SNMP user
1. In the Device Administrator, select the Automation Server.
2. On the View menu, click Network Settings.
3. Click the SNMP Configuration tab.
4. Select SNMP queries to receive SNMP queries.
5. Select SNMP traps to receive SNMP traps.
6. In the Destination host for traps box, type the destination host for traps.
7. In the Username box, type the username.
8. In the Authentication password (MD5) box, type the Authentication
password. The password must be at least ten characters long.
9. In the Confirm password box, type the password again.
10. In the Privacy password box, type the privacy password. The password
must be at least ten characters long.
11. In the Confirm password box,type the password again.
12. In the System contact box, type the name of the system contact.
13. In the Location box, type the location.
14. Click OK.
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3.23

Automation Server Upgrade
You can connect the Device Administrator to the Automation Server in two ways:
• USB connection: The Automation Server is immediately displayed in the list of
devices accessible to the Device Administrator.
• TCP/IP network: If you know the IP address of an Automation Server, you can
reach it via the network and add it to the list of accessible devices.
You must upgrade Device Administrator before you upgrade the Automation
Servers.
You use Device Administrator to upgrade the Automation Server. Device
Administrator uploads the backup set from the Automation Server to the computer
that is running Device Administrator. The database in the backup set is converted to
the new version.
You then open the Conversion Logs and determine if you can use the converted
database for download or if you need to fix configuration issues in the Automation
Server. In WorkStation, fix the configuration issues in the Automation Server. In
Device Administrator, upload and convert the database again. Repeat this process
until you are comfortable with the contents of the Conversion Logs.
You download the converted database to the Automation Server. During this
download, the Automation Server is completely offline and not operational from a
controls perspective for up to 25 minutes.
You can choose to download the database immediately or at a later time. However,
if the converted database is older than 24 hours, you are notified that the database
might be out of date because the Automation Server has been online collecting
data while the backup set containing the database was converted.
The timeframe between the database upgrade and the actual download of the
database can cause the database to be out of date because the Automation Server
has been online collecting data, such as configurations and events, while the
backup set containing the database was converted. However, trendlog data is
always retained.

3.23.1

Set Time on Device
The set time on device function helps you with the time settings on the Automation
Server. The Set time on device function transfers the time from the computer that
runs Device Administrator to the Automation Server.

Automation Server with Factory Settings
An Automation Server with factory settings does not have the correct time. To avoid
obsolete time stamps on the events in the event log, use the Set time on device
function to transfer the time from the computer that runs Device Administrator.

Upgrade an Automation Server with a New Database
When you upgrade an Automation Server with a new database, the time setting on
the Automation Server is overwritten with the time from the computer that runs
Device Administrator when you use the Set time on device function.
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3.23.2

Status
After upload and conversion, the color of the progress bar in the Device
Administrator indicates the status of the database conversion:
• Green: The database conversion is complete.
• Yellow: The database conversion is complete. Open the Conversion Logs and
determine if you can use the converted database for download or if you need
to fix configuration issues in the Automation Server.
• Red: The database conversion has failed. Open the Conversion Logs and
determine the configuration issues that you need to fix in the Automation
Server.
For more information, see the Opening the Conversion Log topic on WebHelp.
For more information, see the Opening the High Priority Conversion Log topic
on WebHelp.

3.23.3

Conversion Logs
Two conversion logs keep track of information about the database conversion of
the Automation Server or the Enterprise Server:
• Conversion log: includes information about any errors, warnings, and notices
that occurred during the conversion of the database
For more information, see the Opening the Conversion Log topic on WebHelp.
• High priority conversion log: contains only the warnings that will most often
require some kind of user action
For more information, see the Opening the High Priority Conversion Log topic
on WebHelp.
For more information, see the Conversion Logs topic on WebHelp.
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3.24

Server Object Properties
Use the Server Object Properties view or dialog box to configure and view the
general and object-reference properties. For more information, see the General
Properties – Basic Tab topic on WebHelp.

Figure: Server Object Properties
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3.25

Displaying CPU and System Memory
Usage
You view the CPU usage and system memory usage of a server polling large
graphics, or a significant number of objects in the Watch pane.

To display CPU and system memory usage
1. In WorkStation, in the System Tree pane, select the server that you want to
diagnose.
2. On the Actions menu, point to View followed by In Watch pane, and then
click Other properties.

3. Select CPU usage and System memory usage.

4. If the CPU usage and system memory usage is above 50%, adjust the polling
interval settings on the network to optimize system performance.
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4.1

Server Communication
You configure communication parameters when you add a Building Operation
server. The Enterprise Server distributes the communication parameters to the
other servers so that they know how to communicate with the newly added server.

4.1.1

Communication Parameters
Communication parameters include address, protocol, and port. You configure
these parameters in the Server wizard when you add servers.

Address
Every server needs an IP address to communicate in the network. You either use
the installation default IP address, or specify a static address that is unique in the
network. We advise against enabling DHCP.
You can also specify the server's fully qualified domain name, if one is defined and
the DNS service is enabled. A fully qualified domain name for a server consists of
two parts: the host name and the domain name. For example, a server with a host
name “es1” and the domain name “universityx.edu” has the fully qualified domain
name “es1.universityx.edu”. Always use the server's fully qualified domain name,
rather than its host name (without the domain information), to avoid lead-shadow
reference server communication problems. For more information, see section 144.7
“Lead-Shadow Reference Server Communication Problems ” on page 5477.

Protocols
Building Operation servers can use three different communication protocols:
• TCP is fast and you can set up domain authentication which makes for easy,
yet secure access.
• HTTP is slower than TCP but better for accessing resources outside the
LAN/firewalls.
• HTTPS is slower than HTTP but safer for accessing resources outside the
LAN/firewalls.

Ports
Each server listens on three communication ports, one for each communication
protocol:
• TCP on port 4444 (fixed)
• HTTP on port 80 (default)
• HTTPS on port 443 (default)

4.1.2

Server Communication Parameters
The communication parameters of a Building Operation server tell other Building
Operation servers where and how to communicate with that particular server. You
use different tools to specify, view, and change communication parameters.
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Figure: Different ways of accessing communication parameters
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To change the communication parameters of an Enterprise Server after it has been
commissioned, you need to open the Software Administrator application. In the
Software Administrator, you must first stop the server before configuring the
parameters.
To change the communication parameters of an Automation Server after it has
been commissioned, you need to access it through the web interface. For more
information, see the Accessing the Automation Server Web Configuration topic on
WebHelp.

4.1.3

Server-to-Server Communication Parameters
Each Building Operation server maintains a list of all the other Building Operation
servers in the system and the communication parameters of those servers.

Figure: Keeping track of the other Building Operation servers

In WorkStation, you can select a server in the System Tree pane and view its
communication parameters in the Network tab of its properties. In the
Communication view, you can view the information the server has about the
communication parameters of other Building Operation servers in the system. Each
server needs to know where and how to address other servers.
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When an Automation Server is added, its communication parameters are
distributed by the Enterprise Server to all other Building Operation servers in the
system. Every server’s communication parameters ends up in every other servers
Communication view.
However, if you change the IP address or protocol port number in an already
commissioned server, you must manually update this information in the Enterprise
Server Communication view. The Enterprise Server then distributes the new
parameters to the other Building Operation servers.

4.1.4

Server Communication in Project
Configuration Server
You configure the server communication parameters in WorkStation for Projects,
before you deploy an Enterprise Server or an Automation Server.
For more information, see section 4.8 “Server Communication in Project
Configuration Server ” on page 186.

4.1.5

E-mail Server Settings
Some Building Operation features, alarms in particular, can be configured to send
E-mails to notify users about important events. You select and specify the E-mail
server settings in the E-mail tab in the Properties of each Building Operation server.
The easiest and most straight-forward way of setting up the E-mail server is to
select the Schneider Electric E-mail Server, specify a Sender E-mail address, and
use the default settings.
For example, if an alarm goes off, the Building Operation server notifies the E-mail
recipient specified in the alarm. The Building Operation server sends the E-mail
through the Schneider Electric E-mail Server, which is hosted by Schneider Electric
for use by Building Operation customers. The Sender E-mail specified in the E-mail
tab is the receiver of the replies from the E-mail recipient.
However, instead of the default Schneider Electric E-mail Server, you can select
and specify a different E-mail server. You can also specify a secondary E-mail
server in case the connection to your primary choice fails.
The Building Operation server tries to connect to the primary E-mail server, and
then to the secondary if the the primary fails, and then to the primary again, and so
on. If the secondary E-mail server is used, it automatically becomes the primary Email server while the other one assumes secondary status.
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4.2

Server Status
The status of a server can be either online or offline. Being online or offline depends
on the operational situation of the server and its connectivity with other servers. A
server can actually be online and communicating with one server, while at the same
time appear to be offline to another server.
Server status has implications on server management. A server needs to be online
to be configured. Another consideration is that configuring a server, while another
server is offline, can cause the offline server to come out of synch when it comes
back online again.

4.2.1

Offline Server Causes
A server can be offline towards another server or the entire live system for several
reasons:
• Server is stopped
• Host is shut down
• Cable connection is faulty
• Communication parameters are invalid (wrong address or port)
• Firewall blocks port

4.2.2

Offline Server Problems
Engineering a server while another server is offline can cause the offline server to
come out of synch when it comes back online again.

Server Communication
An offline server’s communication parameter about other Building Operation
servers, those in the Communication tab, becomes inconsistent:
• If you add a new server to the live system
• If you remove a server from the live system
Solution: select the Enterprise Server and click the Repair server
communication command on the Actions -> Advanced menu.

Object References
An offline server’s object references becomes broken:
• If you delete the referenced object
• If you move the referenced object
• If you rename the referenced object
Solution: select the object and click the Repair references command on the
Actions -> Advanced menu.
You know which objects are affected by the list that is displayed to you, in the
confirmation dialog box, at the time you remove/move/rename the objects in
question.
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4.3

Repairing Server Communication
You use this procedure to repair server communication. Specifically, offline servers,
when they come back online again, need to know if other servers have been added
or removed.
For more information, see section 4.2 “Server Status” on page 177.

To repair server communication
1. In WorkStation, in the System Tree pane, select the Enterprise Server.
2. On the Actions menu, point to Advanced and then click Repair server
communication.
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4.4

Updating Communication Parameters
You use this procedure to update the communication parameters that servers
maintain about other Building Operation servers. You need to do this manually if the
IP address or any of the configurable ports have been changed in another Building
Operation server.
For more information, see section 4.1 “Server Communication” on page 173.

To update communication parameters
1. In WorkStation, in the System Tree pane, select the Enterprise Server.
2. Click the Communication view.
3. In the Server list, select the server that has a new IP address, a new port
number, or a new communication protocol.

4. In the toolbar, click the Show/Hide Communication settings button

.

5. In the Address box, type the new IP address or fully qualified domain name of
the server.

Important
• If the Automation Server has been assigned a dynamic IP
address, use the fully qualified domain name of the server
instead of the IP address.
6. In the Protocol box, select a new protocol if you want to change the way this
server communicates with the other server.
7. In the Port box, enter the new port number.
8. On the toolbar, click the Save button
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4.5

Updating References
You use this procedure to update broken references. Object references can break if
the server or device on which they reside is offline at the time when the referred
object is either deleted, moved, or renamed.
When a change is made to an object that is referred to by offline objects, a confirm
dialog box is displayed with a list of those objects that are affected. Save that list
and use it to find and update the broken references when they come back online
again.
For more information, see section 4.2 “Server Status” on page 177.

To update references
1. In WorkStation, in the System Tree pane, select the object that has a broken
reference.
2. On the Actions menu, point to Advanced and then click Update
References.
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4.6

Selecting the Schneider Electric E-mail
Server for E-mail Notifications
You configure an Automation Server or Enterprise Server to connect to and send Email notifications through the Schneider Electric E-mail Server, which is an SMTP
server hosted by Schneider Electric.

Note
• Any available SMTP server can be used to send E-mail notifications. For more
information, see section 4.7 “Selecting and Specifying an E-mail Server for Email Notifications” on page 183.
For more information, see section 4.1 “Server Communication” on page 173.

To select the Schneider Electric E-mail server for E-mail
notifications
1. In WorkStation, in the System Tree pane, select the server that you want to
configure.
2. On the File menu, click Properties.
3. Click the E-mail tab.
Continued on next page
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4. In the Select E-mail server box, select Schneider Electric E-mail
Server to use the SMTP server hosted by Schneider Electric.

5. In the Sender E-mail box, type a sender address for the E-mail messages
that are generated by this server. The sender E-mail address is the receiver of
replies.
6. In the Maximum queue size box, enter the maximum number of E-mail
messages that is allowed in the queue.
7. In the Maximum retry count box, enter the number of attempts to send an
E-mail message that are performed before cancelling the E-mail message.
8. In the Retry time box, enter the number of minutes between each attempt.
9. In the Host box, confirm that the Schneider Electric E-mail Server address is
smtpservice.tac.com.
10. In the Port box, confirm that the port number is 25.
11. Click OK.
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4.7

Selecting and Specifying an E-mail
Server for E-mail Notifications
You configure a Building Operation server to connect to and send e-mail
notifications through an E-mail server or SMTP server.

Note
• The Schneider Electric E-mail Server, which is hosted by Schneider Electric,
can also be selected to send e-mail notifications. For more information, see
section 4.6 “Selecting the Schneider Electric E-mail Server for E-mail
Notifications” on page 181.
For more information, see section 4.1 “Server Communication” on page 173.

To select and specify an e-mail server for e-mail notifications
1. In WorkStation, in the System Tree pane, select the Building Operation
server that you want to configure.
2. On the File menu, click Properties.
Continued on next page
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3. Click the E-mail tab.

4. In the Select E-mail Server box, select Primary/Secondary to specify an
e-mail server.
5. In the Sender E-mail box, type a sender address for the e-mails that are
generated by this Building Operation server. The sender e-mail address is the
receiver of replies.
6. In the Maximum queue size box, enter the maximum number of e-mails
that is allowed in queue.
7. In the Maximum retry count box, enter the number of attempts to send an
e-mail that are performed before abandoning the e-mail.
8. In the Retry time box, enter the number of minutes between each attempt.
9. In the Primary host box, type the primary e-mail server web address.
10. In the Primary user name box, type the user name for the e-mail user
account on the primary e-mail server.
Continued on next page
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11. In the primary Password box, type the password for the e-mail user account
on the primary e-mail server.
12. In the primary Confirm Password box, type the password again for the email user account on the primary e-mail server.
13. In the Primary port box, enter the port that is designated for incoming SMTP
traffic on the primary e-mail server.
14. In the Secondary host box, type the secondary e-mail server web address.
15. In the Secondary user name box, type the user name that authenticates
the usage of the secondary e-mail server.
16. In the secondary Password box, type the password for the e-mail user
account on the primary e-mail server.
17. In the secondary Confirm Password box, type the password again for the
e-mail user account on the primary e-mail server.
18. In the Secondary port box, enter the port that is designated for incoming
SMTP traffic on the primary e-mail server.
19. Click OK.
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4.8

Server Communication in Project
Configuration Server
You configure the server communication parameters in WorkStation for Projects,
before you deploy an Enterprise Server or an Automation Server.
For more information, see section 4.1 “Server Communication” on page 173.

Figure: Project Configuration Server communication

It is best practice to configure the server communication parameters before a
deploy of an Automation Server or an Enterprise Server. However, you can
configure the server communication parameters after a deploy by logging on with
WorkStation to the on-site server and setting the DNS/IP address. For more
information, see section 4.4 “Updating Communication Parameters” on page 179.

Logon credentials
You can set the logon credential for the communication between the Project
Configuration Server and the Enterprise Server and Automation Servers. For
example, the default user admin and the password admin, which can be useful
when you are setting up new servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.
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4.9

Updating Project Configuration Server
Communication Parameters
You update the Project Configuration Server communication parameters to set the
correct DNS/IP address, HTTP/HTTPS/TCP ports, and logon credentials for
communication with the Enterprise Server or Automation Server.
For more information, see section 4.8 “Server Communication in Project
Configuration Server ” on page 186.

To update Project Configuration Server communication
parameters
1. In WorkStation for Projects, in the System Tree pane, select the project
folder and click the Servers tab.

2. In the Protocol box, select the protocol.
3. In the Server Information view, select a server and click the Show/Hide
Communication Settings button

.

4. In the Communication tab, in the DNS/IP address box, type the IP
address or fully qualified domain name of the server.
5. In the HTTP port box, select the server HTTP port.
6. In the HTTPS port box, select the server HTTPS port.
7. In the TCP port box, select the server TCP port.
8. In the User name box, type the server logon user name.
9. In the Password box, type the server logon password.
10. In the Confirm Password box, retype the server logon password.
11. Click Save.
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4.10

Setting Server Logon Credential
You set the logon credential for any server in the project, to be deployed to the
specific server and used in the communication with a server by the Project
Configuration Server.
For more information, see section 4.8 “Server Communication in Project
Configuration Server ” on page 186.

To set a server logon credential
1. In WorkStation for Projects, in the System Tree pane, select the project
folder and click the Servers tab.

2. In the Server Information view, select a server and click the Show/Hide
Communication Settings button

.

3. In the Communication tab, in the User name box, type the logon user
name.

Note
The default custom user name is admin, and the default password is
also admin.
4. In the Password box, type the logon password.
5. In the Confirm Password box, retype the logon password.
6. Click Save.
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5.1

WorkStation for Projects Overview
Project Configuration Server with WorkStation for Projects is an offline engineering
platform that is used for project configuration and deployment.
A dedicated engineering platform separate from the target system facilitates
flexibility. You do not need to spend as much time at the customer site. Much of the
analyzing, designing, modelling, and programming can be done at your office at
your convenience, in a similar way as in WorkStation.

5.1.1

Project Configuration Server
The Project Configuration Server is used for off-site engineering, project
configuration, and deployment of the project configuration to the on-site servers.
You create the project configuration, such as servers, networks, devices, and
schedules. When you connect the Project Configuration Server to the server (either
locally or remotely), you deploy the project to the Enterprise Server or the
Automation Server.
For more information, see section 5.2 “Project Configuration Server” on page 193.

5.1.2

Compatibility Notes
Working with projects in WorkStation for Projects and the Project Configuration
Server is very similar to working in WorkStation in an online system. However, some
features and functionalities are not supported in Project Configuration Server.
For more information, see section 5.3 “Compatibility Notes” on page 196.

5.1.3

WorkStation for Projects
WorkStation for Projects is the user interface that you use to create and configure
projects on the Project Configuration Server so you can work on the projects off
site.
For more information, see section 5.12 “WorkStation for Projects ” on page 220.

5.1.4

Projects
You use the Project Configuration Server to create and configure projects. The
project can be an almost full logical blueprint of the target system, complete with
servers, programs, domains, user groups, networks, devices, and applications.
However, without any historical data.
For more information, see section 6.1 “Projects” on page 239.
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5.1.5

Project Configuration Server Backup and
Restore
Backup and Restore assures that a project database can be restored after damage
or loss due to hardware or software failures, security threats, or application testing.
Project Configuration Server provides backup and restore capabilities that preserve
the configuration data of a project. Features are the same as for Building Operation
Backup and Restore with a few exceptions:
• You cannot schedule backups.
• You cannot perform multi-server backups.
• You cannot backup alarms.
• You cannot automatically purge backup sets.
For more information, see section 8.2 “Project Backup and Restore” on page 281.

5.1.6

Server Communication in Project
Configuration Server
You configure the server communication parameters in WorkStation for Projects,
before you deploy an Enterprise Server or an Automation Server.
For more information, see section 4.8 “Server Communication in Project
Configuration Server ” on page 186.

5.1.7

Time Zone Configuration in Project
Configuration Server
To adjust the Project Configuration Server time zone and DST, you have to access
the Project Configuration Server through WorkStation for Projects.
For more information, see section 7.2 “Time Zone Configuration in Project
Configuration Server” on page 272.
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5.2

Project Configuration Server
The Project Configuration Server is used for off-site engineering, project
configuration, and deployment of the project configuration to the on-site servers.
You create the project configuration, such as servers, networks, devices, and
schedules. When you connect the Project Configuration Server to the server (either
locally or remotely), you deploy the project to the Enterprise Server or the
Automation Server.

Figure: Project Configuration Server concept

While you are creating a project, you can write, validate, and simulate a program in
a programming editor. However, the Projects Configuration Server does not
communicate with the physical field control devices. Therefore, you cannot
discover, learn, or commission devices when you are working in a project.
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Figure: Project Configuration Server communication concept

WorkStation for Projects is the user interface you use to create objects, create user
accounts for Project Configuration Server, back up the projects, and deploy
projects to an Enterprise Server or Automation Server. For more information, see
section 5.12 “WorkStation for Projects ” on page 220.

5.2.1

Engineering
You can install and run multiple versions of Project Configuration Server on the
same computer as an Enterprise Server.
When connected to the system IP network, the Project Configuration Server can
deploy projects, with domain set-ups, to servers. When working in a project, only
one pre-configured workspace is available.

5.2.2

Features
The Project Configuration Server provides features for project management, and
tools for engineering:
• Project management
• Enterprise Server setup
• Automation Server setup
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• Programming editors
• Binding tool
• Graphics editor
• Domain setup
• Project deployment

5.2.3

License
Project Configuration Server requires no license. However, WorkStation for Projects
used for project configuration requires a WorkStation license since they are installed
with the same installation package.
For more information, see the Licenses topic on WebHelp.
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5.3

Compatibility Notes
Working with projects in WorkStation for Projects and the Project Configuration
Server is very similar to working in WorkStation in an online system. However, some
features and functionalities are not supported in Project Configuration Server.

5.3.1

INET Interface
I/NET is not supported in the Project Configuration Server. In WorkStation for
Projects, you cannot discover devices, learn devices, or retrieve an I/NET device’s
configuration from the I/NET Seven system.

5.3.2

MNL LonWorks
When using the Project Configuration Server, you cannot create MNL LonWorks
devices and applications. Accordingly, the WorkPlace Tech Editor option does not
display in the Control Panel. However, you can engineer MNL LonWorks devices in
an Enterprise Server or Automation Server after you deploy a project to one of these
servers.

5.3.3

Reports
You cannot create reports in the Project Configuration Server. The reports pack
(exported from WebReports) can be uploaded in the Project Configuration Server,
but you cannot view or manage reports in WorkStation for Projects.

5.3.4

Sigma
Sigma is not supported in the Project Configuration Server.

5.3.5

Script Debugger
The Script Debugger is not supported in the Project Configuration Server.
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5.4

Installing the Project Configuration
Server
You install the Project Configuration Server to configure and deploy projects.
For more information, see the Installation Overview topic on WebHelp.

To install the Project Configuration Server
1. In Windows, disable any anti-virus program.
2. Double-click the Project Configuration Server installation file to start the
installation wizard.
3. Click Yes.

4. Click Next.

Continued on next page
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5. Click I Agree.

6. Select installation folder and then click Next.

Continued on next page
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7. Select Project Configuration Server and then click Next.

8. In the Projects Folder box, enter the path to the location where you want to
save the Project Configuration Server projects.

Important
• If a Project Configuration Server is already installed, the project
location of the Project Configuration Server with the highest
version number is default.
• When installing a Project Configuration Server with a different
version number from the currently installed, the new Project
Configuration Server version is installed in parallel to the current
version.
• The user database is copied and upgraded from the current
installation if the current installation has a lower version number.
• The database for a project is located in the project folder.
• The folder path can contain up to 107 characters.
• The folder path can only contain ASCII and Unicode characters.
Continued on next page
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9. Click Next.
10. Click Next.

Continued on next page
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11. In the HTTP Port box, type the port number the Project Configuration Server
listens to when communicating through the Hypertext Transfer Protocol.

12. In the HTTPS Port box, type the port number the Project Configuration
Server listens to when communicating through the Hypertext Transfer Protocol
Secure.
13. In the TCP Port box, type the port number the Project Configuration Server
listens to when communicating through the Transmission Control Protocol.
14. Click Install.
Continued on next page
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15. Click Next.

Note
Click Show details to follow the progress of the installation.
16. Click Finish.

17. In Windows, enable any anti-virus program.
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5.5

Upgrading the Project Configuration
Server
You upgrade the Project Configuration Server to access new features or improve
the performance of the product.

Important
To upgrade Project Configuration Server, you must have access to an installation
package with a higher number than currently installed version.
For more information, see the System Upgrade Overview topic on WebHelp.

To upgrade a Project Configuration Server
1. In Windows, disable any anti-virus program.
2. Double-click on the Project Configuration Server installation file to start the
installation wizard.
3. Click Next, to confirm that you want to run the Project Configuration Server
installation package.

Continued on next page
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4. Click I Agree.

5. Click Next.

Caution
If you previously selected a custom folder for your installation, select
a different installation folder to aviod data loss.

Continued on next page
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6. In the Projects Folder box, enter the path to the location where you want to
save the Project Configuration Server projects.

Important
If a Project Configuration Server is already installed, the set project
location of the installed Project Configuration Server with the highest
version number is default.
When installing a Project Configuration Server with a different version
number as the currently installed Project Configuration Server, the
user database is upgraded. For more information, see the Version
Numbers and Parallel Installations topic on WebHelp.
When installing a Project Configuration Server with a different version
number from the currently installed, the new Project Configuration
Server version is installed in parallel to the current version.
The user database is copied and upgraded from the current
installation with the highest version.
The folder path can contain up to 107 characters.
The folder path can only contain ASCII and Unicode characters.

Important
Projects created in a previous Project Configuration Server version is
not automatically upgraded and have to be upgraded manually in the
new version of WorkStation for Projects. For more information, see
section 6.17 “Upgrading a Project” on page 268.

Continued on next page
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7. Click Next.

8. In the HTTP Port box, type the port number the Project Configuration Server
listens to when communicating through the Hypertext Transfer Protocol.

Important
If you configure the ports manually, make sure not to set the same
HTTP, HTTPS, and TCP ports used in a parallel Project Configuration
Server installation.
9. In the HTTPS Port box, type the port number the Project Configuration
Server listens to when communicating through the Hypertext Transfer Protocol
Secure.
Continued on next page
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10. In the TCP Port box, type the port number the Project Configuration Server
listens to when communicating through the Transmission Control Protocol.
11. Click Install.
12. Click Next.

Note
Click Show details to follow the progress of the installation.
13. Click Finish.

14. In Windows, enable any anti-virus program.
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5.6

Configuring Server Port Settings
You configure server HTTP, HTTPS, and TCP ports to define the communication of
the different protocols. In Software Administrator, you can configure either the ports
of the Enterprise Server or the Project Configuration Server.
For more information, see the Software Administrator topic on WebHelp.

To configure server ports
1. In Software Administrator, click the tab of the Enterprise Server or the
Project Configuration Server.

2. Click Stop Service.
3. In the HTTP Port box, type the port number that the server listens to when
communicating through the Hypertext Transfer Protocol.
4. In the HTTPS Port box, type the port number that the server listens to when
communicating through the Hypertext Transfer Secure Protocol.
5. In the TCP Port box, type the port number that the server listens to when
communicating through the Transmission Control Protocol.
6. Click Apply.
7. Click Start Service.
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5.7

Stopping the Project Configuration
Server Windows Service
You stop the Project Configuration Server Windows service to configure the port
settings or to repair, upgrade (in future releases), or reinstall the Project
Configuration Server.
For more information, see the Software Administrator topic on WebHelp.

To stop the Project Configuration Server Windows service
1. In Software Administrator, click Stop Service.
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5.8

Starting the Project Configuration
Server Windows Service
You start the Project Configuration Server Windows service manually in case you
previously have stopped it.

Note
The Project Configuration Server Windows service automatically starts when the
server is installed or the computer it is installed on is started.
For more information, see the Software Administrator topic on WebHelp.

To start the Project Configuration Server Windows service
1. In Software Administrator, click Start Service.
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5.9

Restarting the Server Windows Service
You restart the Enterprise Server or the Project Configuration Server Windows
service to reset or apply new settings.

Important
Ensure that you have a working and available Enterprise Server license. A working
license is required to start the Enterprise Server. For more information, see the
Licenses topic on WebHelp.
For more information, see the Software Administrator topic on WebHelp.

To restart the server Windows service
1. In the Software Administrator, click the tab of the server that you want to
restart.
2. Click Stop Service.
3. Click Start Service.

04-16006-04-en, March 2015

Technical
213

5 WorkStation for Projects Introduction
5.10 Uninstalling the Project Configuration Server

5.10

Uninstalling the Project Configuration
Server
You uninstall a Project Configuration Server to permanently remove the application
from your computer or server.

Note
You do not need to back up the Project Configuration Server before uninstalling
the product. All projects created on the Project Configuration Server are saved on
the computer and remain unaffected by the uninstallation.
For more information, see the Uninstallation topic on WebHelp.

To uninstall the Project Configuration Server
1. On the Windows toolbar, select Start and then click Control Panel.
2. Click Programs and Features.

Continued on next page
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3. Click Schneider Electric StruxureWare Building Operation Project
Configuration Server x.x and then click Uninstall.

Continued on next page
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4. When the uninstallation process is completed, click Close.
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5.11

Reinstalling the Project Configuration
Server
You reinstall the Project Configuration Server to replace your current installation with
a fresh copy.
For more information, see the Installation Overview topic on WebHelp.

To reinstall the Project Configuration Server
1. In Windows, disable any anti-virus program.
2. In Windows, double-click the Project Configuration Server installation file to
start the installation wizard.
3. Click Yes.

4. Click Next.

Continued on next page
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5. Click I Agree.

6. Click Next.

Continued on next page
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7. Click Next.

8. Click Next.

Continued on next page
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9. In the HTTP Port box, type the port number the Project Configuration Server
listens to when communicating through the Hypertext Transfer Protocol.

10. In the HTTPS Port box, type the port number the Project Configuration
Server listens to when communicating through the Hypertext Transfer Protocol
Secure.
11. In the TCP Port box, type the port number the Project Configuration Server
listens to when communicating through the Transmission Control Protocol.
12. Click Install.
Continued on next page
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13. Click Next.

Note
Click Show details to follow the progress of the installation.
14. Click Finish.

15. In Windows, enable any anti-virus program.
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5.12

WorkStation for Projects
WorkStation for Projects is the user interface that you use to create and configure
projects on the Project Configuration Server so you can work on the projects off
site. In WorkStation for Projects, you can create user accounts for WorkStation for
Projects, back up the Project Configuration Server, and deploy projects to an
Enterprise Server or Automation Server.
Working with projects in WorkStation for Projects is similar to working with an online
system in WorkStation. However, the Projects Configuration Server does not
communicate with the physical field control devices. Therefore, you cannot
discover, learn, or commission devices when you are working in a project.
Only one pre-configured workspace is available. WorkStation for Projects has
different color schemes on the File menu, the toolbar, and the status bar than
WorkStation to make it easier to tell the difference. For more information, see the
WorkStation topic on WebHelp.
WorkStation for Projects is installed in parallel with WorkStation when installing the
WorkStation installation package.

5.12.1

Log on to WorkStation for Projects
You log on to Project Configuration Server through WorkStation for Projects to
securely access the functions in Project Configuration Server.
For more information, see section 5.13 “Log on to WorkStation for Projects” on
page 221.

5.12.2

License
WorkStation for Projects is installed with the same installation package as
WorkStation, and therefore requires a WorkStation license.
For more information, see the Licenses topic on WebHelp.

5.12.3

WorkStation for Projects User Account
Management
When logging on to WorkStation for Projects, you have to authenticate yourself by
using a valid user account. The first time you log on, you need to use the
administrator user account to create a project user account. You use the project
user account to log on and manage projects (create, delete, or configure).
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.
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5.13

Log on to WorkStation for Projects
You log on to Project Configuration Server through WorkStation for Projects to
securely access the functions in Project Configuration Server.
In WorkStation for Projects, you log on with your project user account. Your system
administrator decides which type of user you log on as.
To log on to WorkStation for Projects using a project account, you need to know
the following account information:
• User name
• Password
• Server
The account information for the project account is provided by the system
administrator.
For a faster log on, use the Remember me feature to automatically fill in your user
name, password, and server in WorkStation for Projects.
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5.14

Logging on to WorkStation for Projects
You use WorkStation for Projects to access the Project Configuration Server.
For more information, see section 5.13 “Log on to WorkStation for Projects” on
page 221.

To log on to WorkStation for Projects
1. In the Building Operation WorkStation for Projects window, in the User
name box, type the user name.

Note
The first time you log on to WorkStation for Projects you need to use
the administrator user account to create a project user account. For
more information, see section 5.17 “Creating a WorkStation for
Projects User Account” on page 225.

2. In the Password box, type the password.
3. In the Server box, select the hypertext transfer protocol you want to use and
then enter a server name or an IP address.
4. Select Remember me to have WorkStation for Projects remember your
settings.
5. Click Log on.
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5.15

Logging off WorkStation for Projects
You log off WorkStation for Projects so that unauthorized personnel cannot tamper
with your project. Logging off closes WorkStation for Projects.
For more information, see section 5.13 “Log on to WorkStation for Projects” on
page 221.

To log off WorkStation for Projects
1. In WorkStation for Projects, in the WorkStation for Projects Manager
toolbar, click the Log off button
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5.16

WorkStation for Projects User Account
Management
When logging on to WorkStation for Projects, you have to authenticate yourself by
using a valid user account. The first time you log on, you need to use the
administrator user account to create a project user account. You use the project
user account to log on and manage projects (create, delete, or configure).

5.16.1

Administrator Account
As a WorkStation for Projects administrator, you can set up users, validate
accounts, and change passwords.

Important
You can configure expiration rules for a WorkStation for Projects user account.
The administrator can also force users to change their passwords in WorkStation
for Projects.

Important
When a password is changed while the user is logged on, the user needs to log
off and log on again before opening a project.

5.16.2

User Account
As a WorkStation for Projects user, you can create projects, deploy projects, and
back up projects.
Up to 10 users are able to work simultaneously in the same project, with the
following limitations:
• Only one user can save configuration changes at a time. The other users save
operations are queued.
• Only one project command (Deploy) can be executed at a time. The other
commands are queued.
• During a deploy of a server from a project, a save of configuration changes to
the server will be queued.
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5.17

Creating a WorkStation for Projects
User Account
You create user accounts for specific use in WorkStation for Projects.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To create a WorkStation for Projects user account
1. In WorkStation for Projects, click the Users tab.
2. In the list, right-click, point to New and then click User Account.

Continued on next page
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3. In the Name box, type a user name.

4. In the Description box, type a description.
5. Click Next.
6. In the First name box, type the first name of the person that is going to use
the account.

7. In the Middle name box, type the middle name of the person that is going to
use the account.
Continued on next page
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8. In the Last name box, type the last name of the person that is going to use
the account.
9. In the Home E-mail address box, type the home e-mail address of the
person that is going to use the account.
10. In the Work E-mail address box, type the work e-mail address of the
person that is going to use the account.
11. In the Expires on box, enter an expiration date of the user account.
12. In the Password box, type a password for the user account.

13. In the Confirm Password box, retype the password.
14. Click Create.
This user account will be able to work in WorkStation for Projects.
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5.18

Deleting a WorkStation for Projects
User Account
You delete a WorkStation for Projects user account when it is no longer of use.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To delete a WorkStation for Projects user account
1. In WorkStation for Projects, in the Users tab, right-click on the user to be
deleted and click Delete.

2. Click Yes.
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5.19

Changing the WorkStation for Projects
User Password
You use this procedure to change your WorkStation for Projects user account
password for increased system security.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To change the WorkStation for Projects user password
1. In WorkStation for Projects, in the WorkStation for Projects toolbar, click
the Change Password button.
2. In the Present password box, type the old password.

3. In the New password box, type the new password.
4. In the Confirm new password box, type the new password again.
5. Click OK.
6. Click OK.

Important
You have to log off and then log on again before being able to create
and open projects.
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5.20

Changing other WorkStation for
Projects Users Password
As an administrator, you use this procedure to change any WorkStation for Projects
user account password.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To change other WorkStation for Projects users password
1. In WorkStation for Projects, on the WorkStation for Projects toolbar, click
the Project Configuration Server Users Domain button.
2. In the Users tab, right-click the user account and then select Open.
3. In the Password box, type the new password.

4. In the Confirm Password box, retype the new password.
5. Click Save.
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5.21

Disabling a WorkStation for Projects
User Account
You disable a user account to prevent the user from accessing WorkStation for
Projects.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To disable a WorkStation for Projects user account
1. In WorkStation for Projects, on the WorkStation for Projects toolbar, click
the Project Configuration Server Users Domain button.
2. In the Users tab, right-click the user account and select Open.
3. In the Disabled box, select True.

4. Click Save.
The user is now disabled from logging in to WorkStation for Projects.
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5.22

Enabling a WorkStation for Projects
User Account
You enable a user account to give the user access to WorkStation for Projects.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To enable a WorkStation for Projects user account
1. In WorkStation for Projects, on the WorkStation for Projects toolbar, click
the Project Configuration Server Users Domain button.
2. In the Users tab, right-click the user account and select Open.
3. In the Disabled box, select False.

4. Click Save.
The user is now enabled to log on to WorkStation for Projects.
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5.23

Setting an Expiration Date for a
WorkStation for Projects User Account
You set an expiration date for an account to limit the time period a user has access
to WorkStation for Projects.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To set an expiration date for a WorkStation for Projects user
account
1. In WorkStation for Projects, on the WorkStation for Projects toolbar, click
the Project Configuration Server Users Domain button.
2. In the Users tab, right-click the user account and select Open.
3. In the Expires on boxes, select the date and the time for expiration.

4. Click Save.

04-16006-04-en, March 2015

Technical
235

5 WorkStation for Projects Introduction
5.24 Removing the Expiration Date for a WorkStation for Projects User Account

5.24

Removing the Expiration Date for a
WorkStation for Projects User Account
You remove the expiration date for a user account so that there is no time limit for
how long a user can access WorkStation for Projects.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To remove the expiration date for a WorkStation for Projects
user account
1. In WorkStation for Projects, on the WorkStation for Projects toolbar, click
the Project Configuration Server Users Domain button.
2. In the Users tab, right-click the user account and select Open.
3. In the Expires on boxes, remove the date and time settings for the account.

4. Click Save.

Technical
236

04-16006-04-en, March 2015

5 WorkStation for Projects Introduction
5.25 Forcing WorkStation for Projects User to Change Password

5.25

Forcing WorkStation for Projects User
to Change Password
As an administrator, you use this procedure to force any user of WorkStation for
Projects to change their password at the next log on.
For more information, see section 5.16 “WorkStation for Projects User Account
Management” on page 224.

To force a WorkStation for Projects user to change password
1. In WorkStation for Projects, on the WorkStation for Projects toolbar, click
the Project Configuration Server Users Domain button.
2. In the Users tab, right-click the user account and select Open.
3. In the Force password change box, select True.

4. Click Save.
The user are now forced to change the password, at the next log on to WorkStation
for Projects.
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6.1

Projects
You use the Project Configuration Server to create and configure projects. The
project can be an almost full logical blueprint of the target system, complete with
servers, programs, domains, user groups, networks, devices, and applications.
However, without any historical data.
In a project, you can create either one Enterprise Server or one Automation Server
on the root level. You can configure an Enterprise Server with up to 64 child
Automation Servers.
The following types of objects can be created directly under a project, but they are
not deployed:
• Folder
• Document
• Event View
• Search
Projects are stored in a separate folder specified at the installation of Project
Configuration Server.
You move a project database from an off-site computer to a customer site
computer, when a project cannot be deployed from an off-site computer.
For more information, see section 6.13 “Moving a Project Database” on page 261.
After a project is created, you cannot change the name of the project.

6.1.1

Deploy
You deploy a project to an Enterprise Server or an Automation Server when you are
done with your project engineering off site.
For more information, see section 6.8 “Deploy” on page 248.

6.1.2

Synchronization Events
The synchronization events show the deploy history, such as the time when a
deploy started and who started the deploy.
For more information, see section 6.14 “Synchronization Events” on page 265.

6.1.3

Project Upgrade
Upgrading a project is possible after a new version of the Project Configuration
Server has been installed in parallel to the old version.
When a new version of Project Configuration Server is installed, the database
schemas might have changed, making the old projects incompatible with the new
version of the Project Configuration Server. The projects are not upgraded
automatically when upgrading the Project Configuration Server, but they are visible
for an individual upgrade in the new version.
For more information, see section 6.16 “Project Upgrade” on page 267.
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6.2

Creating a Project
You create a project so that you can configure a Building Operation system off site.

Note
Project names are not case sensitive. For example, you cannot have a project
called “Project1” and another called “project1”.

Note
After a project is created, you cannot change the name of the project.
For more information, see section 6.1 “Projects” on page 239.

To create a project
1. In WorkStation for Projects, in the WorkStation for Projects - Projects
view, click the New Project button

.

2. In the Name box, type a name for the project.

3. In the Description box, type a description for the project.
4. Click Create.
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6.3

Opening a Project
You open a project to configure a project or to deploy a project to a server.
For more information, see section 6.1 “Projects” on page 239.

To open a project
1. In WorkStation for Projects, in the WorkStation for Projects - Projects
view, select the project that you want to open.
2. On the toolbar, click the Open Project button

.

The project opens in WorkStation for Projects.
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6.4

Closing a Project
You close a project when you are done with your project engineering.
For more information, see section 6.1 “Projects” on page 239.

To close a project
1. In WorkStation for Projects, with a project open, click File menu.
2. Click Close project.
The project is closed and you are redirected to the projects view.
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6.5

Deleting a Project
You delete a project when you no longer need it.
For more information, see section 6.1 “Projects” on page 239.

To delete a project
1. In WorkStation for Projects, in the WorkStation for Projects - Projects
view, select the project that you want to delete.
2. On the WorkStation for Projects toolbar, click the Delete button

.

3. Click Yes.
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6.6

Creating an Enterprise Server in a
Project
You create an Enterprise Server in a project in order to be able to configure it offline.

Note
After a server is created, you cannot change the name of the server.
For more information, see section 6.1 “Projects” on page 239.

To create an Enterprise Server in a project
1. In WorkStation for Projects, in the System Tree pane, in the project folder,
select the Servers folder.
2. On the File menu, point to New and then click Server.
3. In the object type list, select Enterprise Server.

4. In the Name box, type a name for the server.
5. In the Description box, type descriptive information about the server.
6. Click Next.
Continued on next page
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7. In the DNS/IP address box, type the IP address or fully qualified domain
name of the server.

Important
Ensure that you use either an IP address or a fully qualified domain
name to avoid lead-shadow communication problems after deploy.
For more information, see section 144.7 “Lead-Shadow Reference
Server Communication Problems ” on page 5477.

8. In the HTTP port box, select the appropriate HTTP port.
9. In the HTTPS port box, select the appropriate HTTPS port.
10. In the TCP port box, select the appropriate TCP port.
11. In the User name box, type the user name.
12. In the Password box, type the password.
13. In the Confirm Password box, retype the password.
14. Click Create.
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6.7

Creating an Automation Server in a
Project
You create an Automation Server in a project in order to be able to configure it
offline.
For more information, see section 6.1 “Projects” on page 239.

Important
When you create a new Automation Server under the Enterprise Server after an
Enterprise Server deploy, the Enterprise Server will not recognize the Automation
Server. This has to be done on the on-line server.

To create an Automation Server in a project
1. In WorkStation for Projects, in the System Tree pane, in the project folder,
select the Servers folder where you want to create the Automation Server.
2. On the File menu, point to New and then click Server.
3. In the Name box, type a name for the server.

4. In the Description box, type descriptive information about the server.
5. Click Next.
Continued on next page
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6. In the DNS/IP address box, type the IP address or fully qualified domain
name of the server.

7. In the HTTP port box, select the appropriate HTTP port.
8. In the HTTPS port box, select the appropriate HTTPS port.
9. In the TCP port box, select the appropriate TCP port.
10. In the User name box, type the user name.
11. In the Password box, type the password.
12. In the Confirm Password box, retype the password.
13. In the Communication Protocol box, select the server communication
protocol.
14. Click Create.
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6.8

Deploy
You deploy the project when you want to download the project configuration to an
Enterprise Server or Automation Servers.
A deploy downloads configurations to one specific server. Objects in a child server
are not deployed when the parent server is deployed. For example, you deploy ES1
with child Automation Server AS1. In WorkStation, only the AS1 object under ES1 is
displayed in the System Tree pane, as an offline server. The objects under the AS1
are not displayed because they have not been deployed yet.

Figure: Deploy of Enterprise Server

Important
• You can only deploy a project to a server when the server has an empty
database and not have been part of a multi-server system. A server is
considered empty when it does not contain any user-created objects, such
as programs and graphics.
The server database can be emptied in different ways depending on if it is an
Automation Server or an Enterprise Server:
• Reinstall the Enterprise Server. For more information, see the Reinstalling the
Enterprise Server topic on WebHelp.
• Upgrade the Automation Server with a new database. For more information,
see the Uploading and Upgrading an Automation Server topic on WebHelp.
You move the project database from an off-site computer to an on-site computer
when you cannot deploy to the on-site computer. For example, there is no network
connection between the off-site computer and the on-site computer. When the
project database has been moved to the on-site computer, you deploy the project
configuration to the Automation Server or Enterprise Server with WorkStation for
Projects.
Technical
250

04-16006-04-en, March 2015

6 WorkStation for Projects Projects
6.8 Deploy

Figure: Deploy of project configuration to server

For more information, see section 6.12 “Deploying a Server” on page 260.
For more information, see section 6.13 “Moving a Project Database” on page 261.
You configure the server communication parameters in WorkStation for Projects,
before you deploy an Enterprise Server or an Automation Server.
For more information, see section 4.8 “Server Communication in Project
Configuration Server ” on page 186.

6.8.1

Deploy Workflow
Setting up a project and synchronize it with servers at the customer site can be
done with different workflows depending on the type of devices used in the project.
You use the generic Deploy Workflow to start setting up the project and the servers.
For more information, see section 6.9 “Deploy Workflow” on page 251.

6.8.2

Alternative Deploy Workflow
Use the Alternative Deploy Workflow to engineer and deploy a project to a Building
Operation server when you cannot set the server communication settings. For
example, the site network is not configured, IP addresses are missing, or the IP
address on the Enterprise Server has changed since the Automation Server deploy.
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For more information, see section 6.10 “Alternative Deploy Workflow” on page 254.

6.8.3

Variables in Project Configuration Server
Non-retained variables cannot be edited in WorkStation for Projects, and are not
deployed.
For more information, see section 6.11 “Variables in Project Configuration Server ”
on page 259.
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6.9

Deploy Workflow
Use the Deploy Workflow to deploy a project to a Building Operation server. This
workflow describes a generic workflow and then refer to each protocols device
workflow as the next step to complete a project deploy.

Figure: Deploy LonWorks project workflow

Create a project
In WorkStation for Projects, create a project for the LonWorks system. For more
information, see section 6.2 “Creating a Project” on page 240.

Create an Enterprise Server
In WorkStation for Projects, create an Enterprise Server in project.
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For more information, see section 6.6 “Creating an Enterprise Server in a Project”
on page 244.

Create Automation Servers
In WorkStation for Projects, create all Automation Servers in the project.
For more information, see section 6.7 “Creating an Automation Server in a Project”
on page 246.

Create devices
In WorkStation for Projects, continue with the appropriate protocol device
workflows to create devices offline and to deploy the Automation Servers and the
Enterprise Server to the on-site server, with specific domain device procedures.
For more information, see section 56.19 “Create LonWorks Device Workflow” on
page 2034.
For more information, see section 61.7 “Create Xenta LonWorks Device Workflow”
on page 2216.
For more information, see section 73.9 “BACnet System Configuration Workflows”
on page 2564.
For more information, see section 83.7 “Create b3 BACnet Devices with Factory
Settings Workflow” on page 3278.
For more information, see section 83.8 “Create Previously Used b3 BACnet Devices
Workflow” on page 3281.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended that you update the Enterprise Server communication
parameters before the deploy of the first Automation Server.

Deploy the Automation Servers
In WorkStation for Projects, deploy the Automation Servers.

Important
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
For more information, see section 6.8 “Deploy” on page 248.

Deploy the Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.
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Important
Ensure that you have created all Automation Servers in the project before the
deploy of the Enterprise Server. You can only deploy to an empty Enterprise
Server. Any additional Automation Servers have to be created on the on-site
server.
For more information, see section 6.8 “Deploy” on page 248.
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6.10

Alternative Deploy Workflow
Use the Alternative Deploy Workflow to engineer and deploy a project to a Building
Operation server when you cannot set the server communication settings. For
example, the site network is not configured, IP addresses are missing, or the IP
address on the Enterprise Server has changed since the Automation Server deploy.
If you have all the server communication settings beforehand, use the Deploy
workflow. For more information, see section 6.9 “Deploy Workflow” on page 251.
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Figure: Server Engineering flowchart
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Create a project and all servers
In WorkStation for Projects, create a project and all servers necessary.
For more information, see the Creating a Project topic on WebHelp.
For more information, see section 6.6 “Creating an Enterprise Server in a Project”
on page 244.
For more information, see section 6.7 “Creating an Automation Server in a Project”
on page 246.

Configure the first batch of Automation Servers and devices
In WorkStation for Projects, configure the first batch of Automation Servers,
creating all necessary devices, objects, alarms, trends, and references.
For more information, see section 56.19 “Create LonWorks Device Workflow” on
page 2034.
For more information, see section 61.7 “Create Xenta LonWorks Device Workflow”
on page 2216.
For more information, see section 73.9 “BACnet System Configuration Workflows”
on page 2564.
For more information, see section 83.7 “Create b3 BACnet Devices with Factory
Settings Workflow” on page 3278.
For more information, see section 83.8 “Create Previously Used b3 BACnet Devices
Workflow” on page 3281.

Configure temporary communication parameters
In WorkStation for Projects, configure temporary communication parameters for the
servers because the final communication parameters are not known or available at
this point for any servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Deploy first batch of Automation Servers
In WorkStation for Projects, deploy the first batch of Automation Servers.
For more information, see section 6.12 “Deploying a Server” on page 260.

Important
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
For more information, see section 6.8 “Deploy” on page 248.

Configure second batch of Automation Servers
In WorkStation for Projects, continue project configuration of the second batch of
Automation Servers, creating all necessary devices, objects, alarms, trends, and
references.
For more information, see section 56.19 “Create LonWorks Device Workflow” on
page 2034.
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For more information, see section 61.7 “Create Xenta LonWorks Device Workflow”
on page 2216.
For more information, see section 73.9 “BACnet System Configuration Workflows”
on page 2564.
For more information, see section 83.7 “Create b3 BACnet Devices with Factory
Settings Workflow” on page 3278.
For more information, see section 83.8 “Create Previously Used b3 BACnet Devices
Workflow” on page 3281.

Update server communication parameters
In WorkStation for Projects, configure the final communications parameters for all
servers, including the Enterprise Server.
For more information, see section 4.4 “Updating Communication Parameters” on
page 179.

Deploy second batch of Automation Servers
In WorkStation for Projects, deploy the second batch of Automation Servers.
For more information, see section 6.12 “Deploying a Server” on page 260.

Deploy the Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.
For more information, see section 6.12 “Deploying a Server” on page 260.

Important
Ensure that you have created all Automation Servers before the deploy of the
Enterprise Server. You can only deploy to an empty Enterprise Server. Any
additional Automation Servers have to be created on the on-site server.
For more information, see section 6.8 “Deploy” on page 248.

Repair Communication Settings
Because the first batch of Automation Servers have incorrect communication
settings at this point, you need to manually repair the communication settings in the
on-site Enterprise Server.
For more information, see section 4.3 “Repairing Server Communication ” on page
178.

Note
All bindings will be synchronized as soon as all server communication are
resolved by the Enterprise Server which can take a couple of minutes.

Configure the third batch of Automation Servers
In WorkStation for Projects, continue project configuration with the last batch of
Automation Servers, creating all necessary devices, objects, alarms, trends, and
references.
For more information, see section 56.19 “Create LonWorks Device Workflow” on
page 2034.
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For more information, see section 61.7 “Create Xenta LonWorks Device Workflow”
on page 2216.
For more information, see section 73.9 “BACnet System Configuration Workflows”
on page 2564.
For more information, see section 83.7 “Create b3 BACnet Devices with Factory
Settings Workflow” on page 3278.
For more information, see section 83.8 “Create Previously Used b3 BACnet Devices
Workflow” on page 3281.

Deploy the third batch of Automation Servers
In WorkStation for Projects, deploy the third batch of Automation Servers.
For more information, see section 6.12 “Deploying a Server” on page 260.
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6.11

Variables in Project Configuration
Server
Non-retained variables cannot be edited in WorkStation for Projects, and are not
deployed.
Retained variables can be edited and are always deployed.
For more information, see section 51.67 “Variables” on page 1726.
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6.12

Deploying a Server
You deploy a server configuration to an Enterprise Server or Automation Server to
add the configuration that you have created off site.
For more information, see section 6.8 “Deploy” on page 248.

Important
It is recommended that you update the Enterprise Server communication
parameters before the deploy of the of the first Automation server, and all
Automation Server communication parameters before the deploy of the
Enterprise Server.

Caution
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
Ensure that you have created all objects and servers, with devices and objects, in
the project and deployed all Automation Servers before the deploy of the
Enterprise Server. Any additional servers, devices, and objects have to be created
on the on-site server.
For more information, see section 6.8 “Deploy” on page 248.

To deploy a server
1. In WorkStation for Projects, in the System Tree pane, select the server that
you want to deploy.
2. On the Actions menu, click Deploy.
3. Click Yes.

4. Click Close.
You can now commission or associate the devices to bring them online with the
Enterprise Server or Automation Server.
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6.13

Moving a Project Database
You move a project database from an off-site computer to a customer site
computer, when a project cannot be deployed from an off-site computer.
For more information, see section 6.8 “Deploy” on page 248.

To move a project database
1. On the source computer, in WorkStation for Projects, ensure that the project is
backed up. For more information, see the Checking the Backup Status of a
Server topic on WebHelp.
2. Close WorkStation for Projects.
3. Wait 5 minutes to ensure that the project is closed.

Note
A project closes 5 minutes after the last user has logged off or when
the Project Configuration Server Windows service is stopped in
Software Administrator.

Note
When multiple users are working with the Project Configuration
Server, make sure a stop of the Project Configuration Server
Windows service does not negatively affect your projects before
closing.
Continued on next page
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4. In Software Administrator, in the Project Configuration Server tab, copy
the path of the Projects folder.

5. In Windows Explorer, in the Address box, paste the path of the Projects
folder.

6. Move the individual project folder to a USB drive or to another appropriate
media.
Continued on next page
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7. On the target computer, in Software Administrator, in the Project
Configuration Server tab, copy the path of the Projects folder.

8. In Windows Explorer, in the Address box, paste the path of the Projects
folder.

9. Move the individual project folder from the USB drive to the Projects folder.
The project can now be opened in WorkStation for Projects on the target computer.
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Important
To see the recently moved project in WorkStation for Projects - Projects view on
the target computer, refresh the view or restart the Project Configuration Server.
For more information, see section 144.9 “Project Not Visible” on page 5479.
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6.14

Synchronization Events
The synchronization events show the deploy history, such as the time when a
deploy started and who started the deploy.
Synchronization events are generated when the following actions occurs:
• deploy command is queued
• deploy is actually started
• deploy is successful
• deploy has failed
For more information, see section 9.10 “Synchronization Event View” on page 321.
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6.15

Viewing Synchronization Events
You use the Synchronization Events view to show the WorkStation for Projects
synchronization event history and details, such as deploy.
For more information, see section 6.14 “Synchronization Events” on page 265.

To view synchronization events
1. In WorkStation for Projects, in the System Tree pane, click the
Synchronization Events View.
2. Click the Detail view button
pane.
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6.16

Project Upgrade
Upgrading a project is possible after a new version of the Project Configuration
Server has been installed in parallel to the old version.
When a new version of Project Configuration Server is installed, the database
schemas might have changed, making the old projects incompatible with the new
version of the Project Configuration Server. The projects are not upgraded
automatically when upgrading the Project Configuration Server, but they are visible
for an individual upgrade in the new version.

Important
When manually upgrading the projects, the old version of the projects will be
deleted. It is advisable to make backups or copies of the old versions before
upgrading, such as storing them in version folders on the off-site computer.
All servers that are to be synchronized with an upgraded project must also be
upgraded to the same version.
For more information, see section 6.17 “Upgrading a Project” on page 268.

6.16.1

Parallel installation of new version of Project
Configuration Server
You install the new version of Project Configuration Server parallel to the old version
in order to make the old projects visible, and to upgrade these in the new version of
Project Configuration Server. The old projects will only be visible with an overlay,
and cannot be opened.
The installation folder path can contain up to 107 characters, and only ASCII and
Unicode characters can be used.
For more information, see section 5.5 “Upgrading the Project Configuration Server”
on page 203.
For more information, see the Version Numbers and Parallel Installations topic on
WebHelp.

6.16.2

Upgrade of Project Configuration Server
The user database is copied and upgraded automatically when installing the new
version of Project Configuration Server.
For more information, see the Project Configuration Server Upgrade Workflow topic
on WebHelp.
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6.17

Upgrading a Project
Upgrading a project is possible after a new version of the Project Configuration
Server has been installed in parallel to the old version. You use this procedure to
upgrade a project.
For more information, see section 6.16 “Project Upgrade” on page 267.

To upgrade a project
1. Install the new version of Project Configuration Server. For more information,
see section 5.5 “Upgrading the Project Configuration Server” on page 203.
2. In the newest version of WorkStation for Projects, in the WorkStation for
Projects - Projects view, select the project and click the Upgrade Project
button

.

3. Click Yes.

You can now open the project and make configurations. The project will also no
longer be visible in the older version of WorkStation for Projects.
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7 Project Configuration Server Time Zone
7.1 Time and Time Zone

7.1

Time and Time Zone
A time zone is a region on the earth that has a uniform standard time, usually
referred to as the local time. Local time is the UTC time plus the current time zone
offset for the considered location. Some time zones also have an offset called DST
added during the summer period. The DST offset is typically +1 hour.

7.1.1

Network Time
Consistent date and timestamping across a network is critical for system wide
access control, security, communications, scheduling, alarms, and events. Network
time uses the NTP protocol that provides the correct current UTC time.
For more information, see the Network Time topic on WebHelp.

7.1.2

Time and Time Zone Configuration in
WorkStation
In WorkStation, all times are by default displayed in local time. This means that a
time, independent of its source, is displayed in the same time zone as the operating
system on which WorkStation is installed. By configuring the operating system time
and time zone settings, you configure how times are displayed in WorkStation. For
more information, please refer to the manufacturer’s manual for the operating
system.
For more information, see the Time and Time Zone Configuration in WorkStation
topic on WebHelp.

7.1.3

Time and Time Zone Configuration in
Enterprise Server
The Enterprise Server time and date settings are configured through the operating
system settings on which the Enterprise Server is installed. The time zone offset,
configured through the Enterprise Server, is added by Building Operation to the
UTC time. The Enterprise Server time zone settings are therefore independent of
the operating system time zone settings.
For more information, see the Time and Time Zone Configuration in Enterprise
Server topic on WebHelp.

7.1.4

Time and Time Zone Configuration in
Automation Server
To adjust the Automation Server time, time zone, and DST, you have to access the
Automation Server through a WorkStation.
For more information, see the Time and Time Zone Configuration in Automation
Server topic on WebHelp.
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7.2

Time Zone Configuration in Project
Configuration Server
To adjust the Project Configuration Server time zone and DST, you have to access
the Project Configuration Server through WorkStation for Projects.

Figure: Project Configuration Server time zone
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7.3

Changing the Time Zone of a Project
You change the time zone of a project to adjust the UTC offset.
For more information, see section 7.2 “Time Zone Configuration in Project
Configuration Server” on page 272.

To change the time zone of a project
1. In WorkStation for Projects, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the project.

3. Click Network time and time zones.
Continued on next page
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4. In the Project Date & Time view, select Predefined time zone and then
select the time zone the Project Configuration Server is located in.

5. Click Save.
If your time zone not is listed, you can create and configure a custom time zone.
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7.4

Creating a Custom Time Zone for a
Project
You use this procedure to set a custom time zone for a project.
For more information, see section 7.2 “Time Zone Configuration in Project
Configuration Server” on page 272.

To create a custom time zone for a project
1. In WorkStation for Projects, on the Tools menu, select Control Panel.
2. On the Control Panel toolbar, select the project.

3. In the Project Date & Time view, click Network time and time zones.
Continued on next page
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4. Select Custom time zone.

5. In the Description box, type a descriptive text for the time zone.
6. In the UTC Offset boxes, select the UTC offset in hours and minutes.
7. Select This custom time zone uses daylight saving time.
8. In the Time adjustment box, select the saving time in minutes.
9. Under the Start column, select the Month, Week, Date, and Time to start
using daylight saving time.
10. Under the End column, select the Month, Week, Date, and Time to start
using daylight saving time.
11. Click Save.
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8 Project Configuration Server Backup and Restore Overview
8.1 Backup and Restore Overview

8.1

Backup and Restore Overview
Backup and Restore assures that Building Operation server data can be restored
after damage or loss due to hardware or software failures, security threats, or
application testing.
Building Operation provides backup and restore capabilities that preserve both
configuration and historical data on an as-needed or periodic basis.

8.1.1

Backup
Backup is the process of copying and storing data so that the copy can be used to
restore the primary source if a data loss occurs as well as to revert to an older
version. Ideally, server backups should take place during non-business hours. In
Building Operation, you can perform backups on an individual server and its devices
or a group of servers and their devices.
Building Operation provides two backup options:
• Configuration only: Useful for new installations, Building Operation backs up
the configuration database, which preserves a snapshot of the configuration
data for a particular date and time.
• All data: Useful for existing systems, Building Operation backs up the
configuration data and historical data, which preserves a snapshot of the
configuration data for a particular date and includes a copy of the trend logs
and event logs.
For more information, see the Backup topic on WebHelp.

8.1.2

Restore
Restore is the process of restoring data to an original or former state. Using
Restore, you can revert to a previous snapshot of the server data despite any
configuration changes made since the last backup. In Building Operation, Restore is
a manual process designed to avoid the accidental overwriting of current server
data.
For more information, see the Restore topic on WebHelp.

8.1.3

BACnet Backup and Restore
BACnet Backup uses a binary file format to back up an entire device. Specifically,
BACnet Backups comprise the entire contents of the selected device, such as
associated objects, properties, bindings, historical data, and related proprietary
configuration data.
For more information, see section 75.39 “BACnet Backup and Restore” on page
2653.
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8.1.4

Archiving Overview
Archiving is the process of preserving historical data, which is comprised of
selected events and extended trend logs. For example, some facilities are required
to maintain archives to comply with government regulations. Another example is in
secure facilities where they must maintain records of who logged in or who
changed setpoints. Archiving is not a backup function because archive data cannot
be imported back into the system.
For more information, see the Archiving Overview topic on WebHelp.

8.1.5

Comparison of Backup and Restore Methods
There are two Backup and Restore methods: Building Operation and BACnet. You
can select the backup and restore method that suits your server data storage and
retrieval requirements.
For more information, see the Comparison of Backup and Restore Methods topic
on WebHelp.
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8.2

Project Backup and Restore
Backup and Restore assures that a project database can be restored after damage
or loss due to hardware or software failures, security threats, or application testing.
Project Configuration Server provides backup and restore capabilities that preserve
the configuration data of a project. Features are the same as for Building Operation
Backup and Restore with a few exceptions:
• You cannot schedule backups.
• You cannot perform multi-server backups.
• You cannot backup alarms.
• You cannot automatically purge backup sets.

8.2.1

Project Backup
Backup is the process of copying and storing data so that the copy can be used to
restore the primary source if a data loss occurs as well as to revert to an older
version. Ideally, server backups should take place during non-business hours.
For more information, see section 8.3 “Project Backup” on page 282.

8.2.2

Project Restore
Restore is the process of restoring data to an original or former state. Using
Restore, you can revert back to a previous snapshot of the project data despite any
configuration changes made since the last backup. In Project Configuration Server,
restore is designed to be a manual rather than an automatic process to avoid the
accidental overwriting of current server data. For convenience, only the backup files
that apply to the selected server are displayed.
For more information, see section 8.11 “Project Restore” on page 292.
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8.3

Project Backup
Backup is the process of copying and storing data so that the copy can be used to
restore the primary source if a data loss occurs as well as to revert to an older
version. Ideally, server backups should take place during non-business hours.
You can select the type of data to back up:
• Configuration only: Project Configuration Server backs up the project
configuration database, which includes points, values, alarm objects, trend
objects, programs, graphics, and custom object type data.
• All data: Project Configuration Server backs up the project configuration
database and the historical database, which include synchronization events.

Note
The system generates default backup names that are a combination of the
project name and the server date, and time. For ease of use, manual backups
include the local time of the Project Configuration Server, such as University X
Project_20130823-020127. The server date stamp that is recorded within the
backup set is based on the local time zone of Project Configuration Server.

Backup Set Renaming
When you create a backup, the system initially names the backup set by combining
the server name with the localized date and time of the computer running
WorkStation for Projects. However, you can change this initial (default) name prior
to generating the backup. If some backup sets are given identical names by
mistake, the duplicate backup sets (restore points) display in the Restore Options
dialog box.

Backup Comments
When you create a manual backup, you can also add a comment up to 255
characters to identify a particular backup set. Once the backup completes, the
system displays these comments as ToolTips in the Restore Options dialog box.
For example, you can add a comment, After Deploy, to backups of deployed
projects. For more information, see the Backup Options Dialog Box topic on
WebHelp.

8.3.1

Project Configuration Server Backup Sets
Backup sets are compressed backup files used for restoring data. Building
Operation stores the local backup set for a Project Configuration Server, Enterprise
Server or Automation Server under a Local folder in the Backup sets folder.
For more information, see section 8.4 “Project Configuration Server Backup Sets”
on page 284.

8.3.2

Project Configuration Server Backup Status
You can check the current backup status of a server from the Backup and Restore
Manager. Backup Status displays the statuses of a server: Ready, Backing up, or
Backup succeeded.
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For more information, see section 8.6 “Project Configuration Backup Status” on
page 286.
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8.4 Project Configuration Server Backup Sets

8.4

Project Configuration Server Backup
Sets
Backup sets are compressed backup files used for restoring data. Building
Operation stores the local backup set for a Project Configuration Server, Enterprise
Server or Automation Server under a Local folder in the Backup sets folder.

Figure: Backup sets in the Local folder

Server Rename
Building Operation associates each backup set with a particular server name.
Therefore, you should not rename a Building Operation server unless absolutely
necessary. If you do rename a server, the previous backup sets do not display in
the Restore Options dialog box. You can view all the backup sets that are stored
locally on a Project Configuration Server. For more information, see Locating the
Local Backup Path on the Project Configuration Server

Tip
Going forward, you must create new backups for the renamed server.

8.4.1

Backup Set Storage and Protection
The Project Configuration Server stores backup sets in the local directory. By
design, the average user may not easily locate these backup directories using a
Windows-based file system. After saving a backup set, you can also copy the file to
another backup storage location.
For more information, see section 8.5 “Backup Set Storage and Protection” on
page 285.
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8.5

Backup Set Storage and Protection
The Project Configuration Server stores backup sets in the local directory. By
design, the average user may not easily locate these backup directories using a
Windows-based file system. After saving a backup set, you can also copy the file to
another backup storage location.
Saving a backup set to a storage location is a two-step process: saving the backup
set and then relocating the file to another location. First, you save the backup set to
the Project Configuration Server. Second, you copy the backup set from Project
Configuration Server to another storage location on your network, such as a USB
drive.

Figure: Copy backup set from a Project Configuration Server to a network drive

Backup Set Removal
You can remove backup sets in WorkStation for Projects. For more information, see
section 8.10 “Deleting a Backup Set from a Project” on page 291.
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8.6

Project Configuration Backup Status
You can check the current backup status of a server from the Backup and Restore
Manager. Backup Status displays the statuses of a server: Ready, Backing up, or
Backup succeeded.
For more information, see section 9.18 “Backup and Restore Manager on the
Project Configuration Server” on page 330.

Figure: Backup sets in the Local folder
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8.7

Checking the Backup Status of a Project
You check the backup status of a project to verify that a backup is complete and to
note the date and time of the last backup.
For more information, see section 8.6 “Project Configuration Backup Status” on
page 286.

To check the backup status of a project
1. In WorkStation for Projects, on the Tools menu, select Control Panel.
2. On the Control Panel toolbar, select the project.

3. Click Backup and Restore Manager.
4. View the current project status or date and time of the last successful backup.
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8.8

Backing Up a Project
You back up a project to easily restore project data if something unexpected
happens.
For more information, see section 8.3 “Project Backup” on page 282.

To back up a project
1. In WorkStation for Projects, in the System Tree pane, right-click the project
and then click Backup.
2. In the Backup set name prefix box, type some text at the beginning of the
file name that helps identify the backup set, such as Daily.
3. In the Backup set name suffix box, type some text at the end of the file
name that helps identify the backup set. Date and Time are inserted by
default.
4. In the Include column, manually select the projects that you want to include
in the backup, or click the Select All button
projects in the backup.

to include all the listed

5. In the Backup content column, select the type of data you want to back up for
each server:
• Configuration only: Project Configuration Server backs up the project
configuration database, which includes points, values, alarm objects,
trend objects, programs, graphics, and custom object type data.
• All data: Project Configuration Server backs up the project configuration
database and the historical database, which include synchronization
events.
Continued on next page
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6. In the Backup set description column, type a brief description up to 255
characters to help identify the content of the backup.

Note
The Synchronize Comment button, Synchronize Content
button, and the Synchronize All button are not activated for
WorkStation for Projects.
7. Click Backup.
8. Verify that each backup succeeded and click Close.

After you backed up a project, you can restore the project data at any time.
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8.9

Locating the Local Backup Path on the
Project Configuration Server
You locate the local backup folder on the Project Configuration Server to view the
stored backup sets. The system displays the valid backup sets stored in this folder
in the Restore Options dialog box.
For more information, see section 8.5 “Backup Set Storage and Protection” on
page 285.

To locate a local backup path on the Project Configuration
Server
1. In WorkStation for Projects, open the project.
2. On the Tools menu, select Control Panel.
3. In the Control Panel toolbar, select the project.
4. In the Backup and archiving area, select Backup and Restore
Manager.
5. In the Backup sets path box, view the local backup path on the server.
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8.10

Deleting a Backup Set from a Project
You delete a backup set from the Local folder of a project when you no longer need
the backup set.
For more information, see section 8.4 “Project Configuration Server Backup Sets”
on page 284.

To delete a backup set from a project
1. In WorkStation for Projects, open the project.
2. On the Tools menu, click Control Panel.
3. In the Control Panel, click Backup Sets.
4. Open the Local folder.
5. In the Local folder view, right-click on the backup set and click Delete.
6. Click Yes.
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8.11

Project Restore
Restore is the process of restoring data to an original or former state. Using
Restore, you can revert back to a previous snapshot of the project data despite any
configuration changes made since the last backup. In Project Configuration Server,
restore is designed to be a manual rather than an automatic process to avoid the
accidental overwriting of current server data. For convenience, only the backup files
that apply to the selected server are displayed.

8.11.1

Restored Data
Depending on what is contained in the backup file, you can restore different types
of data.
• Configuration only: Project Configuration Server restores the project
configuration database, which includes points, values, alarm objects, trend
objects, programs, graphics, and custom object type data.
• All data: Project Configuration Server restores the project configuration
database and the historical database, which include synchronization events.
For more information, see section 8.12 “Restored Data” on page 293.
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8.12

Restored Data
Depending on what is contained in the backup file, you can restore different types
of data.
• Configuration only: Project Configuration Server restores the project
configuration database, which includes points, values, alarm objects, trend
objects, programs, graphics, and custom object type data.
• All data: Project Configuration Server restores the project configuration
database and the historical database, which include synchronization events.
Table: Types of Data and Content
Types of Data

Content

Historical

Event logs are not stored in Project Configuration Server.

Configuration

Includes points, values, alarm objects, trend objects, programs,
graphics, and custom object type data stored on a server.
Includes the configuration properties of variables, such as Unit.
Depending on the retain level of the variable; some configuration
properties like Value are also restored.

The server name is part of the restore data. Therefore, if you rename a server after a
backup, a restore process will revert back to the previous server name.

Impact on Configuration Values and Variables
When you back up a server specifying either Configuration only or All data, Project
Configuration Server includes all the configuration values that are specified for the
server’s objects. If you restore the server, Project Configuration Server restores
these configuration values, which can overwrite any changes made since the last
backup.
Project Configuration Server does not include most variable settings in a backup.
Consequently, Project Configuration Server cannot restore these variable settings.
However, the system does back up the cold-start retained variables.
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8.13

Restoring a Project
You restore a project to recover project data from a backup set.
For more information, see section 8.11 “Project Restore” on page 292.

To restore a project
1. In WorkStation for Projects, open the project.
2. In the System Tree pane, right-click the project and then select Restore.
3. In the Available restore points list, select a backup set and click Restore.

4. Click Yes.
5. Click Close.

Continued on next page
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6. Click Close.

7. Log on to Project Configuration Server through WorkStation for Projects and
open the project.
The project is restored to the condition of the backup set.
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9.1 Software Administrator – Project Configuration Server View

9.1

Software Administrator – Project
Configuration Server View
Use the Project Configuration Server view to start and stop the Project
Configuration Server service and configure the ports of the Project
Configuration Server.

Figure: Project Configuration Server view

Table: Project Configuration Server View
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Component

Description

Status

Displays the current status of the Project
Configuration Server Windows service.

Start Service

Click to start the Project Configuration
Server.

Stop Service

Click to stop the Project Configuration
Server. Check in Windows Task Manager to
ensure all projects have shut down.

HTTP Port

Type the port number that the Project
Configuration Server listens to when
communicating through the Hypertext
Transfer Protocol.

HTTPS Port

Type the port number that the Project
Configuration Server listens to when
communicating through the Hypertext
Transfer Protocol Secure.
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Continued
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Component

Description

TCP Port

Type the port number that the Project
Configuration Server listens to when
communicating through the Transmitting
Control Protocol.

Path

Displays the path to the folder where the
Project Configuration Server projects are
stored.

04-16006-04-en, March 2015

9 WorkStation for Projects User Interface
9.2 Building Operation WorkStation for Projects Window

9.2

Building Operation WorkStation for
Projects Window
Use the Building Operation WorkStation for Projects window to log on to
WorkStation for Projects.

Figure: Building Operation WorkStation for projects window

Table: Building Operation WorkStation for Projects Window
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Component

Description

User name

Type the Project Configuration Server
user account name. For more information,
see section 5.16 “WorkStation for Projects
User Account Management” on page 224.

Password

Type the password.

Server

Select the hypertext transfer protocol you
want to use and enter the IP address or DNS
name of Project Configuration Server.

Remember me on this computer

Select to save the entered information. The
information is automatically filled in the next
time you log on. For more information, see
the Turning off Remember Me On This
Computer topic on WebHelp.
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Component

Description

Log on

Click to log on to WorkStation for Projects.
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9.3

WorkStation for Projects View
Use WorkStation for Projects view to manage your Building Operation projects
and WorkStation for Projects domain users.

Figure: WorkStation for Projects view

Table: WorkStation for Projects view
Component

Description
WorkStation for Projects toolbar. Use
the toolbar to log off, change password, and
open the Projects and Users views. For
more information, see section 9.6
“WorkStation for Projects Manager Toolbar”
on page 307.
Projects view. Use the Projects view to
manage the projects. For more information,
see section 9.4 “WorkStation for Projects –
Projects View” on page 305.
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Component

Description
Users view. Use the Users view to manage
the WorkStation for Projects domain users.
For more information, see section 9.5
“WorkStation for Projects – Users View” on
page 306.
Status bar. Displays the server, user
account, and domain you are connected to.
For more information, see the Status Bar
topic on WebHelp.
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9.4

WorkStation for Projects – Projects
View
Use the WorkStation for Projects - Projects view to manage your off-site
Building Operation projects.

Figure: Project Configuration Server Projects view

Table: Projects view
Component

Description
Open. Click to open a selected project.
New. Click to create a new project.
Delete. Click to delete a selected project.
Upgrade Project. Click to upgrade a
selected upgradable project.
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9.5

WorkStation for Projects – Users View
Use the WorkStation for Projects - Users view to manage user accounts.

Figure: Project Configuration Server Users view

Table: WorkStation for Projects - Users View
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Component

Description

Quick filter

Use the Quick filter to filter user accounts in
the Users list and the Show/hide property
grid button to show the properties for a
selected user account.

Name

Displays the name of the user account.

Description

Displays the description of the user account.
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9.6

WorkStation for Projects Manager
Toolbar
Use the WorkStation for Projects toolbar to log off, change password, and to
open the WorkStation for Projects - Projects and WorkStation for
Projects -Users views.
Table: WorkStation for Projects Toolbar
Button

Description
Log off
Click to log off the WorkStation for Projects.
Project Configuration Manager...
Click to open the WorkStation for
Projects - Projects view. For more
information, see section 9.4 “WorkStation for
Projects – Projects View” on page 305.
Project Configuration Server Domain
Users...
Click to open the WorkStation for
Projects - Users view. For more
information, see section 9.5 “WorkStation for
Projects – Users View” on page 306.
Change password
Click to change the password of the user
account that you are currently using. For
more information, see the Change Password
Dialog Box topic on WebHelp.
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9.7

WorkStation for Projects Toolbar
Use the buttons on the WorkStation for Projects toolbar for easy access to
commands you use frequently.

Figure: WorkSation for Projects toolbar
Button

Description
Close Project
Click to close an open project.
Workspace
Click to open the Workspace menu where
you can view the workspace used. For more
information, see the List View topic on
WebHelp.
Control Panel
Click to open the Control Panel where you
get access to some of the most used
administration functions in Building
Operation, such as alarms, domains, user
accounts, backup and archiving, and
engineering. For more information, see the
Control Panel View topic on WebHelp.
New
Click to open the New submenu where you
create new objects. For more information,
see the File Menu - New Submenu topic on
WebHelp.
Open in New
Click to open the selected object in a new
window in the work area.
Save
Click to save changes.
Cut
Click to cut the selected objects. The objects
are placed on the clipboard.
Copy
Click to copy the selected objects. The
objects are placed on the clipboard.
Paste
Click to paste a copied or cut object.
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Continued
Button

Description
Delete
Click to open the Confirm delete dialog
box where you delete the selected object.
For more information, see the Confirm Delete
Dialog topic on WebHelp.
Cancel
Click to cancel the latest command.
Refresh
Click to refresh the selected object or
workspace.
Print
Click to print the selected object.
Help
Click to open Building Operation help.
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9.8

File Menu
Use the File menu to log off from the system, import and export information, print,
and create new objects.

Figure: The File menu
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Command

Description

New

Click to open the New submenu where you
create new objects. For more information,
see the File Menu - New Submenu topic on
WebHelp.

Open

Click to open an object.

Open in new window

Click to open the selected object in a new
window in the work area.

Save

Click to save changes.

Log Off

Click to log off WorkStation. Your session
ends and you are sent to the Welcome
Window where you can log in to Building
Operation with the same or another user
account. For more information, see the
Building Operation WorkStation Window
topic on WebHelp.

Change Password

Click to open the Change Password
dialog box where you change your
password. For more information, see the
Change Password Dialog Box topic on
WebHelp.

Close Project

Click to close an open project in
WorkStation for Projects.
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Command

Description

Export

Click to open the Save As dialog box where
you export a solution to a file location on the
WorkStation file system.
The Export preview dialog box displays
when there are objects in the solution that
Building Operation cannot export from the
server. Use this dialog box to view multiple
objects that the system can and cannot
export from the server. For more information,
see section 19.2 “Export Preview Dialog
Box” on page 606.

Import

Click to open the Open dialog box where
you select a previously exported solution
that you want to import. After you select a
file, the Import dialog box displays.
The Import dialog box provides a summary
of information about the imported file and a
preview of the names and file structure of the
objects to be imported. For more
information, see section 19.4 “Import Dialog
Box” on page 608.
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LonWorks import

Click to open the Import - LonWorks
submenu where you import resource files
(DRF kits) or device templates (XIF files).

Print Preview

Click to preview a printout before printing.

Print

Click to print the selected object.

Print Setup

Click to adjust the print settings.

Properties

Click to open the Properties dialog box
where you inspect or change properties for
the selected object. For more information,
see the General Properties – Basic Tab topic
on WebHelp.

Shortcut Properties

Displays the Properties dialog box for the
currently selected shortcut.

Exit

Click to quit WorkStation.
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9.9

Actions Menu
Use the Actions menu to carry out commands for objects selected in the System
Tree pane or a List View.

Figure: Action menu when a Function Block program is selected.

Table: Actions Menu
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Command

Description

Actions

Use the Actions submenu to create manual
archives on an Enterprise Server. For more
information, see the Actions Menu – Actions
Submenu topic on WebHelp.

Activation

Use the Activation submenu to enable,
disable, force transfer, or clear a trend log.
For more information, see the Actions
Menu – Activation Submenu topic on
WebHelp.

Advanced

Use the Advanced submenu to repair
references or communication after a server
has been offline. For more information, see
the Actions Menu – Advanced Submenu
topic on WebHelp.

Advanced commands

Use the Advanced commands submenu
to execute commands for a device. For
more information, see section 67.2 “Actions
Menu – Advanced Commands Submenu”
on page 2333.

Alarm enable

Click to enable the Sigma Alarm.

Alarm inhibit

Click to inhibit the Sigma Alarm.

Alarm Refresh

Transfers all alarms buffered in the Xenta
device to the server. For more information,
see section 62.22 “Alarms for Xenta
LonWorks Devices” on page 2257.

b3 devices

Use the b3 devices submenu to
automatically assign the node IDs and initiate
communication with devices on the MS/TP
network, or to update the firmware. For
more information, see section 85.4 “b3
BACnet Device Properties – Advanced Tab”
on page 3463.
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Command

Description

Backup

Click to open the Backup Options dialog
box where you back up the selected server.
For more information, see the Backup
Options Dialog Box topic on WebHelp.

Clear Status

Clears the diagnostic data for the device or
local node. For more information, see
section 60.13 “LonWorks Device
Properties – Diagnostics Tab” on page
2152.

Cold start

Restarts the device and clears the RAM
memory. For more information, see section
62.26 “Xenta LonWorks Device Restart” on
page 2266.

Cold start device

Cold starts a hosted BACnet device. For
more information, see section 75.36 “Device
Cold Start and Warm Start” on page 2650.

Commission

Opens the Commission Device wizard,
where you download settings and
parameters to the device.
For more information, see section 60.35
“Neuron ID and Commission Settings Page ”
on page 2184.
For more information, see section 85.2
“Actions Menu – Device Submenu” on page
3458.
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Create Reports From WebReports

Click to restore the Reports folder in the
System Tree. For more information, see the
Reports in WorkStation and the WebReports
Web Site topic on WebHelp.

Data Import

Click to import the MicroNet import file. For
more information, see section 104.13 “Data
Import” on page 4583.

Data import

Click to import Sigma data from the Sigma
server PC. For more information, see section
109.5 “Sigma Data Import” on page 4809.

Decommission

Deactivates the device in the network.

Deploy

Starts a deploy of a server configuration to a
server from Project Configuration Server. For
more information, see section 6.8 “Deploy”
on page 248.

Device

Use the Device submenu where you
manage your devices. For more information,
see section 85.2 “Actions Menu – Device
Submenu” on page 3458.

Technical
315

9 WorkStation for Projects User Interface
9.9 Actions Menu

Continued
Command

Description

Device communication control

Controls the device communications for
BACnet devices and the BACnet Interface,
and is primarily used for diagnostic
purposes.
For more information, see section 75.21
“Device Communication and Diagnostics” on
page 2631.
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Discover Devices

Identifies the devices and objects on a
particular BACnet network, or an entire
BACnet internetwork. For more information,
see section 75.2 “BACnet Device Discovery”
on page 2606.

Download

Downloads applications or BACnet networks
from the Building Operation server database.
For more information, see section 121.8
“EcoStruxure Web Service Alarm Item” on
page 5131.

Download device configuration

Downloads the parameters from the Building
Operation server database to the device.

Edit

Opens the object for editing in the
appropriate editor.

Edit Alarm

Click to display the properties for a Sigma
Alarm.

Edit Alarm 1

Click to display the properties for Sigma
Alarm 1.

Edit Alarm 2

Click to display the properties for Sigma
Alarm 2.

Edit Assignment Condition

Click to open the Select conditions dialog
box, where you define when to send the
assignment. For more information, see the
Select Conditions Dialog Box – Alarm Filter
Properties topic on WebHelp.

Edit bindings

Click to open the Edit Bindings dialog box.
For more information, see section 17.1
“Bindings View” on page 523.

Edit cooling linear

Click to display the properties for a Sigma
linear cooling optimizer.

Edit cooling logarithmic

Click to display the properties for a Sigma
logarithmic cooling optimizer.

Edit heating linear

Click to display the properties for a Sigma
linear heating optimizer.

Edit heating logarithmic

Click to display the properties for a Sigma
logarithmic heating optimizer.
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Command

Description

Edit Event Filter

Click to open the Select conditions dialog
box, where you edit an event filter to an
object. For more information, see the Select
Conditions Dialog Box – Events Filter
Properties topic on WebHelp.

Edit in spreadsheet

Click to open Edit in spreadsheet where
you can quickly build and reuse a database
of I/O modules on the I/O bus. For more
information, see section 126.4 “Copying
from MS Excel to Spreadsheet View” on
page 5312.

Edit Notification Condition

Click to open the Select conditions dialog
box, where you define when to send the
alarm notification. For more information, see
the Select Conditions Dialog Box – Alarm
Filter Properties topic on WebHelp.

Edit secondary input

Click to display the properties for a
secondary input to a Sigma Setpoint Adjust
object.

Edit schedule

Click to display the schedule editor or
calendar editor (as relevant).

Edit Standard Alarm View filter

Click to open the Select conditions dialog
box, where you sort the information in an
Alarms pane. For more information, see the
Select Conditions Dialog Box – Alarm Filter
Properties topic on WebHelp.

Edit Sum Alarm Condition

Click to open the Select conditions dialog
box, where you configure the conditions that
determine which alarms the sum alarm
surveys. For more information, see the
Select Conditions Dialog Box – Alarm Filter
Properties topic on WebHelp.

Edit the style of associated events

Click to open the Event styles dialog box
where you style the appearance of a specific
event in the Events pane. For more
information, see the Event Styles Dialog Box
topic on WebHelp.

Edit time extension

Click to display the properties for a Sigma
Time Extension.

Host EWS Objects

Click to host a remote EcoStruxure Web
Service object. For more information, see
section 121.7 “EcoStruxure Web Service
Client” on page 5126.

Hours cancel limit 1

Click to prevent the generation of the next
totalization alarm for Limit 1 (like precancel,
except that you cannot later reinstate the
generation of the next Limit 1 totalization
alarm).
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Command

Description

Hours cancel limit 2

Click to prevent the generation of the next
totalization alarm for Limit 2 (like precancel,
except that you cannot later reinstate the
generation of the next Limit 2 totalization
alarm).

Hours cancel limit 3

Click to prevent the generation of the next
totalization alarm for Limit 3 (like precancel,
except that you cannot later reinstate the
generation of the next Limit 3 totalization
alarm).

Hours precancel limit 1

Click to prevent the generation of the next
totalization alarm for Limit 1.

Hours precancel limit 2

Click to prevent the generation of the next
totalization alarm for Limit 2.

Hours precancel limit 3

Click to prevent the generation of the next
totalization alarm for Limit 3.

Hours reinstate limit 1

Click to reverse the effects of clicking Hours
precancel limit 1.

Hours reinstate limit 2

Click to reverse the effects of clicking Hours
precancel limit 2.

Hours reinstate limit 3

Click to reverse the effects of clicking Hours
precancel limit 3.

IO wiring list

Click to open the IO Wiring List dialog box
where you print an I/O wiring list for the I/O
bus that describes which I/O points are
associated with each I/O module. For more
information, see section 22.22 “Print I/O
Wiring List Dialog Box” on page 757.

Launch VisiSat

Click to start VisiSat. For more information,
see section 104.11 “VisiSat Programming”
on page 4579.

Learn BDT Table

Click to open the Learn BDT Table dialog
box where you learn the BACnet Broadcast
Device Table from one BBMD to another
BBMD. For more information, see section
75.35 “Learning a BBMD Configuration from
one BBMD to Another” on page 2649.

Learn LCM

Learns the blocks in the LCM. For more
information, see section 95.9 “Learn LCM
Blocks” on page 3772.

LCM sync date time

Sends the server's date and time to each
LCM device on the LCM network. For more
information, see section 96.5 “NETWORK
8000 LCMs” on page 3799.
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Command

Description

Manage IO bus

Click to open the I/O Module
Management Tool dialog box where you
assign and unassign logical I/O modules,
correct the position of a module type, or
correct a module mismatch. For more
information, see section 22.2 “I/O Module
Management Tool Dialog Box” on page 718.

Manage Meter

Click to open the Manage Meter dialog
box where you manage the settings of a new
meter. For more information, see the
Manage Replacement of Meter Dialog Box
topic on WebHelp.

MNL

Use the MNL submenu to open WorkPlace
Tech Monitor, to monitor or perform a task
on an MNL LonWorks device. For more
information, see section 72.47 “Actions
Menu – MNL Submenu” on page 2545.

Modification

Use the Modification submenu to modify a
trend log. For more information, see the
Actions Menu – Modification Submenu topic
on WebHelp.

Print IO module labels

Click to open the Print IO Module Labels
dialog box where you print the placard of the
I/O module. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Proxy Update

Reads the configuration properties of the
block in the LCM. For more information, see
section 96.5 “NETWORK 8000 LCMs” on
page 3799.

Pulse start

Click to generate a Digital Output pulse
lasting for the duration of the rising edge
setting in Sigma.

Pulse stop

Click to generate a Digital Output pulse
lasting for the duration of the falling edge
setting in Sigma.

Refresh device identification

Click to refresh the basic device identification
displayed in the properties of a Modbus
device. For more information, see section
91.1 “Modbus Devices” on page 3647.

Removed from Network

Removes an offline device object for a
physical device that was previously removed
from the network.

Reset

Resets the block in the LCM. For more
information, see section 96.5 “NETWORK
8000 LCMs” on page 3799.
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Command

Description

Reset IO module

Resets the I/O module with its old
configuration. For more information, see the
I/O Modules topic on WebHelp.

Restore

Click to open the Restore Options dialog
box where you restore the selected server,
or upload the configurations properties of an
external BACnet device to a device proxy.

Retrieve logged values

Click to retrieve logged values from the
relevant Sigma controllers.

Revert to application value

Click to use an NCI value from the device
application when downloading the device
configuration (NCI values) to an MNL
LonWorks device. For more information, see
section 71.8 “NCI Values” on page 2434.

Save To

Save the selected backup to another
location in the Building Operation server
database. For more information, see the
Backup Sets View topic on WebHelp.

Send log set

Click to send the selected log set to the
relevant Sigma controller.

Send log sets

Click to send all log sets to the relevant
Sigma controllers.

Send ServicePin

Sends service pin for the local node, so
other devices can identify the local node on
the network. For more information, see
section 62.3 “Discovering a Xenta Device”
on page 2233.

Send time sync now

Manually forces the server to send out time
synch notifications to all the configured
recipients. For more information, see section
75.12 “Manually Triggering the Time
Recipients List of a Server” on page 2622.

Sigma diagnostics

Click to open the Sigma diagnostics
submenu, where you can retime a controller,
set a controller online, or select diagnostics
text reports. For more information, see
section 110.3 “Controller Diagnostics” on
page 4836.

Teach

Sends a selected BBMD configuration to all
other BBMDs in the system. For more
information, see section 75.34 “Teaching a
BBMD Configuration to Other BBMDs ” on
page 2648.

Temporary off

Click to override a Sigma Time Schedule
object until the next scheduled ON time.
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Command

Description

Temporary on

Click to override a Sigma Time Schedule
object until the next scheduled OFF time.

Time sync

Synchronizes the time between a hosted
device and the local server. For more
information, see section 81.11 “BACnet
Device – Time Synchronization Recipients
Tab” on page 2985.

Update IO module firmware

Click to open the Update IO Module
Firmware dialog box where you upgrade
the firmware for I/O modules. For more
information, see section 22.40 “Update I/O
Module Firmware Dialog Box” on page 786.

Upload

Uploads the application from the device to
the Building Operation server database.

Upload device configuration

Uploads the parameters from the device to
the Building Operation server database.

Update Object list

Updates the list of BACnet device objects.

Warm start

Restarts a device without clearing the RAM
memory. For more information, see section
62.26 “Xenta LonWorks Device Restart” on
page 2266.

Warm start device

Restarts a BACnet hosted device without
clearing all configuration data, run-time data,
and the values of objects. For more
information, see section 75.36 “Device Cold
Start and Warm Start” on page 2650.

View

Use the View menu to open a report, trend
chart, trend log list, or add a value to the
Watch pane. For more information, see the
Actions Menu – View Submenu topic on
WebHelp.

View Action Notes

Click to open an Events pane that displays
all events where an action note has been
added to the alarm. For more information,
see the Events Pane and Event View topic
on WebHelp.

View Cause Notes

Click to open an Events pane that displays
all events where a cause note has been
added to the alarm. For more information,
see the Events Pane and Event View topic
on WebHelp.

View Checklists

Click to open an Events pane that displays
all events where a check list has been added
to the alarm. For more information, see the
Events Pane and Event View topic on
WebHelp.
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Command

Description

View Comments

Click to open an Events pane that displays
all events where a comment has been added
to the alarm. For more information, see the
Events Pane and Event View topic on
WebHelp.

View History

Click to open an Events pane where all
history events of an alarm are displayed. For
more information, see the Events Pane and
Event View topic on WebHelp.

Wink

Generates a response from the device, such
as flashing the power LED, so you can
identify the physical device. The device must
be connected, have its ID set, and support
the Wink function.
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9.10

Synchronization Event View
Use the Synchronization Event view to view any deploy carried out between
Project Configuration Server and an Enterprise Server or Automation Server.

Figure: Synchronization Event View

Table: Synchronization Event View
Number

Description
Use the Synchronization Event View toolbar
to stop or resume showing new
synchronization events. For more
information, see the Events Pane and Event
View Toolbar topic on WebHelp.
Use the Synchronization Event View
columns to sort, hide, or show information
about the synchronization events. For more
information, see the Add/Remove Columns
Dialog Box topic on WebHelp.
Use the Detail view to display all information
about a selected synchronization event.

04-16006-04-en, March 2015

Technical
323

9 WorkStation for Projects User Interface
9.11 Create Object Wizard – Naming the Object Page
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Create Object Wizard – Naming the
Object Page
Use the Naming the object page to set the basic properties for the object. For
objects with several types, you also select the object type.

Figure: Naming the object page

Table: Naming the Object Page

Technical
324

Component

Description

(Object type list)

Select the type of object you want to create.
For more information, see the Object Types
topic on WebHelp.

Name

Type the name of the object. For more
information, see the Object Names topic on
WebHelp.

Prefix

Type a label that is added in front of the
object name. For more information, see the
Suffix and Prefix topic on WebHelp.

Suffix

Type a label that is added after the object
name. For more information, see the Suffix
and Prefix topic on WebHelp.

Location

Enter the path to the location in the System
Tree where you want to create the object. By
default, the path to the selected folder or
object in the System Tree is displayed.

Description

Type a description that explains what the
object is used for.
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9.12

Create Object Wizard – Server
Information Page
Use the Server Information page to configure the server communication
parameters in a project.

Figure: Server Information page

Table: Server Information Page
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Property

Description

Server

Displays the name of the server.

DNS/IP address

Type the IP address or fully qualified domain
name of the server.

HTTP port

Enter the HTTP port number.

HTTPS port

Enter the HTTPS port number.

TCP port

Enter the TCP port number.

User name

Type the User name that is to be used as
custom logon (authentication) when
deploying or learning the server. For more
information, see the Compare and
Synchronize View topic on WebHelp.

Password

Type the Password.

Confirm Password

Type the password again.

Communication Protocol

Select which protocol to use for
communication in the target system.
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9.13

Create Report Wizard – Select Report
Pack Page
Use the Select Report Pack page to select a report pack that you want to create in
WorkStation for Projects.

Figure: Select Report Pack page
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Component

Description

Select Report Pack

Select the report pack of reports that you
want to create in WorkStation for Projects.
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9.14

Confirm Deploy Dialog Box
Use the Confirm Deploy dialog box to commit to the deploy or not.

Figure: Confirm Deploy dialog box
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Component

Description

Yes

Click to deploy. For more information, see
section 6.8 “Deploy” on page 248.

No

Click to cancel.
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9.15

Progress View – Advanced
The Advanced Progress View is displayed when you download and commission
objects in field devices in, for example LonWorks and BACnet, or when you deploy
a server in Project Configuration Server.
The Progress view displays information about time-consuming operations between
WorkStation, WorkStation for Projects and a Building Operation server. You can
also see detailed information about what went wrong if the operation fails.

Figure: Advanced Progress view when an operation failed.

9.15.1

Detail View
The detailed information in the Progress view helps you to identify problems during
any operation.
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Figure: Detailed information is displayed in the Error dialog.
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9.16

Operation Details Dialog Box
The Operating details dialog box displays more detailed information on what
went wrong during the operation.

Figure: Failing Progress - Progress Manager dialog box

Table: Failing Progress - Progress Manager dialog box
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Component

Description

Path

Displays the path to the object the operation
is performed on.

Type

Displays the object type.

Operation details

Dislays the time and text for the operation.

Error details

Click to open the Error dialog box to get
more error details. For more information, see
the Error Details – Progress View topic on
WebHelp.

Copy to clipboard

Click to copy the information to the
clipboard.
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9.17

Project Control Panel View
Use the Project Control Panel view to manage time zone settings and view the
backup sets and backup statuses of your project.

Figure: Project Control Panel view

Table: Project Control Panel view
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Component

Description

Network time and time zones

Click to configure the time zone for your
project. For more information, see section
7.2 “Time Zone Configuration in Project
Configuration Server” on page 272.

Backup Sets

Click to view the backup sets for your
project.

Backup and Restore Manager

Click to open the Backup and Restore
manager, where you can view backup status
and time of last backup. For more
information, see section 9.18 “Backup and
Restore Manager on the Project
Configuration Server” on page 330.

LNS Plug-in Registration

Click to open LNS Plug-in Registration. For
more information, see section 56.26 “LNS
Plug-ins” on page 2047.
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9.18

Backup and Restore Manager on the
Project Configuration Server
Use the Backup and Restore Manager to supervise the backup settings in
Project Configuration Server. You can also open this view in any server to view
current and past backup information.

Figure: Backup and Restore Manager on Project Configuration Server

Table: Project Configuration Server Backup and Restore Manager
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Component

Description

Status

Displays the current backup status, such as
backing up.

Last backup

Displays the date and time of the last
successful backup.

Backup sets path

Displays the path to where the Project
Configuration Server stores Project
Configuration Server backups.
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9.19

WorkStation for Projects - Servers View
Use the WorkStation for Projects - Servers view to edit the communication
parameters of a server in your project.

Figure: Servers view

Table: Servers View
Component

Description

Protocol

Select the protocol to use when deploy of
project to server. For more information, see
section 6.8 “Deploy” on page 248.

Server

Displays a list of servers in the project.
Show/Hide property grid
Click to open the communications properties
for the server.
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DNS/IP address

Type the IP address or fully qualified domain
name of the server.

HTTP port

Enter the HTTP port number.

HTTPS port

Enter the HTTPS port number.

TCP port

Enter the TCP port number.

User name

Type the User name that is to be used
when synchronizing project with server.

Password

Type the password.

Confirm password

Type the password again.
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9.20

Project Server – Date & Time View
Use the Project Server – Date & Time view to configure the Project
Configuration Server time zone.

Figure: Project date & time view

Table: Project Date & Time View
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Component

Description

Predefined time zone

Select the time zone the server belongs to.

Custom time zone

Select to manually define the server time
zone.

Description

Type a description or name for the
customized time zone DST settings.

UTC offset

Select the time difference the time zone has
from UTC in the hours and minutes boxes.

This custom time zone uses daylight
saving time

Select to enable the daylight saving time
settings for the custom time zone.

Time adjustment

Select the time adjustment, in minutes, for
the daylight saving time.

Month - Start

Select the month that daylight saving time
starts.
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Component

Description

Week - Start

Select the week of the month that daylight
saving time starts.

Day - Start

Select the day of the week that daylight
saving time starts.

Time - Start

Select the time that daylight saving time
starts.

Month - End

Select the month that daylight saving time
ends.

Week - End

Select the week that daylight saving time
ends.

Day - End

Select the day of the week that daylight
saving time ends.

Time- End

Select the time that daylight saving time
ends.
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9.21

Enterprise Server – Date & Time View
Use the Date & Time view to configure shadow Automation Servers network time
settings, and the time zone of the Enterprise Server.

Figure: Date & time view

Table: Date & Time View
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Component

Description

Network time synchronization

Select to define the primary and secondary
network time server addresses for
connected shadow Automation Servers.

Enable

Select to define the primary and secondary
network time server addresses for
connected shadow Automation Servers.

Authenticate Network time
synchronization

Select if you want to use authenticated
network time synchronizing.

Primary time server

Type the address to the primary time server
to which the shadow Automation Servers
date and time object synchronizes its clock.
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Component

Description

Secondary time server

Type the address to the secondary time
server to which the shadow Automation
Servers date and time object synchronizes
its clock.

Key id

Type the ID of the authentication key for the
primary time server.

Key id

Type the ID of the authentication key for the
secondary time server.

Key value

Type the password for the primary time
server.

Key value

Type the password for the secondary time
server.

Manually adjust date & time

Select to use manual date and time
configuration for connected shadow
Automation Servers.

Disable

Select to disable all Automation Server date
and time shadow relationships and use the
Automation Servers own date and time
configurations.

Predefined time zone

Select the time zone the server belongs to.

Custom time zone

Select to manually define the server time
zone.

Description

Type a description or name for the
customized time zone DST settings.

UTC offset

Select the time difference the time zone has
from UTC in the hours and minutes boxes.

This custom time zone uses daylight
saving time

Select to enable the daylight saving time
settings for the custom time zone.

Time adjustment

Select the time adjustment, in minutes, for
the daylight saving time.

Month - Start

Select the month that daylight saving time
starts.

Week - Start

Select the week of the month that daylight
saving time starts.

Day - Start

Select the day of the week that daylight
saving time starts.

Time - Start

Select the time that daylight saving time
starts.

Month - End

Select the month that daylight saving time
ends.

Technical
337

9 WorkStation for Projects User Interface
9.21 Enterprise Server – Date & Time View

Continued

Technical
338

Component

Description

Week - End

Select the week that daylight saving time
ends.

Day - End

Select the day of the week that daylight
saving time ends.

Time - End

Select the time that daylight saving time
ends.
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9.22

Automation Server – Date & Time View
Use the Automation Server - Date & Time view to configure the Automation
Server time and time zone.

Figure: Date & Time view

Table: Date & Time View
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Component

Description

Network time synchronization

Select to synchronize the server clock with a
network time server.

Authenticate Network time
synchronization

Select if you want to use authenticated
network time synchronizing.

Primary time server

Type the address to the primary time server
to which the shadow Automation Servers
date and time object synchronizes its clock.

Secondary time server

Type the address to the secondary time
server to which the shadow Automation
Servers date and time object synchronizes
its clock.
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Component

Description

Key id

Type the ID of the authentication key for the
primary time server.

Key id

Type the ID of the authentication key for the
secondary time server.

Key value

Type the password for the primary time
server.

Key value

Type the password for the secondary time
server.

Manually adjust date & time

Select to manually set the server clock.

Local date & time

Enter the date and time you want to set the
server clock to. This time is displayed in
server local time.

Predefined time zone

Select the time zone the server belongs to.

Custom time zone

Select to manually define the server time
zone.

Description

Type a description or name for the
customized time zone DST settings.

UTC offset

Select the time difference the time zone has
from UTC in the hours and minutes boxes.

This custom time zone uses daylight
saving time

Select to enable the daylight saving time
settings for the custom time zone.

Time adjustment

Select the time adjustment, in minutes, for
the daylight saving time.

Month - Start

Select the month that daylight saving time
starts.

Week - Start

Select the week of the month that daylight
saving time starts.

Day - Start

Select the day of the week that daylight
saving time starts.

Time - Start

Select the time that daylight saving time
starts.

Month - End

Select the month that daylight saving time
ends.

Week - End

Select the week that daylight saving time
ends.

Day - End

Select the day of the week that daylight
saving time ends.
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Component

Description

Time- End

Select the time that daylight saving time
ends.
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9.23

Communication View
Use the Communication view to edit the communication parameters that a
Building Operation server maintains about other Building Operation servers.

Figure: Communication view

Table: Communication View
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Component

Description

Server

Displays all Building Operation servers that
this server knows of.

DNS/IP Address

Displays the DNS/IP addresses of the
servers.

Communication

Displays the protocols that are used to
communicate with the servers.

Port

Displays the ports that are used for the
protocols.

Server

Displays the name of the server that is
selected in the list.

Address

Type the new IP address or fully qualified
domain name if the address has changed in
the selected server.

Protocol

Select a new communication protocol to use
with the selected server.

Port

Enter the new port number if it has changed
in the selected server.
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9.24

User Account Properties
Use the User Account properties dialog box to configure the properties of a user
account.

Figure: User account properties

Table: User Account Properties
Component

Description
Click to create a new user profile. For more
information, see section 9.11 “Create Object
Wizard – Naming the Object Page” on page
322.
Click to edit a user profile. For more
information, see the Profile Properties topic
on WebHelp.
Click to remove a user profile.
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Disabled

Select True to disable the user account.

Force password change

Select True to force the user to change
password after the initial logon.
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Component

Description

Password

Type the password again.

Confirm Password

Type the password again.

Expires on

Enter an expiration date and time for the
user account. By default, there is no
expiration date for the account.

System of measurement

Displays the system of measurement for the
user account.
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Topics
Server Wizard – Configure IP/DNS Address and Port Page
Log On Dialog Box
Enterprise Server Properties – Basic Tab
Enterprise Server Properties – Network Tab
Enterprise Server Properties – E-mail Tab
Automation Server Properties – Basic Tab
Automation Server Properties – E-mail Tab
Automation Server Properties – Network Tab
Communication View
Device Discovery View
Variables View

10 Building Operation Servers User Interface
10.1 Server Wizard – Configure IP/DNS Address and Port Page

10.1

Server Wizard – Configure IP/DNS
Address and Port Page
Use the Configure IP/DNS Address and Port page to configure server
communication parameters.

Figure: Server Wizard - Configure IP/DNS address and port page

Table: Server Wizard - Configure IP/DNS Address and Port Page
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Component

Description

Server

Displays the name of the server.

Address

Type the IP address or fully qualified domain
name of the Automation Server.

Protocol

Select a communication protocol for the
server. Other servers use this protocol by
default when they communicate with this
server.

Port

Enter a port for the selected protocol.
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10.2

Log On Dialog Box
Use the Log On dialog box to log on to an Automation Server with an existing
custom logon password to add the server to an Enterprise Server.

Figure: Log on dialog box

Table: Log On Dialog Box
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Component

Description

Protocol

Displays the protocol used by the server.

Port

Displays the communication port used by
the server.

Name

Displays the administrator user name.

Password

Type the custom administrator password.
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10.3

Enterprise Server Properties – Basic
Tab
Use the Basic tab to view basic properties of the Enterprise Server.

Figure: Enterprise Server properties – basic tab

Table: Enterprise Server Properties – Basic Tab
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Component

Description

Server time

Displays the date and time adjusted to the
client time zone.

Hour (h)

Displays the hours according to the server
time zone.

Minute (m)

Displays the minutes according to the server
time zone.

Second (s)

Displays the seconds according to the
server time zone.
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Component

Description

Configuration database size

Displays the current size (Mb) of the
configuration database.

Server directory size

Displays the current size (Mb) of the types
stored in the server file system.

Thread pool size

Displays the present size of the thread pool.

Thread pool usage

Displays the present usage of the thread
pool.

Request-specific thread pool size

Displays the capacity of the request-specific
thread pool.

Request-specific thread pool usage

Displays the current number of threads in the
request-specific thread pool.

Vendor

Displays the vendor of the Building
Operation technology.

Operating system

Displays the operating system on which the
Enterprise Server is running.

Hardware version

Displays the hardware platform on which the
Enterprise Server is running.

Software version

Displays the Enterprise Server software
version.

Restored

Displays whether or not the server database
has been restored.
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10.4

Enterprise Server Properties – Network
Tab
Use the Network tab to view the IP settings of the Enterprise Server.

Figure: Enterprise Server properties - Network tab

Table: Network Tab
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Component

Description

IP/DNS address

Displays the IP address of the host computer
on which the server resides.

Host name

Displays the host name of the computer on
which the server resides.

TCP port

Displays the port number on this server for
incoming TCP communication.

HTTP port

Displays the port number on this server for
incoming HTTP communication.

HTTPS port

Displays the port number on this server for
incoming HTTPS communication.

Technical
351

10 Building Operation Servers User Interface
10.5 Enterprise Server Properties – E-mail Tab

10.5

Enterprise Server Properties – E-mail
Tab
Use the E-mail tab to select and specify the E-mail server that can be used to send
E-mail notifications.

Figure: Enterprise Server properties - E-mail tab

Table: E-mail Tab
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Component

Description

Select E-mail server

Select to use the Schneider Electric E-mail
server or to set up a primary and possibly a
secondary E-mail server.
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Component

Description

Sender E-mail

Type a sender address for the notification Emails that are generated by this Enterprise
Server. The sender E-mail is the receiver of
replies.

Maximum queue size

Enter the maximum number of E-mails that
are allowed in a queue.

Maximum retry count

Enter the number of attempts to send an Email that are performed before abandoning
the E-mail.

Retry time

Enter the number of minutes between
retries.

Host

Displays the web address to the Schneider
Electric E-mail server.

Port

Displays the port number that is designated
for incoming SMTP traffic on the Schneider
Electric E-mail server.

Primary host

Type a primary E-mail server web address.

Primary user name

Type the user name for the E-mail account
on the primary E-mail server.

Primary Password

Type the password for the E-mail account
on the primary E-mail server.

Primary Confirm Password

Type the password again for the E-mail
account on the primary E-mail server.

Primary port

Enter the port that is designated for
incoming SMTP traffic on the primary E-mail
server.

Secondary host

Type a secondary E-mail server web
address.

Secondary user name

Type the user name for the E-mail account
on the secondary E-mail server.

Secondary Password

Type the password for the E-mail account
on the secondary E-mail server.

Secondary Confirm Password

Type the password again for the E-mail
account on the secondary E-mail server.

Secondary port

Enter the port that is designated for
incoming SMTP traffic on the secondary Email server.
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10.6

Automation Server Properties – Basic
Tab
Use the Basic tab to view basic properties of the Automation Server.

Figure: . Automation Server properties – Basic tab

Technical
354

04-16006-04-en, March 2015

10 Building Operation Servers User Interface
10.6 Automation Server Properties – Basic Tab

Table: Automation Server Properties – Basic Tab
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Component

Description

Server time

Displays the date and time adjusted to the
client time zone.

Hour (h)

Displays the hours according to the server
time zone.

Minute (m)

Displays the minutes according to the server
time zone.

Second (s)

Displays the seconds according to the
server time zone.

Configuration database size

Displays the current size (Mb) of the
configuration database.

Server directory size

Displays the current size (Mb) of the types
stored in the server file system.

Thread pool size

Displays the present size of the thread pool.

Thread pool usage

Displays the present usage of the thread
pool.

Request-specific thread pool size

Displays the capacity of the request-specific
thread pool.

Request-specific thread pool usage

Displays the current number of threads in the
request-specific thread pool.

Memory usage (%)

Displays the percentage of the system
memory currently being used by the server
process when including heap manager free
lists to calculate the amount of free memory.

System memory usage (%)

Displays the percentage of the system
memory currently being used by all server
processes.

CPU usage (%)

Displays the level of CPU performance
presently used by the Automation Server.

Vendor

Displays the issuer of the Building Operation
technology.

Operating system

Displays the operating system on which the
Automation Server is running.

Software version

Displays the Automation Server software
revision.

Serial number

Displays the serial number of the Automation
Server hardware.

Product ID

Displays a classification code that represents
the type of Automation Server.
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Component

Description

Part number

Displays the part number, which is what
identifies the product in the context of
purchase.

Hardware platform

Displays a code that represents the
Automation Server CPU.

Hardware version

Displays a code that represents the CPU
revision number of the Automation Server.

MAC address

Displays the hardware address of the
Automation Server, which is a unique
identifier that is allocated to every hardware
network interface.

Restored

Displays whether or not the server database
has been restored.
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10.7

Automation Server Properties – E-mail
Tab
Use the E-mail tab to select and specify the E-mail server that can be used to send
E-mail notifications.

Figure: Automations Server properties - E-mail tab

Table: E-mail Tab
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Component

Description

Select E-mail server

Select to use the Schneider Electric E-mail
server or to set up a primary and possibly a
secondary E-mail server.
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Component

Description

Sender E-mail

Type a sender address for the notification Emails that are generated by this Automation
Server. The sender E-mail is the receiver of
replies.

Maximum queue size

Enter the maximum number of E-mails that
are allowed in a queue.

Maximum retry count

Enter the number of attempts to send an Email that are performed before abandoning
the E-mail.

Retry time

Enter the number of minutes between
retries.

Host

Displays the web address to the Schneider
Electric E-mail Server.

Port

Displays the port number that is designated
for incoming SMTP traffic on the Schneider
Electric E-mail Server.

Primary host

Type a primary E-mail server web address.

Primary user name

Type the user name for the E-mail account
on the primary E-mail server.

Primary Password

Type the password for the E-mail account
on the primary E-mail server.

Primary Confirm Password

Type the password again for the E-mail
account on the primary E-mail server.

Primary port

Enter the port for incoming SMTP traffic on
the primary E-mail server.

Secondary host

Type a secondary E-mail server web
address.

Secondary user name

Type the user name for the E-mail account
on the secondary E-mail server.

Secondary Password

Type the password for the E-mail account
on the secondary E-mail server.

Secondary Confirm Password

Type the password again for the E-mail
account on the secondary E-mail server.

Secondary port

Enter the port for incoming SMTP traffic on
the secondary E-mail server.
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10.8

Automation Server Properties –
Network Tab
Use the Network tab to view communication settings of the Automation Server.

Figure: Automation Server properties - Network tab

Table: Network Tab
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Component

Description

DHCP

Displays if Dynamic Host Configuration
Protocol is enabled. If enabled, the server
obtains TCP/IP configurations from the
DHCP server.

IP/DNS address

Displays the server IP address, which is
assigned by the DHCP server or specified by
you.

Subnet mask

Displays the prefix of the subnet to which the
server belongs, which is assigned by the
DHCP server or specified by you.
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Component

Description

Default gateway

Displays the address to the router, which is
assigned by the DHCP server or specified by
you.

DNS server

Displays the address to the DNS server,
which is assigned by the DHCP server or
specified by you.

Domain name

Displays the name of the domain to which
the server belongs.

Host name

Displays the IP host name of the server. This
host name can be associated to the IP
address, depending on the DNS server.

TCP port

Displays the port number on this server for
incoming TCP communication.

HTTP port

Displays the port number on this server for
incoming HTTP communication.

HTTPS port

Displays the port number on this server for
incoming HTTPS communication.

Neuron ID 0

Displays the Neuron ID 0 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 1

Displays the Neuron ID 1 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 2

Displays the Neuron ID 2 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 3

Displays the Neuron ID 3 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 4

Displays the Neuron ID 4 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 5

Displays the Neuron ID 5 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.
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10.9

Communication View
Use the Communication view to edit the communication parameters that a
Building Operation server maintains about other Building Operation servers.

Figure: Communication view

Table: Communication View
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Component

Description

Server

Displays all Building Operation servers that
this server knows of.

DNS/IP Address

Displays the DNS/IP addresses of the
servers.

Communication

Displays the protocols that are used to
communicate with the servers.

Port

Displays the ports that are used for the
protocols.

Server

Displays the name of the server that is
selected in the list.

Address

Type the new IP address or fully qualified
domain name if the address has changed in
the selected server.

Protocol

Select a new communication protocol to use
with the selected server.

Port

Enter the new port number if it has changed
in the selected server.
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10.10

Device Discovery View
Use the Device Discovery view to discover installed Building Operation server
hardware, Lon devices, and BACnet devices including I/O modules for an
Automation Server.

Figure: Device Discovery view

Table: Device Discovery View
Number

Descriptions
System Tree
Select where to search in the System Tree.
Select device type
Select what to search for in the Select device
type box.
Device result area
Displays search results, filtered according to
device type and System Tree scope. You
can add or map devices to the Building
Operation system by dragging them to the
System Tree.
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10.11

Variables View
Use the Variables view to view values, create trend logs, force values, and to edit
parameters in a structured and manageable way.

Figure: Variables view

Table: Variables View
Number

Description
Use the Variables view toolbar expand or
collapse all folders and property categories
in the Variables list. You can also hide or
show the Property grid.
Use the Quick Filter box to filter categories
or properties in the Variables list.
Use the Variables list to view properties and
values in a structured and manageable way.
You can also create trend logs and edit a
multiple selection of properties.
Use the Property grid to view and edit
parameters and to force values. For more
information, see the Object Properties topic
on WebHelp.

Note
The Variables view is continuously updated. If all categories are expanded, it puts
a heavy load on the system. Avoid having too many values on display.
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11

Device Administrator User
Interface

Topics
Device Administrator
Device Administrator Toolbar
Device Administrator List
Upgrade Device Dialog Box
Connect to Device Dialog Box
Detailed Progress Dialog Box
Device Log On Options Dialog Box
Enter User Name and Password Dialog Box
Edit Connection Dialog Box
Confirm Download Dialog Box
Device Administrator Properties – General Tab
Device Administrator Properties – Network Tab
Device Administrator Properties – SNMP Configuration Tab
Device Administrator Properties – Firewall Tab
Device Administrator Properties – Time Tab

11 Device Administrator User Interface
11.1 Device Administrator

11.1

Device Administrator
Use the Device Administrator to manage and upgrade the software in Automation
Servers.

Figure: Device administrator

Table: Device Administrator Components
Number

Description
Device Administrator toolbar
Use the Device Administrator toolbar to
perform operations on the Automation
Servers in the list. For more information, see
section 11.2 “Device Administrator Toolbar”
on page 366.
Device list
Use the Device list to collect and inspect the
software status of the Automation Servers.
For more information, see section 11.3
“Device Administrator List” on page 368.
device(s)
Displays the number of devices in the list.
Software version
Displays the software version on the
Automation Server.
Firmware version
Displays the current software version that is
used for the upgrade.
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11.2

Device Administrator Toolbar
Use the Device Administrator toolbar to list and select Automation Servers for
upgrade of the software via the USB port or the IP network.

Figure: Device Administrator toolbar

Table: Device Administrator Toolbar
Button

Description
Upgrade Device(s)
Click to open the Upgrade Device dialog
box, where you select the type of upgrade.
For more information, see section 11.4
“Upgrade Device Dialog Box” on page 369.
Download converted database to
device(s)
Click to download the converted database
to the Automation Server.
Cancel action
Click to stop the extraction of debug
information.
Add network device to list
Click to open the Connect to Automation
Server dialog box, where you add an
Automation Server to the list. For more
information, see section 11.5 “Connect to
Device Dialog Box” on page 370.
Remove network device(s) from list
Click to remove the selected Automation
Server from the list. The server itself is not
affected in any way.
Edit network device connection
Click to open the Edit connection dialog
box, where you can change the way an
Automation Server is addressed. For more
information, see section 11.9 “Edit
Connection Dialog Box” on page 374.
Open detailed progress
Click to open the Detailed Progress
dialog box after a software upgrade has
been started. For more information, see
section 11.6 “Detailed Progress Dialog Box”
on page 371.
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Continued
Button

Description
Open upgrade Log
Click to open the most recent log text file for
the selected Automation Server. For more
information, see section 3.23 “ Automation
Server Upgrade ” on page 166.
Open conversion log
Click to open the conversion log.
Properties
Click to open the Properties pane listing
important information about the selected
Automation Server. For more information,
see section 11.11 “Device Administrator
Properties – General Tab” on page 376.
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11 Device Administrator User Interface
11.3 Device Administrator List

11.3

Device Administrator List
Use the Device Administrator List to collect and inspect the software status of the
Automation Server.

Figure: Device Administrator List

Table: Device List Columns
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Columns

Description

Connection

Displays the current connection with the
Automation Server: USB, Network with IP
address or host name.

Software version

Displays the version of the current software
and the build number.

S/N

Displays the serial number of the Automation
Server hardware.

Device status

Displays the status of the device: Ready,
Upgrading, Offline, or DFU mode.

Upgrade status

Displays the dynamic upgrade status of the
device.

Progress

Displays a progress bar, indicating the
degree of upgrade procedure completion.
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11 Device Administrator User Interface
11.4 Upgrade Device Dialog Box

11.4

Upgrade Device Dialog Box
Use the Upgrade Device dialog box to preserve or delete the Automation Server
database.

Figure: Upgrade device dialog box

Table: Upgrade Device Dialog Box
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Component

Description

Software version

Displays the version the Automation Server
will be upgraded to.

Type of upgrade

Select Upgrade database to upgrade the
software and preserve the database. Select
New database to upgrade the software
and delete the database.

Upgrade information

Informs you about what happens when you
upgrade. For more information, see section
3.23 “ Automation Server Upgrade ” on page
166.

Set time on device

Select to transfer the date and time on the
computer that runs Device Administrator to
the Automation Server. For more
information, see section 3.23 “ Automation
Server Upgrade ” on page 166.
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11.5 Connect to Device Dialog Box

11.5

Connect to Device Dialog Box
Use the Connect to Device dialog box to create an Automation Server network
connection.

Figure: Connect to device dialog box

Table: Connect to Device Dialog Box
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Component

Description

Device address

Type the IP address or the host name for an
existing device.

User name

Type the user name.

Password

Type the password.

Port

Type a port number.

SSH

Select to enable the type of communication.

Use default device log on

Select to use default device log on.

Connection string

Displays the selected type of communication
and the specified device address, that is, IP
address or host name, and port number.
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11.6 Detailed Progress Dialog Box

11.6

Detailed Progress Dialog Box
Use the Detailed Progress dialog box to monitor the progress of the installation
procedure.

Figure: Detailed progress dialog box

Table: Detailed Progress Dialog Box
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Component

Description

Device S/N

Displays the unique serial number of the
device.

Device address

Displays the Automation Server IP address.
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11 Device Administrator User Interface
11.7 Device Log On Options Dialog Box

11.7

Device Log On Options Dialog Box
Use the Default Device Log on Options dialog box to set default parameters to
be used by the Device Administrator when you add or upgrade Automation Servers.

Figure: Device log on options

Table: Device Log On Options

Technical
374

Component

Description

User name

Type the user name.

Password

Type the password.

Verify password

Type the password again.
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11.8 Enter User Name and Password Dialog Box

11.8

Enter User Name and Password Dialog
Box
Use the Enter user name and password dialog box if the default log on option
fails.

Figure: Enter user name and password

Table: Enter User Name And Password
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Component

Description

Device name

Displays the name of the device.

Device address

Displays the address to the device.

User name

Type the user name.

Password

Type the password.
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11 Device Administrator User Interface
11.9 Edit Connection Dialog Box

11.9

Edit Connection Dialog Box
Use the Edit connection dialog box to set parameters for the Automation Server
network connection.

Figure: Edit connection dialog box

Table: Edit Connection Dialog Box
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Component

Description

Device address

Type the IP address or the host name for an
existing device.

User name

Type the user name.

Password

Type the password.

Port

Type a port number.

SSH

Select to enable the type of communication.

Use default device log on

Select to use default device log on.

Connection string

Displays the selected type of communication
and the specified device address, that is, IP
address or host name, and port number.
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11.10 Confirm Download Dialog Box

11.10

Confirm Download Dialog Box
Use the Confirm Download dialog box to download the converted database to
the Automation Server.

Figure: Confirm Download dialog box

Table: Confirm Download Dialog Box
Property

Description

Status

Displays the status of the backup.
Green indicates a backup less than 24
hours old.
Yellow indicate a backup more than 24
hours old.
For more information, see section 3.23 “
Automation Server Upgrade ” on page 166.
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S/N

Serial numbers of the Automation Servers to
which the converted database is
downloaded.

Time

Displays the time the backup was made.
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11.11 Device Administrator Properties – General Tab

11.11

Device Administrator Properties –
General Tab
Use the General tab to display software and hardware information about the
selected device.

Figure: General tab

Table: General Tab
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Component

Description

Port

Displays the port on the Automation Server
that is used for Device Administrator
communication.

Software version

Displays the software version currently
installed on the device. This can be changed
with a software upgrade from the Device
Administrator.

Serial number

Displays the unique serial number of the
circuit board in the device.

Connection

Displays the current type of connection: USB
or network.

Product ID

Displays the type of device.

Part no

Displays the Schneider Electric part number
of the device.

Neuron ID

Displays the four Neuron identities of the
device in hexadecimal form.
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11.11 Device Administrator Properties – General Tab

Continued
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Component

Description

Hardware version

Displays the general hardware version of the
device.

Hardware

Displays the hardware platform type, that is,
the current version of the basic hardware
platform.

Product SN

Displays the unique serial number of the
device.

Slot

Displays the I/O bus address, 1-32, for the
device. (Appears only in normal mode, if
USB connection.)
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11.12 Device Administrator Properties – Network Tab

11.12

Device Administrator Properties –
Network Tab
Use the Network tab to edit communication settings for the selected Automation
Server.

Figure: Network tab

Table: Network Tab
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Component

Description

Static IP address

Type a static IP address for the server.

MAC address

Displays the Media Access Control address
of the processor in the device, a hardware
address that uniquely identifies each node of
a network.

Host name

Type a unique host name of the Automation
Server.

Domain

Type the name of the domain to which the
server belongs.

Netmask

Type the prefix of the subnet to which the
server belongs.

Primary DNS

Type the address to the primary DNS server.

Secondary DNS

Type the address to the secondary DNS
server.
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11.12 Device Administrator Properties – Network Tab

Continued
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Component

Description

Tertiary DNS

Type the address to the tertiary DNS server.

Gateway

Type the address to the router.

Current IP address

Displays the server IP address, which is
assigned by the DHCP server.

Enable DHCP

Select to enable DHCP. If selected, the
server obtains TCP/IP configurations from
the DHCP server.
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11.13 Device Administrator Properties – SNMP Configuration Tab

11.13

Device Administrator Properties – SNMP
Configuration Tab
Use the SNMP Configuration tab to configure a user that the SNMP manager
uses to log on to the Automation Server.

Figure: SNMP Configuration tab

Table: SNMP Configuration Tab
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Component

Description

SNMP queries

Select to enable SNMP queries.

SNMP traps

Select if you want the SNMP Manager to
collect information regarding SNMP traps.

Traps destination host address

Type the host name or address to the SNMP
Manager.

Username

Type the username for the SNMP user.

Authentication password (MD5)

Type the password for the SNMP user. The
password must be at least ten characters
long.

Confirm password

Type the password again.

Privacy password

Type the privacy password used to encrypt
the information sent to the SNMP Manager.
The password must be at least ten
characters long.
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Continued
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Component

Description

Confirm password

Type the privacy password again.

System contact

Type the name or e-mail address to the
person responsible for the Automation
Server.

Location

Type the physical location of the Automation
Server.

Enable logging

Select to log all access attempts to the
SNMP server in the System log.
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11.14 Device Administrator Properties – Firewall Tab

11.14

Device Administrator Properties –
Firewall Tab
Use the Firewall tab to to determine the devices that can communicate with
Automation Server.

Figure: Device Administrator properties – Firewall tab

Table: Device Administrator Properties – Firewall Tab
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Component

Description

Whitelist

Add the IP addresses to the devices that are
allowed to communicate with the server to
the whitelist. For more information, see
section 123.3 “Firewall” on page 5189.

Reset whitelist

Click to clear the whitelist.
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11.15 Device Administrator Properties – Time Tab

11.15

Device Administrator Properties – Time
Tab
Use the Time tab to display and modify time settings on the Automation Server.

Figure: Device Administrator properties – Time tab

Table: Device Administrator Properties – Time Tab
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Component

Description

Date

Displays the time on the Automation Server.
Read-only. For more information, see the
Time and Time Zone Configuration in
Automation Server topic on WebHelp.

Time

Displays the date on the Automation Server.
Read-only. For more information, see the
Time and Time Zone Configuration in
Automation Server topic on WebHelp.

Set time on device

Select to transfer the date and time on the
computer that runs Device Administrator to
the Automation Server. For more
information, see section 3.23 “ Automation
Server Upgrade ” on page 166.
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12

Building Operation Servers
Troubleshooting

Topics
Cannot Connect to the Automation Server
Enterprise Server Service Disabled
Error – Upgrade Using DFU Mode
Lead-Shadow Reference Server Communication Problems

12 Building Operation Servers Troubleshooting
12.1 Cannot Connect to the Automation Server

12.1

Cannot Connect to the Automation
Server
If the Automation Server's name, address, serial number and upgrade status are
displayed in grey italic, red, or orange in the Device Administrator, you cannot
connect to the Automation Server. The Automation server is offline.

12.1.1

Solution
• If the Automation Server's name is in red, the password has been changed.
Contact the administrator to get the new, correct password.
• If the Automation Server's name is in grey italic, the connection is broken.
Make sure that the Automation Server is connected using the network or USB.
Make sure that you use the correct address.
• If the Automation Server's name is in orange, the USB program that handles
the connection with the Automation Server has malfunctioned.
• If the Automation Server is offline, make sure that the computer you are using is
on the whitelist:
– Connect the computer to the Automation Server using the USB
connection. For more information, see section 3.11 “Connecting to an
Automation Server Using the USB Device Port” on page 153.
– Add your computer to the whitelist. For more information, see section
123.4 “Adding a Device to the Whitelist” on page 5190.
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12.2 Enterprise Server Service Disabled

12.2

Enterprise Server Service Disabled
The Enterprise Server fails to start and the Enterprise Server Windows service
status is disabled after upgrade.

12.2.1

Solution
Restart the computer.
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12.3 Error – Upgrade Using DFU Mode

12.3

Error – Upgrade Using DFU Mode
The system alarm "Error - Upgrade Using DFU Mode" is triggered when the
Automation Servers file system has been corrupted due to a power failure. If you
receive this alarm you have to restore the Automation Server software and
database to the latest backup.
The alarm is not triggered after every power failure, only when files have been
corrupted due to the power failure.

12.3.1

Solution
Connect to the Automation Server in DFU mode. For more information, see section
3.11 “Connecting to an Automation Server Using the USB Device Port” on page
153.
Restore the software on the Automation Server. For more information, see section
3.21 “Restoring the Software of a Damaged Automation Server” on page 164.
Restore the Automation Server from the latest backup. For more information, see
the Restoring a Server topic on WebHelp.
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12 Building Operation Servers Troubleshooting
12.4 Lead-Shadow Reference Server Communication Problems

12.4

Lead-Shadow Reference Server
Communication Problems
Lead-shadow reference communication does not work between an Automation
Server and the Enterprise Server.

12.4.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the communication address to the Enterprise Server is correct. The
address should be either an IP address or a fully qualified domain name (host
name plus domain name) such as es1.universityx.edu.
For more information, see section 4.4 “Updating Communication Parameters”
on page 179.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.
• If you have deployed both the Enterprise Server and the Automation Server,
and changed the server communication setting on the Automation Server
afterwards, you may have to reset the Automation Server with a warm start.
For more information, see the Reset Functions topic on WebHelp.
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Automation Server Web
Configuration

Topics
Automation Server Web Configuration Page
Configuring the Automation Server TCP/IP Settings and
Ports
Displaying the Automation Server System Information
Exporting Automation Server Log Files
Refreshing the Automation Server System Log

13 Automation Server Web Configuration
13.1 Automation Server Web Configuration Page

13.1

Automation Server Web Configuration
Page
The Automation Server Web Configuration page can only be accessed through
Webstation. In the Automation Server Web Configuration page, you can change
TCP/IP settings, download logs, and check the version of the Automation Server.
You must have permission to be able to access the Automation Server Log Web
Configuration Page.

13.1.1

TCP/IP Settings and System Info
You can change TCP/IP settings, change ports, and change host name using the
Automation Server Web Configuration page. You can also view Automation
Server's serial number, MAC address, hardware version using the System Info tab
on the Automation Server Web Configuration page.
The TCP/IP settings can also be changed using Device Administrator. For more
information, see section 3.18 “Setting the Automation Server IP Address” on page
160.

13.1.2

Automation Server Log Files
The Automation Server stores its log files to the onboard flash memory. Some of the
log files store the events according to the circular storing principle: when a log file
exceeds its maximum size the oldest event is overwritten.
Through the Automation Server Web Configuration page, you can export the
Automation Server log files. When exporting log files, the Automation Server
compresses the files with ZIP.
The information in the logs is essential for the product support service or when
troubleshooting. To forward the information to a troubleshooter who does not have
access to your system, download the log files and attach them to an e-mail.
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13 Automation Server Web Configuration
13.2 Configuring the Automation Server TCP/IP Settings and Ports

13.2

Configuring the Automation Server
TCP/IP Settings and Ports
You configure the TCP/IP settings of the Automation Server through the Automation
Server Web Configuration to define the network communication of the server.
For more information, see section 13.1 “Automation Server Web Configuration
Page” on page 393.

To configure the Automation Server TCP/IP settings and ports
1. In WebStation, in the Settings menu, click Device Configuration.
2. Click TCP/IP.
3. In the DHCP box, select Enable to obtain TCP/IP configuration information
from a DHCP server.
4. In the IP address box, type the IP address of the Automation Server.
5. In the Subnet mask box, type the address of the subnet that the server
belongs to.
6. In the Default gateway box, type the address of the node that serves as an
access point to another network.
7. In the DNS server box, type the address to the DNS server where the
Automation Server address is listed.
8. In the Domain name box, type the IP domain name that the server belongs
to.
9. In the Host name box, type the IP host name of the server.
10. In the HTTP port box, type the HTTP port.
11. In the HTTPS port box, type the HTTPS port.
Continued on next page
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13 Automation Server Web Configuration
13.2 Configuring the Automation Server TCP/IP Settings and Ports

12. Click Save.
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13 Automation Server Web Configuration
13.3 Displaying the Automation Server System Information

13.3

Displaying the Automation Server
System Information
You view the Automation Server settings and manufacturing data to get a an
overview of the current configuration of the Automations Server.
For more information, see section 13.1 “Automation Server Web Configuration
Page” on page 393.

To display the Automation Server system information
1. In WebStation, in the Settings menu, click Device Configuration.
2. Click the System Info tab.

You cannot configure all the settings in the system information using the Web
Configuration. For example, Automation Server time and time zone settings are
configured through WorkStation.
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13 Automation Server Web Configuration
13.4 Exporting Automation Server Log Files

13.4

Exporting Automation Server Log Files
You export the log files on the Automation Server to an external storage device to
view the log information.
For more information, see section 13.1 “Automation Server Web Configuration
Page” on page 393.

To export Automation Server log files
1. In WebStation, in the Settings menu, click Device Configuration.
2. Click Server Log.
3. Click Get all log files.

4. Click Save.

Continued on next page
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13 Automation Server Web Configuration
13.4 Exporting Automation Server Log Files

5. Select the location where you want to save the compressed log files and click
Save.

6. Click Close.

The log files, when downloaded, are compressed to a ZIP file. To open the log files,
extract the compressed file and open the .log-files with any text editor.
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13 Automation Server Web Configuration
13.5 Refreshing the Automation Server System Log

13.5

Refreshing the Automation Server
System Log
You refresh the server log page to display the latest system log events. The
Automation Server Web Configuration page does not automatically update with the
log file.
For more information, see section 13.1 “Automation Server Web Configuration
Page” on page 393.

To refresh the current Automation Server log
1. In WebStation, in the Settings menu, click Device Configuration.
2. Click Server Log to view the Automation Server log.

3. Click Server Log tab to refresh the web page to display the latest log events.
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Automation Server Web
Configuration User Interface

Topics
Automation Server Web Configuration – TCP/IP Page
Automation Server Web Configuration – System Information
Page
Automation Server Web Configuration – Server Log Page

14 Automation Server Web Configuration User Interface
14.1 Automation Server Web Configuration – TCP/IP Page

14.1

Automation Server Web
Configuration – TCP/IP Page
Use the TCP/IP page to configure Automation Server TCP/IP settings.

Figure: TCP/IP page

Table: TCP/IP Page
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Component

Description

DHCP

Select Enabled to obtain configuration
information from a DHCP server.

IP address

Type the IP address of the server.

Subnet mask

Type the address of the subnet that the
server belongs to.

Default gateway

Type the address to the node that serves as
an access point to another network.

DNS server

Type the address to a DNS server where the
server is listed.

Domain name

Type the IP domain name that the server
belongs to.
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Continued

Technical
406

Component

Description

Host name

Type the IP host name of the server. This
host name can be connected to the IP
address, depending of the DNS server.

HTTP Port

Type the port number that the server listens
to when communicating through the
Hypertext Transfer Protocol.
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14.2 Automation Server Web Configuration – System Information Page

14.2

Automation Server Web
Configuration – System Information
Page
Use the System Information page to display server settings and manufacturing
data. All the information on this page is read only.

Figure: System Information page

Table: System Information Page
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Component

Description

Product S/N

Displays the serial number of the server

Product ID

Displays the product ID of the server.

Part number

Displays the part number of the server.

Hardware platform

Displays the hardware platform of the server.

Hardware version

Displays the hardware version of the server.

MAC address

Displays the MAC address of the Automation
Server.
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Continued
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Component

Description

Neuron ID 0

Displays the Neuron ID 0 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 1

Displays the Neuron ID 1 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 2

Displays the Neuron ID 2 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 3

Displays the Neuron ID 3 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 4

Displays the Neuron ID 4 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

Neuron ID 5

Displays the Neuron ID 5 which is used to
identify LonWorks nodes or other
functionality in the LonWorks network.

TAC Software version

Displays the version of the Automation
Server software.

Use external NTP server

Dispalys if the server synchronizes its time
and date with an network time protocol
server

NTP server 1

Displays the address to the primary network
time protocol server to which the server
synchronizes its time with.

NTP server 2

Displays the address to the secondary
network time protocol server to which the
server synchronizes its time with.

Time zone (UTC Offset)

Displays the server time zone settings.

Daylight saving time

Displays if the time zone has a DST offset.

DHCP

Displays if the Dynamic Host Configuration
Protocol is enabled. If enabled, the server
obtains TCP/IP configurations from the
DHCP server.

IP address

Displays the IP address of the server.

Subnet mask

Displays the address of the subnet that the
server belongs to.

Default gateway

Displays the address to the node that serves
as an access point to another network.

DNS server

Displays the address to the DNS server.
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14.2 Automation Server Web Configuration – System Information Page
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Component

Description

Domain name

Displays the IP domain name of the server.

Host name

Displays the IP host name of the server. This
host name can be connected to the IP
address, depending of the DNS server.

HTTP port

Displays the port number that the server
listens to when communicating through the
Hypertext Transfer Protocol.

HTTPS port

Displays the port number that the server
listens to when communicating through the
Hypertext Transfer Protocol Secure.
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14 Automation Server Web Configuration User Interface
14.3 Automation Server Web Configuration – Server Log Page

14.3

Automation Server Web
Configuration – Server Log Page
Use the Server Log page to display the current server system log and to export all
Automation Server log files.

Figure: Server Log page

Table: Server Log Page
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Component

Description

Get all log files

Click to export all log files stored on the
Automation Server. The log files are
compressed into a zip file.
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15 Bindings
15.1 Bindings Overview

15.1

Bindings Overview
A binding is a connection between two or more variables for data exchange. In its
simplest form, a binding consists of a source and a destination. The source supplies
the value to the destination.

Figure: A binding with a source and destination

In Building Operation, you typically bind source values to destination properties in
objects such as programs, alarms, trend logs, and graphics. These objects
frequently need to use values that exist elsewhere in the system.
For example, you create a program that evaluates temperatures and controls a
heating system. You create the temperature properties in the program, open the
Binding view, browse for the source temperature sensors in the system, and drag
their temperature output values to their corresponding temperature input properties
in the program. The values of the temperature properties in the program will then
mirror those of the live sensor values.

Figure: Binding example

With many programming editors, you define, declare, and bind remote values
directly in your program. In Building Operation, you create the destination properties
in the program, but you create the bindings externally, separate from the program.
This separation of program and bindings is due to the object-oriented approach in
Building Operation. Objects, such as programs, can be reused, mass created, and
mass changed. The separation between objects and bindings also enables the use
of binding templates, which enables you to automate as many repetitive binding
tasks as possible.
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15 Bindings
15.1 Bindings Overview

15.1.1

Methods of Binding
You can bind values manually or automatically.
For more information, see section 15.2 “ Methods of Binding” on page 414.

15.1.2

Binding Rules
The value that you bind can be one of five property types: real, multistate, digital,
alphabetic, or a date.
For more information, see section 15.4 “Binding Rules ” on page 417.

15.1.3

Direction of Bindings
All bindings have a sense of direction. In its simplest form, a binding consists of a
source and a destination. The source supplies the value to the destination.
For more information, see section 15.5 “Direction of Bindings” on page 418.

15.1.4

Value Transfer Interval
When you connect one point to another point, the values are transferred at the
default rate of 10 seconds. However, you can change this setting if you want the
values to be transferred faster or with longer intervals to reduce the workload in the
system.
For more information, see section 15.6 “Value Transfer Settings ” on page 420.

15.1.5

Binding Path Format
A binding can have one of two path formats:
• Locked
• Unlocked
For more information, see section 15.9 “Locked and Unlocked Binding Paths” on
page 429.

15.1.6

Bindings Management
You manage bindings so that information is not lost and the system works
efficiently. You can check the bindings in your database using Bindings Diagnostics.
For more information, see section 15.11 “Bindings Management” on page 434.
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15 Bindings
15.1 Bindings Overview

15.1.7

LonWorks Bindings
LonWorks bindings differ from other Building Operation bindings because you can
set LonWorks specific properties, such as LonWorks binding profiles.
For more information, see section 58.1 “LonWorks Bindings ” on page 2093.

15.1.8

Server Values
Server values are values created on an Automation Server. Server values are used
to control network traffic or to provide value configurations that are not available in a
program. Server values work as an interface or connector between an Automation
Server and another:
• A program on one Automation Server and a value on another Automation
Server, for example, a function block program on one Automation Server and a
value on another Automation Server.
• A field device value and an Automation Server, for example, an value from a
sensor and an alarm on an Automation Server.
For more information, see section 15.14 “Server Values” on page 438.
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15.2

Methods of Binding
You can bind values manually or automatically.

15.2.1

Manual
You can bind a value by dragging it to a property's Bindings box in the Binding list.
You use manual binding for a binding task unless you have prepared a binding
template for that particular task.

Figure: Drag-and-drop

You can type a path to a value in the property's Binding box to create a binding.
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Figure: Path writing

When you drag a value to the Binding point list or write a path, you are specifying
the other end of the binding, which is either a source or a destination. You can bind
both ways in the Binding point list.
Binding paths can be unlocked or locked. For more information, see section 15.9
“Locked and Unlocked Binding Paths” on page 429.

15.2.2

Binding Templates
You can bind values automatically by using binding templates, that is, predefined
templates.
For more information, see section 16.1 “Binding Templates” on page 449.
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15.3

Binding Values Manually
You bind values to exchange data between objects.
For more information, see section 15.1 “Bindings Overview” on page 411.

To bind values manually
1. In WorkStation, in the System Tree pane, select the object to which you
want to bind values.
2. On the Actions menu, click Edit bindings.
3. In the binding Browser, drag a value to a property in the binding list to create
a binding.

You can also drag objects from the System Tree pane, or values from the
Search pane, or you can type the binding path in the Binding box.
4. On the toolbar, click the Save button
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15.4

Binding Rules
The value that you bind can be one of five property types: real, multistate, digital,
alphabetic, or a date.
The destination property that you create for the binding must be compatible with
the source value. The destination property and the source value must be of the
same type and descend from the same engineering unit class.
For example, you cannot bind a real (numeric) value to an alphabetic value because
they are not of the same value type. You cannot bind a temperature engineering
unit to a time engineering unit because they are not of the same engineering unit
class. You can, however, bind values of the same engineering unit class, such as
centimeters to meters, or Celsius to Fahrenheit. Conversion of values within the
same engineering unit class is handled by Building Operation.
Other binding rules concern program properties. In general, trying to bind an input
to an input, or an output to an output, is never practical and therefore not possible.
Building Operation neither proposes or allows it. There are also program specific
binding rules, also rather evident to those concerned. A good way to look at it, is
that if you are trying to bind something, and Building Operation does not allow it,
you are doing something wrong.
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15.5

Direction of Bindings
All bindings have a sense of direction. In its simplest form, a binding consists of a
source and a destination. The source supplies the value to the destination.

One-to-One
A one-to-one binding is a binding between two variables of compatible types.

Figure: Bindning direction

For example, an I/O point is bound to a script program.

One-to-Many (Group or Fan-out in LonWorks)
A one to many binding is a binding between one source and many destinations.

Figure: One-to-many binding

For example, a zone controller sends out a setpoint for many HVAC controllers.

The Direction of Bindings in the Binding View
In Building Operation, in the Binding view, you can bind in any direction.
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Figure: Two-way binding

You can select an object in the System Tree pane, open the Binding tab, and then
bind applicable properties. Some become destination properties and some become
source values to destination properties in other objects. If you drag an output to an
input property in the object, Building Operation determines that the property in the
Binding point list is the destination. If you drag an input to an output property in the
Binding point list, Building Operation determines that the output property is the
source and that the remote value is the destination.
If two properties can bind both ways, the Building Operation prompts you to decide
the direction of the binding.
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15.6

Value Transfer Settings
When you connect one point to another point, you can make a number of settings
on the receiving object (consumer) to control the value transfer rate.
You can make the following settings:
• Requested transfer rate
• Value transfer preferences
• Guaranteed transfer even if value has not changed

Figure: The transfer interval rate is set in the Values setting transfer dialog box

15.6.1

Requested Transfer Rate
The requested value transfer rate is how often you would like the transfers to take
place. You can choose between predefined intervals or manually define the interval.
If you enter a manual interval identical to one of the pre-defined intervals, the dialog
box displays the pre-defined interval the next time you open the dialog box. For
example, if you use the manual interval and set it to 1 minute, the pre-defined
interval 1 minute is displayed the next time you open the dialog box.

Note
• The actual transfer rate can differ from the requested transfer rate depending
on, for example:
– Whether or not the value is transferred to more than one recipient.
Continued on next page
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– Whether or not the transfer takes place within an Enterprise Server or
Automation Server or between an Enterprise Server and an Automation
Server or one Automation Server and another Automation Server.
– The speed of the field bus.
– The general load on the system.
If a value is transferred within a server, the transfer takes place as fast as possible.

Figure: The requested transfer rate (1) is the rate at which the value is transferred if
possible.

15.6.2

Delta Value Transfer
Delta lets you define the transfer rate based on a delta value. The Delta value is
checked at every interval but only values that exceed the Delta value (2) are
transferred.

Note
If you set the Delta to zero, the program reacts on any relative change above or
below zero. For example, if the Delta is set to 1, value changes above 1 or below 1 relative to the previous recorded value are transferred.
You can also set the value transfer rate to transfer the value at each requested
interval even if the value has not changed. In this case, the value is transferred at
every interval. Selecting this option makes the Delta setting unavailable since it has
no use if the transfer is accomplished based on the rate
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Figure: The Delta is checked each time but only values that exceed the Delta (2) are
transferred..

15.6.3

Guaranteed Transfer
Guaranteed transfer even if value has not changed (3) lets you make sure that the
value is transferred at the specified time interval, even if the value has not changed.
You can disable this feature.

Figure: The guaranteed transfer interval (3) makes sure that you get at least one transfer
per interval.

15.6.4

Combined Methods
You can combine the value transfer settings. For example, you want a value to be
transferred when it exceeds the Delta 0.5. However, even if the change of the value
does not exceed the Delta, you still want the value to be transferred once every
hour. Therefore, you set the guaranteed transfer interval to one hour.
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Value changes are checked at a minimum of every interval. Depending on the
circumstances, they could be checked more often.

Figure: You can combine methods, for example, to make sure that the value is transferred
at a minimum rate.
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15.7

Value Transfer
When you connect one point to another point, the rate at which values are
transferred from the sending object of the value (producer) to the receiving object of
the value (consumer) depends on the cause of the transfer and the devices that are
involved.
In some cases the Value transfer settings determine the value transfer rate, in some
they do not. There are three types of references that impact the value transfer rate:
• Application
• Central
• Field bus

15.7.1

Application Value Transfer
In application value transfer, the value transfer rate is determined by the application.
The value transfer rate depends on the elements of the application.
• Watch Window – a 500 millisecond value transfer rate, which is not adjustable.
To remove the value subscription, you have to remove the object from the
Watch Window.
• Graphics – By default, a 500 millisecond value transfer rate. To remove the
value subscription, you have to close the graphic.
• Trends – interval trend log. If the interval is greater than one minute, the
minimum value transfer rate (never) is used until just before the time the interval
trend log needs data, and then the transfer rate is increased to maximum. If the
value transfer rate of the interval is a minute or less, then the desired value
transfer rate is set to one half of the interval. The value subscription cannot be
removed as long as the trend log exists.
• Alarms –The desired value transfer rate is set to 100 milliseconds for polled
alarms, including all alarms on field bus points. The subscription cannot be
removed as long as the alarm exists.
• Programs – Script or Function Block Programs read all of their bound inputs at
a value transfer rate corresponding to the task set for the program. The object
reading from the program’s local output reads at a value transfer rate that is
consistent with the transfer type. If another object property is reading from the
output, the Value transfer settings are involved. The value subscription cannot
be removed as long as the connection between the object property and the
program exists.

Note
Delays can happen when several applications try to execute at the same time.

15.7.2

Central Value Transfer
The central value transfer is controlled by the value transfer rate specified by the
user unless the value transfer is entirely within one server and no server-to-server
communication is involved. In this case, the value transfer is immediate. For more
information, see section 15.6 “Value Transfer Settings ” on page 420.
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Examples:
• A value object within AS1 reads from a value object within AS2. In this case,
the value object read is controlled by the Value transfer settings. By default, the
poll rate is set to 10 seconds. You can change the value transfer interval. If you
set a Delta value no value transfer occurs even after the polling interval has
passed unless the change since the previous reading exceeds the Delta value
setting. If you set a Guaranteed value transfer rate, the value transfer is forced
after the elapsed time regardless of whether the value has changed.
• A value object within AS1 reads from a value object also within AS1. In this
case, the value object read is not controlled by the Requested transfer rate
setting. The reason is that there is no cost for immediate value transfer since
there is no server-to-server or field bus communication. However, the Delta
and the Guaranteed transfer settings are still in force.

15.7.3

Field Bus Value Transfer
When the value transfer involves a field bus, the communication plug-in, the field
bus protocol and the direction in which the value transfer takes place control when
the value is transferred.
Examples:
• An SBO object connected to an I/NET object.
– If the I/NET object is reading from the SBO object, the transfer mechanism
considers the cost to communicate down the field bus and it regards the
delta and intervals in the Variable transfer settings.
– If the SBO object is reading from the I/NET object, the Variable transfer
settings are delivered to the I/NET plug-in, but the requested value transfer
rate is not regarded because the I/NET plug-in only supports certain
update rates. The I/NET plug-in uses the point scan rate defined for the
point's associated DCU.
• A BACnet object connected to an SBO object.
– If the BACnet object is reading from the SBO object, the transfer
mechanism considers that there is a cost to communicate down the field
bus and it uses the delta and intervals that are entered in the Variable
transfer settings. The SBO BACnet plug-in issues a write property to the
other BACnet device based upon the delta that is entered into the Variable
transfer settings. If the setting is “0”, a write property occurs upon any
change. If the setting is not “0” but, for example, “1”, then a write property
occurs when the value has changed by more than 1. The write property
does not occur again after the “pre-defined interval” in the Variable transfer
settings. The “pre-defined interval” only has meaning in a polled scenario,
not in a BACnet write property scenario. However, the write property
occurs again after the guaranteed transfer interval provided that it is set.
Consequently, it is important to use that parameter to protect against loss
of setting if the external BACnet device resets and restores default values.
If the guaranteed transfer interval is not used and the BACnet device that
is the recipient of the write property restores default values upon reset, the
SBO does not resend the value after the device reset. It may not even be
aware that it has reset.
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– If the SBO object is reading from the BACnet object, the Variable transfer
settings are delivered to the BACnet plug-in. The plug-in determines if the
device producing the value supports COV for the object property
requested.
– If it does, it requests a subscription between SBO and that device.
The device transfers values based on its own services and the COV
increment for the requested object. It does not use the delta in the
Variable transfer settings. The communication plug-in knows the most
efficient way to get values from the field bus and it uses that method
to satisfy the read request from the consuming object. In the case of
BACnet, COV is most efficient; so it transfers the values at the COV
increment of the object that is being read. The values are then
delivered to the Variable Transfer Manager, which decides if the
values are to be read by the consuming object based on the Delta set
in the Value transfer settings. This can cause unexpected behavior
depending on the relative sizes of the referenced object COV
increment and the Delta set in the Value transfer settings. If the COV
increment in the object is, for example, 0.4 and the Delta in the Value
transfer settings is 0.5, the actual read takes place in 0.8 because the
first 0.4 increment does not satisfy the Value transfer setting so it
waits for the next change actually to read the new value.
– If the object being referenced does not support COV, the BACnet
plug-in issues a read property request at the rate specified in the
shorter of the requested value transfer rate or guaranteed value
transfer rate.
• A Script or Function Block Program using a BACnet object as an input.
– The program’s task rate drives the reading frequency, regardless of the
Value transfer settings.
• A Modbus object connected to an SBO object.
– If the Modbus register is reading from the SBO object, the transfer
mechanism considers the cost to communicate down the field bus and it
regards the delta and intervals in the Variable transfer settings
– If the SBO object is reading from the Modbus register, the Variable transfer
settings are delivered to the Modbus plug-in. Since Modbus is a polled
communication bus, the requested transfer, delta, and guaranteed
transfer rates are regarded. As soon as a subscription is established
between a Modbus register and an SBO object, that subscription cancels
the Modbus device polling regardless of whether the subscription rate is
longer than the device polling rate.
– Since Modbus is a polling protocol, it is possible that so many requests
can be made that none of them can be satisfied in the time requested. In
this case, the value transfer occurs as fast as possible
• A LON device connected to an SBO object.
– If the SBO object requires a value from the LON device, it is recommended
to mirror the LON value to the Local Node, and then bind the SBO object
to the copy on the Local Node. In this way, LON send-on-delta updates
the Local Node copy, and then application data transfer dictates how the
SBO object receives updates from the Local Node’s copy of the value. For
graphics bindings that only generate traffic when the associated graphic is
open, it is acceptable to either bind to a Local Node copy of the value
when available, or otherwise to bind directly to the value on the LON
device. Binding the graphic directly to the value on the LON device
generates polling requests only when the graphic page is open.
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– If the LON device requires a value from the SBO object, this value can be
sent in one of two ways:
– The SBO object’s value can be bound to an object on the Local
Node, and then a LON binding from the Local Node to the LON
device will allow a conventional LON binding (with heartbeat). The
requested transfer rate is not significant between the SBO object and
the Local Node object, but both the delta and the guaranteed transfer
rate are very significant. If either results in an update to the Local
Node object, the LON plug-in will generate an update message and
send it to the LON device. The guaranteed transfer rate can force this
message to be generated even if there is no change in the
value—whenever the Local Node object is updated, a message is
sent. The Local Node object can also be configured with a "send
rate", which can also cause the value to be routinely pushed to the
LON device.
– The SBO object’s value can also be bound directly to the input on a
LON device, and this does make use of the retransmit interval, delta,
and guaranteed transfer rate. It is not a true LON binding, however,
so controllers like the MNL with a configurable heartbeat requirement
may not accept the writes as valid heartbeats and may revert the
objects to default values between writes.

15.7.4

Cautions
The value is transferred as fast as possible considering the value transfer rate
limitations in field bus and network communication. The value transfer rate also
depends on the direction. If an SBO object is reading from a BACnet object, the
value transfer rate can differ from the scenario when the BACnet object is reading
from the SBO object, even if the Variable transfer settings are identical.
If your implementation requires that a certain delta be imposed before doing
something else, a Guaranteed value transfer rate setting can cause unexpected
behavior. The Guaranteed transfer even if value has not changed setting, means
that the value is transferred even if it has not changed in relation to the previous
value by an amount greater than the delta.
When attempting to confirm the actual value transfer rate, it is important to be
certain that all of the value transfers are known because one value transfer can
easily affect another. When the producer is told to update two entities on the same
server at different rates, it updates both at the faster of those two rates.

04-16006-04-en, March 2015

Technical
429

15 Bindings
15.8 Configuring the Value Transfer Interval

15.8

Configuring the Value Transfer Interval
You adapt the value transfer interval between objects in the database to better suit
the transfer workload in the system.
For more information, see section 15.6 “Value Transfer Settings ” on page 420.

To configure the value transfer interval
1. In WorkStation, in the System Tree pane, select the object.
2. On the Actions menu, click Edit bindings.
3. In the Bindings view, click the Edit button

.

4. In the Value transfer settings dialog box, select the value transfer interval.

5. Click OK.
6. On the File menu, click Save.

Technical
430

04-16006-04-en, March 2015

15 Bindings
15.9 Locked and Unlocked Binding Paths

15.9

Locked and Unlocked Binding Paths
A binding can have one of two path formats:
• Locked
• Unlocked
You need to consider the binding path format when you copy and paste or export
and import objects that have bindings. Typically, bindings are included when you
copy objects that have bindings.
When you import or paste a locked path, it keeps its original path and mirrors the
original source value. When you import or paste an unlocked path, it generates a
new path and binds the object to a new source value relative to its new location.
You decide what external binding paths to include in an export: locked, locked and
unlocked, or none. For more information, see section 18.2 “Export” on page 559.

Note
The lock feature is disabled for LonWorks bindings, because a locked LonWorks
binding may result in scenarios where a binding contains several hubs pointing to
one target, or different binding profiles are mixed.

15.9.1

Locked
There are two types of locked binding paths:
• System absolute
• Server absolute

System Absolute
System absolute binding paths to objects on another server are always locked and
cannot be unlocked. The path is displayed as, for example,
/Server2/System/Folder/Value.
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Figure: Locked system absolute binding paths

Server Absolute
Server absolute binding paths to objects in the System folder are always locked and
cannot be unlocked. The path is displayed as, for example, ~/System/Folder/Value.
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Figure: Locked server absolute binding paths

15.9.2

Unlocked
Unlocked binding paths are always relative. All binding paths that are not server
absolute or system absolute are relative and, by default, unlocked. The path starts
with elipses (..),is displayed as, for example, ../Folder/Value.
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Figure: Unlocked relative binding paths

You can manually lock a relative binding path that you want to keep when you copy
and paste or export and import. When you lock a relative binding path it becomes
server absolute. In contrast to server absolute binding paths that point to objects in
the System folder, you can unlock the manually locked binding paths.
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15.10

Locking or Unlocking a Path
You lock a path to make it server absolute, that is, it will always refer to the same
server.
For more information, see section 15.9 “Locked and Unlocked Binding Paths” on
page 429.

To lock or unlock a path
1. In the Actions menu, click Edit bindings.
2. Right-click in the value path field.

3. Select or clear Lock path.
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15.11

Bindings Management
You manage bindings so that information is not lost and the system works
efficiently. You can check the bindings in your database using Bindings Diagnostics.
Faulty bindings can have two types of status:
• Invalid: The binding points to something that cannot be bound together, such
as an out of range alarm that is monitored by a digital value.
• Unresolved: The binding points to an object that is not in the database, such
as an object that you deleted.
If you delete an object and keep the bindings to the deleted object, you get an
unresolved binding. If you later replace the object in the same location and with the
same name, the binding is resolved. For more information, see section 17.13
“Bindings Status Icons” on page 540.
You can resolve invalid or unresolved bindings by editing the binding. For more
information, see section 15.3 “Binding Values Manually” on page 416.
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15.12

Checking the Status of Bindings
You check the status of bindings to identify any unresolved or invalid bindings.
For more information, see section 15.11 “Bindings Management” on page 434.

To check the status of bindings
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click Bindings Diagnostics.
4. In the Status column, view the status of the bindings.
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15.13

LonWorks Bindings
A LonWorks binding is a connection between two or more network variables or
configuration properties for data exchange. In its simplest form, one variable is
bound to another in a Point-to-point binding. You can also bind one variable to
several (Fan-out), or several to one (Fan-in).
LonWorks bindings differ from other Building Operation bindings because you can
set LonWorks specific properties, such as LonWorks binding profiles.

Figure: Point-to-point binding

A binding consists of one hub and one or more targets. The hub is a unique node
that connects to one or more targets.

Note
• To create a LonWorks binding, you need to bind on the variable level. If you
bind two members of network variables, a Building Operation binding is
created rather than a LonWorks binding. For more information, see section
57.9 “Network Variables and Configuration Parameters” on page 2074.

Note
The lock feature is disabled for LonWorks bindings, because a locked LonWorks
binding may result in scenarios where a binding contains several hubs pointing to
one target, or different binding profiles are mixed.

15.13.1

LonWorks Bindings in WorkStation
Use the Bindings View in WorkStation to create your LonWorks bindings. You can
drag and drop NVs to create bindings.
For more information, see section 58.2 “LonWorks Bindings in WorkStation” on
page 2095.

15.13.2

Bindable objects in LonWorks
LonWorks network variables and configuration parameters can be bound to each
other in LonWorks bindings. They can also be bound to most points in Building
Operation, such as programs, graphics, alarms, and trend logs, but then Building
Operation bindings is used, not LonWorks bindings.
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For more information, see section 58.5 “Bindable Objects in LonWorks” on page
2101.

15.13.3

LonWorks Binding Profiles
When you create a binding in LonWorks, you decide its behavior by selecting a
binding profile. You either select a binding profile, or you use the default profile.
For more information, see section 58.3 “LonWorks Binding Profiles ” on page 2096.

15.13.4

LonWorks Binding Types
Building Operation supports different types of LonWorks bindings, such as point-topoint, turnaround, fan-in, and fan-out.
For more information, see section 58.4 “LonWorks Binding Types” on page 2098.

15.13.5

LonWorks Selectors and Bindings
LonWorks uses selectors to create bindings between network variables. A selector
is a unique index that is assigned to a network variable and points to the target
device, where the bound network variable is assigned the same selector index.
For more information, see section 58.6 “LonWorks Selectors and Bindings” on
page 2102.
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15.14

Server Values
Server values are values created on an Automation Server. Server values are used
to control network traffic or to provide value configurations that are not available in a
program. Server values work as an interface or connector between an Automation
Server and another:
• A program on one Automation Server and a value on another Automation
Server, for example, a function block program on one Automation Server and a
value on another Automation Server.
• A field device value and an Automation Server, for example, an value from a
sensor and an alarm on an Automation Server.
Server values can provide value configurations that are not available in a program,
such as forcing a value in a function block program. In the server value, you can set
how often the value should be forced.

15.14.1

Minimizing the Transfer Interval Intensity
Server values help to control network traffic. By default, a subscription to a value
from one Automation Server to another or from a field device value to an
Automation Server occurs at the intensity defined by the consumer object. For
example, a program with a cycle time of 1000 ms subscribes every 1000 ms. To
control the intensity, you set a different transfer value interval in the binding
properties of the server value.
You can take a number of steps to minimize the transfer interval intensity and
thereby the network traffic:
• Avoid using alarms and change of value trend logs to monitor values outside of
the Automation Server where the alarm or trend log resides.
• Set the transfer interval for an Automation Server to Automation Server value to
the longest possible time. If possible, avoid intervals of 10 seconds or less.
• Create a server value object so that you can change the transfer interval
manually for a consuming object like a program.
If short update intervals are required, you need to monitor the CPU and memory
usage of the Automation Server where the value resides. If the CPU and memory
usage are high, limit the number of receivers of the value transfer. If you need to
transfer the value to many receivers, consider a cascading structure where the
Automation Server transfers the value to a few receivers and the few receivers, in
turn, transfer the value to a few receivers.

15.14.2

Server Value Workflow
Using a server value is a four-part process:
• Create a server value object on the Automation Server where the program
resides. For more information, see section 15.15 “Creating a Server Value” on
page 440.
• Bind the server value object to read the value from the other Automation
Server. For more information, see section 15.3 “Binding Values Manually” on
page 416.
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• Configure the transfer interval. For more information, see section 15.8
“Configuring the Value Transfer Interval” on page 428.
• Bind the server value object to the program input. For more information, see
section 15.3 “Binding Values Manually” on page 416.
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15.15

Creating a Server Value
You create server value when you want a value that is not part of a device. For more
information, see section 15.14 “Server Values” on page 438.

To create a server value
1. In WorkStation, on the File menu, point to New, and then click Value.
2. In the object type list, select value you want to create.
3. In the Name box, type a name for the value.
4. In the Description box, type a description for the value.
5. Click Create.

Technical
442

04-16006-04-en, March 2015

15 Bindings
15.16 Creating a Server Analog Value

15.16

Creating a Server Analog Value
You create analog values in the Automation Server or Enterprise Server for the
following reasons:
• A variable needs to be bound to multiple programs.
• A calibrated analog input variable needs to be forced.
For more information, see section 15.1 “Bindings Overview” on page 411.

To create a server analog value
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to add an analog value.
2. On the File menu, point to New and then click Value.
3. In the object type list, select Analog Value.

4. In the Name box, type a name for the analog value.
5. In the Description box, type a description for the analog value.
6. Click Create.
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15.17

Configuring the Value and the Unit for a
Server Analog Value
You configure the value and the unit for a server analog value to ensure that the
server analog value holds the value and the unit as required by the project.
For more information, see section 15.1 “Bindings Overview” on page 411.

To configure the value and the unit for a server analog value
1. In WorkStation, in the System Tree pane, select the server analog value you
want to configure.
2. On the File menu, click Properties.

3. Under Status Information, click the Configure button

.
Continued on next page
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4. Select the Configured box that is in front of the Unit box.

5. In the Unit box, enter the unit.
6. Click OK.
Continued on next page
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7. In the Value box, enter the value.

8. Click OK.
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15.18

Creating a Server Digital Value
You create digital values in the Automation Server or Enterprise Server for the
following reasons:
• A variable needs to be bound to multiple programs.
• A digital schedule or an alarm needs to send information to a program.
For more information, see section 15.1 “Bindings Overview” on page 411.

To create a server digital value
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to add a digital value.
2. On the File menu, point to New and then click Value.
3. In the object type list, select Digital Value.

4. In the Name box, type a name for the digital value.
5. In the Description box, type a description for the digital value.
6. Click Create.
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16.1

Binding Templates
You can bind values automatically by using binding templates, that is, predefined
templates.

Figure: Binding a value by using a binding template

16.1.1

Purpose of Binding Templates
The purpose of binding templates is to automate repetetive tasks. Biding templates
are typically used for objects and binding patterns that are frequently reused. To
use a binding template for a binding task, you need to have a binding template
prepared for that particular task.

16.1.2

Binding Template Location
Binding templates are listed in the Binding Templates folder of the server you are
logged on to. The Binding Templates folder is a system folder under each server.
When you are logged on to an Enterprise Server, only binding templates located on
the Enterprise Server are accessible. The binding templates located on the
Enterprise Server can be used to bind objects on the Automation Servers that are
connected to the Enterprise Server.
When you are logged on to an Automation Server, only binding templates located
on the Automation Server are accessible.
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16.1.3

How to Use Binding Templates
Binding values between objects using a template works similarly to binding
manually. Instead of dragging individual values to properties in the Binding list, you
drag objects to one of the templates in the Binding templates list. The binding
template automatically pairs up all relevant matches and suggests a list of bindings
for you to confirm.
For example, in the System Tree pane, you select the object to which you want to
bind values, such as a control program. In the binding browser, you browse to the
source object, such as a central heater. You drag the heater object to the template
that you want to apply, presumably a predefined binding template that you saved
the last time you carried out the same task. If you confirm the proposed bindings, all
destination property fields in the control program are populated with the binding
paths that you confirmed.

16.1.4

Binding Template Types
Building Operation comes with a general purpose, ready-to-use, binding template
that is called the Name matching template. The Name matching binding template is
accessible in the Binding template list in the Bindings view. The Name matching
binding template binds values between objects that have identical property names.
Building Operation also provides the means for you to define your own binding
templates.
For more information, see section 16.2 “Binding Template Types” on page 451.
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16.2

Binding Template Types
Building Operation comes with a general purpose, ready-to-use, binding template
that is called the Name matching template. The Name matching binding template is
accessible in the Binding template list in the Bindings view. The Name matching
binding template binds values between objects that have identical property names.
Building Operation also provides the means for you to define your own binding
templates.
There are two binding templates typs that you can define:
• Type Binding Templates
• Path Matching Binding Templates

16.2.1

Type Binding Templates
You define and create a Type binding template to automate a binding task between
two LonWorks devices. When you define a Type binding template, you associate
specific properties in a LonWorks device with specific properties in another
LonWorks device.
For more information, see section 16.3 “Type Binding Templates” on page 452.

16.2.2

Type Binding Template Examples
You define and create a Type binding template to automate a binding task between
two LonWorks devices. When you define a Type binding template, you associate
specific properties in a LonWorks device with specific properties in another
LonWorks device.
For more information, see section 16.4 “Type Binding Template Examples” on page
453.

16.2.3

Path Matching Binding Templates and Syntax
You define and create a Path matching template, to automate a binding task for an
object type, which binds values from one or several objects based on path
matching rules.
For more information, see section 16.8 “Path Matching Binding Templates and
Syntax” on page 469.

16.2.4

Path Matching Binding Template Examples
This is an example system with five path matching binding templates. If new rooms
with LonWorks devices (Xenta controllers) are added to the system, or new air
handling units are added to the system, the binding templates are used to
autogenerate the bindings that are involved in the system expansion.
For more information, see section 16.11 “Path Matching Binding Template
Examples” on page 473.
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16.3

Type Binding Templates
You define and create a Type binding template to automate a binding task between
two LonWorks devices. When you define a Type binding template, you associate
specific properties in a LonWorks device with specific properties in another
LonWorks device.
Where as the predefined Name matching binding template binds values that have
identical property names, you can define Type binding templates to associate any
properties between two LonWorks devices, as long as the destination and source
values are compatible.

Figure: Type binding template workflow

You can also create a Type binding template from instance, making the existing
bindings between two LonWorks devices reusable.
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16.4

Type Binding Template Examples
This is an example system with three binding templates, in this case Type binding
templates. If a new room with LonWorks devices (Fan Coil and Temperature
Sensor) is added to the system, the binding templates are used to autogenerate the
bindings that are involved in the system expansion.
The example system is depicted in the illustration below:

Figure: Example system

The example system has four LonWorks devices. There is a main Zone Controller
and a main Occupancy Sensor. There is also a Fan Coil and a Temperatur Sensor in
a room (1). The devices communicate through the LonWorks bus.
The example system is set up in Building Operation as depicted in the
screenshot/illustration below:
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Figure: Example System Tree pane

The screenshot/illustration above shows how the example System Tree pane
relates to the example system model. The screenshot/illustration below shows how
the example System Tree pane is expanded with another room (2):
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Figure: Example System Tree expansion

The example system has three type binding templates that you can use to
autogenerate bindings if you add more rooms.

Figure: Example binding list

All binding templates are based on the Fan Coil because when you add a new
room, the new Fan Coil in that room is either the destination or the source for all the
new bindings that can be created.
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16.4.1

Fan Coil – Bind to Zone Controller
In this example a new room (2) is added. You use the template described in this
example to autogenerate one of the two bindings between the new room 2 Fan Coil
and the main Zone Controller. The other binding must be created manually.
For more information, see section 16.5 “Fan Coil - Bind to Zone Controller” on page
457.

16.4.2

Fan Coil – Bind to Occupancy Sensor
In this example a new room (2) has been added and the bindings between the new
Fan Coil and the Zone Controller have already been created. You use the template
described in this example to autogenerate the binding between the new room 2 Fan
Coil and the main Occupancy Sensor.
For more information, see section 16.6 “Fan Coil - Bind to Occupancy Sensor” on
page 461.

16.4.3

Fan Coil – Bind to Temperature Sensor
In this example a new room (2) has been added and the bindings between the new
Fan Coil, the Zone Controller, and the Occupancy Sensor have already been
created. You use the template described in this example to autogenerate the
bindings between the new room 2 Fan Coil and the new room 2 Temperature
Sensor.
For more information, see section 16.7 “Fan Coil - Bind to Temperature Sensor ” on
page 465.
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16.5

Fan Coil - Bind to Zone Controller
In this example a new room (2) is added. You use the template described in this
example to autogenerate one of the two bindings between the new room 2 Fan Coil
and the main Zone Controller. The other binding must be created manually.
The example system on which this binding template example is based on, is
described in an introductory section. For more information, see section 16.4 “Type
Binding Template Examples” on page 453.
The illustration below shows the expansion of the example system:

Figure: System expansion

The new room 2 Fan Coil can have the same bindings to the Zone Controller as the
room 1 Fan Coil.
The properties and values that can be bound between the Fan Coil and the Zone
Controller are shown in the screenshot/illustration below:
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Figure: The values that can be bound

The new Fan Coil nvoTerminalLoad property that can be bound to the Zone
Controller nviTerminalLoad2 SNVT value, must be bound manually because each
new Fan Coil will bind to a new unique (the next available) SNVT in the list. Fan Coil
3 will bind to nviTerminalLoad3, Fan Coil 4 will bind to nviTerminalLoad4, and so on.
This binding cannot be defined in the template.
However, the other binding can be defined in a template because it binds the same
Zone Controller value to the same property in every new room Fan Coil that is
added. To define a type binding template that takes care of this binding, you create
one based on the Fan Coil LonWorks device type (120FC), and associate it with the
Zone Controller LonWorks device type (ZoneController), and associate the values
that can be bound:
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Figure: Associating type properties

The screenshot below shows how you apply this template. You select the new Fan
Coil in the System Tree pan, open the Binding view, and drag the Zone Controller to
the binding template:

Figure: Dragging the Zone Controller to the binding template

The template will match the property of the Fan Coil with the value in the Zone
Controller and display a binding confirmation dialog box:
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Figure: Found matches

When you confirm the binding suggested in the dialog box, it will appear in the
Binding point list of the Fan Coil. Now you must also create the other binding
manually that was mentioned earlier:

Figure: Dragging the Zone Controller value manually to the Fan Coil property

At this point you can choose to save the bindings and the task will be complete.
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16.6

Fan Coil - Bind to Occupancy Sensor
In this example a new room (2) has been added and the bindings between the new
Fan Coil and the Zone Controller have already been created. You use the template
described in this example to autogenerate the binding between the new room 2 Fan
Coil and the main Occupancy Sensor.
The example system on which this binding template example is based on, is
described in an introductionary section. For more information, see section 16.4
“Type Binding Template Examples” on page 453.
The illustration below shows the expansion of the example system:

Figure: System expansion

The new room 2 Fan Coil can have the same bindings to the Occupancy Sensor as
the room 1 Fan Coil.
The properties and values that can be bound between the Fan Coil and the
Occupancy Sensor are shown in the screenshot/illustration below:
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Figure: The values that can be bound

To define a type binding template that takes care of this binding, you create one
based on the Fan Coil LonWorks device type (120FC), and associate it with the
Occupancy Sensor LonWorks device type (occupSensor), and associate the values
that can be bound:
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Figure: Associating type properties

The screenshot below shows how you apply this template. You select the new Fan
Coil in the System Tree pane, open the Binding view, and drag the Occupancy
Sensor to the binding template:

Figure: Dragging the Occupancy Sensor to the binding template

The template will match the property of the Fan Coil with the value in the
Occupancy Sensor and display a binding confirmation dialog box:
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Figure: Found matches

When you confirm the binding suggested in the dialog box, it will appear in the
Bindning list of the Fan Coil. At this point you can choose to save the bindings and
the task will be complete.
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16.7

Fan Coil - Bind to Temperature Sensor
In this example a new room (2) has been added and the bindings between the new
Fan Coil, the Zone Controller, and the Occupancy Sensor have already been
created. You use the template described in this example to autogenerate the
bindings between the new room 2 Fan Coil and the new room 2 Temperature
Sensor.
The example system on which this binding template example is based on, is
described in an introductionary section. For more information, see section 16.4
“Type Binding Template Examples” on page 453.
The illustration below shows the expansion of the example system:

Figure: System expansion

The new room 2 Fan Coil can have the same bindings to the new room 2
Temperature Sensor as the room 1 Fan Coil has to its room 1 Temperature Sensor.
The properties and values that can be bound between the Fan Coil and the
Temperature Sensor are shown in the screenshot/illustration below:
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Figure: The values that can be bound

To define a Type binding template that takes care of these bindings, you create one
based on the Fan Coil LonWorks device type (120FC), and associate it with the
Temperature Sensor LonWorks device type (STR350), and associate the values
that can be bound:
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Figure: Associating type properties

The screenshot below shows how you apply this template. You select the new Fan
Coil in the System Tree pane, open the Binding view, and drag the Temperature
Sensor to the binding template:
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Figure: Dragging the Temperature Sensor to the binding template

The template will match the properties of the Fan Coil with the values in the
Temperature Sensor and display a binding confirmation dialog box:

Figure: Found matches

When you confirm the bindings suggested in the dialog box, they will appear in the
Binding point list of the Fan Coil. At this point you can choose to save the bindings
and the task will be complete.
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16.8

Path Matching Binding Templates and
Syntax
You define and create a Path matching template, to automate a binding task for an
object type, which binds values from one or several objects based on path
matching rules.
You can define Path matching binding templates for just about any type and for
general use, whereas Type binding templates are defined to associate specific
properties between LonWorks devices.

16.8.1

Path Matching
A Path matching binding template examines and binds values according to a list of
path matching rules. The list can have one or more path matching rules.
For more information, see section 16.9 “Path Matching” on page 470.

16.8.2

Path Syntax
Normally a path is comprised of text elements and path separators:
/ServerName/ObjectName/PropertyName
In the path matching list, you can also use identifier elements and wildcards.
Identifiers and wildcards however, cannot be directly adjacent, but must be
separated by text elements or path separators:
/{ServerName}/*/Temp*
For more information, see section 16.10 “Path Syntax” on page 471.
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16.9

Path Matching
A Path matching binding template examines and binds values according to a list of
path matching rules. The list can have one or more path matching rules.

Figure: List of path matching rules

When you create a Path matching binding template, you base it on an object type,
for example a Function block program. You probably create the template for a
specific Function block program, setting up rules for binding values to other specific
objects, but not necessarily. You can also define a template for a more general use.
When you use the template, the Selected object is, for example, a Function block
program that you have selected in the System Tree pane. The Candidate object is
any object or folder that you drag to this template and that has values that can bind
to the Selected object.
Each rule specifies a property or the path to a property in the Selected object. Each
rule also specifies a value or the path of a value in the Binding candidate. If a value is
found in the Binding candidate, as specified, it is bound to the property that is
specified for the Selected object.
The template examines each rule until the end of the list. If the Candidate object is
actually an entire folder with many objects, all values of each object are tried one
after the other. Theoretically, you can drag the entire system to the template but it
will take a long time to process.
One rule can bind many values. However, the order in which rules are stated can
affect which values are bound. A property in the Selected object that has been
bound once is not bound again.
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16.10

Path Syntax
Normally a path is comprised of text elements and path separators:
/ServerName/ObjectName/PropertyName
In the path matching list, you can also use identifier elements and wildcards.
Identifiers and wildcards however, cannot be directly adjacent, but must be
separated by text elements or path separators:
/{ServerName}/*/Temp*
Table: Syntax Description
Syntax in Paths

Description

PlainText

Text element
You use plain text to specify values,
properties, objects, folders, devices, and
servers in the paths.

{MyID}

Identifier element
You use identifiers, enclosed in curly
brackets, to state where elements must be
equal in both the paths of a rule.

/

Path separator
You use path separators to further specify a
path. The more you specify a path, the more
conditions you impose on possible
candidates, and the more you narrow down
the search.

*

Wildcard
You use wildcards to substitute any
character or any sequence of characters.
However, a wildcard does not substitute
path separators.

Sometimes, the path is only the property name:
PropertyName
In this case, the template looks for a property called PropertyName in the
Selected/Candidate object.
Sometimes the path is only the property name and the name of its value:
PropertyName.Value
Somtimes there is a path separator involved that further specifies the
property/value:
ObjectName/PropertyName
In this case, the template looks for a property called PropertyName that has a
parent object called ObjectName.
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If you impose many conditions, that is specifying a long path, you will be narrowing
down the search. You can also widen the search with wildcards, but then again
impose conditions on both paths in the rule by using identifiers. Identifiers state
which elements must be identical in the two paths of a rule.
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16.11

Path Matching Binding Template
Examples
This is an example system with five path matching binding templates. If new rooms
with LonWorks devices (Xenta controllers) are added to the system, or new air
handling units are added to the system, the binding templates are used to
autogenerate the bindings that are involved in the system expansion.
The example system has one air handling unit. The Automation Server has one
application folder with required logic and I/O to control and monitor these air
handling units. The application folder also holds a Graphic (UI) that an operator can
use to supervise and manage the air controller unit.

Figure: Example system

The example system also has three Lonwork devices (Xenta controllers), in three
rooms, on one floor. The Automation Server has one Graphic (UI) for each room,
and one Graphic (UI) for the entire floor so that an operator can supervise the
rooms. The Automation Server is connected to the Xenta controllers through a
LonWorks bus.
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Figure: Example System Tree pane

The example system has five path matching binding templates that you can use to
autogenerate bindings when you expand the system.

Technical
476

04-16006-04-en, March 2015

16 Binding Templates
16.11 Path Matching Binding Template Examples

Figure: Example Binding list

16.11.1

Path Matching Binding Template Example 1
In this example, a new room with a LonWorks device (Xenta controller) has been
added. When you add a Xenta controller, a new room Graphic (UI) is added as well
so that the operator can supervise the room.
For more information, see section 16.12 “Path Matching Binding Template Example
1” on page 477.

16.11.2

Path Matching Binding Template Example 2
In this example, a floor Graphic (UI) has been created. The floor Graphic (UI) collects
information from the LonWorks devices (Xenta controllers) in all rooms and serves
as an overview for the operator that supervises the rooms on that floor.
For more information, see section 16.13 “Path Matching Binding Template Example
2” on page 482.

16.11.3

Path Matching Binding Template Example 3
In this example, a new Air Handling Unit (AHU) has been added. When you add an
air handling unit, a new Application folder is created in the Automation Server. The
Application folder holds the Program, Alarms, Logs, and Schedules (MODE)
configuration that is needed to control and monitor the air handling unit. The
Application folder also holds a Graphic (UI) so that the operator can supervise the
air handling unit.
For more information, see section 16.14 “Path Matching Binding Template Example
3” on page 488.

16.11.4

Path Matching Binding Template Example 4
In this example, a new Air Handling Unit (AHU) has been added. When you add an
air handling unit, a new Application folder is created in the Automation Server. The
Application folder holds the Program, Alarms, Logs, and Schedules (MODE)
configuration that is needed to control and monitor the air handling unit. The
Application folder also holds a Graphic (UI) so that the operator can supervise the
air handling unit.
For more information, see section 16.15 “Path Matching Binding Template Example
4” on page 493.
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16.11.5

Path Matching Binding Template Example 5
In this example, a new Air Handling Unit (AHU) has been added. When you add an
air handling unit, a new Application folder is created in the Automation Server. The
Application folder holds the Program, Alarms, Logs, and Schedules (MODE)
configuration that is needed to control and monitor the air handling unit. The
Application folder also holds a Graphic (UI) so that the operator can supervise the
air handling unit.
For more information, see section 16.16 “Path Matching Binding Template Example
5” on page 500.
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16.12

Path Matching Binding Template
Example 1
In this example, a new room with a LonWorks device (Xenta controller) has been
added. When you add a Xenta controller, a new room Graphic (UI) is added as well
so that the operator can supervise the room.

Figure: System expansion

The example system on which this binding template example is based on, is
described in an introductionary section. For more information, see section 16.11
“Path Matching Binding Template Examples” on page 473.
You use the template described in this example to autogenerate all the bindings
between the room Graphic (UI) and the Xenta controller.
The room Graphic (UI) will have the same bindings to the Xenta controller as the
other room Graphics (UI) have to their Xenta controllers. When you define a path
matching binding template and reuse bindings, the naming of folders, objects, and
properties must be consistent.
When you create the room Graphic (UI), the properties that can bind to values in the
Xenta device must incorporate the name of the SNVT, the member, and the value
that they bind to.
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For example, naming a property in the room Graphic (UI)
nciSetpoints.Occupied cooling setpoint.Value makes it possible to
define a path matching rule that will bind it to the "Value" of the "Occupied cooling
setpoint" member, of the "nciSetpoints" SNVT in a Xenta device.
Properties and values are bound between the room Graphic (UI) and the Xenta
controller:

Figure: The values that can be bound.

To define a path matching binding template that binds these properties and values,
you create a template based on the Graphic type and define the path matching
rules:
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Figure: Path matching rules

There are two rules in this template. Each rule has a property specified for the
Selected object, in this case the room Graphic (UI). The Binding candidate, for
example, the room Xenta controller or the entire LonWorks bus, also has a
value/path specified. When you drag the Xenta controller to this template, the
template searches for any value in that collection that corresponds to the Binding
candidate value/path that is specified in this rule. If a match is found, the property of
the room Graphic (UI) is bound with the matching value in the Xenta controller. Each
rule is examined in sequence. For more information, see section 16.8 “Path
Matching Binding Templates and Syntax” on page 469.
In WorkStation, you can drag the Xenta controller, the entire LonWorks bus, or the
entire system to the template. The bigger the collection you drag to the template,
the longer it takes for the template to search for matching values.
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Figure: Dragging the Xenta controller to the Graphic binding template

The template matches the properties of the Graphic (UI) with the values in the Xenta
controller and displays a binding confirmation dialog box:

Figure: Found matches

When you click OK, the bindings are displayed in the Binding list of the Graphic (UI).
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Figure: Graphic (UI) Binding list

Instead of searching and manually binding 11 values, you have reduced the
procedure into a one-step-task with less chance of making mistakes. It takes some
effort to define a template but it is well worth the effort for configurations that you
frequently reuse.
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16.13

Path Matching Binding Template
Example 2
In this example, a floor Graphic (UI) has been created. The floor Graphic (UI) collects
information from the LonWorks devices (Xenta controllers) in all rooms and serves
as an overview for the operator that supervises the rooms on that floor.

Figure: System expansion

The example system on which this binding template example is based on, is
described in an introductionary section. For more information, see section 16.11
“Path Matching Binding Template Examples” on page 473.
You use the template described in this example to autogenerate all the bindings
between the floor Graphic (UI) and the Xenta controllers on that floor.
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The floor 1 Graphic (UI) binds to all Xenta controllers on floor 1. The floor Graphic
(UI) can also be reused if more floors with identical room configurations are added.
The binding template in this example autogenerates the bindings between the floor
Graphic (UI) and the Xenta controllers and can also be reused if more floors with
identical room configurations are added. When you define a path matching binding
template and reuse bindings, the naming of folders, objects, and properties must
be consistent.
When you create the floor Graphic (UI), the properties that bind to values in the
Xenta devices must incorporate the name of the device, the SNVT, the member,
and the value that they can bind to.
For example, naming a property in the floor Graphic (UI)
Room0101.nvoOccSensor.Value makes it possible to define a path matching
rule that binds it to the "Value" of the "nvoOccSensor" SNVT in the "Room0101"
Xenta device.
Properties and values are bound between the floor Graphic (UI) and the Xenta
controllers:

04-16006-04-en, March 2015

Technical
485

16 Binding Templates
16.13 Path Matching Binding Template Example 2

Figure: The values that can be bound

To define a Path matching binding template that binds these properties and values,
you create a template based on the Graphic type and define the Path matching
rule:
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Figure: Path matching rule

There is one rule in this template. The rule has a property specified for the Selected
object, in this case the floor Graphic (UI). The Binding candidate, for example the
Floor01 folder on the LonWorks bus or the entire LonWorks bus, also has a
value/path specified. When you drag the Floor01 folder to this template, the
template searches for any value in that collection that corresponds to the Binding
candidate value/path that is specified in this rule. If a match is found, the property of
the floor Graphic (UI) is bound with the matching value in the Xenta controller. For
more information, see section 16.8 “Path Matching Binding Templates and Syntax”
on page 469.
In WorkStation, you can drag the Floor01 folder, the entire LonWorks bus, or the
entire system to the template. The bigger the collection you drag to the template,
the longer it takes for the template to search for matching values.
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Figure: Dragging the Floor01 folder to the Bind to Multiple Xentas binding template

The template matches the properties of the floor Graphic (UI) with the values in the
Xenta controllers and displays a binding confirmation dialog box:

Figure: Found matches

When you click OK, bindings are displayed in the Binding list of the floor Graphic
(UI).
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Figure: Floor Graphic (UI) Binding list

Instead of searching and manually binding 12 values, you have reduced the
procedure into a one-step-task with less chance of making mistakes. It takes some
effort to define a template but it is well worth the effort for configurations that you
frequently reuse.
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16.14

Path Matching Binding Template
Example 3
In this example, a new Air Handling Unit (AHU) has been added. When you add an
air handling unit, a new Application folder is created in the Automation Server. The
Application folder holds the Program, Alarms, Logs, and Schedules (MODE)
configuration that is needed to control and monitor the air handling unit. The
Application folder also holds a Graphic (UI) so that the operator can supervise the
air handling unit.

Figure: System expansion

The example system on which this binding template example is based on, is
described in an introductory section. For more information, see section 16.11 “Path
Matching Binding Template Examples” on page 473.
You use the template described in this example to autogenerate all the bindings
between the Application folder Program and the Air Handling Unit I/O.
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The new AHU 2 Application folder Program will have the same bindings to its Air
Handling Unit I/O as the AHU 1 Program has to its Air Handling Unit I/O. The
Program, the IO, and the naming of folders, objects and properties, is identical in
the two Application folders. Therefore, we can use the same binding template that
was defined for AHU 1, to bind the AHU 2 Program to its air handling unit.
The application folder, in which the application Program resides, must incorporate
the name of the air handling unit that it will control. Also, the air handling unit I/O
binding points must incorporate both the name of its air handling unit and the name
of the program properties that they bind to.
For example, naming an I/O binding point of the AHU02 air handling unit 06AHU02-DAT makes it possible to define a Path matching rule that binds it to the
"DAT" property in the application Program of the "AHU02" application folder.
Properties and values are bound between the application Program and its Air
Handling Unit I/O:

Figure: The values that can be bound

To define a Path matching binding template that binds these properties and values,
you create a template based on the Function block program type and define the
Path matching rules:
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Figure: Path matching rules

There are three rules in this template. Each rule has a property specified for the
Selected object, in this case the application Program. The Binding candidate, in this
case the I/O bus, also has a value/path specified. When you drag the I/O bus to this
template, the template searches for any value in that collection that corresponds to
the Binding candidate value/path that is specified in this rule. If a match is found, the
property of the Program is bound with the matching value in the I/O bus. Each rule
is examined in sequence. For more information, see section 16.8 “Path Matching
Binding Templates and Syntax” on page 469.
In WorkStation, you drag the I/O bus to the Bind to I/O Binding template.
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Figure: Dragging the I/O bus to the Bind to I/O Binding template

The template matches the properties of the AHU 2 application Program with the
values in the I/O bus and displays a binding confirmation dialog box:

Figure: Matching values

When you click OK, the bindings are displayed in the Binding point list of the
application program:
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Figure: Application Program Binding list

Instead of searching and manually binding 10 values, you have reduced the
procedure into a one-step-task with less chance of making mistakes. It takes some
effort to define a template but it is well worth the effort for configurations that you
frequently reuse.
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16.15

Path Matching Binding Template
Example 4
In this example, a new Air Handling Unit (AHU) has been added. When you add an
air handling unit, a new Application folder is created in the Automation Server. The
Application folder holds the Program, Alarms, Logs, and Schedules (MODE)
configuration that is needed to control and monitor the air handling unit. The
Application folder also holds a Graphic (UI) so that the operator can supervise the
air handling unit.

Figure: System expansion

The example system on which this binding template example is based on, is
described in an introductionary section. For more information, see section 16.11
“Path Matching Binding Template Examples” on page 473.
You use the template described in this example to autogenerate all the bindings
between the Application folder Program and the Alarms, Logs, and Schedules
(MODE) configuration.
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The new AHU 2 application Program will have the same bindings to its application
configuration as the application Program in AHU 1 has to its application
configuration. The configuration and the naming of folders, objects and properties,
is identical in the two Application folders. Therefore, we can use the same binding
template that was defined for AHU 1, to bind the AHU 2 application Program to its
application configuration.
When you create the Alarms, Trend logs, and Schedules, the name of the object
that bind to the application Program must incorporate the name of the program
properties that they bind to.
For example, naming an Alarm RF Alarm makes it possible to define a Path
matching rule that binds it to the "RF_A" property in the application Program.
Properties and values are bound between the Program and the application
configuration:
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Figure: The values that can be bound

As can be seen in this instance, the binding direction of most bindings is from the
Program to the application configuration. The direction of a binding is not
necessarily from the binding candidate to the selected object. The direction can be
defined either way.
To define a Path matching binding template based on this example, you create a
template based on the Function block program type and define the Path matching
rules:
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Figure: Path matching rules

There are six rules in this template. Each rule has a property specified for the
Selected object, in this case the application Program. The Binding candidate, for
example the application AHU02 folder or the parent Application folder, also has a
value/path specified. When you drag the AHU02 folder to this template, the
template searches for any value in that collection that corresponds to the Binding
candidate value/path that is specified in this rule. If a match is found, the property of
the Program is bound with the matching value in the AHU02 folder. Each rule is
examined in sequence. For more information, see section 16.8 “Path Matching
Binding Templates and Syntax” on page 469.
In WorkStation, you can drag the application AHU02 folder, the parent Application
folder, or the entire system to the template. The bigger the collection you drag to
the template, the longer it takes for the template to search for matching values.
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Figure: Dragging the AHU02 folder to the Bind to Unit binding template

The template matches the properties of the application Program with the values in
the application AHU02 folder and displays a binding confirmation dialog box:

04-16006-04-en, March 2015

Technical
499

16 Binding Templates
16.15 Path Matching Binding Template Example 4

Figure: Matching values

When you click OK, the bindings are displayed in the Binding list of the application
Program:
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Figure: Application Program Binding list

Instead of searching and manually binding 11 values, you have reduced the
procedure into a one-step-task with less chance of making mistakes. It takes some
effort to define a template but it is well worth the effort for configurations that you
frequently reuse.
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16.16

Path Matching Binding Template
Example 5
In this example, a new Air Handling Unit (AHU) has been added. When you add an
air handling unit, a new Application folder is created in the Automation Server. The
Application folder holds the Program, Alarms, Logs, and Schedules (MODE)
configuration that is needed to control and monitor the air handling unit. The
Application folder also holds a Graphic (UI) so that the operator can supervise the
air handling unit.

Figure: System expansion

The illustration below shows the new Application folder, the red marked and
underlined application Graphic (UI) and the red marked application configuration
that have values that can be bound to the application Graphic (UI).
You use the template described in this example to autogenerate all the bindings
between the Application folder Graphic (UI) and the Program, Alarms, Logs, and
Schedules (MODE) configuration.
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The new AHU 2 application Graphic (UI) have the same bindings to its application
configuration as the application Graphic (UI) in AHU 1 has to its application
configuration. The configuration and the naming of folders, objects and properties,
is identical in the two Application folders. Therefore we can use the same binding
template that was defined for AHU 1, to bind the AHU 2 application Graphic (UI) to
its application configuration.
When you create the application Graphic (UI), the properties that bind to values in
the application Program, the Alarms, the Trend logs, and the Schedules, must
incorporate the name of the object or property value that they bind to.
For example, naming a property in the application Graphic (UI) CWV.Value makes
it possible to define a Path matching rule that binds it to the "Value" of the "CWV"
property in the application.
Properties and values are bound between the application Graphic (UI) and its
application configuration:
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Figure: The values that can be bound

To define a Path matching binding template that binds these properties and values,
you create a template based on the Graphic type and define the Path matching
rules:
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Figure: Path matching rules

There are three rules in this template. Each rule has a property specified for the
Selected object, in this case the application Graphic (UI). The Binding candidate, for
example the AHU02 folder or the entire Application folder, also has a value/path
specified. When you drag the AHU02 folder to this template, the template searches
for any value in that collection that corresponds to the Binding candidate value/path
that is specified in this rule. If a match is found, the property of the application
Graphric (UI) is bound with the matching value in the AHU02 folder. Each rule is
examined in sequence. For more information, see section 16.8 “Path Matching
Binding Templates and Syntax” on page 469.
In WorkStation, you can drag the AHU02 folder, the entire Application folder, or the
entire system to the template. The bigger the collection you drag to the template,
the longer it takes for the template to search for matching values.
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Figure: Dragging the AHU02 folder to the Bind to Unit binding template

The template matches the properties of the application Graphic (UI) with the values
in the AHU02 folder and displays a binding confirmation dialog box:
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Figure: Found matches

When you click OK, the bindings are displayed in the Binding list of the application
Graphic (UI):

Figure: Application Graphic (UI) Binding list

04-16006-04-en, March 2015

Technical
507

16 Binding Templates
16.16 Path Matching Binding Template Example 5

Instead of searching and manually binding 16 values, you have reduced the
procedure into a one-step-task with less chance of making mistakes. It takes some
effort to define a template but it is well worth the effort for configurations that you
frequently reuse.
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16.17

Binding Values Using a Binding
Template
You use binding templates to reduce engineering time when creating bindings.
Binding templates are defined and created for binding patterns that are frequently
reused.
Using binding templates, you create bindings between the Automation Server
program variables, internal values, and I/O points using the following recommended
process:
• First, bind the Automation Server IO Bus to each of the Programs in the
Automation Server that requires data flow with the I/O points.
• Next, bind the Internal Variables to each of the Programs in the Automation
Server that requires data flow with Internal Variables.
• Then, bind each of the individual Programs to all other Programs that require
data flow with other Programs.
• Finally, bind any time schedules and alarms that are required as part of the
programmed control logic.

Tip
• When creating bindings, follow the recommended general guidelines: create
bindings between Inputs and Outputs only and do not create bindings to
Public Signals.
For more information, see section 16.1 “Binding Templates” on page 449.

To bind values using a binding template
1. In WorkStation, in the System Tree pane, select the object that you want to
bind values to.
2. On the Actions menu, click Edit bindings.
Continued on next page
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3. In the binding point browser, drag the object or folder to the binding template
that you want to apply.

4. Select the bindings that you want to create.

5. Click OK.
Continued on next page
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6. Verify that all bindings are correctly bound.

7. On the File menu, click Save.

Tip
• To ensure data flow is occurring as intended, use the Watch pane to view
values and monitor changes.
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16.18

Binding Values in Script Editor Using a
Binding Template
You use binding templates to reduce engineering time when creating bindings for
variables and functions within a Script program. Binding templates are defined and
created for binding patterns that are frequently reused. You can access the
Bindings view without leaving Script Editor.
For more information, see section 16.1 “Binding Templates” on page 449.

To bind values in Script Editor using a binding template
1. In Script Editor, click Bindings to display the Bindings view for the Script
program.
2. In the binding point browser, drag the object or folder to the binding template
that you want to apply.

Continued on next page
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3. Select the bindings that you want to create.

4. Click OK.
5. Verify that all bindings are correctly bound.

6. On the toolbar, click Save.
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16.19

Creating a Type Binding Template from
Instance
You create a type binding template from instance, to automate a binding task, by
reusing the existing bindings between two LonWorks devices.

Note
• The type binding template is only applicable between two LonWorks devices.
For more information, see section 16.1 “Binding Templates” on page 449.

To create a Type binding template from instance
1. In WorkStation, in the System Tree pane, right-click the object that holds the
binding pattern that you want to save and reuse, and click Edit bindings.
2. On the toolbar, click the Create a Type binding template from instance
button

.

Continued on next page
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3. In the Name box, type a name for the template.

4. In the Description box, type a description for the template.
5. In the Type list, select the type on which you will base this template.
6. Click OK.
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16.20

Creating a Type Binding Template
You define and create a Type binding template to automate a binding task between
two LonWorks devices. When you define a Type binding template, you associate
specific properties in a LonWorks device with specific properties in another
LonWorks device.

Note
• The Type binding template is only applicable on LonWorks devices.
For more information, see section 16.3 “Type Binding Templates” on page 452.

To create a Type binding template
1. In WorkStation, in the System Tree pane, in the System folder, select
Binding templates.
2. On the File menu, point to New and then click Binding template.
3. In the object list, select Type Binding Template.

4. In the Name box, type a name for the template.
5. In the Description box, type a description for the template.
6. Click Next.
Continued on next page
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7. Select the LonWorks device, on which this template will be based.

8. Click Next.
9. Select the LonWorks devices that hold values, which will be bound to the type
on which this template is based, and then click the Add button

.

10. Click Next.
Continued on next page
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11. Drag values to the Binds to property boxes.

12. Click Create.
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16.21

Creating a Path Matching Binding
Template
You define and create a Path matching template, to automate a binding task for an
object type, which binds values from one or several objects based on path
matching rules.
For more information, see section 16.8 “Path Matching Binding Templates and
Syntax” on page 469.

To create a path matching binding template
1. In WorkStation, in the System Tree pane, in the System folder, select
Binding templates.
2. On the File menu, point to New and then click Binding template.
3. In the object type list, select Path Matching Binding Template.

4. In the Name box, type a name for the template.
5. In the Description box, type a description for the template.
6. Click Next.
Continued on next page
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7. Select the type, on which this template will be based.

8. Click Next.
9. In the Selected object box, type the property or the path to the property
that you want to bind.

Note
• Paths can be full or partial. Values, properties, and paths can
also contain identifiers and wildcards.
Continued on next page
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10. In the Binding candidate box, type a value or the path to a value that you
want to find and bind.

Note
• If a value is found in the Binding candidate, as specified, it is
bound to the property that is specified for the Selected object.
Paths can be full or partial. Values, properties, and paths can
also contain identifiers and wildcards.

Continued on next page
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11. In the Property box, select if the rule is to match values by their Name,
Description, Note 1, or Note 2 property.
12. Click the Add rule button

to add more path matching rules.

13. Click Create.
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Bindings User Interface

Topics
Bindings View
Bindings Diagnostics
Binding Point List Toolbar
Binding Templates List
Browser Toolbar
Browser
Bind Dialog Box – Select Direction
Bind Dialog Box – Replace or Keep
Bind Dialog Box – Replace or Add
Value Transfer Settings Dialog Box
Variables View Features
Confirm Bindings Dialog Box
Bindings Status Icons
Binding Templates View
Binding Template Wizard – Choosing the Type and Naming
the Object Page
Binding Template Wizard – What Type Do You Want to Bind
in the Template Page
Binding Template Wizard – What Type(s) Do You Want to
Bind to with the Template Page

Binding Template Wizard – Specify the Bindings in The
Template Page
Binding Template Wizard – Specify the Path Matching
Patterns in the Template Page
Binding Template Properties
Edit Binding Template Dialog Box – Type Binding Template
Edit Binding Template Dialog Box – Path Matching Binding
Template
Time Stamp Value Properties

17 Bindings User Interface
17.1 Bindings View

17.1

Bindings View
Use the Bindings view to bind values between objects in the system.

Figure:

Table: Bindings View
Number

Description
Use the toolbar to delete bindings, filter
properties, and create a binding template
from instance. For more information, see
section 17.3 “Binding Point List Toolbar” on
page 526..
Use the Binding templates list to view and
apply Binding templates. For more
information, see section 17.4 “Binding
Templates List” on page 527..
Use the toolbar to lock the Browser and to
filter items in the Browser. For more
information, see section 17.5 “Browser
Toolbar” on page 528.
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Continued
Number

Description
Use the Browser to select and drag a value
to the Binding points list or to the Binding
templates list to create bindings. For more
information, see section 17.6 “Browser” on
page 529.
Use the Binding list to enter the path to the
value that you want to bind. Right-click to
lock or unlock the path. For more
information, see section 15.9 “Locked and
Unlocked Binding Paths” on page 429.
Use the Unit list to view the engineering unit
associated with each property (if any).
Use the Binding point list to view and bind
the values of the object that is selected in the
System Tree pane.
Use the navigation bar to switch the visible
binding point page.
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17.2

Bindings Diagnostics
Use Bindings Diagnostics to check the database for unresolved or invalid
references.

Figure: Bindings Diagnostics

Table: Bindings Diagnostics
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Component

Description

Location

Displays the location of the object.

Name

Displays the name of the object.

Property

Displays the property of the object.

Status

Displays the status of the binding. For more
information, see section 17.13 “Bindings
Status Icons” on page 540.

Reference

Displays the path.
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17.3

Binding Point List Toolbar
Use the toolbar to manage bindings and filter properties in the Binding points list.
Table: Binding Points List Toolbar
Button

Description
Delete all bindings
Click to delete all bindings in the Bindings
points list.
Filter Binding list
Click to filter the Binding points list. You
can hide variables that are already bound.
You can also show the parameters.
Create binding template from
instance
Click to create a binding template based on
the object and the bindings that are
displayed in the Binding points list.
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17.4

Binding Templates List
Use the Binding templates list to apply binding templates.

Figure: Binding template list

Table: Binding Templates List
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Column

Description

Binding templates

Displays your binding templates, which you
can define and use to automate binding
tasks. Building Operation has one
predefined binding template, which is the
Default name matching template.

Description

Displays descriptive text about the binding
template.

[Drop here to apply]

Drag a folder, object, or a value to the box of
the template that you want to apply.
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17.5

Browser Toolbar
Use the Browser toolbar to navigate the bindable values of objects and properties
in the system.
Table: Browser Toolbar
Button

Description
Parent folder
Click to open the parent folder in the
Browser.
Lock/Unlock path
Click to lock the Browser so it stays locked
onto the present folder when you navigate
the System Tree pane.
Lock/Unlock path
Click to unlock the Browser so it displays
what you select in the System Tree pane.
Filter binding browser
Click to filter the properties in the Browser.
You can exclude properties in the Browser
that do not match any of the properties in
the Binding point list, in terms of
engineering unit and data type. You can also
exclude parameters.
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17.6

Browser
Use the Browser to find and drag bindable values to the Binding points list, or
entire folders to the Binding templates list.

Figure: Browser

Table: Browser
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Component

Description

Browser

Select and drag values to the Binding
points list to bind them to the properties of
the selected object. You can also drag
objects and entire folders to applicable
templates in the Binding templates list.
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17.7

Bind Dialog Box – Select Direction
Use this Bind dialog box to select the direction of the binding, when bound values
represent property categories that can be bound either way. With most property
categories, direction is inherent and evident, such as output to input.

Figure: Select direction

Table: Select Direction
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Choice

Description

Choice 1

Select to make the Binding list property the
destination property.

Choice 2

Select to make the dragged property value,
or the typed property path, the destination
property.
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17.8

Bind Dialog Box – Replace or Keep
Use this Bind dialog box to replace or keep the source value of an already bound
destination property.

Figure: Replace or Keep

Table: Replace or Keep
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Choice

Description

Choice 1

Select to replace the bound source value.

Choice 2

Select to keep the bound source value.
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17.9

Bind Dialog Box – Replace or Add
Use this Bind dialog box to replace the destination of a bound source value, or to
add another bindings with the same source value.

Figure: Replace or add

Table: Replace or Add
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Choice

Description

Choice 1

Select to replace the destination property of
the already bound source value.

Choice 2

Select to add the destination property as
another binding that share the same source
value.

04-16006-04-en, March 2015

17 Bindings User Interface
17.10 Value Transfer Settings Dialog Box

17.10

Value Transfer Settings Dialog Box
Use the Value transfer settings dialog box to set the transfer interval for values
between objects in the database.

Figure: Value transfer dialog

Table: Value Transfer Dialog
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Property

Description

Pre-defined interval

Click to select a predefined interval. For
more information, see section 15.6 “Value
Transfer Settings ” on page 420.

Manual interval

Select if you want to use a manual interval.
For more information, see section 15.6
“Value Transfer Settings ” on page 420.

Transfer value each time, even if the
value has not changed

Select if you want to transfer the value even if
it has not changed since the last time it was
sent. For more information, see section 15.6
“Value Transfer Settings ” on page 420.
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Continued
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Property

Description

Transfer only if value change exceeds
'Delta value'

Enter a delta interval. For more information,
see section 15.6 “Value Transfer Settings ”
on page 420.

Transfer interval

Select to use a transfer interval. For more
information, see section 15.6 “Value Transfer
Settings ” on page 420.

Turn off this feature

Select if you do not want to use transfer
interval. For more information, see section
15.6 “Value Transfer Settings ” on page 420.

04-16006-04-en, March 2015

17 Bindings User Interface
17.11 Variables View Features

17.11

Variables View Features
You use the Variables view to view live values, create trend logs, force values, and
to edit parameters in a structured and manageble way.
The Variables view is available in the work area of WorkStation when one of the
following types are selected in the System Tree pane:
• LonWorks device
• Program
• I/O module
The Variables view reflects the content of and object, which is structured in
categories, properties and live values.

Figure: Variables view with expandable categories
04-16006-04-en, March 2015
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The categories can be expanded or collapsed so that you can set up a manageable
overview of properties and live values.
You can also use the Quick Filter box to filter the Variables list. With LonWorks
devices, your typing in the Quick Filter box filters category such as outputs, inputs,
and public signals.

Figure: Filtering categories in the Quick Filter box

With Programs and I/O modules, you type in the Quick Filter box the filter's property
name.
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Figure: Filtering properties in the Quick Filter box

You can also use the toolbar buttons to expand all categories or collapse all
categories. There is also the Property grid that you can show or hide.
If you open the Property grid and multiselect different properties in the Variables list,
their values are displayed together in the Property grid.

Figure: Multiselecting properties
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Multiselecting properties, that are of special interest, in a coherent way makes it
easy for you to view, edit, and force values. The Variable view gives you the ability to
work with live values and parameters alike, in a structured way.
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17.12

Confirm Bindings Dialog Box
Use the Confirm Bindings dialog box to view and confirm applicable bindings.
This dialog box only displays when you apply a binding template.

Figure: Confirm Bindings dialog box

Table: Confirm Bindings Dialog Box
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Column

Description

Binding point

Displays the path to the match. A warning
icon indicates that the value is already
bound. For more information, see section
17.13 “Bindings Status Icons” on page 540.

Binding

Displays the properties in the selected object
that have a match. A warning icon indicates
that the property is already bound. For more
information, see section 17.13 “Bindings
Status Icons” on page 540.

Action

Select to confirm the binding.
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17.13

Bindings Status Icons
This table describes the Bindings status icons.
Table: Bindings Status Icons
Icon

Description
Unresolved
Indicates an unresolved binding due to a number of reasons, for example:
• A binding points to an object or property that does not exist. This may
occur after a copy and paste operation when a new object includes a
property with the same name as a property deleted from the database,
but is incompatible.
• A binding points to an object located on another server. For instance,
the system has not resolved the binding yet so the target object may (or
may not) exist.
• A binding points to an object located on another server that is being
engineered, and server communication is not yet fully synched between
the two servers. Generally, the bindings are automatically resolved.
Warning
Indicates an invalid reference in binding functions, which occurs during an
import of bindings or applying a binding template. For more information, see
section 17.12 “Confirm Bindings Dialog Box” on page 539.
Invalid
Indicates that the system resolved the binding and the object exists.
However, the reference is invalid for some reason. In most cases, the target
property is no longer supported, does not exist in the target object, or the
engineering units are incompatible.
Hover over the icon to view the cause of the invalid status.
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17.14

Binding Templates View
Use the Binding Templates view to manage binding templates. This is where you
create, import, edit, and remove templates.

Figure: Binding templates view

Table: Binding Templates View

04-16006-04-en, March 2015

Column

Description

TypeReference

Displays the object type for each binding
template.

Name

Displays the name of each binding template.

Description

Displays descriptive text about each binding
template.
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17.15

Binding Template Wizard – Choosing
the Type and Naming the Object Page
Use the Choosing the Type and Naming the Object page to choose the type
of binding template you want to create and configure it.

Figure: Choosing the Type and Naming the Object page

Table: Choosing the Type and Naming the Object page
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Property

Description

Quick Filter

Enter a word or a character to filter on. For
more information, see the Quick Filter topic
on WebHelp.

Name

Type a name for the binding template.

Location

Enter the location of the binding template in
the System Tree pane.

Description

Type the description of the binding template.
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17.16

Binding Template Wizard – What Type
Do You Want to Bind in the Template
Page
Use the What type do you want to bind in the template page to select the
type of this template.

Figure: What type do you want to bind in the template page

Table: What Type Do You Want to Bind in the Template Page
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Component

Description

Type list

Select the LonWorks device that will be
selected when applying this template.

Find type

Type to find a type.
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17.17

Binding Template Wizard – What
Type(s) Do You Want to Bind to with
the Template Page
Use the What type(s) do you want to bind to with the template page to
select the types of this binding template.

Figure: What type(s) do you want to bind to with the template page

Table: What Type(s) Do You Want to Bind to with the Template Page
Component

Description

Type list

Select the LonWorks devices that hold
values that can be bound to the LonWorks
device that was selected on the previous
page.
Add
Click to add LonWorks devices.
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Selected object types

Displays the LonWorks devices that have
been selected.

Find type

Type to find a type.
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17.18

Binding Template Wizard – Specify the
Bindings in The Template Page
Use the Specify the bindings in the template page to drag/type applicable
values to the properties of the selected type.

Figure: Specify the bindings in this template page

Table: Specify the Bindings in This Template Page
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Column

Description

[Destination object properties]

Displays properties of the selected
LonWorks device.

Unit

Displays the engineering unit associated with
each property (if any).

Binds to

Drag/type values to these property boxes.

[Browser]

Find and drag values to the selected
LonWorks device.

Technical
547

17 Bindings User Interface
17.19 Binding Template Wizard – Specify the Path Matching Patterns in the Template Page

17.19

Binding Template Wizard – Specify the
Path Matching Patterns in the Template
Page
Use the Specify the path matching patterns in the template page to define
rules on how values will bind when using this template.

Figure: Specify the path matching patterns in the template page

Table: Specify the Path Matching Patterns in the Template Page
Component

Description
Add rule
Click to add a new rule entry. Within a rule
entry, you specify a value or the path to the
value in the Selected object. You also
specify a value or the path of a value in the
Binding candidate. If a value is found in
the Binding candidate, as specified, it is
bound to the specified value in the
Selected object.
Remove rule
Click to remove a rule entry.
Move up
Click to move the selected rule entry up in
the list. The order in which rules are stated
can affect which values are bound.
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Continued
Component

Description
Move down
Click to move the selected rule entry down in
the list. The order in which rules are stated
can affect which values are bound.
Move to top
Click to move the selected rule entry to the
top in the list. The order in which rules are
stated can affect which values are bound.
Move to bottom
Click to move the selected rule entry to the
bottom in the list. The order in which rules
are stated can affect which values are
bound.

Selected object

Type the value or the path of the value that
you want to bind in the Selected object.

Binding candidate

Type the value or the path of the value that
you want to bind in the Binding
candidate.
When the template is used and the rule is
executed, if a value is found in the Binding
candidate as specified, it is bound to the
specified value in the Selected object.

Property
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Select if the rule is to match values by their
Name, Description, Note 1, or Note 2
property,
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17.20

Binding Template Properties
Use the Binding Templates properties dialog box to view and edit the properties
of the binding template.

Figure: Binding template properties

Table: Binding Template Properties
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Component

Description

Description

Type a description that explains what the
object is used for.

Type

Displays the object type that defines the
properties of the object.

Foreign Address

Displays the address to a non-Building
Operation device, for example a BACnet
device.

Modified

Displays the date and time when the object
was last modified.

Note 1

Type text that you display in a graphic or use
when searching for the object.
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Continued
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Component

Description

Note 2

Type text that you display in a graphic or use
when searching for the object.

Validation

Select the validation status of the object to
keep track of which objects have passed or
failed the validation.

Template name

Type a name for the template.

Owning type

Displays the type on which this template is
applicable.
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17.21

Edit Binding Template Dialog Box –
Type Binding Template
Use the Edit binding template dialog box to configure the type binding template.

Figure: Edit binding template dialog box

Table: Edit Binding Template Dialog Box - Binding Template Tab
Component

Description
Hide bound
Hides bound rows.
Hide parameters
Hides parameter rows.
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Continued
Component

Description
Match units
Displays points that match at least one row
that has the same unit.
Match data types
Displays points that match at least one row
that has the same type.
Hide parameters
Hides parameter rows.

[Destination object properties]

Displays properties of the selected
LonWorks device.

Unit

Displays the engineering unit associated with
each property (if any).

Binds to

Drag/type values to these property boxes.

[Browser]

Find and drag values to the selected
LonWorks device.

Table: Edit Binding Template Dialog Box - Default Settings Tab
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Component

Description

Template Name

Type a name for the binding template.

Template Description

Type a description for the binding template.
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17.22

Edit Binding Template Dialog Box –
Path Matching Binding Template
Use the Edit binding template dialog box to configure the path matching binding
template.

Figure: Edit binding template dialog box

Table: Edit Binding Template Dialog Box - Binding Template Tab
Component

Description
Add rule
Click to add a new rule entry. Within a rule
entry, you specify a value or the path to the
value in the Selected object. You also
specify a value or the path of a value in the
Binding candidate. If a value is found in
the Binding candidate, as specified, it is
bound to the specified value in the
Selected object.
Remove rule
Click to remove a rule entry.
Move up
Click to move the selected rule entry up in
the list. The order in which rules are stated
can affect which values are bound.
Move down
Click to move the selected rule entry down in
the list. The order in which rules are stated
can affect which values are bound.
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Continued
Component

Description
Move to top
Click to move the selected rule entry to the
top in the list. The order in which rules are
stated can affect which values are bound.
Move to bottom
Click to move the selected rule entry to the
bottom in the list. The order in which rules
are stated can affect which values are
bound.

Selected object

Type the value or the path of the value that
you want to bind in the Selected object.

Binding candidate

Type the value or the path of the value that
you want to bind in the Binding
candidate.
When the template is used and the rule is
executed, if a value is found in the Binding
candidate as specified, it is bound to the
specified value in the Selected object.

Property

Select if the rule is to match values by their
Name, Description, Note 1, or Note 2
property.

Table: Edit Binding Template Dialog Box - Default Settings Tab
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Component

Description

Template Name

Type a name for the binding template.

Template Description

Type a description for the binding template.
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17.23

Time Stamp Value Properties
Use the Time Stamp Value properties dialog box to view or configure a time
stamp value.

Figure: Time stamp value

Table: Time Stamp Value
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Property

Description

Value

Enter a date and time
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18 Import and Export
18.1 Import and Export Overview

18.1

Import and Export Overview
A solution or application is a user-created object or group of objects that perform a
control process. Examples of creatable objects in Building Operation include
networks, devices, programs, binding templates, graphics, trends, and alarms.
Control processes can manage simple systems like air volume units, switches, and
lighting relays as well as complex systems like air handlers, chillers, and boilers.

Figure: Import and Export

Sharing Solutions Between Building Operation Servers and Projects
When designing Building Operation solutions, you can avoid duplication of effort by
exporting and importing files from one Building Operation server to another. For
example, you can export an alarm solution configured on one server, and then
import this alarm solution to one or more other servers. Take time to organize each
solution within a top folder so that all the interrelated folders and objects are
grouped together, which will simplify the export and import process later.
Import and Export is also version independent, which means that you can share
solutions regardless of the software revision. Specifically, you can import a solution
that was exported from one Building Operation server or WorkStation version with
servers or projects of any Building Operation server or WorkStation version.
In addition, you can create libraries that can be made available to other engineers.
To reduce programming time, you can share these libraries between Building
Operation servers and projects. In turn, libraries and Building Operation solutions
can be shared with other engineers through WorkStation. Solutions from libraries
can be assembled in various combinations to suit the needs of a job.
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18.1.1

Export
Export involves writing a solution configuration into a file, which is saved to another
location. To export a solution in Building Operation, select an existing solution
container and then click the Export command. Building Operation generates an
export file comprised of the objects and their configurations.
For more information, see section 18.2 “Export” on page 559.

18.1.2

Exportable and Non-exportable Objects
Most objects and data can be exported, with a few exceptions.
For more information, see section 18.25 “Exportable and Non-exportable Objects”
on page 590.

18.1.3

Import
Import involves reading a previously exported file and then recreating objects based
on the configuration of the file. To import a solution in Building Operation, select a
target location on the server and then click the Import command.
For more information, see section 18.26 “Import” on page 591.

18.1.4

Import and Export of Supporting Objects
Supporting objects, configured by users, are an integral part of a ported solution.
The export process can automatically include supporting objects in an export file.
For more information, see section 18.30 “Import and Export of Supporting Objects”
on page 599.

18.1.5

Import and Export of Bindings and Binding
Templates
Building Operation imports and exports bindings and binding templates with a few
exceptions.
For more information, see section 18.31 “Import and Export of Bindings and
Binding Templates” on page 601.
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18.2

Export
Export involves writing a solution configuration into a file, which is saved to another
location. To export a solution in Building Operation, select an existing solution
container and then click the Export command. Building Operation generates an
export file comprised of the objects and their configurations.
Building Operation does not export some system objects and properties. For
example, you cannot export the System folder, or object properties like device IDs.
If a system object or folder is mistakenly included in an export, the export process
provides an Export Preview area, which lists the non-exportable objects. The export
proceeds but the system object or folder is not included in the export file. For more
information, see section 18.25 “Exportable and Non-exportable Objects” on page
590.
If you create your own objects and folders within a system folder, you can export
them separately to the corresponding system folder on the targeted server, for
example, System – Alarms.
When exporting a solution, an internal binding path is one that refers to an object
that is also included in the export. An external binding path is one that refers to an
object that is not included in the export. Internal unlocked binding paths are always
kept.
You decide what external binding paths to include in an export: locked, locked and
unlocked, or none.
• Export Special: Keeps all external binding paths (locked and unlocked). After
an import, some binding paths may be unresolved.
• Export Library mode: Removes all external binding paths (locked and
unlocked). Generates an export file that you can use anywhere and know that,
upon import, every reference has been resolved to what you expect. Use one
of the other export reference filter types when you know how the export will be
used.
• Export: Removes all external unlocked binding paths. After an import, some
binding paths may be unresolved.

Tip
From the List View, you can select multiple solutions for export, which are
exported as a single file. For more information, see section 18.4 “Selecting
Multiple Solutions for Export” on page 562.

18.2.1

Export of Networks, Devices, and Protocols
You can export networks, devices, and communication protocols in Building
Operation.
For more information, see section 18.5 “Export of Networks, Devices, and
Protocols” on page 563.
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18.2.2

Export of Programs, Functions, and
Applications
You can export programs, functions, and applications in Building Operation.
For more information, see section 18.16 “Export of Programs, Functions, and
Applications” on page 576.
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18.3

Exporting a Solution
You export a solution to another Building Operation server. You can also use the
standard copy and paste method to copy solutions to other file locations on the
same server.
For more information, see section 18.1 “Import and Export Overview” on page 557.

To export a solution
1. In WorkStation, in the System Tree pane or the List View, select the
solution that you want to export.
2. On the File menu, click Export.
3. In the Select an Export Reference Filter option, select the filter type to be
used for the export.

4. Click Export.
5. In the Save As dialog box, enter the location and file name.
6. Click Save.
7. Click Close when the export is complete.
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18.4

Selecting Multiple Solutions for Export
You use the List View to select multiple objects or solutions that can be grouped
into a single export.
For more information, see section 18.1 “Import and Export Overview” on page 557.

To select multiple solutions for export
1. In WorkStation, in the System Tree pane, select the location where the
solutions are stored.
2. In the List View, press the CTRL key and click the objects or solutions that
you want to export.

3. On the File menu, select Export.
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18.5

Export of Networks, Devices, and
Protocols
You can export networks, devices, and communication protocols in Building
Operation.

18.5.1

Import and Export of I/O Solutions
You can import and export I/O points, devices, and solutions from one Automation
Server to another. Building Operation preserves all the properties of modules and
their points. However, bindings are not included.
For more information, see section 18.6 “Import and Export of I/O Solutions” on
page 565.

18.5.2

Import and Export of b3 Solutions
You can import and export b3 BACnet devices, objects, and solutions in Building
Operation.
For more information, see section 18.7 “Import and Export of b3 Solutions” on page
566.

18.5.3

Import and Export of BACnet Solutions
You can export and import BACnet objects, devices, and solutions from one
Building Operation server to another.
For more information, see section 18.8 “Import and Export of BACnet Solutions” on
page 567.

18.5.4

Import and Export of GCM Solutions
You use WorkStation to import the migrated GCM database into the Automation
Server. The Automation Server uses the export file created by the TAC I/A Series
Migrator for the import process, which then creates a NETWORK 8000 Interface
with all the migrated objects in sub-folders under the NETWORK 8000 Interface
folder.
For more information, see section 18.9 “Import and Export of GCM Solutions” on
page 569.

18.5.5

Import and Export of LonWorks Solutions
You can import and export the contents of an entire LonWorks network.
For more information, see section 18.10 “Import and Export of LonWorks Solutions”
on page 570.
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18.5.6

Import and Export of MNL LonWorks Solutions
In Building Operation, you can use WorkStation to export MNL LonWorks devices
and Application objects as solutions. A solution can be imported any number of
times in other Building Operation servers where needed, thus reducing duplication
of effort.
For more information, see section 70.17 “Import and Export of MNL LonWorks
Solutions” on page 2418.

18.5.7

Import and Export of MicroNet Solutions
You can import and export MicroNet networks in Building Operation. However, you
cannot import and export network components (subnets, devices and objects).
For more information, see section 18.12 “Import and Export of MicroNet Solutions”
on page 572.

18.5.8

Import and Export of Modbus Solutions
You can import and export Modbus objects, networks, devices, and solutions in
Building Operation, with a few exceptions.
For more information, see section 18.13 “Import and Export of Modbus Solutions”
on page 573.

18.5.9

Import and Export of Sigma Solutions
You can import and export certain parts of a Sigma interface in Building Operation.
For more information, see section 18.14 “Import and Export of Sigma Solutions” on
page 574.

18.5.10

Import and Export of Xenta Solutions
You can import and export most Xenta objects and solutions.
For more information, see section 18.15 “ Import and Export of Xenta Solutions” on
page 575.
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18.6

Import and Export of I/O Solutions
You can import and export I/O points, devices, and solutions from one Automation
Server to another. Building Operation preserves all the properties of modules and
their points, as well as their bindings.
Generally, you can export the following module and point properties:
• Module IDs.
• Channel numbers
• All other configuration parameters
• Requested values
For more information, see the I/O Bus Overview topic on WebHelp.

Import
In most cases, you can import the following module and point properties:
• Module IDs. When you import a module, if the module has been used by
another module, the module is still imported. However, the module ID is set to
Null and an import warning is reported.
• Channel numbers. When you import a point, if the channel number has been
used by another point, the point is still imported. However, the channel number
is set to Null and an import warning is reported.
• All other configuration parameters
• Requested values
If an I/O module or point already exists on the targeted server during an import, the
import process creates a copy of the object and generates an alternate name to
prevent accidental overwriting. For example, a module named Slot03:UI16 is
renamed Slot03:UI16_2.
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18.7

Import and Export of b3 Solutions
You can import and export b3 BACnet devices, objects, and solutions in Building
Operation.

Export
Generally, you can:
• Export a b3 BACnet device and its contents to a file.
• Export one or more objects from a b3 BACnet device to a file.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

Import
Generally, you can:
• Import a file containing objects, solutions, or the entire contents of a b3
BACnet device to an MS/TP Network.
• Import one or more objects from a b3 BACnet device to a b3 BACnet device
Application folder.

Tip
After you import a file containing objects, solutions, or the entire contents of a b3
BACnet device, you need to associate the device object with a live b3 BACnet
device in the Hardware folder, or the Automation Server's Device Discovery tab.
You then download the device. If you fail to do so, the b3 BACnet device is
unusable.
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18.8

Import and Export of BACnet Solutions
You can export and import BACnet objects, devices, and solutions from one
Building Operation server to another.
Using Building Operation Export, you select multiple user-created objects for
export. After an export takes place, you can import the BACnet solution to an
Application folder on another Building Operation server. However, some objects
that you select may not be exportable, such as an entire Application folder, which is
a system object. For more information, see section 149.8 “Cannot Export BACnet
System Objects” on page 5512.

Export of BACnet object proxies and BACnet devices
Keep in mind the following information:
• Object IDs are preserved during export.
• The enabled state of Trend logs is preserved during an export and import of a
Trend solution.
• The enabled state of Alarms is preserved during an export and import of an
Alarms solution. Intrinsic (built-in) alarms are also included.
• A device instance number is not preserved in an export. An imported BACnet
device must be associated with a device. For more information, see section
75.6 “Associating a BACnet Instance Number with a Device ” on page 2611.
For more information, see section 73.1 “BACnet Overview” on page 2551.

Import of BACnet object proxies and BACnet devices
Note the following information:
• The Services supported property in the Advanced tab of a device lists the
supported services, such as create-object. If an import contains any BACnet
objects for a device that does not support the create-object service, then these
objects must be created in the device by some proprietary means provided by
the device vendor. Consequently, you need to configure these objects with
object identifiers matching those in the import. In this case, an upload of the
device is recommended.
• By default, the BACnet Notification includes a reference to the BACnet
Interface object. If any references are invalid, the import process warns you
that the references were not imported. You must manually reset these
references after the import takes place before or after downloading. To avoid
this problem, set the BACnet Interface object on the source and destination
servers with the same Building Operation server name. For more information,
see section 149.9 “Cannot Import BACnet Notification References” on page
5513.
• Import does not include the current status flag, such as enabled, on any device
or object in the export file. As a result, these statuses may not be in synch with
the actual device or object because they are not automatically downloaded
after the import takes place. The import process may also indicate that a
manual download is necessary. If so, you need to manually download to the
device or object after an import.
• During an import, Building Operation cannot create references to BACnet
devices or objects that do not exist on the destination server. Therefore, you
need to recreate these references manually after the import takes place.
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Export of Building Operation Server BACnet objects
Keep in mind the following information:
• During an export, Building Operation preserves the object IDs but does not
preserve the device IDs.
• Building Operation preserves the enabled state on Trends during an export or
import.
• Building Operation preserves the enabled state on Schedules during an export
or import.
• Building Operation preserves the enabled state on Alarms during an export or
import. Intrinsic (built-in) alarms are also included.
• A BACnet Interface can only be imported to the same type of server (Enterprise
Server or Automation Server) from which it was exported. It is not possible to
assign the device ID of the BACnet interface manually when importing, only
automatically assigned IDs are possible. To import an entire BACnet interface,
complete the following tasks:
– Assign a unique network ID in the Properties of any imported MSTP
network.
– Associate any imported BACnet devices with a device from the Hardware
folder or Device Discovery manager.
• An imported MSTP network will be created on the same COM port on the
server to which it is imported and the server from which it was exported. The
network ID must be assigned a unique value in the Properties of the MSTP
network.

Import of Building Operation Server BACnet objects
Note the following information:
• Import only preserves object IDs if there are no conflicts.
• By default, BACnet Notifications reference the BACnet Interface. If any
reference is invalid, the import continues with a warning message, but the
reference will not be created. To avoid this problem, make sure that the
Building Operation name for the BACnet Interface object is the same on the
source and destination servers. For more information, see section 149.9
“Cannot Import BACnet Notification References” on page 5513.
• Schedules with Calendar references import successfully if the Calendar is
included in the export file or already exists on the destination server. If this does
not occur, you must manually recreate these references after the import takes
place.
• During an import, Building Operation cannot create references to BACnet
devices or objects that do not exist on the destination server. Therefore, you
must manually recreate these references after the import takes place.
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18.9

Import and Export of GCM Solutions
You use WorkStation to import the migrated GCM database into the Automation
Server. The Automation Server uses the export file created by the TAC I/A Series
Migrator for the import process, which then creates a NETWORK 8000 Interface
with all the migrated objects in sub-folders under the NETWORK 8000 Interface
folder.
You can export any group of NETWORK 8000 objects and import them into other
Automation Servers that have a NETWORK 8000 Interface.

Note
There can be only one NETWORK 8000 Interface in a server. If you attempt to
import another interface, the system identifies import conflicts during the import
process and prevents the import from taking place. However, you can export any
group of NETWORK 8000 objects and import them into another Automation
Server with a NETWORK 8000 Interface.
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18.10

Import and Export of LonWorks
Solutions
You can export and import a LonWorks solution in parts or in its entirety, such as a
particular device, or the configuration of an entire network.
When you export a LonWorks solution, bindings are included if both sender and
receiver devices are part of the exported solution, and if either is missing Building
Operation still creates a binding if a corresponding sender or receiver is detected in
the new system without causing a binding conflict.
When the exported solution is imported, if either a sender or a receiver is missing
and no corresponding server or receiver is detected in the new system, bindings to
and from devices outside the exported solution are cleared.

Tip
There is a workaround that allows you to import solutions and at the same time
resolve binding conflicts. For more information, see section 18.24 “Export Library
Mode” on page 589.
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18.11

Import and Export of MNL LonWorks
Solutions
In Building Operation, you can use WorkStation to export MNL LonWorks devices
and Application objects as solutions. A solution can be imported any number of
times in other Building Operation servers where needed, thus reducing duplication
of effort.
For more information, see section 18.1 “Import and Export Overview” on page 557.

18.11.1

Exporting an MNL LonWorks Solution
You use WorkStation to export an MNL LonWorks device or Application object as
an MNL LonWorks solution so that it can be reused in other Building Operation
servers. When you export an MNL LonWorks Application object, the corresponding
MNL LonWorks application type is automatically included in the solution file.
For more information, see section 18.3 “Exporting a Solution” on page 561.

18.11.2

Importing an MNL LonWorks Solution
You use WorkStation to import an MNL LonWorks solution that was created or
modified on another Building Operation server.
For more information, see section 18.27 “Importing a Solution” on page 594.

Caution
If a name conflict occurs during the import process, proceed with caution. It is
possible that the existing application type and the application type in the solution
file are not identical. In such a case, the Application objects that are created
during import may not contain all the attributes of the original Application
objects on the source server.
For more information, see section 158.21 “Name Conflicts During MNL LonWorks
Solution Import” on page 5619.

Caution
If a name conflict occurs during the import process, and the MNL device model
number is different between the existing application type and the application type
in the solution file, do not proceed with the import. Instead, use WorkPlace Tech
Editor to import the original application type from which the solution was created
and then save it with a different name.
For more information, see section 70.8 “Importing a Single MNL LonWorks
Application Type” on page 2403.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)
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18.12

Import and Export of MicroNet
Solutions
You can import and export MicroNet networks in Building Operation. However, you
cannot import and export network components (subnets, devices and objects).
Keep the following points in mind when importing MicroNet networks:
• You can only import a maximum of two MicroNet networks to an Automation
Server (one for each of the two serial ports).
• You can only import one MicroNet network to an Enterprise Server, which
usually has only one serial port (unless you physically increase the number of
ports).
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18.13

Import and Export of Modbus Solutions
You can import and export Modbus objects, networks, devices, and solutions in
Building Operation, with a few exceptions.
Keep the following points in mind when exporting or importing Modbus objects or
solutions:
• Modbus TCP Server. There can be only one Modbus TCP Server per
Automation Server or Enterprise Server. If one is found, the import will not
succeed.
• Modbus Interface. There can be only one Modbus Interface with the same
instance number per server. If one is found, the import will not succeed.
• Modbus TCP Network. There can be only one Modbus TCP Network with the
same instance number per server. If one is found, the import will not succeed.
For more information, see section 86.1 “Modbus Overview” on page 3561.
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18.14

Import and Export of Sigma Solutions
You can import and export certain parts of a Sigma interface in Building Operation.
You can import and export the following objects within a Sigma interface:
• Global values virtual controller and its global values
• Graphics
• Log sets
• Segments created in the Sigma interface, and their shortcuts
• Text report groups
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18.15

Import and Export of Xenta Solutions
You can import and export most Xenta objects and solutions.
There are limitations to retaining LonWorks bindings and to where you can import
solutions. For more information, see section 18.10 “Import and Export of LonWorks
Solutions” on page 570.
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18.16

Export of Programs, Functions, and
Applications
You can export programs, functions, and applications in Building Operation.

18.16.1

Import and Export of Script Solutions
You can import or export Script programs, functions, and solutions from one
Building Operation server to another.
For more information, see section 18.17 “Import and Export of Script Solutions” on
page 578.

18.16.2

Import and Export of User Management
Solutions
You can export and then import most domains, user accounts, user account
groups, and workspaces.
For more information, see section 18.18 “Import and Export of User Management
Solutions” on page 579.

18.16.3

Import and Export of Alarm Solutions
You can export and then import most Building Operation Alarm objects and
solutions.
For more information, see section 18.19 “Import and Export of Alarm Solutions” on
page 583.

18.16.4

Import and Export of Trend Solutions
You can export and import most Building Operation Trend logs, viewers, and
solutions, with the following exceptions.
For more information, see section 18.20 “Import and Export of Trend Solutions” on
page 584.

18.16.5

Import and Export of Schedule Solutions
You can export and import Schedules and Calendars from one Building Operation
server to another.
For more information, see section 18.21 “Import and Export of Schedule Solutions”
on page 585.
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18.16.6

Import and Export of Report Solutions
You can import and export energy related objects. Otherwise, Import and Export of
report objects and solutions is not recommended.
For more information, see section 18.22 “Import and Export of Report Solutions” on
page 587.

18.16.7

Custom Object Type
Custom object types are object definitions that extend the standard Building
Operation object set. These object definitions are included with the object during
the import and export processes.
For more information, see section 18.23 “Custom Object Type” on page 588.

18.16.8

Export Library Mode
You use Export Library mode reference filter type during an export to generate a
file that you can use anywhere and know that every reference has been resolved to
what you expect. On Import, it is expected that all references will be resolved. For
example, if you place the export into a library to be used by someone else, all
references should be resolved based on objects in the exported file’s solution.
For more information, see section 18.24 “Export Library Mode” on page 589.
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18.17

Import and Export of Script Solutions
You can import or export Script programs, functions, and solutions from one
Building Operation server to another.

Export
You can export one or more Script programs or functions from an Enterprise
Server, Automation Server, or b3 device.

Import
Keep the following points in mind to preserve bindings during an import:
• Import the referenced objects to the targeted server or device prior to
importing the actual Script programs and functions that reference these
objects. For example, import any referenced I/O points before importing the
programs that read and write the I/O points.
• Import a previously exported file that contains one or more Script programs or
functions to an appropriate destination, such as an Enterprise Server.
For more information, see section 52.2 “Script Editor Program Creation” on page
1854.

Note
In multi-server configurations, you may have to manually recreate some bindings
after an import takes place.

Technical
580

04-16006-04-en, March 2015

18 Import and Export
18.18 Import and Export of User Management Solutions

18.18

Import and Export of User Management
Solutions
You can export and then import most domains, user accounts, user account
groups, and workspaces.
Keep in mind the following information regarding the export and import of User
Management objects and solutions.

Export
Within the Domains folder, you can export one domain at a time by choosing either
the full or partial contents. The Domains folder contains the following exportable
folders:
• Building Operation Domains. These domains are preinstalled on Enterprise
Servers as well as Automation Servers that are part of a multi-server
configuration.
– On the Enterprise Server, this domain contains user accounts, user
account groups, software permissions, policies, and workspaces. In a
multi-server scenario, this domain also supports the functionality to add or
remove member servers from the domain.
– On an Automation Server, this domain only supports communication with
the top level server.
• User-created Domains. These domains are created by an administrator or
engineer for a particular purpose. You can create and then export user-created
domains and their contents.
• User-created Accounts and Account Groups. In contrast to other domain
objects, user accounts and groups are unique to the domain to which they
belong. Therefore, you cannot export them individually. They can only be
exported as part of an export of an entire user-created domain.
• Workspaces. Workspaces can be created by the user in any of the domains, or
exported individually. An export of an entire domain includes all the
workspaces within it.
Building Operation cannot export local workspaces.
For more information, see the User Account Management Overview topic on
WebHelp.

Note
In Building Operation, software permissions are set at the path and/or command
level, rather than at the object or folder level. Therefore, do not change the names
of the exported objects or folders. For example, if you change the name of an
exported folder, users with previously granted path permissions will be denied
access to this folder and its subfolders after the import takes place. You will have
to reset these permissions.
Some objects that you select for export may not be exportable because they are
used internally by Building Operation, specifically:
• Domains/Local. Preinstalled on all Building Operation servers, Local is a
system object designed primarily for local server log-on activities.
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• System objects. In addition, there are system objects within the Domains/Local
folder that cannot be exported, for example, groups, users, and workspaces
(except workspaces that are created by users).

Important
Building Operation encrypts account passwords whenever user accounts are
exported from an Enterprise Server.
For more information, see section 149.13 “Cannot Export User Management
System Objects” on page 5518.

Import
You can import the following objects:
• An 'out-of-the-box' domain. For example, the Users Domain contains user
accounts, user account groups, and group-related workspaces and software
permissions.

• A user-defined domain.
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• The full contents of any exported workspaces within the Workspaces folder of
a domain.
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Note
Software permissions are set at the path and/or command level, rather than at
the object or folder level. Therefore, when you import a solution, software
permissions apply only to any identically named objects and folders found on the
targeted location. For example, if you change the name of a folder, users with
previously granted path permissions will be denied access to this folder and its
subfolders. You will have to reset these permissions.
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18.19

Import and Export of Alarm Solutions
You can export and then import most Building Operation Alarm objects and
solutions.

Export
Building Operation exports the following Alarm objects:
• Alarms. Building Operation preserves Alarm references during export.
• Alarm Views. Building Operation preserves Alarm View references during
export.
• Event Views. Building Operation preserves Event View references during
export.
• Automatic assignment. Building Operation preserves the references of
automatically assigned objects during export.
• Notifications. Building Operation preserves Notification references during
export.
• User Action (supporting objects). Building Operation preserves the references
to the following supporting objects: categories, cause notes, action notes, and
checklists during export. For more information, see section 18.30 “Import and
Export of Supporting Objects” on page 599.
Building Operation cannot export the following:
• Alarm styles.
• Default Alarm panes.
• Default Event panes.
• Customized Alarm and Event View Columns
For more information, see the Alarm Functions topic on WebHelp.

Import
When an exported file is imported, Building Operation preserves the references
among the imported Alarm objects, with a few exceptions:
• User Action (supporting objects). The import process handles categories,
cause notes, action notes, and checklists in the following ways:
– If User Actions with conflicting names are found on the targeted server,
Import reestablishes the references among the objects with the identical
name. The import process does not create the imported object under a
new name.
– If User Actions are imported to an Enterprise Server in a multi-server
configuration, the supporting objects have to be recreated on the top
server. After creation, they are automatically copied to the connected tier
level servers. For more information, see section 149.12 “Cannot Import
Supporting Objects for Alarms” on page 5517.
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18.20

Import and Export of Trend Solutions
You can export and import most Building Operation Trend logs, viewers, and
solutions, with the following exceptions.

Export
Keep the following points in mind when exporting Trend objects or solutions:
• Export cannot export historical log data from a Building Operation server.
• When exporting Trend objects, you need to follow some guidelines for porting
Trend solutions from one Building Operation server to another. For more
information, see section 149.10 “Cannot Preserve Trend Object Bindings
During Import” on page 5515.
• An exported extended trend log does not retain the references to the
monitored trend log.
For more information, see the Trend Overview topic on WebHelp.

Import
To preserve bindings during an import:
• Import the referenced points, devices, or programs to the targeted server prior
to importing the Trend logs or solutions. For example, import any referenced
I/O points and programs first. Then, import the Trend logs that reference them.
• Import all the Trend objects in a particular order. For more information, see
section 149.10 “Cannot Preserve Trend Object Bindings During Import” on
page 5515.
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18.21

Import and Export of Schedule
Solutions
You can export and import Schedules and Calendars from one Building Operation
server to another.

Export and Import of Calendars
Generally, you can export and then import:
• Standalone Calendars. For more information, see the Calendars in WorkStation
topic on WebHelp.
• Lead and Shadow Calendars. Building Operation preserves references in
different ways depending on what you include in the export file:
– Export both the Lead and Shadow Calendars together in the same file:
Building Operation preserves the references when you import the file.
– Export only Shadow Calendars without the Lead Calendars: During the
import, Building Operation tries to resolve to the Lead Calendars using the
reference path specified in the import file. If a Lead Calendar is missing,
Building Operation marks the reference unresolved so you need to
manually fix this reference later.

Export and Import of Schedules
In most cases, you can export and then import:
• Standalone Schedules. For more information, see the Building Operation
Schedules topic on WebHelp.
• Lead and Shadow Schedules: Building Operation preserves references in
different ways depending on what you include in the export file:
– Export both the Lead and Shadow Schedules together in the same file:
Building Operation preserves the references when you import the file.
– Export only Shadow Schedules without the Lead Schedule: During the
import, Building Operation tries to resolve to the Lead Schedules using the
server absolute reference paths specified in the import file. If a Lead
Calendar is missing, Building Operation marks the reference unresolved so
you need to manually fix this reference later.
• Schedules with Calendar references. Building Operation preserves references
in different ways depending on what you include in the export file:
– Export both the Schedule and Calendars together in the same file: Building
Operation preserves the references when you import the file.
– Export only the Schedule without the Calendars: During the import,
Building Operation tries to resolve to the Calendars using the server
absolute reference paths specified in the import file. If a Lead Calendar is
missing, Building Operation marks the reference unresolved so you need
to manually fix this reference later.
Building Operation preserves the reference paths for Schedules and Calendars
contained in an imported solution.
To ensure that the reference paths are resolved properly, keep related items in the
same export file:
• Include all the referenced Schedules and Calendars.
• Include both the Lead and Shadow Calendars.
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• Include both the Lead and Shadow Schedules.
When you import objects joined by a reference in separate export files, import the
objects in the following order:
• Import the Calendars before the Schedules.
• Import the Lead objects before the Shadow objects.

Multi-server Configuration
If you import Shadow Schedules or Calendars to a Building Operation server and
the references to the Lead are broken, you need to manually recreate references:
• In the Shadow Calendars that point to the Lead Calendar
• In the Shadow Schedules that point to the Lead Schedule
For more information, see the Schedule and Calendar Synchronization topic on
WebHelp.
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18.22

Import and Export of Report Solutions
You can import and export energy related objects. Otherwise, Import and Export of
report objects and solutions is not recommended.
All energy related objects, (sites and meters) are contained in the Energy folder. For
more information, see the Energy Monitoring Reports topic on WebHelp.
You can import/export the Energy folder complete with sites and meters and their
configurations, or you can import/export a site or sub-site.
You can also use WebReports to complete the following tasks:
• Create a report pack of any custom reports that were created on the source
Reports Server. For more information, see the Report Packs topic on
WebHelp.
• Upload the custom reports pack to the targeted Reports Server for
deployment. For more information, see the About Custom Reports topic on
WebHelp.
After uploading the reports packs from WebReports, the new reports are
automatically created in the default Reports folder of the Enterprise Server.
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18.23

Custom Object Type
Custom object types are object definitions that extend the standard Building
Operation object set. These object definitions are included with the object during
the import and export processes.
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18.24

Export Library Mode
You use Export Library mode reference filter type during an export to generate a
file that you can use anywhere and know that every reference has been resolved to
what you expect. On Import, it is expected that all references will be resolved. For
example, if you place the export into a library to be used by someone else, all
references should be resolved based on objects in the exported file’s solution.
The following references are exported in the Library Mode:
• Unlocked references to objects or properties within the solution being exported
• Task references behave as if task objects are within the solution being
exported
• References to supporting objects (considered to be within the solution being
exported)
The following references are not included in Library Mode exports:
• References to objects or properties outside the current Building Operation
server
• References to objects or properties outside the solution being exported
• Locked references to objects or properties inside the solution being exported
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18.25

Exportable and Non-exportable Objects
Most objects and data can be exported, with a few exceptions.

Exportable Objects
The following table lists the types of data that can be exported.
Table: Exportable Data
Types of Data

Examples

Object Properties

Name, Description, or Engineering Unit

Top level objects and lower tier
objects nested within a top level
object

BACnet devices, LonWorks devices, folders,
programs, graphics, alarms, and trends

References and bindings

Values and type of references (including bindings)
that are part of the object:
• Absolute
• Relative

Supporting objects

Depending on the selected object, the following
objects are included:
• Alarm objects, such as Categories, Cause
Notes, Action Notes, and Checklists
For more information, see section 18.30
“Import and Export of Supporting Objects” on
page 599.

Non-exportable Objects
The following table lists the types of data that cannot be exported.
Table: Non-exportable Data
Types of Data

Example

Runtime values

BACnet Device ID or LonWorks Neuron ID

Runtime properties

Variables

Default (System) objects

Building Operation default and system objects, for
example, System folder of Local Domain

Note
Building Operation does not export some object properties like output values,
forced values, and device IDs.
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18.26

Import
Import involves reading a previously exported file and then recreating objects based
on the configuration of the file. To import a solution in Building Operation, select a
target location on the server and then click the Import command. For convenience,
the Import dialog box displays a summary and preview of the solution you want to
import. Summary displays information about the file to be imported while Import
Preview displays the names and file structure of the objects to be imported. Custom
Type preview displays the names of the custom types that will be imported. For
more information, see section 18.27 “Importing a Solution” on page 594.
Building Operation detects a name conflict if any objects in the targeted destination
have the same name as any of the top level objects in the imported solution. In
addition, the import process generates an alternate name to prevent accidental
overwriting. For more information, see section 149.2 “Name Conflicts During
Import” on page 5504.

Figure: Import dialog box with preview of the solution

04-16006-04-en, March 2015

Technical
593

18 Import and Export
18.26 Import

If there are container conflicts, Building Operation prevents the import from taking
place and makes the Import button unavailable. The reason for why the container
cannot be imported is shown in the error(s) tab.
For more information, see section 149.3 “Container Conflicts During Import” on
page 5506.

Figure: Container conflict in Import dialog box

18.26.1

Import of Networks, Devices, and Protocols
You can import networks, devices, and communication protocols in Building
Operation.
For more information, see section 18.28 “Import of Networks, Devices, and
Protocols” on page 595.
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18.26.2

Import of Programs, Functions, and
Applications
You can import programs, functions, and applications in Building Operation.
For more information, see section 18.29 “Import of Programs, Functions, and
Applications” on page 597.
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18.27

Importing a Solution
You import a solution that was created or modified on another Building Operation
server. You can also use the standard copy and paste method to copy solutions to
other file locations on the same server.
For more information, see section 18.1 “Import and Export Overview” on page 557.

To import a solution
1. In WorkStation, in the System Tree pane or List View, select a location
where you want to import a solution.
2. On the File menu, click Import.
3. In the Open dialog box, select the file and click Open.
4. Click Import.
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18.28

Import of Networks, Devices, and
Protocols
You can import networks, devices, and communication protocols in Building
Operation.

18.28.1

Import and Export of I/O Solutions
You can import and export I/O points, devices, and solutions from one Automation
Server to another. Building Operation preserves all the properties of modules and
their points. However, bindings are not included.
For more information, see section 18.6 “Import and Export of I/O Solutions” on
page 565.

18.28.2

Import and Export of b3 Solutions
You can import and export b3 BACnet devices, objects, and solutions in Building
Operation.
For more information, see section 18.7 “Import and Export of b3 Solutions” on page
566.

18.28.3

Import and Export of BACnet Solutions
You can export and import BACnet objects, devices, and solutions from one
Building Operation server to another.
For more information, see section 18.8 “Import and Export of BACnet Solutions” on
page 567.

18.28.4

Import and Export of GCM Solutions
For more information, see section 18.9 “Import and Export of GCM Solutions” on
page 569.

18.28.5

Import and Export of LonWorks Solutions
You can import and export the contents of an entire LonWorks network.
For more information, see section 18.10 “Import and Export of LonWorks Solutions”
on page 570.
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18.28.6

Import and Export of MNL LonWorks Solutions
In Building Operation, you can use WorkStation to export MNL LonWorks devices
and Application objects as solutions. A solution can be imported any number of
times in other Building Operation servers where needed, thus reducing duplication
of effort.
For more information, see section 70.17 “Import and Export of MNL LonWorks
Solutions” on page 2418.

18.28.7

Import and Export of MicroNet Solutions
You can import and export MicroNet networks in Building Operation. However, you
cannot import and export network components (subnets, devices and objects).
For more information, see section 18.12 “Import and Export of MicroNet Solutions”
on page 572.

18.28.8

Import and Export of Modbus Solutions
You can import and export Modbus objects, networks, devices, and solutions in
Building Operation, with a few exceptions.
For more information, see section 18.13 “Import and Export of Modbus Solutions”
on page 573.

18.28.9

Import and Export of Sigma Solutions
You can import and export certain parts of a Sigma interface in Building Operation.
For more information, see section 18.14 “Import and Export of Sigma Solutions” on
page 574.

18.28.10

Import and Export of Xenta Solutions
You can import and export most Xenta objects and solutions.
For more information, see section 18.15 “ Import and Export of Xenta Solutions” on
page 575.
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18.29

Import of Programs, Functions, and
Applications
You can import programs, functions, and applications in Building Operation.

18.29.1

Import and Export of Script Solutions
You can import or export Script programs, functions, and solutions from one
Building Operation server to another.
For more information, see section 18.17 “Import and Export of Script Solutions” on
page 578.

18.29.2

Import and Export of User Management
Solutions
You can export and then import most domains, user accounts, user account
groups, and workspaces.
For more information, see section 18.18 “Import and Export of User Management
Solutions” on page 579.

18.29.3

Import and Export of Alarm Solutions
You can export and then import most Building Operation Alarm objects and
solutions.
For more information, see section 18.19 “Import and Export of Alarm Solutions” on
page 583.

18.29.4

Import and Export of Trend Solutions
You can export and import most Building Operation Trend logs, viewers, and
solutions, with the following exceptions.
For more information, see section 18.20 “Import and Export of Trend Solutions” on
page 584.

18.29.5

Import and Export of Schedule Solutions
You can export and import Schedules and Calendars from one Building Operation
server to another.
For more information, see section 18.21 “Import and Export of Schedule Solutions”
on page 585.
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18.29.6

Import and Export of Report Solutions
You can import and export energy related objects. Otherwise, Import and Export of
report objects and solutions is not recommended.
For more information, see section 18.22 “Import and Export of Report Solutions” on
page 587.
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18.30

Import and Export of Supporting
Objects
Supporting objects, configured by users, are an integral part of a ported solution.
The export process can automatically include supporting objects in an export file.
When you export a container it automatically includes the necessary supporting
objects in the export file. When the exported file is imported, the supporting objects
are listed but are not included in the actual total number of objects. For more
information, see section 18.2 “Export” on page 559.

Figure: Import preview with supporting objects

Keep the following points in mind when importing a solution that contains
supporting objects:
• Import recreates any supporting objects included in the original export that do
not exist on the targeted server. For more information, see section 149.11
“Supporting Objects Already Exist” on page 5516.
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• Import does not recreate or modify any existing objects on the server. For more
information, see section 149.2 “Name Conflicts During Import” on page 5504.
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18.31

Import and Export of Bindings and
Binding Templates
Building Operation imports and exports bindings and binding templates with a few
exceptions.

Export of Bindings and Binding Objects
Keep the following points in mind:
• Variable connectors. When an object that is the destination of a variable
connector is selected for export, the information for the variable connector
object is included in the export file automatically. For more information, see
section 15.1 “Bindings Overview” on page 411.
• Objects or properties with bindings. It is recommended that you combine all
objects or properties that are bound to each other in the same export file. For
example, combine two programs that reference each other in the same export
file. If exported together, they will be bound when imported. If exported
separately, see the import information below.
• Binding templates. Located in the System folder, the Binding Templates folder
is a system object and, therefore, cannot be exported. However, you can
select one or more templates within this folder for export.

Import of Bindings and Binding Objects
Note the following information:
• Objects or properties with bindings where the bound objects are in separate
import files. To preserve bindings during an import, import the referenced
objects to the targeted server prior to importing the actual objects or programs
that refer to these objects. For example, import any referenced I/O points
before importing the programs that read and write the I/O points. No matter
what order of import is used, the import process will restore the bindings if they
are valid at the time of import.
• Binding templates. Binding templates that were exported from a server version
earlier than 1.2 will have names that are not intuitive. After an import of these
binding templates, you can rename the binding template. For more information,
see section 149.7 “Binding Template Name Is Not Intuitive” on page 5511.
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19 Import and Export User Interface
19.1 Export Status Dialog Box

19.1

Export Status Dialog Box
The Export Status dialog box displays the progress and destination of the
exported file.

Figure: Export Status dialog box
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19.2

Export Preview Dialog Box
Use this dialog box to view multiple objects that the system can and cannot export
from the server.

Figure: Export preview dialog box

Table: Export Preview Dialog Box
Component

Description

Objects that
can be
exported

Displays the objects that can be exported as part of the solution.

Objects that
cannot be
exported

Displays the objects that cannot be exported as part of the solution. For
more information, see section 149.1 “Non-exportable Objects” on page
5503.

Export
special

Select to keep all external binding paths.

Export library Select to remove all external binding paths.
mode
Export
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Select to remove all external unlocked binding paths. For more
information, see section 15.9 “Locked and Unlocked Binding Paths” on
page 429.
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19.3

Import and Export Toolbar
Use the Import and Export toolbar to import and export solutions.
Table: Import and Export Toolbar
Button

Description
Import
Click to import a solution to the selected location.
Export
Click to export a selected solution.
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19.4

Import Dialog Box
Use the Import dialog box to preview the contents of the solution that you want to
import. This dialog box provides a summary of information about the imported file
and a preview of the names and file structure of the objects to be imported.

Figure: Import dialog box

Table: Import Dialog Box
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Component

Description

Import file

Displays the location and name of the file selected for import.

Destination

Displays the selected server location where the file will be imported.

Number of
objects

Displays the total number of the objects selected for import to the server,
not including any supporting objects that may be present. For more
information, see section 18.30 “Import and Export of Supporting Objects”
on page 599.
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Continued
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Component

Description

Import
preview

Displays the names and the file structure of the objects in the solution to
be imported to the server.

Custom
types to
import

Displays the Custom object types that will be part of the solution. If a
Custom object type in the import already exists on the server, the preview
will contain a message that the Custom object type will not be imported.
For more information, see section 18.23 “Custom Object Type” on page
588.

error(s)

Displays errors.

warnings(s)

Displays warnings.

Copy to
clipboard

Click to copy error and warning messages to the clipboard.
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19.5

Import Status Dialog Box
The Import Status dialog box displays the progress and destination of the
imported file.

Figure: Import Status dialog box
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Recovering from an I/O Module Failure
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I/O Points
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Copying from Spreadsheet View to MS Excel
I/O Module Low Power Mode
Setting and Recovering an I/O Module from Low Power
Printing a Label to Identify I/O Channels
Correcting a Module Type Mismatch

Output Override Status
Overriding a Digital Output
Overriding an Analog Output
Associating an Engineering Unit with Property Values
Inserting a New Module in the Middle of an Existing I/O Bus
Resolving I/O Module Device Address Changed and
Blacklisted Device Detection Errors

20 I/O Modules
20.1 I/O Modules Overview

20.1

I/O Modules Overview
In WorkStation, you create or discover an I/O module in the Automation Server I/O
bus folder. When you create an I/O module, you specify the I/O module type and
I/O module name. You can then create I/O points on that I/O module.

20.1.1

I/O Modules
By adding a variety of I/O and power supply modules, you can use the Automation
Server to tailor the Intelligent Building Management System to your unique
requirements.
For more information, see the I/O Modules topic on WebHelp.

20.1.2

I/O Module Workflows
When a physical I/O module is connected to an Automation Server, there are two
ways to create an I/O module and its points.
For more information, see section 20.2 “I/O Module Workflows” on page 615.

20.1.3

Physical Devices and I/O Module Objects
You add an I/O module by installing the module on the terminal base. If there is an
I/O module object in the I/O bus folder with the same module ID, the system
automatically associates its I/O points with the newly installed module.
For more information, see section 20.3 “Physical Devices and I/O Module Objects”
on page 617.

20.1.4

I/O Points
After creating an I/O module in the I/O Bus folder, you can create I/O points in the
I/O module. You can create only the I/O point types that are supported by the I/O
module.
For more information, see section 20.12 “I/O Points” on page 631.

20.1.5

Output Override Status
Using an override switch, you can override analog and digital output channels on
I/O modules with the -H option. Program control or manual control can direct the
output of a channel. Graphics, schedules, variable connectors, and other objects
can also control outputs. You can disable the output as well.
For more information, see section 20.21 “Output Override Status” on page 647.
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20.1.6

I/O Module Low Power Mode
In order to save energy, you can place an I/O module in low power. When an I/O
module is in low power, the following conditions apply:
• The I/O module does not report input signals and all physical outputs are
turned off.
• The Module status reports low power.
• The I/O module's LED pattern indicates low power (the slowest green LED
blink pattern, approximately once every 3 seconds)
For more information, see section 20.17 “I/O Module Low Power Mode” on page
641.
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20.2

I/O Module Workflows
When a physical I/O module is connected to an Automation Server, there are two
ways to create an I/O module and its points.

20.2.1

Discover and Create
In WorkStation, follow this sequence to discover a physical I/O module, and then
create the logical module and its points. Use this method to configure an online I/O
module. (Recommended)

Figure: Discover and create workflow

Discover I/O module
Use Device Discovery to identify the I/O modules on the Automation Server. For
more information, see section 20.6 “Discovering an I/O Module” on page 623.

Create I/O module and I/O points
Drag a physical I/O module to the IO bus folder in the System Tree pane to create
the logical module. Then, create the I/O points for the module. For more
information, see section 21.15 “Creating Multiple I/O Points” on page 690.

20.2.2

Create and Discover
In WorkStation, follow this sequence to create a logical I/O module and its points in
the System Tree, and then associate the module with the physical I/O modules
later. Finally, associate each physical I/O module to its logical equivalent in the
System Tree.
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Figure: Create and discover workflow

Create I/O module and I/O points
In the System Tree pane, create logical I/O modules and I/O points.
For more information, see section 20.4 “Creating an I/O Module” on page 618.
For more information, see section 126.2 “Creating Multiple Objects” on page 5309.

Discover and associate I/O module
Use Device Discovery to identify the I/O modules on the Automation Server. Drag a
physical I/O module to an equivalent logical module in the System Tree pane to
assign the module ID, which brings the module online. Then, use the IO Module
Management Tool to view, assign, or unassign the modules.
For more information, see section 20.6 “Discovering an I/O Module” on page 623.
For more information, see section 20.11 “Assigning and Unassigning Logical I/O
Modules” on page 630.

Note
If there is an I/O module object in the I/O bus folder with the same module ID, the
system automatically associates its I/O points with the newly discovered module.
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20.3

Physical Devices and I/O Module
Objects
You add an I/O module by installing the module on the terminal base. If there is an
I/O module object in the I/O bus folder with the same module ID, the system
automatically associates its I/O points with the newly installed module.
There are three possible scenarios here:
• The physical I/O module is the same type as a logical I/O module configured
with the same Module ID.
• The physical I/O module is a different type than a logical I/O module configured
with the same Module ID. For more information, see section 20.20 “Correcting
a Module Type Mismatch” on page 646.
• There is no logical I/O module configured for the position in which the physical
module is inserted. For more information, see section 20.11 “Assigning and
Unassigning Logical I/O Modules” on page 630.

Note
• A logical I/O module is one that was added to the I/O Bus folder.
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20.4

Creating an I/O Module
You create I/O modules so that you can create physical inputs and outputs in the
database even though the I/O module is not physically connected to the system.
For more information, see the I/O Bus Overview topic on WebHelp.

To create an I/O module
1. In WorkStation, in the System Tree pane, select the IO Bus object under the
Automation Server.
2. On the File menu, point to New and then click IO module.
3. In the object types list, select the type of I/O module you want to create.

Continued on next page
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4. In the Name box, type a name for the I/O module.

5. In the Description box, type a description for the I/O module.
6. Click Next.
7. In the Module ID box, select a module ID of Null or 1 to 32 to specify the
position on the I/O bus where the I/O module is to be located. Selecting a
value of Null specifies that the Module ID is non-operational and can be used
as a placeholder to be configured when you wish to assign it to a physical slot.
You can place multiple modules on the Null slot.

Continued on next page
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8. Select Override capability expected if you would like the module to be
override capable.
9. Click Create.
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20.5

Configuring an I/O Module
You configure an I/O module by modifying the properties on Properties pane.
Because an I/O module is a software object, you configure an I/O point for an I/O
module whether or not the physical I/O module is present.

Tip
An I/O module with a configured status indicates that an I/O point has been
created. This differs from the process of configuring or changing the properties of
the I/O module as described in this procedure. Even if you configure or change
the I/O properties, that does not mean that the I/O module itself is in the
configured state.
For more information, see the I/O Bus Parts topic on WebHelp.

To configure an I/O module
1. In WorkStation, in the System Tree pane, select the IO Bus folder.
2. When the I/O modules display in the System Tree pane, click a selected
module.
Continued on next page
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3. Click File and then Properties.

Once you create I/O modules and I/O points, you can view the status
attributes for that I/O module in the Properties pane. For example, for every
module associated with an Automation Server, you can see the Online/Offline,
Configured/Unconfigured, and Module type mismatch status.
4. Edit the basic I/O module properties as necessary (for example, set the
module to low power to save energy).
For more information, see section 20.18 “Setting and Recovering an I/O
Module from Low Power” on page 642.
5. Click OK.
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20.6

Discovering an I/O Module
You discover an I/O module when the I/O module is connected. If physical I/O
modules display in the Hardware subfolder (under the System folder) in the System
Tree pane, you create an I/O module object representing these I/O modules in the
I/O bus.
For more information, see the IO Bus Overview topic on WebHelp.

To discover an I/O module
1. In WorkStation, in the System Tree pane, select the Automation Server
where you want to discover the I/O module.
2. Click the Device Discovery view.
3. In the Select device type box, select Automation Server IO bus.
4. Select the I/O module you want in the Device results pane.

5. Drag the I/O module to the IO Bus folder in order to create logical modules
and points that you can bind to from other system components.
The physical I/O modules are converted into I/O module objects in the I/O Bus
folder.
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20.7

Creating Multiple I/O Modules
Using the Spreadsheet view, you can quickly create multiple I/O modules, which
you otherwise would create one at a time in the wizard.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To create multiple I/O modules
1. In WorkStation, in the System Tree pane, select the I/O bus where you want
to create the I/O modules.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, select the first row.
4. In the Type column, select the type of I/O module.

5. Enter the rest of the properties, as you would do in the corresponding wizard.
6. Create additional I/O modules using Steps 4-5.

Tip
• You can also copy and paste cells, rows, and entire blocks.
7. On the File menu, click Save.
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20.8

Updating I/O Module Firmware
You upgrade the firmware for an I/O module, or multiple I/O modules of the same
type, if the following conditions are met:
• The Automation Server and the I/O module(s) are online.
• A valid update file is available.
• The I/O module application, or the boot loader (in the event of a prior update
failure) is loaded and running.
• The Module type mismatch property for the I/O module(s) is FALSE.
While I/O modules are being updated, other I/O modules remain operational.

To update I/O modules firmware
1. In WorkStation, in the System Tree pane, right-click the selected I/O
module.
2. Click Update IO module firmware.
3. For multiple I/O modules of the same type, right-click on the IO Bus folder
and then click Update IO module firmware.

Tip
If you right-click on the I/O Bus and perform an upward revision, that
also updates all modules of the same type on the I/O bus.
4. In the Update IO Module File dialog box, locate and select the valid I/O
module firmware file.
5. Click Open to open the I/O module firmware file.
Continued on next page
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6. Click Update Firmware to update the I/O module firmware.

7. Click Save Results to File to save the results to a text file (optional).
8. Click Exit.
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20.9

Moving an I/O Module
You change the Module ID of an I/O module object in the I/O Bus folder that does
not match the physical location of the I/O module on the backplane. You use this
procedure to correct the position of an I/O module object, or use the Spreadsheet
view or Property grid instead. For example, you replace one logical module with
another logical module. The module that is replaced returns to a module ID of Null.
Null specifies that the Module ID is non-operational and can be used as a
placeholder to be configured when you wish to assign it to a physical slot.

To move an I/O module
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. On the Actions menu, click IO module management tool.
3. In the IO Module Management Tool dialog box, drag and drop the desired
I/O module from the Unassigned Modules pane into the row that contains
the matching physical device.

The I/O Module Management Tool application assigns the Module ID to the
I/O module.
You can also drag and drop a physical device, such as an I/O module
hardware device, from the Unassigned Modules pane to an empty position
in the backplane.
4. Unplug the I/O module from the I/O bus.
5. Plug the I/O module into the new location.
Continued on next page
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6. In the IO Module Management Tool window, click Refresh.
The I/O Module Management Tool shows the physical device located at the
new Module ID number.

Note
• After you change the position of an I/O module, the I/O module
object and its I/O points in the Automation Server are bound to
the new physical position. The I/O module ID has been changed
and the I/O module is online. Applications bound to moved
points are still operational and running with as little interruption as
possible.
7. Click Exit.
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20.10

Recovering from an I/O Module Failure
If a physical I/O device fails, you should be able to remove and replace that device
with a physical I/O device of the same type without powering down the I/O bus. The
replacement physical I/O device is automatically configured with the same I/O
points as the original physical I/O device.
For more information, see section 20.3 “Physical Devices and I/O Module Objects”
on page 617.

To recover from an I/O module failure
1. Remove the physical I/O device from the IO Bus and replace it with a physical
I/O device of the same type.
You can do this with the I/O Bus power on.
2. In the IO Module Management Tool, verify that the physical device
displays in the proper location.

3. When finished, click Exit.
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20.11

Assigning and Unassigning Logical I/O
Modules
You use the I/O Module Management Tool to assign and unassign logical I/O
modules to a physical device.
For more information, see section 20.3 “Physical Devices and I/O Module Objects”
on page 617.

To assign and unassign Logical I/O modules
1. In the System Tree pane, expand the IO Bus.
2. On the Actions menu, click IO module management tool.
3. In the IO Module Management Tool dialog box, observe the Physical
device type and IO module name columns.

The Physical device type column lists the physical devices connected to
the Automation Server, while the I/O module name column lists the logical
modules located in the IO Bus folder.
4. In the Unassigned Modules pane, drag and drop unassigned modules to
assign them to a physical device.
5. Drag and drop logical modules into the Unassigned Modules pane to
unassign them (module ID of Null).
6. Click Refresh to update the IO Module Management Tool.
7. Click Exit.
You can visualize physical devices, Module ID positions and the status of the I/O
modules assigned to them using the IO Module Management Tool window.
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20.12

I/O Points
After creating an I/O module in the I/O Bus folder, you can create I/O points in the
I/O module. You can create only the I/O point types that are supported by the I/O
module.

20.12.1

I/O Point Types
An I/O module input point can be one of the following types:
• Counter Input
• Current Input
• Digital Input
• Resistive Input
• 2-Wire RTD Resistive Input
• 3-Wire RTD Resisitive Input
• Supervised Input
• Temperature Input
• 2-Wire RTD Temperature Input
• 3-Wire RTD Temperature Input
• Voltage Input
An I/O module output point can be one of the following types:
• Current Output
• Voltage Output
• Digital Output
• Digital Pulsed Output
• Tristate Output
• Tristate Pulsed Output
For more information, see section 21.1 “I/O Point Types” on page 663.

20.12.2

2-Wire RTD-DI-16 Temperature Input Wiring
Resistance
In the 2-wire RTD temperature input point, you determine the wiring resistance by
direct calculation, or by measuring it instead.
For more information, see section 21.8 “2-Wire RTD-DI-16 Temperature Input
Wiring Resistance” on page 678.
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20.12.3

2-Wire or 3-Wire RTD-DI-16 Temperature
Input Values and Reliability Levels
In the 2-wire or 3-wire RTD temperature input point, the raw resistance value is
used to help determine the temperature input value.
For more information, see section 21.9 “2-Wire or 3-Wire RTD-DI-16 Temperature
Input Value and Reliability Levels” on page 679.

20.12.4

Reliability of I/O Points
All I/O points have a property which describes the reliability or quality of the value.
This property is displayed in the Status Information group of the Properties pane for
the I/O point.
For more information, see section 21.16 “Reliability of I/O Points” on page 692.

20.12.5

Forced I/O Point Values
You can force the value of an input point or the requested value of an output point.
Forcing a value disables the input or output point from receiving values from either a
hardware device or software program.
For more information, see section 21.18 “Forced I/O Point Values” on page 694.

20.12.6

I/O Point Scaling
Scaling applies a mathematical factor that compares the internal values in the
system to and from the physical input and output points on an I/O module. The
scaling is linear and can include both positive and negative slopes.
For more information, see section 21.21 “I/O Point Scaling” on page 698.

20.12.7

Implicit Trend Logs for I/O Points
When you create an I/O point on an I/O module, the system automatically creates
an implicit trend log for that I/O point. The implicit trend log logs the Value of the I/O
point in a Change of Value type trend log.
For more information, see section 21.23 “Implicit Trend Logs for I/O Points” on
page 705.

20.12.8

Input Point Offsets
An offset is a value added to or subtracted from the engineering value before it
impacts the input point's Value property. For example, assume that a Thermistor
input is housed in a wiring closet. If you know the temperature in that closet is 2 °C
higher than the temperature outside the closet, you enter -2,0 as the offset value.
For more information, see section 21.24 “Input Point Offsets” on page 706.
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20.12.9

Threshold Settings for I/O Points
The threshold is the minimum change of value before the I/O module reports the
value to the Automation Server. Properly setting the threshold value reduces
unnecessary communication between the I/O module and the Automation Server.
For more information, see section 21.27 “Threshold Settings for I/O Points” on page
712.
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20.13

Creating Multiple Objects
Using the Spreadsheet view, you can quickly create multiple objects, such as I/O
modules, I/O points, values, alarms, and trend logs.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To create multiple objects
1. In WorkStation, in the System Tree pane, select where you want to create
the objects.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, click the
objects you want to set up.

button and select which type of

Note
• The content of an I/O bus, I/O module, a Modbus interface, or a
Modbus device opens up directly in the Spreadsheet view.
4. In the first row of the Type column, select the object type.

Continued on next page

Technical
636

04-16006-04-en, March 2015

20 I/O Modules
20.13 Creating Multiple Objects

5. Enter the rest of the properties, as you would do in the corresponding wizard.

Tip
You can use the shortcut key Ctrl + U to change the engineering unit
of a value in the Spreadsheet view.
6. Create additional objects using Steps 4-5.

Tip
• You can also copy and paste cells, rows, and entire blocks.
7. On the File menu, click Save.
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20.14

Configuring Multiple Objects
Using the Spreadsheet view, you can quickly configure collections of objects,
such as I/O modules, I/O points, values, alarms, and trend logs, objects that you
otherwise would configure one at a time in their respective property dialog boxes.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

Configuring Multiple Objects
1. In WorkStation, in the System Tree pane, select the collection of objects that
you want to configure.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, edit the objects.

Tip
You can use the shortcut key Ctrl + U to change the engineering unit
of a value in the Spreadsheet view.
4. On the File menu, click Save.
A progress view indicates that Building Operation is saving your changes. If a
problem occurs, the save is cancelled and an error message is displayed.
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20.15

Copying from MS Excel to Spreadsheet
View
You can copy cells, rows, or an entire worksheet from Microsoft Excel and then
paste the data into the Spreadsheet view in WorkStation.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

Tip
• The columns and the format of the cells, such as enumerations (date, time,
and so on) and language, must match the setup in the Spreadsheet view.

To copy from MS Excel to Spreadsheet view
1. In WorkStation, in the System Tree pane, select the server, the I/O bus, the
I/O module, or the folder where you want to paste data.
2. On the Actions menu, click Edit in spreadsheet.
3. Open the MS Excel spreadsheet from where you want to copy data.
4. Select the data that you want to paste to the WorkStation Spreadsheet
view.
5. Press CTRL-C.

Continued on next page
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6. In WorkStation, in the Spreadsheet view, select the cell or the rows where
you want to paste the data.
7. Press CTRL-V.

8. On the File menu, click Save.
The pasted data is saved in the WorkStation Spreadsheet view. If any of the data
would have been invalid according to cell formatting, column order, or just missing
data, a dialog box would have notified you about it. For example, the paste included
an invalid value in the Type column because of an empty input type.

In case of invalid data, you can either go back to MS Excel, correct the data, copy
and paste it again, or you could insert it anyways and correct the data in the
Spreadsheet view.
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20.16

Copying from Spreadsheet View to MS
Excel
You can copy column headers, cells, and rows from the Spreadsheet view in
WorkStation and then paste the data into an MS Excel spreadsheet.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To copy from Spreadsheet view to MS Excel
1. In WorkStation, in the System Tree pane, select the server, the I/O bus, the
I/O module, or the folder where you want to copy data.
2. On the Actions menu, click Edit in spreadsheet.
3. Right-click anywhere in the Spreadsheet view, and then select Copy
column headers.

4. Open a new MS Excel spreadsheet.
Continued on next page
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5. Press CTRL-V.

6. In WorkStation, in the Spreadsheet view, select the cells or the rows that
you want to paste into the MS Excel spreadsheet.
7. Press CTRL-C.
8. In the MS Excel spreadsheet, select where you want to paste the data, and
then press CTRL-V.

9. Save the MS Excel spreadsheet.
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20.17

I/O Module Low Power Mode
In order to save energy, you can place an I/O module in low power. When an I/O
module is in low power, the following conditions apply:
• The I/O module does not report input signals and all physical outputs are
turned off.
• The Module status reports low power.
• The I/O module's LED pattern indicates low power (the slowest green LED
blink pattern, approximately once every 3 seconds)
When you set an I/O module to low power, the software turns off all outputs.
When you want to recover an I/O module from low power, there are several points
you should consider:
• Make sure you set all I/O module Output values to a safe level before you return
to normal power conditions. This prevents "power surge" conditions.
• After normal power resumes, the Output values you set are reached
immediately after any timing delay occurs.
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20.18

Setting and Recovering an I/O Module
from Low Power
You place an I/O module in low power mode in order to save energy and then
recover that module later.
For more information, see section 20.17 “I/O Module Low Power Mode” on page
641.

To set and recover an I/O module from low power
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. Click the I/O module that you want to put in Low power mode.
3. Click File and then Properties.
4. Under Configuration Settings, in the Low power box, select True.

5. Click OK to change the value and close the Properties tab.
Continued on next page
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If the physical I/O module, shown in the System Hardware folder, matches the
logical I/O module defined in the I/O Bus, the I/O module goes into Low
power.

After the physical module enters low power, the Module status attribute in the
Status Information area displays Low power.
6. In the System Tree pane, expand the IO Bus to recover from low power
mode.
7. Click the I/O module you wish to recover.
8. Click File and then Properties.
9. Under Configuration Settings, in the Low power box, select False.
10. Click OK to change the value and close the Properties pane.
If the physical I/O module, shown in the System Hardware folder, matches the
logical I/O module defined in the I/O Bus folder, the I/O module exits from low
power. After the module resumes operation from low power, the Module
status returns to the status it had before it went into Low power.
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20.19

Printing a Label to Identify I/O Channels
You print labels to identify I/O channels on the placard of the I/O module much the
same way you label circuits on an electrical panel. You accept the default names for
the I/O point’s label text property or customize the I/O point’s names for your own
application.

Note
• You cannot print a label for an I/O module with a Module ID of Null.
• I/O points with a channel of Null do not show up in the label.

To print labels to identify I/O channels
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. In the List View, right-click the selected I/O module, the entire IO Bus folder,
or multiple I/O modules.
3. Click Print IO module labels.

Note
• The label text prints in red if the text is too long to fit on the label.
Continued on next page
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4. In the Print IO Module Labels dialog box, select Blank Label Text to print
labels with only the channel number with no additional label text.
5. Use the Paper Type drop-down list to select a paper type.
6. Click Print to print the I/O module label or Save to save any changes to the
point’s label text property.
The I/O module label is properly sized to fit on the placard of the I/O module.
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20.20

Correcting a Module Type Mismatch
You correct a module type mismatch using the I/O Module Management Tool.
For more information, see section 20.3 “Physical Devices and I/O Module Objects”
on page 617.

To correct a module type mismatch
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. On the Actions menu, click IO module management tool.
3. In the IO Module Management Tool dialog box, observe whether the
logical I/O Module type matches the type of physical device.

If not, the Module type mismatch property of the logical I/O module object
is TRUE, the table row displays in red, and an error message displays when
you hold the cursor over the row.
4. Fix this mismatch by physically replacing the mismatched I/O module with a
module of the correct type, or by dragging the logical I/O module out of the
row.

Tip
Moving the logical I/O module into the Unassigned Modules list removes any
association of the I/O module with the physical device.
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20.21

Output Override Status
Using an override switch, you can override analog and digital output channels on
I/O modules with the -H option. Program control or manual control can direct the
output of a channel. Graphics, schedules, variable connectors, and other objects
can also control outputs. You can disable the output as well.
You can set the output Override switch to one of three possible positions.
Table: Output Override Switch Positions
Switch Position

Action

Hand

Analog – Use the potentiometer to manually
adjust the voltage or current output.
Programs have no effect on the Output in
this position.

Hand

Digital – Output relay is energized to an “ON”
state manually. Programs have no effect on
the Output in this position.

Auto

Programs control the output.

Off

Analog – The voltage or current is set to
zero. Programs have no effect on the Output
in this position.

Off

Digital – The output relay is de-energized to
an “OFF” state manually. Programs have no
effect on the Output in this position.

The Override state is displayed in the Properties tab for the Output point. If the
Override State is True, the Output is overridden. The Override value takes
precedence over other values.

Figure: Output Override State
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20.22

Overriding a Digital Output
You take manual control of an output on an I/O module with an override switch (-H
models). Module names with an -H indicate the presence of Hand-Off-Auto override
switches.
For more information, see section 20.21 “Output Override Status” on page 647.

To override a digital output
1. On the I/O hardware module, manually set the override switch from AUTO to
HAND, or OFF for a digital I/O point.
For example, observe the position of the override switches on a DO-FC-8-H
(digital output, form C relay, 8 channel) I/O module.

Tip
There is a separate override switch for each I/O point.
2. View the results of a digital output override by expanding the IO Bus folder
and clicking the selected I/O module.
3. In the List View, click the I/O point.
Continued on next page
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4. Click File and Properties.

5. Under Status Information, verify the Override status and Value.

Tip
You can also add the value to the Watch pane to view a dynamic
updating of the value.
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20.23

Overriding an Analog Output
You take manual control of an output on an I/O module with an override switch (-H
models). Analog outputs have a potentiometer and an override switch. The output
channel follows the state of the override switch and/or potentiometer.
For more information, see section 20.21 “Output Override Status” on page 647.

To override an analog output
1. Manually set the override switch from AUTO to HAND or OFF for an analog I/O
point.
For example, observe the position of the potentiometers and override switches
on a AO-8-H (analog output, 8 channel) I/O module.

2. On the I/O hardware module, adjust the potentiometer to set the current or
voltage level.
3. Override a voltage or current output by setting the override switch to HAND
and then adjusting the output level using the potentiometer.
4. Override an output to 0 by setting the override switch to OFF.
There is a separate potentiometer and override switch for each I/O point.
5. View the results of an analog output override by expanding the IO Bus folder.
6. Click the selected I/O module and then click the I/O point in the List View.
Continued on next page
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7. Click File and then Properties.

8. Under Status Information, verify the Override status and Value.

Tip
You can also add the value to the Watch pane to view a dynamic
updating of the value.
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20.24

Associating an Engineering Unit with
Property Values
You associate an engineering unit, such as current, voltage, temperature and so on,
with certain property values in the Properties pane.

Note
• Engineering units are also used for conversions to/from other applications
such as Script and Function Block programs.
For more information, see section 21.1 “I/O Point Types” on page 663.

To associate an engineering unit with property values
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. Right-click the I/O module that you want.
3. In the List View, click the I/O point and then File and Properties.
4. In the Basic tab, click the Configure Settings icon

next to the Value.

5. For Value, ensure that the checkbox to the left of the Unit field is checked
and then click the browse (

) button.

6. In the Unit selection dialog box, select and expand a Units category (for
example, Current). Then, select a unit (for example, A for Amps).
Continued on next page
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7. Select a Prefix (for example, m for milli-). In this example, the Selected unit
is mA (milli amps).

8. Click Select to select the engineering unit.
9. Click OK to save the point.
The engineering unit becomes associated with the numeric value and is displayed
with the value when the user interface is refreshed. Also, any other values on this
I/O point that have configurable engineering units are also changed to the new
value.
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20.25

Inserting a New Module in the Middle of
an Existing I/O Bus
You insert a new module in the middle of an existing I/O bus by:
• Unassigning the module IDs of any modules after the insertion address
• Physically installing the new I/O module
For more information, see the I/O Bus Overview topic on WebHelp.

To insert a new module in the middle of an existing I/O bus
1. In WorkStation, in the System Tree pane, expand the I/O bus.
2. On the Actions menu, click IO module management tool.
3. Unassign the module IDs of any modules after the address where you are
inserting the new module by dragging and dropping the modules to the
Unassigned Modules pane.

Continued on next page
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4. Physically insert the new I/O module.

Continued on next page
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5. Set the new module IDs from Unassigned to their new address by dragging
the module IDs from the Unassigned Modules pane to the row with the
physical device.
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20.26

Resolving I/O Module Device Address
Changed and Blacklisted Device
Detection Errors
You resolve I/O module device address changed and blacklisted device detection
errors to remove any related alarms, and return module control and communication
to normal.
For more information, see section 150.4 “Device Address Changed” on page 5526.
For more information, see section 150.5 “Blacklisted Device Detected” on page
5527.

To resolve I/O module device address changed and blacklisted
device detected errors
1. In WorkStation, in the System Tree pane, expand the I/O bus.
2. On the Actions menu, click IO module management tool.

Note
The Device ProductSN and Blacklisted ProductSN columns
only display when the system detects an IO module device address
change or blacklisted device error on an Automation Server.
Continued on next page
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3. Find the first highlighted address in the Blacklisted ProductsSN field.
Notice that the first serial number in the Blacklisted ProductSN column is
at module ID 4. The terminal base has likely been damaged.

4. Replace the lowest slot ID terminal base reporting the error as well as the
terminal base preceding this slot ID. Here, the terminal base at both ID 3 and 4
should be replaced.
5. Click Refresh.
If the highlighted addresses display in yellow, the serial numbers now match
the devices in order.
6. Verify that the I/O modules match the physical device configuration.
Continued on next page

Technical
660

04-16006-04-en, March 2015

20 I/O Modules
20.26 Resolving I/O Module Device Address Changed and Blacklisted Device Detection Errors

7. Click Accept Blacklisted Devices to resolve the error and resume normal
operation.

8. Click Yes to reset the I/O modules and use the new address.

Continued on next page
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9. Click Refresh to verify that the blacklist is no longer displayed and the
modules have returned to their normal state.

10. Click Exit.
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21.1

I/O Point Types
After creating an I/O module in the I/O Bus folder, you can create I/O points in the
I/O module.
An I/O module input point can be one of the following types:
• Counter Input
• Current Input
• Digital Input
• Resistive Input
• 2-Wire RTD Resistive Input
• 3-Wire RTD Resisitive Input
• Supervised Input
• Temperature Input
• 2-Wire RTD Temperature Input
• 3-Wire RTD Temperature Input
• Voltage Input
An I/O module output point can be one of the following types:
• Current Output
• Voltage Output
• Digital Output
• Digital Pulsed Output
• Tristate Output
• Tristate Pulsed Output

21.1.1

Valid Point Types for I/O Modules
You can create only the I/O point types that are supported by the I/O module. The
following table displays the valid point types for each of the I/O modules.
Table: I/O Points Associated with Various I/O Modules
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I/O Module

Module Type

I/O Point Types

AO-8

Output

Current Output, Voltage
Output

AO-V-8

Output

Voltage Output

DI-16

Input

Counter Input, Digital Input

DO-FA-12

Output

Digital Output, Digital Pulsed
Output, Tristate Output,
Tristate Pulsed Output
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Continued
I/O Module

Module Type

I/O Point Types

DO-FC-8

Output

Digital Output, Digital Pulsed
Output, Tristate Output,
Tristate Pulsed Output

RTD-DI-16

Input

2-Wire RTD Resistive Input,
2-Wire RTD Temperature
Input, 3-Wire RTD Resistive
Input, 3-Wire RTD
Temperature Input, Counter
Input, Digital Input, Resistive
Input

UI-8/AO-4

Mixed (Input and Output)

Counter Input, Current Input,
Digital Input, Resistive Input,
Supervised Input,
Temperature Input, Voltage
Input
Current Output, Voltage
Output

UI-8/AO-V-4

Mixed (Input and Output)

Counter Input, Current Input,
Digital Input, Resistive Input,
Supervised Input,
Temperature Input, Voltage
Input
Voltage Output

UI-8/DO-FC-4

Mixed (Input and Output)

Counter Input, Current Input,
Digital Input, Resistive Input,
Supervised Input,
Temperature Input, Voltage
Input
Digital Output, Digital Pulsed
Output, Tristate Output,
Tristate Pulsed Output

UI-16

Input

Counter Input, Current Input,
Digital Input, Resisitive Input,
Supervised Input,
Temperature Input, Voltage
Input

You assign each I/O point a channel in the I/O module as part of the configuration
process. The channel represents where the point is physically wired to the I/O
module.

21.1.2

Null Value Selection
By selecting the Null value as the physical input or output channel on the I/O
module, you specify that the input or output point is non-operational and can be
used as a placeholder to be configured when you wish to assign it to a physical
channel. You can place multiple input or output points on the Null channel.
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The input or output channel number is unique to logical input or output points. For
example, a UI-8/DO-FC-4 module can have a Digital Output point on output
channel 1 and a Temperature Input point on input channel 1. The input and output
are different physical slots.

21.1.3

I/O Point Binding
A binding is an association between an I/O point and another object. Script and
Function Block programs, Graphics, and Trends are some examples of these
objects. You access the Bindings view to select the object that you want to bind to
the I/O point.

Figure: I/O Point Binding

For more information, see section 38.10 “Binding Values Using a Binding Template”
on page 1220.
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21.2

Creating an I/O Module Input Point
You create an I/O module input point by selecting the I/O module and then the type
of point you want to create from the list of available points.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module input point
1. In WorkStation, in the System Tree pane, select an I/O module.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select the type of point, for example, a Current Input
point.

4. In the Name box, enter a name for the I/O point.
5. In the Description box, enter the description of the I/O point.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the point will be wired.

8. In the Label text box, enter text to identify the I/O point on the I/O module
label.
The other parameters that appear on the Basic Settings page are specific to
the type of I/O point you create.
For more information, see the New Input Point Configuration Wizard – Basic
Settings Page topic on WebHelp.

Tip
Choosing a channel number of Null creates a non-operational I/O
point on the I/O module that you can use as a placeholder until an
actual Channel number is established for the point. Also, if you
choose to click Create before going to the Basic Settings page,
you can set the I/O point properties at a later time. For more
information, see section 21.14 “Configuring I/O Module Input or
Output Points” on page 689.
9. Enter the I/O point properties that you want and then click Create.
A Progress view displays indicating that the configuration changes are being
saved to the database.
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21.3

Creating an I/O Module Output Point
You create an I/O module output point by selecting the I/O module and then the
type of point you want to create from the list of available points.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module output point
1. In WorkStation, in the System Tree pane, select an I/O module.
2. On the File menu, point to New and then click Output point.
3. In the object type list, select the type of point, for example, a Digital Pulsed
Output point.

4. In the Name box, enter a name for the I/O point.
5. In the Description box, enter the description of the I/O point.
6. Click Next.
Continued on next page
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7. In the Output channel box, select the channel that corresponds to the
terminal connection on the I/O module where the output point is wired.

8. In the Label text box, enter text to identify the I/O point on the I/O module
label.
The other parameters that appear on the Basic Settings page are specific to
the type of I/O point you create.
For more information, see the New Output Point Configuration Wizard – Basic
Settings Page topic on WebHelp..
9. Enter the I/O point properties that you want and then click Create.
A Progress view displays indicating that the configuration changes are being
saved to the database.
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21.4

Creating an I/O Module Digital Input
You create digital inputs to represent where the points are physically wired to the
I/O module.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module digital input
1. In WorkStation, in the System Tree pane, select the I/O module you want to
add a digital input for.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select Digital Input.

4. In the Name box, type a name for the digital input.
5. In the Description box, type a description for the digital input.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the digital input is wired.

8. In the Label text box, type a label text to identify the digital input on the I/O
module label.
9. In the Invert box, select True to invert the value logically.
10. In the LED color box, select Green to make the LED green when it is lit.
11. In the LED invert box, select True to make the LED lit when the digital input
is off.
12. Click Create.
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21.5

Creating an I/O Module Counter Input
You create counter inputs to represent where the points are physically wired to the
I/O module.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module counter input
1. In WorkStation, in the System Tree pane, select the I/O module you want to
add a digital input for.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select Counter Input.

4. In the Name box, type a name for the counter input.
5. In the Description box, type the description for the counter input.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the counter input will be wired.

8. In the Label text box, type label text to identify the counter input on the I/O
module label.
9. In the Invert box, select True to invert the value logically.
10. In the LED color box, select Green to make the light green when it is lit.
11. In the LED invert box, select True to make the LED lit when the counter
input is off.
12. Click Create.
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21.6

Creating an I/O Module Temperature
Input
You create temperature inputs to represent where the sensors are physically wired
to the I/O module.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module temperature input
1. In WorkStation, in the System Tree pane, select the I/O module you want to
add a temperature input for.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select Temperature Input.

4. In the Name box, type a name for the temperature input.
5. In the Description box, type a description for the temperature input.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the temperature input is wired.

8. In the Label text box, type a label text to identify the temperature input on the
I/O module label.
9. In the Digital filter box, select True to filter out noise and prevent false
readings.
10. In the Threshold box, enter the minimum change of value before it is sent to
the Automation Server.
11. In the Thermistor type box, select the connected thermistor type.
12. In the Offset box, enter the offset value you want added to or subtracted
from the engineering value before it affects the point's value property.
13. In the Upper reliability level box, enter the upper value that indicates an
inaccurate sensor reading.
14. In the Lower reliability level box, enter the lower value that indicates an
inaccurate sensor reading.
15. Click Create.
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21.7

Creating an I/O Module 2-Wire or 3Wire RTD Temperature Input
You create 2-wire or 3-wire RTD temperature inputs to represent where the sensors
are physically wired to the RTD DI-16 I/O module.

Tip
The 3-wire RTD temperature input point is a 3-channel input that requires you to
connect the 2 RTD leads to the 2 inputs and the other lead to the RETurn. For
more information, see the RTD-DI-16 I/O Module topic on WebHelp.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module 2-wire or 3-wire RTD temperature
input
1. In WorkStation, in the System Tree pane, select the RTD DI-16 I/O module
to which you want to add a 2-wire or 3-wire RTD temperature input.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select 2-Wire RTD Temperature Input or 3-Wire
RTD Temperature Input.

4. In the Name box, type a name for the 2-wire or 3-wire RTD temperature input.
5. In the Description box, type a description for the 2-wire or 3-wire RTD
temperature input.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the 2-wire or 3-wire RTD
temperature input is wired.

8. In the Label text box, type a label text to identify the 2-wire or 3-wire RTD
temperature input on the I/O module label.
9. In the Digital filter box, select True to filter out noise and prevent false
readings.
10. In the Threshold box, enter the minimum change of value before it is sent to
the Automation Server.
11. In the Sensor type box, select the specified sensor type to determine how
the resistance value is converted to temperature.
12. In the Offset box, enter the offset in degrees to the converted temperature
value.
13. In the Upper reliability level box, enter the upper value that indicates an
inaccurate sensor reading.
For more information, see section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability Levels” on page 679.
14. In the Lower reliability level box, enter the lower value that indicates an
inaccurate sensor reading.
15. In the Wiring resistance box, enter the wiring resistance.
For more information, see section 21.8 “2-Wire RTD-DI-16 Temperature Input
Wiring Resistance” on page 678.
16. Click Create.
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21.8

2-Wire RTD-DI-16 Temperature Input
Wiring Resistance
In the 2-wire RTD temperature input point, you determine the wiring resistance by
direct calculation, or by measuring it instead.
To calculate the wiring resistance directly, use the following formula:
Resistance per unit length x length x 2 = Wiring resistance
To measure the wiring resistance, attach a 100 or 1000 ohm "reference resistor" to
the end of the wire connected to the sensor. Use the reference resistor to measure
the known resistance. Then, use the following formula to determine the wiring
resistance:
Raw resistance - reference resistance = Wiring resistance
After you determine the wiring resistance, disconnect the reference resistor and
connect the sensor.

Note
Wiring resistance is only available for the 2-wire RTD temperature input point.
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21.9

2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability
Levels
In the 2-wire or 3-wire RTD temperature input point, the raw resistance value is
used to help determine the temperature input value.
When determining the value, the following equation is used:
Value = ConvertResistanceToTemperature(RawResistance WiringResistance) + Offset
where:
ConvertResistanceToTemperature is a function that depends on the Sensor
type property you select.
The raw resistance displays the measured resistance from the RTD without
applying the wiring resistance or offset properties. It represents the unconverted
value before temperature conversion occurs.
The raw resistance to temperature conversion tables for each sensor type, such as
Pt100, Pt1000, Ni1000, and LG_Ni1000, are valid for a range of -50°C to +150°C.
If the raw resistance value is above the resistance value corresponding to +150°C
for that sensor type, the value is reported as Over range. If the raw resistance value
is below the resistance value corresponding to -50°C, the value is reported as
under range.
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21.10

Creating an I/O Module 2-Wire or 3Wire RTD Resistive Input
You create 2-wire or 3-wire RTD resistive inputs to represent where the sensors are
physically wired to the RTD DI-16 I/O module.

Tip
The 3-wire RTD temperature input point is a 3-channel input that requires you to
connect the 2 RTD leads to the 2 inputs and the other lead to the RETurn. For
more information, see the RTD-DI-16 I/O Module topic on WebHelp.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module 2-wire or 3-wire RTD resistive input
1. In WorkStation, in the System Tree pane, select the RTD DI-16 I/O module
you want to add a 2-wire or 3-wire RTD resistive input for.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select 2-Wire RTD Resistive Input or 3-Wire RTD
Resistive Input.

4. In the Name box, type a name for the 2-wire or 3-wire RTD resistive input.
5. In the Description box, type a description for the 2-wire or 3-wire RTD
resistive input.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the 2-wire or 3-wire RTD
resistive input is wired.

8. In the Label text box, type a label text to identify the 2-wire or 3-wire RTD
resistive input on the I/O module label.
9. In the Digital filter box, select True to filter out noise and prevent false
readings.
10. In the Threshold box, enter the minimum change of value before it is sent to
the Automation Server.
11. In the Top of scale engineering value box, enter the top of the range for
the sensor.
12. In the Top of scale electrical value box, enter the top of the range
resistance value for the input point scale.
13. In the Bottom of scale engineering value box, enter the bottom of the
range for the sensor.
14. In the Bottom of scale electrical value box, enter the bottom of the range
resistance value for the input point scale.
15. In the Offset box, enter the offset value you want added to or subtracted
from the engineering value before it affects the point's value property.
16. In the Upper reliability level box, enter the upper value that indicates an
inaccurate sensor reading.
17. In the Lower reliability level box, enter the lower value that indicates an
inaccurate sensor reading.
Continued on next page
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18. In the Sensor class box, select the sensor class to configure the RTD
resistive input for the approximate range it will measure:
• 100 ohm based: measures a range from 50 to 220 ohm
• 1000 ohm based: measures a range from 500 to 2200 ohm
19. Click Create.
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21.11

Creating an I/O Module Voltage Input
You create voltage inputs to represent where the points are physically wired to the
I/O module.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module voltage input
1. In WorkStation, in the System Tree pane, select the I/O module you want to
add a digital input for.
2. On the File menu, point to New and then click Input point.
3. In the object type list, select Voltage Input.

4. In the Name box, type a name for the voltage input.
5. In the Description box, type the description for the voltage input.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the voltage input will be wired.

8. In the Label text box, type label text to identify the voltage input on the I/O
module label.
9. In the Digital filter box, select True to filter out noise and prevent false
readings.
10. In the Threshold box, enter the minimum change of value before it is sent to
the Automation Server.
11. In the Top of scale engineering value box, enter the top of the range for
the sensor.
12. In the Top of scale electrical value box, enter the top of the range for the
sensor.
13. In the Bottom of scale engineering value box, enter the top of the range
for the voltage input.
14. In the Bottom of scale electrical value box, enter the top of the range for
the voltage input.
15. In the Unit box, enter the engineering unit for the voltage input.
16. In the Offset box, enter the offset value you want added to or subtracted
from the engineering value before it affects the point's value property.
17. In the Upper reliability level box, enter the upper value that indicates an
inaccurate sensor reading.
18. In the Lower reliability level box, enter the lower value that indicates an
inaccurate sensor reading.
19. Click Create.
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21.12

Creating an I/O Module Digital Output
You create digital outputs to represent where the points are physically wired to the
I/O module.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module digital output
1. In WorkStation, in the System Tree pane, select the I/O module you want to
add a digital output for.
2. On the File menu, point to New and then click Output point.
3. In the object type list, select Digital Output.

4. In the Name box, type a name for the digital output.
5. In the Description box, type a description for the digital output.
6. Click Next.
Continued on next page
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7. In the Output channel box, select the channel that corresponds to the
terminal connection on the I/O module where the digital output is wired.

8. In the Label text box, type a label text to identify the digital output on the I/O
module label.
9. In the Requested value box, select Off to make the initial value of the first
program cycle off.
10. In the Default output value box, select Off to make the value revert to off if
the I/O module loses communication with the Automation Server for more
than 255 seconds.
11. In the Invert box, select True to invert the value logically.
12. Click Create.
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21.13

Creating an I/O Module Voltage Output
You create voltage outputs to represent where the points are physically wired to the
I/O module.
For more information, see section 21.1 “I/O Point Types” on page 663.

To create an I/O module voltage output
1. In WorkStation, in the System Tree pane, select the I/O module you want to
add a voltage output for.
2. On the File menu, point to New and then click Output point.
3. In the object type list, select Voltage Output.

4. In the Name box, type a name for the voltage output.
5. In the Description box, type a description for the voltage output.
6. Click Next.
Continued on next page

04-16006-04-en, March 2015

Technical
689

21 I/O Points
21.13 Creating an I/O Module Voltage Output

7. In the Output channel box, select the channel that corresponds to the
terminal connection on the I/O module where the voltage output is wired.

8. In the Label text box, type a label text to identify the voltage output on the
I/O module label.
9. In the Requested value box, enter a value to make the initial value of the first
program cycle this value.
10. In the Default output value box, enter a value to make the value revert to
this value if the I/O module loses communication with the Automation Server
for more than 255 seconds.
11. In the Threshold box, enter the minimum change of value before it is sent to
the Automation Server.
12. In the Top of scale engineering value box, enter the top of the range
engineering value for the voltage output.
13. In the Top of scale electrical value box, enter the top of the range voltage
value for the voltage output.
14. In the Bottom of scale engineering value box, enter the bottom of the
range engineering value for the voltage output.
15. In the Bottom of scale electrical value box, enter the bottom of the range
voltage value for the voltage output.
16. In the Unit box, enter the engineering unit for the voltage output.
17. Click Create.
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21.14

Configuring I/O Module Input or Output
Points
When you configure input or output points for Automation Server I/O modules, the
data fields that display depend on the type of I/O point you create.
For more information, see section 21.1 “I/O Point Types” on page 663.

To configure I/O module input or output points
1. In WorkStation, in the System Tree pane, select an I/O module that contains
input or output points.
2. In the List View, click the input or output point that you want to configure.
3. Click File and Properties to display the I/O point properties (for example, for
a Digital Output point).

4. Edit the Basic input or output point properties as necessary (for example,
change the Default output value in a Digital Output point).
For more information, see the New Input Point Configuration Wizard – Basic
Settings Page topic on WebHelp.
For more information, see the New Output Point Configuration Wizard – Basic
Settings Page topic on WebHelp.
5. Click OK.

04-16006-04-en, March 2015

Technical
691

21 I/O Points
21.15 Creating Multiple I/O Points

21.15

Creating Multiple I/O Points
Using the Spreadsheet view, you can quickly create multiple I/O points, which you
otherwise would create one at a time in the wizard.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To create multiple I/O points
1. In WorkStation, in the System Tree pane, select the I/O module where you
want to create the I/O points.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, select the row with the channel that corresponds
to the terminal connection on the I/O module where the input or output is
wired.
4. In the Type column, select the type of I/O point.

5. Enter the rest of the properties, as you would do in the corresponding wizard.

Tip
You can use the shortcut key Ctrl + U to change the engineering unit
of a value in the Spreadsheet view.
Continued on next page
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6. Create additional I/O points using Steps 3-5.

Tip
• You can also copy and paste cells, rows, and entire blocks.
7. On the File menu, click Save.
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21.16

Reliability of I/O Points
All I/O points have a property which describes the reliability or quality of the value.
This property is displayed in the Status Information group of the Properties pane for
the I/O point.

Figure: Reliability of an I/O point

The Reliability property can have one of the following values:
• Reliable – The point and module are online and the input is operating properly.
• Over range – The value is above the Upper reliability level field.
Only current, resistive, supervised, temperature, and voltage inputs can be
over range since they are the only points that contain the Upper reliability level
field.
• Under range – The value is below the Lower reliability level field.
Only current, resistive, supervised, temperature, and voltage inputs can be
under range since they are the only points that contain the Lower reliability level
field.
• Open Circuit – A supervised input is in a TROUBLE state and the measured
input resistance is >60KΩ
• Short Circuit – A supervised input is in a TROUBLE state and the measured
input resistance is <300Ω
• Unreliable – The point is not assigned a channel number, the module
containing this point does not have an online status, or its module type
mismatch is true.
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21.17

Reviewing the Reliability of I/O Point
Values
You review the reliability of I/O point values since the system displays the reliability
or quality of data for input/output points.
For more information, see section 21.16 “Reliability of I/O Points” on page 692.

To review the reliability of I/O point values
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. Click the I/O module that contains the selected I/O points. The I/O points
appear in the List View.
3. Click an I/O point.
4. Click File and then Properties.
5. Review the Reliability property.

The Reliability value contains one of the six possible values listed in a read-only
format.
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21.18

Forced I/O Point Values
You can force the value of an input point or the requested value of an output point.
Forcing a value disables the input or output point from receiving values from either a
hardware device or software program. You can force an input or output point for
some of the following reasons:
• Force an input point to test a software program. For example, if a program was
supposed to branch at a temperature of 27 °C (80.6 °F), you could enter that
value for the selected input point and test the branch.
• Force an output point to turn a device on or off. For example, you could turn off
a chiller for servicing.

Input
For an input I/O point, you can force the Value.

Figure: Force input I/O value

You must select Force in order to force a value. The forced status of an I/O point is
available to graphics and trend logs as part of the Present value.

Output
For an output I/O point, you can force the Requested value.
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Figure: Force output I/O value

When you force an output point, the forced value controls the output, and the
Requested value toggles to Unforce. After you remove the forced condition, the
output returns to the unforced value and the Requested value toggles to Force.

Note
• A manual override takes precedence over a forced value.
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21.19

Forcing Input Values
You force the value of an input point to disable the input point from receiving values
from either a hardware device or software program. This is useful when you want to
test a software program.
For more information, see section 21.18 “Forced I/O Point Values” on page 694.

To force an input value
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. Right-click the I/O input point that you want to force.
3. Click File and select Properties.
4. In the Value box, click Force.

5. When the Unforce toggle displays, enter the forced value.
6. Click OK.
The input point is driven to the specificied value.
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21.20

Forcing Output Values
You force the requested value of an output point to disable the output point from
receiving values from either a hardware device or software program. This is useful
when you want to force an output point to turn a device on or off.
For more information, see section 21.18 “Forced I/O Point Values” on page 694.

To force an output value
1. In WorkStation, in the System Tree pane, expand the IO Bus.
2. Right-click the I/O point you want.
3. Click File and then select Properties.
4. In the Requested value box, click the Force button.

5. When the Unforce toggle displays, enter the requested value.
6. Click OK.
The output point is driven to the Requested value.
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21.21

I/O Point Scaling
Scaling applies a mathematical factor that compares the internal values in the
system to and from the physical input and output points on an I/O module. The
scaling is linear and can include both positive and negative slopes.

Example
The Input Voltage range of 0 to 10 VDC measures a light level that ranges from 0 to
1400 Lux. At an input voltage of 1 VDC, the input object would expose 140 Lux.
Scaling applies to both input and output points.

21.21.1

Input Scaling
You can configure the physical inputs of all types, except for Digital, Counter, and
Supervised inputs, to expose the following attributes:
• Calculated value
• Engineering Unit and category
The resulting Engineering Value is the linear interpolation of the configured scale.
The value is not clipped when you configure scaling on an input point. The linear
conversion is applied to the full measureable range of the electrical input.
Scaling parameters appear in the Properties pane of the input point.

Figure: Voltage Input Point Scaling Fields

Input scaling applies to different types of input points.
Table: Input Scaling for Different Input Types
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Input Type

Electrical Top/Bottom of
Scale

Engineering Unit Types
(Inputs Converted To)

Voltage

0 to 10 VDC

Power, Flow, Acceleration,
Percentage, and so forth

Current

0 to 20 mA

Power, Flow, Acceleration,
Percentage and so forth

Resistance

0 to 60 kΩ

Resistance input scaling is
expressed in % or fractions

Temperature

-50 °C to +150 °C

Degrees C, F, and Kelvin
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Input Type

Electrical Top/Bottom of
Scale

Engineering Unit Types
(Inputs Converted To)

Table: Thermistor Types

21.21.2

Thermistor Type

Resistance

None

N/A

10k Type I (Continuum)

10 kΩ

10k Type II (I/NET)

10 kΩ

10k Type III (Satchwell)

10 kΩ

10k Linearized (Satchwell D?T)

10 kΩ

10k Type IV (FD)

10 kΩ

10k Type V (FD w/ 11k shunt)

10 kΩ

1.8k (Xenta)

1.8 kΩ

1k (Balco)

1 kΩ

20k (Honeywell)

20 kΩ

2.2k (Johnson Controls)

2.2 kΩ

Output Scaling
You can configure the physical analog output to receive the following attributes:
• Present (application) value
• Another Engineering Unit (in the same category) and covert it to Electrical Units

Example
A Voltage Output has a range of 0 to 10 VDC which is scaled to equal 0 to 100 %. If
the application value equals 20 %, the Output should be 2 VDC.
The Requested Value and Scaling parameters display in the Properties pane of
the Output point.
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Figure: Output Point Requested Value

For Requested value, click the Configure Settings icon
to display the
Requested value dialog box. Then, click the checkbox to the left of the Unit field
and the browse (
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) button to display the Unit selection parameter you want.
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Figure: Unit Selection Parameters

If the Requested Value is outside of the scaled range, the Voltage or Current
should be limited to the Top of Scale and Bottom of Scale boundaries.
Output scaling is limited to Voltage or Current output types. Scaling can be
configured for either a positive or negative slope.
Table: Output Scaling for Different Input Types

21.21.3

Output Type

Electrical Top/Bottom of
Scale

Engineering Unit Types
(Outputs Converted To)

Voltage

0 to 10 VDC

Power, Flow, Acceleration,
Percentage, and so forth

Current

0 to 20 mA

Power, Flow, Acceleration,
Percentage and so forth

Pulse Width Modulation Scaling
For digital and tristate pulsed outputs you can configure pulse width modulation
(PWM). Pulse width modulation provides a conditioning algorithm that produces a
pulse train with a specific period and duty cycle. When a digital or tristate pulsed
output is scaled, the output produces a repetitive pulse as configured in the scaling.
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Examples
Pulse width modulation scaling can be performed in two ways:
• Using PWM scale parameters of Pulse duration (s) and Period (s), a pulse
duration of 5 seconds and a Period of 20 seconds produces a 5 second pulse
every 20 seconds.
• Using PWM scale parameters of Duty cycle (%) and Period (s), a duty cycle
of 25 % and a Period of 20 seconds produces a 5 second pulse every 20
seconds (25 % of 20 seconds = 5 seconds)
You set these parameters in the Pulse Width Modulation group of the Properties
Pane.

Figure: Pulse Width Modulation Parameters
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21.22

Scaling an Input or Output I/O Point
You configure scaling on the physical inputs of all input point types, or on the analog
outputs of output point types. Scaling applies a linear conversion to the value of the
input and output points on an I/O module and can include both positive and
negative slopes.
For more information, see section 21.21 “I/O Point Scaling” on page 698.

To scale an input or output I/O point
1. In the System Tree pane, click the I/O module that contains the desired input
or output I/O point. The I/O points appear in the List View.
2. Click an input or output I/O point (for example, a Current Output point for an
AO-8 module).
3. Click File and Properties.
4. In the Basic tab, enter a value for the Electrical scale top (20mA in this
example) and Electrical scale bottom (4mA in this example).

5. In the Engineering scale top and Engineering scale bottom boxes,
enter values for the top and bottom of the engineering scale range of the
output point.
6. Click OK to insert the scaling factor.
A Progress view displays indicating that the configuration changes are being
saved to the database.
7. In the List View, click on another output I/O point (for example, a Voltage
Output point for an AO-8 module).
8. Click File and Properties.
9. In the Basic tab Engineering scale top and Engineering scale bottom
boxes, enter values that indicate the top (9V in this example) and bottom (1V in
this example) of the engineering scale for the output point.

10. In the Electrical scale top and Electrical scale bottom boxes, enter
values for the top and bottom of the electrical scale range of the output point.
Continued on next page
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11. Click OK to insert the scaling factor.
A Progress view displays indicating that the configuration changes are being
saved to the database.
Configuring scaling on analog outputs converts the Requested value in
engineering units (application) to a physical value in electrical units (voltage or
current).
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21.23

Implicit Trend Logs for I/O Points
When you create an I/O point on an I/O module, the system automatically creates
an implicit trend log for that I/O point. The implicit trend log logs the Value of the I/O
point in a Change of Value type trend log.
The values must change by the following amounts before the logs show new
values:
• Current Outputs and Inputs: 0.2 mA
• Voltage Outputs and Inputs: 0.1 V
• Resistive Inputs: 200Ω
• Temperature Inputs: 0.2 oC (32.3 oF)
• All others: Any change of value
If scaling is set on an I/O point, the implicit log’s delta is also scaled and the implicit
trend logs the scaled value. The implicit log also logs forced values along with an
indication that a particular value is forced.
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21.24

Input Point Offsets
An offset is a value added to or subtracted from the engineering value before it
impacts the input point's Value property. For example, assume that a Thermistor
input is housed in a wiring closet. If you know the temperature in that closet is 2 °C
higher than the temperature outside the closet, you enter -2,0 as the offset value.
The object then measures 25 °C from the point, uses the offset to calibrate that
value, and displays 23 °C in the Value property. Using the offset value helps to
compensate for the temperature differences between the closet and the ambient
temperature.
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21.25

Configuring Offsets for Input Points
You enter an offset to specify the value that you want added to or subtracted from
the engineering value before it affects the point's value property. For example, using
an offset helps to compensate for the temperature differences between a
Thermistor output housed in a wiring closet and the temperature outside that
closet.
For more information, see section 21.24 “Input Point Offsets” on page 706.

To configure offsets for input points
1. In WorkStation, in the System tree pane, select an I/O module.
2. On the File menu, point to New and then click Input Point.
3. In the object type list, select one of the following input types: Current,
Temperature, Resistive, or Voltage.

4. In the Name box, enter a name for the input point.
5. In the Description box, type a description of the input point.
6. Click Next.
Continued on next page
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7. In the Input channel box, select the channel that corresponds to the
terminal connection on the I/O module where the input will be wired.

8. In the Label text box, enter text to identify the input point on the I/O module
label.
9. Enter the remaining values you want in the boxes on the Basic Settings page.
For more information, see the New Input Point Configuration Wizard – Basic
Settings Page topic on WebHelp.
10. In the Offset box, enter the offset value that you want added to or subtracted
from the engineering value before it affects the point's value property.
11. Click Create.
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21.26

Printing a Wiring List for the I/O Bus
You print an I/O wiring list for the I/O bus that describes which I/O points are
associated with each I/O module. You use the printed copy of this list to help wire
the I/O bus network.

Note
• You cannot print a wiring list for an I/O module with a Module ID of Null
(unconfigured).
• I/O points with a channel of Null do not display on the wiring list.
For more information, see the I/O Bus Overview topic on WebHelp.

To print an I/O wiring list for the I/O bus
1. In WorkStation, in the System Tree pane, expand the IO Bus.
Continued on next page
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2. Right-click IO Bus and then click Print IO wiring list to print a wiring list for
the entire I/O bus.

3. In the Print IO Wiring List dialog box, click the Printer icon
I/O wiring list.

to print the

4. To print a wiring list for a single I/O module, right-click the selected I/O module
(AO-8 in this example).
Continued on next page
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5. Click Print IO wiring list.
You can also select multiple I/O modules in the List View.

6. Click the Printer icon

to print the wiring list.

Observe that the complete path to the I/O module is displayed on the title bar for
the I/O wiring list.
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21.27

Threshold Settings for I/O Points
The threshold is the minimum change of value before the I/O module reports the
value to the Automation Server. Properly setting the threshold value reduces
unnecessary communication between the I/O module and the Automation Server.
When both the Automation Server and the I/O modules are online and operating
normally, an I/O module reports the value of a point to the Automation Server if and
only if the change since the last report is larger than the threshold. This is true for
the value property in both input and output points.
Threshold uses the engineering unit. However, WorkStation does not present the
threshold unit. The Automation Server uses a unit related to the Value property
before WorkStation applies localization. The unit of value before localization is
shown in the Settings page of the Value property.

Figure: Value Unit Before Localization

The relationship between the Value's unit and the threshold is as follows:
• If the unit is not a temperature unit, the server uses the same unit for threshold.
• If the unit is a temperature unit, the server uses the version of the unit. For
example, if the Value's unit is °C, the threshold unit is °C.
With a default threshold value of 0, the I/O module reports the Value with its
maximum resolution. The maximum resolution values for each of the I/O points are
listed here.
Table: I/O Point Resolution Values
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Points

Maximum
Resolution

Minimum Value

Maximum Value

Voltage Input

2.7 mV

0V

10 V
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Continued
Points

Maximum
Resolution

Minimum Value

Maximum Value

Current Input

5.6 µA

0 mA

20 mA

Digital Input

120 ms

n/a

n/a

Counter Input

20 ms

n/a

n/a

Voltage Output

42 mV

0V

10 V

Current Output

0.1 mA

0 mA

20 mA

2- or 3-Wire RTD
Temperature Inputs

0.03 °C

-50 °C

+150 °C

2- or 3-Wire RTD
Resistive Input, 100
ohm type

0.01 ohms

50 ohms

220 ohms

2- or 3-Wire RTD
0.1 ohms
Resistive Input, 1000
ohm type

500 ohms

2200 ohms

Resistive Input, RTD
module

1 ohm

0 ohms

15000 ohms

Resistive Input, UIseries module*

4 ohms

10 ohms

60000 ohms

Temperature Input,
Satchwell 10k

0.08 °C

-50 °C

+150 °C

Temperature Input,
1.8k*

0.05 °C

-50 °C

+150 °C

Temperature Input,
10k series*

0.05 °C

-50 °C

+150 °C

Temperature Input,
1k Balco*

0.6 °C

-50 °C

+150 °C

Temperature Input,
20k*

0.05 °C

-50 °C

+150 °C

Temperature Input,
2.2k

0.05 °C

-50 °C

+150 °C

* For UI-series modules, such as the UI-16, AO-4, UI-8, and DO-4, the temperature and
resistive input maximum resolution varies non-linearly depending on the temperature or
resistance range being measured. The maximum resolution listed here is the maximum
across the entire range.
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Points

Maximum
Resolution

Minimum Value

Maximum Value

Reporting the Value with its maximum resolution requires the system to process
every single fluctuation every time the Value changes. When a large number of
inputs and outputs are involved, the Automation Server may need a significant
amount of CPU bandwidth to process them. As a result, you may observe high
system CPU usage and slow response time. For more information, see section
150.6 “High CPU Usage and Slow System Response Time ” on page 5528.
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Topics
Central I/O System Tree Pane Icons
I/O Module Management Tool Dialog Box
I/O Bus Properties – Basic Tab
I/O Module Properties – Basic Tab
I/O Modules in the Work Area
Counter Input Properties – Basic Tab
Current Input Properties – Basic Tab
Digital Input Properties – Basic Tab
Resistive Input Properties – Basic Tab
2-Wire or 3-Wire RTD Resistive Input Properties – Basic Tab
Supervised Input Properties – Basic Tab
Temperature Input Properties – Basic Tab
2-Wire or 3-Wire RTD Temperature Input Properties – Basic
Tab
Voltage Input Properties – Basic Tab
Current Output Properties – Basic Tab
Voltage Output Properties – Basic Tab
Digital Output Properties – Basic Tab
Digital Pulsed Output Properties – Basic Tab
Tristate Output Properties – Basic Tab

Tristate Pulsed Output Properties – Basic Tab
I/O Points in the Work Area
Print I/O Wiring List Dialog Box
Counter Input – Basic Settings Page
Current Input – Basic Settings Page
Digital Input – Basic Settings Page
Resistive Input – Basic Settings Page
2-Wire or 3-Wire RTD Resistive Input – Basic Settings Page
Supervised Input – Basic Settings Page
Temperature Input – Basic Settings Page
2-Wire or 3-Wire RTD Temperature Input – Basic Settings
Page
Voltage Input – Basic Settings Page
New I/O Module Wizard – Basic Settings Page
Current Output – Basic Settings Page
Voltage Output – Basic Settings Page
Digital Output – Basic Settings Page
Digital Pulsed Output – Basic Settings Page
Tristate Output – Basic Settings Page
Tristate Pulsed Output – Basic Settings Page
Print I/O Module Labels Dialog Box
Update I/O Module Firmware Dialog Box

22 I/O User Interface
22.1 Central I/O System Tree Pane Icons

22.1

Central I/O System Tree Pane Icons
Use the System Tree pane icons to identify the I/O bus, I/O channels, and I/O
modules and points.
Table: Central I/O System Tree Pane Icons
Icon

Description
I/O Bus
Indicates the I/O bus.
I/O Module
Indicates the I/O module.
I/O Point
Indicates an I/O point.
Output I/O Channel
Indicates the output I/O channel in the Hardware folder.
Input I/O Channel
Indicates the input I/O channel in the Hardware folder.
Output I/O Point
Indicates the output I/O point.
Input I/O Point
Indicates the input I/O point.
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22.2

I/O Module Management Tool Dialog
Box
Use the IO Module Management Tool dialog box to assign and unassign logical
I/O modules, to correct the position of a module type, or to correct a module
mismatch.

Figure: IO Module Management Tool dialog box

Table: IO Module Management Tool Dialog Box
Component

Description

Module ID

Displays the position of the I/O module on the I/O Bus. Null and 1
to 32 are valid positions. Null specifies that the Module ID is nonoperational and can be used as a placeholder to be configured
when you wish to assign it to a physical slot.

Physical device
type

Displays the physical device type connected to the Automation
Server.

IO module status

Displays the status of the I/O module:
• Configured– There is at least one I/O point created on the
module.
• Unconfigured- There are no I/O points created on the
module.
• Bootloader– The module's firmware is being updated.
• Low power– The module has been placed in low power
mode to save energy.
• 24V Out of tolerance– The module is not receiving the
required power from the bus.
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IO module name

Displays the logical module located in the IO Bus folder.

IO module type

Displays the type of logical I/O module.
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Continued
Component

Description

Unssigned Modules Displays unassigned I/O modules. You drag and drop unassigned
modules to assign them to a physical device. For more
information, see section 20.11 “Assigning and Unassigning
Logical I/O Modules” on page 630.
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22.3

I/O Bus Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of the I/O bus.

Figure: I/O bus properties - basic tab

Table: Basic Tab
Component

Description

Automation Server backplane address Displays the slot where the Automation
Server is currently located.
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22.4

I/O Module Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of I/O modules.

Figure: I/O module properties - basic tab

Table: Basic Tab
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Component

Description

Status

Displays whether the I/O module is online or
offline. WorkStation displays an alarm when
the I/O module's status changes
unexpectedly, for example, when the
module is online and then goes offline with
respect to the Automation Server.
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Continued
Component

Description

Module status

Displays the status of the I/O module:
• Configured– There is at least one I/O
point created on the module.
• Unconfigured- There are no I/O points
created on the module.
• Bootloader– The module's firmware is
being updated.
• Low power– The module has been
placed in low power mode to save
energy.
• 24V Out of tolerance– The module is
not receiving the required power from
the bus.

Module type mismatch

Displays True when the user has created a
different type of module at a specific location
in the I/O Bus than is physically installed at
that location. When this occurs, a Module
type mismatch alarm is also triggered.

Model name

Displays the I/O module model name.

Product serial number

Displays the I/O module serial number.

Firmware version

Displays the firmware version of the I/O
module.

Hardware version

Displays the hardware version of the I/O
module.

Update status

Displays the update status of the I/O
module:
• Idle– No module firmware update is
occurring.
• In progress- Module firmware is being
updated.
• Bad file– Module firmware update failed
because the uploaded file was
corrupted.
• Complete– Module firmware update
completed successfully.

Technical
724

Module ID

Displays the position of the I/O module on
the I/O Bus. Null and 1 to 32 are valid
positions. Null specifies that the Module ID is
non-operational and can be used as a
placeholder to be configured when you wish
to assign it to a physical slot.

Low power

Displays True when the I/O module has
been placed in low power mode. You place
an I/O module in low power mode to save
energy. The default here is False.
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Continued
Component

Description

Override capability expected

Select Yes to connect a module with an
override switch. The field specifies whether
you would like the module to be override
capable. It does mean that the module is
actually override capable.
To determine whether the module is override
capable, view the Module name property. If it
ends with an -H, the module is override
capable.
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22.5

I/O Modules in the Work Area
Use the Work Area to access details about the I/O modules in the IO Bus.

Figure: Detailed view of the I/O modules on the I/O bus

Tip
If you do not see all of the fields displayed here, right-click on the column header
to display more.
Table: I/O Modules in the Work Area
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Component

Description

Name

Displays the I/O module name that you
assign. When creating the I/O module, the
default value is the I/O module type, for
example AO-8 (analog output, 8-channel).

Description

Displays the user defined description of the
I/O module.

Status

Displays the status of the I/O module: either
online or offline with respect to the
Automation Server.

Module status

Displays the status of the I/O module:
Configured, Unconfigured, Bootloader, Low
power, or 24V Out of tolerance. The module
status is set to configured when there is at
least one I/O point created on the module.

Model name

Displays the type of I/O module.
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Continued
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Component

Description

Module ID

Displays the position of the I/O module on
the I/O Bus. Null and 1 to 32 are valid
positions. Null specifies that the Module ID is
non-operational and can be used as a
placeholder to be configured when you wish
to assign it to a physical slot.
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22.6

Counter Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a counter input point.

Figure: Counter Input Properties – Basic tab

Table: Counter Input Properties - Basic Tab
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Component

Description

Value

Displays the present value. The maximum
value of a counter input is 4294967295.
Once passed, that value wraps to 0. The
maximum supported rate for a counter input
is 25Hz.

Reset counter

Select True to set the counter value to 0.
The reset counter turns back to False after
being set to True.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.
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Continued
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Component

Description

Invert

Select True (inverted) to increment the
counter when the counter input is
disconnected, rather than when it is
connected.

LED color

Select either Red or Green.

LED invert

Select True to turn the LED off when the
counter is connected and on when the
counter is disconnected.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.
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22.7

Current Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a current input point.

Figure: Current Input Properties – Basic tab

Table: Current Input Properties - Basic Tab
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Component

Description

Value

Displays the present value as measured from
0 to 20mA.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.
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Continued
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Component

Description

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.

Digital filter

Select True to filter out noise and prevent
false readings.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Upper reliability level

Type a value for the upper reliability level in
electrical units. When the electrical value is
above the upper reliability level, the Reliability
is Value over range.

Lower reliability level

Type a value for the lower reliability level in
electrical units. When the electrical value is
below the lower reliability level, the Reliability
is Value under range.

Electrical scale top

Type a top of the range voltage (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 10 VDC, 20
mA, or 60 kohm).

Electrical scale bottom

Type a bottom of the range voltage, (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 0 VDC, 0
mA, or 0 kohm)

Engineering scale top

Type a top of the range engineering value for
the input point. (Example: 100%)

Engineering scale bottom

Type a bottom of the range engineering
value for the input point scale. (Example:
0%).

Offset

Type an offset value to be added to or
subtracted from the engineering value before
it impacts the Value property.
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22.8

Digital Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a digital input point.

Figure: Digital Input Properties – Basic tab

Table: Digital Input Properties - Basic Tab
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Component

Description

Value

Displays the present value, On or Off.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.

Invert

Select True (inverted) to turn the LED off
when the current is closed.

LED color

Select either Red or Green.

LED invert

Select True to turn the LED off when the
current is closed.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.
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22.9

Resistive Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a resistive input point.

Figure: Resistive Input Properties – Basic tab

Table: Resistive Input Properties - Basic Tab
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Component

Description

Value

Displays the resistance measured between 0
and 65535 ohms. The RTD module resistive
input range is from 0 to 15000 ohms.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.
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Continued
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Component

Description

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.

Digital filter

Select True to filter out noise and prevent
false readings.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Upper reliability level

Type a value for the upper reliability level in
electrical units. When the electrical value is
above the upper reliability level, the Reliability
is Value over range.

Lower reliability level

Type a value for the lower reliability level in
electrical units. When the electrical value is
below the lower reliability level, the Reliability
is Value under range.

Electrical scale top

Type a top of the range voltage (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 10 VDC, 20
mA, or 60 kohm).

Electrical scale bottom

Type a bottom of the range voltage, (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 0 VDC, 0
mA, or 0 kohm)

Engineering scale top

Type a top of the range engineering value for
the input point. (Example: 100%)

Engineering scale bottom

Type a bottom of the range engineering
value for the input point scale. (Example:
0%).

Offset

Type an offset value to be added to or
subtracted from the engineering value before
it impacts the Value property.
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22.10

2-Wire or 3-Wire RTD Resistive Input
Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a 2-wire or 3-wire RTD
resistive input point.

Figure: 2– or 3–Wire Resistive Input Properties – Basic tab

Table: 2-Wire or 3-Wire Resistive Input Properties - Basic Tab
Component

Description

Value

Displays the measured value.
See the Sensor class property for more
information.

Communications status
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Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.
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Continued
Component

Description

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.

Sensor class

Select the sensor class to configure the RTD
resisitive input for the approximate range it
will measure:
• 100 ohm based: measures a range
from 50 to 220 ohm
• 1000 ohm based: measures a range
from 500 to 2200 ohm

Technical
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Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.

Digital filter

Select True to filter out noise and prevent
false readings.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Upper reliability level

Type a value for the upper reliability level in
electrical units. When the electrical value is
above the upper reliability level, the Reliability
is Value over range.

Lower reliability level

Type a value for the lower reliability level in
electrical units. When the electrical value is
below the lower reliability level, the Reliability
is Value under range.

Electrical scale top

Type a top of the range voltage (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 10 VDC, 20
mA, or 60 kohm).

Electrical scale bottom

Type a bottom of the range voltage, (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 0 VDC, 0
mA, or 0 kohm)

Engineering scale top

Type a top of the range engineering value for
the input point. (Example: 100%)
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Continued
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Component

Description

Engineering scale bottom

Type a bottom of the range engineering
value for the input point scale. (Example:
0%).

Offset

Type an offset value to be added to or
subtracted from the engineering value before
it impacts the Value property.
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22.11

Supervised Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a supervised input point.

Figure: Supervised Input Properties – Basic tab

Table: Supervised Input Properties - Basic Tab

Technical
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Component

Description

Value

Displays the present value: On, Off, Trouble,
or Not set.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.

Supervised circuit type

Select one of the following: Not set, None,
NO Series, NC Series, NO Parallel, NC
Parallel. NO Series/Parallel, or NC
Series/Parallel (NO= normally open, NC=
normally closed). The default value is NO
Series.

Supervised resistor value

Type the resistance value of the resistors in
the supervised circuit.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.
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22.12

Temperature Input Properties – Basic
Tab
Use the Basic tab to view and edit the basic properties of a temperature input
point.

Figure: Temperature Input Properties – Basic tab

Table: Temperature Input Properties - Basic Tab
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Component

Description

Value

Displays the temperature value. The
module's maximum precision is 0.01C.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.

Thermistor type

Select the appropriate thermistor type from
the list. For more information, see section
21.21 “I/O Point Scaling” on page 698.list.
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Continued
Component

Description

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.
In this sample Temperature Input - Basic Tab
graphic, the threshold has a unit of
temperature and is displayed here
localized to the region as C.
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Digital filter

Select True to filter out noise and prevent
false readings.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Upper reliability level

Type a temperature value for the upper
reliability level. When the value is above the
upper reliability level, the Reliability is Value
over range. For more information, see
section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability
Levels” on page 679.

Lower reliability level

Type a temperature value for the lower
reliability level. When the value is below the
lower reliability level, the Reliability is Value
under range. For more information, see
section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability
Levels” on page 679.

Offset

Type an offset value to be added to or
subtracted from the engineering value before
it impacts the Value property.
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22.13

2-Wire or 3-Wire RTD Temperature
Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a 2-wire or 3-wire RTD
temperature input point.

Figure: 2– or 3–Wire RTD Temperature Input Properties – Basic tab

Table: 2- or 3-Wire RTD Temperature Input Properties - Basic Tab

04-16006-04-en, March 2015

Component

Description

Value

Displays the converted temperature value in
degrees including the user-specified wiring
resistance and offset. Has a range of -50 to
150°C. For more information, see section
21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability
Levels” on page 679.

Raw resistance

Displays the measured resistance from the
RTD without applying the wiring resistance
or offset properties.
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Continued
Component

Description

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.

Sensor type

Select a sensor type to determine how the
resistance value is converted to
temperature.

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.
In this sample Temperature Input - Basic Tab
graphic, the threshold has a unit of
temperature and is displayed here
localized to the region as C.
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Digital filter

Select True to filter out noise and prevent
false readings.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Upper reliability level

Type a temperature value for the upper
reliability level. When the value is above the
upper reliability level, the Reliability is Value
over range. For more information, see
section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability
Levels” on page 679.

Lower reliability level

Type a temperature value for the lower
reliability level. When the value is below the
lower reliability level, the Reliability is Value
under range. For more information, see
section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability
Levels” on page 679.

Offset

Type an offset value in degrees to the
converted temperature value. For
instructions on how the value is calculated,
see the Value property.
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Continued
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Component

Description

Wiring resistance

Type a wiring resistance value. For more
information, see section 21.8 “2-Wire RTDDI-16 Temperature Input Wiring Resistance”
on page 678.
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22.14

Voltage Input Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a voltage input point.

Figure: Voltage Input Properties – Basic tab

Table: Voltage Input Properties - Basic Tab

Technical
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Component

Description

Value

Displays the voltage input value.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Channel

Select an input channel number, such as
In1.
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Continued
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Component

Description

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.

Digital filter

Select True to filter out noise and prevent
false readings.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Upper reliability level

Type a value for the upper reliability level in
electrical units. When the electrical value is
above the upper reliability level, the Reliability
is Value over range.

Lower reliability level

Type a value for the lower reliability level in
electrical units. When the electrical value is
below the lower reliability level, the Reliability
is Value under range.

Electrical scale top

Type a top of the range voltage (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 10 VDC, 20
mA, or 60 kohm).

Electrical scale bottom

Type a bottom of the range voltage, (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 0 VDC, 0
mA, or 0 kohm)

Engineering scale top

Type a top of the range engineering value for
the input point. (Example: 100%)

Engineering scale bottom

Type a bottom of the range engineering
value for the input point scale. (Example:
0%).

Offset

Type an offset value to be added to or
subtracted from the engineering value before
it impacts the Value property.
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22.15

Current Output Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a current output point.

Figure: Current Output Properties – Basic tab

Table: Current Output Properties - Basic Tab

Technical
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Component

Description

Value

Displays the value, up to a maximum of
20mA. This is the measured value of the
output from the I/O module.

Requested value

Enter a value that you want to assign to the
output. This property drives the output to a
specific value. If the I/O module loses
communication with the Automation Server
for 255 seconds, the default output value is
used instead of the requested value.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.
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Continued
Component

Description

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Override status

Displays whether the override switch is being
used. If the status is True, the physical
override switch has been set to Hand (value
= 10mA) or Off (value = 0mA).

Channel

Select an output channel number, such as
Out1.

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.
The threshold is applied to the value
measured from the I/O module, not the
output value. For example, suppose that a
current output has a requested value of
2mA, a value of 2mA, and a threshold of
2mA. If the requested value is set to 3mA,
the value will remain at 2mA, but the output
value from the module will be 3mA.
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Default output value

Enter the value that you want to revert to if
the I/O module loses communication with
the Automation Server for more than 255
seconds.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Electrical scale top

Type a top of the range voltage (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 10 VDC, 20
mA, or 60 kohm).

Electrical scale bottom

Type a bottom of the range voltage, (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 0 VDC, 0
mA, or 0 kohm)

Engineering scale top

Type a top of the range engineering value for
the input point. (Example: 100%)

Engineering scale bottom

Type a bottom of the range engineering
value for the input point scale. (Example:
0%).
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22.16

Voltage Output Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a voltage output point.

Figure: Voltage Output Properties – Basic tab

Table: Voltage Output Properties - Basic Tab

Technical
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Component

Description

Value

Displays the value, up to a maximum output
of 10V. This is the measured value of the
output from the I/O module.

Requested value

Enter a value that you want to assign to the
output. This property drives the output to a
specific value. If the I/O module loses
communication with the Automation Server
for 255 seconds, the default output value is
used instead of the requested value.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.
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Continued
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Component

Description

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Override status

Displays whether the override switch is being
used. If the status is True, the physical
override switch has been set to Hand (value
= 5V) or Off (value = 0V).

Channel

Select an output channel number, such as
Out1.

Threshold

Type a value for the minimum amount of
change of value before the I/O module
reports the value to the Automation Server.
Properly setting the threshold value reduces
unnecessary communication between the
I/O module and the Automation Server. For
more information, see section 21.27
“Threshold Settings for I/O Points” on page
712.

Default output value

Enter the value that you want to revert to if
the I/O module loses communication with
the Automation Server for more than 255
seconds.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

Electrical scale top

Type a top of the range voltage (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 10 VDC, 20
mA, or 60 kohm).

Electrical scale bottom

Type a bottom of the range voltage, (VDC),
current (mA), or resistance (kohm) value for
the input point scale. (Example: 0 VDC, 0
mA, or 0 kohm)

Engineering scale top

Type a top of the range engineering value for
the input point. (Example: 100%)

Engineering scale bottom

Type a bottom of the range engineering
value for the input point scale. (Example:
0%).
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22.17

Digital Output Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a digital output point.

Figure: Digital Output Properties – Basic tab

Table: Digital Output Properties - Basic Tab
Component

Description

Value

Displays the value of a digital output, either
On or Off.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Requested value

Select either On or Off to set the Requested
value. Off is the default value.
When the Requested value is set, the output
turns on and off and remains there unless
the I/O module loses communication with
the Automation Server. If the I/O module
loses communication with the Automation
Server for 255 seconds, the default output
value is used instead of the requested value.
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Continued
Component

Description

Override status

Displays whether the override switch is being
used. If the status is True, the physical
override switch Hand value is On and the
override off value is Off.

Channel

Select an output channel number, such as
Out1.

Invert

Select either False (not inverted) or True
(inverted).

Default output value

Select either On or -On to set the default
output value. Off is the default value.
The default output value is the value that the
output reverts to if the I/O module loses
communication with the Automation Server
for more than 255 seconds.

Label text
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Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.
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22.18

Digital Pulsed Output Properties – Basic
Tab
Use the Basic tab to view and edit the basic properties of a digital pulsed output
point.

Figure: Digital Pulsed Output – Basic tab

Table: Digital Pulsed Output Properties - Basic Tab

Technical
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Component

Description

Value

Displays the value of a digital pulsed output,
either On or Off.

Requested value

Enter a value that you want to assign to the
output. This value depends on the PWM
settings. If the PWM scale is Duty cycle,
the requested value is a percentage from 0100. If the PWM scale is Pulse duration,
the requested value turns on for the
requested value seconds.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.
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Component

Description

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Override status

Displays whether the override switch is being
used. If the status is True, the physical
override switch Hand value is On and the
override off value is Off.

Channel

Select an output channel number, such as
Out1.

Invert

Turns a digital pulsed output to the opposite
or contrary value. Select either False (not
inverted) or True (inverted). False is the
default value.

Default output value

Enter the value that you want to revert to if
the I/O module loses communication with
the Automation Server for more than 255
seconds.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

PWM scale

Select the PWM scale parameter Duration (s)
or Duty cycle (%). For more information, see
section 21.21 “I/O Point Scaling” on page
698.

Period

Type a period value. For example, a duty
cycle of 25% and a Period of 20 seconds
produces a 5 second pulse every 20
seconds (25% of 20 seconds = 5 seconds).

PWM minimum pulse

Type a PWM minimum pulse. If the value is
On for less than the minimum pulse, the
value remains Off.

Technical
753

22 I/O User Interface
22.19 Tristate Output Properties – Basic Tab

22.19

Tristate Output Properties – Basic Tab
Use the Basic tab to view and edit the basic properties of a tristate output point.

Figure: Tristate Output Properties – Basic tab

Table: Tristate Output Properties - Basic Tab
Component

Description

Value

Displays the value of a tristate output, either
On, Off, -On or Invalid. On turns the first
channel on. Off turns both channels off and On turns the second channel on. If you use
the override switch to turn both channels on,
the value is invalid.

Requested value

Select either On, Off, or -On to set the
requested value. Off is the default value.
When the requested value is set, the output
turns on or off and remains there unless the
I/O module loses communication with the
Automation Server. If the I/O module loses
communication with the Automation Server
for 255 seconds, the default output value is
used instead of the requested value.

Technical
754

Reliabilty

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.
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Continued
Component

Description

Override status

Displays whether the override switch is being
used. If the status is True, the physical
override switch Hand value is On and the
override off value is Off.

Channel

Select an output channel number. Tristate
and tristate pulsed outputs take up two
channels. The first one is displayed here. For
example, a tristate pulsed output occupies
channels Out1 and Out2.

Default output value

Select either On, Off, or -On to set the
default output value. Off is the default value.
The default output value is the value that the
output reverts to if the I/O module loses
communication with the Automation Server
for more than 255 seconds.

Label text
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Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.
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22.20

Tristate Pulsed Output Properties –
Basic Tab
Use the Basic tab to view and edit the basic properties of a tristate pulsed output
point.

Figure: Tristate Pulsed Output Properties – Basic tab

Table: Tristate Pulsed Output Properties - Basic Tab
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Component

Description

Value

Displays the value of a tristate pulsed output,
either On, Off, or -On. For a tristate pulsed
output at channel 1, On means the first
channel is on and the second is off, while On means that the second channel is on and
the first channel is off. Off means that both
channels are off.

Requested value

Enter a value that you want to assign to the
output. This value depends on the PWM
settings. If the PWM scale is Duty cycle,
the requested value is a percentage from 0100. If the PWM scale is Pulse duration,
the requested value turns on for the
requested value seconds.
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Component

Description

Communications status

Displays online when the module is
communicating with the server and the point
is on a valid, unassigned channel.

Reliability

Displays the integrity of the value of a point.
For more information, see section 21.16
“Reliability of I/O Points” on page 692.

Override status

Displays whether the override switch is being
used. If the status is True, the physical
override switch Hand value is On and the
override off value is Off.

Channel

Select an output channel number. Tristate
and tristate pulsed outputs take up two
channels. The first one is displayed here. For
example, a tristate pulsed output occupies
channels Out1 and Out2.

Default output value

Enter the value that you want to revert to if
the I/O module loses communication with
the Automation Server for more than 255
seconds.

Label text

Type the text that is printed on an I/O
module label. For more information, see
section 22.39 “Print I/O Module Labels
Dialog Box” on page 785.

PWM scale

Select the PWM scale parameter Duration (s)
or Duty cycle (%). For more information, see
section 21.21 “I/O Point Scaling” on page
698.

Period

Type a period value. For example, a duty
cycle of 25% and a Period of 20 seconds
produces a 5 second pulse every 20
seconds (25% of 20 seconds = 5 seconds).

PWM minimum pulse

Type a PWM minimum pulse. If the value is
On for less than the minimum pulse, the
value remains Off.
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22.21

I/O Points in the Work Area
Use the work area to access details about the I/O points that have been created in
an I/O module.

Figure: I/O points in the work area

Tip
If you do not see all of the fields displayed here, right-click on the column header
to display more.
Table: I/O Points in the Work Area
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Component

Description

Name

Displays the point name that was assigned.
The default value is the input or output type,
for example, Counter Input.

Description

Displays the user defined description of the
I/O point
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22.22

Print I/O Wiring List Dialog Box
Use the Print IO Wiring List dialog box to print an I/O wiring list for the I/O bus
that describes which I/O points are associated with each I/O module.

Figure: Print IO wiring list dialog box

Table: Print IO Wiring List Dialog Box
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Component

Description

IO module

Displays the I/O module.

Channel

Displays the electrical channel of the I/O
module.

Point name

Displays the I/O point name.
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Continued
Component

Description

Type

Displays the I/O point type.

Description

Displays a description for the I/O module.

Label text

Displays the text that is printed on an I/O
module label using the Print IO module labels
command.
Click to print a wiring list for the I/O bus. For
more information, see section 21.26
“Printing a Wiring List for the I/O Bus” on
page 709..
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22.23

Counter Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the counter
input I/O point you create.

Figure: Counter Input - Basic Settings page

Table: Counter Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Invert

Select either True or False. Selecting True inverts the value of a
digital input and configures a counter input to increment when the
contact opens.

LED color

Select either Red or Green.

LED invert

Select either True or False. Selecting True lights the LED when the
digital input is on and turns it off when the digital input is off.
Selecting False turns off the LED when the digital input is on and
turns on the LED when the digital input is off.

Technical
761

22 I/O User Interface
22.24 Current Input – Basic Settings Page

22.24

Current Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the current
input I/O point you create.

Figure: Current Input - Basic Settings page

Table: Current Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Digital filter

Select True (On) or False (Off) to filter out noise and prevent false
readings.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.

Top of scale
engineering
value

Type a value to enter the top of the range engineering value for the
input point.

Top of scale
electrical value

Type a value to enter the top of the range voltage (VDC), current
(mA), or resistance (kohm) value for the input point scale.
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Component

Description

Bottom of scale
engineering
value

Type a value for the bottom of the range engineering value for the
input point scale.

Bottom of scale
electrical value

Type a bottom of the range voltage, (VDC), current (mA), or
resistance (kohm) value for the input point scale.

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.

Offset

Type an offset value to be added to or subtracted from the
engineering value before it impacts the Value property.

Upper reliability
level

Type a value for the upper reliability level in electrical units. When the
electrical value is above the upper reliability level, the Reliability is
Value over range.

Lower reliability
level

Type a value for the lower reliability level in electrical units. When the
electrical value is below the lower reliability level, the Reliability is
Value under range.
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22.25

Digital Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the digital
input I/O point you create.

Figure: Digital Input - Basic Settings page

Table: Digital Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Invert

Select either True or False. Selecting True inverts the value of a
digital input and configures a counter input to increment when the
contact opens.

LED color

Select either Red or Green.

LED invert

Select either True or False. Selecting True lights the LED when the
digital input is on and turns it off when the digital input is off.
Selecting False turns off the LED when the digital input is on and
turns on the LED when the digital input is off.
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22.26

Resistive Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the resistive
input I/O point you create.

Figure: Resistive Input - Basic Settings page

Table: Resistive Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Digital filter

Select True (On) or False (Off) to filter out noise and prevent false
readings.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.

Top of scale
enginering value

Type a value to enter the top of the range engineering value for the
input point.

Top of scale
electrical value

Type a value to enter the top of the range voltage (VDC), current
(mA), or resistance (kohm) value for the input point scale.
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Component

Description

Bottom of scale
engineering
value

Type a value for the bottom of the range engineering value for the
input point scale.

Bottom of scale
electrical value

Type a bottom of the range voltage, (VDC), current (mA), or
resistance (kohm) value for the input point scale.

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.

Offset

Type an offset value to be added to or subtracted from the
engineering value before it impacts the Value property.

Upper reliability
level

Type a value for the upper reliability level in electrical units. When the
electrical value is above the upper reliability level, the Reliability is
Value over range.

Lower reliability
level

Type a value for the lower reliability level in electrical units. When the
electrical value is below the lower reliability level, the Reliability is
Value under range.
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22.27

2-Wire or 3-Wire RTD Resistive Input –
Basic Settings Page
Use the Basic Settings page to specify the basic properties for the 2-wire or 3wire RTD resistive input point you create.

Figure: 2-Wire or 3-Wire RTD Resistive Input - Basic Settings page

Table: 2-Wire or 3-Wire RTD Resistive Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Digital filter

Select True (On) or False (Off) to filter out noise and prevent false
readings.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.

Top of scale
enginering value

Type a value to enter the top of the range engineering value for the
input point.

Top of scale
electrical value

Type a value to enter the top of the range voltage (VDC), current
(mA), or resistance (kohm) value for the input point scale.
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Component

Description

Bottom of scale
engineering
value

Type a value for the bottom of the range engineering value for the
input point scale.

Bottom of scale
electrical value

Type a bottom of the range voltage, (VDC), current (mA), or
resistance (kohm) value for the input point scale.

Offset

Type an offset value to be added to or subtracted from the
engineering value before it impacts the Value property.

Upper reliability
level

Type a value for the upper reliability level in electrical units. When the
electrical value is above the upper reliability level, the Reliability is
Value over range.

Lower reliability
level

Type a value for the lower reliability level in electrical units. When the
electrical value is below the lower reliability level, the Reliability is
Value under range.

Sensor class

Select the sensor class to configure the RTD resisitive input for the
approximate range it will measure:
• 100 ohm based: measures a range from 50 to 220 ohm
• 1000 ohm based: measures a range from 500 to 2200 ohm
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22.28

Supervised Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the supervised
input I/O point you create.

Figure: Supervised Input - Basic Settings page

Table: Supervised Input - Basic Settings Page

04-16006-04-en, March 2015

Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Supervised
circuit type

Select one of the following: Not set, None, NO Series, NC
Series, NO Parallel, NC Parallel. NO Series/Parallel, or NC
Series/Parallel (NO= normally open, NC= normally closed).

Supervised
resistor value

Type the value or use the up and down arrow keys to enter the
resistance value of the resistors in the supervised circuit.
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22.29

Temperature Input – Basic Settings
Page
Use the Basic Settings page to specify the the basic properties for the
temperature input I/O point you create.

Figure: Temperature Input - Basic Settings page

Table: Temperature Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Digital filter

Select True (On) or False (Off) to filter out noise and prevent false
readings.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.

Thermistor type

Select the appropriate thermistor type from the list.

Offset

Type an offset value to be added to or subtracted from the
engineering value before it impacts the Value property.
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Component

Description

Upper reliability
level

Type a temperature value for the upper reliability level. When the
value is above the upper reliability level, the Reliability is Value over
range. For more information, see section 21.9 “2-Wire or 3-Wire
RTD-DI-16 Temperature Input Value and Reliability Levels” on page
679.

Lower reliability
level

Type a temperature value for the lower reliability level. When the value
is below the lower reliability level, the Reliability is Value under range.
For more information, see section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability Levels” on page 679.
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22.30

2-Wire or 3-Wire RTD Temperature
Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the 2-wire or
3-wire RTD temperature input point you create.

Figure: 2-Wire or 3-Wire Temperature Input - Basic Settings page

Table: 2-Wire or 3-Wire Temperature Input - Basic Settings Page
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Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Digital filter

Select True (On) or False (Off) to filter out noise and prevent false
readings.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.

Sensor type

Select a sensor type to determine how the resistance value is
converted to temperature.

Offset

Type an offset in degrees to the converted temperature value.
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Component

Description

Upper reliability
level

Type a temperature value for the upper reliability level. When the
value is above the upper reliability level, the Reliability is Value over
range. For more information, see section 21.9 “2-Wire or 3-Wire
RTD-DI-16 Temperature Input Value and Reliability Levels” on page
679.

Lower reliability
level

Type a temperature value for the lower reliability level. When the value
is below the lower reliability level, the Reliability is Value under range.
For more information, see section 21.9 “2-Wire or 3-Wire RTD-DI-16
Temperature Input Value and Reliability Levels” on page 679.

Wiring resistance Type a wiring resistance value. For more information, see section
21.8 “2-Wire RTD-DI-16 Temperature Input Wiring Resistance” on
page 678.
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22.31

Voltage Input – Basic Settings Page
Use the Basic Settings page to specify the the basic properties for the voltage
input I/O point you create.

Figure: Voltage Input - Basic Settings page

Table: Voltage Input - Basic Settings Page

Technical
774

Component

Description

Input channel

Select the physical input channel on the I/O module. Selecting a
value of Null specifies that the input point is non-operational and can
be used as a placeholder. For more information, see section 21.1
“I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Digital filter

Select True (On) or False (Off) to filter out noise and prevent false
readings.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.

Top of scale
engineering
value

Type a value to enter the top of the range engineering value for the
input point.

Top of scale
electrical value

Type a value to enter the top of the range voltage (VDC), current
(mA), or resistance (kohm) value for the input point scale.
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Component

Description

Bottom of scale
engineering
value

Type a value for the bottom of the range engineering value for the
input point scale.

Bottom of scale
electrical value

Type a bottom of the range voltage, (VDC), current (mA), or
resistance (kohm) value for the input point scale.

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.

Offset

Type an offset value to be added to or subtracted from the
engineering value before it impacts the Value property.

Upper reliability
level

Type a value for the upper reliability level in electrical units. When the
electrical value is above the upper reliability level, the Reliability is
Value over range.

Lower reliability
level

Type a value for the lower reliability level in electrical units. When the
electrical value is below the lower reliability level, the Reliability is
Value under range.
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22.32

New I/O Module Wizard – Basic Settings
Page
Use the Basic Settings page to select a module ID for the I/O module you create.

Figure: Basic settings page

Table: Basic Settings Page
Component

Description

Module ID

Select Null or 1 to 32 for valid positions on
the I/O bus. Selecting a value of Null
specifies that the Module ID is nonoperational and can be used as a
placeholder to be configured when you wish
to assign it to a physical slot. You can place
multiple modules on the Null slot.
The Module ID is unique for logical modules.
For example, a UI8/DO-FC-4 module can
have a Digital Output point on output
channel 1 and a Temperature Input point on
input channel 1. The input and output are
different physical slots.

Override capability expected

Technical
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Check or uncheck this field depending upon
which modules you plan to connect. The
field indicates whether you would like the
module to be override capable. By default, it
is always checked.
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22.33

Current Output – Basic Settings Page
Use the Basic Settings page to specify the basic properties for the current output
I/O point you create.

Figure: Current Output - Basic Settings page

Table: Current Output - Basic Settings Page
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Component

Description

Output channel

Select the physical output channel on the I/O module. Selecting a
value of Null specifies that the output point is non-operational and
can be used as a placeholder. For more information, see section
21.1 “I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Requested value

Enter a value that you want to assign to the output. This property
drives the output to a specific value. When the Requested value is
set, the output turns on and off and remains in that state unless the
I/O module loses communication with the Automation Server. 255
seconds later the default output value is used instead of the
requested value.

Default output
value

Enter a default output value. The default output value is the value that
the output reverts to if the I/O module loses communication with the
Automation Server for 255 seconds.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.
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Component

Description

Top of scale
engineering
value

Type a top of the range engineering value for the output point.
Scaling applies a linear conversion to the value of the output points
on an I/O module. For more information, see section 21.22 “Scaling
an Input or Output I/O Point” on page 703.

Top of scale
electrical value

Type a top of the range voltage (VDC) or current (mA) value for the
output point scale.

Bottom of scale
engineering
value

Type a bottom of the range engineering value for the output point.

Bottom of scale
electrical value

Type a bottom of the range voltage (VDC) or current (mA) value for
the output point.

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.
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22.34

Voltage Output – Basic Settings Page
Use the Basic Settings page to specify the basic properties for the voltage output
I/O point you create.

Figure: Voltage Output - Basic Settings page

Table: Basic Settings Page- Voltage Output
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Component

Description

Output channel

Select the physical output channel on the I/O module. Selecting a
value of Null specifies that the output point is non-operational and
can be used as a placeholder. For more information, see section
21.1 “I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Requested value

Enter a value that you want to assign to the output. This property
drives the output to a specific value. When the Requested value is
set, the output turns on and off and remains in that state unless the
I/O module loses communication with the Automation Server. 255
seconds later the default output value is used instead of the
requested value.

Default output
value

Enter a default output value. The default output value is the value that
the output reverts to if the I/O module loses communication with the
Automation Server for 255 seconds.

Threshold

Type a value for minimum change of value before the I/O module
reports the value to the Automation Server. Properly setting the
threshold value reduces unnecessary communication between the
I/O module and the Automation Server. For more information, see
section 21.27 “Threshold Settings for I/O Points” on page 712.
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Component

Description

Top of scale
engineering
value

Type a top of the range engineering value for the output point.
Scaling applies a linear conversion to the value of the output points
on an I/O module. For more information, see section 21.22 “Scaling
an Input or Output I/O Point” on page 703.

Top of scale
electrical value

Type a top of the range voltage (VDC) or current (mA) value for the
output point scale.

Bottom of scale
engineering
value

Type a bottom of the range engineering value for the output point.

Bottom of scale
electrical value

Type a bottom of the range voltage (VDC) or current (mA) value for
the output point.

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.
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22.35

Digital Output – Basic Settings Page
Use the Basic Settings page to specify the basic properties for the digital output
I/O point you create.

Figure: Digital Output - Basic Settings page

Table: Digital Output - Basic Settings Page
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Component

Description

Output channel

Select the physical output channel on the I/O module. Selecting a
value of Null specifies that the output point is non-operational and
can be used as a placeholder. For more information, see section
21.1 “I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Requested value

Select either On or Off to set the Requested value. When the
Requested value is set, the output turns on or off and remains in that
state unless the I/O module loses communication with the
Automation Server. 255 seconds later the default output value is
used instead of the requested value.

Default output
value

Select either On or Off to set the Default output value. The Default
output value is the value that the output reverts to if the I/O module
loses communication with the Automation Server for 255 seconds.

Invert

Select either False (not inverted) or True (inverted).
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22.36

Digital Pulsed Output – Basic Settings
Page
Use the Basic Settings page to specify the basic properties for the digital pulsed
output I/O point you create.

Figure: Digital Pulsed Output - Basic Settings page

Table: Digital Pulsed Output - Basic Settings Page
Component

Description

Output channel

Select the physical output channel on the I/O module. Selecting a
value of Null specifies that the output point is non-operational and
can be used as a placeholder. For more information, see section
21.1 “I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Requested value

Enter a value that you want to assign to the output. This property
drives the output to a specific value. When the Requested value is
set, the output turns on and off and remains in that state unless the
I/O module loses communication with the Automation Server. 255
seconds later the default output value is used instead of the
requested value.
The value of a digital pulsed output is On or Off since the output is
either On or Off at a given point in time.

Default output
value

Technical
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Enter a default output value. The default output value is the value that
the output reverts to if the I/O module loses communication with the
Automation Server for 255 seconds.
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Component

Description

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.

Invert

Select either False (not inverted) or True (inverted).

Technical
783

22 I/O User Interface
22.37 Tristate Output – Basic Settings Page

22.37

Tristate Output – Basic Settings Page
Use the Basic Settings page to specify the basic properties for the tristate output
I/O point you create.

Figure: Tristate Output - Basic Settings page

Table: Tristate Output - Basic Settings Page
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Component

Description

Output channel

Select the physical output channel on the I/O module. Selecting a
value of Null specifies that the output point is non-operational and
can be used as a placeholder. For more information, see section
21.1 “I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Requested value

Select either On, Off, or -On to set the Requested value. When the
Requested value is set, the output turns on or off and remains in that
state unless the I/O module loses communication with the
Automation Server. 255 seconds later the default output value is
used instead of the requested value.

Default output
value

Select either On, Off, or -On to set the Default output value. The
Default output value is the value that the output reverts to if the I/O
module loses communication with the Automation Server for 255
seconds.
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22.38

Tristate Pulsed Output – Basic Settings
Page
Use the Basic Settings page to specify the basic properties for the tristate pulsed
output I/O point you create.

Figure: Tristate Pulsed Output - Basic Settings page

Table: Tristate Pulsed Output - Basic Settings Page
Component

Description

Output channel

Select the physical output channel on the I/O module. Selecting a
value of Null specifies that the output point is non-operational and
can be used as a placeholder. For more information, see section
21.1 “I/O Point Types” on page 663.

Label text

Type the text that is printed on an I/O module label. For more
information, see section 22.39 “Print I/O Module Labels Dialog Box”
on page 785.

Requested value

Enter a value that you want to assign to the output. This property
drives the output to a specific value. When the Requested value is
set, the output turns on and off and remains in that state unless the
I/O module loses communication with the Automation Server. 255
seconds later the default output value is used instead of the
requested value.
For Tristate pulsed outputs, the Requested value is a value in
seconds + or -.

Default output
value
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Enter a default output value. The default output value is the value that
the output reverts to if the I/O module loses communication with the
Automation Server for 255 seconds.
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Component

Description

Unit

Select the engineering unit in use, such as current, voltage, or
temperature.
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22.39

Print I/O Module Labels Dialog Box
Use the Print IO Module Labels dialog box to print labels to identify I/O channels
on the placard of the I/O module.

Figure: Print IO module labels dialog box

Table: Print IO Module Labels Dialog Box
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Component

Description

Blank Label Text

Select to print labels with only the channel
number with no additional label text.

Paper Type

Select the paper type for the label - letter or
A4.

Save

Saves any changes to the point's label text
property.

Print

Prints the I/O module label.

Exit

Exits the Print IO Module Labels dialog
box.
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22.40

Update I/O Module Firmware Dialog Box
Use the Update IO Module Firmware dialog box to update I/O module firmware.

Figure: Update IO module firmware dialog box

Table: Update IO Module Firmware Dialog Box
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Button

Description

Update Firmware

Click to update the firmware in the selected
I/O module or modules. For more
information, see section 20.8 “Updating I/O
Module Firmware” on page 625..

Save Results to File

Click to save the results of the update to a
text file.

Cancel Update

Click to cancel the I/O module firmware
update.

Exit

Click to exit the Update IO Module
Firmware dialog box.
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23 Graphics Introduction
23.1 Graphics Editor Overview

23.1

Graphics Editor Overview
You can use Graphics Editor to create and edit graphics representing a site and the
devices that make up the site.

Important
You have to have a valid Graphics Editor license to start the Graphics Editor. For
more information, see the Licenses topic on WebHelp.
In Graphics Editor you can create advanced graphics. Graphics Editor contains
tools to make geometrical figures, symbols, texts, flexible data conversions,
animations, dynamics and interactivity. You can transform, move, align, arrange,
and distribute graphics objects in a work area in several ways.
Often used functionality, standard symbols and components representing common
functions are available in libraries delivered with Graphics Editor. You can add to
these libraries.
You can open and import graphics or photographs into Graphics Editor, paste
graphics into other graphics, and export from Graphics Editor.
You can link figures, for example, illustrations, symbols, and text, to database
objects in the Building Operation database. When the system is running, the
graphic objects can be displayed in WorkStation and automatically updated as
values at the site change.
You can print the graphics on any printer supported by Microsoft Windows.
A graphic component is a predefined graphic that contains one or several other
parts. Components are meant for reuse and typically represent a feature or a device
in a live system. Components can be designed as symbols which can be used as
building blocks and reused in several graphics. Components reside in dedicated
libraries and are displayed in the Components pane. The analog watch is an
example of a component.
When you design components, it is recommended that you set Graphics Editor
Component mode to Graphics.
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Figure: Graphics Editor

When you create a new component, the default work area is 200x200 pixels (where
a pixel is the smallest possible drawing unit). A standard graphic work area is
600x800. This smaller work area is usually sufficient to draw a fairly detailed
component. When you use the component in the TGML graphic, however, the
component is automatically scaled to one fifth of the graphic size. This default size
of 40x40 pixels makes the component comparable in size to the ISO and DIN
standard components.
For more information, see section 34.5 “TGML File Format” on page 1022.
When you create a component, the root element, ComponentContent, is used
(instead of TGML for a graphic object). When the component is stored in a library
and used in a graphic, the ComponentContent element is replaced with the
Component element.
The root element of a component always includes at least two metadata elements
describing the component: Name and Description. These metadata elements
automatically get their values when you save the component.
The ComponentContent has the following properties:
• Opacity
• Visibility
• Height
• Width
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The height and width values are copied to the ComponentHeight and
ComponentWidth properties of the Component element when you store the
component. When you use the component in a TGML graphic, however, the height
and width values are scaled to 20%, as mentioned above.
Thus, the component has one size when you use it in a graphic and another size
(usually larger) when you create or edit the component.
Components are stored as separate files in subfolders of the Components folder.
Typically, you would save different categories of components in different subfolders.
The subfolder names are displayed as separate bars in the Components pane.

Figure: Example of component categories

You can create and import components in several ways:
• Create a new component in Component mode of Graphics Editor
• Group and save as a component in Graphic mode of Graphics Editor
• Import components from an external source
In WorkStation, you can create graphics that you edit in Graphics Editor. Graphics
consist of one or several graphic objects. You can set properties for the graphic
objects to define their appearance and behavior.
You can create the graphic objects by using the drawing tools, by copying objects
from the work area, or by using instances of objects from the libraries delivered with
Graphics Editor.
All drawn objects belong to one of the following two groups:
• Graphics, that is, free-form drawings
• Components, that is, standardized graphics for defined reuse
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23.1.1

Graphics
Graphics are representations of a site or parts of a site. Graphics can be made up
of figures, text and imported pictures. They can also contain components and
functions.
For more information, see section 23.3 “Graphics in WorkStation” on page 794.

23.1.2

Figures
A figure is the smallest independent element of a graphic, for example, a circle.
For more information, see section 33.1 “Figures” on page 967.

23.1.3

Components
Components are standardized, predefined graphics for defined use.
For more information, see section 24.1 “Components” on page 809.

23.1.4

Layers
When creating complex graphics, it can be a challenge to keep track of all the
graphic figures in the work area. Graphic figures get hidden under one another and
selecting becomes difficult. Layers provide a way to manage the graphic figures
that make up your graphic. Layers can be regarded as folders that contain graphic
figures.
For more information, see section 31.1 “Layers” on page 945.
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23.2

Graphics Editor Libraries
When Graphics Editor is installed, the following folders are normally used.

23.2.1

Folder for Brushes, Components and Snippets
At the installation of the graphics editor, or delivered as a separate package, a
number of symbols and other tgml components are stored in:
C:\Program Data\Schneider Electric StruxureWare\Building Operation [X.X version
number]\Graphics Editor
Frequently used objects, animations, and behaviors are collected in the following
subfolders.
Folder

Usage

\Brushes

The Colors and Gradients palettes are
stored here.

\Components

Standard symbols with specific meaning, as
well as some other common symbols, are
stored as components in the Components
library, available in one of the window panes.
A component can be dragged and dropped
directly into the Design pane. New
components can be added to the library.

\Snippets

A snippet is a piece of TGML code whose
purpose is to store a “behavior” for reuse. A
number of common behaviors are stored in
the Snippets pane.
A snippet can be dragged and dropped on
an object in the Objects pane.
Objects can be copied and modified, even
created, and then saved as new snippets in
the library.

All subfolders in the Components library are displayed as clickable bars in the
Components pane. All *.tgmlcomponent files in such a subfolder are displayed as
selectable components under the corresponding bar.
Similarly, all subfolders in the Snippets library are displayed as clickable bars in the
Snippets pane. All *.tgmlsnippet files in such a subfolder are displayed as selectable
snippets under the corresponding bar.
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23.3

Graphics in WorkStation
Graphics are representations of a site or parts of a site. Graphics can be made up
of figures, text and imported pictures. They can also contain components and
functions.
In WorkStation, graphics are represented by a graphics icon.

Figure: Graphics in WorkStation

You can view graphics in the graphics viewer.
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Figure: Graphics viewer in WorkStation
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23.4

Creating a Graphic
You create a graphic object in WorkStation to make a container for the graphic that
you create in Graphics Editor.
For more information, see section 23.3 “Graphics in WorkStation” on page 794.

To create a graphic
1. In WorkStation, in the System Tree pane, select the folder or server where
you want to create the graphic.
2. On the File menu, point to New and then click Graphic.
3. In the Name box, type a name for the graphic.

4. In the Description box, type a description for the graphic.
5. Click Next.
Continued on next page
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6. In the File box, enter a .tgml file if the graphic has already been created using
Graphics Editor.

7. Click Create.
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23.5

Adjusting the Graphic Work Area
You adjust the graphic work area when you initially edit the graphic in order to
ensure the work area settings, such as graphic size and background color, are
appropriately defined for display in WorkStation.
For more information, see section 24.1 “Components” on page 809.

To adjust the graphic work area
1. In WorkStation, in the System Tree pane, select the graphic you want to
edit.
2. On the Actions menu, click Edit.
3. In Graphics Editor, in the Objects pane, select the Tgml element.

4. In the Properties pane, in the Background box, select the background
color.

5. In the Stretch box, select the the behavior of the graphic when displayed in
WorkStation.
6. In the Height box, type the value for the height of the work area.
Continued on next page
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7. In the Width box, type the value for the width of the work area.

8. On the File menu, click Save.
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23.6

Saving a Graphic
When you have created a graphic you can save it to the database.

To save a graphic
1. In Graphics Editor, on the File menu, click Save.

Important
• You can only save a graphic in Preview mode.
• If you choose to save by using the Save As command the link to
the database is broken and you have to define the location
where you want to save the .Tgml graphics file in the file system.
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23.7

Drawing Tools
Use the Graphics Editor drawing tools to add lines, polylines, curves, polygons,
rectangles, ellipses, arcs, pies, texts, and textboxes to a graphic.

23.7.1

Lines
Use the Graphics Editor Line tool to draw a straight line, that is, a line between two
points.
For more information, see section 33.2 “Lines” on page 969.

23.7.2

Polylines
Use the Graphics Editor Polyline tool to draw a line with several nodes, that is, a
line with angles.
For more information, see section 33.9 “Polygons” on page 976.

23.7.3

Curves
Use the Graphics Editor Curve tool to draw a curve, that is, a line that is not
straight.
For more information, see section 33.6 “Curves” on page 973.

23.7.4

Polygons
Use the Graphics Editor Polygon tool to draw a polygon, that is, a plane figure that
is bounded by a closed path, composed of a finite sequence of straight line
segments.
For more information, see section 33.9 “Polygons” on page 976.

23.7.5

Rectangle
Use the Graphics Editor Rectangle tool to draw a simple rectangle, that is, a
quadrilateral with four right angles.
For more information, see section 33.11 “Rectangles” on page 979.

23.7.6

Ellipses
Use the Graphics Editor Ellipse tool to draw an ellipse, that is, a plane curve that
results from the intersection of a cone by a plane in a way that produces a closed
curve.
For more information, see section 33.14 “Ellipses” on page 982.
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23.7.7

Arcs
Use the Graphcis Editor Arc tool to draw an arc, that is, a part of the periphery of
an ellipse, or a circle.
For more information, see section 33.18 “Arcs” on page 987.

23.7.8

Pies
Use the Graphics Editor Pie tool to draw a pie, that is, an area enclosed by two
radii of a circle and their intercepted arc.
For more information, see section 33.19 “Pies” on page 988.

23.7.9

Texts and Textboxes
Use the Graphics Editor Text tool to write a single line of text with no wrapping.
Use the Graphics Editor Textbox tool to write one or several lines of text that are
wrapped within the specified box.
For more information, see section 33.22 “Texts and Textboxes” on page 991.

23.7.10

Pictures
Use the Graphics Editor Insert Pictures tool to insert supported image files into
your graphic.
For more information, see section 33.30 “Pictures” on page 1001.
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23.8

Keyboard Shortcuts for Graphics Editor
You can acces most of the Graphics Editor commands by using keyboard
shortcuts.
Table: Graphics Editor Keyboard Shortcuts
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Press

To

CTRL+N

Start a new graphic

CTRL+O

Open an existing graphic

CTRL+S

Save the current graphic

CTRL+SHIFT+S

Save the current graphic in a specified
location and with a specified file name

CTRL+SHIFT+P

Preview a print

CTRL+P

Print graphic

CTRL+F4

Close the current graphic

ALT+F4

Close the current graphic and exit the
program

CTRL+Z

Undo the latest change

CTRL+Y

Revert the latest Undo command

F6

Set Design mode

F7

Set Source mode

F8

Set Preview mode

F11

Toggle between hiding and showing all
panes

F12

Toggle between hiding and showing the
Objects and Properties panes

F1

Access Help

F2

Rename

F5

Refresh

CTRL+SHIFT+F6

Go to a previous graphic

CTRL+F6

Go to a later graphic

CTRL+0

Zoom

CTRL+1

Select

CTRL+2

Use the Line tool
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Press

To

CTRL+3

Use the Polyline tool

CTRL+4

Use the Curve tool

CTRL+5

Use the Polygon tool

CTRL+6

Use the Rectangle tool

CTRL+7

Use the Ellipse tool

CTRL+8

Use the Arc tool

CTRL+9

Use the Pie tool

CTRL+T

Use the Text tool

CTRL+SHIFT+T

Use the Textbox tool

CTRL+X

Cut

CTRL+C

Copy

CTRL+V

Paste

DEL

Delete

CTRL+F

Find

CTRL+H

Find and replace

CTRL+A

Select all

CTRL+D

Clear all

CTRL+SHIFT+Space

Toggle to show or hide the grid

CTRL+Space

Toggle to snap or unsnap to the grid

CTRL+G

Group figures

CTRL+SHIFT+G

Ungroup figures

CTRL+Mouse wheel up

Zoom in

CTRL+Mouse wheel down

Zoom out

+ (on numeric keyboard)

Zoom in

– (on numeric keyboard)

Zoom out

CTRL+* (on num. keyboard)

Restore to original size

Arrow keys

Move the selected figure to next grid point if
Snap to Grid is activated

ALT+ Arrow keys

Move the selected figure one pixel
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23.9

Testing
You can test the behavior of graphics and components offline in Preview mode by
setting test values in the Test pane.
Any graphic or component with an associated name and a Bind object, is displayed
in the Test pane.
You enter test values in the Value column, and set an optional Unit.
You can also test the behavior for certain signal status values. The Status column
contains a drop-down menu where you can select four kinds of status:
• Error
• Database value
• Value from devide
• Forced value
By default, Error status is handled by the graphic (the figure is crossed over in red).
Other status types can be modified by user-written Java scripts.

Figure: An example on testing values in Preview mode
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23.10

Testing a Graphic in Preview Mode
You test the animation, snippets, and other parts of a graphic to ensure it works the
way it is intended to.
For more information, see section 23.9 “Testing” on page 805.

To test a graphic in Preview mode
1. In Graphics Editor, on the menu bar, click Preview to open the graphic in
preview mode.
2. On the menu bar, click View and then click Test.
3. In the Test pane, in the Value column, type the value for the drawing object
for which you want to test the behavior.

4. In the Status column select Forced value.
5. In the work area, check the behavior.
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24 Components and Snippets
24.1 Components

24.1

Components
Components are standardized, predefined graphics for defined use.
All drawn objects are either graphics, that is, free-form drawings or components. A
component contains one or several graphic figures. It can also have predefined
functionality. Components typically represent a feature or a component in a live
system. Components can be designed as symbols, which can be used as building
blocks in graphics. Components are located in dedicated libraries and are displayed
in the Components pane. An analog gauge is an example of a component.

24.1.1

Component Design
You create a component to make, for example, a symbol or a well-defined function
available for future reuse.
For more information, see section 24.2 “Component Design” on page 811.

24.1.2

Categories
Standard components and functions are categorized in logical groups.
For more information, see section 26.1 “Categories” on page 839.

24.1.3

Snippets
Snippets are standardized, predefined functions for defined use.
For more information, see section 24.11 “Snippets” on page 828.

24.1.4

Properties
Each element in the Objects pane has a number of properties. The Graphics Editor
object properties are referred to as attributes, in compliance with XML standards.
The attributes are displayed in the Properties pane, where they can be edited.
Attributes are used to give a complete description of a graphic object. Most of the
attributes are automatically defined when the graphic object is created. By
changing the attributes, you can change, for example, the appearance and
behavior of a graphic object.
For more information, see section 27.1 “Attributes” on page 851.

24.1.5

Binds and Links
A dynamic graphic object can be bound to, and thus controlled by, server variables
(signals). When the signal changes the behavior or appearance of the object
changes dynamically.
For more information, see section 28.1 “Binds and Links” on page 871.
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24.1 Components

24.1.6

Editing Tools
You can edit all graphic objects, that is, modify their properties. For example,
shape, size, and color.
For more information, see section 30.2 “Graphics Editing Tools” on page 896.
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24.2

Component Design
You create a component to make, for example, a symbol or a well-defined function
available for future reuse.

24.2.1

The Design Process
You can create a component in two ways:
• Compose your graphics and group the elements as a Component. You then
save the component in a category in the Components pane, or
• Open the component editor, draw your component and save it in a
components category.

Note
• When a component is edited in the components editor, the root element is
called ComponentContent. The element has two metadata elements that
contain the name of the component and the description. These elements are
not present when the component is used in a graphic.

24.2.2

Component Documentation and Saving
To make a component easy to understand and use, you add a description including
all or parts of the following:
• A descriptive name
• A short, comprehensive description of the function
• Notes on the usage
• Exposed properties
• Links or Bindings, if any
You type the information in the Properties dialog box when saving the component.
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24.2 Component Design

Figure: Component properties

You can edit the name and description of a component in the Component library by
editing the properties of the component.

Tip
To get a new line in the description, press CTRL+ENTER. Pressing ENTER alone
has the same effect as clicking OK.
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24.3

Documenting and Saving a Component
You enter a description to document a component.

Note
• To make your components useful to others, you can document and save
them in a standardized way.
For more information, see section 24.2 “Component Design” on page 811.

To document and save a component
1. In Graphics Editor, on the File menu, point to Save As and then click
Component.

2. Select the category in which you want to save the component.
3. Click OK.
4. In the Name box, type the name of the component.
Continued on next page
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24.3 Documenting and Saving a Component

5. In the Description box, type a description using this structure:
Short description of the function.
Special notes, if any
==Bindings==, or ==Links==
Name of Binding/Link: Explanation of signal
==Exposed Properties==
Name of Property: Explanation of property

6. Click OK.
The component is now saved in the selected category and can be used in other
graphics.
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24.4

Inhibiting Clipping
You inhibit clipping to prevent borders of a component from partly disappearing
when the component is used in a larger graphic.
For more information, see section 24.2 “Component Design” on page 811.

To inhibit clipping
1. In Graphics Editor, in the Objects pane, select ComponentContent.
2. In the Properties pane, right-click in any input field, and then click Add.
3. In the Add a Custom Attribute dialog box, in the Attribute box, type 'Clip.
In the Value box, type 'False'.

4. Click OK.
In the Properties pane, the Content attribute has been added and its Clip
property is set to False.
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24.5

Controlling the Appearance of the
Component
You use the Bind object to control the appearance of a component.

Note
• You only bind an exposed property.
• You can also use the Control element to control the appearance of a
component.
For more information, see section 27.6 “Exposed Properties” on page 863.

To control the appearance of a component
1. In Graphics Editor, in the Objects pane, right-click the element you want the
Bind element to control, point to New, and then click Bind.

Continued on next page
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2. In the Objects pane, right-click the bind element, point to New, and then
click the required number of Convert elements.

3. In the Properties pane, set the behavior for the Convert element.
4. On the View menu, click Test to open the Test pane.
Continued on next page
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24.5 Controlling the Appearance of the Component

5. Click Preview.

6. In the Test pane, test the behavior by entering test values.
By using Inherit, Expose and Bind, you can design a standardized component
whose appearance is easily controlled by an external signal.
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24.6

Grouping Drawing Objects as a
Component
You group multiple drawing objects within a graphic as a component for bind
naming and graphics design efficiency. In order to save your work to a components
library for reuse, the drawing elements must be grouped as a component.

To group drawing objects as a component
1. In Graphics Editor, in the Layers pane, select the layer that contains the
drawing objects you want to group.
2. On the work area, select all drawing objects that you want to group as a
component.
3. Right-click the selected objects, point to Group as, and then click
Component.
4. On the File menu, click Save.
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24.7

Adding a Component
You add components to the graphic instead of drawing all the drawing objects
yourself to simplify the graphics creation process.
For more information, see section 24.1 “Components” on page 809.

To add a component
1. In Graphics Editor, in the Layers pane, select the layer where you want to add
the component.
2. In the Components pane, click the component category tab that contains
the component you want to use.
3. Select the component you want to add.

4. Drag the component to the work area.
5. In the Properties pane, in the Name box, type the name of the component.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
Continued on next page
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6. On the Options toolbar or in the Properties pane, adjust the appearance of
the component.
7. On the File menu, click Save.
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24.8

Creating a New Component
You create a new component when you want to create a design that represents a
feature or a component in a live system and want this design to be available for
reuse. The component can be, for example, a button or a representation of a fan.
For more information, see section 24.1 “Components” on page 809.

To create a new component
1. In Graphics Editor, on the File menu, point to New, and then click
Component.
2. In the work area, design the appearance of the component.
3. On the File menu, point to Save As and then click Component.
4. In the Components tree, select the category where you want to save the
component.

5. Click OK.
6. In the Name box, type the name of the component.
7. In the Description box, type a description for the component. The
description is displayed as a ToolTip for the component in the Components
pane.
Continued on next page
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8. In the Height and Width boxes, enter the size the component gets when
used in a drawing.

9. Click OK.

Note
• When you create a new component, a work area opens and a
ComponentContent root element appears in the Objects pane.
The name you give the component is also the file name the component gets when
saved (with the suffix .tgmlcomponent). The new component is now displayed in the
selected category in the Components pane, and is ready to use in other graphics.
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24.9

Editing a Component
You edit a component when you have an original component and want to reuse a
number of its properties. You then save the edited version under a different name or
in a different category.
For more information, see section 24.2 “Component Design” on page 811.

To edit a component
1. In Graphics Editor, in the Components pane, select the category containing
the component you want to edit.
2. Right-click the component and click Edit.

3. In the Components work area, edit the component.
4. On the File menu, point to Save As and click Component.
Continued on next page
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5. Select the category where you want to save the edited component.

6. Click OK.
7. In the Name box, type the name of the component.
8. In the Description box, type a description to make the component easier to
identify.
9. In the Height and Width boxes, specify the size of the component.

10. Click OK.
The edited component is saved in the selected category and under the specified
name.
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24.10

Saving as a Component
You save your components in the Components library so that they are available for
future use.
For more information, see section 24.1 “Components” on page 809.

To save as a component
1. In Graphics Editor, on the work area, select the component you want to save
to highlight it in the Objects pane.

2. From the Objects pane, drag the component to the components category
that you want to add the component to.

Important
You have to drag the component from the Objects pane. You can
not drag the component from the work area.
3. In the Properties dialog box, in the Name box, type the name you want to
display in the components category.

4. In the Description box, type the description you want to display as the
tooltip in the components category.
Continued on next page
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24.10 Saving as a Component

5. In the Height box, type the height you want the component to have when it is
added to the work area.
6. In the Width box, type the width you want the component to have when it is
added to the work area.
7. Select Use default scale (0x0) to give the component the default size when
it is added to the work area.

8. Click OK.
The component is now saved in the Components library for use in the current
graphic and future graphics.
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24.11

Snippets
Snippets are standardized, predefined functions for defined use.
Snippets typically represents a feature in a live system. Snippets are located in
dedicated libraries and are displayed in the Snippets pane. Blink, which starts and
stops a blink animation, is an example of a snippet.
By default, Graphics Editor uses two dedicated folders, containing subfolders, for
Components and Snippets. The folders are installed with the software. If your
computer runs on Windows 7 or Windows 8.1 the components and snippets
folders have the following paths:
C:\Users\[User name]\Documents\StruxureWare\Graphics Editor\Components or
Snippets\
The subfolders are displayed as categories in the Components and Snippets
panes.
Libraries can be located anywhere on the local disk.
You can show and hide categories from a selected library. You can add categories.
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24.12

Adding a Snippet
You add snippets to a graphic to add pre-programmed behaviors, such as colors
changing according to the state of a point or numerically displayed values.

To add a Snippet
1. In Graphics Editor, in the Layers pane, select the layer where you want to add
the snippet.
2. In the Snippet pane, select the snippet category tab that contains the snippet
you want to use.
3. Select the snippet you want to add to the graphic.

4. Drag the snippet to the work area or to a drawing object.
5. On the Drawing toolbar, click Select.
6. On the Options toolbar or in the Properties pane, adjust the appearance of
the snippet.
7. On the File menu, click Save.
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24.13

Saving as a Snippet
You save your bind objects as snippets in the Snippets library so that they are
available for future use.

To save as a snippet
1. In Graphics Editor, in the Objects Pane, select the Bind object that you want
to save to the Snippets library.

2. Drag the Bind object to the snippet category that you want to add the snippet
to.
3. In the Properties dialog box, in the Name box, type the name you want to
display in the snippets category.

4. In the Description box, type the description that you want to display as the
ToolTip in the Snippets category.
5. Click Ok.
The snippet is now saved in the Snippets library for use in the current graphic and
future graphics.
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Topics
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25 Printing and Testing
25.1 Printing Graphics

25.1

Printing Graphics
You print a graphic, for example, to present it to a customer or to get an overview.

To print graphics
1. In Graphics Editor, on the File menu, point to Print, and then click Print.
2. In the Print dialog box, select the printer you want to use and set other print
options.

3. Click Print.
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25.2

Setting Up a Page for Printing
You set up a page for printing to print a graphic in a specified way.

To set up a page for printing
1. In Graphics Editor, on the File menu, point to Print, and then click Page
settings.
2. In the Page Setup dialog box, enter paper size, orientation, margins and
other properties.

3. Click OK.

Note
• The print settings apply for all printouts until you change them.
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25.3

Previewing a Print
You preview a print to make sure the printed page will turn out the way you
intended.

To preview a print
1. In Graphics Editor, on the File menu, point to Print, and then click Print
preview.
2. In the Print preview dialog box, set the amount of pages you want the
graphic to print on.

3. Click Close when finished.
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26 Categories
26.1 Categories

26.1

Categories
Standard components and functions are categorized in logical groups.
The following groups are delivered with Graphics Editor:
• Basic Controls
Control and sensor devices and buttons of different kinds.
• DIN Symbols (EN)
English standard ISO symbols
• ISO Symbols
Standard ISO symbols
• My Components
An empty folder where you can save components you want to make available
for reuse.
• Basic Functions
Functions of different kinds.
• My Snippets
An empty folder where you can save functions you want to make available for
reuse.
For more information, see section 36.13 “Components Pane” on page 1165.

Note
• The categories listed above are read-only, and cannot be deleted.
The different categories are displayed as bars in the Components and Snippets
panes. You can hide unused categories.
You can display hidden categories, or categories that reside in other libraries, in the
Components pane.
You can store categories of components in other libraries. To make new libraries
accessible from the Components pane, you have to add them to the list of available
libraries.
When you import or export categories of components, or create new categories,
the default library is used. You can set any components library folder as the default
library.
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26.2 Creating a Category

26.2

Creating a Category
You create a category when you want to organize your components in the
Components pane or snippets in the Snippets pane.
For more information, see section 26.1 “Categories” on page 839.

To create a category
1. In the Components pane or in the Snippets pane, right-click and then click
New Category.
2. In the box, type a name for the category.

3. Click OK.
The new category is displayed as a tab in the Components pane or Snippets
pane.
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26.3

Selecting a Category
You select a components or snippets category to display its content in the Graphics
Editor, or before performing an operation on the category.
For more information, see section 26.1 “Categories” on page 839.

To select a category
1. In Graphics Editor, in the Components pane or in the Snippets pane, click
the tab of the category you want to select.

The content of the selected category is displayed in the pane.
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26.4 Renaming a Category

26.4

Renaming a Category
You rename a components or snippets category to better reflect the contents.
For more information, see section 26.1 “Categories” on page 839.

To rename a category
1. In the Components pane or Snippets pane, select the category you want to
rename.
2. Right-click an empty space in the selected category and then click Rename
Category.

3. In the box, type a new name for the category.
4. Click OK.
The selected category is displayed with its new name in the Components pane or
Snippets pane.
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26.5

Hiding a Category
Hide a components or snippets category when you do not want to display it in the
Components pane or Snippets pane.
For more information, see section 26.1 “Categories” on page 839.

To hide a category
1. In the Components pane or Snippets pane, click the X to the right on the
specific tab of the category you want to hide.

The selected category disappears from the Components pane or Snippets
pane.
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26.6

Displaying a Hidden Category
You display component or snippet categories that are hidden to make them
available in the component or snippet library for use in Graphics Editor.
For more information, see section 26.1 “Categories” on page 839.

To display a hidden category
1. In Graphics Editor, in the Components pane or Snippets pane, right-click
and then click Categories. in the Components pane, right-click and then
click Categories.
2. On the Components tab, select the category that you want to display.

3. Click Close.
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26.7

Importing a Components Category
You import a components category into the components library to be able to reuse
the components between different Building Operation projects.
For more information, see section 26.1 “Categories” on page 839.

To import a components category
1. In Graphics Editor, in the Components pane, right-click and then click
Import.
2. Select the .tgmlcomponentArchive file that contains the components you want
to import.
3. Click OK.
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26.8 Importing a Snippets Category

26.8

Importing a Snippets Category
You import a snippets category into the snippets library to be able to reuse the
snippets between different Building Operation projects.
For more information, see section 26.1 “Categories” on page 839.

To import a snippets category
1. In Graphics Editor, in the Snippets pane, right-click and then click Import.
2. Select the .tgmlsnippetArchive file that contains the snippets you want to
import.

3. Click OK.
The ímported snippets category is displayed as a tab in the Snippets pane.
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26.9

Exporting a Category
You export component or snippets categories to create a component archive file or
a snippet archive file, which in turn can be imported into the component or snippet
library of Graphics Editor on other computers.
For more information, see section 24.2 “Component Design” on page 811.

To export a category
1. In Graphics Editor, right-click anywhere in the Components pane or
Snippets pane and then click Export.
2. Browse to the location where you want to save the export file.
3. In the File name box, verify or type a new name for the export file.

4. Click Save.
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26.10

Deleting a Category
You delete a components or snippets category when you no longer need it.
For more information, see section 26.1 “Categories” on page 839.

To delete a category
1. In the Components pane or Snippets pane, select the category you want to
delete.
2. Right-click an empty space in the category and then click Delete Category.

3. Click OK.
The selected category is deleted from the database.
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27 Attributes
27.1 Attributes

27.1

Attributes
Each element in the Objects pane has a number of properties. The Graphics Editor
object properties are referred to as attributes, in compliance with XML standards.
The attributes are displayed in the Properties pane, where they can be edited.
Attributes are used to give a complete description of a graphic object. Most of the
attributes are automatically defined when the graphic object is created. By
changing the attributes, you can change, for example, the appearance and
behavior of a graphic object.
The Properties pane has two modes, where you can define which level of detail you
want displayed.
• Normal
• Detailed
Normal mode displays the most commonly edited attributes. Detailed mode
displays all attributes.
You can add attribute values, for example, Name. Some attributes describe a
dynamic behavior and the attributes become apparent only when the graphic is
used in a dynamic environment, for example, as an online graphic accessible in
WorkStation Graphics viewer.
For some of the attributes in the Properties pane, a label is displayed at the bottom
of the pane when you select the attribute.

Figure: Attribute label in the Properties pane

Often an information text, with information on how the specific attribute gets its
value, is displayed below the label:

(blank)
The value has been chosen when the object was created and applies to this object.

Default value
The value was set by default when the object was created and applies to this
object.
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27.1 Attributes

Inherited value
The object is a part of a parent object and has inherited its value from the parent.
This information can be useful when you create more complex objects, where
attribute inheritance is used. For more information, see section 27.3 “Inherited
Attributes” on page 854.
Different objects and items have different attributes, which are described with each
item, but some general rules apply.
There are different categories of graphic object attributes
• Generic attributes
• Appearance, Position and Size attributes
• Behavior, Boundary and Target attributes

27.1.1

Graphic Object Attributes
All graphic objects that you use in a graphic have attributes, that is properties, that
describe the object. For example, shape, position, appearance, and dynamic
behavior.
For more information, see section 27.2 “Graphic Object Attributes” on page 853.

27.1.2

Inherited Attributes
You can define inheritance to enable child objects to inherit attributes from a parent
or any other ancestor object. A parent object can be, for example, a Group object.
A child object can be, for example, a graphic object in a group.
For more information, see section 27.3 “Inherited Attributes” on page 854.

27.1.3

Exposed Properties
You can make certain attributes of a component accessible from outside the
component. For example, you can use the Fill attribute to let an external signal
change the color of a component. You add Expose as a separate element to an
object that has an attribute you want to make accessible in your component.
For more information, see section 27.6 “Exposed Properties” on page 863.
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27.2

Graphic Object Attributes
All graphic objects that you use in a graphic have attributes, that is properties, that
describe the object. For example, shape, position, appearance, and dynamic
behavior.
When you select a graphic object, all its object properties are displayed in the
Properties pane.
You can change most object properties from the options bar and the associated
menus. However, sometimes it is more convenient—or gives more precision—to
enter the property values directly in the Properties pane.

27.2.1

Generic Properties
All items have two generic properties.
Table: Generic Properties
Property

Type

Description

ID

String

The identity of the element.
Reserved for scripts and
other entities that need to
use unique element
identifiers to access specific
elements.

Name

String

The name of the element.
The primary use is to identify
exposed elements such as
Bind.

For Bind elements, the Name is displayed in the Binds and Links pane. From there
the Bind element cannot be connected to external signals. The actual binding is
performed from WorkStation.
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27.3

Inherited Attributes
You can define inheritance to enable child objects to inherit attributes from a parent
or any other ancestor object. A parent object can be, for example, a Group object.
A child object can be, for example, a graphic object in a group.
If you have defined an attribute for a Group object, for example, Fill color, the fill
color is applied on all the individual graphic objects in the group.
Inheritance only applies if you remove the corresponding attribute on the child
object. Conversely, if you keep the attribute on the child object it overrides the
attribute of the parent object.
You use the Properties pane to define inheritance. If an attribute is left undefined
both in the child object and all its parents, a default attribute is used.
If you want to determine the origin of an attribute, you can click the attribute in the
Properties pane and then check the text in the gray box beneath, see For more
information, see section 27.1 “Attributes” on page 851.
Create a rectangle and a circle (ellipse). Each gets the same Fill and Stroke attribute
values from the values in the Options toolbar.

Figure: Graphic objects that can be grouped

Group the objects.
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Figure: Grouped graphic objects

The group only has two Appearance attributes: Opacity and Visibility, and both get
default values.
To define inheritance of Fill and Stroke from the Group object to the two constituting
objects, two things have to be done:
• Create (or Add) the missing attributes in the Group object.
• Remove the Fill and Stroke attributes from the rectangle and ellipse.
Right-click the Group object in the Properties pane, select Add and enter the
attributes; first Fill and then Stroke, and some suitable values (these can be
changed later on).
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Figure: Attributes added to Group object

In the tree structure in the Objects pane, select the Rectangle, right-click the Fill
attribute and select Remove. The rectangle immediately inherits the Fill attribute
from the Group object.

Technical
858

04-16006-04-en, March 2015

27 Attributes
27.3 Inherited Attributes

Figure: The graphic figures own attribute is removed

Repeat the procedure for the ellipse.
Now, you can select the Group and change its Fill attribute. The Fill value of its two
objects is also changed.
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Figure: The graphic figure in the group inherits the Fill attribute from the Group object.

Tip
If you do not know the value (for example, a color code), you can leave the value
box blank. In this case, when you add the property, the value box in the
Properties pane indicates an invalid (empty) value. Use the drop-down menu to
select a valid value.
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27.4

Defining Inheritance
You define inheritance to enable property inheritance from an object containing
other objects, for example, to control a specific property of an entire group of
objects.

To define inheritance
1. In Graphics Editor, in the Objects pane, select the parent object from which
you want to use a property, for example, Group.
2. In the Properties pane, right-click anywhere and then click Add.
3. In the Add a Custom Attribute dialog box, type a name for the property
that you want child objects to inherit, for example, "Fill".

4. In the Objects pane, select the objects that are to inherit properties from the
container object to which they belong.
5. In the Properties pane, delete the property that you want the container
object to control.

6. Click Remove.

Important
• Make sure that the property that you add on the container object
has a corresponding property on the inheriting objects. For
example, Fill.
• Corresponding properties have to have identical names.
Continued on next page
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27.4 Defining Inheritance

Note
• You can override the inheritance from a container object by
keeping the property on an object that belongs to the container
object. This is useful when you want a group of objects in the
same container object to inherit a property, but have one or a
few objects in that container object, which should keep their
individual properties.
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27.5

Setting Up Inherited Properties
You set up inherited properties to make sure that a component gets the same
properties as lead or ancestor components.

Note
• If a property for a shadow object is removed, the object inherits the
corresponding property from its lead object.
For more information, see section 24.2 “Component Design” on page 811.

To set up inherited properties
1. In Graphics Editor, in the Objects pane, select ComponentContent.
2. In the Properties pane, right-click the property field, and then click Add.
3. In the Add a Custom Attribute dialog box, enter the name of the property
that is to be inherited and then enter its initial value.

Note
• If you do not know the value (for example, a color code), you can
leave the Value field blank. In this case, when you add the
property, the Value field in the Properties pane indicates an
invalid (empty) value. Use the drop-down menu to select a valid
value.
4. In the Objects pane, select the object whose property should be inherited.
Continued on next page
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27.5 Setting Up Inherited Properties

5. In the Properties pane, right-click the property or properties that are to be
inherited and then click Remove. The property does not disappear, but the
text at the bottom of the Properties pane, changes to Inherited value.

6. On the File menu, click Save.
Inherent objects get a uniform appearance.
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27.6

Exposed Properties
You can make certain attributes of a component accessible from outside the
component. For example, you can use the Fill attribute to let an external signal
change the color of a component. You add Expose as a separate element to an
object that has an attribute you want to make accessible in your component.
An exposed attribute is displayed among the attributes of its parent figure and all
ancestors all the way up to the root figure (Tgml) of a graphic, in the Exposed
Properties part of the Properties pane.
The Expose element has two attributes:
• Name
This is the name the exposed attribute gets
• ExposedAttribute
This refers to the attribute (attribute) that is exposed

Note
• When naming exposed attributes, note that if two or more exposed elements
have the same name this is considered to be intentional. It means that the
named element is displayed only once in the Exposed Properties part of the
Properties pane.
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27.7

Adding an Expose Element
Use exposed properties to make certain properties of a component accessible from
outside Graphics Editor.
For more information, see section 27.6 “Exposed Properties” on page 863.

To add an Expose object
1. In Graphics Editor, in the Properties pane, right-click the object with the
property you want to expose, point to New, and then click Expose.
2. In the Objects pane, in the component tree structure, select the new Expose
element and change the name from My___ to a more descriptive name.

3. In the Properties pane, click the ExposedAttribute box, and select the
property you want to expose from the drop-down list.
If you select the object containing the exposed property in the Objects pane, the
exposed property is displayed in the Properties pane
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27.8

Exposing a Property
Use exposed properties to make certain properties of a component accessible from
outside Graphics Editor.

Note
• If a property for a low-level object is removed, the object inherits the
corresponding property from its parent object.
For more information, see section 24.2 “Component Design” on page 811.

To expose a property
1. In Graphics Editor, in the Objects pane, select the component containing the
property you want to expose
2. In the Properties pane, right-click the property you want to expose and then
click Expose.

Note
An Exposed Properties element is added in the Properties pane.
3. In the Objects pane, select the new Expose element and change the name
from My___ to a more descriptive name.

Note
• You can expose several properties at a time.
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If you select the object containing the exposed property in the Objects pane, the
exposed property is displayed in the Properties pane.
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27.9

Modifying the Behavior of a Component
You expose the properties of a component to modify its behavior.
For more information, see section 27.6 “Exposed Properties” on page 863.

To modify the behavior of a component
1. In Graphics Editor, on the File menu, point to New and then click
Component.
2. In the Components pane, click the My Components category.
3. Select the required component, and drag it to the work area.

4. In the Properties pane, in the Name box, type the name of the modified
component.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
Continued on next page
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27.9 Modifying the Behavior of a Component

5. In the Properties pane, type values for the Exposed Properties object.

6. Select Preview.
7. In the Binds and Links pane, enter values to test the modified behavior.

Note
• The bindings name consists of the component name, a dot, and
the bind name 'Value'.
8. On the File menu, click Save to save the modified component.
By modifying exposed properties of a component, you can customize it when
reusing the component in different applications.
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28 Binds and Links
28.1 Binds and Links

28.1

Binds and Links
A dynamic graphic object can be bound to, and thus controlled by, server variables
(signals). When the signal changes the behavior or appearance of the object
changes dynamically.
Similarly, you can link a graphic object to other database objects or Server pages by
using a Link property to define a target.
Binds and links are created by using the Bind or Link elements of the graphic
object. Binds and links defined for a graphic, are displayed in the Binds and Links
pane. Although you have to do the physical binding and linking in WorkStation, the
Binds and Links pane gives you a useful overview.
When you select binds or links, the different panes highlight the selected elements
which makes them easy to locate. The binds and links remain selected even if you
toggle between panes.
You can test bindings in Graphics Editor in Preview mode, by manually entering test
values for the binding to test the effect of the rules for a binding. For more
information, see section 23.9 “Testing” on page 805.

28.1.1

Object Binding
A dynamic graphic object is an object whose appearance or behavior is controlled
by variables from the server. This is done by binding elements of the graphic object
to the variable.
A binding can simply reflect the variable value, for example, a symbol toggles
between green when a status signal is 0 and red when the signal is 1.

Figure: The desired dynamic behavior of a graphic object

A binding can also contain converters (rules) that declare how the appearance or
behavior of the graphic object should be affected if the variable value changes.
You can add bindings to, for example, lines, curves, and rectangles. You can also
add bindings to transformations of objects, for example, rotate, scale, or translate
elements.
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Bindings are made by adding a Bind element to the graphic object. The Bind
element has a Target attribute that is changed as the incoming value from the
Server changes.

Figure: Graphics object proerties bound to singals in the system

You select the Target attribute from the Attribute drop-down list, which only shows
the bindable properties of the parent object.
Examples:
When you add a Bind element to an arc, a certain number of arc attributes can be
bound.
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Figure: Arc attributes that can be bound

When you add a Bind element to a Rotate element, only the rotation angle and
center attributes can be bound.

Figure: Rotate attributes that can be bound

When you add a Bind element to an Animate element, only the animation attributes
can be bound.
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Figure: Animate attributes that can be bound

The remaining Bind property is Format. You can set it to None (deliver value as is) or
Presentation. If you select Presentation, the value is converted to and presented as
a text according to an enumeration table in WorkStation.

28.1.2

Object Linking
If you want to dynamically link a graphic object to, for example, other graphic
objects, trend log views, notes, and online plots in WorkStation, you add a Link
element to the graphic object.
Linking is done by using the Link element of the graphic object. You have to set the
Target property of the Link element to define the target that is to be displayed when
the user clicks the link in the graphic object. You do the physical linking to another
object from WorkStation.
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28.2

Adding a Link
You add links to a graphic to open Web sites, applications, or documents from
within WorkStation.
For more information, see section 28.1 “Binds and Links” on page 871.

To add a link
1. In Graphics Editor, click the Snippets tab.
2. Select the Basic Functions category.
3. Drag the Link snippet to the drawing object that will be linked to a Web site,
application, or document.
4. In the Objects pane, click the Link object.
5. In the Properties pane, in the LinkName box, type the name of the Link
object.

6. Click Save.
The link is now added to the graphic and is available for binding in WorkStation.
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28.3

Adding a Bind
You add a bind when you want to bind an attribute of a dynamic graphic object to,
and thus let it be controlled by, server variables (signals). When the signal changes
the behavior or appearance of the object changes dynamically.
For more information, see section 28.1 “Binds and Links” on page 871.

To add a bind
1. In Graphics Editor, in the Objects pane, right-click the object to which you
want to add the bind.
2. Point to New and then click Bind.

3. In the Properties pane, in the Attribute box, enter the object attribute you
want to be affected by the server signal.
Before you can bind the graphic object attribute to a signal in WorkStation you have
to add, for example, a value converter to the bind.
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28.4

Binding a Graphic to a Variable
You bind the graphic to variables to show variable values in the graphic either as
digital values or as dynamic components. You also bind a graphic to objects to
activate the links in the graphic.
For more information, see section 15.1 “Bindings Overview” on page 411.

To bind a graphic to a variable
1. In WorkStation, in the System Tree pane, select the graphic that you want to
bind a variable or an object to.
2. On the Action menu, click Edit bindings.
3. In the Browser pane, select the variable or object that you want bind to the
graphic.

Continued on next page
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28.4 Binding a Graphic to a Variable

4. Drag the variable or object to the box in the Binding column for the binding
point you want to bind.

5. On the File menu, click Save.
6. Click the Graphics view and verify that the bindings correspond to
dynamically changing values in the graphic or working links to objects.
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28.5

Dynamic Updates
A graphic can contain numerous bindings to values that you want to be able to
display in the graphic. When there are numerous bindings, reading the values can
be time-consuming and can slow down the performance of the graphic. By setting
the DynamicUpdates attributes in the Bind elements of the graphic to either
disabled or enabled, you can control which values that are updated. That is, which
values the graphic subscribes to when the graphic is opened. Disabling the updates
can improve the performance when loading the graphic. By default, the dynamic
updates are enabled, that is, the value connected to a Bind element in the graphic
is updated when the graphic is opened.
To control how and when the values of bindings that are not dynamically updated
are to be updated, you can add a script to the Script element of the Bind element.
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28.6

Activating a binding with a dynamic
update attribute
You edit the DynamicUpdate attribute to improve the performance when loading a
graphic. By default, the dynamic updates are enabled, that is, the value connected
to the Bind element of the graphic is updated when the graphic is opened.
For more information, see section 28.5 “Dynamic Updates” on page 879.

To activate a binding with a dynamic update attribute
1. In Graphics Editor, in the Objects pane, select the Bind element for which
you want to edit the DynamicUpdates attribute.
2. In the Properties pane, in the Behavior area, select the DynamicUpdates
attribute and select Enable or Disable depending on whether or not you
want the graphic to subscribe to the value connected to the Bind element
when the graphic is opened.
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29 Groups
29.1 Groups

29.1

Groups
A group is when two or more objects or components are joined together as one
entity. Groups can have nested groups, that is, groups within the group.
The purpose of grouping objects is to make it possible to perform an operation on
them all simultaneously. When you have selected a group, you can move, copy,
and zoom in on the objects of the group in one single command.
Once you have grouped objects, you cannot select individual objects within the
group from the work area. You can still select one or several objects of the group
from the Objects pane. The objects are then indicated as selected members of the
group.
This can be useful, for example, if you want to see on which objects a specific
element operates. The selected object is then indicated as a selected member of
the group in the work area as well.
When you select one or more individual objects of a group, the selected object or
objects are displayed with inverted text in the Objects pane, and are selected as
Group member in the work area.

Note
• A Group member selection is displayed in the work area as green dashed
rectangle(s), enclosing the object(s).

Figure: An individual member of a group has been selected. The group member selection
is indicated with a green rectangle in the work area

You can add objects that do not belong to the group to a selection by pressing
CTRL and clicking in the Objects pane.
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Figure: A single curve is added to the selection. The ellipse is still surrounded by the green
rectangle, but now the group, which is the primary selection, is surrounded by a blue
rectangle

The usage of selection indicators in the work area, when you have selected one or
several objects, can be summarized as follows.
• Primary selection is indicated with a dashed blue rectangle enclosing the object
(which can also be a group)
• Group member selection is indicated with a dashed green rectangle enclosing
the individual object
You have to select an object before editing it. There are several ways to select an
object. You can select objects individually or simultaneously by clicking them or by
drawing a marquee around them.
When you select two or more objects, one of them is regarded as the primary
selection. The primary selection is displayed surrounded with a blue, dashed
rectangle in the work area.
You can select two or more objects to align them. All the selected objects are
aligned with the “primary selection” object. For more information, see section 30.5
“Aligning Objects” on page 902.
Table: Summary of Selection Methods
Selection method

Primary Selection

Group Member Selection

Press CTRL and click in the
work area

Last selected object (group is N/A
also an object)

Selection box in the work
area

Of the selected objects: the
topmost (z-order) in the tree
(group is also an object)

N/A

Press CTRL and click nonFirst selected object (group is N/A
grouped objects or groups in also an object)
the Objects pane
Press CTRL and click
members of a group in the
Objects pane
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N/A

Each individually selected
object in the group
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Selection method

Primary Selection

Group Member Selection

Press CTRL and click child
elements of members of a
group in the Objects pane

N/A

Parent object

Press CTRL and click nongrouped objects and
members of a group in the
Objects pane (‘Mixed
selection’)

First selected (group is also
an object)

Each individually selected
object in the group
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29.2 Grouping Multiple Objects

29.2

Grouping Multiple Objects
You group objects to be able to perform an operation on them all simultaneously.

To group multiple objects
1. In Graphics Editor, in the work area, select the objects you want to include in
the group.

2. On the Options toobar, click Group.

The selected objects are now grouped and enclosed by the selection rectangle.
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29.3

Ungrouping Objects
You ungroup objects to be able to perform operations on them individually. Nested
groups are unfolded in the reverse order.

To ungroup objects
1. In Graphics Editor, in the work area, select the group you want to ungroup.

2. On the Options toolbar, click Ungroup.

The selected objects are now ungrouped. The selection rectangle still encloses all
the objects, but the objects also have separate selection indicators. All selections
are cleared when you click outside the objects.
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29.4 Selecting an Object

29.4

Selecting an Object
You can select a single object to perform an operation only on that object.
For more information, see section 29.1 “Groups” on page 883.

To select an object
1. In Graphics Editor, in the work area, click the border or fill of the object you
want to select.

Note
• When an object is selected in the work area, it is highlighted in the Objects
pane tree structure.The opposite also applies: when you click an object in the
Objects pane, the corresponding object is selected in the work area.
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29.5

Selecting Multiple Objects
You select multiple objects to perform an operation on them all simultaneously.
For more information, see section 29.1 “Groups” on page 883.

To select multiple objects
1. In Graphics Editor, on the Drawing toolbar, click Select.
2. Press CTRL while clicking the border or fill of all the objects you want to
include in the selection.

The last selected object is the primary selection.

Note
• You can add or remove objects by pressing CTRL while clicking the objects.
Clicking the same object toggles between select and clear.
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29.6 Selecting All Objects

29.6

Selecting All Objects
You select all objects to perform an operation on them all simultaneously. This
command selects all objects including invisible objects.
For more information, see section 29.1 “Groups” on page 883.

To select all objects
1. In Graphics Editor, click anywhere in the work area and press CTRL+A.

The last selected object is the primary selection.
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29.7

Clearing the Selection of Multiple
Objects
You clear the selection of objects when you have completed an operation on them.
For more information, see section 29.1 “Groups” on page 883.

To clear the selection of multiple objects
1. In Graphics Editor, in the work area, press CTRL+D.

The selection of all objects in the drawing are cleared.
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29.8 Selecting a Group

29.8

Selecting a Group
You select an entire group of objects to perform an operation on the group and all
objects within the group simultaneously.
For more information, see section 29.1 “Groups” on page 883.

To select a group
1. In Graphics Editor, in the work area, click the border, or any filled part, of any
of the objects in the group.
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30 Editing Tools
30.1 Selecting an Object Within a Group

30.1

Selecting an Object Within a Group
You select individual members within a group to perform an operation only on the
selected objects.
For more information, see section 29.1 “Groups” on page 883.

To select an object within a group
1. In Graphics Editor, in the Objects pane, click the object you want to select
within the group.

The entire group as well as each individually selected object are selected in the
work area. Any operation you perform only affects the individually selected objects,
not the entire group.
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30.2

Graphics Editing Tools
You can edit all graphic objects, that is, modify their properties. For example,
shape, size, and color.
You can edit all graphic objects individually. You can also edit some graphic objects
simultaneously. You can edit the following properties of two or more graphic
objects simultaneously:
• Fill color
• Stroke color
• Stroke style
• Stroke width
• Flip
• Rotate
• Skew
For text boxes, you can also edit the following properties for several text boxes
simultaneously:
• Font
• Font size
• Font style
• Stroke width
• Horizontal text alignment in text box
• Vertical text alignment in text box
If you want a graphic object to be available for future use, you can save it as a
component in the My Components library.

30.2.1

Selection Within a Group
You cannot select individual objects within a group in the work area. However, in
the Objects pane you can select one or several objects within a group. The objects
are then indicated as selected members of the group.

Tip
To include additional elements in the selection, press CTRL while clicking the
additional elements in the Objects pane.
For more information, see section 29.1 “Groups” on page 883.

30.2.2

Object Organization
When organizing objects in a graphic there are many options. You can move, align,
arrange, and distribute objects in the work area. You can use the tools on the
toolbar or any of the features available from the panes.
For more information, see section 30.3 “Object Organization ” on page 898.
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30.2.3

Colors
You can apply color to most objects. Graphics Editor has a range of colors but you
can also customize colors and save for future use. Objects with both stroke and fill
can have different colors on stroke and fill.
For more information, see section 30.23 “Colors” on page 922.

30.2.4

Gradients
In addition to the Color palette, Fill and Stroke have a Gradient palette. Gradients
consist of smooth color transitions along a specified direction from one color to
another. There are two types of gradients: linear and radial.
For more information, see section 30.26 “Gradients” on page 925.

30.2.5

Animations
You can add animations to a graphic object to create an illusion of movement. You
can add animations to, for example, lines curves and rectangles. You can also add
animations to transformations of objects, for example rotate, scale, translate and
others. You can add the Animate property by adding it to the object you want to
animate in the Objects pane.
For more information, see section 30.32 “Animations” on page 937.

30.2.6

Paths
When you create a path of one or several objects, you create a copy in the form of a
path, where the original objects have been dissolved and replaced with
corresponding lines and fills. For example, a rectangle dissolves into a path of four
connected strokes.
For more information, see section 33.27 “Paths” on page 998.
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30.3

Object Organization
When organizing objects in a graphic there are many options. You can move, align,
arrange, and distribute objects in the work area. You can use the tools on the
toolbar or any of the features available from the panes.

30.3.1

Object Moving
You can move drawn objects individually, or collected in arbitrary groups.

30.3.2

Object Aligment
You can align two or more selected objects in seven different ways:
• Left
Horizontally along the left edge of the objects
• Center
Horizontally along the center of the objects
• Right
Horizontally along the right edge of the objects
• Top
Vertically along the top edge of the objects
• Middle
Vertically along the middle of the objects
• Bottom
Vertically along the bottom edge of the objects
• Center Middle
Horizontally along the center of the objects, and vertically along the top edge of
the objects

Note
• All alignments refer to the object considered to be the primary selection.
Which object is regarded as the primary selection depends on how the
objects are selected. For more information, see section 29.1 “Groups” on
page 883.

Tip
The Align drop-down menu options indicate how the objects can be positioned
relative to the primary selection.
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30.3.3

Object Arrangement
If an object more or less overlaps another object, you may want to arrange them.
You can move an object so that it appears behind or in front of other objects. You
can also move a graphic object to the very back or the very front of the stack.
You can arrange one or more selected objects in four different ways:
• Bring to Front
Bring the object(s) to the top position
• Bring Forward
Bring the object(s) one position up
• Bring Backward
Bring the object(s) one position down
• Bring to Back
Bring the object(s) to the bottom position

Note
• When you select more than one object, the selected objects keep their
internal order during the arrangement procedure.

Tip
The Arrange menu options list shows how the objects can be arranged.

30.3.4

Object Distribution
You can distribute three or more selected objects in two directions:
• Horizontal
Evenly distributed between the leftmost and the rightmost of the selected
objects
• Vertical
Evenly distributed between the selected top object and bottom object

Tip
The Distribute menu options list how the objects can be distributed.

30.3.5

Object Rotation
You can rotate objects in different ways, by using the rotation tool or the two
rotation commands. Rotating multiple objects is somewhat different from rotating a
single object. When you rotate multiple objects they are rotated as if they were
grouped. That is, with an common center point around which the objects are
rotated.
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Tip
• You can rotate an object by using the Rotate Selection tool on the Options
toolbar and drag the rotation handle.
• You can drag out the angle handle to increase the angle precision. This does
not affect the rotation in other ways.
• The aspect ratio is automatically used when rotated objects are resized.
• When you use the Rotate Selection tool, you can also change the center of
rotation by clicking it and moving the entire rotation handle. Before changing
the center of rotation, consider that the effect of future rotations can be
difficult to anticipate.
• If you move the center point of an object that has already been rotated, an
additional rotation is added to the object and the moved center point applies
to the new rotation that was added.

30.3.6

Object Skewing
Skewing an object means that you distort the shape in a horizontal or vertical
direction by a number of degrees. You skew by selecting one or several objects and
then applying a value from the horizontal or vertical skewing menu.

30.3.7

Object Flipping
Flipping an object means that you replace the object with a reflection of the original
object on a horizontal or vertical axis.

30.3.8

Object Resizing
You can resize graphics objects, components and groups in the work area.
There are two resizing methods:
• General resizing
Whatever is enclosed by a selection rectangle is resized
• Resizing to same value
The selected graphics object, component, or group is resized to the same size
as another grahics object, component or group. The size can be compared in
three different ways:
– Same width
Resize the width of the graphics object, component, or group to the width
of another graphics object, component, or group.
– Same height
Resize the height of the graphics object, component, or group to the
height of another graphics object, component, or group.
– Same width and height
This action resizes the width and height of the graphics object,
component, or group to the width and height of another graphics object,
component, or group.
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30.4

Moving Objects
You move objects to place them at a new position in a design.

To move objects
1. In Graphics Editor, in the work area, select the object you want to move.

2. Drag the object to its new position.

Note
• You can move multiple objects by selecting them all.
• You can also move the selected object(s) by using the arrow
keys.
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30.5

Aligning Objects
You align two or more objects to position them evenly.
For more information, see section 30.3 “Object Organization ” on page 898.

To align objects
1. In Graphics Editor, in the work area, select the objects you want to align.

Note
• Make sure the object that controls the alignment is the primary
selection. The primary selection is enclosed within a blue,
dashed rectangle.
2. On the Options toolbar, click the Align button
alignment from the drop-down menu.
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30.6

Arranging Objects
You arrange objects that more or less overlap each other to put certain objects in
front of or behind other objects.
For more information, see section 30.3 “Object Organization ” on page 898.

To arrange objects
1. In Graphics Editor, in the work area, select the object you want to move
backward or forward.

2. On the Options toolbar, click the Arrange button
required option.
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30.7

Distributing Objects
You distribute three or more objects to position them evenly in a design, based on
the center points of the objects.
For more information, see section 30.3 “Object Organization ” on page 898.

To distribute objects
1. In Graphics Editor, in the work area, select the objects you want to distribute.

2. On the Options toolbar, click the Distribute button
Horizontal or Vertical distribution.

and then click

Note
• When the objects are distributed, the objects’ center points, that
is, the vertical or horizontal middle, are used. The result becomes
most apparent when objects of different sizes are distributed.
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30.8

Arranging a Table-like Layout
You position objects in a table-like layout to get evenly spaced rows and columns.
For more information, see section 30.3 “Object Organization ” on page 898.

To arrange a table-like layout
1. In Graphics Editor, in the work area, select the objects for the top row, in order
from left to right.

2. On the Options toolbar, click Align
and then click Top. The selected
objects align to the same horizontal height.

3. Select the objects that belong to the leftmost column, in order from top to
bottom.

Continued on next page
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4. On the Options toolbar, click the Align button and then click Left. The
selected objects align to the same left, vertical line.

5. Depending on the pattern and row/column distance you want, group the
objects, row-by-row or column-by-column.
6. Position the top/bottom rows, or the leftmost/rightmost columns.
7. Select all groups, comprising either rows or columns.

Continued on next page
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8. On the Options toolbar, click Distribute
and then click Vertical if the
rows have been grouped, and Horizontal if the columns have been grouped.

The rows, or columns are distributed evenly between the outermost rows/columns.
If necessary, you continue to do adjustments by using the Align and Distribute
commands on individual objects or groups.
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30.9

Duplicating an Object to the Same
Position
You copy any object or component to the same position as the original by working
with the original object from Objects pane tree structure.

To duplicate an object to the same position
1. In Graphics Editor, in the Objects pane, select the object.
2. Press CTRL and drag the object to a new position in the tree structure.

A copy of the object is created directly on top of the original object in the drawing.
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30.10

Duplicating an Object with a Controlled
Offset
You make equidistant copies of an object or component to get a certain conformity
in a design. You specify the position of the first copy and use a special copy
command to distribute the remaining copies as ‘extensions’ of the first copy
operation.

To duplicate an object with a controlled offset
1. In Graphics Editor, in the Objects pane, select the object you want to copy.
2. On the Drawing toolbar, click Copy.
3. Press CTRL+V to paste a copy.

4. Press CTRL+SHFT and move the copy to its correct position, relative to the
original.
5. Press CTRL+SHFT+V to paste another copy at the same distance relative to
the previous copy.
6. Repeat for as many copies as you need.

A number of copies are created and they are all placed with the same offset from
the previous object.
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30.11

Resizing an Object
You resize an object to modify the size of the object.
For more information, see section 30.3 “Object Organization ” on page 898.

To resize an object
1. In Graphics Editor, in the work area, select the object you want to resize.
2. Click the border of the selection rectangle and drag until the object has the
size you want.

Note
• Pulling the “handles” at any of the corners of the rectangle
affects the scaling both horizontally and vertically.
• Pressing SHIFT while resizing makes the scaling proportional,
that is, resizes the object horizontally and vertically.
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30.12

Resizing an Object to the Same Size
You resize an object to the same value to transform the object to the same size as
another object.
For more information, see section 30.3 “Object Organization ” on page 898.

To resize an object to the same size
1. In Graphics Editor, in the work area, select the object you want to resize.
2. Press CTRL while selecting the object you want to use as a size template.

Note
• The last selected object is used as a size template. The size
template is enclosed in a blue rectangle.
3. On the Options toolbar, click Resize
and then click the resize option you
want: Same width, Same height, or Same width and height.
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30.13

Rotating a Single Object
You rotate an object to change its orientation. The rotate command performs a 90°
rotation when the command is executed.
For more information, see section 30.3 “Object Organization ” on page 898.

To rotate a single object
1. In Graphics Editor, in the work area, select the object you want to rotate.
2. On the Options toolbar, click Rotate Left
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or Rotate Right

.

04-16006-04-en, March 2015

30 Editing Tools
30.14 Rotating Multiple Objects

30.14

Rotating Multiple Objects
You rotate multiple objects to change their orientation simultaneously. The rotate
commands performs a 90° rotation each time the command is executed.
For more information, see section 30.3 “Object Organization ” on page 898.

To rotate multiple objects
1. In Graphics Editor, in the work area, select the objects you want to rotate.
2. On the Options toolbar, click Rotate Left
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30.15

Skewing Horizontally
You skew horizontally to transform an object along the x-axis. The skew angle is
measured in degrees from the y-axis.
For more information, see section 30.3 “Object Organization ” on page 898.

To skew horizontally
1. In Graphics Editor, in the work area, select the object you want to skew.
2. On the Options toolbar, click Skew Horizontal
selection menu.

to open the degree

3. Click the required amount of degrees, –60° to +60°.

Note
• A positive value implies counter-clockwise skew.
• A negative value implies clockwise skew.
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30.16

Skewing Vertically
You skew vertically to transform an object along the y-axis. The skew angle is
measured in degrees from the y-axis.
For more information, see section 30.3 “Object Organization ” on page 898.

To skew vertically
1. In Graphics Editor, in the work area, select the object you want to skew.
2. On the Options toolbar, click the Skew Vertical
degree selection menu.

button to open the

3. Click the required amount of degrees, –60° to +60°.

Note
• A positive value implies counter-clockwise skew.
• A negative value implies clockwise skew.
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30.17

Flipping an Object
You flip one or more objects to reflect them in a horizontal or vertical direction.
For more information, see section 30.3 “Object Organization ” on page 898.

To flip an object
1. In Graphics Editor, in the work area, select the object you want to flip.
2. On the Options toolbar, click Flip

to open the flip axis menu.

3. Click Horizontal
to reflect in a horizontal direction and Vertical
reflect in a vertical direction.
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30.18

Copying an Object
You copy an object in the work area to reuse it.

To copy an object
1. In Graphics Editor, in the work area, select the object you want to copy.
2. On the Drawing toolbar, click Copy.
3. On the Drawing toolbar, click Paste.

4. Move the copy to a new position.
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30.19

Editing a Point of an Object
You edit a point of an object to transform its appearance. You can edit the points of
lines, polylines, curves, polygons, arcs, pies, or paths.
For more information, see section 30.2 “Graphics Editing Tools” on page 896.

To edit a point of an object
1. In Graphics Editor, in the work area, select the object whose point you want to
edit.
2. Double-click the point you want to move.

3. Drag the selected point to a new position.

Note
• When small objects are edited at an extreme zoom level, it can
be difficult to select the points. This is due to unavoidable
rounding errors, but the problem can be avoided if you draw and
edit the object in a larger size and then down-scale it.
• You can also use Show Grid (1 px) and Snap to Grid when
you create and edit the object. Grid points are not numerically
rounded.
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30.20

Editing Object Properties
You edit object properties to change the object.
For more information, see section 33.1 “Figures” on page 967.

To edit object properties
1. In Graphics Editor, in the work area, select the object whose properties you
want to edit.
2. In the Properties pane, change, for example, the position properties of the
object.

3. In the work area, click anywhere outside the object you have edited to clear
the selection.
4. On the File menu, click Save.
You can edit a number of properties from the Properties pane.
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30.21

Editing Multiple Objects
You edit multiple objects to simultaneously modify, for example, their shape, size,
and appearance.
For more information, see section 30.2 “Graphics Editing Tools” on page 896.

To edit multiple objects
1. In Graphics Editor, in the work area, select the objects you want to edit.

2. On the Options toolbar, click any of the Fill, Stroke (border) color, Style, or
Width buttons and select appearance from the corresponding menu.
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30.22

Deleting an Object
You delete objects in the work area that you do not want in your design.

To delete an object
1. In Graphics Editor, in the work area, select the object you want to delete.

2. On the Drawing toolbar, click Delete.

The selected object is deleted but you can undo the command by clicking Undo on
the menu bar before you have edited any other objects.
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30.23

Colors
You can apply color to most objects. Graphics Editor has a range of colors but you
can also customize colors and save for future use. Objects with both stroke and fill
can have different colors on stroke and fill.
You can define color hue from the Gradient palette.
Table: Overview of Color, Style, and Gradient Applicability
Object

Stroke
Color

Stroke
Style

Stroke
Gradient

Fill Color

Fill
Gradient

Line

Yes

Yes

Yes

–

–

Shape

Yes

Yes

Yes

Yes

Yes

Text

Yes

–

Yes

Yesa

–

Textbox

Yes

–

Yes

Yesb

Yes

a) Background behind text (default area)
b) Background behind text (textbox area)

Technical
924

04-16006-04-en, March 2015

30 Editing Tools
30.24 Adding a Custom Color

30.24

Adding a Custom Color
You add a custom color the color palette to save it for quick access in the future.
For more information, see section 30.26 “Gradients” on page 925.

To add a custom color
1. In Graphics Editor, on the Options toolbar, click Fill (or Stroke) to open the
color palette.
2. Select Custom Color.

3. In the Color dialog box, in the colored square, move the pointer to the color
you want to add. If required, you can adjust the color by adjusting the
numerical values for Hue, Saturation, Red, Green, Blue, and
Luminosity.

4. Click Add to Custom Colors.

Note
• Fill and Stroke use the same color palette and also the same
custom colors.
5. Click OK.
The color is displayed in one of the Custom Color boxes.
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30.25

Using a Custom Color
You use custom colors when you want to use a specific color in your design.
For more information, see section 30.26 “Gradients” on page 925.

To use a custom color
1. In Graphics Editor, in the work area, select the object on which you want to
use the custom color.
2. On the Options toolbar, expand Stroke (or Fill) to open the color palette.
3. Click Custom Color.

4. Select the color in the Custom colors area.

5. Click OK.
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30.26

Gradients
In addition to the Color palette, Fill and Stroke have a Gradient palette. Gradients
consist of smooth color transitions along a specified direction from one color to
another. There are two types of gradients: linear and radial.
Gradients work with gradient stops where the two colors are specified and
indicating where they start and stop.
The Gradients and Gradient stops are properties, added to the object in the Objects
pane. For more information, see section 33.1 “Figures” on page 967.

30.26.1

Linear Gradient Adjustment
When you use the Fill – Gradient palette, you may need to adjust the color or some
other aspect of the appearance.
Adjusting a linear gradient involves finding the specific object in the Objects pane
and then changing the gradient parameters of the LinearGradient or the
GradientStop elements.

30.26.2

Radial Gradient Adjustment
When you use the Fill – Gradient palette, you may need to adjust the color or some
other aspect of the appearance.
Adjusting a radial gradient involves first finding the specific object in the Objects
pane and then changing the gradient parameters of the RadialGradient or the
GradientStop elements.

30.26.3

Gradient Properties
It is not difficult to change the gradient properties, but you have to have some
understanding of the parameters involved. In most cases, it is sufficient to use the
standard Gradient palette.
For more information, see section 30.27 “Gradient Properties” on page 926.
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30.27

Gradient Properties
It is not difficult to change the gradient properties, but you have to have some
understanding of the parameters involved. In most cases, it is sufficient to use the
standard Gradient palette.
There are two types of gradients, linear and radial, each with somewhat different
properties. These properties are displayed in objects under the corresponding
shape object in the Objects tree. For more information, see section 33.1 “Figures”
on page 967.
A linear gradient has a StartPoint and an EndPoint, local coordinates for the
direction of the gradient.

Figure: A linear gradient, with a diagonal direction from 0, 0 to 1, 1; and a horizontal
gradient from 0.3, 0 to 0.7, 0 (with SpreadMethod “Pad”)

A linear gradient also has a SpreadMethod, which tells how the areas outside the
StartPoint and the EndPoint are to be treated. There are three methods:
• Pad (default)
Extends the gradient end colors to the respective ends of the object.
• Reflect
Reflects the gradient like a mirror placed at the StartPoints and EndPoints.
• Repeat
Repeats the gradient pattern, as far as the “outside” areas stretches.
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Figure: The three different SpredMethods used with the same StartPoints and EndPoints

A radial gradient has the following properties:
• Focus
Point that defines where the radial gradient starts.
• Center
Center point for the circle (ellipse) that defines where the radial gradient ends.
• RadiusX
One of the two axes for the circle (ellipse) that define where the radial gradient
ends.
• RadiusY
One of the two axes for the circle (ellipse) that define where the radial gradient
ends.
Example: An ellipse, created with one of the standard circular gradient patterns
from the Fill Gradient palette:
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Figure: A radial gradient with an off-center focus, suggesting light from upper-left

The SpreadMethod for a radial gradient is always “Pad”.
The colors at the StartPoint and EndPoint of a gradient (linear or radial) are specified
in two GradientStop objects, belonging to the “parent” LinearGradient or
RadialGradient object.
The GradientStop objects also have an Offset, which modifies where the gradient
starts and stops. If the values are 0 and 1, the StartPoint and EndPoint are not
modified.
Example: A rectangle with two different pairs of settings for the GradientStop:
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Figure: A linear gradient, in the lower case modified by the GradientStop Offsets

Gradients and gradient stops can be used in more complex ways.
For example, you can add more GradientStops to a Linear/RadialGradient to make
the color change at each Offset distance. Below is an example with three
GradientStops.
We use a square, 400x400, in which we want the gradients to run roughly in a
diagonal direction, but described only within the inner part of the square. By setting
the StartPoint to (0.2, 0.4) and the EndPoint to (0.7, 0.9), the gradients will run from
the coordinates (180, 260) to (380, 460).
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Figure: A square with a limited linear gradient, three gradient stops, and two
"preadMethod" areas outside the linear gradient definition.

The three GradientStops have the following properties:
• Color 1 (green), Offset=0.1
• Color 2 (none), Offset=0.3
• Color 3 (blue), Offset=0.7
The area between Offset=0 and Offset=0.1 is padded with Color 1 (green).
The area between Offset=0.1 and Offset=0.3 gradually changes from Color 1
(green) to Color 2 (transparent).
The area between Offset=0.3 and Offset=0.7 gradually changes from Color 2
(transparent) to Color 3 (blue).
The area between Offset=0.7 and Offset=1 is padded with Color 3 (blue).
The two areas outside the LinearGradient definition use the same SpreadMethod, in
this case Repeat, but Pad or Reflect could also have been used. With Repeat, the
pattern is repeated according to the defined gradient. With Reflect, the pattern
would have been mirrored, and with Pad the outermost colors (here 1 and 3) would
have been extended.

Note
• You have to add the GradientStops to the Objects pane in a strictly
ascending Offset order (0 to 1), otherwise the result is undefined.
• When you add a GradientStop to the list, its Color and Offset are undefined,
which means that the associated object are transparent until the parameters
have been set.
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30.28

Adding a Linear Gradient
You add a linear gradient to give an object a smooth, varying hue from one point to
another.
For more information, see section 30.26 “Gradients” on page 925.

To add a linear gradient
1. In Graphics Editor, in the work area, select the object on which to apply the
gradient.
2. On the Options toolbar, expand Fill to open the Color/Gradient palette.
3. Click the Gradient tab.

4. Click the box with the gradient you want to use.
In the Objects pane, a LinearGradient element and two or more GradientStop
elements are added to the object.
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30.29

Adjusting a Linear Gradient
You adjust a linear gradient to customize it.
For more information, see section 30.26 “Gradients” on page 925.

To adjust a linear gradient
1. In Graphics Editor, in the work area, select the object with the linear gradient
you want to adjust.
2. In the Objects pane, locate the object.
3. Expand the object elements to display the LinearGradient element with its
GradientStops.
4. Select the LinearGradient element.
5. To change the gradient target (the area or the stroke), in the Target area, in
the Attribute box, switch between Fill and Stroke.

6. To change the gradient start and end points (also indicating the gradient
direction), in the Position area, in the StartPoint or EndPoint box, type x
and y-coordinates between (0,0), (0,1), (1,0) and (1,1). If the gradient is
positioned well within the square outlined above, the areas “outside” the start
and end points can be filled by one of three spread methods.
7. To change the gradient spread method, in the Behavior area, in the
SpreadMethod box, switch between Pad (extending the end colors),
Reflect (mirroring the gradient in the Start/End points), and Repeat
(repeating the gradient as far as the “outside” area stretches).
Continued on next page
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8. To change any of the gradient colors (the “start” and “stop” colors), in the
Appearance area, in the Color box, click a color in the Color palette, or
type a hexadecimal color code.

9. To change the offset (where the “start” and “stop” colors will be positioned,
relative to the LinearGradient Start/End points), in the Position area, in the
Offset box, type a value between 0 and 1.
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30.30

Adding a Radial Gradient
You add a radial gradient to give an object a smooth, varying hue from a center
point to the periphery.
For more information, see section 30.26 “Gradients” on page 925.

To add a radial gradient
1. In Graphics Editor, in the work area, select the object to which you want to
add the radial gradient.
2. On the Options toolbar, expand Fill to open the Color/Gradient palette.
3. Click the Gradient tab.

4. Click the radial gradient you want to use.
In the Objects pane, a RadialGradient element with two or more GradientStops are
added to the object.
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30.31

Adjusting a Radial Gradient
You adjust a radial gradient to suit current requirements.
For more information, see section 30.26 “Gradients” on page 925.

To adjust a radial gradient
1. In Grahics Editor, in the work area, select the object with the radial gradient
that has to be adjusted.
2. In the Objects pane, locate the object.
3. Expand the object elements to display the RadialGradient element with its
GradientStops.
4. Select the RadialGradient element.
5. To change the gradient target (the area or the stroke), in the Target area, in
the Attribute box, switch between Fill and Stroke.

6. To change the gradient focus (the beginning of the radial gradient), in the
Position area, in the Focus box, type x and y-coordinates between (0,0) and
(1,1). To change how far the gradient will reach (a kind of gradient end point
periphery), a circle or ellipse is used.
7. In the Position area, click the periphery ellipse Center, and type x and ycoordinates between (0,0) and (1,1).
8. In the Position area, complete the circle/ellipse by selecting RadiusX or
RadiusY, and type values between 0 and 1 to define the reach of the
periphery.
Continued on next page
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9. To change any of the gradient colors (the “start” and “stop” colors), in the
Appearance area, in the Color box, click a color in the Color palette, or
type the a hexadecimal color code.

10. To change the offset (where the “start” and “stop” colors will be positioned,
relative to the RadialGradient focal point), in the Position area, in the Offset
box, type a value between 0 and 1.
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30.32

Animations
You can add animations to a graphic object to create an illusion of movement. You
can add animations to, for example, lines curves and rectangles. You can also add
animations to transformations of objects, for example rotate, scale, translate and
others. You can add the Animate property by adding it to the object you want to
animate in the Objects pane.
The Animate element has a Target attribute, that is, the property in the parent object
that you want the animation to change. For example, the Target attribute can be
Visibility. The Boundary attribute of the Animate element decides how the Target
attribute is affected. For example, a visible element can be hidden. The Behavior
attribute of the Animate element decides how the parent element of the Animate
element will go from visible to hidden. For example, Linear, in which case the parent
element softly goes from visible to hidden. You select attribute from a drop-down
list in the attribute box. Only relevant attributes are available in the list.
Two examples:
When you add an Animate element to a rectangle, you can animate a whole
number of rectangle properties:

Figure: Rectangle properties

When you add an Animate element to a Rotate element, you can only animate the
rotation angle and center properties:
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Figure: Rotation properties

The remaining Animate properties are used as follows:
• Animation
Start or Stop the dynamic behavior.
• AutoReverse
If True, the animation runs backwards at the end of the forward motion. If
False, there is no backwards run at the end of the forward motion.
• CalcMode
If Discrete, the animation switches between the From and To Boundaries. If
Linear, the animation progresses smoothly between the same Boundaries.
Use discrete animations for:
– Binary values (for example true/false, hidden/visible)
– Enumerations (0, 1, 2)
– Switching between two colors
– Changing properties for a text (for example, Font, Size, Bold, or Italic)
– Changing the size (height and width) of a shape
– Options (for example, alignment and visibility)
Use linear animations to:
– Change properties that are numbers (double, analog values) to smoothly
change the size
– Position a shape
– Set the angle of a rotated shape
– Create a smooth blink, using the Visibility properties
– Create smooth rotation animations
• Duration
The time in seconds for one forward animation.
• Freeze
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If True, the current animation value is saved when the dynamic mode is exited.
If False, the value is reset.
• Repeat
Either an entered number of runs or Forever, that is, endless repetition.
• Boundary, From and To
The end values for the animated property.
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30.33

Adding an Animation
You make an object dynamic by adding an animate element to it.
For more information, see section 30.32 “Animations” on page 937.

To add an animation
1. In Graphics Editor, in the work area, select the object you want to animate.
2. In the Objects pane, right-click the object, click New, and then click
Animate.

3. In the Properties pane, under Target, in the Attribute box, enter the
property that you want the animation to affect.

4. In the Behavior field, in the Animation box, click Start to be able to specify
what is to start the animation.
5. In the Properties pane, add other attributes to control how the attribute is to
behave.
Continued on next page
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6. In the Objects pane, right-click the Animate element, point to New, and
then click Bind.

7. In the Objects pane, right-click the Bind element, point to New, and then
click a converter or another property that controls what the animation is to
change.

You can now bind the animation to an actual signal in WorkStation.
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31 Layers
31.1 Layers

31.1

Layers
When creating complex graphics, it can be a challenge to keep track of all the
graphic figures in the work area. Graphic figures get hidden under one another and
selecting becomes difficult. Layers provide a way to manage the graphic figures
that make up your graphic. Layers can be regarded as folders that contain graphic
figures.
The structure of layers in your document can be as simple or complex as you want
it to be. By default, all graphic figures are organized in a single, root layer. This layer
is named Tgml and you cannot rename it. The Tgml layer is always visible.
Layers have the same properties as Group elements: Opacity and Visibility. You can
control these layer properties from the Properties pane.
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Figure: Tgml layer and two additional layers
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Layers are located on the TGML root level. New layers are added at the top of the
work area (z-order, corresponding to the top of the tree), which means that the
figures in the layer are displayed above (and possibly on top of) figures in previous
layers. For more information, see section 33.1 “Figures” on page 967.

Tip
• To rearrange the order of the layers, you can select a layer in the Layers pane
and click the Move up
and Move down buttons
to move the layer
upward or downward in the tree.
You manage layers in the Layers pane. From the Layers pane you can create, select
and merge layers. You can also show, hide, duplicate, move, rename and delete all
layers except the Tgml layer. You can copy graphic figures from one layer to
another. To edit a layer and access all its contents, you have to make sure that the
layer is selected. When you select one layer, all other layers become inaccessible. If
you move the layers up or down, you change the stacking order of the graphic
figures in the work area.

Figure: Tgml and two additional layers, the last (Layer 2; topmost) active

The display area of the Layers pane has the following columns:
• Buttons to select the active layer
• Thumbnail, showing the contents of a layer. For Tgml the merged contents are
displayed.
• The name of the layer, which can be edited (except for Tgml)
• Check box to show/hide a layer

Tip
• You can edit the name in the Name box in the Properties pane.
• You can also edit the name in the tree structure in the Objects pane.
Continued on next page
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• You can show/hide layers during the design process, but also in run time, for
example, through a signal bound to the Visibility property.
You typically use layers to create a background image, which lies inert during the
remaining design work, or to create layers with information that is to be displayed
only under certain conditions.
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31.2

Adding a Layer
You add layers to make it easier to select an individual element or groups of
elements in the work area when you edit the graphic. Layers are especially useful
when you use a background graphic in your work area.
For more information, see section 31.1 “Layers” on page 945.

To add a layer
1. In Graphics Editor, on the View menu, click Layers.
2. In the Layers pane, on the Layers toolbar, click the New Layer button

.

3. In the layer list, double click the layer name and type the name of the layer.

4. Press Enter.
5. On the File menu, click Save.
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31.3

Copying a Layer
You copy a layer to reuse it.
For more information, see section 31.1 “Layers” on page 945.

To copy a layer
1. In Graphics Editor, on the View menu, click Layers.
2. In the Layers pane, right click the layer you want to copy and then click
Duplicate.

Note
• The Tgml layer cannot be copied.
In the Layers pane, the new layer is displayed at the bottom of the list with content
identical to the content of the original layer. The new layer is automatically named
Copy of [name of the original layer]. For example, Copy of Text layer.
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31.4

Deleting a Layer
You delete a layer and all its contents if you no longer need it.
For more information, see section 31.1 “Layers” on page 945.

To delete a layer
1. In Graphics Editor, on the View menu, click Layers.

2. In the Layers pane, right-click the layer you want to delete and then click
Delete.

Note
• The inherent Tgml layer cannot be removed. Objects,
components and groups in this layer are contents of the root
level of the Tgml object.
The selected layer is deleted from the layers list, and all its contents is removed from
the work area.
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31.5

Renaming a Layer
You can rename layers to make them easier to identify.
For more information, see section 31.1 “Layers” on page 945.

To rename a layer
1. In Graphics Editor, on the View menu, click Layers.
2. In the Layers pane, click the layer name and then type a new name.
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31.6

Selecting a Layer
You select a layer to perform an operation on it. You can only select and edit one
layer at a time.
For more information, see section 31.1 “Layers” on page 945.

To select a layer
1. In Graphics Editor, on the View menu, click Layers.
2. In the Layers pane, select the option button for the layer you want to edit.

Note
• When you have selected a layer, all other layers will automatically
be made inaccessible.
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31.7 Hiding a Layer

31.7

Hiding a Layer
You hide a layer to change the visibility property for the layer, and all its contents.
For more information, see section 31.1 “Layers” on page 945.

To hide a layer
1. In Graphics Editor, on the View menu, click Layers.

2. In the Layers pane, clear the box in the eye icon column for the layer you
want to hide.

Note
• Selecting the box in the eye icon column displays the layer.
• It is not possible to hide the Tgml layer.
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31.8

Controlling the Visibility of a Layer
You control the visibility of a layer in a graphic by binding a signal to the Visibility
property, or by using a JavaScript.
For more information, see section 31.1 “Layers” on page 945.

To control the visibility of a layer
1. In Graphics Editor, in the Objects pane, select the layer that you want to
control with a signal.
2. Right-click, point to New, and then click Bind.

3. In the Properties pane, under General, in the Name box, enter a layer
name and add “.Value”.
4. Right-click the Bind element and add two ConvertValue elements.

5. For the first ConvertValue element, in the Properties pane, under
Behavior, in the AtributeValue box, type Hidden.
6. For the first ConvertValue element, in the Properties pane, under
Behavior, in the SignalLessOrEqualTo box, enter “0”.
Continued on next page

04-16006-04-en, March 2015

Technical
957

31 Layers
31.8 Controlling the Visibility of a Layer

7. For the second ConvertValue element, in the Properties pane, under
Behavior, in the AtributeValue box, type Visible.

8. For the second ConvertValue element, in the Properties pane, under
Behavior, in the SignalMoreOrEqualTo box, enter “1”.
The visibility of the layer in the graphic can now be controlled by the signal values 0
and 1, bound to [Layer name].Value.
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32 Grid and Zoom
32.1 Grid

32.1

Grid
A grid is a Graphics Editor feature that can be of assistance when you draw and
position graphic figures in a graphic. Graphic figures can be made to snap (attach)
to the grid intersection points, which always align with the logical pixels.
There are two kinds of pixels:
• Logical pixels
• Screen pixels
The logical pixel is the unit of measurement in the graphic. Figure coordinates,
stroke width, and so on, are all based on pixels. Although a line with Stroke width
1.0 px will look different (use few or many screen pixels) depending on the zoom
level, the line will always have the width of 1.0 logical pixel.
The width of the grid lines can be set to: 1, 2, 5, 10, or 20 logical pixels.
The screen pixel is the smallest possible detail on a screen and its physical size
depends on the screen resolution.
When you zoom out of a graphic, the grid pattern eventually becomes cluttered. In
this case, the grid lines are removed so that the distance between two grid lines
never gets shorter than five pixels.
You can customize the pixel space between the grid lines. This is useful when you
draw small details.
The grid size is saved in the .tgml document.
When you zoom in on a graphic, additional, lighter grid lines are added to show the
logical 1.0x1.0 pixel grid. This is the grid that is used when you nudge a figure.
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32.2

Showing/Hiding the Grid
You show the grid to get assistance when you position objects in the work area.

Note
• By default, the grid is hidden.
• Even if the grid is hidden, Snap to grid can be active.
For more information, see section 32.1 “Grid” on page 959.

To show/hide the grid
1. In Graphics Editor, on the Drawing toolbar, click Show grid/Hide grid

.

Note
• Show Grid has a drop-down menu where you set the grid
distance to 1, 2, 5, 10, or 20 pixels.
Show grid toggles between showing and hiding the grid.
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32.3

Switching on/off Snap to Grid
You use Snap to Grid to get a certain degree of alignment in a design.
For more information, see section 32.1 “Grid” on page 959.

To switch on/off Snap to Grid
1. In Graphics Editor, on the Drawing toolbar, click Snap to Grid

.

Note
• You can snap to the grid even when the grid is hidden.
Snap to Grid toggles between switching on and switching off the Snap to Grid.
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32.4

Nudging an Object
You nudge an object to make a small adjustment to its position.
For more information, see section 32.1 “Grid” on page 959.

To nudge an object
1. In Graphics Editor, in the work area, select the object you want to nudge.
2. If Snap to Grid is active, press ALT to temporarily disable the snap function
during the nudging.

3. Use the arrow keys to move the object in the desired direction.
You move the object one pixel each time you press an arrow key.
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32.5

Zooming
You zoom in to get a more detalied view of an object. You zoom out to get an
overview of a design.

To zoom
1. In Graphics Editor, on the Drawing toolbar, click Zoom

.

2. On the Options toolbar, select the magnifying glass you want to use, + to
zoom in and - to zoom out.
3. In the work area, click the object you want to zoom in or out on.

Note
You zoom in/out by 10% each time you click the object.
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32.6

Zoom to a Specified Value
You zoom to a specified value to get an exact percentage of the original size.

To zoom to a specified value
1. In Graphics Editor, on the menu bar, enter a percentage in the Zoom box

.

Note
• Zoom to fit zooms the drawing to fill the available presentation
area.
• You can enter any percentage value in the Zoom box.
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33 Graphics Editor Figures
33.1 Figures

33.1

Figures
A figure is the smallest independent element of a graphic, for example, a circle.
All figures in a graphic are displayed in a tree structure in the Objects pane. The
TGML root object is always present in the tree structure and cannot be deleted. The
TGML root object properties define the size and color of the work area. The position
of the objects in the tree structure reflects the relationship between figures in the
graphic. The closer in the tree structure a figure is to the TGML root object, the
further back it is located in the work area. You can move the figures in the tree
structure. When you move a figure in the tree structure, it is dynamically moved
back or forward in the work area.

Note
• Apart from the two surface coordinates, x and y, figures also have a hidden
stacking order known as the z-coordinate or the z-order. The z order means
that more recently added figures are put in the front and older ones in the
back. Thus, more recent figures can cover previous figures in the graphic.

Tip
• To change the order of the figures, you select a figure in the Objects pane
and click the Move up
or Move down
button.
When you select a figure in the work area, the figure and its elements are selected in
the Objects pane. You can also select an element in the Objects pane.

Important
• Before you can select a figure in the work area, you have to make sure that
the layer where the figure is located is active.
To create certain elements on an object, you need to right-click on the object and
then click the element in the Objects pane.
Use this method to create the following elements on an object:
• Bind
• Link
• Animate
• TargetArea
• Metadata
• Chord
• AnimatedImage
• Expose
• Script
you have to right-click the object and then click the element in the Objects pane.
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33.1.1

Figure Tools
Use the Graphics Editor drawing tools to add lines, polylines, curves, polygons,
rectangles, ellipses, arcs, pies, texts, and textboxes to a graphic.
For more information, see section 23.7 “Drawing Tools” on page 801.

33.1.2

Snippets
Snippets are standardized, predefined functions for defined use.
For more information, see section 24.11 “Snippets” on page 828.

33.1.3

Attributes
Each element in the Objects pane has a number of properties. The Graphics Editor
object properties are referred to as attributes, in compliance with XML standards.
The attributes are displayed in the Properties pane, where they can be edited.
Attributes are used to give a complete description of a graphic object. Most of the
attributes are automatically defined when the graphic object is created. By
changing the attributes, you can change, for example, the appearance and
behavior of a graphic object.
For more information, see section 27.1 “Attributes” on page 851.

33.1.4

Binds and Links
A dynamic graphic object can be bound to, and thus controlled by, server variables
(signals). When the signal changes the behavior or appearance of the object
changes dynamically.
For more information, see section 28.1 “Binds and Links” on page 871.

33.1.5

Graphics Editing Tools
You can edit all graphic objects, that is, modify their properties. For example,
shape, size, and color.
For more information, see section 30.2 “Graphics Editing Tools” on page 896.
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33.2

Lines
Use the Graphics Editor Line tool to draw a straight line, that is, a line between two
points.
You can set stroke, style and width properties for the line to change the line color,
pattern and thickness.
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33.3 Drawing a Line

33.3

Drawing a Line
You draw a line when you want to draw an extending one-dimensional figure that
has no curvature .

To draw a line
1. In Graphics Editor, in the Layers pane, select the layer whre you want to draw
the line.
2. On the Drawing toolbar, click Line.
3. In the work area, click where you want the line to start and drag to where you
want it to end.
4. On the Drawing toolbar, click Select.
5. In the Properties pane, in the Name box, type the name of the line.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
6. On the Options toolbar, or in the Properties pane, adjust the appearance of
the line.
7. On the File menu, click Save.
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33.4

Polylines
Use the Graphics Editor Polyline tool to draw a line with several nodes, that is, a
line with angles.
You can set fill, stroke, style and line width to achieve a certain appearance of the
polyline.

04-16006-04-en, March 2015

Technical
973

33 Graphics Editor Figures
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33.5

Drawing a Polyline
You draw a polyline to get a figure that consists of two or more connected line
segments.
For more information, see section 33.4 “Polylines” on page 971.

To draw a polyline
1. In Graphics Editor, in the Layers pane, select the layer where you want to
draw the polyline
2. On the Drawing toolbar, click Polyline.
3. In the work area, drag from where you want the polyline to start and click for
each new line segment you want to add.

Note
You have to add a new segment for every turn of the polyline.
4. Double-click to finish the polyline.
5. On the Drawing toolbar, click Select.
6. In the Properties pane, in the Name box, type the name of the polyline.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
7. On the Options toolbar, or in the Properties pane, adjust the appearance of
the curve.
8. On the File menu, click Save.
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33.6

Curves
Use the Graphics Editor Curve tool to draw a curve, that is, a line that is not
straight.
Drawing perfect curves requires some understanding of the principles of curves, as
well as some practical experience. When you draw a curve and click the key points
of the curve, a number of curve segments are created. These segments are defined
by three vertices:
• The vertex, that is, the start point
• The highest/lowest point of a curve segment
• The end point
When a curve consists of more than one segment, the point connecting two curve
segments is also a vertex. The curve passes through all of these vertex points.
Normally, the vertex points are not displayed, but to modify the curve you need to
access these points.
When you double-click the curve, the vertices are displayed. Two handles are
associated with each vertex (except for the start and end points, which have only
one handle).

Figure: A simple curve with its three vertices and two plus two handles

Each handle controls the shape of the curve at its side of the vertex. The length and
the angle of the handle determine the direction and curvature of that end of the
segment. The handle can be regarded as a magnet attracting its part of the
segment.

Figure: By stretching the top right handle, that part of the curve segment is modified

If you want to modify a curve, you have the following options:
• Moving a Curve Vertex
• Adjusting a Curve Handle

Tip
You can also nudge the vertex by using the arrow keys.
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33.7

Drawing a Curve
You draw a curve to get a line that is not straight and that consists of two or more
segments.
For more information, see section 33.6 “Curves” on page 973.

To draw a curve
1. In Graphics Editor, in the Layers pane, select the layer where you want to
draw the curve.
2. On the Drawing toolbar, click Curve.
3. In the work area, drag from where you want the curve to start and click for
each segment you want to add.

Note
You have to add a new segment for each turn of the curved line.
4. Double-click to finish the curve.
5. On the Drawing toolbar, click Select.
6. In the Properties pane, in the Name box, type the name of the curve.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
7. On the Options toolbar or in the Properties pane, adjust the appearance of
the curve.
8. On the File menu, click Save.
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33.8

Editing a Curve
You edit a curve to adjust any point of the curve.
For more information, see section 33.6 “Curves” on page 973.

To edit a curve
1. In Graphics Editor, in the work area, double-click the curve to display its
vertices.
2. Drag the vertex you want to change to a new position.

3. Click outside the curve to finish.
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33.9

Polygons
Use the Graphics Editor Polygon tool to draw a polygon, that is, a plane figure that
is bounded by a closed path, composed of a finite sequence of straight line
segments.
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33.10

Drawing a Polygon
You draw a polygon when you need a closed multi-sided figure.

To draw a polygon
1. In Graphics Editor, in the Layers pane, select the layer where you want to
draw the polygon.
2. On the Drawing toolbar, click Polygon.
3. In the work area, click where you want to locate the corners of the polygon.

4. Double-click to close the polygon.
5. On the Drawing toolbar, click Select.
6. In the Properties pane, in the Name box, type the name of the polygon.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
Continued on next page
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7. On the Options toolbar or in the Properties pane, adjust the appearance of
the polygon.
8. On the File menu, click Save.
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33.11

Rectangles
Use the Graphics Editor Rectangle tool to draw a simple rectangle, that is, a
quadrilateral with four right angles.
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33.12 Drawing a Rectangle

33.12

Drawing a Rectangle
You draw a rectangle when you need a four-sided figure with four 90 ° angles and
there is no component that works for this situation.
For more information, see section 23.7 “Drawing Tools” on page 801.

To draw a rectangle
1. In Graphics Editor, in the Layers pane, select the layer you want to draw the
rectangle on.
2. On the Drawing toolbar, click Rectangle.
3. In the work area, click where you want the rectangle to begin and drag the
pointer to where you want it to end.

4. On the Drawing toolbar, click Select.

5. In the Properties pane, in the Name box, type the name of the rectangle.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.

6. On the Options toolbar or in the Properties pane, adjust the appearance of
the rectangle.
7. On the File menu, click Save.
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33.13

Drawing a Square
You draw a square when you need a figure with four equal sides and four 90 °
angels.

To draw a square
1. In Graphics Editor, in the Layers pane, select the layer you want to draw the
square.
2. On the Drawing toolbar, click Rectangle
3. In the work area, press SHIFT and click where you want the square to begin
and drag to where you want it to end.
4. On the Drawing toolbar, click Select.
5. In the Properties pane, in the Name box, type the name of the square.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
6. On the Options toolbar or in the Properties pane, adjust the appearance of
the rectangle.
7. On the File menu, click Save.
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33.14

Ellipses
Use the Graphics Editor Ellipse tool to draw an ellipse, that is, a plane curve that
results from the intersection of a cone by a plane in a way that produces a closed
curve.

Tip
To draw a circle, select Ellipse and press SHIFT while you draw.
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33.15

Drawing an Ellipse
You draw an ellipse when you need a conic section whose plane is not parallel to
the axis, base, or generatrix of the intersected cone.

To draw an ellipse
1. In Graphics Editor, in the Layers pane, select the layer where you want to
draw the ellipse.
2. On the Drawing toolbar, click Ellipse.
3. In the work area, drag the pointer from where you want to start the ellipse to
where you want it to end.

4. On the Drawing toolbar, click Select.
5. In the Properites pane, in the Name box, type the name of the ellipse.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
Continued on next page
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6. On the Options toolbar or in the Properties pane, adjust the appearance of
the ellipse.
7. On the File menu, click Save.

Technical
986

04-16006-04-en, March 2015

33 Graphics Editor Figures
33.16 Circles

33.16

Circles
In Graphics Editor, use the Ellipse tool to draw a circle, that is, a line forming a
closed loop, every point on which is a fixed distance from a center point. A circle is
actually a special case of an ellipse. In an ellipse, if you make the major and minor
axis the same length, the result is a circle, with both foci at the center.
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33.17

Drawing a Circle
You draw a circle when you need a figure forming a closed loop where every point
is a fixed distance from the center point.
For more information, see section 33.16 “Circles” on page 985.

To draw a circle
1. In Graphics Editor, in the Layers pane, select the layer where you want to
draw the circle.
2. On the Drawing toolbar, click Ellipse.
3. I the work area, click SHIFT while dragging the pointer from where you want
the circle to begin to where you want it to end.
4. On the Drawing toolbar, click Select.
5. In the Properties pane, in the Name box, type the name of the circle.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
6. On the Options toolbar or in the Properties pane, adjust the apperance of
the circle.
7. On the File menu, click Save.
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33.18

Arcs
Use the Graphcis Editor Arc tool to draw an arc, that is, a part of the periphery of
an ellipse, or a circle.
The arc is defined by a center point, a radius X, a radius Y, a start angle, and a
sweep angle. The start angle is the angle between the X-axis and the start of the
arc. The sweep angle can lie in the interval ±(0° – 360°).
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33.19 Pies

33.19

Pies
Use the Graphics Editor Pie tool to draw a pie, that is, an area enclosed by two
radii of a circle and their intercepted arc.
The pie is defined by a radius X, a radius Y, a start angle, and a sweep angle. The
start angle is the angle between the X-axis and the start of the arc. The sweep angle
can lie in the interval ±(0° – 360°).
A pie is similar to an arc, but includes the two radii and the area within.
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33.20

Drawing an Arc or a Pie
Use Arc or Pie to draw a curve-like segment, but with specified start and end
points. The initial sweep angle is always 90°. The orientation of the 90° arc or pie
corresponds to the position of the end point, related to the start point.
For more information, see section 33.18 “Arcs” on page 987. For more information,
see section 33.19 “Pies” on page 988.

To draw an arc
1. In Graphics Editor, in the Layers pane, select the layer where you want to draw
the arc or pie.
2. On the Drawing toolbar, select Arc The cursor will change into a crosshair
pointer.
3. In the work area, drag the pointer from where you want to start the arc or pie
to where you want it to end.
4. On the Drawing toolbar, click Select.
5. In the Properties pane, in the Name box, type the name of the arc or pie.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.
6. On the Options toolbar, or in the Properties pane, adjust the appearance of
the arc or pie.
7. On the File menu, click Save.
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33.21

Editing an Arc
You edit the start and sweep vertexes of an arc to change its angle.
For more information, see section 33.19 “Pies” on page 988.

To edit an arc
1. In Graphics Editor, in the work area, double-click anywhere on the arc to
display the vertexes.
2. Select the vertex you want to edit and drag it to a new position.

Note
• You can extend the angle handle to increase the precision. This
does not affect the arc in other ways.
• If you press the SHIFT key while moving the cursor, the angle
changes in steps of 7.5°, somewhat depending on how much
you extend the handle.
3. Click outside the arc to finish.
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33.22

Texts and Textboxes
Use the Graphics Editor Text tool to write a single line of text with no wrapping.
Use the Graphics Editor Textbox tool to write one or several lines of text that are
wrapped within the specified box.
You can edit and format the text by using the standard formatting tools.

33.22.1

Text Path
A text path is a free form curve of text. You use the text path to make the characters
independent of any font library. The disadvantage of this is that you can no longer
edit the characters as text.
When you create a path of text, you create a copy, which can be treated as an
ordinary closed curve. You can set Stroke and Fill color for the text path.
The original text remains unchanged and if required you can delete it.
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33.23

Adding Text Using the Text Tool
Text is typically used for adding labels or informative comments within your graphic.
You add a single line of text using the Text tool. Textboxes are used when you need
to wrap text.
For more information, see section 33.22 “Texts and Textboxes” on page 991.

To add text using the Text tool
1. In Graphics Editor, in the Layers pane, select the layer you want to add the
text on.
2. On the Drawing toolbar, click Text.
3. Click in the work area where you want the text to start.
4. Type the text you want to add to the graphic.

5. Press Enter.
6. On the Drawing toolbar, click Select.

7. In the Properties pane, in the Name box, type the name of the text.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.

8. On the Options toolbar or in the Properties pane, adjust the appearance of
the text.
9. On the File menu, click Save.
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33.24

Making Text Content Dynamic
You make text content dynamic so that the text changes according to the value of
the variable it is bound to. This way you use only one text object to show different
texts depending on the value of the variable.

To make text content dynamic
1. In Graphics Editor, in the Layers pane, select the layer that contains the text
you want to make dynamic.
2. In the work area, select the text you want to make dynamic.
3. In the Object pane, right-click Text, point to New, and then click Bind.

4. In the Properties pane, in the Name box, type the name of the Bind object.

Continued on next page
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33.24 Making Text Content Dynamic

5. In the Attribute box, select Content.

6. In the Objects pane, right-click Bind, point to New, and then click
ConvertValue.
7. In the Properties pane, in the Name box, type a name for the ConvertValue
object.

8. In the AttributeValue box, type the text that you want to display in the
graphic.
Continued on next page
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9. In the SignalEqualTo box, type the value when the text is to be displayed.

10. Add more ConvertValue objects to the Bind object, one for each value of the
variable that is to be displayed as text.
11. In the Objects pane, right-click the Text, point to Group as, and then click
Component.
12. In the Properties pane, in the Name box, type the name of the component.

13. On the File menu, click Save.
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33.25

Adding Text Using the Textbox tool
You add text within a textbox when you want to add several lines of text with
automatic line wrap within a defined area.
For more information, see section 33.22 “Texts and Textboxes” on page 991.

To add text using the Textbox tool
1. In Graphics Editor, in the Layers pane, select the layer you want to add the
text on.
2. On the Drawing toolbar, click Textbox.
3. In the work area, click where you want to locate the upper-left corner of the
textbox.
4. Drag the pointer to where the lower-right corner of the textbox is to end.
5. Type the text you want to add to the graphic.

6. On the drawing toolbar, click Select.

7. Adjust the size of the textbox.
8. In the Properties pane, in the Name box, type the name of the textbox.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.

9. On the Options toolbar or in the Properties pane, adjust the appearance of
the text.
10. On the File menu, click Save.

Technical
998

04-16006-04-en, March 2015

33 Graphics Editor Figures
33.26 Editing Text

33.26

Editing Text
You can reformat single line texts and texts within textboxes.
For more information, see section 33.22 “Texts and Textboxes” on page 991.

To edit text
1. In Graphics Editor, in the work area, select the text or textbox object
containing the text you want to edit.

2. On the Options toolbar, expand Stroke and select a new text color from the
Color palette.
3. On the Options toolbar, expand Fill and select a new background color for
the textbox from the Color palette.
4. Double-click the text/textbox object and edit the text by adding or deleting
text.
5. On the Options toolbar, set font, font size, and other text properties.

6. When finished, click outside the text/textbox.
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33.27

Paths
When you create a path of one or several objects, you create a copy in the form of a
path, where the original objects have been dissolved and replaced with
corresponding lines and fills. For example, a rectangle dissolves into a path of four
connected strokes.
By creating a path, the number of objects is reduced to one. That is, the resulting
path.
The advantage of using a path is that it speeds up the drawing of the object, which
can be important when using animations.
The original objects remain unchanged and can be deleted, if required.
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33.28

Creating a Text Path
You create a text path to protect the text so that it cannot be manipulated and to be
able to use effects like gradients on the text. When you creat a text path, the text in
reality becomes a curve.
For more information, see section 33.22 “Texts and Textboxes” on page 991.

To create text path
1. In Graphics Editor, on the Options toolbar set the Fill, Stroke, Style, and
Width properties for the text path you are going to create.
2. On the Drawing toolbar, click Text

or Textbox

.

3. In the work area, click the general area where you want to position the text
path and write the text.

4. Right-click the text or textbox object and click Create Path.

The characters are transformed to curve paths, with the appearance you specified
in the first step. You can edit the appearance.

Note
• The original text remains untouched, but can be moved or deleteed.
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33.29

Editing a Text Path
You edit a text path to change its appearance or other properties. The text path is in
fact a curve and can be modified like any other curve, but you can no longer edit the
text itself.
For more information, see section 33.22 “Texts and Textboxes” on page 991.

To edit a text path
1. In Graphics Editor, in the work area, select the text path.

2. In the Properties pane, edit the properties (Fill, Opacity, Stroke,
StrokeDashArray, StrokeWidth, or Visibility).
3. Double-click the path and drag the vertices to change the shape of the path.

4. Click outside the textpath to clear the selection.
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33.30

Pictures
Use the Graphics Editor Insert Pictures tool to insert supported image files into
your graphic.
The native Graphics Editor file formats are . *.gif, *.jpg, and *.png files. That is,
pasted components and graphics will be saved as one of these file types.
Table: File Formats You Can Insert into a Graphic

33.30.1

Graphic Type

File Type

Bitmap

*.bmp

Bitmap

*.dib

GIF

*.gif

Icon

*.ico

JPEG

*.jpg

JPEG

*.jpeg

JPEG

*.jpe

JPEG

*.jfif

JPEG

*.exif

Metafile

*.wmf

Metafile

*.emf;

PNG

*.png

TIFF

*.tiff

TIFF

*.tif

Image Insertion
A raster image can be inserted anywhere in the work area. When you add an image,
the actual image is saved with the graphic. That is, the image is not linked into the
graphic.
Raster images put a heavy load on graphics handling.

Important
• To minimize system load, reduce size and color depht of the images before
inserting them into a graphic.
Use an image editor to resize the image to the size required in the graphic. If you
use the .jpg format, the image can be compressed to a quality of 60% without any
adverse effects on the appearance.
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If you want to use transparency, you should add it to the original image. This can be
done if you use the .png format.

Tip
• You can paste any picture residing on the clipboard to the work area.
• You can also drag pictures to the work area.
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33.31

SVG Support
You can import SVG pictures, but only the following SVG Elements and Properties
are supported.

33.31.1

Supported SVG Elements
SVG
VERSION
LINE
POLYLINE
POLYGON
ELLIPSE
CIRCLE
RECT
TEXT
PATH
GROUP
DEFS
LINEARGRADIENT
RADIALGRADIENT
STOP
IMAGE

33.31.2

Supported SVG Attributes
LEFT
TOP
WIDTH
HEIGHT
D
R
X
X1
X2
CX
RX
Y
Y1
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Y2
CY
RY
FX
FY
ID
POINTS
STYLE
FILL
STROKE
STROKEWIDTH
OPACITY
OFFSET
FONTFAMILY
FONTSIZE
VISIBILITY
DISPLAY
VISIBILITY_HIDDEN
VISIBILITY_NONE
VISIBILITY_COLLAPSE
VISIBILITY_VISIBLE
VISIBILITY_INLINE
TRANSFORM
TRANSLATE
SCALE
SCALEX
SCALEY
ROTATE
SKEWX
SKEWY
STOP_COLOR
SPREADMETHOD
SPREADMETHOD_PAD
SPREADMETHOD_REFLECT
SPREADMETHOD_REPEAT
STROKE_OPACITY
FILL_OPACITY
XLINK_HREF
STROKEDASHARRAY
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GRADIENTSTOP
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33.32

Inserting a Picture
You insert a picture when you want to add an image, such as a .bmp or .png file,
into a graphic.
For more information, see section 33.30 “Pictures” on page 1001.

To insert a picture
1. In Graphics Editor, in the Layers pane, select the layer where you want to add
the picture.
2. On the Drawing toolbar, click Insert Picture.
3. In the work area, click where you want to locate the upper-left corner of the
picture.
4. Select the picture you want to insert into the graphic.
5. On the Drawing toolbar, click Select.
6. In the Properties pane, in the Name box, type the name of the picture.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.

7. On the Options toolbar or in the Properties pane, adjust the appearance of
the picture.
8. On the File menu, click Save.
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33.33

Adjusting a Picture
You adjust a picture to change any of its properties.
For more information, see section 33.30 “Pictures” on page 1001.

To adjust a picture
1. In Graphics Editor, in the work area, select the picture you want to adjust.
2. Drag the picture to reposition it.

3. Press SHIFT while dragging one of the corner handles to resize the picture but
keep the aspect ratio.
4. To change the opacity or visibility for the picture, in the Properties pane, in
the Appearance area, select the corresponding elements and enter new
values.

Note
• For performance reasons, it is strongly recommended that you
edit the picture before inserting it into the graphic.
5. On the File menu, click Save.
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33.34

Adding an Animated Picture
You insert an animated picture when you want to add an animated image, such as
a .gif file, into a graphic.

To add an animated picture
1. In Graphics Editor, in the Layers pane, select the layer where you want to add
an animated image.
2. On the Drawing toolbar, click Insert Picture.
3. In the work area, click where you want to locate the upper-left corner of the
animated image.
4. Select the animated picture you want to insert into the graphic.
5. On the Drawing toolbar, click Select.
6. In the Properties pane, in the Name box, type the name of the animated
image.

Note
You only need to name the drawing object if you will be binding the
object. Naming the object now will help you identify the object later.

7. On the Options toolbar or in the Properties pane, adjust the appearance of
the animated image.
8. On the File menu, click Save.
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33.35

Making an Animated Picture Dynamic
You make an animated image dynamic so that the animation can start and stop
according to the value of the variable it is bound to. This way you use the animation
in the image instead of using components.

To make an animated picture dynamic
1. In Graphics Editor, in the Layers pane, select the layer where you want to
make an animated image dynamic.
2. In the work area, select the picture you want to make dynamic.
3. In the Objects pane, right-click AnimatedImage, point to New, and then
click Bind.
4. In the Properties pane, in the Name box, type the name of the Bind object.

5. In the Attribute box, select Animation.
6. In the Objects pane, right-click Bind, point to New, and then click
ConvertValue.
7. In the Properties pane, in the Name box, type the name of the ConvertValue
object.

8. In the AttributeValue box, select Start.
Continued on next page
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9. In the SignalEqualTo box, type the value that should start the animation.

10. In the Objects pane, right-click Bind, point to New, and then click Convert
Value.
11. In the Properties pane, in the Name box, type the name of the
ConvertValue.
12. In the AttributeValue box, select Stop.
13. In the SignalEqualTo box, type the value that should stop the animation.
14. On the File menu, click Save.
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34.1

TGML Overview
TGML (TAC Graphics Markup Language) is a declarative XML-based language for
dynamic 2D graphics.
TGML is inspired by the XML based Scalable Vector Graphics (SVG) which is an
open standard for 2D graphics.
TGML specifies a hierarchy of runtime objects with a set of properties and logic.
Each markup element (XML element) represents a TGML object which can be
edited, or configured, in the Graphics Editor. However, not all of the objects are
graphical (visible). Several objects are used to add a specific behavior to a graphical
object, such as enabling dynamic update of attributes, transformations and
gradients.
The TGML object model is based on the W3C Document Object Model (DOM). The
TGML graphics elements are accessible for applications through the exposed
TGML DOM interfaces.

TGML version
The TGML version is specified in a XML processing instruction:

Figure: TGML code displaying the TGML version

Namespaces
The TGML graphics elements specified in this specification belong to the default
XML namespace, TGML.
TGML allows inclusion of elements from foreign namespaces anywhere with the
TGML content. In general, the TGML loader will include the unknown (foreign)
elements in the DOM, but will otherwise ignore the unknown elements.

34.1.1

Properties and Attributes
In the underlying class library, public data members are exposed as properties.
Each TGML element attribute has a corresponding property in the TGML class that
implements the TGML element.

Default Values
Most of the object properties have a default value. Element attributes that are
omitted in the TGML document are considered to be undefined. An undefined
attribute will result in assigning a default value to the corresponding property, unless
the value is inherited from a parent element.

Attribute Inheritance
TGML supports attribute inheritance similar to the SVG and XAML attribute
inheritance.
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The attribute inheritance means that a child element inherits (gets) the attribute
value from an ancestor element if the attribute value is omitted and if the attribute
has been specified for an ancestor (any of the parents).
In the example below, Line will inherit the Stroke value from the Group. StrokeWidth
is not defined either, but since it is not specified at the parent level, StrokeWidth will
be assigned the default StrokeWidth value.

Custom Attributes
The implementation of attribute inheritance also enables the user to specify custom
attributes, since an element will accept attributes that are actually unknown for the
element. For example, in the attribute inheritance example, Stroke was specified,
and accepted at the group level, despite the Group does not have a Stroke
attribute.
Custom attributes can, for example, be used to create "local" variables. The custom
attribute can be bound to a signal, or animated, as any other attribute of an element
and it can be accessed from scripts in the graphics.

Error Notifications
TGML does not specify any error or warning notifications. However, the TGML
implementation (e.g. Graphics Services) and the viewer and editor applications
should notify the user about any error conditions.

Implicit Syntax
TGML uses an implicit syntax. The object model implementation is not exposed in
the serialized TGML.
The following example defines a group containing a line. The TGML code does not
reveal how the containment is implemented in Group. The Group implementation
includes for example a child list that is the actual container, but such information is
not serialized.

Undefined (non-specified) attributes values are not serialized, to avoid breaking the
attribute inheritance.
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34.2

TGML Coordinate System
The origin of the TGML default coordinate system is in the upper-left corner. Values
of x increase as you move right, and values of y increase as you move down.
Container elements such as TGML and Component establish new coordinate
systems. Group is also a container element, but does not establish a new
coordinate system.

Figure: TGML container elements

Coordinates
The unit of measurement for coordinates is the device independent pixel, which is
1/96 of an inch (96dpi). The data type for coordinates and lengths (that is, Width
and Height) is Double.

Initial Scale
A TGML viewer uses the Width, Height and Stretch attributes of the outermost
TGML element to determine the initial scale. Stretch specifies if the document is
scaled to fit within the work area (preserving the aspect ratio or not) or if the original
size is preserved (scale 1:1).
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34.3

TGML Rendering Model
The following description is a summary of the TGML rendering model, which is very
similar to the SVG rendering model.
Elements in a TGML document have an implicit drawing order, with the first
elements in the TGML document getting "painted" first. Subsequent elements are
painted on top of previously painted elements.
Grouping elements have the effect of producing a temporary separate canvas onto
which child elements are painted. Upon the completion of the group, any filter
effects specified for the group are applied to create a modified temporary canvas.
The modified temporary canvas is composited into the background, taking into
account any group-level settings, such as opacity, on the group.
Individual graphics elements are rendered as if each graphics element represented
its own group (applicable when for example opacity is defined for the element).
Grouping elements have the effect of producing a temporary separate canvas onto
which child elements are painted.

Figure: Temporary canvas of grouped elements.

Upon the completion of the group, any filter effects specified for the group are
aööoled to create a modified temporary canvas.

Figure: Filter effects specified for the group modify the temporary canvas.

The modified temporary canvas is composited into the background, taking into
account any group-level settings, such as opacity, on the group.

Figure: Temporary canvas composited into the background
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34.4

TGML Types and Enumerations
All TGML attributes are of a certain type or enumeration.
Type/Enumeration

Description

Animation

An enumeration that controls an animation:
"Start", "Stop"

Bool

A boolean value:
"True", "False"

Brush

Describes how an area (Fill) or a stroke
(Stroke) is painted. Accepted values (WP1):
"None", "<Color>"

CalcMode

Specifies how values are interpolated when
animated:
"Discrete", "Linear"
Remark: "Linear" is only applicable when
you animate attributes of the types Double,
Color, Point and array of Point.

Color

An RGB or an ARGB color.
RGB is described as the hexadecimal
representation of the red,gren and blue
components.
ARGB is described as the hexadecimal
representation of the alpha (00-FF, where 00
is fully transparent), red, green, and blue
components (in that order).
Example, opaque red: Fill="#FF0000"
Example, 50% transparent red:
Fill="#7FFF0000"

Double

Double-precision floating-point numbers. For
example, heights and widths are Double.
Example:"50, 25"

FontStyle

Describes the style of the font: "Normal",
"Italic"

FontWeight

Describes the weight of the font: "Normal",
"Bold"

Format

This enumeration describes the formating of
the subscribed data.
"None": No formating. The data type of the
received data matches the data type of the
server variable (integer, float, boolean, string
etc).
"Presentation": Formated as text. The
server is expected to deliver the text
representation of the value, if any (e.g.
On/Off instead of 0/1.
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Continued
Type/Enumeration

Description

HorizontalAlign

Describes the horizontal alignment of a text
string.
"Left", "Center", "Right"

Point

Represents an XY coordinate.
Syntax: "<Double>, <Double>".
Example: "25.00 , 50.00"

Repeat

Describes the way the animation will be
repeated.
"<Iterations>" "Forever"
<Iterations> specifies the number of times
the animation is repeated.

SpreadMethod

Specifies how a gradient should be drawn
outside of the specified gradient vector or
space:
"Pad": The color values at the ends of the
gradient vector are used to fill the remaining
space.
"Reflect": The gradient is repeated in the
reverse direction until the space is filled.
"Repeat": The gradient is repeated in the
original direction until the space is filled.

Stretch

An enumeration that specifies how the
content shall be stretched.
"None": Preserve the original size.
"Uniform": Resize the content, preserving
the native aspect ratio.
"Fill": The content is resized but aspect
ratio is not preserved.

String

A string value, i.e. plain text. Reserved XML
characters (&<>) are escaped using the
standard XML escaping.

TextDecoration

Describes decorations that are added to the
texts.
"None", "Underline", "Strikethrough"

VerticalAlign

Describes the vertical alignment of a text
string.
"Top", "Middle", "Bottom"

Visibility

An enumeration that specifies the visibility of
an element:
"Visible", "Hidden"
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Type/Enumeration

34.4.1

Description

Arrays
Some attributes accepts arrays of values, such as arrays of Double and Point.
Arrays are written as a sequence of values, delimited by space.
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34.5

TGML File Format
TGML (TAC Graphics Markup Language) is a declarative XML-based language for
dynamic 2D graphics.
Graphics created in Graphics Editor are saved as .TGML files.
When you create a graphic in Graphics Editor, a TGML root object is created at the
bottom of the Objects tree in the objects pane. The TGML root object is also the
default layer in the work area of Graphics Editor. The TGML object cannot be
deleted.

34.5.1

Supported File Formats
You can import other graphics or photographs in supported formats. The following
formats are supported:
Table: Supported file formats that you can import to Graphics Editor
Graphic type

File type

TGML

*.tgml

OGC

*.ogc

OGC

*.sym

OGC

*.sgr

OGC

*.ogx

SVG

*.svg

CAD

*.dxf

CAD

*.dwg

You can export graphics to supported formats.
Table: Supported file formats that you can export from Graphics Editor
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Graphic type

File type

Bitmap

*.bmp

GIF

*.gif

JPEG

*.jpg

JPEG

*.jpeg

JPEG

*.jpe

PNG

*.png

TIFF

*.tiff
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Continued
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File type

TIFF

*.tif
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34.6

TGML Code Snippets
A snippet is a stored piece of TGML code. It can be used for reusing constructs
such as preconfigured animations and gradients.
A snippet file contains only one TGML snippet. The root element includes at least
two Metadata elements descibing the snippet; one for Name and one for
Description. It is recommended that the file name matches the Name metadata.

Figure: TGML code with Name and Description Metadata elements

Figure: Animation snippet that can be inserted as a child to any graphical (renderable)
TGML element
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34.7

TGML Common Attributes
The following attributes are applicable to all TGML elements.
Attribute

Type

Description

ID

String

The identity of the element.
Reserved for scripts and
other entities that need to
use unique element
identifiers to access specific
elements.
Inheritable: No
Animatable: No

Name

String

The name of the element.
The primary use is to identify
exposed elements such as
Bind.
Inheritable: No
Animatable: No
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34.8

TGML Components
Components are standardized, predefined graphics for defined use.

Component Library
Components are stored the same way as TGML code snipptets. Component is the
root element and the associated Metadata elements describe the component.

ComponentContent Element
The document type ComponentContent is the root of the document when the
content of a component is edited in the TGML graphics editor. ComponentContent
is replaced with Component when the component is stored in the library.
ComponentContent has the following attributes:
• Height
• Opacity
• Visibility
• Width
Width and Height are replaced with (copied to) ContentWidth and ContentHeight of
the Component element when the component is stored.

Initial Viewport
Width and Height of the stored Component are the initial viewport, that is, the initial
size of the component when it is pasted into a TGML document.
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34.9

TGML Document Structure
A TGML Graphics document always consists of at least one element, the root
("outermost") TGML element. This TGML element is the ancestor of all other
elements in the document.
Layer and Group are example of grouping (container) elements that are used to
structure the graphics. Elements that describe shapes and other graphical (visible)
objects can also have children, but these children are not visible objects, but
elements that add a specific behavior, such as gradients, animations and dynamic
bindings.

Figure: TGML code with the TGML root element and a number of child elements.

Figure: The graphic as seen in Graphics Editor.

04-16006-04-en, March 2015

Technical
1029

34 Graphics TGML Format Specification
34.10 TGML Document Type Element and Metadata

34.10

TGML Document Type Element and
Metadata
Each TGML document contains the TGML root element. It also contains metadata
created and interpreted by the TGML application.

Document Type Element : <TGML>
The root element of a TGML document is TGML. This element specifies that the
document type is TGML.
Table: TGML element attributes
Attribute

Type

Description

Background

Brush

The background color of the
document canvas (the
viewing area).
Default: "#FFFFFF"
Inheritable: No
Animatable: Yes

Height

Double

The height of the document.
Default: "600"
Inheritable: No
Animatable: No

Stretch

Stretch

Specifies how the document
shall be stretched initially
within a viewer.
Default: "None"
Inheritable: No
Animatable: No

Width

Double

The width of the document.
Default: "800"
Inheritable: No
Animatable: No

Remarks
The viewer uses the width, height, and stretch information to determine how the
document initially is streteched.
The viewer can display a document where information about width and height is
missing. When you view such a document no stretching is applied and any scroll
bars are disabled.
Stretch="None": Preserve the original size. This usually means that scroll bars are
enabled so the user can scroll to the right and the bottom of the document.
Stretch="Uniform": Resize the content, preserving the native aspect ratio. Scroll
bars are initially disabled.
Technical
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Stretch="Fill": The content is resized but aspect ratio is not preserved. Scroll
bars are initially disabled.

Metadata: <Metadata>
The Metadata element carries textual information about its parent element. It is up
to the TGML application to create and interpret the metadata.
Applying metadata to the outermost TGML element is the same as applying the
information to the TGML document.
Table: Metadata element attributes
Attribute

Type

Description

Name

String

A name that identifies the
information.
Inheritable: No
Animatabel: No

Value

String

The information.
Inheritable: No
Animatable: No
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34.11

TGML User-Defined Descriptions of
Custom Attributes
In Graphics Editor, when an attribute is selected, a short description of the element
attribute is displayed in the properties pane.
Custom attributes have no description since the TGML implementation has no
knowledge of the attribute. However, it is possible to use Metadata to add a
description of a custom attribute:

Figure: TGML code containing a user-defined description of a custom attribute. When the
user selects MyAttribute in the Graphics Editor properties pane the desciption is
displayed.

The Name of the Metadata element has to be the same as the attribute name. Value
contains the description.
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34.12

TGML Animations
An animation is a time-based modification of an element attribute. The animation
defines a mapping of time to values for the target attribute.
The TGML implementation (Graphics Services) only runs animations in Dynamic
mode. The value of an attribute that has been animated (changed) in Dynamic
mode is not preserved in the TGML file. The animated value is only valid while
running in Dynamic mode.

34.12.1

Animation: <Animate>
Animate animates a specified attribute of the immediate parent element.

34.12.2

Sequences: <Sequence>
Sequence plays a sequence of graphical elements, for example, shapes, text,
images, as a 'movie'.
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34.13

TGML Animation: <Animate>
Animate animates a specified attribute of the immediate parent element.
Table: Animate element attributes
Attribute

Type

Description

Animation

Animation

Starts and stops the
animation in Dynamic mode.
Default: "Start"
Inheritable: No
Animatable: Yes

Attribute

String

The animated attribute of the
parent element.
Inheritable: No
Animatable: No

AutoReverse

Bool

Indicates whether the
timeline plays in reverse after
it completes a forward
iteration.
Default: "Reverse"
Inheritable: No
Animatable: Yes

CalcMode

CalcMode

Specifies how values are
interpolated.
Default: "Discrete"
Inheritable: No
Animatable: Yes

Duration

Double

Specifies the "simple
duration" of the animation
measured in seconds.
Inheritable: Yes
Animatable: No

Freeze

Bool

Specifies if the animated
attribute value is kept or not
when the animation ends
(end of "active duration" or
stopped by setting Animation
to Stop).
Default: "False"
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

From

String (untyped)

The starting value of an
animation. The type is
determined by the
referenced Attribute.
Inheritable: Yes
Animatable: Yes

Repeat

Repeat

Describes the way the
animation is repeated.
Defautl: "Forever"
Inheritable: No
Animatable: Yes

To

String (untyped)

The ending value of the
animation. The type is
determined by the
referenced Attribute.
Inheritable. Yes
Animatable: Yes

Figure: Different CalcMode values

Figure: TGML code containing an Animate element that performs a blink
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34.14

TGML Sequences: <Sequence>
Sequence plays a sequence of graphical elements, for example, shapes, text,
images, as a 'movie'.
The Interval attribute controls the "frame rate". Interval specifies for how long,
measured in seconds, each graphical element is visible. The sequence can be
started and stopped by setting the Animation attribute to "Start" and "Stop".
Sequence belongs to the immediate parent container element and controls the
visibility of the container's graphical elements.
Table: Sequence element attributes
Attribute

Type

Description

Animation

Animation

Starts and stops the
animation in Dynamic mode.
Default: "Start"
Inheritable: No
Animatable: Yes

Interval

Double

Specifies for how long,
measured in seconds, each
of the shapes in the
container is to be visible.
Inheritable: Yes
Animatable: Yes

Figure: TGML code containing a Sequence element

The example plays a sequence of three rectangles and the frame rate is set to one
second. The Visibility attributes of the second and third rectangles are set to
"Hidden" to hide them in Edit mode.
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34.15

TGML Attribute Exposure
In TGML, it is possible to indicate that an attribute is to be exposed by the TGML
editor in such a way that it is easy to find and set the attribute value.
The primary purpose is to be able to create a "Component interface" to the user. A
Component can be rather complex. The component developer can choose to
expose some of the attributes of the Component (or the contained elements) to, for
example, make it easy to change the appearance of the Component.
An Expose element is used to expose an attribute. The Name of the Expose
element is presented to the user instead of the original attribute name.
The Expose element has a Description attribute that can be used to add a
description of the exposed attribute. This description is presented to the user in the
TGML editor.
The attribute exposure is only handled by the TGML editor. TGML viewers ignores
the exposure.

34.15.1

Expose Element: <Expose>
Expose indicates that an attribute of the immediate parent element is to be exposed
by the TGML editor, using the Name of the Expose element instead of the original
attribute name.
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34.16

TGML Expose Element: <Expose>
Expose indicates that an attribute of the immediate parent element is to be exposed
by the TGML editor, using the Name of the Expose element instead of the original
attribute name.
Table: Expose element attributes
Attribute

Type

Description

ExposedAttribute

String

The exposed attribute of the
parent element
Inheritable: No
Animatable: No

Description

String

A user-defined description of
the exposed attribute
Inheritable: No
Animatable: No

Figure: TGML code containing Expose element including a user-defined description of the
exposed attribute
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34.17

TGML Curves and Paths
TGML contains a definition for curve and path elements.

34.17.1

Cubic Bezier Curve: <Curve>
Curve defines a cubic Bezier curve. The cubic Bezier curve has a start point, an end
point, and two control points. The control points act as magnets, pulling the curve
in certain directions to influence the way the Bezier curve bends.

34.17.2

Path Element: <Path>
Path represents the outline of a shape.
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34.18

TGML Cubic Bezier Curve: <Curve>
Curve defines a cubic Bezier curve. The cubic Bezier curve has a start point, an end
point, and two control points. The control points act as magnets, pulling the curve
in certain directions to influence the way the Bezier curve bends.

Figure: Bezier curve with control points

Curve supports polybezier, which is a consecutive set of Bezier points. The end
point of the preceding Bezier becomes the start point of the following Bezier.

Figure: Polybezier

Table: Cubic Bezier Curve element attributes
Attribute

Type

Description

Closed

Bool

Describes if the curve is
closed or not. That is, if
Points data end with "z" or
not.
Default: "False"
Inheritable: No
Animatable: No

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

Points

Array of Point

The points: start point,
control points, and end point,
of the Bexier. Polybezier is
supported.
Inheritable: No
Animatable: No

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes
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34.19

TGML Path Element: <Path>
Path represents the outline of a shape.
The path is described by the PathData attribute, shich can contain moveto, line,
curve (both cubic and quadratic Beziers), arc,, and closepath instructions.
The path element is an implementation of the SVG path data specification. the
Scalable Vector Graphics (SVG) 1.1 Specification.
Table: Path element attributes
Attribute

Type

Description

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

PathData

String

SVG path data.
Inheritable: No
Animatable: No

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Remarks
Some of the path commands can be converted or replaced when you import SVG
paths. For example, h, H (Horizontal lineto) and v, V (Vertical lineto) can be replaced
with l and L (lineto).
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34.20

TGML Dynamics
A dynamic graphic object is an object (TGML element) whose properties (TGML
attributes) are bound to, and controlled by, server variables (signals).
The TGML implementation (Graphics Services) only runs the dynamics engine in
Dynamic mode. That is, bound properties are not dynamically updated in Static
(edit) mode.
Server variables are connected to element attributes via Bind elements with
associated rule elements. A Bind element belongs to the immediate parent element
and specifies which attribute of the parent element that are going to be dynamically
updated (similar to animations). The rule elements belong to the immediate parent
Bind element and they specify how a signal value is going to be converted to a
TGML attribute value.
The rules are evaluated in sequence, in the same order as they are specified. A rule
is executed (and the specified attribute is set) only if the specified conditions are
fulfilled. If no matching rules are found, the bound attribute is left unaffected.
TGML supports different types of rule elements (ConvertValue, ConvertRange,
ConvertText, ConvertStatus, and so on). Different types of rules can be combined in
the same Bind element.
The Name attribute of the Bind element identifies the binding and is exposed to
bind tools as a binding point to which the server variable is connected.

Figure: Overview of how an attribute in a graphic is bound to a server object, which in turn
dynamically affects the graphic.

Bindings can be thought of as a "connection table" between the exposed Bind
elements and the server variables. The TGML implementation (Graphics Services)
only has knowledge about the Name of the Bind elements.
Subscriptions are set up using the names of the Bind elements. When the value of a
bound signal is updated, it will be experienced as if the binding point was updated
(the signal identity is "hidden" behind the binding point). It is up to the server, or the
communication proxy depending on the binding implementation, to resolve the
name.
A TGML document can contain multiple Bind elements with the same Name.
However, the TGML implementation is only going to expose the Name once to the
bind tool in WorkStation (unique binding point). This makes it possible to have
multiple presentations of a signal, using a single binding point.
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Figure: Multiple Bind elements with the same Name

34.20.1

Signal Binding: <Bind>
Bind enables a dynamic (server/device controlled) update of an attribute of the
immediate parent element.

34.20.2

Value Conversion: <ConvertValue>
ConvertValue specifies how a server variable (signal) value is to be converted to a
TGML element attribute value. A ConvertValue element belongs to the immediate
parent Bind element.

34.20.3

Text Value Conversion: <ConvertText>
ConvertText specifies how a server variable (signal) value is to be converted to a
TGML element attribute value. ConvertText assumes that the signal value is a text.
A ConvertText element belongs to the immediate parent Bind element.

34.20.4

Value Range Conversion: <ConvertRange>
ConvertRange specifies how a server variable (signal) value shall be converted to a
TGML element attribute value using min and max values. A ConvertRange element
belongs to the immediate parent Bind element.

34.20.5

Custom Conversion: <ConvertCustom>
ConvertCustom defines a custom conversion of a signal value. The ConvertCustom
element is a script element with a JavaScript function named 'convert'.
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34.20.6

Status Conversion: <ConvertStatus>
ConvertStatus specifies how the status of a server variable (signal) value is to be
converted to a TGML element attribute value. A ConvertStatus element belongs to
the immediate parent Bind element.
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34.21

TGML Signal Binding: <Bind>
Bind enables a dynamic (server/device controlled) update of an attribute of the
immediate parent element.
The Name of the Bind element is exposed to the WorkStation bind tool as a binding
point.
The Bind element has a Description attribute that can be used to add a description
of the binding. The Description can be exposed together with the Name and
presented to the user in the bind tool.
Bind makes the parent element an "interactive" element. The TGML viewer is
supposed to respond, for example, show a "change value" dialog box, when the
user clicks the element.
Table: Bind element attributes
Attribute

Type

Description

Attribute

String

The bound attribute of the
parent element.
Inheritable: No
Animatable: No

Description

String

A user-defined description of
the binding.
Inheritable: No
Animatable: No

Format

Format

Specifies the formating of the
subscibed data.
Default: "None"
Inheritable: No
Animatable: No

PreventDefault

Bool

Cancels the defautl action
normally taken by the
implementation, for example,
the viewer.
Default: "False"
Inheritable: Yes
Animatable: No

DynamicUpdates

DynamicUpdates

Specifies if the Bind should
be enabled or disabled.
Default: "Enabled"
Inheritable: Yes
Animatable: No

Remarks
Format is an instruction to the server how the subscribed value is to be formated.
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"None" means "deliver the data as is". The data type is preserved (integer, float,
boolean, string, and so on ). You typically use conversion elements to convert the
server variable value to a TGML element attribute value.
"Presentation" is an instruction to the server: Deliver the text representation of the
variable value, if any (for example, On/Off instead of 0/1). "Presentation" is typically
used when the data i to be presented by a Text element without any value
conversions.
The “default action” when a user clicks an element containing a Bind element, is
usually to open an “edit value” dialog. This action is canceled when PreventDefault
is set to 'True'.
PreventDefault is typically set to 'True' in components that mimics interactive
controls such as check boxes and spin buttons. In such components, the value is
set in a JavaScript using the setValue function.

Figure: TGML code contianing a Bind element that dynamically presents a text

Figure: This TGML code example shows Bind that will be enabled/disabled on the
OnMouseOver event.
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34.22

TGML Value Conversion:
<ConvertValue>
ConvertValue specifies how a server variable (signal) value is to be converted to a
TGML element attribute value. A ConvertValue element belongs to the immediate
parent Bind element.
A ConvertValue rule is only executed when each of the specified conditions are
fulfilled.

Figure: TGML code containing a ConvertValue element where the attribute is set to
#00FF00 (green) when the signal value is more than 18 and less than or equal to 22

Figure: A rule can never be fulfilled (and thus, never executed) if the signal value is both
equal to 0 and more than 10

Table: ConvertValue element attributes
Attribute

Type

Description

AttributeValue

String (untyped)

The attribute value that is to
be set (resulting value). The
type is determined by the
bound Attribute (referenced
by the Bind element).
Inheritable: No
Animatable: No

SignalEqualTo

String (untyped)

Corresponds to "="
Inheritable: No
Animatable: No

SignalMoreThan

String (untyped)

Corresponds to ">"
Inheritable: No
Animatable: No

SignalMoreOrEqualTo

String (untyped)

Corresponds to ">="
Inheritable: No
Animatable: No

SignalLessThan

String (untyped)

Corresponds to "<"
Inheritable: No
Animatable: No

SignalLessOrEqualTo

String (untyped)

Corresponds to "<="
Inheritable: No
Animatable: No
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Attribute

Type

Description

Figure: TGML code containing ConvertValue element

Figure: ConvertValue element on screen

Figure: TGML code containing ConvertValue element

Figure: ConvertValue element on screen
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34.23

TGML Text Value Conversion:
<ConvertText>
ConvertText specifies how a server variable (signal) value is to be converted to a
TGML element attribute value. ConvertText assumes that the signal value is a text.
A ConvertText element belongs to the immediate parent Bind element.
A ConvertText rule is executed when the signal value matches the specified text
(SignalEqualTo).
Table: ConvertText element attributes
Attribute

Type

Description

AttributeValue

String (untyped)

The attribute value that is to
be set (resulting value). The
type is determined by the
bound Attribute (referenced
by the Bind element).
Inheritable: No
Animatable: No

SignalEqualTo

String

Corresponds to "="
Inheritable: No
Animatable: No
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34.24

TGML Value Range Conversion:
<ConvertRange>
ConvertRange specifies how a server variable (signal) value shall be converted to a
TGML element attribute value using min and max values. A ConvertRange element
belongs to the immediate parent Bind element.
A ConvertRange rule is executed when the signal value is within the specified range.
Table: ConvertRange element attributes
Attribute

Type

Description

AttributeMax Value

String (untyped)

The upper bound of the
attribute value. The
referenced attribute
(referenced by the Bind
element) will be set to this
value when the signal value is
more than or equal to
SignalMaxValue.
Inheritable: No
Animatable: No

AttributeMin Value

String (untyped)

The lower bound of the
attribute value. The
referenced attribute
(referenced by the Bind
element) will be set to this
value when the signal value is
less than or equal to
SignalMinValue.
Inheritable: No
Animatable: No

SignalMax Value

String (untyped)

The upper bound of the
signal value.
Inheritable: No
Animatable: No

SignalMin Value

String (untyped)

The lower bound of the
signal value.
Inheritable: No
Animatable: No

Figure: TGML code containing a ConvertRange element that calculates an attribute value
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Figure: ConvertRange element on screen
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34.25

TGML Custom Conversion:
<ConvertCustom>
ConvertCustom defines a custom conversion of a signal value. The ConvertCustom
element is a script element with a JavaScript function named 'convert'.

Figure: JavaScript convert function

The function takes one parameter which is the signal value and returns a converted
value.
The user can insert any valid JavaScript code in the function body to accomplish a
value conversion

Figure: TGML code containing a ConvertCustom element.
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34.26

TGML Status Conversion:
<ConvertStatus>
ConvertStatus specifies how the status of a server variable (signal) value is to be
converted to a TGML element attribute value. A ConvertStatus element belongs to
the immediate parent Bind element.
ConvertStatus is executed when the status of the value is different from “normal”,
which means when the status value is 0, 1 or 3.
ConvertStatus can be combined with other converters (for example, ConvertValue
and ConvertRange) but the converters are executed in the same order as they are
specified. The ConvertStatus should be placed last if it is combined with other
converters.
Table: ConvertStatus element attributes
Attribute

Type

Description

Error

String (untyped)

The attribute value that is to
be set when the status is 0
(Error). The type is
determined by the bound
Attribute (referenced by the
Bind element).
Inheritable: No
Animatable: No

Stored

String (untyped)

The attribute value that is to
be set when the status is 1
(Stored value). The type is
determined by the bound
Attribute (referenced by the
Bind element).
Inheritable: No
Animatable: No

Forced

String (untyped)

The attribute value that is to
be set when the status is 3
(Forced value). The type is
determined by the bound
Attribute (referenced by the
Bind element).
Inheritable: No
Animatable: No
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34.27

TGML Basic Shapes
The TGML specification contains a number of basic shapes.

34.27.1

Shape Attributes
The following table describes the common attributes of the basic shapes.
Attribute

Type

Description

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" will result in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

34.27.2

Line: <Line>
The Line element describes a straight line between two points.

34.27.3

Polyline: <Polyline>
The Polyline element describes a series of connected straight lines.

34.27.4

Polygon: <Polygon>
The Polygon element describes a polygon, which is a connected series of lines that
forms a closed shape. The end point does not have to be specified. The polygon is
closed automatically.

34.27.5

Rectangle: <Rectangle>
The Rectangle element defines a rectangle. Rounded rectangles can be achived by
setting values for the attributes RadiusX and RadiusY.

34.27.6

Ellipse: <Ellipse>
The Ellipse element defines an ellipse.
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34.28

TGML Line: <Line>
The Line element describes a straight line between two points.
Table: Line element attributes
Attribute

Type

Description

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

X1

Double

The x coordinate of the line
start point.
Default: "0"
Inheritable: No
Animatable: Yes

X2

Double

The x coordinate of the line
end point.
Default: "0"
Inheritable: No
Animatable: Yes

Y1

Double

The y coordinate of the line
start point.
Default: "0"
Inheritable: No
Animatable: Yes

Y2

Double

The y coordinate of the line
end point.
Default: "0"
Inheritable: No
Animatable: Yes

Figure: TGML code containing a Line element

Figure: Line element on screen
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34.29

TGML Polyline: <Polyline>
The Polyline element describes a series of connected straight lines.
Table: Polyline element attributes
Attribute

Type

Description

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

Points

Array of Point

The vertex points of the
polyline:
"<x1>,<y1> <x2>,<y2>..."
Inheritable: No
Animatable: No

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Figure: TGML code containing a Polyline element

Figure: Polyline element on screen.

04-16006-04-en, March 2015

Technical
1061

34 Graphics TGML Format Specification
34.30 TGML Polygon: <Polygon>

34.30

TGML Polygon: <Polygon>
The Polygon element describes a polygon, which is a connected series of lines that
forms a closed shape. The end point does not have to be specified. The polygon is
closed automatically.
Table: Polygon element attributes
Attribute

Type

Description

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

Points

Array of Point

The vertex points of the
polygon:
"<x1>,<y1> <x2>,<y2>..."
Inheritable: No
Animatable: No

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Figure: TGML code containing a Polygon element

Figure: Polygon element on screen
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34.31

TGML Rectangle: <Rectangle>
The Rectangle element defines a rectangle. Rounded rectangles can be achived by
setting values for the attributes RadiusX and RadiusY.
Table: Rectangle element attributes
Attribute

Type

Description

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Height

Double

The height of the rectangle.
Inheritable: No
Animatable: Yes

Left

Double

The x coordinate of the
upper left corner of the
rectangel.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

RadiusX

Double

For rounded rectangles. The
x axis radius of the ellipse
used to round off the corners
of the rectangle.
Default: "0"
Inheritable: No
Animatable: Yes

RadiusY

Double

For rounded rectangles. The
y axis radius of the ellipse
used to round off the corners
of the rectangle.
Default: "0"
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Top

Double

The y coordinate of the
rectangles upper left corner.
Default: "0"
Inheritable: No
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Width

Double

The width of the rectangle.
Inheritable: No
Animatable: Yes
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Attribute

Type

Description

Figure: TGML code containing a Rectangle element

Figure: Rectangle element on screen
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34.32

TGML Ellipse: <Ellipse>
The Ellipse element defines an ellipse.
Table: Ellipse element attributes
Attribute

Type

Description

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Height

Double

The height of the ellipse.
Inheritable: No
Animatable: Yes

Left

Double

The x coordinate of the
upper left corner of the
ellipse.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Top

Double

The y coordinate of the
upper left corner of the
ellipse.

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Width

Double

The width of the ellipse.
Inheritable: No
Animatable: Yes

Figure: TGML code containing an Ellipse element
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Figure: Ellipse element on screen
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34.33

TGML Segment Shapes
The TGML specification defines a number of shapes that are segments of an ellipse.

34.33.1

Elliptical Arc: <Arc>
Arc defines an elliptical arc. The elliptical arc is part of an ellipse.

34.33.2

Elliptical Pie: <Pie>
Pie defines an elliptical pie slice. Pie is similar to Arc.

34.33.3

Elliptical Chord: <Chord>
Chord defines an elliptical chord. Chord is similar to Pie and Arc.
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34.34

TGML Elliptical Arc: <Arc>
Arc defines an elliptical arc. The elliptical arc is part of an ellipse.

Figure: Elliptical Arc

Table: Arc element attributes
Attribute

Type

Description

Center

Point

The center point of the
ellipse.
Default: "0.0 , 0.0"
Inheritable: No
Animatable: Yes

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

RadiusX

Double

The horizontal radius of the
ellipse.
Inheritable: No
Animatable: Yes

RadiusY

Double

The vertical radius of the
ellipse.
Inheritable: No
Animatable: Yes

04-16006-04-en, March 2015

Technical
1071

34 Graphics TGML Format Specification
34.34 TGML Elliptical Arc: <Arc>

Continued
Attribute

Type

Description

StartAngle

Double

Specifies the angle between
the x axis and the starting
point of the arc.
Default: "0.0"
Inheritable: No
Animatable: Yes

SweepAngle

Double

Specifies the angle between
the starting and ending
points of the arc.
Default: "0.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes
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34.35

TGML Elliptical Pie: <Pie>
Pie defines an elliptical pie slice. Pie is similar to Arc.

Figure: Elliptical Pie

Table: Pie element attributes
Attribute

Type

Description

Center

Point

The center point of the
ellipse.
Default: "0.0 , 0.0"
Inheritable: No
Animatable: Yes

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

RadiusX

Double

The horizontal radius of the
ellipse.
Inheritable: No
Animatable: Yes

RadiusY

Doubel

The vertical radius of the
ellipse.
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

StartAngle

Double

Specifies the angle between
the x axis and the starting
point of the arc.
Default: "0.0"
Inheritable: No
Animatable: Yes

SweepAngle

Double

Specifies the angle between
the starting and ending
points of the arc.
Default: "0.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes
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34.36

TGML Elliptical Chord: <Chord>
Chord defines an elliptical chord. Chord is similar to Pie and Arc.

Figure: Elliptical Chord

Table: Chord element attributes
Attribute

Type

Description

Center

Point

The center point of the
ellipse.
Default: "0.0 , 0.0"
Inheritable: No
Animatable: Yes

Fill

Brush

Specifies how the interior of
the shape is painted.
Default: "None"
Inheritable: Yes
Animatable: Yes

Opacity

Double

A value between "0.0"
(transparent) and "1.0"
(opaque)
Default: "1.0"
Inheritable: No
Animatable: Yes

RadiusX

Double

The horizontal radius of the
ellipse.
Inheritable: No
Animatable: Yes

RadiusY

Double

The vertical radius of the
ellipse.
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

StartAngle

Double

Specifies the angle between
the x axis and the starting
point of the arc.
Default: "0.0"
Inheritable: No
Animatable: Yes

SweepAngle

Double

Specifies the angle between
the starting and ending
points of the arc.
Default: "0.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Describes how the line is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

StrokeDashArray

Array of Double

The pattern of dashes and
gaps used to outline shapes:
"<dash> [ <gap> <dash>
<gap>...]"
If the array only specifies the
first dash, the line is
patterned as if a gap with the
same length as the dash was
specified.
An array with only one dash
set to "0" results in a line
without any pattern.
Default: "0"
Inheritable: Yes
Animatable: Yes

StrokeWidth

Double

The width of the outline of a
line.
Default: "1"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Technical
1076

04-16006-04-en, March 2015

34 Graphics TGML Format Specification
34.37 TGML Gradients

34.37

TGML Gradients
Gradients consist of continuously smooth color transitions along a vector from one
color to another. TGML provides for two types of gradients, linear gradients and
radial gradients.

34.37.1

Linear Gradient: <LinearGradient>
The LinearGradient creates a linear gradient brush for the stroke or fill area of the
immediate parent.

34.37.2

Radial Gradient: <RadialGradient>
RadialGradient defines a radial gradient brush for the stroke or fill area of the
immediate parent.

34.37.3

Gradient Stop: <GradientStop>
The GradientStop describes the location and color of a transition point in a gradient.
GradientStop belongs to its immediate parent gradient element.
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34.38

TGML Linear Gradient: <LinearGradient>
The LinearGradient creates a linear gradient brush for the stroke or fill area of the
immediate parent.
LinearGradient works in conjunction with gradient stops (see 19.3 Gradient stop),
which describe the location and color of transition points in gradients.
Table: LinearGradient element attributes
Attribute

Type

Description

Attribute

String

The brush attribute of the
parent ("Fill" or "Stroke")
Inheritable: No
Animatable: No

EndPoint

Point

The ending coordinates of
the linear gradient
Default: "1.0 , 0.0"
Inheritable: Yes
Animatable: Yes

SpreadMethod

SpreadMethod

Specifies how the gradient
should be drawn outside of
the specified gradient vector
or space
Default: "Pad"
Inheritable: Yes
Animatable: Yes

StartPoint

Point

The starting coordinates of
the linear gradient
Default: "0.0 , 0.0"
Inheritable: Yes
Animatable: Yes

Remarks
StartPoint and EndPoint specify the starting and ending coordinates of the linear
gradient. "0.0 , 0.0" represents the upper left corner of the element and "1.0 , 1.0"
represents the lower right corner.
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Figure: StartPoint set to "0.0 , 0.0" and EndPoint set to "1.0 , 1.0

Figure: Different SpreadMethod values
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34.39

TGML Radial Gradient: <RadialGradient>
RadialGradient defines a radial gradient brush for the stroke or fill area of the
immediate parent.
RadialGradient works in conjunction with gradient stops, which describe the
location and color of transition points in gradients.
Table: RadialGradient element attributes
Attribute

Type

Description

Attribute

String

The brush attribute of the
parent ("Fill" or "Stroke")
Inheritable: No
Animatable: No

Center

Point

The center of the circle of the
radial gradient
Default:"0.5 , 0.5"
Inheritable: Yes
Animatable: Yes

Focus

Point

The location of the focal
point that defines the
beginning of the gradient
Default:"0.5 , 0.5"
Inheritable: Yes
Animatable: Yes

RadiusX

Double

The horizontal radius of the
circle of the radial gradient
Default:"0.5"
Inheritable: Yes
Animatable: Yes

RadiusY

Double

The vertical radius of the
circle of a radial gradient
Default:"0.5"
Inheritable: Yes
Animatable: Yes

SpreadMethod

SpreadMethod

Specifies how the gradient
should be drawn outside of
the specified gradient vector
or space
Default: "Pad"
Inheritable: Yes
Animatable: Yes
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Attribute

Type

Description

Remarks
The RadialGradient element is similar in programming model to the LinearGradient
element. To define the gradient behavior, the RadialGradient element has a circle
along with a focal point instead of start and end points. The focal point defines the
beginning of the gradient and the circle defines the end point of the gradient. Radial
gradient only supports the spread method Pad in TGML version 1.0.

Figure: RadialGradient element
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34.40

TGML Gradient Stop: <GradientStop>
The GradientStop describes the location and color of a transition point in a gradient.
GradientStop belongs to its immediate parent gradient element.
Table: GradientStop element attributes
Attribute

Type

Description

Color

Color

The color of the gradient
stop
Inheritable: Yes
Animatable: yes

Offset

Double

The location of the gradient
stop within the gradient
Inheritable: Yes
Animatable: Yes

Figure: The relations between the StartPoint/EndPoint of the LinearGradient element and
the Color/Offset of the GradientStop element

Figure: TGML code containing LinearGradient with GradientStop elements
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Figure: LinearGradient with GradientStop elements on screen

Figure: TGML code containing RadialGradient with GradientStop elements

Figure: RadialGradient with GradientStop elements on screen
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34.41

TGML Grouping Elements
With TGML there are several ways to collect elements in a common container
element.

34.41.1

Grouping: <Group>
The Group element is a container element, used for grouping elements together so
they can, for example, be moved, copied and resized as if they were a single
element.

34.41.2

Components: <Component>
The Components element is a container element (similar to Group) which defines a
reusable group of elements.

34.41.3

Layers: <Layer>
The Layer element is a container element used to create layered TGML graphics.
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34.42

TGML Grouping: <Group>
The Group element is a container element, used for grouping elements together so
they can, for example, be moved, copied and resized as if they were a single
element.
Table: Group element attributes
Attribute

Type

Description

Opacity

Double

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Visibility

Visibility

Specifies if the element shall
be visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Figure: TGML code containing a group element
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34.43

TGML Components: <Component>
The Components element is a container element (similar to Group) which defines a
reusable group of elements.
Top and Left of Component specifies the position of the component in the parent
coordinate system. Component itself establishes a new coordinate system for the
contained elements, which means that the upper left corner of Component is the
origin (0,0) for the contained elements.
Width and Height specifies the "viewport" (size on screen) of the component.
ContentWidth and ContentHeight specify the "viewbox", which is the boundary of
the contained elements. If the viewport is different from the viewbox, a scale
transformation is applied by the TGML implementation (similar to Stretch="Fill", see
7.1 Document type element). In other words, resizing a Component has the effect
of scaling the content of the Component.
The Clip attribute specifies if the renderer shall clip elements that exceed (are drawn
outside) the specified viewbox or not.
When a Component includes Bind or Link elements, the Name of Component will
prefix the exposed bind names ("MyComponent.MyBind").
Table: Component element attributes
Attribute

Type

Description

Clip

Bool

Specifies if the content shall
be clipped or not.
Default: "True"
Inheritable: No
Animatable: No

ContentHeight

Double

Specifies the viewbox height
(height of the content).
Inheritable: No
Animatable: No

ContentWidth

Double

Specifies the viewbox width
(width of the content).
Inheritable: No
Animatable: No

Height

Double

The viewport height of the
component (height on
screen).
Inheritable: No
Animatable: Yes

Left

Double

The x coordinate of the
component's upper left
corner.
Default: "0"
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

Opacity

Double

A value between 0.0
(transparen) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Top

Double

The y coordinate of the
components upper left
corner.
Default: "0"
Inheritable: No
Animatable: Yes

Visibility

Visibility

Specifies if the element shall
be visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Width

Double

The viewport width of the
component (width on
screen).
Inheritable: No
Animatable: Yes

Figure: TGML code containing a component element

Figure: TGML component element on screen
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34.44

TGML Layers: <Layer>
The Layer element is a container element used to create layered TGML graphics.
Only the TGML root element can contain Layer elements, which means that nested
layers are not supported.
Layer elements cannot be transformed. Child transformation elements will have no
effect on the Layer element.
Table: Layer element attributes
Attribute

Type

Description

Opacity

Double

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "0"
Inheritable: No
Animatable: Yes

Visibility

Visbility

Specifies if the element is
visible or not.
Default: "Visibile"
Inheritable: No
Animatable: Yes

Figure: TGML code containing two layer elements
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34.45

TGML Link element: <Link>
Link represents a hyperlink to another presentation stored in the database, or file
system, of the connected server. Examples of presentation objects are: TGML
graphics files, trend log views and on-line plots.

Figure: Example of a text made into a link object

Link indicates that the immediate parent shape or container element is a hyperlink
object, which the user can click to navigate to another presentation.
A Link is bound to a presentation object on the server with the same technique
used for Dynamics. The Name attribute of the Link element is exposed as a
connection point to which the presentation object is connected in WorkStation. For
more information, see section 34.20 “TGML Dynamics” on page 1042.
The Link element has a Description attribute that you can use to add a description
of the link. You can expose Description along with Name and present it to the user
by binding it in WorkStation.
Link makes the parent element an interactive element, and a TGML viewer is
supposed to open the linked presentation object when the user clicks the element.
Table: Link element attributes
Attribute

Type

Description

Description

String

A user-defined description of
the link.
Inheritable: No
Animatable: No

PreventDefault

Bool

Cancels the default action
normally taken by the
implementation, for example
the viewer.
Default: "False"
Inheritable: Yes
Animatable: No

Remarks
The default action when the user clicks an element containing a Link element is to
navigate to, or open, another presentation. When PreventDefault is set to "True" this
action is canceled.
Only painted regions are clickable. Clicking a hollow shape, that is a shape with the
Fill attribute set to "None", has no effect.
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34.46

TGML Raster Images
TGML defines raster images and an animated raster image.

34.46.1

Image Element: <Image>
Image represents a raster image. Image supports JPEG and PNG images.

34.46.2

Animated Images (GIF89a): <Animated
Image>
Animated image represents an animated raster image. AnimatedImage supports
the GIF89a format.
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34.47

TGML Image Element: <Image>
Image represents a raster image. Image supports JPEG and PNG images.
The image data is stored as a Base64 encoded string in the CDATA section of the
Image element.

Figure: TGML code containing an Image element

The image data is accessible through the Content attribute which means that it can
be bound and dynamically updated in View mode.
Table: Image element attributes
Attribute

Type

Description

Content

String

The image data (Base64
encoded).
Inheritable: No
Animatable: Yes

Height

Double

The height of the image.
Inheritable: No
Animatable: Yes

Left

Double

The x coordinate of the
upper left corner of the
image.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Double

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Top

Double

The y coordinate of the
upper left corner of the
image.
Default: "0"
Inheritable: No
Animatable: Yes
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Continued
Attribute

Type

Description

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Width

Double

The width of the image.
Inheritable: No
Animatable: Yes
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34.48

TGML Animated Images (GIF89a):
<AnimatedImage>
Animated image represents an animated raster image. AnimatedImage supports
the GIF89a format.
The Animation attribute starts and stops the animation.
The image data is stored as a Base64-encoded string in the CDATA section of the
AnimatedImage element. The image data is accessible through the Content
attribute.
Table: Animated Image element attributes
Attribute

Type

Description

Content

String

The image data (Base64
encoded).
Inheritable: No
Animatable: Yes

Height

Double

The height of the image.
Inheritable: No
Animatable: Yes

Left

Double

The x coordinate of the
upper left corner of the
image.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Double

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Top

Double

The y coordinate of the
upper left corner of the
image.
Default: "0"
Inheritable: No
Animatable: Yes

Visibility

Visibility

Specifies if the element is
visible or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

04-16006-04-en, March 2015

Technical
1093

34 Graphics TGML Format Specification
34.48 TGML Animated Images (GIF89a): <AnimatedImage>

Continued
Attribute

Type

Description

Width

Double

The width of the image.
Inheritable: No
Animatable: Yes

Animation

Animation

Starts and stops the
animation.
Default: "Start"
Inheritable: No
Animatable: Yes
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34.49

TGML Scripting
TGML supports the script language JavaScript 1.5. A JavaScript editor is available
in Graphics Editor. You can use the JavaScript edtor to access the elements and
their attributes in View mode. The script engine does not run in Edit mode.
The DOM (the elements and their attributes) is accesed using DOM methods such
as getCurrentTarget, getAttribute, and setAttribute.
Apart from accessing the DOM, it is also possible to interact with the TGML Viewer,
and thus the underlying system, using Building Operation-specific JavaScript
functions such as setValue and execute.
The execution of the scripts is event driven. Event attributes are used to specify the
event and a function name. The function is executed in View mode when the
specified event is raised.

34.49.1

Script Element: Script
Script defines a script block that belongs to the immediate parent element.

34.49.2

Target Area Element: TargetArea
TargetArea represents a clickable area in a graphic. Target area is not painted, that
is, it is always invisible.

Global Variables
Variables declared outside the Java script functions are global within the script
block. The global variables exist while the TGML document is displayed (executed)
in Dynamic mode.
The global variables can only be accessed by the functions that are defined in the
same script block.

About Data Types
Java script variables are untyped. If you, for example, use global variables or
custom attributes to store numeric values: Convert the variables to a Number.
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Figure: TGML code with an example of how you can convert a varible to a number

Common Event Methods

Technical
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Method

Description

getCurrentTarget()

Returns the element the Script belongs to.
That is, the EventTarget whose
EventListeners are currently being
processed.

getTarget()

Returns the element to which the event was
originally dispatched. For example, the
element you clicked.

preventDefault()

If the event is cancelable, preventDefault
cancels the default action normally taken by
the implementation, for example, the viewer.

stopPropagation

Prevents further propagation of an event.
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Method

Description

When an element contains Bind or Link, the viewer is supposed to respond when
the user clicks the element. The viewer is supposed to respond by showing a
change value dialog box or opening the linked presentation object. This is the
viewer default action that is canceled by the preventDefault function.
preventDefault in an OnMouseClick function cancels the change value dialog box
(when the element contains a Bind) or the link function (when the element contains
a Link).
preventDefault in an OnSignalChange function cancels the error indication indicated
by a red cross.

Figure: TGML code with a scipts containing getTarget() and getCurrentTarget() methods

Mouse Event Methods
Method

Description

getButton()

Returns an integer describing which button
was pressed or released. Applicable for
MouseDownEvent and MouseUpEvent.
0 = Left button, 1 = Middle button, and 2 =
Right button.

getClientX()

Returns the X coordinate of the cursor,
relative the origin of the target coordinate
system.
The coordinate is calculated using the
transformations of the target element.

getClientY()

Returns the Y coordinate of the cursor,
relative the origin of the target coordinate
system.
The coordinate is calculated using the
transformations of the target element.
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Continued
Method

Description

getCurrentTargetX()

Returns the X coordinate of the cursor,
relative the origin of the current target
coordinate system.
The coordinate is calculated using the
transformations of the current target element

getCurrentTargetY()

Returns the Y coordinate of the cursor,
relative the origin of the current target
coordinate system.
The coordinate is calculated using the
transformations of the current target
element.

getCurrentTargetParentX()

Returns the X coordinate of the cursor,
relative the origin of the current target's
parent coordinate system.
The coordinate is calculated using the
transformations of the current target's
parent.

getCurrentTargetParentY()

Returns the Y coordinate of the cursor,
relative the origin of the current target's
parent coordinate system.
The coordinate is calculated using the
transformations of the current target's
parent.

getScreenX()

Returns the X coordinate of the cursor,
relative to the origin of the document
coordinate system.

getScreenY()

Returns the Y coordinate of the cursor,
relative to the origin of the document
coordinate system.

SignalChange Event Methods
Method

Description

getStatus()

Returns the status of the signal:
0: Error (Bad quality)
1: Stored value (Uncertain quality)
2: Real value (Good quality).3: Forced value
(Good quality)
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getPresentationValue()

Returns the value of the bound signal as a
presentation value.

getUnit()

Returns the unit of the bound signal as a
string.

getValue()

Returns the value of the bound signal.
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Method

Description

TGML DOM Methods
Object

Mehtod

Description

Any element

getChild ("‹name›")

Returns the immediate child
element that has the Name
attribute with the given value.
If no such child exists, this
returns null. If more than one
immediate child element has
a Name attribute with that
value, what is returned is
undefined.

Any element

getChildRecursive ("‹name›")

Returns the child element at
any level that has the Name
attribute with the given value.
If no such element exists, this
returns null. If more than one
element has a Name
attribute with that value, what
is returned is undefined.

Any element

getFullBindName()

Returns the exposed name
of the Bind or Link element,
including names of parent
components.

Figure: TGML code with a script containing a getFullBindName() method

Standard DOM Methods
These standard methods are commonly used. the W3C Document Object Model
(DOM), Level 3 Core Specifications.
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Method

Description

Any element

getAttribute("‹attribute›")

Returns the value of
‹attribute›
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Continued
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Object

Method

Description

Any element

getChildNodes()

Returns a NodeList that
contains all children of this
node

Any element

getOwnerDocument()

Returns the document

Any element

getParentNode()

Returns the parent element

Any element

getTagName()

Returns the element tag
name, e.g. Rectangle or Bind

Any element

setAttribute("‹attribute›",
"‹value›")

Sets the value of ‹attribute› to
‹value›. If the element does
not have the attribute, it is
created as a TGML custom
attribute.

Document

getDocumentElement()

Returns the TGML (root)
element

Document

getElementById("‹Id›")

Returns the child element
that has the Id attribute with
the given value

Document

getElementsByTagName
("‹tagName›")

Returns a NodeList of all the
elements in document order
with a given tag name

NodeList

getLength()

Returns the number of
elements in the NodeList

NodeList

item("‹index›")

Returns the element at
‹index› in the NodeList
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Object

Method

Description

Figure: TGML code with a script containing getAttribute() and setAttribute() methods

TGML JavaScript Functions
Method

Description

alert("<messages>")

Displays a message box

clearInterval(intervalID)

Cancels the previously started interval using
the setInterval function.
intervalID is an identifier returned by a
previous call to the setInterval function.

clearTimeout(timeoutID)

Cancels a time-out that was set with the
setTimeout function.
timeoutID is an identifier returned by a
previous call to the setTimeout function.

confirm("<message>")

Displays a confirm box with "Yes" and "No"
buttons.
Returns true if the user clicks "Yes" or false if
the user clicks "No".
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Continued
Method

Description

execute("<commande>"),
execute("<command>", "<options>")

Requests an execute operation to be
performed by the TGML viewer (start a
Windows program).
command is the name of the program (full
path) and options is the command line
options.
Returns true if succeeded or false if failed.
Note: The implementation of this function is
system dependent. May not be implemented
in some systems.

invoke("<bindingName>", "<operation>")

Requests an operation to be performed on a
bound object by the TGML viewer. The
bindingName is the full name (as it is
exposed to the binding tools) of a Bind or
Link element.
Returns true if succeeded or false if failed.
Note: The implementation of this function is
system dependent. May not be implemented
in some systems.

openFile("<path>", "<operation>")

Request the TGML viewer to open a file. The
operation is typical Windows object verbs.
Returns true if succeeded or false if failed.
Note: The implementation of this function is
system dependent. May not be implemented
in some systems.

prompt("<message>", "<defaultValue>")

Prompts the user to enter a value.
Returns the entered value or null if canceled.

setForce("<bindingName>", "<true|false>")|

Sets the force state of a bound signal object.
The bindingName is the full name (as it is
exposed to the binding tools) of a Bind
element.
Returns true if succeeded or false if failed.
Note: The implementation of this function is
system dependent. May not be implemented
in some systems.

setInterval("<expression>", "<milliseconds>") Evaluates (executes) the expression each
time the specified number of milliseconds
has elapsed.
Returns an identifier that cancels the timer
with the clearInterval method.
setTimeout("<expression>",
"<milliseconds>")

Evaluates (executes) the expression after the
specified number of milliseconds has
elapsed.
Returns an identifier that cancels the timer
with the clearTimeout method.

Technical
1102

04-16006-04-en, March 2015

34 Graphics TGML Format Specification
34.49 TGML Scripting

Continued
Method

Description

setValue("<bindingName>", "<value>")

Sets the value of a bound signal object. The
bindingName is the full name (as it is
exposed to the binding tools) of a Bind
element.
Returns true if succeeded or false if failed.
Note: The implementation of this function is
system dependent. May not be implemented
in some systems.

Figure: TGML code containing a rectangle that toggles a value
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Figure: Rectangle that toggles a value on screen

Figure: TGML code that starts an interval timer and animates (toggles) the fill color when
the pointer is placed over the rectangle. The timer is stopped and the color is restored
when the pointer is moved from the rectangle.

Figure: TGML code where an alert box is displayed when the pointer is held over the
rectangle for one second. The timer is stopped wehn the pointer is moved from the
rectangle.

JavaScript 1.5
ECMAScript Language Specification, Rev. 3.
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34.50

TGML Script Element: Script
Script defines a script block that belongs to the immediate parent element.
Specifying an event attribute on the Script element makes the parent element the
target for the specified event. For example, if OnMouseClick and the function
name "click" are specified, the click function is executed when the user clicks the
parent element (assuming that the element is a visible graphical element).
If the parent element of Script is a container element, such as Component, the
mouse event is sent when any of the contained graphical elements are hit. The hit
element is the target, while the parent element, which handles the event, is the
current target.
The functions are always defined with an in parameter. The parameter is a reference
to the event object that can be used to get event specific information and to access
the DOM, starting with getTarget or getCurrentTarget.
Each Script element (script block) creates a JavaScript context. Function calls
between script blocks (contexts) are not supported, that is, no support for global
script functions.
The script functions are stored in the CDATA section of the Script element. The
CDATA section is accessible through the Content attribute.
Table: Script element attribute
Attribute

Type

Descirption

Content

String

The script.
Inheritable: No
Animatable: No

Table: Events and event attributes
Event Attribute

Event Type

Target

OnDocumentLoad DocumentLoadEvent Any element

Desciption
The TGML document
is uploaded (opened).
Cancelable: No

OnMouseClick

MouseClickEvent

Painted element

A mouse button is
clicked over an
element.
Cancelable: Yes

OnMouseDown

MouseDownEvent

Painted element

A mouse button is
pressed over an
element.
Cancelable: Yes

OnMouseUp

MouseUpEvent

Painted element

A mouse button is
released over an
element.
Cancelable: Yes
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Continued
Event Attribute

Event Type

Target

Desciption

OnMouseOver

MouseOverEvent

Painted element

The pointer is moved
onto an element.
Cancelable: Yes

OnMouseMove

MouseMoveEvent

Painted element

The pointer is moved
while it is over an
element.
Cancelable: Yes

OnMouseOut

MouseOutEvent

Painted element

The pointer is moved
away from an
element.
Cancelable: Yes

OnSignalChange

SignalChangeEvent

Bind element

The value of the
bound signal has
been changed.
The referenced
attribute in the Bind
element is updated
before the event is
sent.
Cancelable: Yes

Figure: TGML code containing a Script element with an OnMouseClick attribute event

Figure: Script element on screen
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34.51

TGML Target Area Element:
<TargetArea>
TargetArea represents a clickable area in a graphic. Target area is not painted, that
is, it is always invisible.
You do not have to use TargetArea to be able to handle mouse events. All of the
graphical (painted) elements can be targets of mouse events. Use TargetArea when
you need an invisible but clickable area.
Table: TargetArea element attributes
Attribute

Type

Description

Height

Double

The height of the area.
Inheritable: No
Animatable: Yes

Length

Double

The x-coordinate of the
area's upper left corner.
Default: "0"
Inheritable: No
Animatable: Yes

Top

Double

The y-coordinate of the
area's upper left corner.
Default: "0"
Inheritable: No
Animatable: Yes

Width

Double

The width of the area.
Inheritable: No
Animatable: Yes

You can use TargetArea to create a mouse-sensitive area that covers the whole
Component.
Without the TargetArea, the MouseOver and MouseOut events are sent every
time the cursor passes the contained elements when the Script is defined at the
Component level. The TargetArea has the effect of "hiding" the contained shapes
and you only get one MouseOver and one MouseOut when the cursor passes the
Component.
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Figure: TGML code containing a TargetArea element and an OnMouseOut attribute event

Figure: TGML code fragment containing an invisible link area that can be placed above
other shapes
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34.52

TGML Text
TGML supports two types of text elements: Text and TextBox.
Figure: The character data (the text) is stored within the Text element as XML element
content.

The character data is accessible through the Content attribute which means that it
is possible to cerate dynamic texts by animating or binding the Content attribute.

34.52.1

Text Line: <Text>
Text defines a graphics element consisting of text. Each Text element causes a
single string of text to be rendered. The Text element perfoms no automatic line
break or word wrapping.

34.52.2

Text Flow: <TextBox>
Text defines a graphics element consisting of text. TextBox wraps the text within
the specified box. The TextBox element also supports manual line breaks (ASCII
character 10).
Table: Common text attributes
Attribute

Type

Description

Content

String

The character data.
Inheritable: No
Animatable: Yes

FontFamily

String

The name of the font or font
family.
Inheritable: Yes
Animatable: Yes

FontSize

Double

The size of the font, in device
independent pixels. For more
information, see section 34.2
“TGML Coordinate System”
on page 1017.
Inheritable: Yes
Animatable: Yes

FontStyle

FontStyle

The style of the font, that is,
Normal or Italic.
Default: "Normal"
Inheritable: Yes
Animatable: Yes
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Attribute

Type

Description

FontWeight

FontWeight

The weight of the font, that
is, Normal or Bold.
Default: "Normal"
Inheritable: Yes
Animatable: Yes

HorizontalAlign

HorizontalAlign

Describes the horizontal
alignment of a text string:
Text: relative to the x
coordinate Left
TextBox: relative the
specified box
Default: "Left"
Inheritable: Yes
Animatable: Yes

Left

Double

The x coordinate of the
upper left corner of the text
area.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Brush

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Specifies how the text is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

TextDecoration

TextDecoration

Specifies decorations that
are added to the text.
Default: "None"
Inheritable: Yes
Animatable: Yes
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Attribute

Type

Description

Top

Double

The y coordinate of the
upper left corner of the text
area.
Default: "0"
Inheritable: No
Animatable: Yes

VerticalAlign

VerticalAlign

Describes the vertical
alignment of a text string:
Text: relative to the x
coordinate Left
TextBox: relative the
specified box
Default: "Top"
Inheritable: Yes
Animatable: Yes

Visibility

Visibility

Specifies if the text is visible
or not.
Default: "Visible"
Inheritable: No
Animatable: Yes
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34.53

TGML Text Line: <Text>
Text defines a graphics element consisting of text. Each Text element causes a
single string of text to be rendered. The Text element perfoms no automatic line
break or word wrapping.
Table: Text element attributes
Attribute

Type

Description

Content

String

The character data.
Inheritable: No
Animatable: Yes

FontFamily

String

The name of the font or font
family.
Inheritable: Yes
Animatable: Yes

FontSize

Double

The size of the font, in device
independent pixels. For more
information, see section 34.2
“TGML Coordinate System”
on page 1017.
Inheritable: Yes
Animatable: Yes

FontStyle

FontStyle

The style of the font, that is,
Normal or Italic.
Default: "Normal"
Inheritable: Yes
Animatable: Yes

FontWeight

FontWeight

The weight of the font, that
is, Normal or Bold.
Default: "Normal"
Inheritable: Yes
Animatable: Yes

HorizontalAlign

HorizontalAlign

Describes the horizontal
alignment of a text string:
Text: relative to the x
coordinate Left
TextBox: relative the
specified box
Default: "Left"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

Left

Double

The x coordinate of the
upper left corner of the text
area.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Double

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Specifies how the text is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

TextDecoration

TextDecoration

Specifies decorations that
are added to the text.
Default: "None"
Inheritable: Yes
Animatable: Yes

Top

Double

The y coordinate of the
upper left corner of the text
area.
Default: "0"
Inheritable: No
Animatable: Yes

VerticalAlign

VerticalAlign

Describes the vertical
alignment of a text string:
Text: relative to the x
coordinate Left
TextBox: relative the
specified box
Default: "Top"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

Visibility

Visibility

Specifies if the text is visible
or not.
Default: "Visible"
Inheritable: No
Animatable: Yes
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34.54

TGML Text Flow: <TextBox>
Text defines a graphics element consisting of text. TextBox wraps the text within
the specified box. The TextBox element also supports manual line breaks (ASCII
character 10).
The text is stored in the CDATA section of the TextBox element.
Table: TextBox element attributes
Attribute

Type

Description

Content

String

The character data.
Inheritable: No
Animatable: Yes

FontFamily

String

The name of the font or font
family.
Inheritable: Yes
Animatable: Yes

FontSize

Double

The size of the font, in device
independent pixels. For more
information, see section 34.2
“TGML Coordinate System”
on page 1017.
Inheritable: Yes
Animatable: Yes

FontStyle

FontStyle

The style of the font, that is,
Normal or Italic.
Default: "Normal"
Inheritable: Yes
Animatable: Yes

FontWeight

FontWeight

The weight of the font, that
is, Normal or Bold.
Default: "Normal"
Inheritable: Yes
Animatable: Yes

HorizontalAlign

HorizontalAlign

Describes the horizontal
alignment of a text string:
Text: relative to the x
coordinate Left
TextBox: relative the
specified box
Default: "Left"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

Left

Double

The x coordinate of the
upper left corner of the text
area.
Default: "0"
Inheritable: No
Animatable: Yes

Opacity

Double

A value between 0.0
(transparent) and 1.0
(opaque).
Default: "1.0"
Inheritable: No
Animatable: Yes

Stroke

Brush

Specifies how the text is
painted.
Default: "#000000"
Inheritable: Yes
Animatable: Yes

TextDecoration

TextDecoration

Specifies decorations that
are added to the text.
Default: "None"
Inheritable: Yes
Animatable: Yes

Top

Double

The y coordinate of the
upper left corner of the text
area.
Default: "0"
Inheritable: No
Animatable: Yes

VerticalAlign

VerticalAlign

Describes the vertical
alignment of a text string:
Text: relative to the x
coordinate Left
TextBox: relative the
specified box
Default: "Top"
Inheritable: Yes
Animatable: Yes
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Continued
Attribute

Type

Description

Visibilty

Visibility

Specifies if the text is visible
or not.
Default: "Visible"
Inheritable: No
Animatable: Yes

Height

Double

The height of the text area.
Inheritable: No
Animatable: Yes

Width

Double

The width of the text area.
Inheritable: No
Animatable: Yes

Figure: TGML code containing a TextBox element

Figure: Textbox element on screen
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34.55

TGML Transformations
Transformation elements control the size, position, rotation and skew of graphic
objects. The transformation establishes a transformed coordinate system for the
immediate parent element.
Transformations are appliced in the same order as they are specified in the TGML
file.
Transformations can be nested to any level. The effect of nested transformations is
to post-multiply, that is, concatenate, the subsequent transformation matrices onto
previously defined transformations.

34.55.1

Rotation: <Rotate>
Rotate rotates the coordinate system for the immediate parent element about a
specified point.

34.55.2

Skewing: <SkewX> and <SkewY>
SkewX and SkewY skew (stretch) the coordinate system for the immediate parent
element about a specified point.

34.55.3

Scaling: <Scale>
Scale scales the coordinate system for the immediate parent element.

34.55.4

Translations: <Translate>
Translate translates (moves) the coordinate system for the immediate parent
element.
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34.56

TGML Rotation: <Rotate>
Rotate rotates the coordinate system for the immediate parent element about a
specified point.
Table: Rotate element attributes
Attribute

Type

Description

Angle

Double

The angle of the rotation,
measured in degrees.
A positive value implies
clockwise rotation. A
negative value implies
counter-clockwise rotation.
Default: "0.0"
Inheritable: No
Animatable: Yes

Center

Point

Describes the position of the
center point ("X,Y") of the
rotation.
"0.0 , 0.0" represents the
upper left corner of the
element and "1.0 , 1.0"
represents the lower right
corner.

Remarks

Figure: Different Center values

Figure: TGML code containg a Rotate element
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34.56 TGML Rotation: <Rotate>

Figure: Rotate element on screen
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34.57 TGML Skewing: <SkewX> and <SkewY>

34.57

TGML Skewing: <SkewX> and <SkewY>
SkewX and SkewY skew (stretch) the coordinate system for the immediate parent
element about a specified point.
Skew X specifies a skew transformation along the X axis. The skew angle is
measured in degrees from the Y axis.
Skew Y specifies a skew transformation along the Y axis. The skew angle is
measured in degrees from the X axis.

Figure: Skewing along the X axis and the Y axis

Table: Skew element attributes
Attribute

Type

Description

Angle

Double

The skew angle, measured in
degrees.
A positive value implies
counterclockwise skew. A
negative value implies
clockwise skew.
Default: "0.0"
Inheritable: No
Animatable: Yes

Center

Point

Describes the position of the
center point of the skew.
For more information, see
section 34.56 “TGML
Rotation: <Rotate>” on page
1117.
Default: "0.5 , 0.5"
Inheritable: No
Animatable: Yes
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34.57 TGML Skewing: <SkewX> and <SkewY>

Attribute

Type

Description

Figure: TGML code containing Skew elements

Figure: Skew elements on screen
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34.58 TGML Scaling: <Scale>

34.58

TGML Scaling: <Scale>
Scale scales the coordinate system for the immediate parent element.
Table: Scale element attributes
Attribute

Type

Description

Center

Point

Describes the position of the
center point (origin) of the
scale.
For more information, see
section 34.56 “TGML
Rotation: <Rotate>” on page
1117.
Default: "0.5 , 0.5"
Inheritable: No
Animatable: Yes

ScaleX

Double

The horizontal scale factor.
Default: "0.0"
Inheritable: No
Animatable: Yes

ScaleY

Double

The vertical scale factor.
Default: "0.0"
Inheritable: No
Animatable: Yes
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34.59 TGML Translations: <Translate>

34.59

TGML Translations: <Translate>
Translate translates (moves) the coordinate system for the immediate parent
element.
Table: Translate element attributes
Attribute

Type

Description

X

Double

Specifies the X direction.
Default: "0.0"
Inheritable: No
Animatable: Yes

Y

Double

Specifies the Y direction.
Default: "0.0"
Inheritable: No
Animatable: Yes

Figure: TGML code containing Translate element

Figure: Translate element on screen
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35 TGML Additions for Building Operation
35.1 TGML Elements

35.1

TGML Elements
TGML supports the listed elements.
TGML Element

Type

Possible parent

Description

<Animate>

Animation

Brush, Container,
Image, Shape,
Transform,
<GradientStop>

Animate animates a
specified attribute of
the immediate parent
element.
For more information,
see section 34.13
“TGML Animation:
<Animate>” on page
1032.

<AnimatedImage>

Image

Container, <Tgml>

Animated image
represents an
animated raster
image.
AnimatedImage
supports the GIF89a
format.
For more information,
see section 34.48
“TGML Animated
Images (GIF89a):
<AnimatedImage>”
on page 1091.

<Arc>

Shape

Container, <Tgml>

Arc defines an
elliptical arc. The
elliptical arc is part of
an ellipse.
For more information,
see section 34.34
“TGML Elliptical Arc:
<Arc>” on page
1069.

<Bind>

Shape

Not in Rule,
<Expose>, <Link>,
<Metadata> or
<Script>

Bind enables a
dynamic
(server/device
controlled) update of
an attribute of the
immediate parent
element.
For more information,
see section 34.21
“TGML Signal
Binding: <Bind>” on
page 1045.
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35.1 TGML Elements

Continued
TGML Element

Type

Possible parent

Description

<Component>

Container

Container, <Tgml>

The Components
element is a
container element
(similar to Group)
which defines a
reusable group of
elements.
For more information,
see section 34.43
“TGML Components:
<Component>” on
page 1084.

<ComponentContent Container
>
<ConvertCustom>

Rule

<Bind>

ConvertCustom
defines a custom
conversion of a signal
value. The
ConvertCustom
element is a script
element with a
JavaScript function
named 'convert'.
For more information,
see section 34.25
“TGML Custom
Conversion:
<ConvertCustom>”
on page 1052.

<ConvertRange>

Rule

<Bind>

ConvertRange
specifies how a
server variable
(signal) value shall be
converted to a TGML
element attribute
value using min and
max values. A
ConvertRange
element belongs to
the immediate parent
Bind element.
For more information,
see section 34.24
“TGML Value Range
Conversion:
<ConvertRange>” on
page 1050.
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35.1 TGML Elements

Continued
TGML Element

Type

Possible parent

Description

<ConvertStatus>

Rule

<Bind>

ConvertStatus
specifies how the
status of a server
variable (signal) value
is to be converted to
a TGML element
attribute value. A
ConvertStatus
element belongs to
the immediate parent
Bind element.
For more information,
see section 34.26
“TGML Status
Conversion:
<ConvertStatus>” on
page 1053.

<ConvertText>

Rule

<Bind>

ConvertText specifies
how a server variable
(signal) value is to be
converted to a TGML
element attribute
value. ConvertText
assumes that the
signal value is a text.
A ConvertText
element belongs to
the immediate parent
Bind element.
For more information,
see section 34.23
“TGML Text Value
Conversion:
<ConvertText>” on
page 1049.

<ConvertValue>

Rule

<Bind>

ConvertValue
specifies how a
server variable
(signal) value is to be
converted to a TGML
element attribute
value. A
ConvertValue
element belongs to
the immediate parent
Bind element.
For more information,
see section 34.22
“TGML Value
Conversion:
<ConvertValue>” on
page 1047.
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35.1 TGML Elements

Continued
TGML Element

Type

Possible parent

Description

<Chord>

Shape

Container, <Tgml>

Chord defines an
elliptical chord.
Chord is similar to Pie
and Arc.
For more information,
see section 34.36
“TGML Elliptical
Chord: <Chord>” on
page 1073.

<Curve>

Shape

Container, <Tgml>

Curve defines a cubic
Bezier curve. The
cubic Bezier curve
has a start point, an
end point, and two
control points. The
control points act as
magnets, pulling the
curve in certain
directions to
influence the way the
Bezier curve bends.
For more information,
see section 34.18
“TGML Cubic Bezier
Curve: <Curve>” on
page 1038.

<Ellipse>

Shape

Container, <Tgml>

The Ellipse element
defines an ellipse.
For more information,
see section 34.32
“TGML Ellipse:
<Ellipse>” on page
1065.

<Expose>

Not in <Script>

Expose indicates that
an attribute of the
immediate parent
element is to be
exposed by the
TGML editor, using
the Name of the
Expose element
instead of the original
attribute name.
For more information,
see section 34.16
“TGML Expose
Element: <Expose>”
on page 1036.
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Continued
TGML Element

Type

<GradientStop>

Brush

Possible parent

Description
The GradientStop
describes the
location and color of
a transition point in a
gradient.
GradientStop
belongs to its
immediate parent
gradient element.
For more information,
see section 34.40
“TGML Gradient
Stop:
<GradientStop>” on
page 1080.

<Group>

Container

Container, <Tgml>

The Group element is
a container element,
used for grouping
elements together so
they can, for
example, be moved,
copied and resized
as if they were a
single element.
For more information,
see section 34.42
“TGML Grouping:
<Group>” on page
1083.

<Image>

Image

Container, <Tgml>

Image represents a
raster image. Image
supports JPEG and
PNG images.
For more information,
see section 34.47
“TGML Image
Element: <Image>”
on page 1089.

<Layer>

Container

<Tgml>

The Layer element is
a container element
used to create
layered TGML
graphics.
For more information,
see section 34.44
“TGML Layers:
<Layer>” on page
1086.
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Continued
TGML Element

Type

Possible parent

Description

<Line>

Shape

Container, <Tgml>

The Line element
describes a straight
line between two
points.
For more information,
see section 34.28
“TGML Line: <Line>”
on page 1056.

<LinearGradient>

Brush

Container, Shape

The LinearGradient
creates a linear
gradient brush for the
stroke or fill area of
the immediate
parent.
For more information,
see section 34.38
“TGML Linear
Gradient:
<LinearGradient>” on
page 1076.

<Link>

Container, Image,
Link represents a
Shape, <TargetArea> hyperlink to another
presentation stored
in the database, or
file system, of the
connected server.
Examples of
presentation objects
are: TGML graphics
files, trend log views
and on-line plots.
For more information,
see section 34.45
“TGML Link element:
<Link>” on page
1087.

<Metadata>

Not in <Metadata> or Each TGML
<Script>
document contains
the TGML root
element. It also
contains metadata
created and
interpreted by the
TGML application.
For more information,
see section 34.10
“TGML Document
Type Element and
Metadata” on page
1028.
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35.1 TGML Elements

Continued
TGML Element

Type

Possible parent

Description

<Path>

Shape

Container, <Tgml>

Path represents the
outline of a shape.
For more information,
see section 34.19
“TGML Path
Element: <Path>” on
page 1040.

<Pie>

Shape

Container, <Tgml>

Pie defines an
elliptical pie slice. Pie
is similar to Arc.
For more information,
see section 34.35
“TGML Elliptical Pie:
<Pie>” on page
1071.

<Polygon>

Shape

Container, <Tgml>

The Polygon element
describes a polygon,
which is a connected
series of lines that
forms a closed
shape. The end point
does not have to be
specified. The
polygon is closed
automatically.
For more information,
see section 34.30
“TGML Polygon:
<Polygon>” on page
1060.

<Polyline>

Shape

Container, <Tgml>

The Polyline element
describes a series of
connected straight
lines.
For more information,
see section 34.29
“TGML Polyline:
<Polyline>” on page
1058.

<RadialGradient>

Brush

Container, Shape

RadialGradient
defines a radial
gradient brush for the
stroke or fill area of
the immediate
parent.
For more information,
see section 34.39
“TGML Radial
Gradient:
<RadialGradient>” on
page 1078.
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Continued
TGML Element

Type

Possible parent

Description

<Rectangle>

Shape

Container, <Tgml>

The Rectangle
element defines a
rectangle. Rounded
rectangles can be
achived by setting
values for the
attributes RadiusX
and RadiusY.
For more information,
see section 34.31
“TGML Rectangle:
<Rectangle>” on
page 1062.

<Rotate>

Transform

Container, Image,
Shape

Rotate rotates the
coordinate system
for the immediate
parent element about
a specified point.
For more information,
see section 34.56
“TGML Rotation:
<Rotate>” on page
1117.

<Scale>

Transform

Container, Image,
Shape

Scale scales the
coordinate system
for the immediate
parent element.
For more information,
see section 34.58
“TGML Scaling:
<Scale>” on page
1121.

<Script>

Container, Image,
Shape, <Bind>,
<TargetArea>,
<Tgml>

Script defines a script
block that belongs to
the immediate parent
element.
For more information,
see section 34.50
“TGML Script
Element: Script” on
page 1103.

<Sequence>

Animation

Container

Sequence plays a
sequence of
graphical elements,
for example, shapes,
text, images, as a
'movie'.
For more information,
see section 34.14
“TGML Sequences:
<Sequence>” on
page 1034.
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Continued
TGML Element

Type

Possible parent

Description

<SkewX>

Transform

Container, Image,
Shape

SkewX and SkewY
skew (stretch) the
coordinate system
for the immediate
parent element about
a specified point.
For more information,
see section 34.57
“TGML Skewing:
<SkewX> and
<SkewY>” on page
1119.

<SkewY>

Transform

Container, Image,
Shape

SkewX and SkewY
skew (stretch) the
coordinate system
for the immediate
parent element about
a specified point.
For more information,
see section 34.57
“TGML Skewing:
<SkewX> and
<SkewY>” on page
1119.

<Snippet>

Container

A snippet is a stored
piece of TGML code.
It can be used for
reusing constructs
such as
preconfigured
animations and
gradients.
For more information,
see section 34.6
“TGML Code
Snippets” on page
1024.

<TargetArea>

Container, <Tgml>

TargetArea
represents a
clickable area in a
graphic. Target area
is not painted, that is,
it is always invisible.
For more information,
see section 34.51
“TGML Target Area
Element:
<TargetArea>” on
page 1105.
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Continued
TGML Element

Type

Possible parent

Description

<Text>

Shape

Container

Text defines a
graphics element
consisting of text.
Each Text element
causes a single string
of text to be
rendered. The Text
element perfoms no
automatic line break
or word wrapping.
For more information,
see section 34.53
“TGML Text Line:
<Text>” on page
1110.

<TextBox>

Shape

Container

Text defines a
graphics element
consisting of text.
TextBox wraps the
text within the
specified box. The
TextBox element also
supports manual line
breaks (ASCII
character 10).
For more information,
see section 34.54
“TGML Text Flow:
<TextBox>” on page
1113.

<Tgml>

Each TGML
document contains
the TGML root
element. It also
contains metadata
created and
interpreted by the
TGML application.
For more information,
see section 34.10
“TGML Document
Type Element and
Metadata” on page
1028.

<Translate>

Transform

Container, Image,
Shape

Translate translates
(moves) the
coordinate system
for the immediate
parent element.
For more information,
see section 34.59
“TGML Translations:
<Translate>” on
page 1122.

Technical
1136

04-16006-04-en, March 2015

35 TGML Additions for Building Operation
35.2 TGML Limitations

35.2

TGML Limitations
In some implementations, for example, Microsoft GDI+ there are limitations to
TGML attributes.

Positional and Size-Related Limitations
Positional attributes have a limitation of +/- 10.000 pixels. Size-related attributes
have a limitation of 10.000 by 10.000 pixels. That is, no TGML figure can have a
size that exceeds 10.000 by 10.000 pixels. This size limitation also applies for the
canvas. The following TGML attributes are affected by the limitations:
• Top
• Left
• Height
• Width
• Length
• X1
• X2
• Y1
• Y2
• Points
• RadiusX
• RadiusY
• StartPoint
• EndPoint
• ContentHeight
• ContentWidth
• FontSize
• StrokeWidth
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35.3

Displaying the TGML Version
You display the TGML version to find out which TGML version the Graphics Editor
version supports.
For more information, see section 34.1 “TGML Overview” on page 1015.

To display the TGML Version
1. In Graphics Editor, click the Design button.
2. On the File menu, click Properties.
The TGML version is displayed in the TGML version box.
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35.4

Global Scripts in TGML Graphics
By default, each Script element (script block) creates a JavaScript context. In this
mode, function calls between script blocks (contexts) are not supported, that is, no
support for global script functions.
From Building Operation 1.6 it is possible to enable scripts to run in one single
context for the whole graphic so that functions and variables can be shared
between script blocks. This is done by setting the TGML element property
‘UseGlobalScripts’ in the Graphics Editor to ‘True’. By default, 'UseGlobalScripts' is
‘False’.
Using ‘UseGlobalScripts’ may have a very positive effect on graphics loading
performance in some of the viewers, such as the HTML5-based viewer in
WebStation.

Global variables
In the HTML5 viewer some names are reserved for the Web Browser. It might not
be apparent for users writing Java Scripts that using reserved names can cause a
conflict when viewing the TGML graphic in the HTML5 viewer, as it works fine in the
WorkStation viewer.
You can check whether or not there is a conflict by using the Global Variables tool in
the Graphics Editor Statistics pane to analyze the scripts in the TGML graphic and
looks for global variables that could cause name conflicts.
Example:
A script that contains a variable named ‘window’ without the var declaration might
have been intended to be used as a local variable. However, not declaring it as ‘var’
makes it a global variable and since ‘window’ is a reserved word (an object in the
Web Browser) this object is referenced instead, when the Web Browser executes
the script.
function load(evt)
{
window = 1;
}

Note
• The variable 'window' is visible in the list of Global script variables.
• To use reserved words locally in scripts as variables, make sure to declare
them as ‘var’.
function load(evt)
{
var window = 1;
}

04-16006-04-en, March 2015

Technical
1139

35 TGML Additions for Building Operation
35.5 Invoke Function

35.5

Invoke Function
Graphic components can be used to navigate within panels. The navigation
function requires that you add a script with an invoke function to the graphic
component in Graphics Editor.
With invoke functions in the script, you can configure the graphic component to
open a linked target object in a target location when the user performs a specific
action on the component. For example a graphics component can be configured to
open a trend chart in another pane in the panel of your graphic when the user clicks
the graphic component.
This is an example of the invoke command syntax:
invoke("BindingName", "Operation") where Operation is "OperationName Attribute
1 | Attribute2"
The operation in the invoke function defines where the target object is to be
opened.
For more information, see section 34.49 “TGML Scripting” on page 1093.

Figure: An example of the Invoke syntax in Graphics Editor

Table: Invoke commands
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Command

Description

invoke("Link 1", "OpenInFloatingWindow");

Opens the target object in a floating window.

invoke("Link 1", "OpenInNewWindow");

Opens the target object in a new window.

invoke("Link 1", "OpenInParent");

The target object replaces the parent
location, that is, the panel in which the
graphic is contained.

invoke("Link 1", "OpenInSelf");

The target object replaces the graphic.

invoke("Link 1", "OpenInTarget");

Opens the target object in a specific pane.

invoke("Link 1", "OpenInTop");

The target object replaces the top panel,
that is the panel in which all other panels are
contained.

invoke("Link 1", "OpenInWorkArea");

Opens the target object in the work area.
This command replaces the obsolete 'View
object' command.

invoke("", "HistoryForward");

Navigates forward to a view you have visited
before in the selected window.

invoke("", "HistoryBack");

Navigates back to a view you have visited
before in the selected window.

Invoke("", "LogOff");

Logs off the current user from WorkStation
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Command

35.5.1

Description

Invoke Function Attributes
You can include any number of attributes that are supported for the used
command. The OpenInTarget command has to include the Target attribute in order
to work.
For each invoke command you can set a number of attributes:
• Width: sets the width of the window in pixels.
• Height: sets the height of the window in pixels
• Top: sets the top position of the window in number of pixels from the top left
corner o the screen
• Left: sets the left position of the window in number of pixels from the top left
corner or the screen
• Target: sets the target location where the link target is to be opened. You type
the name of the pane. The pane and the graphic have to be contained in the
same panel.
• DisplayName: displays the name you have typed for the target pane. By
default, the object name is the display name of the target pane.
• ShowToolbar: displays the toolbar in the target pane when set to “Yes“.
• SkipFallback: when set to “Yes“, this attribute makes the invoke function return
a "false" message if the target object does not exist. By using SkipFallback in
your script, you make it possible for the script to control what to do if the target
location does not exist.
By default, the fallback handles a non-existing target location as follows: If the
graphic is contained in a panel, the object opens in the workarea. If the graphic
is stand-alone, the object replaces the graphic.
Table: Invoke Function Attributes
Command
OpenInFloatingWindow

Supported Attributes
• Width
• Height
• Top
• Left
• ShowToolBar

OpenInTarget

• Target
• DisplayName
• SkipFallback
• ShowToolbar

OpenInSelf

• DisplayName
• ShowToolbar
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35.5 Invoke Function

Continued
Command
OpenInWorkArea

Supported Attributes
• SkipFallback
• ShowToolbar

OpenInParent

• DisplayName
• SkipFallback
• ShowToolbar

OpenInTop

• SkipFallback
• ShowToolbar

OpenInNewWindow

• ShowToolbar

Figure: Example of the invoke syntax where you want Trend Chart 1 to open in the pane
named TopPane. If TopPane does not exist in the panel of the graphic, Trend Chart 1 is to
be opened in a floating window. The display name is Graphic 1 and a toolbar is to be
hidden.

Important
The following attribute settings made in the graphic override the corresponding
attributes of the previously displayed object in the panel:
• DisplayName
• ShowToolbar
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35.6

Panel Navigation
When you use graphics in a panel, you can configure in which target location a
target object linked to the graphic is to be opened when the user performs an
action on the graphic, for example, a mouse click. You configure the graphic in
Graphics Editor by adding an invoke function script. In WorkStation or WebStation,
you link the graphic to the target object you want to open when the user performs
the action.
A target object can be opened from a graphic in any of the following target
locations:
• Floating window
• New window
• Parent
• Self
• Target
• Top
• Work area
You can also use the invoke function script to give the user the ability to navigate
back and forward to a previously visited view.
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Topics
Graphics Editor
Graphics Editor Menu Bar
Graphics Editor File Menu
Graphics Editor File Menu – New Submenu
File Menu – Open Submenu
File Menu – Save As Submenu
File Menu – Print Submenu
File Menu – Settings Submenu
Graphics Editor View Menu
Categories Context Menu
Graphics Editor Drawing Toolbar
Graphics Editor Options Toolbar
Components Pane
Graphics Editor Snippets Pane
Graphics Editor Panes
Graphics Editor Objects Pane
Graphics Editor Properties Pane
Graphics Editor Statistics Pane
Graphics Editor Test Pane
Graphics Editor Binds and Links Pane

Graphics Editor Layers Pane
Create Graphics Wizard - Basic Settings Page
Graphic Properties - Basic Tab
Graphic Properties – Bindings Tab
Graphic Properties – Links Tab
Graphic Properties - References Tab
Document Properties Dialog Box
Unsupported Characters

36 Graphics User Interface
36.1 Graphics Editor

36.1

Graphics Editor
Use the Graphics Editor main window to create, test, and save application
graphics.

Figure: Graphics Editor

Table: Graphics Editor Window
Number

Description
Toolbars
Contain tools used to create and edit .tgml
files and other objects.
Work area
You can drag elements from the panes to
the work area. You can also draw free form
objects by using the drawing tools.
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36.1 Graphics Editor

Continued
Number

Description
Panes
Includes the following:
• Objects pane with a tree structure of
what is included in the graphic
• Properties pane where you edit the
properties of a selected object
• Layers pane where you manage layers
in a graphic
• Statistics Pane where you check the
efficiency of a graphic
• Binds and Links pane with
information on the bind objects
• Test pane where you test the behavior
of a graphic
• Components pane where you can
access standard components libraries
as well as components categories that
you have imported or created on your
own
• Snippets pane where you can access
standard snippets libraries as well as
snippets categories that you have
imported or created on your own
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36.2

Graphics Editor Menu Bar
Use the menu bar to manage graphic files, and to toggle between different views of
the current graphic.

Figure: Graphics Editor menu bar

Table: Graphics Editor Menu Bar
Button

Description
File
Click to open the File menu. For more
information, see section 36.3 “Graphics
Editor File Menu” on page 1149.
Save
Click to open the standard Save As
window.
Undo
Click to revert the graphic to the state it was
in before the latest performed command
was executed. Repeated use of Undo takes
you back in the changes history, all the way
to when the graphic file was opened.
Redo
Click to revert the graphic to the state it was
in before the latest Undo command.
Repeated use of Redo takes you forward in
the changes history, all the way to the most
recent change.
Magnification
Click to enter the percentage of
magnification of the work area.
Design
Click to open the current graphic's work
area for drawing and editing. It also displays
the tools on the drawing toolbar. Graphics
Editor opens in Design mode.
Source
Click to open the current graphic for tgml
text editing, by putting the cursor in the text.
Common text editing tools are made
available in the Options bar.
Preview
Click to open the current graphic to test
animations, bindings, and links.
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36 Graphics User Interface
36.2 Graphics Editor Menu Bar

Continued
Button

Description
View
Click to open the View menu from which
you can select the panes you want to use in
Graphics Editor: Components, Snippets,
Statistics, Layers, Objects, Properties, Binds
and Links, and Test. You can also select Full
Screen mode. For more information, see
section 36.9 “Graphics Editor View Menu”
on page 1156.
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36.3 Graphics Editor File Menu

36.3

Graphics Editor File Menu
Use the File menu to manage graphic files.

Figure: Graphics Editor File menu

Table: Graphics Editor File Menu
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Command

Description

New

Opens a submenu where you can select if
you want to create a graphic or a
component.

Open

Opens a submenu where you select a .tgml
graphic file or an .ogc file.

Save

Saves the graphic as a Building Operation
object in the database.

Save As

Opens a submenu where you select how the
current graphic file is to be saved. When you
use the Save As command to save a graphic
as a file, the link to Building Operation is
broken.

Import

Opens a dialog box where you can locate
graphics files that you want to import into
Graphics Editor.

Export

Exports a graphics file to the selected
location, under the name you enter, and in
the file format you specify.

Print

Opens a submenu where you can make a
number of print preferences for printing the
active graphic or component.

Properties

Opens the document properties pane. For
more information, see section 36.17
“Graphics Editor Properties Pane” on page
1172.

Settings

Opens a submenu from which you access
user interface settings for Graphics Editor.
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36.3 Graphics Editor File Menu

Continued
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Command

Description

Close

Closes the current design and the editor in
which it is open. If you have several
instances of the editor open simultaneously,
only the current editor is closed.

Exit

Exits all instances of the program.
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36.4 Graphics Editor File Menu – New Submenu

36.4

Graphics Editor File Menu – New
Submenu
Use the New submenu to create a graphic or a component.

Figure: Graphics Editor File menu - New submen

Table: Graphics Editor File Menu - New Submenu
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Command

Description

Graphic

Click to open a graphic workspace where
you create a new graphic. For more
information, see section 23.1 “Graphics
Editor Overview” on page 789.

Component

Click to open a new component workspace
where you create a new component. For
more information, see section 23.1
“Graphics Editor Overview” on page 789.
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36.5 File Menu – Open Submenu

36.5

File Menu – Open Submenu
Use the Open submenu to open .tgml or .ogc files in Graphics Editor.

Figure: Graphics Editor File menu - Open submenu

Table: Open Submenu
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Command

Description

File

Click to open a graphics or components file
in .tgml or .ogc format.
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36.6 File Menu – Save As Submenu

36.6

File Menu – Save As Submenu
Use the Save As submenu to save a graphics or components file.

Figure: Graphcis Editor File menu - Save As submenu

Table: Graphics Editor File Menu - Save As Submenu
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Command

Description

File

Click to save the graphic as a .tgml file.

Component

Click to save a component in a component
category.
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36.7 File Menu – Print Submenu

36.7

File Menu – Print Submenu
Use the Print submenu to make settings that affect how a graphic or component is
printed.

Figure: Graphics Editor File menu - Print submenu

Table: Graphics Editor File Menu - Print Submenu
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Command

Description

Page settings

Click to open a dialog box where you can set
paper size, source, orientation and margins.

Print preview

Click to display a print preview of the page,
that is, a view of how the page appears
when printed.

Print

Click to open the default Print dialog box
where you can select a printer, set the page
range, and set the number of copies you
want to print.

04-16006-04-en, March 2015

36 Graphics User Interface
36.8 File Menu – Settings Submenu

36.8

File Menu – Settings Submenu
Use the Settings submenu to save settings you have made to the user interface or
to reset the user interface to the default settings.

Figure: Graphics Editor File menu - Settings submenu

Table: Graphics Editor File Menu - Settings Submenu
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Command

Description

Save settings

Click to save customized settings that define
the size, position and visibility of the grid,
panes, magnification, tools options, and
columns. Snap to the grid is also saved.

Reset to default

Click to reset the user interface to the default
settings.
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36 Graphics User Interface
36.9 Graphics Editor View Menu

36.9

Graphics Editor View Menu
Use the View menu to show or hide the Graphics Editor tabs and panes. From the
View menu, you can also toggle a graphic between full screen mode and
displaying it in the Graphics Editor window.

Figure: Graphics Editor View menu

Table: Graphics Editor View Menu
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Command

Description

Components

Click to show or hide the Components tab
where you can access and manage
components.

Snippets

Click to show or hide the Snippets tab where
you can access and manage snippets.

Layers

Click to show or hide the Layers pane where
you can manage the layers of your graphic.

Objects

Click to show or hide the Objects pane
where you can view the object tree with all
the elements included in the graphic.

Properties

Click to show or hide the Properties pane
where you can view and set the properties of
a graphic.

Statistics

Click to show or hide the Statistics pane
where you can view the efficiency of the
graphic.

Binds and Links

Click to show or hide the Binds and Links
pane where you manage the binds and links
of the graphic.

Test

Click to show or hide the Test pane where
you can test that your graphics functions
behave as expected.

Full Screen

Click to view the graphic in full screen mode
or to revert to the Graphics Editor window.
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36.10 Categories Context Menu

36.10

Categories Context Menu
Use the categories context menu to manage components and snippets categories.

Figure: Categories context menu

Table: Categories Context Menu
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Command

Description

Libraries

Opens the Libraries dialog box where you
manage components and snippets libraries.
For more information, see section 24.11
“Snippets” on page 828.

Categories

Opens the Categories dialog box where
you select or clear the components and
snippets categories that you want to be
displayed in the Components pane or
Snippets pane.

Import

Opens an Explorer window where you can
import a components or snippets archive
file.

Export

Opens an Explorer window where you can
save a components or snippets archive file.

New Category

Opens the New Component Category or
the New Snippet Category dialog box
where you type a name for the new category
you want to create.

Delete Category

Opens the Delete Category dialog box
where you confirm that you want to delete
the selected components or snippets
category.

Rename Category

Opens the Rename Category dialog box
where you type a new name for the selected
components or snippets category.

Hide Category

Hides the selected components or snippets
category in Graphics Editor.
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36.11 Graphics Editor Drawing Toolbar

36.11

Graphics Editor Drawing Toolbar
Use the Drawing toolbar to access the tools you need to create and edit .tgml files
and other objects.

Figure: Graphics Editor Drawing toolbar

Table: Graphics Editor Drawing Toolbar
Button

Description
Select
Click the border, or anywhere within a filled
object, to select the object.
Scroll
Click and drag to adjust the work area in the
pane.
Zoom
Click to display three zoom tools in the
Options bar: Restore original, Zoom In, and
Zoom Out.
Line
Click-drag-release in the work area to draw
a line between the two end points.
Polyline
Click a number of times in the work area to
draw a polyline between the click points.
Double-click to finish the polyline.
Curve
Click a number of times in the work area to
draw a curve between the click points.
Double-click to finish the curve.
Polygon
Click a number of times in the work area to
draw a polygone between the click points.
Double-click to finish the polygon.
Rectangle
Click and drag in the work area to open up a
rectangle between the two corner points.
Simultaneously, press SHIFT to open up a
square.
Ellipse
Click and drag in the work area to open up
an ellipse between the two size-determining
points. Simultaneously, press SHIFT to open
up a circle.

Technical
1160

04-16006-04-en, March 2015

36 Graphics User Interface
36.11 Graphics Editor Drawing Toolbar

Continued
Button

Description
Arc
Click and drag in the work area to open up
an arc between the two size-determining
points. Simultaneously, press SHIFT to open
up a quarter of a circle. For more
information, see section 33.19 “Pies” on
page 988.
Pie
Click and drag in the work area to open up a
pie (filled arc) between the two sizedetermining points. Simulataneously, press
SHIFT to open up a quarter of a pie. For
more information, see section 33.19 “Pies”
on page 988.
Text
Click in the work area to position the start
point of a text string. Type the text and press
ENTER.
Textbox
Click and drag in the work area to open up a
rectangular text box between the two corner
points. Simultaneously, press SHIFT to open
up a square. Type the text and press
ENTER.
Insert Picture
Click in the work area to position the upper
left corner of a picture insert. An Open
window lets you browse to the desired
picture file.
Cut
Click to remove the selected object from the
graphic. The object is temporarily stored on
the clipboard.
Copy
Click to save a copy of the selected object
on the clipboard.
Paste
Click to create a copy of the object residing
on the clipboard. The copy is displayed on
the graphic slightly displaced from the
original, or from any previous copy.
Delete
Click to delete the selected object from the
graphic. The clipboard is not affected.
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36 Graphics User Interface
36.11 Graphics Editor Drawing Toolbar

Continued
Button

Description
Show Grid
Click to toggle between show and hide grid.
Select a grid size value from the adjacent
combo box.
Snap to Grid
Click to toggle between enabling and
disabling the snap objects to the grid
function.
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36.12 Graphics Editor Options Toolbar

36.12

Graphics Editor Options Toolbar
Use the Options toolbar to specify properties, or perform commands that become
available when you have selected a tool on the toolbar.

Figure: Graphics Editor Options toolbar

Table: Graphics Editor Options Toolbar
Button

Description
Point Selection
Click the border, or anywhere within a filled
object, to select the object and display the
curve points.
Rotate Selection
Click to rotate the selected object by
dragging the handle that is displayed at the
top of the object.

Fill

Select the required fill color or gradient from
the palette. For more information, see
section 30.26 “Gradients” on page 925.
Swap Colors
Click to swap the current colors of the stroke
and the fill.

Stroke

Select the required stroke color or gradient
from the palette. For more information, see
section 30.26 “Gradients” on page 925.

Style

Select the required stroke style from the list.

Width

Select the required stroke width, 0–30
pixels, from the list.

Corner

Select the required corner radius, 0–50
pixels, from the list.
Group
Click to group the selected objects in the
work area.
Ungroup
Click to ungroup objects that were
previously grouped.
Align
Select the required alignment of two or more
objects from the list: left, center, right, top,
middle, bottom, or center and middle.
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36.12 Graphics Editor Options Toolbar

Continued
Button

Description
Arrange
Select the required arrangement of an object
relative to other objects, from the list.
Distribute
Select the required distribution of three or
more objects, in the horizontal or vertical
direction, from the list.
Flip
Select the required flip operation of the
selected object, in the horizontal or vertical
direction, from the list.
Resize
Select the required resize operation of two or
more objects from the list: same width,
height, or width and height.
Rotate Left
Click to rotate objects (single or group) 90°
left.
Rotate Right
Click to rotate objects (single or group) 90°
right.
Skew Horizontal
Click to skew the objects (single or group)
horizontally to ±60°, ±45°, ±30°, or ±15°.
Skew Vertical
Click to skew the objects (single or group)
vertically to ±60°, ±45°, ±30°, or ±15°.
Font
Select the required font family from the list.
Size
Select the required font size, 8–100 pixels,
from the list.
Bold
Click to make the characters of the selected
text string or text box bold.
Italic
Click to make the characters of the selected
text string or text box italic.
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36.12 Graphics Editor Options Toolbar

Continued
Button

Description
Underline
Click to make the characters of the selected
text string or text box underlined.
Strikethrough
Click to display the characters of the
selected text string or text box with
strikethrough.
Text
Click to align the text to the left based on the
insertion point of the text row.
Textbox
Click to align the text to the left in the text
box.
Text
Click to center the text based on the
insertion point of the text row.
Textbox
Click to center each text row in the textbox.
Text
Click to align the text to the left based on the
insertion point of the text row.
Textbox
Click to align the text to the right in the text
box.
Text
Click to align the top of the text to the
insertion point.
Textbox
Click to align the text to the top of the
textbox
Text
Click to align the middle of the text to the
insertion point.
Textbox
Click to align the text in the middle of the
texbox.
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36.12 Graphics Editor Options Toolbar

Continued
Button

Description
Text
Click to align the bottom of the text to the
insertion point.
Textbox
Click to align the text to the bottom of the
textbox.
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36.13 Components Pane

36.13

Components Pane
Use the Components pane to access components and manage components
categories.

Figure: Graphics Editor Components pane

Table: Graphics Editor Components Pane
Number

Description
Basic Controls
This category contains standard controls
delivered with the program.
DIN Symbols
Standardized DIN control symbols.
ISO Symbols
Standardized ISO control symbols.
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36 Graphics User Interface
36.13 Components Pane

Continued
Number

Description
My Components
This category is where you add customized
components that you want to reuse in the
future.
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36.14 Graphics Editor Snippets Pane

36.14

Graphics Editor Snippets Pane
Use the Graphics Editor Snippets pane to manage function categories.

Figure: Graphics Editor Snippets pane

Tip
• To get a description of a snippet, right-click the snippet in the list, and then
click Properties.
Table: Graphics Editor Snippets Pane
Number

Description
Basic Functions
This category contains standard functions
delivered with the program.
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36 Graphics User Interface
36.14 Graphics Editor Snippets Pane

Continued
Number

Description
My Snippets
This category is where you save customized
functions that you want to reuse in the
future.
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36.15 Graphics Editor Panes

36.15

Graphics Editor Panes
Use the Graphics Editor panes to manage graphics and components.

Figure: Graphics Editor panes

Table: Graphics Editor Panes
Number

Description
Layers
Use the Layers pane to manage layers in a
graphic.
Objects
Use the Objects pane tree structure to
navigate among the objects that make up a
graphic or a component.
Properties
Use the Properties pane to view and edit
the properties of a graphic or a component.
Statistics
Use the Statistics pane to test the
performance of a graphic.
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36 Graphics User Interface
36.15 Graphics Editor Panes

Continued
Number

Description
Test
Use the Test pane to test the behavior of a
graphic or a component.
Binds and Links
Use the Binds and Links pane to manage
and test the binds and links of a graphic or a
component.
Snippets
Use the Snippets pane to access and
manage functions.
Components
Use the Components pane to access and
manage components.

Technical
1172

04-16006-04-en, March 2015

36 Graphics User Interface
36.16 Graphics Editor Objects Pane

36.16

Graphics Editor Objects Pane
Use the Objects pane to get an overview of the structure of a graphic and all its
objects, graphical and non-graphical. You can also use the Objects pane to
manage objects.

Figure: Graphics Editor Objects pane with the Tgml tree structure

Table: Graphics Editor Objects Pane
Button

Description
Expand All
Click to show all branches in the Tgml tree.
Collapse All
Opens the standard Save As window.
Move Up
Moves the selected object upward in the
Tgml tree.
Move Down
Moves the selected object down in the Tgml
tree.
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36.17 Graphics Editor Properties Pane

36.17

Graphics Editor Properties Pane
Use the Properties pane to view and edit properties of the objects present in the
work area.

Figure: Graphics Editor Properties pane

Table: Graphics Editor Properties Pane
Button

Description
Normal
Click to display a selection of commonly
used properties.
Detailed
Click to display all properties.

Which properties that are displayed in the Properties pane depends on the objects
included in the graphic. Graphics properties define the appearance, boundary, and
behavior of the graphic.

Technical
1174

04-16006-04-en, March 2015

36 Graphics User Interface
36.18 Graphics Editor Statistics Pane

36.18

Graphics Editor Statistics Pane
Use the Statistics pane to get information on the performance of your graphics
and components.

Figure: Statistics pane

Table: Graphics Editor Statistics Pane
Component

Description

Loading

Parse time displays the time it takes to
load the graphic file. Small files load quickly
whereas large files take longer to load. If the
loading process takes long, you should
consider reducing the amount of figures
included in the graphic.
Script setup and document load display
the amount of time it takes to load Script
blocks, initiate and start the script engine,
and execute the OnDocumentLoad scripts.
If this takes too long, you can consider
reducing the amount of OnDocumentLoad
scripts and the total number of Script blocks
in the graphic. Complex OnDocumentLoad
scripts delay the opening of the graphic.
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36 Graphics User Interface
36.18 Graphics Editor Statistics Pane

Continued
Component

Description

Rendering

Initial render time displays the time it
takes to draw the graphics file the first time,
that is, the time it takes for the system to
draw all the graphic figures. The more
complex the graphic is, the longer it takes to
render.
Average render time in sample displays
the time it takes to update the graphic in run
time. The result is updated every second.
The average rendering time and the
maximum rendering time are displayed.

Drawing efficiency

The bar indicates the performance of the
graphic:
• Green = Excellent performance
• Yellow = Acceptable. Consider
simplifying the graphic.
• Red = The graphic could be perceived
as slow. Simplify the graphic.
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Update

Click to analyze all the scripts and refresh the
view to show all global variables, that is,
variables not declared as 'var'.

Validate

Click to analyze the found Global script
variables and notify which variables are in
conflict with reserved names.
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36.19 Graphics Editor Test Pane

36.19

Graphics Editor Test Pane
Use the Test pane to test the dynamic behavior in Preview mode.

Figure: Graphics Editor Test pane

Table: Graphics Editor Test Pane
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Component

Description

Name

The name of the object you are testing.

Value

Tests a bind, that is, a dynamic behavior.
Enter a value to start the test.

Unit

Tests the unit management under the
condition that you have used getUnit in
your scripts. Enter any text.

Status

Simulates signal status. "Value from device"
is the normal status.
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36.20 Graphics Editor Binds and Links Pane

36.20

Graphics Editor Binds and Links Pane
Use the Binds and Links pane to get an overview of the binds and links used in a
graphic and their properties.

Note
• The actual binding and linking are perfomred in WorkStation.

Figure: Graphics Editor Binds and Links pane

Table: Graphcis Editor Binds and Links Pane
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Column

Description

Name

Displays the name of the bind/link,
consisting of the object’s name and, for the
binds, a suffix normally ‘Value’. Name also
shows the number of bind values or link
targets that use this name. (One signal can
affect several properties.)

Attribute

Displays the property (if present) that is
affected by the bound value.

Format

None or Presentation. As selected in the
Properties pane, under Behavior - Format.

Description

Displays an optional descriptive text.
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36.21 Graphics Editor Layers Pane

36.21

Graphics Editor Layers Pane
Use the Layers pane to manage layers in a graphic.

Figure: Graphics Editor Layers pane

Table: Graphics Editor Layers Pane
Button

Description
New layer
Click to create a new layer.
Duplicate layer
Click to duplicate the current layer.
Merge layer
Click to merge the selected layers.
Delete layer
Click to delete the current layer.
Move up
Moves the selected layer upward in the layer
pane.
Move down
Moves the selected layer down in the layer
pane.

Table: Layers Pane
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Column

Description

1st column

Click to select the active layer. For more
information, see section 31.1 “Layers” on
page 945.

2nd column

Displays the graphics contents of the layer.
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36.21 Graphics Editor Layers Pane

Continued
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Column

Description

3rd column

Displays the name of the layer (the Name
property).

4th column

Select to make the layer visible.
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36.22 Create Graphics Wizard - Basic Settings Page

36.22

Create Graphics Wizard - Basic Settings
Page
Use the Basic Settings page to enter a tgml file if you want to use a pre-existing
graphic. You can also leave this empty if the tgml file has not yet been created.

Figure: Basic Settings page

Table: Basic Settings Page
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Property

Description

File

Enter a tgml file if you want to use a preexisting graphic.
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36.23 Graphic Properties - Basic Tab

36.23

Graphic Properties - Basic Tab
Use the Graphic properties Basic tab to select a new TGML file to present in the
graphic viewer.

Figure: Basic tab

Table: Basic Tab
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Property

Description

File

Enter the graphic file you want to display in
the graphic viewer. For more information,
see section 23.3 “Graphics in WorkStation”
on page 794.
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36.24 Graphic Properties – Bindings Tab

36.24

Graphic Properties – Bindings Tab
Use the Bindings tab to view and edit the bindings of the graphic.

Figure: Bindings tab

Table: Bindings Tab
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Property

Description

[Binding name]

Enter the path to the object to which you
want to bind the graphic. For more
information, see section 15.1 “Bindings
Overview” on page 411.
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36.25 Graphic Properties – Links Tab

36.25

Graphic Properties – Links Tab
Use the Links tab to view and edit the links of the graphic.

Figure: Links tab

Table: Links Tab
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Property

Description

[Link name]

Enter the path to the object to which you
want to link the graphic. For more
information, see section 28.1 “Binds and
Links” on page 871.
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36.26 Graphic Properties - References Tab

36.26

Graphic Properties - References Tab
Use the References Properties to view and access the references of the graphic.

Figure: References tab
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36 Graphics User Interface
36.27 Document Properties Dialog Box

36.27

Document Properties Dialog Box
Use the Document Properties dialog box to view, enter, or edit details on the
creation of the TGML graphic.

Figure: Document Properties dialog box

Table: Document Properties Dialog Box
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Component

Description

TGML version

Displays the TGML version of the TGML
graphic.

Title

View, add, or edit the title of the TGML
graphic.

Author

View, add, or edit the name of the author
who created the TGML graphic.

Company

View, add, or edit the name of the company
the author belongs to.

Created

Displays the date the TGML graphic was
created.

Modified

Displays the date the TGML graphic was
modified.

Revision

View, add, or edit the document revision
number.

Comments

View, add, or edit the document comments.
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36.28 Unsupported Characters

36.28

Unsupported Characters
Object names cannot include any of the following characters: exclamation point (!),
quotation mark (“), number sign (#), percent sign (%), ampersand (&), apostrophe ('),
left parenthesis ((), right parenthesis ()), asterisk (*), plus sign (+), comma (,), hyphenminus (-), full stop (.), semicolon (;), less than sign (<), greater than sign (>), equals
sign (=), question mark (?), backslash (\), or pipe symbol (|).
In addition, the following restrictions apply:
• Object names can contain full stops (.), however, leading and trailing full stops
(.) are not supported in object names.
• Leading and trailing spaces are automatically removed from object names.
• You cannot create an object with an empty name.
• You cannot create an object with a name beginning with a question mark (?).
This applies for all property values.
• You cannot create an object with a name beginning with a dollar sign ($).
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37 Function Block Introduction
37.1 Graphical Programming

37.1

Graphical Programming
When you program a function block program using Function Block Editor, you
define the function block program graphically in the function block diagram. The
function block diagram has two fundamental elements:
• Function blocks, which process the data
• Connections, which transport the signals

37.1.1

How a Function Block Program Works
In a function block program, the input signals to the blocks are processed and
generated into a single output signal.
Each function block can have one or several parameters that process the input
signals. The parameters can be defined as numerical values or as identifiers
(constants).
The output signal is forwarded to other blocks. The signal follows the route defined
by the connections, which represent the data flow during the program execution.
The data normally flows left-to-right in the diagram: An exception to this rule is when
a connection is used to close a feedback loop. In this case, the data flows back to
complete a loop.

Figure: A simple function block diagram (FBD)

In general, blocks with no inputs (source blocks) are located on the left in the
diagram.
Blocks with no outputs connected to other blocks (destination blocks) are often
placed to the right in the diagram.
Intermediate blocks, which make calculations and logical decisions, are placed
between the source blocks and the destination blocks. These intermediate blocks
are oriented in the direction of the data flow.
A function block program is cyclic and is executed at a constant time interval, called
the program cycle. During each program cycle, source blocks send data to the
intermediate blocks, which then send data to the destination blocks.

37.1.2

Printouts of Function Block Programs with
Multiple Pages
Boundary ties are cross references at both ends of a connection that crosses
pages. The boundary ties are useful when you prepare a printout of a function block
program with multiple pages. Boundary ties indicate where the signal continues in a
three-position format, separated by a dot: x-axis.y-axis.page. Boundary ties are
automatically created but can be manually moved and deleted.
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37 Function Block Introduction
37.2 Function Block Editor Overview

37.2

Function Block Editor Overview
Function Block Editor is a graphical programming tool for Automation Servers,
which you use to create function block programs that control and monitor building
automation systems. For example, you create a basic program, called OfficeLight,
to control lighting in a room based on occupancy.

Important
Ensure that you have a working and available Function Block Editor license. A
working license is required to start the Function Block Editor software. For more
information, see the Licenses topic on WebHelp.
When you open your new OfficeLight program in Function Block Editor, you begin
by adding function blocks based on the type of action you wish the program to
perform. You then connect the blocks. For more information, see section 37.1
“Graphical Programming” on page 1189.
When you have finished the graphical programming, you create points in
WorkStation. You then bind the signals of the function block program to those
points to view the output.
When you are finished, you use the Function Block Editor Simulation mode to check
the program for errors and save the program.
In WorkStation, in the Properties pane, you select the task in which you want to
include your programs. You then execute your function block program.
For more information, see section 37.3 “Function Block Workflow” on page 1191.
You can store your function block programs and include them later in projects for
use in your control system. By putting small function block programs together, you
can create function block programs that perform anything from simple to very
complex operations, such as lighting, boilers, and air handling units at multiple sites.
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37.3

Function Block Workflow
The function block workflow enables you to create (and edit) function block
programs in Building Operation.
The following flowchart describes the basic steps required to create (or edit) a
function block program. Related information can be found in the sections after the
flowchart. If you want to edit an existing function block program, select the program
in the Automation Server and then continue from the second step.
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Figure: Function block workflow

Create a function block program
In WorkStation, create a function block program under an Automation Server.
Technical
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For more information, see section 38.3 “Creating a Function Block Program” on
page 1211.

Open Function Block Editor
In WorkStation, open Function Block Editor so that you can edit the program.
For more information, see section 38.8 “Editing a Function Block Program” on page
1218.

Add, name, and connect function blocks
In Function Block Editor, in Edit mode, add, name, and connect function blocks.
Edit library programs as required.
For more information, see section 47.2 “Adding a Simple Block” on page 1373.
For more information, see section 48.2 “Adding an Operator” on page 1484.
For more information, see section 46.2 “Adding an Expression Block” on page
1353.
For more information, see section 39.11 “Naming a Function Block” on page 1256.
For more information, see section 45.3 “Connecting a Block Output to a Block
Input” on page 1337.

Open the program in Simulation mode
In Function Block Editor, open the program in Simulation mode.
For more information, see section 44.2 “Changing to Simulation Mode” on page
1308.

Test and verify the program
In Simulation mode, execute the program for one or more cycles, for different input
values.
For more information, see section 44.7 “Starting a Simulation” on page 1313.
For more information, see section 44.5 “Simulating One Cycle Only” on page 1311.
For more information, see section 44.6 “Simulating a Defined Number of Cycles” on
page 1312.

Change the program to Edit mode
Change to Edit mode so that you can save the program.
For more information, see section 39.2 “Changing to Edit Mode” on page 1246.

Save program to server
In Function Block Editor, in Edit mode, save the tested program to the Automation
Server.
For more information, see section 38.11 “Saving a Function Block Program” on
page 1223.

Bind inputs and outputs
In WorkStation, bind the inputs and outputs of the program to I/O bus variables.
For more information, see section 38.9 “Binding a Function Block Program to I/Os”
on page 1219.
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Select a task and execute the program
In WorkStation, select the function block execution frequency (the task) and
execute the program.
For more information, see section 50.24 “Adding a Task to a Program” on page
1603.
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37.4

Function Block Editor File Type
A Function Block Editor .AUT file is the data file type used for creating a function
block program for an Automation Server.
The .AUT file is a text file with function block program source code and data
including a graphical block diagram. When you save a function block program from
Function Block Editor, it is saved to the function block program object in the
Building Operation database. To use the file outside Building Operation, you need
to export the text file.

.MTA
An .MTA file can be imported into Function Block Editor but, when saved, it is
converted into an .AUT file.
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37.5

Function Block Editor Shortcut Keys
You can use shortcut commands to make the work in Function Block Editor more
efficient.
In Edit mode the following commands are available:
Table: Shortcut Commands in Edit Mode
Key

Function

F7

Open the Search dialog box.

F8

Open the Replace dialog box.

F9

Center a selection in the diagram window.

F12

Change to Simulation mode.

In Simulation mode the following commands are available:
Table: Shortcut Commands in Simulation Mode
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Key

Function

F2

Start and stop a simulation.

F5

Change to table view.

F7

Open the Search dialog box.

F12

Change to Edit mode.
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37.6

Programming Hints
To make your programming tasks in Function Block Editor more efficient, use these
hints.

37.6.1

Program Cycle Time
The cycle time for the function block program is variable. Take this into account
when drawing your function block program.
For example, you can use the INTEG block to calculate Energy consumption from
the input Power. When resetting the block at the start of a new calculation interval,
the reset value must be the input signal multiplied by the program cycle time.

37.6.2

Time Counter
The time counter counts in seconds, which takes care of the actual function block
program cycle time. The counter is reset by a binary signal.

Figure: Time counter

You can also make Time counters by using the PULSE and RT blocks. Designs
using RT and INTEG can be reset during the count. You can use the INTEG counter
when counting something, such a time or power, over time.

37.6.3

Equality
When testing whether two values are equal, ensure that the tested values are of the
Binary or Integer type. Do not carry out an equal test on Real values.

37.6.4

Reset Counter
You can use the RST, for example, to reset an energy counter without losing any
pulses during the reset:

Figure: Reset a counter
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37.6.5

Bitwise Operators
The output of the bitwise AND (&) operator is an integer that represents the result of
the AND operation on two analog signals. By using this operation inside an
expression block with a binary output and assigning the result of the AND operation
to the output, you obtain a binary signal that is zero if there is no match and one as
soon as there is a match in at least one bit position.

37.6.6

Sliding Average Value
You use sliding average values to display previous values.
Programming example of the sliding average of three values:

Figure: Sliding average value

37.6.7

Time Shift
You can detect a time shift, if the latest displayed time has a lower value than the
previously displayed time. A lower value of an HOUR block indicates a day shift, a
lower value in a MINUTE block indicates an hour shift, and a lower value in a
SECOND block indicates a minute shift.

Figure: A lower value in an HOUR block indicates a day shift

37.6.8

Expression Blocks
You cannot change the output type of an expression block when the output is
connected to a node.
Expression blocks can be used to convert from a Real signal to an Integer signal
and vice versa:
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Figure: Expression blocks

If the expression block contains an IF-THEN-ELSE statement, both the IF and the
ELSE part of the statement are calculated each cycle.

37.6.9

Start-Up Delay
Use the RST block to create a start-up delay following a warm start of the device.
Use different delays for different AHUs by altering the DelayOff time (60 s in the
example):

Figure: Start-Up delay
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37.7

Units of Measure
In Function Block Editor, a number of blocks use either the SI unit system or the
imperial unit system. SI units are the metric units and imperial units are the inchpound units.
The regional settings of the Windows operating system that is used to create the
function block program, determines the units of measure for some blocks. The
definition of the signal determines the units of measure for other blocks.
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37.8

Function Block Diagram Structure
In a function block diagram (FBD), the function blocks process input signals and
generate a single output signal. During the program execution, the output signal is
forwarded to other blocks by using connections that represent the data flow from
left to right.
The first step when structuring is to make an outline structure by:
• Identifying the main functions, and
• Determine where to graphically locate these function groups in relation to each
other.
The grouping can be done in several ways. The most important thing is to make the
FBD easy to understand. Function blocks that perform a function together should
preferably be located together.
The second step is to graphically locate the groups. Create a left-to-right logical
sequence in the FBD. If there is a connection between two groups, place a group
that delivers an output to the left of a group that receives an input. To standardize
this, we recommend a logical order from left-to-right: START CONDITION - STOP
CONDITION - GENERAL CONTROL - PID CONTROL SEQUENCES - ALARM
HANDLING.

Figure: Left-to-right logical sequence

Use the following rules of thumb when you locate blocks and groups:
• Enter a framed comment containing the last edition date of the FBD in the
upper left corner. History notes, describing the revision, can also be included.
Update this information whenever you make a program revision.
• Try to structure every page so that the physical input blocks are arranged in a
column to the left, and the physical output blocks in a column to the right.
• Adjust the function block diagram to the page break lines, to make a printout
legible.
• Make space between the groups so that it is possible to add connections and
additional functions.
• Add new pages to the right when necessary, but try to use only one page in a
vertical direction.
• Locate connections like a bus with common left-to-right connections at the top
of the diagram. Avoid mixing connections running in opposite directions. Put
connections running in opposite directions in a separate bus at the bottom of
the page. Mark the direction of these signals.
• Reuse tested macros from the Macro Block Library or your own library as often
as possible.
• Structure the function block program so that all public signals that you want to
display together belong to the same module (and have the same module
name).
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Figure: Page breaks have to be adjusted to make printouts easy to read
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37.9

Programming Phases
When you program an Automation Server, the work can be divided into three
fundamental phases:
• Function phase: analyze the requirements
• Design phase: program the function block program
• Test phase: simulate the functionality of the function block program

37.9.1

Function Phase
In the function phase, you read and analyze the functional specification. You add
your analysis and form an overall solution. In this phase, you sometimes need to
acquire more data regarding parts of the installation that affect the programming.
An important part of this phase is to locate function block programs that are ready
to use or that only require small changes, in the folder where you store your function
block programs.

37.9.2

Design Phase
During the Design phase, you start working in Function Block Editor. You identify
points, name the points, and allocate them. You plan the structure of the function
block program and finally build your function block program in Function Block
Editor.

37.9.3

Test Phase
During the test phase you can test a function block program in two ways:
• In Simulation mode in Function Block Editor.
• As a final system test where you download the complete function block
program to an Automation Server and test it.
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37.10

Design Phase
During the Design phase, you start working in Function Block Editor. You identify
points, name the points, and allocate them. You plan the structure of the function
block program and finally build your function block program in Function Block
Editor.

37.10.1

Point Identification and Allocation
The importance of a good point allocation is often underestimated. There is a very
close relationship between a well-prepared point allocation and the efficiency that
can be achieved later on in the project.
With good point allocation, copying techniques can substantially reduce the
engineering hours needed for the design and manufacturing of electrical panels.
Installation and commissioning work benefits from efficient point allocation.

37.10.2

Points and Alarms Naming Conventions
The naming of points and signals is an important part of design work. I/O and
signals are best given names that are descriptive and easy to recognize. The
customer or end user has often specific demands on the use of acronyms or
designations. The same applies, even in a higher degree, for alarm texts.

37.10.3

The Function Block Diagram Structure
In a function block diagram (FBD), the function blocks process input signals and
generate a single output signal. During the program execution, the output signal is
forwarded to other blocks by using connections that represent the data flow from
left to right.
For more information, see section 37.8 “Function Block Diagram Structure” on page
1201.
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37.11

Operation Modes
In Function Block Editor, there are two modes to choose from depending on if you
are programming a function block program or if you are testing a function block
program.

37.11.1

Edit Mode
You use Edit mode when designing the function block program. In Edit mode you
add and edit blocks and connections.
For more information, see section 39.1 “Edit Mode” on page 1245.

37.11.2

Simulation Mode
You use Simulation mode to test and troubleshoot function block programs and to
show the state of the signals. You can run Simulation mode without a connected
Automation Server.
For more information, see section 44.1 “Simulation Mode” on page 1307.
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38 Function Block Programs
38.1 Function Block Programs in WorkStation

38.1

Function Block Programs in
WorkStation
You create function block programs in WorkStation. In WorkStation, function block
programs are represented by a designated icon. At this stage, the function block
program is empty, that is, it contains no function blocks or source code of any kind.

Figure: Function Block programs in WorkStation

Function Block Editor starts automatically when you use the Edit command on a
function block program from WorkStation.
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38.2

Function Block Program Printouts
In Function Block Editor, you can print function block programs. You use the Print
dialog box to determine what you want to include in the printout and the Page
Setup dialog box to set up the appearance of the printout. If you make a selection,
only the selected blocks are printed.
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38.3

Creating a Function Block Program
You create a Function Block program to import existing program code or to
program new logic for the Automation Server using Function Block Editor.
For more information, see section 37.1 “Graphical Programming” on page 1189.

To create a function block program
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the function block program.
2. On the File menu, point to New and then click Program.
3. In the object type list, select Function Block Program.

4. In the Name box, type a name for the function block program.
Continued on next page

04-16006-04-en, March 2015

Technical
1213

38 Function Block Programs
38.3 Creating a Function Block Program

5. In the Description box, type a description for the function block program.

6. Click Create.
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38.4

Function Block Program Import
You can import and reuse a function block program that has been exported from
Function Block Editor and saved at an earlier stage. For more information, see
section 38.5 “Importing Function Block Program Code” on page 1214.
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38.5

Importing Function Block Program Code
You import function block program code to reuse all or parts of existing code.
Function Block Editor supports import of .aut and .mta files created for Xenta
280/300/400 LonWorks devices in Menta Editor, as well as .aut file previously
created in Function Block Editor.
For more information, see section 37.1 “Graphical Programming” on page 1189.

To import function block program code
1. In WorkStation, in the System Tree pane, select the function block program
you want to import program code to.
2. On the Actions menu, click Edit.
3. In Function Block Editor, on the File menu, click Import.
4. Select the file you want to import.
5. Click Open.

Continued on next page
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6. On the File menu, click Save.

Tip
• When a Menta file is imported, TSCH blocks and ALARM blocks
are removed, AI/DI blocks are converted to RI/BI blocks, and
AO/DO blocks are converted to RO/BO blocks. As a result of
these conversions, you may need to make adjustments to the
imported Menta code.
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38.6

Exporting Function Block Program Code
You export function block program code to an .aut file when you want to save a
copy of the program code, which can be imported into Function Block Editor and
reused for other function block programs.
For more information, see section 37.1 “Graphical Programming” on page 1189.

To export function block program code
1. In Function Block Editor, on the File menu, click Export.
2. In the File name box, type a path and file name for the export file.
3. Click Save.
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38.7

Opening a Function Block Program
You open a function block program to view its properties.
For more information, see section 38.1 “Function Block Programs in WorkStation”
on page 1209.

To open a function block program
1. In WorkStation, in the System Tree pane, click the function block program
you want to open.
2. On the File menu, click Open.
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38.8

Editing a Function Block Program
You edit a function block program in Function Block Editor to modify the function
block program logic.
For more information, see section 37.2 “Function Block Editor Overview” on page
1190.

Important
Ensure that you have a working and available Function Block Editor license. A
working license is required to start the Function Block Editor software. For more
information, see the Licenses topic on WebHelp.

To edit a function block program
1. In WorkStation, in the System Tree pane, select the function block program.
2. On the Actions menu, click Edit.
The function block program opens in Function Block Editor where you can edit it.
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38.9

Binding a Function Block Program to
I/Os
You bind a function block program to I/Os to connect the inputs and outputs of a
function block program to variables in an Automation Server. For more information,
see the I/O Bus Overview topic on WebHelp.

To bind a function block program to I/Os
1. In WorkStation, in the System Tree pane, select the function block program
to which you want to bind values.
2. On the Actions menu, click Edit bindings.
3. In the binding Browser, drag IO Bus values to inputs and outputs in the
binding list to create the bindings.
4. On the toolbar, click Save to save the bindings to the Automation Server.
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38.10

Binding Values Using a Binding
Template
You use binding templates to reduce engineering time when creating bindings.
Binding templates are defined and created for binding patterns that are frequently
reused.
Using binding templates, you create bindings between the Automation Server
program variables, internal values, and I/O points using the following recommended
process:
• First, bind the Automation Server IO Bus to each of the Programs in the
Automation Server that requires data flow with the I/O points.
• Next, bind the Internal Variables to each of the Programs in the Automation
Server that requires data flow with Internal Variables.
• Then, bind each of the individual Programs to all other Programs that require
data flow with other Programs.
• Finally, bind any time schedules and alarms that are required as part of the
programmed control logic.

Tip
• When creating bindings, follow the recommended general guidelines: create
bindings between Inputs and Outputs only and do not create bindings to
Public Signals.
For more information, see section 16.1 “Binding Templates” on page 449.

To bind values using a binding template
1. In WorkStation, in the System Tree pane, select the object that you want to
bind values to.
2. On the Actions menu, click Edit bindings.
Continued on next page
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3. In the binding point browser, drag the object or folder to the binding template
that you want to apply.

4. Select the bindings that you want to create.

5. Click OK.
Continued on next page
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6. Verify that all bindings are correctly bound.

7. On the File menu, click Save.

Tip
• To ensure data flow is occurring as intended, use the Watch pane to view
values and monitor changes.
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38.11

Saving a Function Block Program
You save a function block program to make it available for reuse. The Save process
automatically processes the function block program data and creates a number of
subfolders in the System Tree pane.

To save a function block program
1. In Function Block Editor, on the File menu, click Save.
You can now use the function block program, with the blocks and the folders
automatically created in the database.

04-16006-04-en, March 2015

Technical
1225

38 Function Block Programs
38.12 Tasks

38.12

Tasks
Function block and Script programs must be connected to tasks in order to run.
You access Tasks from the Properties dialog box.
The task is a property of the object that defines the program cycles.
When you create a new function block or Script program, Task 3 is the default. This
means that one program cycle executes in 1000 ms.

Figure: Tasks

The way you schedule programs to execute in Script differs from how you schedule
them to execute in Continuum. For more information, see the Script and Plain
English Program Differences topic on WebHelp.
Table: Task Intervals
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Task

Interval

Task 1

0.1 seconds

Task 2

0.5 seconds

Task 3

1 seconds

Task 4

5 seconds

Task 5

10 seconds

04-16006-04-en, March 2015

38 Function Block Programs
38.13 Adding a Task to a Program

38.13

Adding a Task to a Program
To make a Script or Function Block program run, the program must be connected
to a task.
For more information, see section 50.23 “Tasks” on page 1602.

To add a task to a program
1. In WorkStation, in the System Tree pane, select the program you want to
add a task to.
2. On the File menu, click Properties.
3. In the Task box, enter the task you want to add.
4. Click OK.
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38.14

Program Cycles in Building Operation
All programs are executed in the order they are bound in Building Operation. For
example, in programs that are executed in a straight order or in any similar
configuration, Program 4 runs after Program 3 that runs after Program 2 that runs
after Program 1. The first program to be executed is Program 1.
The illustration that follows shows the execution sequence for a straight order
configuration.

Figure: Execution order of programs

When programs are connected in an algebraic loop, the execution order cannot be
determined and the program that runs first needs to be established. In Building
Operation, algebraic loops are called Cycles. In this case, there is no way to
determine the execution order of the programs. Program 4 runs after Program 3
that runs after Program 2 that runs after Program 1 that runs after Program 4.

Figure: In an algebraic loop the execution order of programs cannot easily be determined.

To resolve a cycle and determine which program runs first in the cycle, you use the
execution precedence function. Programs can have execution precedence values
ranging from 0 to 255 where 0 results in the highest priority and 255 results in the
lowest priority. The program with highest execution precedence is always executed
first in the cycle.
Execution Precedence
Values:

Integers ranging from 0 to 255

Highest priority value:

0

Lowest priority value:

255

The execution precedence is configured in the properties for the program. The
default value when you create a new program is 100.
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Figure: Execution precedence

The execution precedence can never override the execution order of programs
based on how they are bound. The execution precedence decides the order in
which the programs are run when they are set up in some form of cycle and the
binding does not give a straight order for which program runs first.
The execution precedence can be used in two different situations:
• To determine the execution order when programs are bound in a cycle.
• As troubleshooting, for example when a there are delays without any known
reason. A long delay might be the result of programs that run in the wrong
order.

38.14.1

Example A
In this example we have four programs that are connected in a cycle. The execution
order cannot be determined from how programs are bound. Program 1 should run
before Program 2, Program 2 before Program 3, and Program 4 before Program 1.
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Figure: Example

However, Program 2 reads from a physical input, Input A, and the information from
this reading is transferred to Program 4, which writes to a physical output, Output
B.

Figure: Example

So, we want to Program 2 to run before Program 4. To do this we use execution
precedence. By configuring the Execution precedence as 99 for Program 2,
Program 2 will be the first program to be executed in the cycle.

Figure: Example

The resulting execution order will be P2, P3, P4 and P1.

Technical
1230

04-16006-04-en, March 2015

38 Function Block Programs
38.14 Program Cycles in Building Operation

38.14.2

Example B
All programs use the default execution precedence that is 100. In this example, it is
not possible to determine the execution order of Program 1 and Program 2 and the
execution order of Program 3 and Program 4. The only thing we can be sure of is
that the cycle with Program 1 and Program 2 is executed before the cycle with
Program 3 and Program 4 due to the fact that Program 3 awaits input from
Program 2.

Figure: Example

To resolve the order we configure Program 2 and Program 3 to have the execution
precedence of 99. Then Program 2 runs before Program 1 in the first cycle and
Program 3 before Program 4 in the second cycle.

Figure: Example

Now the execution order is Program 2, Program 3, Program 4 and Program 1.

38.14.3

Application Scheduler
The Application Scheduler displays the programs execution order and if you have
any cycles in your system. In the System Tree pane, the Application Scheduler is
displayed in the Modules folder. The programs are represented with an entry under
the task they are assigned to.
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Figure: Application scheduler

The object called cycle identifies a cycle. In the properties dialog for the task the
property "Conflict" is set to "True" if there is any cycle in the Task. Conflicts do not
mean that the programs will not run at all. The programs will run but the might run in
an execution order that may cause unnecessary delays from input to output.
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38.14 Program Cycles in Building Operation

Figure: Conflict setting in task 3

Use the List View to see the execution order of the programs.

Figure: Entries in the List View

Entry is the order of execution of the programs for a specific task. In this case
Program 2 executes first followed by Program 4. Program 3 runs last.
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38.15 Configuring the Execution Precedence for a Program

38.15

Configuring the Execution Precedence
for a Program
You configure the highest execution precedence number on the program you want
to be executed first in a cycle.
For more information, see section 50.25 “Program Cycles in Building Operation ” on
page 1604.

To configure the execution precedence for a program
1. In WorkStation, in the System tree pane, select the program.
2. On the File menu, click Properties.
3. In the Execution precedence box, enter a number that is higher than all the
other programs in the cycle.

4. Click OK.
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38.16 Finding Cycles in a Task

38.16

Finding Cycles in a Task
If you encounter unexpected delays in input to output response, the execution
order of the programs in a Task might not optimized.
For more information, see section 50.25 “Program Cycles in Building Operation ” on
page 1604.

To find cycles in a task
1. In WorkStation, in the System Tree pane, in the System folder, open the
Modules, and then ApplicationScheduler foldes.
2. Open a Task.
3. If the Task contains an object called Cycle, a cycle is present.
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38.17 Module Names

38.17

Module Names
You can add a module name to the name of a signal to make the signal name
unique. Using modules in the signal name enables you to divide a large function
block program into separate systems, such as multiple heating groups. This division
provides two major advantages:
• You can use the same signal name in multiple systems, and make them unique
using the module name in the signal name. For example, AHU1\T1_SP and
AHU2\T1_SP.
• All public signals in a module are treated as a group and are located together in
the database when they are imported into Building Operation.
You can enter and edit the module name for a single block or a group of blocks.

Figure: Blocks in Modules

Module Signal Names
Use the following syntax for the module name in a signal name:
Module name\Signal
The module part of a signal name can have a maximum of 12 characters.
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38.18 Default Names

38.18

Default Names
You can let the program generate default names for all function blocks. When you
save a function block program, all public blocks without any Identifier get a default
name. For example, a block of type BI (Binary Input) gets the identifier “BI1”. If more
than one block of the same type is used in the function block program, the blocks
are separated with a continuous series of numbers; BI1, BI2, BI3, and so on.
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38.19 Adding and Editing the Module Name

38.19

Adding and Editing the Module Name
You can add and edit module names in the diagram window.

To add and edit the module name
1. In Function Block Editor, in the diagram window, select the block or group of
blocks you want to name or rename.
2. Right-click the selection and then click Module.

3. In the Module Name box, type the desired module name.
4. Click OK.

The module name is displayed in each function block in the module. The block type
designation of a block in a module is underlined and purple.
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38.20 Adding Default Names to Function Blocks

38.20

Adding Default Names to Function
Blocks
You can save unnamed function blocks under default names generated by the
program.

To add default names to function blocks
1. In Function Block Editor, on the File menu, click Save to save unnamed
function blocks under default names.

All previously unnamed blocks get an identifier referring to the block type and a
number, for example, BI1 and BI2 for Binary input blocks.
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38.21 Searching for a Text String

38.21

Searching for a Text String
You search for a text string when you want to locate certain signals, constants,
comments, modules, or block types.

To search for a text string
1. In Function Block Editor, on the Edit menu, click Search.
2. In the Search for box, type the text string you want to search for.

3. Select Signal-/ Constant Names to search for the text string in signal and
constant names.
4. Select Comment Text to search for the text string in comment texts.
5. Select Module Names to search for the text string in module names.
6. In the Block Types list, select the block type to search in.
7. Select Match case to match the letter case in the text string.
8. Select Whole words to only match whole words in the text string.
9. Click Search Next to start the search.
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38 Function Block Programs
38.21 Searching for a Text String

The text is displayed in the Text in Found Block area and the blocks containing the
text are selected.
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38.22 Replacing a Text String

38.22

Replacing a Text String
You search for and replace a text string in a function block program to locate a
certain block or function.

To replace a text string
1. In Function Block Editor, on the Edit menu, click Replace.

2. In the Search for box, type the text string to replace.
3. In the Replace with box, type the text string to replace with.
4. Select Signal-/ Constant Names to search for the text string in signal and
constant names.
5. Select Comment Text to search for the text string in comment texts.
6. Select Module Names to search for the text string in module names.
7. In the Block Types list, select the block type to search.
8. Select Case sensitive to match the letter case in the text string.
9. Select Whole words to match whole words in the text string.
10. Click Search Next to search for the text string.
11. Click Replace to replace the text string.
12. Click Search Next if you want to search for the text string again.

Note
• To replace text strings in all blocks, click Replace All.
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38.23 Program Conversion

38.23

Program Conversion
In Function Block Editor, the programming principles and features are quite different
from the programming principles of Menta Editor. In Function Block Editor, the
functionality is built up by program modules, but in Menta Editor the functionality is
typically built up by logical blocks into a single large program.
It is still possible to import and save Menta programs for Xenta 280/300/401 into
Function Block Editor. When you save the program it is saved as a function block
program, that is, an .AUT file. Some of the blocks that were available for Xenta
280/300/401 controllers in Menta are automatically converted into new blocks
when you save the program in Function Block Editor. Some of the converted blocks
lose their configuration data but are necessary for non-public blocks to function
properly.
The following conversions are made:
• AI blocks are converted into RI blocks.
• AO blocks are converted into RO blocks.
• ALARM blocks are converted into modified ALARM blocks, with inputs and
outputs but no parameters. The block acts as an input/output between the
function block program and Building Operation, but because of the alarm
capabilities in Building Operation, it is often unnecessary to keep the alarm
handling in the function block program. When imported into Function Block
Editor, Alarm blocks in Menta programs generate Change of State alarm
objects in Building Operation. You have to configure the alarms from
WorkStation. You can mass create alarms in Building Operation. For more
information, see the Alarm Functions topic on WebHelp.
Because of the improved capabilities in Building Operation alarm, it is often
possible to remove logic in Menta connected to alarm handling
• CNT blocks are converted into PI blocks connected to control inputs.
• DI blocks are converted into BI blocks.
• DO blocks are converted into BO blocks.
• DOPU blocks are converted into PO blocks.
• ERR blocks are converted into ERROR blocks.
• TSCH blocks are converted into TSCHI blocks, with inputs only. The block acts
as an input from the time schedule in Building Operation into the function block
program.
• Trend logs are lost and have to be manually recreated in Building Operation.
You can mass create trend logs in Building Operation. For more information,
see the Trend Log Functions topic on WebHelp.
• The bindings to physical I/Os are lost. You have to create the I/O point list in
Building Operation and then recreate the bindings either manually or by using a
binding template. For more information, see section 38.10 “Binding Values
Using a Binding Template” on page 1220.
• SNVTs are converted into RI/RO blocks.
• The .MTA file is converted into an .AUT file. For more information, see section
37.4 “Function Block Editor File Type” on page 1195.
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38.24

Importing a Xenta 280/300/401
Program
You import a Xenta 280/300/401 program to Function Block Editor to reuse its
functions in an Automation Server.

To import a Xenta 280/300/401 program
1. In Function Block Editor, on the File menu, click Import.
2. Enter the name of the Menta program you want to import.
3. Click Open.

4. Click Yes.
The Menta program is now converted into a function block program is now
uploaded and can be edited in Function Block Editor.
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39 Function Blocks
39.1 Edit Mode

39.1

Edit Mode
You use Edit mode when designing the function block program. In Edit mode you
add and edit blocks and connections.

39.1.1

Function Block Programming
You work with graphical elements that contain functionality. You put the elements
together to get a function block program that can be used in an Automation Server.
For more information, see section 45.1 “Function Block Programming” on page
1333.

39.1.2

Programming Phases
When you program an Automation Server, the work can be divided into three
fundamental phases:
• Function phase: analyze the requirements
• Design phase: program the function block program
• Test phase: simulate the functionality of the function block program
For more information, see section 37.9 “Programming Phases” on page 1203.
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39 Function Blocks
39.2 Changing to Edit Mode

39.2

Changing to Edit Mode
You change from Simulation mode to Edit mode to edit your function block
program.
For more information, see section 37.11 “Operation Modes” on page 1205.

To change to Edit mode
1. In Function Block Editor, on the Options menu, click Edit.
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39.3 Duplicating a Function Block

39.3

Duplicating a Function Block
You create an empty function block to get a function block of a certain type but
without any specific parameters. You cannot duplicate Hierarchical Function Blocks
(HFB) using the Duplicate command.

To duplicate a function block
1. In Function Block Editor, in the diagram window, right-click the block you want
to duplicate and then click Duplicate.

2. Move the duplicate block to a suitable position in the diagram window.
3. Clear the function block selection.
You can now edit the name and parameters of the new block.
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39 Function Blocks
39.4 Selecting a Function Block

39.4

Selecting a Function Block
You select a function block if you want to move or copy it.

To select a function block
1. In Function Block Editor, in the diagram window, drag the pointer around the
block.

The block is now enclosed in a green rectangle and you can move or copy it.
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39.5 Copying a Selection to the Clipboard

39.5

Copying a Selection to the Clipboard
You copy a selection to the clipboard when you want to export it to metafile
formatted function block programs.

To copy a selection to the clipboard
1. In Function Block Editor, in the diagram window, select the group of function
blocks you want to copy.
2. On the Edit menu, click Copy To Clipboard.
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39 Function Blocks
39.6 Clearing a Function Block Selection

39.6

Clearing a Function Block Selection
You clear a selection of blocks and connections that you no longer want to move or
copy.

To clear a function block selection
1. In Function Block Editor, in the diagram window, click outside the green
rectangle that encloses the block.

The function block selection is cleared.
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39.7 Printing a Selection

39.7

Printing a Selection
You print a selection when you want to print only a part of a function block program.

To print a selection
1. In Function Block Editor, in the diagram window, select the function block you
want to print.
2. On the File menu, click Print.
3. Under Options, select Scale Output to one page.

Continued on next page
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39 Function Blocks
39.7 Printing a Selection

4. Click Print.
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39.8 Moving a Function Block

39.8

Moving a Function Block
You can move a function block to a new position in the diagram window.

To move a function block
1. In Function Block Editor, in the diagram window, select the function block you
want to move.

2. Drag the selected function block to a new position.

3. Click outside the function block to clear the selection.
The block is now moved to its new location.
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39 Function Blocks
39.9 Copying a Function Block

39.9

Copying a Function Block
You copy function blocks whose parameters and connections you want to reuse.

To copy a function block
1. In Function Block Editor, in the diagram window, select the function block you
want to copy.
2. On the Edit menu, click Copy.
3. On the Edit menu, click Paste.

4. Drag the block from the top left corner to a new position in the diagram
window.
You can now change the block parameters.
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39.10 Deleting a Function Block

39.10

Deleting a Function Block
You can delete a function block that you no longer want in the function block
program.

To delete a function block
1. In Function Block Editor, in the diagram window, select the function block you
want to delete.

2. On the Edit menu, click Delete.
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39 Function Blocks
39.11 Naming a Function Block

39.11

Naming a Function Block
You name a function block to make it unique, which is required to avoid conflicts in
the function block program. You can also add a description for the block.
For more information, see section 37.1 “Graphical Programming” on page 1189.

To name a function block
1. In Function Block Editor, in the diagram window, right-click the block you want
to name..
2. On the BLOCK menu, click Edit.
3. In the Identifier box, type a name for the block.

4. In the Description box, type a description for the block.
5. Click OK.
The block name is displayed at the top of the block in the diagram window.
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39.12 Selecting a Group

39.12

Selecting a Group
You select a group of blocks in the diagram window to be able to perform an action
on multiple blocks. A connection is only partially selected if either the starting point
or the end point of the connection is selected. A connection is completely selected
if the starting point and end point are selected.

To select a group
1. In Function Block Editor, in the diagram window, drag the pointer around all
the blocks and connections you want to select.

The group is now selected and you can move, delete or copy it.
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39 Function Blocks
39.13 Centering a Group

39.13

Centering a Group
You can center a group to display a selection of blocks and connections in the
center of the diagram window.

To center a group
1. In Function Block Editor, in the diagram window, select all the blocks and
connections you want to center.
2. On the Edit menu, click Center Selection.

Note
• The selection shifts what is displayed in the center of the diagram
window. It does not move any blocks or connections.
• Selections to the far left or at the top are not centered as well as
selections made at the bottom or to the right in the diagram
window.

•
The program centers the selection as well as possible.
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39.14 Moving a Group

39.14

Moving a Group
You can move a group of function blocks in the diagram window.

To move a group
1. In Function Block Editor, in the diagram window, select all the blocks and
connection you want to move.
2. Drag the selected group to a new position.

3. Click outside the selection to clear the selection.
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39 Function Blocks
39.15 Deleting a Group

39.15

Deleting a Group
You can delete all function blocks in a group.

To delete a group
1. In Function Block Editor, in the diagram window, select the blocks and
connections you want to delete.

2. On the Edit menu, click Delete.

Technical
1262

04-16006-04-en, March 2015

39 Function Blocks
39.16 Copying a Group

39.16

Copying a Group
You can copy blocks and connections in a function block program.

To copy a group
1. In Function Block Editor, in the diagram window, select all the blocks and
connections you want to copy.
2. On the Edit menu, click Copy.
3. On the Edit menu, click Paste.

The copy is located at the top and to the left in the diagram window. You can now
move it to another position in the function block program and edit the block
parameters.
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39.17 Disconnecting a Group

39.17

Disconnecting a Group
You can disconnect all function blocks in a group from blocks outside the group.

To disconnect a group
1. In Function Block Editor, in the diagram window, select the group.
2. Right-click inside the selection.
3. Click Disconnect.

The connections between the blocks inside the group and blocks outside the group
are removed. The connections between the blocks within the group are kept.
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40 Hierarchical Function Blocks
40.1 Hierarchical Function Blocks

40.1

Hierarchical Function Blocks
In Function Block Editor, you use hierarchical function blocks referred to as HFBs to
get an overview of a function block program. An HFB is a graphical solution for
grouping and structuring function blocks.
You can print or view a function block program with HFBs on the screen. You can
download the function block program to an Automation Server as an ordinary
function block program, not as HFBs.
You can create HFBs two ways:
• You can create an empty HFB and then add function blocks and connections.
• You can create a function block program from a group of existing function
blocks and connections, and then split it into hierarchical function blocks.
You can create one or more HFBs in another HFB.

Important
• If you create or rename a function block program that includes an HFB, the
HFB and all its lower levels are included in this function block program.
HFBs have their own inputs and outputs.
An HFB with at least one public signal has a red dot in the upper right corner of the
HFB symbol. The red dot is also used when the public signal is located in an
embedded HFB.
The figures below show an HFB on the top level, as well as on the expanded level.

Figure: HFB on top level
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40 Hierarchical Function Blocks
40.1 Hierarchical Function Blocks

Figure: HFB on expanded level

You can add and connect blocks for the function block program in the HFB function
block diagram the same way as an ordinary function block diagram. You use HFB
I/O blocks to connect signals from the HFB to other levels in the hierarchical
function block diagram.
You connect the HFB signals to function blocks outside the HFB by using the HFAI,
HFAO, HFDI, and HFDO blocks.
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40.2 Creating an Empty HFB

40.2

Creating an Empty HFB
You can create an empty HFB in which you can structure your function block
program in a hierarchy.
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To create an empty HFB
1. In Function Block Editor, in the diagram window, right-click and then click
HFB.
2. In the Identifier box, type a name for the hierarchical function block.

3. In the Description box, type a description of the HFB.
4. Click OK.
The empty HFB is added to the diagram window at the position where you rightclicked.
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40.3 Adding an HFB I/O Block

40.3

Adding an HFB I/O Block
You add HFB I/O blocks to connect the HFB signals to function blocks outside the
HFB.
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To add an HFB I/O block
1. In Function Block Editor, in the diagram window, double-click to expand the
HFB.
2. In the diagram window, right-click and then click HFB I/O.
3. In the HFB I/O types list, click the type of input or output you want to create.

4. Click OK.
5. In the Identifier box, type a name for the signal.

6. Click OK.

Note
• The signals within the HFB must have unique names. The input
and output blocks are only displayed when the HFB is expanded
and the signals cannot be made public.
The HFB I/O is added to the HFB in the diagram window.
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40.4 Creating an HFB of Existing Function Blocks

40.4

Creating an HFB of Existing Function
Blocks
You create an HFB of existing function blocks to create a hierarchy of function
blocks.

Important
• When an HFB has been created, it cannot be reverted to its original flat
structure.
• When you create an HFB of a group of blocks and connections, the required
input and output block types HFAI, HFAO, HFDI, and HFDO are automatically
created and use the existing signal names.
• Do not change the name of the blocks (HFAI, HFAO, HFDI and HFDO).
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To create an HFB of existing function blocks
1. In Function Block Editor, in the diagram window, select all function blocks and
connections you want to save as an HFB block.
2. Right-click the selection and then click Create HFB.

3. In the Edit Hierarchy dialog box, in the Identifier box, type a name for the
HFB.
4. In the Description box, type a description of the HFB.
5. Click OK.
6. Click Save.
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40.5 Expanding an HFB

40.5

Expanding an HFB
You expand an HFB to view the structure of the function blocks in the HFB.
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To expand an HFB
1. In Function Block Editor, in the diagram window, right-click the HFB function
block and then click Expand HFB.

The expanded HFB is displayed and contains the input and output block types
HFAI, HFAO, HFDI, and HFDO.

Note
• The displayed HFB I/Os are only symbols used to show the connections to
the higher level in the function block diagram structure.
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40.6 Compressing an HFB

40.6

Compressing an HFB
You compress an HFB to show the HFB on the higher level in the diagram window.
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To compress an HFB
1. In Function Block Editor, in the diagram window, right-click the expanded HFB
and then click Compress HFB.
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40.7 Navigating in a Hierarchical Structure of HFBs

40.7

Navigating in a Hierarchical Structure of
HFBs
You can navigate in a hierarchical function block using the HFB Navigation Tree.
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To navigate in the hierarchical structure of HFBs
1. In Function Block Editor, on the Options menu, click Show HFB
Navigation Tree.

Continued on next page
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40.7 Navigating in a Hierarchical Structure of HFBs

2. In the HFB Navigation Tree dialog box, click the HFB.
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40.8 Printing an HFB

40.8

Printing an HFB
You can print either a single HFB or all levels of a function block diagram.
For more information, see section 40.1 “Hierarchical Function Blocks” on page
1265.

To print an HFB
1. In Function Block Editor, on the File menu, click Print.

2. In the FBD area, select FBD.
3. Select a level to print: Click Current Level to print only the current level of the
HFB. Click All levels, to print each HFB level on separate pages, with the
name and the page number of the HFB at the bottom of the page.
4. Click Print.
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41 Macros
41.1 Function Block Editor Macros

41.1

Function Block Editor Macros
Macros in Function Block Editor, are small function block programs that contain
useful functions you want to reuse.
By saving existing function block programs or parts of them as macros, you can
reduce time when designing a function block program. A number of pre-tested
macros are delivered with Function Block Editor and stored in the following location:
• Windows 7 and Windows 8.1: \ProgramData\Schneider Electric
StruxureWare\Building Operation x.x\WorkStation\Function Block Editor
x.x indicates the Building Operation version number.
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41 Macros
41.2 Function Block Editor Macro Commands

41.2

Function Block Editor Macro Commands
Macro commands are texts written in Comments, used to reduce time when
designing a function block program.
You use macro commands to replace generic text strings with site-specific texts,
display messages when you upload macros to Function Block Editor, display
reminders, or play sounds when you open a function block program.
Macro commands are executed as they appear in the Comment, from top to
bottom. For example, the first Replace command replaces the first text string in all
blocks. The second Replace command replaces the second text string, and so on.

Macro Command Syntax
You create macro commands by entering one or more of the following commands
in a comment:
• $REPLACE$ – text appears once and is replaced by _REPLACE$ when you
have entered a new text.
Syntax example: $REPLACERoofUnit$
• $MESSAGEBOX$ – Message appears once and is replaced by
_MESSAGEBOX$ when it has been displayed once.
Syntax example: $MESSAGEBOXText$
• $REMINDER$ - Reminder appears every time you open the function block
program file.
Syntax example: $REMINDERText$
• $PLAYSOUND$ - is played every time you open the function block program
file.
Syntax example: $PLAYSOUNDC:\MySounds\Soundfilename.wav$

Note
• You can use a macro command in more than one comment.
• You can mix macro commands with ordinary text in comments.
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41.3 Saving a Macro

41.3

Saving a Macro
You save a part of a function block program as a macro to make the function
accessible for future use.
For more information, see section 41.2 “Function Block Editor Macro Commands”
on page 1278.

To save a macro
1. In Function Block Editor, in the diagram window, select all function blocks and
connections you want to include when saving the macro.
2. Right-click the selection and on the GROUP menu, click Save to save part of
the function block program.
3. Enter the location where you want to save the macro.
4. In the File name box, type a file name for the macro.

5. Click Save.
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41.4 Loading a Macro

41.4

Loading a Macro
You can load a function block macro (part of a function block program) into a
function block program. When you load the function block macro its constants are
automatically added to the constants table.
For more information, see section 41.2 “Function Block Editor Macro Commands”
on page 1278.

To load a macro
1. In Function Block Editor, right-click in the diagram window.
2. On the NEW menu, click Load Macro.

3. In the File name box, enter the name of the function block program you want
to load.
4. Click Open.

The imported function block program is added to the existing function block
program and selected.
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41.5

Replacing a String
You can replace text strings in function block names, function block parameters,
and comments, for example, to apply a naming convention on blocks with text
strings. Macro commands replace the command text strings in the comments. If
you save the macro again, it will use the replacement strings.
For more information, see section 41.2 “Function Block Editor Macro Commands”
on page 1278.

To replace a text string
1. In Function Block Editor, in the diagram window, right-click and then click
Comment.
2. Type '$REPLACE', the text string you want to replace, and then '$'.

3. Click OK.

4. Save the function block program and exit Function Block Editor.
5. In WorkStation, right-click the saved function block program and then click
Edit.
6. In the Macro Replace dialog box, in the With box, type the text string you
want to replace the existing text string with.

Continued on next page
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7. Click OK.
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41.6

Adding a Message Box
You add a message box to get a text box that opens every time you open the
function block program for editing.
For more information, see section 41.2 “Function Block Editor Macro Commands”
on page 1278.

To add a message box
1. In Function Block Editor, in the diagram window, right-click and then click
Comment.
2. Type '$MESSAGEBOX$' and then type the text you want to display in the
message box.

3. Click OK.
4. Save the function block program and exit Function Block Editor.
5. In WorkStation, right-click the saved function block program and then click
Edit.
6. Click OK.
The message box opens every time you open the function block program for
editing.
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41.7

Adding a Reminder
You add a reminder box to get a text box that opens every time you open the
function block program for editing.
For more information, see section 41.2 “Function Block Editor Macro Commands”
on page 1278.

To add a reminder
1. In Function Block Editor, in the diagram window, right-click and then click
Comment.
2. Type '$REMINDER$' and then type the text you want to display in the
reminder box.

3. Click OK.
4. Save the function block program and exit Function Block Editor.
5. In WorkStation, right-click the saved function block program and then click
Edit.
6. Click OK.
The message box for the REMINDER macro command displays the reminder every
time the function block program is opened for editing.
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41.8

Adding a Sound
You add a sound to play a sound file every time you open the function block
program for editing. The sound file has to be located in the same folder as the
macro file (.AUT).
For more information, see section 41.2 “Function Block Editor Macro Commands”
on page 1278.

To add a sound
1. In Function Block Editor, in the diagram window, right-click and then click
Comment.
2. Type '$PLAYSOUND$' and then type the name of the .wav sound file you
want to use.

3. Click OK.
4. Save the function block program and exit Function Block Editor.
5. In WorkStation, right-click the saved function block program and then click
Edit.
6. Click OK.
The sound file is played every time you open the function block program for editing.
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42 Constants
42.1 Constants

42.1

Constants
Constant names are alphanumerical strings of up to 20 characters. A constant
name must have at least one letter.
You can create constants separately or when you configure parameters in a
function block.
If you create a constant when you configure parameters in a function block, you
select the use of the constant by entering a text string instead of a numerical value
for the parameter in the function block. The text string is the identifier for the
constant.
Constants can be declared as either public or internal. By definition, a constant
cannot be modified by the function block program in which it is declared. When you
declare a constant as public, it can be accessed and modified from other nodes on
the network.

42.1.1

Public Constants
To give better access to parameters in function blocks, you can use public
constants instead of numerical values. The use of a public constant also allows
access to the value from other nodes on the network.
A small circle to the right of the parameter field in a function block indicates that a
public constant is used.

Figure: Public constant

By default, the module name of a public constant is the same as the module name
of the block. The module name of the public constant is not displayed in the
function block program unless it differs from the module name of the block.
Public constants in a function block program are listed in the program specification
and can be of the following types:
• Binary constants (PVB)
• Integer constants (PVI)
• Real constants (PVR)
Depending on whether other nodes are allowed to read and/or modify the constant
value, constants are read-only or read/write. You can change the value of a public
constant only in Simulation mode. Values of internal, that is non-public, constants
can be viewed but not modified. If a value for a public constant is modified from the
Constants Table, the source code for the function block program is changed. The
source code is not changed if the modifications are made during a simulation in
tabular mode.
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Important
• Public constants can be modified over the network as well during runtime.
• A public constant in Function Block Editor can only be assigned to one
function block parameter.
• An internal constant can be assigned to any number of function block
parameters. Non-public constant names are substituted with the
corresponding numerical values when the FBD is compiled.
• A public constant cannot have the same name as a public signal.
• Public constants are not allowed in expression blocks, or in operators.
• Public constants are not allowed inside the binding parameters of IO blocks.
• A constant used as a parameter in a function block is not removed from the
Constants Table when the function block is deleted.
You should always name blocks containing public constants so that the constants
can retrieve/change module names.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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42.2

Using a Constant
You can make parameters in function blocks accessible from the function block
program by using public constants instead of numerical values.

To use a constant
1. In Function Block Editor, in the diagram window, right-click the function block
and then click Edit.
2. In the Parameter box, type a text string (identifier) instead of a numerical
value to use the value of the constant as the parameter setting.

3. Click OK.
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42.3

Making a Constant Public
You define a constant as public to make it available to other nodes on the network,
and to make it editable from the function block program.
For more information, see section 42.1 “Constants” on page 1289.

To make a constant public
1. In Function Block Editor, in the diagram window, right-click the function block
that contains the constant and then click Edit.
2. Select Public.

3. Click OK.
The constant is now available to other nodes on the network and can be edited
from the function block program.
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42.4

Deleting All Unused Constants
You can simultaneously delete all unused constants.
For more information, see section 42.1 “Constants” on page 1289.

To delete all unused constants
1. In Function Block Editor, on the Options menu, click Constants Table.

2. Click Delete Unused.

3. Click Exit.
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42.5

Deleting a Constant
You delete a constant when it is no longer needed.

To delete a constant
1. In Function Block Editor, on the Options menu, click Constants Table.

2. Select the constant.
3. Click Delete.

4. Click Exit.
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42.6

Editing a Constant
You edit a constant to change its properties. All properties are editable, with the
exception of the identifier.
For more information, see section 42.1 “Constants” on page 1289.

To edit a constant
1. In Function Block Editor, on the Options menu, click Constants Table.
2. Double-click the constant you want to edit.
3. In the Value box, type the value.

4. Select Public to get a public constant.
5. In the Unit box, select unit for the constant.
6. In the Description box, type a description for the constant.
7. Click OK.
8. Click Exit.
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42.7

Adding a Constant
You add a constant value to a function block program by adding it to the Constants
Table.
For more information, see section 42.1 “Constants” on page 1289.

To add a constant
1. In Function Block Editor, on the Options menu, click Constants Table.
2. Click Add.
3. In the Identifier box, type a name for the constant.

4. In the Value box, type the value of the constant.
5. Select Public to make the constant public.
6. In the Unit box, select a unit for the constant.
7. In the Description box, type a description for the constant.
8. Click OK.
9. Click Exit.
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42.8

Changing the Value of a Constant
You can change the value of a constant.

Important
• You can only change values for public constants in Simulation mode.
• You can view but not change values for internal constants.
• Values for public constants, modified from the Constants Table, update the
source code for the function block program, except when changes are made
during a simulation in tabular mode.

To change the value of a constant
1. In Function Block Editor, in Simulation mode, on the Options menu, click
Constants Table.
2. In the Constants Table dialog box, double-click the constant.
3. In the Edit constant dialog box, enter the required value.

4. Click OK.
5. Click Exit.
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43.1 Signals

43.1

Signals
The signals in a function block program are variables. These variables are generated
as outputs of function blocks and are transferred to inputs in other blocks by using
connections.
All function blocks in Function Block Editor have one output only. Each function
block generates a unique signal.

43.1.1

Signal Types
Three types of signals are used in Function Block Editor:
• Integer: Signed 16 bit number (range: –32768 to 32767).
• Real: Signed real 32 bit number in the IEEE format with a precision of 6 digits
(range: 3.4x10-38 to 3.4x1038).
• Binary: 1 bit to represent binary values (0/1 = FALSE/TRUE).
Normally, you can only connect outputs to inputs of the same type in the function
block program.

43.1.2

Public Signals
By declaring the signals of interest as public signals, you make them readable and
they can be modified outside the function block program. Many signals in a function
block program represent intermediate values. In most function block programs, only
a few of the signals in the function block program are useful to other nodes on the
network.
All public signals in the function block program are compiled in the Public Signal
Table, an automatically compiled part of the program specification.

43.1.3

Accessing Signals
The permissions for a user to view, enter, or modify a block output signal are
defined by the access class for the signal. The following classes are used:
• Read-only (RO): The signal can be read from other nodes on the network, but
not modified.
• Read/write (RW): The signal can be read and modified from other nodes on the
network.
The signals in blocks where the computed output value depends only on the
current value(s) of the input signal(s) are read-only (RO).
If the output of such a block is modified over the network, the modification is
restored by the function block program in the next program cycle. Subsequent
blocks that use the signal can detect and reflect the transitory change.
For other block types, such as integrators and accumulators, you can allow external
write operations on the block outputs. For example, when you modify the value of a
block output and the new value is computed by adding or subtracting the
increment of the previous output value.
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43.1.4

Signal Names
In Function Block Editor, public signals have alpha numerical string names of up to
20 characters. In signal names, you can use national character sets. However, you
cannot begin the name with a number and you cannot use any blank spaces. Public
signal names have to be unique. They cannot differ only in using upper and
lowercase characters.
For more information, see section 43.2 “Signal Names” on page 1303.
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43.2

Signal Names
In Function Block Editor, public signals have alpha numerical string names of up to
20 characters. In signal names, you can use national character sets. However, you
cannot begin the name with a number and you cannot use any blank spaces. Public
signal names have to be unique. They cannot differ only in using upper and
lowercase characters.
The module name does not count in the 20 character limit. For more information,
see section 38.17 “Module Names” on page 1234.

Unsupported characters
The following characters are reserved for use as separators or system object
identifiers in monitoring and supervising systems and cannot be used: comma ( , ),
semicolon ( ; ), colon ( : ), hyphen ( - ), period ( . ), dollar ( $ ), and apostrophe ( ' ).
Double-quotes are not allowed. If you type a name string with double-quotes
("Signal_name", for example), the double-quotes are deleted when the dialog box is
closed.
The space character (white space) is not allowed. Use the underscore character ( _ )
instead.
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44 Simulation Mode
44.1 Simulation Mode

44.1

Simulation Mode
You use Simulation mode to test and troubleshoot function block programs and to
show the state of the signals. You can run Simulation mode without a connected
Automation Server.
When simulating in Function Block Editor, you can modify the physical inputs in
different ways. One way is to manually alter the input values by using the buttons.
When the value for an input is manually modified, it remains constant until modified
again.
There are buttons for each physical input block in the function block program. The
buttons show the name of the corresponding input block. The buttons are located
on the left side of the diagram window. A scroll bar is displayed if the number of
inputs exceeds the available space.
In Simulation mode, you can start/stop the program execution and alter
values/states, which is useful when troubleshooting a function block program.
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44.2

Changing to Simulation Mode
You change from Edit mode to Simulation mode to test your function block
program.
For more information, see section 37.11 “Operation Modes” on page 1205.

To change to simulation mode
1. In Function Block Editor, on the Options menu, click Simulate.

2. Adjust the size of the diagram window and the trend area by moving the
separation bar between the two panes.
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44.3

Setting Date and Time
You set date and time values in Simulation mode to simulate, for example, time
schedules.

To set date and time
1. In Function Block Editor, in Simulation mode, on the Options menu, click
Set Date And Time.

2. In the Date box, enter the date.
3. In the Time box, enter the time.
4. Click OK.
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44.4

Tiling the Simulation Area Vertically and
Horizontally
You tile the simulation area to change the orientation of the user interface vertically
and horizontally.
For more information, see section 37.11 “Operation Modes” on page 1205.

To tile the simulation area vertically and horizontally
1. In Function Block Editor, in Simulation mode, double-click the separation
bar between the diagram window and the trend area.

The simulation areas changes from horizontal to vertical, or vice versa.
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44.5

Simulating One Cycle Only
You simulate the function block program one step at a time to observe the changes
in the program cycle-by-cycle. The cycle number in the Cycle box upper right side
of the window is incremented.
For more information, see section 44.1 “Simulation Mode” on page 1307.

To simulate one cycle only
1. In Function Block Editor, in Simulation mode, on the Commands menu,
click Step.
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44.6

Simulating a Defined Number of Cycles
You define the number of cycles to observe changes, for example, delays.

To simulate a defined number of cycles
1. In Function Block Editor, in Simulation mode, on the Commands menu,
click Execute n Times.
2. In the Number of Cycles box, type the number of cycles.

3. Press ENTER.
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44.7

Starting a Simulation
You start a simulation of a function block program to observe the changes in the
program.
For more information, see section 44.1 “Simulation Mode” on page 1307.

To start a simulation
1. In Function Block Editor, in Simulation mode, on the Commands menu,
click Execute.
The simulation toggles between start and stop when you click Execute.
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44.8

Setting Analog Simulation Inputs
You simulate the analog inputs of a function block program to ensure that the
function block program behaves as expected.
For more information, see section 44.1 “Simulation Mode” on page 1307.

To set analog simulation inputs
1. In Function Block Editor, in Simulation mode, in the left part of the diagram
window, click the button of the analog input block.

2. In the Value box, type the required value.

Note
• You have to enter values in the engineering unit defined for the
analog input block.

3. Press ENTER.
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44.9

Setting Digital Simulation Inputs
You simulate the digital inputs of a function block program to ensure that the
function block program behaves as expected.
For more information, see section 44.1 “Simulation Mode” on page 1307.

To set digital simulation inputs
1. In Function Block Editor, in Simulation mode, in the left part of the diagram
window, click the button of the digital input block.

The symbols on digital input buttons toggle between open and closed switches
when you click the buttons.
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44.10

Changing from Function Diagram View
to Table View
You can change from graphically viewing the blocks to viewing a table of all blocks
and signals.

To change from function diagram view to table view
1. In Function Block Editor, in Simulation mode, press the F5 function key.

Note
You can toggle between the graphical view and the table view by
pressing F5.

The view shifts from the graphical view to the table view.
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44.11

Adding a Binary Signal to the Recorder
You can record a binary signal in Simulation mode.

To add a binary signal to the recorder
1. In Function Block Editor, in Simulation mode, right-click the function block
with the signal you want to record and then click Record.

Note
• When you record a binary signal, the plot range (scale) for the
signal is always 0 to 1.
One of the six trend channel boxes in the trend logging area shows the name of the
signal you added to the recorder.
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44.12

Removing a Signal from the Recorder
You can remove a signal from the recorder when you no longer want to record it.

To remove a signal from the recorder
1. In Function Block Editor, in Simulation mode, in the trend logging area, rightclick the trend record box and then click Delete.
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44.13

Editing the Range of a Recorded Value
You can change the range of a recorded signal during the simulation.

To edit the range of a recorded value
1. In Function Block Editor, in Simulation mode, right-click in the Trend record
box and then click Edit Range.
2. In the Maximum Value box, type the value.
3. In the Minimum Value box, type the value.

4. Press ENTER.
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44.14

Restarting the Recorder
You restart the recorder to resume recording when you have paused.

To restart the recorder
1. In Function Block Editor, in Simulation mode, right-click anywhere in the
trend logging area and then click Restart.

Note
• When you record a binary signal, the plot range (scale) for the
signal is always 0 to 1.
The recorder continues to display the graphs, starting from the left in the trend
logging area. Previously drawn graphs are left unchanged.
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44.15

Resetting the Recorder
You reset the recorder to remove all defined log signals. Previously drawn graphs
are unchanged.

To reset the recorder
1. In Function Block Editor, in Simulation mode, right-click anywhere in the trend
logging area and then click Reset.
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44.16

Viewing Sampled Values
You can view the logged signals values at any point of time in the trend logging
area.

To view sampled values
1. In Function Block Editor, in Simulation mode, in the trend logging area, click
the point of time where you want to view the value.
2. In the Cycle counter, view the cycle for the sampling value.

3. In the trend record box, view the logged values for the sampling.

4. Right-click the trend logging area when finished.
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44.17

Scanning Sampled Values
You scan the graph to view each sampled value and the cycle it was sampled.

To scan sampled values
1. In Function Block Editor, in Simulation mode, in the trend logging area, click
the point of time.
2. Drag the dotted line.

3. In the recorded signal boxes, view the logged values for each sampling.
4. Right-click the trend logging area when finished.
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44.18

Defining the Sampling Period
You can define the number of times a program is executed between each sampling
period.

To define the sampling period
1. In Function Block Editor, in Simulation mode, on the Commands menu,
click Sampling.
2. In the Cycles per sample box, type the number of program cycles.

3. Press ENTER.
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44.19

Automatically Generated Input Signals
In the Function Block Editor Simulation mode, you can automatically generate signal
variations for physical inputs. You define the conditions for the variations in the
Analog Input or Binary Input dialog box with Automatic mode selected. The
simulated values generated by the input buttons are independent of the IO
configuration parameters for the input. The exception to this is the Time Constant
parameter in the RI block. In the RI block, an automatically generated signal is
filtered using the same filter function as defined by the Time Constant parameter.
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44.20

Automatically Generating an Analog
Input Signal
You can automatically generate signal variations for physical inputs in II, PI, and RI
blocks.

To automatically generate an analog input signal
1. In Function Block Editor, in Simulation mode, in the left part of the diagram
window, right-click the button for the analog input.
2. In the Analog Input dialog box, click Automatic.

3. In the Wave Form box, select the wave form.
4. Select Circular if repeated lapses are required.
5. In the Amplitude box, enter the amplitude.
6. In the Average Value box, enter the value.
7. In the Phase (degrees) box, enter the phase relationship.
8. In the Period (sec) box, enter the period.
9. Click OK.
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44.21

Automatically Generating a Binary Input
Signal
You can automatically generate a binary input signal in a BI block.

To automatically generate a binary input signal
1. In Function Block Editor, in Simulation mode, in the left part of the diagram
window, right-click the button for the digital input.
2. In the Digital Input dialog box, click Automatic.

3. Select Circular if repeated lapses are required.
4. In the Sequence box, type the sequence.
5. In the Period box, enter the period.
6. Click OK.
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44.22

Modifying an Analog Signal
You can modify the value of an analog signal.

To modify an analog signal
1. In Function Block Editor, in Simulation mode, click the block (signal).
2. In the Value box, type the value.

3. Press ENTER.
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44.23

Modifying a Binary Signal
You can modify the value of a binary signal.

To modify a binary signal
1. In Function Block Editor, in Simulation mode, click the block (signal).
2. In the dialog box, select the State option button to simulate a logical one or
clear the State option button to simulate a logical zero.

3. Press ENTER.
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44.24

Viewing Parameters in a Function Block
You can view the internal block parameters as they are shown in the View block
dialog box when you simulate a function block program.

To view parameters in a function block
1. In Function Block Editor, in Simulation mode, in the diagram window, rightclick the block and then click View.
2. In the View block dialog box, view the available values.

3. Click OK.

Note
• When you use a public constant for a block parameter, you can
change the value by using the constants table.
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45 Function Block Programming
45.1 Function Block Programming

45.1

Function Block Programming
You work with graphical elements that contain functionality. You put the elements
together to get a function block program that can be used in an Automation Server.

45.1.1

Simple Blocks
Simple blocks are graphical representations of functions in a function block
program.
For more information, see section 47.1 “Simple Blocks” on page 1367.

45.1.2

Operators
An operator is a type of function, which can perform an operation on one or several
operands.
For more information, see section 48.1 “Operators” on page 1481.

45.1.3

Expression Blocks
Expression blocks are blocks with an expression. You give the expression block its
behavior when you type the expression using input variables, constants, operators
or arithmetical functions. You can use several input variables. The graphic
representation of the blocks varies in size, depending on the expression and the
number of inputs.
For more information, see section 46.1 “Expression Blocks” on page 1351.

45.1.4

Connections
Connections in function block programs transport signals (data) between the
function blocks in the function block diagram. The connection is a link between the
output of one block and one or more inputs of other blocks.
For more information, see section 45.2 “Connections” on page 1335.

45.1.5

Signals
The signals in a function block program are variables. These variables are generated
as outputs of function blocks and are transferred to inputs in other blocks by using
connections.
For more information, see section 43.1 “Signals” on page 1301.
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45.1.6

Macros
Macros in Function Block Editor, are small function block programs that contain
useful functions you want to reuse.
For more information, see section 41.1 “Function Block Editor Macros” on page
1277.

45.1.7

Comments
Comments are graphical containers for text. You use Comments when there is a
need to explain what the function block is supposed to do. Comments are plain text
that is displayed in the function block program. Comments are also the containers
where you write macro commands that are to be used in Function Block Editor.
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45.2

Connections
Connections in function block programs transport signals (data) between the
function blocks in the function block diagram. The connection is a link between the
output of one block and one or more inputs of other blocks.
Connections inherit their data types from the connected outputs. Outputs and
inputs can only be connected when they have the same signal data type.
Connections are formed by straight line segments. The points where line segments
join are called nodes. The corners, formed when connection lines change direction,
are also nodes.

Figure: Connection node

In the function block diagram, binary connections end at an input with an unfilled
arrowhead, and analog (real or integer) connections end at an input with a filled
arrowhead.
A node, joining more than two segments, is displayed as a black circle to
differentiate it from connections crossing each other.
A connection normally starts at a block output and ends at a block input but you
can sometimes use incomplete connections. When a connection is connected to
an output only, the unconnected end is displayed as a black circle. When a
connection is connected to an input only, the unconnected end is displayed as a
black square.

Note
• You cannot compile a function block diagram when there are unconnected
inputs.
• Unconnected inputs must be connected before switching to simulation
mode.
In Function Block Editor, you can draw connections from different starting points in
the diagram.
• Starting at a block output
• Starting at a connection line
• Starting at a node
• Starting in the work area
When you click the output of a function block, the cursor changes to an angled
cross.
When you start moving the cursor, a floating connection line is created and
movements are tracked by an elastic, green line.
When it is necessary to change position or direction of the connection line, you can
fixate the current segment end by clicking once. The floating connection line
changes into a fixed segment and a new floating connection line starts at the break
point.
You can repeat this fixation as many times as necessary, creating a connection
made up of various consecutive segments.
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When you point to an input where you can connect, the cursor changes to a square
around a small angled cross.
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45.3

Connecting a Block Output to a Block
Input
You draw a connection line to connect the output of one function block to the input
of another function block in the diagram window.
For more information, see section 45.2 “Connections” on page 1335.

To connect a block output to a block input
1. In Function Block Editor, in the diagram window, click the output of the block.

2. Drag the pointer to the input of the block you want to connect to.

Tip
When it is necessary to change position or direction of the
connection line, you can fixate the current segment by clicking once.
You can repeat this fixation as many times as needed.

3. Click the input to finish the connection.
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45.4

Creating a Node on a Connection Line
You create a node on a connection line to connect the signal to an additional
function block in the diagram window.
For more information, see section 45.2 “Connections” on page 1335.

To create a node on a connection line
1. In Function Block Editor, in the diagram window, right-click the connection line
at a point where you want to create a node.

2. On the CONNECTION menu, click Create Node.
3. Click where you want to finish the connection.

Tip
When it is necessary to change position or direction of the
connection line, you can fixate the current segment by clicking once.
You can repeat this fixation as many times as needed.

A node shaped as a filled, black circle is created on the connection line at the point
where you right-clicked.
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45.5

Drawing a Connection Line from a Node
You draw a new connection line, starting from a node on an existing connection
line, to make an additional connection.
For more information, see section 45.2 “Connections” on page 1335.

To draw a connection line from a node
1. In Function Block Editor, in the diagram window, click the node.

2. Click where you want the connection line to finish.
A connection line is created on the node.
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45.6

Drawing a Connection Line in the
Diagram Window
You can draw a connection at an arbitrary place on the diagram window.
For more information, see section 45.2 “Connections” on page 1335.

To draw a connection line in the diagram window
1. In Function Block Editor, in the diagram window, right-click a location in the
diagram window where you want to start the connection line, point to Node,
and then click the type of connection (Real, Integer, or Binary) you want to
use.

2. Double-click where you want to finish the connection line.
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45.7

Disconnecting All Connections
You can remove all connections to a function block with a single command.
For more information, see section 45.2 “Connections” on page 1335.

To disconnect all connections
1. In Function Block Editor, in the diagram window, right-click the block and then
click Disconnect.
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45.8

Disconnecting a Connection
You can remove a connection to an input or an output of a function block with a
single command.
For more information, see section 45.2 “Connections” on page 1335.

To disconnect a connection
1. In Function Block Editor, in the diagram window, right-click the connection at
an input or an output, and then click Disconnect.
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45.9

Changing a Connection
You can change a connection from one input to another or one output to another.
The connection lines are not lost.
For more information, see section 45.2 “Connections” on page 1335.

To change a connection
1. In Function Block Editor, in the diagram window, right-click the connection you
want to change and then click Detach.

2. Click the input or output to which you want to connect.
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45.10

Deleting a Connection
You delete a connection or parts of it when you want to disconnect a block or
change the direction of the connection:
• When you right-click the connection close to the output of a block, the whole
connection, including all branches, is deleted.
• When you right-click the connection after a branch, only the part between the
point where you click and the connected input is deleted.
For more information, see section 45.2 “Connections” on page 1335.

To delete a connection
1. In Function Block Editor, in the diagram window, right-click the connection line
you want to delete.

2. On the CONNECTIONS menu, click Delete Node.
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45.11

Detaching a Connection
You detach a connection to an input or output to move it to another input or output.
For more information, see section 45.2 “Connections” on page 1335.

To detach a connection
1. In Function Block Editor, in the diagram window, right-click the connection you
want to detach and then click Detach.
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45.12

Changing the Color of a Connection
Line
You change the color of a connection line to differentiate different lines. For
example, you change the color of a connection to trace signals in a function block
program.
For more information, see section 45.2 “Connections” on page 1335.

To change the color of a connection line
1. In Function Block Editor, in the diagram window, right-click the connection,
point to Mark, and then select color.

The connection is marked with its new color.
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45.13

Changing the Orthogonal Connection
Setting
You change the orthogonal connection setting to draw connection lines in
segments that form 90 degree angles.
For more information, see section 45.2 “Connections” on page 1335.

To change the orthogonal connection setting
1. In Function Block Editor, on the Preferences menu, click Orthogonal
Connections.
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46 Expression Blocks and Comments
46.1 Expression Blocks

46.1

Expression Blocks
Expression blocks are blocks with an expression. You give the expression block its
behavior when you type the expression using input variables, constants, operators
or arithmetical functions. You can use several input variables. The graphic
representation of the blocks varies in size, depending on the expression and the
number of inputs.

Figure: Function Block Editor expression

There is only one output from an expression block. You choose if it should be
binary, integer or real. The name of the block will depend of the type of output
signal.
Table: The Expression Block Characteristics
Name

Description

XPB

Expression block with a binary output.
If the expression result is any value other
than zero, the output is one.

XPI

Expression block with an integer output. The
result of the expression is converted to a 16
bit signed integer.

XPR

Expression block with a real output.
The result of the expression is a real number.

Expression blocks are always read-only. The memory they occupy when compiled
depends on the complexity of the expression.

46.1.1

Expression Block Input Variables
Input variables are declared in the expression using a single letter. An uppercase
letter represents an analog variable and a lowercase letter represents a binary
variable.
You cannot use the same letter in both upper and lowercase, that is, “A” and “a”
cannot be used in the same expression.
The input variables are sorted in alphabetical order on the left side of the expression
block.
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46.1.2

Expression Block Constants
Expression blocks can contain two types of constants:
• Numerical, for example, “5”, “–13”, “0.03”
• Alphanumerical, for example, “PI”, “ENERGY”, “1.25E12”
A numerical constant is an integer portion which can be preceded by a symbol: +
or –. The integer portion cab be followed by a decimal point (.) and a decimal
portion. Finally, an exponential portion can be added: the letters e or E, followed by
an integer with two digits.
Alphanumerical constants are alphanumerical identifiers of 20 significant characters
which must be defined in the Constants Table. The constant name must be placed
between quotation marks if a / (solidus) or : (colon) character is included in the
name.

46.1.3

Expression Block Operators
Expressions have two components: operands and operators. Operands are the
variables, numbers, values, or objects that are being manipulated by operators.
For more information, see section 46.4 “Expression Block Operators” on page
1356.

46.1.4

Expression Block Arithmetical Functions
Arithmetical functions can be used in the expression block to make more complex
calculations.
For more information, see section 46.3 “Expression Block Arithmetical Functions”
on page 1355.
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46.2

Adding an Expression Block
You create a program by adding simple blocks, operators, and expression blocks.
For more information, see section 46.1 “Expression Blocks” on page 1351.

To add an expression block
1. In Function Block Editor, right-click in the diagram window at the position
where you want to add the expression block.
2. On the NEW menu, click Expression.
3. In the Identifier box, type a name for the expression block.

4. In the Unit box, enter the required engineering unit for the output.
5. In the Description box, type a short description that explains the expression.
6. Select Public to make the output signal into a public signal.
7. Click the type of expression you want for the output: Real, Integer, or
Binary.
Continued on next page
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8. In the Expression box, type the expression you want to use to calculate the
output.

9. Click OK.
10. If the block is enclosed by a red rectangle, move the block to an empty space.
11. Click outside the green rectangle that encloses the block to clear the
selection.

Technical
1356

04-16006-04-en, March 2015

46 Expression Blocks and Comments
46.3 Expression Block Arithmetical Functions

46.3

Expression Block Arithmetical Functions
Arithmetical functions can be used in the expression block to make more complex
calculations.
Table: Arithmetical Functions in the Expression Blocks
Syntax

Description

x**y

x raised to the power of y

LN (x)

Natural logarithm of x

LOG (x)

Base 10 logarithm of x

EXP (x)

Exponential e to the power of x

COS (x)

Cosine of x (radians), defined for all x

SIN (x)

Sine of x (radians), defined for all x

TAN (x)

Tangent of x (radians), defined for all x

ACOS (x)

Arc cosine of x, where –1 < x < 1, gives a
result between 0 and /2 radians

ASIN (x)

Arc sine of x, where –1 < x < 1, gives a result
between –p/2 and p/2 radians

ATAN (x)

Arc tangent of x, defined for all x, gives a
result between –/2 and /2 radians

SQRT (x)

Square root of x

ABS (x)

Absolute value of x

INT (x)

Conversion to Integer (truncation)

You can use parentheses in an expression to force an evaluation order to differ from
the precedence order of the operators.
The three types of variables can always be combined with an operator without
problem, since the necessary type conversions are automatically performed
according to the rules described below:
• For the operations +, –, * and /, all values are converted to Real values.
• For the operations %, <<, >>, &, ^ and |, all values are converted to Integer
values (Real values are truncated).
• For the operation !, a Real or Integer value is converted to Binary using the
following rule: if the value is zero, it converts to zero, and if it is non-zero, it
converts to one before logical negation is carried out. A “true” bitwise Not
operation on an integer A can be obtained with the operation A ^ (-1), i.e. A
XOR (-1).
• The operations >, <, >=, <=, =, != convert the operands to Real values,
perform the comparison and return a Binary result.
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46.4

Expression Block Operators
Expressions have two components: operands and operators. Operands are the
variables, numbers, values, or objects that are being manipulated.
In a function block program you can find, for example, “-” (change of sign), “*”
(multiplication), “+” (addition), “>>” (right shift), “<” (less than) and “a ? b : c” (IFTHEN-ELSE statement: “if a then b else c”).
Operators indicate particular actions. For example, if y - 10 is an expression, y and
10 are the operands and the minus sign (-) is the operator. Each expression has at
least one operand and one or more operators.
The Function Block Editor Expression block operands can be manipulated with the
operators, described in the table in order of precedence.
Table: Operators in Expression Blocks
Operator

Description

–,!

Change of sign, logical negation

*, /, %

Multiplication, division and modulus

+,–

Addition, subtraction

<< , >>

Left shift, right shift

<,>

Less than, greater than

<= , >=

Less than or equal to, greater than or equal
to

= , !=

Equal to, not equal to

&

Logical AND (bit wise)

^

Logical Exclusive OR (bit wise)

|

Logical OR (bit wise)

?:

IF-THEN-ELSE statement.
“a ? b : c” means “if a then b else c”.

Note
• Operators in Function Block Editor are equivalent to operators that can be
used in expression blocks. The result is equivalent; each single operator is
compiled to a single expression block, exactly as if it had been written in an
expression block.

Miscellaneous Operators
In an expression block, operands of different types can be combined by using any
operator. However, when you use an operator in the Function Block Editor shortcut
menu, you should perform conversions explicitly.
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The D/A and A/D operators are simply operators that convert from binary to analog
and vice versa. Those operators are needed because the rest of the operators have
typed inputs. That is, without them you would not, for example, be able to
summarize a binary and an analog signal. In expression blocks, conversions are
done implicitly so you do not need to use these operators in expressions. The
conversion rules are as follows:
• A real or integer value is converted to a binary value giving a logical 0 if the
input is exactly 0, or 1 if it is anything but 0.
• A binary value is converted to an analog value as follows: logical 0 gives the
number 0 and logical 1 gives the number 1.
The multiplexer operators are switches, which select one of two input signals
depending on the binary switch value.
The Conversion AA operator is used when connecting an integer output to a real
input or vice versa. Since operators do not distinguish between real and integer
values, the Conversion AA operator does not carry out an explicit type conversion
with rounding or truncation. Instead, this type conversion is done in the block using
the Conversion AA output value as the input. It is recommended that you use
expression blocks when explicit type conversions with rounding or truncation are
required.

04-16006-04-en, March 2015

Technical
1359

46 Expression Blocks and Comments
46.5 Function Block Editor Comments

46.5

Function Block Editor Comments
Comments are graphical containers for text. You use Comments when there is a
need to explain what the function block is supposed to do. Comments are plain text
that is displayed in the function block program. Comments are also the containers
where you write macro commands that are to be used in Function Block Editor.

Figure: Function Block Editor comment
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46.6

Adding a Comment
You add a comment to add a title to a function block program, explain the reason
for adding a certain function, or add information on the changes in a revised
function block program.
For more information, see section 46.5 “Function Block Editor Comments” on page
1358.

To add a comment
1. In Function Block Editor, right-click in the diagram window at the position
where you want to add the comment.
2. On the NEW menu, click Comment.
3. Type the text you want to display in the comment.

4. Click Font.
Continued on next page
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5. Configure the font settings.

6. Click OK.
7. In the Edit comment dialog box, click OK.
8. Click outside the green rectangle that encloses the comment to clear the
selection.
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46.7

Adding a Rectangle
You add a rectangle to make the function block diagram easy to understand, for
example, add a rectangle that encloses function blocks that perform a function
together.

To add a rectangle
1. In Function Block Editor, right-click in the diagram window at the position
where you want the rectangle to begin.
2. On the NEW menu, click Rectangle.
3. Drag the pointer to where you want the rectangle to end.

4. Click where you want the rectangle to end.
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Adding a Simple Block
Connection Blocks
BI – Binary Input
BO – Binary Output
II – Integer Input
IO – Integer Output
PI – Pulse-Counter Binary Input
PO – Pulsed Binary Output
RI – Real Input
RO – Real Output
Time Schedule and Alarm Blocks
ALARM – Alarm
TSCHI – Time Schedule
Accumulator Blocks
ACCUM – Accumulator
INTEG – Integrator
RT – Run-Time Measurement
Non-linear Function Blocks
AHYST – Analog Hysteresis

HYST – Binary Hysteresis
LIMIT – High/Low Signal Limit
MAX – Maximum Signal Selector
MIN – Minimum Signal Selector
Logical Function Blocks
AND – Logical AND Gate
NOT – NOT Gate
OR – OR Gate
PULSE – Pulse Generator
SR – Set-Reset Flip-Flop
TRIG – Trigger
XOR – Exclusive OR Gate
Transformation Function Blocks
CURVE – Curve Function
ENTH – Enthalpy
POLY – Polynomial Function
PRCNT – Percentage
VECTOR – Vectorial Curve Function
Delay Blocks
DELAY – Delayed On/Off
DELB – Binary Value Delay
DELI – Integer Value Delay
DELR – Real Value Delay
SHB – Sample and Hold Binary Value
SHI – Sample and Hold Integer Value
SHR – Sample and Hold Real Value
System Variable Blocks
DATE – Day
ERROR – System Error

Error Codes for the ERROR Function Block
HOUR – Hour
MINUTE – Minute
MONTH – Month
RST – Restart
SECOND – Second
WDAY – Week Day
TCYC – Cycle Time
Controller and Filter Blocks
FILT – First Order Filter
OPT – Optimization
PIDA – PID Controller – Analog Output
PIDI – PID Controller – Incremental Output
PIDP – PID Controller – Analog Output
RAMP – Ramp Filter
SEQ – Sequencer
Signal Source Blocks
NCYC – Program Cycle Counter
OSC – Oscillator
PVB – Parameter Value Binary
PVI – Integer Value Parameter
PVR – Real Value Parameter

47 Function Block Types
47.1 Simple Blocks

47.1

Simple Blocks
Simple blocks are graphical representations of functions in a function block
program.
Each simple block has a number of inputs and parameters and one simple block
generates a single output signal.
The parameters in a simple block are always a numerical value or a list of numerical
values within a predetermined range for each type of parameter.
There are two ways to specify the numerical value:
• By using a decimal number in exponential format.
• By using an identifier of 20 significant characters which must be defined in the
Constants Table.
In the description of a block the following information is provided:
Table: Block Characteristics and Their Descriptions
Characteristics

Description

Identifier

Defines the name of the block.

Unit

Defines the measurement unit of the block.

Inputs

Defines the input types and briefly explains
their function.

Parameters

Defines the functional block parameters and
briefly explains their meaning.

Output Types

Defines the data type of the block output.
When two blocks are connected, the output
type should coincide with the input type.

Access

Defines whether the signal exported by the
block is read-only (RO) or read/write (R/W).

Description

A brief functional description of the block.

Figure: Simple block example

47.1.1

Connection Blocks
You use connection blocks to connect signals to and from a function block
program.
For more information, see section 47.3 “Connection Blocks” on page 1374.
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Table: Connection Block Names and Their Descriptions

47.1.2

Name

Description

RI

Real input connection block

RO

Real output connection block

II

Integer input connection block

IO

Integer output connection block

PI

Pulse counting, digital input connection
block

PO

Pulse width modulated output connection
block

BI

Boolean input connection block

BO

Boolean output connection block

Signal Source Blocks
Signal sources are function blocks that can give signals into the function block
program.
For more information, see section 47.66 “Signal Source Blocks” on page 1473.
Table: Signal Source Names and Their Descriptions

47.1.3

Name

Description

NCYC

Program cycle counter Single source block

OSC

Oscillator, gives a pulse train

PVB

Binary value parameter

PVI

Integer value parameter

PVR

Real value parameter

Logical Function Blocks
A Logical function block adds logical operations to a function block program.
For more information, see section 47.25 “Logical Function Blocks” on page 1403.
Table: Logical Function Names and Their Descriptions
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Name

Description

AND

AND function on two binary signals

NOT

Inverts a binary signal
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Continued

47.1.4

Name

Description

OR

OR function on two binary signals

PULSE

Mono-stable pulse generator (signal)

SR

Set/Reset flip-flop

TRIG

Trigger, true on input change of state

XOR

XOR function on two binary signals

Non-linear Function Blocks
Non-linear function blocks are used for min and max limitations of signals.
For more information, see section 47.19 “Non-linear Function Blocks” on page
1395.
Table: Non-linear Function Names and Their Descriptions

47.1.5

Name

Description

AHYST

Analog hysteresis

HYST

Binary hysteresis (relay function)

LIMIT

Max/Min limit

MAX

Maximum value of two signals

MIN

Minimum value of two signals

Delay Blocks
A Delay block delays a signal in one of a number of ways.
For more information, see section 47.39 “Delay Blocks” on page 1424.
Table: Delay Block Names and Their Descriptions
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Name

Description

DELAY

Delay on or off

DELB

Delays a binary value one cycle

DELI

Delays an integer value once cycle

DELR

Delays a real value one cycle

SHB

Maximum vale of two signals

SHI

Sample and hold a binary value
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Continued

47.1.6

Name

Description

SHR

Sample and hold a real value

Controller and Filter Blocks
Controller and Filter blocks control and filter signals in a function block program.
For more information, see section 47.58 “Controller and Filter Blocks” on page
1448.
Table: Controller and Filter Names and Their Descriptions

47.1.7

Name

Description

FILT

First order filter

OPT

Start/Stop time optimization

PIDA

PID controller (analog output)

PIDI

PID controller (increased/decreased output)

PIDP

Improved PID controller (analog output)

RAMP

Ramp filter (rate limit)

SEQ

Sequencer

Accumulator Blocks
The Accumulator block is used to accumulate the total consumption from an
incremental input (the consumption during one program cycle).
For more information, see section 47.15 “Accumulator Blocks” on page 1388.
Table: Accumulator Names and Their Descriptions

47.1.8

Name

Description

ACCUM

Real accumulator

INTEG

Integrator

RT

Running time measurement

System Variable Blocks
The System variable blocks have no inputs. The blocks display values from the
system clock or the system program.
For more information, see section 47.47 “System Variable Blocks” on page 1436.
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Table: System Variable Names and Their Descriptions

47.1.9

Name

Description

DATE

Actual date

ERROR

System error

HOUR

Actual hour

MINUTE

Actual minute

MONTH

Actual month

RST

Restart. The output is activated the first
execution

SECOND

Actual second

TCYC

Cycle time for the Function Block Program
module

WDAY

Actual day of the week. 1=Monday

Time Schedule and Alarm Blocks
Time Schedules and Alarms blocks define time control and alarm handling in a
function block program. Time schedules and alarms are configured in WorkStation
and executed outside the function block program.
For more information, see section 47.12 “Time Schedule and Alarm Blocks” on
page 1384.
Table: Time Schedule and Alarm Names and Their Descriptions

47.1.10

Name

Description

ALARM

Initiates alarm message

TSCHI

Time schedule block

Transformation Function Blocks
Transformation function blocks include blocks that transform signals in various
ways in a function block program.
For more information, see section 47.33 “Transformation Function Blocks” on page
1413.
Table: Transformation Functions Names and Their Description
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Name

Description

CURVE

Partially linear curve function

ENTH

Enthalpy calculation
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Name

Description

POLY

Polynomial transformation function

PRCNT

Percentages transformation function

VECTOR

Vectorial transformation function
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47.2

Adding a Simple Block
You create a program by adding simple blocks, operators, and expression blocks.
For more information, see section 47.1 “Simple Blocks” on page 1367.

To add a simple block
1. In Function Block Editor, right-click in the diagram window at the position
where you want to add the simple block.
2. On the NEW menu, click Simple Block.
3. In the block type list, select the type of simple block you want to add.

4. Click OK.
5. If the block is enclosed by a red rectangle, move the block to an empty space.
6. Click outside the green rectangle that encloses the block to clear the
selection.
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47.3

Connection Blocks
You use connection blocks to connect signals to and from a function block
program.

47.3.1

BI
The BI block is a binary input to a function block program.
For more information, see section 47.4 “BI – Binary Input” on page 1376.

47.3.2

BO
The BO block is a binary output from a function block program.
For more information, see section 47.5 “BO – Binary Output ” on page 1377.

47.3.3

II
The II block is an integer input to function block program.
For more information, see section 47.6 “II – Integer Input” on page 1378.

47.3.4

IO
The IO block is an integer output from function block program.
For more information, see section 47.7 “IO – Integer Output ” on page 1379.

47.3.5

PI
The PI function block counts the number of pulses on the input during one
execution of a function block program.
For more information, see section 47.8 “PI – Pulse-Counter Binary Input” on page
1380.

47.3.6

PO
The PO block is designed to be used together with the PIDI function block.
For more information, see section 47.9 “PO – Pulsed Binary Output” on page 1381.

47.3.7

RI
The RI block represents a real input in a function block program.
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For more information, see section 47.10 “RI – Real Input” on page 1382.

47.3.8

RO
The RO block represents a real output in a function block program.
For more information, see section 47.11 “RO – Real Output” on page 1383.
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47.4

BI – Binary Input
The BI block is a binary input to a function block program.

Figure: The binary input block

The block is updated once during each program cycle. Changes to the inputs with
a duration of less than one program cycle are not noted by the function block
program.

Note
• The BI block has no parameters.
Table: The BI Block Input
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Data Type

Access

BINARY

RO
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47.5

BO – Binary Output
The BO block is a binary output from a function block program.

Figure: The binary output block

Important
It is not recommended to make any connection after the BO function blocks. Due
to system infrastructure, bindings to physical outputs are handled outside the
function block program. If you force the value of an output signal, the forced value
is not transferred back to the application program and anything connected after
the BO function block is unaffected by the forced value.

Note
• The BO block has no parameters.
Table: The BO Block Output

04-16006-04-en, March 2015

Data Type

Access

BINARY

RO
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47.6

II – Integer Input
The II block is an integer input to function block program.

Figure: The integer input block

The value of the integer input connection block is a 16 bit integer value. The block
handles inputs of 32 bit integer values controlled by the Mode parameter value:
• Value 0.
The block integer value is limited to the range -32768 and 32767. An input
value outside this range generates a system error called integer
underflow/overflow and can be detected by the ERROR block.
• Value 1.
The block integer value is the most significant word (16 bits) of the 32 bits input
value.
• Value 2.
The block integer value is the least significant word (16 bits) of the 32 bits input
value.
Table: The II Block Parameter
Parameter

Data Type

Description

Mode

–

16 bit output control

Table: The II Block Input
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Data Type

Description

INTEGER

RO
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47.7

IO – Integer Output
The IO block is an integer output from function block program.

Figure: The integer output block

Important
It is not recommended to make any connection after the IO function blocks. Due
to system infrastructure, bindings to physical outputs are handled outside the
function block program. If you force the value of an output signal, the forced value
is not transferred back to the application program and anything connected after
the IO function block is unaffected by the forced value.

Note
• The IO block has no parameters.
Table: The INTEG Block Output
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Data Type

Access

INTEGER

RO
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47.8

PI – Pulse-Counter Binary Input
The PI function block counts the number of pulses on the input during one
execution of a function block program.

Figure: The pulse-counter binary input block

Note
• The ACCUM block can be used to accumulate the number of pulses during
execution.
• The PI block has no parameters.
Table: The PI Block Input
Data Type

Description

INTEGER

–

Table: The PI Block Output
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Data Type

Access

REAL

RO
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47.9

PO – Pulsed Binary Output
The PO block is designed to be used together with the PIDI function block.

Figure: The pulsed binary output block

The pulse duration is determined by the block input signal value (in seconds).
Negative values are ignored.
Block input signals with duration shorter than the MinPulse value are accumulated
until the MinPulse value is reached. Short input signals can only be accumulated to
a duration of the program cycle.
Input pulses with durations longer than the program cycle time can create output
pulses longer than the program cycle time.
When the block gets a value equal to or higher than the cycle time of the function
block program, the block automatically adds 10% to avoid a dip in the output value.
That is, if the function block program execution takes 10 seconds the online viewer
shows 10 seconds for the block connected to the PO block and 11 seconds for the
PO block.

Important
It is not recommended to make any connection after the PO function blocks. Due
to system infrastructure, bindings to physical outputs are handled outside the
function block program. If you force the value of an output signal, the forced value
is not transferred back to the application program and anything connected after
the PO function block is unaffected by the forced value.
Table: The PO Block Parameter
Parameter

Data Type

Description

MinPulse

REAL

Minimum output pulse
duration (seconds)

Table: The PO Block Output
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Data Type

Access

REAL

RO
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47.10

RI – Real Input
The RI block represents a real input in a function block program.

Figure: The real input block

The real input block has a discrete time first order software filter for filtering a sensor
reading. The filter time constant is specified in seconds with the parameter
TimeConst.
Table: The RI Block Parameter
Parameter

Data Type

Description

TimeConst

REAL

Filter time constant (seconds)

Table: The RI Block Input
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Data Type

Description

REAL

RO
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47.11

RO – Real Output
The RO block represents a real output in a function block program.

Figure: The real output

Important
It is not recommended to make any connection after the RO function blocks. Due
to system infrastructure, Bindings to physical outputs are handled outside the
function block program. If you force the value of an output signal, the forced value
is not transferred back to the application program and anything connected after
the RO function block is unaffected by the forced value.

Note
• The RO block has no parameters.
Table: The RO Block Output
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Data Type

Access

REAL

RO
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47.12

Time Schedule and Alarm Blocks
Time Schedules and Alarms blocks define time control and alarm handling in a
function block program. Time schedules and alarms are configured in WorkStation
and executed outside the function block program.

47.12.1

ALARM
The ALARM block monitors the state of the binary input signal.
For more information, see section 47.13 “ALARM – Alarm” on page 1385.

47.12.2

TSCHI
The TSCHI block is an integer output indicating the number of minutes until the next
change of state of the time schedule.
For more information, see section 47.14 “TSCHI – Time Schedule” on page 1387.
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47.13

ALARM – Alarm
The ALARM block monitors the state of the binary input signal.

Figure: The Alarm block

In the alarm block, a rising edge (transition from 0 to 1) starts a timer which
measures how long the input is true (1). If the measured time exceeds the specified
alarm activation (set) delay time, an alarm record containing information about the
status, time, signal name, priority, and an optional alarm text is generated by the
system software.
When an alarm is set, the alarm block waits for the input to become false (0). The
falling edge of the input signal triggers a timer in the same manner as the rising
edge. After the alarm reset delay time has expired, the alarm is reset by the system
software.
The alarm block output signal indicates the current alarm status:
• 1 = alarm set
• 0 = no alarm (reset)
The alarm set and reset delay times are specified in seconds with the DelayOn and
DelayOff parameters, respectively. Please refer to the timing diagram below, which
shows the setting and resetting of an alarm. If a power outage occurs during the
delay, the elapsed delay time is saved if the Backup check box is selected.
The alarm priority is specified with the Priority parameter.

Figure: The relation between input signal and alarm output signal

Note
• The input signal must be true for a time interval longer than DelayOn in order
to generate a new alarm. The input must also be false for a time interval
longer than DelayOff in order to reset the alarm.
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Table: The ALARM Block Parameters
Parameter

Data Type

Description

DelayOn

REAL

Delay before the alarm is set
(sec)

DelayOff

REAL

Delay before the alarm is
reset (sec)

Priority

INTEGER

Alarm priority level

AlarmText

STRING

Optional alarm text

Table: The ALARM Block Input
Input

Data Type

Description

Variable

BINARY

Input signal

Table: The ALARM Block Output
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Data Type

Access

BINARY

RO
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47.14

TSCHI – Time Schedule
The TSCHI block is an integer output indicating the number of minutes until the next
change of state of the time schedule.

Figure: The time schedule block

The TSCHI block has a signed integer output whose sign indicates the time
schedule status (negative = true, positive = false), and whose value indicates the
time left until the next status change (negative = time in minutes to false, positive =
time in minutes to true).

Note
• The TSCHI block has no parameters.
Table: The TSCHI Block Output
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Data Type

Access

INTEGER

RO
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47.15

Accumulator Blocks
The Accumulator block is used to accumulate the total consumption from an
incremental input (the consumption during one program cycle).

47.15.1

ACCUM
The ACCUM block is used to accumulate the total consumption from an
incremental input (the consumption during one program cycle).
For more information, see section 47.16 “ACCUM – Accumulator” on page 1389.

47.15.2

INTEG
The INTEG block integrates a rate or flow over time.
For more information, see section 47.17 “INTEG – Integrator” on page 1391.

47.15.3

RT
The RT block is used to calculate the runtime of the RunIndication signal.
For more information, see section 47.18 “RT – Run-Time Measurement” on page
1393.
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47.16

ACCUM – Accumulator
The ACCUM block is used to accumulate the total consumption from an
incremental input (the consumption during one program cycle).
The block calculates the sum of the variable increment over time. The summation is
done using numerical precision to avoid underflow when the increment is small.

Figure: The accumulator block

Note
• The accumulated value is delayed by one program cycle before it appears on
the output.
The accumulator output is set to InitValue at the initial state. When the Reset input is
activated, the accumulator output is reset to a value specified by the ResetValue
input signal. When the Reset input is deactivated, the accumulation resumes from
the last value of the ResetValue input.
The upper and lower output limits are set by the maximum floating-point number
that can be represented in the controller.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
The ACCUM block has the following characteristics.
Table: The ACCUM Block Parameter
Parameter

Data Type

Description

InitValue

REAL

Initial accumulator value

Table: The ACCUM Block Inputs
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Input

Data Type

Description

Increment (i)

REAL

Amount accumulated in each
program cycle

Reset (rs)

BINARY

Reset input (1 = reset)
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Continued
Input

Data Type

Description

ResetValue (rv)

REAL

Value assigned to the output
when the reset input is
activated

Table: The ACCUM Block Output
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Data Type

Access

REAL

R/W
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47.17

INTEG – Integrator
The INTEG block integrates a rate or flow over time.

Figure: The integrator block

Table: The INTEG Block Parameter
Parameter

Data Type

Description

InitValue

REAL

Initial integrator value

Table: The INTEG Block Inputs
Input

Data Type

Description

Rate (r)

REAL

Rate input variable

Reset (rs)

REAL

Reset input (1 = reset)

ResetValue (rv)

REAL

Value assigned to the output
when the reset input is
activated

Table: The INTEG Block Output
Data Type

Access

REAL

R/W

The integral is computed as the sum of the rate multiplied by the time increment
(program cycle). The summation is done using extended numerical precision to
avoid underflow when the rate is small.
The integrator output is set to InitValue at the initial state. When the Reset input is
activated, the integrator output is reset to a value specified by the ResetValue input
signal. When the Reset input is deactivated, the integration is resumed starting from
the last value of the ResetValue input.
The upper and lower output limits are set by the maximum floating-point number
that can be represented in the controller.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
Continued on next page
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• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.18

RT – Run-Time Measurement
The RT block is used to calculate the runtime of the RunIndication signal.

Figure: The run-time measurement block

Table: The RT Block Parameter
Parameter

Data Type

Description

Unit

INTEGER

Output time unit
0 = hours
1 = minutes
2 = seconds
Default value = 0

Table: The RT Block Inputs
Input

Data Type

Description

RunIndication (i)

BINARY

Running indication to be
measured

Reset (rs)

BINARY

Reset input
1 = reset

Table: The RT Block Output
Data Type

Access

INTEGER

R/W

The output time unit (hours, minutes or seconds) is selected using the Unit
parameter. The output and all internal block states are set to zero at the initial state
or when the Reset input is activated. When the Reset input is deactivated,
accumulation resumes.
When the output reaches the maximum Integer limit (32767), accumulation stops,
but the output is not reset to zero.
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Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.19

Non-linear Function Blocks
Non-linear function blocks are used for min and max limitations of signals.

47.19.1

AHYST
The AHYST block implements an analog hysteresis function.
For more information, see section 47.20 “AHYST – Analog Hysteresis” on page
1396.

47.19.2

HYST
The binary HYST block implements a relay function with hysteresis.
For more information, see section 47.21 “HYST – Binary Hysteresis” on page 1398.

47.19.3

LIMIT
The LIMIT block limits the analog signal within a given range.
For more information, see section 47.22 “LIMIT – High/Low Signal Limit” on page
1400.

47.19.4

MAX
The MAX signal selector block selects the highest of two analog signals.
For more information, see section 47.23 “MAX – Maximum Signal Selector” on
page 1401.

47.19.5

MIN
The MIN signal selector block selects the lowest of two analog signals.
For more information, see section 47.24 “MIN – Minimum Signal Selector” on page
1402.
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47.20

AHYST – Analog Hysteresis
The AHYST block implements an analog hysteresis function.
The output follows the input as long as the input is outside the limits of the
hysteresis loop. When the input variable enters into the hysteresis loop, the output
takes the limiting values of the hysteresis.

Figure: The analog hysteresis block

Figure: Analog hysteresis

If Rise > Fall, the loop is counter-clockwise. If Rise < Fall, the hysteresis loop is
clockwise.
If a complex function containing several hysteresis loops is required, program the
function by using other blocks (POLY, CURVE, VECTOR, and so on) and append in
cascade as many AHYST blocks as there are hysteresis loops in the desired
transfer function.
Table: The AHYST Block Parameters
Parameter

Data Type

Description

Rise

REAL

Value of the input signal for
the ascent in the hysteresis
loop

Fall

REAL

Value of the input signal for
the descent in the hysteresis
loop

Table: The AHYST Block Input
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Input

Data Type

Description

Variable

REAL

Input signal
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Input

Data Type

Description

Table: The AHYST Block Output
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Data Type

Access

REAL

RO
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47.21

HYST – Binary Hysteresis
The binary HYST block implements a relay function with hysteresis.

Figure: The binary hysteresis block

Table: The HYST Block Parameters
Parameter

Data Type

Description

Activate

REAL

Threshold value of the input
signal for activation of the
output

Deactivate

REAL

Threshold value of the input
signal for deactivation of the
output

Table: The HYST Block Input
Input

Data Type

Description

Variable

REAL

Input signal

Table: The HYST Block Output
Data Type

Access

BINARY

RO

When activate is greater than deactivate, the block has the following functions:
• If the output is false (0) and the input signal exceeds the activation threshold,
the output changes to true (1).
• If the output is true (1) and the input signal drops below the deactivation
threshold, the output changes to false (0).
• When the input signal is in the zone between the two thresholds, the output
remains in its previous state.

Figure: Binary hysteresis, when activate is greater than deactivate
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When activate is less than deactivate, the block has the following functions:
• If the output is true (1) and the input signal exceeds the deactivation threshold,
the output changes to false (0).
• If the output is false (0) and the input signal drops below the activation
threshold, the output changes to true (1).
• When the input signal is in the zone between the two thresholds, the output
remains in its previous state.

Figure: Binary hysteresis, when activate is less than deactivate
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47.22

LIMIT – High/Low Signal Limit
The LIMIT block limits the analog signal within a given range.

Figure: The high/low signal limit block

Table: The LIMIT Block Parameters
Parameter

Data Type

Description

MinValue

REAL

Minimum value limit

MaxValue

REAL

Maximum value limit

Table: The LIMIT Block Input
Data Type

Description

REAL

Input signal

Table: The LIMIT Block Output
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Data Type

Access

REAL

RO
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47.23

MAX – Maximum Signal Selector
The MAX signal selector block selects the highest of two analog signals.

Figure: The maximum signal selector block

Note
• The MAX block has no parameters.
Table: The MAX Block Inputs
Data Type

Description

REAL

Input1. First input signal

REAL

Input2. Second input signal

Table: The MAX Block Output
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Data Type

Access

REAL

RO
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47.24

MIN – Minimum Signal Selector
The MIN signal selector block selects the lowest of two analog signals.

Figure: The minimum signal selector block

Note
• The MIN block has no parameters.
Table: The MIN Block Input
Data Type

Description

REAL

Input1. First input signal

REAL

Input2. Second input signal

Table: The MIN Block Output
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Data Type

Access

REAL

RO
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47.25

Logical Function Blocks
A Logical function block adds logical operations to a function block program.

47.25.1

AND
The logical AND gate block calculates the boolean AND function of state1 and
state2.
For more information, see section 47.26 “AND – Logical AND Gate” on page 1405.

47.25.2

NOT
The NOT gate block inverts a binary signal.
For more information, see section 47.27 “NOT – NOT Gate” on page 1406.

47.25.3

OR
The OR gate block calculates the boolean OR function.
For more information, see section 47.28 “OR – OR Gate” on page 1407.

47.25.4

PULSE
The PULSE generator block generates a variable width pulse when the control input
is triggered.
For more information, see section 47.29 “PULSE – Pulse Generator” on page 1408.

47.25.5

SR
The SR flip-flop block is a bi-stable block with two inputs: set and reset.
For more information, see section 47.30 “SR – Set-Reset Flip-Flop” on page 1409.

47.25.6

TRIG
The TRIG block is mono-stable and fires when it detects a transition in its input
signal and generates a pulse which is equal to the duration of one program cycle.
For more information, see section 47.31 “TRIG – Trigger” on page 1411.
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47.25.7

XOR
The exclusive OR gate block is a logical exclusive OR operator between two binary
values.
For more information, see section 47.32 “XOR – Exclusive OR Gate” on page 1412.
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47.26

AND – Logical AND Gate
The logical AND gate block calculates the boolean AND function of state1 and
state2.

Figure: The logical AND gate

Note
• The AND block has no parameters.
Table: The AND Block Inputs
Data Type

Description

BINARY

State1

BINARY

State2

Table: The AND Block Output
Data Type

Access

BINARY

RO

Table: Calculation of the Boolean AND Function of state1 and state2 in the Logical
AND Gate Block
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state 1

state 2

output

0

0

0

0

1

0

1

0

0

1

1

1
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47.27

NOT – NOT Gate
The NOT gate block inverts a binary signal.

Figure: The NOT gate block

Note
• The NOT block has no parameters.
Table: The NOT Block Input
Data Type

Description

BINARY

Input signal

Table: The NOT Block Output
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Data Type

Access

BINARY

RO
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47.28

OR – OR Gate
The OR gate block calculates the boolean OR function.

Figure: The OR gate block

Note
• The OR block has no parameters.
Table: The OR Block Inputs
Data Type

Description

BINARY

State1. Input signal 1

BINARY

State2. Input signal 2

Table: The OR Block Output
Data Type

Access

BINARY

RO

Table: Calculation of the Boolean OR Function of state1 and state2 Using the OR
Gate Block
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state1

state2

Output

0

0

0

0

1

1

1

0

1

1

1

1
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47.29

PULSE – Pulse Generator
The PULSE generator block generates a variable width pulse when the control input
is triggered.

Figure: The pulse generator block

Note
• The PULSE block has no parameters.
Table: The PULSE Block Inputs
Input

Data Type

Description

Trig (t)

BINARY

Trigger signal

PulseLength (pl)

REAL

Duration of output pulse
(seconds)

Table: The PULSE Block Output
Data Type

Access

BINARY

RO

The pulse generator block is a function block with a mono-stable binary output of
variable pulse length (pulse generator). The pulse length (in seconds) is given by the
input signal PulseLength. The PULSE block only has one stable output state (0).
When the input signal Trig switches from 0 to 1, the output switches to the unstable
state (1) and remains in this state for PulseLength seconds, after which it returns to
0. The output pulse is triggered by the transition of the input signal, from zero to
one, and not on its state. Thus, the output pulse length is independent of the
duration of the trig input pulse length.

Figure: Pulse length

The output pulse length is always a multiple of the program cycle time, for example,
if the PulseLength input is set to 5.2 seconds and the cycle time is 1 second, the
output pulse duration is 6 seconds.
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47.30

SR – Set-Reset Flip-Flop
The SR flip-flop block is a bi-stable block with two inputs: set and reset.

Figure: The set-reset flip-flop block

Table: The SR Block Parameter
Parameter

Data Type

Description

InitValue

BINARY

Initial value of the output
signal

Input

Data Type

Description

Set (s) (D)

BINARY

Activates the output state

Reset (r)

BINARY

Deactivates the output state

Table: The SR Block Inputs

Table: The SR Block Output
Data Type

Access

BINARY

R/W

Depending on the value of these inputs at any given moment, the output of the
block is given a value during the next program cycle in accordance with the
following transition table:
Table: Set-Reset Flip-Flop Block Transition Table

04-16006-04-en, March 2015

State (t)

Reset (t)

Output (t+1)

0

0

output (t)

0

1

0

1

0

1

1

1

inverse (output(t))
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State (t)

Reset (t)

Output (t+1)

Thus, the output at time t+1 is equal to the input at time t if the two inputs are
inactive. If the two inputs are active, the output changes state every program cycle.
If only one of them is active, the output is activated or deactivated depending on
whether the input variable set or reset is active respectively.

Figure: The set-reset flip-flop block function
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47.31

TRIG – Trigger
The TRIG block is mono-stable and fires when it detects a transition in its input
signal and generates a pulse which is equal to the duration of one program cycle.

Figure: The trigger block

Table: The TRIG Block Parameter
Parameter

Data Type

Description

Mode

INTEGER

Operation modes 1, 2, or 3

Input

Data Type

Description

State

BINARY

Trigger signal

Table: The TRIG Block Input

Table: The TRIG Block Output
Data Type

Access

BINARY

RO

Depending on the mode of operation selected, the trigger can fire:
• Mode 0 and 1: on the low to high transitions
• Mode 2: on the high to low transitions
• Mode 3: on any transition
The mode can be entered as an integer between 0 and 255, but any mode higher
than mode 3 works as mode 3 (the trigger fires on any transition).
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47.32

XOR – Exclusive OR Gate
The exclusive OR gate block is a logical exclusive OR operator between two binary
values.

Figure: The exclusive OR gate block

Note
• The XOR block has no parameters.
Table: The XOR Block Inputs
Data Type

Description

BINARY

State1

BINARY

State2

Table: The XOR Block Output
Data Type

Access

BINARY

RO

The exclusive OR gate block calculates the boolean exclusive OR function of state1
and state2, according to the following truth table:
Table: The Exclusive OR Gate Block Calculation Table

Technical
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State1

State2

Output

0

0

0

0

1

1

1

0

1

1

1

0
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47.33

Transformation Function Blocks
Transformation function blocks include blocks that transform signals in various
ways in a function block program.

47.33.1

CURVE
The CURVE function block implements an arbitrary partially linear curve defined by a
number of curve breakpoints (xi, yi), that are the function values y = f(x) for a set of
input x values.
For more information, see section 47.34 “CURVE – Curve Function” on page 1414.

47.33.2

ENTH
The ENTH block is used to calculate moist air at normal atmospheric pressure as a
function of the dry-bulb temperature and the relative humidity.
For more information, see section 47.35 “ENTH – Enthalpy” on page 1416.

47.33.3

POLY
The POLY block calculates the polynomial function.
For more information, see section 47.36 “POLY – Polynomial Function” on page
1419.

47.33.4

PRCNT
The PRCNT block transforms an input signal to a 0–100% output signal.
For more information, see section 47.37 “PRCNT – Percentage” on page 1421.

47.33.5

VECTOR
In the VECTOR block the output value is calculated using a ranged array of input
values.
For more information, see section 47.38 “VECTOR – Vectorial Curve Function” on
page 1422.
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47.34

CURVE – Curve Function
The CURVE function block implements an arbitrary partially linear curve defined by a
number of curve breakpoints (xi, yi), that are the function values y = f(x) for a set of
input x values.

Figure: The Curve function block

Table: The CURVE Block Parameters
Parameter

Data Type

Description

Limit

BINARY

Selector for limit function
(limit = 1) or linear
extrapolation (limit = 0)

Dimension (Pair list x,y)

REAL

A list of coordinate pairs x,y
defining the breakpoints of
the curve function

Table: The CURVE Block Input
Data Type

Description

REAL

Input signal

Table: The CURVE Block Output
Data Type

Access

BINARY

RO

The number of breakpoints must not exceed 127. The number of specified
breakpoints (N) is indicated as Dimension in the graphical function block symbol.
The breakpoints are entered as a list of Real values x,y separated by commas, with
one coordinate pair on each row. The x values in the list have to be entered in order,
that is xi-1 < xi < xi+1.
The input signal is compared to the x-components of the breakpoints in order. The
first coordinate pair with an x-component greater than the input signal is chosen as
the end point of a line segment starting in the previous point. The output signal is
then calculated by linear interpolation on this line segment.
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If the limit function selector is set to 1, the output is set to y1 when the input is less
than x1, and to yN when the input is greater than xN. When the limit selector is
disabled, the output is computed by linear extrapolation whenever the input signal
exceeds the range (x1, xN).
The following is a graphical representation of a “simple” case:

Figure: A simple case of the curve function block

If two coordinates are equal, the curve look like this:

Figure: A case where two coordinates are equal.

At the discontinuity (when the input = x2) the function output is y2.
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47.35

ENTH – Enthalpy
The ENTH block is used to calculate moist air at normal atmospheric pressure as a
function of the dry-bulb temperature and the relative humidity.

Figure: The enthalpy block

Note
• The ENTH block has no parameters.
Table: The ENTH Block Inputs
Input

Data Type

Description

Temperature (T)

REAL

Dry-bulb temperature °C (ºF)

Humidity (H)

REAL

Relative humidity (%)

Table: The ENTH Block Output
Data Type

Access

REAL

RO

The enthalpy, kJ/kg (BTU/pound), of moist air at normal atmospheric pressure is
calculated as a function of the dry-bulb temperature °C (ºF) and the relative humidity
(%).
The ENTH block uses the T input (temperature) in SI unit system (metric) or I-P
(inch-pound) unit system, depending on the regional settings of the computer on
which the function block program is generated. The metric setting produces a block
where the T input is in degrees Celsius. A US setting produces a block where the T
input is in degrees Fahrenheit.
The above-mentioned setting also determines the units for the calculated enthalpy.
An SI (metric) setting gives the result in kJ/kg. An I-P (inch-pound) setting gives a
result in BTU/pound. The calculation of enthalpy in each unit system differs, and
cannot be converted from one unit system to another.

Algorithm, SI measurement units
The water vapor saturation pressure over liquid water for the temperature range 0
to 200 °C is approximated by the following function:
pws(T) = exp(c8/T + c9 + c10*T + c11*T² + c12*T³ + c13*ln(T)) (6)
where
• T = Absolute temperature (K),
• pws = saturation pressure (Pa) and
Technical
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• c8 = –5.8002206E+03;
• c9 = 1.3914993E+00;
• c10 = –4.8640239E-02;
• c11 = 4.1764768E-05;
• c12 = –1.4452093E-08;
• c13 = 6.5459673+00;
The enthalpy of moist air at normal atmospheric pressure as a function of the drybulb temperature and the relative humidity is then given by the following equations:
pwsat = pws(t+273.15)
pw =F*pwsat/100)(24)
W = 0.62198*pw/(p-pw)(22)
h = 1.006 *t + W*(2501+1.805*t)(32)
where
• pwsat = water vapor saturation pressure (Pa)
• t = dry-bulb temperature (°C)
• F = relative humidity (%)
• pw = partial pressure of water vapor in moist air (Pa)
• p = ambient pressure (101325 Pa)
• W = humidity ratio, mass of water per unit mass of dry air
• h = enthalpy (kJ/kg)

Note
• Reference: ASHRAE Handbook 2001 – Fundamentals SI System of units.
Chapter 6, Psychrometrics. The equation numbers within parenthesis refer to
the corresponding equations in the ASHRAE Handbook.

Algorithm, I-P measurement units
The water vapor saturation pressure over liquid water for the temperature range
–80 to 300 °F is approximated by the following function:
pws(T) = exp(c8/T + c9 + c10*T + c11*T² + c12*T³ + c13*ln(T)) (6)
where
• T= Absolute temperature (ºR)
• pws = saturation pressure (psia) and
• c8 = –1.0440397E+04;
• c9 = –1.1294650E+01;
• c10 = –2.7022355E-02;
• c11 = 1.2890360E-05;
• c12 = –2.4780681E-09;
• c13 = 6.5459673;The enthalpy of moist air at normal atmospheric pressure as
a function of the dry-bulb temperature and the relative humidity is then given by
the following equations:

04-16006-04-en, March 2015
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pwsat = pws(t+459.67)
pw = F*pwsat/100)(24)
W = 0.62198*pw/(p-pw)(22)
h = 0.240*t + W*(1061+0.444*t)(32)
where
• pwsat = water vapor saturation pressure (psi)
• t = dry-bulb temperature (°F)
• F = relative humidity (%)
• pw = partial pressure of water vapor in moist air (psi)
• p = ambient pressure (14.696 psi)
• W = humidity ratio, mass of water per unit mass of dry air
• h = enthalpy (BTU/Pound)

Note
• Reference: ASHRAE Handbook 2001 – Fundamentals I-P System of units.
Chapter 6, Psychrometrics. The equation numbers within parenthesis refer to
the corresponding equations in the ASHRAE Handbook.
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47.36

POLY – Polynomial Function
The POLY block calculates the polynomial function.

Figure: The polynomial function block

Table: The POLY Block Parameter
Parameter

Data Type

Description

Order

REAL

List of coefficients

Table: The POLY Block Input
Data Type

Description

REAL

–

Table: The POLY Block Output
Data Type

Access

REAL

RO

The Polynomial block calculates the polynomial function defined by the expression:

Figure: Polynomial function

The order of the polynomial (n) is equal to the number of coefficients minus one, and
this is indicated in the graphical function block symbol. The maximum number of
coefficients is 255.
The polynomial value p(x) is calculated using an algorithm known as Horner's
scheme [Reference: Fröberg, Carl-Erik: “Numerical Mathematics – Theory and
Computer Applications”, Addison-Wesley (1985)] to improve the numerical
accuracy and reduce the number of floating point operations. The algorithm can be
described using the following equations, where p(x) = bn:
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Figure: Polynomial value calculated by using the algorithm known as Horner's scheme
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47.37

PRCNT – Percentage
The PRCNT block transforms an input signal to a 0–100% output signal.

Figure: The percentage block

Table: The PRCNT Block Parameters
Parameter

Data Type

Description

Value0%

REAL

Value of the input variable for
0% at the output

Value100%

REAL

Value of the input variable for
100% at the output

Table: The PRCNT Block Input
Data Type

Description

REAL

Input signal

Table: The PRCNT Block Output
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Data Type

Access

REAL

RO
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47.38

VECTOR – Vectorial Curve Function
In the VECTOR block the output value is calculated using a ranged array of input
values.

Figure: The Vectorial curve function block

Table: The VECTOR Block Parameters
Parameter

Data Type

Description

Xmin

REAL

Lower limit of the input range

Xmax

REAL

Upper limit of the input range

Dimension(Y(X))

REAL

List of function values
(minimum of 2 and maximum
of 255). Each value in the list
is entered on a separate line.

Table: The VECTOR Block Input
Data Type

Description

REAL

Input signal

Table: The VECTOR Block Output
Data Type

Access

REAL

RO

The Vectorial curve function block permits the definition of any piece-wise linear
function for an input signal within the limits Xmax and Xmin. The function is defined
by specifying the output function values y = f(x) for N equally spaced input (x) values
between the two limits. For input values between two points, the function value is
calculated by linear interpolation. If the value of the input signal is less than Xmin,
the value defined at that point is used, and likewise if the input is greater than Xmax.
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Note
• The Vectorial curve function block can act as a ranged array of Real values for
use as a look-up table as in the example below.
Table: The VECTOR Block as a Ranged Array of Real Values
Input

Output

5

34.5

6

28.0

7

42.5

8

33.9

To do this, the input must always be an integer between Xmin and Xmax (Xmin = 5,
Xmax = 8 in the example), and the number of elements in the list must be equal to
Xmax – Xmin + 1 (8 – 5 + 1 = 4 in the example).
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47.39

Delay Blocks
A Delay block delays a signal in one of a number of ways.

47.39.1

DELAY
The DELAY on/off block delays the transitions of an input signal (state) by the time
specified in seconds as defined by the DelayOn (transition 0 to 1) and DelayOff
(transition 1 to 0) parameters.
For more information, see section 47.40 “DELAY – Delayed On/Off” on page 1426.

47.39.2

DELB
The DELB block introduces a delay of one program cycle in the propagation of a
binary signal. For each program cycle, the output value is updated with the input
value from the previous cycle.
For more information, see section 47.41 “DELB – Binary Value Delay” on page
1427.

47.39.3

DELI
The DELI block introduces a delay of one program cycle in the propagation of an
Integer signal. For each program cycle, the value of the output is updated with the
input value from the previous cycle.
For more information, see section 47.42 “DELI – Integer Value Delay” on page
1428.

47.39.4

DELR
The DELR block introduces a delay of one program cycle in the propagation of a
Real signal. For each program cycle, the value of the output is updated with the
input value from the previous cycle.
For more information, see section 47.43 “DELR – Real Value Delay” on page 1429.

47.39.5

SHB
The SHB binary value block copies the input state to the output if the control signal
is active. If the control signal is inactive the output remains in the same state.
For more information, see section 47.44 “SHB – Sample and Hold Binary Value” on
page 1430.
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47.39.6

SHI
The SHI integer value block copies the input state to the output if the control signal
is active. If the control signal is inactive the output remains in the same state.
For more information, see section 47.45 “SHI – Sample and Hold Integer Value” on
page 1432.

47.39.7

SHR
The SHR real value block copies the input state to the output if the control signal is
active. If the control signal is inactive the output remains in the same state.
For more information, see section 47.46 “SHR – Sample and Hold Real Value” on
page 1434.
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47.40

DELAY – Delayed On/Off
The DELAY on/off block delays the transitions of an input signal (state) by the time
specified in seconds as defined by the DelayOn (transition 0 to 1) and DelayOff
(transition 1 to 0) parameters.

Figure: The delayed on/off block

Table: The DELAY Block Parameters
Parameter

Data Type

Description

DelayOn

REAL

Activation delay in seconds

DelayOff

REAL

Deactivation delay in
seconds

Table: The DELAY Block Input
Data Type

Description

BINARY

State. Input signal

Table: The DELAY Block Output
Data Type

Access

BINARY

RO

The input signal must be true for a time interval longer than DelayOn in order to
generate a pulse on the block output. The input must also be false for a time interval
longer than DelayOff in order to reset the output to false.

Figure:

If a power outage occurs during the delay, the elapsed delay time is saved if
Backup is selected in the Edit block dialog box.
Technical
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47.41

DELB – Binary Value Delay
The DELB block introduces a delay of one program cycle in the propagation of a
binary signal. For each program cycle, the output value is updated with the input
value from the previous cycle.

Figure: The binary value delay block

Table: The DELB Block Parameter
Parameter

Data Type

Description

InitValue

BINARY

Initial value for the output
signal

Table: The DELB Block Input
Input

Data Type

Description

State

BINARY

Binary input signal

Table: The DELB Block Output
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Data Type

Access

BINAY

R/W
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47.42

DELI – Integer Value Delay
The DELI block introduces a delay of one program cycle in the propagation of an
Integer signal. For each program cycle, the value of the output is updated with the
input value from the previous cycle.

Figure: The integer value delay block

Table: The DELI Block Parameter
Parameter

Data Type

Description

InitValue

INTEGER

Initial value for the output
signal

Input

Data Type

Description

Variable

INTEGER

Input signal

Table: The DELI Block Input

Table: The DELI Block Output
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Data Type

Access

INTEGER

R/W
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47.43

DELR – Real Value Delay
The DELR block introduces a delay of one program cycle in the propagation of a
Real signal. For each program cycle, the value of the output is updated with the
input value from the previous cycle.

Figure: The real value delay block

Table: The DELR Block Parameter
Parameter

Data Type

Description

InitValue

REAL

Initial value for the output
signal

Table: The DELR Block Input
Data Type

Description

REAL

Analog input signal

Table: The DELR Block Output
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Data Type

Access

REAL

R/W
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47.44

SHB – Sample and Hold Binary Value
The SHB binary value block copies the input state to the output if the control signal
is active. If the control signal is inactive the output remains in the same state.

Figure: The sample and hold binary value block

Table: The SHB Block Parameter
Parameter

Data Type

Description

InitValue

BINARY

Initial value of the input signal

Table: The SHB Block Inputs
Input

Data Type

Description

State (d)

BINARY

Binary input signal

Control (c)

BINARY

Control signal

Table: The SHB Block Output
Data Type

Access

BINARY

R/W

Table: The Sample and Hold Function
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state (t)

control (t)

output (t+1)

0

0

output (t)

0

0

output (t)

0

1

0

1

1

1
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state (t)

control (t)

output (t+1)

Figure: The sample and hold function binary value

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.45

SHI – Sample and Hold Integer Value
The SHI integer value block copies the input state to the output if the control signal
is active. If the control signal is inactive the output remains in the same state.
However, while the control signal remains inactive, the output retains the value of
the input during the last cycle that the control signal was active.

Figure: The sample and hold integer value

Table: The SHI Block Parameter
Parameter

Data Type

Description

InitValue

INTEGER

Initial value of the output

Input

Data Type

Description

Variable (D)

INTEGER

Analog input signal

Control (c)

BINARY

Control signal

Table: The SHI Block Inputs

Table: The SHI Block Output
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Data Type

Access

INTEGER

R/W
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Data Type

Access

Figure: The sample and hold integer value function

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.46

SHR – Sample and Hold Real Value
The SHR real value block copies the input state to the output if the control signal is
active. If the control signal is inactive the output remains in the same state.

Figure: The sample and hold real value block

Table: The SHR Block Parameter
Parameter

Data Type

Description

InitValue

INTEGER

Initial value of the output

Table: The SHR Block Inputs
Input

Data Type

Description

Variable (D)

NTEGER

Analog input signal

Control (c)

BINARY

Control signal

Table: The SHR Block Output
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Data Type

Access

REAL

R/W
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Data Type

Access

Figure: The sample and hold real value function

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.47

System Variable Blocks
The System variable blocks have no inputs. The blocks display values from the
system clock or the system program.

47.47.1

DATE
The DATE block provides the date of the month (1–31) according to the internal
system clock.
For more information, see section 47.48 “DATE – Day” on page 1438.

47.47.2

ERROR
The output of the system ERROR block is an integer value where each bit
represents an internal signal or error from the system program.
For more information, see section 47.49 “ERROR – System Error” on page 1439.

47.47.3

HOUR
The HOUR block provides the current hour (0–23) according to the internal system
clock.
For more information, see section 47.51 “HOUR – Hour” on page 1441.

47.47.4

MINUTE
The MINUTE block provides the current minute (0–59), according to the internal
system clock.
For more information, see section 47.52 “MINUTE – Minute” on page 1442.

47.47.5

MONTH
The MONTH block provides the month of the year (1–12) according to the internal
system clock.
For more information, see section 47.53 “MONTH – Month” on page 1443.

47.47.6

RST
The output in the RST block is activated the first program cycle after a warm start.
For more information, see section 47.54 “RST – Restart” on page 1444.
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47.47.7

SECOND
The SECOND block provides the current second (0–59), according to the system
clock.
For more information, see section 47.55 “SECOND – Second” on page 1445.

47.47.8

TCYC
The TCYC block gives the duration in seconds of the set program cycle.
For more information, see section 47.57 “TCYC – Cycle Time” on page 1447.

47.47.9

WDAY
The WDAY block provides the week according to the system clock. 1 = Monday,
and so on.
For more information, see section 47.56 “WDAY – Week Day” on page 1446.
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47.48

DATE – Day
The DATE block provides the date of the month (1–31) according to the internal
system clock.

Figure: The day block

Note
• The DATE block has no parameters.
Table: The DATE Block Output
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Data Type

Access

INTEGER

RO
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47.49

ERROR – System Error
The output of the system ERROR block is an integer value where each bit
represents an internal signal or error from the system program.

Figure: The system error block

Note
• The ERROR block has no parameters.
Table: The ERROR Block Output
Data Type

Access

INTEGER

RO

Each output bit is set as long as the error condition remains. In the case of a restart
after a warm start, during the first program cycle following the restart, the output
value is zero when no error conditions are set.
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47.50

Error Codes for the ERROR Function
Block
Bit 0, 1, and 3 are used for error codes in the ERROR function block.
Table: Error Codes for the ERROR Function Block
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Bit No.

Output Value

Description

0

1

Set during the first execution
when restarted after a warm
start.

1

2

Integer underflow/overflow
when the II function block is
used in 16 bit mode (Mode
0).

3

8

RT block overflow.
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47.51

HOUR – Hour
The HOUR block provides the current hour (0–23) according to the internal system
clock.

Figure: The hour block

Note
• The HOUR block has no parameters.
Table: The HOUR Block Output
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Data Type

Access

INTEGER

RO
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47.52

MINUTE – Minute
The MINUTE block provides the current minute (0–59), according to the internal
system clock.

Figure: The minute block

Note
• The MINUTE block has no parameters.
Table: The MINUTE Block Output
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Data Type

Access

INTEGER

RO
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47.53

MONTH – Month
The MONTH block provides the month of the year (1–12) according to the internal
system clock.
• Month 1 corresponds to January
• Month 12 corresponds to December

Figure: The month block

Note
• The MONTH block has no parameters.
Table: The MONTH Block Output
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Data Type

Access

INTEGER

RO
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47.54

RST – Restart
The output in the RST block is activated the first program cycle after a warm start.

Figure: The restart block

Note
• The RST block has no parameters.
Table: The RST Block Output
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Data Type

Access

BINARY

RO
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47.55

SECOND – Second
The SECOND block provides the current second (0–59), according to the system
clock.

Figure: The second block

Note
• The SECOND block has no parameters.
Table: The SECOND Block Output
Data Type

Access

INTEGER

RO

Note
• The output signal does not change its value during execution of the function
block program module where it is being used. This is important if longer cycle
times than one second are used.
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47.56

WDAY – Week Day
The WDAY block provides the week according to the system clock. 1 = Monday,
and so on.
The output value 1 corresponds to Monday and 7 to Sunday.
The WDAY block has no parameters.

Figure: The week day block

Note
• If you use both Script and Function Block programming, for example, when
using control sequences, be aware of the following. Script uses Sunday as
the first day of the week and assigns a value of 1 to that day, while Function
Block uses Monday as the first day of the week and assigns Monday a value
of 1.
Table: The WDAY Block Output
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Data Type

Access

INTEGER

RO
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47.57

TCYC – Cycle Time
The TCYC block gives the duration in seconds of the set program cycle.

Figure: The cycle time block

Note
• The TCYC block has no parameters.
Table: The TCYC Block Output
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Data Type

Access

REAL

RO
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47.58

Controller and Filter Blocks
Controller and Filter blocks control and filter signals in a function block program.

47.58.1

FILT
The FILT block is a discrete time first order software filter.
For more information, see section 47.59 “FILT – First Order Filter” on page 1450.

47.58.2

OPT
The OPT block calculates optimum start and stop times according to actual
temperatures.
For more information, see section 47.60 “OPT – Optimization” on page 1452.

47.58.3

PIDA
The PIDA controller block is designed to be used in control loops where the
controller output is either connected to an analog physical output or used as a set
point for another control loop (cascade control).
For more information, see section 47.61 “PIDA – PID Controller – Analog Output”
on page 1459.

47.58.4

PIDI
The PIDI controller block is designed to be used together with digital pulse output
(PO) blocks in control loops with increase/decrease actuators.
For more information, see section 47.62 “PIDI – PID Controller – Incremental
Output” on page 1463.

47.58.5

PIDP
The PIDP controller block is designed to be used in control loops where the
controller output is either connected to an analog physical output or used as a set
point for another control loop (cascade control).
For more information, see section 47.63 “PIDP – PID Controller – Analog Output”
on page 1466.

47.58.6

RAMP
The RAMP filter block limits the rate of change of the input variable.
For more information, see section 47.64 “RAMP – Ramp Filter” on page 1470.
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47.58.7

SEQ
The SEQ block activates stages in proportion to the input signal.
For more information, see section 47.65 “SEQ – Sequencer” on page 1471.
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47.59

FILT – First Order Filter
The FILT block is a discrete time first order software filter.

Figure: The first order filter block

Table: The FILT Block Parameter
Parameter

Data Type

Description

TimeConst

REAL

Time constant of the filter
measured in seconds

Table: The FILT Block Input
Data Type

Description

REAL

Input signal

Table: The FILT Block Output
Data Type

Access

REAL

R/W

The filter time constant is specified in seconds with the TimeConst parameter. The
initial block output value is zero.
The filter algorithm is:

Figure: Filter algorithm

where y(k) and u(k) are the filtered and unfiltered values at time k, respectively, h is
the sampling interval (that is the function block program cycle time), and T is the
filter time constant. If the time constant is less than or equal to zero, no filtering is
done. To obtain a good filter function, the time constant should be set significantly
greater than the function block program cycle time.
This filter algorithm is based on a straightforward backward difference
approximation of the continuous time derivative operator.
Technical
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Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.60

OPT – Optimization
The OPT block calculates optimum start and stop times according to actual
temperatures.

Figure: The optimization block

Table: The OPT Block Parameters
Parameter

Data Type

Description

AutoAdjust

INTEGER

Automatic adjustment switch
AutoAdjust = 0 => no
adjustment
AutoAdjust = 1 =>
adjustment of curve points
AutoAdjust = 2 =>
adjustment of curve points
and holiday compensation
Default = 2

RoomTempF

BINARY

Room sensor flag
RoomTempF = 0 => Sensor
not present
RoomTempF = 1 => Sensor
present
Default = 1 sensor present
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Continued
Parameter

Data Type

Description

OperIndicF

BINARY

Flag for selecting whether
external operation indication
is present.
OperIndicF = 0 => Not
present
OperIndicF = 1 => Present
Default = 0 not present

StartTimeLo

REAL

Start-time (minutes) at low
outdoor temperature, -10 °C
(14 ºF), 10 °C (50 ºF).
Default = 105 °C

StartTimeHi

REAL

Start-time (minutes) at high
outdoor temperature, 10 °C
(50 ºF), 30 °C (86 ºF).
Default = 45 °C

HolidayComp

REAL

Holiday compensation (%)
when the plant has been
shut down > 48 h.
Default = 0 °C

MaxStartTi

REAL

Max start-time (hours).
Default = 12 °C

ETol

REAL

Temperature error when
switching from optimization
to normal operation.
Default = 0.5 °C

StopLoTemp

REAL

Low outdoor temperature
point in stop-time
optimization °C (ºF).
Default = –10 °C

StopTimeLo

REAL

Stop-time (minutes) when
outdoor temperature =
StopLoTemp.
Default = 0 °C

StopHiTemp

REAL

High outdoor temperature
point in stop-time
optimization °C (ºF).
Default = 10 °C

StopTimeHi

REAL

Stop-time (minutes) when
outdoor temperature =
StopHiTemp.
Default = 0 °C

04-16006-04-en, March 2015

Technical
1455

47 Function Block Types
47.60 OPT – Optimization

Continued
Parameter

Data Type

Description

StopTimeErr

REAL

Permissible deviation at the
end of normal optimal
operation. Used for
calculating stop-time.
Default = 0.5

Table: The OPT Block Inputs
Input

Data Type

Description

RoT

REAL

Room temperature ºC (ºF).

SP

REAL

Set point: the desired room
temperature during day time
ºC (ºF).

OuT

REAL

Outdoor temperature ºC (ºF).

OpI

BINARY

Operation indication: an
external signal that is used
for detecting whether the
controlled equipment is in
operation.
OpI = 0 => not in operation
OpI = 1 => in operation

TmL

INTEGER

Time left (minutes) until the
plant goes into operation. If
TmL is negative, OPT
interprets the size of TmL as
the time until the plant shuts
down.

Mode

INTEGER

Switch for media mode and
disabling optimization.
Mode = 0 => heating
Mode = 1 => cooling
Mode = –1 => no
optimization
Anything else is interpreted
as 0, that is, heating.

Table: The OPT Block Output
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Data Type

Access

INTEGER

R/W
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Data Type

Access

General
You can use the OPT block in heating as well as cooling function block programs.
OPT is executed at the same frequency as the other function blocks in the same
function block program. However, the main part of the algorithm is only executed
once every minute. The purpose of the start-time optimization is to start the
heating/cooling system in advance in order to obtain the correct temperature at the
beginning of normal operation. The purpose of the stop-time optimization is to shut
down the heating/cooling system before the end of normal operation, without the
temperature falling outside the given limits during normal operation.
You can block the optimization function by setting the parameter Mode = –1. The
output of OPT then follows the time schedule status, (output = 0 when TmL > 0,
and output = 1 when TmL < 0). Curve points and HolidayComp are not be adjusted
when Mode = –1.
The block uses the RoT, SP, and OuT inputs in the SI unit system (metric) or I-P
(inch-pound) unit system, depending on the regional settings of the computer on
which the function block program is generated. Using the metric setting produces a
block where the inputs are in degrees Celsius. A US setting produces a block
where the inputs are in degrees Fahrenheit.
The block parameters StartTimeLo and StartTimeHi define parts of coordinates for
breakpoints which are using fixed temperatures of –10 ºC (14 ºF), 10 ºC (50 ºF), and
30 ºC (86 ºF). Entering values for the start times completes definition of the
coordinates.

Start-Time Optimization
The start-time is calculated once every minute on condition that TmL > 0 and
optimization has not already started. If the calculated start-time is longer than the
time left until the plant goes into normal operation, the output of OPT is set to 2
(optimization state).
When the room temperature has reached the set point (SP) minus an adjustable
tolerance, ETol (default = 0.5 °C), the output of the function block is set to 1 (normal
operation) in order to indicate that the start-time optimization is completed and that
normal operation can begin. If the room temperature has not reached the
temperature required for normal operation, which has to be set before TmL turns
negative, the output is set to 1 at this point. During cooling, the output is instead set
to 1 when the room temperature falls below the set point (SP), plus the same
tolerance (ETol).
The start-time is obtained from a curve that defines the relationship between the
outdoor temperature (OuT) and the start-time. If a room sensor is not used, the
start-time is calculated directly from the curve with a possible contribution from
holiday compensation. When a room sensor is connected, the curve instead yields
the start-time per °C of deviation between the room temperature (RoT) and its set
point (SP). For example, the start-time is 120 min if the curve yields the value 60 min
at the outdoor temperature in question and the room temperature is 2 °C too low.
To obtain a correct start-time after longer shut-down periods, such as after holidays
or weekends, an extra contribution can be added to the start-time. Holiday
compensation is contributed to the start-time when the building has not been in use
for a long period. If the parameter OperIndicF is set to 1, OPT uses the input OpI to
decide whether the plant is in operation. If OperIndicF is set to 0, OPT ignores the
input OpI and instead assume that the plant is in operation if the output of OPT is 1
(normal operation) or 2 (optimization state).
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Finally, the start-time is limited to a maximum value (MaxStartTi).

OPT Output Values
The OPT block output value is used to set the plant's operating mode, as described
in the list:
• Output = 0 => Off
• Output = 1 => Normal operation
• Output = 2 => Optimization state

Curve, Start-Time as a Function of Outdoor Temperature
The curve that describes the relationship between the outdoor temperature and the
start-time, or alternatively the start-time per °C of room deviation if the room sensor
is connected, is defined by two points. The outdoor temperature at these points is
defined by the selection of the Mode (cooling or heating), while the corresponding
start-times (StartTimeLo and StartTimeHi) are freely selectable.
The outdoor temperatures of the curve points are –10 °C and 10 °C during heating,
respectively 10 °C and 30 °C during cooling. The default values for the start-times
are 105 minutes (StartTimeLo) and 45 minutes (StartTimeHi). The start-times at the
curve points can be adjusted automatically.

Figure: Curve, Start-Time as a Function of Outdoor Temperature

Automatic Adjustment of Curve Points
To be able to adjust the curve to the thermal properties of a specific building, there
is a mechanism for automatically adjusting the curve points. If the desired room
temperature has not been reached when the optimization time expires (or, if it is
reached too early), the adjustment mechanism computes an estimate of the
optimization time that should have been used and adjusts the curve points
accordingly. Automatic adjustment of the curve points can only be used in systems
with a room sensor.
Adjustment of the curve points is performed when normal operation begins
following an optimization phase and adjustment is selected (AutoAdjust > 0).
Adjustment of the curve points is not be performed when the plant has been shut
down for more than 20 hours.
You can alter the start-times in the curve points through the Operators Interface. If
this is done while optimization is active, no adjustment of the curve points is
performed when normal operation begins following this optimization phase. After
the next optimization phase, the adjustment mechanism works as normal again.

Holiday Compensation (Monday Effect)
When the building has been shut down for a long period of time, a longer heating
time is required to reach the desired temperature. To compensate for this, we add
an extra percentage of the start-time calculated above when the plant has been
shut down for more than 20 hours. 48 hours after shut down, the extra contribution
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is at maximum (HolidayComp), since we then assume that the building has reached
a stationary state (it will not get any colder even if the shut down lasts longer). The
percentage is increased linearly from 0 % at 20 h of shut down time to
HolidayComp % at 48 h of shut down time.

Figure: Holiday Compensation (Monday Effect)

The influence of holiday compensation is more important in systems without a room
sensor. The reason for this is that systems with a room sensor automatically start
earlier following a longer shut down, since the temperature in the room in general
has fallen more than during a normal shut down.

Automatic Adjustment of Holiday Compensation
The adjustment of holiday compensation is performed when normal operation
begins following an optimization phase, on the condition that the plant has been
shut down for more than 30 h. A necessary precondition is that adjustment has
been selected (AutoAdjust = 2). The curve points and HolidayComp are never
adjusted simultaneously following an optimization phase. The curve points can only
be adjusted if the plant has been shut down for less than 20 hours while
HolidayComp can only be adjusted if the plant has been shut down for more than
30 hours. This also means that no adjustment is performed if the shut-down time is
between 20 h and 30 h.

Stop-Time Optimization
The reason for using stop-time optimization is to save energy by stopping
heating/cooling before the end of the occupancy time. It is of course important that
the room temperature does not fall outside an acceptable temperature range during
the occupancy time. Since the stop time that can be used without the temperature
falling outside the acceptable temperature range depends on the room
temperature, optimized stop is normally only used in systems with a room sensor.
The stop time is obtained from a curve that describes the relationship between
outdoor temperature and stop time. The curve gives the stop time per °C of
deviation between the room temperature and the lowest permissible temperature in
the room at the end of normal operation, when a room sensor is used. The lowest
permissible temperature is set to the set point (SP) minus StopTimeErr during
heating. StopTimeErr is by default = 0.5 °C.

Figure: Stop-Time Optimization

During cooling, the highest permissible room temperature in the room at the end of
normal operation is set to the set point plus StopTimeErr. If a room sensor is not
used, the optimization function assumes that the room temperature exceeds the set
point by 1 °C in heating operation and is 1 °C below the set point during cooling, cf.
04-16006-04-en, March 2015
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start-time optimization. Both x (StopLoTemp and StopHiTemp) and y-values
(StopTimeLo and StopTimeHi) for both curve points are freely selectable. The
default values are (-10 °C, 0 min) and (10 °C, 0 min) respectively. This implies that
stop-time optimization does not have any effect before these parameters are
changed. The reason for this is that stop-time optimization is seldom used.
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47.61

PIDA – PID Controller – Analog Output
The PIDA controller block is designed to be used in control loops where the
controller output is either connected to an analog physical output or used as a set
point for another control loop (cascade control).

Figure: The PID controller - analog output block

Table: The PIDA Block Parameters
Parameter

Data Type

Description

ControlInt

REAL

Control interval (seconds)

UMin

REAL

Minimum permissible control
signal

UMax

REAL

Maximum permissible control
signal

StrokeTime

REAL

Actuator full stroke travel
time (seconds)

Table: The PIDA Block Inputs
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Input

Data Type

Description

MV

REAL

Measured value

SP

REAL

Setpoint

Mod

INTEGER

Controller operating mode

G

REAL

Proportional gain

Ti

REAL

Integral time (seconds)

Td

REAL

Derivative time (seconds)

DZ

REAL

Dead zone
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Continued
Input

Data Type

Description

TSg

REAL

Tracking signal (actual value
of the previous control signal)

Table: The PIDA Block Output
Data Type

Access

REAL

R/W

Control Algorithm
The PIDA block is designed to be used in control loops where the controller output
is either connected to an analog physical output or used as a setpoint for another
control loop (cascade control). The control algorithm is a discrete time-incremental
PID algorithm, where the change in control signal du(t) is calculated as:

Figure: Control algorithm

where:
• e = control error
• y = measured value (MV)
• G = controller gain
• Ti = integral time
• Td = derivative time and
• h = control interval (ControlInt), that is, the time between two successive
updates of the controller output signal.
If ControlInt is set to 0, the control interval is automatically set equal to the program
cycle time. Time index t represents the present value of a variable, t-h represents
the value at the previous evaluation of the control algorithm, and so on.
The PID-module is executed at the interval hx seconds, where hx seconds is the
function block program execution interval, even if the selected control interval is
longer. The control interval, h, must be a multiple of hx. If this is not the case, the
PID algorithm automatically selects the closest multiple smaller than h as the control
interval. By default, the control interval is set equal to 1.
The control error e is defined as e = SP – MV. Thus, if the measured value is below
the setpoint and the gain G is positive, the controller output increases (heating
control). With a negative G value, the controller output decreases instead (cooling
control). When the control error is smaller than the dead zone, that is, abs(e) < DZ,
the change in the control output, du(t), is set to zero. The dead zone is given in the
same units as the measurement value and the setpoint.
The controller output signal is calculated as:
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Figure: Controller output

where:
• u(t) = present control signal and
• u(t–h) = previous value of the control signal
The value of u(t–h) is taken from the input TSg, which represents the actual value of
the previous control signal, taking into account any external limitations and/or
override functions in the function block program. Normally, the TSg input would be
connected directly to the controller output.
The proportional band corresponding to a certain proportional gain value G can be
calculated as:

Figure: Proportional band

P and PD Controller
The algorithm described above is used when the controller has integral action. If a
controller without I- or D-action is desired, Ti or Td respectively is set to 0. In
accordance with this, a PI-controller is obtained by setting Ti > 0 and Td = 0. If the
gain G is set to 0, the program does not fail to execute, but the control signal is not
changed, regardless of the size of the error.
If the incremental control algorithm in the equation (1) is used without integral
action, an arbitrarily large stationary error can be obtained which is not necessarily
decreased if the controller gain is increased. For this reason, we use a special
algorithm for P and PD control, where the control signal is calculated according to
the equation:

Figure: Calculation of control signal

where:
• UMax is the biggest permissible control signal and
• UMin is the smallest permissible control signal.

Limitation of the Control Signal
The maximum rate of change of the controller output during one control interval,
DuMax, depends on the actuator stroke time and can be calculated as:

Figure: Calculation of actuator stroke time

The calculated change in the control output, du(t), is limited to the range ±DuMax
before the absolute level of the control signal is calculated. The calculated new
control signal u(t) is limited to the interval (UMin, UMax). The parameters UMin and
UMax should be given in engineering units. Default values are 0 and 100 (%),
respectively.
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The parameter StrokeTime is used to define the actual full stroke travel time of the
actuator. StrokeTime can be used to limit the change of the control signal even if
the output is not connected to an actuator. The StrokeTime is then the minimum
permissible time for the control signal to change from UMin to UMax. If the
controller output is used as a setpoint for another controller and there is no special
reason for limiting the change in the control signal, StrokeTime should be set to 0.

Operating Mode
The controller operating mode depends on the input signal Mode where:
• Mode = 0 => Off, controller stopped (du = 0)
• Mode = 1 => Normal control
• Mode = 2 => Controller output forced to UMax
• Mode = 3 => Controller output forced to UMin
If Mode = 0, the controller output tracks the signal on the tracking signal (TSg) input.
If Mode < 0 or Mode > 3, the controller operating mode is Off (same as Mode = 0).
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47.62

PIDI – PID Controller – Incremental
Output
The PIDI controller block is designed to be used together with digital pulse output
(PO) blocks in control loops with increase/decrease actuators.

Figure: The PID controller - incremental output block

Table: The PIDI Block Parameters
Parameter

Data Type

Description

ControlInt

REAL

Control interval (seconds)

StrokeTime

REAL

Actuator full stroke travel
time (seconds)

Input

Data Type

Description

MV

REAL

Measured value

SP

REAL

Setpoint

Mod

INTEGER

Controller operating mode

G

REAL

Proportional gain

Ti

REAL

Integral time (seconds)

Td

REAL

Derivative time (seconds)

DZ

REAL

Dead zone

Table: The PIDI Block Inputs

04-16006-04-en, March 2015

Technical
1465

47 Function Block Types
47.62 PIDI – PID Controller – Incremental Output

Input

Data Type

Description

Table: The PIDI Block Output
Data Type

Access

REAL

R/W

Control Algorithm
The control algorithm is a discrete time incremental PID algorithm, where the
calculated change (increment) in the control signal is converted to the
corresponding travel time of the actuator. The change in the control signal du(t) is
calculated using the same formula as in the PIDA block (cf. equation (1) in the PIDA
block description).
The calculated change in the control signal, du(t), is converted to the corresponding
actuator travel time dt (in seconds) using the following equation:

Figure: Calculated change of control signal

where: StrokeTime is the full stroke actuator travel time (in seconds). It is assumed
that StrokeTime corresponds to a 100% change in the actuator position. The PIDI
block output is the computed dt value.
If StrokeTime is set to 0, a stroke time of 60 seconds is automatically used.
If ControlInt is set to 0, the control interval is automatically set equal to the Function
Block Program cycle time. However, if the ControlInt is longer than the cycle time
(hx), the PO block cannot be active more than hx seconds before a new output
from the PIDI block is calculated. This means that the output time dt, calculated in
equation (2), has to be propagated in pieces that are not longer than hx.
Example: If ControlInt = 10 s, hx = 1 s and dt = 5.5 s, the output from the PIDI block
is 1 s for 5 cycles, then 0.5 s during the sixth cycle and finally 0 s during the
following 4 cycles, until it is time to calculate dt again.
The proportional band corresponding to a certain proportional gain value can be
calculated as:

Figure: Calculated proportional band

P- and PD Control
A controller with an incremental output does not work very well without I-action.
Arbitrarily large steady state errors can be obtained, which do not necessarily
decrease when the controller gain is increased. For this reason, a controller with an
incremental output without I-action should not be used. However, if a controller
without I or D-action is desired, Ti or Td respectively is 0. In accordance with this, a
PI-controller is obtained by setting Ti > 0 and Td = 0. If the gain G is set to 0, the
program does execute, but the control signal does not change regardless of the
size of the error.
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Limitation of the Control Signal
The calculated travel time is limited to the range ±ControlInt (sec), since that is the
maximum amount of actuator travel time that can be obtained during one control
interval.

Operating Mode
The controller operating mode depends on the input signal Mode where:
• Mode = 0 => Off, controller stopped (dt = 0)
• Mode = 1 => Normal control
• Mode = 2 => Actuator forced to max (dt = ControlInt seconds)
• Mode = 3 => Actuator forced to min, (dt = –ControlInt seconds)
Note that when Mode = 2 or 3, the travel time is set to the smallest value that
makes the actuator move constantly in the desired direction. If Mode < 0 or Mode >
3, the controller operating mode is Off (same as Mode = 0).
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47.63

PIDP – PID Controller – Analog Output
The PIDP controller block is designed to be used in control loops where the
controller output is either connected to an analog physical output or used as a set
point for another control loop (cascade control).

Figure: The PID controller - analog output - block

Table: The PIDP Block Parameters
Parameter

Data Type

Description

ControlInt

REAL

Control interval (seconds)

UMin

REAL

Minimum permissible control
signal

UMax

REAL

Maximum permissible control
signal

StrokeTime

REAL

Actuator full stroke travel
time (seconds)

Table: The PIDP Block Inputs
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Input

Data Type

Description

MV

REAL

Measured value

SP

REAL

Setpoint

Mode

INTEGER

Controller operating mode

G

REAL

Proportional gain

Ti

REAL

Integral time (seconds)

Td

REAL

Derivative time (seconds)

DZ

REAL

Dead zone

TSg

REAL

Tracking signal (actual value
of the previous control signal)

04-16006-04-en, March 2015

47 Function Block Types
47.63 PIDP – PID Controller – Analog Output

Input

Data Type

Description

Table: The PIDP Block Output
Data Type

Access

REAL

R/W

Control Algorithm
The control algorithm is a discrete time positional PID algorithm, where the output
signal U(k) is calculated according to the diagram:

Figure: Figure control algorithm

Here SP is the setpoint value, MV is the measured value, G is the controller gain, Ti
is the integral time, Td is the derivative time and h is the control interval (ControlInt),
that is, the time between two successive updates of the controller output signal. If
ControlInt is set to 0, the control interval is automatically set equal to the program
cycle time.
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Time index k represents the present value of a variable, k-1 represents the value at
the previous evaluation of the control algorithm, and so on.
The PID-module is executed at the interval hx seconds, where hx seconds is the
function block program execution interval, even if the selected control interval is
longer. The control interval, h, must be a multiple of hx. If this is not the case, the
PID algorithm automatically selects the closest multiple smaller than h as the control
interval. By default the control interval is set equal to 1.
When the control error is smaller than the dead zone, that is abs(e) < DZ, the control
signal is set to the same value as the previous output, that is, the output is not
changed. The dead zone is given in the same units as the measurement value and
the setpoint.

Other Controller Types
The algorithm described above can be used for all types of controllers. At PI or PID
control the P-part does not depend on the difference between the setpoint and the
measured value, but only on the measured value, MV.
If P or PD control is used, the P-part automatically changes to depend on the error
(SP-MV). When these controllers are used, an offset value is also added to the
output signal:

Figure: Calculation of output signal

where Umax is the biggest permissible control signal and Umin is the smallest
permissible control signal.
If a controller without I- or D-action is desired, Ti or Td respectively is set to 0. In
accordance with this a PI-controller is obtained by setting Ti > 0 and Td = 0. If the
gain G is set to 0, the program does not fail to execute, but the control signal is not
changed regardless of the size of error.
Please note that when any of the G, Ti and Td parameters have been changed, an
automatic internal update of the controller is performed. No measures have to be
taken in the Function Block Program to avoid bumps in the control signal.

Limitation of the Control Signal
The parameter StrokeTime is used to define the actual full stroke travel time of the
actuator. Note that StrokeTime can be used to limit the change of the control signal
even if the output is not connected to an actuator.
If the controller output is used as a setpoint for another controller and there is no
special reason for limiting the change in the control signal, StrokeTime should be
set to 0, which is also the default value.
The maximum rate of change of the controller output during one control interval,
DuMax, depends on the actuator stroke time and can be calculated as:
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Figure: Calculated actuator stroke time

This corresponds to the maximum change in two successive output signals from
the PIDP block.
The calculated new control signal u(t) is limited to the interval (Umin , Umax). The
parameters UMin and UMax should be given in engineering units. Default values are
0 and 100 (%), respectively.

Operating Mode
The controller operating mode depends on the input signal Mode where:
• Mode = 0 => Off, controller stopped
• Mode = 1 => Normal control
• Mode = 2 => Controller output forced to UMax
• Mode = 3 => Controller output forced to UMin
If Mode = 0, the controller output tracks the signal on the tracking signal (TSg) input.
If Mode = 1, the controller ignores the (TSg input). If Mode < 0 or Mode > 3, the
controller operating mode is Off (same as Mode = 0).
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47.64

RAMP – Ramp Filter
The RAMP filter block limits the rate of change of the input variable.

Figure: The ramp filter block

Table: The RAMP Block Parameter
Parameter

Data Type

Description

Increment

REAL

Maximum increment in the
signal per second

Table: The RAMP Block Input
Data Type

Description

REAL

Input signal

Table: The RAMP Block Output
Data Type

Access

REAL

R/W

The maximum increment in the output signal per second is given by the parameter
increment. The sign of the increment parameter is ignored and the absolute value is
used as a rate limit.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
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47.65

SEQ – Sequencer
The SEQ block activates stages in proportion to the input signal.

Figure: The sequencer block

Table: The SEQ Block Parameters
Parameter

Data Type

Description

Stages

REAL

Number of output stages (1
to 16)

Rotation

BINARY

Defines whether or not there
is rotation of the stages

Period

INTEGER

Delay of simultaneous
activation of the stages in
milliseconds

Hysteresis

REAL

Width of the hysteresis (%)

Table: The SEQ Block Input
Data Type

Description

REAL

Input signal (%)

Table: The SEQ Block Output
Data Type

Access

INTEGER

RO

The Sequencer block is used to start N of M stages, where M is the total number of
output stages as defined by the Stages parameter (up to a maximum of 16) and N
is the Integer part of the result of the following calculation:
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Figure: Sequencer block algorithm

where Input is a value between 0% and 100%. The M stages are represented by
the first M bits of the Integer block output value. The first N of these bits is true (1)
and the rest false (0).
Example: If Stages is 4, and neither Hysteresis nor Rotation is used, stage one
starts (Output = 1; 0001) at 20% Input signal, stage two (Output = 3; 0011) at 40%,
stage three (Output = 7; 0111) at 60% and stage four (Output = 15; 1111) at 80%.
Function Block Editor uses a two-complement representation of signed integers,
the output signal for starting 16 stages would be –1 (1111111111111111).
If the Hysteresis parameter is zero, the previous formula gives the number of
activated stages as a function of the input signal. If Hysteresis has a non-zero value,
a hysteresis loop exists to the left or to the right (depending on whether Hysteresis
is a negative or a positive number) of the points calculated in the previous equation.
In this case, the activation values of the stages are displaced with respect to the
deactivation values. For example, if we define a 4 stage sequencer, the stages
started according to the previous formula is one stage at 20%, two stages at 40%,
three stages at 60% and four stages at 80%. If a positive hysteresis is defined,
equal to 10, activation of the stages is displaced to the right by 10%. The stages are
activated at 30%, 50%, 70% and 90%, but deactivation is maintained at the
previous values.
On the other hand, if the hysteresis were negative, for example –15%, deactivation
would be displaced to the left and so the stages would activate at 20%, 40%, 60%
and 80% and deactivate at 5%, 25%, 45% and 65%.

Figure: Hysteresis in different stages

The Period parameter is used to prevent two or more stages from being activated
simultaneously. If the value is non-zero, the stages is always activated sequentially
with an interval equal to Period (milliseconds), even if the input were to vary sharply,
obliging simultaneous activation of the stages. However, if this value is zero, the
stages can be activated simultaneously.
The Rotation parameter determines whether the active stages should rotate or not.
The difference between Rotation = 1 (with rotation) and Rotation = 0 (without
rotation) is that, in the first case, the stages deactivates in the same order in which
they activated. The stage which has been active longest is always deactivated first,
while in the second case, the deactivation order is the opposite of the activation
order. When the sequencer is defined with rotation, you can assume that the time
during which each stage remains active be approximately the same for all stages.
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47.66

Signal Source Blocks
Signal sources are function blocks that can give signals into the function block
program.

47.66.1

NCYC
The NCYC program cycle counter block increments the output value by one unit
each program cycle if InitValue is less than Final, and decreases the output value if
the opposite applies. When the count reaches the final value, the counter restarts
the count at the initial value in the next cycle.
For more information, see section 47.67 “NCYC – Program Cycle Counter” on page
1474.

47.66.2

OSC
The OSC oscillator block generates a train of pulses of duration PulseTime and a
period of CycleTime.
For more information, see section 47.68 “OSC – Oscillator” on page 1475.

47.66.3

PVB
The PVB block is used to assign a binary value to the input signal of another block.
For more information, see section 47.69 “PVB – Parameter Value Binary” on page
1476.

47.66.4

PVI
The PVI block is used to assign an integer value to the input signal of another block.
For more information, see section 47.70 “PVI – Integer Value Parameter” on page
1477.

47.66.5

PVR
The PVR block is used to assign a real value to the input signal of another block.
For more information, see section 47.71 “PVR – Real Value Parameter” on page
1478.
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47.67

NCYC – Program Cycle Counter
The NCYC program cycle counter block increments the output value by one unit
each program cycle if InitValue is less than Final, and decreases the output value if
the opposite applies. When the count reaches the final value, the counter restarts
the count at the initial value in the next cycle.

Figure: The program cycle counter block

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• When you edit a function block program, this block keeps the value from the
last program cycle. When you change the init value in Function Block Editor it
does not affect the block.
Table: The NCYC Block Parameters
Parameter

Data Type

Description

InitValue

INTEGER

Initial value of the counter

Final

INTEGER

Final value of the counter

Table: The NCYC block output
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Data Type

Access

INTEGER

R/W
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47.68

OSC – Oscillator
The OSC oscillator block generates a train of pulses of duration PulseTime and a
period of CycleTime.

Figure: The oscillator block

Table: The OSC Block Parameters
Parameter

Data Type

Description

CycleTime

REAL

Oscillation period (seconds)

PulseTime

REAL

Pulse duration (seconds)

Table: The OSC Block Output
Data Type

Access

BINARY

RO

The train of pulses is always a multiple of the program cycle time. For example, if
CycleTime is 7.4 seconds and PulseTime is 5.2 seconds and the function block
program cycle time is 1 second, a 6 second pulse fires every eight seconds.
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47.69

PVB – Parameter Value Binary
The PVB block is used to assign a binary value to the input signal of another block.

Figure: The binary value parameter block

Table: The PVB Block Parameter
Parameter

Data Type

Description

InitValue

BINARY

Initial output state

Table: The PVB Block Output
Data Type

Access

BINARY

R/W

The initial state of the output is determined by the InitValue parameter.
If the output signal is not public, this block acts as a constant parameter value for
another block input, since it is never modified during execution of the function block
program.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• For public PVx blocks: When a program is edited, this block will keep the
value from the last program cycle. A change of the init value in the editor will
have no effect.
• For non public PVx blocks: When a program is edited, this block will get the
new value from the editor.
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47.70

PVI – Integer Value Parameter
The PVI block is used to assign an integer value to the input signal of another block.

Figure: The integer value parameter

Table: The PVI Block Parameter
Parameter

Data Type

Description

InitValue

INTEGER

Initial value of the output
signal

Table: The PVI Block Output
Data Type

Access

INTEGER

R/W

The initial value of the output is determined by the InitValue parameter.
If the output signal is not public, this block acts as a constant parameter value for
another block input, since it is never modified during execution of the function block
program.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• For public PVx blocks: When a program is edited, this block will keep the
value from the last program cycle. A change of the init value in the editor will
have no effect.
• For non public PVx blocks: When a program is edited, this block will get the
new value from the editor.
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47.71

PVR – Real Value Parameter
The PVR block is used to assign a real value to the input signal of another block.

Figure: The real value parameter block

Table: The PVR Block Parameter
Parameter

Data Type

Description

InitValue

REAL

Initial value of the output

Table: The PVR Block Output
Data Type

Access

REAL

R/W

The initial value of the output is determined by the InitValue parameter.
If the output signal is not public, this block acts as a constant parameter value for
another block input, since it is never modified during execution of the function block
program.

Note
• When you create a function block program, this block gets the initial value as
specified in the block.
• For public PVx blocks: When a program is edited, this block will keep the
value from the last program cycle. A change of the init value in the editor will
have no effect.
• For non public PVx blocks: When a program is edited, this block will get the
new value from the editor.
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48 Function Block Operators
48.1 Operators

48.1

Operators
An operator is a type of function, which can perform an operation on one or several
operands.

Figure: An example of an operator

You can connect the analog input of an operator to a real or an integer output. You
can connect the analog output of an operator to both real and integer inputs. When
the analog output of an operator is connected to an integer input, the operator
output is converted to an integer.

Note
• If the same operator output is connected to more than one function block,
these inputs receive an integer signal. An additional conversion might be
needed.
You can only connect binary inputs to other binary outputs.

Note
• Function Block Editor performs Modulo operations on integers.

48.1.1

Constant Operators
Constant operators give a static value to the function block program.
Table: Constant Operators

48.1.2

Name

Description

Binary const

No input / Binary output

Integer const

No input / Integer output

Real const

No input / Real output

Logical Operators
Logical operators perform logical operations.
Table: Logical Operators
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Name

Description

NOT

Binary input – Binary output
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Continued

48.1.3

Name

Description

AND

Binary inputs – Binary output

OR

Binary inputs – Binary output

XOR

Binary inputs – Binary output

Math Operators
Math operators perform mathematical operations.
Table: Math Operators

48.1.4

Name

Description

Negate

Analog input – Analog output

Addition

Analog inputs – Analog output

Subtraction

Analog inputs – Analog output

Product

Analog inputs – Analog output

Division

Analog inputs – Analog output

Module

Analog inputs – Analog output

Comparison Operators
Operators used in comparison operations.
Table: Comparison Operators

48.1.5

Name

Description

Less than

Analog inputs – Binary output

Greater than

Analog inputs – Binary output

Equal

Analog inputs – Binary output

Not equal

Analog inputs – Binary output

Greater or equal

Analog inputs – Binary output

Less or equal

Analog inputs – Binary output

Bit Operators
Operators used in bit operations.

Technical
1484

04-16006-04-en, March 2015

48 Function Block Operators
48.1 Operators

Table: Bit Operators

48.1.6

Name

Description

bit AND

Analog inputs – Analog output

bit OR

Analog inputs – Analog output

bit XOR

Analog inputs – Analog output

Shift right

Analog inputs – Analog output

Shift left

Analog inputs – Analog output

Other Operators
Miscellaneous uncategorized operators.
Table: Other Operators
Name

Description

D/A converter

Binary input – Analog output

A/D converter

Analog input – Binary output

Analog multiplexer

Analog inputs – Analog output

Binary multiplexer

Binary inputs – Binary output

Conversion AA

Integer signal – Real signal
or
Real signal – Integer signal
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48.2

Adding an Operator
You create a program by adding simple blocks, operators, and expression blocks.
For more information, see section 48.1 “Operators” on page 1481.

To add an operator
1. In Function Block Editor, right-click in the diagram window at the position
where you want to add the operator.
2. On the NEW menu, click Operator.
3. In the Operators list, select the operator you want to add.

4. Click OK.
5. If the operator is enclosed by a red rectangle, move the operator to an empty
space.
6. Click outside the green rectangle that encloses the operator to clear the
selection.
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48.3

Constant Operators
Constant operators give a static value to the function block program.

48.3.1

Binary Const
Binary constants give a binary static value to the function block program.

Inputs and Outputs
No input / Binary output

48.3.2

Integer Const
Integer constants give an integer static value to the function block program.

Inputs and Outputs
No input / Integer output

48.3.3

Real Const
Real constants give a real static value to the function block program.

Inputs and Outputs
No input / Real output
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48.4

Logical Operators
Logical operators perform logical operations.

48.4.1

NOT operator
Logical NOT operators invert binary signals.

Inputs and Outputs
Binary input / Binary output

48.4.2

AND operator
AND operators perform logical AND operations between two binary signals.

Inputs and Output
Binary inputs / Binary output

48.4.3

OR operator
OR operators perform logical OR operations between two binary signals.

Inputs and Output
Binary inputs / Binary output

48.4.4

XOR operator
XOR operators perform logical XOR operations between two binary signals.

Inputs and Output
Binary inputs / Binary output
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48.5

Math Operators
Math operators perform mathematical operations.

48.5.1

Negate
Negate operators invert analog signals.

Input and Output
Analog input / Analog output.

48.5.2

Addition
Addition operators add values of analog signals.

Inputs and Output
Analog inputs / Analog output

48.5.3

Subtraction
Subtraction operators subtract one value from another.

Inputs and Output
Analog inputs / Analog output

48.5.4

Product
Product operators multiply two analog signals.

Inputs and Output
Analog inputs / Analog output

48.5.5

Division
Division operators divide two analog signals.

Inputs and Output
Analog inputs / Analog output

48.5.6

Modulo
Modulo operators calculate the remainder of division of one number by another.
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Inputs and Output
Analog inputs / Analog output
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48.6

Comparison Operators
Operators used in comparison operations.

48.6.1

Less than
Less than operators compare two analog values.

Inputs and Output
Analog inputs / Binary output

48.6.2

Greater than
Greater than operators compare two analog values.

Inputs and Output
Analog inputs / Binary output

48.6.3

Equal
Equal operator compare two analog values.

Inputs and Output
Analog inputs / Binary output

48.6.4

Not Equal
Not equal operators compare two analog values.

Inputs and Output
Analog inputs / Binary output

48.6.5

Greater or Equal
Greater or equal operators compare two analog values.

Inputs and Output
Analog inputs / Binary output

48.6.6

Less or Equal
Less or equal operators compare two analog values.
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Inputs and Output
Analog inputs / Binary output
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48.7

Bit Operators
Operators used in bit operations.

48.7.1

bit AND
Bit AND operators compare bitwise AND operations.

Inputs and Output
Integer inputs / Integer output

48.7.2

bit OR
Bit OR operators compare bitwise OR operations.

Inputs and Output
Integer inputs / Integer output

48.7.3

bit XOR
Bit XOR operators compare bitwise XOR operations.

Inputs and Output
Integer inputs / Integer output

48.7.4

Shift Right
Shift right operators right-shift and insert 0 to the left most bit positions. The second
input indicates the number of positions to move.

Inputs and Output
Integer inputs / Integer output

48.7.5

Shift Left
Shift left operators left-shift and insert 0 to the right most bit positions. The second
input indicates the number of positions to move.

Inputs and Output
Integer inputs / Integer output
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48.8

Bit Operator Examples
Bit operators operate on bit level and have integers as signals.

Bit operation example

Figure: Operator bit AND – Analog inputs -> Analog output

Figure: Operator bit OR – Analog inputs -> Analog output

Figure: Operator XOR bit – Analog inputs -> Analog output

Figure: Operator << – Analog inputs -> Analog output
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Figure: Operator >> – Analog inputs -> Analog output

Note
• All 16 positions are shifted, and 0 is shifted into empty positions. Any shift
count >16 always gives the output value 0.
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48.9

Miscellaneous Operators
Miscellaneous uncategorized operators.

48.9.1

D/A Converter
D/A Converter operators convert binary signals to an analog value. Logical FALSE
gives 0, logical TRUE gives 1.

Inputs and Output
Binary inputs / Analog output

48.9.2

A/D Converter
A/D Converter operators convert analog values to a binary signal. 0 gives logical
FALSE, all other values give logical TRUE.

Inputs and Output
Analog inputs / Binary output

48.9.3

Analog Multiplexer
Analog multiplexer operators select one of two possible analog values depending
on the logical signal.

Inputs and Output
Two analog and one binary input / Analog output

48.9.4

Binary Multiplexer
Binary multiplexer operators select one of two possible binary signals depending on
the logical signal.

Inputs and Output
Three binary inputs / Binary output

48.9.5

Conversion AA
Conversion AA operators convert a real value to an integer value or an integer value
to a real value.

Inputs and Output
Analog input / Analog output
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49 Function Block User Interface
49.1 Function Block Editor (Edit Mode)

49.1

Function Block Editor (Edit Mode)
Use Function Block Editor in Edit mode to program new or edit existing function
block programs. The work area in Edit mode consists of the diagram window.

Figure: Function Block Editor window in Edit mode

Table: Function Block Editor Window in Edit Mode
Number

Description
Function Block Editor menu bar
Function Block Editor diagram window
Function block program in diagram window
Function Block Editor position indicator
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49.2

Function Block Editor File Menu
Use the File menu in Edit mode to save, import, export, and print function block
programs.

Figure: Function Block Editor File menu
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Component

Description

Save

Saves the function block program to the
object in the Building Operation database.

Import

Opens the Import dialog box where you
import a function block program as an .aut
file.

Export

Opens the Export dialog box where you
export a function block program as an .aut
file.

Print

Opens the Print dialog box.
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49.3

Function Block Editor Edit Menu
Use the Edit menu to work with objects in the Function Block Editor diagram
window.

Figure: Function Block Editor Edit menu

Table: Edit Menu
Command

Description

Undo

Undoes the latest command in Function
Block Editor.

Copy To Clipboard

Copies a function block to the clipboard.

Copy

Copies a function block.

Paste

Pastes a function block.

Delete

Deletes a function block.

Select All

Selects all objects in the Function Block
Editor diagram window.

Search

Opens the Search dialog box where you
search for text strings in the function blocks.

Replace

Opens the Replace dialog box where you
replace text strings in the function blocks.

Center Selection

Centers a selected group of objects in the
Function Block Editor diagram window.

Add Boundary Ties

Adds boundary ties when you prepare a
printout.
• First position: Page number, vertically
continued.
• Second position: page number,
horizontally continued.
• Third position: signal number on page.
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Continued
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Command

Description

Remove Boundary Ties

Removes boundary ties from a printout. All
manually moved and deleted cross reference
boxes are restored when you add boundary
ties.
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49.4

Preferences Menu
Use the Preferences menu to set various page display and print options in Edit
mode.

Figure: Function Block Editor Preferences menu

Table: Preferences Menu
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Command

Description

Page Setup

Opens the Page Setup dialog box where
you customize printout pages from Function
Block Editor.

View Only Public Identifier

Displays only the Public Identifier in the
Function Block Editor diagram window.

Show Status Bar

Displays the status bar at the bottom of the
diagram window.

Orthogonal Connections

Makes all connections in the diagram
window orthogonal, which means that all
segments are done in 90 degree angles.
Orthogonal connections is the default in
Function Block Editor.

Black And White

Displays the diagram window and its
contents in black and white.
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49.5 Options Menu

49.5

Options Menu
Use the Options menu to toggle between Edit mode and Simulation mode, to
access Simulation mode settings, lists, tables, and trees for specific function block
programs.

Figure: Function Block Editor Options menu

Table: Options Menu

Technical
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Command

Description

Simulate

Changes to Simulation mode.

Set Date And Time

Opens the Set Date and Time dialog box
where you set the date and time in
simulation mode.

Constants Table

Opens the Constants Table dialog box
where you can view, add, and delete
constants.

Public Signal Table

Opens the Public Signal Table property
sheet with a list of the public signals in the
function block program and their
descriptions.

Show HFB Navigation Tree

Opens the Show HFB Navigation Tree.
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49.6

Zoom Menu
Use the Zoom menu to zoom in and out in a function block program. You can
zoom out in any of the indicated percentages and return to normal view.

Figure: Function Block Editor Zoom menu in Simulation mode

04-16006-04-en, March 2015

Technical
1505

49 Function Block User Interface
49.7 Commands Menu

49.7

Commands Menu
Use the Commands menu to adjust the Function Block Editor simulation in
Simulation mode.

Figure: Function Block Editor Commands menu in Simulation mode

Table: Commands Menu

Technical
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Command

Description

Reset

Resets all values in a function block program
simulation.

Step

Executes the simulation of a function block
program step-by-step.

Execute

Starts the simulation of a function block
program. Click Execute again to stop the
simulation.

Execute n Times

Executes a simulation of a function block
program in the number of program cycles (n)
you type in the box. Press Enter to start the
execution.

Sampling

Samples the program execution the number
of times you type in the box. Press Enter to
start the sampling.
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49.8

Function Block Editor Tools Menu
Use the Tools menu to refresh the screen in both Edit and Simulation mode.

Figure: Function Block Editor Tools menu

Table: Tools Menu
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Command

Description

Redraw Screen

Refreshes the screen.
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49.9 Function Block Editor Help Menu

49.9

Function Block Editor Help Menu
Use the Help menu to get to the online help and information about the Function
Block Editor.

Figure: Function Block Editor Help menu

Table: Function Block Editor Help Menu
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Command

Description

Online Help

Connect to WebHelp.

About Function Block Editor

Displays the version number of Function
Block Editor, copyright information, the
license agreement, and technical
information.
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49.10

Import Dialog Box
Use the Import dialog box to import a function block program .aut file into Function
Block Editor.
The .aut file is a text file with function block program source code and data including
a graphical block diagram.

Figure: Function Block Editor Import dialog box
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49 Function Block User Interface
49.11 Export Dialog Box

49.11

Export Dialog Box
Use the Export dialog box to export a function block program that contains
functionality you want to make available for reuse. The function block program is
exported as an .aut file.
The .aut file is a text file with function block program source code and data including
a graphical block diagram.

Figure: Function Block Editor Export dialog box
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49.12

Print Dialog Box
Use the Print dialog box to customize printouts of function block programs in both
Edit and Simulation mode.

Figure: Function Block Editor Print dialog box

Table: Print Dialog Box
Component

Description

Public Signals

Select to print a list of all public signals in the
function block program. The properties
included in the table are:
• Name
• Type
• Acc (access class)
• Unit
• Description

Alarms

Select to include a list of all alarms in the
function block program. The properties
included in the table are:
• Alarm name
• Parameter name
• Alarm Text
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49.12 Print Dialog Box

Continued
Component

Description

Constants

Select to print a list of all defined constants in
the function block program. The properties
included in the table are:
• Public
• Name
• Value

Constants Usage

Select to print a list of used constants in the
function block program. The properties
included in the table are:
• Constant
• Block where it is used.

Time Schedules

Select to print a list of the time schedules in
the function block program. The properties
included in the table are:
• Name
• W (max. number of weekly charts)
• H (max. number of holiday charts)
• Start Date
• Stop Date
• Start Time
• Stop Time
• Weekdays.

Block Parameters

Select to print a list of all function block
parameters in the function block program.
The properties included in the table are:
• Type
• Name
• Parameter or Value
• Parameter or Value
The content of the list depends on the
selected All Blocks or Public Blocks
options.

FBD

Select to include a graphic presentation of
the function block diagram in the printout.

Page Number

Select to number the function block
diagram. The properties are:
• Page number
• Total number of pages

Current Level

Technical
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Click to print only the current level of a
function block diagram when hierarchical
function blocks (HFBs) are used.
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49.12 Print Dialog Box

Continued
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Component

Description

All Levels

Click to print all levels of a function block
diagram when hierarchical function blocks
(HFBs) are used.

Text File

Select to add an optional associated text file
to the function block program printout.

Overview

This function is not available in this version of
Function Block Editor.

Detailed

This function is not available in this version of
Function Block Editor.

Scale Output to one page

Select if you want to print the selection on
one page only.

Color Printout

Select to make a color print.

Skip Empty Pages

Select to avoid printing empty pages.

Public Blocks

Click to print only parameters from public
function blocks.

All Blocks

Click to print out all blocks.

Printer

Select the printer you want to use from the
list.
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49.13

Page Setup Dialog Box
Use the Page Setup dialog box in Edit mode, to customize printouts of a function
block program.

Figure: Function Block Editor Page Setup dialog box

Table: Page Setup Dialog Box
Component

Description

Variables

Select the variables that are included in the
second line of the page heading of the
printout.
The available list items are:
• #abbrev, #author, #date, and #name
(originating from the program
specification)
• #prdate and #prtime (printout time and
date)
• #tab (tab character)
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Left

Type the left margin in mm.

Top

Type the top margin in mm.

Right

Type the right margin in mm.

Bottom

Type the bottom margin in mm.

Horizontal

Enter the number of horizontal pages used
to print the function block program. You
cannot set the number of pages to a lower
number than what is required to display the
complete function block program when
maximally zoomed out. Changing the Block
size percentage reduces the minimum
number of pages.
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49.13 Page Setup Dialog Box

Continued
Component

Description

Vertical

Enter the number of vertical pages used to
print the function block program. You cannot
set the number of pages to lesser than
required to display the complete function
block program when maximally zoomed out.
Changing the Block size percentage
reduces the minimum number of pages.

Landscape

Click to print the pages in landscape
orientation.

Portrait

Click to print the pages in portrait orientation.

Block sizes (%)

Enter the size of the blocks in percent.
Smaller block sizes can be used for a better
overview. Larger block sizes make the
printed pages easier to read.
Block sizes ranges from 25 to 500%. The
default value in Function Block Editor is
100%.
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Show page breaks

Select to display the page breaks in the
diagram window.

Page Header

Type a title to use in the second line of the
page header. The first line in the page
header always contains the name of the
function block program. You can enter either
free text or add items from the Variables list
in the Page Header.
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49.14

Search Dialog Box
Use the Search dialog box to search for text strings in function block programs.
The text strings can be: signal names, constant names, module names, comment
text, and block types. When the searched text string is found, the item containing
the string is selected and framed in green. Search is available in Edit mode.

Figure: Function Block Editor Search dialog box

Table: Search Dialog Box
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Component

Description

Search for

Enter the string to search for. When the
Search for box is empty, all blocks of the
marked block type(s) and comments are
searched for.

Signal-/ Constant Names

Select to search for the string in signal
names in block identifiers, constant names,
and network addresses.

Comment Text

Select to search for the string in comment
texts.

Block Types

Select a single block type or all block types
to search in.

Module Names

Select to search for the string used as a
Module name in block identifiers, constant
names, and network addresses.

Match case

Select to make a case sensitive search for
the string.

Whole words

Select to search for whole words.

Search Next

Click to continue the search.

Close

Click to close the dialog box.
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49.15

Replace Dialog Box
You use the Replace dialog box to search and replace text strings in function
block programs. The text string can be: signal names, constant names, module
names, comment text, and block types. Replace is available in Edit mode.

Figure: Function Block Editor Replace dialog box

Table: Replace Dialog Box
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Component

Description

Search for

Type the string you want to search for. If the
Search for box is empty, all blocks of the
marked block type(s) and comments are
searched for.

Replace with

Type the string you want to use instead of
the original text.

Signal- /Constant Names

Select to search for the string in signal
names in block identifiers, constant names,
and network addresses.

Comment Text

Select to search for the string in comment
texts.

Block Types

Select a single block type or all types to
search in.

Module Names

Select to search for the string used as a
Module name in block identifiers, constant
names, and network addresses.

Case sensitive

Select to make a case sensitive search for
the string.

Whole words

Select to search for whole words.
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49.15 Replace Dialog Box

Continued
Component

Description

Replace only first appearance

Select to replace only the first match of the
string in a block. Otherwise, all matches in
the block are replaced.

Search Next

Click to continue the search.

Replace

Click to replace the string.
After replacing text, ensure that the new
name does not exceed the character limit.
• Module Name does not exceed 12
characters.
• Signal or Constant Names do not
exceed 10 characters.

Replace All

Click to replace all matches of the string.
After replacing text, ensure that the new
name does not exceed the character limit.
• Module Name does not exceed 12
characters.
• Signal or Constant Names do not
exceed 10 characters.

Close
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Click to close the dialog box.
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49.16

NEW Menu
Use the NEW menu to create new objects in the Function Block Editor diagram
window in Edit mode.

Figure: Function Block Editor NEW menu

Table: NEW Menu
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Command

Description

Simple Block

Opens the Select Simple Block dialog
box where you select the type of function
block you want to create.

Operator

Opens the Select Operator dialog box
where you select the type of operator you
want to create.

Expression

Opens the Edit expression dialog box
where you can write and edit a logical
expression.

Node

Defines the output signal type as Real,
Integer or Binary.

HFB

Opens the Edit Hierarchy dialog box
where you can edit the hierarchy in a
hierarchical function block.

HFB I/O

Opens the Select Hierarchy Connection
dialog box. The HFB I/O is only available if
you click inside a hierarchical function block.

Compress HFB

Compresses a hierarchical function block.

Comment

Opens the Edit comment dialog box.

Line

Click to add a line.

Rectangle

Adds a rectangle.
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49.16 NEW Menu

Continued
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Command

Description

Paste

Pastes a function block from the clipboard.

Load Macro

Opens the Load Macro dialog box.
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49.17

BLOCK Menu
Use the BLOCK menu to edit a block and its connections in Edit mode.

Figure: Function Block Editor BLOCK menu

Table: BLOCK Menu
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Command

Description

Edit

Opens the Edit block menu.

Duplicate

Duplicates a function block.

Disconnect

Disconnects a function block.

Delete

Deletes a function block.

Expand HFB

Expands an HFB.
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49.18

INPUT Menu
Use the INPUT menu to edit a block input in Function Block Editor in Edit mode.

Figure: Function Block Editor INPUT menu

Table: INPUT Menu
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Command

Description

Disconnect

Disconnects an input.

Detach

Detaches an input.
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49.19 OUTPUT Menu

49.19

OUTPUT Menu
Use the OUTPUT menu to edit a block output in Function Block Editor in Edit
mode.

Figure: Function Block Editor OUTPUT menu

Table: OUTPUT Menu
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Command

Description

Disconnect

Disconnects an output.

Delete

Deletes an output.
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49.20

CONNECTION Menu
Use the CONNECTION menu to edit a connection in Function Block Editor in Edit
mode.

Figure: Function Block Editor CONNECTION menu

Table: CONNECTION Menu
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Command

Description

Move Node

Moves a node.

Create Node

Creates a node.

Delete Node

Deletes a node.

Detach

Detaches a node.

Mark

Changes the color of the selected
connection.

Unmark

Changes the color of the selected
connection to the default color (black).

Unmark all

Changes the color of all the connections in
the Diagram window to the default color
(black).
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49.21

Select Simple Block Dialog Box
Use the Select Simple Block dialog box to create a Function Block Editor simple
block in Edit mode.

Figure: Function Block Editor Select Simple Block dialog box

Table: Select Simple Block Dialog Box
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Component

Description

Simple Block

Type the name of the block type you want to
create, if you know the name.

Description box

Displays a short description of the selected
simple block.

List

Select a subset of simple blocks to display in
the list.

Block selection list

Select the block you want to create.

Technical
1525

49 Function Block User Interface
49.22 Edit Expression Dialog Box

49.22

Edit Expression Dialog Box
Use the Edit expression dialog box to create or edit a Function Block Editor
expression block in Edit mode.

Figure: Function Block Editor Edit Expression dialog box

Table: Edit Expression Dialog Box
Component

Description

Identifier

Type a new name for the expression block.

Unit

Select an engineering unit.

Description

Type a description of the block up to 40
characters.

Public

Select if the output signal from the block is a
public signal.

Read/Write

Select to be able to modify the output signal
from other network nodes during execution
of the function block program, and manually
during offline simulation.
The R/W option cannot be selected for
blocks with RO access.
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Access

Displays the type of access (RO or RW) for
the output signal from the block.

Node

Click to define the output signal type as Real,
Integer or Binary.
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49.22 Edit Expression Dialog Box

Continued
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Component

Description

Expression

Type the arithmetic or logical expression.
The maximum length of an expression is 500
characters.
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49.23

Edit Block Dialog Box
Use the Edit block dialog box to edit a Function Block Editor block in Edit mode.

Figure: Function Block Editor Edit block dialog box

Table: Edit Block Dialog Box
Component

Description

Identifier

Type a new name for the block in the
Identifier box.

Unit

Select an engineering unit.

Description

Type a description of the block up to 40
characters.

Public

Select if the output signal from the block is a
public signal and included in the Public
Signal Table.

Read/Write

Select to be able to modify the output signal
from other network nodes during execution
of the function block program, and manually
during offline simulation.
The R/W option cannot be selected for
blocks with RO access.
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Backup

Select to have the current value of the
function block output used when the devices
perform a warm start.

Type

Displays the value type: Real, Integer or
Binary.

Access

Displays the type of access (Read Only or
Read/Write) for the output signal from the
function block.
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Continued
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Component

Description

Parameters

Displays function block parameters. The set
of parameters depend on the function block
type. Some function blocks have no
parameters.
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49.24

Select Operator Dialog Box
Use the Select Operator dialog box to create an operator in Function Block
Editor in Edit mode.

Figure: Function Block Editor Select Operator dialog box

Table: Select Operator Dialog Box
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Component

Description

Operator

Type the name of the operator type you
want to create, if you know the name.

Operators

Select the operator you want to create from
the list.
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49.25

Edit Operator Dialog Box
Use the Edit operator dialog box to edit the properties of the operator.

Figure: Edit operator dialog box

Table: Edit Operator Dialog Box
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Component

Description

Identifier

Type a new name for the operator.

Unit

Select an engineering unit.

Description

Type a description of the operator.
Maximum 40 characters.

Public

Select to make the output signal from the
operator a public signal that is included in
the Public Signal Table.

Mode 2

Select to change the orientation of the
connections.

Type

Defines the data type of the operator output.

Access

Defines whether the signal exported by the
operator is read-only (RO) or read/write
(R/W).

Parameters

Displays the operator parameters. The set of
parameters depend on the operator type.
Some operators have no parameters.
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49.26

Constants Table Dialog Box
Use the Constants Table dialog box to add or delete constants in Function Block
Editor in Edit mode.

Figure: Function Block Editor Constants Table dialog box

Table: Constants Table Dialog Box
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Component

Description

Public

Displays if the constant is public.

Name

Displays the name of the constant.

Value

Displays the value of the constant.

Unit

Displays the unit of the constant.

Description

Displays the description of the constant.

Exit

Click to exit the dialog box without making
any change.

Delete

Click to delete the constant that is marked in
the constant list.

Add

Click to add a new constant.

Delete Unused

Click to delete all unused constants.
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49.27

New Constant Dialog Box
Use the New constant dialog box to add a new constant in Edit mode.

Figure: Function Block Editor New constant dialog box

Table: New Constant Dialog Box
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Component

Description

Identifier

Type a name for the constant you want to
create. Blank spaces are not allowed.

Value

Type the required constant value.

Public

Select to make the constant public, that is,
accessible from outside the block.

Unit

Select the engineering unit.

Description

Type a description for the constant.
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49.28 Public Signal Table

49.28

Public Signal Table
Use the Public Signal Table in Edit mode to display all public signals in a function
block program.

Figure: Function Block Editor Public Signal Table dialog box

Table: Public Signal Table Dialog Box
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Component

Description

Name

Displays the name of the public signal.

Description

Displays the description of the public signal.
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49.29

Edit Hierarchy Dialog Box
Use the Edit Hierarchy dialog box to create a new hierarchical function block or
to edit an existing hierarchical function block in Edit mode.

Figure: Function Block Editor Edit Hierarchy dialog box

Table: Edit Hierarchy Dialog Box

04-16006-04-en, March 2015

Component

Description

Identifier

Type a name for the hierarchical function
block.

Description

Type a description for the hierarchical
function block.
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49.30

Edit Comment Dialog Box
Use the Edit comment dialog box to add or edit a comment in the diagram
window in Edit mode.

Figure: Function Block Editor Edit comment dialog box

Table: Edit Comment Dialog Box
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Component

Description

Comment

Type the comment you want to display in the
function block program.

Font

Opens the Font dialog box.
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49.31

Font Dialog Box
Use the Font dialog box to change the font, font style, and size of a comment in
Edit mode.

Figure: Function Block Editor Font dialog box

Table: Font Dialog Box
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Component

Description

Font

Select a font.

Font style

Select a font style.

Size

Select a font size.

Strikeout

Select if you want the text to be struck out.

Underline

Select if you want the text to be underlined.

Color

Select a font color from the list.

Sample

Displays the formatted text.

Script

Select a script style.
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49.32

Select Hierarchy Connection Dialog Box
Use the Select Hierarchy Connection dialog box to add inputs and outputs
from a hierarchical function block in Edit mode.

Figure: Function Block Editor Select Hierarchy Connection dialog box

Table: Select Hierarchy Connection Dialog Box
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Component

Description

HB I/O types

Select the required input or output for the
hierarchical function block.
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49.33

HFB Navigation Tree
Use the HFB Navigation Tree to navigate inside hierarchical function blocks in
Edit mode.

Figure: Function Block Editor HFB Navigation Tree box
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49.34

Function Block Editor (Simulation Mode)
Use Function Block Editor in Simulation mode to test function block programs.

Figure: Function Block Editor window in Simulation mode

Table: Function Block Editor Window in Simulation Mode
Number

Description
Function Block Editor menu bar
Simulation control buttons
Function block diagram window
Online/Offline status box
Cycle counter
Trend area
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49.34 Function Block Editor (Simulation Mode)

Continued
Number

Description
Input buttons

Function Block Editor Simulation mode has a number of buttons that you use to
control how the Simulation is done.
Table: Tools in Simulation Mode
Button

Description
Click to start or stop a simulation.
Click to execute a simulation in steps.
Displays the number of executed program
cycles.
Click to reset the cycle counter.

Right-click to open the Input dialog box.

Click to modify a value during simulation, or
right-click to open the RECORD menu where
you make the required recording settings.

04-16006-04-en, March 2015

Technical
1541

49 Function Block User Interface
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49.35

File Menu in Simulation Mode
Use the File menu in Simulation mode to print a simulation or to exit Function Block
Editor.

Figure: Function Block Editor File menu in Simulation mode

Table: File Menu
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Command

Description

Print

Opens the Print dialog box that you use to
print out a function block program.

Exit

Exits Function Block Editor.
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49.36

Preferences Menu in Simulation Mode
Use the Preferences menu to set display options in Simulation mode.

Figure: Function Block Editor Preferences menu in Simulation mode

Table: Preferences Menu in Simulation Mode
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Command

Description

Page Setup

Opens the Page Setup dialog box.

View Only Public Identifier

Displays only Public Identifier in the Function
Block Editor diagram window.

View Signal Values

Displays the signal values in the function
blocks during simulation.

Show Status Bar

Displays the status bar at the bottom of the
diagram window.
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49.37

Options Menu in Simulation Mode
Use the Options menu to toggle between Simulation mode and Edit mode, to set
date and time, and to access tables and a view of hierarchical function blocks in
Simulation mode.

Figure: Function Block Editor Options menu in Simulation mode

Table: Options Menu in Simulation Mode
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Command

Description

Edit

Changes to Edit mode.

Set Date and Time

Opens the Set Date and Time dialog box.

Constants Table

Opens the Constants Table dialog box.

Public Signal Table

Opens the Public Signal Table dialog box.

Show HFB Navigation Tree

Opens the HFB Navigation Tree dialog
box.
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49.38

Set Date and Time (Simulation) Dialog
Box
Use Set Date And Time (Simulation) to set date and time in Edit and Simulation
mode.

Figure: Set Date and Time (Simulation) dialog box

Table: Set Date and Time (Simulation) dialog box
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Property

Description

Date (yy/mm/dd)

Type the date.

Time (hh/mm/ss)

Type the time.
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49.39

Analog Input Dialog Box
Use the Analog Input dialog box to generate analog signal variations for physical
inputs automatically or manually in Simulation mode.

Figure: Function Block Editor Analog Input dialog box

Table: Analog Input Dialog Box
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Component

Description

Manual

Click to manually control the input values.

Automatic

Click to automatically generate input values.

Wave Form

Select the shape of the generated signal
from the list.

Amplitude

Type the sequence of wave periods with
different amplitudes separated by a comma
for the generated signal.

Circular

Select to repeat the sequence, defined in the
Amplitude box. Clear to revert the input to
manual mode after generating the sequence
once.

Average Value

Type the average value that, together with
the amplitude, gives the generated value.

Phase (degrees)

Type the time displacement of the generated
signal, in degrees. A complete period is 360
degrees.

Period (sec.)

Type the duration of a complete wave period
in seconds.
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49.40

Digital Input Dialog Box
Use the Digital Input dialog box to generate digital signal variations for physical
inputs automatically or manually in Simulation mode.

Figure: Function Block Editor Digital Input dialog box

Table: Digital Input Dialog Box
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Component

Description

Manual

Click to manually control the input values.

Automatic

Click to automatically generate input values.

Sequence

Type the sequence you want to test
separated by a comma.

Circular

Select to repeat the sequence. Clear to
revert the input to manual mode after
generating one sequence.

Period (ms.)

Type the duration of a sequence period in
milliseconds.
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49.41

RECORD Menu
Use the RECORD menu to define how to record signals in Simulation mode.

Figure: Function Block Editor RECORD menu in Simulation mode

Table: RECORD Menu

Technical
1548

Command

Description

Modify

Modifies a value during simulation.

Edit Range

Edits the maximum and minimum value for
the recording.

Stop at Limit

Opens the Edit Break Limit dialog box
where you set the break points where the
simulation is stopped.

Delete

Deletes the recording of the selected signal.

04-16006-04-en, March 2015

49 Function Block User Interface
49.42 Edit Break Limit Dialog Box

49.42

Edit Break Limit Dialog Box
Use the Edit Break Limit dialog box to stop logging and simulation when the
logged values exceed a defined level in Simulation mode.

Figure: Function Block Editor Edit Break Limit dialog box in Simulation mode

Table: Edit Break Limit Dialog Box
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Component

Description

Break Active

Select to stop the simulation when the set
value is reached.

Break when signal

Select to stop the simulation when the value
exceeds or is below the limit.

the limit

Type the limit for when to break the signal.
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49.43

TREND Menu
Use the TREND menu to clear, restart, and reset the recorder in Simulation mode.
You open the TREND menu by right-clicking on the Trend area in Function Block
Editor.

Figure: Function Block Editor TREND menu in Simulation mode

Table: TREND Menu
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Command

Description

Clear

Clears all trends in the recorder. The logged
signals are not affected.

Restart

Restarts the recorder. The previous graph is
not affected but the logging restarts.

Reset

Restarts the recorder and removes all
defined logged signals from the recorder.
The previous graph is not affected.
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49.44

SIGNAL Menu
Use the SIGNAL menu to modify the value or state of signals with a RW (read/write)
access in Simulation mode.

Figure: Function Block Editor SIGNAL menu in Simulation mode

Table: SIGNAL Menu
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Command

Description

Modify

Modifies a value.

View

Opens the View block property sheet. It
displays the information you can edit in the
Edit Block dialog box in Edit mode.

Record

Adds the signal to the recorder.

Delete

Deletes the signal from the recorder.

Mark

Changes the color of the selected
connection.

Unmark

Clears the selected color of a connection
and resets the color to the default color
(black).

Unmark all

Resets the color of all connections to the
default color (black).

Expand

Expands a hierarchical function block and
display the sub level.
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49.45

Function Block Program Properties –
Basic Tab
Use the Basic tab to view status and execution information for the function block
program and to make settings that affect the program execution.

Figure: Function Block Program properties - Basic tab

Table: Basic Tab
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Component

Description

Compilation valid

Displays True if the function block program
is complete and able to run on the server.

Status

Displays the current function block program
status. Displays Running if the program is
currently running. Displays Unloaded if the
program has never been started. Displays
Halted if the program has been manually
halted.

Number of cycles

Displays the number of executed program
cycles.
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Continued
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Component

Description

Last execution time (ms)

Displays the duration of the last function
block program execution.

Minimum execution time (ms)

Displays the minimum duration of the last
function block program execution cycle.

Maximum execution time (ms)

Displays the maximum duration of the last
function block program execution cycle.

Enabled

Select Yes to run the function block
program on Automation Server.

Task

Enter the task to set the function block
program execution frequency. For more
information, see section 50.23 “Tasks” on
page 1602.

Execution precedence

Enter a number to set the execution priority
for function blocks with internal, cyclic
dependencies. A function block program
with a lower number is executed before a
function block program with a higher
number. For more information, see section
50.25 “Program Cycles in Building
Operation ” on page 1604.
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49.46

Function Block Program Properties –
Inputs Tab
Use the Inputs tab to select whether or not to use the input values for the following
function blocks: BI, II, PI and RI.

Figure: Function Block Program properties - Inputs tab

Table: Inputs Tab

Technical
1554

Component

Description

[Block name]

Select Force value to use the input value of
the function block in the function block
program. If the input has been bound, the
value is overwritten by the following program
execution cycle.
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49.47

Function Block Program Properties –
Public Signals Tab
Use the Public Signals tab set the values of the public signals in the function
block program.

Figure: Function Block Program properties Public Signals tab

Table: Public Signals Tab
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Component

Description

[Public Signal name]

Enter a value for the public signal.
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49.48

Function Block Program Properties –
Outputs Tab
Use the Outputs tab to view the output values for the following function blocks:
BO, IO, PO and RO.

Figure: Function Block Program properties Outputs tab

Table: Outputs Tab
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Component

Description

[Block name]

Select Force value to use the output value
of the function block in the function block
program. If the output has been bound, the
value is overwritten by the following program
execution cycle.
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49.49

Function Block Program Properties –
References Tab
Use the References tab to view and access the references of the function block
program.

Figure: References tab
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50 Script Introduction
50.1 Script Overview

50.1

Script Overview
Script programs are text-based instructions that tell the server to take some kind of
action to control a building.
For example, you can tell the server to take the following actions:
• OPEN THE DAMPER
• CLOSE THE VALVE
Each instruction is a complete text-command description. Program instructions are
listed in the order in which the controller must perform them.

50.1.1

Script Workflow
The Script workflow allows you to create (and edit) Script programs in Building
Operation.
For more information, see section 50.2 “Script Workflow” on page 1561.

50.1.2

Script Programs
You can store your Script programs like a common document and include them
later in other projects for use in your control system. You can also write programs
that perform very complex control system decisions, such as controlling lighting,
boilers, and air handling units at multiple sites.
For more information, see section 50.3 “Script Programs” on page 1565.

50.1.3

Script Functions
A function is a routine designed to carry out an often repeated task or series of
tasks. Your Script function then becomes a subroutine that can be called whenever
that particular action needs to be performed.
For more information, see section 51.96 “Script Functions” on page 1761.

50.1.4

Script Program Components
Script programs are composed of the following components that allow you to
develop your programs quickly and easily:
• Program constants
• Program operators
• Program statements
• Expressions
• Variables
For example, you can create program statements with everyday language, so you
do not need to be a programmer to learn how to program with Script.
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For more information, see section 51.1 “Script Program Components” on page
1619.

50.1.5

Script Editor Overview
The Script Editor is a text programming tool you use to create Script programs that
control and monitor building automation systems. Script Editor opens when you
create or edit a Script program in WorkStation.
When you open a new program in the Script Editor, you begin by declaring local
variables for the program input and output followed by names for those variables.
The program starts with zero or more of these declarations followed by one or more
lines specifying the operation(s) to perform.
For more information, see section 52.1 “Script Editor Overview” on page 1853.

50.1.6

Script Web Services
Web Services are programmable applications accessible from standard Internet
protocols, like HTTP and XML. Web Services help solve application integration
challenges by allowing applications to communicate with one another independent
of the target, host operating system, object model, or programming language.
For more information, see section 53.1 “Script Web Services” on page 1917.
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50.2

Script Workflow
The Script workflow allows you to create (and edit) Script programs in Building
Operation.
The following flowchart describes the basic steps required to create (or edit) a
Script program. Related information can be found in the sections after the
flowchart. If you want to edit an existing Script program, select the program in the
Automation Server and then continue from the second step.
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Figure: Script Workflow

Create a Script program
In WorkStation, create a Script program under an Automation Server.
Technical
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For more information, see section 50.4 “Creating a Script Program” on page 1567.

Open your program in Script Editor
In WorkStation, select and open your program in Script Editor.
For more information, see section 50.5 “Opening a Script Program or Function” on
page 1569.

Declare local variables
In Script Editor, declare local variables for the program inputs and outputs followed
by names for the variables.
For more information, see section 50.16 “Local Variable Declarations” on page
1592.

Create program lines
In your Script program, create program lines to specify the type of actions you want
the program to perform.
For more information, see section 52.9 “Adding a Line” on page 1871.

Create points or values
In WorkStation, create points or values.
For more information, see section 76.10 “Creating a BACnet Point in a Server” on
page 2675.
For more information, see section 76.24 “Creating a BACnet Value” on page 2756.

Bind variables to the points or values
In WorkStation, bind the variables to the points or values you created to view the
output.

Note
In Script, you can bind using either the Bindings view in Building Operation, or the
Bindings view in Script Editor. For more information, see section 38.10 “Binding
Values Using a Binding Template” on page 1220.

Check and save your program
In Script Editor, check your program for errors and then save the program.
For more information, see section 52.15 “Checking and Saving a Script Program”
on page 1878.

Select the task
In WorkStation, select the task in which you wish to include your Script program.
For more information, see section 50.24 “Adding a Task to a Program” on page
1603.

Execute your Script program
In WorkStation, execute your Script program.
For more information, see section 52.16 “Executing a Script Program” on page
1879.
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Store and reuse your programs
In WorkStation, store your programs like a common document and import them
later for reuse in other projects.
For more information, see section 52.17 “Importing Script Program Code” on page
1881.
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50.3

Script Programs
A Script program consists of a set of instructions or statements that direct the
server to perform one or more operations. Program statements are written with
Script words, known as keywords.

50.3.1

Script Keywords
Script keywords are arranged in a predefined structure with their own syntax.
According to the rules of that syntax, certain parameters and values are allowed or
not allowed to follow a keyword.
For more information, see section 50.6 “Script Keywords” on page 1570.

50.3.2

Script Program Instructions
The Script programming language consists of a set of instructions that tells the
server what to do. Each instruction is a complete text-command description that
tells the Automation Server to take some type of specific action to control a
building. Program instructions are listed in the order in which the controller must
perform them.
For more information, see section 50.10 “Script Program Instructions” on page
1581.

50.3.3

Script Program Flow
Script programs tell a server to perform numerous actions, such as increasing the
heat, locking doors, and printing reports. The program instructions that command
these actions are arranged and executed in a certain order, known as a program
flow.
For more information, see section 50.7 “Script Program Flow” on page 1577.

50.3.4

Tasks
Function block and Script programs must be connected to tasks in order to run.
You access Tasks from the Properties dialog box.
The task is a property of the object that defines the program cycles.
When you create a new function block or Script program, Task 3 is the default. This
means that one program cycle executes in 1000 ms.
For more information, see section 50.23 “Tasks” on page 1602.
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50.3.5

Program Cycles in Building Operation
All programs are executed in the order they are bound in Building Operation. For
example, in programs that are executed in a straight order or in any similar
configuration, Program 4 runs after Program 3 that runs after Program 2 that runs
after Program 1. The first program to be executed is Program 1.
For more information, see section 50.25 “Program Cycles in Building Operation ” on
page 1604.

50.3.6

Bindings and Script Programs
A binding is an association between a local variable (numeric, string, datetime,
function) within a Script program and a property of an object in the system. The use
of bindings increases the flexibility of the building automation system.
For more information, see section 50.14 “Bindings and Script Programs” on page
1589.
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50.4

Creating a Script Program
You create a Script program to import existing program code or to program new
logic for an Automation Server using Script Editor.
For more information, see section 50.3 “Script Programs” on page 1565.

To create a Script program
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the script program.
2. On the File menu, point to New and then click Program.
3. In the object type list, select Script Program.

4. In the Name box, type a name for the script program.
Continued on next page
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5. In the Description box, type a description for the script program.

6. Click Create.
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50.5

Opening a Script Program or Function
You open a Script program or function in Script Editor to enter program
instructions.
For more information, see section 50.3 “Script Programs” on page 1565.

To open a Script program or function
1. In WorkStation, in the System Tree pane, select the Script program or
function.
2. On the Actions menu, click Edit.
The Script program or function is now open and ready for input.
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50.6

Script Keywords
Script keywords are arranged in a predefined structure with their own syntax.
According to the rules of that syntax, certain parameters and values are allowed or
not allowed to follow a keyword.

50.6.1

A-D
This table contains keywords that begin with the lettters A - D.
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A

B

C

ABS

BASEDON...GOTO CEILING

D
DATE

For more information, For more information,
see section 51.117
see section 51.48
“ABS” on page 1790. “BASEDON...GOTO”
on page 1697.

For more information,
see section 51.132
“CEILING” on page
1810.

For more information,
see section 51.81
“DATE” on page
1744.

ACOS

BITAND

CHR

DATETIME

For more information,
see section 51.157
“ACOS” on page
1844.

For more information,
see section 51.16
“BITAND” on page
1646.

For more information,
see section 51.145
“CHR” on page
1830.

For more information,
see section 51.41
“DATETIME” on page
1683.

AND

BITNOT

CONTINUE

DAYOFMONTH

For more information,
see section 51.21
“AND” on page
1651.

For more information,
see section 51.17
“BITNOT” on page
1647.

For more information,
see section 51.50
“CONTINUE” on
page 1700.

For more information,
see section 51.82
“DAYOFMONTH” on
page 1745.

ARG

BITOR

COS

DAYOFYEAR

For more information,
see section 51.40
“ARG” on page
1682.

For more information,
see section 51.18
“BITOR” on page
1648.

For more information,
see section 51.161
“COS” on page
1848.

For more information,
see section 51.83
“DAYOFYEAR” on
page 1746.

ASC

BITXOR

DIFFTIME

For more information, For more information,
see section 51.144
see section 51.19
“ASC” on page 1829. “BITXOR” on page
1649.

For more information,
see section 51.154
“DIFFTIME” on page
1840.

ASIN

BREAK

DIVIDED BY

For more information,
see section 51.158
“ASIN” on page
1845.

For more information,
see section 51.49
“BREAK” on page
1699.

For more information,
see section 51.27
“DIVIDED BY” on
page 1661.

ATAN

Buffered

For more information,
see section 51.159
“ATAN” on page
1846.

For more information,
see section 51.63
“Buffered ” on page
1722.
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A

B

C

D

ATAN2
For more information,
see section 51.160
“ATAN2” on page
1847.
AVERAGE
For more information,
see section 51.137
“AVERAGE” on page
1815.

50.6.2

E-H
This table contains keywords that begin with the letters E - H.
E

F

G

H

EQUALS

FACTORIAL

GETNAME

HOD

For more information,
see section 51.22
“EQUALS” on page
1653.

For more information,
see section 51.119
“FACTORIAL” on
page 1792.

For more information,
see section 51.126
“GETNAME” on page
1800.

For more information,
see section 51.84
“HOD” on page
1747.

ERRORS

FAILURE

GetBufferSize

HOUR

For more information,
see section 51.93
“ERRORS” on page
1758.

For more information,
see section 51.8
“Failure” on page
1630.

For more information,
see section 51.110
“GetBufferSize” on
page 1780.

For more information,
see section 51.85
“HOUR” on page
1748.

EXPONENTIAL

FLOOR

GetBufferedValue

For more information,
see section 51.118
“EXPONENTIAL” on
page 1791.

For more information,
see section 51.133
“FLOOR” on page
1811.

For more information,
see section 51.111
“GetBufferedValue”
on page 1782.

FOR...NEXT

GOTO

For more information,
see section 51.51
“FOR...NEXT” on
page 1701.

For more information,
see section 51.52
“GOTO” on page
1704.

FREEMEM
For more information,
see section 51.94
“FREEMEM” on page
1759.
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Continued
E

50.6.3

F

G

H

I-N
This table contains keywords that begin with the letters I -N.
I

L

M

N

IF...THEN...ELSE

LEFT

MAXIMUM

NOT

For more information,
see section 51.53
“IF...THEN...ELSE”
on page 1707.

For more information,
see section 51.146
“LEFT” on page
1831.

For more information, For more information,
see section 51.138
see section 51.24
“MAXIMUM” on page “NOT” on page 1657.
1817.

INPUT

LENGTH

MAXITEM

NUMERIC

For more information,
see section 51.62
“INPUT” on page
1721.

For more information,
see section 51.147
“LENGTH” on page
1832.

For more information,
see section 51.139
“MAXITEM” on page
1819.

For more information,
see section 51.43
“NUMERIC” on page
1689.

IS...

LINE

MID

NUMTOSTR

For more information,
see section 51.23
“IS...” on page 1654.

For more information, For more information,
see section 51.148
see section 51.113
“MID” on page 1833. “NUMTOSTR” on
page 1784.
LN

MINIMUM

For more information, For more information,
see section 51.120
see section 51.140
“LN” on page 1793. “MINIMUM” on page
1821.
LOG

MINITEM

For more information,
see section 51.121
“LOG” on page
1794.

For more information,
see section 51.141
“MINITEM” on page
1823.
MINUS
For more information,
see section 51.28
“MINUS” on page
1662.
MINUTE
For more information,
see section 51.86
“MINUTE” on page
1749.

Technical
1574

04-16006-04-en, March 2015

50 Script Introduction
50.6 Script Keywords

Continued
I

L

M

N

MOD
For more information,
see section 51.29
“MOD” on page
1663.
MONTH
For more information,
see section 51.87
“MONTH” on page
1750.
MOVE
For more information,
see section 51.54
“MOVE” on page
1711.

50.6.4

O-S
This table contains keywords that begin with the letters O - S.
O

P

R

S

OFF

P

RANDOM

SCAN

For more information, For more information, For more information,
see section 51.9
see section 51.35 “P” see section 51.122
“OFF” on page 1631. on page 1670.
“RANDOM” on page
1795.

For more information,
see section 51.95
“SCAN” on page
1760.

ON

ReadProperty

SELECT CASE

For more information, For more information,
see section 51.10
see section 51.130
“ON” on page 1632. “PASSED Function”
on page 1808.

For more information,
see section 51.127
“ReadProperty” on
page 1804.

For more information,
see section 51.57
“SELECT CASE” on
page 1715.

-ON

Relinquish

SECOND

For more information, For more information,
see section 51.11 “- see section 51.30
ON” on page 1633.
“PLUS” on page
1664.

For more information,
see section 51.128
“Relinquish” on page
1805.

For more information,
see section 51.88
“SECOND” on page
1752.

OR

Repeat...Until

SEARCH

PASSED

PLUS

PRINT

For more information, For more information,
see section 51.25
see section 51.36
“OR” on page 1658. “PRINT” on page
1671.
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O

P

R

S

OUTPUT

PUBLIC

RETURN

SET

For more information,
see section 51.64
“OUTPUT” on page
1723.

For more information,
see section 51.65
“PUBLIC” on page
1724.

For more information, For more information,
see section 51.56
see section 51.37
“RETURN” on page
“SET” on page 1677.
1713.
RIGHT

SIN

For more information, For more information,
see section 51.149
see section 51.162
“RIGHT” on page
“SIN” on page 1849.
1834.
ROUND

StandardDeviatio
n

For more information,
see section 51.134
For more information,
“ROUND” on page
see section 51.142
1812.
“StandardDeviation”
on page 1825.
STOP
For more information,
see section 51.58
“STOP” on page
1717.
STRING
For more information,
see section 51.44
“STRING” on page
1691.
STRINGFILL
For more information,
see section 51.151
“STRINGFILL” on
page 1836.
STRTODATE
For more information,
see section 51.114
“STRTODATE” on
page 1785.
STRTONUM
For more information,
see section 51.115
“STRTONUM” on
page 1787.
SQRT
For more information,
see section 51.123
“SQRT” on page
1796.
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Continued
O

P

R

S
SUM
For more information,
see section 51.124
“SUM” on page
1797.

50.6.5

T-Y
This table contains keywords that begin with the letters T - Y.
T

W

Y

TAB

WAIT

YEAR

For more information, see
section 51.152 “TAB” on
page 1838.

For more information, see
section 51.59 “WAIT” on
page 1718.

For more information, see
section 51.91 “YEAR” on
page 1756.

TAN

WebService

For more information, see
section 51.163 “TAN” on
page 1850.

For more information, see
section 51.46 “ Webservice”
on page 1694.

TIMEPIECE

WEEKDAY

For more information, see
For more information, see
section 51.155 “TIMEPIECE” section 51.90 “WEEKDAY”
on page 1842.
on page 1754.
TOD

WHILE

For more information, see
section 51.89 “TOD” on
page 1753.

For more information, see
section 51.60 “WHILE” on
page 1719.

TD

WriteProperty

For more information, see
section 51.78 “TD” on page
1739.

For more information, see
section 51.129
“WriteProperty” on page
1806.

TH
For more information, see
section 51.77 “TH” on page
1738.
THE
For more information, see
section 51.45 “THE” on page
1693.
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Continued
T

W

Y

TIMES
For more information, see
section 51.31 “TIMES” on
page 1665.
TM
For more information, see
section 51.76 “TM” on page
1737.
TS
For more information, see
section 51.75 “TS” on page
1736.
TURN
For more information, see
section 51.38 “TURN” on
page 1679.
TRUNCATE
For more information, see
section 51.135 “TRUNCATE”
on page 1813.
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50.7

Script Program Flow
Script programs tell a server to perform numerous actions, such as increasing the
heat, locking doors, and printing reports. The program instructions that command
these actions are arranged and executed in a certain order, known as a program
flow.
Script has two types of program flows: FallThru and Looping.

50.7.1

FallThru Program Flow
A FallThru program executes the program lines in the sequential order in which you
list them: from the first line to the last line. Therefore, the program flows, or “falls
thru” the entire sequence of instructions.
For more information, see section 50.8 “FallThru Program Flow” on page 1578..

50.7.2

Looping Program Flow
A Looping program remains on one line until the program is instructed to go to
another line.
For more information, see section 50.9 “Looping Program Flow” on page 1580.
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50.8

FallThru Program Flow
A FallThru program executes the program lines in the sequential order in which you
list them: from the first line to the last line. Therefore, the program flows, or “falls
thru” the entire sequence of instructions.
In the following FallThru program example, when the controller determines that the
temperature is not less than 70 and not greater than 75, the program flows to the
next consecutive line (labeled “Pumping”).

Figure: Script FallThru Program Example

FallThru programs start when prompted by a specific point or system variable. Any
point or system variable can automatically start a progam when its value changes.
The program is triggered by the action of the point or system variable. Once you
create a point or choose a system variable, the program you want to run is attached
through the trigger.
For example, suppose you write a program to control a circulating fan. You want
the fan to turn on when the room is occupied and turn off when the room is not
occupied. In your program, you could choose to use a point called OCCUPIED that
triggers the following program.

Figure: FallThru Program Trigger
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You configure the trigger for the OCCUPIED point on the b3 field controller. Note
that you can only configure triggers on the b3 device. For more information, see
section 83.10 “Configuring Script FallThru Program Triggers in a b3 BACnet
Device” on page 3285..
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50.9

Looping Program Flow
A Looping program remains on one line until the program is instructed to go to
another line.
In the following Looping program example, the program continuously scans the
CheckOccupied line to determine if the office is occupied. If so, the program turns
on the office lights and fan. If not, the program turns them off.

Figure: Looping Program Example
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50.10

Script Program Instructions
The Script programming language consists of a set of instructions that tells the
server what to do. Each instruction is a complete text-command description that
tells the Automation Server to take some type of specific action to control a
building. Program instructions are listed in the order in which the controller must
perform them.
Script has two types of program instructions: conditional and unconditional. A
conditional instruction establishes criteria that have to be met before the instruction
can be executed and the task performed by a server:
IF Temp is 78 THEN Turn on Fan
An unconditional instruction directs a specific action without establishing any criteria
before the action can occur:
Turn on Fan
You can use “the” in a Script program instruction to make the statement easier to
read. The following examples show how “the” improves the readability of a
statement:
IF FAN IS ON THEN TURN ON PUMP
IF THE FAN IS ON THEN TURN ON THE PUMP

50.10.1

Lines and Line Numbers
A line acts as the basic execution unit of a Script program. Lines consist of one or
more statements that belong together under one label. The first or only line of a
program does not need to have a label. You can also add a comment here
preceded by a single quote ('), to help explain the operation of the program.
Comments are not acted upon by the program's logic.
For example, you can create a simple program that contains a single declaration
followed by a single program line:
Numeric i ‘Declaration of a local variable of type Numeric
i = 1 ‘Single program line
You can add a label to the line:
Numeric i
Line Setting
i=1
In this example, the line is labeled with the Line keyword or a colon after the line
name (but not both). All of the statements following the “Setting” label are then part
of that line until another Line label is encountered.
For more information, see section 50.11 “Lines and Line Numbers” on page 1583.

50.10.2

Verb and Verb Elements
To construct a Script program instruction, you must follow these guidelines:
• Use only one verb
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• Use one verb element or a list of verb elements after the verb
For example, these Script program instructions are valid:
OPEN THE DAMPER
CLOSE THE VALVE
Open the damper, vent1, vent2, vent3, and vent4
Close the firstvalve, secondvalve, thirdvalve
You cannot use two verbs, such as open and close, in the same instruction.
Therefore, this instruction is invalid:
OPEN THE DAMPER AND CLOSE THE VALVE

50.10.3

Case Sensitivity
Script instructions are not case sensitive. For example, the uppercase letter R and
the lowercase letter r are not treated differently. In Script, the following names are
treated the same:
RoomTemp1
ROOMTEMP1
RoomtemP1

50.10.4

Reserved Words
Reserved words are those words used as system constants, keywords, system
functions, and system variables that are reserved as part of the Script programming
language. Being familiar with these words helps avoid naming errors. You cannot
use reserved words as line label or program variables.
Before importing older programs to your controllers, check the program for
reserved words and remove or replace them. For more information, see section
50.12 “Reserved Words” on page 1584.
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50.11

Lines and Line Numbers
A line acts as the basic execution unit of a Script program. Lines consist of one or
more statements that belong together under one label. The first or only line of a
program does not need to have a label. You can also add a comment here
preceded by a single quote ('), to help explain the operation of the program.
Comments are not acted upon by the program's logic.
You label a line with the LINE keyword or a colon after the line name:

Figure: Line Labeling

In the previous example, all of the statements following the “BEGIN” label are part of
that line, until another LINE label is encountered. Line labels are limited to 16
characters, including underscores, periods, and numbers.
Statements in a line are indented to emphasize their relationship to the line label.
Ideally, you should always form lines this way.
You can number the lines in your program window in Script for easy reference while
programming. When you enable this feature, line numbers display in the left hand
side of the Script Editor.

Figure: Line Numbering
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50.12

Reserved Words
Reserved words are those words used as system constants, keywords, system
functions, and system variables that are reserved as part of the Script programming
language. Being familiar with these words helps avoid naming errors. You cannot
use reserved words as line label or program variables.
Before importing older programs to your controllers, check the program for
reserved words and remove or replace them.

50.12.1

Script Constants
Script constants, including class names, are listed in alphabetical order in the
following tables. You cannot use Script constants as a line label or program
variable.
For more information, see section 51.6 “Script Constants” on page 1627.

50.12.2

Script Reserved Words
Script reserved words are listed in alphabetical order in the following tables. You
cannot use reserved words as a line label or program variable.
For more information, see section 50.13 “Script Reserved Words” on page 1585.
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50.13

Script Reserved Words
Script reserved words are listed in alphabetical order in the following tables. You
cannot use reserved words as a line label or program variable.
Table: Reserved Words A-H
A

B

C

D

E

F

G

Above

Basedon

C

Date

E

Fact

GetName Hod

Abs

Below

Case

DateTime Either

Factorial

GetObjec Hour
t

AccessLo Between
g

CD

DayOfMo Else
nth
DayOfYe
ar

First

Go

HourOfD
ay

AccessS
erver

Ceiling

Del

En

Floor

GoTo

Hr

AckAlarm Bitnot

Change

DiffTime

Enable

For

Greater

Acos

Bitor

Chr

Dis

Encrypt

From

Adjust

Bitxor

Cos

Disable

Encrypte
d

All

Break

Cosine

Div

End

Am

Breakpoi
nt

Curvefit

Divided

EndIf

And

By

Does

EndSelec
t

Append

Dom

EndWhen

Arcsine

Doy

EndWhile

Arctange
nt

Dt

Equal

Bitand

Arctange
nt2

Equals

Arg

Erase

Asc

Errors
Execute

Asin

Exists

Ask

Exp

Atan

Exponenti
al

H

Atan2
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Continued
A

B

C

D

E

F

G

H

Average
Averaged
Avg

Table: Reserved Words I-S
I

L

M

N

O

P

R

S

If

Last

Max

Neither

Object

P

Random

Sc

In

Left

Maximum Next

Open

Param

Return

Scan

Is

Len

Maxitem

Not

Or

Passed

Right

Sd

Length

Message
Window

Number

Output

Pid

Rnd

Search

Less

Mid

Numeric

Plus

Run

Sec
Second

Let

Min

NumToSt
r

Pm

Select

Ln

Minimum

Pr Print

Set

Log

Minitem

Shut

Lookup

Minus

Sin

Minute

Sine

Mod

Site

Modify

Sqrt

Month

Standard
Deviation

Move

Start

Mth

Status

Mult

StatusLin
e

Multiplied

Step
Stop
String
Stringfill
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Continued
I

L

M

N

O

P

R

S
StrToDat
e
StrToNu
m
StrToTim
e
Sum

Table: Reserved Words T-Z
T

U

V

W

Tab

Unadvise

Val

Weekday

Tan

UniquePIN

Version

When

Tangent

Until

Where

Td

Update

While

Th

UpdateAlarms

With

Than

UpdateEvents

WriteProperty

The

UpdateExitLog

Then
Through
Thru
Time
TimeOfDay
Timepiece
Times
TmTo
Tod
Touchedcell
Trace
Trunc
Truncate
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Continued
T

U

V

W

Ts
Turn
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50.14

Bindings and Script Programs
A binding is an association between a local variable (numeric, string, datetime,
function) within a Script program and a property of an object in the system. The use
of bindings increases the flexibility of the building automation system. You can write
a program for one application, and use that program for a similar application by just
changing the bindings instead of changing all of the local variable names in the
program to suit the new program.

50.14.1

Local Variable Declarations
In Script, you declare local variables using either the Input, Output, or Public binding
keyword. Then, you bind those variables to the object properties. For example, you
can bind to the value of a point, or have a program's output bound to an input of
another program.

Note
With bindings, you are not limited solely to the properties of points and programs.
You can also use other object types.
For more information, see section 50.16 “Local Variable Declarations” on page
1592.

50.14.2

Binding Attributes
A binding is an association between a local variable (numeric, string, datetime, or
function) within a Script program and a property of an object in the system. In
Script, you declare local variables using either the Input, Output, or Public binding
keyword. Then, you bind those variables to the object properties (the values of the
points in the system).
For more information, see section 50.17 “Binding Attributes” on page 1596.
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50.15

Binding Values in Script Editor Using a
Binding Template
You use binding templates to reduce engineering time when creating bindings for
variables and functions within a Script program. Binding templates are defined and
created for binding patterns that are frequently reused. You can access the
Bindings view without leaving Script Editor.
For more information, see section 16.1 “Binding Templates” on page 449.

To bind values in Script Editor using a binding template
1. In Script Editor, click Bindings to display the Bindings view for the Script
program.
2. In the binding point browser, drag the object or folder to the binding template
that you want to apply.

Continued on next page
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3. Select the bindings that you want to create.

4. Click OK.
5. Verify that all bindings are correctly bound.

6. On the toolbar, click Save.
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50.16

Local Variable Declarations
In Script, you declare local variables using either the Input, Output, or Public binding
keyword. Then, you bind those variables to the object properties. For example, you
can bind to the value of a point, or have a program's output bound to an input of
another program.

Note
With bindings, you are not limited solely to the properties of points and programs.
You can also use other object types.
During execution, when the program gets the value of an Input variable, the
program gets the value of the object property (the value of a point). When the
program sets the value of an Output variable, the program sets the value of the
object property (the value of a point).
You can use a binding with the following:
• Input variables
• Output variables
• Public variables
• User-Defined Functions
Any hardware or software input, output device like a fan, motion sensor, or a Script
function is represented as an object in Building Operation. When you create a local
variable in Script, that variable is generic and can potentially be associated with the
object property and the local variable that property is bound to. The object property
and the local variable must have similar types. For example, you bind a numeric
local variable to an integer, float, digital, and enumeration instead of a string or
datetime.

An example of a binding with a Script Program
To access the values of points in the system through bindings, a Script program
must include Input, Output, Public, or Function local variables. The following figure
shows the Bindings view for a Script program.
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Figure: Bindings View for a Script Program

Tip
Corresponding properties tabs are displayed, one for each binding type. These
tabs list each of the local variables that can be bound to other objects in the
system.
In Script, you can bind using either the Bindings view in Building Operation, or the
Bindings view in the Script Editor. For more information, see section 38.10 “Binding
Values Using a Binding Template” on page 1220.
Using the Bindings view in Script Editor, you can slide the view, overlay your Script
program, bind the necessary objects, retract the view, and then resume
programming without leaving the Script Editor.
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Figure: Bindings View - Slider View

You can also undock the Bindings view in Script Editor and include it as a tab
wherever you want in the Editor window. For example, you can position it at the
bottom of the window as shown in the following graphic.
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Figure: Bindings View - Tabbed View

Public Binding Qualifier
Public is a binding qualifier that identifies a variable as a public variable. You can
modify a public variable from outside a Script program, such as from a graphic.
Public behaves like an output variable, so you may bind the public variable to the
value of a point, or to the input variable of a Script program as you would with any
output variable. Unlike an output variable, you do not have to use the force
capability to modify Public from the Script property grid, or from a graphic.
You should use the Public binding qualifier when you need to directly modify that
variable from the Script property grid (that is, modify the value the Public binding
variable is bound to). Unlike an output variable, you can manually change the value
of the public variable from a graphic.
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50.17

Binding Attributes
In Script, you declare local variables using either the Input, Output, or Public binding
keyword. Then, you bind those variables to the object properties (the values of the
points in the system).
You can set and read four binding attributes in a Script program: Forced, Invalid,
Offline, and Overridden. To access these binding attributes, use the . (dot) syntax in
the Script Editor. For more information, see section 50.22 “Accessing a Binding
Attribute” on page 1601.

Tip
The Script Editor provides Intellisense for the binding attributes. Intellisense is an
auto-completion tool that you use to fill in predictive text based on the possible
matches to the text you type. For more information, see section 52.10 “Script
Auto-Completion” on page 1872.

50.17.1

Forced
You use the Forced binding attribute to force a point to its most recent value. You
can only force an output.
For more information, see section 50.18 “Forced” on page 1597.

50.17.2

Invalid
You use the Invalid binding attribute to determine if there is an error with the bound
point. Invalid works for any input and output point.
For more information, see section 50.19 “Invalid” on page 1598.

50.17.3

Offline
You use the Offline binding attribute to determine if the point is offline. If the point is
offline, it displays true.
For more information, see section 50.20 “Offline” on page 1599.

50.17.4

Overridden
You use the Overridden binding attribute to determine if the point has been
physically overridden. Overridden is valid for output bindings only.
For more information, see section 50.21 “Overridden” on page 1600.
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Forced
You use the Forced binding attribute to force a point to its most recent value. You
can only force an output.
Forcing a value prevents the output point from receiving values from the Script
program. As a result, the last value stays in the output even if you attempt to
change it within the program.

Syntax
BINDING_NAME.Forced = true
BINDING_NAME.Forced = false
Table: Forced Parameters
Parameter

Description

true

Sets the point to the most recent value.

false

Turns off the force operation.

Examples
This example forces output1 to its most recent value.
output1.Forced = true
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50.19

Invalid
You use the Invalid binding attribute to determine if there is an error with the bound
point. Invalid works for any input and output point.

Syntax
BINDING_NAME.Invalid = true
BINDING_NAME.Invalid = false
Table: Invalid Parameters
Parameter

Description

true

Specifies there is an error with the bound
point.

false

Specifies there is no error with the bound
point.

Examples
This example checks the bound point for errors.
If output1.Invalid = true then...
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50.20

Offline
You use the Offline binding attribute to determine if the point is offline. If the point is
offline, it displays true.

Syntax
BINDING_NAME.Offline = true
BINDING_NAME.Offline = false
Table: Offline Parameters
Parameter

Description

true

Specifies that the point is offline.

false

Specifies that the point is online.

Note
If a Script program sets the Offline status and later checks it, the status will be
unchanged from when it was last set by the program. It will not show the actual
property value from the source.

Examples
This example determines if the bound point is offline.
If output1.Offline = true then...
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50.21

Overridden
You use the Overridden binding attribute to determine if the point has been
physically overridden. Overridden is valid for output bindings only.

Syntax
BINDING_NAME.Overridden = true
BINDING_NAME.Overridden = false
Table: Overridden Parameters
Parameter

Description

true

Specifies that the output is physically
overridden.

false

Specifies that the output is not physically
overridden.

Examples
This example determines if the point has been physically overridden.
If output1.Overridden = true then...
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50.22

Accessing a Binding Attribute
You set and read binding attributes within a Script program or function.
For more information, see section 50.17 “Binding Attributes” on page 1596.

To access a binding attribute
1. Open the Script Editor.
2. Aaccess the binding attributes using the . (dot) syntax.
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50.23

Tasks
Function block and Script programs must be connected to tasks in order to run.
You access Tasks from the Properties dialog box.
The task is a property of the object that defines the program cycles.
When you create a new function block or Script program, Task 3 is the default. This
means that one program cycle executes in 1000 ms.

Figure: Tasks

The way you schedule programs to execute in Script differs from how you schedule
them to execute in Continuum. For more information, see the Script and Plain
English Program Differences topic on WebHelp.
Table: Task Intervals
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Task

Interval

Task 1

0.1 seconds

Task 2

0.5 seconds

Task 3

1 seconds

Task 4

5 seconds

Task 5

10 seconds
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50.24

Adding a Task to a Program
To make a Script or Function Block program run, the program must be connected
to a task.
For more information, see section 50.23 “Tasks” on page 1602.

To add a task to a program
1. In WorkStation, in the System Tree pane, select the program you want to
add a task to.
2. On the File menu, click Properties.
3. In the Task box, enter the task you want to add.
4. Click OK.
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50.25

Program Cycles in Building Operation
All programs are executed in the order they are bound in Building Operation. For
example, in programs that are executed in a straight order or in any similar
configuration, Program 4 runs after Program 3 that runs after Program 2 that runs
after Program 1. The first program to be executed is Program 1.
The illustration that follows shows the execution sequence for a straight order
configuration.

Figure: Execution order of programs

When programs are connected in an algebraic loop, the execution order cannot be
determined and the program that runs first needs to be established. In Building
Operation, algebraic loops are called Cycles. In this case, there is no way to
determine the execution order of the programs. Program 4 runs after Program 3
that runs after Program 2 that runs after Program 1 that runs after Program 4.

Figure: In an algebraic loop the execution order of programs cannot easily be determined.

To resolve a cycle and determine which program runs first in the cycle, you use the
execution precedence function. Programs can have execution precedence values
ranging from 0 to 255 where 0 results in the highest priority and 255 results in the
lowest priority. The program with highest execution precedence is always executed
first in the cycle.
Execution Precedence
Values:

Integers ranging from 0 to 255

Highest priority value:

0

Lowest priority value:

255

The execution precedence is configured in the properties for the program. The
default value when you create a new program is 100.
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Figure: Execution precedence

The execution precedence can never override the execution order of programs
based on how they are bound. The execution precedence decides the order in
which the programs are run when they are set up in some form of cycle and the
binding does not give a straight order for which program runs first.
The execution precedence can be used in two different situations:
• To determine the execution order when programs are bound in a cycle.
• As troubleshooting, for example when a there are delays without any known
reason. A long delay might be the result of programs that run in the wrong
order.

50.25.1

Example A
In this example we have four programs that are connected in a cycle. The execution
order cannot be determined from how programs are bound. Program 1 should run
before Program 2, Program 2 before Program 3, and Program 4 before Program 1.
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Figure: Example

However, Program 2 reads from a physical input, Input A, and the information from
this reading is transferred to Program 4, which writes to a physical output, Output
B.

Figure: Example

So, we want to Program 2 to run before Program 4. To do this we use execution
precedence. By configuring the Execution precedence as 99 for Program 2,
Program 2 will be the first program to be executed in the cycle.

Figure: Example

The resulting execution order will be P2, P3, P4 and P1.
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50.25.2

Example B
All programs use the default execution precedence that is 100. In this example, it is
not possible to determine the execution order of Program 1 and Program 2 and the
execution order of Program 3 and Program 4. The only thing we can be sure of is
that the cycle with Program 1 and Program 2 is executed before the cycle with
Program 3 and Program 4 due to the fact that Program 3 awaits input from
Program 2.

Figure: Example

To resolve the order we configure Program 2 and Program 3 to have the execution
precedence of 99. Then Program 2 runs before Program 1 in the first cycle and
Program 3 before Program 4 in the second cycle.

Figure: Example

Now the execution order is Program 2, Program 3, Program 4 and Program 1.

50.25.3

Application Scheduler
The Application Scheduler displays the programs execution order and if you have
any cycles in your system. In the System Tree pane, the Application Scheduler is
displayed in the Modules folder. The programs are represented with an entry under
the task they are assigned to.
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Figure: Application scheduler

The object called cycle identifies a cycle. In the properties dialog for the task the
property "Conflict" is set to "True" if there is any cycle in the Task. Conflicts do not
mean that the programs will not run at all. The programs will run but the might run in
an execution order that may cause unnecessary delays from input to output.
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Figure: Conflict setting in task 3

Use the List View to see the execution order of the programs.

Figure: Entries in the List View

Entry is the order of execution of the programs for a specific task. In this case
Program 2 executes first followed by Program 4. Program 3 runs last.
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50.26

Configuring the Execution Precedence
for a Program
You configure the highest execution precedence number on the program you want
to be executed first in a cycle.
For more information, see section 50.25 “Program Cycles in Building Operation ” on
page 1604.

To configure the execution precedence for a program
1. In WorkStation, in the System tree pane, select the program.
2. On the File menu, click Properties.
3. In the Execution precedence box, enter a number that is higher than all the
other programs in the cycle.

4. Click OK.
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50.27

Finding Cycles in a Task
If you encounter unexpected delays in input to output response, the execution
order of the programs in a Task might not optimized.
For more information, see section 50.25 “Program Cycles in Building Operation ” on
page 1604.

To find cycles in a task
1. In WorkStation, in the System Tree pane, in the System folder, open the
Modules, and then ApplicationScheduler foldes.
2. Open a Task.
3. If the Task contains an object called Cycle, a cycle is present.
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51.1

Script Program Components
Script programs are composed of the following components that allow you to
develop your programs quickly and easily:
• Program constants
• Program operators
• Program statements
• Expressions
• Variables
For example, you can create program statements with everyday language, so you
do not need to be a programmer to learn how to program with Script.

51.1.1

Program Constants
Constants are numbers, words, or dates that do not change.
For more information, see section 51.2 “Program Constants” on page 1621.

51.1.2

Program Operators
An operator is the part of an expression that causes a mathematical operation to
occur, such as addition, or tests a condition, such as equality.
For more information, see section 51.13 “Program Operators” on page 1635.

51.1.3

Program Statements
Program statements are written with Script words, known as keywords, that are
arranged in a predefined structure. Each keyword has its own keyword syntax.
According to the rules of that syntax, certain parameters and values are allowed or
not allowed to follow a keyword.
For more information, see section 51.32 “Program Statements” on page 1666.

51.1.4

Expressions
Instructions that consist of mathematical operations are called expressions.
Expressions can also be item names or constants that return a numeric or string
result.
For more information, see section 51.66 “Expressions” on page 1725.

51.1.5

Variables
A variable is a run-time (dynamically changing) property of an object.
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For more information, see section 51.67 “Variables” on page 1726.
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51.2

Program Constants
Constants are numbers, words, or dates that do not change.

51.2.1

Numeric Constants
A numeric constant is a number. In Script, only floating point numbers are used. A
floating point number is a number with a decimal.
For more information, see section 51.3 “Numeric Constants” on page 1622.

51.2.2

String Constants
A string constant is a series of ASCII characters, including blanks, surrounded by
quotation marks ("string").
For more information, see section 51.4 “String Constants” on page 1623.

51.2.3

Script Constants
Script constants, including class names, are listed in alphabetical order in the
following tables. You cannot use Script constants as a line label or program
variable.
For more information, see section 51.6 “Script Constants” on page 1627.

51.2.4

Constant Keywords
Script constant keywords represent numbers or values that are used in
expressions.
For more information, see section 51.7 “Constant Keywords” on page 1629.
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51.3

Numeric Constants
A numeric constant is a number. In Script, only floating point numbers are used. A
floating point number is a number with a decimal.
You can enter a floating point number in one of the following ways:
• Number with up to seven decimal places
• Number in scientific notation
• Positive numbers between 1.40129E-45 and 3.402823E+38
• Negative numbers between -3.402823E+38 and -1.40129E-45
Floating point numbers can display without decimal points, but are still handled by
the system as floating point numbers. The accepted numbers are based on the
Institute of Electrical and Electronics Engineers, IEEE 754 single precision format.
The following numbers are examples of numeric constants:
• 12
• 74.5
• -.543
• 4E+32
Do not use a comma in the number. For example, 1,000 is an invalid numeric
constant.
Script interprets only the following numbers:
• Greater than 3.402823E+38 as infinity.
• Less than -.402823E+38 as negative infinity.
Script accepts all numbers, but interprets only the following numbers:
• Numbers greater than 3.402823E+38 are interpreted as infinity.
• Less than -.402823E+38 as negative infinity.
• Between 1.40129E-45 and -.40129E-45 as zero.
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51.4

String Constants
A string constant is a series of ASCII characters, including blanks, surrounded by
quotation marks ("string").
The following are examples of some acceptable strings:
• "Hello world"
• "Access to the building is restricted"
• "123"

51.4.1

Rules for String Constants
Even though a string contains a number, the number cannot be directly used in
mathematical calculations.
In Script, the vertical bar, |, is the control character in a string. Anything you put after
the vertical bar is interpreted as a code or a format for a variable value. For example,
to print a quote enclosed by quotation marks you would use (“) following the vertical
bar. In the statement that follows:
PRINT "The string |" abc|" is included"
The printer outputs: The string "abc" is included.
More information about the vertical bar in strings is included under the PRINT
keyword.

51.4.2

ASCII Codes
Most keyboards have a limited set of characters. There are no characters to control
such actions as feeding the paper, turning on a beep, scrolling the screen, and so
on. For these actions, you use a set of codes called the American Standard Code
for Information Interchange (ASCII).
For more information, see section 51.5 “ASCII Codes” on page 1624.

04-16006-04-en, March 2015

Technical
1625

51 Script Programming
51.5 ASCII Codes

51.5

ASCII Codes
Most keyboards have a limited set of characters. There are no characters to control
such actions as feeding the paper, turning on a beep, scrolling the screen, and so
on. For these actions, you use a set of codes called the American Standard Code
for Information Interchange (ASCII).
You use these codes in a PRINT statement to control your printer or screen. For
more information, see section 51.36 “PRINT” on page 1671.
The following table lists ASCII codes. Examples follow the table.
Table: ASCII Code

Technical
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Code (in Decimal)

Character or Action

0

NUL

1

SOH

2

STX

3

ETX

4

EOT

5

ENQ

6

ACK

7

Beep

8

Backspace

9

TAB forward

10

Line feed

11

Vertical TAB

12

Form feed

13

Carriage return

14

SO

15

SI

16

DLE

17

DC1

18

DC2

19

DC3

20

DC4

21

NAK
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Continued
Code (in Decimal)

Character or Action

22

SYN

23

ETB

24

CAN

25

EM

26

SUB

27

ESC

28

FS

29

GS

30

RS

31

US

127

DEL

Note
• Script supports characters at or below ASCII 127. Additional characters are
not supported and are replaced by a question mark (?).

Examples
For example, you might use the ASCII code for a character in the STRINGFILL
function. You must give STRINGFILL the code for the character with which you
want to fill the string. For more information, see section 51.151 “STRINGFILL” on
page 1836.
For example, to make the printer beep, you send the beep code a PRINT
statement, like this:
Print "|7" to Printer1
You can also make a terminal beep as follows:
Print "|7" to Screen1
To feed the paper forward one form feed:
Print "|12" to Printer1
To send an ESCAPE to the printer:
Print "|27" to Printer1
More printer control statements can be available for your printer. See the
manufacturer's documentation.
To create a bar in a chart, you might fill a string with asterisks using STRINGFILL
and the ASCII code for asterisk, 42, as follows:
Stringfill (Kilowatts, 42)
You could make a similar bar in a chart using pound signs:
04-16006-04-en, March 2015
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Stringfill (Pressure, 35)

Technical
1628

04-16006-04-en, March 2015

51 Script Programming
51.6 Script Constants

51.6

Script Constants
Script constants, including class names, are listed in alphabetical order in the
following tables. You cannot use Script constants as a line label or program
variable.
Table: Script Constants A-M
A

B

C

D

E

F

J

M

Apr

Binary

Char

Days

Enabled

Failed

Jan

Mar

April

Bit

Character Dec
SetNotSu
pported

January

March

Aug

Bitstring

CharType Decembe EndResto False
r
re

Jul

Minutes

August

Closed

Delete

Fault

July

MissingR
equiredP
arameter

Average

Constant

Digital

Feb

Jun

Mon

Averaged

CurrentV
alue

Disabled

February

June

Monday

EnableDis Failure
able

Equal

Active

Fri

Months

Friday

MonthTo
Date

Function

MonthTo
Now

Table: Script Constants N-Z
N

O

P

R

S

T

Nov

Object

Print

Run

Sat

Thu

November

ObjectClass

Running

Saturday

Thursday

Sep

Today

ObjectID

September

True

ObjectIdentifi
erAlreadyExists

Singular

Tue

ObjectRefere
nce

Site_Config

Tuesday

NoVTSession ObjectDeletio
s-Available
nNotPermitte
d
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Continued
N

O

P

R

S

T

Oct

Site_ConfigB

October

Success

Odd

Sun

Off

Sunday

Offline
On
-On
OneWeekTo
Date
OneWeekTo
Now
OneYearToD
ate
OneYearToN
ow
Online
Opened
Or
Other
OverRange
Overridden
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51.7

Constant Keywords
Script constant keywords represent numbers or values that are used in
expressions.
There are five different Script constant keywords.

51.7.1

Failure
Failure is used in expressions to indicate a function has failed to complete. Failure is
always numeric and equal to one. Failure can be used to replace numbers in a
comparison expression.
For more information, see section 51.8 “Failure” on page 1630.

51.7.2

OFF
OFF is used in expressions to indicate an item is OFF or set to bottom of scale.
OFF is always numeric and thus, can be compared to numeric values of points or
variables in a comparison expression.
For more information, see section 51.9 “OFF” on page 1631.

51.7.3

ON
ON is used in expressions to indicate an item is ON or set top of scale.
ON is always numeric and can be compared to input, output, and numeric points or
variables in a comparison expression.
For more information, see section 51.10 “ON” on page 1632..

51.7.4

-ON
-ON is used in expressions to indicate a tri-state point is set to -ON.
-ON is always numeric and thus, can be compared to numeric values of points or
variables in a comparison expression.
For more information, see section 51.11 “-ON” on page 1633..

51.7.5

Success
Success is used in expressions to indicate a process or function has completed
successfully.
Sucess is always numeric and equal to zero.
For more information, see section 51.12 “Success” on page 1634..
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51.8

Failure
Failure is used in expressions to indicate a function has failed to complete. Failure is
always numeric and equal to one. Failure can be used to replace numbers in a
comparison expression.

Syntax
Failure
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51.9

OFF
OFF is used in expressions to indicate an item is OFF or set to bottom of scale.
OFF is always numeric and thus, can be compared to numeric values of points or
variables in a comparison expression.

Syntax
Off

Examples
Example 1
Program File
Turn the Lobby_Light Off
Example 2
Program File
If the Lobby_Light is Off then Turn Off the Heat
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51.10

ON
ON is used in expressions to indicate an item is ON or set top of scale.
ON is always numeric and can be compared to input, output, and numeric points or
variables in a comparison expression.

Syntax
On

Example
Script Program File - Using ON and OFF
If timeofday is between 9 and 17 then
Set the Fan to ON
Else
Set the Fan to OFF
Endif

Technical
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51.11

-ON
-ON is used in expressions to indicate a tri-state point is set to -ON.
-ON is always numeric and thus, can be compared to numeric values of points or
variables in a comparison expression.

Syntax
-On

Example
Program File
If the Flow is greater than SetPoint then set the Damper to -On
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51.12

Success
Success is used in expressions to indicate a process or function has completed
successfully.
Sucess is always numeric and equal to zero.

Syntax
Success

Examples
Call a user-defined Script function, which returns either Success or Failure.
If MyUpdateFunction (“Zone1”, “Temperature”, TempValue) =
Success then Print "Update Successful"
Else
user1Goto RecordFailure
Endif
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51.13

Program Operators
An operator is the part of an expression that causes a mathematical operation to
occur, such as addition, or tests a condition, such as equality.

51.13.1

Operator Precedence
In Script, operators are acted upon in a certain sequence when more than one
operator occurs in an expression. This is known as operator precedence. The
following table lists the order (top to bottom) that is used when working out an
expression.
Table: Operator Precedence
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Operator

Description

Association

()

Parentheses

Left to Right

[]

Array Element Left to Right

Blank or \

Path Name Connector

Right to Left

+

Plus Sign on Number

Right to Left

-

Minus Sign on Number

NOT

Logical Negation

BITNOT

Bitwise Negation

%

Percentage

^

Exponentiation

Left to Right

*

Multiplication

Left to Right

/

Division

MOD

Modulo

+

Addition

-

Subtraction

<

Less Than

<=

Less Than or Equal

>

Greater Than

>=

Greater Than or Equal

=

Equal

<>

Not Equal

IS IN

Set Inclusion

IS NOT IN

Set Exclusion

IS BETWEEN

Range

IS THRU

Range

Left to Right

Left to Right

Left to Right
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Continued

51.13.2

Operator

Description

Association

BITAND

Bitwise Logical And

Left to Right

BITOR

Bitwise Logical Or

BITXOR

Bitwise Exclusive Or

&

Logical And

!

Logical Or

;

Joining Operator

Left to Right

Left to Right

Plus Sign, Minus Sign, Negation, BITNOT, and
Percentage Operators
The following table identifies and defines the plus sign, minus sign, negation,
BITNOT, and percentage operators.
Table: Plus Sign, Minus Sign, Negation, BITNOT, and Percentage

51.13.3

Operator

Definition

+ number

Shows that a number is positive, but does
not affect the value.

- number

Makes a positive number negative and a
negative number positive. This operator
works only on numeric expressions.

NOT number

Negates the number or expression. If the
value of the expression is nonzero, NOT
changes that expression to 0. If the
expression is TRUE, NOT makes that
expression FALSE.

BITNOT integer

Changes the 1s to 0s and 0s to 1s in the
binary equivalent of the integer, and then
gives you the decimal integer equivalent of
that binary number.

number %

Divides the number by 100 to determine the
percentage.

Fundamental Operators
The following table identifies and defines the fundamental operators.

Technical
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Table: Fundamental Operators
Operator

Example

Definition

Addition

number + number

Adds the numbers. Works on
numbers or datetimes and
the resulting expression is
numeric or datetime.
Alias: PLUS

Subtraction

number - number

Works on numbers or
datetimes and the resulting
expression is numeric or
datetime.
Alias: MINUS

Multiplication

number * number

Multiples the numbers.
Works on numbers and the
resulting expression is
numeric.
Aliases: TIMES, MULT, and
MULTIPLIED BY

Division

number / number

Divides the first number by
the second. Works on
numbers and the resulting
expression is numeric.
Alias: DIVIDED BY

Modulus

number MOD number

Finds the amount left over
when dividing the first
number by the second. For
example, 9 MOD 7 gives 2.
Alias: REMAINDER

Exponentiation

number ^ number

Raises the first number to the
power of the second
number. For example, 2 ^ 3
=8
Alias: EXP

51.13.4

Comparative Operators
A comparative operator compares the number to the left of the keyword with the
number to its right. The results are TRUE (numeric 1) or FALSE (numeric 0) and are
considered numeric.
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Table: Comparative Operators
Operator

Example

Definition

Less Than

number < number

Determines whether the
value of the left number is
less than the value of the
right number.
Aliases: IS LESS THAN
(THAN is optional) and IS
BELOW

Less Than or Equal

number <= number

Determines whether the
value of the left number is
less than or equal to the
value of the right number.
Alias: IS LESS THAN OR
EQUAL TO where THAN and
TO are optional

Greater Than

number > number

Determines whether the
value of the left number is
greater than the value of the
right number.
Alias: IS GREATER THAN
(THAN is optional) and IS
ABOVE

Greater Than or Equal

number >= number

Determines whether the
value of the left number is
greater than or equal to the
value of the right number.
Alias: IS GREATER THAN
OR EQUAL TO, where THAN
and TO are optional

Equal

number = number

Determines whether the
value of the left number is
equal to the value of the right
number.
Aliases: EQUALS, IS EQUAL
TO, and IS EQUAL

Not Equal

number <> number

Determines whether the
value of the left number is not
equal to the value of the right
number.
Aliases: DOES NOT EQUAL,
IS NOT EQUAL TO, and IS
NOT EQUAL
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Operator

Example

Definition

Comparing String Values
You can also use Greater Than, Less Than, or Equal To operators to compare two
string values. The strings are evaluated by ASCII code, using their numerical ASCII
values. For example, "Z" which has an ASCII value of 90 is greater than "A" which
has an ASCII value of 65. Likewise, "9" is greater than "0", and "A" is greater than
"9". Also, "ABC", which is the equivalent to the sum of the ASCII values of each
individual character, is greater than "A". For more information, see section 51.5
“ASCII Codes” on page 1624..

51.13.5

List and Range Operators
The following table identifies and defines list and range operators.
Table: List and Range Operators
Operator

Example

Definition

IS IN

number IS IN list

Determines if the number or
expression on the left is in
the listed set. If the number
on the left-hand side of the
expression is in the list
expression on the right-hand
side, the expression yields
TRUE (numeric 1). If the
expression is not in the list on
the right-hand side, the
expression yields FALSE
(numeric 0).

Or
number IS list

Alias: IS EITHER
IS NOT IN

number is NOT IN list

Determines if the number or
expression on the left is NOT
in the listed set. If the number
on the left-hand side of the
expression is NOT in the list
expression on the right-hand
side, the expression yields
TRUE (numeric 1). If the
expression is in the list on the
right-hand side, the
expression yields FALSE
(numeric 0).
Alias: IS NEITHER
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Continued
Operator

Example

Definition

IS THRU

number IS number THRU
number

Designates a range starting
with the number or
expression on the left-hand
side of THRU and ending
with the number or
expression on the right-hand
side. If the number at
beginning of the expression
is within the inclusive range,
the expression yields TRUE
(numeric 1). If the expression
is not in the inclusive range,
the expression yields FALSE
(numeric 0).
This statement is
operationally equivalent to IS
BETWEEN.

IS BETWEEN

number IS BETWEEN
number AND number

Designates a range starting
with the number or
expression on the left-hand
side of AND and ending with
the number or expression on
the right-hand side. If the
number at the beginning of
the expression is within the
inclusive range, the
expression yields TRUE
(numeric 1). If the expression
is not in the inclusive range,
the expression yields FALSE
(numeric 0).
This statement is
operationally equivalent to IS
THRU.

51.13.6

Bit Operators
The following table identifies and defines the bit operators.
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Table: Bit Operators
Operator

Example

Definition

BITAND

integer BITAND integer

Compares the binary
equivalents of the two
integers, digit by digit, as if
the 1s were TRUE and the 0s
were FALSE.
If both binary numbers
contain a 1 in the same
place, that is TRUE AND
TRUE, which is TRUE If both
numbers contain a 0 in the
same place, that is FALSE
and FALSE, which is FALSE.
If one number contains a 1
and the other a 0 in the same
place, that is TRUE AND
FALSE, which is also FALSE.
Refer to the Truth Tables that
follow for further explanation.

BITOR

integer BITOR integer

Compares the binary
equivalents of the two
integers, digit by digit, as if
the 1s were TRUE and the 0s
FALSE.
If both binary numbers
contain a 1 in the same
place, that is TRUE OR
TRUE, which is TRUE. If both
numbers contain a 0 in the
same place, that is FALSE
OR FALSE, which is FALSE.
If one number contains a 1
and the other a 0 in the same
place, that is TRUE OR
FALSE, which is TRUE.
Refer to the Truth Tables that
follow for further explanation.
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Continued
Operator

Example

Definition

BITXOR

integer BITXOR integer

Compares the binary
equivalents of the two
integers, digit by digit, as if
the 1s were TRUE and the 0s
FALSE. BITXOR finds cases
where one digit or the other
is TRUE, but not cases
where both digits are TRUE.
If both binary numbers
contain a 1 in the same
place, that is TRUE XOR
TRUE, which is FALSE
because only one or the
other can be TRUE, not both.
If both numbers contain a 0
in the same place, that is
FALSE XOR FALSE, which is
FALSE. If one number
contains a 1 and the other a
0 in the same position, that is
TRUE XOR FALSE, which is
TRUE.
Refer to the Truth Tables that
follow for further explanation.

Truth Tables
The following table is the truth table for the bit operators:
Table: Truth Table
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Operator

Integer1

Integer2

Result

BITAND

TRUE

TRUE

TRUE

BITAND

TRUE

FALSE

FALSE

BITAND

FALSE

FALSE

FALSE

BITAND

FALSE

TRUE

FALSE

BITOR

TRUE

TRUE

TRUE

BITOR

TRUE

FALSE

TRUE

BITOR

FALSE

FALSE

FALSE

BITOR

FALSE

TRUE

TRUE

BITXOR

TRUE

TRUE

FALSE

BITXOR

TRUE

FALSE

TRUE

BITXOR

FALSE

FALSE

FALSE

BITXOR

FALSE

TRUE

TRUE
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Operator

51.13.7

Integer1

Integer2

Result

AND/OR and String Joining Operators
The following table identifies and defines the AND, OR, and String Joining
Operators.
Operator

Example

Definition

AND

number & number

Compares two expressions,
which must be numeric or
converted to numeric, in a
comparison. The statement
returns TRUE (numeric 1) if
both expressions are
nonzero.
Alias: AND

OR

number ! number

Determines whether a
comparison is true by
making the comparison to
each expression (which must
be numeric or converted to
numeric) separately,
excluding the others. The
statement returns FALSE
(numeric 0) if both
expressions are false, TRUE
(numeric 1) if at least one is
true.
Alias: OR

String Joining

string ; string

Joins two strings by adding
the second one onto the end
of the first to form a new
string. Both expressions
must be string or convert to
type string (that includes
numeric and datetime types).
Also known as the
concatenation operator.

51.13.8

Operator Keywords
Operators carry out a mathematical process, such as addition, subtraction, or a
logical TRUE/FALSE comparison.
For more information, see section 51.14 “Operator Keywords” on page 1644.
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51.14

Operator Keywords
Operators carry out a mathematical process, such as addition, subtraction, or a
logical TRUE/FALSE comparison.
Script uses three different types of operator keywords: bitwise, logical, and
mathematical operators.

51.14.1

Bitwise Operators
Bitwise operators perform logical operations on the binary equivalents of integers.
Bitwise operators include the following keywords:
• BITAND
• BITNOT
• BITOR
• BITXOR
For more information, see section 51.15 “Bitwise Operators ” on page 1645...

51.14.2

Logical Operators
Logical operators carry out TRUE/FALSE comparisons.
Logical operators include the following keywords:
• AND
• EQUALS
• IS...
• NOT
• OR
For more information, see section 51.20 “Logical Operators ” on page 1650...

51.14.3

Mathematical Operators
Mathematical operators perform mathematical operations, such as addition or
subtraction.
Mathematical operators include the following keywords:
• DIVIDED BY
• MINUS
• MOD
• PLUS
• TIMES
For more information, see section 51.26 “Mathematical Operators” on page 1660...
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51.15

Bitwise Operators
Bitwise operators perform logical operations on the binary equivalents of integers.

51.15.1

BITAND
BITAND logically compares the binary equivalents of the two integers, digit by digit.
This operator creates a new binary number that contains a 1 for each digit position,
where the first number's bit and the second number's bit are both 1, and sets all
other digits to zero. The new binary number is then converted to its decimal
equivalent.
For more information, see section 51.16 “BITAND” on page 1646..

51.15.2

BITNOT
BITNOT switches 1s to 0s and 0s to 1s in the binary equivalent of the integer, digit
by digit. (This is called the one’s complement of the binary number.) This operator
creates a new binary number and then converts that number back to its decimal
equivalent.
For more information, see section 51.17 “BITNOT” on page 1647..

51.15.3

BITOR
BITOR logically compares the binary equivalents of the two integers, digit by digit.
For more information, see section 51.18 “BITOR” on page 1648..

51.15.4

BITXOR
BITXOR logically compares the binary equivalents of the two integers, digit by digit.
For more information, see section 51.19 “BITXOR” on page 1649..
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51.16

BITAND
BITAND logically compares the binary equivalents of the two integers, digit by digit.
This operator creates a new binary number that contains a 1 for each digit position,
where the first number's bit and the second number's bit are both 1, and sets all
other digits to zero. The new binary number is then converted to its decimal
equivalent.
BITAND carries out comparisons of checksums and similar operations.

Syntax
integer bitand integer
Table: BITAND Parameter
Parameter

Description

integer

Any number from 0 to 65535.
If you provide a number with a decimal point,
BITAND uses only the integer and drops
everything to the right of the decimal point.

Example
Suppose you want to compare Total1 and Total2:
Total1 = 13 (binary equivalent is 0000000000001101)
Total2 = 11 (binary equivalent is 0000000000001011)
You would compare them with BITAND as follows:
Program File
Set result = Total1 bitand Total2
The comparison would give 0000000000001001. RESULT would be set to 9.
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51.17

BITNOT
BITNOT switches 1s to 0s and 0s to 1s in the binary equivalent of the integer, digit
by digit. (This is called the one’s complement of the binary number.) This operator
creates a new binary number and then converts that number back to its decimal
equivalent.
BITNOT carries out bitmasking and similar operations.

Syntax
bitnot integer
Table: BITNOT Parameter
Parameter

Description

integer

Any number from 0 to 65535.
If you provide a number with a decimal point,
BITNOT uses only the integer and drops
everything to the right of the decimal point.

Example
Suppose you want to find the one’s complement of AMOUNT:
Amount = 13 (binary equivalent is 0000000000001101)
You could reverse the number with BITNOT as follows:
Program File
Set result = bitnot AMOUNT
The BITNOT of the amount would be 1111111111110010. The statement would
set RESULT to 65522.
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51.18

BITOR
BITOR logically compares the binary equivalents of the two integers, digit by digit.
This operator creates a new binary number that contains a 1 for each digit position
where the first number's bit or the second number's bit is 1 and where both the first
and second number's bits are 1. The operator also sets all other digits to zero.
BITOR converts the new binary number to its decimal equivalent.
BITOR carries out comparisons of checksums and similar operations.

Syntax
integer bitor integer
Table: BITOR Parameter
Parameter

Description

integer

Any number from 0 to 65535.
If you provide a number with a decimal point,
BITOR uses only the integer and drops
everything to the right of the decimal point.

Example
Suppose you want to compare Total1 and Total2:
Total1 = 13 (binary equivalent is 0000000000001101)
Total2 = 11 (binary equivalent is 0000000000001011)
You would compare them with BITOR as follows:
Program File
Set result = Total1 bitor Total2
The comparison would give 0000000000001111. RESULT would be set to 15.
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51.19

BITXOR
BITXOR logically compares the binary equivalents of the two integers, digit by digit.
This operator creates a new binary number that contains a 1 for each digit position,
where either the first number's bit or the second number's bit is 1, but gives zeros
where both are 1 or both are 0. BITXOR converts the new binary number to its
decimal equivalent.
BITXOR carries out comparisons of checksums and similar operations.

Syntax
integer bitxor integer
Table: BITXOR Parameter
Parameter

Description

integer

Any number from 0 to 65535.
If you provide a number with a decimal point,
BITXOR uses only the integer and drops
everything to the right of the decimal point.

Example
Suppose you want to compare Total1 and Total2:
Total1 = 13 (binary equivalent is 0000000000001101)
Total2 = 11 (binary equivalent is 0000000000001011)
Program File
Set result = Total1 bitxor Total2
The comparison would give 0000000000000110. RESULT would be set to 6.
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51.20

Logical Operators
Logical operators carry out TRUE/FALSE comparisons.

51.20.1

AND
The AND keyword can be used in two ways.
For more information, see section 51.21 “AND” on page 1651..

51.20.2

EQUALS
EQUALS is similar to the IS... operator.
For more information, see section 51.23 “IS...” on page 1654.

51.20.3

IS...
IS... carries out the logical test you specify.
For more information, see section 51.23 “IS...” on page 1654.

51.20.4

NOT
NOT logically negates or inverts a number or expression, changing 0 (FALSE to
OFF) to 1 (TRUE or ON) or vice versa.
For more information, see section 51.24 “NOT” on page 1657..

51.20.5

OR
The OR keyword can be used to provide the logical OR between two expressions,
or positioned in a list of names beween the last two items.
For more information, see section 51.25 “OR” on page 1658..
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51.21

AND
Alias: Ampersand (&) is the alias for the logical AND only.
The AND keyword can be used in two ways.
See Syntax for more details.
The controller carries out all other operations (such as adding and subtracting)
before acting on AND or OR. Because AND and OR are acted on last, you can form
logical statements without using too many parentheses. (See Example 3 for using
AND and OR together.)

Syntax
Syntax 1: number and number
Provides the logical AND between two expressions.
Syntax 2: namelist and final_name
When used in a list of names between the last two items, indicates the end of the
series.
Table: AND Parameters
Parameter

Description

number

Any number or expression.

namelist

One or more names with commas between
them.

final_name

A single name at the end of a series of
names.
AND before the last name is optional.

Examples
Example 1
Instead of forming IF..THEN statements to turn the heat on when multiple
conditions exist, you can make one statement using AND:
Program File
If Temp < 70 and TOD > 7:00am then turn On the Heat
or
If Temp < 70 & TOD > 7:00am then turn On the Heat
Example 2
To run a series of programs, instead of using RUN several times, you can list the
program names on the same line, using AND (final comma optional) to indicate the
last item in the list:
Program File
Run the Cooling, Heating and Fan
or using the final comma:
Run the Cooling, Heating, and Fan
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You cannot use the ampersand (&) for AND in a series. You can, however, leave out
AND as follows:
Run the Cooling, Heating, Fan
Example 3
If OR occurs before AND, the controller interprets OR first because the controller
works from left to right on AND and OR. For example, take this statement:
Program File
If Wkd = Sat or Wkd = Sun and TOD > 9:00 then...
The above statement is interpreted so that the items in parentheses below are
calculated first:
If (Wkd = Sat or Wkd = Sun) and TOD > 9:00 then...
If AND occurs before OR, the controller interprets AND first:
Program File
If TOD > 9:00 and Wkd = Sat or Wkd = Sun then...
is interpreted as:
If (TOD > 9:00 and Wkd = Sat) or Wkd = Sun then...
Example 4
AND is also used with the operator BETWEEN, as in the following example:
Program File
If TOD is between 8:00am and 6:00pm then...
You cannot use the ampersand (&) for AND when AND is used with BETWEEN.

Note
• Use parentheses to enforce the order of interpretations and resolve potential
ambiguities.
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51.22

EQUALS
EQUALS is similar to the IS... operator.
For more information, see section 51.23 “IS...” on page 1654..
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51.23

IS...
IS... carries out the logical test you specify.

Syntax
Greater-than-expression:
number > number
number is greater than number
number is above number
Greater-than-or-equal-to-expression:
number >= number
number is greater than or equal to number
Less-than-expression:
number < number
number is less than number
number is below number
Less-than-or-equal-to-expression:
number <= number
number is less than or equal to number
Equal-expression:
number = number
number is number
number is equal to number
number equals number
Not-equal-expression:
number <> number
number is not number
number is not equal to number
number does not equal number
List-inclusion-expression:
number is in list
number is range (see range-expression below)
number is EITHER list
List-exclusion-expression:
number is not in list
number is not range (see range-element below)
number is neither list
Range-expression:
number is between lower_number AND higher_number
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number is not between lower_number AND higher_number
number is lower_number THRU higher_number
number is not lower_number THRU higher_number
Table: IS...Parameters
Parameter

Description

number

Any number or expression, including a date
and time or name that stands for one.

list

Two or more numbers (as defined above)
with commas between them.

range

Two numbers (as defined above), each
marking one end of a range with THRU
between them, or two numbers preceded by
BETWEEN with AND between them.

Examples
Example 1
To compare two values, you usually place an IS... statement between IF and THEN
in an IF..THEN statement.

Note
• Because THAN is optional, in the following pairs of statements, each
statement gives the same instructions to the controller.
Program File
If Zone_Temp is greater than 70 then…
If Zone_Temp is greater 70 then…
If Zone_Temp is above 70 then…
If Zone_Temp is less than 70 then…
If Zone_Temp is less 70 then…
If Zone_Temp is below 70 then…
Example 2
The following statements are grouped together and give the same instructions to
the controller, because TO is optional and EQUALS can be used without IS:
Program File
If Zone_Temp is equal to 70 then…
If Zone_Temp is equal 70 then…
If Zone_Temp equals 70 then…
If Zone_Temp is not equal to 70 then…
IF Zone_Temp does not equal 70 then…
Example 3
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With IS IN, IS EITHER, IS NOT IN, or IS NEITHER, the comma in the list means OR.
You can also use the word OR before the last item in the list, for example:
Program File
If Zone_Temp is in Occupied, Warmup then…
If Zone_Temp is either Occupied, Warmup, OR Reset then…
If Zone_Temp is not in Occupied, Warmup then...
If Zone_Temp is neither Occupied, Warmup then...
If Zone_Temp is not 8 through 81 then...
Example 4
With IS BETWEEN and IS NOT BETWEEN, you always use AND. IS BETWEEN with
AND is equivalent to IS with THRU. The following statements are equivalent:
Program File
If Zone_Temp is between 70 and 80 then…
If Zone_Temp is 70 thru 80 then…
With THRU or BETWEEN, do not put parentheses around the two elements being
compared. The following parenthesis are not allowed:
If Zone_Temp is (70 thru 80) then…
If Zone_Temp is between (70 thru 80) then…
Program File
If Zone_Temp is not between 70 and 80 then…
If Zone_Temp is not 70 thru 80 then…
If Zone_Temp is not (ROOMTMP-5) thru (ROOMTMP+5)
If Zone_Temp is not ROOMTMP-5 thru ROOMTMP+5
With THRU or BETWEEN, always put the lower number first. The following
examples are not allowed:
If Zone_Temp is 80 thru 70 then…
If Zone_Temp is between 80 and 70 then…

Note
• Both THRU and BETWEEN are always inclusive, so the following are both
TRUE if the ZONE_TEMP is equal to 70 or 80.
If Zone_Temp is 70 thru 80 then…
If Zone_Temp is between 70 AND 80 then…
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51.24

NOT
NOT logically negates or inverts a number or expression, changing 0 (FALSE to
OFF) to 1 (TRUE or ON) or vice versa.

Syntax
not number
Table: NOT Parameter
Parameter

Description

number

Any number or expression.

Example
Program File
If not OCCUPIED then..
In this example, assume OCCUPIED can be ON or OFF. When OCCUPIED is ON,
placing NOT in front tests for the opposite condition, OFF.
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51.25

OR
The OR keyword can be used to provide the logical OR between two expressions,
or positioned in a list of names beween the last two items.
In this second example, OR indicates the end of the series. OR with the last name is
optional. The system carries out all other operations (such as adding and
subtracting) before acting on OR (or AND).
Operators by Precedence compares the order of operations on which the system
software acts. Because OR (and AND) are acted on last, you can form logical
statements without using too many parentheses. See Example 4 for how to use
AND and OR together.

Syntax
number or number
namelist or final_name
Table: OR Parameters
Parameter

Description

number

Any number, name that stands for a number,
formula or function that gives a number.

namelist

One or more names with commas between
them.

final_name

A single name at the end of a series of
names.

Examples
Example 1
To take an action only if at least one of several conditions exists, you use OR
between the numbers, so if one of them is true, the resulting action occurs:
Program File
If the Heat is On or the Cool is On then...
Note that in the above statement, you can substitute exclamation mark (!) for OR.
Example 2
To put a list in an IF statement, you can use an OR between the last two names in
the list:
Program File
You cannot use the exclamation mark (!) for OR in a series. You can, however, leave
out OR as follows:
If the Zone is Warming, Occupied, Lowtemp then...
Example 3
You can also combine the logical OR with a name list containing an OR (with or
without the comma before OR) as follows:
Program File
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If the Zone is either Warm, Occupied, or Low or Heat is Off then...
The controller always interprets the first OR as the list OR and the second as the
logical OR. If you want to reverse the order of the statement, use parentheses, as
follows:
Program File
If (Heat is Off) or Zone is either Warming, Occupied or Low
then...
Example 4
If OR occurs before AND, the system software interprets OR first because the
software works from left to right on AND and OR. For example, take this statement:
Program File
If WKD = Sat or Wkd = Sun and TOD > 900 then...
The above statement is interpreted so that the items in parentheses below are
calculated first:
If (Wkd = Sat or Wkd = Sun) and TOD > 900 then...
If AND occurs before OR, the controller interprets AND first:
Program File
If TOD > 900 and Wkd = Sat or Wkd = Sun then...
is interpreted as:
If (TOD > 900 and Wkd = Sat) or Wkd = Sun then...
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51.26

Mathematical Operators
Mathematical operators perform mathematical operations, such as addition or
subtraction.
Mathematical operators include the following keywords.

51.26.1

DIVIDED BY
DIVIDED BY divides one number by another. The division operator (/) can be
substituted for DIVIDED BY.
For more information, see section 51.27 “DIVIDED BY” on page 1661..

51.26.2

MINUS
MINUS subtracts number from number.
For more information, see section 51.28 “MINUS” on page 1662..

51.26.3

MOD
MOD returns the remainder of one number divided by another.
For more information, see section 51.29 “MOD” on page 1663..

51.26.4

PLUS
PLUS adds two expressions.
For more information, see section 51.30 “PLUS” on page 1664..

51.26.5

TIMES
TIMES multiplies two numbers.
For more information, see section 51.31 “TIMES” on page 1665..
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51.27

DIVIDED BY
Aliases: /, DIV
DIVIDED BY divides one number by another. The division operator (/) can be
substituted for DIVIDED BY.

Syntax
number divided by number
Table: DIVIDED BY Parameters
Parameter

Description

number

Any number or expression.

Examples
Example 1
Program File
Usage = kwh divided by 24
Example 2
Program File
Usage = kwh/24
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51.28

MINUS
Alias: MINUS subtracts number from number.

Syntax
number minus number
Table: MINUS Parameters
Parameter

Description

number

Any number or expression.

list

Two or more numbers (as defined above)
with commas between them.

range

Two numbers (as defined above), each
marking one end of a range with THRU
between them, or two numbers preceded by
BETWEEN with AND between them.

Examples
Example 1
Program File
Kwh_day = Kwh_PM minus Kwh_AM
Example 2
Program File
Kwh_day = Kwh_PM - Kwh_AM
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51.29

MOD
Alias: REMAINDER
MOD returns the remainder of one number divided by another.

Syntax
number mod number
Table: MOD Parameter
Parameter

Description

number

Any number or expression.

Example
Program File
Extra = 5 mod 2
The equation divides 5 by 2 and gives a remainder of 1, so EXTRA is set to 1.
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51.30

PLUS
Alias : +
PLUS adds two expressions.

Syntax
number plus number
Table: PLUS Parameter
Parameter

Description

number

Any number or expression.

Example
Example 1
Program File
TotalKwh = KwhMonth plus KwhDay
Example 2
Program File
TotalKwh = KwhMonth + KwhDay
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51.31

TIMES
Aliases: MULTIPLIED BY, MULT, *
TIMES multiplies two numbers.

Syntax
number times number
Table: TIMES Parameter
Parameter

Description

number

Any number or expression.

Example
Example 1
Program File
Energycost = Building1_KW times 1.78
Example 2
Program File
Energycost = Building1_KW * 1.78
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51.32

Program Statements
Program statements are written with Script words, known as keywords, that are
arranged in a predefined structure. Each keyword has its own keyword syntax.
According to the rules of that syntax, certain parameters and values are allowed or
not allowed to follow a keyword.

51.32.1

Statement Keywords
Statements define the actions that controllers perform (such as START), or assist in
the structure of a statement (such as THE).
For more information, see section 51.33 “Statement Keywords” on page 1667.
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51.33

Statement Keywords
Statements define the actions that controllers perform (such as START), or assist in
the structure of a statement (such as THE).
Script uses three different types of statement keywords: action, declaration, and
program control statements.

51.33.1

Action Statements
Action statements define the actions that controllers perform (such as SET).
Action statements include the following keywords:
• P
• PRINT
• SET
• TURN
For more information, see section 51.34 “Action Statements ” on page 1669.

51.33.2

Declaration Statements
Declaration statements assist in defining program variables.
Declaration statements include the following keywords:
• ARG
• DATETIME
• LINE
• NUMERIC
• STRING
• THE
For more information, see section 51.39 “Declaration Statements ” on page 1680.

51.33.3

Program Control Statements
Program Control statements assist in directing program flow.
Program Control statements include the following keywords:
• BASED ON...GOTO
• BREAK
• CONTINUE
• FOR..NEXT
• GOTO
• IF...THEN...ELSE
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• MOVE
• REPEAT...UNTIL
• RETURN
• SELECT CASE
• STOP
• STOP
• WAIT
• WHILE
For more information, see section 51.47 “Program Control Statements ” on page
1695.

51.33.4

Qualifier Statements
Qualifier statements assist in defining input, output, and public variables.
Qualifier statements include the following keywords:
• INPUT
• OUTPUT
• PUBLIC
For more information, see section 51.61 “Qualifier Statements” on page 1720.
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51.34

Action Statements
Action statements define the actions that controllers perform (such as SET).

51.34.1

P
P prints the values of one or more variables, points, constants, or other expressions
representing a value, including strings of characters and datetimes, each on a
separate line.
For more information, see section 51.35 “P” on page 1670..

51.34.2

PRINT
PRINT prints a series of characters (text strings, often simply called strings) to a
string object or attribute, a local variable, a printer, or a communications port.
For more information, see section 51.36 “PRINT” on page 1671..

51.34.3

SET
SET assigns a value to a point or variable.
For more information, see section 51.37 “SET” on page 1677..

51.34.4

TURN
TURN sets the name or names to the top of the defined range for the point if ON
and to the bottom of the range if OFF.
For more information, see section 51.38 “TURN” on page 1679..
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51.35

P
Alias: PR
P prints the values of one or more variables, points, constants, or other expressions
representing a value, including strings of characters and datetimes, each on a
separate line.
The list can contain different types of items. Prints units with point values.
For points, system variables, and attributes, prints the name of the point (or variable
or attribute), followed by an equal sign, the value of the point, and the units.
Otherwise, only the value prints.
Also, can print to comm ports and string objects (including program string
variables).

Syntax
P list
Table: P Parameter
Parameter

Description

list

One or more expressions with commas
between them. The list can also include
functions or attributes.

Examples
Example 1
Command Line
P SupplyAir, ReturnAir, BurnerStat, CoilStatus
SupplyAir = 46 degrees F
ReturnAir = 68 degrees F
BurnerStat = on
CoilStatus = off
Notice that the name of the point and the units print for each point.
Example 2
Command Line
P OutsideAir, Avg (Temp), AvgSetpt, OutsideAir_Type, TOD
OutsideAir_Type = 46 degrees F
86
AvgSetpt = 64
OutsideAir Type = Input
TIMEOFDAY = 8:32 pm
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51.36

PRINT
PRINT prints a series of characters (text strings, often simply called strings) to a
string object or attribute, a local variable, a printer, or a communications port.
You can also print to a string point or local variable to fill that point or variable with a
string of text or numbers. In addition, on WorkStation, you can print to an ASCII file.

Syntax
Format 1: any_of_formats_above to string_point_or_variable
Prints any value or string, including messages, points, or variables, into a string
point or variable to set the value of that string.
Format 2: Print string
Prints a string value of text to the default comm port of the program or report.
Format 3: Print list
Prints the values of one or more variables, points, constants, or other expressions
representing a value. The list can contain different types of items.
Format 4: Print string_format, list
Prints the variables, points, or other expressions in the list in the format you specify.
Table: PRINT Parameters
Parameter

Description

string

A series of characters in quotation marks.

string_format

A known character or string of characters
combined with changeable characters to
form one print line.

list

A known character or string of characters
combined with changeable characters to
form one print line.

;

(Optional) If you end a PRINT statement
without the semicolon, the next line you print
starts on a new line. If you want to print two
strings one after the other on the same line,
you must end the first with a semicolon.

string_point_or_variable

Any defined string point or string variable.

Formatting Characters
You can indicate the layout of the print line using the following special symbols:
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Table: Special PRINT Line Symbols
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Character

Description

|

Indicates the beginning of a series of
characters that are strictly for formatting and
not to be treated as text. When followed by a
numeric constant, indicates an ASCII code
follows.

|"

(A vertical bar immediately before a
quotation mark.) Indicates to print the
quotation mark, rather than interpreting that
mark as the beginning or end of the string.

| numeric_constant

Produces the ASCII code that corresponds
to the numeric constant. For example, |7
would produce a bell or beep if printed on a
terminal. |13 is the carriage return character.
See the ASCII Codes for more codes.

#

Represents one character that is numeric.
The series of characters prints right-justified,
filling with blanks any blank characters to the
left.

$###

Displays either ON, -ON, or OFF (as with
tristate Output point).

%

Multiplies the point value by 100 and places
a percent sign after that point value (most
useful with scale of 0 to 1, where 1 is 100%).

*

Prints the next argument result.

-

Prints a leading or trailing minus sign, if
expression is a negative number; prints a
leading or trailing plus sign if expression is a
positive number.

}

Removes trailing zeroes (extra decimal
spaces)

,

Prints commas every third digit left of the
decimal point.

>

Right justifies the number or text within the
format.

<

Left justifies the number or text within the
format.

^

Displays a numeric expression in scientific
notation.

@

Represents one character of any kind,
alphabetic or numeric. A series of characters
prints left justified, filling with blanks any
blank characters to the right.
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Character

Description

The format must be enclosed in quotation marks. The comma is required after the
format (outside the quotation marks) if an item to insert in the format follows (see
Example 3).

Examples
Table: PRINT Program File and Output Columns
No.
1

Program File

Output

Print
"HEAT_SETPT"
to PointName

Explanation
Prints the value
into the string
and changes its
setting. You can
set a string point
or variable this
way.

2

Print "WARNING Trouble on the
4th Floor!"

WARNING-Trouble
on the 4th Floor!

The string of
characters prints; the
quotation marks do
not.

3

Print TEMP1,
TEMP2, TEMP3,
TEMP4

67 72 77 75

The value of each
variable in the list
prints, with a space
after the value.

4

Print "The
temperature is
|###.# at
|##:##:##",
~Temp4, Hour,
Minute, Second

The Temperature is
75.0 at 4:32:05

The string prints with
a value of the first
point (or variable) in
the first format and
the value of the next
point or variable in
the next format. If
there are more than
two formats, the
subsequent point or
variable values are
printed in the
corresponding
formats in order.

5

Print
"|#######",
Total_Watts

1340

Leaves 3 leading
spaces before the
value of Total Watts.
The value prints on
the terminal called
TERMINAL.

6

Print WeekDay;

Tuesday January 2

Prints all text and
spaces on the same
line because each
PRINT statement
ends with a
semicolon (;).

Print " ";
Print Month;
Print " ";
Print DayOfMonth
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Continued
No.

Program File

Output

Explanation

7

Print
"|##,###.##",
Total_Watts

1,340.00

Leaves one leading
space. Adds the
comma after the 1
and has two zeros
after the decimal.

8

Print
"#,###.##}",
Total_Watts

1,340

Drops extra decimal
places (trailing zeros).

9

Print "The Fan
Status is
|$###",
FanStatus

The Fan Status is ON Prints ON, -ON, or
OFF for a digital or
tristate point, leftjustifying ON in the
format.

10

Print "The
Damper Setting
is |##.##",
Damper

The Damper Setting
is 20.00

Prints the pulsing
value of the damper
in the format. Here
the damper is ON for
20 seconds. for -ON,
the value is negative.

11

Print "| *",
Murphy FullName

Murphy Johnson

Outputs any number
of characters of any
type that are in the
FullName attribute.
The * is particularly
useful when you do
not want to limit the
number of character
in a variable.

12

Heater Failed!
Print
"|@@@@@@@@@@@@@
@",
~ STRMSG to
Building1
Console
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The message inside
STRMSG prints left
justified in the 14
characters allowed
by the @ signs.

13

21.7
Print
"|>#######.##}"
, 21.70

Right justifies and
drops the trailing 0.

14

Print "|-##>##", +88.8
88.8

Prints leading minus
sign if the number is
negative and the
leading plus sign if
the number is
positive. Prints all
trailing zeros.
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Continued
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No.

Program File

Output

Explanation

15

Print "|##.##-", 88.80-88.80

16

Print "|###^##
is the
|"TOTAL.|"",
97000

8,97e03+05 is the
"Total."

Prints the number is
scientific notation.
Also prints the
quotation marks
around VALUE,
because a vertical
bar is before each
quotation mark that
should print.

17

Print
"|###^##"",
.8970

8,97e-01

Prints in scientific
notation with
negative exponent.

18

Print "|##.##^##"",
1340000

+1.340e+06

Prints in scientific
notation with a
leading plus sign for
a positive number.

19

The blower's current
Print "The
blower's current state is ENABLED.
state is
|@@@@@@@@.",~
Blower State

Prints the text string
left justified in the
format and leaves a
blank for the
unfulfilled character
at the end.

20

Print "The valve The Valve is set to
45% open.
is set to |%###
open.",~Water_V
alue

Prints the value in
engineering units as
a percentage of the
scale for the point.
This format works
best with a scale of 0
to 1, where 0 is fully
closed and 1 is fully
open. So, if the value
is 1, the statement
prints 100%. If the
value is .45, the
statement prints
45%.

Prints trailing minus
sign if the number is
negative and the
trailing plus sign if the
number is positive.
Prints all trailing
zeros.
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Continued
No.

Program File

Output

Explanation

21

Print "Date:",
Month,
",~DayOfMonth,
",",Year

Date: December 4,
2008

Prints the date.
Commas must
separate each group
of literal text. Notice
that the only place a
space displays is
immediately after the
word Date. You must
specify the blank
space in quotation
marks.

Print " "
Print "Test
Report"

Test Report

Also prints a blank
line between the date
and the report title. If
you use the word
PRINT, followed by
one blank in
quotation marks,
then the entire line
prints as a blank line
(as long as you do
not put a semicolon
at the end).
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51.37

SET
Alias: ADJUST and CHANGE (Format 1 only), LET (Format 2 only), MODIFY
SET assigns a value to a point or variable.

Syntax
Syntax 1: Set namelist to number
Syntax 2: Set namelist = number
Table: SET Parameters
Parameter

Description

namelist

Any defined name or list of names. The
name or names can be any of the following
types:
• Point (any type).
• Local variable, either numeric, string, or
datetime.
The type of name must match the type of
number.

number

Any number or expression, including a string
or date and time, or a name that stands for
either of those.
A numeric name can accept only the results
of a numeric expression. A string name can
accept only text. A datetime name can
accept only a date and time.

Examples
Example 1
At any time in a program, you can set the value of a variable or array of variables
using SET and the word TO:
Program File
Set area to height times width
You can also use ADJUST, CHANGE, or MODIFY with TO. With ADJUST and
CHANGE, the TO is required:
Program File
Adjust Valve to Open
Program File
Change Space_SP to 72
Program File
Modify Space_SP to 72
You cannot use the equal sign with ADJUST or CHANGE, but you can use the
equal sign with MODIFY.
Example 2
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You can set a variable using SET and an equals sign as in the example below:
Program File
Set KwAbg = Average (KW)
Instead of SET, you can use LET with the equals sign, as follows:
Program File
Let KwAvg = Average (KW)
You cannot use the word TO with LET.
Neither the word SET nor the word LET is required with the equals sign, so you can
set the same variable like this:
Program File
KwAvg = Average (KW)
Example 3
You can set a string variable or point to a particular value:
Program File
Set Stat_Message to "Heat active"
Example 4
You can set several points and variables to a particular value:
Program File
Set KwAvg, OATAvg, HWAvg, CHWAvg = 0
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51.38

TURN
TURN sets the name or names to the top of the defined range for the point if ON
and to the bottom of the range if OFF.

Syntax
Format 1: Turn On point_list
TURN OFF point_list
Format 2: Turn point_list On
TURN point_list OFF
Table: TURN Parameter
Parameter

Description

point_list

One or more defined output or numeric
points; the statement is not designed for
other types of points.

Examples
Example 1
Suppose you want to turn on the fan and the pump. You can turn both on in one
program statement:
Program File
Turn on the Fan and the Pump
Example 2
You can place the word ON or OFF after the name of the point:
Program File
Turn the Pump off
Example 3
You can also place ON or OFF before the name of the point:
Program File
Turn off the Pump
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51.39

Declaration Statements
Declaration statements assist in defining program variables.

51.39.1

ARG
ARG is a keyword that defines an argument and can be given a name. After you
assign an easy-to-remember name to an argument variable, you can then refer to
that variable by its name so your function is easier to understand.
For more information, see section 51.40 “ARG” on page 1682..

51.39.2

DATETIME
DATETIME creates and defines one or more names as local DATETIME variables.
You define the variables inside a program for use only in that particular program.
For more information, see section 51.41 “DATETIME” on page 1683..

51.39.3

LINE
LINE labels a particular line in the program so that program control can later branch
or move to that line with the GOTO (or more advanced BASED ON..GOTO)
statement.
For more information, see section 51.42 “LINE” on page 1685..

51.39.4

NUMERIC
NUMERIC creates and defines one or more names as local numeric variables. You
define the variables inside a program for use only in that particular program.
For more information, see section 51.43 “NUMERIC” on page 1689..

51.39.5

STRING
STRING creates and defines one or more names as local string variables. You
define the variables inside a program for use only in that particular program. You
can specify the length of the string of characters with the string_length.
For more information, see section 51.44 “STRING” on page 1691..

51.39.6

THE
THE performs no function, but enhances readability.
For more information, see section 51.45 “THE” on page 1693..
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51.39.7

Webservice
Webservice delares a Web Service in a Script program.
For more information, see section 51.46 “ Webservice” on page 1694.
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51.40

ARG
Alias: PARAM
ARG is a keyword that defines an argument and can be given a name. After you
assign an easy-to-remember name to an argument variable, you can then refer to
that variable by its name so your function is easier to understand.
ARG can only be used to declare that variable in a function (Syntax 1). ARG calls the
argument variable by the variable’s number (Syntax 2).

Syntax
Syntax 1: ARG integer_constant name
Syntax 2: ARG [ integer_expression ]
Table: ARG Parameters
Parameter

Description

integer_constant

Any integer between 1 and 15.

name

Any name you choose for the argument
including underscore and period, but must
begin with a letter. Not a keyword.

integer_expression

Any integer or expression that gives an
integer.

Examples
Example 1
In this example, ARG[5] represents the status of a report. To make that easier to
understand, ARG[5] is named RPTSTATUS. The program refers to RPTSTATUS for
the variable value from then on.
Function File
ARG 5 RptStatus
Example 2
To test to see if the report status equals SUCCESS, you can call on the argument
variable using the easy-to-remember name (from Example 1):
Function File
If RptStatus is Success then…
Example 3
To test to see if the report status equals SUCCESS, you can also call on the
argument variable using ARG[5]:
Function File
If ARG[5] is Success then…
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51.41

DATETIME
DATETIME creates and defines one or more names as local DATETIME variables.
You define the variables inside a program for use only in that particular program.
You define the variables as follows:
• Specify an array by including the array_size_number during the array definition
since each variable can be a single variable or an array.
• Add seconds as if the datetime were a number because the datetime is stored
in seconds.
• Define all local datetime variables at the top of your program.
• Set the datetime variable to the time at a given moment using the DATE system
variable.
• Print the datetime variable. When you do, you receive the date and time printed
in this format:
MONTH DD YYYY hh:mm:ss
The month is spelled out; the day is two digits, the year is four digits. The hour,
minute, and second are in 24-hour time.
Binding Qualifiers
Variables can also be bound to the object property of a point outside of the
program. To do this, you must use a keyword, either Input or Output.

Syntax
Datetime Binding_qualifier namelist [ array_size_number ]
Table: DATETIME Parameters
Parameter

Description

namelist

The name of a datetime variable you are
defining or a series of datetime variables
separated by commas.

array_size_number

A number up to 32,767 that tells the
controller how many positions are in the
array.

Binding_qualifier

The keyword Input or Output, which you can
bind to a point.

Examples
Example 1
In this program, the first statement defines the TEMPTIME as a datetime variable.
The next statement sets the variable to the time at a given moment with the DATE
system variable:
Program File
Datetime TempTime
TempTime = date
Example 2
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You can define a series of datetime variables in a single statement:
Program File
Datetime TempTime, FirstTime, LastTime
Example 3
You can define more than one array of datetime variables in a single statement:
Program File
Datetime TempTime[40], Timer[30], Watch[15]
Example 4
You can define several arrays of datetime variables and several single variables in a
single statement:
Program File
Datetime TempTime[40], FirstTime, Timer[30], LastTime
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51.42

LINE
LINE labels a particular line in the program so that program control can later branch
or move to that line with the GOTO (or more advanced BASED ON..GOTO)
statement.

Caution
• Line names 0, C, and E are reserved for use by WorkStation. LINE 0 is
predefined for stopping the program, so you cannot label a line LINE 0.
However, you can use GOTO line 0 to stop a program. You can label a line
LINE E and the program automatically goes to that line when an error occurs.
LINE C is reserved for future use.
You can label lines to redirect program flow to any part of the program. For
example, you could return program flow to an earlier line, such as the first line. Or
you could send program flow to a later line to branch into a specific set of actions.

Syntax
Line linename
linename:
Line integer
Integer:
Table: LINE Parameters
Parameter

Description

linename

Any single character or word that is not a
keyword, except:
• C (reserved)
• E (used for error detection)
You must begin the name with an alphabetic
character. In the GOTO statement, the label
must be spelled exactly as is in the LINE
statement; however, you can interchange
upper- and lowercase.

integer

Any single whole number, except 0.
LINE 0 is predefined for stopping the
program, so you cannot label a line LINE 0.
However, you can use the GOTO line 0 to
stop a program.
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The linename followed by a colon (:) on its
own line.

Format 4

The integer followed by a colon (:) on its own
line. In this case, the line has a line number
for a name.
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Parameter

Description

Examples
Example 1
In the following example the first linename is STARTUP, labeled LINE STARTUP.
Follow the program flow to see how the line name directs the control of the
program.
Program File
Line Startup
If Temp > 72 then goto Cooling
If Temp < 70 then goto Heating
Line Heating
Turn on the Heat
...
Goto Startup
Line Cooling
Turn on the Blower
...
Goto Startup
Example 2
This example is the same as the last, only each linename is labeled with the name
followed by a colon:
Program File
Startup:
If Temp > 72 then goto Cooling
If Temp < 70 then goto Heating
Heating:
Turn on the Heat
...
Goto Startup
Turn on the Blower
Cooling:
...
Goto Startup
Example 3
This example shows how to use an integer as a line label:
Program File
LINE 1
Start Fan1
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Goto 2
LINE 2
If Fan1_Status is on then goto Shutdown
LINE Shutdown
If Zone1 temperature is less than 60 then
Stop Fan1
Goto 1
Endif
Example 4
This example shows an integer with a colon as a line label:
Program File
1:
Start Fan1
Goto 2
2:
If Fan1_Status is on then goto 3
3:
If Zone1 temperature is less than 60 then
Stop Fan1
Goto 1
Endif
Example 5
This example shows a program that has a line labeled E. The program automatically
goes to line E when an error occurs. If you do not have a line E, the software
automatically disables the program. When an error occurs, you might want the
program to go to a special line. For example, you might want the program to go to a
special line that closes an open comm port (see OPEN).
The following program goes to line E and closes the comm port when an error
occurs:
Program File
Numeric Result
Line OpenPort3
Result = Open (Comm3)
Line TestingOpen
If result = success then goto PrintMenus
Line PrintMenus
Run MenuDisplay
...
If Comm3_PrintDone = true then goto ClosePort3
Line ClosePort3
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Result = Close (Comm3)
Line TestingClose
If result = Success then Stop
Line E
Result = Close (Comm3)
Print "EMERGENCY EXIT - MENUPROGRAM FAILED."
If you have a line E, when an error occurs, line E displays in the file status
information.
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NUMERIC
Alias: NUMBER
NUMERIC creates and defines one or more names as local numeric variables. You
define the variables inside a program for use only in that particular program.

Tip
A numeric variable is a name that represents a number. Numeric variables are
subject to the same range limitations as numeric constants. Numeric constants,
variables, points, expressions (formulas), or functions can be compared to other
numeric type items or used in mathematical calculations.
Each variable can be a single variable or an array. You specify an array by including
the array_size_number during the array definition.

Binding Qualifiers
Varibles can also be bound to the object property of a point outside of the program.
To do this, you must use a keyword, either Input or Output.

Syntax
Numeric Binding_qualifier namelist [array_size_number]
Table: NUMERIC Parameters
Parameter

Description

namelist

The name of the numeric variable you are
defining, or a series of numeric variables
separated by commas.

array_size_number

A number up to 32,767 that tells the
controller how many positions are in the
array.

Binding_qualifier

The keyword Input or Output which you can
bind to a point.

Examples
Example 1
Suppose that you are averaging the values of the ten temperatures. The points that
take the outside air temperature have been defined using menus and windows, but
you define the variable that contains the average using NUMERIC:
Program File
Numeric Avg_Temp
Avg_Temp = Average (Temp)
Print Avg_Temp
Example 2
You can define a series of numeric variables in a single statement:
Program File
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Numeric Ave_OAT, AVE_Temp, Fan_SP
Example 3
You can define an array of numeric variables in a single statement:
Program File
Numeric Fan_SP[20]
Example 4
You can define several arrays of numeric variables and several single variables in a
single statement:
Program File
Numeric Fan_SP[20], Pump_SP, AHU_SP[10], Heat_SP
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51.44

STRING
STRING creates and defines one or more names as local string variables. You
define the variables inside a program for use only in that particular program. You
can specify the length of the string of characters with the string_length.

Tip
A string variable is a name that represents a series of alphanumeric characters.
String constants, variables, points, expressions, or functions can be compared to
other string type items. Strings cannot be used in mathematical calculations
unless they are converted to a numeric type.
Each variable can be a single variable or an array. You specify an array by including
the array_size_number during the array definition.
You must define all local string variables at the top of your program.
STRING is used to store textual information in the current program.
If you do not give a string_length, the string is given the default length, which is 16
characters.

Tip
For Enterprise Servers and Automation Servers, the maximum string_length is
255 characters. For b3 BACnet devices, the maximum length is 32 characters.
The Script compiler catches any number that is out of range.

Binding Qualifiers
Varibles can also be bound to the object property of a point outside of the program.
To do this, you must use a keyword, either Input or Output.

Syntax
String Binding_qualifier string_length namelist [array_size_number]
Table: STRING Parameters
Parameter

Description

namelist

The name of the string (text) variable you are
defining, or a series of string variables
separated by commas.

array_size_number

(Optional) Any number up to 32,767 that tells
the controller how many positions are in the
array.

Binding_qualifier

The keyword Input or Output which you can
bind to a point.

Examples
Example 1
To set a string variable, you must first define that variable using STRING. To define a
single string variable of the default length, you enter this program line:
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Program File
String VarName
Example 2
To have a program read information from a file containing text, you would create a
series of string variables like those below to contain each piece of text information.
You can create them all in the same program line:
Program File
String 20 LNAME, LOGON, PWORD, ROOM, TERMINAL
The length of each string is 20. To give them different lengths, you must define
(declare) each one separately.
Example 3
To create a string array of variables, you must first define the array. The string called
PUMP below is an eight-character string with 20 variables in the array (PUMP[1],
PUMP[2], PUMP[3], and so on).
Program File
String 8 Pump[20]
Pump[6] = "HeatPump"
Example 4
You can create several arrays of string variables and single string variables all in one
program line:
Program File
String Pump[6], Blower[8], HeaterNM, FanName
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51.45

THE
THE performs no function, but enhances readability.

Syntax
the name
Table: THE Parameter
Parameter

Description

name

Any point, piece of equipment, terminal,
computer, or printer.
THE can precede a name only. THE cannot
precede a keyword that designates an
action (verb).

Examples
Program File
Turn on the Fan
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51.46

Webservice
Webservice delares a Web Service in a Script program.

Syntax
Webservice (service name)
Table: Webservice Parameter
Parameter

Description

service name

Any Web Service name of your choosing.

Tip
The Web Service declaration name does not need to match the Script Web
Service object you intend to bind.

Example
You declare a Web Service here in order to invoke an online calculator service.
Program File
Webservice wsCalculator
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51.47

Program Control Statements
Program Control statements assist in directing program flow.

51.47.1

BASEDON...GOTO
BASEDON...GOTO branches to a different line for each value the number can have.
You put the line names in the linelist.
For more information, see section 51.48 “BASEDON...GOTO” on page 1697..

51.47.2

BREAK
BREAK halts the smallest enclosing FOR...NEXT, REPEAT...UNTIL, WHILE, or
SELECT CASE statement.
For more information, see section 51.49 “BREAK” on page 1699..

51.47.3

CONTINUE
CONTINUE stops the current iteration of the smallest enclosing FOR...NEXT,
REPEAT...UNTIL, or WHILE statement and starts the next iteration from the top of
the loop. CONTINUE also exits the SELECT CASE statement.
For more information, see section 51.50 “CONTINUE” on page 1700..

51.47.4

FOR...NEXT
FOR...NEXT carries out all statements in a loop a fixed number of times.
For more information, see section 51.51 “FOR...NEXT” on page 1701..

51.47.5

GOTO
GOTO branches to the line labeled linename.
For more information, see section 51.52 “GOTO” on page 1704..

51.47.6

IF...THEN...ELSE
IF...THEN...ELSE carries out a given statement or series of statements if the
expression is TRUE.
IF...THEN...ELSE can also carry out a given statement or series of statements if the
given expression is FALSE.
For more information, see section 51.53 “IF...THEN...ELSE” on page 1707..
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51.47.7

MOVE
MOVE converts engineering units to electrical units to control the output point,
using the top and bottom of scale for that point.
For more information, see section 51.54 “MOVE” on page 1711..

51.47.8

Repeat...Until
Repeat...Until carries out the statements in the loop until the number is true.
For more information, see section 51.55 “Repeat...Until” on page 1712..

51.47.9

RETURN
In a function, the RETURN keyword controls the calling program, returns and sends
the number to the calling program, and returns the contents of the variable.
For more information, see section 51.56 “RETURN” on page 1713..

51.47.10

SELECT CASE
SELECT CASE executes one or more statements, depending on the value of a
test_expression.
For more information, see section 51.57 “SELECT CASE” on page 1715..

51.47.11

STOP
With an output point, STOP actually stops the piece of equipment. With an input
point, STOP sets the point to the bottom of the defined scale. With a numeric point,
STOP sets the point to the lowest number in the controller system. You might STOP
an input after using the RUN keyword in order to test whether the input is active.
For more information, see section 51.58 “STOP” on page 1717..

51.47.12

WAIT
WAIT makes a program's execution wait for a specified number of seconds and
then resume right after the WAIT command statement.
For more information, see section 51.59 “WAIT” on page 1718..

51.47.13

WHILE
WHILE carries out the instructions in the statements within the loop over and over
again as long as the given number is TRUE.
For more information, see section 51.60 “WHILE” on page 1719..
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51.48

BASEDON...GOTO
BASEDON...GOTO branches to a different line for each value the number can have.
You put the line names in the linelist.

Syntax
Syntax 1:
Basedon (number) Goto linelist
or
Basedon (number) Go to linelist
or
Basedon (number) Go to linelist
Syntax 2:
Basedon (number) Goto Line linelist
or
Basedon (number) Go to Line linelist
Table: BASEDON... GOTO Parameters
Parameter

Description

number

Any number or expression. If less than 1 or
greater than the number of lines in the
linelist, the controller ignores the
BASEDON...GOTO statement and executes
the statement immediately after
BASEDON...GOTO.

linelist

One or more defined line labels (see LINE
statement) present in the current program.
The label must be spelled here just as the
label is defined, except you can interchange
upper- and lowercase. The line label can
also be an integer.

Examples
You can have a series of steps (a line) that you want to run every Friday to shut
down equipment not required over the weekend. Then, every Monday you can
restart that equipment.
To run different lines on particular days, you write a program that activates certain
lines based on the day of the week. The lines are labeled with LINE, telling the line
the routine starts on.
Remember that SUN is considered the first day of the week, so in the program
below, the first line listed after GOTO runs on Sunday, the next on Monday, the next
on Tuesday, and so on:
Program File
Basedon Wkd Goto Sun_1, Mon_1, Tue_1, Wed_1, Thu_1, Fri_1, Sat_1
…
Line Sun_1
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…
Line Mon_1
…
Line Tue_1
…
Line Wed_1
…
Line Thu_1
…
Line Fri_1
…
Line Sat_1

Note
• The following variations to the BASEDON statement (above) are acceptable.
You can also include the word LINE in front of the line list:
Basedon Wkd Goto Line Sun_1, Mon_1, Tue_1, Wed_1, Thu_1, Fri_1,
Sat_1
You can replace GOTO with the word GO:
Basedon Wkd Go Sun_1, Mon_1, Tue_1, Wed_1, Thu_1, Fri_1, Sat_1
You can separate the word GO from the word TO:
Basedon Wkd Go to Sun_1, Mon_1, Tue_1, Wed_1, Thu_1, Fri_1, Sat_1
You can include the word LINE after GO and TO:
Basedon Wkd Go to Line Sun_1, Mon_1, Tue_1, Wed_1, Thu_1, Fri_1,
Sat_1
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BREAK
BREAK halts the smallest enclosing FOR...NEXT, REPEAT...UNTIL, WHILE, or
SELECT CASE statement.
After BREAK executes, the next statement the controller carries out is the one
immediately following the end of the loop or block.

Syntax
Break

Examples
To check several stored temperatures to see if any is reading over 75 degrees, you
use a FOR...NEXT loop. Normally, the loop below would end after checking the 20
temperatures. To exit the loop as soon as you find one over 75 degrees, you use
the BREAK statement.
Program File
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CONTINUE
CONTINUE stops the current iteration of the smallest enclosing FOR...NEXT,
REPEAT...UNTIL, or WHILE statement and starts the next iteration from the top of
the loop. CONTINUE also exits the SELECT CASE statement.
Each time the loop repeats, the action is an iteration of that loop.

Syntax
Continue

Examples
To check several temperatures stored in an array and print names of those over 75
degrees, you use a FOR...NEXT loop. (See the FOR...NEXT statement.) Normally,
the loop below would print the names of all 20 stored temperatures. To get the loop
to select those over 75, use CONTINUE to break the loop whenever one is less than
or equal to 75, and skip to the next array item.
Program File

In the above program, if the temperature is less than or equal to 75 degrees,
CONTINUE tells the controller to go back to the top of the FOR...NEXT loop to
check the next temperature (and therefore skip any statement between CONTINUE
and the NEXT statement).
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FOR...NEXT
FOR...NEXT carries out all statements in a loop a fixed number of times.

Syntax
Syntax 1:
For numeric_name = begin to end
Statement
Statement
...
Next numeric_name
Syntax 2:
For numeric_name = begin to end step number
Statement
Statement
...
Next numeric_name
Table: FOR...NEXT Parameters
Parameter

Description

numeric_name

A defined local variable or point that stands
for a number.
The numeric_name after NEXT must be the
same as the one after FOR.

statement

Any complete instruction that tells the
program what to do next or what action to
take.

begin

An integer expression.

end

An integer expression.

number

The amount to increase numeric_name by
each time the controller goes through the
loop.

Examples
Example 1
A FOR...NEXT loop looks like this:
Program File
For count = 2 to 10 step 2
Print count, " ", (10 + count)
Next count
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The statement sets the value of the numeric_name to the begin value, then carries
out the statements after FOR until reaching NEXT. At NEXT, the program goes back
to FOR and gets the next value of numeric_name by adding number to begin.
Here, since begin is 2, end is 10, and number is 2, the numeric_name (often called
the counter) counts 2, 4, 6, 8, 10. The first time through the loop numeric_name is
2, the second time numeric_name is 4, and so on.
As long as numeric_name is less than or equal to end, the statements inside the
loop are carried out. When numeric_name is greater than end the program then
goes to the statement after NEXT.
Here is the output printed by the previous loop:
2 12
4 14
6 16
8 18
10 20
If you do not specify a STEP number, the name automatically increases by one
(increments) each time the loop executes.
The step can also be a negative step, taking the value of the name from a begin of,
for example, 10 to an end of 1 by a number of -1.
The step can also be a negative step, taking the value of the name from a begin of,
for example, 10 to an end of 1 by a number of -1.
Example 2
Before you run functions that use the ARG variables, you can set them all to zero
with one programming statement using FOR...NEXT:
Program File
For count = 1 to 15
Set ARG[count] = 0
Next count
The first time through the loop, ARG[1] is set to 0, the second time ARG[2] is set to
0, the third time ARG[3] is set to 0, and so on.
Example 3
To set every third value in an array to zero, you can go to the third item, then sixth,
then ninth, and so on, using STEP with FOR...NEXT:
Program File
Number count
For count = 3 to 15 step 3
Set Pump[count] = 0
Next count
Example 4
To find a filtered average, you could set up a function called FILT_TOTAL. The
function, shown below, uses FOR...NEXT to loop from ARG[3] through ARG[15],
and add only the numbers with a value between that of ARG[1] and ARG[2].
Function File
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51.52

GOTO
GOTO branches to the line labeled linename.

Syntax
Syntax 1: Goto linename
Syntax 2: Goto Line linename
Syntax 3: Go linename
Syntax 4: Go To linename
Syntax 5: Go To Line linename
Table: GOTO Parameter
Parameter

Description

linename

Any line label created with the LINE
statement. Must be in the same program.

Examples
Example 1
In the following looping program, the GOTO statement with IF..THEN controls the
heating and cooling processes:
Program File
Line Beginning
If Temp is less than 68 then Goto Heating
If Temp is greater than 76 then Goto Cooling
Line Heating
Turn on Heater1
Goto Beginning
Line Cooling
Turn on Cool1
Goto Beginning
Both Heating and Cooling are line labels. When the temperature changes, GOTO
sends control to the appropriate line.
The controller then executes instructions in the labeled line.
Notice that the GOTOs have been strategically placed so the controller executes
some statements and skips others.
Example 2
You can include the word LINE in front of the line name, as follows:
Program File
Line 1
Start Fan1
Goto Line 2
Technical
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Line 2
If Fan1_Status is on then Goto Line Shutdown
Line Shutdown
If Zone1 Temp is less than 60 then
Stop Fan1
Goto Line 1
Endif
Example 3
You can leave out TO and type only GO:
Program File
Line Beginning
If Temp is less than 68 then go Heating
If Temp is greater than 76 then go Cooling
Line Heating
Turn On Heater1
Go Beginning
Line Cooling
Turn On Cool1
Go Beginning
Example 4
You can separate GO and TO, as follows:
Program File
Line Beginning
If Temp is less than 68 then Go to Heating
IF Temp is greater than 76 then Go to Cooling
Line Heating
Turn Heater1
Go to Beginning
Line Cooling
Turn On Cool1
Go to Beginning
Example 5
You can separate GO and TO, and include LINE as well:
Program File
Line Beginning
If Temp is less than 68 then Go to Line Heating
If Temp is greater than 76 then Go to Line Cooling
Line Heating
Turn On Heating1
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Go to Line Beginning
Line Cooling
Turn On Cool1
Go to Line Beginning
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IF...THEN...ELSE
IF...THEN...ELSE carries out a given statement or series of statements if the
expression is TRUE.
IF...THEN...ELSE can also carry out a given statement or series of statements if the
given expression is FALSE.
For all formats, the following actions take place:
• If the expression is TRUE, the controller carries out the statement or
statements following THEN.
• If the expression is FALSE, the controller skips those statements after THEN
and does either of these actions:
– Carries out the statements after ELSE (if ELSE is used).
– Moves on to the next statement after the IF..THEN block.
Whether the expression is TRUE or FALSE, when the IF..THEN statement is
complete, program flow goes to the statement following the IF..THEN statement
unless the flow is directed to another line using GOTO, BREAK, or CONTINUE.
If you have multiple statements after THEN, they must occur on consecutive
(physical) lines, and the end of the statement must be marked with ENDIF.
Here are some general rules you should follow for all formats:
• IF and THEN must always be on the same physical line.
• THEN can be followed by one statement on the same physical line or many
statements on the physical lines that follow.
• If a multi-line statement, ELSE must always be on a physical line by itself
(Syntax 4).
• ELSE can be followed by one statement on the same physical line or multiple
statements on the physical lines that follow (Syntax 4).
• ENDIF is required to close an IF..THEN block when multiple statements occur
after THEN or when one or more statements occur after ELSE.
• When you use an IF statement after THEN, that statement must be nested
under THEN and end with ENDIF. (See Example of an IF statement after THEN,
below.)

Syntax
Syntax 1:
If expression then statement
Syntax 2:
If expression then
statement
statement
statement
..
ENDIF
Syntax 3:
If expression then statement else statement
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Syntax 4:
If expression then
statement
statement
statement
...
Else
statement
statement
statement
...
Endif
Table: IF...THEN...ELSE Parameters
Parameter

Description

expression

Any number or expression. The expression
can be a TRUE or FALSE comparison.

statement

Any complete instruction that tells the
program what to do next or what action to
take.

Examples
Example of Syntax 1
To take a single action if the expression is TRUE, you use Syntax 1, the single-line
IF..THEN statement:
Program File
If TOD >= 1200 then Goto Noon
If the time of day is greater than 12:00 noon, then program flow moves to the
NOON line. Otherwise, the program continues with the next statement.

Note
• If you put THEN on a separate physical line from IF, a syntax error occurs.
Example of Syntax 2
To take several actions if the expression is TRUE, and take no action if the
expression is FALSE, you use Syntax 2:
Program File
If Wkd = Mon and TOD > 800 and TOD < 1600 then
Run the HeaterProg
Run the FanCheckProg
Stop the PumpProg
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Endif
If the expression is FALSE, the controller ignores the statements following THEN
and moves to the statement after ENDIF.
Example of Syntax 3
To take a single action if an expression is TRUE and another single action if the
expression is FALSE, you use Syntax 3:
Program File
If TOD > 800 & TOD < 1700 then Run DayPrg else Run NiteProg
Notice that IF, THEN, and ELSE must all be on one line in this format.
Example of Syntax 4
To take several actions if the expression is TRUE or take several others if the
expression is FALSE, you use Syntax 4:
Program File
If Temp < 72 and Pump.Stat is off then
Turn on the Fan
Close the Damper
Else
Turn off the Fan
Open the Damper
Endif
ELSE stands on a line by itself in this format, and the end of the IF.. THEN..ELSE
statement must be marked by ENDIF.
Example of nested IFs
IF statements can be included (nested) within other IF statements.
Program File
If the Wkd is Either Saturday OR Sunday then
Set Occupancy to Off
Stop the DailyProgram
If the Temp is Greater Than 70 then
Turn On the Fan
Open the Damper
Else
Turn OFF the Fan
Open the Damper
Endif
Else
Set Occupancy to On
Start the DailyProgram
Endif
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Notice that each IF ends with an ENDIF. The inner (indented) ENDIF goes with the
inner IF and ELSE, the outer ENDIF with the outer IF and ELSE.
The ELSE and ENDIF that belong to the indented IF are aligned under that IF.
Notice that the last IF ends first.
Example of an IF statement after THEN
Take a look at the following statement with an IF after THEN:
Program File
If the Wkd is Sat then if the Hour is 1 then Goto 1 else Goto 2
Which IF does the ELSE belong to? In this case the ELSE belongs to the second IF.
Why? Because ELSE belongs to the closest previous IF on the same physical line.
An IF..THEN statement that starts right after THEN is always a self-contained
statement that ends on that physical line.
To make the ELSE belong to the first IF, you must form a nested IF arrangement, as
follows:
Program File
If the Wkd is Sat then
If the Hour is 1 then
Goto 1
Endif
Else
Goto 2
Endif
In this nested IF statement, the ELSE belongs with the first IF.
Example of a nonzero value number
Program File
If 10 then start Burner
Here, since 10 is a nonzero value, 10 is interpreted as TRUE and causes the burner
to fire up.

Caution
• Be careful when programming with IF..THEN..ELSE statements if the number
is any nonzero value. When this occurs, the number is interpreted as TRUE
and the THEN block is executed.
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MOVE
Alias: MODULATE
MOVE converts engineering units to electrical units to control the output point,
using the top and bottom of scale for that point.
Set the point or points in output_point_list to number.
The percent sign is optional.

Syntax
MOVE output_point_list TO number
MOVE output_point_list TO number %
Table: MOVE Parameters
Parameter

Description

output_point_list

One or more output point names or variables
with commas between them. Top and
bottom of scale must be set for each point.

number

Any number or expression, including a date
and time or name that stands for one.

Products Supported
CX series, BACnet series, CMX series, SCX series, TCX series, LCX series, ACX
series, DCX 250, Automation Server, Enterprise Server

Examples
Example 1
If Valve2 has engineering units of 0 to 90 degrees, and the corresponding electrical
units are 0 to 20 mA, when you move the setting of Valve2 to 45, the electrical unit
sets to 10 mA. To have the engineering units automatically converted to electrical
units, you use MOVE as follows:
Program File
MOVE VALVE2 TO 45
Example 2
For this valve, assume engineering units of 0 to 1 where 0 is closed and 1 is open
and corresponding electrical units of 0 to 20 mA. Moving the setting of Valve2 to
50% gives .5. At .5, the valve is set to the corresponding value of 10 mA.
Program File
MODULATE VALVE2 TO 50%
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51.55

Repeat...Until
Repeat...Until carries out the statements in the loop until the number is true.

Syntax
Repeat
statement
statement
...
Until number
Table: Repeat...Until Parameters
Parameter

Description

statement

Any complete instruction that tells the
program what to do next or what action to
take.

number

Any number or expression, including a date
and time or name that stands for one.

The statements within the loop always execute at least once before the expression
is evaluated.

Examples
You want to print all the values in an array:
Program File
Numeric Count
Count = 1
Repeat
Print OutsideAir [Count]
Count = Count + 1
Until Count = OutsideAir_Size
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RETURN
In a function, the RETURN keyword controls the calling program, returns and sends
the number to the calling program, and returns the contents of the variable.
If you expect to use the results of a calculation in more than one program, you set
up a function file and put the calculation instructions inside, thus creating a function.
When you need the function in a program, you call the function by using the
function variable as if that function were any other keyword verb.
Later, the RETURN statement tells the function the value to return to the calling
program.
Make sure to return a number or other value when you want to use the returned
value in the calling program.

Syntax
Return
Return number
Table: RETURN Parameter
Parameter

Description

number

(Optional) Any number or expression,
including a date and time or name that
stands for one.

Examples
Example 1
You use RETURN without an expression to return to the calling program without
passing parameters. You might do that with a function that contains a series of
actions to be carried out, as in the SHUTDOWN function shown below:
Function File
Turn off the Heat
Turn off the Fan
Run Pump, Cooling
Return
In this case, RETURN returns you to the program that called the SHUTDOWN
function, returning a numeric 0 because you supplied no arguments on the
RETURN statement.
The statement that calls SHUTDOWN in the calling program looks like this:
Program File
Shutdown ()
Example 2
To create a function called GetArea that calculates the cross-sectional area of a
circle, name the function file GetArea and enter the following in the function file:
Function File
ARG 1 radius
04-16006-04-en, March 2015

Technical
1715

51 Script Programming
51.56 RETURN

Return (3.14159 * (radius ^ 2))
You pass the radius into the function file from the calling statement in the main
program. Here is a sample calling statement:
Program File
VOL = GetArea(radius) * LEG
This statement calls the GetArea function, giving the radius value, which the
function requires to calculate the area.
Example 3
Create a function that uses a diameter as an argument to calculate and return the
value of the circumference.
Function File
ARG[1] diameter
Numeric Circumf
Circumf = 3.14159 * diameter
Return (Circumf)
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SELECT CASE
SELECT CASE executes one or more statements, depending on the value of a
test_expression.

Syntax
Select Case test_expression
Case expression_list
statement_list
Case expression_list
statement_list
...
Case Else
else_statement_list
EndSelect
Table: SELECT CASE Parameters
Parameter

Description

test_expression

Any numeric, string, or datetime expression.

expression_list

A list of one or more expressions, separated
by commas.

statement_list

One or more statements to execute if
test_expression matches any expression in
the corresponding expression_list.

else_statement_list

One or more statements to execute if
test_expression matches any expression in
corresponding expression_list.

If test_expression matches any expression in CASE expression_list, then the
statements following that CASE clause are executed up to the next CASE clause, if
any, or up to EndSelect. At least one CASE expression_list clause is expected.
The CASE ELSE clause is used to execute the statements in else_statement_list if
test_expression does not match any expression in any of the CASE expression_list
clauses. The CASE ELSE clause is not required. However, you should include the
clause anyway to catch unexpected test_expression values.
Once the statements in the statement_list or else_statement_list have been
executed, the statement right after the EndSelect is the one to execute next.
Expressions can be numeric, string, or datetime.

Examples
Example 1
Program File
Select Case Weekday
Case Monday, Tuesday
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Print "Run Mon_Tue Report"
Case Wednesday thru Friday
Print "Run Wed_Thu_Fri Report"
Case Else
Print "Run Weekend Report"
EndSelect
Example 2
Program File
Numeric ReportId
Select Case ReportId
Case 1
Print "Run First Report"
Case 2, 3, 5 thru 10, 15
Print "Run Special Report"
Case 20
Print "Run Final Report"
Case Else
Print "Invalid Report Id"
EndSelect
Example 3
Program File
Select Case Numeric1 Description
Case Numeric2 Description
Print "Numeric1 and Numeric2 have the same description”
Case “West Building”
Print "Numeric1 is the West Building”
Case Else
Print "Numeric1 is not the West Building”
EndSelect
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STOP
Aliases: CLOSE, SHUT
With an output point, STOP actually stops the piece of equipment. With an input
point, STOP sets the point to the bottom of the defined scale. With a numeric point,
STOP sets the point to the lowest number in the controller system. You might STOP
an input after using the RUN keyword in order to test whether the input is active.

Syntax
Stop point_list
Sets the point (or points) to bottom of its defined scale, turns the equipment off, and
controls the equipment through the point. You can use this statement in a program
to turn off a piece of equipment.
Table: STOP Parameters
Parameter

Description

point_list

Usually any defined Output point or list of
points. The statement is not designed for
other types of points, but you can stop an
input or numeric point.

Examples
You can STOP a program from inside a program in response to a certain set of
conditions. For example, to halt the HEATPROG after 8 PM:
Program File
If TOD > 2000 then stop the HeatProg
If you do not name a program after STOP, the controller assumes you mean the
current program.
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WAIT
Alias: Delay
WAIT makes a program's execution wait for a specified number of seconds and
then resume right after the WAIT command statement.

Syntax
WAIT number
Table: WAIT Parameter
Parameter

Description

number

Any expression that results in a number.
Interpreted as the number of seconds to
wait.

Products Supported
Automation Servers and Enterprise Servers

Examples
Wait 5 'waits for 5 seconds
Wait (3) 'waits for 3 seconds
Delay 10 'waits for 10 seconds

Restrictions
You can only use the WAIT keyword in the following situations:
• At the Server level (Automation Server and Enterprise Server)
• In a Script program and not in a Script function

Tip
WAIT is not supported inside a For loop.
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WHILE
WHILE carries out the instructions in the statements within the loop over and over
again as long as the given number is TRUE.

Syntax
While number
statement
statement
...
Endwhile
Table: WHILE Parameters
Parameter

Description

statement

Any complete instruction that tells the
program what to do next or what action to
take.

number

Any number, expression, or variable whose
value determines if the WHILE loop is
executed. If the value is TRUE (non-zero) the
WHILE loop is executed. If the value is
FALSE (zero), the WHILE loop is not
executed. If the value is a variable, the value
can be changed inside the WHILE loop to
cause the loop to terminate.

Examples
Initialize a 10 element manual array:
Program File
Numeric Counter
Set Counterto 1
While Counter <= 10
ManualArray[Counter] = Counter*10
Counter = Counter + 1
Endwhile
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Qualifier Statements
Qualifier statements assist in defining input, output, and public variables.

51.61.1

INPUT
INPUT is a binding qualifier that identifies a variable declaration as an input variable.
You can bind an input variable to an object property outside of the program. The
input variable takes on the same value as the property it is bound to. You cannot
set an input variable's value.
For more information, see section 51.62 “INPUT” on page 1721..

51.61.2

Buffered
Buffered is used exclusively as a qualifier for an input variable to indicate that the
variable can hold one or more buffered values. The type of input variable may be
Numeric, String, or DateTime.
For more information, see section 51.63 “Buffered ” on page 1722.

51.61.3

OUTPUT
OUTPUT is a binding qualifier that identifies a variable declaration as an output
variable. You can bind an output variable to an object property outside of the
program. When the output variable is set, the bound property value will be set to the
same value.
For more information, see section 51.64 “OUTPUT” on page 1723..

51.61.4

PUBLIC
PUBLIC is a binding qualifier that identifies a variable as a public variable. You can
modify a public variable from outside a Script program, such as from a graphic.
For more information, see section 51.65 “PUBLIC” on page 1724..
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INPUT
INPUT is a binding qualifier that identifies a variable declaration as an input variable.
You can bind an input variable to an object property outside of the program. The
input variable takes on the same value as the property it is bound to. You cannot
set an input variable's value.

Syntax
variable_declaration input namelist
Table: INPUT Parameters
Parameter

Description

variable_declaration

The keyword Numeric, String, or Datetime
which defines the type of input variable.

namelist

The name of the input variable you are
defining, or a series of input variables
separated by commas.

Examples
Program File
If you have a program that controls a fan based on the value of a temperature input
point, you define an input variable to bind to the input's value property.
Numeric_input Temp_DegF
If Temp_DegF is greater than 75 then
Turn Fan On
Endif
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Buffered
Buffered is used exclusively as a qualifier for an input variable to indicate that the
variable can hold one or more buffered values. The type of input variable may be
Numeric, String, or DateTime.

Note
The buffering of values is performed on a First-In, First-Out basis (that is, a
queue).

Syntax
type buffered input variable_name
Table: Buffered Parameters
Parameter

Description

type

The keyword Numeric, String, or DateTime
which defines the type of input variable.

variable_name

The name of the input variable you are
defining, or a series of input variables
separated by a comma.

Example
You declare a buffered input variable (BIn1) and a pair of output variables in this
sample program. BIn1 has the same value every time it is used as expected.

Note
Buffered inputs are supported only in Automation Server and Enterprise Server
programs. They are not supported in functions, or on b3 BACnet controllers.
Program File
Numeric Buffered Input BIn1
Numeric Buffered Input BIn2
Numeric Output Out1
Out1 = BIn1 + BIn2
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OUTPUT
OUTPUT is a binding qualifier that identifies a variable declaration as an output
variable. You can bind an output variable to an object property outside of the
program. When the output variable is set, the bound property value will be set to the
same value.

Syntax
variable_declaration output namelist
Table: OUTPUT Parameters
Parameter

Description

variable_declaration

The keyword Numeric, String, or Datetime
which defines the type of output variable.

namelist

The name of the output variable you are
defining, or a series of output variables
separated by commas.

Examples
Program File
If you have a program that controls a thermostat temperature, you define an output
variable to bind to the thermostat's temperature property.
Numeric output Thermostat_Temp_DegF
Thermostat_Temp_DegF = 72.5
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PUBLIC
PUBLIC is a binding qualifier that identifies a variable as a public variable. You can
modify a public variable from outside a Script program, such as from a graphic.
Public behaves like an output variable, so you may bind the public variable to the
value of a point, or to the input variable of a Script program as you would with any
output variable. Unlike an output variable, you do not have to use the force
capability to modify Public from the Script property grid, or from a graphic.
You should use the Public binding qualifier when you need to directly modify that
variable from the Script property grid (that is, modify the value the Public binding
variable is bound to). Unlike an output variable, you can manually change the value
of the public variable from a graphic.

Syntax
variable_declaration public namelist
Table: PUBLIC Parameter
Parameter

Description

variable_declaration

The keywords Numeric, String, or Datetime
which defines the type of public variable.

namelist

The name of the public variable you are
defining, or a series of output variables
separated by commas.

Examples
Program File
Assume you want to set an output in your Script program using the PUBLIC
variable.
Numeric public ReceivedValue
Numeric Output OutputValue
Set OutputValue to ReceivedValue
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Expressions
Instructions that consist of mathematical operations are called expressions.
Expressions can also be item names or constants that return a numeric or string
result.

51.66.1

Numeric Expressions
Numeric expressions always result in a number. Numeric constants and variables
are expressions. Expressions can also be mathematical calculations that result in a
number or comparisons that produce a TRUE or FALSE response.
The following expressions are valid numeric expressions:
• 2
• SQRT (9)
• 900 DIVIDED BY 8
• WKD IS GREATER THAN MONDAY

51.66.2

String Expressions
String expressions are textual expressions that always result in a string of
characters enclosed in quotation marks. String constants and string variables are
also expressions. String expressions can be combinations that result in a string of
characters.
The following expressions are valid string expressions:
• “WARNING- HIGH TEMPERATURE”
• LEFT (“TEST”, 1)
• “THE NUMBER OF ERRORS IS”, TOTAL1
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51.67

Variables
A variable is a run-time (dynamically changing) property of an object.
Script supports program, system, and runtime variables.

51.67.1

Program Variables
Variables are names that represent numbers, words, or dates and times. Unlike a
constant, a variable has a value that changes or varies.
For more information, see section 51.69 “Program Variables” on page 1728..

51.67.2

System Variables
System variables are objects that the system sets and updates automatically.
System variables are controlled by the system and cannot be changed by the user.
For more information, see section 51.73 “System Variables” on page 1734.

51.67.3

System Variable Keywords
Values that change are represented by system variables. The controller
automatically updates the value of these variables.
For more information, see section 51.79 “System Variable Keywords” on page
1740.

51.67.4

Script Runtime Variables
Script runtime variables are read-only properties that display information about the
state of a program.
For more information, see section 51.74 “Script Runtime Variables” on page 1735.
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51.68

Declaring a Variable
You declare local program variables at the beginning of the Script program or
function where the variables are used.
For more information, see section 51.70 “Local Program Variables” on page 1729.

To declare a variable
1. In Script Editor, declare the variable you want to use in the program or
function:
• Declare the variable using the type keyword Numeric, String, or DateTime
before the name of the variable.
• Declare the variable using the binding keyword Input, Output, or Public
after the type keyword, and before the name of the variable, to enable
bindings to the variable.

You have now declared the variables in your Script program or function. These
declarations are then followed by one or more program lines or instructions that
specify the operations to perform.
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51.69

Program Variables
Variables are names that represent numbers, words, or dates and times. Unlike a
constant, a variable has a value that changes or varies.

51.69.1

Local Program Variables
Local program variables are related to system variables. Unlike system variables,
which are known to all controllers in the system, local program variables are only
known to the program where they are defined. You define each local variable at the
beginning of the program where they are used. For example, you can bind a local
program variable to a server variable, an I/O point, or a local program variable of
another program in order to allow them to read or change values in the system.
For more information, see section 51.70 “Local Program Variables” on page 1729.

51.69.2

Program Arrays
A Script array is a group of variables of the same size that shares a single name, but
is broken up into numbered cells, called elements.
For more information, see section 51.72 “Program Arrays” on page 1733.

51.69.3

Variables Pane Types
The types of variables displayed in the Variables Pane include Integer, Float,
Boolean, String, or DateTime, with Float as the Default value. Each of these types
are applicable to numeric variables only.
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51.70

Local Program Variables
Local program variables are related to system variables. Unlike system variables,
which are known to all controllers in the system, local program variables are only
known to the program where they are defined. You define each local variable at the
beginning of the program where they are used. For example, you can bind a local
program variable to a server variable, an I/O point, or a local program variable of
another program in order to allow them to read or change values in the system.

Note
• Script supports characters at or below ASCII 127. Additional characters are
not supported and are replaced by a question mark (?).

51.70.1

Local Program Variable Declaration
There are two formats available for the Local Program Variable Declaration Line:
Type Local_Variable Name[array_index]
Type Binding_Qualifier Local_Variable Name
In each format, you can use one or more local variables.

Note
• The array index option is not supported for binding variables.
Examples
Numeric A
Datetime D
String S
Numeric Input A1
Numeric Input A2, A3, A4
Numeric Input A2, A3, A4
String Input S1
Datetime Input DT1
Numeric Output B1
String Output outstr1
Datetime Output outdt1
Numeric Fan_SP [20], Temp [20]
You can declare local variable types using the following keyword statements:
• Numeric
• String
• DateTime
• Function
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• WebService

Numeric keyword
The Numeric keyword assigns the name that follows as a local numeric variable:
Numeric RateOfRise

String Keyword
The String keyword assigns the name that follows as a local string variable:
String DirtyFilterMsg

DateTime Keyword
The DateTime keyword assigns the name that follows as a local variable that
accepts a date and time:
DateTime LocalDateTime

Function Keyword
The Function keyword assigns the name that follows as a local variable, which you
bind to a Script user-defined function.
Function MyFunction

WebService Keyword
The WebService keyword assigns the name that follows as a local variable, which
you bind to a Script Web Service object.
WebService wsCalculator

51.70.2

Local Program Variables and Bindings
To enable a local program variable to bind to the property of an object, you must
include an additional keyword to qualify your declaration. You use the binding
keyword Input, Output, or Public after the type, and before the name of the local
variable.
These binding keywords indicate either the inputs or outputs of the program, or the
public variables that use property bindings outside of the program:
• An Input variable indicates that the program uses the variable to read the
object property that variable is bound to. For this type, the program is not
allowed to set the value of the local variable because the variable is read-only.
• An Output variable indicates that the program uses the variable to set the
object property that variable is bound to.
• A Public variable indicates that the program makes the variable accessible to
other applications. You can then allow an application to bind its output variable
to that public variable.

Tip
The Input and Output qualifiers apply only to the Numeric, String, and DateTime
types.

Technical
1732

04-16006-04-en, March 2015

51 Script Programming
51.70 Local Program Variables

The type of the object property you bind a local variable to must match the type of
the local variable you plan to bind to. For example, you must bind a Numeric local
variable to object property types such as integer, double, float, digital, and
enumeration. Similarly, you must also bind strings to string type properties, and
datetimes to datetime properties.
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51.71

Variables Pane Types
The types of variables displayed in the Local or Binding Variables panes include
Integer, Float, Boolean, String, or DateTime, with Float as the Default value. Integer,
Float or Boolean types apply to a numeric variable only.
Table: Types of Variables
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Declared

Variable

Description

Numeric

Float

Use when binding to a
floating point property, such
as an Analog Value

Int

Use when binding to an
integer property, such as a
Multistate Value

Bool

Use when binding to a
Boolean (true or false)
property, such as a Digital
Value

String

String

Use when binding to a String
value.

DateTime

DateTime

Use when binding to a
DateTime value.
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51.72

Program Arrays
A Script array is a group of variables of the same size that shares a single name, but
is broken up into numbered cells, called elements.
You refer to each element in the array using a number called an index.
For example, if we had an array with 8 elements called CLOCK, you can refer to its
eight possible values as CLOCK[1], CLOCK[2], CLOCK[3], CLOCK[4], and so on.
Table: Example of an Eight Element Array
Index

Value

1

8.00

2

8.51

3

9.00

4

9.62

5

10.00

6

10.75

7

11.00

8

11.25

CLOCK[1] is 8.00, CLOCK[2] is 8.51, CLOCK[3] is 9.00, and so on. Each entry in an
array is referred to as an element. An array can contain up to 32,767 elements.
You can also put a numeric variable in place of the index number, such as
CLOCK[COUNT]. The variable is called an index variable.
When you define an array variable, you must specify a type (numeric, string, or
datetime) and the number of elements. The following statement defines (declares) a
local array called “Temperature” as numeric with 50 elements:
NUMERIC TEMPERATURE[50]
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51.73

System Variables
System variables are objects that the system sets and updates automatically.
System variables are controlled by the system and cannot be changed by the user.
Continuum devices, such as a b3 (with unchanged firmware), are the only
exception. The Date and Hour system variables can be changed in a b3 device with
unchanged firmware. For more information, see section 51.79 “System Variable
Keywords” on page 1740.
The following table provides a complete list of the system variables for Building
Operation.
Table: System Variables
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Name

Description

Date

Retrieves current system date and time so
that you can then store that date and time in
a variable.

DayofMonth

Supplies the current day of the month from 1
to 31.

DayofYear

Supplies the current day of the year between
1 and 366.

Hour

Indicates the current hour, from 0 to 23.

HourofDay

Indicates the time in decimal form from 0 to
23.99.

Minute

Supplies the minute of the current hour, from
0 to 59.

Month

Supplies the current month of the year, from
January to December.

Scan

Indicates the controller’s last scan time in
seconds.

Second

Supplies the number of seconds of the
current minute, from 0 to 59.

TimeofDay

Supplies the time of day with the hour and
minute in the format HHMM where HH is a
number between 0 and 23 and MM is a
number between 0 and 59.

Weekday

Supplies the current day of the week, from
SUNDAY through SATURDAY.

Year

Supplies the current year.
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51.74

Script Runtime Variables
Script runtime variables are read-only properties that display information about the
state of a program.
Script uses four different runtime variables.

51.74.1

TS
TS is a Script program runtime property that contains the number of seconds (Time
in Seconds) that have elapsed since the program has been on the current line.
TS stands for Time in Seconds.
For more information, see section 51.75 “TS” on page 1736..

51.74.2

TM
TM is a Script program runtime property that contains the number of minutes (Time
in Minutes) that have elapsed since the program has been on the current line.
TM stands for Time in Minutes.
For more information, see section 51.76 “TM” on page 1737..

51.74.3

TH
TH is a Script program runtime property that contains the number of hours (Time in
Hours) that have elapsed since the program has been on the current line.
TH stands for Time in Hours.
For more information, see section 51.77 “TH” on page 1738..

51.74.4

TD
TD is a Script program runtime property that contains the number of days (Time in
Days) that have elapsed since the program has been on the current line.
TD stands for Time in Days.
For more information, see section 51.78 “TD” on page 1739..
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51.75

TS
TS is a Script program runtime property that contains the number of seconds (Time
in Seconds) that have elapsed since the program has been on the current line.
TS stands for Time in Seconds.

Syntax
TS

Example
To allow for a 90-second valve stroke time, see if 90 seconds have elapsed since
you opened the valve.
Program File:

The controller measures 90 seconds starting the instant that the program is on the
line making the request for elapsed time.
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51.76

TM
TM is a Script program runtime property that contains the number of minutes (Time
in Minutes) that have elapsed since the program has been on the current line.
TM stands for Time in Minutes.

Syntax
TM

Example
To have a 5-minute warmup of a fan before turning on the pump, you would check
to see if the fan has been running for 5 minutes after activation.
Program File:

The controller measures 5 minutes starting the instant that the program is on the
line making the request for elapsed time.
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51.77

TH
TH is a Script program runtime property that contains the number of hours (Time in
Hours) that have elapsed since the program has been on the current line.
TH stands for Time in Hours.

Syntax
TH

Example
To have the lead fan run 1 hour then run the lag fan, you would check to see if the
fan has been running for 1 hour after activation.
Program File:

The controller measures 1 hour starting the instant that the program is on the line
making the request for elapsed time.
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51.78

TD
TD is a Script program runtime property that contains the number of days (Time in
Days) that have elapsed since the program has been on the current line.
TD stands for Time in Days.

Syntax
TD

Example
In order to have a lead pump run for 3 days, then turn on the lag pump, you would
check to see if the pump has been running for 3 days after activation.
Program File:

The controller measures 3 days starting the instant that the program is on the line
making the request for elapsed time.
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51.79

System Variable Keywords
Values that change are represented by system variables. The controller
automatically updates the value of these variables.
Script uses two different types of system-variable keywords: date and time and
runtime variable keywords.

51.79.1

Date and Time System Variables
Date and Time System variables represent changeable time of day and calendar
values.
Date and Time System variables include the following keywords:
• DATE
• DAYOFMONTH
• DAYOFYEAR
• HOD
• HOUR
• MINUTE
• MONTH
• SECOND
• TOD
• WEEKDAY
• YEAR
For more information, see section 51.80 “Date and Time System Variables ” on
page 1741..

51.79.2

Runtime System Variables
Runtime system variables are variables the controller maintains.
Runtime system variables include the following keywords:
• ERRORS
• FREEMEM
• SCAN
For more information, see section 51.92 “Runtime System Variables ” on page
1757..
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51.80

Date and Time System Variables
Date and Time System variables represent changeable time of day and calendar
values.
A datetime variable is a name that represents a date and time. Datetime constants,
variables, points, expressions, or functions can be compared to other datetime
items. You can retrieve the date and time from the STRTODATE function or from
the DATE system variable.

Tip
You can print out a datetime variable to see what date and time the variable
contains. However, the date and time that prints out is a predefined format you
cannot change. The date and time prints in this format (in the 24-hour clock):
MONTH DD YYYY hh:mm:ss

51.80.1

DATE
DATE retrieves the current system date and time so that you can then store them in
a variable.
The value for DATE is always the current date.
DATE is designed to be used with DIFFTIME, along with a datetime variable (defined
using the DATETIME statement).
For more information, see section 51.81 “DATE” on page 1744..

51.80.2

DAYOFMONTH
DAYOFMONTH gives the day of month from 1 to 31.
You cannot change the DAYOFMONTH. The server automatically updates this
value.
For more information, see section 51.82 “DAYOFMONTH” on page 1745..

51.80.3

DAYOFYEAR
DAYOFYEAR gives the number of the day of the year, between 1 and 366.
You cannot change the DAYOFYEAR. The server automatically updates this value
For more information, see section 51.83 “DAYOFYEAR” on page 1746..

51.80.4

HOD
HOD gives the time in a decimal form from 0.0 to 23.99.
You cannot change the HOD. The system automatically updates this value.
For more information, see section 51.84 “HOD” on page 1747..

04-16006-04-en, March 2015

Technical
1743

51 Script Programming
51.80 Date and Time System Variables

51.80.5

HOUR
HOUR gives the current hour, from 0 to 23.
If the time is 5:23:02, the hour is 5.
The system automatically updates the HOUR variable.
For more information, see section 51.85 “HOUR” on page 1748..

51.80.6

MINUTE
MINUTE gives the exact minute of the current hour, from 0 to 59.
The minute is the minute on the controller clock, so if the time is 5:23:02, the minute
is 23.
You cannot change the MINUTE. The server automatically updates this value.
For more information, see section 51.86 “MINUTE” on page 1749...

51.80.7

MONTH
MONTH gives you the current month of year, from January to December.
You cannot change the MONTH. The server automatically updates this value.
For more information, see section 51.87 “MONTH” on page 1750...

51.80.8

SECOND
SECOND gives the exact number of seconds of the current minute, from 0 to 59.
The number of seconds is as indicated by the server clock. If the time is 10:02:12,
then SECOND equals 12.
For more information, see section 51.88 “SECOND” on page 1752..

51.80.9

TOD
TOD gives the time of the day from 0 (midnight) to 2359, where 2359 is the
equivalent of 23:59 on the 24-hour clock.
The time of day is the time from the controller clock. You cannot change TOD since
the controller automatically updates that setting.
For more information, see section 51.89 “TOD” on page 1753..

51.80.10

WEEKDAY
WEEKDAY gives current day of week, from SUNDAY through SATURDAY.
When printed, the weekday is spelled out as Sunday, Monday, Tuesday,
Wednesday, and so on through Saturday.
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For more information, see section 51.90 “WEEKDAY” on page 1754..

51.80.11

YEAR
YEAR gives the current year. You cannot change the YEAR. The system
automatically updates the value.
When printed, the four-digit year is given.
For more information, see section 51.91 “YEAR” on page 1756...
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51.81

DATE
Alias: TIME
DATE retrieves the current system date and time so that you can then store them in
a variable.
The value for DATE is always the current date.
DATE is designed to be used with DIFFTIME, along with a datetime variable (defined
using the DATETIME statement).

Syntax
Date

Example
Once you have defined the datetime variable called TEMP_DATE using the
DATETIME statement, you can then set the value of that variable using the DATE
system variable, as follows:
Program file
Datetime Temp_Date
Temp_Date = Date
This way, TEMP_DATE retrieves the exact system date and time at a given
moment.
You can, for example, record the date and time that a point changes. You can use
the variable you have created in subsequent calculations.
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DAYOFMONTH
Alias: DOM
DAYOFMONTH gives the day of month from 1 to 31.
You cannot change the DAYOFMONTH. The server automatically updates this
value.

Syntax
DayOfMonth

Example
Example 1
To print out a headline that contains the date, you would use DAYOFMONTH, as
shown below:
Program File
Print "The kwh history for", MONTH, DayofMonth, "," , YEAR
The resulting header would print the actual month, day of the month, and year, like
this:
The kwh History for October 15, 2008
Example 2
To make some events occur only on particular days of each month, you could set
up an IF..THEN statement that would check for the day of the month:
Program File
If DayofMonth is between 7 and 14 then…
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51.83

DAYOFYEAR
Alias: DOY
DAYOFYEAR gives the number of the day of the year, between 1 and 366.
You cannot change the DAYOFYEAR. The server automatically updates this value

Syntax
DayOfYear

Example
Suppose on a certain date, you need to switch off the heating and switch on
cooling. You would use DAYOFYEAR to instruct the controller:
Program File
If DayofYear is 152 then
Stop the Heating_Prog
Run the Cooling_prog
Endif
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51.84

HOD
Alias: HOUROFDAY
HOD gives the time in a decimal form from 0.0 to 23.99.
You cannot change the HOD. The system automatically updates this value.

Syntax
HOD

Example
Example 1
You can use the decimal form of the time to see if the time is past 5:30 a.m.:
Program File
If HOD is greater than 5.50 then...
Example 2
A simple way to calculate the StartTime based on OutsideAir could use HOD as
follows:
Program File
If OutsideAir > 70 then Goto CoolStart
Set StartTime = (8.00 - (70-OutsideAir) * RateOfRise)
If HOD = StartTime then Goto StartBldg
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51.85

HOUR
Alias : HR
HOUR gives the current hour, from 0 to 23.
If the time is 5:23:02, the hour is 5.
The system automatically updates the HOUR variable.

Syntax
Hour

Example
To take action every day at 5:00 a.m., you would check the hour with the following
statement:
Program File
If Hour is equal to 5 then Goto Startup
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MINUTE
Alias: MIN
MINUTE gives the exact minute of the current hour, from 0 to 59.
The minute is the minute on the controller clock, so if the time is 5:23:02, the minute
is 23.
You cannot change the MINUTE. The server automatically updates this value.

Syntax
Minute

Example
Suppose you have eight programs to run every hour. To avoid customizing scan
time by running all the programs at once, you could run two programs in each
quarter of any hour:
Program File
If Minute equals 15 then
Run the System_Check
Run the Power_Usage
Endif
If Minute equals 30 then
Run the Temp_Check
Run the Temp_Rept
Endif
If Minute equals 45 then
Run the Fan_Check
Run the Damper_Check
Endif
If Minute equals 0 then
Run the Heater_Check
Run the CO_Check
Endif
The SYSTEM_CHECK and POWER_USAGE programs now run at 15 minutes after
the hour every hour of every day, 24 hours a day and 365 days a year.
The TEMP_CHECK and TEMP_REPT programs now run at 30 minutes after the
hour every hour of every day, 24 hours a day and 365 days a year.
The FAN_CHECK and DAMPER_CHECK programs now run at 45 minutes after the
hour every hour of every day, 24 hours a day and 365 days a year.
The HEATER_CHECK and CO_CHECK programs now run on the hour every hour
of every day, 24 hours a day and 365 days a year.
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51.87

MONTH
Alias: MTH
MONTH gives you the current month of year, from January to December.
You cannot change the MONTH. The server automatically updates this value.
When printed, the month is spelled out as January, February, March, and so on
through December. You can also compare the MONTH to:
• The numbers (1 through 12).
• The abbreviated three-letter names (first three letters).
All values for MONTH are listed below:
Table: MONTH Values
Constant

Short Name

Long Name

1

JAN

JANUARY

2

FEB

FEBRUARY

3

MAR

MARCH

4

APR

APRIL

5

MAY

MAY

6

JUN

JUNE

7

JUL

JULY

8

AUG

AUGUST

9

SEP

SEPTEMBER

10

OCT

OCTOBER

11

NOV

NOVEMBER

12

DEC

DECEMBER

Syntax
Month

Example
Example 1
You can use the spelled out (long) names for printing or for comparing to an actual
month:
Program File
If Month is December then print Month
Output
Saturday
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Example 2
You can use the short names for comparing the month:
Program File
If Month is either JUN, JUL, AUG or SEP then…
Example 3
You can use the constants 1 through 12 for comparing the month:
Program File
If Month is 2 then…
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51.88

SECOND
Alias: SEC
SECOND gives the exact number of seconds of the current minute, from 0 to 59.
The number of seconds is as indicated by the server clock. If the time is 10:02:12,
then SECOND equals 12.

Syntax
Second

Example
If you want to take action every time 50 seconds of the minute have gone by, you
enter the following program statement:
Program File
If Second is greater than 50 then…
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51.89

TOD
Alias: TIMEOFDAY
TOD gives the time of the day from 0 (midnight) to 2359, where 2359 is the
equivalent of 23:59 on the 24-hour clock.
The time of day is the time from the controller clock. You cannot change TOD since
the controller automatically updates that setting.

Syntax
TOD

Example
Example 1
To check to see if the time of day is past 5:00 AM, you enter the following program
line:
Program File
If TOD is greater than 500 then…
Example 2
When you print out TOD, as in the following example, you always receive the 24hour time:
Print TOD
The time displays as follows:
20.000 (that means 8:00:00 PM)

04-16006-04-en, March 2015

Technical
1755

51 Script Programming
51.90 WEEKDAY

51.90

WEEKDAY
Alias: WKD
WEEKDAY gives current day of week, from SUNDAY through SATURDAY.
When printed, the weekday is spelled out as Sunday, Monday, Tuesday,
Wednesday, and so on through Saturday.
You can also compare the WEEKDAY to:
• The numbers 1 through 7 (1 equal to Sunday).
• The abbreviated three-letter names (first three letters).

Note
• If you use both Script and Function Block programming, for example, when
using control sequences, be aware of the following. Script uses Sunday as
the first day of the week and assigns a value of 1 to that day, while Function
Block uses Monday as the first day of the week and assigns Monday a value
of 1.
All values for the weekday are as follows:
Table: WEEKDAY Values
Constant

Short Name

Long Name

1

SUN

SUNDAY

2

MON

MONDAY

3

TUE

TUESDAY

4

WED

WEDNESDAY

5

THU

THURSDAY

6

FRI

FRIDAY

7

SAT

SATURDAY

Syntax
Weekday

Example
Example 1
You can spell out names for printing or for comparing to an actual day:
Program File
If Weekday is Saturday then Print Weekday
Output
Saturday
Example 2
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You can use the short name or the constants 1 through 7 for comparing the
weekday in an IF statement:
Program File
If Weekday > Sun OR Weekday < 7 then…
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51.91

YEAR
Alias: YR
YEAR gives the current year. You cannot change the YEAR. The system
automatically updates the value.
When printed, the four-digit year is given.

Syntax
Year

Example
To take an action in the distant future, such as sending a reminder message to
check certain pieces of equipment, you use the YEAR system variable to test the
year:
Program File
If year is 2010 THEN PRINT "Welcome to the year Two Thousand and
Ten."
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51.92

Runtime System Variables
Runtime system variables are variables the controller maintains.

51.92.1

ERRORS
ERRORS, a variable the controller maintains, indicates the number of system errors
pending. The number increments (increases by one) each time a new error occurs
and is cleared when manually reset to zero (0).
For more information, see section 51.93 “ERRORS” on page 1758..

51.92.2

FREEMEM
FREEMEM contains the number of bytes of free memory in the largest single
contiguous memory block on a controller.
For more information, see section 51.94 “FREEMEM” on page 1759..

51.92.3

SCAN
SCAN indicates the length in seconds of the last interpreter scan interval, which the
program updates regularly.
For more information, see section 51.95 “SCAN” on page 1760..
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51.93

ERRORS
ERRORS, a variable the controller maintains, indicates the number of system errors
pending. The number increments (increases by one) each time a new error occurs
and is cleared when manually reset to zero (0).
The controller automatically updates ERRORS. You can only reset the controller to
zero.
The controller increments ERRORS when any of the following occurs:
• A Script program error disables a program (which also sets the program
ERROR attribute).
• The controller’s input reference voltage goes out of its normal range, usually
when you apply too much voltage to one or more inputs.
• The controller’s output reference voltage goes out of its normal range, usually
when drawing too much current from one or more inputs.
• The server has trouble transmitting or receiving data.
• Someone resets a controller.
• Someone turns off the AC power to a controller so that the AC power shuts
down, but the battery retains memory.

Syntax
Errors

Example
Since the ERRORS variable automatically decrements after you acknowledge an
error, the value of the variable should never get very large.
In the sample program below, you set a limit to how many errors can accumulate
and generate a report on all errors if the limit is exceeded:
Program File
If Errors > 10 then
Goto Report_Error
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FREEMEM
FREEMEM contains the number of bytes of free memory in the largest single
contiguous memory block on a controller.
For system managers only. Primarily designed to be used on the command line
only, not in programs, because the value of FREEMEM does not change
dynamically. Primarily, FREEMEM is used in the programs to slow the controller
scan.

Syntax
Freemem

Example
If you want to know the size of the largest block of free memory available on a
controller, enter the following:
Program File
Print Freemem

04-16006-04-en, March 2015

Technical
1761

51 Script Programming
51.95 SCAN

51.95

SCAN
Alias: SC
SCAN indicates the length in seconds of the last interpreter scan interval, which the
program updates regularly.

Syntax
Scan

Example
To find the average number of seconds per scan, you would run the following
program once every scan after all other programs have been run.
Program File
Numeric Tot_Scan_SCS, Scan_Count, Scan_Avg
Set Tot_Scan_SCS, Scan_Count, Scan_Avg = 0
Line Totaling
Tot_Scan_SCS = Tot_Scan_SCS + Scan
Scan_Count = Scan_Count + 1
If TOD = 2359 then
Scan_Avg = Tot_Scan_SCS/Scan_Count
Print "The average scan for", WKD " is", Scan_Avg, "sec"
Set Scan_Avg = 0
Set Scan_Count = 0
Set Tot_ScSCS = 0
Endif
For each scan the program adds the seconds that scan took to the total seconds
for the day. Also for each scan, the program adds 1 to the scan counter.
At the end of the day (2359, or 11:59 PM), the program divides the scan total by the
number of scans to get the average length of the scans that day. The program then
prints the average for the day.
The numeric variables used to calculate the average number of scans per day are all
set to zero at the end of each day, so that they start at zero the next day.
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51.96

Script Functions
A function is a routine designed to carry out an often repeated task or series of
tasks. Your Script function then becomes a subroutine that can be called whenever
that particular action needs to be performed.
When a function is used to calculate or provide a value, the function “returns” the
value to the program that calls the function. A program can also provide (“pass”) the
function some values (called “arguments”) to use in calculations or actions the
program must take. Arguments (separated by commas) are included in parentheses
following the function name. Function calls require parentheses, so you should
include the parentheses even if the function is empty (that is, function ()).

Note
Script functions support up to 15 arguments.

51.96.1

Script Function Workflow
In Script, you must declare a local variable of type Function and bind it to a Script
function object within the same device (for example, server or field bus).
For more information, see section 51.97 “Script Function Workflow” on page 1762.

51.96.2

Script Functions and Programs
You create a function just like you create a program, using standard Script
keywords, and then save that function to a file.
Functions perform specific tasks or calculations that return a resulting value. They
are simple and flexible and can make programs run in a much more efficient manner
by eliminating redundant tasks.
For more information, see section 51.101 “Script Functions and Programs” on page
1767.

51.96.3

System Functions
System functions carry out a particular set of calculations or actions and can return
one or more specific values, such as Sum, Sqrt, Length, and Avg.
For more information, see section 51.107 “System Functions” on page 1774.
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51.97

Script Function Workflow
In Script, you must declare a local variable of type Function and bind it to a Script
function object within the same device (for example, server or field bus).
You do this as follows:
• Write a Script program and in that program, declare a local variable of the type,
Function. For more information, see section 51.103 “Declaring and Calling a
Script Function” on page 1770.
• Bind the local variable to the Script Function object.
For more information, see section 38.10 “Binding Values Using a Binding
Template” on page 1220.
For more information, see section 50.15 “Binding Values in Script Editor Using
a Binding Template” on page 1590.
• Use the name of that local variable to activate the function
You do so by using the Function keyword, thus enabling the program to refer to or
call the function, through its binding. This is similar to the way in which the program
calls a system function.

Tip
You can use the RETURN statement to return a value to the calling program or
function.
There are several different types of Script functions, including:
• Functions without arguments
• Functions with arguments
• Functions that return a value

51.97.1

Script Functions without Arguments
A function need not have arguments.
For more information, see section 51.98 “Script Functions without Arguments” on
page 1764.

51.97.2

Script Functions with Arguments
Functions can have valid Script expressions for arguments, including local variables
from the calling program, or function.
For more information, see section 51.99 “Script Functions with Arguments” on page
1765.
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51.97.3

Script Functions that Return a Value
In addition to returning to the calling program, RETURN can also bring back the
results of a calculation. These results are: a variable, a constant, or an expression.
For more information, see section 51.100 “Script Functions that Return a Value” on
page 1766.
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51.98

Script Functions without Arguments
A function need not have arguments. For example, you can define a function that
stops all fans and name that function FANSTOP.
Numeric Output Fan1, Fan2, Fan3, Fan4
Stop Fan1, Fan2, Fan3, AND Fan4
Return
Calling Program:
Function Fanstop
If TOD > 1800 and TOD < 800 then FanStop ( )
FANSTOP knows about the fans because they are points on the controller.
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51.99

Script Functions with Arguments
Functions can have valid Script expressions for arguments, including local variables
from the calling program, or function.
The following example shows a function that starts and stops two programs.
ARG 1 Program1
ARG 2 Program2
Start Program1
Start Program2
Return
The calling program can send any two arguments to this function that can be acted
on by START or STOP. You can start and stop any object (piece of equipment) or
program.
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51.100

Script Functions that Return a Value
In addition to returning to the calling program, RETURN can also bring back the
results of a calculation. These results are: a variable, a constant, or an expression.
The following example shows a function that returns a value. In this case, the
RETURN statement contains an expression. The function returns the value of that
expression to the program.
ARG 1 Tmp1
ARG 2 Tmp2
ARG 3 Tmp3
ARG 4 Tmp4
Numeric Total_Change
Total_Change = (Tmp1 - Tmp2) + (Tmp2 - Tmp3) + (Tmp3 - Tmp4)
Return (Total_Change/3)
As shown below, you could also give the expression a local variable name.
ARG 1 Tmp1
ARG 2 Tmp2
ARG 3 Tmp3
ARG 4 Tmp4
Numeric Total_Change, Mid_Change
Total_Change = (Tmp1 - Tmp2) + (Tmp2 - Tmp3) + (Tmp3 - Tmp4)
Mid_Change = Total_Change/3
Return Mid_Change

Note
• Use a variable instead of an expression in the RETURN statement because
the name of the variable, when created, should generally describes its
purpose.
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51.101

Script Functions and Programs
You create a function just like you create a program, using standard Script
keywords, and then save that function to a file.
Functions perform specific tasks or calculations that return a resulting value. They
are simple and flexible and can make programs run in a much more efficient manner
by eliminating redundant tasks.
If your system performs complex calculations or processes repeatedly, you can
avoid retyping these programs every time you need them by making them
functions. You can think of these functions as tools you use to build larger
programs. To determine whether you need a function, look at the kinds of actions
you repeat. For example, suppose you repeatedly test for occupancy. You can
create a function that performs the task, then call that function whenever necessary.
An example of a function is a PID loop. Some PID loops can be very large and
contain cumbersome portions of programming code. Rather than clutter up a
program with the PID code, you can create a function that contains all of the PID
code. When you need to use the PID loop, you call the PID function. As a result, the
main program is much smaller and easier to understand.
You call functions in a Script program or function by declaring a function at the
beginning of the program or function in which you would like to use that function. A
function variable is a name that represents a Script function. Any function call using
the local variable name means a call to the actual function. For more information,
see section 51.102 “Function Declarations and Statements” on page 1768.
Be sure that any local variable of type Function declared in a program or function is
bound to an actual function object. If the local variable is declared, but not properly
bound, that program does not run.

51.101.1

Function Declarations and Statements
Unlike Script programs, Script functions do not support the concept of lines as
execution units. Instead, Script functions consist of declarations and statements.
For more information, see section 51.102 “Function Declarations and Statements”
on page 1768.
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51.102

Function Declarations and Statements
Unlike Script programs, Script functions do not support the concept of lines as
execution units. Instead, Script functions consist of declarations and statements.
Declarations specify the arguments that the function takes, followed by the local
variables. Statements specify the actions the function must perform and must be
executed together. Typically, the function returns a value to the calling program.
Argument declarations begin with the ARG keyword. For example, the following
basic Script function, called myaverage, adds 3 variables and then determines their
average.
The optional comment preceded by the single quotation mark (') helps explain the
operation and purpose of the function. You can place comments either at the
beginning or end of the declaration or function as you wish.

Figure: Function Example

Once you finish creating the function, you then add a declaration (1) and a function
call (2) in the designated program to invoke that function.
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Figure: Function Declaration and Call
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51.103

Declaring and Calling a Script Function
You can declare and call a Script function in a Script program or another Script
function. For example, you include a function as a subroutine and access it
repeatedly in the same program or any other program.
For more information, see section 51.102 “Function Declarations and Statements”
on page 1768.

To declare and call a Script function
1. In Script Editor, declare the function you want to call by using the keyword
Function before the name of the function.

2. Add the function call.

You have now declared and called a function in a Script program or another Script
function.
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51.104

Creating a Script Function
You create Script functions so that you can program code that can be used in one
or several Script programs or functions.
For more information, see section 51.101 “Script Functions and Programs” on page
1767.

To create a Script function
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the Script function.
2. On the File menu, point to New and then click Program.
3. In the object type list, select Script Function.

4. In the Name box, type a name for the Script function.
5. In the Description box, type a description for the Script function.
6. Click Create.
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51.105

Declaring a Script Function Argument
You declare arguments at the beginning of the Script function where they are used.
The argument values are provided by the calling Script program or function.
For more information, see section 51.102 “Function Declarations and Statements”
on page 1768.

To declare a Script function argument
1. In Script Editor, declare the Script function arguments using the ARG
keyword.

You have now declared the arguments in the Script function. You can now add one
or more instructions that specify the operations to perform.
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51.106

Checking and Saving a Script Function
You check your Script function to ensure there are no syntax errors. You perform a
save operation to check and then save your Script function.
For more information, see section 51.101 “Script Functions and Programs” on page
1767.

To check and save a Script function
1. In Script Editor, click Check.
2. In the Check pane, double-click on an error message to go to the line of code
that contains the error.

3. Click Save to check and save your Script function.
You have now checked and saved your Script function.
The Script Editor displays the Save Successful message, even if the function
contains errors and does not compile successfully.
If you save a function that contains errors, that function will not run. The function
must have a successful check prior to running.
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51.107

System Functions
System functions carry out a particular set of calculations or actions and can return
one or more specific values, such as Sum, Sqrt, Length, and Avg.
For example, the system function SQRT returns the square root of a given number:
Result = SQRT (25)
The number on which the function operates (25) is included within the parentheses.
This function returns the value 5.

51.107.1

System Function Keywords
Script uses the following types of system function keywords:
• Buffered variable functions
• Conversion functions
• Mathematical functions
• Object functions
• Passed function
• Rounding functions
• Statistical functions
• String functions
• Time functions
• Trigonometric functions
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51.108

System Function Keywords
System functions carry out a particular set of calculations or actions and can return
one or more specific values, such as Sum, Sqrt, Length, and Avg.
Script uses the following types of system function keywords:
• Buffered variable functions
• Conversion functions
• Mathematical functions
• Object functions
• Passed function
• Rounding functions
• Statistical functions
• String functions
• Time functions
• Trigonometric functions

51.108.1

Buffered Variable Functions
Buffered variable functions perform input variable-related operations.
For more information, see section 51.109 “Buffered Variable Functions” on page
1779.

51.108.2

Conversion Functions
Conversion functions convert numeric or string variables.
Conversion functions include the following keywords:
• NUMTOSTR
• STRTODATE
• STRTONUM
For more information, see section 51.112 “Conversion Functions” on page 1783...

51.108.3

Mathematical Functions
Mathematical functions perform mathematical operations.
Mathematical functions include the following keywords:
• ABS
• EXPONENTIAL
• FACTORIAL
• LN
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• LOG
• RANDOM
• SQRT
• SUM
For more information, see section 51.116 “Mathematical Functions” on page
1788...

51.108.4

Object Functions
Object functions perform operations on mathematical objects.
Object functions include the following keywords:
• GETNAME
• ReadProperty
• Relinquish
• WriteProperty
For more information, see section 51.125 “Object Functions” on page 1799...

51.108.5

PASSED Function
The PASSED function keyword indicates whether or not the argument with the
arg_number has been passed into the current function. Returns TRUE (numeric 1) if
the argument is actually passed and FALSE (numeric 0) if not.
For more information, see section 51.130 “PASSED Function” on page 1808..

51.108.6

Rounding Functions
Rounding functions round numbers to the next integer and then return values.
Rounding functions include the following keywords:
• CEILING
• FLOOR
• ROUND
• TRUNCATE
For more information, see section 51.131 “Rounding Functions” on page 1809...

51.108.7

Statistical Functions
Statistical functions perform statistical operations.
Statistical functions include the following keywords:
• AVERAGE
• MAXIMUM
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• MAXITEM
• MINIMUM
• MINITEM
• StandardDeviation
For more information, see section 51.136 “Statistical Functions” on page 1814...

51.108.8

String Functions
String functions perform string-related operations.
String functions include the following keywords:
• ASC
• CHR
• LEFT
• LENGTH
• MID
• RIGHT
• SEARCH
• STRINGFILL
• TAB
For more information, see section 51.143 “String Functions” on page 1827...

51.108.9

Time Functions
Time functions perform time-related operations.
Time functions include the following keywords:
• DIFFTIME
• TIMEPIECE
For more information, see section 51.153 “Time Functions” on page 1839.. .

51.108.10

Trigonomentric Functions
Trigonometric functions return arccosine, arctangents, and arcsines of given
numbers.
Trigonometric functions include the following keywords:
• ACOS
• ASIN
• ATAN
• ATAN2
• COS
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• SIN
• TAN
For more information, see section 51.156 “Trigonometric Functions” on page
1843.. .
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51.109

Buffered Variable Functions
Buffered variable functions perform input variable-related operations.

51.109.1

GetBufferSize
GetBufferSize returns the current buffer size (that is, the number of buffered values)
of a passed buffered input variable.
For more information, see section 51.110 “GetBufferSize” on page 1780.

51.109.2

GetBufferedValue
GetBufferedValue gets the next available value of the passed buffered input
variable. This function returns Success or Failure.
For more information, see section 51.111 “GetBufferedValue” on page 1782.
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51.110

GetBufferSize
GetBufferSize returns the current buffer size (that is, the number of buffered values)
of a passed buffered input variable.

Note
A returned value of 0 indicates that the passed argument is not a buffered input
variable, or that there is no buffered input variable value. If two or more arguments
are passed, the program goes to Line E if one exists. When the program goes to
Line E, it indicates that an error has occurred.

Syntax
GetBufferSize (variable_name)
Table: GetBufferSize Parameter
Parameter

Description

variable_name

The name of the passed input variable
whose buffer size you are querying.

Example
You can use the following program to check the buffer size and if the number of
items in the buffer exceeds 15, empty the buffer.
Program File
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Note
This program, BufferedVariablesTest.xml, is included in the Sample Import Files
folder in the Code Library. For more information, see section 52.24 “Working with
Code Library Sample Import Files” on page 1894.
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51.111

GetBufferedValue
GetBufferedValue gets the next available value of the passed buffered input
variable. This function returns Success or Failure.

Note
If the returned value is zero, it is not a buffered input variable. If two or more
arguments are passed, the program is disabled or goes to Line E if one exists.
When the program goes to Line E, it indicates an error has occurred.

Syntax
GetBufferedValue (variable_name)
Table: GetBufferedValue Parameter
Parameter

Description

variable_name

The name of the passed input variable
whose next available value you wish to
determine.

Example
You declare two buffered input variables (BIn1 and BIn2) and two output variables in
this example. BIn1 has the same value every time it is used as expected until a call
is made to the function GetBufferedValue to obtain the next buffered value. This
example checks to see if there are any buffered values for BIn1 by calling the
GetBufferSize function and making sure that the number of buffered values is
greater than zero. Then, it gets the next available value from the buffer. BIn1
assumes that newly-obtained value.
Program File
Numeric Buffered Input BIn1
Numeric Buffered Input BIn2
Numeric Output Out1
Numeric Output Out2
Out1 = BIn1 + BIn1
Out2 = 0
While GetBufferSize (BIn2) > 0
if GetBufferedValue (BIn2) = Success then
Out2 = Out2 + Bin2 'add all buffered values
Endif
EndWhile

Technical
1784

04-16006-04-en, March 2015

51 Script Programming
51.112 Conversion Functions

51.112

Conversion Functions
Conversion functions convert numeric or string variables.

51.112.1

NUMTOSTR
NUMTOSTR converts a number in a numeric variable or other numeric form to a
string variable so the number can be used in string operations. NUMTOSTR returns
the converted string value.
For more information, see section 51.113 “NUMTOSTR” on page 1784...

51.112.2

STRTODATE
STRTODATE returns a datetime that corresponds to the particular date and time
you specify in the date_time. The controller has a unique number for each
understandable moment in time.
For more information, see section 51.114 “STRTODATE” on page 1785..

51.112.3

STRTONUM
STRTONUM converts a string that contains a number in a string variable or other
string form to a numeric variable for use in mathematical operations. StrToNum
returns the converted numeric value.
For more information, see section 51.115 “STRTONUM” on page 1787..
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51.113

NUMTOSTR
NUMTOSTR converts a number in a numeric variable or other numeric form to a
string variable so the number can be used in string operations. NUMTOSTR returns
the converted string value.

Syntax
NumToStr ( number )
Table: NUMTOSTR Parameter
Parameter

Description

number

Any number or expression.
A number in a string variable can be used in
string operations..

Examples
The following program translates the number 240 into a string:
Program File
String Trans
Trans = NumToStr (240)
Print TRANS
TRANS is no longer numeric and cannot be used in calculations.
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51.114

STRTODATE
Alias: STRTOTIME
STRTODATE returns a datetime that corresponds to the particular date and time
you specify in the date_time. The controller has a unique number for each
understandable moment in time.
The system uses this date_time to process information about the date and time. If
you print a variable that is equal to a STRTODATE, you receive the date_time.

Note
Be aware that STRTODATE converts a text string to local rather than UTC time.
To receive the date and time from STRTODATE, you must enter both the date and
the time in one continuous input line. You can position the time before the date on
that line, if you prefer.
You can set up the date in any reasonably interpretable format—using all numbers
or spelling the month as either the full word or the three-letter abbreviation. You can
also separate the month, day, and year with spaces, slashes, dashes, periods,
commas, or any combination of these punctuation characters.
DAY and MONTH If you prefer to put the day first, ensure that the day is obviously a
day. There are two ways that a day cannot be misinterpreted as a month:
• Spell the month as a word so that the day is the only other number so low.
• Use numbers for both month and day only if the day is greater than 12, since
any number between 1 and 12 could be a month.
The month can be any of the following options:
• JAN[UARY]
• FEB[RUARY]
• MAR[CH]
• APR[IL]
• MAY
• JUN[E]
• JUL[Y]
• AUG[UST]
• SEP[TEMBER]
• OCT[OBER]
• NOV[EMBER]
• DEC[EMBER]
YEAR
You must enter the year as a four-digit year after 2008.
WEEKDAY
Since the controller already knows the day of the week that corresponds to each
date, you don’t need the day. You can, however, place the day of the week after
the date. The day of week must be either the three-letter abbreviation or the
completely spelled-out name of the day.
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The weekday can be any of the following options:
• MON[DAY]
• TUE[SDAY]
• WED[NESDAY]
• THU[RSDAY]
• FRI[DAY]
• SAT[URDAY]
• SUN[DAY]
TIME
You enter the time as the one- or two-digit hour and one- or two-digit minute
separated by a colon. You can type another colon and follow that colon with
seconds.
You can enter the time in 24-hour time or use regular time with AM or PM following.
The controller translates that time into the 24-hour clock. For example, you can
enter 3:00 PM which the controller automatically translates to 15:00:00.
The following formats are acceptable:
• hh:mm:ss [AM/PM]
• hh:mm [AM/PM]
Where AM and PM (upper- or lowercase) are optional and the following are true:
• hh is hours (00 – 23)
• mm is minutes (00 – 59)
• ss is seconds (00 – 59)

Syntax
StrToDate (date_time)
Table: STRTODATE Parameter
Parameter

Description

date_time

Any actual date and time in a string
(surrounded by quotation marks) or a name
that stands for a date and time.

Examples
Program File
CONV_DATE = StrToDate (‘SEPTEMBER-21-2000 11:00 pm’)
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51.115

STRTONUM
Alias: VAL
STRTONUM converts a string that contains a number in a string variable or other
string form to a numeric variable for use in mathematical operations. StrToNum
returns the converted numeric value.
Once a number is in a numeric variable, the number can be used in mathematical
expressions and operations.

Syntax
StrToNum (string)
Table: STRTONUM Parameter
Parameter

Description

string

Any number in string form (in quotation
marks) or string expression that stands for a
number in text form.
If string is not a valid numeral or series of
numerals, STRTONUM fails. If STRTONUM
fails, the program either goes to LINE E (see
LINE keyword) or disables.

Examples
If you receive string input from the keyboard, but want the input to be numeric so
you can add another number, you use STRTONUM. The following program adds
the string (in quotation marks) that contains 78.5 to the number 92.8:
Program File
Numeric Trans
Trans = StrToNum ("78.5") + 92.8
Output
171.3
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51.116

Mathematical Functions
Mathematical functions perform mathematical operations.

51.116.1

ABS
ABS returns the absolute value of number. The absolute value of any number,
positive or negative, is always the positive number.
For more information, see section 51.117 “ABS” on page 1790..

51.116.2

EXPONENTIAL
EXPONENTIAL returns a value equal to the base e raised to the number power.
For more information, see section 51.118 “EXPONENTIAL” on page 1791..

51.116.3

FACTORIAL
FACTORIAL returns the factorial of integer_expression.
For more information, see section 51.119 “FACTORIAL” on page 1792..

51.116.4

LN
LN returns the natural logarithm of any number_expression.
For more information, see section 51.120 “LN” on page 1793..

51.116.5

LOG
LOG returns the base 10 logarithm of integer_expression.
For more information, see section 51.121 “LOG” on page 1794..

51.116.6

RANDOM
RANDOM returns a random number from 0 to 32,767 using number. Random is
used to simulate real-life values to test programs.
For more information, see section 51.122 “RANDOM” on page 1795..

51.116.7

SQRT
SQRT returns the square root of the number.
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For more information, see section 51.123 “SQRT” on page 1796..

51.116.8

SUM
SUM returns the sum of the listed items (Syntax 1), the sum of an array (Syntax 2),
or the sum of a numeric log (Syntax 3).
For more information, see section 51.124 “SUM” on page 1797.
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51.117

ABS
ABS returns the absolute value of number. The absolute value of any number,
positive or negative, is always the positive number.

Syntax
ABS (number)
Table: ABS Parameter
Parameter

Description

number

Any number or expression.

Examples
Example 1
You find the absolute value of -3 as follows:
Program File
Result=ABS(-3)
This statement sets RESULT to 3.
To maintain a setpoint temperature to within plus or minus 3 degrees, when the
temperature changes in either direction, the fan should blow in either the heating or
cooling as required.
In this situation, you should find the absolute value of the change to control the fan.
Whether the change is positive or negative makes no difference.
Example 2
Program File
If ABS(Temp_SP - Temp_2) >= 3 then run Fan_2
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51.118

EXPONENTIAL
Alias: EXP
EXPONENTIAL returns a value equal to the base e raised to the number power.

Syntax
Exponential (number)
Table: EXPONENTIAL Parameter
Parameter

Description

number

Any number or expression.

Examples
Example 1
Program File
EVAL = Exponential (0)
The result of e to the 0 power is 1. Because the EXPONENTIAL function returns 1,
EVAL is set to 1.
Example 2
Program File
R_VAL = Exponential (-1)
The result of e to the -1 power is 0.368, so R_VAL is set to 0.368.
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51.119

FACTORIAL
Alias: FACT
FACTORIAL returns the factorial of integer_expression.

Syntax
Factorial (integer_expression)
Table: FACTORIAL Parameters
Parameter

Description

integer_expression

Factorial (integer_expression)

The value returned is between 0 and pi (3.14159) radians.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
The following statement sets FVAL to the result of factorial 3:
Program File
FVAL = Factorial (3)
The function returns 6, so FVAL = 6.
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51.120

LN
LN returns the natural logarithm of any number_expression.

Syntax
LN (number_expression)
Table: LN Parameter
Parameter

Description

integer_expression

Any number not equal to zero.

Examples
Program File
LGVAL = LN(3.2)
The natural log is returned and placed in LGVAL.
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51.121

LOG
LOG returns the base 10 logarithm of integer_expression.

Syntax
LOG (number_expression)
Table: LOG Parameter
Parameter

Description

integer_expression

An integer greater than zero.

Examples
Program File
Result = LOG(10)
This statement sets RESULT equal to 1.
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51.122

RANDOM
Alias: RND
RANDOM returns a random number from 0 to 32,767 using number. Random is
used to simulate real-life values to test programs.
You must vary the number to generate different random sequences. If you do not
vary the number, you can see a repetitious pattern of values emerging over time.

Syntax
Random (number)
Table: RANDOM Parameter
Parameter

Description

number

Any number or expression.
You can omit number, but the parentheses
are required, as with all functions.

Examples
To simulate fluctuations of temperature between 50 and 70 degrees, you put any
number in the number. To generate a result in the range of 20 possible
temperatures, you divide the random number you generate by 32767, which gives
you a number between 0 and 1. Then multiply the result by 20. Finally, add 50
degrees to set the bottom of the range.
Program File
Random (8)/32767 times 20
Finally you add the bottom of the range you are trying to simulate to the random
number:
Program File
Temp = (Random (8)/32767 times 20) + 50

04-16006-04-en, March 2015

Technical
1797

51 Script Programming
51.123 SQRT

51.123

SQRT
SQRT returns the square root of the number.

Syntax
SQRT (number)
Table: SQRT Parameter
Parameter

Description

number

Any number or expression.

Examples
Program File
MVAL = SQRT (4)
The SQRT function returns 2 and the statement sets MVAL to 2.
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51.124

SUM
SUM returns the sum of the listed items (Syntax 1), the sum of an array (Syntax 2),
or the sum of a numeric log (Syntax 3).
Items in the list must all be either numbers or variables that contains numbers.
If any of the items in the list in Syntax 1 is an array or a log, the controller retrieves
the first item from the array or log and treats that item like any other single one in the
list.

Syntax
Format 1: Sum (numeric_list)
Format 2: Sum (numeric_array)
Format 3: Sum (numeric_log)
Table: SUM Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for numbers, separated by commas.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

Examples
Example 1
To sum several timers, you place them directly in the SUM function statement. You
list them in parentheses after SUM, as follows:
Program File
Total_Timers = Sum (Timer1, Timer2. Timer3, Timer4)
Example 2
You have been storing calculated values in an array called PARTTME. You then use
the sum on that array, as follows:
Program File
TotalTime = Sum (PartTime)
Example 3
You have been logging temperatures in a log for several hours. To find the sum of
them, you find the sum of that log, as follows:
Program File
HourlyTot = Sum (TempLog)
Example 4
You find the sum of several temperatures in a list, including the current value of
TEMPLOG, as follows:
Program File
HourlyAvg = Sum (Tmp801, Tmp802, TempLog)
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In this example, TEMPLOG is interpreted as the current value of TEMPLOG.
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51.125

Object Functions
Object functions perform operations on mathematical objects.

51.125.1

GETNAME
GETNAME changes the string to a name, such as the name of a defined point, so
the string can then be set to a value or used anywhere in the language that a point
name is allowed.
For more information, see section 51.126 “GETNAME” on page 1800...

51.125.2

ReadProperty
ReadProperty retrieves the value of a property of a BACnet object.
For more information, see section 51.127 “ReadProperty” on page 1804...

51.125.3

Relinquish
Relinquish relinquishes a command. (You may also use WriteProperty and pass no
argument for the value).
For more information, see section 51.128 “Relinquish” on page 1805..

51.125.4

WriteProperty
WriteProperty sets the value of a property of a BACnet object. The returned value is
either SUCCESS or FAILURE.
For more information, see section 51.129 “WriteProperty” on page 1806..
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51.126

GETNAME
GETNAME changes the string to a name, such as the name of a defined point, so
the string can then be set to a value or used anywhere in the language that a point
name is allowed.
Getname can be used to give one name to a series of items in the database that
have the same root in their names. Each of the names is made up of a root abutted
with (joined to) a variable.

Syntax
Getname (string)
Getname (string, bacnet_broadcast_flag)
Table: GETNAME Parameters
Parameter

Description

string

This argument can be either text (word or
words) or a text expression. The text
expression can be a known character or
characters combined with a changeable
character or characters to form one word. A
semicolon joins parts of the combined string
("TEMP";X gives TEMP1, TEMP2, TEMP3,
as X becomes 1, then 2, then 3).
The word formed in the string must be a
path name or a single-word name that you
have defined somewhere in the control
system software.

bacnet_broadcast_flag

This argument is for BACnet controllers.
Using this argument, a Script program can
execute a GETNAME function
asynchronously, as a BACnet broadcast, to
find an object – usually on another BACnet
controller. The GETNAME function executes
Who Has – I Have BACnet broadcast.
Inserting this argument makes execution of
this function asynchronous. Enter either
TRUE or FALSEr:
• TRUE, 1, or any other numeric
expression not equal to zero
• FALSE, 0, or any other numeric
expression equal to FALSE
Enter TRUE (or equivalent numeric
expression) to send this Who Has – I Have
broadcast to other BACnet controllers on
the network, in search of the object.
Enter FALSE (or equivalent numeric
expression) to perform a search on the local
controller.
See Example 3 for an example of the
bacnet_broadcast_flag argument.
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Parameter

Description

Examples
Example 1
In the following example, GETNAME converts the "TEMP"; ROOM string to the
TEMP1, TEMP2, and other temperature point names up to TEMP10. These points
have been defined on the controller. The program prints the values of the points:
Program File
Numeric room
Line SettingRoom
Set Room = 1
Goto PrintingTemp
Line PrintingTemp
Print Getname("Temp";ROOM) TO Printer1
Goto GettingRoom
Line GettingRoom
Set Room = Room + 1
If Room is less than 11 then
Goto PrintingTemp
Else
Stop
Endif
Example 2
You can use GETNAME to get the value of a point from more than one controller. In
this example, the controllers are VAV box controllers called ROOM1, ROOM2,
ROOM3, and so on, up to ROOM10. Since each ROOM controller has a TEMP
point, GETNAME can easily retrieve that point from each controller:
Program File
Numeric room
Line SettingRoom
Room = 1
Goto CheckingTemp
Line CheckingTemp
If Getname("ROOM";ROOM;" TEMP") > 75 then
Print "Room |## IS |###", ROOM, GETNAME("Room"; ROOM;" TEMP")
Endif
Goto GetNextRoom
Line GetNextRoom
If room >= 10 then Stop
Room = Room + 1
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Goto CheckingTemp
"Room"; ROOM; "Temp" gets the path to the TEMP point on the ROOM1 controller
first. Once the program gets the value of TEMP from each controller, the program
compares that value to the setpoint of 75. If the temperature is not at setpoint, the
program prints a message.
Example 3
Here is a program example using the bacnet_broadcast_flag argument:
Program File
Object ObjRef
Line GettingObject
ObjRef = Getname(“BCX2 \ ANALOGVALUE1”)
Line SettingObject
ObjRef = 72
Example 4
To get an attribute with GETNAME, you must include the full path in the GETNAME
string. (You cannot get the name and then follow that with an attribute.) Include the
attribute as follows:
Program File
Print Getname("Room"; room; "Temp VALUE")
Example 5
You can also get attributes of a point other than the value. This example retrieves
the STATE (enabled or disabled):
Program File
Print "The Lights are |*", Getname("Room";room;"Lights State")
Example 6
You can also get attributes of any other name defined in the control system
software, for example, the STATUS of a program called HEATING (active or
inactive):
Program File
Print "Status of Heating is|*",
Getname("Floor";FloorNum;"Heating STATUS")
Example 7
You can use GETNAME to generate a report on several points at a particular time.
For example, you can get the setting of the lights in a particular space, the status of
the lighting program, the setpoint at that time, the actual temperature at that time,
the airflow setpoint, and the actual airflow:
Program File
Numeric room
Line SetRoom
Room = 1
Print "Today’s Date and Time are ";DATE
Goto CheckRoom
Line CheckRoom
Technical
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Print "Room |## Status", room
Print "The lights are |$###", Getname("Room";room;"Lights")
Print "The lighting program is |*",
Getname("Floor";Num,"Lighting STATUS")
Print "The temperature setpoint is |##.#",
Getname("Room";room;"Setpt")
Print "The actual temperature is |##.#",
Getname("Room";room;"Temp")
Print "The airflow setpoint is |### cfm",
Getname("Room";room;"AirSetpt")
Print "The actual air flow is |### cfm",
Getname("Room";room;"AirFlow")
Goto GetNextRoom
Line GetNextRoom
If Room >=10 then stop
Room = Room + 1
Goto CheckRoom
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51.127

ReadProperty
ReadProperty retrieves the value of a property of a BACnet object.

Syntax
ReadProperty (object_property, index)
Table: ReadProperty Parameters
Parameter

Description

local var

This is bound to the object property.

index

This is optional. It applies only to an arraytype BACnet property. The index is ignored
when it is not applicable.

Products Supported
b3 series controllers, Automation Servers, Enterprise Servers

Examples
Example 1
Use ReadProperty to get a property value, without designating the property name:
Numeric Input AV1
Numeric Temp
Temp = ReadProperty (AV1)
Example 2
Use ReadProperty to get the description of an analog point and place it in a string
point:
String Input AV1_Description
String StringPoint
StringPoint = ReadProperty (AV1_Description)
Example 3
Use ReadProperty to get the value of a point, using index 3:
Numeric Input Indexed_Property
Numeric Temp
Temp = ReadProperty (Indexed_Property, 3)
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51.128

Relinquish
Relinquish relinquishes a command. (You may also use WriteProperty and pass no
argument for the value).
Either an application program or operator issues a command to write to the
commandable property of a BACnet object, or relinquishes a command issued at
an earlier time.
A relinquish operation is similar to a WriteProperty operation, except that it places a
NULL value in the Priority_Array corresponding to the appropriate priority. When
that occurs, the next lower priority, non-NULL position, takes control of the
property.
If all the priority table array elements are NULL, the commandable property
assumes the one defined in the Relinquish Default property of the object.

Note
• Present Value is the commandable property for the following classes: Analog
Output, Binary Output, Multistate Output, Analog Value, Multistate value,
Binary Value.

Syntax
Relinquish (object_property, priority)
Table: Relinquish Parameters
Parameter

Description

local var

Bound to object property.

priority

Priority number, ranging from 1 (highest) to
16 (lowest).
This applies only to a BACnet commandable
property. For controllers: If not present, the
property value that matches priority 16, if
applicable, is used.

Products Supported
b3 series controllers, Automation Servers, Enterprise Servers

Example
Use Relinquish to relinquish the last command issued with priority 5. This statement
places a NULL in the fifth entry of the priority array (1-biased):
Numeric Output AV1
Relinquish (AV1,5)
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51.129

WriteProperty
WriteProperty sets the value of a property of a BACnet object. The returned value is
either SUCCESS or FAILURE.

Syntax
WriteProperty (object_property, value, priority, index)
Table: WriteProperty Parameters
Parameter

Description

local var

Bound to an object property.
The object identifier and property identifier
are combined as one argument.

value

Actual value to which the property is set.
This is optional. If it is not present, then the
next argument, priority, must be present to
perform a Relinquish command.

priority

Priority number, ranging from 1 (highest) to
16 (lowest).
This is optional. It applies only to a BACnet
commandable property.
For controllers: If it is not present, priority 10,
if applicable, is used.

index

This is optional. It applies only to an arraytype BACnet property. The index is ignored
whenever it is not applicable.

Products Supported
b3 series controllers, Automation Servers, Enterprise Servers

Examples
Example 1
Use WriteProperty to set the analog value of an object to 100.
‘Value property is assumed
Numeric Output AV1
WriteProperty (AV1, 100)
Example 2
Use WriteProperty to set the Present_Value property of an object to 100, using
priority 5:
Numeric Output AV1
WriteProperty (AV1, 100, 5)
Example 3
Use WriteProperty to relinquish a command using priority 5:
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‘Value is not passed; This is equivalent to a relinquish
Numeric Output AV1
WriteProperty (AV1, , 5)

Exceptions
When an Automation Server or Enterprise Server program uses the WriteProperty
keyword to set the value of a BACnet object (including b3 objects), the value is
always written to priority 16. For example, if you bind the program’s output to an
analog value in $SERVER/BACnet Device/Application and add it to a task, the value
is written to the analog output’s priority 16.
To write to a specific priority in a BACnet object from an Automation Server or
Enterprise Server program, the program must be bound directly to the priority you
wish to write to. This means that the priority no longer gets passed an argument as
shown in the examples that follow.
‘bound to BACnet analog value AV1 Priority 5
Numeric output x
Numeric a
‘places the value of 100 into AV1 Priority 5 slot
WriteProperty (x, 100)
‘places the value of AV1 Priority 5 into variable a
a = ReadProperty (x)
‘relinquishes the AV1 Priority 5 value
Relinquish (x)
‘relinquishes the AV1 Priority 5 value
‘Value argument is not passed into the WriteProperty
‘function
WriteProperty (x, )
WriteProperty (x)
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51.130

PASSED Function
The PASSED function keyword indicates whether or not the argument with the
arg_number has been passed into the current function. Returns TRUE (numeric 1) if
the argument is actually passed and FALSE (numeric 0) if not.

Syntax
Passed (arg_number)
Table: PASSED Parameter
Parameter

Description

arg_number

Returns TRUE (numeric 1) if the argument is
actually passed and FALSE (numeric 0) if
not.

Examples
You can create a function that takes an argument and checks to see if the
argument is passed. The function below returns the number of the argument that
has the highest value and also returns after finding the first argument that is not
passed. The function called MAXITEM, predefined in the language, is shown as
follows:
Function File
Numeric Count, Lastmax
Lastmax = 1
For Count = 1 TO 15
If not(Passed (Count)) then return (Lastmax)
If ARG[Count] > Lastmax then Lastmax = Count
Next Count
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51.131

Rounding Functions
Rounding functions round numbers to the next integer and then return values.

51.131.1

CEILING
CEILING rounds a number to the next larger integer on the number line and returns
that integer.
For more information, see section 51.132 “CEILING” on page 1810..

51.131.2

FLOOR
FLOOR returns the next smaller integer on the number line and returns that integer.
For more information, see section 51.133 “FLOOR” on page 1811..

51.131.3

ROUND
ROUND rounds a number to the nearest integer and returns that value.
For more information, see section 51.134 “ROUND” on page 1812..

51.131.4

TRUNCATE
TRUNCATE drops the fractional part of number and returns the integer.
For more information, see section 51.135 “TRUNCATE” on page 1813..
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51.132

CEILING
CEILING rounds a number to the next larger integer on the number line and returns
that integer.
See ROUND for a comparison of all rounding functions.

Syntax
Ceiling (number)
Table: CEILING Parameter
Parameter

Description

number

Any number or expression.

Examples
Example 1
Program File
The following shows how the controller calculates the ceiling of -2.7:
Top = Ceiling(-2.7)
This statement returns -2.
Example 2
Program File
RndVal = Ceiling(4.3)
This statement returns 5.
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51.133

FLOOR
FLOOR returns the next smaller integer on the number line and returns that integer.

Syntax
Floor (number)
Table: FLOOR Parameter
Parameter

Description

number

Any number or expression. (See ROUND for
a comparison of all rounding functions.)

Examples
Example 1
Program File
TmpVar = Floor (42.7)
This statement returns 42.
Example 2
Program File
Result = Floor(-1.1)
This statement returns -2.
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51.134

ROUND
ROUND rounds a number to the nearest integer and returns that value.
The number is any number or expression.
ROUND, CEILING, FLOOR, and TRUNCATE are similar, but differ in the following
ways:
• ROUND rounds up if the decimal is .5 or higher and down if the decimal is
below .5. ROUND (-1.7) gives -2 (see figure below).
• CEILING always rounds up. CEILING (-2.7) gives the closest higher number on
the number line, -2. For more information, see section 51.132 “CEILING” on
page 1810.
• FLOOR always rounds down. FLOOR (-3.8) gives the closest lower number on
the number line, -4. For more information, see section 51.133 “FLOOR” on
page 1811.
• TRUNCATE cuts off the decimal value. TRUNCATE (-3.8) gives the integer
without the decimal, -3.
The following table illustrates how the four functions differ:
Table: ROUND Functions
Function

4.2

4.7

-3.1

-3.7

ROUND

4

5

-3

-4

CEILING

5

5

-3

-3

FLOOR

4

4

-4

-4

TRUNCATE

4

4

-3

-3

Syntax
Round (number)
Parameter

Description

number

Any number or expression.

Examples
Example 1
Program File
Tmpvar = Round (-42.7)
This statement returns -43.
Example 2
Program File
Rndval = Round (4.3)
This statement returns 4.
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51.135

TRUNCATE
Alias: TRUNC
TRUNCATE drops the fractional part of number and returns the integer.

Syntax
Truncate (number)
Table: TRUNCATE Parameter
Parameter

Description

number

Any number or expression.

Examples
Example 1
Program File
CHP = Truncate (4.5)
TRUNCATE returns 4 and the program statement sets CHP to 4.
Example 2
Program File
VAL_C = Truncate (-1.7)
TRUNCATE returns -1 and the program statement sets VAL_C to -1.
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51.136

Statistical Functions
Statistical functions perform statistical operations.

51.136.1

AVERAGE
AVERAGE returns the average of a list of items, the average of the items in an array
you name, or the average of the items in the log you name.
For more information, see section 51.137 “AVERAGE” on page 1815..

51.136.2

MAXIMUM
MAXIMUM finds the maximum number in a list of numeric values, a numeric array,
or a numeric log.
For more information, see section 51.138 “MAXIMUM” on page 1817..

51.136.3

MAXITEM
MAXITEM finds the position of the largest number in a list, an array, or a log. For
example, MAXITEM returns 1 if the largest number is the first one in the list.
For more information, see section 51.139 “MAXITEM” on page 1819..

51.136.4

MINIMUM
MINIMUM finds the minimum number in a list of numeric values, a numeric array, or
a numeric log.
For more information, see section 51.140 “MINIMUM” on page 1821..

51.136.5

MINITEM
MINITEM finds the position of the smallest number in a list, an array, or log. For
example, MINITEM returns 1 if the smallest number is the first one in the list.
For more information, see section 51.141 “MINITEM” on page 1823..

51.136.6

StandardDeviation
StandardDeviation finds the standard deviation of a series of numbers.
For more information, see section 51.142 “StandardDeviation” on page 1825..
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51.137

AVERAGE
Alias: AVG
AVERAGE returns the average of a list of items, the average of the items in an array
you name, or the average of the items in the log you name.

Syntax
Format 1: Average (numeric_list)
Format 2: Average (numeric_array)
Format 3: Average (numeric_log)
• Format 1 is supported in Building Operation and in field devices, such as b3
BACnet devices.
• Format 2 is supported for local variables declared in a program in Building
Operation and in field devices, such as b3 BACnet devices.
• Format 2 is not supported in a Script program running on a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to a numeric, manual, array external to the program.
• Format 3 is supported in a program running in a field device like a b3 BACnet
device that accesses a numeric log.
• Format 3 is not supported in a Script program running in a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to any numeric log in the server itself or any other
device, including field devices like b3 BACnet devices.
Table: AVERAGE Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for number, separated by commas.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

Items in the list must all be either numbers or variables that contain numbers.
Element numbers are not required. Omitting element numbers averages the entire
array or log.

Examples
Example 1
To average several temperatures, you place them directly in the AVERAGE function
statement. You list them in parentheses after AVERAGE, as follows:
Program File
Flr8_AVG = Average (TMP801, TMP802, TMP803, TMP804)
Example 2
Since you know a certain temperature varies, you have been storing readings in an
array called OAT. You then use the AVERAGE function on that array, as follows:
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Program File
OAT_AVG = Average (OAT)
Example 3
You have been logging temperatures in a log, called TEMPLOG, for several hours.
To find their average, you use the AVERAGE function as follows:
Program File
HourlyAVG = Average (TEMPLOG)
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51.138

MAXIMUM
Alias: MAX
MAXIMUM finds the maximum number in a list of numeric values, a numeric array,
or a numeric log.

Syntax
Format 1: Maximum (numeric_list)
Format 2: Maximum (numeric_array)
Format 3: Maximum (numeric_log)
• Format 1 is supported in Building Operation and in field devices, such as b3
BACnet devices.
• Format 2 is supported for local variables declared in a program in Building
Operation and in field devices, such as b3 BACnet devices.
• Format 2 is not supported in a Script program running on a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to a numeric, manual, array external to the program.
• Format 3 is supported in a program running in a field device like a b3 BACnet
device that accesses a numeric log.
• Format 3 is not supported in a Script program running in a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to any numeric log in the server itself or any other
device, including field devices like b3 BACnet devices.
Table: MAXIMUM Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for numbers, separated by commas.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

Items in the list must all be either numbers or variables that contain numbers.
If any of the items in the list in Format 1 is an array or a log but does not indicate an
element number, the controller retrieves the current value of the point and treats
that point like any other single item in the list.

Examples
Example 1
The MAXIMUM function finds the maximum number in a list of variables as follows:
Program File
TOPNUMBER = Maximum (Zone1, Zone2, Zone3, Zone4)
The TOPNUMBER variable is assigned the maximum value found.
Example 2
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You can find the maximum number of kilowatts (KW) in the array of variables as
follows:
Program File
TOPNUMBER = Maximum (KW)
Example 3
You find the highest of several temperatures, including the current value of
TEMPLOG, as follows:
Program File
TOPNUMBER = Maximum (TMP801, TMP802, TEMPLOG)
In this example, TEMPLOG is interpreted as the current value of TEMPLOG.
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MAXITEM
MAXITEM finds the position of the largest number in a list, an array, or a log. For
example, MAXITEM returns 1 if the largest number is the first one in the list.

Syntax
Format 1: Maxitem (numeric_list)
Format 2: Maxitem (numeric_array)
Format 3: Maxitem (numeric_log)
• Format 1 is supported in Building Operation and in field devices, such as b3
BACnet devices.
• Format 2 is supported for local variables declared in a program in Building
Operation and in field devices, such as b3 BACnet devices.
• Format 2 is not supported in a Script program running on a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to a numeric, manual, array external to the program.
• Format 3 is supported in a program running in a field device like a b3 BACnet
device that accesses a numeric log.
• Format 3 is not supported in a Script program running in a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to any numeric log in the server itself or any other
device, including field devices like b3 BACnet devices.
Table: MAXITEMS Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for numbers, separated by commas.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

If any of the items in the list in Format 1 is an array or a log, the controller retrieves
the first item from the array or log and treats that item like any other single item in
the list.

Examples
Example 1
To find the position of the largest number in a series of numbers, you enter the
series in the parentheses:
Program File
Temp1 = 60
Temp2 = 65
Temp3 = 70
Temp4 = 67
Maxitem (Temp1, Temp2, Temp3, Temp4)
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The Maxitem statement returns 3, because the third item in the list contains the
largest number.
Example 2
To find the index position of the largest number in an array, you give the array name
in parentheses:
Program File
Maxitem (KW)
Example 3
To find the index position of the largest number in a log, you give the log name in
parentheses:
Program File
Maxitem(Temp)
Example 4
You find the position of the highest of several temperatures in a list, including the
current value of TEMPLOG, as follows:
Program File
Maxindex = Maxitem (TMP801, TMP802, TEMPLOG)
In this example, TEMPLOG is interpreted as the current value of TEMPLOG.
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MINIMUM
MINIMUM finds the minimum number in a list of numeric values, a numeric array, or
a numeric log.
Items in the list must all be either numbers or variables that contains numbers.
If any of the items in the list in Format 1 is an array or a log but does not indicate an
element number, the controller retrieves the current value of the point and treats
that value like any other single item in the list.

Syntax
Format 1: Minimum (numeric_list)
Format 2: Minimum (numeric_array)
Format 3: Minimum (numeric_log)
• Format 1 is supported in Building Operation and in field devices, such as b3
BACnet devices.
• Format 2 is supported for local variables declared in a program in Building
Operation and in field devices, such as b3 BACnet devices.
• Format 2 is not supported in a Script program running on a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to a numeric, manual, array external to the program.
• Format 3 is supported in a program running in a field device like a b3 BACnet
device that accesses a numeric log.
• Format 3 is not supported in a Script program running in a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to any numeric log in the server itself or any other
device, including field devices like b3 BACnet devices.
Table: MINIMUM Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for numbers.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

Examples
Example 1
The MINIMUM function finds the minimum number in a list of variables as follows:
Program File
BotNumber = Minimum (Zone1, Zone2, Zone3, Zone4)
The BotNumber variable is assigned the minimum value found.
Example 2
You can find the minimum number of kilowatts in the array of variables as follows:
Program File
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BottomNumber = Minimum (KW)
Example 3
You find the minimum of several temperatures, including the current value of
TEMPLOG, as follows:
Program File
BottomNumber = Minimum (TMP801, TMP802, TEMPLOG)
In this example, TEMPLOG is interpreted as the current value of TEMPLOG.
Example 4
You have a log called AV_TEMP that holds the average temperature for each of the
last five days. You can use the MINIMUM function to find the minimum temperature:
Program File
WklyMin = Minimum (AV_TEMP)
If AV_TEMP contains 110, 114, 112, 108, 109, MINIMUM returns 108 and the
program statement sets WKLYMIN to 108.
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MINITEM
MINITEM finds the position of the smallest number in a list, an array, or log. For
example, MINITEM returns 1 if the smallest number is the first one in the list.
If any of the items in the list in Format 1 is an array or a log, the controller retrieves
the first item from the array or log and treats that item like any other single item in
the list.

Syntax
Format 1: Minitem (numeric_list)
Format 2: Minitem (numeric_array)
Format 3: Minitem (numeric_log)
• Format 1 is supported in Building Operation and in field devices, such as b3
BACnet devices.
• Format 2 is supported for local variables declared in a program in Building
Operation and in field devices, such as b3 BACnet devices.
• Format 2 is not supported in a Script program running on a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to a numeric, manual, array external to the program.
• Format 3 is supported in a program running in a field device like a b3 BACnet
device that accesses a numeric log.
• Format 3 is not supported in a Script program running in a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to any numeric log in the server itself or any other
device, including field devices like b3 BACnet devices.
Table: MINITEM Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for numbers.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

Examples
Example 1
To find the position of the smallest number in a series of numbers, you enter the
series in the parentheses:
Program File
Temp1 = 60
Temp2 = 65
Temp3 = 70
Temp4 = 67
Minitem (Temp1, Temp2, Temp3, Temp4)
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The MINITEM statement returns 2, because the second item in the list contains the
smallest number.
Example 2
To find the index position of the smallest number in an array, you give the array
name in parentheses:
Program File
Minindex = Minitem (KW)
Example 3
To find the index position of the smallest number in a log, called TEMPLOG, you
give the log name in parentheses:
Program File
Minindex = Minitem (TEMPLOG)
Example 4
You find the position of the lowest of several temperatures in a list, including the
current value of TEMPLOG, as follows:
Program File
Minindex = Minitem(TMP801, TMP802, TEMPLOG)
In this example, TEMPLOG is interpreted as the current value of TEMPLOG.
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StandardDeviation
Alias: SD
StandardDeviation finds the standard deviation of a series of numbers.
The standard deviation is the result of the following steps:
Table: Finding the Standard Deviation
Step

Action

1

Find the average of the list.

2

Find the differences between the average
and each number.
If the average is 110 and one of the numbers
is 112 that difference is 2.

3

Square the differences, so 2 becomes 4.

4

Add up the squares and find the average of
them.

5

Take the square root of the average.

Items in the list must all be either numbers or variables that contain numbers.
If any of the items in the list in Format 1 is an array or a log but does not indicate an
element number, the controller retrieves the current value of the point and treats
that point like any other single item in the list.

Syntax
Format 1: StandardDeviation (numeric_list)
Returns the standard deviation of the listed items.
Format 2: StandardDeviation (numeric_array)
Returns the standard deviation of the items in the array.
Format 3: StandardDeviation (numeric_log)
Returns the standard deviation of the items in the log.
• Format 1 is supported in Building Operation and in field devices, such as b3
BACnet devices.
• Format 2 is supported for local variables declared in a program in Building
Operation and in field devices, such as b3 BACnet devices.
• Format 2 is not supported in a Script program running on a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to a numeric, manual, array external to the program.
• Format 3 is supported in a program running in a field device like a b3 BACnet
device that accesses a numeric log.
• Format 3 is not supported in a Script program running in a Building Operation
server, such as an Automation Server or Enterprise Server. This is true for
binding variables bound to any numeric log in the server itself or any other
device, including field devices like b3 BACnet devices.
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Table: StandardDeviation Parameters
Parameter

Description

numeric_list

One or more numbers or names that stand
for numbers, separated by commas.

numeric_array

Any defined array that contains numbers.

numeric_log

Any defined log that contains numbers.

Examples
Example 1
To find the standard deviation of several temperatures, you place them directly in
the STANDARDDEVIATION statement. You list them in parentheses as follows:
Program File
TempDev = StandardDeviation (70, 72, 74)
The standard deviation returned is 2.
Example 2
Since you know a certain temperature varies, you have been storing readings in an
array called VARTMP. You then use the STANDARDDEVIATION function on that
array, as follows:
Program File
Variation = StandardDeviation (VARTMP)
Example 3
You have been logging temperatures in a log for several hours. You find the
standard deviation of them as follows:
Program File
Deviance = StandardDeviation (TEMPLOG)
Example 4
You find the standard deviation of several temperatures in a list, including the
current value of TEMPLOG, as follows:
Program File
StdDev = StandardDeviation (TMP1, TMP2, TEMPLOG)
In this example, TEMPLOG is interpreted as the current value of TEMPLOG.
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String Functions
String functions perform string-related operations.

51.143.1

ASC
ASC returns the ASCII value of the first character of the string.
For more information, see section 51.144 “ASC” on page 1829..

51.143.2

CHR
CHR returns one character whose ASCII code is number. CHR can be used to
send non-printing characters to a terminal, computer, or printer to initiate action.
For more information, see section 51.145 “CHR” on page 1830..

51.143.3

LEFT
LEFT returns a string consisting of the leftmost characters of string with a length
specified by integer.
For more information, see section 51.146 “LEFT” on page 1831..

51.143.4

LENGTH
LENGTH returns the number of characters in the string.
For more information, see section 51.147 “LENGTH” on page 1832..

51.143.5

MID
MID returns a string number character extracted from the string starting at offset.
For more information, see section 51.148 “MID” on page 1833..

51.143.6

RIGHT
RIGHT returns the number of requested characters (the integer) from the text string
starting from the right side (end) and counting left.
For more information, see section 51.149 “RIGHT” on page 1834..
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51.143.7

SEARCH
SEARCH returns the position of the given search_string within string or 0 if the
controller can’t find the search_string.
For more information, see section 51.150 “SEARCH” on page 1835..

51.143.8

STRINGFILL
STRINGFILL returns a string of number length containing a particular character that
you specify with the ASCII character code named by character code.
For more information, see section 51.151 “STRINGFILL” on page 1836..

51.143.9

TAB
TAB returns a series of continuous blank spaces. The number of blank spaces is
number.
For more information, see section 51.152 “TAB” on page 1838..
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ASC
ASC returns the ASCII value of the first character of the string.

Syntax
ASC (string)
Table: ASC Parameter
Parameter

Description

string

Any text (word or words) or text expression

Examples
This statement returns 83, which is the ASCII value of the character S:
Program File
ASC ("S")
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CHR
CHR returns one character whose ASCII code is number. CHR can be used to
send non-printing characters to a terminal, computer, or printer to initiate action.

Syntax
CHR (number)
Table: CHR Parameter
Parameter

Description

number

Any number or expression.

Examples
Example 1
After several pages of messages print, you then want to send a report to that
printer.
You make sure the report starts on a clean sheet of paper by sending an instruction
telling the printer to bring the paper to the top of a new page. This action is called a
formfeed. The code to generate a formfeed is 12. You write the formfeed as follows:
Program File
‘Generate a formfeed and report title
Print CHR(12); "Weekly Energy Report"
Example 2
Another way to use the CHR function is to send a bell to a terminal, computer, or
printer to warn that the ERRORS variable has reached a critically high value. The
ASCII code to generate a bell sound is 7. You write the errors variable notification as
follows:
Program File
‘Decides if too many errors are not acknowledged and generates a
bell
If errors > 15 then print CHR(7)
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LEFT
Alias: FIRST
LEFT returns a string consisting of the leftmost characters of string with a length
specified by integer.

Syntax
Left (string, integer)
Table: LEFT Parameters
Parameter

Description

string

Any text (word or words) or text expression.

integer

Any integer or integer expression up to the
length of the string that tells how many
characters you want from the string.
If integer is greater than the length of the
string then the controller returns the entire
string.

Examples
Example 1
Program File
LVAL = Left("ABCDEF", 2)
This statement returns AB.
Example 2
Suppose that the TEXT variable contains ROOM808; the following statement
retrieves the word ROOM by carrying out the LEFT function:
Program File
LVAL = Left(TEXT, 4)
This statement returns ROOM.
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LENGTH
Alias: LEN
LENGTH returns the number of characters in the string.

Syntax
Length (string)
Table: LENGTH Parameter
Parameter

Description

string

Any text (word or words) or text expression.

Examples
Example 1
Program File
Result = Length ("ABCDE")
The LENGTH function returns 5 and the statement sets RESULT to 5.
Example 2
Program File
Result = Length ("")
The LENGTH function returns 0 and the statement sets RESULT to 0.
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MID
MID returns a string number character extracted from the string starting at offset.

Syntax
MID (string, offset, number)
Table: MID Parameters
Parameter

Description

string

Any text (word or words) or text expression.

offset

The number (or a variable that contains the
number) of the position where you want the
controller to start extracting the string of
characters.
If offset is greater than the length of the
string expression, then MID returns the
empty string, " ".

number

Any number or expression. Tells how many
characters you want extracted from the text
string.

Examples
Example 1
Program File
MIDSTR = MID("ABCDE", 2, 3)
MID returns BCD and the statement sets MIDSTR to BCD.
Example 2
Program File
PARTSTR = MID (ABCDE, 9, 2) returns " ".
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RIGHT
Alias: LAST
RIGHT returns the number of requested characters (the integer) from the text string
starting from the right side (end) and counting left.

Syntax
Right ( string, integer )
Table: RIGHT Parameters
Parameter

Description

string

Any text (word or words) or text expression.

integer

Any integer or integer expression up to the
length of the string that tells how many
characters you want from the string.
If integer is greater than the length of the
string, then the controller returns the entire
string.

Example
Program File
RGTVAL = Right ("ABCDE", 3)
This statement returns CDE.
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SEARCH
SEARCH returns the position of the given search_string within string or 0 if the
controller can’t find the search_string.

Syntax
Search (string, search_string)
Table: SEARCH Parameters
Parameter

Description

string

Any text (word or words) or text expression.

search_string

Any text (word or words) that you want to
search for in the string.

Examples
Example 1
Program File
NSTR = Search ("ABCDE", "BC")
The search returns 2 and sets NSTR to 2, the position BC starts at in the string.
Example 2
Program File
NSTR = Search ("ABCDE", "CB")
The search returns 0 and sets NSTR to 0 because CB is not in the string.
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STRINGFILL
STRINGFILL returns a string of number length containing a particular character that
you specify with the ASCII character code named by character code.

Syntax
Stringfill (number, charactercode)
Table: STRINGFILL Parameters
Parameter

Description

number

Any number or expression. Gives the length
of the string.

charactercode

The ASCII character code of the character
you want to fill the string.

Examples
Example 1
Suppose you want to print a series of 60 asterisks across the top of a report. You
use STRINGFILL to print the asterisks by providing the number 60 for the number of
asterisks, and the number 42 as the ASCII code for the asterisk, as follows:
Print Stringfill(60, 42)
Example 2
You can draw dashed horizontal lines in a report using STRINGFILL by providing
the number of spaces you want the line to print across (60) and the ASCII code for a
dash (45):
Report File
Print Stringfill(60, 45)
Example 3
Suppose you want to design a graph to show the peak kilowatt demand for each
day in the last week. You can create a bar graph by filling the appropriate number of
spaces with, for example, asterisks. The following program sets up such a graph:
Program File
Numeric ShortDays, DayX
Print "Peak KW Demand for Week"
Print " "
For DayX = 1 TO 7
Print ST(ShortDays, DayX);" | "; ~
Stringfill (KWD[DayX]/100, 42)
Next DayX
Print " +----+----+----+----+----+"
Print " 0 500 1000 1500 2000 2500 "
The program prints the title and proceeds to a FOR...NEXT loop.
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Inside the FOR...NEXT loop, the program first prints the short name of the weekday,
based on the number for the day (1 for SUN) using a customized function called ST.
Next, the program prints a plus sign after the name.
STRINGFILL then uses two values to print the kilowatt demand for that day:
Kilowatt demand for the day from the KWD array (KWD[1] = Sunday’s kilowatt
demand, KWD[2] = Monday’s kilowatt demand, and KWD[3] = Tuesday’s kilowatt
demand, and so on.
ASCII code for the asterisk (42).
To see how STRINGFILL uses these two values, take a look at Sunday in the graph
the program produces:
Program File Output
PEAK KWDEMAND FOR WEEK
SUN +******
MON +**********
TUE +********
WED +*********
THU +*******
FRI +********
SAT +***
+---+-----+-----+-----+-----+
0 500 1000 1500 2000 2500
First the program retrieves Sunday’s kilowatt demand from the KWD array.
Sunday’s kilowatt demand is 600 Kw. The program divides the demand by 100,
giving 6. So STRINGFILL prints six asterisks for Sunday.
The program then retrieves Monday’s kilowatt demand from the KWD array.
Monday’s kilowatt demand is 1000 Kw. The program divides the demand by 100,
giving 10. So STRINGFILL prints 10 asterisks for Monday.
The program continues to carry out the same process for each day of the week.
After printing Saturday’s kilowatt demand, the program prints the scale for the
graph, which displays 0 to 2500 Kw.
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TAB
TAB returns a series of continuous blank spaces. The number of blank spaces is
number.

Syntax
Tab (number)
Table: TAB Parameter
Parameter

Description

number

Any number or expression.
The number represents the number of
spaces you want to push the printed text to
the right, as on a typewriter. Must be less
than 132.

Examples
Program File
Print Tab (10); "This is a Title"
Output
This is a Title
The text is moved ten spaces to the right.
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51.153

Time Functions
Time functions perform time-related operations.

51.153.1

DIFFTIME
DIFFTIME calculates the difference in whole seconds, minutes, hours, or days
between two dates and times, date_time1 and date_time2. (Subtracts date_time1
from date_time2.)
For more information, see section 51.154 “DIFFTIME” on page 1840..

51.153.2

TIMEPIECE
TIMEPIECE retrieves the piece of time (hour, minute, second) or the piece of the
date (weekday, month, day of the month, year, day of the year) from a variable or
point.
For more information, see section 51.155 “TIMEPIECE” on page 1842..
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DIFFTIME
DIFFTIME calculates the difference in whole seconds, minutes, hours, or days
between two dates and times, date_time1 and date_time2. (Subtracts date_time1
from date_time2.)

Syntax
Syntax 1: Difftime ( SECOND, date_time1, date_time2 )
Calculates the difference in whole seconds between two dates and times,
date_time1 and date_time2. (Subtracts date_time1 from date_time2.)
Syntax 2: Difftime ( MINUTE, date_time1, date_time2 )
Calculates the different in whole minutes between two dates and times, date_time1
and date_time2. (Subtracts date_time1 from date_time2.)
Syntax 3: Difftime ( HOUR, date_time1, date_time2 )
Calculates the different in whole hours between two dates ad times, date_time1
and date_time2. (Subtracts date_time1 from date_time2.)
Syntax 4: Difftime ( WKD, date_time1, date_time2 )
Calculates and returns the different in whole days between two times and dates,
date_time1 and date_time2. (Subtracts date_time1 from date_time2.)
Table: DIFFTIME Parameters
Parameter

Description

date_time1

Any actual date and time or a datetime
variable.
DIFFTIME always subtracts the first datetime
from the second one.
With SECOND, any time beyond a complete
second is not counted. So, 2 1/2 seconds
becomes 2 seconds.
With MINUTE, any time beyond a complete
minute is not counted. So, 2 minutes and 15
seconds becomes 2 minutes.
With HOUR, any time beyond a complete
hour is not counted. So, 2 hours and 15
minutes becomes 2 hours.
With WKD, any time beyond a complete day
is not counted. So, two days and 15 hours
becomes two days.

date_time2

If date_time1 is later than date_time2,
DIFFTIME returns a negative number.

Examples
Example 1
You can use DIFFTIME with SECOND to determine how many seconds have
passed. The sample program below calculates the difference between two readings
of the datetime variable TIMER.
Program File
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Datetime Timer[2]
If Difftime (second, Timer[1], Timer[2]) > 30 then Run Test
The statement determines the result of TIMER[2] - TIMER[1]. If the difference is
greater than 30 seconds, TEST runs.
You would substitute MINUTE or HOUR in the above example to get time difference
in minutes or hours.
Example 2
You can use DIFFTIME with WKD to determine how many days have passed. The
sample program that follows calculates the difference between the old date (stored
in the OLDDATE variable) and the current date (in the DATE system variable).
Program File
Datetime Timer[2]
Result = Difftime (WKD, OLDTIME, DATE)
The statement sets RESULT to the number of days that DATE - OLDDATE gives.
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51.155

TIMEPIECE
TIMEPIECE retrieves the piece of time (hour, minute, second) or the piece of the
date (weekday, month, day of the month, year, day of the year) from a variable or
point.

Note
Be aware that the days of the week correspond to the following digits:
• Sunday = 1
• Monday = 2
• Tuesday = 3
• Wednesday = 4
• Thursday = 5
• Friday = 6
• Saturday = 7

Syntax
Timepiece (datetime_system_variable, datetime_name)
Table: TIMEPIECE Parameters
Parameter

Description

datetime_system_variable

One of the date or time system variables:
HOUR, MINUTE, SECOND, HOD, TOD,
WEEKDAY, MONTH, DAYOFMONTH,
YEAR, DAYOFYEAR.

datetime_name

Any name that stands for a date and time,
including datetime variables and points and
the DATE system variable.

Examples
Example 1
Program File
Datetime Date1
Numeric CurrentMin
Date1 = StrToDate ("5-25-98 11:13:23")
CurrentMin = Timepiece (Minute, Date1)
In this program, the TIMEPIECE function retrieves the minute from DATE1 and
returns 13.
Example 2
Program File
Numeric TodayMonth
TodayMonth = Timepiece (Month, Date)
In this program, the TIMEPIECE function retrieves the month from the DATE system
variable. If the date is June 20, 2005, TODAYMONTH is set to JUNE.
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51.156

Trigonometric Functions
Trigonometric functions return arccosine, arctangents, and arcsines of given
numbers.

51.156.1

ACOS
ACOS returns the arccosine of the given number.
For more information, see section 51.157 “ACOS” on page 1844..

51.156.2

ASIN
ASIN returns the arcsine of the number.
For more information, see section 51.158 “ASIN” on page 1845..

51.156.3

ATAN
ATAN returns the arctangent of number.
For more information, see section 51.159 “ATAN” on page 1846..

51.156.4

ATAN2
ATAN2 returns an angle with a sine of sin and a cosine of cos.
For more information, see section 51.160 “ATAN2” on page 1847..

51.156.5

COS
COS returns the cosine of number.
For more information, see section 51.161 “COS” on page 1848..

51.156.6

SIN
SIN returns the sine of the angle you specify.
For more information, see section 51.162 “SIN” on page 1849..

51.156.7

TAN
TAN returns the tangent of number.
For more information, see section 51.163 “TAN” on page 1850..
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51.157

ACOS
Alias: ARCCOSINE
ACOS returns the arccosine of the given number.

Syntax
ACOS (number)
Table: ACOS Parameter
Parameter

Description

number

Any number or expression that gives a result
between -1 and 1 inclusive.

The value returned is between 0 and pi (3.14159) radians.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Program File
AN_VALUE = ACOS(.7071)
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51.158

ASIN
Alias: ARCSINE
ASIN returns the arcsine of the number.

Syntax
ASIN (number)
Table: ASIN Parameter
Parameter

Description

number

Any number or expression that gives a result
between -1 and 1 inclusive, or expression
that gives a result in that range.

Returns the arcsine of number as an angle between -3.14159/2 and 3.14159/2.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Program File
Result = ASIN(1)
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51.159

ATAN
Alias: ARCTANGENT
ATAN returns the arctangent of number.

Syntax
ATAN (number)
Table: ATAN Parameter
Parameter

Description

number

Any number or expression.

Returns an angle value between -3.14159/2 and 3.14159/2.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Program File
Val_ARC = ATAN(0)
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51.160

ATAN2
Alias: ARCTANGENT2
ATAN2 returns an angle with a sine of sin and a cosine of cos.

Syntax
ATAN2 (sin, cos)
Table: ATAN2 Parameter
Parameter

Description

sin

A number that is the sine of an angle.

cos

A number that is the cosine of an angle.

The angle returned is between -3.14159 and 3.14159 radians.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Program File
Ang_Damper = ATAN2(0.0, 1.0)
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51.161

COS
Alias: COSINE
COS returns the cosine of number.

Syntax
COS (number)
Table: COS Parameter
Parameter

Description

number

Any number or expression that represents
an angle measured in radians, between 65536 and 65536.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Example 1
Program File
My_COS = COS(3.14159/2)
Example 2
Program File
My_COS = COS(angle)

Technical
1850

04-16006-04-en, March 2015

51 Script Programming
51.162 SIN

51.162

SIN
Alias: SINE
SIN returns the sine of the angle you specify.

Syntax
SIN (number)
Table: SIN Parameter
Parameter

Description

number

Any number or expression. The number
represents an angle in radians, between 65536 and 65536.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Program File
Result = SIN (1)
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51.163

TAN
Alias: TANGENT
TAN returns the tangent of number.

Syntax
TAN (number)
Table: TAN Parameter
Parameter

Description

number

Any number or expression.
The number represents an angle measured
in radians.
Radians = degrees TIMES (3.14159/180).
Degrees = radians TIMES (180/3.14159).

Examples
Program File
Position = TAN (3.14159/180)
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52.1 Script Editor Overview

52.1

Script Editor Overview
Script Editor is a text programming tool you use to create Script programs that
control and monitor building automation systems. Script Editor opens when you
edit a Script program in WorkStation.

52.1.1

Script Editor Program Creation
Script Editor is a text programming tool you use to create Script programs that
control and monitor building automation systems. For example, in WorkStation, you
can create a basic program, called OfficeLights, to control lighting and ventilation in
a room based on occupancy.
For more information, see section 52.2 “Script Editor Program Creation” on page
1854.

52.1.2

Script Editor Features
There are a number of features in Script Editor that allow you to improve the
readability and efficiency of your Script programs. These include:
• Program elements and colors
• Keystrokes
• Collapsible code segments
• Comments
• Auto-completion
For more information, see section 52.5 “Script Editor Features” on page 1864.

52.1.3

Script Compiler Errors
Script compiler errors identify problems that may occur in Script programming.
For more information, see section 52.3 “Script Compiler Errors” on page 1859.

52.1.4

Script Runtime Errors
Script runtime errors identify problems that may occur in Script programming.
For more information, see section 52.4 “Script Runtime Errors” on page 1862.
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52.2

Script Editor Program Creation
Script Editor is a text programming tool you use to create Script programs that
control and monitor building automation systems. For example, in WorkStation, you
can create a basic program, called OfficeLights, to control lighting and ventilation in
a room based on occupancy.

Important
Ensure that you have a working and available Script license. A working license is
required to start Script. For more information, see the Licenses topic on
WebHelp.

Figure: OffliceLights Program in the List View

When you open your new OfficeLights program in Script Editor, you begin by
declaring local variables for the program input and output followed by names for the
variables. For more information, see section 50.16 “Local Variable Declarations” on
page 1592.
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Figure: Variable Declarations

Once you have declared and referenced these variables, you then create the
program lines to specify the type of action you wish the program to perform. Script
programs are composed of everyday language statements, called instructions, so
you do not need to be a programmer to learn how to program with the Script
Editor.
After you finish writing the instructions in your program, you create points in
WorkStation.
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Figure: WorkStation Points

You then bind the variables to those points to view the output.

Figure: Script Program Bindings
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By using bindings, you can increase the flexibility of your building automation
system. For example, you can use your OfficeLights program to control lighting and
ventilation in one room and then use that program for another room by changing
the bindings. You do not need to change all of the local variable names to suit the
new program. When you are finished, you use Script Editor to check the program
for errors and save the program.

Figure: Script Program Check and Save Process

In WorkStation, in the Properties pane, you select the task in which you wish to
include your program. You then execute your Script program.
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Figure: Script Program Execution

You can store your Script programs like a common document and include them
later in other projects for use in your control system. You can also write programs
that perform very complex control system decisions, such as controlling lighting,
boilers, and air handling units at multiple sites.
A single program file controls one piece of equipment, which makes programs
easier to maintain and debug. The capability to control one piece of equipment also
eliminates the possibility of a conflict occurring between the instructions in two
different programs. For example, a program that locks and unlocks a door prevents
the likelihood of an accidental door locking and unlocking.
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52.3

Script Compiler Errors
Script compiler errors identify problems that may occur in Script programming.
Table: Script Compiler Error Messages (1001...1102)
Error

Error Text

1001
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1002

Identifier <name> is too long.

1025

String <name> is too long.

1026

Comment exceeds maximum number of
characters.

1027

Syntax error, unexpected character
<character>.

1029

Syntax error, unexpected token <token>.

1030

Array size <number> is not an integer
between 1 and 36,767.

1031

FOR loop variable and NEXT variable are
different.

1032

GOTO statement is not allowed inside a
loop.

1033

Not enough free memory.

1034

Line <label> is redefined.

1035

Line <label> is not defined.

1036

Local variable <name> is redeclared.

1037

Variable <name> is not declared.

1038

Cannot define any more local variables.

1039

BREAK or CONTINUE is outside a loop or
block.

1040

Argument <name> is redeclared.

1041

Unsupported operational code.

1042

<number> is not a valid number.

1043

Number cannot be longer than 132 digits.

1044

Internal error: Invalid Stack Address.

1045

Internal error: Illegal stack pop operation.

1046

No function with that name exists.

Technical
1861

52 Script Editor
52.3 Script Compiler Errors

Continued
Error

Error Text

1047

Variable is not an attribute.

1048

No quotation marks at end of string.

1054

Path name is too long.

1055

Attribute <name> does not apply to object
<name>.

1056

<name> defines an argument that cannot be
a local variable.

1057

Incorrect array entry type.

1058

Alarm expression is too large.

1059

Cannot set this variable. Make sure the
variable is not an input or function variable.

1060

Cannot set this attribute.

1061

Illegal rotate identifier type.

1062

Cannot enable or disable that object.

1064

Internal error: Stack overflow.

1065

Illegal use of a FOR loop variable. You must
use a local numeric variable.

1067

Cannot set a system variable.

1068

Statement is too long.

1069

System reserved label.

1070

Unsupported feature.

1071

Non integer number.

1072

Passed too many arguments to a function.
Be aware that Script functions support up to
15 arguments.
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1073

Argument outside of index range.

1074

No character is allowed after continuation
symbol.

1075

Cannot Run or Stop program.

1076

Cannot compile report.

1077

Illegal command option.
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Continued
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Error

Error Text

1080

Command is valid only in a program or
function.

1081

Illegal name in alarm expression.

1083

Operation is not available.

1084

Total number of errors: <number>

1086

Syntax error, unexpected keyword
<keyword>

1087

Syntax error, unexpected symbol <symbol>

1088

Syntax error, unexpected symbol.

1089

Syntax error, unexpected comment.

1090

Local variable <name> is not an array.

1091

Syntax error, unexpected end of line.

1092

Syntax error, unexpected end of file.

1093

File not saved - You have not made any
changes.

1095

No Errors.

1096

Total number of characters used in line
labels exceeded maximum.

1097

Object <name> and the program are not in
the same network.

1098

Cannot use custom attribute in Program and
Function.

1099

Exceeded number of displayable lines.

1100

Unknown identifier.

1101

Unknown file type.

1102

End of file.
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52.4

Script Runtime Errors
Script runtime errors identify problems that may occur in Script programming.
Table: Script Runtime Error Messages
Error Text
Illegal type of assignment left-hand identifier
Set type mismatch
Local variable does not exist
Illegal expression type
Illegal hour value
String has more than 255 characters
Operation not supported
Stack Overflow
Illegal argument
Invalid destination
Illegal identifier type
Illegal variable type
Tried to divide a value by zero
Index out of range
Illegal array index
Illegal argument count
Invalid DateTime value
Executed too many statements on one line
Loop variable is not numeric
Error stopping current program
Illegal import ID
Bad path name
Illegal attribute usage
Exit User Function
Invalid set value
Preparse failed
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Continued
Error Text
Could not read from text file
Could not write to text file
Execution failed
Text file open failed
Comm failed
Cannot set attribute
Recursion not supported
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52.5

Script Editor Features
There are a number of features in Script Editor that allow you to improve the
readability and efficiency of your Script programs. These include:
• Program elements and colors
• Keystrokes
• Collapsible code segments
• Comments
• Auto-completion
• Initial binding variable values

52.5.1

Script Editor Program Elements and Colors
Within the Script Editor, each program element is displayed in a different color to
differentiate it from other program elements.
For more information, see section 52.6 “Script Editor Program Elements and
Colors” on page 1866.

52.5.2

Keyboard Shortcuts for Script Editor
You use keystrokes to change, move, find, cut, and paste text in the Script Editor.
For more information, see section 52.7 “Keyboard Shortcuts for Script Editor” on
page 1867.

52.5.3

Collapsible Code Segments
You can improve the readability of your programs by using collapsible code
segments within the Script Editor.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

52.5.4

Comments in Script Programs
Comments are optional sentences you use to help document the operation and
purpose of your Script programs for the reader.
For more information, see section 52.13 “Comments in Script Programs” on page
1876.
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52.5.5

Script Auto-Completion
You can use auto-completion to fill in predictive text based on the possible matches
to the text that you type. Intellisense™ is an auto-completion tool that Building
Operation uses to store a collection of keywords, function names, and constants
that you can use in Script programming.
For more information, see section 52.10 “Script Auto-Completion” on page 1872.

52.5.6

Script Editor Initial Binding Variable Values
In the Script Editor, you have two different ways of setting the initial binding variable
values:
• You can write statements in your Script program
• You can use the Initial Value field in the Variables pane
For more information, see section 52.12 “Script Editor Initial Binding Variable
Values” on page 1874.
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52.6

Script Editor Program Elements and
Colors
Within the Script Editor, each program element is displayed in a different color to
differentiate it from other program elements.
Table: Program Elements and Default Colors
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Program Element

Default Color

Text

Black

Keyword

Blue

Function

Dodger Blue

Value

Maroon

String

Red

Number

Navy

Operator

Teal

Comment

Green
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52.7

Keyboard Shortcuts for Script Editor
You use keystrokes to change, move, find, cut, and paste text in the Script Editor.
Table: Changing and Moving Text
Keystroke

Action

Backspace

Deletes any selected text, or deletes one
character to the left of the cursor.

CTRL + F

Opens the Find dialog box.

Ctrl + Insert or CTRL + C

Copies selected text and stores that text in
the clipboard.

Shift + Insert

Inserts text wherever you wish.

Delete

Deletes selected text or deletes one
character to the right of the cursor. If the
cursor is at the end of a line, connects the
line to the next one.

Enter

Ends a line and starts a new one.

Insert

Toggles between two modes:
• Insert – Inserting text into current text
• Overwrite – Typing over current text
The current mode is shown on the Status
bar on the bottom of the Script Editor
screen.
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Shift + Delete or CTRL + X

Cuts the selected text and stores that text in
the clipboard.

Shift + Insert or CTRL + V

Pastes the text you last cut or copied at the
current cursor position in your program.
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52.8

Collapsible Code Segments
You can improve the readability of your programs by using collapsible code
segments within the Script Editor.
You can expand or collapse code for the following types of code segments:
• For...Next
• While...Endwhile
• Repeat...Until
• Select Case...Endselect
Collapsed code segments display as text within the program next to a Maximize
button indicating the keyword/collapser name in place of the full code lines.

52.8.1

Clipboard
You use the Clipboard pane as the area to store copied and cut items while
programming. You can paste items from the Clipboard into any of the program
editor panes that are being used. For example, by double-clicking on an item in the
clipboard pane, you can insert that text into the program where the cursor is
currently located.
You access the cut, copy, and paste commands in one of two ways:
• By using the toolbar buttons
• Through the use of keyboard shortcuts

52.8.2

Code Library
Within Script Editor, the Code Library is a helpful programming tool that allows you
to create multiple folders to save, organize, and recall frequently used text. You
store folders on your PC and these folders appear alphabetically in the Code Library
pane.
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Figure: Folders

A code library folder is made up of frequently used units of text called entries. These
entries can be single words, a full code line, a function, or even an entire Script
program. You can decide how much and what kind of text is stored as an item
according to your programming preferences.
You can also give entries meaningful names to help you identify and use them
easily. You can reference the code library file from anywhere on the PC that you use
to run WorkStation.

System-Provided Programs, Functions, and Sample Import Files
The Script Editor Code Library contains a series of system-provided programs,
functions, and sample import files that can help you solve common problems. For
example, the sample import files help to implement and utilize Script program
features such as simulation and calculation programs. The Code Library contains
the entire set of objects, such as programs, functions, and values necessary for the
application to function.
You can use these system-provided programs, functions, and sample import files
as-is or as samples when developing your own Script programs. They are located in
the designated folders in the Code Library.
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Figure: System-Provided Code Library Programs, Functions, and Import Files
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52.9

Adding a Line
You add lines to specify the type of action you want your Script program to perform.
A line is an instruction or series of instructions that belong together under one line
label.
For more information, see section 50.11 “Lines and Line Numbers” on page 1583.

To add a line
1. In Script Editor, type a line label that is preceded by the Line keyword or
followed by a colon, and then add the instructions that belong to the line label.

You have now added line labels and instructions in your program.
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52.10

Script Auto-Completion
You can use auto-completion to fill in predictive text based on the possible matches
to the text that you type. Intellisense™ is an auto-completion tool that Building
Operation uses to store a collection of keywords, function names, and constants
that you can use in Script programming.
These matches display for Script keywords, functions, and constants. The list of
words displays in a box to the right side of the cursor when you start typing a new
word.

Figure: Auto-completion

As more characters are typed, the list shrinks as the possible matches decrease. If
there are no matches, the box closes automatically.
ToolTips display next to the text options with information about each, such as
function description, keyword name, and function parameters. You can use
ToolTips to auto-complete the text by selecting any of the options listed.
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52.11

Using Script Auto-Completion
To save time, you use auto-completion to fill in predictive text based on possible
matches to the text you enter in your Script programs or functions.
For more information, see section 52.10 “Script Auto-Completion” on page 1872.

To Use Script auto-completion
1. In Script Editor, start typing and notice the predictive text that displays for
Script keywords, functions, and constants.

2. In the list, double-click the text you want to use.
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52.12

Script Editor Initial Binding Variable
Values
In the Script Editor, you have two different ways of setting the initial binding variable
values:
• You can write statements in your Script program
• You can use the Initial Value field in the Variables pane

52.12.1

Statements in Script Programs
You can write statements directly in your Script program using an initialization line,
with one or more statements typically setting the output variables.
Initializing:
Set Output1 to 1
Set Output2 to 2
...
E:
'Some Error occurred, Restart Execution
GoTo Initializing

Tip
With this method, you can issue a GoTo statement to the initialization line
anywhere in the program. This GoTo statement directs the program to re-execute
the initialization statements and start over (based on program execution logic).

52.12.2

Script Editor Variables Pane Initial Value Field
You can configure initial binding variables values using the Initial Value field in Script
Editor's Variables pane.
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Figure: Script Editor Variables Pane

When you configure the initial binding variable values in the Variables pane, the
program uses those values. However, when those variables are bound to object
properties, the program uses the variable values of the objects when it runs, instead
of the initial ones from the Variables pane.
The table that follows explains how to configure an initial value for each variable
type.
Table: Initial Value Variable Types
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Variable

Expected Value

Configuration object

Float

Numeric

Text box

Integer

Numeric

Text box

Boolean

Numeric

Dropdown

String

String

Text box

DateTime

DateTime

Date and time picker
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52.13

Comments in Script Programs
Comments are optional sentences you use to help document the operation and
purpose of your Script programs for the reader.
Comments are not operated upon. Instead, you enter comments as single lines
preceded by a single quotation mark (‘).

Note
• Script supports characters at or below ASCII 127. Additional characters are
not supported and are replaced by a question mark (?).

Figure: Comments in Script Program

You can add as many comments as necessary, but each is restricted to one
physical (132 characters) line.
You can also add a comment after a statement on the same physical line, such as
the following:
TURN THE FAN ON ‘start cooling
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52.14

Adding a Comment
You use optional comments to help document the operation and purpose of a
Script program or function.
For more information, see section 52.13 “Comments in Script Programs” on page
1876.

To add a comment
1. In Script Editor, type a single quotation mark (') and then type a comment.

You can add a comment at the beginning of the program or function to explain its
purpose. You can also add comments at the end of any statement in a Script
program or function.
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52.15

Checking and Saving a Script Program
You check your Script program to ensure there are no syntax errors. You perform a
save operation to check and then save your Script program.

Important
If you save a program that contains errors, that program will not run. The progam
must have a successful check before running.
For more information, see section 50.3 “Script Programs” on page 1565.

To check and save a Script program
1. In Script Editor, click Check.
2. In the Check pane, double-click on an error message to go to the line of code
that contains the error.

3. Click Save to check and save your Script program.
When you save a program that contains Input, Output, Public, Function and
WebService variables, the entries are automatically added to the
corresponding binding tabs in the Properties pane.
The Script Editor displays a Save Successful message, even if the program
contains errors and does not compile successfully.
You have now checked and saved your Script program.
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52.16

Executing a Script Program
You execute a Script program in order to tell the Automation Server or Enterprise
Server to take a specific action to control a building.
For more information, see section 50.23 “Tasks” on page 1602.

To execute a Script program
1. In WorkStation, in the List View, select the Script program.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. In the Task box, enter the task you want to add to the program.

The default is Task 3.
5. Click OK.
6. In the List View, select the program you want to execute.
7. On the Actions menu, click Restart.
Continued on next page
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8. In the Script Program Properties Basic tab, observe that the Runtime
fields, such as TS, TM, and TH, update as the program executes.
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52.17

Importing Script Program Code
You import Script program code to reuse all or parts of existing code. Script Editor
supports import of .txt files created using the Plain English tool, as well as previously
created Script program files.
For more information, see section 50.10 “Script Program Instructions” on page
1581.

To import Script program code
1. In WorkStation, in the System Tree pane, select the Script program or
function you want to import program code to.
2. On the Actions menu, click Edit.
3. In Script Editor, position the insertion point in the program or function where
you want to import program code.
4. Click the Script menu button

.

5. Point to Import and click Text or Plain English.
6. Select the file you want to import.
7. Click Open.
8. Click Save.

Tip
• When a Plain English .txt file is imported, you have to load the file
and complete a conversion process. As a result of these
conversions, you may need to make adjustments to the
imported script program code.
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52.18

Exporting a Script Program
You can export the contents of any program file to a .txt file in the Script Editor. This
lets you export programs and modify them in a text editor application separate from
WorkStation, or write them to a text file for use in another location.

Note
• To import text into a new program, create the program in a text editor first
and then import the .txt file.
For more information, see section 50.3 “Script Programs” on page 1565.

To export a Script program
1. In WorkStation, in the List View, select the Script program or function you
want to open.
2. On the Actions menu, click Edit.
3. In Script Editor, select the text in the program that you want to export.
4. Click the Script menu button

.

5. Click Export.
6. Select the location where you want to save the exported text.
7. In the File name box, enter a name for the .txt file.
8. Click Save.
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52.19

Converting a Plain English File
You convert Plain English files to Script to reuse all or parts of existing Plain English
code.
For more information, see the Script and Plain English Program Differences topic on
WebHelp.

To convert a Plain English file
1. In WorkStation, in the System Tree pane, select the Script program or
function you want to convert Plain English code to.
2. On the Actions menu, click Edit.
3. In Script Editor, position the insertion point in the program or function where
you want to import the Plain English code.
4. Click the Script menu icon
English.

, point to Import and then click Plain

5. Click Load file to load an entire PE file, or paste the text you want from your
PE program or function into the Plain English Editor pane.

6. Select the .txt file you want to convert.
7. Click Open.
Continued on next page
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8. Convert all or part of the file:
• Click Convert all to convert the entire PE file to a Script program.
• Select the lines you want to convert and then click Convert selected to
convert the selected lines to the Script program or function.

9. Correct any errors that occur during the conversion.
10. Click Close.
11. In Script Editor, click Save.
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52.20

Customizing the Script Editor
You can customize the Script Editor and choose the preferred layout, line numbers,
or colors you want to use. You can also customize the appearance of programming
elements for easy identification, or select a path for use with code libraries and the
import/export tool.
For more information, see section 52.5 “Script Editor Features” on page 1864.

To customize the Script Editor
1. In Script Editor, click Options.
2. Click the General tab.

3. Select Tabbed documents to display your programs and functions as
tabbed documents in the Script Editor.
4. Select Multiple documents to display your programs and functions as
multiple documents in the Script Editor.
5. Select Enable IntelliSense to auto-complete keywords, function names,
and constants as you create programs in the Script Editor.
For more information, see section 52.10 “Script Auto-Completion” on page
1872.
6. Select Enable outlining to show the code segments eligible for collapse.
7. Select Show line numbers to display line numbers in the program window.
8. Click Restore default settings to restore the settings to their default values.
9. Click the Fonts and Colors tab.
10. In the Font box, click the drop-down menu to select the font you want to use.
11. In the Size box, select the font size.
Continued on next page
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12. In the Display items list, select the Script programming language element
you want to locate and highlight in your program.
For example, specify that a string in your Script program is highlighted in red.

13. Click Apply. Notice that the string in your Script program is now highlighted.

Continued on next page
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14. Click the Paths tab.

15. For Code library path, enter a path:
• Click Browse to locate and select a path.
Click Restore to specify the default path.
16. For Import / export path, enter a path:
• Click Browse to locate and select a path.
• Click Restore to specify the default path.
17. Click OK.
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52.21

Using a Collapsible Script Code Block
You improve the readability of your Script programs and functions by using
collapsible code blocks within Script Editor. Code blocks are elements that Script
Editor automatically adds for certain types of program statements, such as
For...Next, Repeat...Until, Select Case...Endselect, and While...Endwhile.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

To use a collapsible Script code block
1. In Script Editor, create a code block that determines squares using the
For...Next, Repeat...Until, Select Case...Endselect, or While...Endwhile
statements.

Continued on next page

Technical
1890

04-16006-04-en, March 2015

52 Script Editor
52.21 Using a Collapsible Script Code Block

2. Expand or collapse the code in the code block by clicking + (Maximize), or (Minimize).
Collapsed code blocks appear as text within the program next to a + button
that indicates the keyword/collapser name in place of the full code lines.

You have now utilized a collapsible code block.
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52.22

Adding an Entry to the Code Library
You can add entries to the code library in Script Editor. Entries can be single words,
a full code line, a function, or a Script program.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

To add an entry to the code library
1. In Script Editor, select the text that you want to save.
2. Right-click and select Add to library.

Continued on next page
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3. In the Entry name box, type an entry name.

4. In the Create in box, select a code library folder:
• Select a folder from the list to add the entry to an existing folder.
• Click New folder to add the entry to a new folder.
Continued on next page
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5. Click Add.

Technical
1894

04-16006-04-en, March 2015

52 Script Editor
52.23 Working with Code Library Folders

52.23

Working with Code Library Folders
You can add, delete, and rename code library folders on your PC using Script
Editor. A code library is composed of frequently used units of text called entries.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

To work with code library folders
1. In Script Editor, click Library.
2. In the Library pane, click a folder.
3. To add a new folder, right-click and click New folder. Then, enter a name for
the folder and click OK.

4. To change a folder name, right-click and click Rename folder. Then, enter a
new name for the folder and click OK.
5. To delete a folder and its contents, right-click and click Delete folder. Then,
click Yes.
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52.24

Working with Code Library Sample
Import Files
You use the system-provided sample import files in the Script Editor Code Library
to develop your own Script programs that utilize Web Services. In this procedure,
the sample import file provides you with weather data, such as temperature and
humidity, for a given US zip code.
For more information, see section 53.1 “Script Web Services” on page 1917.

To work with code library sample import files
1. In Script Editor, click Library.
2. In the Library pane, click Sample Import Files.
Continued on next page

Technical
1896

04-16006-04-en, March 2015

52 Script Editor
52.24 Working with Code Library Sample Import Files

3. Double-click the sample import file you want, such as WebService SOAP US
City Weather by ZipCode.xml file.

A dialog then displays with a summary of the impending import operation.

Tip
By default, the path for the import is the Server. You cannot change
Continued on next page
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the path.
4. Click Import.
All of the objects contained in the import sample file are created in the server.
5. In the List View, click the City Zip Code variable and on the File menu, click
Properties.
6. Enter the zip code you want, such as 01845 for North Andover, MA.

7. Click OK.
Continued on next page
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8. Drag these City values to the Watch pane and observe the functioning
program as it obtains the temperature and humidity for zip code 01845.

9. In the List View, click the GET US City Weather by Zip Code program.
10. On the Actions menu, click Edit.
Continued on next page
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11. View and edit the program as needed.

12. Click Save to execute the updated GET US City Weather by Zip Code
program.
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52.25

Working with Code Library Items
You use items such as programs and functions in the code library when developing
your own Script programs and functions.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

To work with code library items
1. In Script Editor, click Library.
2. In the Library pane, click the folder that contains the item.
3. Right-click the item and then click Rename item.

4. Enter a new name in the highlighted area.
5. To delete a code library item, click Delete item and then click Yes when
prompted.
6. To move a code library item, click Move to folder and then select the code
library location from the list.
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52.26

Inserting a Code Library Item in a Script
Program or Function
You insert a code library item in a Script program or function to add a frequently
used unit of text such as a single word, a program instruction, a program line or set
of instructions, or a complete function or program.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

To insert a code library item in a Script program or function
1. In Script Editor, position the insertion point in the program or function where
you want to insert the item.
2. Click Library.
3. In the Library pane, click the folder that contains the item.
4. Right-click the item and click Insert in editor.

The item appears at your insertion point in the Script program or function.
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52.27

Referencing the Code Library File
You reference the code library file from anywhere on the PC you choose to run
Script.
For more information, see section 52.8 “Collapsible Code Segments” on page
1868.

To reference the code library file
1. In Script Editor, click Options.
2. Click the Paths tab.
3. For Code library path, enter a path:
• Click Browse to locate and select a path.
• Click Restore to specify the default path.

4. Click OK.
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52.28

Finding Text in Script Editor
You can find text in a Script program or function using the Script Editor toolbar Find
field.

Important
• Use this method when you want to search only the current program.
For more information, see section 52.5 “Script Editor Features” on page 1864.

To find text in Script Editor
1. In Script Editor, position the insertion point where you want to begin searching
in the program or function.
2. In the Find box, type the text or string you want to find in the program or
function.

3. Click the Find icon

.

4. In the Find and replace dialog, click Find.

5. In the current program or function, view the highlighted results.

6. Click Enter to find the next instance of the queried text.
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52.29

Using Undo and Redo in Script Editor
You use the Undo button on the Quick access toolbar in Script Editor to undo the
last keystroke or action. You use the Redo button to repeat the last keystroke or
action that you previously undid.
For more information, see section 52.5 “Script Editor Features” on page 1864.

To use Undo and Redo in Script Editor
1. In Script Editor, click the Undo button
action.
2. Click the Redo button
previously undid.

to undo the last keystroke or

to repeat the last keystroke or action that you

Note
• The limit of Undo and Redo actions is forward or backwards by
24 instances.
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52.30

Script Debugger
In order to solve complex problems, Script programs have become more and more
sophisticated. With this increased sophistication, finding and fixing issues in the
program's logic has become even more difficult. The Script Debugger is designed
to address such issues.
For example, in the Script Debugger, you can single step through your Script
programs and proceed to the next executing line. You can visually trace your
program's operation as it highlights every executing statement, potentially
uncovering any problems in the program's logic.
You can also set a breakpoint in order to do the following:
• Establish a line where you want your program execution to stop.
• Examine or change variable values.
• Resume execution from that point.
When setting a breakpoint, you may discover the statement at that line is never
reached, uncovering a potential problem. The ability to identify problems in your
Script programs is one of the major advantages of the Script Debugger. Using its
in-session editing capabilities, you can then edit and fix any of the issues that you
identify.

52.30.1

Debug Mode Editing
In the Script Debugger, you can utilize debug mode editing features that allow you
to skip over troublesome areas in your Script programs and then resolve their
problems later. For example, you can use the following features
• Line E ignores error conditions and continues executing your Script programs.
You can then go back later and clear the error condition by correcting the
program's logic.
• Set next statement places the cursor at any executable statement or line in
your Script program. That line then gets highlighted and when you click Go or
single Step, gets executed. Execution resumes or starts from that newlyselected statement, thus letting you skip over troublesome program issues.
• Comments selected lets you comment out one or more selected statements in
your Script program. By doing so, you direct Script program execution to
ignore commented statements in the Debugger until you identify and fix the
problems. You may also uncomment one or more selected statements and
direct your program to execute them. This is particularly useful for debugging
large Script programs with a number of loops.

52.30.2

Debug b3 BACnet Script Programs
Directly troubleshooting b3 BACnet device Script programs is not supported in the
Script Debugger. However, you can create an Automation Server Script program
that contains similar logic. You can then use this Automation Server Script program
to access b3 BACnet device points and debug that program. Be aware, however,
that not every syntax permitted in the b3 BACnet device is available in an
Automation Server.
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Note
Nested function calls are also not supported in the Script Debugger.
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52.31

Script Debugger Function Keys
You can use function keys in the Script Debugger to go to the next executing line in
your Script program, set or remove a breakpoint, or continuously execute your
program until a breakpoint is reached.
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Function Key

Action

Acts like...

F5

Continuously executes a
Script program until a
breakpoint is reached or
execution ends.

Clicking Go in the Script
toolbar

F9

Sets or removes a
breakpoint in your Script
program.

Selecting the Insert
breakpoint menu item

F10

Goes to the next executing
line in the Script program.

Clicking Step in the Script
toolbar
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52.32

Debugging a Script Program
You use the Script Debugger to troubleshoot the Script programs you create.
For more information, see section 52.30 “Script Debugger ” on page 1904.

To debug a Script program
1. In WorkStation, in the List View, select the Script program you want to
debug.
2. On the Actions menu, click Edit.
3. In the Script Editor toolbar, click Start to initiate a Script debugging session.

4. Debug your Script program.
Continued on next page
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5. Click Trace On to initate a continuous single step operation. This saves you
from having to constantly press Step.

Note
The icon beside the program name changes to indicate the Script
Editor is now in Debug mode. Be aware that you can only debug one
program at a time.
6. Control the Trace operation.
For more information, see section 52.33 “Controlling the Trace Operation in
the Script Debugger ” on page 1911.
Continued on next page
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7. Click Step to go to the next executing line in your Script program.

8. Click Go to continuously execute a Script program until a breakpoint is
reached, or execution ends
9. Right click and select Insert breakpoint to toggle a breakpoint in your Script
program.

Programs execute until they reach a programmed breakpoint.
10. Place the cursor at any executable statement or line in your Script program.
Continued on next page
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11. Right click and select Set next statement from the Script Editor context
menu.
That line in the program gets highlighted.

12. Click Go or single Step to execute that statement.
Program execution resumes or starts from that newly-selected statement.
13. When finished, click Stop to terminate your Script debugging session.
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52.33

Controlling the Trace Operation in the
Script Debugger
You can control the Trace operation in the Script Debugger by setting a breakpoint
stop or specifying the timing trace.
For more information, see section 52.30 “Script Debugger ” on page 1904.

To control the trace operation in the Script Debugger
1. In WorkStation, in the List View, select the Script program you want to
debug.
2. On the Actions menu, click Edit.
3. In the Script Editor toolbar, click Options.
4. Click Debugger.

5. Control the Trace operation by clicking the Stop in breakpoint while
tracing check box.
6. In the Trace timer (ms) field, enter a value that specifies the timing of the
Trace operation.
Optionally, you may adjust the frequency of program statement execution,
such as .25, or .50 of a second.
7. Click Apply.
8. Click OK.
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52.34

Changing Values in the Script Debugger
Local or Binding Variables Pane
While in the Script Debugger, you can use the Local or Binding Variables pane
to re-calculate your Script program values.
For more information, see section 52.30 “Script Debugger ” on page 1904.

To change values in the Script Debugger local or binding
variables pane
1. In WorkStation, in the List View, select the Script program you want to
debug.
2. On the Actions menu, click Edit.
3. Click Start to enter the Script Debugger.
4. In the Script Debugger, click the Value field in the Local or Binding
Variables pane.

Continued on next page
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5. Type the new value and press Enter.

For example, you can change values here to force a shutdown in case the
boiler temperature rises above 100°.
6. Click Stop to exit the Script Debugger.
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53.1

Script Web Services
Web Services are programmable applications accessible from standard Internet
protocols, like HTTP and XML. Web Services help solve application integration
challenges by allowing applications to communicate with one another independent
of the target, host operating system, object model, or programming language.

Figure: Web Services Overview

Web Services are designed to support interoperable, machine-to-machine
interaction over a network. As a result, it makes perfect sense to use a Web Service
from a programming language, like Script. Because the Web Service is an
application delivered and utilized with regular Internet standards, the Web Service
operates as a URL by programmatically returning information for clients to employ.
The URL acts as a URI that specifies the location, identifies the available resource,
and provides a mechanism for retrieving it. For example, the following URLs identify
available online calculator and weather services:
• http://www.cs.fsu.edu/~engelen/calc.wsdl?wsdl
• http://ws.cdyne.com/WeatherWS/Weather.asmx?wsdl
To interact with Web Services, Script uses the Web Services Description Language
(WSDL) file to extract information about functions, parameters, and return types.
WSDL is an XML-based language that provides a model for describing Web
Services. For more information, see section 118.2 “Web Services ” on page 5064.

53.1.1

Script Web Services Workflow
You create and configure a Script Web Service by following these four basic steps:
• Create the Web Service interface
• Configure the Web Service interface
• Create a Script program
• Configure the Script Program to use Web Services
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For more information, see section 53.2 “Script Web Services Workflow” on page
1919.

53.1.2

Script SOAP Web Services Data Type
The Simple Object Access Protocol (SOAP) is a protocol for exchanging structured
information when implementing Web Services in computer networks. The Web
Service data type supports the interaction between a SOAP-based Web Service
and Script.
For more information, see section 53.6 “Script SOAP Web Services Data Type” on
page 1927.

53.1.3

Script RESTFul Web Services
REST (Representational State Transfer) is a style of software architecture for
distributed hypermedia systems, such as the World Wide Web. REST has emerged
as a predominant Web Service design model since it is lighter and simpler to use
than SOAP.
For more information, see section 53.7 “Script RESTful Web Services” on page
1931.
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53.2

Script Web Services Workflow
You create and configure a Script Web Service by following these four basic steps:
• Create the Web Service interface
• Configure the Web Service interface
• Create a Script Program
• Configure the Script Program to use Web Services
For example, you can use the online calculator service at Florida State University to
add 2 numerics and calculate the result. In WorkStation, you create a Script Web
Service interface called Calculator and configure this interface by entering the
location of the service you wish to target. In this example, you enter the URL of a
WSDL file located at http://www.cs.fsu.edu/~calc.wsdl?wsdl.

You then create a Script program named Calculator Program and configure this
Script program to use Web Services. In this example, you use the Webservice
keyword to declare the Web Service in the program.
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53.3

Creating a Script Web Service Interface
You create a Script Web Service to identify and deliver with standard Internet
protocols an application that you can utilize as a service.
For more information, see section 53.1 “Script Web Services” on page 1917.

To create a Script Web Service interface
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create a Web Service interface.
2. On the File menu, point to New and click Interface.
3. In the object type list, expand Web Service and then click Script Web
Service.

4. In the Name box, type the name of the Web Service interface.
5. In the Description box, type a description of the Web Service interface.
6. Click Create.
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53.4

Configuring a Script Web Service
Interface
You configure a Script Web Service interface by entering the URL or WSDL file
location and then specifying the service you wish to target.
For more information, see section 53.2 “Script Web Services Workflow” on page
1919.

To configure a Script Web Service interface
1. In WorkStation, in the System Tree pane, select the Web Service interface.
2. On the File menu, click Properties.
3. Click the Basic tab.

4. In the Wsdl Url box, type the URL or a WSDL file located on a local PC or on
the Internet.
Continued on next page
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5. In the Service box, enter the name of the service you want to target.

Tip
• When you create a Web Service, you should ensure that your PC
can connect to the target service.
6. In the EndPoint box, type the URL of the machine where the Web Service
calls are processed.

Note
• Typically, the WSDL file defines the EndPoint, in which case, this
box is completed automatically. In some circumstances, you
may still need to enter an EndPoint, however.
7. Click OK.
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53.5

Configuring a Script Program to use
Web Services
You select a Script program and then configure that program to use Web Services.
For more information, see section 53.2 “Script Web Services Workflow” on page
1919.

To configure a Script program to use Web Services
1. In WorkStation, in the System Tree pane, select the Script program that you
want to use Web Services.
2. On the Actions menu, click Edit.
3. In Script Editor, use the Webservice keyword to declare the Web Service in
the program.

4. In the Script Editor toolbar, click Save.
5. In the Properties pane, click the Web Services tab.
Continued on next page
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6. Enter the path to the Script Web Service interface.

7. In the Script Editor toolbar, click Save.
8. Continue building your Script program.
9. In the Script Editor toolbar, click Save.
Continued on next page
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10. In the Variables pane, view the results of the Web Service program.

Technical
1928

04-16006-04-en, March 2015

53 Script Web Services
53.6 Script SOAP Web Services Data Type

53.6

Script SOAP Web Services Data Type
The Simple Object Access Protocol (SOAP) is a protocol for exchanging structured
information when implementing Web Services in computer networks. The Web
Service data type supports the interaction between a SOAP-based Web Service
and Script.
SOAP relies on XML for its message format, and usually relies on other application
protocols for message negotiation and transmission. SOAP can form the foundation
layer for Web Services and also provide a basic messaging framework upon which
Web Services are built.
You bind the Script Web Services object to a corresponding Script program. Once
you do so, Script extracts all of the necessary material, including the methods, data
type for the arguments, and return values and their types.

Figure: Web Services Object Model

The Script Editor then displays Web Services methods using Intellisense.
Intellisense is an auto-completion tool that you use to fill in predictive text based on
possible matches to the text you type. For more information, see section 52.10
“Script Auto-Completion” on page 1872.
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53.6.1

Supported Data Types
Only simple data types are supported for both Web Service methods and return
values including:
• String
• Numerics
• DateTime
Complex types are supported with the String data type. To manipulate complex
types, you use Script string operations.

Tip
Web Service method calls need their own execution lines within Script programs.

53.6.2

Web Service Declarations
You declare a Web Service the same way you declare a function. You do so using
the keyword Webservice followed by a local variable name at the beginning of your
Script program. Then, you bind a Web Service object to the Script program using
the binding generated by this Web Service declaration as shown:

Figure: Web Services Declarations
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In Script Editor, you use the .(dot) syntax to select the Web Service execution
method as shown here.

Figure: Web Services .(Dot) Notation

53.6.3

Web Service Selection and EndPoints
You select the Web Service you want to target by entering the Wsdl Url in the Basic
tab. In this case, the URL identifies an online calculator service. The Service field is
populated when you enter a valid Web Service URL. A WSDL file can contain one or
more services.
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Figure: Web Service Selection

Tip
When you create a Web Service, be sure that your PC can connect to the target
service.
The EndPoint is a reference to an entity, processor, machine, or resource for target
Web Service messages and calls. It represents the URL of the machine where the
Web Service calls are processed. Typically, information about EndPoints is
embedded inside the WSDL files. In those cases, the box is completed
automatically. In some circumstances, you may still have to enter an EndPoint,
however.
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53.7

Script RESTful Web Services
REST (Representational State Transfer) is a style of software architecture for
distributed hypermedia systems, such as the World Wide Web. REST has emerged
as a predominant Web Service design model since it is lighter and simpler to use
than SOAP.
REST defines a set of architectural principles you can use to connect to Web
Services that focus on a system's resources. This includes how resource states are
addressed and transferred over Hypertext Transfer Protocol (HTTP) by a wide range
of clients written in different languages. For more information, see section 53.6
“Script SOAP Web Services Data Type” on page 1927.
Script supports the generic use of REST Web Services through new Application
Programming Interfaces (APIs).

53.7.1

SendWebRequest
The SendWebRequest system function sends a request to a Uniform Resource
Locator (URL). Requests are sent from the running program in Script to a particular
Universal Resource Identifier (URI) following standard HTTP protocols.
The syntax for SendWebRequest is as follows:
SendWebRequest(BaseUrl,Method,ContentType,Headers,Message)
where:
• BaseUrl – A string with the location of the base URL to request data.
• Method – A string that contains the method type to access the URL. It can
take the following values:
– "POST"
– "GET"
• Headers – The headers for the HTTP message. Header fields are colonseparated name-value pairs that can be concatenated with semi-colons (for
example, "IsMobileApp:TRUE;IsAndroidClient:TRUE")
• ContentType – A string that contains the content type. It is usually defined by
the target URL itself.
• Message – A string that contains the message sent to the URL. It is usually in
query-string values.
The return value is a string, usually in XML, that contains the response from the Web
Service.

53.7.2

UrlEncode
The UrlEncode system function encodes the entire URL, including the message
with its query-string values. If characters, such as blanks, punctuation marks, and
arithmetic are passed directly to the HTTP stream, they may be misinterpreted and
result in the return of incorrect results. This function converts characters that are not
allowed in a URL into their equivalents.
The syntax for UrlEncode is as follows:
UrlEncode(Message)
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where:
Message is a string that needs Url encoding.
The return value is a string with valid characters the HTTP stream transmits.
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53.8

Using Script to Send a Request to a
RESTful Web Service
You can use the SendWebRequest system function to send a request to a RESTful
Web Service. In this procedure, you use SendWebRequest to request US city
weather data.
For more information, see section 53.7 “Script RESTful Web Services” on page
1931.

To use Script to send a request to a RESTful Web Service
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create a Script program.
2. On the File menu, point to New and then click Program.
3. In the Name box, enter the name of your new Script program, such as Get US
City Weather by ZIP.

4. In the Description box, type a description of the program.
5. Click Create.
6. In the List View, click the new Weather by ZIP Script program.
7. Click Edit.
Continued on next page

04-16006-04-en, March 2015

Technical
1935

53 Script Web Services
53.8 Using Script to Send a Request to a RESTful Web Service

8. Develop a Script program using the SendWebRequest system function and
the following parameters:
• BaseUrl – http://wsf.cdyne.com
• Method – GET
• ContentType – txt/xml
• Headers – ""
• Message –
/WeatherWS/Weather.asmx/GetCityWeatherbyZIP?ZIP=02109
9. In the Script Editor toolbar, click Save.

10. Close the Script Editor.
11. In the List View, click the Get US City Weather by ZIP Script program.
12. In the Actions menu, click Restart to start the Script program.
13. On the File menu, click File and then Properties.
Continued on next page
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14. Click the Outputs tab and observe the resultXMLString output for zip code
02109.

The current weather for Boston is as follows:
• Description – Cloudy
• Temperature – 34°F
• Relative Humidity – 72%
• Wind - North at 13 MPH
• Barometric Pressure – 30.45 Steady
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53.9

Using Script to Obtain a Secure Web
Page from a RESTful Web Service
You can use the SendWebRequest system function to obtain a secure web page
from a RESTful Web Service. In this procedure, you obtain a secure SSL certificate
authority page.
For more information, see section 53.7 “Script RESTful Web Services” on page
1931.

To use Script to obtain a secure web page from a RESTful Web
Service
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create a Script program.
2. On the File menu, click New and Program.
3. In the Name box, type the name of your new Script program, such as Get
Secure Web Page.

4. In the Description box, enter a description of the program.
5. Click Create.
6. In the List View, click the new Get Secure Web Page program.
7. Click Edit.
Continued on next page
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8. Develop a Script program using the SendWebRequest system function and
the following parameters:
• BaseUrl – https://ssl.trustwave.com
• Method – GET
• ContentType – txt/xml
• Headers – ""
• Message – None
9. In the Script Editor toolbar, click Save.

10. Close the Script Editor.
11. In the List View, click the Get Secure Web Page Script program.
12. In the Actions menu, click Restart to start the Script program.
13. On the File menu, click File and then Properties.
Continued on next page
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14. Click the Outputs tab and observe the webPageString output.
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54.1 Script Editor

54.1

Script Editor
Use the Script Editor to develop Script programs.

Figure:

Table: Script Editor
Number

Description
Script Editor Toolbars
Use the toolbars to perform a variety of
functions, including opening, closing, saving,
printing, importing, and exporting Script
programs.
Clipboard pane
Use this pane to store copied and cut items
to use in Script programming. By doubleclicking on an item in the clipboard pane,
you can insert that text into the program
where the cursor is currently located.
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Continued
Number

Description
Status bar
Use this pane to review the path of the active
Script program or function. You can view the
line and column where the cursor is
positioned within the current editor pane.
The status bar also identifies the input
method, Insert or Overwrite, currently being
used in the editor.
Code Library pane
Use this pane to create and display the
folders and entries contained within your
code library. You can use the Code Library
to create multiple folders to save, organize,
and recall frequently used text. You can also
use the system-provided programs and
functions available in the Code Library when
developing your Script programs and
functions.
Properties pane
Use this pane to view and change general,
configuration, and runtime information about
your Script programs and fuctions and their
inputs and outputs tabs.
Local Variables pane
Binding Variables pane
Use these panes to view and edit properties
of the local or binding variables in the Script
Editor.
For more information, see section 54.4
“Script Editor – Local Variables Pane” on
page 1948.
For more information, see section 54.3
“Script Editor – Binding Variables Pane” on
page 1947.
Check pane
Use this pane to review the results of your
program compilation, including any syntax
errors. If the Script Editor checks a program
and finds no errors, a Check Successful
message displays. If errors occur, they
display with the error message number, line
and column location within the program, and
text or keywords involved.
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Continued
Number

Description
Find pane
Use this pane to locate and display queried
text. The Find pane displays the queried text
in quotes on the first line of the pane, the
open program the instance is located in, the
line number within the program where the
text can be found, and the context in which
the queried text is found.
Bindings view
Click to display the Bindings view for a Script
program. You can access the Bindings view
without leaving the Script Editor. For more
information, see section 50.16 “Local
Variable Declarations” on page 1592.
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54.2

Script Editor Toolbars
Use the Script Editor toolbar to perform a variety of different tasks within the
application.

Figure: Script Editor toolbars

Table: Script Editor Toolbars
Button

Description
Open
Click to open an existing Script or b3
program or function.
Save
Click to save the currently active program.
Save All
Click to save all open programs.
Print
Click to print the current program.
Cut
Click to cut the selected text.
Copy
Click to copy the selected text.
Paste
Click to paste text.
Window
Click to open a pane or activate a minimized
pane.

Options
Click to configure program editor options
such as fonts, colors, layout, and code
library path.
Refresh
Click to refresh the focus window in the
Script Editor.
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Continued
Button

Description
Script Bindings
Click to display the read-only Script Binding
View which shows the path for the local
bindings variables in your Script programs.
Check
Click to check a program file for syntax
errors.
Check All
Click to check all open program files for
syntax errors.

Start
Initiates a Script Debugger session. As the
debugger proceeds, it highlights the current
executing line in the Script program.
Stop
Terminates a Script Debugger session.
Trace On
Initiates a continuous single step operation
without the need to keep pressing the Step
icon.
Trace Off
Terminates the continuous single step
operation.
Go
Continuously executes a Script program until
a breakpoint is reached or execution ends.
Step
Goes to the next executing line in the Script
program.
Find
Click to find a specific word in the current
program.
Replace
Click to replace a specific word in the current
program.
Help
Click to view help topics for Script
programming.
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Continued
Button

Description
Script menu button
Click to open the Script menu.
Script menu
Click to open, save, import, export, print, or
close a program. Export exports the current
Script object to a text file. Import imports
text from a text file, or opens the Import
Plain English dialog box which allows you
to import Plain English text for conversion.
For more information, see section 54.6
“Import Plain English Dialog Box” on page
1951.

Save
Click to save a Script program or function.
Undo
Click to undo or revert back one keystroke
or action in the Script Editor to the last state
of the text.
Redo
Click to redo or move ahead one keystroke
or action in the Script Editor to the state of
the text which was previously undone.
Customize quick access toolbar
Click to access the Customize quick
access toolbar dialog box where you can
add or remove additional buttons from the
Quick access toolbar.
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54.3

Script Editor – Binding Variables Pane
Use the Binding Variables pane to view and edit the properties of the binding
variables in Script Editor. If the Script program is executing, this pane is
automatically updated with the current variable values.

Figure: Script Editor - binding variables pane

Table: Binding Variables Pane
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Component

Description

Name

Displays the variable name.

Value

Displays the variable value.

Type

Displays the variable type. For more
information, see section 51.71 “Variables
Pane Types” on page 1732.

Unit

Displays the variable unit. Property values
bound to the program are automatically
converted to this unit.

Property

Displays the path of the property bound to
the variable.

Initial value

Provides a text box, dropdown, or date and
time picker you can use to configure the
initial binding variable values in your Script
program. For more information, see section
52.12 “Script Editor Initial Binding Variable
Values” on page 1874.
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54.4

Script Editor – Local Variables Pane
Use the Local Variables pane to view and edit the properties of the local variables
in the Script Editor, including arrays. The display limit is the first 1,000 elements of
an array.

Figure: Script Editor – local variables pane

Table: Local Variables Pane
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Component

Description

Name

Displays the variable name.

Value

Displays the variable value.

Type

Displays the variable type. For more
information, see section 51.71 “Variables
Pane Types” on page 1732.

04-16006-04-en, March 2015

54 Script User Interface
54.5 Script Editor Shortcut Menu

54.5

Script Editor Shortcut Menu
Use the Script Editor shortcut menu to write or edit Script programs and
functions.

Figure: Script Editor shortcut menu

Table: Script Editor Shortcut Menu

04-16006-04-en, March 2015

Command

Description

Go to definition

Positions the cursor at the definition line for
an item within the current Script program. If
the item is a function variable that is already
bound to a function object, the cursor is
positioned at the object definition the
function is bound to (the Script function
opens in the Script Editor).

Go to declaration

Positions the cursor at the declaration line
for an item within the current Script program.
If the item is a function variable that is
already bound to a function, the cursor is
positioned at the line declaring the function
variable.

Add to library

Opens the Add to Code Library dialog
box where you can save code library entries.

Collapse all

Collapses all the collapsible code segments.

Expand all

Expands all the collapsible code segments.

Comment selected

Creates comments from the selected Script
program lines.
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Continued
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Command

Description

Uncomment selected

Uncomments the selected Script program
lines.

Toggle breakpoint

Inserts and removes a breakpoint at the
selected program line in the Script
Debugger.

Set Next Statement

Highlights the next program statement in the
Script Debugger.

Find

Opens the Find tab in the Find and
Replace dialog box where you can find a
specific word in the current program.

Replace

Opens the Replace tab in the Find and
Replace dialog box. You can then replace a
specific word in the current program.

Goto

Opens the Goto dialog box. You can then
enter a program line to jump to.
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54.6

Import Plain English Dialog Box
Use the Import Plain English dialog box to import Plain English programs and
functions into Script.

Figure: Import Plain English dialog box

Table: Import Plain English Dialog Box
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Component

Description

Load file

Click to locate and load the Plain English file
that you want to add to your current Script
Editor program or function.

Display pane

Use this pane to view and edit the PE
program or function that you want to load in
the Script Editor.

Editor pane

Use this pane to review the results of your
Plain English program or function
conversion. If the Script Editor conversion
tool checks a program and finds no errors, a
Converting and then Conversion
Successful message displays. If errors
occur, they display with the error message
number, line and column location within the
program, and text or keywords involved.
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Component

Description

Convert all

Use this button to convert all of the text in
the Plain English program or function to
Script.

Convert selected

Use this button to convert the selected text
in the Plain English program or function to
Script.

Close

Use this button to close the Import Plain
English dialog box.
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54.7

Script Program Properties – Basic Tab
Use the Basic tab to view and change general, configuration, runtime, and status
information about your Script programs.

Figure: Script program properties - basic tab

Table: Basic Tab
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Component

Description

Compilation valid

Displays whether the program compiled
successfully.

Status

Displays the program status.

Current line

Displays the program's current line.

Line start time

Displays the program's line start time.

TS

Displays the number of seconds that have
elapsed since the program has been on the
current line.
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Component

Description

TM

Displays the number of minutes that have
elapsed since the program has been on the
current line.

TH

Displays the number of hours that have
elapsed since the program has been on the
current line.

TD

Displays the number of days that have
elapsed since the program has been on the
current line.

Scan

Specifies the length in seconds of the last
interpreter interval.

Error

Indicates whether the program ran
successfully or encountered an error.

Enabled

Displays whether or not the program is
enabled.

Task

Enter the task you wish to execute. For more
information, see section 50.23 “Tasks” on
page 1602.

Execution precedence

Select the order in which two programs are
run when the two programs are in the same
task. Applies when there is a loop
connection between them such that the
input of one program is actually the output of
another. For more information, see section
50.25 “Program Cycles in Building
Operation ” on page 1604.

Flow type

Select the Looping or FallThru flow type
to order the way Script program instructions
are arranged and executed.

Apply Initial Value

Select Yes to apply the initial values of the
binding variables. The default No does not
apply the values, thus ensuring, for example,
that an output point does not reset every
time a program that binds to one of its own
output variables is saved.

Debug mode

Displays either On or Off to indicate visually
whether the Script Editor is in Debug mode.
This is a read-only setting.
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54.8

Script Program Properties – Advanced
Tab
Use the Advanced tab to add or remove object properties that trigger the Script
program currently being edited.

Figure: Script program properties - advanced tab

Table: Advanced Tab
Component

Description

Triggers

Adds or removes object properties that
trigger the Script program currently being
edited. Any object property value change
triggers or executes the Script program.
Click Add to browse and select the desired
object property, or Edit to modify a selected
item in the Triggers list. Uncheck the box
preceding the object property to remove that
item from the list.
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54.9

Script Program Properties – Inputs Tab
Use the Inputs tab to display the input bindings associated with the Script
program.

Figure: Script program properties - inputs tab

Table: Inputs Tab
Component

Description

[Property Name]

Select the value of the bound property. Use
the up and down arrow keys to increment
the value up or down by .5 of a point. Click
the Configure Settings icon
to open
the [Property name] dialog and its
Configuration and Operation tabs.
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54.10

Script Program Properties – Outputs
Tab
Use the Outputs tab to display output bindings associated with the Script
program.

Figure: Script program properties - outputs tab

Table: Outputs Tab
Component

Description

[Property Name]

Select the value of the bound property. Use
the up and down arrow keys to increment
the value up or down by .5 of a point. Click
the Configure Settings icon
to open
the [Property name] dialog and its
Configuration and Operation tabs.
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54.11

Script Program Properties – Publics Tab
Use the Publics tab to display public bindings associated with your Script
programs.

Figure: Script program properties - publics tab

Table: Publics Tab
Component

Description

[Property Name]

Select the value of the bound property. Use
the up and down arrow keys to increment
the value up or down by .5 of a point. Click
the Configure Settings icon
to open
the [Property name] dialog and its
Configuration and Operation tabs.
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54.12

Script Program Properties – Functions
Tab
Use the Functions tab to display output bindings associated with the Script
function.

Figure: Script program properties - functions tab

Table: Functions Tab
Component

Description

[Function Name]

Select the value of the bound property. Use
the up and down arrow keys to increment
the value up or down by .5 of a point. Click
the Configure Settings icon
to open
the [Property name] dialog and its
Configuration and Operation tabs.
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54.13

Script Program Properties – Web
Services Tab
Use the Web Services tab to select and bind the displayed service to the Web
Service interface you created.

Figure: Script program properties - Web Services tab

Table: Web Services Tab

Technical
1962

Component

Description

[service name]

Displays the Web Service name. Select and
bind this service to the Web Service interface
you created. For more information, see
section 53.3 “Creating a Script Web Service
Interface” on page 1921.
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54.14

Script Function Properties – Basic Tab
Use the Basic tab to view and change general and configuration information about
your Script functions.

Figure: Script function properties - basic tab

Table: Basic Tab
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Component

Description

Compilation valid

Displays whether the program compiled
successfully.
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54.15

Script Function Properties – Inputs Tab
Use the Inputs tab to display the input bindings associated with the Script
function.

Figure: Script function properties - inputs tab

Table: Inputs Tab
Component

Description

[Property Name]

Set the value of the bound property. Use the
up and down arrow keys to increment the
value up or down by .5 of a point. Click the
Configure Settings
icon to open the
[Property name] dialog and its Operation tab.
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54.16

Script Function Properties – Outputs
Tab
Use the Outputs tab to display output bindings associated with the Script function.

Figure: Script function properties - outputs tab

Table: Outputs Tab
Component

Description

[Property name]

Set the value of the bound property. Use the
up and down arrow keys to increment the
value up or down by .5 of a point. Click the
Configure Settings
icon to open the
[Property name] dialog and its Operation tab.
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54.17

Script Function Properties – Publics Tab
Use the Publics tab to display public bindings associated with the Script function.

Figure: Script function properties - publics tab

Table: Publics Tab
Component

Description

[Property Name]

Set the value of the bound property. Use the
up and down arrow keys to increment the
value up or down by .5 of a point. Click the
Configure Settings
icon to open the
[Property name] dialog and its Operation tab.
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54.18

Script Function Properties – Functions
Tab
Use the Functions tab to display function bindings associated with the Script
function.

Figure: Script function properties - functions tab

Table: Functions Tab
Component

Description

[Function name]

Set the value of the bound property. Use the
up and down arrow keys to increment the
value up or down by .5 of a point. Click the
Configure Settings
icon to open the
[Property name] dialog and its Operation tab.
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54.19

Script Web Service – Basic Tab
Use the Basic tab to specify the location, identify the Web Service, and provide a
mechanism for retrieving it.

Figure: Script Web Service - basic tab

Table: Basic Tab
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Component

Description

Wsdl Url

Type the URL for the WSDL file. The URL
must end with ?wsdl. SOAP 1.1 and 1.2 files
are supported here.

Service

Select the Web Service you want to target.
For more information, see section 53.6
“Script SOAP Web Services Data Type” on
page 1927.

EndPoint

Type the Web Service endpoint. For more
information, see section 53.6 “Script SOAP
Web Services Data Type” on page 1927.
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54.20

Script Web Service – Methods Tab
Use the Methods tab to view a list of the methods supported by Web Services.

Figure: Sript Web Services - methods tab

Table: Methods Tab
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Component

Description

Methods

Displays the list of methods supported by
the Web Service. Methods are the functions
that a Web Service can execute. SOAP 1.1
and 1.2 are supported here.
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55 LonWorks Introduction
55.1 LonWorks Overview

55.1

LonWorks Overview
LonWorks is a fieldbus standard that is used for the automation of various functions
within buildings, such as lighting and HVAC. The platform is built on an open,
scalable protocol, called LonTalk that was developed by Echelon Corporation and
supported by LonMark International.
For more information, visit the LonMark website.

55.1.1

LonWorks Engineering
LonWorks engineering covers topics that describe how you use Building Operation
to configure and commission an automation system based on the LonWorks
fieldbus standard.
For more information, see section 55.2 “LonWorks Engineering” on page 1972.

55.1.2

LonWorks Operating
LonWorks operating covers topics that describe how you use Building Operation to
supervise and manage an automation system based on the LonWorks fieldbus
standard.
For more information, see section 59.11 “LonWorks Operating” on page 2127.

55.1.3

LonWorks Maintenance
LonWorks maintenance covers topics that describe how you use Building
Operation to replace hardware and troubleshoot an automation system based on
the LonWorks fieldbus standard.
For more information, see section 59.1 “LonWorks Maintenance” on page 2113.
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55.2

LonWorks Engineering
LonWorks engineering covers topics that describe how you use Building Operation
to configure and commission an automation system based on the LonWorks
fieldbus standard.
LonWorks devices communicate with network variables and can be configured with
configuration properties. Each LonWorks device has a predefined number of
variables and properties organized in functional blocks that are tailored for certain
tasks, such as temperature measuring and actuator control.

Figure: LonWorks communication overview

LonWorks bindings provide for efficient communication as they can be configured
to send and receive values according to rules, instead of having different
applications polling the devices.
Enterprise Servers and Automation Servers can have a local node on their networks
that can act as LonWorks node. By defining NVs and LonWorks bindings on the
local node, you can communicate with LonWorks devices in a very efficient way.
The functionality of a device is described in a device template, which is declared in a
XIF file. When a XIF is imported, the functional blocks, NVs, and CPs of the device
type are added to the Building Operation configuration.
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Figure: Resource files(DRF) and device template(XIF) in Building Operation

55.2.1

LonWorks Interfaces
Building Operation servers connect to LonWorks networks through various
LOYTEC interfaces and communicate with LonWorks devices over EIA-709 (FT-10)
or EIA 852 (Ethernet).
For more information, see section 68.3 “LonWorks Interfaces” on page 2358.

55.2.2

LonWorks Devices
LonWorks devices are commonly called devices or nodes in LonWorks
documentation. Each LonWorks device includes local processing (Neuron Chip or
similar) and often I/O hardware to process input data from sensors, execute a
control task, and control actuators. Each device also includes the capability to
communicate with other devices using the LonTalk protocol in firmware.
For more information, see section 56.1 “LonWorks Devices” on page 2005.

55.2.3

LonWorks Local Node
Enterprise Servers and Automation Servers can have a local node on their networks
that can act as a LonWorks node.
For more information, see section 57.1 “LonWorks Local Node” on page 2065.

55.2.4

LonWorks Bindings
LonWorks bindings differ from other Building Operation bindings because you can
set LonWorks specific properties, such as LonWorks binding profiles.
For more information, see section 58.1 “LonWorks Bindings ” on page 2093.
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55.3

LonWorks Interfaces
Building Operation servers connect to LonWorks networks through various
LOYTEC interfaces and communicate with LonWorks devices over EIA-709 (FT-10)
or EIA 852 (Ethernet).

Figure: LonWorks in Building Operation
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55.3.1

LonWorks in the Automation Server
The Automation Server connects to LonWorks networks through a built-in LOYTEC
FT interface and communicates with LonWorks devices over EIA-709 (FT-10).
For more information, see section 55.4 “LonWorks in the Automation Server” on
page 1976.

55.3.2

LonWorks in the Enterprise Server
The Enterprise Server connects to LonWorks networks through various LOYTEC
NIC-interfaces and communicates with LonWorks devices over EIA-709 (FT-10) or
EIA-852 (Ethernet).
For more information, see section 55.5 “LonWorks in the Enterprise Server” on
page 1977.

55.3.3

Externally Managed LonWorks Network
You can connect an externally managed LonWorks network to Building Operation
through an Automation Server, in order to view and represent that same LonWorks
network data in WorkStation. The externally managed network is configured and
managed, through LNS, with an external LonWorks manager tool connected to the
network.
For more information, see section 55.11 “Externally Managed LonWorks Network”
on page 1991.

04-16006-04-en, March 2015

Technical
1977

55 LonWorks Introduction
55.4 LonWorks in the Automation Server

55.4

LonWorks in the Automation Server
The Automation Server connects to LonWorks networks through a built-in LOYTEC
FT interface and communicates with LonWorks devices over EIA-709 (FT-10).

Figure: Automation server and LonWorks.

Each Automation Server has one physical LonWorks interface, which can connect
to one LonWorks network. For more information, see the Automation Servers topic
on WebHelp.
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55.5

LonWorks in the Enterprise Server
The Enterprise Server connects to LonWorks networks through various LOYTEC
NIC-interfaces and communicates with LonWorks devices over EIA-709 (FT-10) or
EIA-852 (Ethernet).

Figure: Various LOYTEC NIC-interfaces

The NIC-LOYTEC Network Interface Software package includes NIC Legacy
Drivers and the L-Config Tool to configure and enable the LOYTEC network
interfaces. The package also includes the documentation for installing the network
interfaces. For more information and for downloads, visit the LOYTEC website.

55.5.1

LonWorks NIC709-PCI Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC709-PCI interface.
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For more information, see section 55.7 “LonWorks NIC709-PCI Interface” on page
1980.

55.5.2

LonWorks NIC709-USB Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC709-USB interface.
For more information, see section 55.6 “LonWorks NIC709-USB Interface” on page
1979.

55.5.3

LonWorks NIC709-IP Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC709-IP interface.
For more information, see section 55.8 “LonWorks NIC709-IP Interface” on page
1981.

55.5.4

LonWorks NIC852 Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC852 interface.
For more information, see section 55.9 “LonWorks NIC852 Interface” on page
1982.

Note
• You need a LonTalk license USB service dongle to use NIC852.
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55.6

LonWorks NIC709-USB Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC709-USB interface.

Figure: Basic LonWorks network with Enterprise Server with NIC709-USB.

In WorkStation, you use the LonWorks port on the Enterprise Server to represent a
NIC709-USB interface connected to an USB port.
Several network interfaces can be installed in the Enterprise Server so that several
LonWorks FT networks can be connected.
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55.7

LonWorks NIC709-PCI Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC709-PCI interface.

Figure: Basic LonWorks network with Enterprise Server with NIC709-PCI.

In WorkStation, you use the LonWorks interface on the Enterprise Server to
represent a NIC709-PCI interface installed in the PCI bus.
Several network interfaces can be installed in the Enterprise Server so that several
LonWorks FT networks can be connected.
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55.8

LonWorks NIC709-IP Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC709-IP interface.

Figure: Basic LonWorks network with Enterprise Server with NIC709-IP

In WorkStation, you use the LonWorks interface on the Enterprise Server to
represent a NIC709-IP interface on the IP network.
This is called a Remote Network Interface, RNI, where the Enterprise Server is the
client and the NIC-IP interface is the RNI server.
Several network interfaces can be installed in the Enterprise Server so that several
LonWorks FT networks can be connected.
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55.9

LonWorks NIC852 Interface
The Enterprise Server can be connected to a LonWorks FT network with a LOYTEC
NIC852 interface.

Figure: Basic LonWorks network with Enterprise Server with NIC852-IP.

In WorkStation. you use the LonWorks interface on the Enterprise Server to
represent a LonWorks/IP router on the IP network using the EIA-852 protocol.
The 852 specification provides for multiple 852 channels on the same IP network,
which means that you can have several LonWorks FT channels integrated in one
LonWorks network.
With NIC852, you can integrate several LonWorks FT channels in Building
Operation and also create LonWorks bindings between devices on different
channels. (NIC709-IP can only have LonWorks bindings within its networks.)
If you have LonWorks/IP devices, you can connect these directly to the IP network
without the L-IP router.
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Note
• You need a LonTalk licence, which you can obtain by a USB service dongle
or software activation.
• You need to enable one of the L-IP routers to act as configuration server in
the LonWorks network.

55.9.1

L-IP Router Setup
The L-IP router from LOYTEC incorporates the NIC852 interface. Relevant software
downloads and user documentation is provided by LOYTEC. For more information,
visit the LOYTEC website.
This topic is a complement to existing LOYTEC documentation and a guideline
regarding the setup of the L-IP router in a Building Operation context.
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55.10

L-IP Router Setup
The L-IP router from LOYTEC incorporates the NIC852 interface. Relevant software
downloads and user documentation is provided by LOYTEC. For more information,
visit the LOYTEC website.
This topic is a complement to existing LOYTEC documentation and a guideline
regarding the setup of the L-IP router in a Building Operation context.
In this installation example, we include two L-IP devices, the Enterprise Server, and
assign one of them to be the configuration server. We use L-IP devices with factory
default values, and a PC with no previous installation of LOYTEC software.

55.10.1

Step 1: PC Setup
Install the Building Operation software package. In this example, you use the
Enterprise Server, the Software Administrator, and WorkStation.

Technical
1986

04-16006-04-en, March 2015

55 LonWorks Introduction
55.10 L-IP Router Setup

Figure: PC setup

When the Building Operation software is installed, proceed with the following tasks:
• In the Software Administrator, stop the Enterprise Server.
• Install the NIC software package from LOYTEC.
• Activate LonTalk licence with USB service dongle or software activation.
• In the Software Administrator, start the Enterprise Server again.
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55.10.2

Step 2: L-IP Device Configuration
Use a terminal program and an RS232 cable to connect to the L-IP device console.

Figure: L-IP device donfiguration

Use the following COM port settings when connecting to the console:
• Bits per second: 38 400
• Data bits: 8
• Parity: None
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• Stop bits: 1
• Flow control: None
In the L-IP device console, in the IP configuration menu, type the following
information:
• IP Address for the device
• IP Netmask
• IP Gateway
Save the IP configuration and Reset the L-IP device.
Connect to the other L-IP device and repeat the process.

Tip
On the L-IP devices, the router mode must physically be set to Smart Switch
Mode (DIP).

55.10.3

Step 3: Configuration Server Setup
One of the L-IP devices must act as configuration server as well. The configuration
server coordinates the Enterprise Server and the L-IP device(s) that interface the
LonWorks network.
The clients, the L-IP devices and the Enterprise Server, communicate through port
1628 (default). The configuration server communicates with its clients through port
1629 (default).
The configuration server and the L-IP device, on which it resides, share the same IP
address but use different ports.

Figure: Port communication

Use a web browser to connect to the L-IP device that you want to enable as
configuration server.
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Figure: Configuration server setup

In the EIA-852 Server section, select Config server status = Enabled.
In the EIA-852 Ch. List section, you can see the client L-IP device on which the
configuration server resides. Now add the other clients:
• Click Add Device, type the IP address of the other L-IP device and click Save.
• Click Add Device, type the IP address of the Enterprise Server and click Save.

Technical
1990

04-16006-04-en, March 2015

55 LonWorks Introduction
55.10 L-IP Router Setup

55.10.4

Step 4: Enterprise Server Setup
Open the LConfig tool from LOYTEC to configure the Enterprise Server.

Figure: Enterprise Server setup
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In the NIC852 tab, click CNIP Configuration. In the Conf. Server IP addr. box, type
the IP address of the configuration server. Click OK.
In the NIC852 tab, click Advanced. Select Run as Service and click OK.
In the NIC852 tab, increase both MNI settings to their maximum.

Figure: MNI settings

Click Test Device / Serial Number. The test should pass.
Click OK.

55.10.5

Step 5: Final Test
Use a web browser and connect to the configuration server again.
In the EIA-852 Ch. List section, click Reload.

Figure: Stat Flags

All Stat Flags should indicate registered.
Now you can log into WorkStation and discover the EIA-852 Interface. For more
information, see section 55.13 “Discovering a LonWorks Interface” on page 1994.
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55.11

Externally Managed LonWorks Network
You can connect an externally managed LonWorks network to an Automation
Server, so you can view the LonWorks network data in WorkStation. You use an
external LonWorks manager tool through LNS to configure and manage the
network.

Figure: Externally managed LonWorks interface

You cannot use WorkStation to create or manage bindings in the externally
managed network. All maintenance of bindings or of the network in the external
LonWorks network are managed through LNS in an external LonWorks manager,
such as NL-220 or LonMaker. See the Newron System or Echelon website.
The network variables in the Automation Server can be viewed in WorkStation. The
Building Operation bindings, trend logs, charts can be created within Building
Operation.
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When you create the externally managed LonWorks network, a local node is
automatically created. In the local node, it is possible to create any necessary
functional blocks. For more information, see section 57.1 “LonWorks Local Node”
on page 2065.

Figure: Externally managed LonWorks network local node with objects

Note
You cannot create any other LonWorks network in the Automation Server used
for the externally managed LonWorks network.
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55.12

Creating a LonWorks Interface
You create a LonWorks interface under the Building Operation server to connect to
a LonWorks network.
For more information, see section 55.1 “LonWorks Overview” on page 1971.

To create a LonWorks interface
1. In WorkStation, in the System Tree pane, select the server where you want
to create the interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, select LonWorks Local FT-10 Interface or
LonWorks Interface.

4. In the Name box, type a name for the interface.
5. In the Description box, type a description.
6. Click Create.
You can now discover the interface and/or create the LonWorks network. You can
also configure the default settings of the interface.

04-16006-04-en, March 2015

Technical
1995

55 LonWorks Introduction
55.13 Discovering a LonWorks Interface

55.13

Discovering a LonWorks Interface
You discover a LonWorks interface to create or configure the LonWorks interface in
the Building Operation server. The LonWorks interface must be physically
connected to the Building Operation server.
For more information, see section 56.16 “LonWorks Device Workflows” on page
2029.

To discover a LonWorks interface
1. In WorkStation, in the System Tree pane, select the server that is connected
to the interface you want to discover.
2. Click the Device Discovery view.
3. In the Select device type box, select LonWorks.

4. Drag the discovered interface to the System Tree pane:
• Drag to an existing interface to associate it with the discovered physical
interface.
• Drag to the server to create the interface.
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55.14

Configuring a LonWorks Interface
You configure a LonWorks interface to define the network interface and its
properties.
For more information, see section 55.1 “LonWorks Overview” on page 1971.

To configure a LonWorks interface
1. In WorkStation, in the System Tree pane, select the interface you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

State

Displays the interface status: Online or
Offline.

Network interface name

Displays the name of the network
interface. The name is automatically set
when you drag-and-drop the interface
from the Device Discovery tab.

Maximum number of concurrent
messages

Select the maximum number of
messages to be transmitted at the same
time.

5. Click the Advanced tab.
6. Edit the advanced properties:
Component

Description

Priority

Select the priority for the alarm.

Device name

Displays the name of the interface.

7. Click OK.
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55.15

Creating a LonWorks Network
You create a LonWorks network under the LonWorks interface to connect to
devices that are using the LonWorks protocol.
For more information, see section 55.1 “LonWorks Overview” on page 1971.

To create a LonWorks network
1. In WorkStation, in the System Tree pane, select the LonWorks interface
where you want to create the network.
2. On the File menu, point to New and then click LonWorks Network.
3. In the Name box, type a name for the network.

4. In the Description box, type a description.
5. Click Create.
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55.16

Configuring a LonWorks Network
You configure a LonWorks network by editing its properties.
For more information, see section 55.1 “LonWorks Overview” on page 1971.

To configure a LonWorks network
1. In WorkStation, in the System Tree pane, select the network you want to
configure.
2. On the File menu, click Properties.
3. Click the Advanced tab.
Continued on next page
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4. Edit the advanced properties:
Component

Description

Index

Displays the location of the entry in the
domain table. The first item is 0.

ID (decimal)

Displays the domain ID of which the
device is a member.

Domain ID lenght

Displays the byte length of the domain ID.

Subnet

Displays the subnet of which the device is
a member.

Node

Displays the node ID of the device. The
Local Node is always node 1.

Edit

Click Edit to change domain ID.

Component

Description

Classic Operator Panel Support

Select Yes to get support for classic OP
functionality, that is, the OP can be
connected to any Xenta device.

Network name in blueprint

Displays the current name of the network.

System alarm priority

Enter the priority of Xenta non-application
alarms.

Time synchronization interval (min)

Enter the time interval between
synchronization of Xenta and the server
clocks. The default value is 10.

Heartbeat (s)

Enter the time interval for the server
heartbeat on the LonWorks network. The
default value is 20 s.

Component

Description

Timeout (ms)

Enter the amount of time in milliseconds
until Xenta communication should be
considered broken. The default is 10,000
ms.

Transmit timer (ms)

Displays the time before Xenta
retransmission (if no answer).

Number of retries

Enter the maximum number of attempts
before giving up. The default value is 4.

5. Click OK.
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55.17

Creating an Externally Managed
LonWorks Network
You create an externally managed LonWorks network to connect to an external
network that is using the LonWorks protocol.
For more information, see section 55.11 “Externally Managed LonWorks Network”
on page 1991.

To create an Externally Managed LonWorks Network
1. In WorkStation, in the System Tree pane, select the LonWorks interface
where you want to create the network.
2. On the File menu, point to New and then click Externally Managed
LonWorks Network.
3. In the Name box, type a name for the network.

4. In the Description box, type a description.
5. Click Create.
You can now discover the interface or create the externally managed LonWorks
network.
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55.18

Changing the Domain ID for a
LonWorks Network
You change the domain ID for a LonWorks network to suit your requirements. For
example, you can change the domain ID to make it possible to use the same Xenta
Operator Panel on different sites.
For more information, see section 155.1 “LonTalk Addressing Overview” on page
5567.

To change the domain ID for a LonWorks network
1. In WorkStation, in the System Tree pane, select the LonWorks network that
you want to change the domain ID for.
2. On the File menu, click Properties.
3. Click the Advanced tab.

4. Under Domain table for Network Interface, select Index 0 and then click
the Edit button

.
Continued on next page
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5. In the ID (decimal) box, enter the domain ID.

6. Click OK.

Continued on next page
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7. Click OK.

Important
• If there are commissioned devices connected to the LonWorks
network, you need to recommission all devices that indicate they
are out of sync.
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56.1 LonWorks Devices

56.1

LonWorks Devices
LonWorks devices are commonly called devices or nodes in LonWorks
documentation. Each LonWorks device includes local processing (Neuron Chip or
similar) and often I/O hardware to process input data from sensors, execute a
control task, and control actuators. Each device also includes the capability to
communicate with other devices using the LonTalk protocol in firmware.
A LonWorks device can have an additional host processor beside the Neuron Chip.
In this case, the application can execute on the host processor and the Neuron
Chip can be used as the network interface.

56.1.1

LonWorks Device Templates
When you add a LonWorks device in Building Operation, you must define the
device so that Building Operation can recognize its type and communicate with the
device. You define a LonWorks device by associating it with a predefined device
template.
For more information, see section 56.12 “LonWorks Device Templates” on page
2022.

56.1.2

Device Resource Files
Device resource files are a set of files, called a DRF kit, that contain definitions of
enumerations, functional profiles, property types, and variables types used in device
templates.
For more information, see section 56.14 “Device Resource Files” on page 2026.

56.1.3

LonWorks Device Workflow
In WorkStation, you can select a Building Operation server and use Device
Discovery to locate its physical LonWorks interface and installed LonWork devices.
The purpose of locating the physical hardware is to associate it with the
corresponding objects in the System Tree.
For more information, see section 56.16 “LonWorks Device Workflows” on page
2029.

56.1.4

Network Variables and Configuration
Parameters
Applications can contain network variables and configuration parameters to share
data or to customize the application. These network variables and configuration
parameters are usually defined in the device template.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.

04-16006-04-en, March 2015

Technical
2007

56 LonWorks Devices
56.1 LonWorks Devices

56.1.5

LonWorks Commission and Decommission
When you are configuring LonWorks devices or the local node in WorkStation the
configuration data are stored in the Building Operation server database. In order to
download the configuration data to devices or the local node, you need to perform
a commission.
For more information, see section 57.4 “LonWorks Commission and
Decommission” on page 2069.

56.1.6

LonWorks Application Upgrade
The application program in standard LonWorks devices (not host devices) can be
upgraded by downloading an NXE file.
For more information, see section 56.10 “LonWorks Application Upgrade” on page
2019.

56.1.7

LNS Plugins
The LNS Plug-in standard is defined by the LNS network operating system so that
device manufacturers can create custom software that simplifies the configuration
of their devices, and integrate seamlessly with the network commissioning tool. In
WorkStation, the LNS Plug-in function allows the user to register and launch an
LNS Plug-in and make an offline configuration of a generic LonWorks device. The
LNS Plug-in function makes it possible to launch specific manufacturers LNS
applications.
For more information, see section 56.26 “LNS Plug-ins” on page 2047.
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56.2

Creating a LonWorks Device
You create LonWorks devices under the LonWorks network to connect to physical
LonWorks devices.
For more information, see section 56.16 “LonWorks Device Workflows” on page
2029.

To create a LonWorks device
1. In WorkStation, in the System Tree pane, select the LonWorks network or
LonWorks network folder where you want to create the device.
2. On the File menu, point to New and then click Device.
3. In the object type list, select a device template.

4. In the Name box, type a name for the device.

Tip
• The name of the LonWorks device must be unique in the
network, even for LonWorks devices in different folders in the
network.
5. In the Description box, type a description.
6. Click Next.
Continued on next page
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7. In the Neuron ID box, enter the Neuron ID for the device.

8. Select Commission to commission the device.
9. Select which configuration to use:
• Click Keep current configuration in the device to leave the
configuration in the device as is.
• Click Download default configuration to device to use the default
configuration from the device template.
• Click Upload configuration from device to use the current
configuration in the device.

Important
All the above actions are executed after the NXE file download.
10. Select Device application file to upgrade the device application and enter
the NXE file in the Device application file box. For more information, see
section 56.10 “LonWorks Application Upgrade” on page 2019.
11. Click Create.
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56.3

Configuring a LonWorks Device
You configure a LonWorks device by editing its properties.

To configure a LonWorks device
1. In WorkStation, in the System Tree pane, select the device you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:

04-16006-04-en, March 2015

Component

Description

Needs commissioning

Displays True when the device needs to
be commissioned, for example after a
SNVT binding has been changed.

Needs device configuration
download

Displays True when the network
configuration has changed and the device
needs a configuration download.

Needs application download

Displays True when the application has
changed and the device needs an
application download.

Program ID

Displays the program ID for the node.

Neuron ID

Displays the unique hardware ID for the
node.

Non group receive timer

Displays the receive timer for all traffic that
does not reach the node through the
address table.

Use extended NMP

Displays True when the node uses the
Extended Network Management
Command Set, ECS. For more
information, see section 155.1 “LonTalk
Addressing Overview” on page 5567.

Model

Displays the model name or number.

File directory index

Displays the index of the NVT that
specifies the configuration file for CPTs
implemented with direct memory
read/write access.

Host based application

Displays Yes when the application runs
mainly in the host.

Complete template

Displays False when the device template
is incomplete. Devices based on an
incomplete template can have limited
functionality.
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5. Click the Offline Detection tab.
6. Edit the offline detection properties:
Component

Description

Last communication

Displays the time when the device/node
last communicated its status
successfully.

Status

Displays the status of the device/node:
Invalid, Offline or Online.

7. Click OK.
You must commission the device to update the configuration.
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56.4

LonWorks Commission and
Decommission
When you are configuring LonWorks devices or the local node in WorkStation the
configuration data are stored in the Building Operation server database. In order to
download the configuration data to devices or the local node, you need to perform
a commission.

56.4.1

Commission
When you commission a device or a local node the following actions occur:
• Device tables (Address, Selector, Alias, and Domain table) are written to the
device or the local node.
• The Device state is set to Configured Online.
When you commission a device the following additional actions occur:
• If you select to download the configuration to device, the Configuration
Parameters values are written to the device.
• If you select to upload the configuration from the device, the Configuration
Parameters values are read from the device.
• If you select a device application file, the file is downloaded to the device.
• If the domain table is updated, or if a Configuration Parameter requires it, the
device is restarted.

56.4.2

Decommission
When you decommission a device or a local node the following actions occur:
• The device or the local node stops communicating.
• The application is stopped unless it is host based.
• The device object configuration is kept, which means that everything can be
restored in the physical device or the local node at a new commission.

Important
Decommission a LonWorks device before you remove it from the network.
Otherwise, the old network information can cause problems if the device is used
in another network.
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56.5

Discovering a LonWorks Device
You discover LonWorks devices to create or configure the LonWorks devices in the
server. The LonWorks devices must be physically connected to the server field bus.
For more information, see section 56.16 “LonWorks Device Workflows” on page
2029.

To discover a LonWorks device
1. In WorkStation, in the System Tree pane, select the server that is connected
to the device you want to discover.
2. Click the Device Discovery view.
3. In the Select device type box, select LonWorks.

4. Select the Devices folder.
5. On the Actions menu, click Activate listen to service pin.
6. Press the service pin on the physical device.
7. In the Device Discovery view, ensure that the LonWorks device is displayed
in the Devices folder. This may take up to 5 seconds.

8. On the Actions menu, click Deactivate listen to service pin.
Continued on next page
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9. Drag the discovered service pin (device) to the System Tree pane:
• Drag to an existing device to associate it with the discovered physical
device.
• Drag to the LonWorks network to create the device.

Important
• You cannot drag a standard MNL LonWorks device to the
System Tree pane if the discovered device is in an
unconfigured state. For more information, see section 158.18
“Dragging Discovered MNL LonWorks Device to System Tree
Pane Does Not Acquire Neuron ID” on page 5616. For more
information, see section 158.19 “Dragging Discovered MNL
LonWorks Device to System Tree Pane Does Not Create New
MNL Device” on page 5617.

Tip
• To verify the device Neuron ID, select the device in the System
Tree pane, and then select Properties on the File menu. The
Neuron ID can be found on the Basic tab of the Device
Properties.
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56.6

Commissioning a LonWorks Device
You commission physical LonWorks devices to make them operational. The
commission enables the devices to communicate on the LonWorks network.
For more information, see section 57.4 “LonWorks Commission and
Decommission” on page 2069.

To commission a LonWorks device
1. In WorkStation, in the System Tree pane, select the device.
2. On the Actions menu, click Commission.
3. In the Neuron ID box, make sure that the correct Neuron ID is entered.

4. Select which configuration to use:
• Click Keep current configuration in the device to leave the
configuration in the device as is.
• Click Download current configuration to device to use the current
configuration from Building Operation.
• Click Download default configuration to device to use the default
configuration from the device template.
• Click Upload configuration from device to use the current
configuration in the device.

Important
• Before downloading or uploading the device configuration,
carefully consider the effects of overwriting the current device
configuration in the LonWorks device or server.
Continued on next page
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Important
All the above actions are executed after the NXE file download.
5. Select Device application file to upgrade the device application and enter
the NXE file in the Device application file box.
6. Click Commission.
7. Click Close.
The device is commissioned and activated.
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56.7

Decommissioning a LonWorks Device
You decommission a device to silence it and to let the other devices in the network
know that it is deactivated.

To decommission a LonWorks device
1. In WorkStation, in the System Tree pane, select the device.
2. On the Actions menu, click Decommission.
The device address is revoked in the network and it stops communicating.
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56.8

Downloading the LonWorks Device
Configuration
You download the device configuration from WorkStation to update the
configuration parameters in the LonWorks device.

To download the LonWorks device configuration
1. In WorkStation, in the System Tree pane, select the LonWorks device.
2. On the Actions menu, click Download device configuration.
The configuration is downloaded to the LonWorks device.
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56.9

Uploading the LonWorks Device
Configuration
You upload the device configuration from the LonWorks device to update the
configuration parameters in the server with local device configuration changes,
which have been made through, for example, an operator panel.

Important
• Before uploading the device configuration from a device, carefully consider
the effects of overwriting the current device configuration in the server.

To upload the LonWorks device configuration
1. In WorkStation, in the System Tree pane, select the LonWorks device.
2. On the Actions menu, click Upload device configuration.
The configuration is uploaded to the server.
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56.10

LonWorks Application Upgrade
The application program in standard LonWorks devices (not host devices) can be
upgraded by downloading an NXE file.
In WorkStation, you can download an NXE to a device when creating or
commissioning a LonWorks device. Each NXE contains a Program ID that should
match the Program ID in the device or in the XIF file used when creating the device.
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56.11

Upgrading the Device Application
You upgrade a LonWorks device application by downloading a NXE file to the
device.

Warning
• Ensure that the program ID of the NXE file matches the Program ID of the
device application in the device. If the program IDs do not match, the device
can malfunction.
For more information, see section 56.10 “LonWorks Application Upgrade” on page
2019.

To upgrade the device application
1. In WorkStation, in the System Tree pane, select the device.
2. On the Actions menu, click Commission.
3. In the Neuron ID box, make sure that the correct Neuron ID is entered.

Continued on next page
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4. Select which configuration to use:
• Select Keep current configuration in the device to leave the
configuration in the device as is.
• Select Download current configuration to device to use the current
configuration from WorkStation.
• Select Download default configuration to device to use the default
configuration from the device template.
• Select Upload configuration from device to use the current
configuration in the device.

Important
All the above actions are executed after the NXE file download.
5. Select Device application file to upgrade the device application and enter
the NXE file in the Device application file box.
6. Click Commission.
7. Click Close.
The device application is upgraded and the device is commissioned.
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56.12

LonWorks Device Templates
When you add a LonWorks device in Building Operation, you must define the
device so that Building Operation can recognize its type and communicate with the
device. You define a LonWorks device by using a device template.
Every generic LonWorks device has a corresponding device template. The device
template itself is a set of predefined network variables and configuration properties
organized in functional blocks.
The following device templates are preinstalled in Building Operation:
• 102-B, 102-VF, 102-EF (80:00:13:50:0A:06:04:03)
• 102-ES (80:00:13:50:0A:06:04:04)
• 102-AX (80:00:13:50:0A:06:04:80)
• 103-A (80:00:13:50:46:06:04:05)
• 104-A (80:00:13:50:1E:06:04:01)
• 110-D (80:00:13:55:06:06:04:01)
• 151-D (80:00:13:6E:01:06:04:01)
• 121-FC (80:00:13:55:01:06:04:02)
• 121-HP (80:00:13:55:03:06:04:02)
• 420A (80:00:13:05:3C:06:04:01)
• 450A (80:00:13:05:0A:06:04:01)
• STR350 (80:00:13:50:5A:06:04:01)
• Xenta OP (90:00:13:05:28:00:04:00)
• ATV21 (80:00:13:3C:0A:0A:04:30)
• ATV61 (80:00:13:3C:0A:0A:04:10)
Each device template is based on a XIF file. The name of a device template in
Building Operation is comprised of the display name of its XIF file (can be edited)
and the Program ID that identifies the LonWorks device type.
You can also add new device templates to Building Operation by importing XIF files.
You can obtain XIF files from the following places:
• Device manufacturer
• Packaging for the shipped product
• LonMark website for certified and published devices
If you try to import a XIF file that refers to types not on your system, you are asked
to import the necessary resource files. For more information, see section 56.14
“Device Resource Files” on page 2026.
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Figure: LonWorks device template(XIF) in Building Operation

You can import a device template without the necessary types from the resource
files, but there are limitations in the devices created from the template.
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56.13

Importing a Device Template
You import device templates (XIF files) so that you can introduce new types of
devices to the system.
For more information, see section 56.12 “LonWorks Device Templates” on page
2022.

To import a device template
1. In WorkStation, on the File menu, point to LonWorks import, and then click
Device Template.
2. In the XIF file box, select the XIF file to import.

3. Click Import.
4. In the Template Name field, type a name for the template.

Note
Use a descriptive name for the template. The name will be shown
when creating new devices.

5. Click OK.
Continued on next page
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6. In the Import Device Template box, click Close.

If the device template refers to NVT or CPTs not on your system, you will be
prompted to import necessary resource files. When the resource files have been
imported, the device template import restarts. When finished, the device template is
imported and available when creating a new device. For more information, see
section 56.14 “Device Resource Files” on page 2026.
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56.14

Device Resource Files
Device resource files are a set of files, called a DRF kit, that contain definitions of
enumerations, functional profiles, property types, and variables types used in device
templates.
If you try to import a XIF file that uses network variables types, configuration
parameters, or functional profiles that do not exist in your type library, you are asked
to import a new DRF kit with these definitions.
The DRF kits are provided by the manufacturer of your LonWorks device. You can
also download DRF kits from the LonMark website.
The following DRF kits are preinstalled on the Automation Server and the Enterprise
Server:
• TAC of version 1.48 (80:00:13:XX:XX:XX:XX:XX)
• HVACdrives of version 1.00 (80:00:13:3C:0A:XX:XX:XX)
• Standard of version 13.20 (XX:XX:XX:XX:XX:XX:XX:XX)
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56.15

Importing Device Resource Files
You import device resource files (DRF kit) to complement device templates.
Consequently, importing a device template may require that you import a DRF kit as
well.
For more information, see section 56.14 “Device Resource Files” on page 2026.

To import device resource files
1. In WorkStation, on the File menu, point to LonWorks import, and then click
Resource files.
2. In the Import Resource Files box, enter the resource kit directory to import.

3. Click Next.
Continued on next page
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4. When the download is finished, click Import.

5. Click Close.
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56.16

LonWorks Device Workflows
There are three ways of creating and configuring a LonWorks device.

56.16.1

Create and then Discover LonWorks Device
Workflow
Use the Create and then Discover LonWorks Device workflow to create and
discover LonWorks devices online.
For more information, see section 56.17 “Create and then Discover LonWorks
Device Workflow” on page 2030.

56.16.2

Discover LonWorks Device Workflow
Use the Discover LonWorks Device workflow to create and discover LonWorks
devices online.
For more information, see section 56.18 “Discover LonWorks Device Workflow” on
page 2032.

56.16.3

Create LonWorks Device Workflow
Use the Create LonWorks Device workflow to create LonWorks devices offline in a
project and then deploy and commission the devices and the local node on an onsite server.
For more information, see section 56.19 “Create LonWorks Device Workflow” on
page 2034.
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56.17

Create and then Discover LonWorks
Device Workflow
Use the Create and then Discover LonWorks Device workflow to create and
discover LonWorks devices online.

Figure: Deploy LonWorks project workflow
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Create a LonWorks interface
In WorkStation, create a LonWorks interface in the server.
For more information, see section 55.12 “Creating a LonWorks Interface” on page
1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks Interface.
For more information, see section 55.15 “Creating a LonWorks Network” on page
1996.

Create LonWorks devices
In WorkStation, create the LonWorks devices on the LonWorks network.
For more information, see section 56.2 “Creating a LonWorks Device” on page
2007.

Connect the LonWorks devices
Physically connect the LonWorks devices to the on-site server.

Discover the LonWorks devices
In WorkStation, discover the LonWorks devices to obtain the Neuron ID.
For more information, see section 56.5 “Discovering a LonWorks Device” on page
2012.

Configure the LonWorks devices
Configure the network variables and configuration parameters, using properties or
an LNS Plug-in.
For more information, see section 56.3 “Configuring a LonWorks Device ” on page
2009.
For more information, see section 56.29 “Configuring Network Variables and
Configuration Parameters using LNS Plug-in” on page 2053.

Create a local node and local node variables
In WorkStation, create a Local Node and Local Node variables by mirroring a device
network variable or manually creating.
For more information, see section 57.2 “Creating a Local Node” on page 2067.
For more information, see section 57.12 “Creating Network Variables Automatically”
on page 2078.

Commission the LonWorks devices
In WorkStation, commission the devices on the server.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.
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56.18

Discover LonWorks Device Workflow
Use the Discover LonWorks Device workflow to create and discover LonWorks
devices online.

Figure: Deploy LonWorks project workflow

Create a LonWorks interface
In WorkStation, create a LonWorks interface in the server.
For more information, see section 55.12 “Creating a LonWorks Interface” on page
1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks Interface.
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For more information, see section 55.15 “Creating a LonWorks Network” on page
1996.

Connect the LonWorks devices
Physically connect the LonWorks devices to the on-site server.

Discover the LonWorks devices
In WorkStation, discover the LonWorks devices to obtain the Neuron ID and create
the devices.
For more information, see section 56.5 “Discovering a LonWorks Device” on page
2012.

Configure the LonWorks devices
Configure the network variables and configuration parameters, using properties or
an LNS Plug-in.
For more information, see section 56.3 “Configuring a LonWorks Device ” on page
2009.
For more information, see section 56.29 “Configuring Network Variables and
Configuration Parameters using LNS Plug-in” on page 2053.

Create a local node and local node variables
In WorkStation, create a Local Node and Local Node variables by mirroring a device
network variable or manually creating.
For more information, see section 57.2 “Creating a Local Node” on page 2067.
For more information, see section 57.12 “Creating Network Variables Automatically”
on page 2078.

Commission the LonWorks devices
In WorkStation, commission the devices on the on-site server.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.
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56.19

Create LonWorks Device Workflow
Use the Create LonWorks Device workflow to create LonWorks devices offline in a
project and then deploy and commission the devices and the local node on an onsite server.
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Figure: Deploy LonWorks project workflow
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Create a LonWorks interface
In WorkStation for Projects, create a LonWorks interface.
For more information, see section 55.12 “Creating a LonWorks Interface” on page
1993.

Create a LonWorks network
In WorkStation for Projects, create a LonWorks network on the LonWorks interface.
For more information, see section 55.15 “Creating a LonWorks Network” on page
1996.

Create LonWorks devices
In WorkStation for Projects, create the LonWorks devices in an Automation Server
necessary for the project on the LonWorks network.
For more information, see section 56.2 “Creating a LonWorks Device” on page
2007.

Configure the LonWorks devices
Configure the network variables and configuration parameters, using properties or
an LNS Plug-in.
For more information, see section 56.3 “Configuring a LonWorks Device ” on page
2009.
For more information, see section 56.29 “Configuring Network Variables and
Configuration Parameters using LNS Plug-in” on page 2053.

Create a local node and local node variables
In WorkStation for Projects, create a Local Node and Local Node variables by
mirroring a device network variable or manually creating.
For more information, see section 57.2 “Creating a Local Node” on page 2067.
For more information, see section 57.12 “Creating Network Variables Automatically”
on page 2078.

Create objects
In WorkStation for Projects, create all necessary objects, such as alarms, schedules
and trend logs.
For more information, see the Alarm Overview topic on WebHelp.
For more information, see the Trend Overview topic on WebHelp.
For more information, see the Schedules Overview topic on WebHelp.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended that you update the Enterprise Server communication
parameters before the deploy of the first Automation Server.
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For more information, see section 4.4 “Updating Communication Parameters” on
page 179.

Deploy the Automation Server
In WorkStation for Projects, deploy the Automation Server.

Caution
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.

Connect the LonWorks devices
Physically connect the LonWorks devices to the on-site server.

Commission the LonWorks devices
In WorkStation, commission the devices on the on-site server.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.

Commission the local node
In WorkStation, commission the local node on the on-site server.
For more information, see section 57.5 “Commissioning a Local Node” on page
2070.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended that you update all Automation Server communication
parameters before the deploy of the Enterprise Server.
For more information, see section 4.4 “Updating Communication Parameters” on
page 179.

Deploy the Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.
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Important
Ensure that you have created all Automation Servers in the project before the
deploy of the Enterprise Server. You can only deploy to an empty Enterprise
Server. Any additional Automation Servers have to be created on the on-site
server.
For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.
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56.20

Network Variables and Configuration
Parameters
Applications can contain network variables and configuration parameters to share
data or to customize the application. These network variables and configuration
parameters are usually defined in the device template.

56.20.1

Network Variables
A network variable is any data item that a device application gets from, or makes
available to, other devices on the network. A network variable is typically a
temperature, a switch value, or an actuator position setting.
Network variables allow a device to send (output) and receive (input) data over the
network to and from other devices.
In Building Operation, there are 4 classes of network variables:
• Internal NVI: Input variable owned by a local node
• Internal NVO: Output variable owned by a local node
• External NVI: Input variable owned by a device
• External NVO: Output variable owned by a device
You configure the network variables by editing the properties in WorkStation. For
more information, see section 57.15 “Configuring a Network Variable” on page
2083.
You can also configure LonWorks network variables by editing the properties using
an LNS Plug-in. For more information, see section 56.29 “Configuring Network
Variables and Configuration Parameters using LNS Plug-in” on page 2053.

56.20.2

Configuration Parameters
Configuration parameters are used to configure the operation of a device.
Configuration parameters can be implemented in two ways:
• Configuration network variable types use a special class of network variables.
• Direct memory access (DMA) configuration properties are stored in a data
block that is read and written using direct memory access.
You modify the configuration parameters by editing the properties in WorkStation.
For more information, see section 56.25 “Configuring a Configuration Property” on
page 2046.
You can also configure configuration parameters by editing the properties using an
LNS Plug-in. For more information, see section 56.29 “Configuring Network
Variables and Configuration Parameters using LNS Plug-in” on page 2053.

56.20.3

Variable Members and Structured Variables
A network variable can contain one or several variable members that hold different
values, structured with different members in a hierarchy.
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For more information, see section 56.21 “Variable Members and Structured
Variables” on page 2041.

56.20.4

NVTs and CPTs
The network variables and configuration parameters are based on types (NVTs and
CPTs) in the Building Operation type repository. The types are defined in the
LonWorks standard and define how the variable/parameter should be interpreted,
because the same raw value can have different meaning in different types.
For example, a value can correspond to a temperature in one case and to a date in
another case. The type repository is pre-installed with the standard LonWorks types
(SNVTs and SCPTs). User defined types (UNVTs and UCPTs) can also be added by
importing Device Resource Files.

56.20.5

Network Variable and Configuration Parameter
Values
Network variables and configuration parameters can be monitored in WorkStation,
and some of them can be edited.
For more information, see section 56.22 “Network Variable and Configuration
Parameter Values” on page 2042.

56.20.6

Update Monitor
Input network variables can be monitored if a device stops sending data updates,
detecting when incoming signals not are updated within a set period of time.
For more information, see section 57.10 “Update Monitor” on page 2076.

56.20.7

Propagation Trigger
A propagation trigger sends the output network variables in a local node functional
block to devices. The output network variables can be sent to the devices either
manually or triggered automatically through a program attached to functions, such
as a Menta application.
For more information, see section 57.11 “Propagation Trigger” on page 2077.
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56.21

Variable Members and Structured
Variables
A network variable can contain one or several variable members that hold different
values, structured with different members in a hierarchy.
For example, a Xenta 101 device has a functional block (SFPTfanCoilUnit) with a
number of network variables (nv...) and configuration properties (nc...).

Figure: Network variables and members in Building Operation System Tree

The nviFanSlave variable is an input variable containing the members State and
Value (structured SNVT).
The nviApplicMode variable HVAC mode is shown together with its associated CP
variable nciRcvHrtBt separately as nviApplicMode_nciRcvHrtBt. The
nviApplicMode_nciRcvHrtBt is an associated configuration property.
By associating a CP to an NV, you can control your NV with a CP value. In this
case, the nciRcvHrtBt stands for ”Receive Heart Beat” and can be 1 minute. This
means that if the NV does not get a new input value within this time, the NV falls
back to a default value.
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56.22

Network Variable and Configuration
Parameter Values
Network variables and configuration parameters can be monitored in WorkStation,
and some of them can be edited.

Read-only values
Read-only values cannot be modified in Building Operation. These values are
normally output variables sent by a device. Values that are not read-only can be
modified in Building Operation, but the value is overwritten when a new value is sent
from the network or device.

Forced values
You force network variables to make them into temporary parameters. A forced
value ignores updates from the network and keeps its value until it is manually
changed, removed, or the server is restarted.

Retained values
A retained value means that the value is saved and can be retrieved from the server
database in case of a power failure or restart. A value that is not retained exists only
in the RAM memory and is lost in case of a server restart.
The following table illustrates which features are available for the different variable
and parameter classes:
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Class

Read-only

Force possible

Retained

Local Node NVI

Yes

Yes

No

Local Node NV0

No

No

Yes

External Device NVI

No

No

No

External Device NVO

Yes

No

No

Configuration
Parameters

No

No

Yes

DMA - Configuration
Parameters

No

No

Yes
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56.23

Configuring a Network Variable
You can configure a network variable by editing its properties.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.

To configure a network variable
1. In WorkStation, in the System Tree pane, select the network variable.
2. On the File menu, click Properties.
3. Click the Variable Instance Settings tab.
4. Edit the variable instance properties:
Component

Description

Direction

Displays the direction of the variable:
Input (receives) or Output (sends).

Polling enabled

Select if an input variable is to be polled at
regular intervals or not. If the variable is
not polled, it needs to be read according
to a binding.

Poll rate (s)

Enter the time in seconds for the poll rate.

Sending enabled

Select if an output variable is to be sent at
regular intervals or not. If the variable is
not sent at regular intervals, the variable
needs to be sent according to a binding.

Send rate (s)

Enter the time in seconds for the send
rate.

5. Click OK.
6. In the System Tree pane, expand the network variable and then select the
variable member.
7. On the File menu, click Properties.
Continued on next page
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8. Edit the variable member property Value:
Component

Description

Default value

Displays the default value for the variable.
Defined in the XIF file.

Value

Enter the value of the variable.

Minimum value

Displays the minimum value for the
variable. Defined in the DRF kit.

Maximum value

Displays the maximum value for the
variable. Defined in the DRF kit.

Invalid value

Displays the invalid value for the variable.
Defined in the DRF kit.

9. Click OK.
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56.24

Configuring the Value for a Network
Variable Member
You configure the value for a network variable member by editing its properties.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.

To configure the value for a network variable member
1. In WorkStation, in the System Tree pane, expand the network variable and
then select the variable member.
2. On the File menu, click Properties.
3. In the Value box, enter the value of the variable.

4. Click OK.
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56.25

Configuring a Configuration Property
You configure the Configuration properties of the LonWorks device to ensure that
the device performs as required by the project.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.

To configure a configuration property
1. In WorkStation, in the System Tree pane, select the configuration property.
2. In the List View, right-click on the column heading bar and click
Add/Remove columns.
3. Select Value.
4. Click OK.
5. In the Value column, click on the value.
6. Enter the value for the configuration property.
7. On the File menu, click Save.

Tip
When all configuration properties are defined for a LonWorks device,
you can copy and paste the device in the System Tree pane and
then rename it as a means to add another device of the same type
and configuration.

Technical
2048

04-16006-04-en, March 2015

56 LonWorks Devices
56.26 LNS Plug-ins

56.26

LNS Plug-ins
The LNS Plug-in standard is defined by the LNS network operating system so that
device manufacturers can create custom software that simplifies the configuration
of their devices, and integrate seamlessly with the network commissioning tool. In
WorkStation, the LNS Plug-in function allows the user to register and launch an
LNS Plug-in and make an offline configuration of a generic LonWorks device. The
LNS Plug-in function makes it possible to launch specific manufacturers LNS
applications.
In order to register the LNS plugin, configure the device, and download the
configuration to the device, you have to make some preparations on the computer
where Building Operation is installed.
• Install the OpenLNS software. For more information and for downloads, visit
the Echelon website.
• Install the LNS Plug-in for the device you intend to use. The LNS Plug-in
contains the corresponding XIF file/DRF kit. You can also download XIF
files/DRF kits from the LonMark website.

Figure: LNS Plug-in overview

The following Schneider Electric LNS Plug-ins are tested and supported in Building
Operation:
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Continued
LNS Plug-in Package

LNS Plug-in

Device

TACSTR350PlugIn519 (or
newer)

TAC STR350 Plug-in

STR350

TACXenta100PlugIn519 (or
newer)

TACXenta102AXPlugin

Xenta102 AX

TAC ZBuilder Plug-in

Xenta121 HP

"

Xenta121 FC

TAC Xenta 100 Plug-in

Xenta102 b

"

Xenta102 ef

"

Xenta102 vf

"

Xenta102 ES

"

Xenta103 A

"

Xenta104 A

"

Xenta110 D

Other LNS Plug-ins following the LNS network operating system not presented in
the table can also be supported by Building Operation but have not been tested.

Important
Communication with the LonWorks devices is not possible while using the LNS
Plug-in. For example, in purpose for calibration.

Note
You need to download the configuration when the device is configured through
the LNS Plug-in. For more information, see section 56.8 “Downloading the
LonWorks Device Configuration ” on page 2017.
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56.27

Registering LNS Plug-ins
You register LNS Plug-ins in LNS in order to be able to configure device variables
and configuration properties using the tools provided from the manufacturer.
For more information, see section 56.26 “LNS Plug-ins” on page 2047.

To register LNS Plug-ins
1. Ensure that the LNS Plug-ins are installed.

Note
Some plug-ins need a system restart to function properly.
2. In WorkStation, on the Tools menu, click Control Panel.
3. On the Control Panel toolbar, select the server.
4. Click LNS Plug-in Registration.

Continued on next page
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5. In the Available Plug-ins list, select the LNS Plug-ins.

6. Click the Add button

.

7. Click Save.

Important
Depending on the implementation of the LNS Plug-in by the
manufacturer, there is an option to import the device template / XIF
file in LNS. For more information, see section 56.30 “Importing a
Device Template in LNS” on page 2056.
The LNS Plug-ins are registered in Building Operation.
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56.28

Unregistering LNS Plug-ins
You unregister LNS Plug-ins in Building Operation to disable the LNS Plug-ins when
you no longer want to use them.
For more information, see section 56.26 “LNS Plug-ins” on page 2047.

To unregister LNS Plug-ins
1. In WorkStation, on the Tools menu, click Control Panel.
2. Click LNS Plug-in Registration.

Continued on next page

04-16006-04-en, March 2015

Technical
2053

56 LonWorks Devices
56.28 Unregistering LNS Plug-ins

3. In the Registered Plug-ins list, select the LNS Plug-ins .

4. Click the Remove button

.

5. Click Save.
The LNS Plug-ins are unregistered in Building Operation.
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56.29

Configuring Network Variables and
Configuration Parameters using LNS
Plug-in
You configure LonWorks device network variables and configuration parameters
through the LNS Plug-in, to ensure that the device performs as required by the
project.
For more information, see section 56.26 “LNS Plug-ins” on page 2047.

To configure network variables and configuration parameters
using LNS Plug-in
1. In WorkStation, in the System Tree pane, select the LonWorks device that
you want to configure.
2. On the Actions menu, click Configure.
3. Click Next.

Continued on next page
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4. Select the LNS Plug-in.

5. Click the Open LNS Plug-in button

.

6. Edit the configuration data in the LNS Plug-in application and ensure that the
configuration data have been saved.
7. Close the LNS Plug-in application.
8. Click Next.

Continued on next page
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9. Click Next.

10. Click Finish.

You need to download the configuration when the device is configured through the
LNS Plug-in. For more information, see section 56.8 “Downloading the LonWorks
Device Configuration ” on page 2017.
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56.30

Importing a Device Template in LNS
Depending on the implementation of the LNS Plug-in by the manufacturer, there is
an option to install the XIF file in LNS.
For more information, see section 56.26 “LNS Plug-ins” on page 2047.

To import a device template in LNS
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click LNS Plug-in Registration.
Continued on next page
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4. Click the Import Device Template in LNS button

.

5. Select the device template / XIF file.
6. Click Open.

7. Click OK.
The selected device template is imported in LNS.
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56.31

Winking a Device
You wink a device to cause it to generate an application-dependant audible or
visible response, such as flashing the power LED. Winking can be useful for
identification and testing purposes.

Note
• For the Wink command to work, the device needs to support the Wink
function.

To wink a device
1. In WorkStation, in the System Tree pane, select the device.
2. On the Actions menu, click Wink.
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56.32

Adding Missing XIF and DRF Files
You add missing XIF and DRF files to complete third party device templates and
DRF kits.

To add missing XIF and DRF files
1. In WorkStation, on the File menu, point to LonWorks import and then click
Add missing XIF/DRF files.
2. In the Searching for missing files page, click Next.

Continued on next page
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3. In the Search directory box, enter a folder where the missing files can be
found. Building Operation searches subfolders as well.

4. Click Next.
5. In the Searching for replacement files page, click Import or click
Previous to search more missing files to import.

Continued on next page
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6. In the Importing replacement files page, click Close.
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57.1 LonWorks Local Node

57.1

LonWorks Local Node
Enterprise Servers and Automation Servers can have a local node on their networks
that can act as a LonWorks node.
In the local node, you can create your own NVs that can be bound to external
LonWorks devices using LonWorks bindings. The NVs in your local node can then
be used in Building Operation bindings for applications and graphics. For more
information, see section 57.12 “Creating Network Variables Automatically” on page
2078.

Figure: Local Node
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Using LonWorks bindings to communicate with external LonWorks devices is more
efficient than having applications polling the devices. LonWorks bindings can be
event driven, for example tuned to only send values when they are changed or
reach a predefined value. For more information, see section 58.1 “LonWorks
Bindings ” on page 2093.
This minimizes the communication on the network and saves the bandwidth.

57.1.1

LonWorks Commission and Decommission
When you are configuring LonWorks devices or the local node in WorkStation the
configuration data are stored in the Building Operation server database. In order to
download the configuration data to devices or the local node, you need to perform
a commission.
For more information, see section 57.4 “LonWorks Commission and
Decommission” on page 2069.

57.1.2

LonWorks Functional Block
A functional block organizes related network variables and configuration
parameters. The functional block is based on a Functional Profile Type that contains
network variables and configuration parameters.
For more information, see section 57.7 “LonWorks Functional Block” on page
2072.

57.1.3

Network Variables and Configuration
Parameters
Applications can contain network variables and configuration parameters to share
data or to customize the application. These network variables and configuration
parameters are usually defined in the device template.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.
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57.2

Creating a Local Node
You create a local node for your LonWorks network to add network variables in a
server that will be bound to network variables in the LonWorks devices on the field
bus.
For more information, see section 57.1 “LonWorks Local Node” on page 2065.

To create a local node
1. In WorkStation, in the System Tree pane, select the network where you want
to create the local node.
2. On the File menu, point to New and then click Local Node.
3. In the Name box, type a name for the node.

4. In the Description box, type a description.
5. Click Create.
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57.3

Configuring a Local Node
You configure a local node by editing its properties.
For more information, see section 57.1 “LonWorks Local Node” on page 2065.

To configure a local node
1. In WorkStation, in the System Tree pane, select the local node you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Needs commissioning

Displays True when the node needs to
be commissioned.

Needs device configuration
download

Displays True when the configuration has
changed and the node needs a
configuration download.

Program ID

Displays the program ID for the node.

Non group receive timer

Displays the receive timer for all traffic that
does not reach the node through the
address table.

Use extended NMP

Displays True if the node can use the
Extended Network Management
Command Set, ECS. For more
information, see section 155.1 “LonTalk
Addressing Overview” on page 5567.

Model

Displays the model.

Host based application

Displays Yes if the application is host
based.

5. Click OK.
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57.4

LonWorks Commission and
Decommission
When you are configuring LonWorks devices or the local node in WorkStation the
configuration data are stored in the Building Operation server database. In order to
download the configuration data to devices or the local node, you need to perform
a commission.

57.4.1

Commission
When you commission a device or a local node the following actions occur:
• Device tables (Address, Selector, Alias, and Domain table) are written to the
device or the local node.
• The Device state is set to Configured Online.
When you commission a device the following additional actions occur:
• If you select to download the configuration to device, the Configuration
Parameters values are written to the device.
• If you select to upload the configuration from the device, the Configuration
Parameters values are read from the device.
• If you select a device application file, the file is downloaded to the device.
• If the domain table is updated, or if a Configuration Parameter requires it, the
device is restarted.

57.4.2

Decommission
When you decommission a device or a local node the following actions occur:
• The device or the local node stops communicating.
• The application is stopped unless it is host based.
• The device object configuration is kept, which means that everything can be
restored in the physical device or the local node at a new commission.

Important
Decommission a LonWorks device before you remove it from the network.
Otherwise, the old network information can cause problems if the device is used
in another network.
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57.5

Commissioning a Local Node
You commission a local node to activate it. The commission enables the local node
to communicate on the LonWorks network.
For more information, see section 57.4 “LonWorks Commission and
Decommission” on page 2069.

To commission a Local Node
1. In Workstation, in the System Tree pane, select the local node.
2. On the Actions menu, click Commission.
The local node is commissioned.
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57.6

Decommissioning a Local Node
You decommission a local node to deactivate it, making it not communicating with
the network.
For more information, see section 57.4 “LonWorks Commission and
Decommission” on page 2069.

To decommission a Local Node
1. In Workstation, in the System Tree pane, select the local node.
2. On the Actions menu, click Decommission.
The device address is revoked in the network and it stops communicating.
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57.7

LonWorks Functional Block
A functional block organizes related network variables and configuration
parameters. The functional block is based on a Functional Profile Type that contains
network variables and configuration parameters.

Figure: Functional block in the Local Node

A node can contain several functional blocks. On external devices, the functional
blocks are created from the device template. On the local node, you can create
your own functional blocks and add network variables to them.

Technical
2074

04-16006-04-en, March 2015

57 LonWorks Local Node
57.8 Creating a Functional Block

57.8

Creating a Functional Block
You create functional blocks in a local node to organize network variables that will
be created in the Local Node.
For more information, see section 57.7 “LonWorks Functional Block” on page
2072.

To create a functional block
1. In WorkStation, in the System Tree pane, select the local node where you
want to create the functional block.
2. On the File menu, point to New and then click Functional Block.
3. In the Name box, type a name for the functional block.

4. In the Description box, type a description.
5. Click Create.
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57.9

Network Variables and Configuration
Parameters
Applications can contain network variables and configuration parameters to share
data or to customize the application. These network variables and configuration
parameters are usually defined in the device template.

57.9.1

Network Variables
A network variable is any data item that a device application gets from, or makes
available to, other devices on the network. A network variable is typically a
temperature, a switch value, or an actuator position setting.
Network variables allow a device to send (output) and receive (input) data over the
network to and from other devices.
In Building Operation, there are 4 classes of network variables:
• Internal NVI: Input variable owned by a local node
• Internal NVO: Output variable owned by a local node
• External NVI: Input variable owned by a device
• External NVO: Output variable owned by a device
You configure the network variables by editing the properties in WorkStation. For
more information, see section 57.15 “Configuring a Network Variable” on page
2083.
You can also configure LonWorks network variables by editing the properties using
an LNS Plug-in. For more information, see section 56.29 “Configuring Network
Variables and Configuration Parameters using LNS Plug-in” on page 2053.

57.9.2

Configuration Parameters
Configuration parameters are used to configure the operation of a device.
Configuration parameters can be implemented in two ways:
• Configuration network variable types use a special class of network variables.
• Direct memory access (DMA) configuration properties are stored in a data
block that is read and written using direct memory access.
You modify the configuration parameters by editing the properties in WorkStation.
For more information, see section 56.25 “Configuring a Configuration Property” on
page 2046.
You can also configure configuration parameters by editing the properties using an
LNS Plug-in. For more information, see section 56.29 “Configuring Network
Variables and Configuration Parameters using LNS Plug-in” on page 2053.

57.9.3

Variable Members and Structured Variables
A network variable can contain one or several variable members that hold different
values, structured with different members in a hierarchy.
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For more information, see section 56.21 “Variable Members and Structured
Variables” on page 2041.

57.9.4

NVTs and CPTs
The network variables and configuration parameters are based on types (NVTs and
CPTs) in the Building Operation type repository. The types are defined in the
LonWorks standard and define how the variable/parameter should be interpreted,
because the same raw value can have different meaning in different types.
For example, a value can correspond to a temperature in one case and to a date in
another case. The type repository is pre-installed with the standard LonWorks types
(SNVTs and SCPTs). User defined types (UNVTs and UCPTs) can also be added by
importing Device Resource Files.

57.9.5

Network Variable and Configuration Parameter
Values
Network variables and configuration parameters can be monitored in WorkStation,
and some of them can be edited.
For more information, see section 56.22 “Network Variable and Configuration
Parameter Values” on page 2042.

57.9.6

Update Monitor
Input network variables can be monitored if a device stops sending data updates,
detecting when incoming signals not are updated within a set period of time.
For more information, see section 57.10 “Update Monitor” on page 2076.

57.9.7

Propagation Trigger
A propagation trigger sends the output network variables in a local node functional
block to devices. The output network variables can be sent to the devices either
manually or triggered automatically through a program attached to functions, such
as a Menta application.
For more information, see section 57.11 “Propagation Trigger” on page 2077.
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57.10

Update Monitor
Input network variables can be monitored if a device stops sending data updates,
detecting when incoming signals not are updated within a set period of time.
When creating the update monitor on a local node input network variable, you can
set the period in minutes. As default the update monitor is set to a 5 minute period.
The period defines the time between the checkpoints of input network variable field
value changes. When the period is set to 5 minutes, the system monitors the
incoming data every fifth minute. If the system does not receive any incoming data
updates after 5 minutes, the network variable is considered offline. When incoming
data is received, the network variable is considered online.
This feature can be used for triggering events, such as an alarm. The alarm will then
be triggered when the incoming variable not is updated within the set period of time
in the update monitor.

Figure: Update monitor function
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57.11

Propagation Trigger
A propagation trigger sends the output network variables in a local node functional
block to devices. The output network variables can be sent to the devices either
manually or triggered automatically through a program attached to functions, such
as a Menta application.
When several field values are changed, the propagation trigger sends a variable as
one value rather than as several values at different times. Propagation triggers
decrease network traffic and ensure that the necessary parts of the output network
variable are in synch before the variable is sent to the device.

Important
The propagation trigger feature disables any send variable instance setting on an
output network variable. For more information, see section 57.15 “Configuring a
Network Variable” on page 2083.
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57.12

Creating Network Variables
Automatically
You create network variables in the local node by mirroring network variables in
LonWorks field bus devices when you want to create and bind multiple network
variables in one action, which saves you engineering time.
For more information, see section 57.1 “LonWorks Local Node” on page 2065.

To create network variables automatically
1. In WorkStation, in the System Tree pane, in the LonWorks network, select
the functional block that contains the network variables that you want to be
represented in the local node.
2. In the List View, select the network variables that you want to be represented
in the local node.
3. On the File menu, point to New and then click Mirrored network
variables.
Mirrored network variables of the network variables that you selected, are
automatically created and bound in the local node, within functional blocks that are
also automatically created and named according to the LonWorks devices from
where the network variables originate.

Note
• This procedure uses a lot of the Automation Server CPU and takes some time
to complete. System alarms might be triggered.
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57.13

Creating an Input Network Variable
You create input network variables in functional blocks in a local node for binding
LonWorks variables between the Automation Server and the Xenta 280/300/401
LonWorks devices or other LonWorks devices.
For more information, see section 57.1 “LonWorks Local Node” on page 2065.

To create an input network variable
1. In WorkStation, in the System Tree pane, select the functional block where
you want to create the variable.
2. On the File menu, point to New and then click Network Variable.
3. In the Resource files kit box, select the DRF that contains the types for the
variable.

4. In the Type box, select the type of variable.
5. In the Direction box, select Input.
6. In the Name box, type a name for the variable.
7. Click Next.
8. In the Polling enabled box, select Yes to poll the variable.

Tip
• To ensure efficient bandwidth usage, enable polling only when
the sending device cannot use event-driven communication.
Continued on next page
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9. In the Poll rate (s) box, enter the number of seconds between the polls.
10. Click Create.

Technical
2082

04-16006-04-en, March 2015

57 LonWorks Local Node
57.14 Creating an Output Network Variable

57.14

Creating an Output Network Variable
You create output network variables in functional blocks in a local node for binding
LonWorks variables between the Automation Server and the Xenta 280/300/401
LonWorks devices or other LonWorks devices.
For more information, see section 57.1 “LonWorks Local Node” on page 2065.

To create an output network variable
1. In WorkStation, in the System Tree pane, select the functional block where
you want to create the variable.
2. On the File menu, point to New and then click Network Variable.
3. In the Resource files kit box, select the DRF that contains the types for the
variable.

4. In the Type box, select the type of variable.
5. In the Direction box, select Output.
6. In the Name box, type a name for the variable.
7. Click Next.
Continued on next page
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8. In the Sending enabled box, select Yes to send the variables at periodic
intervals.

9. In the Send rate box, enter the number of seconds between the sends.
10. In the Initial Value box, enter the initial value for the variable.
11. Click Create.
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57.15

Configuring a Network Variable
You can configure a network variable by editing its properties.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.

To configure a network variable
1. In WorkStation, in the System Tree pane, select the network variable.
2. On the File menu, click Properties.
3. Click the Variable Instance Settings tab.
4. Edit the variable instance properties:
Component

Description

Direction

Displays the direction of the variable:
Input (receives) or Output (sends).

Polling enabled

Select if an input variable is to be polled at
regular intervals or not. If the variable is
not polled, it needs to be read according
to a binding.

Poll rate (s)

Enter the time in seconds for the poll rate.

Sending enabled

Select if an output variable is to be sent at
regular intervals or not. If the variable is
not sent at regular intervals, the variable
needs to be sent according to a binding.

Send rate (s)

Enter the time in seconds for the send
rate.

5. Click OK.
6. In the System Tree pane, expand the network variable and then select the
variable member.
7. On the File menu, click Properties.
Continued on next page
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8. Edit the variable member property Value:
Component

Description

Default value

Displays the default value for the variable.
Defined in the XIF file.

Value

Enter the value of the variable.

Minimum value

Displays the minimum value for the
variable. Defined in the DRF kit.

Maximum value

Displays the maximum value for the
variable. Defined in the DRF kit.

Invalid value

Displays the invalid value for the variable.
Defined in the DRF kit.

9. Click OK.
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57.16

Configuring the Value for a Network
Variable Member
You configure the value for a network variable member by editing its properties.
For more information, see section 57.9 “Network Variables and Configuration
Parameters” on page 2074.

To configure the value for a network variable member
1. In WorkStation, in the System Tree pane, expand the network variable and
then select the variable member.
2. On the File menu, click Properties.
3. In the Value box, enter the value of the variable.

4. Click OK.
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57.17

Creating an Update Monitor
You create an update monitor to monitor the communication with an external
LonWorks device in a externally managed LonWorks network.
For more information, see section 57.10 “Update Monitor” on page 2076.

To create an Update Monitor
1. In WorkStation, in the System Tree pane, select the input network variable
where you want to create the update monitor.
2. On the File menu, point to New and then click Update Monitor.
3. In the Name box, type the name of the update monitor.

4. In the Description box, type the description of the update monitor.
5. Click Create.
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57.18

Creating a Propagation Trigger
You create a propagation trigger to send network variable output data.
For more information, see section 57.11 “Propagation Trigger” on page 2077.

To create a Propagation Trigger
1. In WorkStation, in the System Tree pane, select the output network
variable where you want to create the propagation trigger.
2. On the File menu, point to New and then click Propagation Trigger.
3. In the Name box, type the name of the propagation trigger.

4. In the Description box, type the description of the propagation trigger.
5. Click Create.
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57.19

Configuring an Update Monitor
You configure the update monitor to change the amount of time between input
network variable updates before the variable is considered offline.
For more information, see section 57.10 “Update Monitor” on page 2076.

To configure an update monitor
1. In WorkStation, in the System Tree pane, expand the input network variable
and then select the update monitor.
2. On the File menu, click Properties.
3. In the Period box, enter the value of the period.

4. Click OK.
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57.20

Configuring a Propagation Trigger
You configure the propagation to send the network variable as one value rather
than several values at different times, or not.
For more information, see section 57.11 “Propagation Trigger” on page 2077.

To configure a propagation trigger
1. In WorkStation, in the System Tree pane, expand the output network
variable and then select the propagation trigger.
2. On the File menu, click Properties.
3. In the Propagate network variable box, select Yes or No.

4. Click OK.

04-16006-04-en, March 2015

Technical
2091

58

LonWorks Bindings

Topics
LonWorks Bindings
LonWorks Bindings in WorkStation
LonWorks Binding Profiles
LonWorks Binding Types
Bindable Objects in LonWorks
LonWorks Selectors and Bindings
Creating a LonWorks Binding
Replacing a Hub in a LonWorks Binding

58 LonWorks Bindings
58.1 LonWorks Bindings

58.1

LonWorks Bindings
A LonWorks binding is a connection between two or more network variables or
configuration properties for data exchange. In its simplest form, one variable is
bound to another in a Point-to-point binding. You can also bind one variable to
several (Fan-out), or several to one (Fan-in).
LonWorks bindings differ from other Building Operation bindings because you can
set LonWorks specific properties, such as LonWorks binding profiles.

Figure: Point-to-point binding

A binding consists of one hub and one or more targets. The hub is a unique node
that connects to one or more targets.

Note
• To create a LonWorks binding, you need to bind on the variable level. If you
bind two members of network variables, a Building Operation binding is
created rather than a LonWorks binding. For more information, see section
57.9 “Network Variables and Configuration Parameters” on page 2074.

Note
The lock feature is disabled for LonWorks bindings, because a locked LonWorks
binding may result in scenarios where a binding contains several hubs pointing to
one target, or different binding profiles are mixed.

58.1.1

LonWorks Bindings in WorkStation
Use the Bindings View in WorkStation to create your LonWorks bindings. You can
drag and drop NVs to create bindings.
For more information, see section 58.2 “LonWorks Bindings in WorkStation” on
page 2095.

58.1.2

Bindable objects in LonWorks
LonWorks network variables and configuration parameters can be bound to each
other in LonWorks bindings. They can also be bound to most points in Building
Operation, such as programs, graphics, alarms, and trend logs, but then Building
Operation bindings is used, not LonWorks bindings.
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For more information, see section 58.5 “Bindable Objects in LonWorks” on page
2101.

58.1.3

LonWorks Binding Profiles
When you create a binding in LonWorks, you decide its behavior by selecting a
binding profile. You either select a binding profile, or you use the default profile.
For more information, see section 58.3 “LonWorks Binding Profiles ” on page 2096.

58.1.4

LonWorks Binding Types
Building Operation supports different types of LonWorks bindings, such as point-topoint, turnaround, fan-in, and fan-out.
For more information, see section 58.4 “LonWorks Binding Types” on page 2098.

58.1.5

LonWorks Selectors and Bindings
LonWorks uses selectors to create bindings between network variables. A selector
is a unique index that is assigned to a network variable and points to the target
device, where the bound network variable is assigned the same selector index.
For more information, see section 58.6 “LonWorks Selectors and Bindings” on
page 2102.
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58.2

LonWorks Bindings in WorkStation
Use the Bindings View in WorkStation to create your LonWorks bindings. You can
drag and drop NVs to create bindings.

Figure: Building Operation bindings View

When you select an object in the System Tree pane, all its bindable points are
displayed in the Binding point list. To create a binding, drag an NV (or NVs) from the
Browser to an NV in the Binding point list and save the binding. You can also add
more points to the binding, remove points, or change the hub of the binding. If all
points of a binding are removed, the binding itself is removed.
When you copy and paste LonWorks solutions in the System Tree, bindings are
retained as long as both bound sender and receiver objects are included.
Copy, paste, and move can be used within different scopes in the System Tree.
You can move objects within a network in the System Tree. You can copy and
paste objects within a server in the System Tree. To reuse a LonWorks solution
outside the server of origin, you need to use the export and import command ( For
more information, see section 18.10 “Import and Export of LonWorks Solutions” on
page 570.). For bindings to be retained in all these operations, both sender and
receiver objects need to be included in the operation.
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58.3

LonWorks Binding Profiles
When you create a binding in LonWorks, you decide its behavior by selecting a
binding profile. You either select a binding profile, or you use the default profile.
There are basically three types of binding profiles:
• Acknowledged profiles
• Unacknowledged profiles
• Broadcast profiles
Use an acknowledged binding profile when the sending device should receive an
acknowledgement from the receiving device indicating that the value of the bound
variable was successfully sent.
Binding profile

Transmit timer

Retry count

Acknowledged Profile

96 ms

3

Acknowledged , Tx tmr
256, 3 retries

256 ms

3

Acknowledged , Tx tmr 256, 256 ms
5 retries

5

Acknowledged , Tx tmr
1024, 5 retries

5

1024 ms

Tip
Be careful of creating large, acknowledged fan-out bindings because they
generate a lot of traffic, especially if the device of one of the recipients is offline.
Use an unacknowledged binding profile when the sending device should not
receive an acknowledgement from the receiving device. Use this type when the
value being sent is not critical and is of low importance to the control logic.
Binding profile

Repeat timer

Unacknowledged Profile

Repeat count
0

Unacknowledged Repeated
Profile

48 ms

3

Unacknowledged
Repeated , 5 repeats

48 ms

5

Use a broadcast profile when you do not want to use up an entry in the address
table. The device address table has 15 available entries for bindings but the first
entry is a reserved broadcast entry that all broadcast bindings can share.
Binding profile

Repeat timer

Broadcast Profile
Broadcast Profile, 5 repeats
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0

48 ms

5
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Binding profile

Repeat timer

Repeat count

If no binding profile is selected, a default profile is used:
• Point-to-point bindings use the Acknowledged profile as default.
• Fan-out bindings use the Unacknowledged Repeated profile as default.
• Building Operation uses the broadcast profile as default when the device
address table has run out of entries.
If a point-to-point binding is changed to a fan-out binding, the binding profile is
automatically updated to an Unacknowledged Repeated profile.
If a fan-out binding is changed to a point-to-point binding, the binding profile is
automatically updated to an Acknowledged profile.
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58.4

LonWorks Binding Types
Building Operation supports different types of LonWorks bindings, such as point-topoint, turnaround, fan-in, and fan-out.

58.4.1

Hubs and Targets in Bindings
A binding consists of one hub and one or more targets. The hub is the center of the
binding which connects to one or more targets. When creating bindings, both the
hub and target can be an NVI as well as an NVO. A good rule is to always use the
NVO as the hub, except when creating a fan-in binding. With the NVO as the hub,
you can create a point-to-point binding and then expand it to a fan-out.
The following table describes which hub and targets are used in each type of
binding:

58.4.2

Binding Type

Hub

Target(s)

Point-to-point

NVO

NVI

Turnaround

NVO

NVI

Fan-out

NVO

NVIs

Fan-in

NVI

NVOs

Point-to-point Bindings
A point-to-point binding is a binding between two single network variables of
compatible types. An NVO must bind to an NVI and vice versa. A typical example of
a point-to-point binding is a LonWorks occupancy sensor that sends the
snvt_occupancy to a Xenta controller, that is doing the HVAC control of a room.

Figure: Point-to-point binding

In a point-to-point binding, the hub might be either the NVI or the NVO.
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58.4.3

Turnaround Bindings
A turnaround binding is a connection between input and output network variables
on the same device. A turnaround binding is appropriate for a device that receives
the data it transmits. For example, a device that has a temperature input that is
bound to its actuator output.

Figure: Turnaround binding

In a turnaround binding, the hub might be either the NVI or the NVO.

58.4.4

Fan-out Bindings
A fan-out binding is a binding between one sender and several receivers. For
example a zone controller that sends out a snvt_temp_p as the (nvi-) setpoint for a
large number of HVAC controllers.

Figure: Fan-out bindings

In fan-out bindings, the hub should always be the unique output variable. In this
case, the unique variable is the NVO.
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In the Binding view, drag the the NVIs to the hub in the Binding points list, not the
other way around.

58.4.5

Fan-in Bindings
A fan-in binding is a binding between several senders and one receiver. For
example, several temperatures from LonWorks devices bound into one single (nvi-)
temp_p in a device.
In Building Operation, fan-in bindings are treated just like a number of point-to-point
bindings. When several values are received, the last received value is used. No
mean value calculations are available.

Figure: Fan-in bindings

In fan-in bindings, the hub should always be the unique input variable. In this case,
the unique variable is the NVI.
In the Binding view, drag the the NVOs to the hub in the Binding points list, not the
other way around.

Note
• Do not use fan-in bindings for a polling NVI.
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58.5

Bindable Objects in LonWorks
LonWorks network variables and configuration parameters can be bound to each
other in LonWorks bindings. They can also be bound to most points in Building
Operation, such as programs, graphics, alarms, and trend logs, but then Building
Operation bindings is used, not LonWorks bindings.
Some points are read-only and can therefore only be used as producers. Other
points are of the type object reference and can only be used as consumers.
You can bind the following points in LonWorks:
Point

Comments

Local node NVO
Local node NVI
LonWorks device NVO

(producer only)

LonWorks device NVI
LonWorks device CP

You can bind LonWorks points with the following points in Building Operation:
Point

Comments

Function Block output
Function Block input
Script output
Script input
Schedule outputs

(producer only)

Variables
Central IO points
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Graphics reference input

(consumer only)

Alarm reference input

(consumer only)

Trend reference input

(consumer only)
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58.6

LonWorks Selectors and Bindings
LonWorks uses selectors to create bindings between network variables. A selector
is a unique index that is assigned to a network variable and points to the target
device, where the bound network variable is assigned the same selector index.
In Building Operation, the selectors and the addresses of the bound nodes are kept
in different tables on each node. These tables are the domain table, address table,
selector table, and alias table. The tables can be viewed in WorkStation and are
stored on the device or local node when commissioned. A master selector table is
also stored on the Building Operation server that owns the network.

Domain Table
The domain table stores the node's own DSN address. The address is set for all
network nodes when the objects are created in Building Operation.

Figure: Domain table example

Address Table
The address table contains DSN addresses of other nodes together with a unique
index that is used by the Selector table.
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Figure: Address table example

Selector Table
The selector table stores information about the network variables in the node. (The
selector table is also called network variable configuration table, or just variable
selectors.)
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Figure: Selector table example

The selector table automatically assigns a selector for each network variable on the
node. Unused selectors are given a hex number between 3000-3FFF. Used
selectors is given a hex number between 0000-2FFF. The used selectors are
unique for the entire network. A device can be assigned a maximum of 4 096
selectors (3FFF-3000) and a network can use a total of 12 228 selectors (2FFF0000).

Simple Binding Example
In this single point-to-point binding, NV with index 1 (the second SNVT in the XIF
file) in DEVICE 1, is bound to the NV with index 6 (the seventh SNVT in that XIF file)
in DEVICE 2.
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Figure: Domain, Address and Selector tables in Building Operation

When the binding is created, the selector table row for the used network variable on
the hub (Device 1) is assigned a unique selector number (453). The selector row
also points to an index(a) in the address table, with the address to the target
node(b).
04-16006-04-en, March 2015

Technical
2107

58 LonWorks Bindings
58.6 LonWorks Selectors and Bindings

The target node’s (Device 2) selector table is also assigned the same unique
selector number for its used network variable (c).
All used selector numbers are also stored in a master selector table in the Building
Operation server that owns the network, to keep track of used selectors.
When a network variable is bound to several other devices (a group binding), the
same selector number is assigned to the used network variables in all devices.

Alias Table
The alias table is a secondary selector table used for giving the same network
variable several selectors. In a selector table, the same selector index can only
appear once. If you want to bind one network variable to several target network
variables in the same device, aliases are used for each target.

Figure: Alias table example
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58.7

Creating a LonWorks Binding
You create a LonWorks binding between the Automation Server local node and a
LonWorks device or between two LonWorks devices. You create the binding
between LonWorks Network Variables or Configuration Parameters (NV based).
You use a LonWorks binding to communicate with a LonWorks device because it
enables event-driven communication, which is more efficient than communication
using the polling method.
For more information, see section 58.1 “LonWorks Bindings ” on page 2093.

To create a LonWorks binding
1. In WorkStation, in the System Tree pane, select the local node or device for
which you want to create a LonWorks binding.
2. On the Actions menu, click Edit bindings.
3. In the binding point list, select the variable you want to bind to.

4. In the binding point browser, select the device to bind from.
5. Expand the selected device to display the variables that are available to be
bound.
Continued on next page
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6. Select the variable to be bound and drag it to the binding box for the variable
in the binding point list.

Important
• To bind more than one variable to a binding point, drag the
variable to the name of the binding point. Each binding adds a
row to the binding point.

7. In the binding point list, click the Binding profile button
for the binding
that you just created.
8. In the Lon binding properties dialog box, click a binding profile. For more
information, see section 58.3 “LonWorks Binding Profiles ” on page 2096.

9. Select Disable initial read to disable initial read of the network variable in
the device.
10. Click OK.
11. On the File menu, click Save.

Tip
• You cannot use a custom binding template when you create
LonWorks bindings. Custom binding templates can be used
when you create Building Operation bindings.
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58.8

Replacing a Hub in a LonWorks Binding
You replace the hub in LonWorks binding to change the source value or the fan-in
destination value of a binding.
For more information, see section 58.4 “LonWorks Binding Types” on page 2098.

To replace a hub in a LonWorks binding
1. In WorkStation, in the System Tree pane, select the hub to replace.
2. In the Bindings view, in the bindings point list, right-click the hub variable and
click Replace hub.

Continued on next page
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3. Select the new hub.

4. Click Select.
5. On the File menu, click Save.
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59.1 LonWorks Maintenance

59.1

LonWorks Maintenance
LonWorks maintenance covers topics that describe how you use Building
Operation to replace hardware and troubleshoot an automation system based on
the LonWorks fieldbus standard.

59.1.1

LonWorks Device Replacement
You replace a physical LonWorks device because of malfunction issues, new
requirements, or misplacement.
For more information, see section 59.2 “LonWorks Device Replacement” on page
2114.

59.1.2

LonWorks Network Analysis
Analyzing a LonWorks network in Building Operation is both a matter of general
network troubleshooting and reviewing your Building Operation configuration. A
systematic approach is to define the problem, gather facts, and find the cause. You
can then decide the actions to take, considering how your actions can affect other
parts of the network. The first place to start is to review your Building Operation
configuration. Check the properties of your ports, networks, devices, NVs, CPs,
and bindings. Try to wink your devices ( For more information, see section 56.31
“Winking a Device” on page 2058.) and check their status.
For more information, see section 59.5 “LonWorks Network Analysis” on page
2118.

59.1.3

LonWorks Device Diagnostics
Finding diagnostic data is important when reviewing or troubleshooting a LonWorks
network.
For more information, see section 59.6 “LonWorks Device Diagnostics” on page
2122.
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59.2

LonWorks Device Replacement
You replace a physical LonWorks device because of malfunction issues, new
requirements, or misplacement.
The LonWorks device that you want to replace can be online or offline (not able to
communicate at all).
If the LonWorks device is online, you can upload the device configuration to
WorkStation before you remove the device and then reuse the old configuration in
the new device. Removing a LonWorks device, for any reason, should involve a
decommissioning of the device.
If the LonWorks device is offline, there is no possibility of uploading the device
configuration to WorkStation nor decommissioning the device. Then you will have to
manage and work with the device configuration that is stored in WorkStation. If the
device configuration that is stored in WorkStation is synchronized with the device,
then there is no issue.
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59.3

Replacing an Online LonWorks Device
You replace a physical LonWorks device because of malfunction issues, new
requirements, or misplacement.
For more information, see section 59.2 “LonWorks Device Replacement” on page
2114.

To replace an online LonWorks device
1. In WorkStation, in the System Tree pane, select the LonWorks device that
you want to replace.

Tip
• If the device configuration in the physical LonWorks device is not
synchronized with the configuration that is stored in the server,
you can upload the device configuration to the server before you
decommission and remove the LonWorks device. For more
information, see section 56.9 “Uploading the LonWorks Device
Configuration ” on page 2018.
2. On the Actions menu, click Decommission.
3. Remove the old physical LonWorks device.
4. Install the new physical LonWorks device.
5. On the Actions menu, click Commission.
Continued on next page
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6. In the Neuron ID box, type or retrieve the Neuron ID of the new LonWorks
device:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical device
to retrieve the Neuron ID.

7. Click Download current configuration to device.
8. Click Commission.
9. Click Close.
The LonWorks device is replaced, commissioned, and activated.
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59.4

Replacing an Offline LonWorks Device
You replace a physical LonWorks device because of malfunction issues, new
requirements, or misplacement.
For more information, see section 59.2 “LonWorks Device Replacement” on page
2114.

To replace an offline LonWorks device
1. Remove the old physical LonWorks device.
2. Install the new physical LonWorks device.
3. In WorkStation, in the System Tree pane, select the LonWorks device that
you have replaced.
4. On the Actions menu, click Commission.
5. In the Neuron ID box, type or retrieve the Neuron ID of the new LonWorks
device:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical device
to retrieve the Neuron ID.

6. Click Download current configuration to device.
7. Click Commission.
8. Click Close.
The LonWorks device is replaced, commissioned, and activated.
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59.5

LonWorks Network Analysis
Analyzing a LonWorks network in Building Operation is both a matter of general
network troubleshooting and reviewing your Building Operation configuration. A
systematic approach is to define the problem, gather facts, and find the cause. You
can then decide the actions to take, considering how your actions can affect other
parts of the network. The first place to start is to review your Building Operation
configuration. Check the properties of your ports, networks, devices, NVs, CPs,
and bindings. Try to wink your devices ( For more information, see section 56.31
“Winking a Device” on page 2058.) and check their status.
Common network problems, such as high network load or cable problems, can
also cause errors. To find the source of errors, you probably need to analyze your
networks using a network analyzer. In Building Operation, we recommend LOYTEC
Protocol Analyzer (LPA). LOYTEC offers a detailed guide for analyzing and
troubleshooting LonWorks networks with the LPA software. See the LOYTEC
website for more information.

59.5.1

LOYTEC Protocol Analyzer (LPA)
The LPA is a Windows-based tool for analyzing traffic on LonWorks networks.
Connected to the LonWorks network you can observe all network communication
on your PC.

Figure: The LOYTEC Protocol Analyzer

The LPA software processes and displays all data packets in an easy to understand
and intuitive form.
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59.5.2

LPA in Building Operation
You can connect the LPA directly to a LOYTEC interface or to the built-in LonWorks
interface of the Automation Server.

LPA with Automation Server

Figure: LPA with Automation Server

To connect the LPA to the built-in LonWorks interface of an Automation Server, you
must first set it up in the LPA. You specify the address of the Automation Server in
the Remote LPA Assignment dialog box and then you assign/add it in the
Network Interface Selection list.

Note
• You need a USB service dongle with an LPA license to run the LPA tool and
you need the LConfig tool to register it.
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LPA with Enterprise Server

Figure: LPA with Enterprise Server

To connect the LPA to an interface of an Enterprise Server, select an available MNI
interface from the same NIC device in the Network Interface Selection list.

Note
• You need a USB service dongle with an LPA license to run the LPA tool and
you need the LConfig tool to register it.

59.5.3

LPA Analysis Overview
When you have your LPA software installed and are connected to your Building
Operation networks, you can start analyzing the network traffic.
Detailed information can be found in the LPA manual and the LOYTEC
troubleshooting guide “Network Troubleshooting White Paper, AN008E”.
The following table lists some important questions and some hints on solutions.
Table: Analyzing with LPA
Analyze
Network bandwidth utilization. Rate > 50%?

Solution
• Check poll & update rates.
• Improve structure of network.
• Change Ack to UnAck for group
messages.

Network error rate. Rate > 2%

• Check network termination.
• Check cabling (broken cables,
frequency converters, and shielding).
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Continued
Analyze
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Solution

Missed preamble counter. Increasing fast
(>10/sec.)?

• Check network termination.

Alternate path packets. Are there AP
packets?

• Check power supply.

• Check cabling (broken cables,
frequency converters, and shielding).

• Check for installation errors
(inconsistent database and uninstalled
nodes).
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59.6

LonWorks Device Diagnostics
Finding diagnostic data is important when reviewing or troubleshooting a LonWorks
network.
You can view traffic information for a device using WorkStation. For more
information, see section 59.7 “Viewing Diagnostic Data” on page 2123.
You can rebind a network if you suspect that bindings have become currupt. For
more information, see section 59.9 “Rebinding a LonWorks Network” on page
2125.
You can detect subnet/node conflicts if you suspect that device addresses are in
conflict. For more information, see section 59.10 “Detecting Subnet/Node
Conflicts” on page 2126.
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59.7

Viewing Diagnostic Data
You view diagnostic data about a device, or a local node, for reviewing or
troubleshooting purposes.

To view diagnostic data
1. In WorkStation, in the System Tree pane, select the device or local node.
2. In the Properties dialog box, click the Diagnostics tab.
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59.8

Clearing Diagnostic Data
You clear the diagnostic data about a device or a local node, to start a new
collection of diagnostic data.

To clear the diagnostic data
1. In WorkStation, in the System Tree pane, select the device or local node.
2. On the Actions menu, click Clear Status.
The diagnostic data for the device or local node is cleared.
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59.9

Rebinding a LonWorks Network
You rebind a LonWorks network to clear and recreate all LonWorks bindings.
For more information, see section 154.3 “Corrupt LonWorks Bindings” on page
5560.

To rebind a LonWorks network
1. In WorkStation, in the System Tree pane, select the LonWorks network that
you want to rebind.
2. On the Actions menu, point to Advanced and then click Rebind.
3. Click Yes.

4. Click Close.
5. Decommission all devices in the LonWorks network. For more information, see
section 56.7 “Decommissioning a LonWorks Device” on page 2016.
6. Commission all devices in the LonWorks network. For more information, see
section 56.6 “Commissioning a LonWorks Device” on page 2014.
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59.10

Detecting Subnet/Node Conflicts
You detect conflicting devices so that you can recommission them with unique
addresses.
For more information, see section 154.2 “LonWorks Device Communication
Problems” on page 5559.

To detect subnet/node conflicts
1. In WorkStation, in the System Tree pane, select the LonWorks network that
you want to examine.
2. On the Actions menu, point to Advanced and then click Detect
Subnet/Node conflicts.
The command finds devices with conflicting addresses and displays their neuron
IDs. Decommission the conflicting device and commission it again to give it a new
and unique address.

Technical
2128

04-16006-04-en, March 2015

59 LonWorks Maintenance and Operating
59.11 LonWorks Operating

59.11

LonWorks Operating
LonWorks operating covers topics that describe how you use Building Operation to
supervise and manage an automation system based on the LonWorks fieldbus
standard.

59.11.1

LonWorks Offline Alarms
LonWorks nodes can be monitored to trigger alarms if they go offline. Offline alarms
are handled as system alarms in Building Operation. Offline detection can be
enabled or disabled for each LonWorks node. Also, the NIC-USB and NIC-IP ports
on the Enterprise Server can be monitored.
For more information, see section 59.12 “LonWorks Offline Alarms” on page 2128.
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59.12

LonWorks Offline Alarms
LonWorks nodes can be monitored to trigger alarms if they go offline. Offline alarms
are handled as system alarms in Building Operation. Offline detection can be
enabled or disabled for each LonWorks node. Also, the NIC-USB and NIC-IP ports
on the Enterprise Server can be monitored.
When activating offline detection, you can set the delay and priority.
The delay defines how long after a device is detected as offline, until an alarm is
sent. If you set the delay to 60 seconds, the system polls the device every 30
seconds. This means that the allowed delay actually is 30 to 60 seconds.
For example, the delay is set to 1 minute. The device goes offline just after minute 1,
but goes online again before the next poll (1:30), so no alarm is sent. Later the
device goes offline after minute 2 and this is detected at the next poll (2:30). At
minute 3 an alarm is sent.

Figure: Offline Detection
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60.1

LonWorks System Tree Icons
This table describes the icons in WorkStation that relate to LonWorks.
Table: LonWorks Icons in WorkStation
Icon

Description
LonWorks Interface
Indicates a LonWorks interface.
LonWorks Network
Indicates a LonWorks network.
LonWorks Device or Local Node
Indicates a device or local node.
LonWorks Device or Local Node,
Database Mode
Indicates a device or local node in database
mode. For more information, see the
LonWorks Database Mode topic on
WebHelp.
LonWorks Device or Local Node,
Offline
Indicates a device or local node in offline
mode.
LonWorks Device or Local Node, Out
of sync
Indicates a device or local node that is out of
sync. For more information, see section
154.4 “LonWorks Device Out of Sync” on
page 5561.
LonWorks Device or Local Node,
Invalid
Indicates a device or local node with
unknown status. The node is not
commissioned or has been
decommissioned.
LonWorks Binding
Indicates LonWorks binding.
LonWorks Binding Profile
Indicates a LonWorks binding profile.
LonWorks Binding Profile, Default
Indicates the LonWorks binding profile,
currently set as default.
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Continued
Icon

Description
LonWorks Folder or Functional Block
Indicates a LonWorks folder or Functional
Block.
LonWorks Network Variable or
Configuration Property
Indicates a Network Variable or
Configuration Property.
LonWorks Network Variable or
Configuration Property, Offline
Indicates a Network Variable or
Configuration Property that is offline.
LonWorks Device Table
Indicates a LonWorks device table.
LonWorks Device Table, Offline
Indicates a LonWorks device table that is
offline.
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60.2

File Menu – LonWorks Import Submenu
Use the commands on the LonWorks Import submenu to import device
templates, resource files, and to add missing files to existing templates and
resource files.

Figure: LonWorks import submenu

Table: LonWorks Import Submenu
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Command

Description

Device Template

Click to import a LonWorks device template.
For more information, see section 56.13
“Importing a Device Template” on page
2024.

Recource Files

Click to import a set of device resource files.
For more information, see section 56.15
“Importing Device Resource Files” on page
2027.

Add missing XIF/DRF files

Click to add missing XIF/DRF files. For more
information, see section 56.32 “Adding
Missing XIF and DRF Files” on page 2059.
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60.3

Devices Shortcut Menu
Use the Devices shortcut menu in the Device Discovery to update and manage the
list of Neuron IDs.

Figure: Device shortcut menu

Table: Devices Shortcut Menu
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Command

Description

Activate listen to service pin

Click to listen for service pins from devices
on the network. When a service pin is
received, it is displayed in the Device list.

Deactivate listen to service pin

Click to stop listening for service pins.

Clear found devices

Click to clear the list of Neuron IDs.

Advanced

Click to open the Advanced submenu. For
more information, see the Actions Menu –
Advanced Submenu topic on WebHelp.
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60.4

LonWorks Interface Properties – Basic
Tab
Use the Basic tab to view and edit basic information about the interface.

Figure: Basic tab

Table: Basic Tab
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Component

Description

State

Displays the interface status: Online or
Offline.

Network interface name

Displays the name of the network interface.
The name is automatically set when you
drag-and-drop the interface from the Device
Discovery tab.

Maximum number of concurrent
messages

Select the maximum number of messages to
be transmitted at the same time.
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60.5

LonWorks Interface Properties –
Advanced Tab
Use the Advanced tab to view and edit alarm settings for the interface.

Figure: Advanced tab

Table: Advanced Tab
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Component

Description

Priority

Select the priority for the alarm.

Device name

Displays the name of the interface.
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60.6

LonWorks Network Properties – Basic
Tab
Use the Basic tab to view and edit properties of the selected network.

Figure: Basic tab
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60.7

LonWorks Network Properties –
Advanced Tab
Use the Advanced tab to view and edit domain properties and posssibly Xentaspecific parts of the LonWorks network.

Figure: Advanced tab

Table: Domain Table for Network Interface
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Component

Description

Index

Displays the location of the entry in the
domain table. The first item is 0.

ID (decimal)

Displays the domain ID of which the device is
a member.

Domain ID lenght

Displays the byte length of the domain ID.

Subnet

Displays the subnet of which the device is a
member.

Node

Displays the node ID of the device. The Local
Node is always node 1.
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Continued
Component

Description
Click to change domain ID.

Table: Xenta General
Component

Description

Classic Operator Panel Support

Select Yes to get support for classic OP
functionality, that is, the OP can be
connected to any Xenta device.

Network name in blueprint

Displays the current name of the network.

System alarm priority

Enter the priority of Xenta non-application
alarms.

Time synchronization interval (min)

Enter the time interval between
synchronization of Xenta and the server
clocks. The default value is 10.

Heartbeat (s)

Enter the time interval for the server
heartbeat on the LonWorks network. The
default value is 5 s.

Table: Xenta LACnet Settings
Component

Description

Timeout (ms)

Enter the amount of time in milliseconds until
Xenta communication should be considered
broken. The default is 40,000 ms.

Transmit timer (ms)

Displays the time before Xenta
retransmission (if no answer).

Number of retries

Enter the maximum number of attempts
before giving up. The default value is 6.

The Xenta LACnet parameters only apply to certain types of data transfer, such as
application download, fetching of trend logs, and alarms refresh.
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60.8

Local Node Properties – Basic Tab
Use the Basic tab to view basic information about the local node. For more
information, visit the LonMarks website and the ISO website.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Needs commissioning

Displays True when the node needs to be
commissioned.

Needs device configuration download

Displays True when the configuration has
changed and the node needs a configuration
download.

Program ID

Displays the program ID for the node.

Non group receive timer

Displays the receive timer for all traffic that
does not reach the node through the
address table.
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Component

Description

Use extended NMP

Displays True if the node can use the
Extended Network Management Command
Set, ECS. For more information, see section
155.1 “LonTalk Addressing Overview” on
page 5567.

Model

Displays the model.

Host based application

Displays Yes if the application is host based.
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60.9

Local Node Properties – Offline
Detection Tab
Use the Offline Detection tab to view alarm settings for the node. For more
information, visit the LonMarks website and the ISO website.

Figure: Offline detection tab

Table: Offline Detection Tab
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Component

Description

Last communication

Displays the time when the device/node last
communicated its status successfully.

Status

Displays the status of the device/node:
Invalid, Offline or Online.
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60.10

Local Node Properties – Diagnostics
Tab
Use the Diagnostics tab to view traffic information and troubleshooting data for a
local node. For more information, visit the LonMarks website and the ISO website.

Figure: Diagnostics tab
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Continued
Component

Description

Device state

Displays the current known state of the
node:
• Unconfigured and Applicationless:
Application is not loaded or not in
working order and the node is not
configured.
• Unconfigured: The node is not
configured.
• Configured, Soft Offline: The node is
configured and offline, and returns to
online once it is reset.
• Configured, Hard Offline: The node is
configured and offline, and stays so
until deliberately put online.
• Configured, Online: The node is
configured and in normal operating
mode.
• Configured, Bypass Offline: The node is
configured and online, and does not
necessary observe go offline requests.
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Packet errors

Displays the number of CRC errors detected
during packet reception.

Transaction timeouts

Displays the number of times that the node
failed to receive expected acknowledgments
or responses after retrying the configured
number of times.

Receive transaction full errors

Displays the Receive Transaction Full Errors.
The number of times that an incoming
packet was discarded because there was no
room in the transaction database.

Lost messages

Displays the number of times, since the last
device restart, that an incoming packet was
discarded because there was no application
buffer available.

Missed Messages

Displays the number of times, since the last
device restart, that an incoming packet was
discarded because there was no network
buffer available.
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Continued
Component

Description

Last reset cause

Displays the cause of the last reset for this
node:
• Power-up: The node was powered up.
• External: The node was asked by
external source to reset.
• Watchdog: The internal watchdog
caused the reset.
• Software: The internal application
caused the reset.
• Cleared: The cause was cleared.
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60.11

LonWorks Device Properties – Basic
Tab
Use the Basic tab to view and edit basic information about the device. For more
information, visit the LonMarks website and the ISO website.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Needs commissioning

Displays True when the device needs to be
commissioned, for example after a SNVT
binding has been changed.

Needs device configuration download

Displays True when the network
configuration has changed and the device
needs a configuration download.

Needs application download

Displays True when the application has
changed and the device needs an
application download.
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Component

Description

NeedsDownloadSchedules

Displays True when the Xenta schedule has
changed and the device needs a schedule
download.

Program ID

Displays the program ID for the node.

Neuron ID

Displays the unique hardware ID for the
node.

Non group receive timer

Displays the receive timer for all traffic that
does not reach the node through the
address table.

Use extended NMP

Displays True when the node uses the
Extended Network Management Command
Set, ECS. For more information, see section
155.1 “LonTalk Addressing Overview” on
page 5567.

Model

Displays the model name or number.

File directory index

Displays the index of the NVT that specifies
the configuration file for CPTs implemented
with direct memory read/write access.

XIF

Displays the used XIF files.
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60.12

LonWorks Device Properties – Offline
Detection Tab
Use the Offline Detection tab to view and edit alarm settings for the device. For
more information, visit the LonMarks website and the ISO website.

Figure: Offline detection tab

Table: Offline Detection Tab
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Component

Description

Status

Displays the offline status of the device:
Invalid, Offline, or Online.

Last communication

Displays the time when the device last
communicated its status successfully.

Offline monitoring

Select True to enable offline monitoring and
trigger an alarm when the device goes
offline.

Alarm Delay(s)

Select the time, in seconds, between when
the device is detected as offline until an
alarm is sent.
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Component

Description

Priority

Select the priority for the alarm.
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60.13

LonWorks Device Properties –
Diagnostics Tab
Use the Diagnostics tab to view traffic information and troubleshooting data for a
device. For more information, visit the LonMarks website and the ISO website.

Figure: Diagnostics tab
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Table: Diagnostics Tab
Component

Description

Device state

Displays the current known state of the
node:
• Unconfigured and Applicationless:
Application is not loaded or not in
working order and the node is not
configured.
• Unconfigured: The node is not
configured.
• Configured, Soft Offline: The node is
configured and offline, and returns to
online once it is reset.
• Configured, Hard Offline: The node is
configured and offline, and stays so
until deliberately put online.
• Configured, Online: The node is
configured and in normal operating
mode.
• Configured, Bypass Offline: The node is
configured and online, and does not
necessary observe go offline requests.
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Packet errors

Displays the number of CRC errors detected
during packet reception.

Transaction timeouts

Displays the number of times that the node
failed to receive expected acknowledgments
or responses after retrying the configured
number of times.

Receive transaction full errors

Displays the Receive Transaction Full Errors.
The number of times that an incoming
packet was discarded because there was no
room in the transaction database.

Lost messages

Displays the number of times, since the last
device restart, that an incoming packet was
discarded because there was no application
buffer available.

Missed messages

Displays the number of times, since the last
device restart, that an incoming packet was
discarded because there was no network
buffer available.

Technical
2155

60 LonWorks User Interface
60.13 LonWorks Device Properties – Diagnostics Tab

Continued
Component

Description

Last reset cause

Displays the cause of the last reset for this
node:
• Power-up: The node was powered up.
• External: The node was asked by
external source to reset.
• Watchdog: The internal watchdog
caused the reset.
• Software: The internal application
caused the reset.
• Cleared: The cause was cleared.
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Firmware version number

Displays the version number of the firmware
reported by the device.

Last error logged

Displays the last encountered error. For
more information, see section 154.1 “Packet
Errors” on page 5557..

Neuron model

Displays the type of chip reported by the
device.
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60.14

Update Monitor - Basic Tab
Use the Update Monitor - Basic tab to configure the update period for an input
network variable update monitor in a LonWorks network.

Figure: Update monitor - basic tab

Table: Update monitor
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Component

Description

Period

Enter the amount of time between receiving
updates before the input network variable is
considered offline.
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60.15

Propagation Trigger - Basic Tab
Use the Propagation Trigger - Basic tab to configure the propagation trigger.

Figure: Propagation trigger - basic tab

Table: Propagation trigger
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Component

Description

Propagate network variable

Select Yes to send the network variable as
one value rather than several values at
different times.
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60.16

Device Tables Properties – Basic Tab
Use the Basic tab to view and edit basic information for the device tables.

Figure: Basic tab
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60.17

Device Tables Properties – Address
Table Tab
Use the Address Table tab to view the address table of the device or the local
node. For more information, visit the LonMarks website and the ISO website.

Figure: Address table tab

Table: Address Table Tab
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Component

Description

Index

Displays the location of the entry in the
address table. The first entry is reserved for
the broadcast binding profile.

Type

Displays the type of address.

Domain name

Displays the first part of the group address
(Group/subnet is the second).

Member/Node

Displays the member number of the target
device if the table entry is a fan-out binding,
or the node address of target device if the
entry is a point-to-point binding.
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Component

Description

Repetition interval

Displays the interval (in seconds) in which the
message is resent if a number of Retries is
given.

Retries

Displays the number of attempts to resend
the message.

Recieve timer

Displays a timer interval for group messages.
If a message with the same transaction ID is
received before the receive timer expires, the
message is considered to be a retry of the
previous message.

Transaction timer

Displays the time interval between retries
when acknowledged or request/response
service is used.

Group/Subnet

Displays the group ID of the binding if the
table entry is a fan-out binding, or the subnet
node address of the target device if the table
entry is a point-to-point binding.
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60.18

Device Tables Properties – Domain
Table Tab
Use the Domain table tab to view and edit the domain table of the node. For more
information, visit the LonMarks website and the ISO website.

Figure: Domain table tab

Table: Domain Table for Network Interface

Technical
2162

Component

Description

Index

Displays the location of the entry in the
domain table. The first item is 0.

ID (decimal)

Displays the domain ID of which the device is
a member.

Domain ID lenght

Displays the byte length of the domain ID.

Subnet

Displays the subnet of which the device is a
member.

Node

Displays the node ID of the device. The Local
Node is always node 1.
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Continued
Component

Description
Click to change domain ID.
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60.19

Device Tables Properties – Selector
Table Tab
Use the Selector Table tab to view the selector table of the node. For more
information, visit the LonMarks website and the ISO website.

Figure: Selector Table tab

Table: Selector Table Tab
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Component

Description

Index

Displays the location of the entry in the
selector table. The first item is 0.

Selector

Displays the unique selector ID used to bind
the NVs.

Address index

Displays the index of the variable in the
address table, to which the binding sends its
data. The first item is 0.

Priority

Displays the priority for the binding. Defines
the order in which concurrent values are to
be sent.
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Continued
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Component

Description

Direction

Displays the direction of the NV.

Service

Displays the service type to use.

Turnaround

Displays True when the selector is a part of
a turnaround binding.

Authentication

Displays True when the receiver verifies the
sender's ID with an acknowledgement key.
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60.20

Device Tables Properties – Alias Table
Tab
Use the Alias Table tab to view the alias table of the node. For more information,
visit the LonMarks website and the ISO website.

Figure: Alias table tab

Table: Alias Table Tab
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Component

Description

Index

Displays the location of the entry in the alias
table. The first item is 0.

Selector

Displays the unique selector ID used to bind
the NVs.

Direction

Displays the direction of the NV.

Priority

Displays the priority for the binding. Defines
the order in which concurrent values are to
be sent.
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Component

Description

Address index

Displays the index of the variable in the
address table, to which the binding sends its
data. The first item is 0.

Authentication

Displays True when the receiver verifies the
sender's ID with an acknowledgement key.

Primary

Displays the selector index for which this
alias refers to.

Service

Displays the service type to use for
connections containing this variable.

Turnaround

Displays True when the selector is part of a
turnaround binding.
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60.21

Create Network Variable Wizard –
Define Network Variable Page
A network variable is created from predefined types in a resource files (DRF) kit. A
name and direction is needed to monitor and bind the variable.

Figure: Define network variable page

Table: Define Network Variable Page
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Component

Description

Resource files kit

Select the resource files kit (DRF) which
contains the variable type to use.

Type

Select the variable type.

Direction

Select the direction for the variable.

Name

Type a name for the variable.
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60.22

Create Network Variable Wizard – Input
Variable Parameters Page
An input variable is received by the device. You can set the variable to poll the
values at selected intervals, otherwise the values is received according to bindings.

Figure: Input variable parameters page
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60.23

Create Network Variable Wizard –
Output Variable Parameters Page
An output variable is transmitted from the device. You can set the variable value to
be sent at selected intervals, otherwise the value is sent according to bindings. You
can also set the variable name and its initial value.

Figure: The output variable parameters page
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60.24

Functional Block Properties
Use the Functional Block Properties tab to view and edit properties of the
selected functional block.

Figure: Functional block properties
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60.25

Configuration Parameters and Network
Variable Properties – Basic Tab
Use the Basic tab to view and edit general properties.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Reference NVT name

Displays the reference NVT name.

Is DMA

Select True if the CPT is based on a Direct
Memory Read/Write Access.

Inherited

Displays if the CPT inherits its type from an
associated network variable. Defined in the
device template or the resource files.

Is constant

Constant property. Indicates that the
property cannot be changed by a network
tool.
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Component

Description

Is device specific

Indicates that the property must be read
from the device, not from interface or
database.

Modify only during manufacturing

Indicates a factory setting which should
normally not be changed, or may require a
password.

Is object disabled

Indicates that the functional block must be
disabled before the value can be changed.

Is offline at change

Indicates that the device must be offline
before the value can be changed.

Is reseting after change

Indicates that the device must be restarted
after change of the value.

Default value

Displays the default value of the
configuration property.

Minimum value

Displays the minimum value of the
configuration property.

Maximum value

Displays the maximum value of the
configuration property.
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60.26

Configuration Parameters and Network
Variable Properties – Variable Instance
Settings Tab
Use the Variable Instance Settings tab to view and edit variable instance
settings. The variable instance settings define how the parameter/variable is to be
sent or received.

Figure: Variable instance settings tab

Table: Variable Instance Settings Tab
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Component

Description

Direction

Displays the direction of the variable: Input
(receives) or Output (sends).

Polling enabled

Select if an input variable is to be polled at
regular intervals or not. If the variable is not
polled, it needs to be read according to a
binding.

Poll rate (s)

Enter the time in seconds for the poll rate.
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Component

Description

Sending enabled

Select if an output variable is to be sent at
regular intervals or not. If the variable is not
sent at regular intervals, the variable needs
to be sent according to a binding.

Send rate (s)

Enter the time in seconds for the send rate.
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60.27

Configuration Parameters and Network
Variable Properties – Extended Settings
Tab
Use the Extended Settings tab to view detailed information about the
parameter/variable.

Figure: Extended settings tab

Table: Extended Settings Tab
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Component

Description

XIF index

Displays the index number for this variable in
the device template (XIF file).

Authentication

Displays the authentication default for the
variable. Yes to use authentication by
default, No to not use authentication by
default.
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Component

Description

Authentication changeable

Displays whether the use of authentication
can be changed in the field. Yes if the use of
authentication can be changed, No if it
cannot.

Priority

Displays the default use of priority for the
variable. Yes to use priority for the variable
by default, No if it cannot.

Priority changeable

Displays whether the use of priority can be
changed in the field. Yes if the use of priority
can be changed, No if it cannot.

Default service type

Displays the default service type to use for
connections containing this variable. 0 for
acknowledged, 1 for repeated, or 2 for
unacknowledged.

Changeable binding type

Displays whether the binding type can be
changed in the field. Yes if the type can be
changed, No if it cannot.

Sync

Displays the synchronized attribute of the
variable. No if the variable is not
synchronized, Yes if the variable is
synchronized (that is if all outputs are
transmitted and their order is preserved).

Config

Displays the configuration attribute of the
variable. No for a non-configuration class
variable, Yes for a configuration class
variable.

Extension record

Select Yes to store this variable in a
manufacturer-specific extension record in
the Network object.

Offline

Displays whether the device should be taken
offline before updating the variable. No if the
variable can be updated when online or
offline, or Yes if it should be updated only
when offline.

Estimated maximum rate

Displays the maximum rate estimate
specified as an encoded decimal string (0 –
250). Encoded as an unsigned decimal n,
where the rate estimate = 2(n/8)-5. Set to 0 if
the estimate is not specified.

Estimated average rate

Displays the average rate estimate specified
as an encoded decimal string (0 – 250).
Encoded as an unsigned decimal n, where
the rate estimate = 2(n/8)-5. Set to 0 if the
estimate is not specified.

Network variable name

Displays the network variable name.
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Component

Description

Array index

If the network variable is an array, only a
single array element can be the device
property. The Array Index index defines this
element.

Default service type changeable

Displays whether the service type can be
changed in the field. Yes if the type can be
changed, No if it cannot.

Self documentation string

Displays the variable’s self-documentation
string from the device template (XIF). If the
variable has no self-documentation, the field
contains a single asterisk.

Self documentation text

Displays any optional text for the network
variable from the device template (XIF).
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60.28

Variable Member Properties
Use the Variable Member Properties tab or dialog box to view detailed
information about network variable members or associated configuration
properties.

Figure: Basic tab

Table: Basic tab
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Component

Description

Default value

Displays the default value for the variable.
Defined in the XIF file.

Value

Enter the value of the variable.

Minimum value

Displays the minimum value for the variable.
Defined in the DRF kit.

Maximum value

Displays the maximum value for the variable.
Defined in the DRF kit.

Invalid value

Displays the invalid value for the variable.
Defined in the DRF kit.
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60.29

Import Resource Files Wizard – Select
Resource Kit Directory Page
You import Device Resource Files, DRF kits, which contain a set of files that provide
profiles for functional blocks and used by device templates.

Figure: Select resource kit directory page
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60.30

Import Resource Files Wizard –
Importing DRF Kit Page
While the resource files are importing, the import status is displayed below the
progress bar. When the import is successful, the progress bar is green and
complete. If the import is not successful, the progress bar is red and complete.

Figure: Importing DRF kit page
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60.31

Import Resource Files Wizard –
Committing the DRF Kit Page
When the resource files have been imported, they need to be committed to be
stored in the system. While the resource files are committed, the commit status is
displayed below the progress bar. When the commit is successful, the progress bar
is green and complete. If the commit is not successful, the progress bar is red and
complete.

Figure: Committing the DRF kit page
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60.32

Import Device Template Wizard –
Import Device Template Page
You import device templates stored in XIF files, which defines the functional profiles,
SNTVs, and SCPTs the device contains. If the XIF refers to functional profiles,
SNTVs, and SCPTs that do not exist in your system, you are prompted to import
matching Resource Files. For more information, see section 60.30 “Import
Resource Files Wizard – Importing DRF Kit Page” on page 2179.

Figure: Import device template page
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60.33

Import Device Template Wizard –
Device Template Dialog Box
When importing a device template, you can give it your own name to make it easier
to find it later (spaces and special characters are not allowed). The Program ID fields
displays the program ID from the XIF file.

Figure: Device template dialog box
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60.34

Import Device Template Wizard –
Importing Device Template Page
When the device template is imported, it is analyzed and any errors are displayed. If
the device template uses functional profiles, SNTVs, and SCPTs that do not exist in
your system, you are prompted to import matching resource files and the XIF import
starts over.
The template can be successfully created even if errors are found or resource files
are missing. However, devices built on the template can have limited functionality
and their Complete Template flag is set to False.

Figure: Importing device template page
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60.35

Neuron ID and Commission Settings
Page
You use the Neuron ID and commission settings page to assign a neuron ID
to a device and set up how the configuration is handled when the device is
commissioned.

Figure: Neuron ID and commission settings page

Table: Neuron ID and Commission Settings Page
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Component

Description

Neuron ID

Type the neuron ID for the device.

Service Pin

Click to receive the neuron ID when it is sent
from the device.

Template Program ID

Displays the program ID of the device
template (XIF file) for the selected device
type.

Received Program ID

Displays the Program ID in the physical
device.

Application download

Select to download the application that is
assigned to the device to the physical
device.

Commission

Select to commission the device.

Keep current configuration in the
device

Select to leave the configuration parameters
in the physical device as is.
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Continued
Component

Description

Download current configuration to
device

Select to download the device configuration
parameters to the physical device.

Download default configuration to
device

Select to download the default configuration
parameters from the device template for this
device type to the physical device.

Upload configuration from device

Select to update the the server with the
current configuration parameters in the
physical device.

Xenta group

Enter the group to which the device belongs
(Xenta devices only). For more information,
see section 62.18 “Xenta LonWorks Groups”
on page 2252.

Device application file

Select to upgrade the device application for
the physical device. For more information,
see section 56.10 “LonWorks Application
Upgrade” on page 2019.
The Device application file check box is
not applicable to MNL LonWorks devices.
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Files (*.nxe)

Enter the NXE file that you want to upgrade
the device with.

Application download

Select to transfer an application to the
physical device (Xenta devices only).

Files (*.mta)

Enter the MTA file that you want to tranfer to
the device (Xenta devices only)

M1...n (IO modules)

Type the neuron ID for the IO module if you
have not already associated it with the Xenta
device (Xenta devices only).

Service Pin

Click to receive the neuron ID when it is sent
from the IO module (Xenta devices only).
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60.36

Lon Folder Properties
Use the Lon Folder Properties view or dialog box to configure and view the
general and object-reference properties. For more information, see the General
Properties – Basic Tab topic on WebHelp.

Figure: Lon folder properties
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60.37

Add Missing Files Wizard – Searching
for Missing Files Page
Use the Searching for Missing Files page to identify missing XIF and DRF files.

Figure: Searching for missing files page
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60.38

Add Missing Files Wizard – Select
Directory to Search for XIF and DRF
Resources Page
Use the Select Directory to Search for XIF and DRF Resources page to
select the folder where the missing files can be found. Subfolders are searched as
well.

Figure: Select directory to search for XIF and DRF resources page
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60.39

Add Missing Files Wizard – Searching
for Replacement Files Page
Use the Searching for Replacement Files page to view and import the missing
files that have been found.

Figure: Searching for replacement files page
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60.40

Add Missing Files Wizard – Importing
Replacement Files Page
Use the Importing Replacement Files page to view the import result and to
commit the import.

Figure: Importing replacement files page
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60.41

LNS Plug-in Registration View
Use the LNS Plug-in Registration view to register LNS Plug-ins. You register
LNS Plug-ins so that you can use manufacturer´s applications when configuring
LonWorks devices.

Figure: LNS Plug-in registration view

Table: LNS Plug-in Registration View
Component

Description
Import device template in LNS
database
Enter the LNS Plug-in .exe file that you want
to make available.
Add all button
Click to register all LNS Plug-ins.
Add button
Click to register the selected LNS Plug-in.
Remove all button
Click to unregister all LNS Plug-ins.
Remove button
Click to unregister the selected LNS Plug-in.
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Available LNS Plug-ins

List of the LNS Plug-ins available.

Registered LNS Plug-ins

List of the LNS Plug-ins that are registered.
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Continued
Component
LNS Plug-in Information
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Description
Displays the third party
information about LNS Plugins, such as name,
description, manufacturer,
and version.
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60.42

Configure Using LNS Plug-ins Wizard Copying Device Configuration to LNS
Page
Use the Copying Device Configuration to LNS page to match the device with
the correct LNS template, and copy the device configuration to the LNS database.

Figure: Copying device configuration to LNS page
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60.43

Configure Using LNS Plug-ins Wizard Select LNS Plug-in Page
Use the Select LNS Plug-in page to view, select, and launch available LNS Plugins.

Figure: Select LNS Plug-in page

Table: LNS Device Wizard Configure Page
Property

Description
Open LNS Plug-in
Click to open the selected LNS Plug-in.
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LNS Plug-in

List of the available LNS Plug-ins.

Description

Description of the LNS Plug-in.
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60.44

Configure Using LNS Plug-ins Wizard Confirm LNS Configuration Page
Use the Confirm LNS Configuration page to proceed with the configuration
after making sure that all changes have been applied.

Figure: Confirm LNS configuration page
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60.45

Configure Using LNS Plug-ins Wizard Copying Device Configuration from LNS
Page
Use the Copying Device Configuration from LNS page to copy the device
configuration from the LNS database and finish the LNS Plug-in configuration.

Figure: Copying device configuration from LNS page
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60.46

Lon Binding Properties
Use the Lon Binding Properties dialog box to configure a LonWorks binding.

Figure: Lon binding properties

Table: Lon Binding Properties
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Component

Description

Binding profile

Select a binding profile. For more
information, see section 58.3 “LonWorks
Binding Profiles ” on page 2096.

Initial Read

Select to disable initial read. Disabling initial
read results in less communication load on
the network when restarting the Automation
Server.
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60.47

LonWorks Binding Profile Icons
This table describes the LonWorks binding profile icons.
Table: LonWorks Binding Profile Icons
Icon

Description
Indicates an Acknowledged binding profile.
Indicates an acknowledged binding profile
with retries.
Indicates an unacknowledged binding
profile.
Indicates an unacknowledged binding profile
with repeats.
Indicates a broadcast binding profile.
Indicates a broadcast binding profile with
repeats.
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60.48

LonWorks Binding Profile Properties –
Basic Tab
Use the Basic tab to view the basic properties of the binding profile.

Note
• The template is read only.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Service type

Displays the type of service to be used for
sending messages. Auto automatically
selects the service type according to the XIF
file.

Priority

Displays if priority messaging is used. Auto
enables messaging when the devices on
both sides of the connection have priority
enabled.
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60.49

LonWorks Binding Profile Properties –
Advanced Tab
Use the Advanced tab to view the advanced properties of the binding profile.

Note
• The template is read only.

Figure: Advanced tab

Table: Advanced Tab
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Component

Description

Suppress source address

Displays True if it suppresses address table
and selector table updates for bindings using
this template. This function is used for
devices that use explicit addressing to get
around address table limitations. The source
device is responsible for managing the
destination addresses.

Use broadcast

Displays if broadcast is enabled.

Transmit

The transmit timer displays how long an
Acknowledged messaging binding should
wait for confirmation before resending the
message.

Repeat

The repeat timer displays how long the
connection waits between repeats when
using Unacknowledged Repeat messaging.
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Component

Description

Receive

The receive timer displays the time during
which the receiving end of the binding treats
messages from the same source with the
same message ID a duplicate messages.

Retry

The retry count displays the number of times
a binding using Acknowledged messaging
should retry sending the message if no
confirmation is received.

Repeat

The repeat count displays the number of
times a connection using Unacknowledged
Repeat messaging should repeat a
message.

Technical
2203

61

Xenta LonWorks Introduction

Topics
Xenta LonWorks Device Overview
Xenta LonWorks Engineering
LonWorks Interfaces
Xenta LonWorks Device Workflows
Create and then Discover Xenta LonWorks Device Workflow
Discover Xenta LonWorks Device Workflow
Create Xenta LonWorks Device Workflow
Configuring a LonWorks Network for Xenta Devices
Binding Xenta Network Variables
Xenta OP

61 Xenta LonWorks Introduction
61.1 Xenta LonWorks Device Overview

61.1

Xenta LonWorks Device Overview
The Xenta 280/300/401 LonWorks devices are a family of programmable, standalone devices that provide Direct Digital Control of air handlers and systems as well
as individual terminal units.
Because these devices focus on individual units, they are often referred to as field
controllers. Xenta 280/300/401 LonWorks devices include local processing (Neuron
chip) and I/O hardware to process input data from sensors, execute a control task,
and control actuators.
TAC Xenta 280/300/401, product manual, PN 04-00067 and TAC Xenta 400 I/O
Modules, product manual, PN 0047771

61.1.1

Xenta LonWorks Devices
Xenta 280/300/401 LonWorks devices are configured as LonWorks devices with
SNVT handling. These devices also have non-standard enhancements, such as
support for TACNV, advanced alarm handling, time schedules, and extensive trend
logs.
For more information, see section 62.1 “Xenta LonWorks Devices” on page 2229.

61.1.2

Xenta LonWorks Engineering
Using Building Operation, you configure a LonWorks network that connects to an
Automation Server or an Enterprise Server. These servers collect information from
the devices on the LonWorks network(s) and display them on WorkStation.
For more information, see section 61.2 “Xenta LonWorks Engineering” on page
2206.

61.1.3

Xenta LonWorks Device Functions
Many of the functions and features of Xenta LonWorks devices are supported in
Building Operation, including trend logs, alarms, schedules, time functions, and the
ability to view Xenta variables from a Menta application.
For more information, see section 62.19 “Xenta LonWorks Device Functions” on
page 2253.
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61.2

Xenta LonWorks Engineering
Using Building Operation, you configure a LonWorks network that connects to an
Automation Server or an Enterprise Server. These servers collect information from
the devices on the LonWorks network(s) and display them on WorkStation.
WorkStation acts as the primary interface and allows you to configure, program,
and monitor the system. WorkStation uses any IP network to communicate with the
Automation Servers and Enterprise Servers. The Automation Servers are hardware
modules that reside at the IP-level and route information to and from the IP-level to
the LonWorks network.
For more information, see the Automation Servers topic on WebHelp.
For more information, see section 3.2 “Enterprise Server” on page 136.

Figure: LON devices, for example Xenta devices, in a Building Operation network
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The communication between the Automation Servers and Xenta 280/300/401
LonWorks devices allows the Xenta devices to create and manage alarms, trend
logs, time schedules, and share data with other controllers. Xenta 280/300/401
LonWorks devices support the LonTalk protocol to communicate with other
LonWorks devices. When talking to other Xenta 280/300/401 LonWorks devices,
LACnet, a proprietary protocol, is used.
In WorkStation, each Automation Server and associated Xenta 280/300/401
LonWorks devices are represented in the System Tree pane.

Figure: An Automation Server, a LonWorks network, and Xenta devices in the System
Tree

Xenta 280/300/401 LonWorks devices on a LonWorks network can be attached to
the Building Operation network in two basic ways:
• Connected to an Automation Server by means of a built-in network interface,
with a maximum of 30 Xenta 280/300/401 LonWorks devices.
• Connected to an Enterprise Server by means of a suitable Loytec network
interface, with a maximum of about 60 Xenta 280/300/401 LonWorks devices.
The configuration and commissioning of Xenta 280/300/401 LonWorks devices is
performed at WorkStation. After this, the associated Menta applications are running
in the physical Xenta devices. Public signals, SNVTs, and TACNVs are updated and
are available from WorkStation.
The Xenta 280/300/401 LonWorks devices communicate with each other over the
LonWorks network using TACNV and SNVT bindings. To ease the network
communication load, SNVTs can be bound to a local node associated with the
Automation Server. For more information, see section 57.9 “Network Variables and
Configuration Parameters” on page 2074.

61.2.1

Xenta LonWorks Device Workflow
There are three ways of creating and configuring a Xenta 280/300/401 LonWorks
device.
For more information, see section 61.4 “Xenta LonWorks Device Workflows” on
page 2211.
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61.2.2

LonWorks Interfaces
Building Operation servers connect to LonWorks networks through various
LOYTEC interfaces and communicate with LonWorks devices over EIA-709 (FT-10)
or EIA 852 (Ethernet).
For more information, see section 68.3 “LonWorks Interfaces” on page 2358.

61.2.3

Xenta LonWorks Groups
The Xenta Group is a logical group that is used to build a simple hierarchy of the
Xenta 280/300/401 LonWorks devices. In Building Operation, each Xenta Group is
collected in a separate folder.
For more information, see section 62.18 “Xenta LonWorks Groups” on page 2252.

61.2.4

Xenta LonWorks Device Commissioning
When you click Commission a number of tasks are performed on the Xenta
280/300/401 LonWorks device. The commission command may or may not include
an application download, depending on what you specify (if that option is available)
and on what has been changed since the previous commission and download.
For more information, see section 62.5 “Xenta LonWorks Device Commissioning”
on page 2236.

61.2.5

Xenta LonWorks Applications
The application in a Xenta LonWorks device contains the control logic used in the
device. Xenta LonWorks applications appear below the device object in the
System Tree pane and are edited in Menta Editor to configure the device to
different control and monitoring tasks.
For more information, see section 63.1 “Xenta LonWorks Applications” on page
2269.
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61.3

LonWorks Interfaces
Building Operation servers connect to LonWorks networks through various
LOYTEC interfaces and communicate with LonWorks devices over EIA-709 (FT-10)
or EIA 852 (Ethernet).

Figure: LonWorks in Building Operation
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61.3.1

LonWorks in the Automation Server
The Automation Server connects to LonWorks networks through a built-in LOYTEC
FT interface and communicates with LonWorks devices over EIA-709 (FT-10).
For more information, see section 55.4 “LonWorks in the Automation Server” on
page 1976.

61.3.2

LonWorks in the Enterprise Server
The Enterprise Server connects to LonWorks networks through various LOYTEC
NIC-interfaces and communicates with LonWorks devices over EIA-709 (FT-10) or
EIA-852 (Ethernet).
For more information, see section 55.5 “LonWorks in the Enterprise Server” on
page 1977.

61.3.3

Externally Managed LonWorks Network
You can connect an externally managed LonWorks network to Building Operation
through an Automation Server, in order to view and represent that same LonWorks
network data in WorkStation. The externally managed network is configured and
managed, through LNS, with an external LonWorks manager tool connected to the
network.
For more information, see section 55.11 “Externally Managed LonWorks Network”
on page 1991.

Technical
2212

04-16006-04-en, March 2015

61 Xenta LonWorks Introduction
61.4 Xenta LonWorks Device Workflows

61.4

Xenta LonWorks Device Workflows
There are three ways of creating and configuring a Xenta 280/300/401 LonWorks
device.

61.4.1

Create and then Discover Xenta LonWorks
Device Workflow
Use the Create and then Discover Xenta LonWorks Device workflow to create and
discover LonWorks devices online.
For more information, see section 61.5 “Create and then Discover Xenta LonWorks
Device Workflow” on page 2212.

61.4.2

Discover Xenta LonWorks Device Workflow
Use the Discover Xenta LonWorks Device workflow to discover and create Xenta
LonWorks devices online.
For more information, see section 61.6 “Discover Xenta LonWorks Device
Workflow” on page 2214.

61.4.3

Create Xenta LonWorks Device Workflow
Use the Create Xenta LonWorks Device Workflow to create Xenta LonWorks
devices offline in a project and to deploy and commission the devices and the local
node on an on-site server.
For more information, see section 61.7 “Create Xenta LonWorks Device Workflow”
on page 2216.
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61.5

Create and then Discover Xenta
LonWorks Device Workflow
Use the Create and then Discover Xenta LonWorks Device workflow to create and
discover LonWorks devices online.

Figure: Deploy LonWorks project workflow
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Create a LonWorks interface
In WorkStation, create a LonWorks interface in the server.
For more information, see section 55.12 “Creating a LonWorks Interface” on page
1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks Interface.
For more information, see section 55.15 “Creating a LonWorks Network” on page
1996.

Create Xenta LonWorks devices
In WorkStation, create the Xenta LonWorks devices on the LonWorks network.
For more information, see section 62.2 “Creating a Programmable Xenta Device” on
page 2231.

Configure the Xenta LonWorks devices and Edit the Menta
Applications
In WorkStation, configure the Xenta LonWorks devices and edit and import the
Menta applications.
For more information, see section 62.4 “Configuring a Xenta LonWorks Device” on
page 2235.
For more information, see section 63.3 “Editing a Menta Application” on page 2271.
For more information, see section 63.4 “Importing a Menta Application to a Xenta
Device” on page 2272.

Connect the Xenta LonWorks devices
Physically connect the Xenta LonWorks devices to the on-site server.

Discover the Xenta LonWorks devices
In WorkStation, discover the Xenta LonWorks devices to obtain the Neuron ID and
create the devices.
For more information, see section 62.3 “Discovering a Xenta Device” on page 2233.

Create a local node and local node variables
In WorkStation, create a local node and local node variables by mirroring a device
network variable or manually creating.
For more information, see section 57.2 “Creating a Local Node” on page 2067.
For more information, see section 57.12 “Creating Network Variables Automatically”
on page 2078.

Commission the Xenta LonWorks devices
In WorkStation, commission the devices on the server.
For more information, see section 62.6 “Commissioning a Xenta Device” on page
2237.
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61.6

Discover Xenta LonWorks Device
Workflow
Use the Discover Xenta LonWorks Device workflow to discover and create Xenta
LonWorks devices online.

Figure: Deploy LonWorks project workflow

Create a LonWorks interface
In WorkStation, create a Lonworks interface in the server.
For more information, see section 55.12 “Creating a LonWorks Interface” on page
1993.
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Create a LonWorks network
In WorkStation, create the Lonworks network on the LonWorks Interface.
For more information, see section 55.15 “Creating a LonWorks Network” on page
1996.

Connect the Xenta LonWorks devices
Physically connect the Xenta LonWorks devices to the on-site server.

Discover the Xenta LonWorks devices
In WorkStation, discover the Xenta LonWorks devices to obtain the Neuron ID and
create the devices.
For more information, see section 62.3 “Discovering a Xenta Device” on page 2233.

Configure the Xenta LonWorks devices and Edit the Menta
Applications
In WorkStation, configure the Xenta LonWorks devices and edit and import the
Menta applications.
For more information, see section 62.4 “Configuring a Xenta LonWorks Device” on
page 2235.
For more information, see section 63.3 “Editing a Menta Application” on page 2271.

Create a local node and local node variables
In WorkStation, create a local node and local node variables by mirroring a device
network variable or manually creating.
For more information, see section 57.2 “Creating a Local Node” on page 2067.
For more information, see section 57.12 “Creating Network Variables Automatically”
on page 2078.

Commission the Xenta LonWorks devices
In WorkStation, commission the Xenta LonWorks devices on the server.
For more information, see section 62.6 “Commissioning a Xenta Device” on page
2237.
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61.7

Create Xenta LonWorks Device
Workflow
Use the Create Xenta LonWorks Device Workflow to create Xenta LonWorks
devices offline in a project and to deploy and commission the devices and the local
node on an on-site server.
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Figure: Deploy LonWorks project workflow
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Create a LonWorks interface
In WorkStation for Projects, create a LonWorks interface.
For more information, see section 55.12 “Creating a LonWorks Interface” on page
1993.

Create a LonWorks network
In WorkStation for Projects, create a LonWorks network on the LonWorks interface.
For more information, see section 55.15 “Creating a LonWorks Network” on page
1996.

Create Xenta LonWorks devices
In WorkStation for Projects, create the Xenta LonWorks devices in an Automation
Server necessary for the project on the LonWorks network.
For more information, see section 62.2 “Creating a Programmable Xenta Device” on
page 2231.

Import Menta applications to the devices
In WorkStation for Projects, open the Menta Editor and import Menta applications
to the devices.
For more information, see section 63.4 “Importing a Menta Application to a Xenta
Device” on page 2272.

Configure the Xenta LonWorks devices and Edit the Menta
Applications
In WorkStation for Projects, configure the Xenta LonWorks devices and edit and
import the Menta applications necessary.

Note
Xenta groups are not created automatically in WorkStation for Projects. After
deploy, a Xenta group is automatically created for every 30 Xenta devices.
For more information, see section 62.4 “Configuring a Xenta LonWorks Device” on
page 2235.
For more information, see section 63.3 “Editing a Menta Application” on page 2271.

Create a local node and local node variables
In WorkStation for Projects, create a Local Node and Local Node variables by
mirroring a device network variable or manually creating.
For more information, see section 57.2 “Creating a Local Node” on page 2067.
For more information, see section 57.12 “Creating Network Variables Automatically”
on page 2078.

Create Objects
In WorkStation for Projects, create all necessary objects, such as alarms, schedules
and trend logs.
For more information, see the Alarm Overview topic on WebHelp.
For more information, see the Schedules Overview topic on WebHelp.
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For more information, see the Trend Overview topic on WebHelp.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended to update the Enterprise Server communication parameter
before the deploy of the first Automation Server.
For more information, see section 4.4 “Updating Communication Parameters” on
page 179.

Deploy the Automation Servers
In WorkStation for Projects, deploy the Automation Server.

Caution
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.

Connect the Xenta LonWorks devices
Physically connect the Xenta LonWorks devices to the on-site server.

Commission the Xenta LonWorks devices
In WorkStation, commission the deployed devices on the on-site server.
For more information, see section 62.6 “Commissioning a Xenta Device” on page
2237.

Commission the local node
In WorkStation, commission the deployed local node on the on-site server.
For more information, see section 57.5 “Commissioning a Local Node” on page
2070.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.
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Important
It is recommended to update all Automation Server communication parameters
before the deploy of the Enterprise Server.
For more information, see section 4.4 “Updating Communication Parameters” on
page 179.

Deploy the Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.

Important
Ensure that you have created all Automation Servers in the project before the
deploy of the Enterprise Server. You can only deploy to an empty Enterprise
Server. Any additional Automation Servers have to be created on the on-site
server.
For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.
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61.8

Configuring a LonWorks Network for
Xenta Devices
You configure the communication parameters for the Xenta devices in a LonWorks
network by editing the properties under the Xenta tab.
For more information, see section 61.2 “Xenta LonWorks Engineering” on page
2206.

To configure a LonWorks network for Xenta devices
1. In WorkStation, in the System Tree pane, select the network.
2. Click the Properties tab and then click the Xenta tab.
Continued on next page
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3. Edit the Xenta network properties.
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Component

Description

Classic Operator Panel Support

Select Yes to get support for classic OP
functionality, that is, the OP can be
connected to any Xenta device.

Network name in blueprint

Displays the current name of the network.

System alarm priority

Enter the priority of Xenta non-application
alarms.

Time synchronization interval (min)

Enter the time interval between
synchronization of Xenta and the server
clocks. The default value is 10.

Heartbeat (s)

Enter the time interval for the server
heartbeat on the LonWorks network. The
default value is 20 s.

Component

Description

Timeout (ms)

Enter the amount of time in milliseconds
until Xenta communication should be
considered broken. The default is 10,000
ms.

Transmit timer (ms)

Displays the time before Xenta
retransmission (if no answer).

Number of retries

Enter the maximum number of attempts
before giving up. The default value is 4.
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4. Click OK to save the changes.
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61.9

Binding Xenta Network Variables
In Building Operation Menta Editor, you bind TACNV signals to public signals of
other Xenta 280/300/401 LonWorks devices on the same network. TAC Menta
Technical Manual, 04-00030.

To bind Xenta network variables
1. In WorkStation, in the System Tree pane, select the Xenta 280/300/401
LonWorks device where you want to add the new TACNV signal.
2. On the Actions menu, click Edit.
3. In the Building Operation Menta Editor, add a suitable input or output block.
4. Select Public.

5. In the Identifier box, type an identity for the signal.
6. In the Unit box, select a unit, if applicable.
7. In the Description box, type an optional description.
8. Click Bind.
Continued on next page
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9. Select Network Variable.

10. In theNetwork Address box, click the Browse button.
11. Select a public signal from the list of all public signals in the network.

12. Click Select.
13. In the Bind Analog Input dialog box, click OK.
14. Click OK.
You have created a public Xenta signal bound to another public Xenta signal. The
bound signal appears among the variables listed for the Xenta 280/300/401
LonWorks device.
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61.10

Xenta OP
Xenta OP is an operator panel that can be used with Xenta 280/300/401 LonWorks
devices that are part of a Building Operation system. Xenta OP can be used in two
ways:
• As a LonWorks unit inspector of other LonWorks units and the SNVTs they
use.
• To monitor Xenta 280/300/401 LonWorks devices with a user defined OP tree,
and group hierarchy display.
In the latter case, Xenta OP can be set up to operate in one of three different
modes:
• INST: Xenta OP is permanently connected, electrically, to the LonWorks
network and is not portable. It gets its address from the network management
tool. It can see and inspect all LonWorks devices on the network and there is
no risk of address conflicts. This is the recommended mode for Xenta OP.
• MAN: Xenta OP is partly portable, and can be moved anywhere in the network.
It sets its own address but requires manual input of the current Domain ID. It
can see all LonWorks devices but can only inspect those devices that are
under the same router as the OP.
• TAC: Xenta OP is fully portable, and can be easily moved anywhere in the
network. It gets its address from the Xenta 280/300/401 LonWorks base unit.
It can see and inspect all LonWorks devices on the network. However, the OP
has a more complex underlying configuration structure. Although this mode is
useful, it should be used sparingly because there is a risk for address conflicts.
The standard menus and the operation of the operator panel are described in the
TAC Xenta OP Operating Manual (04-00065).
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62.1

Xenta LonWorks Devices
Xenta 280/300/401 LonWorks devices are configured as LonWorks devices with
SNVT handling. These devices also have non-standard enhancements, such as
support for TACNV, advanced alarm handling, time schedules, and extensive trend
logs.
TAC Xenta 280/300/401, Product Manual (04-00067) and TAC Xenta 400 I/O
Modules, Product Manual (0047771)
Table: Models of Xenta LonWorks Devices and I/O Modules
Device Series

Devices

I/O Modules

Xenta 280 Series

Xenta 281 LonWorks Device

None

Xenta 282 LonWorks Device
Xenta 283 LonWorks Device
Xenta 301 Series

Xenta 301 LonWorks Device

Up to 2 I/O modules:

Xenta 302 LonWorks Device

See models listed for Xenta
401 LonWorks Device

Xenta 301:C LonWorks
Device

Up to 4 I/O modules:

Xenta 302:C LonWorks
Device
Xenta 401 Series

Xenta 401 LonWorks Device

See models listed for Xenta
401 LonWorks Device
Up to 10 I/O modules:
Xenta 411 I/O Module
Xenta 412 I/O Module
Xenta 421A I/O Module
Xenta 422A I/O Module
Xenta 451A I/O Module
Xenta 452A I/O Module
Xenta 471 I/O Module
Xenta 491 I/O Module
Xenta 492 I/O Module
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Xenta 401:B LonWorks
Device

None

Xenta 401:C LonWorks
Device

Up to 15 I/O modules:
See models listed for Xenta
401 LonWorks Device
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Device Series

62.1.1

Devices

I/O Modules

Xenta OP
Xenta OP is an operator panel that can be used with Xenta 280/300/401 LonWorks
devices that are part of a Building Operation system. Xenta OP can be used in two
ways:
• As a LonWorks unit inspector of other LonWorks units and the SNVTs they
use.
• To monitor Xenta 280/300/401 LonWorks devices with a user defined OP tree,
and group hierarchy display.
For more information, see section 61.10 “Xenta OP” on page 2226.

62.1.2

Xenta LonWorks Device Restart
When you cold start or warm start a Xenta 280/300/401 LonWorks device, the
device is not indicated as offline and no alarm is generated.
For more information, see section 62.26 “Xenta LonWorks Device Restart” on page
2266.
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62.2

Creating a Programmable Xenta Device
You create programmable Xenta devices under the LonWorks network to connect
to physical Xenta 280/300/401 LonWorks devices.

To create a programmable Xenta device
1. In WorkStation, in the System Tree pane, select the LonWorks network or
LonWorks network folder where you want to create the programmable Xenta
device.
2. On the File menu, point to New and then click Device.
3. In the object type list, select ProgrammableXenta.

4. In the Name box, type a name for the device.

Tip
• The name of the programmable Xenta device must be unique in
the network, even for programmable Xenta devices in different
folders in the network.
5. In the Description box, type a description.
6. Click Next.
Continued on next page
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7. In the Neuron ID box, enter the Neuron ID for the device.

8. In the Files box, enter the Menta application (MTA) file.
9. Select Application download to download the application to the device.
10. Click Create.

Note
• Xenta I/O modules are not added in this way. As they are defined in the
Menta application program, they are automatically added to the I/O folder
when the Xenta application is downloaded.
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62.3

Discovering a Xenta Device
You discover Xenta 280/300/401 LonWorks devices to create or configure the
programmable Xenta devices in the server. The Xenta 280/300/401 LonWorks
devices must be physically connected to the server field bus.
For more information, see section 56.16 “LonWorks Device Workflows” on page
2029.

To discover a Xenta device
1. In WorkStation, in the System Tree pane, select the server that is connected
to the device you want to discover.
2. Click the Device Discovery view.
3. In the Select device type box, select LonWorks.

4. Select the Devices folder.
5. On the Actions menu, click Activate listen to service pin.
6. Press the service pin on the physical device.
Continued on next page
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7. In the Device Discovery view, ensure that the Xenta device is displayed in
the Devices folder. This may take up to 5 seconds.

8. On the Actions menu, click Deactivate listen to service pin.
9. Drag the discovered service pin (device) to the System Tree pane:
• Drag to an existing device to associate it with the discovered physical
device.
• Drag to the LonWorks network to create the device.

Tip
• To verify the device Neuron ID, select the device in the System
Tree pane, and then select Properties on the File menu. The
Neuron ID can be found on the Basic tab of the Device
Properties.
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62.4

Configuring a Xenta LonWorks Device
In WorkStation, you read the properties of a Xenta device under the Xenta tab.
For more information, see section 61.2 “Xenta LonWorks Engineering” on page
2206.

To configure a Xenta LonWorks device
1. In WorkStation, in the System Tree pane, select the Xenta device.
2. Click the Properties tab and then click the Xenta tab.
3. Edit the Xenta device properties.
Component

Description

Xenta type

Displays type as selected in Menta.

Group master

Displays if this Xenta device is a group
master.

Member of group

Displays the Xenta group to which a
device belongs.

Node number

Displays the node number in the
LonWorks network.

Software version

Displays the Xenta software (firmware)
version.

Hardware version

Displays Xenta hardware version.

Boot version

Displays the Xenta boot program version.

Local time

Displays the local time in the Xenta
device. May be compared with the server
clock.

DST Last update

Displays date and time for the last
Daylight Saving Time update.

4. Click Close to close the window.
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62.5

Xenta LonWorks Device Commissioning
When you click Commission you affect the Xenta 280/300/401 LonWorks device
in a number of ways. The commission command may or may not include an
application download, depending on what you specify (if that option is available)
and on what has been changed since the previous commission and download.
The following tasks are performed during the commissioning:
• Daylight Saving Time settings are downloaded to the physical Xenta
280/300/401 LonWorks device.
• The Xenta 280/300/401 LonWorks device clock is updated with the target
server time.
• Address tables, Selector tables, and domain tables are written to the physical
Xenta 280/300/401 LonWorks device.
• The physical Xenta 280/300/401 LonWorks device Neuron chip is set to
Configured Online.
• The physical Xenta 280/300/401 LonWorks device is restarted if the domain
table was updated.
• In certain cases the user may choose whether to download the application
image or not during the commissioning operation. See below.
There are two different conditions determining the setting for the download
application image option:
• Commission without application download: The application has not been
updated. If this is true the default selection is not to download the image.
• Commission with application download: The application has been updated, the
SNVT interface has been changed, or the image is new. If this is true, the
default selection is to download the image.

62.5.1

Xenta LonWorks Device Decommissioning
When you click Decommission you remove a Xenta 280/300/401 LonWorks
device from a LonWorks network.
For more information, see section 62.11 “Xenta LonWorks Device
Decommissioning” on page 2242.

62.5.2

Xenta Objects and Device Configuration
Parameters
You create and maintain Xenta objects in a Building Operation server (an Enterprise
Server or an Automation Server).
For more information, see section 64.1 “Xenta Objects and Device Configuration
Parameters” on page 2277.
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62.6

Commissioning a Xenta Device
You commission physical Xenta 280/300/401 LonWorks devices to make them
operational. The commission downloads the Menta application, gives the device a
subnet node address, and sets the device status to online. After a commission, the
device can communicate with other devices on the LonWorks network and execute
its application.
For more information, see section 64.1 “Xenta Objects and Device Configuration
Parameters” on page 2277.

To commission a Xenta device
1. In WorkStation, in the System Tree pane, select the device.
2. On the Actions menu, click Commission.
3. Select Application download to download the application program to the
device.

4. Under IO modules, type or retrieve the Neuron ID of the associated Xenta I/O
modules:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical Xenta
I/O module to retrieve the Neuron ID.
5. Click Commission.
6. Click Close.

Tip
• The Xenta I/O Modules communication automatically begins
upon commissioning the Xenta 280/300/401 LonWorks device,
as long as the I/O module's Neuron ID was associated to the I/O
module prior to commissioning the Xenta 280/300/401
LonWorks device.
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62.7

Xenta LonWorks Daylight Savings Time
Switchover
The Building Operation server updates the upcoming Daylight Savings Time
switchovers (using DST data extracted from the server Time Zone settings) in the
physical Xenta 280/300/401 LonWorks devices in advance.
This is done by trying to send the switchover data to the Xenta 280/300/401
LonWorks devices.
• A first try is done 1 January 01.00.
• If it fails, a new try is done each week at the same time until the physical Xenta
DST is successfully updated.
• A property, DST Last update, on the Xenta 280/300/401 LonWorks device
object indicates the last time DST was successfully sent to the physical Xenta.
• If it indicates that the DST data was not successfully sent to the Xenta
280/300/401 LonWorks device the present year, and the remaining time to the
next DST switchover is less than 2 weeks, the Xenta device object tries to send
the DST data once again.
• If any sending of DST settings fails, the Xenta 280/300/401 LonWorks device is
indicated as out of sync.
The Daylight Saving Time is also set at the commissioning.
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62.8

Xenta LonWorks Time Synchronization
A Xenta device is time synchronized at the commissioning. After that, all Xenta
devices inherit their time zone settings (and DST rules where applicable) from the
Building Operation server to which they belong.
To achieve this the LonWorks network broadcasts time synchronization messages
to all Xentas beneath it with a period determined by a Xenta synchronization
interval.

Important
Make sure the following applies to the Building Operation server before the Xenta
device is commissioned:
• The correct time has been set.
• The time zone has been defined.
The Time synchronization interval is one of the properties under the Advanced tab in
the LonWorks Network object. The configurable Xenta broadcast period has a
default value of 10 minutes and allowed values between 10 minutes and one week.
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62.9

Identifying a Xenta I/O Module
You identify a Xenta I/O module to enable it to communicate with its associated
Xenta programmable device on the LonWorks Network.

To identify a Xenta I/O module
1. In WorkStation, in the System Tree pane, select the Xenta I/O module.
2. On the File menu, click Properties.

3. In the Neuron ID box, enter Neuron ID or click the Browse button to enable the
Service Pin procedure.
4. Click the Close button.

Note
The Xenta I/O module is automatically commissioned when you commission its
associated Xenta 280/300/401 LonWorks device.
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62.10

Checking the Neuron ID of a Xenta I/O
Device
You check the Neuron ID of a Xenta I/O device to make sure that the device has
been identified by Building Operation.

To check the Neuron ID of a Xenta I/O device
1. In the System Tree pane, locate the IO folder belonging to the Xenta device.
2. In the List View, click on the specific I/O device.
3. On the Basic tab, in the Device information area, check that the Neuron
ID box shows a valid ID.
If the Neuron ID is 000000000000, the device needs to be commissioned. For more
information, see section 62.9 “Identifying a Xenta I/O Module” on page
2240.Commissioning a Xenta I/O Module
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62.11

Xenta LonWorks Device
Decommissioning
When you click Decommission you remove a Xenta 280/300/401 LonWorks
device from a LonWorks network.
The following things are performed during the decommissioning:
• The domain table is set to Unused on the physical device, but not in the
database.
• The physical device is set to Unconfigured.
You can decommission a Xenta 280/300/401 LonWorks device in the network to
‘silence it’ temporarily.

Important
• Decommission a Xenta 280/300/401 LonWorks or LonWorks device before it
is removed from the network. Otherwise, the old network information may
cause problems if the device is used in another network.
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62.12

Decommissioning a Xenta Device
In WorkStation, you remove a Xenta device from a LonWorks network and clear its
network configuration by a Decommission command.
For more information, see section 64.1 “Xenta Objects and Device Configuration
Parameters” on page 2277.

To decommission a Xenta device
1. In WorkStation, in the System Tree pane, select the Xenta device.
2. On the Actions menu, click Decommission.
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62.13

Replacing an Online Xenta Device
You replace a physical Xenta 280/300/401 LonWorks device because of
malfunction issues, new requirements, or simply because of misplacement.

Important
Manually override essential equipment that is controlled by outputs of the device
or its I/O modules. Otherwise, this equipment will be turned on and off during the
application download.

Important
• Replace a device with a new device or a decommissioned device. Do not
install a commissioned device in a new network as the reused device might
contain an application or an address that can cause serious problems in the
new network.

To replace an online Xenta device
1. In WorkStation, in the System Tree pane, select the programmable Xenta
device that you want to replace.

Tip
• If the device configuration in the physical Xenta 280/300/401
LonWorks device is not synchronized with the configuration that
is stored in WorkStation, you can upload the device configuration
to WorkStation before you remove the Xenta 280/300/401
LonWorks device. For more information, see section 62.15
“Uploading the Xenta Device Configuration” on page 2247.
2. On the Actions menu, click Decommission.
3. Remove the old physical Xenta 280/300/401 LonWorks device.
4. Install the new physical Xenta 280/300/401 LonWorks device.
5. On the Actions menu, click Commission.
Continued on next page
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6. In the Neuron ID box, type or retrieve the Neuron ID of the new Xenta
280/300/401 LonWorks device:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical device
to retrieve the Neuron ID.

7. Select Application download.
8. Under IO modules, type or retrieve the Neuron ID of the associated Xenta
I/O modules:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical Xenta
I/O module to retrieve the Neuron ID.
9. Click Commission.
10. Click Close.

Important
• Restore equipment that you manually overrode before you
replaced the device.
The Xenta 280/300/401 LonWorks device is replaced, the application is
downloaded, and the device is commissioned and activated.
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62.14

Downloading the Xenta Device
Configuration
You download the device configuration from the server to update the configuration
parameters in the Xenta 280/300/401 LonWorks device.

Important
• Before downloading the device configuration from the server, carefully
consider the effects of overwriting the current device configuration in the
Xenta 280/300/401 LonWorks device.
For more information, see section 64.3 “Device Configuration Parameters” on page
2281.

To download the Xenta device configuration
1. In WorkStation, in the System Tree pane, select the Xenta 280/300/401
LonWorks device that you want to download the device configuration to.
2. On the Actions menu, click Download device configuration.
The configuration is downloaded to the Xenta 280/300/401 LonWorks device.
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62.15

Uploading the Xenta Device
Configuration
You upload the device configuration from the Xenta 280/300/401 LonWorks
devices to update the configuration parameters in the server with local device
configuration changes, which have been made through, for example, an operator
panel.

Important
• Before uploading the device configuration from a device, carefully consider
the effects of overwriting the current device configuration in the server.
For more information, see section 64.3 “Device Configuration Parameters” on page
2281.

To upload the Xenta device configuration
1. In WorkStation, in the System Tree pane, select the Xenta 280/300/401
LonWorks device that you want to upload the device configuration from.
2. On the Actions menu, click Upload device configuration.
The device configuration is uploaded to the server.
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62.16

Replacing an Offline Xenta Device
You replace a physical Xenta 280/300/401 LonWorks device because of
malfunction issues, new requirements, or simply because of misplacement.

Important
• Replace a device with a new device or a decommissioned device. Do not
install a commissioned device in a new network as the reused device might
contain an application or an address that can cause serious problems in the
new network.

To replace an offline Xenta device
1. Remove the old physical Xenta 280/300/401 LonWorks device.
2. Install the new physical Xenta 280/300/401 LonWorks device.
3. On the Actions menu, click Commission.
4. In the Neuron ID box, type or retrieve the Neuron ID of the new Xenta
280/300/401 LonWorks device:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical device
to retrieve the Neuron ID.

5. Select Application download.
6. Under IO modules, type or retrieve the Neuron ID of the associated Xenta
I/O modules:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical Xenta
I/O module to retrieve the Neuron ID.
Continued on next page
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7. Click Commission.
8. Click Close.
The Xenta 280/300/401 LonWorks device is replaced, the application is
downloaded, and the device is commissioned and activated.

04-16006-04-en, March 2015

Technical
2251

62 Xenta LonWorks Devices
62.17 Replacing a Xenta I/O Module

62.17

Replacing a Xenta I/O Module
You replace a physical Xenta I/O module because of malfunction issues, new
requirements, or simply because of misplacement.

Important
• Manually override essential equipment that is controlled by outputs on I/O
modules. Otherwise, this equipment will be turned on and off during the
application download.

To replace a Xenta I/O module
1. Remove the old physical Xenta I/O module.
2. Install the new physical Xenta I/O module.
3. In the System Tree pane, select the programmable Xenta device to which
the Xenta I/O module belongs.
4. On the Actions menu, click Commission.
5. Verify the identity of the Xenta 280/300/401 LonWorks device by checking the
Neuron ID.
6. Select Application download.

Important
• Do not forget to select Application download before you
commission the device, otherwise the application will not be
downloaded properly.
Continued on next page
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7. Under IO modules, type or retrieve the Neuron ID of the new Xenta I/O
module:
• Type the Neuron ID in the box.
• Click Service Pin and then press the service pin on the physical Xenta
I/O module to retrieve the Neuron ID.

8. Click Commission.
9. Click Close.

Important
• Restore equipment that you manually overrode before you
replaced the device.
The green LED on the new I/O module flashes at a normal, low frequency rate. The
Out of sync icon is removed from the Xenta device in the System Tree pane.
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62.18

Xenta LonWorks Groups
The Xenta Group is a logical group that is used to build a simple hierarchy of the
Xenta 280/300/401 LonWorks devices. In Building Operation, each Xenta Group is
collected in a separate folder.
The use of Xenta Groups has two main purposes:
• To keep the Building Operation server updated, in an efficient way, on which
devices are online.
• To introduce a hierarchy in large networks, making the information in the
System Tree pane and operator panel easier to find and use.
The Building Operation server must be kept up-to-date on which devices are online
on the LonWorks network. To avoid having each device communicate with the
Building Operation server about this status, the group master periodically collects
online status for all members of the group and sends it to the server. Devices that
send a periodic heartbeat to the group master are considered online.
If the group master goes offline, the group members are pinged from the Building
Operation server to determine each member's online status.

62.18.1

XentaGroups and Group Indications
To handle the special requirements of Xenta Groups, Building Operation creates a
separate object called “XentaGroups” in the System Tree pane as soon as the first
Xenta 280/300/401 LonWorks device object is created.
Under the XentaGroups object, the automatically created Xenta groups are saved.
Each created group gets the same name as the folder in which the Xenta object
was created. In this way, wise usage of folders in the System Tree pane will reflect
the natural grouping of the Xenta devices. However, a Xenta that has been
assigned to a group remains a member of that group, even when moved to another
folder.
If a Xenta 280/300/401 LonWorks device is created directly under the LonWorks
Network, a group with the LonWorks Network name is created for this Xenta
280/300/401 LonWorks device.

62.18.2

Xenta Group Master
The Xenta group master is a Xenta 280/300/401 LonWorks device (in the Xenta
Group) that monitors the online and offline status of the group members. In Building
Operation, the first device in a group is automatically appointed group master for
the online/offline information exchange in Building Operation. The group master
forwards the online and offline information to the Building Operation server.
However, the online status of the group master is monitored with a ping
mechanism, like other LonWorks devices.
To let each member (including the group master) know who the other members of
the group are, the current group list must be downloaded to each device. This is
included in the so called blueprint for each device. For more information, see
section 64.4 “Synchronization of the Xenta LonWorks Device ” on page 2282.
Alarms and other information are always sent independently and directly to the
Building Operation server by each Xenta 280/300/401 LonWorks device.
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62.19

Xenta LonWorks Device Functions
Many of the functions and features of Xenta LonWorks devices are supported in
Building Operation, including trend logs, alarms, schedules, time functions, and the
ability to view Xenta variables from a Menta application.

62.19.1

Trend Logs for Xenta LonWorks Devices
Trend logs for Xenta 280/300/401 LonWorks devices are created in Menta Editor.
You then upload these trend logs to Building Operation. You can only log public
signals from within the same Xenta device.
For more information, see section 62.20 “Trend Logs for Xenta LonWorks Devices”
on page 2255.

62.19.2

Alarms for Xenta LonWorks Devices
Alarms for Xenta 280/300/401 LonWorks devices are created in Menta Editor. You
can view the Alarms in WorkStation.
For more information, see section 62.22 “Alarms for Xenta LonWorks Devices” on
page 2257.

62.19.3

Schedules for Xenta LonWorks Devices
Xenta 280/300/401 LonWorks device schedules are different from other Building
Operation schedules. The differences originate from legacy software
considerations. Xenta 280/300/401 LonWorks device schedules are created in the
TSCH block in Menta Editor and can be edited from the Xenta Schedule editor in
WorkStation.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

62.19.4

Time Functions for Xenta LonWorks Devices
Time functions perform time-related operations in Xenta LonWorks Devices. They
include time synchronization between the Xenta LonWorks device and the server,
as well as the switchover for Daylight Savings Time.
For more information, see section 62.24 “Time Functions for Xenta LonWorks
Devices” on page 2260.

62.19.5

Xenta LonWorks Variables Display
In Building Operation, you can view Xenta variables from a Menta application in
several different ways (normal graphics not included).
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For more information, see section 62.25 “Xenta LonWorks Variables Display” on
page 2261.
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62.20

Trend Logs for Xenta LonWorks Devices
Trend logs for Xenta 280/300/401 LonWorks devices are created in Menta Editor.
You then upload these trend logs to Building Operation. You can only log public
signals from within the same Xenta device.

Tip
When using Xenta 300/400, create a number of unused logs in Menta Editor.
These can then be configured in WorkStation if logging becomes necessary at a
later date.
There are two types of trend logs in the Xenta 280/300/401 LonWorks devices:
• Circular trend logs: new values overwrite old values when the buffer in the
Xenta 280/300/401 LonWorks device is filled.
• Non-circular trend logs: the logging stops when the buffer in the Xenta
280/300/401 LonWorks device has been filled.
The buffer size of the Xenta 280/300/401 LonWorks devices is limited by the
amount of memory in the device. To store more data, and on a higher level, you can
connect the Xenta trend log to an extended trend log in the server. At configurable
intervals, or according to a smart log algorithm, data are uploaded from the trend
log in the Xenta to the much bigger extended trend log in the server. In the
extended trend log the log data is available for backup, restore, and general data
treatment. For more information, see the Extended Trend Logs topic on WebHelp..
You edit the trend log parameters in WorkStation. For more information, see section
62.21 “Configuring a Xenta Trend Log” on page 2256.
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62.21

Configuring a Xenta Trend Log
You configure a Xenta trend log by editing its properties.
For more information, see section 62.20 “Trend Logs for Xenta LonWorks Devices”
on page 2255.

To configure a Xenta trend log
1. In WorkStation, in the System Tree pane, select the Xenta trend log that you
want to configure.
2. On the File menu, click Properties.
3. Edit the properties:
Component

Description

Logged Signal

Enter the name of a public signal in the
Xenta device in which the trend log
resides.

Log Interval

Enter the time interval between the log
readings.

Log Space

Enter the total time that you want log
readings for. The number of values will be
Log Space/Log Interval.

Circular Log

Click True to select circular log.

Activate

Select type of activation: Manual - Off,
Manual - On, or Automatic.

Start Time

Type the date and time for the log to start.

Start Variable

If you have set Activate to Automatic:
Enter the name of a public signal in the
Xenta device which will start the log

No stop if logically activated

Select True to inhibit the stopping of a
log activated by a logical variable when
the variable is no longer true. The logging
continues until stopped manually, or the
log is full when the non-circular log option
is selected.

Clear log at start

Select True to make sure the log buffer is
cleared at start.

4. Click OK.
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62.22

Alarms for Xenta LonWorks Devices
Alarms for Xenta 280/300/401 LonWorks devices are created in Menta Editor. You
can view the Alarms in WorkStation.
Alarms for Xenta LonWorks devices are handled as Building Operation alarms, with
a few exceptions:
• Application alarms created in Menta Editor, using the Alarm Block and optional
Alarm Text table
• System alarms, which are mainly messages created by the system
• Offline alarms, which are alarms that concern the loss of communication with
one or several Xenta 280/300/401 LonWorks devices

62.22.1

Xenta LonWorks System Alarms
The Xenta non-application alarms are shown as system alarms in the Building
Operation Alarms pane.
For more information, see section 65.3 “Xenta LonWorks System Alarms” on page
2292.

62.22.2

Xenta LonWorks Offline Alarms
The Xenta offline alarms relate to these two cases:
• A Xenta group member goes offline
• A Xenta group master goes offline
In both cases the Xenta 280/300/401 LonWorks devices can be monitored by the
server to detect if one or more devices go offline.
For more information, see section 65.4 “Xenta LonWorks Offline Alarms” on page
2293.
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62.23

Schedules for Xenta LonWorks Devices
Xenta 280/300/401 LonWorks device schedules are different from other Building
Operation schedules. The differences originate from legacy software
considerations. Xenta 280/300/401 LonWorks device schedules are created in the
TSCH block in Menta Editor and can be edited from the Xenta Schedule editor in
WorkStation.
For more information, see section 63.2 “Building Operation Menta Editor” on page
2270.
The main differences between Xenta Schedule Editor and Building Operation
Schedule Editor are summed up as follows:
• There are no priority levels for Xenta schedules.
• The number of scheduled events, weekly and exception, are set in the Menta
Editor and determine the number of possible separate events for a specific
Xenta 280/300/401 LonWorks device.
• On all day in a weekly event is selected from a drop-down menu in Xenta
Schedule Editor or can be entered as a time range. In the Building Operation
Schedule Editor, you select on/off from a drop-down menu (24:00 not being
allowed).
• Only one start-end time pair is possible for each event.
• For exception events, only Date range is available. Date, Calculated, or
Calendar events are not available.
• On (or off) all day in an exception event is selected from a drop-down menu in
Xenta Schedule Editor.
• In Xenta 280/300/401 LonWorks devices, an exception event overrides any
weekly events for the whole of that day, not only for the limited time defined by
the exception event.
• In Menta applications, the Xenta exception events can use specific days of the
week, Monday to Sunday. As selected, the indicated days of the week
determine valid days of events within the date range. Weekly events are
defined by the days of the week; in this case the days of the week are
displayed in the schedule editor, but cannot be changed.
• If an event has a start time later than the end time, this is treated as one
overnight event.

Note
You can copy and paste a Xenta 280/300/401 LonWorks device schedule.
However, any Xenta Central schedule reference will not be copied.

62.23.1

Number of Scheduled Events for Xenta
LonWorks Devices
The number of scheduled events for a Xenta 280/300/401 LonWorks device
application is set in the Time Schedule window, which is opened when you click
Edit in the Edit block TSCH window. For more information, see section 66.1
“Number of Scheduled Events for Xenta LonWorks Devices” on page 2297.
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62.23.2

All-day Events for Xenta LonWorks Devices
All-day events have the same meaning, but are indicated differently in Menta Editor
and the schedule editor. For more information, see section 66.2 “All-Day Events for
Xenta LonWorks Devices” on page 2298.

62.23.3

Exception Events for Xenta LonWorks Devices
Exception events in Xenta 280/300/401 LonWorks device applications can only be
defined as a range of dates. For more information, see section 66.4 “Exception
Events for Xenta LonWorks Devices” on page 2300.

62.23.4

Weekly Events for Xenta LonWorks Devices
Weekly events in a Xenta 280/300/401 LonWorks device are specified with the
days of the week. For more information, see section 66.3 “Weekly Events for Xenta
LonWorks Devices” on page 2299.

62.23.5

Overnight Events for Xenta LonWorks Devices
Once an event has been defined, the selected days of the week are shown in the
schedule editor, but cannot be changed. The end time is interpreted as occurring
on the following day.
Overnight events are counted as single events, when the schedule editor calculates
the total number of events. This applies to both weekly and exception events.

62.23.6

Xenta Central Schedules
Xenta Central schedules are used to group Xenta 280/300/401 LonWorks device
schedules created in the TSCH block in Menta Editor. When you use a Central
schedule, you can change settings on whole Xenta schedule groups from a central
place.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

04-16006-04-en, March 2015

Technical
2261

62 Xenta LonWorks Devices
62.24 Time Functions for Xenta LonWorks Devices

62.24

Time Functions for Xenta LonWorks
Devices
Time functions perform time-related operations in Xenta LonWorks Devices. They
include time synchronization between the Xenta LonWorks device and the server,
as well as the switchover for Daylight Savings Time.

62.24.1

Xenta LonWorks Time Synchronization
A Xenta device is time synchronized at the commissioning. After that, all Xenta
devices inherit their time zone settings (and DST rules where applicable) from the
Building Operation server to which they belong.
For more information, see section 62.8 “Xenta LonWorks Time Synchronization” on
page 2239.

62.24.2

Xenta LonWorks Daylight Savings Time
Switchover
The Building Operation server updates the upcoming Daylight Savings Time
switchovers (using DST data extracted from the server Time Zone settings) in the
physical Xenta 280/300/401 LonWorks devices in advance.
For more information, see section 62.7 “Xenta LonWorks Daylight Savings Time
Switchover” on page 2238.
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62.25

Xenta LonWorks Variables Display
In Building Operation, you can view Xenta variables from a Menta application in
several different ways (normal graphics not included).
Table: Xenta Variables View and the Value Updates
View

Value Update

Properties view
Refresh button
Variables view

Automatic

Watch pane

Automatic

Depending on the status of the device, these values represent online or offline
values. For more information, see the Window Menu topic on WebHelp.
In Menta, values can be defined as read/write values or read-only values. If a value
is defined as a read/write value, you can enter a new manual value in the Properties
dialog box. In order to avoid overwrite of new online values from inputs/outputs, you
click Force value before you enter a manual value. For more information, see the
Forced Values topic on WebHelp..

Figure: Entering a manual value in ‘Forced’ mode
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The forced value is accepted only when the device is online, or goes online after it
has been offline.

62.25.1

Device: Online
An online value is displayed without any additional indication.

Figure: Properties dialog box, online value
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Figure: Variables view, online value

The selected variable (M3_U7) as one of three in the Watch pane. For more
information, see the Watch Pane topic on WebHelp.

Figure: Watch pane, online value

62.25.2

Device: Offline
An offline value is displayed with an offline indication (except in the Properties
dialog box).
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Figure: Properties dialog box, offline value

Figure: Variables view, offline value

The selected variable (M3_U7) as one of three in the Watch pane:
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Figure: Watch pane, offline value
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62.26

Xenta LonWorks Device Restart
When you cold start or warm start a Xenta 280/300/401 LonWorks device, the
device is not indicated as offline and no alarm is generated.
Table: Xenta Restart Modes
Mode

Description

Warm start

A warm start restarts the device without
clearing the RAM memory.

Cold start

A cold start restarts the device and clears
the RAM memory.

For an explanation of warm start or cold start, refer to Xenta documentation.
appendix A of TAC Xenta 280/300/401, Product Manual (04-00067)
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63 Xenta LonWorks Applications
63.1 Xenta LonWorks Applications

63.1

Xenta LonWorks Applications
The application in a Xenta LonWorks device contains the control logic used in the
device. Xenta LonWorks applications appear below the device object in the
System Tree pane and are edited in Menta Editor to configure the device to
different control and monitoring tasks.

63.1.1

Building Operation Menta Editor
You use Menta Editor to create programs that you download to the Xenta
280/300/401 LonWorks device where these programs execute.
For more information, see section 63.2 “Building Operation Menta Editor” on page
2270.

63.1.2

Xenta LonWorks Application Alarms
Xenta application alarms have a few limitations compared to the ordinary Building
Operation alarms.
For more information, see section 65.1 “Xenta LonWorks Application Alarms” on
page 2289.

63.1.3

Synchronization of the Xenta LonWorks Device
A Xenta 280/300/401 LonWorks device is out of sync when it is not fully updated on
its object parts: its network surroundings, its device configuration, or its application.
For more information, see section 64.4 “Synchronization of the Xenta LonWorks
Device ” on page 2282.
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63.2

Building Operation Menta Editor
You use Menta Editor to create programs that you download to the Xenta
280/300/401 LonWorks device where these programs execute.
The Menta Editor programming language is a graphical programming tool slightly
modified from the corresponding tool in the TAC Vista system.
TAC Menta Technical Manual (04-00030)

Example Program
This example Menta program includes a simple fan control program that turns a fan
on or off based upon a time schedule and occupancy.

Figure: An example Menta program for a Xenta device
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63.3

Editing a Menta Application
You edit a Menta application to change the control logic for a Xenta 280/300/401
LonWorks device.
For more information, see section 63.2 “Building Operation Menta Editor” on page
2270.

To edit a Menta application
1. In WorkStation, in the System Tree pane, select the device that you want to
edit the Menta application for.
2. On the Actions menu, click Edit.
3. In Menta Editor, edit the application.
4. On the File menu, click Save.

Tip
• In Menta Editor, on the Options menu, click Simulate if you
want to validate the program and identify the location of errors in
the program.

Tip
• In simulation mode, on the Commands menu, click Generate
if you want to make sure that it is possible to generate the output
files, for example, binary files, OP menu tree files, and .XIF file, for
the program.
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63.4

Importing a Menta Application to a
Xenta Device
You import an application file to the Xenta 280/300/401 LonWorks device so the
device is programmed with control logic.
For more information, see section 63.2 “Building Operation Menta Editor” on page
2270.

To import a Menta application to a Xenta device
1. In WorkStation, in the System Tree pane, select the device that you want to
import the application file to.
2. On the Actions menu, click Edit.
3. In Menta Editor, on the File menu, click Import.
4. Select the .MTA or .AUT file to be used as the application for the selected
device.
5. On the Options menu, click Device Specification.
6. In the Type box, select the Xenta device type that the application is designed
for.

7. In the System Version box, select blank so that no system version is
defined.
8. In the Hardware Version box, leave the default setting as is.
9. Select Add new network variables (SNVT) last in the XIF file.
Continued on next page
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10. Add the required Xenta IO modules for this application.

11. Click OK.
12. On the File menu, click Save.

Tip
• In Menta Editor, on the Options menu, click Simulate if you
want to validate the program and identify the location of errors in
the program.

Tip
• In simulation mode, on the Commands menu, click Generate
if you want to make sure that it is possible to generate the output
files, for example, binary files, OP menu tree files, and .XIF file, for
the program.
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64.1 Xenta Objects and Device Configuration Parameters

64.1

Xenta Objects and Device Configuration
Parameters
You create and maintain Xenta objects in a Building Operation server (an Enterprise
Server or an Automation Server).
A Xenta object consists of the following descriptive parts:
• Building Operation object description
• Network information: Bindings and subnet/node addresses
• Device application
• Device configuration
When the objects are created offline, you have to arrange for these parts to be
downloaded to the Xenta 280/300/401 LonWorks device itself when the system is
commissioned.
On the other hand, if some parameters in the device configuration have been finetuned online in the device, these parameters should be uploaded back to the server
database for backup and maintenance purposes. In this way, you synchronize the
database for the Xenta object(s) and the device(s).
To copy all or some of these parts in one or the other direction, you use the
following commands:
• Commission with optional Download Application
• Upload/Download Device Configuration
The following graphic shows the Xenta object and some of the commands that you
can use. Device Config set A consists of semi-static configuration values, such as
setpoint values. Set B consists of dynamic or accumulated values, such as energy
meter values.
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Figure: The Xenta object and some of its associated commands

As the same information can reside in two or three different places at the same
time, the commands also help to keep the data synchronized. For more
information, see section 64.4 “Synchronization of the Xenta LonWorks Device ” on
page 2282.

64.1.1

Xenta Object Parts
When you create a Xenta object, the required descriptive parts are automatically
included. The parts include information that is necessary to administrate and
address the Xenta 280/300/401 LonWorks device; they also include the current
application and the parameters that belong to the application.
For more information, see section 64.2 “Xenta Object Parts” on page 2280.

64.1.2

Device Configuration Parameters
The device configuration parameters contain several types of parameters. The
parameters can be regarded as two separate sets, A and B, when information is
copied during the upload, download, and device application update procedures.
For more information, see section 64.3 “Device Configuration Parameters” on page
2281.
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64.1.3

Xenta LonWorks Database Mode
It is possible to set all Xenta 280/300/401 devices in database mode by one
Database Mode command.
For more information, see the Xenta LonWorks Database Mode topic on WebHelp.
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64.2

Xenta Object Parts
When you create a Xenta object, the required descriptive parts are automatically
included. The parts include information that is necessary to administrate and
address the Xenta 280/300/401 LonWorks device; they also include the current
application and the parameters that belong to the application.

Object Description
The object description contains information on how to handle the Xenta object in
the System Tree pane. The object description is not used in the Xenta 280/300/401
LonWorks device, and so cannot be downloaded to the device.

Bindings and Subnet/Node Addresses
When the Xenta is used in a LonWorks network, the Xenta 280/300/401 LonWorks
device must have a network address. The use of SNVTs requires certain
information. This kind of data is collected in the Bindings, Subnet/node area. For
more information, see section 64.1 “Xenta Objects and Device Configuration
Parameters” on page 2277.
You can download the information to the Xenta 280/300/401 LonWorks device with
the Commission command. For more information, see section 64.4
“Synchronization of the Xenta LonWorks Device ” on page 2282.

Device Application
The actual function of the Xenta 280/300/401 LonWorks device is defined in a
Menta program. This program, together with some auxiliary files, is stored in the
device application. If you update the function in any of the servers, you have to
download the application to the Xenta 280/300/401 LonWorks device itself. For
more information, see section 64.4 “Synchronization of the Xenta LonWorks
Device ” on page 2282.
You download the information to the Xenta 280/300/401 LonWorks device by
selecting Download Application together with the Commission command.

Device Configuration
The parameters that define the behavior of the current Xenta application are
collected in the device configuration. During operation of the system, when some
experience is gained, some of these parameters may require adjustment. In most
cases you fine-tune the parameters in the device, using a Xenta Operator Panel. For
backup purposes, you should upload the parameters to the server database.
The device configuration parameters are of two kinds, which in some cases are
treated separately (set A and set B). For more information, see section 64.3 “Device
Configuration Parameters” on page 2281..
You can download the information to the Xenta 280/300/401 LonWorks device with
the Download Device Configuration command.
You can upload the device configuration from the Xenta 280/300/401 LonWorks
device to the server with the Upload Device Configuration command.
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64.3

Device Configuration Parameters
The device configuration parameters contain several types of parameters. The
parameters can be regarded as two separate sets, A and B, when information is
copied during the upload, download, and device application update procedures.
Set A: Semi-static configuration values, such as the set value.
• PVB, PVI, PVR block values
• Public constants
• Time schedule configuration
• Xenta alarm priority
• Trend log definition
The Trend log definitions include the following parameters:
• Logged signal
• Log interval
• Log space
• Log type (Circular or Non-circular)
• Activate
• Start time
• Start variable
• No stop if logically activated
• Clear log at start
Set B: Dynamic or accumulated values, such as energy meter values
• Public output values (with no input in Menta Editor) of ACCUM, INTEG, RT,
NCYC, FILT, RAMP, SHR, SHI, SHB, and RT blocks
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64.4

Synchronization of the Xenta LonWorks
Device
A Xenta 280/300/401 LonWorks device is out of sync when it is not fully updated on
its object parts: its network surroundings, its device configuration, or its application.
For more information, see section 156.1 “Xenta Device Out of Sync” on page 5579.
Depending on the case, the following is done to bring the Xenta 280/300/401
LonWorks device into sync.

64.4.1

Synchronization of the Application and the
Device Configuration Parameters
When a Xenta 280/300/401 LonWorks device has been commissioned, fine-tuned,
and perhaps stored a number of data, a careless download of the original device
configuration and/or application may overwrite some important pieces of
information.
Instead, you should update the original configuration and/or application with the
current values, which will then be used at the next download. For more information,
see section 64.1 “Xenta Objects and Device Configuration Parameters” on page
2277.
You update the device configuration parameters correctly by following these
general steps:
Table: Updating the Device Configuration Parameters
Step number

Action
Upload the device configuration parameters
from the Xenta 280/300/401 LonWorks
device to the server.
Edit/Save the Menta application program in
the server.
Commission and download the application
file from the server to the Xenta 280/300/401
LonWorks device.
Download the device configuration
parameters from the server to the Xenta
280/300/401 LonWorks device. (Optional,
as these values are normally already there.)

The different synchronization steps can be summarized in an illustration:
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Figure: Using the current configuration parameters when editing the application file

The following device configuration parameters (Set A and B. For more information,
see section 64.3 “Device Configuration Parameters” on page 2281.) are involved in
the different steps, as shown above:
Table: Parameters Involved at Synchronization

04-16006-04-en, March 2015

Synchronization step

Set A

Set B

1 Upload Device Config
parameters

Yes

Yes

2a Edit the Menta application Yes

-

2b Save the Menta
application

Yes

-

3 Commission and
Download Application

Yes

Reset to their Initial values in
the physical device after a
Download Application.

4 Download Device Config
parameters

Yes

Yes
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Synchronization step

64.4.2

Set A

Set B

Synchronization of the Network Information
If the application has been changed so that NVs or SNVTs have been added or
removed, or if the network configuration has been changed, the Xenta 280/300/401
LonWorks device must be brought into sync.
In these cases it is the Bindings, Subnet/node part of the Xenta that must be
updated with a Commission (with optional download application) command.
The following items are involved:
• The Daylight Saving Time settings are transferred
• The Xenta 280/300/401 LonWorks device clock is updated with the target
server time
• Bindings and Address tables are written to the Xenta 280/300/401 LonWorks
device
• The physical Xenta 280/300/401 LonWorks device Neuron chip is set to
Configured Online
• The physical Xenta 280/300/401 LonWorks device is automatically restarted if
the domain table was updated
At the commissioning an application download is often mandatory, but in some
cases you can specify if you want it to be included with the commissioning. In the
latter case the Download Application box is made selectable; otherwise it is
dimmed and preselected.
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Figure: The Commission command after a change of the network configuration only, with
optional download of application
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65 Xenta LonWorks Alarms
65.1 Xenta LonWorks Application Alarms

65.1

Xenta LonWorks Application Alarms
Xenta application alarms have a few limitations compared to the ordinary Building
Operation alarms.

65.1.1

Alarm Priority Conversion
In Menta Editor, the alarm priority for Xenta alarms has a range of only 0–9, whereas
Building Operation uses the greater range 0–999. So, when the alarms of the Xenta
application are used in the server for presentation they are converted, the first time
only, according to this table:
Table: Alarm Priority Conversion
Menta Application Priority

Building Operation Default Priority

0

0

1

100

2

200

3

300

4

400

5

500

6

600

7

700

8

800

9

900

You can then modify the Building Operation alarm priority as required for each
Xenta 280/300/401 LonWorks device, as for any other alarm. The modified value is
not overwritten. You can also modify the Menta Editor alarm priority for Xenta
alarms. For more information, see section 65.2 “Modifying a Menta Application
Alarm Priority” on page 2291.

65.1.2

Alarm Texts in Menta Editor
In Menta Editor, alarm texts are defined both for display in the server and on the
Xenta OP operator panel. You can see and edit all the different texts in the Menta
Editor alarm text table.
You can also edit the alarm texts for display on the server in the Building Operation
alarm properties. The OP text, however, cannot be edited in this way.
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65.1.3

Alarm Application Considerations
Unpredictable results may occur if the Menta application is changed and saved in
the Building Operation database, but not downloaded to the corresponding Xenta
280/300/401 LonWorks device.
For example, if an alarm block is removed in the Menta application, this alarm will
also disappear from the Alarms pane in WorkStation. Without downloading to the
Xenta 280/300/401 LonWorks device, however, the Xenta may still indicate an
alarm that cannot be viewed or acknowledged. If this happens you will receive an
"unhandled application alarm" message in the error log.

Important
If you make changes to a Menta application and save it in the Building Operation
database, remember to also download the application to the Xenta 280/300/401
LonWorks device.
However, as a reminder the Xenta 280/300/401 LonWorks device is indicated as
unsynced. For more information, see section 67.1 “Xenta Icons” on page 2331.

65.1.4

Xenta OP Acknowledge
Xenta application alarms can be acknowledged from the Xenta OP operator panel.
The acknowledge text on the OP is defined in the Menta Editor alarm text table, but
cannot be modified in the Building Operation alarm properties.
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65.2

Modifying a Menta Application Alarm
Priority
You modify an application alarm priority for a Xenta device. The original alarm
priority comes from the previously designed Menta application.

To modify a Menta application alarm priority
1. In WorkStation, in the System Tree pane, select the application for which
you want to modify the alarm priority.
2. Click the List View tab.
3. Select the Alarm for which you want to modify the priority.
4. On the File menu, point to Open.
5. Click the Xenta tab.

6. In the Priority box, type the new alarm priority, 0–9.
7. On the File menu, click Save.
The Menta application is updated with the new priority value the next time you open
the application.
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65.3

Xenta LonWorks System Alarms
The Xenta non-application alarms are shown as system alarms in the Building
Operation Alarms pane.
This is applicable for alarms with the following system alarm IDs:
• System cold start
• System warm start
• New application program
• Parser failed
• Unit is locked
• Unit is unlocked
• Started logging
• Stopped logging
• Log stopped because it is full
• Log full
• Not enough RAM memory for log
• Too many log definitions
• Error in log definition
• Not enough flash memory for log
• Log variable error
• No valid BPF
You can modify the Xenta system alarm priority. The default is 90. The priority
applies to all Xenta system alarms from Xenta 280/300/401 LonWorks devices on
the network.

Technical
2294

04-16006-04-en, March 2015

65 Xenta LonWorks Alarms
65.4 Xenta LonWorks Offline Alarms

65.4

Xenta LonWorks Offline Alarms
The Xenta offline alarms relate to these two cases:
• A Xenta group member goes offline
• A Xenta group master goes offline
In both cases the Xenta 280/300/401 LonWorks devices can be monitored by the
server to detect if one or more devices go offline.

65.4.1

Independent Offline Detection
Independent offline detection is the detection of a Xenta LonWorks device's online
status directly by the Building Operation server, independent of involvement from
the group master.
As long as the group master is online, independent offline detection applies to the
group master only. If the group master goes offline, all the other members of the
group are then monitored directly by the server, using independent offline detection.
When a Xenta 280/300/401 LonWorks device is offline, all Xenta alarm commands
are disabled.
The three parameters related to independent offline detection can be set from the
Properties tab of each Xenta 280/300/401 LonWorks device in the group. These
parameters enable or disable offline monitoring, set the priority of an offline alarm,
and set the maximum delay time for the alarm.

65.4.2

Group Master Guided Offline Detection
As long as the group master of a Xenta group is online it reports the online/offline
status of all other members of the group.
The two parameters related to group master guided offline detection can be set
from the Properties tab of each Xenta 280/300/401 LonWorks device in the
group. These parameters enable or disable offline monitoring and set the priority of
an offline alarm. The alarm's maximum delay time cannot be set when using group
master guided offline detection.
Although the time needed for an offline alarm varies greatly with the different Xenta
280/300/401 LonWorks device models, when group master guided offline
detection is used it takes a maximum of 3 minutes and 45 seconds from the time
when the connection is disabled until a Xenta offline alarm is received in
WorkStation.
The resetting of the offline alarm takes a maximum of 90 seconds from the time
when the connection is restored.
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65.5

Modifying the Xenta Offline Detection
Parameters
You modify the offline detection parameters for a Xenta device to enable or disable
the offline alarm, change the delay time for the offline alarm, or change the priority
level of the offline alarm. Offline detection is handled differently depending on
whether the Xenta is a group master or a group member.
For more information, see section 65.4 “Xenta LonWorks Offline Alarms” on page
2293.

To modify the Xenta offline detection parameters
1. In WorkStation, in the System Tree pane, select the Xenta device for which
you want to modify the offline detection parameters.
2. Click the Variables tab and then the Offline Detection tab.

3. Enter the Alarm settings for the parameters that you want to modify.
4. On the File menu, click Save.
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66.1

Number of Scheduled Events for Xenta
LonWorks Devices
The number of scheduled events for a Xenta 280/300/401 LonWorks device
application is set in the Time Schedule window, which is opened when you click
Edit in the Edit block TSCH window.

Figure: Specifying the number of scheduled events when editing the TSCH block

There is one entry for the maximum number of weekly events and one entry for the
maximum number of exception events.
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66.2

All-Day Events for Xenta LonWorks
Devices
All-day events have the same meaning, but are indicated differently in Menta Editor
and the Xenta Schedule Editor.
In Menta Editor and the Xenta Schedule Editor:
• You indicate On all day with a time interval 00-24.
• You indicate Off all day with a time interval 00-00.
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66.3

Weekly Events for Xenta LonWorks
Devices
Weekly events in a Xenta 280/300/401 LonWorks device are specified with the
days of the week.
Once an event has been defined in Menta Editor, the selected days of the week are
shown in the Xenta Schedule Editor, where it can be edited.

Figure: Xenta Schedule Editor weekly events
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66.4

Exception Events for Xenta LonWorks
Devices
Exception events in Xenta 280/300/401 LonWorks device applications are defined
as a range of dates, weekday, or time pair. A one-day exception is indicated with
equal Start and End dates.
If the day of the week is unimportant, you specify all days of the week in the
exception event. If you have selected anything other than all days of the week, the
exception event applies for the selected weekdays.
If limited to certain days only, the indicated days of the week determine valid days of
the event within the date range.
Exception events can be defined to reoccur on the same dates every year. To
indicate reoccurence, you need to replace the year in Start date and End date with
an asterisk.

Figure: Xenta Schedule Editor exception event
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66.5

Creating a Schedule for a Xenta
LonWorks Device
You create a schedule for a Xenta device to control a Xenta 280/300/401
LonWorks device input or output in a Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To create a schedule for a Xenta LonWorks device
1. In WorkStation, in the System Tree pane, select the Xenta 280/300/401
LonWorks device.
2. On the Action menu, click Edit.
3. In Menta Editor, create a TSCH block and set the appropriate
configurations.
4. In the Parameter box, click Edit and set all appropriate parameters.
5. In the Time schedule dialog box, click OK.
6. In the Edit block dialog box, click OK.
7. Click Save.
8. Click Exit.
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66.6

Editing a Schedule for a Xenta
LonWorks Device
You edit a schedule for a Xenta device to change the input or output control
settings in a Xenta 280/300/401 LonWorks device in a Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To edit a schedule for a Xenta LonWorks device
1. In WorkStation, in the System Tree pane, select the Xenta 280/300/401
LonWorks device schedule.
2. On the Action menu, click Edit.
3. In Menta Editor, change the appropriate configurations.
4. In the Parameter box, click Edit and edit all appropriate parameters.
5. In the Time schedule dialog box, click OK.
6. In the Edit block dialog box, click OK.
7. Click Save.
8. Click Exit.

Important
You can reassign any Xenta Central schedule in the Xenta Schedule
Editor to ensure that you not have any synchronization problems.
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66.7

Xenta Central Schedules
Xenta Central schedules are used to group Xenta 280/300/401 LonWorks device
schedules created in the TSCH block in Menta Editor. When you use a Central
schedule, you can change settings on whole Xenta schedule groups from a central
place.
In a first level, the Xenta Central schedule is referenced from a Xenta 280/300/401
LonWorks device schedule to override the schedule events set locally in the Xenta
280/300/401 LonWorks device. You can have two Xenta Central schedules
referenced from the same 280/300/401 LonWorks device schedule to override
both a weekly event and an exception event.
You can also use Xenta Central schedules in a second or more level located in
another server to override other Xenta Central schedules.
The number of events a Xenta Central schedule can have is determined by the
Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.
In WebStation, you can only read a Xenta Central schedule.
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Figure: Xenta Central Schedule example flowchart
Technical
2306

04-16006-04-en, March 2015

66 Xenta LonWorks Schedules
66.7 Xenta Central Schedules

66.7.1

Xenta Central Schedule Synchronization
If a first level Xenta Central schedule is changed when the device is offline, the
device will be out of synchronization and you have to download the configuration to
the device when the device is back online again.
When you upload a Xenta 280/300/401 LonWorks device configuration to the
Automation Server, the configuration is propagated to the Xenta 280/300/401
LonWorks device schedule and not to the Xenta Central schedule.
For more information, see section 156.1 “Xenta Device Out of Sync” on page 5579.
It is possible to edit the Xenta 280/300/401 LonWorks device schedule in the Menta
Editor although it has an assigned Xenta Central schedule. However, you will have
to ensure that any assigned Xenta Central schedules are in sync with the Xenta
280/300/401 LonWorks device schedule settings.
For more information, see section 156.4 “Xenta Schedule Synchronization
Problems” on page 5583.

66.7.2

Xenta Central Schedule Group Editing
A second top level lead Xenta Central schedule uses a Lead-Shadow relationship to
propagate the changes, similar to other Building Operation schedules. Any changes
made to the lead schedule when the shadow schedule are offline is propagated to
the shadow schedule when the device is back online again.
To change a property within the shadow schedules, you make the change within
the lead schedule. The changes are then propagated in all of the shadow
schedules. Some properties in a lead schedule, such as name and description, are
unique to the lead schedule and are not propagated to the shadow schedules.

Note
Xenta Central schedule property changes may take up to one minute before they
are propagated to shadow Xenta schedules.
For more information, see the Lead and Shadow Relationship topic on WebHelp.
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66.8

Creating a Xenta Central Schedule
You create a Xenta Central schedule for control of Xenta schedules, or other Xenta
Central schedules.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To create a Xenta Central schedule
1. In WorkStation, in the System Tree pane, select a folder.
2. On the File menu, point to New and click Schedule.
3. In the object type list, select Xenta Central Schedule.

4. In the Name box, type a name for the Xenta Central schedule.
5. In the Description box, type a description for the Xenta Central schedule.
6. Click Create.
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66.9

Adding a Weekly Event to a Xenta
Schedule
You add weekly events to a Xenta schedule to determine when the event is to
regularly occur. Weekly events always occur regularly unless overridden by an
exception event.

Important
You cannot add, edit, or delete schedule events in a Xenta Schedule in
WorkStation when a Xenta Central schedule has been assigned to it.
The number of events a Xenta Central schedule can have is determined by the
Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To add a weekly event to a Xenta schedule
1. In WorkStation, in the System Tree pane, select the schedule to which you
want to add the weekly event.
Continued on next page

04-16006-04-en, March 2015

Technical
2309

66 Xenta LonWorks Schedules
66.9 Adding a Weekly Event to a Xenta Schedule

2. In the Xenta Schedule editor, click the New button

for a weekly event.

Continued on next page
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66 Xenta LonWorks Schedules
66.9 Adding a Weekly Event to a Xenta Schedule

3. In the Time interval box, select the time range for the weekly event.

4. In the Start time box, enter the time when the weekly event starts.
5. In the End time box, enter the time when the weekly event ends.
6. Select the weekdays the weekly event is to be in service.
7. Click OK.
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66 Xenta LonWorks Schedules
66.10 Adding an Exception Event to a Xenta Schedule

66.10

Adding an Exception Event to a Xenta
Schedule
You add an exception event to configure an exception that is to apply instead of a
scheduled weekly event for a single date, date range, or a time pair.

Important
You cannot add, edit, or delete schedule events in a Xenta Schedule in
WorkStation when a Xenta Central schedule has been assigned to it.
The number of events a Xenta Central schedule can have is determined by the
Menta application.

Important
An added exception event overrides any weekly events for all of the selected
days.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To add an exception event to a Xenta schedule
1. In WorkStation, in the System Tree pane, select the schedule to which you
want to add the exception event.
Continued on next page
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66 Xenta LonWorks Schedules
66.10 Adding an Exception Event to a Xenta Schedule

2. In the Xenta Schedule editor, click the New button
event.

for an exception

Continued on next page
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66 Xenta LonWorks Schedules
66.10 Adding an Exception Event to a Xenta Schedule

3. In the Time span box, select the time range the exception event is to be in
service.

4. In the Start date box, enter the date when the exception event starts.
5. In the End date box, enter the date when the exception event ends.
6. In the Start time box, enter the time when the exception event starts.
7. In the End time box, enter the time when the exception event ends.
8. Select the weekdays the exception event is to be in service.
9. Click OK.
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66.11 Editing a Weekly Event in a Xenta Schedule

66.11

Editing a Weekly Event in a Xenta
Schedule
You edit a weekly event to change the time range, start and stop time, or weekdays
of the weekly event.

Important
You cannot add, edit, or delete schedule events in a Xenta Schedule in
WorkStation when a Xenta Central schedule has been assigned to it.
The number of events a Xenta Central schedule can have is determined by the
Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To edit a weekly event in a Xenta schedule
1. In WorkStation, in the System Tree pane, select the schedule containing the
weekly event you want to edit.
Continued on next page
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66 Xenta LonWorks Schedules
66.11 Editing a Weekly Event in a Xenta Schedule

2. In the Xenta Schedule editor, in the weekly event table, select the event and
click the Edit button

.

Continued on next page
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66 Xenta LonWorks Schedules
66.11 Editing a Weekly Event in a Xenta Schedule

3. In the Time interval box, select the time range the weekly event is to be in
service.

4. In the Start time box, enter the time when the weekly event starts.
5. In the End time box, enter the time when the weekly event ends.
6. Select the weekdays the weekly event starts.
7. Click OK.
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66.12 Editing an Exception Event in a Xenta Schedule

66.12

Editing an Exception Event in a Xenta
Schedule
You edit an exception event to change the time range, start and stop date, start and
stop time, or weekdays of an exception event.

Important
You cannot add, edit, or delete schedule events in a Xenta Schedule in
WorkStation when a Xenta Central schedule has been assigned to it.
The number of events a Xenta Central schedule can have is determined by the
Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To edit an exception event in a Xenta schedule
1. In WorkStation, in the System Tree pane, select the schedule containing the
exception event you want to edit.
Continued on next page
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66 Xenta LonWorks Schedules
66.12 Editing an Exception Event in a Xenta Schedule

2. In the Xenta Schedule editor, in the exception event table, select the event and
click the Edit button

.

Continued on next page
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66 Xenta LonWorks Schedules
66.12 Editing an Exception Event in a Xenta Schedule

3. In the Time span box, select the time range the exception event is to be in
service.

4. In the Start date box, enter the date when the exception event starts.
5. In the End date box, enter the date when the exception event ends.
6. In the Start time box, enter the time when the exception starts.
7. In the End time box, enter the time when the exception ends.
8. Select the weekdays the exception event starts.
9. Click OK.
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66.13 Deleting a Weekly Event from a Xenta Schedule

66.13

Deleting a Weekly Event from a Xenta
Schedule
You delete a weekly event when the event is no longer to regularly occur.

Important
You cannot add, edit, or delete schedule events in a Xenta Schedule in
WorkStation when a Xenta Central schedule has been assigned to it.
The number of events a Xenta Central schedule can have is determined by the
Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To delete a weekly event from a Xenta schedule
1. In WorkStation, in the System Tree pane, select the schedule containing the
weekly event you want to delete.
2. In the Xenta Schedule editor, in the weekly event table, select the event and
click the Delete button
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66.14 Deleting an Exception Event from a Xenta Schedule

66.14

Deleting an Exception Event from a
Xenta Schedule
You delete an exception event when you no longer need the exception to make an
exception from a weekly event.

Important
You cannot add, edit, or delete schedule events in a Xenta Schedule in
WorkStation when a Xenta Central schedule has been assigned to it.
The number of events a Xenta Central schedule can have is determined by the
Menta application.
For more information, see section 62.23 “Schedules for Xenta LonWorks Devices”
on page 2258.

To delete an exception event from a Xenta schedule
1. In WorkStation, in the System Tree pane, select the schedule containing the
exception event you want to delete.
Continued on next page
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66 Xenta LonWorks Schedules
66.14 Deleting an Exception Event from a Xenta Schedule

2. In the Xenta Schedule editor, in the exception event table, select the event and
click the Delete button
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66 Xenta LonWorks Schedules
66.15 Assigning a Xenta Central Schedule

66.15

Assigning a Xenta Central Schedule
You assign a Xenta Central schedule to a Xenta Schedule to override the Xenta
schedule settings, in order to administrate the Xenta 280/300/401 LonWorks
device schedule in a central place, sending out schedule changes to the Xenta
280/300/401 LonWorks devices.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To assign a Xenta Central schedule
1. In WorkStation, in the System Tree pane, select the Xenta schedule to which
you want to assign a Xenta Central schedule.
2. In the Xenta Schedule editor, in the Central weekly schedule or Central
exceptions schedule box, enter the path to a Xenta Central schedule.

3. Click
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66.16 Unassigning a Xenta Central Schedule

66.16

Unassigning a Xenta Central Schedule
You unassign a Xenta Central schedule in a Xenta schedule to use the Xenta
schedule event settings.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To unassign a Xenta Central schedule
1. In WorkStation, in the System Tree pane, select the Xenta schedule to which
you want to unassign a Xenta Central schedule.
2. In the Xenta Schedule editor, in the Central weekly schedule or Central
exceptions schedule box, delete the assigned Xenta Central schedule.

3. Click
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66 Xenta LonWorks Schedules
66.17 Assigning a Lead Xenta Central Schedule

66.17

Assigning a Lead Xenta Central
Schedule
You assign a Xenta Central schedule to a another Xenta Central Schedule to
override the Xenta Central schedule settings, in order to administrate the Xenta
280/300/401 LonWorks device schedule in a central place, sending out schedule
changes to the Xenta 280/300/401 LonWorks devices.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To assign a lead Xenta Central schedule
1. In WorkStation, in the System Tree pane, select the Xenta Central schedule
to which you want to assign a lead Xenta Central schedule.
2. In the Xenta Schedule editor, in the Lead central schedule box, enter the
path to a Xenta Central schedule.

3. Click
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66.18 Unassigning a Lead Xenta Central Schedule

66.18

Unassigning a Lead Xenta Central
Schedule
You unassign a lead Xenta Central schedule in a shadow Xenta Central schedule to
use the shadow Xenta Central schedule event settings.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To unassign a lead Xenta Central schedule
1. In WorkStation, in the System Tree pane, select the Xenta Central schedule
to which you want to unassign a lead Xenta Central schedule.
2. In Xenta Schedule editor, in the Lead central schedule box, delete the path
to the lead Xenta Central schedule.

3. Click
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66.19 Viewing a Xenta Central Schedule Reference

66.19

Viewing a Xenta Central Schedule
Reference
You can view the path to a Xenta Central schedule referenced in a Xenta Schedule.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To view a Xenta Central schedule reference
1. In WorkStation, in the System Tree pane, select the Xenta schedule where
you want view the referenced Xenta Central schedule.
2. In Xenta Schedule editor, in the Central weekly schedule or Central
exceptions schedule box, view the referenced Xenta Central schedule
path.
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66.20 Viewing a Lead Xenta Central Schedule Reference

66.20

Viewing a Lead Xenta Central Schedule
Reference
You can view the referenced Xenta Central schedule in another Xenta Central
Schedule to check the reference path.
For more information, see section 66.7 “Xenta Central Schedules” on page 2303.

To view a lead Xenta Central schedule reference
1. In WorkStation, in the System Tree pane, select the Xenta Central schedule
where you want view the referenced lead Xenta Central schedule.
2. In Xenta Schedule editor, in the Lead central schedule box, view the
referenced lead Xenta Central schedule path.
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Xenta LonWorks Device User
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67 Xenta LonWorks Device User Interface
67.1 Xenta Icons

67.1

Xenta Icons
Use the Xenta device icons to check the device status.
Table: Xenta Device Icons
Icon

Description

Programmable Xenta
Indicates that a Xenta device is a Group
master and is online.

Programmable Xenta
Indicates that a Xenta device is a Group
master and is online, but unsynced.

Programmable Xenta
Indicates that a Xenta device is a Group
master, and is offline.

Programmable Xenta
Indicates that a Xenta device is a Group
master, unsynced, and offline.

Programmable Xenta
Indicates that a Xenta device is a Group
member, unsynced, and invalid.

Xenta I/O Module
Indicates an online Xenta I/O module in the
IO folder. Also used for Xenta group
members.

(Menta object name)
Indicates the Menta application, listing the
Public Signals and Inputs/Outputs
associated with the Xenta device.

(Menta object name)
Indicates the Menta application in a device
which is offline.

(Menta Module name)
Indicates a Module defined in the Menta
application.
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67 Xenta LonWorks Device User Interface
67.1 Xenta Icons

Continued
Icon

Description

Programmable Xenta
Indicates a Xenta device which is out of
sync.

Programmable Xenta
Indicates a Xenta device which is offline.

Programmable Xenta
Indicates an invalid Xenta device.

Technical
2334

04-16006-04-en, March 2015

67 Xenta LonWorks Device User Interface
67.2 Actions Menu – Advanced Commands Submenu

67.2

Actions Menu – Advanced Commands
Submenu
Use the Advanced Commands submenu to execute functions on the selected
LonWorks device or Xenta device.

Figure: The Actions menu - Advanced Commands submenu

Table: Advanced Commands Submenu
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Command

Description

Wink

Click to generate a response from the
device, such as flashing the power LED.

Clear Status

Click to clear the diagnostic data for the
device or local node. For more information,
see section 60.13 “LonWorks Device
Properties – Diagnostics Tab” on page
2152.

Warm Start

Click to restart the device without clearing
the RAM memory. For more information, see
section 62.26 “Xenta LonWorks Device
Restart” on page 2266.

Cold Start

Click to restart the device and clear the RAM
memory. For more information, see section
62.26 “Xenta LonWorks Device Restart” on
page 2266.

Alarm Refresh

Click to transfer all alarms buffered in the
physical Xenta device to Building Operation.
For more information, see section 62.22
“Alarms for Xenta LonWorks Devices” on
page 2257.
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67.3 LonWorks Network Properties – Advanced Tab

67.3

LonWorks Network Properties –
Advanced Tab
Use the Advanced tab to view and edit domain properties and posssibly Xentaspecific parts of the LonWorks network.

Figure: Advanced tab

Table: Domain Table for Network Interface
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Component

Description

Index

Displays the location of the entry in the
domain table. The first item is 0.

ID (decimal)

Displays the domain ID of which the device is
a member.

Domain ID lenght

Displays the byte length of the domain ID.

Subnet

Displays the subnet of which the device is a
member.

Node

Displays the node ID of the device. The Local
Node is always node 1.
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67.3 LonWorks Network Properties – Advanced Tab

Continued
Component

Description
Click to change domain ID.

Table: Xenta General
Component

Description

Classic Operator Panel Support

Select Yes to get support for classic OP
functionality, that is, the OP can be
connected to any Xenta device.

Network name in blueprint

Displays the current name of the network.

System alarm priority

Enter the priority of Xenta non-application
alarms.

Time synchronization interval (min)

Enter the time interval between
synchronization of Xenta and the server
clocks. The default value is 10.

Heartbeat (s)

Enter the time interval for the server
heartbeat on the LonWorks network. The
default value is 5 s.

Table: Xenta LACnet Settings
Component

Description

Timeout (ms)

Enter the amount of time in milliseconds until
Xenta communication should be considered
broken. The default is 40,000 ms.

Transmit timer (ms)

Displays the time before Xenta
retransmission (if no answer).

Number of retries

Enter the maximum number of attempts
before giving up. The default value is 6.

The Xenta LACnet parameters only apply to certain types of data transfer, such as
application download, fetching of trend logs, and alarms refresh.
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67 Xenta LonWorks Device User Interface
67.4 ProgrammableXenta Properties – Xenta Tab

67.4

ProgrammableXenta Properties – Xenta
Tab
Use the Xenta tab to view and edit properties of the selected Xenta device.

Figure: Xenta tab

Table: Xenta Tab
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Component

Description

Xenta type

Displays type as selected in Menta.

Group master

Displays if this Xenta device is a group
master.

Member of group

Displays the Xenta group to which a device
belongs.

Software version

Displays the Xenta software (firmware)
version.

Hardware version

Displays Xenta hardware version.

Boot version

Displays the Xenta boot program version.
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67.4 ProgrammableXenta Properties – Xenta Tab

Continued
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Component

Description

Local time

Displays the local time in the Xenta device,
as adjusted to the client´s local time zone.

DST Last update

Displays date and time for the last Daylight
Saving Time update, as adjusted to the
client´s local time zone.

Technical
2339

67 Xenta LonWorks Device User Interface
67.5 Menta Program Properties – Basic Tab

67.5

Menta Program Properties – Basic Tab
Use the Basic tab to view and edit properties of the selected Xenta application.

Figure: Basic tab

For more information, see the General Properties – Basic Tab topic on WebHelp..

Note
The same property tabs appear when you select a Module created in the Menta
program.
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67.6 Menta Program Properties – Public Signals Tab

67.6

Menta Program Properties – Public
Signals Tab
Use the Public Signals tab to view and edit the public signals of the selected
Xenta application.

Figure: Public signals tab

All public signals of the Xenta application, except the inputs and outputs, are listed
under this tab. Depending on the type of signal, values are displayed or open for
modification.
The contents depend on the Menta application.

Note
The same property tabs appear when you select a Module created in the Menta
program.
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67 Xenta LonWorks Device User Interface
67.7 Menta Program Properties – Inputs Tab

67.7

Menta Program Properties – Inputs Tab
Use the Inputs tab to view the input signals of the selected Xenta application.

Figure: Menta program properties - Inputs tab

All inputs of the Xenta application are listed under this tab. The values are displayed
according to the type of input.
The contents depend on the Menta application.

Note
The same property tabs appear when you select a Module created in the Menta
program.
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67.8 Menta Program Properties – Outputs Tab

67.8

Menta Program Properties – Outputs
Tab
Use the Outputs tab to view the output signals of the selected Xenta application.

Figure: Menta program properties - Outputs tab

All outputs of the Xenta application are listed under this tab. The values are
displayed according to the type of output.
The contents depend on the Menta application.

Note
The same property tabs appear when you select a Module created in the Menta
program.
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67 Xenta LonWorks Device User Interface
67.9 Xenta I/O Module Properties – Basic Tab

67.9

Xenta I/O Module Properties – Basic Tab
Use the Xenta I/O Module Basic tab to view and edit properties of the selected
Xenta I/O module in the IO folder.

Figure: Xenta I/O Module Properties - Basic tab

Table: Xenta I/O Basic Tab
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Component

Description

Neuron ID

Displays the unique hardware ID for the
node.

Program ID

Displays the program ID for the node.

Subnet

Displays the assigned subnet number.

Node

Displays the assigned node number.

Index

Displays the assigned index number.
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67.10 Xenta I/O Module Properties – Advanced Tab

67.10

Xenta I/O Module Properties –
Advanced Tab
Use the Xenta I/O Module Advanced tab to view and edit advanced properties of
the selected Xenta I/O module in the IO folder.

Figure: Xenta I/O Module Properties - Advanced tab

Table: Xenta I/O Advanced Tab
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Component

Description

Manufacturer

Displays the name of the manufacturer.

Model

Displays the model name or number.

Version

Displays the firmware version.
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67.11 Xenta Trend Log Properties

67.11

Xenta Trend Log Properties
Use the Xenta Trend Log properties dialog box to view and edit Xenta trend logs.

Figure: Xenta trend log properties

Table: Xenta Trend Log Properties
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Component

Description

Logged Signal

Enter the name of a public signal in the Xenta
device in which the trend log resides.

Log Interval

Enter the time interval between the log
readings.

Log Space

Enter the total time that you want log
readings for. The number of values will be
Log Space/Log Interval.

Circular Log

Click True to select circular log.

Activate

Select type of activation: Manual - Off,
Manual - On, or Automatic.

Start Time

Type the date and time for the log to start.
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67.11 Xenta Trend Log Properties

Continued
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Component

Description

Start Variable

If you have set Activate to Automatic:
Enter the name of a public signal in the Xenta
device which will start the log

No stop if logically activated

Select True to inhibit the stopping of a log
activated by a logical variable when the
variable is no longer true. The logging
continues until stopped manually, or the log
is full when the non-circular log option is
selected.

Clear log at start

Select True to make sure the log buffer is
cleared at start.
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67.12 Xenta Schedule Editor

67.12

Xenta Schedule Editor
Use the Xenta Schedule Editor to view and configure weekly events and exception
events for a Xenta schedule.

Figure: Xenta Schedule editor

Table: Xenta Schedule Editor
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Number

Description

Weekly (Maximum)

Displays the maximum number of weekly
events the schedule can have. For more
information, see section 66.1 “Number of
Scheduled Events for Xenta LonWorks
Devices” on page 2297.

Central weekly schedule/Central
exceptions schedule/Lead central
schedule

Enter a central weekly or exception schedule
reference, or enter a lead Xenta Central
Schedule reference in a Xenta Central
schedule.

Lead central schedule

Enter a lead Xenta Central Schedule
reference.
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67.12 Xenta Schedule Editor

Continued
Number

Description
New
Click to open the Xenta Schedule dialog box,
where you can add an event. For more
information, see section 67.13 “Xenta
Schedule Dialog Box ” on page 2348.
Edit
Click to open the Xenta Schedule dialog box,
where you can edit an event. For more
information, see section 67.13 “Xenta
Schedule Dialog Box ” on page 2348.
Delete
Click to delete a selected event.

Weekly event table

Displays the weekly events for the Xenta
schedule or Xenta Central schedule.

Exceptions (Maximum)

Displays the maximum number of
exceptions events the schedule can have.
For more information, see section 66.1
“Number of Scheduled Events for Xenta
LonWorks Devices” on page 2297.
New
Click to open the Xenta Schedule dialog box,
where you can add an event. For more
information, see section 67.13 “Xenta
Schedule Dialog Box ” on page 2348.
Edit
Click to open the Xenta Schedule dialog box,
where you can edit an event. For more
information, see section 67.13 “Xenta
Schedule Dialog Box ” on page 2348.
Delete
Click to delete a selected event.

Exceptions event table
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Displays the exception events for the Xenta
schedule.
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67.13 Xenta Schedule Dialog Box

67.13

Xenta Schedule Dialog Box
Use the Xenta Schedule dialog box to edit the exception start and stop date, time
interval, and weekday of a weekly or exception event.

Figure: Xenta Schedule dialog box

Table: Xenta Schedule Editor
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Preperty

Description

[Time span/On all day/Off all day menu]

Click to select the time range the schedule
should be in service, or select On all day or
Off all day.

Start date/Stop date

Enter the date range when the schedule
should be in service.

Start time/Stop time

Enter the time range when the schedule
should be in service.

Result

Displays the result of the selected time
range.

[List of weekdays]

Select the weekdays the schedule should be
in service.
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67.14 Xenta Alarm Properties - Basic Tab

67.14

Xenta Alarm Properties - Basic Tab
Use the Xenta Alarm Properties - Basic tab to set configuration settings on a
Xenta alarm.

Figure: Xenta Alarm Properties - Basic tab

Table: Xenta Alarm Properties - Basic tab
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Property

Description

Message when alarm

Enter the alarm message.

Priority when alarm

Enter the priority level.

Message when reset

Enter the alarm message when reset.

Priority when reset

Enter the Xenta alarm priority when reset.

Priority

Enter the Xenta alarm priority.

OP alarm text

Enter the OP alarm text.

Shunt variable

Enter the shunt variable.

Alarm state

Displays the current alarm state.
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67.15 Xenta Alarm Properties - Advanced Tab

67.15

Xenta Alarm Properties - Advanced Tab
Use the Xenta Alarm Properties - Advanced tab to configure the Advanced
properties of a Xenta alarm.

Figure: Xenta Alarm Properties - Advanced Tab

Table: Xenta Alarm Properties - Advanced tab
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Property

Description

Category

Enter the alarm category.

Cause note group

Enter the cause note group.

Action Note group

Enter the action note group.

Checklist

Enter the alarm checklist.

Checklist required

Click True to require a checklist.

Audible alert

Click True to select audible alert.
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67.15 Xenta Alarm Properties - Advanced Tab

Continued
Property

Description

Flashing alert

Click True to select flashing alert.

Alarm View source name prefix

Type a prefix that is added to the beginning
of the source name property of an alarm
record.

Forced user action

Displays all added forced user actions.
Add
Click to add a forced user action.
Edit
Click to edit a forced user action.
Delete
Click to delete a forced user action.

List of attachments

Displays all added attachments.
Add
Click to add an attachment.
Edit
Click to edit an attachment.
Delete
Click to delete an attachment.
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68 MNL LonWorks Introduction
68.1 MNL LonWorks Device Overview

68.1

MNL LonWorks Device Overview
MNL LonWorks devices are a family of programmable, stand-alone devices that
provide direct digital control in a building's environmental control system. MNL
LonWorks devices consist of standard MNL LonWorks devices and MNL-800
LonWorks devices. MNL devices are complemented by S-Link sensors, which are
designed specifically for use with these devices.
Standard MNL LonWorks devices provide direct-digital control of fan coil, heat
pump, roof top unit, and VAV applications. Standard MNL devices are based on
nine basic hardware platforms, and each contains a standardized LonMark HVAC
functional profile that defines the device's network image.
MNL-800 LonWorks devices are capable of greater control functions than standard
MNL devices through an expanded I/O point count and a programmable LonWorks
profile.
S-Link sensors are a family of digital sensors designed specifically for use with MNL
LonWorks devices. Each sensor has a network jack to support an optional twistedpair connection to the LonWorks network.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)

68.1.1

MNL LonWorks Devices
In Building Operation documentation, the family of TAC I/A Series Lon controllers is
referred to as MNL LonWorks devices. These devices are further defined as
standard MNL LonWorks devices and MNL-800 LonWorks devices.
For more information, see section 69.1 “MNL LonWorks Devices” on page 2375.

68.1.2

MNL LonWorks Engineering
In Building Operation, you engineer a system of MNL LonWorks devices using a
variety of approaches. You can use an Automation Server to integrate a single-level
bus of MNL devices, or you can use an IP/Ethernet to FT-10 router to integrate
MNL devices with the IP/Ethernet backbone.
For more information, see section 68.2 “MNL LonWorks Engineering” on page
2356.

68.1.3

MNL LonWorks Device Functions
Many of the functions and features of MNL LonWorks devices are supported in
Building Operation. For example, Building Operation provides support for all NCIs,
NVIs, and NVOs specified in the MNL LonWorks devices' respective LonMark
profiles.
For more information, see section 69.8 “MNL LonWorks Device Functions” on page
2384.
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68.2

MNL LonWorks Engineering
In Building Operation, you engineer a system of MNL LonWorks devices using a
variety of approaches. You can use an Automation Server to integrate a single-level
bus of MNL devices, or you can use an IP/Ethernet to FT-10 router to integrate
MNL devices with the IP/Ethernet backbone.

68.2.1

LonWorks Interfaces
Building Operation servers connect to LonWorks networks through various
LOYTEC interfaces and communicate with LonWorks devices over EIA-709 (FT-10)
or EIA 852 (Ethernet).
For more information, see section 68.3 “LonWorks Interfaces” on page 2358.

68.2.2

Standard MNL LonWorks Device Workflow
For standard MNL LonWorks devices with firmware revision 4.1 and higher, use the
LonWorks procedures for creating, discovering, and commissioning.
For more information, see section 68.4 “Standard MNL LonWorks Device
Workflow” on page 2360.

68.2.3

MNL-800 LonWorks Device Workflow
For MNL-800 LonWorks devices with firmware revision 2.0 and higher, use the
MNL-800 LonWorks procedures for creating, discovering, and commissioning.
For more information, see section 68.5 “MNL-800 LonWorks Device Workflow” on
page 2365.

68.2.4

Older MNL LonWorks Device Workflow
Use this workflow for the following older MNL LonWorks devices and firmware
revisions:
• Standard MNL devices with firmware revision 4.0 and lower
• MNL-800 devices with firmware revision 1.x
For more information, see the Older MNL LonWorks Device Workflow topic on
WebHelp.

68.2.5

Commission MNL-800 LonWorks Devices
You commission an MNL LonWorks device to assign it an address and activate it in
the network.
For more information, see section 69.6 “Commission MNL-800 LonWorks Devices”
on page 2382.
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68.2.6

MNL LonWorks Applications
There are two types of MNL LonWorks devices, each with a different type of
application:
• Standard MNL LonWorks devices have standard LonMark network profiles.
• MNL-800 LonWorks devices have applications with network profiles that are
fully customizable, through the use of SNVTs.
For more information, see section 70.1 “MNL LonWorks Applications” on page
2391.

68.2.7

Synchronize MNL LonWorks Devices after
Server Restore
Whenever you restore a server database in a system containing MNL LonWorks
devices, you need to commission all the MNL devices and download the device
configurations. You may also need to synchronize the MNL device with the server
database if changes were made to the device's application or configuration since
the time when the database backup was created.
For more information, see section 68.7 “Synchronize MNL LonWorks Devices after
Server Restore” on page 2371.

68.2.8

Bindings for MNL LonWorks Devices
Bindings for MNL LonWorks devices are created and viewed using the Bindings
view, in WorkStation. Use Building Operation bindings for I/O points, S-Link sensor
points, and NCIs in MNL devices. Use LonWorks bindings for NVs in MNL devices.
For more information, see section 68.6 “Bindings for MNL LonWorks Devices” on
page 2370.
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68.3

LonWorks Interfaces
Building Operation servers connect to LonWorks networks through various
LOYTEC interfaces and communicate with LonWorks devices over EIA-709 (FT-10)
or EIA 852 (Ethernet).

Figure: LonWorks in Building Operation
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68.3.1

LonWorks in the Automation Server
The Automation Server connects to LonWorks networks through a built-in LOYTEC
FT interface and communicates with LonWorks devices over EIA-709 (FT-10).
For more information, see section 55.4 “LonWorks in the Automation Server” on
page 1976.

68.3.2

LonWorks in the Enterprise Server
The Enterprise Server connects to LonWorks networks through various LOYTEC
NIC-interfaces and communicates with LonWorks devices over EIA-709 (FT-10) or
EIA-852 (Ethernet).
For more information, see section 55.5 “LonWorks in the Enterprise Server” on
page 1977.

68.3.3

Externally Managed LonWorks Network
You can connect an externally managed LonWorks network to Building Operation
through an Automation Server, in order to view and represent that same LonWorks
network data in WorkStation. The externally managed network is configured and
managed, through LNS, with an external LonWorks manager tool connected to the
network.
For more information, see section 55.11 “Externally Managed LonWorks Network”
on page 1991.
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68.4

Standard MNL LonWorks Device
Workflow
For standard MNL LonWorks devices with firmware revision 4.1 and higher, use the
LonWorks procedures for creating, discovering, and commissioning.
There are three ways of creating and configuring a standard MNL device.

68.4.1

Create and then Discover
Use the Create and then Discover Standard MNL LonWorks Device workflow to
create and discover standard MNL LonWorks devices online.

Create a LonWorks interface
In WorkStation, create a LonWorks interface in the Enterprise Server or Automation
Server. For more information, see section 55.12 “Creating a LonWorks Interface” on
page 1993.
Technical
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Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks interface. For more
information, see section 55.15 “Creating a LonWorks Network” on page 1996.

Create an MNL device
In WorkStation, create an MNL device on the LonWorks network. For more
information, see section 56.2 “Creating a LonWorks Device” on page 2007.

Create and edit an MNL application
In the Applications view, create and edit an MNL application, using WorkPlace
Tech Editor.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
For more information, see section 70.10 “Editing an MNL LonWorks Application
Type” on page 2408.

Assign MNL application to device
In the System Tree pane, assign the MNL application to the MNL device. For
more information, see section 70.12 “Assigning an MNL LonWorks Application ” on
page 2412.

Obtain Neuron ID and associate it with MNL device
Connect the physical MNL device to the Enterprise Server or Automation Server. In
WorkStation, use the Device Discovery view to find the device (service pin) and
its Neuron ID in the list of discovered devices. Drag the discovered device to the
System Tree pane to associate its Neuron ID with the MNL device. For more
information, see section 56.5 “Discovering a LonWorks Device” on page 2012.

Commission MNL device
Commission the MNL device. For more information, see section 56.6
“Commissioning a LonWorks Device” on page 2014.

Download MNL application to device
In the System Tree pane, download the MNL application to the MNL device. For
more information, see section 70.13 “Downloading an MNL LonWorks Application
Type” on page 2413.

68.4.2

Discover
Use the Discover Standard MNL LonWorks Device workflow to discover standard
MNL LonWorks devices online.
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Create a LonWorks interface
In WorkStation, create a LonWorks interface in the Enterprise Server or Automation
Server. For more information, see section 55.12 “Creating a LonWorks Interface” on
page 1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks interface. For more
information, see section 55.15 “Creating a LonWorks Network” on page 1996.

Obtain Neuron ID and create MNL device
Connect the physical MNL device to the Enterprise Server or Automation Server. In
WorkStation, use the Device Discovery view to find the device (service pin) and
its Neuron ID in the list of discovered devices. Drag the discovered device to the
LonWorks network in the System Tree pane to create the MNL device. For more
information, see section 56.5 “Discovering a LonWorks Device” on page 2012.

Create and edit an MNL application
In the Applications view, create and edit an MNL application, using WorkPlace
Tech Editor.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
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For more information, see section 70.10 “Editing an MNL LonWorks Application
Type” on page 2408.

Assign MNL application to device
In the System Tree pane, assign the MNL application to the MNL device. For
more information, see section 70.12 “Assigning an MNL LonWorks Application ” on
page 2412.

Commission MNL device
Commission the MNL device. For more information, see section 56.6
“Commissioning a LonWorks Device” on page 2014.

Download MNL application to device
In the System Tree pane, download the MNL application to the MNL device. For
more information, see section 70.13 “Downloading an MNL LonWorks Application
Type” on page 2413.

68.4.3

Create
Use the Create Standard MNL LonWorks Device workflow to create standard MNL
LonWorks devices online.

04-16006-04-en, March 2015

Technical
2365

68 MNL LonWorks Introduction
68.4 Standard MNL LonWorks Device Workflow

Create a LonWorks interface
In WorkStation, create a LonWorks interface in the Enterprise Server or Automation
Server. For more information, see section 55.12 “Creating a LonWorks Interface” on
page 1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks interface. For more
information, see section 55.15 “Creating a LonWorks Network” on page 1996.

Create an MNL device and enter its Neuron ID
In WorkStation, create an MNL device on the LonWorks network and then enter its
Neuron ID. For more information, see section 56.2 “Creating a LonWorks Device”
on page 2007.

Create and edit an MNL application
In the Applications view, create and edit an MNL application, using WorkPlace
Tech Editor.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
For more information, see section 70.10 “Editing an MNL LonWorks Application
Type” on page 2408.

Assign MNL application to device
In the System Tree pane, assign the MNL application to the MNL device. For
more information, see section 70.12 “Assigning an MNL LonWorks Application ” on
page 2412.

Commission MNL device
Connect the physical MNL device to the Enterprise Server or Automation Server
and then commission the device. For more information, see section 56.6
“Commissioning a LonWorks Device” on page 2014.

Download MNL application to device
In the System Tree pane, download the MNL application to the MNL device. For
more information, see section 70.13 “Downloading an MNL LonWorks Application
Type” on page 2413.
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68.5

MNL-800 LonWorks Device Workflow
For MNL-800 LonWorks devices with firmware revision 2.0 and higher, use the
MNL-800 LonWorks procedures for creating, discovering, and commissioning.
There are three ways of creating and configuring an MNL-800 device.

68.5.1

Create and then Discover
Use the Create and then Discover MNL-800 LonWorks Device workflow to create
and discover MNL-800 LonWorks devices online.

Create a LonWorks interface
In WorkStation, create a LonWorks interface in the Enterprise Server or Automation
Server. For more information, see section 55.12 “Creating a LonWorks Interface” on
page 1993.
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Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks interface. For more
information, see section 55.15 “Creating a LonWorks Network” on page 1996.

Create an MNL-800 device
In WorkStation, create an MNL-800 device on the LonWorks network. For more
information, see section 69.2 “Creating an MNL-800 LonWorks Device” on page
2377.

Create and edit an MNL-800 application
In the Applications view, create and edit an MNL-800 application, using
WorkPlace Tech Editor.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
For more information, see section 70.10 “Editing an MNL LonWorks Application
Type” on page 2408.

Assign application to MNL-800 device
In the System Tree pane, assign the MNL application to the MNL-800 device. For
more information, see section 70.12 “Assigning an MNL LonWorks Application ” on
page 2412.

Obtain Neuron ID and associate it with MNL-800 device
Connect the physical MNL-800 device to the Enterprise Server or Automation
Server. In WorkStation, use the Device Discovery view to find the device (service
pin) and its Neuron ID in the list of discovered devices. Drag the discovered device
to the System Tree pane to associate its Neuron ID with the MNL-800 device. For
more information, see section 69.3 “Discovering an MNL-800 LonWorks Device” on
page 2378.

Commission MNL-800 device
Commission the MNL-800 device. Commissioning includes a partial download of
the application to give the device its device profile and program ID. For more
information, see section 69.7 “Commissioning an MNL-800 LonWorks Device” on
page 2383.

Download MNL application to device
In the System Tree pane, download the MNL application to perform a full
download of the application to the MNL-800 device. For more information, see
section 70.13 “Downloading an MNL LonWorks Application Type” on page 2413.

68.5.2

Discover
Use the Discover MNL-800 LonWorks Device workflow to discover MNL-800
LonWorks devices online.
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Create a LonWorks interface
In WorkStation, create a LonWorks interface in the Enterprise Server or Automation
Server. For more information, see section 55.12 “Creating a LonWorks Interface” on
page 1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks interface. For more
information, see section 55.15 “Creating a LonWorks Network” on page 1996.

Obtain Neuron ID and create MNL-800 device
Connect the physical MNL-800 device to the Enterprise Server or Automation
Server. In WorkStation, use the Device Discovery view to find the device (service
pin) and its Neuron ID in the list of discovered devices. Drag the discovered device
to LonWorks network in the System Tree pane to create the MNL-800 device. For
more information, see section 69.3 “Discovering an MNL-800 LonWorks Device” on
page 2378.

Create and edit an MNL-800 application
In the Applications view, create and edit an MNL-800 application, using
WorkPlace Tech Editor.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
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For more information, see section 70.10 “Editing an MNL LonWorks Application
Type” on page 2408.

Assign application to MNL-800 device
In the System Tree pane, assign the MNL application to the MNL-800 device. For
more information, see section 70.12 “Assigning an MNL LonWorks Application ” on
page 2412.

Commission MNL-800 device
Commission the MNL-800 device. Commissioning includes a partial download of
the application to give the device its device profile and program ID. For more
information, see section 69.7 “Commissioning an MNL-800 LonWorks Device” on
page 2383.

Download MNL application to device
In the System Tree pane, download the MNL application to perform a full
download of the application to the MNL-800 device. For more information, see
section 70.13 “Downloading an MNL LonWorks Application Type” on page 2413.

68.5.3

Create
Use the Create MNL-800 LonWorks Device workflow to create MNL-800 LonWorks
devices online.
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Create a LonWorks interface
In WorkStation, create a LonWorks interface in the Enterprise Server or Automation
Server. For more information, see section 55.12 “Creating a LonWorks Interface” on
page 1993.

Create a LonWorks network
In WorkStation, create the LonWorks network on the LonWorks interface. For more
information, see section 55.15 “Creating a LonWorks Network” on page 1996.

Create an MNL-800 device and enter its Neuron ID
In WorkStation, create an MNL-800 device on the LonWorks network and then
enter its Neuron ID. For more information, see section 69.2 “Creating an MNL-800
LonWorks Device” on page 2377.

Create and edit an MNL-800 application
In the Applications view, create and edit an MNL-800 application, using
WorkPlace Tech Editor.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
For more information, see section 70.10 “Editing an MNL LonWorks Application
Type” on page 2408.

Assign application to MNL-800 device
In the System Tree pane, assign the MNL application to the MNL-800 device. For
more information, see section 70.12 “Assigning an MNL LonWorks Application ” on
page 2412.

Commission MNL-800 device
Connect the physical MNL-800 device to the Enterprise Server or Automation
Server and then commission the device. Commissioning includes a partial
download of the application to give the device its device profile and program ID. For
more information, see section 69.7 “Commissioning an MNL-800 LonWorks
Device” on page 2383.

Download MNL application to device
In the System Tree pane, download the MNL application to perform a full
download of the application to the MNL-800 device. For more information, see
section 70.13 “Downloading an MNL LonWorks Application Type” on page 2413.
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68.6

Bindings for MNL LonWorks Devices
Bindings for MNL LonWorks devices are created and viewed using the Bindings
view, in WorkStation. Use Building Operation bindings for I/O points, S-Link sensor
points, and NCIs in MNL devices. Use LonWorks bindings for NVs in MNL devices.

Caution
EEPROM, where NCI data is stored in MNL devices, supports only a finite number
of write operations. Because of this, you should not bind these NCIs to frequently
changing values in Building Operation.

68.6.1

Bindings Overview
A binding is a connection between two or more variables for data exchange. In its
simplest form, a binding consists of a source and a destination. The source supplies
the value to the destination.
For more information, see section 15.1 “Bindings Overview” on page 411.

68.6.2

LonWorks Bindings
LonWorks bindings differ from other Building Operation bindings because you can
set LonWorks specific properties, such as LonWorks binding profiles.
For more information, see section 58.1 “LonWorks Bindings ” on page 2093.
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68.7

Synchronize MNL LonWorks Devices
after Server Restore
Whenever you restore a server database in a system containing MNL LonWorks
devices, you need to commission all the MNL devices and download the device
configurations. You may also need to synchronize the MNL device with the server
database if changes were made to the device's application or configuration since
the time when the database backup was created.

Important
Following a server restore, you cannot determine if you need to synchronize an
MNL device with the restored database by viewing the device's Application
status property. Instead, you must determine whether any changes were made
to the device's application or configuration since the last server backup.
Complete the tasks listed in the following flowchart. Related information can be
found in the sections after the flowchart.

Figure: Synchronize MNL LonWorks device flowchart

Commission the MNL device
Commission the MNL device and then select Download current configuration
to device to download the NCI values, which in the case of a VAV device include
flow balance calibration information, from the restored database to the device.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.
For more information, see section 69.7 “Commissioning an MNL-800 LonWorks
Device” on page 2383.
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For more information, see section 71.15 “Flow Balance Calibration Information” on
page 2454.

Download MNL LonWorks Application Type
If the MNL device’s application has changed since the last backup, download the
application to the device.
For more information, see section 70.13 “Downloading an MNL LonWorks
Application Type” on page 2413.

Download Configuration Properties
If the MNL device’s I/O point or S-Link configuration properties have changed since
the last backup, download the configuration properties to the device.
For more information, see section 69.5 “Downloading Configuration Properties to
an MNL LonWorks Device” on page 2381.

Backup or restore S-Link offsets
If the MNL device’s S-Link offsets information has changed since the last backup,
restore or back up the values you want to keep:
• If you want to keep the values from the restored database, restore the
information to the MNL device.
For more information, see section 71.6 “Restoring S-Link Sensor Offsets” on
page 2431.
• If you want to keep the information in the MNL device, then back up the
information to the database.
For more information, see section 71.5 “Backing Up S-Link Sensor Offsets” on
page 2430.

Technical
2374

04-16006-04-en, March 2015

69

MNL LonWorks Devices

Topics
MNL LonWorks Devices
Creating an MNL-800 LonWorks Device
Discovering an MNL-800 LonWorks Device
Resetting an MNL LonWorks Device
Downloading Configuration Properties to an MNL LonWorks
Device
Commission MNL-800 LonWorks Devices
Commissioning an MNL-800 LonWorks Device
MNL LonWorks Device Functions
Schedules for MNL LonWorks Devices
Trend Logs for MNL LonWorks Devices
Alarms for MNL LonWorks Devices

69 MNL LonWorks Devices
69.1 MNL LonWorks Devices

69.1

MNL LonWorks Devices
In Building Operation documentation, the family of TAC I/A Series Lon controllers is
referred to as MNL LonWorks devices. These devices are further defined as
standard MNL LonWorks devices and MNL-800 LonWorks devices.
Table: Models of MNL LonWorks Devices

69.1.1

Devices

Model Numbers

Standard MNL LonWorks devices

MNL-5Rxx, MNL-10Rxx, MNL-11RFx, MNL13RFx, MNL-15Rxx, MNL-20Rxx, MNLV1RVx, MNL-V2RVx, and MNL-V3RVx

MNL-800 LonWorks devices

MNL-800

Device Templates
Building Operation provides preinstalled device templates for newer MNL devices.
For older MNL devices, you must import their device templates into Building
Operation.
Table: MNL LonWorks Devices and Device Templates
Firmware Revision Numbers

Workflow

Standard MNL LonWorks devices, 4.1 and
higher

Use the LonWorks procedures for creating,
discovering, and commissioning.
For more information, see section 68.4
“Standard MNL LonWorks Device Workflow”
on page 2360.

Standard MNL LonWorks devices, 4.0 and
lower

Use the LonWorks procedures for importing
a device template, and creating, discovering,
and commissioning.
For more information, see the Older MNL
LonWorks Device Workflow topic on
WebHelp.

MNL-800 LonWorks devices, 2.0 and higher Use the MNL-800 LonWorks procedures for
creating, discovering, and commissioning.
For more information, see section 68.5
“MNL-800 LonWorks Device Workflow” on
page 2365.
MNL-800 LonWorks devices, 1.x

Use the LonWorks procedures for importing
a device template, and creating, discovering,
and commissioning.
For more information, see the Older MNL
LonWorks Device Workflow topic on
WebHelp.
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Firmware Revision Numbers

69.1.2

Workflow

MNL Device Model and Firmware Revision
When viewing MNL LonWorks devices in the Device Discovery view, extended
information is displayed.

Figure: MNL LonWorks device information

Model Number
The model number of the MNL device, which identifies the device's hardware
platform, LonMark profile type, and profile version number, for example, "MNLV2RV3."

Firmware Revision
The revision number of the MNL device's firmware, for example, "Rev 4.1."

Unconfigured MNL Device
If an MNL device's information does not include the model number or the firmware
revision, this indicates that the MNL device is in an unconfigured state. Adding the
device to the system depends on the device type.
• For standard MNL devices with firmware revisions 4.1 and later, use the Create
method of the device workflow to add the device to the system.
For more information, see section 68.4 “Standard MNL LonWorks Device
Workflow” on page 2360.
• For MNL-800 devices with firmware revisions 2.0 and later, you can add the
device to the system using any of the methods described in the MNL-800
workflow, even when the device is in an unconfigured state.
For more information, see section 68.5 “MNL-800 LonWorks Device Workflow”
on page 2365.
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69.2

Creating an MNL-800 LonWorks Device
You create MNL-800 LonWorks devices under the LonWorks network to connect
to physical MNL LonWorks devices.

To create an MNL-800 LonWorks device
1. In WorkStation, in the System Tree pane, select the LonWorks network
where you want to create the device.
2. On the File menu, point to New and then click Device.
3. In the object type list, select MNL-800.

4. In the Name box, type a name for the device.
5. In the Description box, type a description for the device.
6. Click Create.
You now assign an application to the MNL-800 LonWorks device and then
commission the device.
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69.3

Discovering an MNL-800 LonWorks
Device
You discover MNL-800 LonWorks devices to create or configure the MNL devices
in the Building Operation server. The MNL devices must be physically connected to
the Building Operation server fieldbus.

To discover MNL-800 LonWorks devices
1. In WorkStation, in the System Tree pane, select the server that is connected
to the devices that you want to discover.
2. Click the Device Discovery view.

3. In the Select device type box, select LonWorks.
4. Select the Devices folder.
5. On the Actions menu, click Activate listen to service pin.
6. Briefly press the service pin on the device.

Caution
Do not press the service pin for 8 seconds or longer. Pressing the
service pin for 8 seconds or longer causes the MNL device to
become unconfigured.
7. In the Device Discovery view, ensure that the MNL device is displayed in the
Devices folder. This may take up to 5 seconds.

Note
If a discovered device does not show its model number and firmware
revision, the device is unconfigured. Configure the device and then
repeat the device discovery process.
For more information, see section 69.1 “MNL LonWorks Devices” on
page 2375.
Continued on next page
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8. On the Actions menu, click Deactivate listen to service pin.
9. Drag the discovered MNL device from the Device Discovery view to the
MNL device in the System Tree pane.

Note
To verify the Neuron ID of the device, select the device in the
System Tree pane and then select Properties on the File menu.
You will find the Neuron ID on the Basic tab of the device properties
view.
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69.4

Resetting an MNL LonWorks Device
You reset an MNL LonWorks device to clear values written to RAM in WorkPlace
Tech Monitor. Resetting a device also implements changes you have made to the
sensor type property of an analog input point in an MNL-800 LonWorks device.

To reset an MNL LonWorks device
1. In WorkStation, in the System Tree pane, select the MNL LonWorks device.
2. On the Actions menu, point to MNL and then click Reset device.

Caution
Resetting an MNL LonWorks device causes its outputs to cycle off
and its application to restart.
3. Click Yes.
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69.5

Downloading Configuration Properties
to an MNL LonWorks Device
You download configuration properties to an MNL LonWorks device to update the
device with changes to the configuration properties of I/O points and S-Link sensor
points.
This can be useful when you want to update only the device configuration in the
MNL device or the Application object in the database, without affecting the device
configuration in the application type.
For more information, see section 70.3 “Application Status” on page 2395.

To download configuration properties to an MNL LonWorks
device
1. In WorkStation, in the System Tree pane, select the MNL device that you
want to download configuration properties to.
2. On the Actions menu, point to MNL and then click Download
configuration properties.
The configuration properties in the MNL LonWorks device are now synchronized
with the corresponding properties in the Building Operation database.
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69.6

Commission MNL-800 LonWorks
Devices
You commission an MNL LonWorks device to assign it an address and activate it in
the network.
Commissioning an MNL-800 device is the same as commissioning any LonWorks
device, with two exceptions.
• In order for the Commissioning command to be enabled, you must first
assign an application to the MNL-800 device.
• When you start the commissioning process, the system first initializes the MNL800 by downloading a portion of the application to the device. This is done to
ensure that the MNL-800 has a device profile and program ID that will match
the application, which is downloaded later in the process.
For more information, see section 69.7 “Commissioning an MNL-800 LonWorks
Device” on page 2383.
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69.7

Commissioning an MNL-800 LonWorks
Device
You commission the physical MNL-800 LonWorks devices to give them their
addresses, which are defined in the MNL-800 LonWorks devices in the Building
Operation server. The commission enables the devices to communicate on the
LonWorks network.
For more information, see section 69.6 “Commission MNL-800 LonWorks Devices”
on page 2382.

To commission an MNL-800 LonWorks device
1. In WorkStation, in the System Tree pane, select the MNL-800 device.
2. On the Actions menu, click Commission.
3. In the Neuron ID box, make sure that the correct Neuron ID is entered.

4. Select Commission.
5. Select which configuration to use:
• Select Keep current configuration in the device to leave the
configuration in the device as is.
• Select Download current configuration to device to use the current
configuration and download it to the device upon commission.
• Select Download default configuration to device to use the default
configuration from the device template.
• Select Upload configuration from device to use the current
configuration in the device.
6. Click Commission.
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69.8

MNL LonWorks Device Functions
Many of the functions and features of MNL LonWorks devices are supported in
Building Operation. For example, Building Operation provides support for all NCIs,
NVIs, and NVOs specified in the MNL LonWorks devices' respective LonMark
profiles.
In Building Operation, standard MNL LonWorks devices and MNL-800 LonWorks
devices have the following additional functions:
• In the MNL application, select properties of I/O point objects connected to I/O
resource tags are exposed without the need to connect SNVTs for that
purpose.
• Configuration of I/O points. For more information, see section 71.1 “MNL
LonWorks Objects” on page 2421.
• Configuration changes to individual I/O objects can be applied without the
need to recompile and download the entire MNL device application.
• Values of select I/O points can be forced. For more information, see section
71.10 “Forceable MNL I/O Point Properties” on page 2436.
• Support for public types, which allow one application to be applied to multiple
MNL devices.
• I/O points related to S-Link sensors can be configured.
• Inclusion of the associated application when an MNL device object is copied,
moved, imported, or exported.
• On-site storage of WorkPlace Tech Editor application drawings, in the Building
Operation server databases.
MNL-800 LonWorks devices in Building Operation have the following additional
functions:
• Calculation and enforcement of unique program IDs for the MNL-800
applications. The program ID is no longer defined by the the user.

69.8.1

Alarms for MNL LonWorks Devices
Building Operation alarms for MNL LonWorks devices are created and viewed in
WorkStation.
For more information, see section 69.11 “Alarms for MNL LonWorks Devices” on
page 2388.

69.8.2

Trend Logs for MNL LonWorks Devices
Building Operation trend logs for MNL LonWorks devices are created and viewed in
WorkStation.
For more information, see section 69.10 “Trend Logs for MNL LonWorks Devices”
on page 2387.
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69.8.3

Schedules for MNL LonWorks Devices
You can create schedules for MNL LonWorks devices two ways.
For more information, see section 69.9 “Schedules for MNL LonWorks Devices” on
page 2386.

69.8.4

Properties of MNL LonWorks Objects
You configure the properties of various MNL LonWorks objects to set or change the
behavior of these objects.
For more information, see section 71.7 “Properties of MNL LonWorks Objects” on
page 2432.
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69.9

Schedules for MNL LonWorks Devices
You can create schedules for MNL LonWorks devices two ways.
• Use WorkStation to create, view, and modify Building Operation schedules for
MNL LonWorks devices. You use LonWorks bindings to associate Building
Operation schedules with NVIs and NVOs in the MNL devices.
• You can use WorkPlace Tech Editor to create built-in schedules that reside
locally in MNL LonWorks devices. Built-in schedules are used as fallback
schedules at times when communication is lost between the MNL devices and
the Automation Server. By creating a built-in schedule in an application type,
the schedule becomes available in all application objects of this type.
WorkPlace Tech Tool 4.0 Users Guide (F-27255)
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
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69.10

Trend Logs for MNL LonWorks Devices
Building Operation trend logs for MNL LonWorks devices are created and viewed in
WorkStation.
The MNL devices do not contain trend logs. Instead, you use bindings to associate
the Building Operation trend logs with NVs or I/O points in the MNL LonWorks
devices.
For more information, see the How Trends Work topic on WebHelp.

69.10.1

Trend Logs from NVs
You can use LonWorks bindings to associate Building Operation trends with NVIs
and NVOs in the MNL devices.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

69.10.2

Trend Logs from I/O Points
You can use Building Operation bindings to associate Building Operation trends
with I/O points in the MNL devices.
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69.11

Alarms for MNL LonWorks Devices
Building Operation alarms for MNL LonWorks devices are created and viewed in
WorkStation.
The MNL devices do not contain alarms. Instead, you use LonWorks bindings to
associate the Building Operation alarms with NVIs and NVOs in the MNL LonWorks
devices.

Technical
2390

04-16006-04-en, March 2015

70

MNL LonWorks Applications

Topics
MNL LonWorks Applications
Changes to Applications
Application Status
WorkPlace Tech Overview
WorkPlace Tech Editor
Viewing an MNL LonWorks Application Type
Creating an MNL LonWorks Application Type
Importing a Single MNL LonWorks Application Type
Importing Multiple MNL LonWorks Application Types
Editing an MNL LonWorks Application Type
Removing an MNL LonWorks Application Type
Assigning an MNL LonWorks Application
Downloading an MNL LonWorks Application Type
Editing an MNL LonWorks Application Type in a Device
WorkPlace Tech Monitor
Monitoring an MNL LonWorks Application
Import and Export of MNL LonWorks Solutions

70 MNL LonWorks Applications
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70.1

MNL LonWorks Applications
There are two types of MNL LonWorks devices, each with a different type of
application:
• Standard MNL LonWorks devices have standard LonMark network profiles.
• MNL-800 LonWorks devices have applications with network profiles that are
fully customizable, through the use of SNVTs.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)
In Building Operation, applications exist as application types and Application
objects (instances).
Application types contain the control logic used in an MNL device. You can view the
MNL application types that are available in Building Operation in the Applications
view.
For example, you can view an application type compatible with MNL-20RS4
devices, named mnl-20rs4-BasicIO, in the Applications view, together with other
MNL application types that have been created in, or imported into, Building
Operation.

Figure: MNL application type

When you assign an application type to an MNL device, an Application object is
created in the System Tree pane.
For example, when you assign “mnl-20rs4-BasicIO” to a compatible device, such
as MNL-20RS4, Application is created in the System Tree pane.
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Figure: Application object in System Tree pane

At the device level, each MNL device has an application that contains a variety of
objects, including physical I/O point objects, S-Link objects, and SNVT objects.

Important
In Building Operation, use WorkStation to download MNL device applications. Do
not use WorkPlace Tech Tool 5.x to download an MNL device that has already
been assigned an application in Building Operation.

70.1.1

Changes to Applications
When you save changes to an MNL LonWorks application type in WorkPlace Tech
Editor, the changes are automatically made to all the Application objects that
were created from that type.
In the System Tree pane, the affected MNL LonWorks devices have an icon that
indicates they need an application download.
For more information, see section 70.2 “Changes to Applications” on page 2394.

70.1.2

Application Status
Applications in MNL LonWorks devices can have any one of five statuses, as
indicated in the Advanced properties tab of the MNL device.
For more information, see section 70.3 “Application Status” on page 2395.
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70.1.3

WorkPlace Tech Overview
The WorkPlace Tech component of Building Operation WorkStation consists of two
graphical tools: WorkPlace Tech Monitor and WorkPlace Tech Editor. With these
tools you can view, examine, and program MNL LonWorks device applications.
For more information, see section 70.4 “WorkPlace Tech Overview” on page 2396.

70.1.4

Import and Export of MNL LonWorks
Applications
In Building Operation there are two ways to import and export MNL LonWorks
applications.

Import and Export Using WorkStation
In Building Operation, you can use WorkStation to export MNL LonWorks devices
and Application objects as solutions. A solution can be imported any number of
times in other Building Operation servers where needed, thus reducing duplication
of effort.
For more information, see section 70.17 “Import and Export of MNL LonWorks
Solutions” on page 2418.

Import and Export Using WorkPlace Tech Editor
You can use WorkPlace Tech Editor to export an MNL LonWorks application as a
Visio drawing. Once the Visio drawing is created, it can be imported into other
Building Operation servers as an application type, using WorkPlace Tech Editor.
For more information, see section 70.8 “Importing a Single MNL LonWorks
Application Type” on page 2403.
For more information, see section 70.9 “Importing Multiple MNL LonWorks
Application Types” on page 2406.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)
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70.2

Changes to Applications
When you save changes to an MNL LonWorks application type in WorkPlace Tech
Editor, the changes are automatically made to all the Application objects that
were created from that type.
For each of those devices, you must download the application to the physical
device so that the changes take effect.

MNL-800 Applications
For the most part, the propagation of changes from MNL-800 application types to
their associated Application objects is automated, as is the case with standard
MNL devices. However, MNL-800 applications have customizable network profiles
that require additional steps whenever you save changes that alter an MNL-800
application type’s network profile:
• Changes to SNVT names
• Changes to NV indexes
• Additions or deletions of SNVT objects or tags
If you save changes to an MNL-800 application type’s profile, the system assigns a
new program ID to the application. When the application type has associated
Application objects, the type’s program ID no longer matches the program ID of
those objects. To synchronize the program IDs, you must download the affected
MNL devices and then commission them.
Another consequence of saving changes to an application type’s profile is that by
propagating those changes to the Application objects, you could affect the
external LonWorks network bindings that come from those Application objects.
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70.3

Application Status
Applications in MNL LonWorks devices can have any one of five statuses, as
indicated in the Advanced properties tab of the MNL device.
• Normal: The application is synchronized with the server.
• Application download required: No application is assigned to the MNL
LonWorks device, or an application has been assigned or modified since the
last download to this device.
• Reset required: Configuration changes have been made to the application.
The device needs to be reset for these changes to take effect.
• Configuration properties download required: Configuration changes
have been made to the application. The configuration properties need to be
downloaded for these changes to take effect.
• Config properties download and reset required: Configuration changes
have been made to the application. The configuration properties need to be
downloaded and then the device needs to be reset for these changes to take
effect.
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70.4

WorkPlace Tech Overview
The WorkPlace Tech component of Building Operation WorkStation consists of two
graphical tools: WorkPlace Tech Monitor and WorkPlace Tech Editor. With these
tools you can view, examine, and program MNL LonWorks device applications.
Both tools are installed when you select the WorkPlace Tech check box on the
Choose Components page of the WorkStation installation wizard.

70.4.1

WorkPlace Tech Editor
You use WorkPlace Tech Editor to program, modify, and compile control
applications for MNL LonWorks devices.
For more information, see section 70.5 “WorkPlace Tech Editor” on page 2397.

70.4.2

MNL LonWorks Objects
MNL LonWorks objects are translated into Building Operation I/O points, Sensor
object, and S-Link sensor points.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

70.4.3

WorkPlace Tech Monitor
You use WorkPlace Tech Monitor to verify and troubleshoot control applications for
MNL LonWorks devices in real time.
For more information, see section 70.15 “WorkPlace Tech Monitor” on page 2415.
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70.5

WorkPlace Tech Editor
You use WorkPlace Tech Editor to program, modify, and compile control
applications for MNL LonWorks devices.
WorkPlace Tech Editor uses a Microsoft Visio drawing interface, and can be used
with Visio 2010 SP1, Visio 2007 SP2, or Visio 2003 SP3. In WorkPlace Tech Editor,
you create new applications, modify and compile existing applications, import
applications into Building Operation, and export applications as Visio files.

Figure: The WorkPlace Tech Editor interface

Important
When Visio 2007 is installed on a Windows Server 2012 system or a Windows
Server 2012 R2 system, you must add .NET Framework 3.5 in order to ensure
the proper function of WorkPlace Tech Editor and Monitor.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745) for
a procedure for installing Visio 2007 on Windows Server 2012.

Important
Where multiple versions of Microsoft Visio are installed, the last-run version of
Visio must be compatible with the version of WorkPlace Tech Editor or Monitor
you wish to start. If WorkPlace Tech Editor or Monitor does not start, close any
sessions of Visio that are open. Next, open and then close a compatible version
of Visio, and then start WorkPlace Tech Editor or Monitor. To identify the version
of Visio or WorkPlace Tech Editor or Monitor you are running, click the
appropriate About option in the Help menu.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745) for
a troubleshooting procedure addressing the inability of WorkPlace Tech Editor or
Monitor to start due to an incompatible version of Visio.

70.5.1

Hardware Configuration
You use the Hardware Wizard to modify an application’s hardware configuration.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
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WorkPlace Tech Tool 4.0 Users Guide (F-27255)

70.5.2

Applications
Applications are displayed in the Visio interface as control logic drawings (also
known as application drawings) that represent an MNL device's control logic. For
more information, see section 70.1 “MNL LonWorks Applications” on page 2391.

70.5.3

I/O Control Objects and Tags
You construct the control logic by linking various Visio shapes that function as
I/O points, control objects, and tags.
Monitor tags are not active in WorkPlace Tech Editor. To view real-time data on
monitor tags, you open the control logic drawing in WorkPlace Tech Monitor.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

70.5.4

Application Import
You use the Import Wizard to import existing WorkPlace Tech applications into the
Building Operation system. This allows you to reuse previously created applications,
saving engineering time and effort.

Important
Applications must be from WorkPlace Tech version 4.0 or later, in order to be
imported into Building Operation.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

70.5.5

Application Compile
When you have finished creating or editing an application in WorkPlace Tech Editor,
you compile the control logic drawing. A compiled application can be used in one or
more devices of the same type.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

70.5.6

Application Export
You can save a copy of an MNL device application drawing as a Microsoft Visio file.
This makes the drawing available for use in WorkPlace Tech, outside the Building
Operation environment.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)
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70.6

Viewing an MNL LonWorks Application
Type
You view an MNL LonWorks application type in WorkPlace Tech Editor to see the
application's sequence of operation.

To view an MNL LonWorks application type
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click WorkPlace Tech Editor.
Continued on next page
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4. In the Applications view, double-click the application type that you want to
view.

You can now view and edit the application type in WorkPlace Tech Editor.

Caution
Do not open more than 10 applications concurrently in WorkPlace Tech Editor.
Opening more than 10 applications concurrently can cause an exception error,
and unsaved changes may be lost.
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70.7

Creating an MNL LonWorks Application
Type
You use WorkPlace Tech Editor to create an MNL LonWorks application type so
the new application type is available to assign to MNL LonWorks devices.
For more information, see section 70.5 “WorkPlace Tech Editor” on page 2397.

To create an MNL LonWorks application type
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click WorkPlace Tech Editor.
Continued on next page
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4. Click the Add an Application button

.

5. In the MNL device list box, select the MNL device model.
6. In WorkPlace Tech Editor, create a new application.
7. On the File menu, click Save.
8. In the Enter a name for this application box, type a name for the
application.

9. In the Enter a description for this application box, type a description for
the application.
10. In the Enter a category for this application box, type a category for the
application.
11. Click OK.
You can view the new application type in the WorkPlace Tech Applications view in
WorkStation. The application type is now available to assign to MNL LonWorks
devices.
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70.8

Importing a Single MNL LonWorks
Application Type
You use WorkPlace Tech Editor to import an MNL LonWorks application type into
the Building Operation database so the new application type is available to assign
to MNL LonWorks devices.

Important
Applications must be from WorkPlace Tech version 4.0 or later, in order to be
imported into the Building Operation database.
For more information, see section 70.5 “WorkPlace Tech Editor” on page 2397.

To import a single MNL LonWorks application type
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click WorkPlace Tech Editor.
Continued on next page
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4. Click the Add an Application button

.

5. In the MNL device list box, select the MNL device model.
6. In WorkPlace Tech Editor, on the Application menu, click Import Wizard.
7. On the Input File Selection page, read the information and then click Next.
8. In the Select WorkPlace Tech File to Import dialog box, select the
application (.vsd) file to be imported.
9. Click Open.
10. On the Application menu, click Hardware Wizard.
11. In the Hardware Wizard, on the Controller Selection page, make sure the
correct hardware type is selected.

Important
In WorkPlace Tech Editor, you can only change the hardware type of
a new application before saving the application to the Building
Operation database.

Tip
If you have saved the new application and then want to change the
hardware type, first create a copy of the application by selecting
Copy Application on the Application menu, and then select a
different hardware type.
12. On the File menu, click Save.
Continued on next page
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13. In the Enter a name for this application box, type a name for the
application.

14. In the Enter a description for this application box, type a description for
the application.
15. In the Enter a category for this application box, type a category for the
application.
16. Click OK.
You can view the new application type in the WorkPlace Tech Applications view in
WorkStation. The application type is now available to assign to MNL LonWorks
devices.
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70.9

Importing Multiple MNL LonWorks
Application Types
You use WorkPlace Tech Editor to import two or more MNL LonWorks application
types into the Building Operation database so the new application types are
available to assign to MNL LonWorks devices.

Important
Applications must be from WorkPlace Tech version 4.0 or later, in order to be
imported into the Building Operation database.
For more information, see section 70.5 “WorkPlace Tech Editor” on page 2397.

To import multiple MNL LonWorks application types
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click WorkPlace Tech Editor.
Continued on next page
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4. Click the Add an Application button

.

5. In the MNL device list box, select the MNL device model.
6. In WorkPlace Tech Editor, on the Application menu, click Import Wizard.
7. On the Input File Selection page, read the information and then click Next.
8. In the Select WorkPlace Tech File to Import dialog box, select the
application (.vsd) files to be imported.

Important
Application file names may only contain digits 1 through 9,
uppercase letters A through Z, lowercase letters a through z, hyphen
(-) and underscore (_), in order to be imported into the Building
Operation database.

Note
Duplicate application names are appended with an underscore
followed by a number when imported into the Building Operation
database.
9. Click Open.
10. On the Ready to Import page, verify the number of files that will be imported
and then click Next.

Note
If the Import Wizard pauses and displays a message during the
import process, click OK to proceed.
11. Review the import log file and then click Finish.
You can view the new application types in the WorkPlace Tech Applications view in
WorkStation. The application types are now available to assign to MNL LonWorks
devices.
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70.10

Editing an MNL LonWorks Application
Type
You edit an MNL LonWorks application type from the Applications view when you
want to modify the application's sequence of operation and you don't know which
MNL LonWorks devices use that application type.

To edit an MNL LonWorks application type
1. In WorkStation, in the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click WorkPlace Tech Editor.
Continued on next page
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4. In the Applications view, select the application type.

5. Click the Edit an application

button.

6. In WorkPlace Tech Editor, edit and save the application type.
For more information, see section 70.5 “WorkPlace Tech Editor” on page
2397.
For each device that uses the edited application type, you now download the
application type to the physical device so that the changes take effect.
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70.11

Removing an MNL LonWorks
Application Type
You remove an MNL LonWorks application type from the system when you no
longer need the application.

To remove an MNL LonWorks application type
1. In WorkStation, in the System Tree pane, delete any Application objects
that are associated with the application type you want to delete.
2. On the Tools menu, click Control Panel.
3. On the Control Panel toolbar, select the server.

4. Click WorkPlace Tech Editor.
Continued on next page
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5. In the Applications view, select the application type.

6. Click the Remove an Application button
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70.12

Assigning an MNL LonWorks Application
You assign an application to an MNL LonWorks device to specify which application
type the device will use.
For more information, see section 70.1 “MNL LonWorks Applications” on page
2391.

To assign an MNL LonWorks application
1. In WorkStation, in the System Tree pane, select an MNL LonWorks device.
2. On the Actions menu, point to MNL and then click Assign application.
3. When assigning an MNL-800 application, select Only show MNL-800
applications with the same program ID as the selected device to
make it easier to select an application that is appropriate for an MNL-800
device.

4. In the list of applications, select an application.
5. In the Description box, type a description of the application.
6. Click Assign.
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70.13

Downloading an MNL LonWorks
Application Type
You download an application type to an MNL LonWorks device to load the device
with its assigned application.

Important
In Building Operation, use WorkStation to download MNL device applications. Do
not use WorkPlace Tech Tool 5.x to download an MNL device that has already
been assigned an application in Building Operation.

To download an MNL LonWorks application type
1. In WorkStation, in the System Tree pane, select the MNL LonWorks device
that you want to download the application to.

Warning
Prior to application download, manually override any critical
equipment that is controlled by outputs on the affected field devices.
When the download completes, the devices are reset and all outputs
are turned off until the application restarts, removing any software
overrides (forced values) that were in effect before the download.
Such overrides may be in place while service is being performed on
the equipment, and their inadvertent removal can result in personal
injury or equipment damage.
2. On the Actions menu, point to MNL and then click Download application.
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70.14

Editing an MNL LonWorks Application
Type in a Device
You edit an application type in an MNL LonWorks device object when you want to
modify the application's sequence of operation and you know a device that uses
the application type.

To edit an MNL LonWorks application type in a device
1. In WorkStation, in the System Tree pane, expand an MNL device that
contains the application you want to edit.
2. Select Application.

3. On the Actions menu, click Edit.
4. In WorkPlace Tech Editor, edit and save the application.
For more information, see section 70.5 “WorkPlace Tech Editor” on page
2397.
For each device that uses the edited application type, you now download the
application type to the physical MNL device so that the changes take effect.
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70.15

WorkPlace Tech Monitor
You use WorkPlace Tech Monitor to verify and troubleshoot control applications for
MNL LonWorks devices in real time.
WorkPlace Tech Monitor uses a Microsoft Visio drawing interface, and can be used
with Visio 2010 SP1, Visio 2007 SP2, or Visio 2003 SP3. When you open an
application in WorkPlace Tech Monitor, you are automatically connected to the
MNL device. You can view real-time values with monitor tags and temporarily write
fixed values to the device's RAM, using constant tags. Using WorkPlace Tech
Monitor, you can also monitor multiple devices simultaneously.

Figure: The WorkPlace Tech Monitor interface

Important
When Visio 2007 is installed on a Windows Server 2012 system or a Windows
Server 2012 R2 system, you must add .NET Framework 3.5 in order to ensure
the proper function of WorkPlace Tech Editor and Monitor.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745) for
a procedure for installing Visio 2007 on Windows Server 2012.

Important
Where multiple versions of Microsoft Visio are installed, the last-run version of
Visio must be compatible with the version of WorkPlace Tech Editor or Monitor
you wish to start. If WorkPlace Tech Editor or Monitor does not start, close any
sessions of Visio that are open. Next, open and then close a compatible version
of Visio, and then start WorkPlace Tech Editor or Monitor. To identify the version
of Visio or WorkPlace Tech Editor or Monitor you are running, click the
appropriate About option in the Help menu.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745) for
a troubleshooting procedure addressing the inability of WorkPlace Tech Editor or
Monitor to start due to an incompatible version of Visio.
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70.15.1

Monitor Tags
In WorkPlace Tech Monitor, you can use monitor tags to view real-time data and
use that information to verify or troubleshoot an application. Monitor tags you add in
WorkPlace Tech Monitor are not saved with the application. If you wish to add and
save monitor tags with the application drawing, you must do so in WorkPlace Tech
Editor.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

70.15.2

Write to RAM
In WorkPlace Tech Monitor, you can temporarily write fixed values to the MNL
device's RAM, using constant tags. Using write-to-RAM, you can quickly make
these changes while connected to the MNL device, without having to recompile or
download the entire application. Using monitor tags, you can then view the results
of the revised constants to verify whether the expected effects were achieved. This
can be useful when diagnosing an application online. Constant tags you add or
modify in WorkPlace Tech Monitor are not saved with the drawing.

Important
Values written to RAM are only temporarily retained in the MNL device. Such
values are cleared when the MNL device is reset, or its application is downloaded.
To make permanent changes, use WorkPlace Tech Editor.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

Technical
2418

04-16006-04-en, March 2015

70 MNL LonWorks Applications
70.16 Monitoring an MNL LonWorks Application

70.16

Monitoring an MNL LonWorks
Application
You use WorkPlace Tech Monitor to view an application in an MNL LonWorks
device and monitor its output values in real time, or to write to fixed-value inputs
using the write-to-RAM function. You can view multiple applications simultaneously.
For more information, see section 70.15 “WorkPlace Tech Monitor” on page 2415.

Monitoring an MNL LonWorks application
1. In WorkStation, in the System Tree pane, select an MNL LonWorks device
with the application that you want to monitor.
2. On the Actions menu, point to MNL and then click Launch WorkPlace
Tech Monitor.
You can now use WorkPlace Tech Monitor to view and monitor the application, or
perform the write-to-RAM function.
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70.17

Import and Export of MNL LonWorks
Solutions
In Building Operation, you can use WorkStation to export MNL LonWorks devices
and Application objects as solutions. A solution can be imported any number of
times in other Building Operation servers where needed, thus reducing duplication
of effort.
For more information, see section 18.1 “Import and Export Overview” on page 557.

70.17.1

Exporting an MNL LonWorks Solution
You use WorkStation to export an MNL LonWorks device or Application object as
an MNL LonWorks solution so that it can be reused in other Building Operation
servers. When you export an MNL LonWorks Application object, the corresponding
MNL LonWorks application type is automatically included in the solution file.
For more information, see section 18.3 “Exporting a Solution” on page 561.

70.17.2

Importing an MNL LonWorks Solution
You use WorkStation to import an MNL LonWorks solution that was created or
modified on another Building Operation server.
For more information, see section 18.27 “Importing a Solution” on page 594.

Caution
If a name conflict occurs during the import process, proceed with caution. It is
possible that the existing application type and the application type in the solution
file are not identical. In such a case, the Application objects that are created
during import may not contain all the attributes of the original Application
objects on the source server.
For more information, see section 158.21 “Name Conflicts During MNL LonWorks
Solution Import” on page 5619.

Caution
If a name conflict occurs during the import process, and the MNL device model
number is different between the existing application type and the application type
in the solution file, do not proceed with the import. Instead, use WorkPlace Tech
Editor to import the original application type from which the solution was created
and then save it with a different name.
For more information, see section 70.8 “Importing a Single MNL LonWorks
Application Type” on page 2403.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)
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71.1 MNL LonWorks Objects

71.1

MNL LonWorks Objects
MNL LonWorks objects are translated into Building Operation I/O points, Sensor
object, and S-Link sensor points.
In Building Operation, you can view the MNL LonWorks object name for a Building
Operation point in the System Tree pane, and also in the title bar of the point's
properties dialog box. You can view the Building Operation I/O point type in the
Object ID.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

71.1.1

I/O Points
MNL LonWorks I/O point objects are translated into Building Operation I/O points.
For more information, see section 71.2 “I/O Points” on page 2422.

71.1.2

S-Link Sensors
The sensor configuration pages and tabs of the WorkPlace Tech Editor Hardware
Wizard are translated into corresponding Building Operation S-Link sensor objects.
For more information, see section 71.3 “S-Link Sensors” on page 2426.
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71.2

I/O Points
MNL LonWorks I/O point objects are translated into Building Operation I/O points.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
Table: Building Operation I/O points
WorkPlace Tech Editor
Object

Building Operation I/O
Point

Comments

Analog Input

AnalogInM

Provides a means to
interface the application to
various types of physical
analog input hardware.

For more information, see
section 72.3 “AnalogIn
Properties – Basic Tab” on
page 2467.

Analog Input

AnalogInR
For more information, see
section 72.3 “AnalogIn
Properties – Basic Tab” on
page 2467.

Analog Input

AnalogInTC and
AnalogInTF
For more information, see
section 72.3 “AnalogIn
Properties – Basic Tab” on
page 2467.

Analog Input

AnalogInV
For more information, see
section 72.3 “AnalogIn
Properties – Basic Tab” on
page 2467.

Analog Output

Technical
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Created when the Analog
Input object's Input Sensor
Type property is set to
Milliamps.
Provides a means to
interface the application to
various types of physical
analog input hardware.
Created when the Analog
Input object's Input Sensor
Type property is set to
Resistance 1k or Resistance
10k.
Provides a means to
interface the application to
various types of physical
analog input hardware.
Created when the Analog
Input object's Input Sensor
Type property is set to
Thermistor (10k), Balco, or
Platinum. AnalogInTC is
created when the units used
by the MNL device are set to
Metric, and AnalogInTF is
created when the units are
set to English.
Provides a means to
interface the application to
various types of physical
analog input hardware.
Created when the Analog
Input object's Input Sensor
Type property is set to Volts.

AnalogOut

Provides a means to
interface the application to a
For more information, see
physical analog output point
section 72.7 “AnalogOut and on an MNL device.
AnalogOutPri Properties –
Basic Tab” on page 2475.
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Continued
WorkPlace Tech Editor
Object

Building Operation I/O
Point

Comments

Analog Output Priority

AnalogOutPri

Same as the Analog Output
object but features four
prioritized inputs.

For more information, see
section 72.7 “AnalogOut and
AnalogOutPri Properties –
Basic Tab” on page 2475.
Binary Input

BinaryIn
For more information, see
section 72.9 “BinaryIn
Properties – Basic Tab” on
page 2479.

Provides a means to
interface the application to
any physical input point on
an MNL device that accepts
a digital input signal.
Created when the Binary
Input object's Binary Type
property is set to Direct or
Reverse.

Binary Input

BinaryInPls
For more information, see
section 72.11 “BinaryInPls
Properties – Basic Tab” on
page 2483.

Provides a means to
interface the application to
any physical input point on
an MNL device that supports
the monitoring of a pulse
train device, such as a flow
meter or demand meter.
Created when the Binary
Input object's Binary Type
property is set to Pulse.

Binary Output

BinaryOut
For more information, see
section 72.13 “BinaryOut
Properties – Basic Tab” on
page 2487.

DUI Expander

DUI
For more information, see
section 72.15 “DUI
Properties – Basic Tab” on
page 2489.

Event Indicator

EventInd
For more information, see
section 72.17 “EventInd
Properties – Basic Tab” on
page 2493.
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Provides a means to
interface the application to a
physical digital output point
on an MNL device.

Digital Universal Input (DUI)
object. Provides support for
up to five digital inputs, using
a single physical universal
input on the MNL device.
A special-purpose I/O point
with a physical hardware
address for a digital output
point. Operates like a
BinaryOut I/O point but can
also generate an interrupting
pulse (flick) used to signal an
approaching event.
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Continued
WorkPlace Tech Editor
Object

Building Operation I/O
Point

Comments

Fan Speed

FanSpeed1

The Fan Speed object
provides sequenced control
of up to three physical digital
outputs.

For more information, see
section 72.19 “FanSpeed1
Properties – Basic Tab” on
page 2496.

Fan Speed

FanSpeed2
For more information, see
section 72.21 “FanSpeed2
Properties – Basic Tab” on
page 2499.

Fan Speed

FanSpeed3
For more information, see
section 72.23 “FanSpeed3
Properties – Basic Tab” on
page 2503.

Floating Actuator

FloatingAct
For more information, see
section 72.24 “FloatingAct
and FloatingActPri
Properties – Basic Tab” on
page 2505.

Created when the Fan Speed
object's Number of Speeds
property is set to Single
Speed.
The Fan Speed object
provides sequenced control
of up to three physical digital
outputs.
Created when the Fan Speed
object's Number of Speeds
property is set to Two
Speed.
The Fan Speed object
provides sequenced control
of up to three physical digital
outputs.
Created when the Fan Speed
object's Number of Speeds
property is set to Three
Speed.
Used to control a floating
type actuator, using two
physical digital outputs on
the MNL device.

For more information, see
section 72.25 “FloatingAct
and FloatingActPri
Properties – Advanced Tab”
on page 2507.
Floating Actuator Priority

FloatingActPri
For more information, see
section 72.24 “FloatingAct
and FloatingActPri
Properties – Basic Tab” on
page 2505.

Momentary Start/Stop

MomenSS
For more information, see
section 72.26 “MomenSS
Properties – Basic Tab” on
page 2509.
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Same as the Floating
Actuator object but features
four prioritized inputs.

Provides timed start and
stop pulses, using two
physical digital outputs on
the MNL device.
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Continued
WorkPlace Tech Editor
Object

Building Operation I/O
Point

Comments

Pressure Transducer

PressureTransInH2O

Supports the onboard
velocity-pressure transducer
of an MNL VAV device.

For more information, see
section 72.28
“PressureTransInH20 and
PressureTransPa
Properties – Basic Tab” on
page 2513.
Pressure Transducer

PressureTransPa
For more information, see
section 72.28
“PressureTransInH20 and
PressureTransPa
Properties – Basic Tab” on
page 2513.

PWM

PWMMin
For more information, see
section 72.30 “PWMMin,
PWMPriMin, PWMSec, and
PWMPriSec Properties –
Basic Tab” on page 2517.

PWM

PWMSec
For more information, see
section 72.30 “PWMMin,
PWMPriMin, PWMSec, and
PWMPriSec Properties –
Basic Tab” on page 2517.

PWM Priority

PWMPriMin
For more information, see
section 72.30 “PWMMin,
PWMPriMin, PWMSec, and
PWMPriSec Properties –
Basic Tab” on page 2517.

PWM Priority

PWMPriSec
For more information, see
section 72.30 “PWMMin,
PWMPriMin, PWMSec, and
PWMPriSec Properties –
Basic Tab” on page 2517.

VAV Actuator

VAVActuator
For more information, see
section 72.32 “VAVActuator
Properties – Basic Tab” on
page 2521.
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Created when the units used
by the MNL device are set to
English. Velocity pressure is
expressed in inches of water
column.
Supports the onboard
velocity-pressure transducer
of an MNL VAV device.
Created when the units used
by the MNL device are set to
Metric. Velocity pressure is
expressed in Pascals.
Provides a physical hardware
address for a digital output
that behaves as a pulse
width modulator.
Created when the Time
Select property of the PWM
object is set to Minutes.
Provides a physical hardware
address for a digital output
that behaves as a pulse
width modulator.
Created when the Time
Select property of the PWM
object is set to Seconds.
Same as the PWM object but
features four prioritized
inputs.
Created when the Time
Select property of the PWM
object is set to Minutes.
Same as the PWM object but
features four prioritized
inputs.
Created when the Time
Select property of the PWM
object is set to Seconds.
Used to control a VAV
terminal box damper
actuator.

Technical
2427

71 MNL LonWorks Objects
71.3 S-Link Sensors

71.3

S-Link Sensors
The sensor configuration pages and tabs of the WorkPlace Tech Editor Hardware
Wizard are translated into corresponding Building Operation S-Link sensor objects.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
Table: S-Link Sensor in Building Operation
WorkPlace Tech Editor
Hardware Wizard

Building Operation SLink Sensor Object Type

Comments

Controller Configuration
Page

Sensor object

Supports the temperature,
humidity, pushbutton
override, and emergency
heat properties of the S-Link
sensor. When you select an
S-Link sensor in the
Hardware Wizard, a Sensor
object is created in Building
Operation.

Display Tab

Display1 to Display4
sensor points

For more information, see
section 72.43 “Sensor
Object Properties – Basic
Tab” on page 2538.

For more information, see
section 72.40 “Display
Properties – Basic Tab” on
page 2533.

Supports the monitored
values you can display at the
LCD screen of the S-Link
sensor that is connected to
the MNL device. Each
monitored value you
configure in the Hardware
Wizard results in a
corresponding Display SLink sensor point in Building
Operation.
The name of the Display SLink sensor point in
WorkStation matches the
monitor name entered in the
Hardware Wizard.

Fan1 Tab

FanMode1 sensor point
For more information, see
section 72.34 “FanMode1
and FanMode2 Properties –
Basic Tab” on page 2525.

Supports the ability to
monitor and control a fan
directly from the S-Link
sensor. When you use the
Fan1 tab of the Hardware
Wizard in WorkPlace Tech
Editor to enable Fan1, a
FanMode1 S-Link sensor
point is created in Building
Operation.
The name of the FanMode1
S-Link sensor point in
WorkStation is always
FanMode1, even though
the name of the Fan1 sensor
tag can be edited in the
Hardware Wizard.
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Continued
WorkPlace Tech Editor
Hardware Wizard

Building Operation SLink Sensor Object Type

Comments

Fan2 Tab

FanMode2 sensor point

Supports the ability to
monitor and control a
second fan directly from the
S-Link sensor. When you
use the Fan2 tab of the
Hardware Wizard in
WorkPlace Tech Editor to
enable Fan2, a FanMode2
S-Link sensor point is
created in Building
Operation.

For more information, see
section 72.34 “FanMode1
and FanMode2 Properties –
Basic Tab” on page 2525.

The name of the FanMode2
S-Link sensor point in
WorkStation is always
FanMode2, even though
the name of the Fan2 sensor
tag can be edited in the
Hardware Wizard.
If you enable Fan2 in the
Hardware Wizard, make sure
you also enable Fan1. If you
enable Fan2 but not Fan1,
no FanMode S-Link sensor
points are created in Building
Operation.
Mode1 Tab

HvacMode1 sensor point
For more information, see
section 72.36 “HvacMode1
and HvacMode2
Properties – Basic Tab” on
page 2527.

Supports the first mode you
can access at the S-Link
sensor, by which you can
monitor and control the
heating and cooling modes
of a system. When you
use the Mode1 tab of the
Hardware Wizard to enable
(HVAC) Mode1, an
HvacMode1 S-Link sensor
point is created in Building
Operation.
The name of the
HvacMode1 S-Link sensor
point in WorkStation is
always HvacMode1, even
though the name of the
HVAC Mode1 sensor tag can
be edited in the Hardware
Wizard.
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Continued
WorkPlace Tech Editor
Hardware Wizard

Building Operation SLink Sensor Object Type

Comments

Mode2 Tab

HvacMode2 sensor point

Supports the second mode
you can access at the S-Link
sensor, by which you can
monitor and control the
heating and cooling modes
of a system. When you
use the Mode1 tab of the
Hardware Wizard to enable
(HVAC) Mode1, an
HvacMode1 S-Link sensor
point is created in Building
Operation.

For more information, see
section 72.36 “HvacMode1
and HvacMode2
Properties – Basic Tab” on
page 2527.

The name of the
HvacMode2 S-Link sensor
point in WorkStation is
always HvacMode2, even
though the name of the
HVAC Mode2 sensor tag can
be edited in the Hardware
Wizard.
If you enable Mode 2 in the
Hardware Wizard, make sure
you also enable Mode 1. If
you enable Mode 2 but not
Mode 1, no HvacMode SLink sensor points are
created in Building
Operation.
Setpoint Tab

Setpoint1 to Setpoint4
sensor points
For more information, see
section 72.38 “Setpoint
Properties – Basic Tab” on
page 2529.

Supports the setpoints you
can access at the S-Link
sensor that is connected to
the MNL device. Each
setpoint you configure in the
Hardware Wizard results in a
corresponding Setpoint SLink sensor point in Building
Operation.
The name of the Setpoint
S-Link sensor point in
WorkStation matches the
setpoint name entered in the
Hardware Wizard.
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71.4

Calibrating S-Link Sensors
You calibrate an S-Link sensor's offset values to adjust for sensor measurement
errors.

To calibrate S-Link sensors
1. In WorkStation, in the System Tree pane, select the MNL LonWorks device.
2. Click the Advanced tab.
3. In the Temperature offset box, enter a value to calibrate the temperature
reading of the S-Link sensor.
4. In the Humidity offset box, enter a value to calibrate the humidity reading of
the S-Link sensor.

You can now download the configuration properties to the device. For more
information, see section 69.5 “Downloading Configuration Properties to an MNL
LonWorks Device” on page 2381.
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71.5

Backing Up S-Link Sensor Offsets
You back up S-Link sensor offsets from MNL LonWorks devices to copy the values
into the Building Operation database for future reference.

To back up S-Link sensor offsets
1. In WorkStation, in the System Tree pane, select the MNL LonWorks device
you want to back up.
2. On the Actions menu, point to MNL and then click Backup S-Link
offsets.
The S-Link sensor offsets are now backed up in the properties of the MNL device
object, so that they can be restored to the MNL device when needed. For more
information, see section 71.6 “Restoring S-Link Sensor Offsets” on page 2431.
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71.6

Restoring S-Link Sensor Offsets
You restore S-Link sensor offsets to an MNL LonWorks device to load that device
with S-Link sensor offsets from a previous backup.

To restore S-Link sensor offsets
1. In WorkStation, in the System Tree pane, select the MNL device that you
want to restore S-Link sensor offsets to.
2. On the Actions menu, point to MNL and then click Restore S-Link
offsets.
The S-Link sensor offsets are now restored to the MNL device.
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71.7

Properties of MNL LonWorks Objects
You configure the properties of various MNL LonWorks objects to set or change the
behavior of these objects.

71.7.1

NCI Values
In Building Operation, NCI objects represent NCIs in an MNL LonWorks device.
Initial NCI values are defined in an MNL device's WorkPlace Tech Editor application,
and the current values are stored in Building Operation NCI objects.
For more information, see section 71.8 “NCI Values” on page 2434.

71.7.2

Forceable I/O Point Properties
In WorkStation, when you want to perform an override, you force the value of an I/O
point property.
For more information, see section 71.10 “Forceable MNL I/O Point Properties” on
page 2436.

71.7.3

Not Active (NA) Property Values
In WorkPlace Tech, undefined data is represented as a special NA, or not active,
value.
For more information, see section 71.12 “Not Active (NA) Property Values” on page
2445.

71.7.4

Not Active (NA) SNVT Values For MNL
LonWorks Devices
SNVTs in MNL LonWorks devices have LonMark or MNL defined invalid values.
Some MNL SNVTs have LonMark defined invalid values. However, SNVTs without
LonMark defined invalid values have alternate invalid values defined for MNL
devices. When an NVI or NCI in an MNL device receives its LonMark or MNL
defined invalid value, the output of the SNVT in MNL device is set to NA depending
on the configuration of the SNVT in the MNL device's application. When the input of
an NVO in an MNL device is NA, the NVO sends the defined invalid value when
bound or polled depending on the configuration of the NVO in the MNL device's
application.
For more information, see section 71.13 “Not Active (NA) SNVT Values For MNL
LonWorks Devices” on page 2446.

71.7.5

Point Object Name
Each I/O point or S-Link sensor point has an Object Name property.
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For more information, see section 71.14 “Point Object Name” on page 2453.

71.7.6

Flow Balance Calibration Information
You flow balance a terminal box that is controlled by an MNL LonWorks VAV
device, using the MicroNet VAV Flow Balance software (MNL-FLOW-BAL). After
you flow balance the terminal box, you back up the calibration information from the
MNL device into Building Operation.
For more information, see section 71.15 “Flow Balance Calibration Information” on
page 2454.

71.7.7

Enumerations for FanModes
The Value property of a FanMode1 or FanMode2 S-Link sensor point is an
enumeration.
For more information, see section 71.18 “Enumerations for FanModes” on page
2458.

71.7.8

Enumerations for HvacModes
The Value property of an HvacMode1 or HvacMode2 S-Link sensor point is an
enumeration.
For more information, see section 71.19 “Enumerations for HvacModes” on page
2459.

04-16006-04-en, March 2015

Technical
2435

71 MNL LonWorks Objects
71.8 NCI Values

71.8

NCI Values
In Building Operation, NCI objects represent NCIs in an MNL LonWorks device.
Initial NCI values are defined in an MNL device's WorkPlace Tech Editor application,
and the current values are stored in Building Operation NCI objects.
In Building Operation, MNL devices use flags to indicate which NCI values will be
downloaded with the application:
• The NCI values from the NCI objects in WorkStation (flag set)
• The NCI values from the WorkPlace Tech application (flag not set)
At the time an application is downloaded, the system examines the flag of each NCI
object to determine whether or not the flag has been set, and then downloads the
appropriate NCI values. In the System Tree pane, you can see the status of an
NCI object.
For more information, see section 72.48 “MNL LonWorks System Tree Icons” on
page 2547.
For more information, see section 70.13 “Downloading an MNL LonWorks
Application Type” on page 2413.
When a device is first created in WorkStation, all its NCI flags are clear (not set).
If you are connected to a server and use the Properties pane in WorkStation to
modify the value of an NCI object, the corresponding NCI value is updated, in both
the MNL device and in the database, and the NCI object’s flag is set. Because the
flag is set, any future downloads will also use the NCI value from the object in the
database.

Note
If you modify an NCI value and then decide that you want to revert to the value
from the MNL application, you can use the Revert to application value
command.
For more information, see section 71.9 “Reverting to the Application Value for NCI
Downloads” on page 2435.

Flow Balance NCIs
One use of NCIs in Building Operation is to contain the flow balance calibration
values in MNL VAV devices. Whenever flow balance information is uploaded from,
or downloaded to, the device, the flag of each flow balance NCI object is set so that
subsequent application downloads will use the values from the flow balance NCI
objects.
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71.9

Reverting to the Application Value for
NCI Downloads
You use an NCI value from the device application when downloading the device
configuration (NCI values) to the MNL LonWorks device. This can be useful if you
set an NCI value and then decide that you want to revert to the value from the MNL
application instead.
For more information, see section 71.8 “NCI Values” on page 2434.

To revert to the application value for NCI downloads
1. In WorkStation, in the System Tree pane, select the NCI.
2. On the Actions menu, click Revert to application value.
3. In the System Tree pane, select the MNL device that contains the NCI.
4. On the Actions menu, point to MNL and then click Download application.
The NCI value in the MNL device is updated to use the value from the application,
and future downloads will use the NCI value from the MNL application.
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71.10

Forceable MNL I/O Point Properties
In WorkStation, when you want to perform an override, you force the value of an I/O
point property.
Forcing the value disables the input or output point from receiving values from either
the MNL LonWorks device or the WorkPlace Tech application.

71.10.1

Forceable MNL I/O Points
The following MNL input and output points allow their values to be forced.
Table: Forceable MNL I/O Points

71.10.2

Input Points

Output Points

AnalogInM

AnalogOut

AnalogInR

AnalogOutPri

AnalogInTC

BinaryOut

AnalogInTF

EventInd

AnalogInV

PWMMin

BinaryIn

PWMSec

BinaryInPls

PWMPriMin

PressureTransInH20

PWMPriSec

PressureTransPa

Sensor (Temperature)

Forced and Unforced Value Properties
Each I/O point has a Value output property that reflects the current value of that
point. In I/O points that support the force feature, you can view the forced value as
well as the unforced value.

Important
Secondary protection that is part of an output object, such as Minimum On Time,
is overridden when forcing values.
For more information, see the Forced Values topic on WebHelp.

Value Property
The Value property displays the current value associated with the I/O point. This
will either be the calculated value based on the application, or the forced value if it is
currently in a forced state.
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Unforced Value Property
The Unforced value property displays the value that the system will return to
when the force condition is removed. When not in a force condition, the displayed
value is the last known value that was received.
For more information, see the Viewing an Unforced Value topic on WebHelp.

Important
When you force the Value property of certain input I/O points, the Unforced
value property indicates "32768" (NA) rather than the actual unforced value. This
applies to the following I/O points:
• AnalogIn series
• BinaryIn
• BinaryInPls
• DUI
• PressureTransInH20
• PressureTransPa

71.10.3

Displayed Value of Forced MNL I/O Point
In Building Operation, the value of the Value property of an MNL I/O point, whether
forced or unforced, is displayed in three places:
• The I/O pont's Basic property tab
• WorkPlace Tech Monitor, on the MNL application drawing itself, where a
monitor tag is connected to the object's output
• The Watch pane, when you drag the Value there from the property page
The displayed value in these three places can either agree or disagree, depending
on whether the I/O point is associated with an MNL input object or MNL output
object, and whether the value is forced or unforced.
For more information, see section 71.11 “Displayed Value of Forced MNL I/O Point”
on page 2439.

71.10.4

Pocket I/A Software and Overrides
The use of TAC I/A Series Pocket I/A software with Building Operation is not
recommended. Pocket I/A is designed to be installed on a handheld PC and used
onsite to perform various monitoring and maintenance tasks on MNL LonWorks
devices. Although it is possible to connect Pocket I/A to an MNL device that is part
of a Building Operation system, using Pocket I/A to apply or clear overrides to the
MNL device can result in operational problems in Building Operation.

Warning
Avoid using TAC I/A Series Pocket I/A to clear an override that was set from
within Building Operation. Such overrides are often set to calibrate or diagnose
equipment operation. Clearing the override using Pocket I/A could unintentionally
restore normal operation, resulting in damage to the equipment.
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Note
When you set or clear overrides with TAC I/A Series Pocket I/A, it may take one
minute or longer for the override status icon in WorkStation to update. To avoid
confusion over the actual status of the override, use WorkStation, not Pocket I/A,
to perform overrides.
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71.11

Displayed Value of Forced MNL I/O
Point
In Building Operation, the value of the Value property of an MNL I/O point, whether
forced or unforced, is displayed in three places:
• The I/O pont's Basic property tab
• WorkPlace Tech Monitor, on the MNL application drawing itself, where a
monitor tag is connected to the object's output
• The Watch pane, when you drag the Value there from the property page
The displayed value in these three places can either agree or disagree, depending
on whether the I/O point is associated with an MNL input object or MNL output
object, and whether the value is forced or unforced.
The display of MNL I/O point values is dependent on the sources from which those
values are obtained. Overrides of MNL devices are performed by forcing the I/O
point at the hardware level, through the use of a hardware input tag or hardware
output tag on the MNL application drawing. In the case of MNL input objects, the
I/O hardware input tag is connected to the input of the MNL input object, which
allows the override to be seen by that object. In the case of an MNL output object,
the hardware output tag is connected to the output of the object, and so the object
has no awareness of the forced condition.

71.11.1

Display of Forced MNL Input Object Value
In WorkStation, forcing the Value of an I/O point associated with an MNL input
object acts on a hardware input tag connected to the object's input, so that the
object processes the input and then provides an output. When you force this type
of input value, the displayed value is the same when viewed in these three places:
• On the I/O point's Basic property tab
• At the input object's output, as displayed on a monitor tag connected to this
output on the application drawing
• In the Watch pane, when you drag the Value there from the property page
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Figure: Forced Value in MNL Input Object – All Displayed Values Are the Same

Important
When you force the Value property of an input object in WorkStation, the
displayed value on the Basic tab may revert to the previous value, even though
the Value output in the application updates correctly. This behavior is limited to
the displayed value on the Basic tab. To display the current forced value on the
Basic tab, refresh the display.
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71.11.2

Display of Unforced and Forced MNL Output
Object Value
In WorkStation, forcing the Value property of an I/O point associated with an MNL
output object acts directly on the object's output side, at a hardware output tag
connected to the object's hardware output. Because the forcing action is applied at
the hardware output, and not the object's Output property, the forced value
bypasses the processing normally performed by the object.

When Value Property is Unforced
When the Value property of an I/O point is unforced, the values displayed on the
Basic property tab, in the application drawing, and in the Watch pane are all in
agreement.
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Figure: Unforced Value in MNL Output Object – All Displayed Values Are the Same

When Value Property is Forced
When the Value property is forced, some of the displayed values no longer agree,
as seen on the I/O point's Basic property tab, in the application drawing, and in the
Watch pane:
• In the Watch pane, the displayed value of the I/O point is the same as the
forced value displayed on the I/O point's Basic property tab
• In the Watch pane, the displayed value of the SNVT object attached to the
Output of the I/O point object is different from the forced value displayed on
the I/O point's Basic property tab
Technical
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• On the application drawing, the value at the output object's Output property,
as displayed on a monitor tag connected to this output, is different from the
forced value displayed on the I/O point's Basic property tab

Figure: Forced Value in MNL Output Object – Output Property Displayed Value Is Different
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Note
To avoid the inconsistent display values for forced MNL output objects, alter the
application so that it is not dependent on the Output property, alone, for passing
the value to other logic or points. After making changes to the application, save
the changes and then download the application to the MNL device.
For more information, see section 70.14 “Editing an MNL LonWorks Application
Type in a Device” on page 2414.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745) for
a procedure detailing how to edit an application that is assigned to MNL-800
LonWorks devices.
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71.12

Not Active (NA) Property Values
In WorkPlace Tech, undefined data is represented as a special NA, or not active,
value.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
In an MNL LonWorks device within Building Operation, certain properties use
designated values to signify NA. Such properties can be identified by a tool tip that
appears when you hover your mouse pointer over them. This tool tip displays the
property’s designated value for NA:
• A value of 32768 represents NA: Used with properties that have no units (either
configurable or nonconfigurable), as well as the units %, %RH, minutes,
seconds, mA, Ω (ohms), and volts.
• A value greater than 16383 represents NA: Used with properties having the
units ft3/min (CFM), liters/sec, in. H2O, Pa, °C, or °F.
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71.13

Not Active (NA) SNVT Values For MNL
LonWorks Devices
SNVTs in MNL LonWorks devices have LonMark or MNL defined invalid values.
Some MNL SNVTs have LonMark defined invalid values. However, SNVTs without
LonMark defined invalid values have alternate invalid values defined for MNL
devices. When an NVI or NCI in an MNL device receives its LonMark or MNL
defined invalid value, the output of the SNVT in MNL device is set to NA depending
on the configuration of the SNVT in the MNL device's application. When the input of
an NVO in an MNL device is NA, the NVO sends the defined invalid value when
bound or polled depending on the configuration of the NVO in the MNL device's
application.
The table below gives invalid values in US customary and SI units of measure. Use
these values when you want to set the output of an NVI or NCI to NA in an MNL
device. When setting the value using WorkStation, the value to use (US or SI)
depends on the units system of the PC that WorkStation is running on. When
setting the value using a binding from an output of a program object, the value to
use depends on the engineering unit configuration of the bound property of the
program object.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
The table lists the SNVT types in alphabetical order.
Table: Not Active (NA) SNVT Values for MNL LonWorks Devices
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_amp

Electric current

3276.68 A

3276.68 A

SNVT_amp_ac

Amperage in
alternating current

65535 A

65535 A

SNVT_amp_f

Electric current

2.00E+38 A

2.00E+38 A

SNVT_amp_mil

Electric current

3276.69 mA

3276.69 mA

SNVT_angle

Angular distance

3754.879 deg

65.535 rad

SNVT_angle_deg

Angular distance

655.34 deg

655.34 deg

SNVT_angle_f

Angular distance

1.90E+40 deg

2.00E+38 rad

SNVT_angle_vel

Angular velocity

3276.69 rad/s

3276.69 rad/s

SNVT_angle _vel_f

Angular velocity

2.00E+38 rad/s

2.00E+38 rad/s

SNVT_area

Area

20315.89 feet2

13.107 m2

SNVT_btu_f

Thermal energy

1.99E+38 Btu

2.10E+41 J

SNVT_btu_kilo

Thermal energy

65535 kBtu

69143085324.31 J

SNVT_btu_mega

Thermal energy

65535 kBtu

69,143,085,324,309
J
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_char_ascii

ASCII character

Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Alarm flag

Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Chiller-water-flow
flag

Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Condenser-waterflow flag

Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Limited-condition flag Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Locally-controlled
flag

Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Run-enabled flag

Not possible to set to Not possible to set to
NA
NA

SNVT_chlr_status

Chiller operating
mode

HVAC_NULL

HVAC_NULL

SNVT_chlr_status

Chiller run mode

CHLR_NULL

CHLR_NULL

SNVT_config_scr

Configuration source

CFG_NUL (255)

CFG_NUL (255)

SNVT_count

Absolute count

65535

65535

SNVT_count_f

Absolute count

2.00E+38

2.00E+38

SNVT_count_inc

Increment count

32767

32767

SNVT_count_inc_f

Increment count

2.00E+38

2.00E+38

SNVT_date_day

Day of week

DAY_NUL

DAY_NUL

SNVT_defr_mode

Defrost mode

DFM_NUL

DFM_NUL

SNVT_defr_state

Defrost state

DFS_NUL

DFS_NUL

SNVT_defr_term

Defrost termination

DFT_NUL

DFT_NUL

SNVT_density

Density

1.1838 lb/in3

32767.5 kg/m3

SNVT_density_f

Density

1.22E+34 lb/in3

2.00E+38 kg/m3

SNVT_elapsed_tm

Day

65535 days

65535 days

SNVT_elapsed_tm

Hour

NA if Days is NA.

NA if Days is NA.

SNVT_elapsed_tm

Millisecond

NA if Days is NA.

NA if Days is NA.

SNVT_elapsed_tm

Minute

NA if Days is NA.

NA if Days is NA.
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_elapsed_tm

Second

NA if Days is NA.

NA if Days is NA.

SNVT_elec_kwh

Electric energy

65535 kWh

65535 kWh

SNVT_elec_whr

Electric energy

6553.5 Wh

6553.5 Wh

SNVT_elec_whr_f

Electric energy

2.00E+38 Wh

2.00E+38 Wh

SNVT_evap_state

Evaporator state

EVAP_NUL

EVAP_NUL

SNVT_flow

Flow volume

138860.801015545
ft3/min

65535 l/s

SNVT_flow_f

Flow volume

4.2.00E+38 ft3/min

2.00E+38 l/s

SNVT_flow_mil

Flow volume

138.860801015545
ft3/min

65535 ml/s

SNVT_freq_f

Frequency

2.00E+38 Hz

2.00E+38 Hz

SNVT_freq_hz

Frequency

6553.5 Hz

6553.5 Hz

SNVT_freq_kilohz

Frequency

6553.5 kHz

6553.5 kHz

SNVT_freq_milhz

Frequency

6553.5 kHz

6553.5 kHz

SNVT_grammage

Grammag

6553.5 g/m2

6553.5 g/m2

SNVT_grammage_f

Grammag

2.00E+38 g/m2

2.00E+38 g/m2

SNVT_hvac_emerg

HVAC emergency
mode

EMERG_NUL

EMERG_NUL

SNVT_havc_mode

HVAC mode

HVAC_NUL

HVAC_NUL

SNVT_hvac_overid

Flow

138860.801015545
ft3/min

65535 l/s

SNVT_hvac_overid

State

HVO_NUL

HVO_NUL

SNVT_hvac_overid

Percent

163.83 %

163.83 %

SNVT_hvac_status

Cooling output

163.835 %

163.835 %

SNVT_hvac_status

Economizer output

163.835 %

163.835 %

SNVT_hvac_status

Fan output

163.835 %

163.835 %

SNVT_hvac_status

HVAC status mode

HVAC_NUL (255)

HVAC_NUL (255)

SNVT_hvac_status

Alarm state

255

255

SNVT_hvac_status

Primary heat output

163.835 %

163.835 %

SNVT_hvac_status

Secondary heat
output

163.835 %

163.835 %
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_hvac_type

HVAC unit type

HVT_NUL

HVT_NUL

SNVT_length

Length

21500.9 ft

6553.5 m

SNVT_length_f

Length

6.50E+38 ft

2.00E+38 m

SNVT_length_kilo

Length

21500984 ft

6553.5 km

SNVT_length_micr

Length

0.0215009 ft

6553.5 um

SNVT_length_mil

Length

21.5009 ft

6553.5 mm

SNVT_lev_cont

Continuous level

Not possible to set to Not possible to set to
NA
NA

SNVT_lev_cont_f

Continuous level

Not possible to set to Not possible to set to
NA
NA

SNVT_lev_disc

Percentage level

ST_NUL

ST_NUL

SNVT_lev_percent

Level percent

163.835 %

163.835 %

SNVT_lux

Illumination

65535 lux

65535 lux

SNVT_mass

Mass

14.4479 lb

6553.5 g

SNVT_mass_f

Mass

4.4E+35 lb

2.00E+38 g

SNVT_mass_kilo

Mass

14447.9 lb

6553.5 kg

SNVT_mass_mega

Mass

14447994 lb

6553.5 Mg

SNVT_mass_mil

Mass

0.0144479 lb

6553.5 mg

SNVT_muldiv

Divisor

65535

65535

SNVT_muldiv

Multiplier

65535

65535

SNVT_multiplier

Multiplier

32.767501

32.767501

SNVT_occupancy

Occupancy

OC_NULL

OC_NULL

SNVT_override

Override code

OV_NULL

OV_NULL

SNVT_ph

Acidity

32.7669 pH

32.7669 pH

SNVT_ph_f

Acidity

2.00E+38 pH

2.00E+38 pH

SNVT_power

Power

6553.5 W

6553.5 W

SNVT_power_f

Power

2.00E+38 W

2.00E+38 W

SNVT_power_kilo

Power

6553.5 kW

6553.5 kW

SNVT_ppm

Concentration

65535 ppm

65535 ppm
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_ppm_f

Concentration

2.00E+38 ppm

2.00E+38 ppm

SNVT_press

Pressure (gauge)

475.24 psi

3276.69 kPa

SNVT_press_f

Pressure (gauge)

2.90E+34 psi

2.90E+34 pa

SNVT_press_p

Pressure (gauge)

4.75245157 psi

32767 Pa

SNVT_pwr_fact

Power factor

Not possible to set to Not possible to set to
NA
NA

SNVT_pwr_fact_f

Power factor

Not possible to set to Not possible to set to
NA
NA

SNVT_res

Electric resistance

6553.5 ohm

6553.5 ohm

SNVT_res_f

Electric resistance

2.00E+38 ohm

2.00E+38 ohm

SNVT_res_kilo

Electric resistance

6553500 ohm

6553.5 kohm

SNVT_rpm

Angular velocity

65535 RPM

65535 RPM

SNVT_smo_obscur

Smoke obscuration

65.535 %

65.535 %

SNVT_sound_db

Sound level

327.67 dB (SPL)

327.67 dB (SPL)

SNVT_sound_db_f

Sound level

2.00E+38 dB (SPL)

2.00E+38 dB (SPL)

SNVT_speed

Linear velocity

21500.9 ft/s

6553.5 m/s

SNVT_speed_f

Linear velocity

7.00E+38 ft/s

2.00e+38 m/s

SNVT_speed_mil

Linear velocity

215.009 ft/s

65.535 m/s

SNVT_state

State bit (all states)

Not possible to set to Not possible to set to
NA
NA

SNVT_switch

State

-1

SNVT_switch

Value

Not possible to set to Not possible to set to
NA
NA

SNVT_telcom

Telecomm states

TEL_NUL

TEL_NUL

SNVT_temp

Temperature

11335.1 deg F

6279.5 deg C

SNVT_temp_f

Temperature

4.00E+38

2.00E+38 deg C

SNVT_temp_p

Temperature

621.8 deg F

327.67 deg C

SNVT_temp_ror

Temperature

29490.3 deg F/min

16383.5 deg C/min

SNVT_temp_setpt

Occupied cooling
setpoint

621.8 deg F

327.67 deg C

-1
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_temp_setpt

Occupied heating
setpoint

621.8 deg F

327.67 deg C

SNVT_temp_setpt

Standby cooling
setpoint

621.8 deg F

327.67 deg C

SNVT_temp_setpt

Standby heating
setpoint

621.8 deg F

327.67 deg C

SNVT_temp_setpt

Unoccupied cooling
setpoint

621.8 deg F

327.67 deg C

SNVT_temp_setpt

Unoccupied heating
setpoint

621.8 deg F

327.67 deg C

SNVT_therm_mode

Thermostat mode

THERM_NUL

THERM_NUL

SNVT_time_f

Elapsed time

2.00E+38 s

2.00E+38 s

SNVT_time_hour

Elapsed time

65535 h

65535 h

SNVT_time_min

Elapsed time

65535 min

65535 min

SNVT_time_sec

Elapsed time

6553.5 s

6553.5 s

SNVT_tod_event

Occupancy, current

OC_NUL

OC_NUL

SNVT_tod_event

Occupancy, next

OC_NUL

OC_NUL

SNVT_tod_event

Time to next state

65535 min

65535 min

SNVT_turbidity

Turbidity

65.535 NTU

65.535 NTU

SNVT_turbidity_ f

Turbidity

2.00E+38 NTU

2.00E+38 NTU

SNVT_vol

Volume

399919 in3

6553.5 litre

SNVT_vol_f

Volume

1.2E+40 in3

2.00E+38 litre

SNVT_vol_kilo

Volume

399919106 in3

6553.5 klitre

SNVT_vol_mil

Volume

399.919 in3

6553.5 mlitre

SNVT_volt

Electric voltage

3276.69 V

3276.69 V

SNVT_volt_ac

Electric voltage

65535 V

65535 V

SNVT_volt_dbmv

Electric voltage

327.67 dBuV

327.67 dBuV

SNVT_volt_f

Electric voltage

2.00E+38 V

2.00E+38 V

SNVT_volt_kilo

Electric voltage

3276.69 kV

3276.69 kV

SNVT_volt_mil

Electric voltage

3276.69 mV

3276.69 mV

SNVT_zerospan

Span-factor

32.77

32.77
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SNVT Type

SNVT Element

US Customary
System Value

SI Value

SNVT_zerospan

Zero-term

163.835

163.835
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71.14

Point Object Name
Each I/O point or S-Link sensor point has an Object Name property.
A point object’s name in WorkStation is the same as the Object Name assigned in
WorkPlace Tech Editor. You must configure the Object Name in WorkPlace Tech
Editor because you cannot edit the object name from WorkStation.
WorkPlace Tech Tool 4.0 Engineering Guide (F-27254)
WorkPlace Tech Tool 4.0 Users Guide (F-27255)
When renaming I/O points and S-Link sensor points, be sure to consider the
following:
• The names of I/O points and S-Link sensor points cannot be changed in
WorkStation. Use WorkPlace Tech Editor to make these changes.
Building Operation WorkPlace Tech Editor and Monitor Engineering Guide
Supplement (F-27745)
• When you change the name of an I/O point or an S-Link sensor point, the
bindings are deleted and you need to recreate them.
For more information, see section 68.6 “Bindings for MNL LonWorks Devices”
on page 2370.
• Building Operation allows the use of certain special characters in the names of
MNL LonWorks point objects.
Building Operation WorkPlace Tech Editor and Monitor Engineering Guide
Supplement (F-27745), where you can find details on the characters allowed in
names of created and uploaded MNL LonWorks Objects
• When you revise the name of an I/O point or an S-Link sensor point in
WorkPlace Tech Editor and then save the application, this change is copied
from that application type to all the application objects created from that type.
For more information, see section 70.2 “Changes to Applications” on page
2394.
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71.15

Flow Balance Calibration Information
You flow balance a terminal box that is controlled by an MNL LonWorks VAV
device, using the MicroNet VAV Flow Balance software (MNL-FLOW-BAL). After
you flow balance the terminal box, you back up the calibration information from the
MNL device into Building Operation.
TAC I/A Series MicroNet VAV Flow Balance User’s Guide (F-26421)
For more information, see section 71.16 “Backing Up Flow Balance Calibration” on
page 2456.
In WorkStation, you can view an MNL VAV device’s flow balance information on the
Advanced tab, in the Flow Balance Information property group. You can also
view the time at which the last backup was completed, displayed as Last flow
balance backup time. For more information, see section 72.46 “MNL LonWorks
Device Properties – Advanced Tab” on page 2543.
You can write the backed up flow balance information to the MNL VAV device
whenever it becomes necessary to restore or replace the device. For more
information, see section 71.17 “Restoring Flow Balance Information” on page 2457.

71.15.1

Data Backups and Flow Balance NCIs
Six NCIs contain the flow balance calibration values in MNL VAV devices:
• nciHighFlowCal: The high flow calibration value, in liters/sec (ft3/min). This value
is the terminal box flow rate at a velocity pressure of 249 Pa (1.0 in. w.g.).
• nciLowFlowCal: The low flow calibration value, in liters/sec (ft3/min). This value
is the terminal box flow rate at a velocity pressure of 24.9 Pa (0.1 in. w.g.).
• nciRotation: The MNL VAV device’s direction of rotation to close or open the
terminal box damper.
• nciMaxFlow: The maximum flow setpoint, in liters/sec (ft3/min). This is the
maximum flow control point used by the MNL VAV device.
• nciMinFlow: The minimum flow setpoint, in liters/sec (ft3/min). This is the
minimum flow control point used by the MNL VAV device.
• nciMinFlowHeat: The heating minimum flow setpoint, in liters/sec (ft3/min). This
is the minimum flow control point used by the MNL VAV device during reheat
conditions.
When you perform a backup of flow balance calibration information from an MNL
VAV device, the preceding NCI values are copied to the Building Operation
database.

71.15.2

Data Restore
When you restore flow balance calibration information to an MNL VAV device,
Building Operation downloads the values from the Flow Balance Information
property group to the device.
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In WorkStation, you can view the time at which the last restore was performed,
displayed as Last flow balance restore time, part of the Flow Balance
Information property group on the MNL VAV device’s Advanced tab. For more
information, see section 72.46 “MNL LonWorks Device Properties – Advanced Tab”
on page 2543.

71.15.3

Flow Balance Data Backups
Once the flow balance information is backed up to the server database, it can be
included as part of Building Operation’s system backups.
For more information, see the Archiving Overview topic on WebHelp.
For more information, see section 8.1 “Backup and Restore Overview” on page
279.

71.15.4

Flow Balance Text Report
In WorkStation, you can use the text report, I/A Series Flow Balance Report, to view
flow balance information for an MNL VAV device.
For more information, see section 128.1 “Text Reports Overview” on page 5325.
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71.16

Backing Up Flow Balance Calibration
You back up flow balance information of MNL LonWorks VAV devices to copy the
values into the Building Operation database for future reference.

To back up flow balance calibration
1. Ensure that the MNL VAV device is flow balanced.
For more information, see section 71.15 “Flow Balance Calibration
Information” on page 2454.
2. In WorkStation, in the System Tree pane, select the VAV device.
3. On the Actions menu, point to MNL and then click Backup flow balance
information.
The flow balance information is now backed up into the Building Operation
database.
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71.17

Restoring Flow Balance Information
You restore flow balance information to an MNL LonWorks VAV device to load that
device with flow balance information from a previous backup. Restoring the flow
balance information is often sufficient to calibrate the replacement device, and in
cases where some additional calibration is needed, the restored data can be used
as a starting point.

To restore flow balance information
1. In WorkStation, in the System Tree pane, select the MNL VAV device.
2. On the Actions menu, point to MNL and then click Restore flow balance
information.
The flow balance values are now written to the MNL VAV device.
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71.18

Enumerations for FanModes
The Value property of a FanMode1 or FanMode2 S-Link sensor point is an
enumeration.
For each enumeration, text that describes the status of the point is displayed in
WorkStation. Each textual enumeration name has a corresponding numeric
enumeration value.
Table: Numeric Values and Textual Names of Enumerations
Textual Name

Numeric Value

Auto

1

Off

100

On

101

Low

133

Medium

166

High

200

You can use these numeric values in other Building Operation applications such as
graphics, script programs, and function block programs.
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71.19

Enumerations for HvacModes
The Value property of an HvacMode1 or HvacMode2 S-Link sensor point is an
enumeration.
For each enumeration, text that describes the status of the point is displayed in
WorkStation. Each textual enumeration name has a corresponding numeric
enumeration value.
Table: Numeric Values and Textual Names of Enumerations
Textual Name

Numeric Value

Auto

0

Heat

1

Cool

3

Off

6

You can use these numeric values in other Building Operation applications such as
graphics, script programs, and function block programs.
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72

MNL LonWorks User Interface

Topics
Properties of I/O Points, Sensor Object, and S-Link Sensor
Points – Basic Tab
Properties of I/O Points, Sensor Object, and S-Link Sensor
Points – Advanced Tab
AnalogIn Properties – Basic Tab
AnalogInM and AnalogInV Properties – Advanced Tab
AnalogInR Properties – Advanced Tab
AnalogInTC and AnalogInTF Properties – Advanced Tab
AnalogOut and AnalogOutPri Properties – Basic Tab
AnalogOut and AnalogOutPri Properties – Advanced Tab
BinaryIn Properties – Basic Tab
BinaryIn Properties – Advanced Tab
BinaryInPls Properties – Basic Tab
BinaryInPls Properties – Advanced Tab
BinaryOut Properties – Basic Tab
BinaryOut Properties – Advanced Tab
DUI Properties – Basic Tab
DUI Properties – Advanced Tab
EventInd Properties – Basic Tab
EventInd Properties – Advanced Tab

FanSpeed1 Properties – Basic Tab
FanSpeed1 Properties – Advanced Tab
FanSpeed2 Properties – Basic Tab
FanSpeed2 and FanSpeed3 Properties – Advanced Tab
FanSpeed3 Properties – Basic Tab
FloatingAct and FloatingActPri Properties – Basic Tab
FloatingAct and FloatingActPri Properties – Advanced Tab
MomenSS Properties – Basic Tab
MomenSS Properties – Advanced Tab
PressureTransInH20 and PressureTransPa Properties –
Basic Tab
PressureTransInH20 and PressureTransPa Properties –
Advanced Tab
PWMMin, PWMPriMin, PWMSec, and PWMPriSec
Properties – Basic Tab
PWMMin, PWMPriMin, PWMSec, and PWMPriSec
Properties – Advanced Tab
VAVActuator Properties – Basic Tab
VAVActuator Properties – Advanced Tab
FanMode1 and FanMode2 Properties – Basic Tab
FanMode1 and FanMode2 Properties – Advanced Tab
HvacMode1 and HvacMode2 Properties – Basic Tab
HvacMode1 and HvacMode2 Properties – Advanced Tab
Setpoint Properties – Basic Tab
Setpoint Properties – Advanced Tab
Display Properties – Basic Tab
Applications View
Assign Application Wizard - Naming the Object Page
Sensor Object Properties – Basic Tab
Sensor Object Properties – Advanced Tab

MNL Device Application Properties – Basic Tab
MNL LonWorks Device Properties – Advanced Tab
Actions Menu – MNL Submenu
MNL LonWorks System Tree Icons

72 MNL LonWorks User Interface
72.1 Properties of I/O Points, Sensor Object, and S-Link Sensor Points – Basic Tab

72.1

Properties of I/O Points, Sensor Object,
and S-Link Sensor Points – Basic Tab
Use the Basic tab to view and edit basic information about I/O points, the Sensor
object, and S-Link sensor points.
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72.2

Properties of I/O Points, Sensor Object,
and S-Link Sensor Points – Advanced
Tab
Use the Advanced tab to view or edit configuration properties associated with I/O
points, the Sensor object, and S-Link sensor points.
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72.3

AnalogIn Properties – Basic Tab
Use the Basic tab of an AnalogIn I/O point to view and edit basic information about
AnalogIn.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: AnalogIn properties – Basic tab

Table: AnalogIn Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Value

Enter an output value for the AnalogIn I/O
point.
Corresponds to the Output property of the
Analog Input object in WorkPlace Tech
Editor.
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Continued
Property

Description

Status

Displays the status of the AnalogIn I/O point.
Corresponds to the Status property of the
Analog Input object in WorkPlace Tech
Editor.
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72.4

AnalogInM and AnalogInV Properties –
Advanced Tab
Use the Advanced tab of the AnalogInM or AnalogInV I/O point to view or edit
configuration properties associated with AnalogInM or AnalogInV.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: AnalogInM and AnalogInV properties – Advanced tab

Table: AnalogInM and AnalogInV Properties – Advanced Tab
Property

Description

Input low value

Enter the input low value, where the Value
output equals the Scaled low value.
Corresponds to the Input Low Value
property of the Analog Input object in
WorkPlace Tech Editor.

Scaled low value

Enter the value you want the Value output
to have when the hardware input equals the
Input low value.
Corresponds to the Scaled Low Value
property of the Analog Input object in
WorkPlace Tech Editor.
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Continued
Property

Description

Input high value

Enter the input high value, where the Value
output equals the Scaled high value.
Corresponds to the Input High Value
property of the Analog Input object in
WorkPlace Tech Editor.

Scaled high value

Enter the value you want the Value output
to have when the hardware input equals the
Input high value.
Corresponds to the Scaled High Value
property of the Analog Input object in
WorkPlace Tech Editor.

Filter constant

Enter the filter constant or filter factor applied
to the input, where maximum filter is at 0.01
and minimum filter is at 0.99.
Corresponds to the Filter Constant property
of the Analog Input object in WorkPlace
Tech Editor.

Offset calibration

Enter the value to be added to or subtracted
from the calculated output value prior to
placing this value at the Value output.
Corresponds to the Offset property of the
Analog Input object in WorkPlace Tech
Editor.

Sensor type default

Displays the default sensor type connected
to the hardware.
Corresponds to the Input Sensor Type
property of the Analog Input object in
WorkPlace Tech Editor.
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Input low value default

Displays the default value for the Input low
value property.

Scaled low value default

Displays the default value for the Scaled
low value property.

Input high value default

Displays the default value for the Input high
value property.

Scaled high value default

Displays the default value for the Scaled
high value property.

Filter constant default

Displays the default value for the Filter
constant property.

Offset calibration default

Displays the default value for the Offset
calibration property.
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72.5

AnalogInR Properties – Advanced Tab
Use the Advanced tab of the AnalogInR I/O point to view or edit configuration
properties associated with AnalogInR.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: AnalogInR properties – Advanced tab

Table: AnalogInR Properties – Advanced Tab
Property

Description

Sensor type

Select the type of sensor that is connected
to the hardware.

Filter constant

Enter the filter constant or filter factor applied
to the input, where maximum filter is at 0.01
and minimum filter is at 0.99.
Corresponds to the Filter Constant property
of the Analog Input object in WorkPlace
Tech Editor.
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Continued
Property

Description

Offset calibration

Enter the resistance value to be added to or
subtracted from the calculated output value
prior to placing this value at the Value
output.
Corresponds to the Offset Value property of
the Analog Input object in WorkPlace Tech
Editor.

Sensor type default

Displays the default sensor type connected
to the hardware.
Corresponds to the Input Sensor Type
property of the Analog Input object in
WorkPlace Tech Editor.
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Filter constant default

Displays the default value for the Filter
constant property.

Offset calibration default

Displays the default value for the Offset
calibration property.
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72.6

AnalogInTC and AnalogInTF
Properties – Advanced Tab
Use the Advanced tab of the AnalogInTC or AnalogInTF I/O point to view or edit
configuration properties associated with AnalogInTC or AnalogInTF.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: AnalogInTC and AnalogInTF properties – Advanced tab

Table: AnalogInTC and AnalogInTF Properties – Advanced Tab
Property

Description

Sensor type

Select the type of sensor that is connected
to the hardware.

Filter constant

Enter the filter constant or filter factor applied
to the input, where maximum filter is at 0.01
and minimum filter is at 0.99.
Corresponds to the Filter Constant property
of the Analog Input object in WorkPlace
Tech Editor.
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Continued
Property

Description

Offset calibration

Enter the temperature value that is added to
or subtracted from the calculated output
value prior to placing this value at the Value
output.
Corresponds to the Offset property of the
Analog Input object in WorkPlace Tech
Editor.

Sensor type default

Displays the default sensor type connected
to the hardware.
Corresponds to the Input Sensor Type
property of the Analog Input object in
WorkPlace Tech Editor.
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Filter constant default

Displays the default value for the Filter
constant property.

Offset calibration default

Displays the default value for the Offset
calibration property.
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72.7

AnalogOut and AnalogOutPri
Properties – Basic Tab
Use the Basic tab of an AnalogOut or AnalogOutPri I/O point to view and edit basic
information about AnalogOut or AnalogOutPri.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: AnalogOut and AnalogOutPri properties – Basic tab

Table: AnalogOut and AnalogOutPri Properties – Basic Tab
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Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.
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Continued
Property

Description

Value

Enter the calculated output value. The
output value is a percentage of the input
range established by the Scaled low value
and Scaled high value.
Corresponds to the Output property of the
Analog Output or Analog Output Priority
object in WorkPlace Tech Editor.

Control level

Displays the priority input value.
Corresponds to the CtrlLvl property of the
Analog Output Priority object in WorkPlace
Tech Editor.
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72.8

AnalogOut and AnalogOutPri
Properties – Advanced Tab
Use the Advanced tab of the AnalogOut or AnalogOutPri I/O point to view or edit
configuration properties associated with AnalogOut or AnalogOutPri.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: AnalogOut and AnalogOutPri properties – Advanced tab

Table: AnalogOut and AnalogOutPri Properties – Advanced Tab
Property

Description

Output low value

Enter the hardware output current that is to
be produced when the input value equals
the Scaled low value.
Corresponds to the Output Low Value
property of the Analog Output or Analog
Output Priority object in WorkPlace Tech
Editor.

04-16006-04-en, March 2015

Technical
2479

72 MNL LonWorks User Interface
72.8 AnalogOut and AnalogOutPri Properties – Advanced Tab

Continued
Property

Description

Scaled low value

Enter the value you want the I/O point input
to be when the hardware output equals the
value assigned to the Output low value
(and the Value output equals 0.0 %).
Corresponds to the Scaled Low Value
property of the Analog Output or Analog
Output Priority object in WorkPlace Tech
Editor.

Output high value

Enter the hardware output current that is to
be produced when the input value equals
the Scaled high value.
Corresponds to the Output High Value
property of the Analog Output or Analog
Output Priority object in WorkPlace Tech
Editor.

Scaled high value

Enter the value you want the I/O point input
to be when the hardware output equals the
value assigned to the Output high value
(and the Value output equals 100.0 %).
Corresponds to the Scaled High Value
property of the Analog Output or Analog
Output Priority object in WorkPlace Tech
Editor.
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Output low value default

Displays the default value for the Output
low value property.

Scaled low value default

Displays the default value for the Scaled
low value property.

Output high value default

Displays the default value for the Output
high value property.

Scaled high value default

Displays the default value for the Scaled
high value property.
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72.9

BinaryIn Properties – Basic Tab
Use the Basic tab of a BinaryIn I/O point to view and edit basic information about
BinaryIn.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: BinaryIn properties – Basic tab

Table: BinaryIn Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Value

Displays the value at the point's output.
When forcing this value, select On.
Corresponds to the Output property of the
Binary Input object in WorkPlace Tech
Editor.
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Continued
Property

Description

Count

Displays the total status changes seen at the
hardware input.
Corresponds to the Count property of the
Binary Input object in WorkPlace Tech
Editor.
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72.10

BinaryIn Properties – Advanced Tab
Use the Advanced tab of a BinaryIn I/O point to view or edit configuration
properties associated with BinaryIn.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: BinaryIn properties – Advanced tab

Table: BinaryIn Properties – Advanced Tab
Property

Description

Binary action

Click the property box and then select
whether the type of contact or device that is
connected to the MNL device's hardware is
direct-acting or reverse-acting. This correctly
configures the condition at BinaryIn's Value
property.
Corresponds to the Binary Type property of
the Binary Input object in WorkPlace Tech
Editor.

04-16006-04-en, March 2015

Technical
2483

72 MNL LonWorks User Interface
72.10 BinaryIn Properties – Advanced Tab

Continued
Property

Description

Reset count

Click the property box and then select On to
enable the count. Off resets the count and
holds it at zero.
Corresponds to the Reset property of the
Binary Input object in WorkPlace Tech
Editor.
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Binary action default

Displays the default value for the Binary
action property.

Reset count default

Displays the default value for the Reset
count property.
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72.11

BinaryInPls Properties – Basic Tab
Use the Basic tab of a BinaryInPls I/O point to view and edit basic information
about BinaryInPls.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: BinaryInPls properties – Basic tab

Table: BinaryInPls Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Pulse rate

Displays the pulse rate value at output,
which is calculated as (Pulse constant) x
(pulses per second at input). When forcing
this value, enter a value for the pulse rate
output.
Corresponds to the Output property of the
Binary Input object in WorkPlace Tech Editor
(when configured for pulse input).
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Continued
Property

Description

Pulse count

Displays the total number of pulses detected
at the hardware input.
Corresponds to the Count property of the
Binary Input object (configured for pulse
input) in WorkPlace Tech Editor.
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72.12

BinaryInPls Properties – Advanced Tab
Use the Advanced tab of a BinaryInPls I/O point to view or edit configuration
properties associated with BinaryInPls.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: BinaryInPls properties – Advanced tab

Table: BinaryInPls Properties – Advanced Tab
Property

Description

Pulse constant

Enter the pulse scaling value used by the
pulse algorithm when calculating a pulsesper-second frequency Pulse rate value.
Corresponds to the Pulse property of the
Binary Input object in WorkPlace Tech Editor
(when configured for pulse input).
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Continued
Property

Description

Reset outputs

Click the property box and then select On to
cause both the Pulse rate and the Pulse
count outputs to be reset and held at zero.
Select Off to enable both Pulse rate and
the Pulse count outputs.
Corresponds to the Reset property of the
Binary Input object in WorkPlace Tech Editor
(when configured for pulse input).
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Pulse constant default

Displays the default value for the Pulse
constant property.

Reset outputs default

Displays the default value for the Reset
outputs property.
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72.13

BinaryOut Properties – Basic Tab
Use the Basic tab of a BinaryOut I/O point to view and edit basic information about
BinaryOut.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: BinaryOut properties – Basic tab

Table: BinaryOut Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Value

Select On to turn the device on when
Binary action is set to Direct.
Corresponds to the Ouptut property of the
Binary Output object in WorkPlace Tech
Editor.
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72.14

BinaryOut Properties – Advanced Tab
Use the Advanced tab of a BinaryOut I/O point to view or edit configuration
properties associated with BinaryOut.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: BinaryOut properties – Advanced tab

Table: BinaryOut Properties – Advanced Tab
Property

Description

Binary action

Click the property box and then select
Direct to send the monitored input value
directly to the output. Reverse sends the
inverse of the monitored input value to the
output.
Corresponds to the Binary Action property of
the Binary Output object in WorkPlace Tech
Editor.

Binary action default
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Displays the default value for the Binary
action property.

04-16006-04-en, March 2015

72 MNL LonWorks User Interface
72.15 DUI Properties – Basic Tab

72.15

DUI Properties – Basic Tab
Use the Basic tab of a DUI I/O point to view and edit basic information for DUI.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: DUI properties – Basic tab

Table: DUI Properties – Basic Tab
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Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Output 1

Displays the state of Input 1 on the R2R
resistor network.

Output 2

Displays the state of Input21 on the R2R
resistor network.

Output 3

Displays the state of Input31 on the R2R
resistor network.
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Continued

Technical
2492

Property

Description

Output 4

Displays the state of Input41 on the R2R
resistor network.

Output 5

Displays the state of Input51 on the R2R
resistor network.

Input status

Displays the status of the input.
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72.16

DUI Properties – Advanced Tab
Use the Advanced tab of a DUI I/O point to view or edit configuration properties
associated with DUI.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: DUI properties – Advanced tab

Table: DUI Properties – Advanced Tab
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Property

Description

Binary action 1

Click the property box and then select the
action for Output 1 (Basic tab).

Binary action 2

Click the property box and then select the
action for Output 2 (Basic tab).

Binary action 3

Click the property box and then select the
action for Output 3 (Basic tab).

Binary action 4

Click the property box and then select the
action for Output 4 (Basic tab).

Binary action 5

Click the property box and then select the
action for Output 5 (Basic tab).
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Continued

Technical
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Property

Description

Binary action 1 default

Displays the default selection for the Binary
action 1 property.

Binary action 2 default

Displays the default selection for the Binary
action 2 property.

Binary action 3 default

Displays the default selection for the Binary
action 3 property.

Binary action 4 default

Displays the default selection for the Binary
action 4 property.

Binary action 5 default

Displays the default selection for the Binary
action 5 property.
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72.17

EventInd Properties – Basic Tab
Use the Basic tab of an EventInd I/O point to view and edit basic information about
EventInd.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: EventInd properties – Basic tab

Table: EventInd Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Value

Select On to turn on the point's output
whenever the Input value is greater than 0
(zero) and an event indication sequence (flick
action) is not in progress.
Corresponds to the Output property of the
Event Indicator object in WorkPlace Tech
Editor.
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72.18

EventInd Properties – Advanced Tab
Use the Advanced tab of the EventInd I/O point to view or edit configuration
properties associated with EventInd.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: EventInd properties – Advanced tab

Table: EventInd Properties – Advanced Tab
Property

Description

Event time

Enter the value which, when matched at the
point's input, starts an event indication
sequence (flick action).
Corresponds to the Event Time property of
the Event Indicator object in WorkPlace Tech
Editor.

Event duration

Enter the time duration for the event
indication (flick action).
Corresponds to the Event Duration property
of the Event Indicator object in WorkPlace
Tech Editor.

Technical
2496

04-16006-04-en, March 2015

72 MNL LonWorks User Interface
72.18 EventInd Properties – Advanced Tab

Continued
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Property

Description

Event time default

Displays the default value for the Event
time property.

Event duration default

Displays the default value for the Event
duration property.
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72.19

FanSpeed1 Properties – Basic Tab
Use the Basic tab of a FanSpeed1 I/O point to view and edit basic information
about FanSpeed1.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FanSpeed1 properties – Basic tab

Table: FanSpeed1 Properties – Basic Tab

Technical
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Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Value

Displays On when the fan is operating.
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72.20

FanSpeed1 Properties – Advanced Tab
Use the Advanced tab of the FanSpeed1 I/O point to view or edit configuration
properties associated with FanSpeed1.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: Fanspeed1 properties – Advanced tab

Table: FanSpeed1 Properties – Advanced Tab
Property

Description

Minimum on time

Enter the minimum time that a digital output
remains on when that particular output or
speed is activated.
Corresponds to the Minimum On Time
property of the Fan Speed object in
WorkPlace Tech Editor.

Purge time

Enter the amount of time that an output
remains active after the algorithm sets all
outputs to Off or 0.0 %.
Corresponds to the Purge Time property of
the Fan Speed object in WorkPlace Tech
Editor.
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Continued

Technical
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Property

Description

Minimum on time default

Displays the default value for the Minimum
on time property.

Purge time default

Displays the default value for the Purge
time property.
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72.21

FanSpeed2 Properties – Basic Tab
Use the Basic tab of a FanSpeed2 I/O point to view and edit basic information
about FanSpeed2.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FanSpeed2 properties – Basic tab

Table: FanSpeed2 Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.
In the case of FanSpeed2, the hardware I/O
tag is attached to the Fan Speed object's
Physical Address High output.

Value
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Displays the operating mode of the fan.
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Continued
Property

Description

Low speed output

Displays Off when low speed operation is
inactive.
Corresponds to the Low Speed property of
the Fan Speed object in WorkPlace Tech
Editor.

High speed output

Displays On when high speed operation is
active.
Corresponds to the High Speed property of
the Fan Speed object in WorkPlace Tech
Editor.

Variable speed

Displays the calculated speed value.
Corresponds to the Variable Speed property
of the Fan Speed object in WorkPlace Tech
Editor.
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72.22

FanSpeed2 and FanSpeed3 Properties –
Advanced Tab
Use the Advanced tab of the FanSpeed2 or FanSpeed3 I/O point to view or edit
configuration properties associated with FanSpeed2 or FanSpeed3.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FanSpeed2 and FanSpeed3 properties – Advanced tab

Table: FanSpeed2 and FanSpeed3 Properties – Advanced Tab
Property

Description

Kick time

Enter a time greater than 1.0 to enable a kick
start (kick time) sequence. This time value
determines how long the kick sequence is in
effect.
Corresponds to the Kick Time property of
the Fan Speed object in WorkPlace Tech
Editor.
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Continued
Property

Description

Minimum on time

Enter the minimum time that a digital output
remains on when that particular output or
speed is activated.
Corresponds to the Minimum On Time
property of the Fan Speed object in
WorkPlace Tech Editor.

Purge time

Enter the amount of time that an output
remains active after the algorithm sets all
outputs to Off or 0.0 %.
Corresponds to the Purge Time property of
the Fan Speed object in WorkPlace Tech
Editor.
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Kick time default

Displays the default value for the Kick time
property.

Minimum on time default

Displays the default value for the Minimum
on time property.

Purge time default

Displays the default value for the Purge
time property.
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72.23

FanSpeed3 Properties – Basic Tab
Use the Basic tab of a FanSpeed3 I/O point to view and edit basic information
about FanSpeed3.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FanSpeed3 properties – Basic tab

Table: FanSpeed3 Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.
In the case of FanSpeed3, the hardware I/O
tag is attached to the Fan Speed object's
Physical Address High output.

Value
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Displays the operating mode of the fan.
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Continued
Property

Description

Low speed output

Displays the status of the output for low
speed operation.
Corresponds to the Low Speed property of
the Fan Speed object in WorkPlace Tech
Editor.

Medium speed output

Displays the status of the output for medium
speed operation.
Corresponds to the Medium Speed property
of the Fan Speed object in WorkPlace Tech
Editor.

High speed output

Displays the status of the output for high
speed operation.
Corresponds to the High Speed property of
the Fan Speed object in WorkPlace Tech
Editor.

Variable speed

Displays the calculated speed value.
Corresponds to the Variable Speed property
of the Fan Speed object in WorkPlace Tech
Editor.
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72.24

FloatingAct and FloatingActPri
Properties – Basic Tab
Use the Basic tab of a FloatingAct or FloatingActPri I/O point to view and edit basic
information about FloatingAct or FloatingActPri.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FloatingAct and FloatingActPri properties – Basic tab

Table: FloatingAct and FloatingActPri Properties – Basic Tab
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Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.
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Continued
Property

Description

Value

Displays the position of the floating actuator
as either a calculated position or the actual
value.
Corresponds to the Output property of the
Floating Actuator or Floating Actuator Priority
object in WorkPlace Tech Editor.

Control level

Displays the priority number of the currently
active input.
Corresponds to the Control Level property of
the Floating Actuator Priority object in
WorkPlace Tech Editor.

Drive open output

Displays On to indicate that the floating
actuator is actively driving towards the open
(100.0 %) position.
Corresponds to the Drive Open property of
the Floating Actuator Priority object in
WorkPlace Tech Editor.

Drive close output

Displays On to indicate that the floating
actuator is actively driving towards the
closed (0.0 %) position.
Corresponds to the Drive Close property of
the Floating Actuator Priority object in
WorkPlace Tech Editor.
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72.25

FloatingAct and FloatingActPri
Properties – Advanced Tab
Use the Advanced tab of a FloatingAct or FloatingActPri I/O point to view or edit
configuration properties associated with FloatingAct or FloatingActPri.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FloatingAct and FloatingActPri properties – Advanced tab

Table: FloatingAct and FloatingActPri Properties – Advanced Tab
Property

Description

Drift compensation enable

Select On to enable the drift compensation
function.
Corresponds to the Drift Compensation
Enable property of the Floating Actuator or
Floating Actuator Priority object in
WorkPlace Tech Editor.

Drive time

Enter the full stroke travel time of the
actuator.
Corresponds to the Drive Time property of
the Floating Actuator or Floating Actuator
Priority object in WorkPlace Tech Editor.
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Continued
Property

Description

Deadband

Enter the deadband range within which the
active output drive is not permitted.
Corresponds to the Deadband property of
the Floating Actuator or Floating Actuator
Priority object in WorkPlace Tech Editor.

Force open input

Select On to force the actuator to a full open
condition.
Corresponds to the Force Open property of
the Floating Actuator or Floating Actuator
Priority object in WorkPlace Tech Editor.

Force close input

Select On to force the actuator to a full
closed condition. The actuator is driven
closed for the full value of Drive time.
Corresponds to the Force Close property of
the Floating Actuator or Floating Actuator
Priority object in WorkPlace Tech Editor.
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Drive mode default

Displays the default value for the Drive
mode property.

Drift compensation enable default

Displays the default value for the Drift
compensation enable property.

Drive time default

Displays the default value for the Drive time
property.

Deadband default

Displays the default value for the Deadband
property.

Force open input default

Displays the default value for the Force
open input property.

Force close input default

Displays the default value for the Force
close input property.
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72.26

MomenSS Properties – Basic Tab
Use the Basic tab of a MomenSS I/O point to view and edit basic information
about MomenSS.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: MomenSS properties – Basic tab

Table: MomenSS Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Value

Displays the operating mode of the start or
stop pulse for motor control, or the on or off
pulse for some other use.
Corresponds to the Input property of the
Momentary Start/Stop object in WorkPlace
Tech Editor.
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Continued
Property

Description

Start output

Display changes from Off to On to indicate
that the start pulse sequence has begun.
This property remains On for the duration of
the start pulse sequence, as defined by
Start pulse duration, and then returns to
Off.
Corresponds to the Output Start property of
the Momentary Start/Stop object in
WorkPlace Tech Editor.

Stop output

Display changes from Off to On to indicate
that the stop pulse sequence has begun.
This property remains On for the duration of
the stop pulse sequence, as defined by
Stop pulse duration, and then returns to
Off.
Corresponds to the Output Stop property of
the Momentary Start/Stop object in
WorkPlace Tech Editor.
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72.27

MomenSS Properties – Advanced Tab
Use the Advanced tab of a MomenSS I/O point to view or edit configuration
properties associated with MomenSS.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: MomenSS properties – Advanced tab

Table: MomenSS Properties – Advanced Tab
Property

Description

Start pulse duration

Enter the On pulse duration for a start pulse
sequence.
Corresponds to the On Pulse property of the
Momentary Start/Stop object in WorkPlace
Tech Editor.

Stop pulse duration

Enter the Off pulse duration for a stop pulse
sequence.
Corresponds to the Off Pulse property of the
Momentary Start/Stop object in WorkPlace
Tech Editor.

Start pulse duration default
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Displays the default value for the Start
pulse duration property.
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Continued
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Property

Description

Stop pulse duration default

Displays the default value for the Stop
pulse duration property.
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72.28

PressureTransInH20 and
PressureTransPa Properties – Basic Tab
Use the Basic tab of a PressureTransInH20 or PressureTransPa I/O point to view
and edit basic information about PressureTransInH20 and PressureTransPa.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: PressureTransInH20 and PressureTransPa properties – Basic tab

Table: PressureTransInH20 and PressureTransPa Properties – Basic Tab
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Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.
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Continued
Property

Description

Value

Enter the output flow value. The output flow
value is based on the Velocity pressure
and flow rate values at the High flow
calibration and Low flow calibration
inputs.
Corresponds to the Flow property of the
Pressure Transducer object in WorkPlace
Tech Editor.

Velocity pressure

Displays the actual velocity pressure value
measured by the pressure transducer on the
MNL VAV device.
Corresponds to the Velocity Pressure
property of the Pressure Transducer object
in WorkPlace Tech Editor.

Flow calibration

Displays the current value at the High flow
calibration input.
Corresponds to the Flow Calibration Output
property of the Pressure Transducer object
in WorkPlace Tech Editor.

Status

Displays a non-zero value whenever an error
condition is determined by the Pressure
Transducer algorithm.
Corresponds to the Status Flags property of
the Pressure Transducer object in
WorkPlace Tech Editor.
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72.29

PressureTransInH20 and
PressureTransPa Properties – Advanced
Tab
Use the Advanced tab of a PressureTransInH20 or PressureTransPa I/O point to
view or edit configuration properties associated with PressureTransInH20 and
PressureTransPa.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: PressureTransInH20 and PressureTransPa properties – Advanced tab

Table: PressureTransInH20 and PressureTransPa Properties – Advanced Tab
Property

Description

High flow calibration

Enter the equivalent input flow at differential
pressure of 1.0 in., H2O, or 249 Pa.
Corresponds to the High Flow Calibration
property of the Pressure Transducer object
in WorkPlace Tech Editor.
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Continued
Property

Description

Low flow calibration

Enter the equivalent input flow at differential
pressure of 0.1 in., H2O, or 24.9 Pa.
Corresponds to the Low Flow Calibration
property of the Pressure Transducer object
in WorkPlace Tech Editor.
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High flow calibration default

Displays the default value for the High flow
calibration property.

Low flow calibration default

Displays the default value for the Low flow
calibration property.
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72.30

PWMMin, PWMPriMin, PWMSec, and
PWMPriSec Properties – Basic Tab
Use the Basic tab of a PWMMin, PWMSec, PWMPriMin, or PWMPriSec I/O point
to view and edit basic information about PWMMin, PWMSec, PWMPriMin, or
PWMPriSec.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: PWMMin, PWMSec, PWMPriMin, and PWMPriSec properties – Basic tab

Table: PWMMin, PWMSec, PWMPriMin, and PWMPriSec Properties – Basic tab
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Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.
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Continued
Property

Description

Value

Select On to set the current digital output
state.
Corresponds to the Output property of the
PWM or PWM Priority object in WorkPlace
Tech Editor.

Control level

Displays the currently active input by
providing the priority number of the related
input, that is 1, 2, 3, or 4.
Corresponds to the Control Level property of
the PWM Priority object in WorkPlace Tech
Editor.
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72.31

PWMMin, PWMPriMin, PWMSec, and
PWMPriSec Properties – Advanced Tab
Use the Advanced tab of a PWMMin, PWMSec, PWMPriMin, or PWMPriSec I/O
point to view or edit configuration properties associated with PWMMin, PWMSec,
PWMPriMin, or PWMPriSec.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: PWMMin, PWMSec, PWMPriMin, and PWMPriSec properties – Advanced tab

Table: PWMMin, PWMSec, PWMPriMin, and PWMPriSec Properties – Advanced
Tab
Property

Description

Period

Enter the period or total time of each
complete pulse width modulation cycle. A 0
(zero), negative, or "not active" (NA) holds
the Value output (hardware) Off.
Corresponds to the Period property of the
PWM or PWM Priority object in WorkPlace
Tech Editor.
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Continued
Property

Description

On time

Enter the minimum On time value, based on
the Time select default property. A
negative value or NA disables this property.
Corresponds to the On time property of the
PWM or PWM Priority object in WorkPlace
Tech Editor.

Off time

Enter the minimum Off time value, based on
the Time select default property. A
negative value or NA disables this property.
Corresponds to the Off time property of the
PWM or PWM Priority object in WorkPlace
Tech Editor.
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Time select default

Displays the default unit of time.

Period default

Displays the default value for the Period
property.

On time default

Displays the default value for the On time
property.

Off time default

Displays the default value for the Off time
property.
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72.32

VAVActuator Properties – Basic Tab
Use the Basic tab of a VAVActuator I/O point to view and edit basic information
about VAVActuator.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: VAVActuator properties – Basic tab

Table: VAVActuator Properties – Basic Tab
Property

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Drive A output

Displays On when the actuator is driving
towards the Drive A position.
Corresponds to the Drive A property of the
VAV Actuator object in WorkPlace Tech
Editor.
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Continued
Property

Description

Drive B output

Displays On when the actuator is driving
towards the Drive B position.
Corresponds to the Drive B property of the
VAV Actuator object in WorkPlace Tech
Editor.
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72.33

VAVActuator Properties – Advanced
Tab
Use the Advanced tab of a VAVActuator I/O point to view or edit configuration
properties associated with VAVActuator.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: VAVActuator properties – Advanced tab

Table: VAVActuator Properties – Advanced Tab
Property

Description

Drive time

Enter the actuator’s full-stroke drive time.
Corresponds to the Drive Time property of
the VAV Actuator object in WorkPlace Tech
Editor.

Actuator action

Select Drive A closes to have Drive A close
the damper and Drive B open the damper.
Corresponds to the Action property of the
VAV Actuator object in WorkPlace Tech
Editor.
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Continued
Property

Description

Force open input

Select On to cause the actuator to drive
towards the full open condition for the time
duration set in Drive time.
Corresponds to the Force Open property of
the VAV Actuator object in WorkPlace Tech
Editor.

Force close input

Select On to cause the actuator to drive
towards the full closed condition for the time
duration set in Drive time.
Corresponds to the Force Close property of
the VAV Actuator object in WorkPlace Tech
Editor.
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Drive time default

Displays the default value for the Drive time
property.

Actuator action default

Displays the default value for the Actuator
action property.

Force open input default

Displays the default value for the Force
open input property.

Force close input default

Displays the default value for the Force
close input property.
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72.34

FanMode1 and FanMode2 Properties –
Basic Tab
Use the Basic tab of the FanMode1 or FanMode2 S-Link sensor point to view and
edit basic information about FanMode1 or FanMode2.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FanMode1 and FanMode2 properties – Basic tab

Table: FanMode1 and FanMode2 Properties – Basic Tab
Property

Description

Value

Displays the fan's operating mode, entered
at the S-Link sensor.
Corresponds to the Value property of the
Fan1 or Fan2 sensor tag in WorkPlace Tech
Editor.

Mode input number

Displays the fan number.
Corresponds to the fan number in the
WorkPlace Tech Editor Hardware Wizard.
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72.35

FanMode1 and FanMode2 Properties –
Advanced Tab
Use the Advanced tab of a FanMode1 or FanMode2 S-Link sensor point to view
or edit configuration properties associated with FanMode1 or FanMode2.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: FanMode1 and FanMode2 properties – Advanced tab

Table: FanMode1 and FanMode2 Properties – Advanced Tab
Property

Description

Fan mode

Select the fan's operating mode. The modes
that are available here depend on the fan
type that was selected in WorkPlace Tech
Editor Hardware wizard.
Corresponds to the fan's operating mode,
selected at the S-Link sensor.

Fan mode default
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Displays the default value for the Fan mode
property.
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72.36

HvacMode1 and HvacMode2
Properties – Basic Tab
Use the Basic tab of the HvacMode1 or HvacMode2 S-Link sensor point to view
and edit basic information about HvacMode1 or HvacMode2.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: HvacMode1 and HvacMode2 properties – Basic tab

Table: HvacMode1 and HvacMode2 Properties – Basic Tab
Property

Description

Value

Displays the HVAC operating mode entered
at the S-Link sensor.
Corresponds to the output of the HVAC
Mode1 or HVAC Mode2 sensor tag in
WorkPlace Tech Editor.

Mode input number

Displays the HVAC mode number.
Corresponds to the HVAC mode number in
the WorkPlace Tech Editor Hardware
Wizard.
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72.37

HvacMode1 and HvacMode2
Properties – Advanced Tab
Use the Advanced tab of an HvacMode1 or HvacMode2 S-Link sensor point to
view or edit configuration properties associated with HvacMode1 or HvacMode2.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: HvacMode1 and HvacMode2 properties – Advanced tab

Table: HvacMode1 and HvacMode2 Properties – Advanced Tab
Property

Description

HVAC mode

Click the property box and then select the
HVAC operating mode.
Corresponds to the HVAC operating mode
selected at the S-Link sensor.

HVAC mode default

Technical
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Displays the default value for the HVAC
mode property.
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72.38

Setpoint Properties – Basic Tab
Use the Basic tab of the Setpoint S-Link sensor point to view and edit basic
information about Setpoint.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: Setpoint properties – Basic tab

Table: Setpoint Properties – Basic Tab
Property

Description

Value

Displays the setpoint entered at the S-Link
Sensor.
Corresponds to the output of the Setpoint
sensor tag in WorkPlace Tech Editor.

Setpoint number

Displays the Setpoint number.
Corresponds to the order in which the
Setpoint appears in the WorkPlace Tech
Editor Hardware Wizard.
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Continued
Property

Description

Icons enabled

Displays which mode or occupancy icon is
enabled for the setpoint at the S-Link
sensor.
Corresponds to the icons you selected in the
WorkPlace Tech Editor Hardware Wizard.
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72.39

Setpoint Properties – Advanced Tab
Use the Advanced tab of a Setpoint S-Link sensor point to view or edit
configuration properties associated with Setpoint.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: Setpoint properties – Advanced tab

Table: Setpoint Properties – Advanced Tab
Property

Description

Setpoint

Enter a value for the setpoint.
Corresponds to the setpoint value at the SLink sensor.

Enable limits

Click the property box and then select On to
enable limits for the setpoint adjustment
range.
Corresponds to the check box, Limit the
setpoint value to, in the WorkPlace Tech
Editor Hardware Wizard.
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Continued
Property

Description

Minimum limit

Enter a minimum limit for the setpoint
adjustment.
Corresponds to the Min setpoint limit setting
in the WorkPlace Tech Editor Hardware
Wizard.

Maximum limit

Enter a maximum limit for the setpoint
adjustment.
Corresponds to the Max setpoint limit setting
in the WorkPlace Tech Editor Hardware
Wizard.
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Setpoint default

Displays the default value for the Setpoint
property.

Enable limits default

Displays the default value for the Enable
limits property.

Minimum limit default

Displays the default value for the Minimum
limit property.

Maximum limit default

Displays the default value for the Maximum
limit property.
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72.40

Display Properties – Basic Tab
Use the Basic tab of the Display S-Link sensor point to view and edit basic
information about Display.
For more information, see section 71.1 “MNL LonWorks Objects” on page 2421.

Figure: Display properties – Basic tab

Table: Display Properties – Basic Tab
Property

Description

Value

Displays the monitored value you can view at
the S-Link sensor.
Corresponds to the input value at the Display
sensor tag in WorkPlace Tech Editor.

Display number

Displays the Display number.
Corresponds to the order in which the
display appears in the WorkPlace Tech
Editor Hardware Wizard.
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Continued
Property

Description

Icons enabled

Displays which mode or occupancy icon is
enabled for display at the S-Link sensor.
Corresponds to the selections made for
Select the mode icon that will display and
Select the occupancy icon that will display in
the WorkPlace Tech Editor Hardware
Wizard.
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72.41

Applications View
Use the Applications view to view a list of applications that are available for
assignment to MNL LonWorks devices, or to add, edit, or delete an MNL
application.

Figure: Applications view

Table: Applications View
Component

Description
Add an application
Click to open WorkPlace Tech Editor, where
you create or import a new application to
add to Building Operation.
Edit an application
Click to open the selected application for
editing in WorkPlace Tech Editor.
Remove an application
Click to remove the selected application
from the list of available applications in
WorkPlace Tech Editor.
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Application name

Displays the name of the application.

Device type

Displays the type of MNL LonWorks device
in which the application is used.

Profile

Displays the LonMark profile of the
application.

Category

Displays the category that was defined for
the application.

Size

Displays the size of the application, in bytes.

Last modified

Displays the date and time when the
application was last modified.
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Continued
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Component

Description

Modified by

Displays the user who last modified the
application.
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72.42

Assign Application Wizard - Naming the
Object Page
Use the Naming the object page to choose and assign an application to the MNL
LonWorks device. For more information, see section 70.12 “Assigning an MNL
LonWorks Application ” on page 2412.

Figure: Assign Application wizard – Naming the object page

Table: Assign Application Wizard – Naming the Object Page
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Property

Description

(application list)

Select the type of application you want to
create.

Name

Type the name of the object.

Instance Path

Displays the path to the application.

Description

Type a description for the application.

Type Path

Not used.

Only show MNL-800 applications ...

Select this check box to filter the application
list and make it easier to select an
application that is appropriate for the MNL800 device. Available only with MNL-800
devices.
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72.43

Sensor Object Properties – Basic Tab
Use the Basic tab of a Sensor object to view or edit properties associated with
Sensor.

Figure: Sensor object properties – Basic tab

Table: Sensor Object Properties – Basic Tab
Properties

Description

Object ID

Displays the object ID. The object ID is
composed of three parts: the name of the
attached hardware I/O tag (resource tag) in
WorkPlace Tech Editor, the Building
Operation I/O point type, and the object
name assigned in WorkPlace Tech Editor.

Temperature

Displays the current room temperature, read
from the S-Link sensor connected to the
MNL device.
Corresponds to the value at the RoomTemp
sensor tag in WorkPlace Tech Editor.
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Continued
Properties

Description

Humidity

Displays the current room humidity, read
from the S-Link sensor connected to the
MNL device.
Corresponds to the value at the RelHumidity
sensor tag in WorkPlace Tech Editor.

Emergency heat pushbutton

Displays On under either of these two
conditions:
• The sensor's emergency heat key is
pressed.
• In the WorkPlace Tech application, an
On value is received at either the
EmerIconStat or EmerSwitch output
sensor tag.

Override state

Displays On when the sensor's override key
has been pressed and the sensor is in
occupancy override mode.
Corresponds to the value at the
PBOccMode sensor tag in WorkPlace Tech
Editor.

Time remaining

Displays the amount of time remaining in the
active occupancy override mode.
Corresponds to the value at the
OvrdTimeRemain sensor tag in WorkPlace
Tech Editor.

04-16006-04-en, March 2015

Technical
2541

72 MNL LonWorks User Interface
72.44 Sensor Object Properties – Advanced Tab

72.44

Sensor Object Properties – Advanced
Tab
Use the Advanced tab of a Sensor object to view or edit configuration properties
associated with Sensor.

Figure: Sensor object properties – Advanced tab

Table: Sensor Object Properties – Basic Tab
Properties

Description

Override time

Enter the length of the override period that
starts when the S-Link sensor's override key
is pressed.
Corresponds to the value at the OvrdTime
sensor tag in WorkPlace Tech Editor.

Override time default
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Displays the default value for Override
time.
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72.45

MNL Device Application Properties –
Basic Tab
In WorkStation, use the Basic tab of an MNL LonWorks device application to view
basic information about the application.

Figure: MNL LonWorks device application properties – Basic tab

Table: MNL LonWorks Device Application Properties – Basic Tab
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Property

Description

Drawing

Displays the file name of the MNL device
application.

Device type

Displays the type of MNL device in which the
application is used.

VSD written by

Displays the user name of the user who
created the application drawing.

VSD last write time

Displays the date and time at which values
were last written to the application.

Object size

Displays the size of the application, in bytes.
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Continued
Property

Description

Application category

Displays a category, if this optional property
was defined for the application in the Import
Wizard. This property makes it possible, in
list views, to sort applications based on their
function or some other criteria.

Application description

Displays a description, if this optional
property was entered in the Import Wizard. A
description can be used to more easily
differentiate between applications that have
similar names.

Program ID

Displays a unique, alphanumeric
identification for the application's network
profile.
WorkPlace Tech Editor and Monitor
Engineering Guide Supplement (F-27745)
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72.46

MNL LonWorks Device Properties –
Advanced Tab
Use the Advanced tab of an MNL LonWorks device to view or edit configuration
properties associated with the device or the connected S-Link sensor, and in the
case of VAV devices, the flow balance calibration.

Figure: MNL LonWorks device properties – Advanced tab

Table: MNL LonWorks Device Properties – Advanced Tab
Property

Description

Application status

Displays the status of the application in the
MNL device.
For more information, see section 70.3
“Application Status” on page 2395.
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Continued
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Property

Description

Sensor model

Displays the model number of the S-Link
sensor that is defined by the application in
the MNL device.

Temperature

Displays the temperature that is being read
by the S-Link sensor connected to the MNL
device.

Humidity

Displays the humidity that is being read by
the S-Link sensor connected to the MNL
device.

Active temperature offset

Displays the temperature offset, read from
the MNL device.

Active humidity offset

Displays the humidity offset, read from the
MNL device.

Temperature offset

Enter a value to calibrate the temperature
reading of the S-Link sensor.

Humidity offset

Enter a value to calibrate the humidity
reading of the S-Link sensor.

High flow calibration

Displays the terminal flow rate, determined at
a velocity pressure of 249 Pa (1.0 in. w.g).

Low flow calibration

Displays the terminal box flow rate,
determined at a velocity pressure of 24.9 Pa
(0.1 in. w.g.).

Rotation action

Displays the action configuration of the VAV
device. Displays Drive A closes when
Drive A is set to close the damper and Drive
B is set to open it.

Maximum flow setpoint

Displays the maximum flow control point
used by the MNL VAV device.

Minimum flow setpoint

Displays the minimum flow control point
used by the MNL VAV device.

Heating minimum flow setpoint

Displays the minimum flow control point
used by the MNL VAV device during reheat
conditions.

Last flow balance backup time

Displays the most recent time at which the
flow balance information in the MNL VAV
device was backed up.

Last flow balance restore time

Displays the most recent time at which the
backup flow balance information was
restored to the MNL VAV device.
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72.47

Actions Menu – MNL Submenu
Use the MNL submenu to open WorkPlace Tech Monitor or to perform a task on
an MNL LonWorks device.

Figure: MNL submenu when an MNL device is selected

Table: MNL Submenu
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Command

Description

Download application

Click to download the application of the
selected MNL LonWorks device. For more
information, see section 70.3 “Application
Status” on page 2395.

Launch WorkPlace Tech Monitor

Click to open WorkPlace Tech Monitor. For
more information, see section 70.15
“WorkPlace Tech Monitor” on page 2415.

Assign application

Click to open the Assign Application Wizard,
where you assign an application to the
selected MNL device. For more information,
see section 72.42 “Assign Application
Wizard - Naming the Object Page” on page
2537.

Reset device

Click to reset the selected MNL device.

Backup flow balance information

Click to copy the MNL VAV device's flow
balance calibration information to the
Building Operation database. For more
information, see section 71.15 “Flow
Balance Calibration Information” on page
2454.

Restore flow balance information

Click to write the flow balance calibration
information contained in the Flow Balance
Information property group, from the
Building Operation database to the MNL
VAV device. For more information, see
section 71.15 “Flow Balance Calibration
Information” on page 2454.

Backup S-Link offsets

Click to copy the MNL device's Active
temperature offset and Active
humidity offset values to the
Temperature offset and Humidity
offset properties.
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Command

Description

Restore S-Link offsets

Click to write the Temperature offset and
Humidity offset values to the MNL device.

Download configuration properties

Click to download configuration properties
to the selected MNL device. For more
information, see section 70.3 “Application
Status” on page 2395.
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72.48

MNL LonWorks System Tree Icons
The following table describes System Tree icons that are specific to MNL
LonWorks devices.
Table: MNL LonWorks System Tree Icons
Icon

Description
Application
Indicates an Application object that is
assigned to an MNL device, created from a
compatible MNL application type.
For more information, see section 70.1
“MNL LonWorks Applications” on page
2391.
MNL LonWorks Device Requires
Action
Indicates that action is required to
synchronize the physical MNL device with its
application in the database.
For more information, see section 70.3
“Application Status” on page 2395.
nci (flag not set)
Indicates that the system uses the NCI value
from the WorkPlace Tech application. Future
application downloads to the MNL device
will also use the NCI value from the
WorkPlace Tech application.
For more information, see section 71.8 “NCI
Values” on page 2434.
nci (flag set)
Indicates that the system uses the NCI value
from the Building Operation database.
Future application downloads to the MNL
device will also use the NCI value from the
Building Operation database.
For more information, see section 71.8 “NCI
Values” on page 2434.
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73 BACnet Overview
73.1 BACnet Overview

73.1

BACnet Overview
Building Operation is a native BACnet system with features that enable you to
create and manage an interoperable BACnet building automation system according
to the ASHRAE Standard. Building Operation features and components support the
BACnet services in all five of the BACnet interoperability areas.
Interoperability
Area
Data sharing

Building Operation Example
• View and modify the properties of BACnet objects
• Monitor and control the values of BACnet objects
• Modify and control setpoints and parameters
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm and event
management

• Create and define the conditions for algorithmic and intrinsic
alarming
• Acknowledge alarms and events
• Create and define BACnet notifications and device recipients
For more information, see section 79.6 “BACnet Alarms” on page
2898.
For more information, see section 79.1 “BACnet Notifications” on
page 2879.

Scheduling

• Create and modify schedules
• Create and modify exception events for schedules
• Control the start and stop time of schedules
For more information, see section 80.1 “BACnet Schedules” on
page 2935.

Trending

• Create and define trend logs for algorithmic and intrinsic
reporting
• Create and modify extended trend logs
• Display trended data
For more information, see section 75.29 “Extended Logging for
External BACnet Trend Logs Workflow” on page 2640.

Device and network
management

• Discover and display information about devices on the BACnet
internetwork
• Discover and display information about objects in the BACnet
internetwork
• Backup and restore BACnet devices
For more information, see section 75.2 “BACnet Device Discovery”
on page 2606.
For more information, see section 75.39 “BACnet Backup and
Restore” on page 2653.

http://www.bacnet.org/
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73.1.1

BACnet Interface
A BACnet Interface is the BACnet device object of a local server and enables
BACnet communication in Building Operation. In a BACnet internetwork, each
BACnet device maintains one device object whose properties represent the BACnet
device. As the device object of a local server, the BACnet Interface is the BACnet
representation of a server in a BACnet internetwork.
For more information, see section 73.2 “BACnet Interface” on page 2554.

73.1.2

BACnet Networks
Building Operation supports IP networks and MS/TP networks. As a result, you can
host BACnet devices that reside on each type of network.
When you create a BACnet Interface for an Automation Server or an Enterprise
Server, an IP network is automatically created. You can create an MS/TP network in
the BACnet interface of an Automation Server.
For more information, see section 74.1 “BACnet Networks” on page 2573.

73.1.3

BACnet Device Management
BACnet device management is a collection of services that perform administrative,
maintenance, and troubleshooting tasks on a BACnet device.
For more information, see section 75.1 “BACnet Device Management” on page
2603.

73.1.4

BACnet Objects and Properties
You can create BACnet objects in Automation Servers, Enterprise Servers, and
BACnet devices in the Building Operation database.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

73.1.5

BACnet Download and Upload
You can download and upload the properties of a single object or BACnet device,
or the full contents and properties of a BACnet device.
For more information, see section 78.1 “BACnet Download and Upload” on page
2863.
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73.1.6

BACnet System Configuration Workflows
When engineering a BACnet system off-site, you can use WorkStation for Projects
to configure and then deploy a configuration project to an online Enterprise Server
or Automation Server. When on-site, you can then use WorkStation to fine-tune the
configuration on the online server(s), or configure the entire system on-site.
For more information, see section 73.9 “BACnet System Configuration Workflows”
on page 2564.
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73.2

BACnet Interface
A BACnet Interface is the BACnet device object of a local server and enables
BACnet communication in Building Operation. In a BACnet internetwork, each
BACnet device maintains one device object whose properties represent the BACnet
device. As the device object of a local server, the BACnet Interface is the BACnet
representation of a server in a BACnet internetwork.
You create only one BACnet Interface for a server. The server can be an
Automation Server or an Enterprise Server. When you create a BACnet Interface,
the system automatically creates the Application and IP network folders within the
BACnet Interface folder on the System Tree. If you create a BACnet Interface for an
Automation Server, you can optionally create an MS/TP network. For more
information, see section 74.1 “BACnet Networks” on page 2573.

Figure: BACnet Interface in the System Tree

The Application folder of the BACnet Interface is where you create BACnet server
objects. For more information, see section 76.1 “BACnet Objects and Properties”
on page 2663.
The IP network and MS/TP network are the BACnet networks where you add
BACnet devices when you want to host a BACnet device. For more information, see
section 74.1 “BACnet Networks” on page 2573.

73.2.1

BACnet Communications
A BACnet Interface is the mechanism by which you enable BACnet communication
in Building Operation.
For more information, see section 73.6 “BACnet Communications” on page 2561.

73.2.2

BACnet References and System References
In Building Operation, BACnet devices and objects use references to make a
connection between two or more variables for data exchange. For example, you
can create a reference for a setpoint property in a device.
For more information, see section 73.7 “BACnet References and System
References” on page 2562.
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73.2.3

Interface Required Identification Properties
BACnet objects have required identification properties that are defined by the
ASHRAE Standard.
For more information, see section 73.8 “Interface Required Identification Properties”
on page 2563.

73.2.4

BACnet Folders in the BACnet Interface
Use folders within the BACnet Interface to organize the devices and objects into
logical groupings in WorkStation.
For more information, see section 73.4 “BACnet Folders in the BACnet Interface”
on page 2558.
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73.3

Creating a BACnet Interface
You create the BACnet Interface to enable the BACnet communications port on an
Enterprise Server or Automation Server.
For more information, see section 73.2 “BACnet Interface” on page 2554.

To create a BACnet Interface
1. In WorkStation, in the System Tree, select the location where you want to
create the BACnet Interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, select BACnet Interface.

4. In the Name box, type a name for the BACnet Interface.
5. In the Description box, type a description for the BACnet Interface.
6. Click Next.
7. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet interface.

Note
• If you enter an Instance ID manually, you must ensure that it is
globally unique among all the BACnet devices on the
internetwork (that is, among all the devices that it can
communicate with).
Continued on next page
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8. In the BACnet name box, type a name for the BACnet interface. Do not type
a name if you want it assigned for you.
9. In the Network ID box, enter 1, which is the universal standard for all BACnet
IP communications.
10. Click Create.
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73.4

BACnet Folders in the BACnet Interface
Use folders within the BACnet Interface to organize the devices and objects into
logical groupings in WorkStation.

Figure: BACnet devices and objects grouped into folders

You can create folders in three places: a BACnet network, the Application folder of
a BACnet device, and within another folder.

73.4.1

BACnet Network Folders
Use folders in the BACnet network to locate objects by category, such as function
or location. For example, organize all the air-handling units hosted by an
Automation Server into one AHU folder.
For more information, see section 74.1 “BACnet Networks” on page 2573.
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73.4.2

BACnet Device Application Folders
Use folders in the Device Application folder to make it easier for operators to locate
objects by category, such as object type or unit. For example, organize all the
sensors for an air handler into one AHU Sensors folder. You can also use the
Application folders to copy an application that includes graphics and other objects
executed by the Automation Server or Enterprise Server to another BACnet device.

Note
Generally, IDs are assigned by a device during an upload, or by the system during
a download. If you copy and paste folders containing BACnet objects to other
devices, the object names and IDs can remain the same. However, the IDs of
BACnet objects must be unique to each device. If duplicate IDs are detected in
the target destination, the system displays an error message and cancels the
copy command.

73.4.3

Folders within a Folder
Use folders within a folder to organize devices and objects into smaller groups. For
example, create subfolders for sensors, outputs, programs, alarms, and graphics
within an air-handler folder.

73.4.4

Best Practices for Using Folders
To save engineering time, create all the necessary BACnet and Building Operation
objects and folders in one BACnet device first. Then, use this device as the basis for
creating (cloning) additional, similar devices. In WorkStation, follow these steps:
Step

Description

1

Upload the device to the Building Operation database.

2

Create folders as needed on the device.

3

Create and configure the BACnet objects and place them into the designated
folders.

4

Create and configure the Building Operation objects and place them into the
designated folders.

5

Export the configured device to preserve the bindings.

6

Import (clone) the configured device as many times as needed.

7

Associate the cloned devices with their respective online devices on the network.

For more information, see the Creating a Folder topic on WebHelp.
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73.5

Automatically Discovering BACnet
Subnetworks
You use auto discovery to control the detection of BACnet subnetworks during
BACnet device discovery.
For more information, see section 75.2 “BACnet Device Discovery” on page 2606.

To automatically discover BACnet subnetworks
1. In WorkStation, in the System Tree, select BACnet Interface.
2. On the File menu, click Properties.
3. Click the Basic tab.

4. In the Auto-discover sub-networks box, select one of the following
options:
• Select Yes if you want Building Operation to discover the BACnet devices
on subnetworks during device discovery.
• Select No if you do not want Building Operation to discover the BACnet
devices on subnetworks during device discovery.
5. Click OK.
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73.6

BACnet Communications
A BACnet Interface is the mechanism by which you enable BACnet communication
in Building Operation.
After you create a BACnet Interface, you can perform the following operations in
WorkStation:
• View BACnet devices and their objects.
• Discover BACnet devices. For more information, see section 75.2 “BACnet
Device Discovery” on page 2606.
• Create and configure BACnet objects in the server. For more information, see
section 76.1 “BACnet Objects and Properties” on page 2663.
• Host BACnet devices. For more information, see section 75.21 “Device
Communication and Diagnostics” on page 2631.
• Create and configure BACnet objects in BACnet devices. For more
information, see section 76.1 “BACnet Objects and Properties” on page 2663.
For more information, see section 82.5 “Creating a BACnet Interface” on page
3261.
In the BACnet internetwork, BACnet devices interoperate with the Enterprise Server
and Automation Server. For example, operators can perform the following
operations using a BACnet workstation:
• View the server as a BACnet device.
• View the objects and properties of the server.
• Create and configure BACnet analog, digital, and multistate values in the
server.
• Create and configure BACnet objects, such as trend logs and notifications, in
the server.
• View the properties of BACnet IO points created for IO modules that are
connected to an Automation Server.
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73.7

BACnet References and System
References
In Building Operation, BACnet devices and objects use references to make a
connection between two or more variables for data exchange. For example, you
can create a reference for a setpoint property in a device.
There are two ways to configure a reference on a network:
• System reference: Use this standard method to create a path-based
reference to an object or property that is currently located on the server.
• BACnet reference: Use this method to create a reference that uses the
elements of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not currently
on the server but may be uploaded or imported to the server later. You can
also use this method to reference a BACnet object or property on an external
device.
After you create the reference, the system automatically fills in the available
information. If any information is missing in the BACnet reference, you may need to
download or upload the device. For more information, see section 78.1 “BACnet
Download and Upload” on page 2863.

Figure: System reference and BACnet reference examples
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73.8

Interface Required Identification
Properties
BACnet objects have required identification properties that are defined by the
ASHRAE Standard.
The properties include the object identifier, object name, and object type, which are
required to be unique within the device and the BACnet internetwork.
• Object identifier is the BACnet instance number that identifies a BACnet
device.
To meet this requirement, you need to specify an object identifier for the
BACnet Interface. When you create a BACnet Interface, you can specify an
instance number or use the instance number generated by the server. It is
recommended that you use the number generated by the server.
In Building Operation, Object ID is the equivalent of the object identifier
property, However, the property includes the object type as well as the
instance number of the object, for example, device, 2151234.
• Object name is the BACnet name of an object.
To meet this requirement, you need to specify an object name for the BACnet
Interface. When you create a BACnet Interface, you can specify an object
name or use the default object name. The default name is AS_nnnn or
ES_nnnn where AS is assigned for an Automation Server, ES is assigned for an
Enterprise Server, and _nnnn is the instance number of the server.
In Building Operation, BACnet name is the equivalent of the object name
property.
• Object type is the BACnet object class of an object, for example, device,
notification class, or analog input.
In Building Operation, BACnet type is the equivalent of the object type
property. The object type of a BACnet Interface is device, which displays in
both the Object ID property and the BACnet type property.
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73.9

BACnet System Configuration
Workflows
When engineering a BACnet system off-site, you can use WorkStation for Projects
to configure and then deploy a configuration project to an online Enterprise Server
or Automation Server. When on-site, you can then use WorkStation to fine-tune the
configuration on the online server(s), or configure the entire system on-site.

73.9.1

BACnet System Off-site Configuration
Workflow
Use the BACnet System Off-site Configuration Workflow to deploy a BACnet
project that contains programmable devices, external devices, or a combination of
both, to an Enterprise Server or Automation Server.
For more information, see section 73.10 “BACnet System Off-site Configuration
Workflow” on page 2565.

73.9.2

BACnet System On-site Configuration
Workflow
Use the BACnet System On-site Configuration Workflow to fine-tune BACnet
networks, programmable devices, and external devices on an online Enterprise
Server or Automation Server. Alternately, you can configure an entire system on-site
on the online servers.
For more information, see section 73.11 “BACnet System On-site Configuration
Workflow” on page 2568.
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73.10

BACnet System Off-site Configuration
Workflow
Use the BACnet System Off-site Configuration Workflow to deploy a BACnet
project that contains programmable devices, external devices, or a combination of
both, to an Enterprise Server or Automation Server.
In WorkStation for Projects, follow this sequence.

Figure: BACnet off-site system configuration workflow
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Create BACnet networks
Create and configure the networks for the BACnet system:
• IP network. For more information, see section 74.3 “Creating an Additional
BACnet IP Network” on page 2579.
• MS/TP network. For more information, see section 83.3 “Creating a BACnet
MS/TP Network” on page 3272.
• Remote network. For more information, see section 74.9 “Creating a BACnet
Remote Network ” on page 2587.

Create offline BACnet devices
Create and configure the BACnet devices for each network:
• BACnet devices. For more information, see section 75.4 “Creating a BACnet
Device” on page 2608.
• IA Series BACnet devices. For more information, see section 75.5 “Creating an
I/A Series (MNB) BACnet Device” on page 2610.
• BBMD devices. For more information, see section 75.31 “Creating a BBMD”
on page 2645.

Create BACnet objects
Create and configure BACnet objects on each network:
• BACnet points. For more information, see section 76.10 “Creating a BACnet
Point in a Server” on page 2675.
• BACnet values. For more information, see section 76.24 “Creating a BACnet
Value” on page 2756.
• BACnet trend logs. For more information, see section 76.43 “Creating a
BACnet Trend Log” on page 2825.
• BACnet schedules. For more information, see section 80.6 “Creating a BACnet
Schedule” on page 2945.

Import third-party devices
Import one or more external device configurations that originated outside of Building
Operation, such as Viconics or bCX. Then, configure one of the devices to use as a
template for creating additional devices of that type. After deployment to an online
system, you can discover and then associate the devices on the network.
For more information, see section 18.27 “Importing a Solution” on page 594.

Create offline third-party devices
Create and configure third-party devices that act as placeholders in the BACnet
system. After deployment to an online system, you can discover and then associate
the devices on the network.
For more information, see section 75.4 “Creating a BACnet Device” on page 2608.

Deploy the Automation Servers
Deploy the Automation Servers to the on-site server.
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Caution
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server. For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended that you update the Enterprise Server communication
parameters before the deploy of the first Automation Server.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Deploy Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.

Important
Ensure that you have created all Automation Servers in the project before the
deploy of the Enterprise Server. You can only deploy to an empty Enterprise
Server. Any additional Automation Servers have to be created on the on-site
server.
For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.
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73.11

BACnet System On-site Configuration
Workflow
Use the BACnet System On-site Configuration Workflow to fine-tune BACnet
networks, programmable devices, and external devices on an online Enterprise
Server or Automation Server. Alternately, you can configure an entire system on-site
on the online servers.
In WorkStation, follow this sequence.

Figure: BACnet on-site system configuration workflow

Discover BACnet devices
Use Device Discovery to identify installed Building Operation server hardware and
BACnet devices in the BACnet network.
For more information, see section 75.3 “Discovering a BACnet Device” on page
2607.

Associate BACnet devices
Associate a BACnet instance number to a deployed device. The association with an
instance number enables the device to go online.
For more information, see section 75.6 “Associating a BACnet Instance Number
with a Device ” on page 2611.
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Download devices
Download the configuration data from the online server to each deployed device to
update all of the objects and properties of the device.
For more information, see section 78.5 “Downloading the Contents of a BACnet
Device” on page 2868.

Upload external devices
Upload the configuration data from each external device to the server to update all
of the objects and properties of the device to the Building Operation server's
database.
For more information, see section 78.12 “Uploading the Contents of a BACnet
Device” on page 2876.

Download networks
Download the contents of a BACnet network from the Building Operation server's
database to update all of the devices, objects, and properties of the network.
• For more information, see section 78.6 “Downloading an IP Network” on page
2869.
• For more information, see section 78.7 “Downloading an MSTP Network” on
page 2870.
• For more information, see section 78.8 “Downloading a Remote Network” on
page 2871.
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74.1

BACnet Networks
Building Operation supports IP networks, MS/TP networks, Remote networks, and
the Internetwork. As a result, you can host BACnet devices that reside on each type
of network.

74.1.1

IP Network
Automation Servers and Enterprise Servers communicate with BACnet devices
over IP networks. The system automatically creates an initial IP network when you
create a BACnet Interface. However, you can create additional IP networks to join
one or more subnetworks to the BACnet network.
For more information, see section 74.2 “IP Network” on page 2576.

74.1.2

MS/TP Network
Create a MS/TP network in the BACnet Interface of an Automation Server when you
want to host BACnet devices that can communicate with the server, such as b3
BACnet devices.
For more information, see section 74.5 “MS/TP Network” on page 2581.

74.1.3

Remote Network
A remote network is a BACnet network that is not directly connected to an
Automation Server or Enterprise Server. Devices created on remote networks use
BACnet routers to communicate to other devices in the BACnet internetwork.
For more information, see section 74.8 “Remote Network” on page 2585.

74.1.4

BACnet Internetwork
A BACnet Internetwork comprises all the different networks including IP, MS/TP,
and Remote, which are set up to communicate with each other.
For more information, see section 74.11 “BACnet Internetwork” on page 2590.

74.1.5

Poll Interval
A poll interval is the interval at which the system reads a variable, such as one-half
second (500 ms). A polling delay or lag is the difference between the time
WorkStation scheduled a poll of a variable from a BACnet object and when the
variable was actually polled. A high number, such as 10,000 milliseconds, may
indicate the system is under a greater load than the network can process in a timely
manner. For example, if you set a poll on a variable property in WorkStation for
4:00:00 PM, but the system actually polls the property at 4:00:10 PM, the delay is
10 seconds (10,000 milliseconds).
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Note
Lag depends upon the type of network. For example, an IP network runs faster
than an MS/TP network. Furthermore, a network of b3s running in enhanced
MS/TP mode runs faster than one running in non-enhanced mode. For more
information, see section 83.4 “Configuring the MS/TP Network for b3
Communication” on page 3274.
In Building Operation, a large number of polled variables may directly affect system
response time. However, you can optimize system performance of polled BACnet
variables by (1) reducing the number of polled variables in a graphic or Watch pane,
(2) fine-tuning the BACnet polling interval settings, or (3) both. For more information,
see section 161.1 “System Performance Diagnostics” on page 5637.

74.1.6

BACnet Gateway
When your installation includes non-BACnet devices and networks, you can employ
a BACnet Gateway to expose the foreign objects and devices as BACnet objects
and devices. To provide communication, interconnectivity, and visibility, a BACnet
gateway can bridge the primary BACnet network to the non-standard networks.
The two widely used approaches for implementing a BACnet Gateway are BACnet
device and Router to Virtual BACnet devices.
For more information, see section 74.15 “BACnet Gateway” on page 2598.

74.1.7

Summary
Devices and objects in a BACnet network conform to the requirements published
by ASHRAE, the American Society of Heating, Refrigerating, and Air-Conditioning
Engineers. The ASHRAE Standard is a data communication protocol for building
and automation control networks.
The following illustration provides an overview of BACnet.
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Figure: BACnet system overview
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74.2

IP Network
Automation Servers and Enterprise Servers communicate with BACnet devices
over IP networks. The system automatically creates an initial IP network when you
create a BACnet Interface. However, you can create additional IP networks to join
one or more subnetworks to the BACnet network.

Figure: IP Network
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74.2.1

Multiple BACnet IP Networks
You can create multiple IP networks in the BACnet system as long as each network
has a unique identifier (network Id and name) and UDP/IP port number. The unique
identifier and port number ensures that there is a single communication path
between any two devices, which is required by BACnet. For more information, see
section 74.3 “Creating an Additional BACnet IP Network” on page 2579.

Figure: Multiple BACnet IP networks in the BACnet Internetwork

For more information, see section 74.4 “Configuring a BACnet IP Network” on page
2580.
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74.2.2

Best Practices for Multiple IP Networks and
BBMDs
There are guidelines for configuring multiple BACnet IP networks or BBMDs to
ensure that the communication channels are distinct in the BACnet system.
For more information, see section 74.12 “Best Practices for Multiple IP Networks
and BBMDs” on page 2592.
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74.3

Creating an Additional BACnet IP
Network
You create another IP network to set up a communication channel that is distinct
from another IP network installed on the same server.
For more information, see section 74.2 “IP Network” on page 2576.

To create an additional BACnet IP Network
1. In WorkStation, in the System Tree, select the BACnet Interface.
2. On the File menu, point to New and then click IP Network.
3. In the Name box, type a name for the IP network.
4. In the Description box, type a description for the IP network.
5. Click Next.
6. In the Network ID box, enter a unique number between 1 and 65534.
7. Select the Defer ID assignment check box to assign a network ID after the
network is created.
8. Click Create.
You can now maintain multiple IP networks on the same server.
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74.4

Configuring a BACnet IP Network
You configure a BACnet IP network to change the IP address, IP port, or Network
ID. By default, all BACnet IP devices use UDP/IP port 47808.
For more information, see section 74.2 “IP Network” on page 2576.

To configure a BACnet IP network
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. On the List View, select the IP network that you want to modify.
3. On the File menu, click Properties.
4. In the Description box, type a description for the BACnet device.
5. Edit the properties.
Property

Description

Online

Displays True when the Building Operation server is available
on the BACnet IP network.

Reliability

Displays any error status for a network that is configured as a
foreign device.

Out Of Service

Set to True to disable the IP network from the BACnet
system.

IP address

Displays the IP address of the server represented by the
BACnet Interface.

IP port number

Displays the IP port number of the server represented by
the BACnet Interface.

Network ID

Displays the Network ID of the BACnet IP network.

Maximum APDU
length accepted

Displays the maximum size of a message that a device on the
network can accept.

IP broadcast
address

Displays the IP address used to send broadcast messages on
a BACnet IP network.

BBMD IP address

Type the IP address of the BBMD to register the network as a
foreign device with the BBMD.

BBMD port
number

Enter the port number of the BBMD to register the network as
a foreign device with the BBMD.

6. Click OK.
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74.5

MS/TP Network
Create a MS/TP network in the BACnet Interface of an Automation Server when you
want to host BACnet devices that can communicate with the server, such as b3
BACnet devices.

Figure: MS/TP Network
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74.6

Creating a BACnet MS/TP Network
You create an MS/TP network in order to connect a b3 BACnet device or other
BACnet device to an Automation Server.
For more information, see section 74.1 “BACnet Networks” on page 2573.

To create a BACnet MS/TP network
1. In WorkStation, in the System Tree, select the BACnet Interface.
2. On the File menu, point to New and then click MSTP Network.
3. In the Name box, type a name for the MS/TP network.

4. In the Description box, type a description for the MS/TP network.
5. Click Next.
Continued on next page
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6. In the Network ID box, enter a unique number between 1 and 65534.

7. Select the Defer ID assignment check box to assign a network ID after the
MS/TP network is created.
8. In the MAC address box, enter the number that represents the Automation
Server's address on the MS/TP network.
9. In the RS-485 port box, enter the location of the serial port RS485-COMA
or RS485-COMB.
10. Click Create.
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74.7

Configuring a BACnet MS/TP Network
You configure a BACnet MS/TP network to change the MAC address, MSTP baud
rate, or Maximum information frames.
For more information, see section 74.5 “MS/TP Network” on page 2581.

To configure a BACnet MS/TP network
1. In WorkStation, in the System Tree, expand BACnet Interface of the
Automation Server.
2. In List View, select the MS/TP Network you want to modify.
3. On the File menu, click Properties.
4. Edit the properties.
Property

Description

Online

Displays True when the Building Operation server is
available on the BACnet MS/TP network.

Network ID

View or enter the Network ID of the MS/TP network.
Enter a number from 1 to 65534 that uniquely identifies the
network over the entire BACnet internetwork.

RS-485 port

View or enter the path to the serial port on the Automation
Server.

MAC address

View or enter the MS/TP MAC address of the Automation
Server. Enter a number between 0 and 127. Most
installations use 0.

MSTP baud rate

View or select the MS/TP baud rate.

Enhanced mode

Select True to improve throughput when used with b3
devices. Enhanced mode allocates more bandwidth to the
Automation Server. This setting has no effect on other
(non-b3) MS/TP devices.
Select False if you anticipate heavy communication among
the MS/TP devices, or if strict BACnet compliance is
required.

Maximum master

Enter the highest used address of the master nodes on the
MS/TP network. Enter a number between 0 and 127.

Maximum
information frames

Enter the maximum number of information frames that can
be sent before the BACnet device is required to pass a
token on the MS/TP network.

Maximum APDU
length accepted

Displays the maximum size of a message that a device on
the network can accept.

5. Click OK.
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74.8

Remote Network
A remote network is a BACnet network that is not directly connected to an
Automation Server or Enterprise Server. Devices created on remote networks use
BACnet routers to communicate to other devices in the BACnet internetwork.

Figure: BACnet Network

For example, you hosted BACnet device_208808 that serves as a router to BACnet
device_10925. In this scenario, BACnet device_10925 is on a network that is not
directly connected to the server. To host the device, you create the BACnet
network for the device, and then host the device. For more information, see section
74.9 “Creating a BACnet Remote Network ” on page 2587.
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Figure: BACnet network in System Tree
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74.9

Creating a BACnet Remote Network
You create a BACnet remote network when you connect to a BACnet device that
resides on a network not directly connected to the server.
For more information, see section 74.8 “Remote Network” on page 2585.

To create a BACnet remote network
1. In WorkStation, in the System Tree, expand BACnet Interface, and
expand IP Network or MSTP Network.
2. Select the BACnet device.
3. On the File menu, point to New and click BACnet network.
4. In the Name box, type a name for the BACnet network.

5. In the Description box, type a description for the BACnet network.
6. Click Next.
Continued on next page
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7. In the Network ID box, enter a network ID for the BACnet network.

8. Click Create.
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74.10

Configuring a BACnet Remote Network
You configure a BACnet remote network to add a description or note.
For more information, see section 74.8 “Remote Network” on page 2585.

To configure a BACnet remote network
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the IP Network or MSTP Network where the BACnet device
resides.
2. Expand the BACnet device and select the BACnet network you want to
modify.
3. On the File menu, click Properties.
4. In the Description box, type a description for the network.
5. In the Note box, type text that you want to display in a graphic or use when
searching for the object.
6. Click OK.
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74.11

BACnet Internetwork
A BACnet Internetwork comprises all the different networks including IP, MS/TP,
and Remote, which are set up to communicate with each other.

Figure: BACnet Internetwork

In the BACnet internetwork, BACnet devices interoperate with the Enterprise Server
and Automation Server. For example, operators can perform the following
operations using a BACnet workstation:
• View the server as a BACnet device.
• View the objects and properties of the server.
• Create and configure BACnet analog, digital, and multistate values in the
server.
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• Create and configure BACnet objects, such as trend logs and notifications, in
the server.
• View the properties of BACnet IO points created for IO modules that are
connected to an Automation Server.

Tip
The Device Discovery view displays all BACnet devices and objects discovered in
the BACnet internetwork. For more information, see section 75.2 “BACnet Device
Discovery” on page 2606.
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74.12

Best Practices for Multiple IP Networks
and BBMDs
There are guidelines for configuring multiple BACnet IP networks or BBMDs to
ensure that the communication channels are distinct in the BACnet system.
Once the IP networks or BBMDs are configured, you can use Device Discovery to
locate devices on all the IP subnets in the BACnet network.

74.12.1

Multiple IP Networks
Since BACnet requires a single communication path between any two devices,
consider the following points when setting up one or more IP networks in a BACnet
system:
• Network Id. Configure a unique network ID for each IP network installed on
the same server. If you defer assigning an ID when creating an IP network, you
can add the network ID later. For more information, see section 81.30 “BACnet
IP Network Properties – Basic Tab” on page 3008.
• Network name. Define a unique network name for each IP network installed
on the same server. As a precaution, the system automatically appends a
number to the default name to avoid duplication. For more information, see
section 74.4 “Configuring a BACnet IP Network” on page 2580.
• Additional network. To avoid routing loops, use a UDP/IP port number that
is not being used by another Building Operation server or BACnet device when
opening up an additional network. By default, all BACnet IP devices use
UDP/IP port 47808. For more information, see section 160.7 “Routing Loops”
on page 5633.
For more information, see section 74.2 “IP Network” on page 2576.

74.12.2

BBMDs and IP Networks
Generally, you create a BBMD if you want to register a foreign device that resides
on a solitary IP subnet, or to set up communication with other BBMDs in the
BACnet system. For example, IP Network-A includes a BBMD, IP Network-B
includes a BBMD, and IP Network-C includes a foreign device. If registered, a
Building Operation server can also serve as a foreign device in the BACnet system.
Consider the following points when configuring BBMDs or foreign devices:
• Network Id. Configure a unique IP network ID for each BBMD installed on the
same Building Operation server. For more information, see section 81.30
“BACnet IP Network Properties – Basic Tab” on page 3008.
• BBMD to register server. Create a BBMD if you want to register a foreign
device that resides on a solitary IP subnet to allow the device to join the
BACnet system. For more information, see section 75.31 “Creating a BBMD”
on page 2645.
• Multiple BBMDs. Configure each BBMD with a different UDP/IP port if you
plan to install multiple BBMDs on the same BACnet IP network to prevent
broadcast storms. For more information, see section 160.8 “Broadcast
Storms” on page 5634.
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• Register server as foreign device. Register a Building Operation server as
a foreign device with a BBMD to allow the server (and its BACnet/IP devices) to
join the BACnet system. For more information, see section 75.33 “Registering
a Building Operation Server as a Foreign Device” on page 2647.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.
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74.13

Diagnosing Polled Variables on a
BACnet Network
You diagnose polled variables on a BACnet network to observe the various polling
times on each network. The system calculates these polling values every five
minutes of server operation, and then the values are reset. You can also determine
how many properties use the more efficient BACnet COV service instead of the
explicit read-property polling.
For more information, see section 74.1 “BACnet Networks” on page 2573.

To diagnose polled variables on a BACnet network
1. In WorkStation, in the System Tree, expand System folder.
2. Expand the Modules folder, BACnet devices, and then Diagnostics.
Objects in the Diagnostics folder vary with the server, for example, an
Automation Server may also include MS/TP diagnostic objects (if installed).
Continued on next page
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3. Select a diagnostic object for a BACnet network containing a large number of
polled objects.

Continued on next page
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4. View the following read-only polling statistics, which are reset for every five
minutes of server operation:
Property

Description

Average polling delay

Displays the average lag between the time
WorkStation scheduled a poll of a variable from a
BACnet object and when the variable was actually
polled.

Minimum polling delay

Displays the minimum polling lag between the time
WorkStation scheduled a poll of a variable from a
BACnet object and when the variable was actually
polled.

Maximum polling delay

Displays the maximum polling lag between the time
WorkStation scheduled a poll of a variable from a
BACnet object and when the variable was actually
polled.

Number of polled
variables

Displays the total number of polled variables on the
BACnet network.

Number of COV
variables

Displays the total number of Change Of Value variables
on the BACnet network. A zero (0) indicates that there
are no variables present.

5. View the number of COV variables, if available.
6. Drag and drop one or more diagnostic variables to the Watch pane.
7. Set up the Watch pane to view the CPU usage and System memory usage of
the server.
Now you can set up the Watch pane to view the CPU usage and System memory
usage of the server. For more information, see section 3.25 “Displaying CPU and
System Memory Usage” on page 169.
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74.14

Optimizing System Performance Using
BACnet Polling Intervals
To improve system performance, you can fine-tune the polling intervals for an
installed BACnet network that contains graphics containing numerous polled
objects.
For more information, see section 74.1 “BACnet Networks” on page 2573.

To optimize system performance using BACnet polling
intervals
1. In WorkStation, in the System Tree, select the BACnet Interface of the server
that you want to diagnose.
2. On the File menu, point to Properties.
3. Click the Advanced tab and scroll down to the bottom of the page.
4. In the Minimum polling interface for local IP network box, enter the
number of milliseconds for the polling interval for all the installed IP networks,
for example, 1000 (1 second).

5. In the Minimum polling interface for remote network box, enter the
number of milliseconds for an installed remote BACnet network, for example,
1000.
6. In the Minimum polling interface for MSTPA network box, enter the
number of milliseconds (on an Automation Server only) for an installed MS/TP
COMA network, for example, 1000.
7. In the Minimum polling interface for MSTPB network box, enter the
number of milliseconds (on an Automation Server only) for an installed MS/TP
COMB network, for example, 1000.
8. Click OK.
9. In the Watch pane, monitor any change in the CPU or system memory usage.
Keep in mind that the fine-tuning only affects the polled intervals of BACnet objects
that reside on BACnet networks. These polling interval settings override the default
system interval, which is one-half second (500 ms). For example, you can adjust the
polling interval from zero (default) to one second (1000 ms) to adjust the polling
interval frequency of the BACnet objects on IP networks.
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74.15

BACnet Gateway
When your installation includes non-BACnet devices and networks, you can employ
a BACnet Gateway to expose the foreign objects and devices as BACnet objects
and devices. To provide communication, interconnectivity, and visibility, a BACnet
gateway can bridge the primary BACnet network to the non-standard networks.
The two widely used approaches for implementing a BACnet Gateway are BACnet
device and Router to Virtual BACnet devices.

74.15.1

BACnet Gateway as BACnet Device
BACnet Gateways may represent non-BACnet objects as BACnet objects in a
BACnet device. The non-BACnet source objects may reside on the BACnet
Gateway, or on a non-BACnet device and network connected to the BACnet
Gateway.

Figure: BACnet Gateway as BACnet device

The BACnet device method isolates the source objects from the primary BACnet
network to ensure that the primary BACnet network never directly communicates
with the source object.
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74.15.2

BACnet Gateway as Router to Virtual BACnet
Devices
BACnet Gateways represent non-BACnet devices or logical groups of objects that
are on (or connected to and hosted by) a BACnet Gateway as “virtual” BACnet
devices. For example, there is a group of wireless lighting controllers on a ZigBee
network. On the BACnet network, the gateway represents the lighting controllers as
virtual BACnet devices. Although the devices share the same IP address, they
independently respond to BACnet messages. However, each device requires a
unique BACnet instance number as defined by the BACnet Standard.

Figure: BACnet Gateway as router

Note
A BACnet Gateway that routes to virtual BACnet devices may not necessarily be
a device. Therefore, a gateway that is not a device has no properties or objects of
its own. For more information, see section 81.18 “BACnet Gateway Properties –
Basic Tab” on page 2992.

04-16006-04-en, March 2015

Technical
2601

75

BACnet Device Management

Topics
BACnet Device Management
BACnet Device Discovery
Discovering a BACnet Device
Creating a BACnet Device
Creating an I/A Series (MNB) BACnet Device
Associating a BACnet Instance Number with a Device
BACnet Time Synchronization
Configuring a Server as a Time Sync Master for Local Time
Configuring a Server as a Time Sync Master for UTC Time
Configuring a BACnet Device as a Time Sync Master for
Local Time
Editing a Device Recipient
Manually Triggering the Time Recipients List of a Server
Manually Synchronizing an IP Network to Local Time
Manually Synchronizing an IP Network to UTC Time
Manually Synchronizing an MSTP Network to Local Time
Manually Synchronizing an MSTP Network to UTC Time
Manually Synchronizing a Remote Network to Local Time
Manually Synchronizing a Remote Network to UTC Time
Manually Synchronizing a BACnet Device to Local Time

Manually Synchronizing a BACnet Device to UTC Time
Device Communication and Diagnostics
Enabling BACnet Device Communication
Disabling BACnet Device Communication
Disabling Initiation of BACnet Device Communication
Enabling BACnet Interface Communication
Disabling BACnet Interface Communication
Disabling Initiation of BACnet Interface Communication
Refreshing COV Subscriptions
Extended Logging for External BACnet Trend Logs Workflow
BBMDs and Foreign Devices
Creating a BBMD
Configuring a BBMD
Registering a Building Operation Server as a Foreign Device
Teaching a BBMD Configuration to Other BBMDs
Learning a BBMD Configuration from one BBMD to Another
Device Cold Start and Warm Start
Warm Starting a BACnet Device
Cold Starting a BACnet Device
BACnet Backup and Restore
Backing Up a BACnet Device
Restoring a BACnet Device

75 BACnet Device Management
75.1 BACnet Device Management

75.1

BACnet Device Management
BACnet device management is a collection of services that perform administrative,
maintenance, and troubleshooting tasks on a BACnet device.

75.1.1

BACnet Device Discovery
You discover BACnet devices when you want to identify the BACnet devices on a
BACnet network and then add the BACnet devices to the Automation Server or
Enterprise Server.
For more information, see section 75.2 “BACnet Device Discovery” on page 2606.

75.1.2

Hosted I/A Series BACnet (MNB) Devices and
Properties
In Building Operation, I/A Series BACnet devices are simplified versions of generic
BACnet devices. When hosted on an Automation Server or Enterprise Server, these
devices help improve the engineering and runtime performance of I/A Series
BACnet (MNB-70, MNB-300, MNB-V1, MNB-V2 and MNB- 1000) devices.
Hosted I/A Series BACnet devices only include the features supported by their
corresponding I/A Series devices. For example, these simplified devices do not
support intrinsic alarming, and the present value is not commandable for most I/A
Series value objects. Therefore, these objects do not have priority array or relinquish
default properties. Removal of the unsupported features from the I/A Series BACnet
devices improves the object upload time because the server does not try to read
the unsupported properties.
The following tale lists the supported objects and properties.
Table: Supported Objects and Properties for Hosted I/A Series BACnet Devices
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General Object Type

I/A Series Object
Type

Value

Commandable Forceable

BACnet Analog Value

I/A Analog Value

R/W

–

–

I/A Analog COV
Client

R/W

–

X

I/A Analog Monitor

R

–

–

I/A Analog Setpoint

R/W

–

X

I/A Analog Setpoint
Priority

R/W

X

X
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Continued
General Object Type

I/A Series Object
Type

BACnet Binary Value

I/A Binary Value

R/W

–

–

I/A Binary COV
Client

R/W

–

X

I/A Binary Monitor

R

–

–

I/A Binary Setpoint

R/W

–

X

I/A Binary Setpoint
Priority

R/W

X

X

BACnet Multistate

I/A Multistate Value

R/W

–

–

BACnet Analog Input

I/A Analog Input

R

–

X

BACnet Analog Output I/A Analog Output

R/W

X

X

BACnet Multistate
Output

R/W

X

X

I/A Multistate Output

Value

Commandable Forceable

To improve system performance, you can create I/A Series BACnet devices that
operate more efficiently than generic BACnet devices. For more information, see
section 75.5 “Creating an I/A Series (MNB) BACnet Device” on page 2610.

75.1.3

BACnet Download and Upload
You can download and upload the properties of a single object or BACnet device,
or the full contents and properties of a BACnet device.
For more information, see section 78.1 “BACnet Download and Upload” on page
2863.

75.1.4

BACnet Time Synchronization
You can synchronize the time clocks of BACnet devices, and networks of BACnet
devices. Generally, BACnet devices and networks run in the local time of the server
where they reside. However, some BACnet devices or networks located in different
time zones may require synchronization to the UTC time of the server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

75.1.5

Device Cold Start and Warm Start
Building Operation supports the BACnet Reinitialize Device service that controls a
warm start and cold start of a BACnet device.
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For more information, see section 75.36 “Device Cold Start and Warm Start” on
page 2650.

75.1.6

Device Communication and Diagnostics
Building Operation supports the BACnet Communication Control service that
controls the ability of a BACnet device to communicate with other devices in the
BACnet internetwork. You use the service primarily for diagnostic purposes.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

75.1.7

BACnet Backup and Restore
The BACnet backup and restore commands back up and restore BACnet devices.
For more information, see section 75.39 “BACnet Backup and Restore” on page
2653.

75.1.8

BBMDs and Foreign Devices
BACnet Broadcast Management Devices (BBMDs) allow BACnet to operate
through IP routers. A foreign device is a BACnet device that has an IP subnet
address different from those comprising the BACnet/IP network, which the device
seeks to join.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

75.1.9

Extended Logging for External BACnet Trend
Logs Workflow
You configure extended logging for a BACnet trend log to transfer records from an
external BACnet trend log to the Building Operation server. Be sure to create the
extended trend log on the same server that hosts the BACnet device and its trend
log to ensure that they remain synchronized in the event the server needs to be
restored.
For more information, see section 75.29 “Extended Logging for External BACnet
Trend Logs Workflow” on page 2640.
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75.2

BACnet Device Discovery
You discover BACnet devices when you want to identify the BACnet devices on a
BACnet network and then add the BACnet devices to the Automation Server or
Enterprise Server.
When you drag the discovered device from the Device Discovery view to the
System Tree, you create the BACnet device in the Building Operation database.
You then upload the contents of the device to create the objects in the Building
Operation database. For example, you discover a BACnet device called
ACC_3316023 and then drag the device to the IP Network folder in the System
Tree. You then upload the contents of this device.

Figure: Device Discovery View

You can discover BACnet devices and objects on a directly connected network, or
on subnetworks in the BACnet Interface. For more information, see section 73.5
“Automatically Discovering BACnet Subnetworks” on page 2560.
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75.3

Discovering a BACnet Device
You discover BACnet devices in order to create BACnet devices in the Building
Operation server.
For more information, see section 75.2 “BACnet Device Discovery” on page 2606.

To discover a BACnet device
1. In WorkStation, in the System Tree, select the server where you want to
discover the BACnet device.
2. Click the Device Discovery view.

3. In the Select device type box, select BACnet devices.

4. Drag the BACnet device to IP Network or MSTP Network. Use the same
network where the actual BACnet device resides.
5. In the Information dialog box, click OK.

Now that you have discovered the BACnet device, you upload the contents of
the device. For more information, see section 78.12 “Uploading the Contents
of a BACnet Device” on page 2876.
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75.4

Creating a BACnet Device
You create a BACnet device when you want to create a new device on the network.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To create a BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select the network where you want to create a BACnet device.
2. On the File menu, point to New and then click BACnet device.
3. In the Name box, type a name for the BACnet device.

4. In the Description box, type a description for the BACnet device.
5. Click Next.

Continued on next page
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6. Click Download to BACnet device.
Enter an Instance ID if you know it, or leave this blank if you want to
associate the ID with the physical device after the object has been created.
7. In the BACnet name box, type a BACnet name for the device. Do not type a
name if you want a name to be assigned for you.
8. Select Upload from BACnet device to upload the properties of an object in
the BACnet device.
9. Click Create.
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75.5

Creating an I/A Series (MNB) BACnet
Device
You create an I/A BACnet Series device object to host an external I/A device o)n the
BACnet network.
For more information, see section 75.1 “BACnet Device Management” on page
2603.

To create an I/A Series (MNB) BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select the network where you want to host an external I/A device.
2. On the File menu, point to New and then click IA Series Device.
3. In the Name box, type a name for the device.
4. In the Description box, type a description for the device.
5. Click Next.
6. Click Download to BACnet device.
Enter an Instance ID if you know it, or leave this blank if you want to
associate the ID with the physical device after the object is created.
7. In the BACnet name box, leave the field blank.
8. Select Upload from BACnet device to upload the properties of an object in
the BACnet device.
9. Click Create.
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75.6

Associating a BACnet Instance Number
with a Device
You use the Associate with device command in situations where you created a
BACnet device, but did not assign a BACnet instance number to the device. For
example, you may have created a device, but did not know the instance number at
the time. When you use the command, you type the BACnet instance number of
the external BACnet device that you want to associate with the device. After you
complete the procedure, the device is associated with the external BACnet device.
The command cannot be used to change or update an instance number of a
device.

To associate a BACnet instance number with a device
1. In WorkStation, in the System Tree, expand BACnet Interface, then
expand the network where the device resides.
2. Select the device.
3. On the Actions menu, point to Device and then click Associate with
device.

4. In the Device Id box, type the BACnet instance number of the external
BACnet device that you want to associate with the device.

5. Click OK.
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75.7

BACnet Time Synchronization
You can synchronize the time clocks of BACnet devices, and networks of BACnet
devices. Generally, BACnet devices and networks run in the local time of the server
where they reside. However, some BACnet devices or networks located in different
time zones may require synchronization to the UTC time of the server.
You can designate a Building Operation server or BACnet device as a time server to
read the actual time from a reference clock, such as time.nist.gov. In BACnet, a
time server is referred to as a master time controller or time sync master.

Figure: Synchronization of BACnet devices and networks using master time controllers

Using BACnet time synchronization, the following BACnet objects can act as
master time controllers by sending time updates every hour to their recipients:
• BACnet Interface, which is the data portal to the Building Operation server, can
send time synch messages to any BACnet device or network.
• BACnet Device, which supports the time-sync master functionality, can send
time synch messages to any BACnet device or network.
For example, you can configure a router to send time-sync messages to a
remote MS/TP network if the router supports time-sync master functionality.
To do this, you add the router to the recipients list of the server’s BACnet
Interface. For more information, see section 75.10 “Configuring a BACnet
Device as a Time Sync Master for Local Time” on page 2619.
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75.7.1

Local and UTC
In Building Operation, there are two configurable time synchronization settings:
• Use local time to configure BACnet devices and networks located in the same
time zone as the local server, which avoids the need for periodic clock resets,
such as Daylight Savings.
• Use UTC to configure BACnet devices and networks located in different time
zones, or BACnet devices that do not have local time synchronization services.

75.7.2

Automatic Time Sync
Using a master time controller, you can automatically synchronize the time clocks of
BACnet networks and BACnet devices using the following BACnet objects:
• BACnet Interface (server)
For more information, see section 75.8 “Configuring a Server as a Time Sync
Master for Local Time” on page 2615.
For more information, see section 75.9 “Configuring a Server as a Time Sync
Master for UTC Time” on page 2617.
• BACnet device
For more information, see section 75.10 “Configuring a BACnet Device as a
Time Sync Master for Local Time” on page 2619.

Tip
You can force a server to send out time sync notifications that are automatically
synchronized periodically. For more information, see section 75.12 “Manually
Triggering the Time Recipients List of a Server” on page 2622.

75.7.3

Manual Time Sync
You can manually synchronize the time clocks of BACnet networks and BACnet
devices to the following server times:
• Local time
For more information, see section 75.13 “Manually Synchronizing an IP
Network to Local Time” on page 2623.
For more information, see section 75.15 “Manually Synchronizing an MSTP
Network to Local Time” on page 2625.
For more information, see section 75.17 “Manually Synchronizing a Remote
Network to Local Time” on page 2627.
For more information, see section 75.19 “Manually Synchronizing a BACnet
Device to Local Time” on page 2629.
• UTC time
For more information, see section 75.14 “Manually Synchronizing an IP
Network to UTC Time” on page 2624.
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For more information, see section 75.16 “Manually Synchronizing an MSTP
Network to UTC Time” on page 2626.
For more information, see section 75.18 “Manually Synchronizing a Remote
Network to UTC Time” on page 2628.
For more information, see section 75.20 “Manually Synchronizing a BACnet
Device to UTC Time” on page 2630.

Technical
2616

04-16006-04-en, March 2015

75 BACnet Device Management
75.8 Configuring a Server as a Time Sync Master for Local Time

75.8

Configuring a Server as a Time Sync
Master for Local Time
You add recipients to a BACnet Interface to synchronize the time clocks of BACnet
devices (and networks of BACnet devices) that reside in the same time zone to the
local time of the server. Acting as a time sync master, the server synchronizes the
other BACnet devices using the timeSynchronization service.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To configure a server as a time sync master for local time
1. In WorkStation, in the System Tree, select the server and click the Date &
Time tab.
2. Verify that the time zone of the server, which the BACnet Interface inherits, is
correct.
3. Select the BACnet Interface.
4. Click the Time Synchronization Recipients tab.

5. In the Time sync MSTP networks box, select True if the server supports
an MS/TP network.
6. Click
to add a device recipient that you want to receive time updates
based on the local time of the server.
Continued on next page
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7. Configure the device recipient.
Property

Description

Reference

Click to identify the device recipient by referencing the device.

Device ID

Click to identify the device recipient by the instance number of
the BACnet device.

MAC address

Click to identify the device recipient by the network of the device.
Use a MAC and network address when you want to identify
objects not included in the Building Operation database.

Recipient
device object
reference

Enter the reference to a BACnet device.

Recipient
Enter the BACnet instance number of the device.
device identifier
Network ID

Choose one of the following options:
• Type a specific Network ID number.
• Select Global broadcast to send messages to all
networks in the BACnet system.
• Select Local Network to send a message to a device on
a directly connected network (IP or MS/TP).
Local Network, the initial IP network created by the BACnet
Interface wizard, has a network ID of zero (0). Any additional
installed IP network must have a distinct ID number in the
BACnet network.

MS/TP

Enter a number between 0 and 254 for the MS/TP address of
the device recipient on the network.

IP

Enter the IP address and port number for the IP address of the
device recipient.

Raw
(hexadecimal)

Enter the hexadecimal address for the device recipient.

Broadcast

Click to send the message to all devices on the network.

8. Click OK.
9. Click Save.
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75.9

Configuring a Server as a Time Sync
Master for UTC Time
You add recipients to a BACnet Interface to synchronize the time clocks of thirdparty BACnet devices that do not support the local time sync service (or BACnet
devices and networks that reside in a different time zone) to the UTC time of the
local server. Acting as a time sync master, the server synchronizes the other
BACnet devices using the utcTimeSynchronization service.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To configure a server as a time sync master for UTC time
1. In WorkStation, in the System Tree, select the BACnet Interface.
2. Click the Time Synchronization Recipients tab.

3. In the Time sync MSTP networks box, select True if the server supports
an MS/TP network.
4. Click
to add a device recipient that you want to receive time updates
based on the UTC time of the server.
Continued on next page
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5. Configure the device recipient.
Property

Description

Reference

Click to identify the device recipient by referencing the device.

Device ID

Click to identify the device recipient by the instance number of
the BACnet device.

MAC address

Click to identify the device recipient by the network of the device.
Use a MAC and network address when you want to identify
objects not included in the Building Operation database.

Recipient
device object
reference

Enter the reference to a BACnet device.

Recipient
Enter the BACnet instance number of the device.
device identifier
Network ID

Choose one of the following options:
• Type a specific Network ID number.
• Select Global broadcast to send messages to all
networks in the BACnet system.
• Select Local Network to send a message to a device on
a directly connected network (IP or MS/TP).
Local Network, the initial IP network created by the BACnet
Interface wizard, has a network ID of zero (0). Any additional
installed IP network must have a distinct ID number in the
BACnet network.

MS/TP

Enter a number between 0 and 254 for the MS/TP address of
the device recipient on the network.

IP

Enter the IP address and port number for the IP address of the
device recipient.

Raw
(hexadecimal)

Enter the hexadecimal address for the device recipient.

Broadcast

Click to send the message to all devices on the network.

6. Click OK.
7. Click Save.
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75.10

Configuring a BACnet Device as a Time
Sync Master for Local Time
You can add time synch recipients to a BACnet device to synchronize them with its
time clock. Acting as a time sync master, the BACnet device synchronizes the other
BACnet devices using the timeSynchronization service.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To configure a BACnet device as a time sync master for local
time
1. In WorkStation, in the System Tree, expand the BACnet Interface where
the BACnet device resides.
2. Select the BACnet device that you want to configure.
3. Click the Time Synchronization Recipients tab.

4. Click
to add a device recipient that you want to receive time updates
based on the time clock of the BACnet device.
Continued on next page
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5. Configure the device recipient.
Property

Description

Reference

Click to identify the device recipient by referencing the device.

Device ID

Click to identify the device recipient by the instance number of
the BACnet device.

MAC address

Click to identify the device recipient by the network of the device.
Use a MAC and network address when you want to identify
objects not included in the Building Operation database.

Recipient
device object
reference

Enter the reference to a BACnet device.

Recipient
Enter the BACnet instance number of the device.
device identifier
Network ID

Choose one of the following options:
• Type a specific Network ID number.
• Select Global broadcast to send messages to all
networks in the BACnet system.
• Select Local Network to send a message to a device on
a directly connected network (IP or MS/TP).
Local Network, the initial IP network created by the BACnet
Interface wizard, has a network ID of zero (0). Any additional
installed IP network must have a distinct ID number in the
BACnet network.

MS/TP

Enter a number between 0 and 254 for the MS/TP address of
the device recipient on the network.

IP

Enter the IP address and port number for the IP address of the
device recipient.

Raw
(hexadecimal)

Enter the hexadecimal address for the device recipient.

Broadcast

Click to send the message to all devices on the network.

6. Click OK.
7. Click Save.
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75.11

Editing a Device Recipient
You configure a device recipient by specifying a reference, device ID, or MAC
address.
For more information, see section 75.1 “BACnet Device Management” on page
2603.

To edit a device recipient
1. Edit the properties.
Property

Description

Reference

Click to identify the device recipient by referencing the device.

Device ID

Click to identify the device recipient by the instance number of
the BACnet device.

MAC address

Click to identify the device recipient by the network of the device.
Use a MAC and network address when you want to identify
objects not included in the Building Operation database.

Recipient
device object
reference

Enter the reference to a BACnet device.

Recipient
Enter the BACnet instance number of the device.
device identifier
Network ID

Choose one of the following options:
• Type a specific Network ID number.
• Select Global broadcast to send messages to all
networks in the BACnet system.
• Select Local Network to send a message to a device on
a directly connected network (IP or MS/TP).
Local Network, the initial IP network created by the BACnet
Interface wizard, has a network ID of zero (0). Any additional
installed IP network must have a distinct ID number in the
BACnet network.

MS/TP

Enter a number between 0 and 254 for the MS/TP address of
the device recipient on the network.

IP

Enter the IP address and port number for the IP address of the
device recipient.

Raw
(hexadecimal)

Enter the hexadecimal address for the device recipient.

Broadcast

Click to send the message to all devices on the network.

2. Click OK.
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75.12

Manually Triggering the Time Recipients
List of a Server
You can manually force the server to send out time synch notifications to all the
configured recipients.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually trigger the time recipients list of a server
1. In WorkStation, in the System Tree, select BACnet Interface.
2. On the Actions menu, click Send time sync now.
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75.13

Manually Synchronizing an IP Network
to Local Time
You synchronize an IP network to local time when the network is out of sync with
the local server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize an IP network to local time
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the IP Network that you want to synchronize with the server.
3. On the Actions menu, point to Time sync and then click Local.

04-16006-04-en, March 2015

Technical
2625

75 BACnet Device Management
75.14 Manually Synchronizing an IP Network to UTC Time

75.14

Manually Synchronizing an IP Network
to UTC Time
You synchronize an IP network to UTC time to synchronize the network to the UTC
time of the local server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize an IP network to UTC time
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the IP Network that you want to synchronize to UTC time.
3. On the Actions menu, point to Time sync and then click UTC.
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75.15

Manually Synchronizing an MSTP
Network to Local Time
You synchronize an MSTP network to local time when the network is out of sync
with the local Automation Server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize an MSTP network to local time
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the MSTP Network that you want to synchronize with the server.
3. On the Actions menu, point to Time sync and then click Local.
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75.16

Manually Synchronizing an MSTP
Network to UTC Time
You synchronize an MSTP network to UTC time to synchronize the network to the
UTC time of the local Automation Server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize an MSTP network to UTC time
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the MSTP Network that you want to synchronize to UTC time.
3. On the Actions menu, point to Time sync and then click UTC.
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75.17

Manually Synchronizing a Remote
Network to Local Time
You synchronize a remote network to local time when the network is out of sync
with the local server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize a remote network to local time
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the Remote Network that you want to synchronize with the server.
3. On the Actions menu, point to Time sync and then click Local.
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75.18

Manually Synchronizing a Remote
Network to UTC Time
You synchronize a remote network to UTC time to synchronize the network to the
UTC time of the local server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize a remote network to UTC time
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the Remote Network that you want to synchronize to UTC time.
3. On the Actions menu, point to Time sync and then click UTC.
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75.19

Manually Synchronizing a BACnet
Device to Local Time
You synchronize a BACnet device to local time when the device is out of sync with
the server.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize a BACnet device to local time
1. In WorkStation, in the System Tree, select the BACnet device that you want
to synchronize with the server.
2. On the Actions menu, point to Device and then click Time sync.

3. On the Time sync submenu, click Local to synchronize the time of the
BACnet device with the local time of the server.
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75.20

Manually Synchronizing a BACnet
Device to UTC Time
You synchronize BACnet devices located in different time zones, or BACnet devices
that do not have local time services, to UTC time.
For more information, see section 75.7 “BACnet Time Synchronization” on page
2612.

To manually synchronize a BACnet device to UTC time
1. In WorkStation, in the System Tree, select the device that you want to
synchronize with UTC time.
2. On the Actions menu, point to Device and then click Time sync.

3. On the Time sync submenu, click UTC to synchronize the time of the device
with UTC time.
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75.21

Device Communication and Diagnostics
Building Operation supports the BACnet Communication Control service, which
controls the ability of a Building Operation server to communicate with BACnet
networks and devices in the BACnet system. This service also controls the ability of
a BACnet device to communicate with other networks and devices in the BACnet
internetwork. You use the service primarily for diagnostic purposes.

75.21.1

BACnet Interface
You can perform the following diagnostic tasks on the BACnet Interface:
• Enable communication, which instructs the BACnet Interface to clear disable
conditions and resume communication with other BACnet subnetworks and
devices in the BACnet system. For more information, see section 75.25
“Enabling BACnet Interface Communication” on page 2636.
• Disable communication, which instructs the BACnet Interface not to
communicate on the BACnet system. For more information, see section 75.26
“Disabling BACnet Interface Communication” on page 2637.
• Disable initiation of communication, which instructs the BACnet Interface to
respond to requests, but not to initiate new requests on the BACnet system.
For more information, see section 75.27 “Disabling Initiation of BACnet
Interface Communication” on page 2638.

75.21.2

BACnet Device
You can perform the following diagnostic tasks on a BACnet device:
• Enable communication, which instructs a BACnet device to clear disable
conditions and resume communication with other devices on the BACnet
internetwork. For more information, see section 75.22 “Enabling BACnet
Device Communication” on page 2633.
While a device is disabled, the device can still respond to communication
control requests, and requests for warm and cold starts if supported by the
device. To enable device communication following a disable, you can use
Enable communication, or perform a warm start or cold start of the device.
• Disable communication, which instructs a BACnet device not to communicate
on the BACnet internetwork. For more information, see section 75.23
“Disabling BACnet Device Communication” on page 2634.
• Disable initiation of communication, which instructs a BACnet device to
respond to requests, but not to initiate new requests on the BACnet
internetwork. For more information, see section 75.24 “Disabling Initiation of
BACnet Device Communication” on page 2635.
The following table lists the device communication control commands and their
corresponding properties.
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Table: Device Communication Control Commands
Communication Control
Command

Time Duration

Password (if required)

Device Disable

X

X

Device Disable Initiation

X

X

Device Enable

–

X

BACnet Interface Disable

X

–

BACnet Interface Disable
Initiation

X

–

BACnet Interface Enable

–

–

For more information, see section 81.162 “BACnet Device Communication Dialog
Box” on page 3245.

75.21.3

COV Subscriptions
You can immediately refresh COV subscriptions when a BACnet device goes offline
unexpectedly, for example, during a network disconnect or power outage. This
command overrides the system’s five-minute refresh interval for COV variables. For
more information, see section 75.28 “Refreshing COV Subscriptions” on page
2639.
You can view the number of properties using the BACnet COV service as well as
the various polling times on each network. For more information, see section 74.13
“Diagnosing Polled Variables on a BACnet Network” on page 2594.
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75.22

Enabling BACnet Device
Communication
You enable a BACnet device to resume communication with devices on the BACnet
internetwork.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To enable BACnet device communication
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the device resides.
3. Select the disabled BACnet device.
4. On the Actions menu, point to Device and then click Communication.

5. On the Communication submenu, click Enable.
6. In the Password box, type the vendor-supplied password of the device, or
leave the box empty if a password is not required.

7. Click OK.

04-16006-04-en, March 2015

Technical
2635

75 BACnet Device Management
75.23 Disabling BACnet Device Communication

75.23

Disabling BACnet Device
Communication
You disable the communication of a BACnet device to other devices on the BACnet
internetwork when you want to identify problems with the device. Disabled devices
can still receive device communication control requests. If supported by the device,
the disabled device can also receive warm start and cold start requests.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To disable BACnet device communication
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Select the BACnet device that you want to troubleshoot.
4. On the Actions menu, point to Device and then click Communication.

5. On the Communication submenu, click Disable.
6. In the Time Duration box, enter 0 (indefinite) to disable the device until the
device receives an Enable communication request.

7. In the Password box, enter the vendor-supplied password of the device, or
leave the box empty if a password is not required.
8. Click OK.

Technical
2636

04-16006-04-en, March 2015

75 BACnet Device Management
75.24 Disabling Initiation of BACnet Device Communication

75.24

Disabling Initiation of BACnet Device
Communication
You disable the ability of a BACnet device to initiate communication with other
BACnet devices on the internetwork when you want to identify or troubleshoot
problems with the device.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To disable initiation of BACnet device communication
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Select the BACnet device that you want to troubleshoot.
4. On the Actions menu, point to Device and then click Communication.

5. On the Communication submenu, click Disable initiation.
6. In the Time Duration box, enter 0 (indefinite) to disable the BACnet device
until the device receives an Enable communication request.

7. In the Password box, enter the vendor-supplied password of the device, or
leave the box empty if a password is not required.
8. Click OK.
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75.25

Enabling BACnet Interface
Communication
You enable the BACnet Interface to resume communication with devices and
networks in a BACnet system.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To enable BACnet Interface communication
1. In WorkStation, in the System Tree, select BACnet Interface.
2. On the Actions menu, point to Device communication control and then
click Enable.

Technical
2638

04-16006-04-en, March 2015

75 BACnet Device Management
75.26 Disabling BACnet Interface Communication

75.26

Disabling BACnet Interface
Communication
You disable the communication of the BACnet Interface to other devices and
networks in the BACnet system when you want to identify problems with the
interface.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To disable BACnet Interface communication
1. In WorkStation, in the System Tree, select BACnet Interface.
2. On the Actions menu, point to Device communication control and then
click Disable.
3. In the Time Duration box, enter 0 (indefinite) to disable the interface until the
interface receives an Enable communication request.

4. Click OK.
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75.27

Disabling Initiation of BACnet Interface
Communication
You disable the ability of the BACnet Interface to initiate communication with other
BACnet devices and networks when you want to identify or troubleshoot problems
with the interface.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To disable initiation of BACnet Interface communication
1. In WorkStation, in the System Tree, select BACnet Interface.
2. On the Actions menu, point to Device Communication control and then
click Disable initiation.
3. In the Time Duration box, enter 0 (indefinite) to disable the BACnet interface
until the interface receives an Enable communication request.

4. Click OK.
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75.28

Refreshing COV Subscriptions
You can immediately refresh COV subscriptions when a BACnet device goes offline
unexpectedly due to a network disconnect or power outage. This command
overrides the system generated five-minute refresh interval for polled COV variables.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.

To refresh COV subscriptions
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Select the device in the System Tree.
4. On the Actions menu, point to Device and then click Renew COV
subscriptions.
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75.29

Extended Logging for External BACnet
Trend Logs Workflow
You configure extended logging for a BACnet trend log to transfer records from an
external BACnet trend log to the Building Operation server. Be sure to create the
extended trend log on the same server that hosts the BACnet device and its trend
log to ensure that they remain synchronized in the event the server needs to be
restored.
Use this workflow for configuring BACnet trend logs in external BACnet devices.

Figure: BACnet trend log in external BACnet device configuration workflow

Create a BACnet trend log
Create a BACnet trend log in an external device. For more information, see section
76.45 “Creating a BACnet Trend Log (Generic)” on page 2831.

Configure an intrinsic buffer ready alarm?
If an external device supports intrinsic events and notifications in trend logs, you can
configure the reporting properties in the device itself rather than configuring a
separate alarm. To do so, complete these tasks:
• Create a BACnet trend log. For more information, see section 76.43 “Creating
a BACnet Trend Log” on page 2825.
• Configure the intrinsic reporting properties in the external device. For more
information, see section 76.46 “Configuring a BACnet Trend Log (Generic)” on
page 2833.
In Building Operation, this optional feature is supported in some external devices
but not in bCX or b3 devices.
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Create a buffer ready alarm?
If an external device does not support intrinsic events and notifications in trend logs,
you create and configure a separate buffer ready alarm. To do so, complete these
tasks:
• Create a BACnet buffer ready alarm. For more information, see section 79.14
“Creating a BACnet Alarm (Generic)” on page 2917.
• Create a BACnet notification to deliver notifications to the server. For more
information, see section 79.4 “Creating a BACnet Notification (Generic)” on
page 2889.
• Configure the BACnet notification to specify the device recipients and to
determine how the events and acknowledgements are handled. For more
information, see section 79.3 “Configuring a BACnet Notification” on page
2882.

Tip
Set the buffer ready alarm threshold parameter to 10% of the trend log buffer size
to ensure that it works most efficiently with extended trend logs. For example, if
the trend log buffer size is 100, the buffer ready threshold should be 10.

Create an extended trend log
Create an extended trend log in the Application folder of the external device to
monitor the trend log in Building Operation. For more information, see the Creating
an Extended Trend Log topic on WebHelp.

Note
For local BACnet trend logs, you create an extended trend log in the Application
folder of the BACnet interface. For more information, see the Creating an
Extended Trend Log topic on WebHelp.

04-16006-04-en, March 2015

Technical
2643

75 BACnet Device Management
75.30 BBMDs and Foreign Devices

75.30

BBMDs and Foreign Devices
BACnet Broadcast Management Devices (BBMDs) allow BACnet to operate
through IP routers. A foreign device is a BACnet device that has an IP subnet
address different from those comprising the BACnet/IP network, which the device
seeks to join.

75.30.1

BBMDs
The BBMD's primary purpose is to redistribute the essential broadcast messages
that BACnet requires, such as who is/I am broadcasts used for Device Discovery. In
some cases, however, there may be devices on the BACnet/IP internetwork that
are transient. For example, these devices may reside on a subnet where it is not
economical to install, configure, and maintain a BBMD, or where there are no other
BACnet nodes. In this case, BBMDs can enable transient devices to associate
themselves with a BACnet/IP internetwork, which is essential for establishing
communication with them in the BACnet system.

75.30.2

Foreign Devices
A Foreign device may be a full-time node on the foreign subnet or a part-time
participant. There are no restrictions on where foreign devices reside or how they
gain access to the Internet. For example, a foreign device can be a workstation on a
full-time Internet subnet or a laptop at a home office accessing the Internet by way
of an Internet Service Provider. To establish a connection with a Building Operation
server that is outside of the BACnet network, you create a BBMD and then register
the server as a foreign device with the BBMD. For more information, see section
75.33 “Registering a Building Operation Server as a Foreign Device” on page 2647.

Note
BBMDs and foreign devices are mutually exclusive so you either create a BBMD
or a foreign device (or neither) on a particular IP subnet.
In the following illustration, a workstation, which is registered with a BBMD,
becomes a member of the BACnet/IP internetwork and receives broadcast
messages on its behalf. The foreign device can directly communicate with any
BACnet device without registration. However, the foreign device will only receive
broadcasts if the registration process is successful.
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Figure: Foreign Devices in the BACnet system

75.30.3

BBMD Configuration
BBMD includes a Broadcast Distribution table (BTD) that lists the BACnet devices
that are included in the message distribution. To save configuration time, you can
choose one of the following options:
• Teach. Write one BBMD configuration to all other BBMDs in the BACnet
system. For more information, see section 75.34 “Teaching a BBMD
Configuration to Other BBMDs ” on page 2648.
• Learn. Read a BBMD installed on another IP subnet to update a selected
BBMD. For more information, see section 75.35 “Learning a BBMD
Configuration from one BBMD to Another” on page 2649.
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Note
There are no known practical limits on the number of Broadcast Distribution Table
(BDT) entries for the Enterprise Server or Automation Server. For more
information, see the Architectural Guidelines datasheet.
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75.31

Creating a BBMD
You create a BBMD on a Building Operation server to redistribute essential
broadcast messages over the BACnet IP network, which enables Device Discovery.
As a result, the server becomes a BBMD, which contains a Broadcast Distribution
Table (BDT) that lists all the devices to which the BBMD sends broadcast
messages.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

To create a BBMD
1. In WorkStation, in the System Tree, expand the BACnet Interface on
the server.
2. Select the IP Network where you want to create a BBMD.
3. On the File menu, point to New and then click BBMD.
4. In the Name box, type a name for the BBMD.
5. In the Description box, type a description for the BBMD.
6. Click Create.
The server is now a BBMD. You can view or edit the BDT properties of the BBMD.
For more information, see section 81.27 “BBMD BDT Entry Properties – Basic Tab”
on page 3005.
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75.32

Configuring a BBMD
You configure a BBMD to specify the IP subnetwork settings of the BBMD, which
stores the changes as an enty in the Broadcast Distribution Table (BDT).
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

To configure a BBMD
1. In WorkStation, in the System Tree, expand the BACnet Interface of the
server.
2. Expand the IP Network where the BBMD resides.
3. In List View, double click on the BBMD that you want to modify.
4. Double click on the BDT entry within the BBMD.
5. In the IP address box, type the IP address of the BBMD on the subnet.

6. In the IP port number box, type the IP port of the BBMD on the subnet.
7. In the Broadcast distribution mask, type the distribution mask that
specifies how the broadcast messages are distributed on the subnet.
8. Click OK.
The BDT is now configured. You can view or edit the BDT properties. For more
information, see section 81.27 “BBMD BDT Entry Properties – Basic Tab” on page
3005.

Tip
To save configuration time, you can use the Teach or Learn commands to update
multiple BBMDs in the BACnet system.
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75.33

Registering a Building Operation Server
as a Foreign Device
If a Building Operation server and a BBMD are located on different BACnet IP
subnets, you can register the server as a foreign device with the BBMD. Once the
connection is established, the server (and all BACnet/IP devices installed on its
subnet) can receive BACnet broadcasts forwarded from the BBMD. The subnet
also joins the BACnet internetwork.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

To register a Building Operation server as a foreign device
1. In WorkStation, in the System Tree, select the BACnet IP Network of
the server that you want to register as a foreign device.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Verify that the server is located on a different IP subnet than the BBMD to
avoid a routing loop or broadcast storm.
5. In the BBMD IP address box, type the IP address of the BBMD.
6. In the BBMD port number box, enter the port number of the BBMD.
7. Click OK.
The server is now a member of the BACnet/IP internetwork and receives forwarded
broadcast messages from the BBMD when they are available. You can now use
Device Discovery to locate the BACnet devices on the subnet where the registered
server resides. For more information, see section 75.2 “BACnet Device Discovery”
on page 2606.
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75.34

Teaching a BBMD Configuration to
Other BBMDs
Using the Teach command, you can send a BBMD configuration table (BDT) to
update all other BBMDs in the system.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

To teach a BBMD configuration to other BBMDs
1. In WorkStation, in the System Tree, expand the BACnet Interface of the
server where the BBMD resides.
2. Expand the IP Network.
3. Right click on the BBMD and click Teach.
All the BBMDs in the system are now configured. You can view the individual BBMD
configurations. For more information, see section 81.27 “BBMD BDT Entry
Properties – Basic Tab” on page 3005.
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75.35

Learning a BBMD Configuration from
one BBMD to Another
To save configuration time, you can copy one BBMD configuration to another using
the Learn BDT Table command.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

To learn a BBMD configuration from one BBMD to another
1. In WorkStation, in the System Tree, expand the BACnet Interface on the
server where the BBMD is installed.
2. Expand the IP Network.
3. Right click on the BBMD and point to Learn BDT Table.
4. In the IP Address box, type the IP address of the BBMD from which you
want to copy the configuration.
5. In the Port Number box, type the port of the BBMD.
6. Click OK.
The BBMD is now configured. You can view the BDT configuration. For more
information, see section 81.27 “BBMD BDT Entry Properties – Basic Tab” on page
3005.
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75.36

Device Cold Start and Warm Start
Building Operation supports the BACnet Reinitialize Device service that controls a
warm start and cold start of a BACnet device.
In WorkStation, you use the following menu options to invoke the Reinitialize Device
service:
• Cold start, which instructs a BACnet device to reboot itself.
With a cold start, some devices retain the object database, the object list, and
configuration information; however, depending on vendor implementation,
some devices do not retain the object list. The run-time data is usually not
preserved. For more information, see section 75.38 “Cold Starting a BACnet
Device” on page 2652.
• Warm start, which instructs a BACnet device to reset itself to a predefined
initial state.
With a warm start, the device retains all configuration data, run-time data, and
the values of objects. For more information, see section 75.37 “Warm Starting
a BACnet Device” on page 2651.
When you use the Warm start or Cold start menu option, you are prompted to enter
a vendor-supplied device password. Not all devices, however, are password
protected. If the device does not require a password, you can click OK to continue.
For more information, see section 81.163 “BACnet Password Dialog Box” on page
3246.
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75.37

Warm Starting a BACnet Device
You warm start a BACnet device when you want the device to reset itself. When
you warm start a device, the device retains all configuration data, run time data, and
the values of objects. You use the Warm start command to direct the device to
reset itself.

To warm start a BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface, then
expand the network where the BACnet device resides.
2. Select the BACnet device.
3. On the Actions menu, point to Device and then click Restart.

4. On the Restart submenu, click Warm start.
5. In the Password box, enter the vendor-supplied password of the device, or
leave the box empty if a password is not required.

6. Click OK.
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75.38

Cold Starting a BACnet Device
You cold start a BACnet device when you want to reboot the device. Some devices
retain the object database, the object list, and configuration information. However,
some devices do not retain the object list depending on vendor implementation.
The run-time data is usually not preserved. You use the Cold start command to
reboot a BACnet device.

To cold start a BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface, then
expand the network where the BACnet device resides.
2. Selet the BACnet device.
3. On the Actions menu, point to Device and then click Restart.

4. On the Restart submenu, click Cold start.
5. In the Password box, enter the vendor-supplied password of the device, or
leave the box empty if a password is not required.

6. Click OK.
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75.39

BACnet Backup and Restore
The BACnet backup and restore commands back up and restore BACnet devices.

Figure: Comparison of Building Operation and BACnet backup methods

When you back up a device, Building Operation creates a backup file, which is
stored in the file system of the local server. One backup file per device is created
and saved, and only one file can exist at a time. When you run the backup again,
the previous file is overwritten. The content in the backup file varies according to the
device. For instance, some BACnet devices support the backup of configuration
properties only, while other devices support the backup of all the objects in a
device, such as trends and alarms.

Online and offline
A backup only operates when a device is online. Conversely, a restore only
operates when a device is offline. In most cases, the device automatically goes
back online once the restore is completed.

75.39.1

BACnet Backup and Restore Services
BACnet Backup and Restore services are required for backing up and restoring
BACnet devices. Therefore, verify that these devices support the following BACnet
services: ReinitializeDevice, ReadProperty, WriteProperty, AtomicWriteFile,
AtomicReadFile, and CreateObject (optional, not required).
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75.39.2

BACnet Backup and Restore Properties
You can find BACnet backup and restore information on b3, bCX, and BACnet
device properties, and BACnet Interface properties.
The following table lists the BACnet backup and restore properties and where they
are located.
BACnet device –
Advanced Tab

BACnet Interface –
Basic Tab

Backup path

X

–

Backup configuration files

X

–

Last restore time

X

–

Last backup time

X

–

Backup and restore state

–

X

Backup failure timeout

X

X

Backup preparation time

–

X

Restore preparation time

–

X

Restore completion time

–

X

Property

75.39.3

b3 BACnet Devices
Before backing up or restoring b3 devices, first determine how the b3 devices are
configured in your system. If the b3s are connected:
• Either to a bCX controller or third-party router device, use the BACnet backup
and restore commands.
For more information, see section 75.40 “Backing Up a BACnet Device” on
page 2655.
For more information, see section 75.41 “Restoring a BACnet Device” on page
2657.
• To an Automation Server that functions as a controller or a router, use the
Building Operation (server) backup and restore commands.
For more information, see the Backing Up Servers Manually topic on WebHelp.
For more information, see the Restoring a Server topic on WebHelp.
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75.40

Backing Up a BACnet Device
You back up a BACnet device using BACnet backup commands if the device
supports the BACnet Backup and Restore services.

To back up a BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Select the BACnet device that you want to back up.
4. On the Actions menu, point to Device and then click Backup.

5. In the Password box, type the vendor supplied password, or leave the box
empty if a password is not required.

6. Click OK.
Continued on next page
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7. In Progress view, click Close when the backup finishes.
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75.41

Restoring a BACnet Device
You restore a BACnet device using BACnet backup commands if the device
supports the BACnet Backup and Restore services.

To restore a BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Select the BACnet device.
4. On the Actions menu, point to Device and then click Restore.

5. In the Password box, type the vendor supplied password, or leave the box
empty if a password is not required.

6. Click OK.
Continued on next page
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7. In Progress view, click Close when the restore finishes.
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76.1

BACnet Objects and Properties
You can create BACnet objects in Automation Servers, Enterprise Servers, and
BACnet devices in the Building Operation database.
When you create an object in a device, you need to perform one of the following
operations:
• Download to a device to update all of the objects and properties in the BACnet
device. For more information, see section 78.5 “Downloading the Contents of a
BACnet Device” on page 2868.
• Upload from a device to upload all the objects and properties from a BACnet
device into Building Operation. For more information, see section 78.12
“Uploading the Contents of a BACnet Device” on page 2876.
For example, if an external client modifies an object in a device, that object needs to
be uploaded in order to synchronize it with Building Operation. If Building Operation
modifies an object offline when communicating with the device, that object is also
out of synch and must be downloaded.
Server objects operate the server, while objects in other devices are owned by
those devices. To differentiate a server object from a device object, the system
adds the term, generic, to the end of the device name. For example, the name of an
input installed on a server is a BACnet Analog Input while an input installed on a
device is a BACnet Analog Input (Generic). In addition, there is support for
specialized devices, such as a Continuum Workstation.
Server objects do not need to be uploaded or downloaded. Instead, these objects
are used to publish data so that data can be exposed to external clients through the
Building Operation server.

Tip
While you can create Script and Function Block programs in the Application
folder, they are not visible to external BACnet clients.

76.1.1

Supported BACnet Object Types
As of BACnet protocol revision 6, Building Operation supports all BACnet object
types.
For more information, see section 76.2 “Supported BACnet Object Types” on page
2665.

76.1.2

BACnet Object Properties
BACnet objects and devices have a variety of required and optional properties that
are used for the purposes of identification, reliability indication, and configuration of
the object or device, and for prioritization of write requests.
For more information, see section 76.4 “BACnet Object Properties” on page 2667.

04-16006-04-en, March 2015

Technical
2665

76 BACnet Objects and Properties
76.1 BACnet Objects and Properties

76.1.3

BACnet Command Priorities
A building automation system may include objects that are manipulated and written
to by other objects, operators, or applications. However, conflicts may arise when
these different entities try to write to the same commandable value property of a
BACnet object, such as a digital output.
For more information, see section 77.1 “BACnet Command Priorities” on page
2849.

76.1.4

BACnet Device Object Indicator – Executed By
To make it easier to locate objects, you can differentiate BACnet device objects
executed by a BACnet device from those executed by a Building Operation server.
For more information, see section 76.6 “BACnet Device Object Indicator –
Executed By” on page 2670.

76.1.5

BACnet String
For BACnet objects that support BACnet strings, you can enter text that displays as
readable text to users. For example, you can display a message that the room
temperature reached the configured setpoint.

Note
The BACnet string does not support intrinsic reporting and Present Value is not
commandable.
For more information, see section 76.42 “Changing a BACnet String” on page
2824.
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76.2

Supported BACnet Object Types
As of BACnet protocol revision 6, Building Operation supports all BACnet object
types.

76.2.1

Table of Supported Object Types
In Building Operation, an object type comprises both device and server objects.
For more information, see section 76.3 “Table of Supported Object Types” on page
2666.

76.2.2

BACnet Notifications
A BACnet notification is the Building Operation equivalent of a BACnet notification
class. A BACnet notification defines what devices to notify when a transition from
one event state to another has occurred, such as a to-normal event has
transitioned to a to-fault event.
For more information, see section 79.1 “BACnet Notifications” on page 2879.

76.2.3

BACnet Alarms
A BACnet alarm is the Building Operation equivalent of an Event Enrollment. A
BACnet alarm defines the conditions of an event and identifies the property to be
monitored.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

76.2.4

BACnet Schedules
A BACnet schedule controls a writable property of an object by writing a value at a
specified time and date.
For more information, see section 80.1 “BACnet Schedules” on page 2935.
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76.3

Table of Supported Object Types
In Building Operation, an object type comprises both device and server objects.
The following table lists the device types that you can install at the server or device
level.
Table: Supported Object Types
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Object type

Server

Device (Generic)

Accumulator

–

X

Analog Input

X

X

Analog Output

X

X

Analog Value

X

X

Averaging

–

X

Binary Input

X

X

Binary Output

X

X

Binary Value

X

X

Calendar

X

X

Command

–

X

Device

X

X

Event Enrollment

X

X

File

–

X

Load Control

–

X

Loop

X

X

Multistate Input

X

X

Multistate Output

X

X

Multistate Value

X

X

Notification Class

X

X

Program

–

X

Pulse Converter

–

X

Schedule

X

X

Trend Log

X

X
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76.4

BACnet Object Properties
BACnet objects and devices have a variety of required and optional properties that
are used for the purposes of identification, reliability indication, and configuration of
the object or device, and for prioritization of write requests.

76.4.1

Required BACnet Identification Properties
BACnet devices and objects have required properties as defined by the ASHRAE
Standard. BACnet devices and objects have to support required properties.
Optional properties are also defined by the ASHRAE Standard. However,
manufacturers can determine whether to support the optional properties in their
devices and objects.

76.4.2

Required BACnet
Identification Property

Building Operation
Property

Description

Object Identifier

Object ID

Object ID is equivalent to
Object identifier. However,
Object ID includes the object
type as well as the instance
number of the object.

Object name

BACnet name

BACnet name is equivalent
to Object name.

Object type

BACnet type

BACnet type is equivalent to
Object type.

BACnet Reliability Property
A number of BACnet object types have a property called Reliability that indicates
the reliability of the Value property or the operation of the BACnet object.
For more information, see section 76.5 “BACnet Reliability Property” on page 2669.

76.4.3

BACnet Configuration Properties
You can download and upload the configuration properties of a BACnet device.
Configuration properties include such items as Daylight savings status, UTC offset,
and APDU timeout.
For more information, see section 76.7 “BACnet Configuration Properties” on page
2671.

76.4.4

BACnet Command Priorities
A building automation system may include objects that are manipulated and written
to by other objects, operators, or applications. However, conflicts may arise when
these different entities try to write to the same commandable value property of a
BACnet object, such as a digital output.
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For more information, see section 77.1 “BACnet Command Priorities” on page
2849.

76.4.5

BACnet Status Flags
Status flags indicate a change in the normal state of a BACnet object or device, and
can be used to trigger alarms and notifications. However, the various status
properties must be included in a BACnet object or device before the system can
display the corresponding status flags.
For more information, see section 76.9 “BACnet Status Flags” on page 2673.
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76.5

BACnet Reliability Property
A number of BACnet object types have a property called Reliability that indicates
the reliability of the Value property or the operation of the BACnet object.
The following table lists the possible values for this property.
Table: BACnet Reliability Properties
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Value

Description

no fault detected

The present value is reliable.

no sensor

No sensor is connected to the input object.

over range

A sensor connected to the input is reading a value higher than the
normal operating range. This is possible if the object is a binary
input and the binary state is derived from an analog sensor or a
binary input equipped with electrical loop supervision circuits.

under range

A sensor connected to the input is reading a value lower than the
normal operating range. This is possible if the object is a binary
input and the binary input is actually a binary state calculated from
an analog sensor.

open loop

The connection between the defined object and the physical
device provides a value specifying an open circuit condition.

shorted loop

The connection between the defined object and the physical
device provides a value specifying a short circuit condition.

no output

No physical device is connected to the output object.

multistate fault

The present value of the multistate object is equal to one of the
states in the Is fault value property.

configuration error

The object's properties are not in a consistent state.

unreliable other

The controller has detected that the present value is unreliable.
However, none of the other conditions describe the problem. A
generic fault, other than those listed here, has been detected. For
example, a binary input is not cycling as expected.
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76.6

BACnet Device Object Indicator –
Executed By
To make it easier to locate objects, you can differentiate BACnet device objects
executed by a BACnet device from those executed by a Building Operation server.
To do this, you add the Executed by column in the List View of the Application
folder of an external BACnet device. Use this column to view, group, and sort the
objects. There are two values for Executed by: BACnet device and no entry
(blank). BACnet device indicates the object is executed by a BACnet device. An
empty field indicates the object is executed by an Automation Server or Enterprise
Server. For example, a BACnet Digital Value displays BACnet device while a
Building Operation Trend Chart remains blank.

Figure: Executed by column in List View

For more information, see the Columns in Views and Panes topic on WebHelp.
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76.7

BACnet Configuration Properties
You can download and upload the configuration properties of a BACnet device.
Configuration properties include such items as Daylight savings status, UTC offset,
and APDU timeout.

76.7.1

BACnet Download
You download data when you want to use the data in the Building Operation server
rather than the data that is in the physical device. For example, you can download
the properties of a single object or the entire contents of a BACnet device.
For more information, see section 78.2 “BACnet Download” on page 2864.

76.7.2

BACnet Upload
You upload data when you want to use the data that is in the physical device rather
than the data in the Building Operation server. For example, you can upload the
properties of a single object or the full contents of a BACnet device.
For more information, see section 78.9 “BACnet Upload” on page 2872.
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76.8

Updating the Object List of a BACnet
Device
You use the Update object list command when you want to view an up-to-date
list of objects in a BACnet device that resides in the Hardware folder.

To update the object list of a BACnet device
1. In WorkStation, in the System Tree, expand Hardware, expand BACnet
devices.
2. Expand the network where the BACnet device resides, then expand the
BACnet device.

3. Select Application.
4. On the Actions menu, click Update object list.

5. Click the Refresh button
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76.9

BACnet Status Flags
Status flags indicate a change in the normal state of a BACnet object or device, and
can be used to trigger alarms and notifications. However, the various status
properties must be included in a BACnet object or device before the system can
display the corresponding status flags.

Figure: BACnet alarm and fault status flags for an open loop before and after configuration

The following table lists the BACnet status flags and their states.
Table: BACnet Status Flags
Status Flag

Description

In alarm

Displays a check when the Event state has a condition other than
Normal, such as Off-normal. For more information, see section
79.1 “BACnet Notifications” on page 2879.
The box remains unchecked if intrinsic alarming is not supported
by the object. For more information, see section 79.6 “BACnet
Alarms” on page 2898.
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Fault

This flag is supported by BACnet objects, for example, multistate
inputs and values, trend logs, and loops. Fault is also associated
with the Reliability property. If supported, the system displays a
check when a fault is detected, such as an open loop. For more
information, see section 76.5 “BACnet Reliability Property” on
page 2669.

Overridden

This flag is not supported by Building Operation servers. However,
there may be other devices in the BACnet network that have
override switches, for example, b3920s, b3810s, and b3814s as
well as some xP modules that are attached to b3 devices. If
supported, a check displays when the switch is in the manual
position on the device. When a manual override occurs, the device
goes out of service.
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Continued
Status Flag

Description

Out of service

Displays a check if one of the following conditions occur:
• The Out of service property is set to True.
• An override switch is in the manual position on the device.
• The point is not configured with a valid I/O channel on the
Building Operation server.
• There is a break or decoupling in the connection between the
Associated value and the Value property on the Building
Operation server.
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76.10

Creating a BACnet Point in a Server
You create a BACnet analog, digital, or multistate point in a local server so you can
then configure the BACnet point for a non-BACnet device, such as an Automation
Server IO module or LON device. BACnet points that are configured for a nonBACnet device are visible to other workstations and devices in the BACnet
internetwork.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

To create a BACnet point in a server
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. On the File menu, point to New and then click Point.
3. In the object type list, select the type of point that you want to create.

4. In the Name box, type a name for the point.
5. In the Description box, type a description for the point.
6. Click Next.
Continued on next page
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7. In the Instance ID box, choose one of the following options:
• Automatically generated: The server generates a BACnet instance ID.
• Manually entered: Enter an Instance ID.

8. In the BACnet name box, type a BACnet name for the point.
Do not type a name if you want a name to be assigned for you.
9. In the Command priority retain level box, select one of the following
options to configure the warm start and cold start settings for a command
priority array:
• Warm start: The variable retains the last value set by a user or
application. However, the variable reverts to the default value for a cold
start.
• Cold start: The variable retains the last value set by a user or application
for a warm start or cold start.
• No: The variable reverts to the default value upon a restart.
10. Click Create.
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76.11

Configuring a BACnet Analog Input
Point
You configure a BACnet analog input point to associate the value of an analog input
point on an Automation Server IO module with the BACnet analog input point. You
associate the points to derive the value from the input point of the IO module. You
can also configure an intrinsic alarm for the point if supported by the device.

To configure a BACnet analog input point
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the analog input point that you want to configure.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Under Status Information, click the Configure button
property.

for the Value

6. Edit the properties.
Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.

7. Click OK to close the Value dialog box and return to the Basic tab.
8. Under Configuration Settings, click the Configure button
Associated value property.

for the

Continued on next page
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9. Edit the properties.
Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.

10. Click OK to to close the Associated value dialog box and return to the
Basic tab.

Continued on next page
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11. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Associated
value

Displays the value of the referenced property.

COV increment

Enter the minimum change in the Value property that causes a
COV notification to be sent.

12. Click OK.
Continued on next page
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13. Click the Advanced tab.

Continued on next page
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14. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name
BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.
Continued on next page
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Continued
Property

Description

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit, and
Deadband. For example, if you enter 5 seconds and the Value
remains outside the Upper limit and Lower limit boundaries for a
minimum of 5 seconds, the system generates a to-off-normal
event.

Deadband

Enter a range that is an offset from the low-level and high-level
limits, which defines the range where a to-normal event can be
generated. To generate a to-normal event, the value must be
above the low limit and below the high limit, minus the
deadband. For generic objects, this property is present only in
analog objects from external devices that support intrinsic
reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower
limit off-normal events and to-normal events. Select High
limit enable to enable the reporting of Upper limit off-normal
events and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

15. Click OK.
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76.12

Configuring a BACnet Digital Input
Point
You configure a BACnet digital input point to associate the value of a digital input
point on an Automation Server IO module with the BACnet digital input point. You
associate the points in order to derive the value from the input point of the IO
module. You can also configure an intrinsic alarm for the point.

To configure a BACnet digital input point
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the digital input point that you want to configure.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Under Configuration Settings, click the Configure button
Associated value property.

for the

6. Edit the properties.

04-16006-04-en, March 2015

Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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7. Click OK to close the Value dialog box and return to the Basic tab.

Continued on next page
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8. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Associated
value

Displays the value of the referenced property.

Polarity

Select one of the following options to control the relationship
between the BACnet point and the point of the Automation
Server IO module:
• Normal if you want the Associated value of True to
equal Active.
• Reverse if you want the Associated value of False to
equal Active.

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text
for the Value property and related priority array values. It is visible
in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text
for the Value property and related priority array values. It is visible
in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.
Continued on next page
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Continued
9. Click OK.
10. Click the Advanced tab.

Continued on next page
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11. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.
Continued on next page
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Continued
Property

Description

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit, and
Deadband. For example, if you enter 5 seconds and the Value
remains outside the Upper limit and Lower limit boundaries for a
minimum of 5 seconds, the system generates a to-off-normal
event.

Deadband

Enter a range that is an offset from the low-level and high-level
limits, which defines the range where a to-normal event can be
generated. To generate a to-normal event, the value must be
above the low limit and below the high limit, minus the
deadband. For generic objects, this property is present only in
analog objects from external devices that support intrinsic
reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower
limit off-normal events and to-normal events. Select High
limit enable to enable the reporting of Upper limit off-normal
events and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Note
• The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit,
and Deadband. For example, if you enter 5 seconds and the
Value remains outside the Upper limit and Lower limit
boundaries for a minimum of 5 seconds, the system generates a
to-off-normal event.
12. Click OK.
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76.13

Configuring a BACnet Multistate Input
Point
You configure a BACnet multistate input point to associate the value of a multistate
input point on an Automation Server IO module with the BACnet multistate input
point. You associate the points to derive the value from the input point of the IO
module. You can also configure an intrinsic alarm for the point if supported by the
device.

To configure a BACnet multistate input point
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the multistate input point that you want to configure.
3. On the File menu, click Open.
4. Click the State Configuration tab.
5. In the Number of states box, enter the number of states that you want to
create, for example, enter 3 if you want to create 3 states.

6. In the Label column, click the text and then type a description for the state
number, such as Unoccupied, Standby, or Warmup.
Repeat this step for each state that you created.
7. Click the Save button

.
Continued on next page
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8. Click the Properties tab and then click the Basic tab.

Continued on next page
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9. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Reliability

Displays the reliability of the point.

Associated
value

Displays the value of the referenced property.

Associated
value offset

Enter an offset value, which is a combination of the Associated
value and Associated offset value.

10. Click the Save button

.
Continued on next page
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11. Click the Advanced tab.

Continued on next page
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12. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

State Id

Enter the State Id for which you want to set an alarm or fault
alarm.
Continued on next page
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Continued
Property

Description

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you
select Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you
select Yes, select No for Is alarm value.
Click to add an alarm or fault State Id to the list of alarm and
fault values.
Click to open the Properties dialog box where you can edit
the alarm or fault configuration for a selected State Id. For
more information, see section 81.62 “BACnet Multistate Alarm
Properties Dialog Box” on page 3069.
Click to remove the State Id from the list of alarm or fault
values.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.
For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

13. Click

to create a multistate alarm.

14. Type a name for the alarm and click Create.

15. Repeat the process until you have the desired number of alarms.
Continued on next page
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16. Select an alarm from the list and click

to modify an alarm.

17. Edit the properties.
Property

Description

State Id

Enter the state that you want to configure for the multistate
point or value.

Is alarm value

Select Yes to assign an alarm to the State Id. Then, select No
for Is fault value.

Is fault value

Select Yes to assign a fault alarm to the State Id. Then, select
No for Is alarm value.

18. Click OK to return to the Advanced tab.
19. Repeat the steps to modify another alarm.
20. Click the Save button
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76.14

Configuring a BACnet Analog Output
Point
You configure a BACnet analog output point to associate the value of the point on
an Automation Server IO module with the BACnet analog output point. You
associate the points to control the value of the IO module point. You can also
configure an intrinsic alarm for the point if supported by the device.

To configure a BACnet analog output point
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the analog output point that you want to configure.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Under Status Information, click the Configure button
property.

for the Value

6. Edit the properties.
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Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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7. Click OK to close the Value dialog box and return to the Basic tab.

Continued on next page
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8. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Associated
value

Displays the value of the referenced property.

COV increment

Enter the minimum change in the Value property that causes a
COV notification to be sent.

9. Click OK.
Continued on next page
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10. Click the Advanced tab.

Continued on next page
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11. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.
Continued on next page
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Continued
Property

Description

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit, and
Deadband. For example, if you enter 5 seconds and the Value
remains outside the Upper limit and Lower limit boundaries for a
minimum of 5 seconds, the system generates a to-off-normal
event.

Deadband

Enter a range that is an offset from the low-level and high-level
limits, which defines the range where a to-normal event can be
generated. To generate a to-normal event, the value must be
above the low limit and below the high limit, minus the
deadband. For generic objects, this property is present only in
analog objects from external devices that support intrinsic
reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower
limit off-normal events and to-normal events. Select High
limit enable to enable the reporting of Upper limit off-normal
events and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Note
• The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit,
and Deadband. For example, if you enter 5 seconds and the
Value remains outside the Upper limit and Lower limit
boundaries for a minimum of 5 seconds, the system generates a
to-off-normal event.
12. Click OK.
13. Click the Command tab.
Continued on next page
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14. Edit the properties.

Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

15. Click OK.
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76.15

Configuring a BACnet Digital Output
Point
You configure a BACnet digital output point to associate the value of a digital output
point on an Automation Server IO module with the BACnet digital output point. You
associate the points in order to control the value of the IO module point.

To configure a BACnet digital output point
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the digital output point that you want to configure.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Under Status Information, click the Configure button
property.

for the Value

6. Edit the properties.
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Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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7. Click OK to close the Value dialog box and return to the Basic tab.

Continued on next page
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8. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Select True to disassociate the Value from the physical output.
Out of service is primarily used for testing purposes.

Event state

Displays one of the following active event states associated with
the point:
• Normal when the point is not in an alarm state.
• Off Normal when the Intrinsic Alarm is configured and the
point is in an alarm state.

Associated value Displays the read-only value of the property that is associated
with the BACnet point.
Polarity

Select one of the following options to control the relationship
between the BACnet point and the point of the Automation
Server IO module:
• Normal if you want the Associated value of True to
equal Active.
• Reverse if you want the Associated value of False to
equal Active.

Inactive text

Type the text that explains the Inactive state of the value, such
as Pump_Basement_Off. This text is used as an enumeration
text for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties
pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties
pane.
If you leave this box empty, the default (Active) is used instead.
Continued on next page
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Continued
9. Click OK.
10. Click the Advanced tab.

11. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

12. Click OK.
Continued on next page
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13. Click the Command tab.

14. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

15. Click OK.
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76.16

Configuring a BACnet Multistate Output
Point
You configure a BACnet multistate output point to associate the value of a
multistate output point on an Automation Server IO module with the BACnet
multistate output point. You associate the points in order to control the value of the
IO module point. You can also enter a value for the Relinquish default property.

To configure a BACnet multistate output point
1. In WorkStation, in the System Tree, expand BACnet Interface and select
Application.
2. In List View, select the multistate output point that you want to configure.
3. On the File menu, click Open.
4. Click the State Configuration tab.
5. In the Number of states box, enter the number of states that you want to
create, for example, enter 3 if you want to create 3 states.

Use the up arrow to enter the number.
6. In the Label column, click the text and then type a description for the state
number, such as Unoccupied, Standby, or Warmup.
Repeat this step for each state that you created.
7. Click the Save button

.

8. Click the Properties tab and then click the Basic tab.
9. Under Status Information, click the Configure button
property.

for the Value
Continued on next page

Technical
2710

04-16006-04-en, March 2015

76 BACnet Objects and Properties
76.16 Configuring a BACnet Multistate Output Point

10. Edit the properties.
Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.

11. Click OK to return to the Basic tab.

Continued on next page
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12. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Associated
value

Displays the value to be read by the referenced property.

Associated
value offset

Enter an offset value, which is a combination of the Associated
value and Associated offset value.

13. Click the Save button

.

14. Click the Advanced tab.
15. In the BACnet name box, type a name for the multistate point.

16. Click the Save button

.
Continued on next page
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17. Click the Command tab.

18. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

19. Click the Save button
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76.17

Creating a BACnet Point (Generic)
You create an analog, digital, or multistate BACnet point (generic) for a device when
you want to view and configure a BACnet point in an external BACnet device.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.
When you create the BACnet point (generic), you need to perform one of the
following operations:
• Download to a device to create a point in an external BACnet device. For more
information, see section 76.7 “BACnet Configuration Properties” on page
2671.
• Upload from a device to upload the properties of a point from a BACnet device
into Building Operation.
After you create the point, you can use WorkStation to configure and modify the
point, and perform additional BACnet interoperable tasks with the object.

To create a BACnet point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, expand
the network where the device resides, then expand the device.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select the type of point that you want to create.

5. In the Name box, type a name for the point.
6. In the Description box, type a description for the point.
Continued on next page

Technical
2714

04-16006-04-en, March 2015

76 BACnet Objects and Properties
76.17 Creating a BACnet Point (Generic)

7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated. Once
created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the point. Do not type a
name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.18

Configuring a BACnet Analog Input
Point (Generic)
You configure a BACnet analog input (generic) to configure the properties of an
analog input point in an external BACnet device. You can also configure an intrinsic
alarm for the point.

To configure a BACnet analog input point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the external analog input point resides and select
Application.
3. In List View, select the analog input point (generic) that you want to
configure.
4. On the File menu, click Properties.
5. Click the Basic tab.
6. Under Status Information, click the Configure button
property.

for the Value

7. Edit the properties.
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Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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8. Click OK to close the Value dialog box and return to the Basic tab.

Continued on next page
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9. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

COV increment

Enter the minimum change in the Value property that causes a
COV notification to be sent.

Update interval Displays the maximum amount of time between updates to the
Value property when the input is not Overridden and Out of
service is False. The time value is hundredths of a second.
Minimum value

Enter the lowest value that can be reliably derived for the Value
property.

Maximum value Enter the highest value that can be reliably derived for the Value
property.
Resolution

Displays the smallest recognizable change in the Value property.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe
the type of sensor connected to an analog input or the type of
sensor represented by an accumulator.

10. Click OK.
Continued on next page
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11. Click the Advanced tab.

Continued on next page
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12. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal
transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal
transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.
Continued on next page
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Continued
Property

Description

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit, and
Deadband. For example, if you enter 5 seconds and the Value
remains outside the Upper limit and Lower limit boundaries for a
minimum of 5 seconds, the system generates a to-off-normal
event.

Deadband

Enter a range that is an offset from the low-level and high-level
limits, which defines the range where a to-normal event can be
generated. To generate a to-normal event, the value must be
above the low limit and below the high limit, minus the
deadband. For generic objects, this property is present only in
analog objects from external devices that support intrinsic
reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower
limit off-normal events and to-normal events. Select High
limit enable to enable the reporting of Upper limit off-normal
events and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from an external device displays in the Alarm
text field instead of the configured text.
13. Click OK.
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76.19

Configuring a BACnet Digital Input
Point (Generic)
You configure a BACnet digital input (generic) to configure the properties of a digital
input point in a BACnet device. You can also configure an intrinsic alarm for the
point.

To configure a BACnet digital input point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the digital input point (generic) resides and select
Application.
3. In List View, select the digital input point (generic) that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.
6. Click the Configure button

for the Value property.

7. Edit the properties.
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Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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8. Click OK to return to the Basic tab.

Continued on next page
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9. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for
the point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value
or click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out
of service. For more information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For
more information, see section 77.7 “Forced Priority Level” on
page 2857.

Status flags

Displays the condition or status of the BACnet point. For
more information, see section 76.9 “BACnet Status Flags” on
page 2673.

Out of service

Set to True to decouple the Value from the associated
property. If the associated property is not configured, this
property is True and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

Change of state
time

Displays the reliability of the point.

Change of state
count

Displays how often the Value property has changed state
since the Change of state count was last set to 0. The
Change of state count increments when the Value
property has a change of state based on an event that alters
the Value property.
Enter 0 if you want to reset the Change of state count.

Time of state count Displays the date and time when the Change of state
reset
count was last set to 0.
Elapsed active time Displays the number of seconds that the Value property
was Active since the Elapsed active time was last set to
0.
Enter 0 if you want to reset the Elapsed active time.
Time of active time Displays the date and time when Elapsed active time was
reset
last set to 0.
Continued on next page
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Continued
Property

Description

Polarity

Select Normal or Reverse to control the relationship
between the physical state of the point and the Value
property. When Out of service is set to False, the
Polarity property causes a change to the Value property.

Inactive text

Type the text that explains the Inactive state of the value,
such as Pump_Basement_Off. This text is used as an
enumeration text for the Value property and related priority
array values. It is visible in graphics, in the Watch pane, and
in the Properties pane.
If you leave this box empty, the default (Inactive) is used
instead.

Active text

Type the text that explains the Active state of the value, such
as Pump_Basement_On. This text is used as an enumeration
text for the Value property and related priority array values. It
is visible in graphics, in the Watch pane, and in the Properties
pane.
If you leave this box empty, the default (Active) is used
instead.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could
describe the type of sensor connected to an analog input or
the type of sensor represented by an accumulator.

10. Click OK.
Continued on next page
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11. Click the Advanced tab.

Continued on next page
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12. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Continued on next page
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Continued
Property

Description
Building Operation BACnet devices.

Alarm value

Select the state that Value requires before an off-normal event
is triggered.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured text.
13. Click OK.
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76.20

Configuring a BACnet Multistate Input
Point (Generic)
You configure a BACnet multistate input (generic) to configure the properties of a
multistate input point in an external BACnet device. You can also configure an
intrinsic alarm for the point if supported by the device.

To configure a BACnet multistate input point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the multistate input point (generic) resides and select
Application.
3. In List View, select the multistate input point (generic) that you want to
configure.
4. On the File menu, click Open.
5. Click the State Configuration tab.

6. In the Number of states box, enter the number of states that you want to
create, for example, enter 3 if you want to create 3 states.
Use the up arrow to enter the number.
7. In the Label column, click the text and then type a description for the state
number, such as Unoccupied, Standby, or Warmup.
Repeat this step for each state that you created.
8. Click the Save button

.

9. Click the Properties tab and then click the Basic tab.
10. Click the Configure button

for the Out of service property.
Continued on next page
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11. Edit the properties.
Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.

12. Click OK to return to the Basic tab.

Continued on next page
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13. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for
the point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value
or click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out
of service. For more information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For
more information, see section 77.7 “Forced Priority Level” on
page 2857.

Status flags

Displays the condition or status of the BACnet point. For
more information, see section 76.9 “BACnet Status Flags” on
page 2673.

Out of service

Set to True to decouple the Value from the associated
property. If the associated property is not configured, this
property is True and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could
describe the type of sensor connected to an analog input or
the type of sensor represented by an accumulator.

14. Click the Save button

.
Continued on next page
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15. Click the Advanced tab.

Continued on next page
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16. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

State Id

Enter the State Id for which you want to set an alarm or fault
alarm.
Continued on next page
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Continued
Property

Description

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you
select Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you
select Yes, select No for Is alarm value.
Click to add an alarm or fault State Id to the list of alarm and
fault values.
Click to open the Properties dialog box where you can edit
the alarm or fault configuration for a selected State Id. For
more information, see section 81.62 “BACnet Multistate Alarm
Properties Dialog Box” on page 3069.
Click to remove the State Id from the list of alarm or fault
values.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.
For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured text.

17. Click

to create a multistate alarm.

18. Type a name for the alarm and click Create.

19. Repeat the process until you have the desired number of alarms.
Continued on next page
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20. Select an alarm from the list and click

to modify an alarm.

21. Edit the properties.
Property

Description

State Id

Enter the state that you want to configure for the multistate
point or value.

Is alarm value

Select Yes to assign an alarm to the State Id. Then, select No
for Is fault value.

Is fault value

Select Yes to assign a fault alarm to the State Id. Then, select
No for Is alarm value.

22. Click OK to return to the Advanced tab.
23. Repeat the steps to modify another alarm.
24. Click the Save button
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76.21

Configuring a BACnet Analog Output
Point (Generic)
You configure a BACnet analog output (generic) to configure the properties of an
analog output point in an external BACnet device. You can also configure an
intrinsic alarm for the point if supported by the device.

To configure a BACnet analog output point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the external device where the analog output point resides and select
Application.
3. In List View, select the analog output point (generic) that you want to
configure.
4. On the File menu, click Properties.
5. Click the Basic tab.
6. Under Status Information, click the Configure button
property.

for the Value

7. Edit the properties.
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Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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8. Click OK to return to the Basic tab.

Continued on next page
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9. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Select True to disassociate the Value from the physical output.
Out of service is primarily used for testing purposes.

Event state

Displays one of the following active event states associated with
the point:
• Normal when the point is not in an alarm state.
• Off Normal when the Intrinsic Alarm is configured and the
point is in an alarm state.

Technical
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Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

Reliability

Displays the reliability of the point.

COV increment

Enter the minimum change in the Value property that causes a
COV notification to be sent. The default COV increment is .10.

Minimum value

Enter the lowest value that can be reliably used for the Value
property.

Maximum value

Enter the highest value that can be reliably used for the Value
property.

Resolution

Displays the smallest recognizable change in the Value
property.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe
the type of sensor connected to an analog input or the type of
sensor represented by an accumulator.
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10. Click OK.
11. Click the Advanced tab.

Continued on next page
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12. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal
transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal
transition.

Time delay (s)

Select the minimum number of seconds required before a tooff-normal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or
event in WorkStation.

Event enable

Select the flags to enable the reporting of to-off-normal, tofault, and to-normal events.

Upper limit

Enter a limit that Value is required to exceed before an event is
generated.

Lower limit

Enter a limit that Value is required to fall below before an event
is generated.

Deadband

Enter the deadband which is the range the value must stay
within before a to-normal event is generated.
Continued on next page
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Continued
Property

Description

Limit enable

Select one or more flags to enable the reporting of off-normal
events and the return to to-normal events based on the lower
limit value or upper limit value.

Alarm message

Enter the text that you want to display in the Alarm text field in
the Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text
is displayed in the Alarm text field instead of the configured text.

Fault message

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured text.
13. Click OK.
14. Click the Command tab.

Continued on next page
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15. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values
in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null
value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

16. Click OK.
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76.22

Configuring a BACnet Digital Output
Point (Generic)
You configure the properties of a generic BACnet digital output in an external
BACnet device. You can also configure an intrinsic alarm for the point if supported
by the device.

To configure a BACnet digital output point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the external device where the digital output point resides and select
Application.
3. In List View, select the digital output point (generic) that you want to
configure.
4. On the File menu, click Properties.
Continued on next page
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5. Click the Basic tab.

Continued on next page
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6. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for
the point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value
or click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out
of service. For more information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For
more information, see section 77.7 “Forced Priority Level” on
page 2857.

Status flags

Displays the condition or status of the BACnet point. For
more information, see section 76.9 “BACnet Status Flags” on
page 2673.

Out of service

Set to True to decouple the Value from the associated
property. If the associated property is not configured, this
property is True and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

Change of state
time

Displays the reliability of the point.

Change of state
count

Displays how often the Value property has changed state
since the Change of state count was last set to 0. The
Change of state count increments when the Value
property has a change of state based on an event that alters
the Value property.
Enter 0 if you want to reset the Change of state count.

Time of state count Displays the date and time when the Change of state
reset
count was last set to 0.
Elapsed active time Displays the number of seconds that the Value property
was Active since the Elapsed active time was last set to
0.
Enter 0 if you want to reset the Elapsed active time.
Time of active time Displays the date and time when Elapsed active time was
reset
last set to 0.
Continued on next page
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Continued
Property

Description

Polarity

Select Normal or Reverse to control the relationship
between the physical state of the point and the Value
property. When Out of service is set to False, the
Polarity property causes a change to the Value property.

Inactive text

Type the text that explains the Inactive state of the value,
such as Pump_Basement_Off. This text is used as an
enumeration text for the Value property and related priority
array values. It is visible in graphics, in the Watch pane, and
in the Properties pane.
If you leave this box empty, the default (Inactive) is used
instead.

Active text

Type the text that explains the Active state of the value, such
as Pump_Basement_On. This text is used as an enumeration
text for the Value property and related priority array values. It
is visible in graphics, in the Watch pane, and in the Properties
pane.
If you leave this box empty, the default (Active) is used
instead.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could
describe the type of sensor connected to an analog input or
the type of sensor represented by an accumulator.

Minimum off time

Enter the minimum number of seconds that you want the
Value property to remain Inactive following a write to the
Value property that causes the Inactive state.

Minimum on time

Enter the minimum number of seconds that you want the
Value property to remain Active following a write to the
Value property that causes the Active state.

7. Click OK.
Continued on next page
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8. Click the Advanced tab.

Continued on next page

04-16006-04-en, March 2015

Technical
2747

76 BACnet Objects and Properties
76.22 Configuring a BACnet Digital Output Point (Generic)

9. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Feedback value

Displays the state that is required to be different from the Value
property before a to-off-normal event is generated. You can
view this state in the Alarms pane or an alarm view.
Continued on next page
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Continued
Property

Description
For more information, see the Add/Remove Columns Dialog
Box (Alarms) topic on WebHelp.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.
For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured text.
10. Click OK.
11. Click the Command tab.

Continued on next page
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12. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

13. Click OK.
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76.23

Configuring a BACnet Multistate Output
Point (Generic)
You configure a generic BACnet multistate output point in an external BACnet
device. You can also configure an intrinsic alarm for the point if supported by the
device.

To configure a BACnet multistate output point (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the external device where the multistate output point resides and
select Application.
3. In List View, select the multistate output point (generic) that you want to
configure.
4. On the File menu, click Open.
5. Click the State Configuration tab.

6. In the Number of states box, enter the number of states that you want to
create, for example, enter 3 if you want to create 3 states. Use the up arrow to
enter the number.
7. In the Label column, click the text and then type a description for the state
number, such as Unoccupied, Standby, or Warmup.
Repeat this step for each state that you created.
8. Click the Save button

.

9. Click the Properties tab.
Continued on next page
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10. Click the Basic tab.

Continued on next page
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11. Edit the properties.
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for
the point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value
or click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out
of service. For more information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For
more information, see section 77.7 “Forced Priority Level” on
page 2857.

Status flags

Displays the condition or status of the BACnet point. For
more information, see section 76.9 “BACnet Status Flags” on
page 2673.

Out of service

Set to True to decouple the Value from the associated
property. If the associated property is not configured, this
property is True and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could
describe the type of sensor connected to an analog input or
the type of sensor represented by an accumulator.

12. Click the Save button

.
Continued on next page
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13. Click the Advanced tab.

Continued on next page
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14. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Feedback value

Displays the state that is required to be different from the Value
property before a to-off-normal event is generated. You can
view this state in the Alarms pane or an alarm view.
Continued on next page
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Continued
Property

Description
For more information, see the Add/Remove Columns Dialog
Box (Alarms) topic on WebHelp.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.
For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured text.

15. Click the Save button

.

16. Click the Command tab.

Continued on next page
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17. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

18. Click the Save button
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76.24

Creating a BACnet Value
You create a BACnet analog, digital, or multistate value in a local server so you can
then configure a control system parameter for the server. The server can be an
Automation Server or an Enterprise Server. The BACnet values that you create are
visible to other workstations and devices in the BACnet internetwork. You create
BACnet values for a server in the Application folder of the server's BACnet Interface.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

To create a BACnet value
1. In WorkStation, in the System Tree, expand the BACnet Interface and then
select Application.
2. On the File menu, point to New and then click Value.
3. In the object type list, select the type of BACnet value that you want to create.
Do not select String Value or Time Stamp Value, which are not BACnet
object types.

4. In the Name box, type a name for the value.
5. In the Description box, type a description for the value.
6. Click Next.
Continued on next page
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7. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you.
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.

8. In the BACnet name box, type a BACnet name for the value. Do not type a
name if you want a name to be assigned for you.
9. In the Command priority retain level box, select one of the following
options to configure the warm start and cold start settings for a command
priority array:
• Warm start: The variable retains the last value set by a user or
application. However, the variable reverts to the default value for a cold
start.
• Cold start: The variable retains the last value set by a user or application
for a warm start or cold start.
• No: The variable reverts to the default value upon a restart.
10. Click Create.
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76.25

Configuring a BACnet Analog Value
You configure a BACnet analog value to define a control system parameter for an
Automation Server or Enterprise Server. You can also create an intrinsic alarm for
the analog value and enter a value for the Relinquish default property.

To configure a BACnet analog value
1. In WorkStation, in the System Tree, expand the BACnet Interface and then
select Application.
2. In the List View, select the analog value that you want to configure.
3. On the File menu, click Properties.
4. Click the Basic tab.

5. For Value, click the Configure button

.
Continued on next page
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6. Select the Unit check box.

7. In the Unit box, enter the unit that matches the unit of the input and output
points on the Automation Server IO module.
8. Click OK to return to the Basic tab.
9. In the Value box, enter the value to be used as a control system parameter for
the device.
10. In the Out of service box, select False.
Continued on next page
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11. In the COV increment box, enter the minimum change in the Value
property that causes a COV notification to be sent.

The default COV increment is 0.10.
Continued on next page
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12. Click the Advanced tab.

13. Under Intrinsic Alarm Configuration, in the Time delay (s) box, enter
the minimum number of seconds that the value is inside or outside the
specified limits before a to-off-normal event, or to-normal event is
generated.
14. In the BACnet notification box, select the type of BACnet notification for
generating event notifications for this object:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
15. In the Alarm handling and presentation box, choose whether the alarm
presentation is determined by its BACnet notification object or the alarm
source itself (intrinsic). For more information, see section 79.6 “BACnet
Alarms” on page 2898.
Continued on next page
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16. In the Notify type box, select the type of BACnet event notification to be
generated:
• Select alarm to define the event as a BACnet alarm.
• Select event to define the event as a BACnet event.
17. In the Event enable box, select the flags to enable the reporting of to-offnormal and to-normal events. to-fault reporting is not supported by
BACnet devices.
18. In the Upper limit box, enter a limit that Value is required to exceed before a
to-off-normal event is generated.
19. In the Lower limit box, enter a limit that Value is required to fall below
before a to-off-normal event is generated.
20. In the Deadband box, enter a value to create a range between the Upper
limit and Lower limit values where the Value property is required to remain
before a to-normal event is generated.
21. In the Limit enable box, select one or both of the following options:
• Select Low limit enable to enable the reporting of Lower limit offnormal events and to-normal events.
• Select High limit enable to enable the reporting of Upper limit offnormal events and to-normal events.
22. In the Alarm message, Reset message and Fault message boxes, enter
the text that you want to display in the Alarm text field in the Alarm View for
the corresponding alarm state. The configured text is also sent to any external
BACnet clients configured as alarm recipients in the BACnet notification.
23. Click the Command tab.
24. In the Relinquish default box, enter the value to be used by the Value
property when all values in the priority array are set to Null.
25. In the Priority x box, set the value at a priority level, such as Active.
Priority 6 is reserved for timer-based algorithms that are not currently
supported. (Read only)
26. Click OK.
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76.26

Configuring a BACnet Digital Value
You configure a BACnet digital value to define a control system parameter for an
Automation Server or an Enterprise Server. You can also configure an intrinsic alarm
for the point if supported by the device.

To configure a BACnet digital value
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the digital value that you want to configure.
3. On the File menu, click Properties.
4. Click the Basic tab.

Continued on next page
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5. Edit the properties.
Property

Description

Value

Enter the value to be used as the control system parameter under
the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text
for the Value property and related priority array values. It is visible
in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text
for the Value property and related priority array values. It is visible
in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.

6. Click OK.
Continued on next page

Technical
2766

04-16006-04-en, March 2015

76 BACnet Objects and Properties
76.26 Configuring a BACnet Digital Value

7. Click the Advanced tab.

Continued on next page
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8. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Alarm value

Select the state that Value requires before an off-normal event
is triggered.
Continued on next page
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Continued
Property

Description

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

9. Click OK.
10. Click the Command tab.

Continued on next page
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11. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

12. Click OK.
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76.27

Configuring a BACnet Multistate Value
You configure a BACnet multistate value to define a control system parameter for
an Automation Server or an Enterprise Server. You can also configure an intrinsic
alarm for the point if supported by the device.

To configure a BACnet multistate value
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. In List View, select the multistate value that you want to configure.
3. On the File menu, click Open.
4. Click the State Configuration tab.

5. In the Number of states box, enter the number of states that you want to
create, for example, enter 3 if you want to create 3 states.
Use the up arrow to enter the number.
6. In the Label column, click the text and then type a description for the state
number, such as Unoccupied, Standby, or Warmup.
Repeat this step for each state that you created.
7. Click the Save button

.
Continued on next page
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8. Click the Properties tab and then click the Basic tab.

Continued on next page
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9. Edit the properties.
Property

Description

Value

Enter the value to be used as the control system parameter under
the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Reliability

Displays one of the following descriptions to indicate the reliability
of the Value property:
• no fault detected
• multistate fault

10. Click the Save button

.
Continued on next page
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11. Click the Advanced tab.
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12. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

State Id

Enter the State Id for which you want to set an alarm or fault
alarm.
Continued on next page

04-16006-04-en, March 2015

Technical
2775

76 BACnet Objects and Properties
76.27 Configuring a BACnet Multistate Value

Continued
Property

Description

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you
select Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you
select Yes, select No for Is alarm value.
Click to add an alarm or fault State Id to the list of alarm and
fault values.
Click to open the Properties dialog box where you can edit
the alarm or fault configuration for a selected State Id. For
more information, see section 81.62 “BACnet Multistate Alarm
Properties Dialog Box” on page 3069.
Click to remove the State Id from the list of alarm or fault
values.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.
For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

13. Click the Save button
14. Click

.

to create a multistate alarm.

15. Type a name for the alarm and click Create.

16. Repeat the process until you have the desired number of alarms.
Continued on next page
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17. Select an alarm from the list and click

to modify an alarm.

18. Edit the properties.
Property

Description

State Id

Enter the state that you want to configure for the multistate
point or value.

Is alarm value

Select Yes to assign an alarm to the State Id. Then, select No
for Is fault value.

Is fault value

Select Yes to assign a fault alarm to the State Id. Then, select
No for Is alarm value.

19. Click OK.
20. Repeat the steps to modify another alarm.
21. Click the Save button

.
Continued on next page
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22. Click the Command tab.

23. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

24. Click the Save button
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76.28

Creating a BACnet Value (Generic)
You create an analog, digital, or multistate value (generic) for a device when you
want to view and configure a BACnet value in an external BACnet device from
WorkStation.
For more information, see section 75.21 “Device Communication and Diagnostics”
on page 2631.
When you create the BACnet value (generic), you need to perform one of the
following operations:
• Download to a device to create a value in an external BACnet device. For more
information, see section 76.7 “BACnet Configuration Properties” on page
2671.
• Upload from a device to upload the properties of a value from a BACnet
device.

To create a BACnet value (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface and
expand the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Value.
4. In the object type list, select the type of value that you want to create. Do not
select String Value or Time Stamp Value, which are not BACnet value
types.

5. In the Name box, type a name for the value.
6. In the Description box, type a description for the value.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance
ID now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the value.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device.
11. Click Create.
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76.29

Configuring a BACnet Analog Value
(Generic)
You configure the properties of a generic BACnet analog value in an external
BACnet device. You can also configure an intrinsic alarm for the point if supported
by the device.

To configure a BACnet analog value (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the external device where the analog value resides and select
Application.
3. In List View, select the analog value (generic) that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.
6. Click the Configure button

04-16006-04-en, March 2015

for the Value property.

Property

Description

Type

Displays the object type. Read-only

Unit

Select the Unit check box and enter the unit that matches the
unit of the point on the Automation Server IO module. For more
information, see the Units topic on WebHelp.

Init value

Displays the initial value, if defined. Read-only.

Reference

Enter the Value property of the point that you want to reference.

Forceable

Select to make the value forcible. For more information, see the
Forced Values topic on WebHelp.

Retain level

Select how to handle values for warm start, cold start, system
events, and system activities. For more information, see the
Retain Level topic on WebHelp.
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7. Click OK to return to the Basic tab.

Continued on next page
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8. Edit the properties.
Property

Description

Value

Enter the value to be used as the control system parameter under
the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

COV increment

Enter the minimum change in the Value property that causes a
COV notification to be sent.

9. Click OK.
Continued on next page

04-16006-04-en, March 2015

Technical
2783

76 BACnet Objects and Properties
76.29 Configuring a BACnet Analog Value (Generic)

10. Click the Advanced tab.

Continued on next page
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11. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Building Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.

Lower limit

Enter a limit that Value is required to fall below before a to-offContinued on next page
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Continued
Property

Description
normal event is generated.
The system generates a to-off-normal event based on Value
and the boundaries defined by the Upper Limit, Lower limit, and
Deadband. For example, if you enter 5 seconds and the Value
remains outside the Upper limit and Lower limit boundaries for a
minimum of 5 seconds, the system generates a to-off-normal
event.

Deadband

Enter a range that is an offset from the low-level and high-level
limits, which defines the range where a to-normal event can be
generated. To generate a to-normal event, the value must be
above the low limit and below the high limit, minus the
deadband. For generic objects, this property is present only in
analog objects from external devices that support intrinsic
reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower
limit off-normal events and to-normal events. Select High
limit enable to enable the reporting of Upper limit off-normal
events and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured device.
12. Click OK.
Continued on next page
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13. Click the Command tab.

14. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

15. Click OK.
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76.30

Configuring a BACnet Digital Value
(Generic)
You configure a BACnet digital value (generic) to configure the properties of a digital
value in an external BACnet device. You can also configure an intrinsic alarm for the
point if supported by the device.

To configure a BACnet digital value (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the external device where the digital value resides and select
Application.
3. In List View, select the digital value (generic) that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.

Continued on next page
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6. Edit the properties.
Property

Description

Value

Enter the value to be used as the control system parameter
under the following conditions:
• Unforce. Displays a forced value. Enter a forced value
or click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out
of service. For more information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For
more information, see section 77.7 “Forced Priority Level” on
page 2857.

Status flags

Displays the condition or status of the BACnet value. For
more information, see section 76.9 “BACnet Status Flags” on
page 2673.

Out of service

Set to True to decouple the Value from the associated
property. If the associated property is not configured, this
property is True and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

Change of state
time

Displays the reliability of the point.

Change of state
count

Displays how often the Value property has changed state
since the Change of state count was last set to 0. The
Change of state count increments when the Value
property has a change of state based on an event that alters
the Value property.
Enter 0 if you want to reset the Change of state count.

Time of state count Displays the date and time when the Change of state
reset
count was last set to 0.
Elapsed active time Displays the number of seconds that the Value property
was Active since the Elapsed active time was last set to
0.
Enter 0 if you want to reset the Elapsed active time.
Time of active time Displays the date and time when Elapsed active time was
reset
last set to 0.
Inactive text

Type the text that explains the Inactive state of the value,
Continued on next page
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Continued
Property

Description
such as Pump_Basement_Off. This text is used as an
enumeration text for the Value property and related priority
array values. It is visible in graphics, in the Watch pane, and
in the Properties pane.
If you leave this box empty, the default (Inactive) is used
instead.

Active text

Type the text that explains the Active state of the value, such
as Pump_Basement_On. This text is used as an enumeration
text for the Value property and related priority array values. It
is visible in graphics, in the Watch pane, and in the Properties
pane.
If you leave this box empty, the default (Active) is used
instead.

Minimum off time

Enter the minimum number of seconds that you want the
Value property to remain Inactive following a write to the
Value property that causes the Inactive state.

Minimum on time

Enter the minimum number of seconds that you want the
Value property to remain Active following a write to the
Value property that causes the Active state.

7. Click OK.
Continued on next page
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8. Click the Advanced tab.

Continued on next page
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9. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Continued on next page
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Continued
Property

Description
Building Operation BACnet devices.

Alarm value

Select the state that Value requires before an off-normal event
is triggered.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

Tip
Message text received from the external device displays in the Alarm
text field instead of the configured text.
10. Click OK.
11. Click the Command tab.

Continued on next page
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12. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

13. Click OK.
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76.31

Configuring a BACnet Multistate Value
(Generic)
You configure a generic BACnet multistate value to configure the properties of a
multistate value in an external BACnet device. You can also create an intrinsic alarm
if supported by the device.

To configure a BACnet multistate value (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface and then
expand the appropriate network.
2. Expand the external device where the multistate value resides and select
Application.
3. In List View, select the multistate value (generic) that you want to configure.
4. On the File menu, click Open.
5. Click the State Configuration tab.

6. In the Number of states box, enter the number of states that you want to
create, for example, enter 128.
7. In the Label column, click the text and then type a description for the state
number, such as Unoccupied, Standby, or Warmup.
Repeat this step for each state that you created.
8. Click the Save button

.
Continued on next page

04-16006-04-en, March 2015

Technical
2795

76 BACnet Objects and Properties
76.31 Configuring a BACnet Multistate Value (Generic)

9. Click the Properties tab and then click the Basic tab.

Continued on next page
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10. Edit the properties.
Property

Description

Value

Enter the value to be used as the control system parameter
under the following conditions:
• Unforce. Displays a forced value. Enter a forced value
or click to release the value.
• Force. Displays a non-forced value. Click to force the
value.
For all BACnet inputs, a Forced condition is the same as out
of service. For more information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For
more information, see section 77.7 “Forced Priority Level” on
page 2857.

Status flags

Displays the condition or status of the BACnet value. For
more information, see section 76.9 “BACnet Status Flags” on
page 2673.

Out of service

Set to True to decouple the Value from the associated
property. If the associated property is not configured, this
property is True and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides
additional information about an intrinsic alarm or algorithmic
alarm configured for an object. For more information, see the
Alarm States topic on WebHelp.

11. Click the Save button

.
Continued on next page
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12. Click the Advanced tab.
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13. Edit the properties.
Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object
that you want to use to generate event notifications:
• Select System reference to define a path-based
reference to an object or property that is currently located
on the server. When selected, only the Path field becomes
editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that
uses the elements of a property value (Device instance
number, Object type, or Object instance number) to
identify a BACnet object or property that is not currently on
the server but may be uploaded or imported to the server
later. You can also use this method to reference a BACnet
object or property on an external device.
For more information, see section 73.7 “BACnet References
and System References” on page 2562.

Alarm handling
Select the data source for alarm handling and presentation
and presentation information. The alarm presentation settings display as three
tabs (User Action, Attachment, and Presentation) on the alarm
sources (value) as well as in the notification class. For more
information, see section 79.6 “BACnet Alarms” on page 2898.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and
to display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and
to-normal events. to-fault reporting is not supported by
Continued on next page
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Property

Description
Building Operation BACnet devices.

State Id

Enter the State Id for which you want to set an alarm or fault
alarm.

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you
select Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you
select Yes, select No for Is alarm value.
Click to add an alarm or fault State Id to the list of alarm and
fault values.
Click to open the Properties dialog box where you can edit
the alarm or fault configuration for a selected State Id. For
more information, see section 81.62 “BACnet Multistate Alarm
Properties Dialog Box” on page 3069.
Click to remove the State Id from the list of alarm or fault
values.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to
any external BACnet clients configured as alarm recipients in
the BACnet notification.
For more information, see the Alarms Pane and Alarm View
topic on WebHelp.

14. Click

to create a multistate alarm.

15. Type a name for the alarm and click Create.

16. Repeat the process until you have the desired number of alarms.
Continued on next page
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17. Select an alarm from the list and click

to modify the alarm.

18. Edit the properties.
Property

Description

State Id

Enter the state that you want to configure for the multistate
point or value.

Is alarm value

Select Yes to assign an alarm to the State Id. Then, select No
for Is fault value.

Is fault value

Select Yes to assign a fault alarm to the State Id. Then, select
No for Is alarm value.

19. Click OK to return to the Advanced tab.
20. Repeat the steps to modify another alarm.
21. Click the Save button

.
Continued on next page
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22. Click the Command tab.

23. Edit the properties.
Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in
the priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present
value. The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.

24. Click the Save button
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76.32

Creating a BACnet Accumulator
(Generic)
You create a BACnet accumulator (generic) when you want to monitor an
accumulated quantity being precisely measured over time, such as electric power,
water, or natural gas usage.

To create a BACnet accumulator (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface and
expand the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Accumulator (Generic).
5. In the Name box, type a name for the accumulator (generic).

6. In the Description box, type a description.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the schedule.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.33

Configuring a BACnet Accumulator
(Generic)
You configure a BACnet accumulator (generic) when you want to configure or
modify the intrinsic alarming properties of an accumulator object in a BACnet
device.

To configure a BACnet accumulator (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the accumulator (generic) resides and select
Application.
3. In List View, select the accumulator (generic) that you want to configure.
4. On the File menu, click Properties.
5. Click the Advanced tab.

Continued on next page
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6. In the Time delay (s) box, enter the minimum number of seconds that Pulse
rate is required to remain outside of the range specified by the Upper limit
and Lower limit before a to-off-normal event is generated. The value also
specifies the number of seconds that Pulse rate is required to remain within
the range of Upper limit and Lower limit before a to-normal event is
generated.
7. In the BACnet notification box, select the type of BACnet notification for
generating the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
8. In the Notify type box, select one of the following options:
• Select alarm if you want the generated event to be reported as an Alarm
• Select event if you want the generated event to be reported as an Event.
9. In the Event enable box, select the appropriate boxes to enable the
reporting of to-off-normal, to-fault, and to-normal events.
10. In the Upper limit box, enter a value that Pulse rate is required to exceed
before an an event is generated.
11. In the Lower limit box, enter a value that Pulse rate is required to fall below
before an an event is generated.
12. In the Limit monitoring interval (s) box, enter the number of seconds
during which the value of the Pulse rate can be determined.
13. In the Limit enable box, select the appropriate box to perform one or both of
the following operations:
• Select Low limit enable to enable the reporting of off-normal events
and the return to to-normal events based on the Lower limit value.
• Select High limit enable to enable the reporting of off-normal events
and the return to-normal events based on the Upper limit value.
14. In the Alarm message, Reset message and Fault message boxes, enter
the text that you want to display in the Alarm text field in the Alarm View for
the corresponding alarm state.

Tip
If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.
15. Click OK.
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76.34

Creating a BACnet Averaging (Generic)
You create a BACnet averaging (generic) when you want to capture electrical
consumption data that provides a sampling of minimum, maximum, and average
values of a referenced property.

To create a BACnet averaging (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, expand
the network where the device resides, and then expand the device.
2. Select Application.
3. On the File menu, point to New and then click Program.
4. In the object type list, select BACnet Averaging (Generic).
5. In the Name box, type a name for the averaging (generic).

6. In the Description box, type a description.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the schedule.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.35

Configuring a BACnet Averaging
(Generic)
You configure a BACnet averaging (generic) to configure the properties of an
averaging object in a BACnet device.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

To configure a BACnet averaging (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the averaging (generic) resides and select
Application.
3. In List View, select the averaging (generic) that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.

Continued on next page
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6. In the Object property reference box, enter the property whose value is
sampled during the time specified by the Window interval property:
• System reference: Defines a path to a property or object reference
located on the server (including hosted objects, if available). When
selected, only the Path field becomes editable. All the other fields become
non-editable.
• Protocol reference (Advanced): Using the BACnet standard method,
defines a path to a property or object reference located anywhere on the
network. When selected, the Device, Object type, and Object instance
fields become editable (except for notification-class objects) and the Path
field becomes non-editable.
• Path: Select the path to the reference on the file system.
• Device: Type the device number associated with the device.
• Object type: Select the object class of an object, such as analog input.
• Object instance: Type the object instance number associated with the
referenced object.
• Property: Enter the property identifier associated with the value.
The system automatically fills in the device, object type, and object instance
fields for either reference path, where available.
7. In the Window interval box, enter the number of seconds during which the
values for the Minimum value, Maximum value, and Average value are
calculated.
8. In the Window samples box, enter a number (greater than zero) to indicate
how many samples that you want to be taken during the time specified by the
Windows interval property.
9. Click OK.
10. Click the Advanced tab.

11. In the BACnet name box, type a new name to rename the averaging object.
12. Click OK.
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76.36

Creating a BACnet Command (Generic)
You create a BACnet command (generic) when you want to specify an action code
for the object in a BACnet device.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

To create a BACnet command (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, expand
the network where the device resides, and then expand the device.
2. Select Application.
3. On the File menu, point to New and then click Program.
4. In the object type list, select BACnet Command (Generic).
5. In the Name box, type a name for the command (generic).

6. In the Description box, type a description.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the schedule.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.37

Configuring a BACnet Command
(Generic)
You configure a BACnet command (generic) when you want to specify the number
of the action list that you want generated when the command object runs.

To configure a BACnet command (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the command (generic) resides and select
Application.
3. In List View, select the command (generic) that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.

6. In the Value box, enter the number of the action list that you want generated
when the command object runs.
7. Click OK.
8. Click the Advanced tab only if you want to rename the command object.

Continued on next page
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9. In the BACnet name box, type a new name if you want to rename the
command object.
10. Click OK.
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76.38

Creating a BACnet Load Control
(Generic)
You create a BACnet load control (generic) when you want to manage the shedding
of electrical loads to reduce peak consumption.

To create a BACnet load control (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, expand
the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Program.
4. In the object type list, select BACnet Load Control (Generic).
5. In the Name box, type a name for the load control (generic).

6. In the Description box, type a description.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the schedule.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.39

Configuring a BACnet Load Control
(Generic)
You configure a BACnet load control (generic) when you want to configure or
modify the intrinsic alarming properties of a load control object in an external
BACnet device.

To configure a BACnet load control (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the load control (generic) resides.
3. Select Application.
4. In List View, select the load control (generic) that you want to configure.
5. On the File menu, click Properties.
Continued on next page
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6. Click the Advanced tab.

7. In the Time delay (s) box, enter a minimum number of seconds that the
Value property is required to be shed non-compliant before a to-offnormal event is generated, or a state other than shed non-compliant before
a to-normal event is generated.
Continued on next page
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8. In the BACnet notification box, select the type of BACnet notification for
generating the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
9. In the Notify type box, select one of the following options:
• Select event if want the generated event to be reported as an event.
• Select alarm if want the generated event to be reported as an alarm.
10. In the Event enable box, select the appropriate boxes to enable the
reporting of to-off-normal, to-fault, and to-normal events.
11. In the Alarm message, Reset message and Fault message boxes, enter
the text that you want to display in the Alarm text field in the Alarm View for
the corresponding alarm state.

Tip
If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.
12. Click OK.
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76.40

Creating a BACnet Pulse Converter
(Generic)
You create a BACnet pulse converter (generic) when you want to monitor
approximate information about an accumulated quantity being measured over time,
such as electric power consumption, water consumption, or natural gas usage.

To create a BACnet pulse converter (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, expand
the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Pulse Converter (Generic).
5. In the Name box, type a name for the pulse converter (generic).

6. In the Description box, type a description.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the schedule.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.41

Configuring a BACnet Pulse Converter
(Generic)
You configure a BACnet pulse converter (generic) to configure the properties of a
pulse converter in a BACnet device. An additional configuration task includes
configuring an intrinsic alarm for the object.

To configure a pulse converter (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the pulse converter (generic) resides and select
Application.
3. In List View, select the pulse converter (generic) that you want to configure.
4. On the File menu, click Properties.
Continued on next page
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5. Click the Basic tab.

6. In the Input reference box, select the type of BACnet notification for
defining the property whose value is sampled during the time specified by the
Window interval property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
Continued on next page
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7. In the COV increment box, enter the minimum change in the Value property
that causes a COV notification to be sent.
8. Click OK.
9. Click the Advanced tab.

10. In the BACnet name box, type a new name to rename the pulse converter
object.
11. In the Time delay (s) box, enter the minimum number of seconds that the
Value property is required to remain outside of the range specified by the
Upper limit and Lower limit before a to-off-normal event is generated. The
value also specifies the minimum number of seconds that the Value property
is required to remain within the range of Upper limit, Lower limit, and
Deadband before a to-normal event is generated.
Continued on next page
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12. In the BACnet notification box, select the type of BACnet notification for
generating the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
13. In the Notify type box, select one of the following categories to identify the
event when an event is generated by the object:
• Select alarm to report the event as an alarm.
• Select event to report the event as an event.
14. In the Event enable box, select one or more flags to enable the reporting of
to-off-normal, to-fault, and to-normal events.
15. In the Upper limit box, enter a value that the Value property is required to
exceed before an an event is generated. The Value property is required to
exceed the Upper limit value for the minimum time specified in the Time
delay (s) property.
16. In the Lower limit box, enter a value that the Value property is required to
fall below before an an event is generated. The Value property is required to
fall below the Lower limit value for the minimum time specified in the Time
delay (s) property.
17. In the Deadband box, enter a value to create a range between the Upper
limit and Lower limit values. The Value property is required to remain
within the range before a to-normal event is generated based on various
conditions. For more information, see section 81.97 “BACnet Pulse Converter
Properties (Generic) – Advanced Tab” on page 3142.
18. In the Limit enable box, do one of the following actions:
• Select Low limit enable to enable the reporting of Lower limit offnormal events and to-normal events.
• Select High limit enable to enable the reporting of Upper limit offnormal events and to-normal events.
19. In the Alarm message, Reset message and Fault message boxes, enter
the text that you want to display in the Alarm text field in the Alarm View for
the corresponding alarm state.

Tip
If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.
20. Click OK.
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76.42

Changing a BACnet String
You can change a BACnet string, if supported in a BACnet device.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

To change a BACnet string
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the BACnet network where the external device resides.
3. Expand the external BACnet device and select the BACnet string that you
want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.
6. In the Value box, type the text that you want to display.
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76.43

Creating a BACnet Trend Log
You create a BACnet trend log with intrinsic reporting so you can monitor and
record the trends in the value of a monitored property.

To create a BACnet trend log
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. On the File menu, point to New and then click Trend.
3. In the object type list, select BACnet Trend Log.

4. In the Name box, type a name for the trend log.
5. In the Description box, type a description for the trend log.
6. Click Next.
Continued on next page
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7. In the Instance ID box, click:
• Automatically generated to have the server generate a BACnet
instance ID for you.
• Manually entered if you want and then enter an Instance ID yourself.

8. In the BACnet name box, type a BACnet name for the trend log. Do not type
a name if you want a name to be assigned for you.
9. Click Create.
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76.44

Configuring a BACnet Trend Log
You configure a BACnet trend log with intrinsic reporting so you can monitor and
record the trends in the value of a monitored property. Before you use this
procedure, create and configure a BACnet notification.

To configure a BACnet trend log
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the appropriate network.
2. Expand the device where the BACnet trend log resides and select
Application.
3. In List View, select the BACnet trend log that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.

Continued on next page
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6. In the Log enable box, select True to enable logging of the monitored
property referenced by Log device object property.
7. In the Start time box, enter the date and time to start trending.
8. In the Stop time box, enter the date and time to stop trending.
9. In the Stop when full box, select True if you want trending to stop when the
log buffer reaches the maximum Buffer size.
10. In the Buffer size box, enter the maximum number of records the buffer can
hold.
11. In the Log device object property box, enter the property to be trended:
• System reference: Defines a path to a property or object reference
located on the server (including hosted objects, if available). When
selected, only the Path field becomes editable. All the other fields become
non-editable.
• BACnet reference: Using the BACnet standard method, defines a path
to a property or object reference located anywhere on the network. When
selected, the Device, Object type, and Object instance fields become
editable (except for notification-class objects) and the Path field becomes
non-editable.
• Path: Select the path to the reference on the file system.
• Device instance number: Type the device number associated with the
device.
• Object type: Select the object class of an object, such as analog input.
• Object instance number: Type the object instance number associated
with the referenced object.
• Property: Enter the property identifier associated with the variable.
The system automatically fills in the device, object type, and object instance
fields for either reference path, where available.
12. In the Logging type box, select one of the following options:
• Select Change of Value if you want Building Operation to add an entry
to the trend log only when the value of the monitored property changes. If
you select Change of value, you also
• Select Interval if you want Building Operation to poll the monitored
property at time intervals, and then add the trend entry to the trend log.
13. In the Log interval box, do one of the following actions:
• Enter how often you want the trend log to poll for a value if you selected
Interval for Logging type. The frequency is days, hours, minutes,
seconds, hundredths of seconds.
• Enter 0 for each interval if you selected Change of value for Logging
type.
14. In the Delta box, enter a value if you are trending the COV increment of an
object, and want the Delta value to be used.
Delta is the difference between the value of the current COV increment. and
the last log value. To log a variable according to the time interval, use a delta of
zero.
Continued on next page
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15. In the COV resubscription interval box, enter the number of seconds that
you want the trend log to request a COV subscription from the device.
16. Click the Advanced tab.

17. In the Notification threshold box, enter the number of records required to
accumulate in the trend log before BACnet devices are notified by the BACnet
notification. Set the number to equal 10% of the maximum Buffer size.
Continued on next page
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18. In the BACnet notification box, select the type of BACnet notification for
defining when the number of records specified by the Notification
threshold property has been reached.
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
19. In the Notify type box, select the type of BACnet notification to be
generated:
• Select alarm to define the event as a BACnet alarm and to display the
event in Alarm View.
• Select event to define the event as a BACnet event and to display the
event in Event View.
20. In the Event enable box, select to-normal. Then, select to-offnormal to
enable the reporting of to-offnormal events.
21. Click OK.
Create and configure an extended trend log to enable extended logging. For
more information, see the Creating an Extended Trend Log topic on WebHelp.
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76.45

Creating a BACnet Trend Log (Generic)
You create a BACnet trend log with intrinsic reporting on an external device so you
can monitor and record the trends in the value of a monitored property.
For more information, see section 76.1 “BACnet Objects and Properties” on page
2663.

To create a BACnet trend log (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the device resides, expand the device, and select
Application.
3. On the File menu, point to New and then click Trend.
4. In the object type list, expand BACnet Trends and then select BACnet
Trend Log (Generic).

5. In the Name box, type a name for the trend log.
6. In the Description box, type a description for the trend log.
7. Click Next.
Continued on next page
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8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.

Once created, you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the trend log.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.46

Configuring a BACnet Trend Log
(Generic)
You configure a BACnet trend log with intrinsic reporting on an external device so
you can monitor and record the trends in the value of a monitored property. Before
you use this procedure, create and configure a BACnet notification.

To configure a BACnet trend log (generic)
1. In List View, select the trend log.
2. On the File menu, click Open.
3. Click the Basic tab.

4. In the Log enable box, select True to enable logging of the monitored
property referenced by Log device object property.
5. In the Start time box, enter the date and time to start trending.
6. In the Stop time box, enter the date and time to stop trending.
Continued on next page
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7. In the Stop when full box, select True if you want trending to stop when the
log buffer reaches the maximum Buffer size.
8. In the Buffer size box, enter the maximum number of records the buffer can
hold.
9. In the Log device object property box, enter the property to be trended:
• System reference: Defines a path to a property or object reference
located on the server (including hosted objects, if available). When
selected, only the Path field becomes editable. All the other fields become
non-editable.
• BACnet reference: Using the BACnet standard method, defines a path
to a property or object reference located anywhere on the network. When
selected, the Device, Object type, and Object instance fields become
editable (except for notification-class objects) and the Path field becomes
non-editable.
• Path: Select the path to the reference on the file system.
• Device instance number: Type the device number associated with the
device.
• Object type: Select the object class of an object, such as analog input.
• Object instance number: Type the object instance number associated
with the referenced object.
• Property: Enter the property identifier associated with the variable.
The system automatically fills in the device, object type, and object instance
fields for either reference path, where available.
10. In the Logging type box, select one of the following options:
• Select Change of Value if you want Building Operation to add an entry
to the trend log only when the value of the monitored property changes. If
you select Change of value, you also
• Select Interval if you want Building Operation to poll the monitored
property at time intervals, and then add the trend entry to the trend log.
11. In the Log interval box, do one of the following actions:
• Enter how often you want the trend log to poll for a value if you selected
Interval for Logging type. The frequency is days, hours, minutes,
seconds, hundredths of seconds.
• Enter 0 for each interval if you selected Change of value for Logging
type.
12. In the Delta box, enter a value if you are plan to trend the COV increment of
an object and use the Delta value.
Delta is the difference between the value of the current COV increment. and
the last log value. To log a variable according to the time interval, use a delta of
zero.
13. In the COV resubscription interval box, enter the number of seconds that
you want the trend log to request a COV subscription from the device.
14. In the Client COV interval box, enter a value used to determine that a
change of value has occurred.
Continued on next page
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15. In the Interval offest box, enter the offset in hundredths of seconds from the
beginning of the period specified for trending until the acquisition of a record
begins.
The offset number is the value of Interval offset minus the value of the Log
interval. For example, if you enter 21 for Interval offset, the value of Log
interval is 20 and the offset number is 1.
16. Click the Advanced tab.

Continued on next page
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17. In the BACnet notification box, select the BACnet notification to be used
when the number of records specified by the Notification threshold
property has been reached.
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
18. In the Notify type box, select the type of BACnet notification to be
generated:
• Select alarm to define the event as a BACnet alarm and to display the
event in Alarm View.
• Select event to define the event as a BACnet event and to display the
event in Event View.
19. In the Event enable box, select to-normal. Then, optionally, select tooffnormal to enable the reporting of to-offnormal events.
20. In the Notification threshold box, enter the number of records required to
accumulate in the trend log before BACnet devices are notified by the BACnet
notification. Set the number to equal 10% of the maximum Buffer size.
21. Click OK.
Create and configure an extended trend log if you want to enable extended
logging. For more information, see the Creating an Extended Trend Log topic
on WebHelp.
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76.47

Configuring Extended Logging for a
Local BACnet Trend Log
You configure extended logging for a BACnet trend log in order to transfer records
from a local BACnet trend log to the Building Operation server. Be sure to create
the extended trend log on the same server that hosts the BACnet device and its
trend log to ensure that they remain synchronized in the event the server needs to
be restored.
For more information, see the Extended Trend Logs topic on WebHelp.

To configure extended logging for a local BACnet trend log
1. In WorkStation, in the System Tree, expand BACnet interface.
2. Create an extended trend log.
For more information, see the Creating an Extended Trend Log topic on
WebHelp.
3. Configure the extended log to monitor the trend log.
For more information, see the Configuring an Extended Trend Log topic on
WebHelp.
You can also configure extended logging for an external (generic) BACnet trend log.
For more information, see section 75.29 “Extended Logging for External BACnet
Trend Logs Workflow” on page 2640.
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76.48

Creating a BACnet Loop
You create a BACnet loop so you can then configure a control loop for an
Automation Server or Enterprise Server.

To create a BACnet loop
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. On the File menu, point to New and then click Program.
3. In the object type list, select BACnet Loop.

4. In the Name box, type a name for the control loop.
5. In the Description box, type a description for the control loop.
Continued on next page
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6. Click Next.

7. Click Automatically generated to have the system generate a BACnet
instance ID or click Manually entered to type a specific Instance ID.
You cannot change the object’s Instance ID after the object is created.
8. In the BACnet name box, type a BACnet name for the control loop.
Do not type a name if you want a name to be assigned for you.
9. In the Priority for writing box, enter a priority at which the referenced
properties are commanded.
Value 1 is the highest priority and 16 is the lowest.
10. Click Create.
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76.49

Creating a BACnet Loop (Generic)
You create a generic BACnet loop program to view and control a BACnet loop in an
external BACnet device from WorkStation. When you create the loop program, you
need to perform one of the following operations:
• Download to a device to create a loop in an external BACnet device
• Upload from a device to upload the properties of a loop from a BACnet device
into Building Operation

To create a BACnet loop (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface and
expand the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Program.
4. In the object type list, select BACnet Loop (Generic).

5. In the Name box, type a name for the loop.
6. In the Description box, type a description for the loop.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device if you want to download the device
properties from the Building Operation database.
9. Click Automatically generated to have the system generate a BACnet
instance ID or click Manually entered to type a specific Instance ID.
You cannot change the object’s Instance ID after the object is created.
10. In the BACnet name box, type a BACnet name for the control loop.
Do not type a name if you want a name to be assigned for you.
11. Click Upload from BACnet device if you want to upload the properties of
the program into Building Operation.
12. In the Priority for writing box, enter a priority at which the referenced
properties are commanded.
Priority 1 is the highest and 16 is the lowest.
13. Click Create.
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76.50

Creating a BACnet File (Generic)
You create a BACnet file (generic) when you want to upload the properties of a
BACnet file from a BACnet device into Building Operation.

To create a BACnet file (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface and
expand the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Program.
4. In the object type list, select BACnet File (Generic).

5. In the Name box, type a name for the BACnet file.
6. In the Description box, type a description for the BACnet file.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the file.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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76.51

Creating a BACnet Program (Generic)
You create a BACnet program (generic) when you want to upload the properties of
a BACnet program from a BACnet device into Building Operation.

To create a BACnet program (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, expand
the network where the device resides, then expand the device.
2. Select Application.
3. On the File menu, point to New and then click Program.
4. In the object type list, select BACnet Program (Generic).

5. In the Name box, type a name for the BACnet program.
6. In the Description box, type a description for the program.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated. Once
created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the program. Do not type
a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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77.1

BACnet Command Priorities
A building automation system may include objects that are manipulated and written
to by other objects, operators, or applications. However, conflicts may arise when
these different entities try to write to the same commandable value property of a
BACnet object, such as a digital output.
To resolve this problem, a BACnet command priority handles any potential conflicts
by prioritizing the write requests in a descending order from 1 (highest) to 16
(lowest). In this way, the system resolves whether a BACnet write request takes
effect immediately or is stored in the command priority. Essentially, a command
priority manages the actions of multiple operators or applications that use the Value
property. For more information, see section 81.2 “Interface Manager for BACnet –
Basic Tab” on page 2967.
In the following illustration, a schedule configured to write to priority 10, regulates
several fans that circulate the air in a large office area. This schedule writes a value
of Off, which turns off the fans during normal operation. A program, configured with
an output bound to priority 3, monitors air quality for the same office area. If a
sensor monitored by the program detects an increase in the CO² levels, the
program overrides the current priority 10 and supersedes the schedule in the
command priority. The program sets a value of On, which turns on the fans. The
program relinquishes control of priority 3 when the CO² levels return to normal.
Then, the output of the schedule, which writes to priority 10, becomes active again.

Figure: BACnet Command Priority overview

In a 16-level BACnet priority array, there are different types of levels: available,
suggested, and reserved. You can configure these levels according to your specific
site requirements.
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Priority Level

Description

1

Manual life safety. This is a suggested priority level based on the
BACnet Standard.

2

Automatic life safety. This is a suggested priority level based on the
BACnet Standard.
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Continued
Priority Level

Description

3

Available for use.

4

Available for use.

5

Critical equipment control. This is a suggested priority level based on
the BACnet Standard.

6

Minimum on and off. This priority is reserved for timer-based
algorithms that are not currently supported. (Read only)

7

Available for use.

8

Manual operator. This is a suggested priority level based on the
BACnet Standard.

9

Available for use.

10

Available for use.

11

Available for use.

12

Available for use.

13

Available for use.

14

Available for use.

15

Available for use.

16

Available for use.

Relinquish default
Relinquish default is the value that the system uses for the value if all commandable
priority values in the priority array are NULL. For example, you can consider this
value as the lowest priority in the system. Relinquishing a priority is the same as
writing NULL at that priority. For more information, see section 81.2 “Interface
Manager for BACnet – Basic Tab” on page 2967.

77.1.1

Commandable Properties and Objects
In a building automation system, all BACnet devices are peers of one another and,
therefore, can equally write to the writable properties of other devices. However, the
peer status may cause conflicts when one BACnet device or application tries to
write to a property of an object on another device.
For more information, see section 77.2 “Commandable Properties and Objects” on
page 2852.
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77.1.2

Active Command Priority
Active command priority specifies the priority level (1-16) currently controlling the
value. The present value is the highest priority with a non-Null value. This property is
Null when the entire priority array is Null and the Relinquish default applies.
For more information, see section 77.3 “Active Command Priority” on page 2853.

77.1.3

Default Priority Level
The Default priority level is the lowest priority level in the system and applies in
situations where a user or system engineer does not specify a priority.
For more information, see section 77.5 “Default Priority Level” on page 2855.

77.1.4

Schedule and Loop Priority for Writing
Property
In a building automation system, schedules may interact with multiple BACnet
objects that have commandable value properties and, in most cases, act
independently of BACnet services. To fine tune the automation, BACnet schedules
include a Priority for writing property that defines the priorities of the commandable
values for the BACnet objects under their control. Similarly, a BACnet Loop
program includes a Priority for writing property that defines the appropriate priority
of the program in relation to the commandable value.
For more information, see section 77.9 “Schedule and Loop Priority for Writing
Property” on page 2859.

77.1.5

Command Priority Retain Levels for BACnet
Objects
When creating a BACnet point or value, you can configure the warm start and cold
start settings for a command priority array.
For more information, see section 77.10 “Command Priority Retain Levels for
BACnet Objects” on page 2860.
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77.2

Commandable Properties and Objects
In a building automation system, all BACnet devices are peers of one another and,
therefore, can equally write to the writable properties of other devices. However, the
peer status may cause conflicts when one BACnet device or application tries to
write to a property of an object on another device.
To resolve conflicts, a command priority uses the following commandable
properties of BACnet objects to prioritize the writable commands.
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Commandable Property

Analog Output

Present Value

Binary (Digital) Output

Present Value

Multistate Output

Present Value

Analog Value

Present Value

Binary (Digital) Value

Present Value

Multistate Value

Present Value
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77.3

Active Command Priority
Active command priority specifies the priority level (1-16) currently controlling the
value. The present value is the highest priority with a non-Null value. This property is
Null when the entire priority array is Null and the Relinquish default applies.
In the following example, the highest non-Null value is set to Priority 4; therefore, the
Active command priority is 4.

Figure: Active command priority example

You set the priority levels from the Command tab of objects that support command
priorities, such as a BACnet analog or digital output. You can also set the priority
levels using the Binding tool. For more information, see section 80.10 “Binding an
Object Property to a BACnet Schedule” on page 2953.
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77.4

Viewing the Command Priority Levels
You can view the BACnet command priority levels to see what levels are available
for use.
For more information, see section 77.1 “BACnet Command Priorities” on page
2849.

To view the command priority levels
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click Interface Manager.
4. View the available command priority levels for the BACnet system.
You can also configure a default priority level for the BACnet system. For more
information, see section 77.6 “Configuring the Default Priority Level” on page 2856.
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77.5

Default Priority Level
The Default priority level is the lowest priority level in the system and applies in
situations where a user or system engineer does not specify a priority.
The Default priority level controls the following actions:
• Implicitly writes to the default priority level when a binding transmits data to a
commanded value.
• Automatically configures the Priority for writing property to the default priority
level when a new schedule is created.

Tip
As a best practice, define the Default priority level prior to configuring the system.
In addition, consider maintaining the same default priority level for multiple active
systems at your site. For example, configure the same default priority level for the
building automation system and fire protection system.

Figure: Default priority level example

In a multi-server system, you can only configure the Default priority level from the
Interface Manager of the top-level server (Enterprise Server). If you set a new priority
level, the system propagates the change to the other BACnet servers in the
network. For more information, see section 77.6 “Configuring the Default Priority
Level” on page 2856.
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77.6

Configuring the Default Priority Level
You can change the default priority level for the lead server in the BACnet system.
For more information, see section 77.1 “BACnet Command Priorities” on page
2849.

To configure the default priority level
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click Interface Manager.
4. In the Default priority level box, enter a priority level for the BACnet system.
5. Click OK.
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77.7

Forced Priority Level
Forced Priority Level is a global setting that you assign to forced values in the
BACnet system. Whenever a commandable output or value is forced, the BACnet
system determines when and if the change is made based on the command priority
settings.
By default, the Forced Priority Level is set to Priority 8. However, you can change it,
if necessary. In most cases, this value is defined during the initial system
configuration. Once defined, it is recommended that you do not change this setting.
For more information, see section 77.8 “Configuring a Forced Priority Level” on
page 2858.
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77.8

Configuring a Forced Priority Level
You can set the forced priority level for the lead server in the BACnet system.
For more information, see section 77.7 “Forced Priority Level” on page 2857.

To configure a forced priority level
1. In WorkStation, on the Tools menu, click Control Panel.
2. Click Interface Manager.
3. In the Forced priority level box, enter a forced priority level for the BACnet
system.
4. Click OK.
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77.9

Schedule and Loop Priority for Writing
Property
In a building automation system, schedules may interact with multiple BACnet
objects that have commandable value properties and, in most cases, act
independently of BACnet services. To fine tune the automation, BACnet schedules
include a Priority for writing property that defines the priorities of the commandable
values for the BACnet objects under their control. Similarly, a BACnet Loop
program includes a Priority for writing property that defines the appropriate priority
of the program in relation to the commandable value.
Priority for writing manages the priority of BACnet schedules or loop programs that
reference commandable values, which are used in a command priority. Similar to
the commandable values of BACnet outputs and values, the priority levels range
from 1 (highest) to 16 (lowest). For more information, see section 77.1 “BACnet
Command Priorities” on page 2849.
You can initially set the Priority for writing level when creating a schedule or loop
program. Later, you can change the priority level, if necessary. You can also change
a priority using the Binding tool. For more information, see section 80.10 “Binding
an Object Property to a BACnet Schedule” on page 2953.

Figure: Priority for writing property

04-16006-04-en, March 2015

Technical
2861

77 BACnet Command Priorities
77.10 Command Priority Retain Levels for BACnet Objects

77.10

Command Priority Retain Levels for
BACnet Objects
When creating a BACnet point or value, you can configure the warm start and cold
start settings for a command priority array.
Option

Description

Warm start

After a warm start, the variable retains the last value set by a user or
application, or retains the default if never defined by a user. For example,
use this option for system-based control applications that preserve the
state of equipment during short-term power failures. In most cases,
users should be denied access to these applications and, consequently,
would not manually set any values.
After a cold start, the value reverts to the default.

Cold start

After a warm start or cold start, the variable retains the last value set by a
a user or application, or retains the default if never set by a user. For
example, use this option for temperature set points that can be defined
by both users and control programs.

No

After a restart, the variable reverts to the default value. For example, use
this option for temporary values that can be reset to zero later.

You can initially configure the Command priority retain level. For example, you can
configure when the system should retain the value of a BACnet analog output. For
more information, see the Retain Level topic on WebHelp.
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78.1

BACnet Download and Upload
You can download and upload the properties of a single object or BACnet device,
or the full contents and properties of a BACnet device.

78.1.1

BACnet Download
You download data when you want to use the data in the Building Operation server
rather than the data that is in the physical device. For example, you can download
the properties of a single object or the entire contents of a BACnet device.

Tip
A full device download attempts to delete anything from the device that is not in
the database - possibly destroying an existing configuration a user performs with
a non-Building Operation tool.
For more information, see section 78.2 “BACnet Download” on page 2864.

78.1.2

BACnet Upload
You upload data when you want to use the data that is in the physical device rather
than the data in the Building Operation server. For example, you can upload the
properties of a single object or the full contents of a BACnet device.

Tip
After you discover a device, you use full device upload in order to create the
contents of the physical BACnet device in the Building Operation server. Upload
deletes anything from the database that is not in the device - possibly destroying
the configuration a Building Operation user has performed.
For more information, see section 78.9 “BACnet Upload” on page 2872.
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78.2

BACnet Download
You download data when you want to use the data in the Building Operation server
rather than the data that is in the physical device. For example, you can download
the properties of a single object or the entire contents of a BACnet device.

78.2.1

Download Single Object Properties
You download a single object from the Building Operation server to update only that
object’s properties in the BACnet device. Downloading a single object synchronizes
the properties of that object in a Building Operation server with the properties of
that object in the physical BACnet device. For more information, see section 78.4
“Downloading the Properties of an Object” on page 2867.

Tip
A device that requires a download is marked with the Download required icon
, which indicates that the Building Operation server's database is not
synchronized with the physical BACnet device.

78.2.2

Download Device Configuration Properties
You download the configuration properties of the device from a Building Operation
server to update only the configuration properties of the BACnet device. This
process downloads only the device properties without disturbing any objects. For
example, if a device is offline and you need to make some configuration changes,
you use the Device Properties' pane to modify the properties of the BACnet device,
such as changing the APDU timeout. After you save the edits and the device is
back online, you download these changes to the device without affecting any other
objects. For more information, see section 78.3 “Downloading Configuration
Properties ” on page 2866.

Tip
Download Configuration Properties is especially useful if other objects in the
device were modified outside of Building Operation. However, the system only
clears the

78.2.3

indicator for the BACnet device but not for any objects it contains.

Download Device Full Contents
You download the entire contents of a BACnet device from the Building Operation
server to update all of the objects and properties in the physical BACnet device.
Download synchronizes the contents of a BACnet device in a Building Operation
server with the contents of the physical BACnet device. The synchronization can
destroy any existing configuration in the physical BACnet device performed by a
generic BACnet workstation. For example, a physical BACnet device has a BACnet
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schedule that is not in the Automation Server. When you perform a full device
download, the BACnet schedule in the physical BACnet device is deleted. For more
information, see section 78.5 “Downloading the Contents of a BACnet Device” on
page 2868.

Note
The Download command sends create and delete requests to the device, but
the device determines if these requests are supported or allowed.

78.2.4

Download Network
In one step, you can download the following networks:
• IP Network. For more information, see section 78.6 “Downloading an IP
Network” on page 2869.
• MSTP Network. For more information, see section 78.7 “Downloading an
MSTP Network” on page 2870.
• Remote Network. For more information, see section 78.8 “Downloading a
Remote Network” on page 2871.
The system downloads all the devices and objects on the network in sequential
order.
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78.3

Downloading Configuration Properties
You download the configuration properties of the BACnet device from the Building
Operation server to update only the device's configuration properties. You do this to
download only device properties without disturbing any other objects. Examples of
the configuration properties include Daylight savings status, UTC offset, APDU
timeout.

To download configuration properties
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Select the BACnet device.
4. On the Actions menu, point to Device and then click Download
configuration.

5. In Progress view, click Close when the download finishes.
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78.4

Downloading the Properties of an
Object
You download an object from the Building Operation server database to update
only that object's properties in the BACnet device without disturbing the database
information for any other object.
For more information, see section 78.2 “BACnet Download” on page 2864.

To download the properties of an object
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Expand the device, and then expand Application.
4. Select the object in the System Tree.
5. On the Actions menu, click Download.

The commands on the Actions menu are context-sensitive and, therefore,
vary with the selected object.
6. In the Progress view, click Close when the download finishes.

04-16006-04-en, March 2015

Technical
2869

78 BACnet Download and Upload
78.5 Downloading the Contents of a BACnet Device

78.5

Downloading the Contents of a BACnet
Device
You download a BACnet device from the Building Operation server's database to
update all of the objects and properties of the device.
For more information, see section 78.2 “BACnet Download” on page 2864.

To download the contents of a BACnet device
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand Application and then expand the network where the device is
installed.
3. Select the BACnet device.
4. On the Actions menu, click Download.

5. In Progress view, click Close when the download finishes.
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78.6

Downloading an IP Network
You download the contents of an IP network from the Building Operation server's
database to update all of the devices, objects, and properties of the network.
For more information, see section 78.2 “BACnet Download” on page 2864.

To download an IP network
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the IP Network that you want to download.
3. On the Actions menu, click Download.
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78.7

Downloading an MSTP Network
You download the contents of an MSTP network from the Automation Server's
database to update all of the devices, objects, and properties of the network.
For more information, see section 78.2 “BACnet Download” on page 2864.

To download an MSTP network
1. In WorkStation, in the System Tree, expand BACnet Interface on the
Automation Server.
2. Select the MSTP Network that you want to download.
3. On the Actions menu, click Download.
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78.8

Downloading a Remote Network
You download the contents of an Remote network from the Building Operation
server's database to update all of the devices, objects, and properties of the
network.
For more information, see section 78.2 “BACnet Download” on page 2864.

To download a remote network
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Select the Remote Network that you want to download.
3. On the Actions menu, click Download.
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78.9

BACnet Upload
You upload data when you want to use the data that is in the physical device rather
than the data in the Building Operation server. For example, you can upload the
properties of a single object or the full contents of a BACnet device.

78.9.1

Upload Single Object Properties
You upload a single object from the physical BACnet device to update only that
object’s properties in the Building Operation server database. Uploading a single
object synchronizes the properties of that object in the physical device with the
properties of that object in the Building Operation server. For more information, see
section 78.11 “Uploading the Properties of an Object” on page 2875.

Tip
A device that requires an upload is marked with the Upload required icon
,
which indicates that the Building Operation server's database is not synchronized
with the physical BACnet device.

78.9.2

Upload Device Configuration Properties
You upload the configuration properties of a device to a Building Operation server
to update only the configuration properties of the BACnet device. This process
uploads only the device properties without disturbing any objects. For more
information, see section 78.10 “Uploading Configuration Properties ” on page 2874.

78.9.3

Upload Device Full Contents
You upload the full contents of a BACnet device to the Building Operation server to
update all of the objects and properties in the Building Operation server's database.
For more information, see section 78.12 “Uploading the Contents of a BACnet
Device” on page 2876.
The following examples show a before and after view of a full contents upload on
the Building Operation server's database.
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Figure: Before and after device upload

During an upload, the Building Operation server reads the configuration of the
physical BACnet device to synchronize its database with that of the device. The
synchronization will supplant the current configuration of this device in the Building
Operation server database. For example, an Automation Server may include a
schedule that no longer exists in the physical device. As a result, the upload
process will delete the schedule from the Automation Server database.
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78.10

Uploading Configuration Properties
You upload the configuration properties of the BACnet device to update only the
device's configuration properties in the Building Operation server's database. You
do this to upload only device properties without disturbing any other objects.
Examples of the configuration properties include Daylight savings status, UTC
offset, APDU timeout.

To upload configuration properties
1. In WorkStation, in the System Tree, expand BACnet Interface, then
expand the network where the BACnet device resides.
2. Select the BACnet device.
3. On the Actions menu, point to Device and then click Upload
configuration.

4. In Progress view, click Close when the upload finishes.
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78.11

Uploading the Properties of an Object
You upload an object from the BACnet device to update only that object's
properties in the Building Operation server database without disturbing the
database information for any other object.
For more information, see section 78.9 “BACnet Upload” on page 2872.

To upload the properties of an object
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the network where the BACnet device resides.
3. Expand the device, and then expand Application.
4. Select the object in the System Tree.
5. On the Actions menu, click Upload.

The commands on the Actions menu are context-sensitive and, therefore,
vary with the selected object.
6. In the Progress view, click Close when the upload finishes.
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78.12

Uploading the Contents of a BACnet
Device
You upload a BACnet device to update all of the objects and properties of the
device to the Building Operation server's database.
For more information, see section 78.9 “BACnet Upload” on page 2872.

To upload the contents of a BACnet device
1. In WorkStation, in the System Tree pane, expand BACnet Interface.
2. Expand Application and then expand the network where the device is
installed.
3. Select the BACnet device.
4. On the Actions menu, click Upload.

5. In Progress view, click Close when the upload finishes.
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79.1 BACnet Notifications

79.1

BACnet Notifications
A BACnet notification is the Building Operation equivalent of a BACnet notification
class. A BACnet notification defines what devices to notify when a transition from
one event state to another has occurred, such as a to-normal event has
transitioned to a to-fault event.
BACnet devices that receive a BACnet notification are called device recipients. In
addition, a BACnet notification defines how to prioritize the handling of an event,
and whether an event acknowledgement by an operator is required.
In Building Operation, a BACnet notification also defines the following components:
• Alarm category and alarm alert type. For more information, see section 81.103
“BACnet Notification – Presentation Tab” on page 3150.
• User actions for responding to an alarm. For more information, see section
81.104 “BACnet Notification – User Action Tab” on page 3151.
There are two types of BACnet notifications, one for the server and the other for
device. To differentiate a server notification from a device notification, the system
adds the term, generic, to the end of the notification name. For example, a
notification created on a server is a BACnet Notification while a notification created
on a device is a BACnet Notification (Generic).

Tip
A single BACnet notification can be referenced by multiple BACnet alarms.
However, a single BACnet notification can also be referenced by multiple objects
that support intrinsic alarming.
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79.2

Creating a BACnet Notification
You create a BACnet notification so you can then configure the notification to notify
devices of certain system conditions. In BACnet, notifications are referenced by
algorithmic alarms and intrinsic alarms. After you create the notification, you use
WorkStation to configure the notification.

To create a BACnet notification
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. On the File menu, point to New and then click Alarm.
3. In the object type list, select BACnet Notification.

4. In the Name box, type a name for the notification.
5. In the Description box, type a description for the notification.
Continued on next page
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6. Click Next.

7. In the Instance ID box, choose one of the following options:
• Click Automatically generated to have the server generate a BACnet
instance ID for you.
• Click Manually entered if you want to enter an Instance ID manually.
8. In the BACnet name box, type a BACnet name for the notification.
Do not type a name if you want a name to be assigned for you.
9. Click Create.
You can now configure the BACnet notification.
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79.3

Configuring a BACnet Notification
You configure a BACnet notification to define a device recipient for the notification,
prioritize event handling, and specify whether acknowledgements for the notification
are required. Prior to configuring the notification, determine if you need to create
any of the following alarm options:
• Alarm categories. For more information, see section 26.1 “Categories” on page
839.
• Alarm cause notes. For more information, see the Cause Notes topic on
WebHelp.
• Alarm action notes. For more information, see the Action Notes topic on
WebHelp.
• Alarm checklists. For more information, see the Checklists topic on WebHelp.
For more information, see section 79.1 “BACnet Notifications” on page 2879.

To configure a BACnet notification
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the folder where the BACnet notification resides.
A BACnet notification created on the server resides in the Application folder
of the BACnet Interface. However, a BACnet notification (generic) created on
an external device resides in the Application folder of the device.
3. Select the BACnet notification that you want to configure.
4. On the File menu, click Open.
5. Click the Presentation tab.
6. In the Category box, enter the alarm category (if any) of the alarm that you
want to reference the notification.

7. Select the alert type that the system will use when the alarm is triggered.
Continued on next page
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8. Click the User Action tab.

9. Edit the properties.
Property

Description

Cause note group

Enter the cause note group that is used by the alarm.

Action note group

Enter the action note group that is used by the alarm.

Checklist

Enter the checklist that belongs to the alarm.

When
acknowledging an
alarm

Select what actions the user has to perform when
acknowledging an alarm.

Required user
actions

Select what actions the user has to perform when any of the
listed events occur.

10. Click the Attachment tab.
Continued on next page

04-16006-04-en, March 2015

Technical
2885

79 BACnet Notifications and Alarms
79.3 Configuring a BACnet Notification

11. Click the Add attachment button
to attach an object to the notification
that displays when the alarm is triggered, such as a report or chart.

12. Click the Device Recipient Rules tab.

Continued on next page
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13. Edit the properties.
Property

Description

Priority to off
normal

Enter the priority for sending the notification when a to-offnormal event state occurs. The lower the number, the
higher the priority, for example, 1 assigns a high priority for
sending the notification.

Priority to fault

Enter the priority for sending the notification when a to-fault
event state occurs. The lower the number, the higher the
priority, for example, 1 assigns a high priority for sending the
notification.

Priority to normal

Enter the priority for sending the notification when a tonormal event state occurs. The lower the number, the
higher the priority, for example, 1 assigns a high priority for
sending the notification.

Acknowledgement
required

Select one or more event states to specify whether an
acknowledgement of the notification is required when the
event state occurs. This property may be supported in third
party BACnet devices, but is not supported by Building
Operation BACnet devices.
Click to open the Device Recipient Rule dialog box where
you define a device recipient for the notification. For more
information, see section 81.107 “BACnet Notification –
Device Recipient Rule Dialog Box” on page 3155.
Click to open the Device Recipient Rule dialog box where
you modify the device recipient rules. For more information,
see section 81.107 “BACnet Notification – Device Recipient
Rule Dialog Box” on page 3155.
Click to remove a selected device recipient from the list.

Name

Indicates the devices that are receiving the notification.

14. Click the Add recipient rules button
notification.

to define a device recipient for the
Continued on next page
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15. In the Process identifier box, enter the process Id of the device recipient.
This property is device-dependent and may be supported by some BACnet
devices. However, this property is not supported by Building Operation
BACnet devices.

16. In the Confirmed notifications box, select Yes if you want a device that
goes into alarm to use the BACnet ConfirmedEventNotification Service.
This option does not control or affect alarm acknowledgements by an
operator.
Continued on next page
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17. Configure the time settings for generating notifications, for example, select All
day if you want the notifications to be sent over a 24-hour period.
After choosing either All day or entering a Start time and End time, select
one or more valid days.
18. Choose one of the following methods:
• Click Reference to identify the device recipient by referencing the
device. This selection activates the Recipient device object
reference box.
• Click Device ID to identify the device recipient by the instance number of
the BACnet device. This selection activates the Recipient device
identifier box.
• Click MAC address to identify the device recipient by the network
address of the device. Use a MAC network address when you want to
identify objects not included in the Building Operation database. This
selection activates the Network ID box.
19. In the Recipient device object reference box, enter the reference to a
BACnet device or the local BACnet Interface (if you clicked Reference for the
Recipient type).
20. In the Recipient device identifier box, enter the BACnet instance number
of the device (f you clicked Device Id for the Recipient type).
21. In the Network ID box, select one of the following options (if you clicked
MAC address for the Recipient type):
• Select Local Network to send the event notification to a device recipient
on the same network. Then enter the MAC address of the device
recipient.
If the event notification resides on two networks, such as an MS/TP
network and IP network, the system sends the event notification to a
device recipient on the IP Network.
• Select Global Broadcast to send the event notification to all devices on
all networks.
22. Select one of the following actions (if you selected Local Network for
Network ID):
• Click MS/TP and enter a number between 0 and 255 for the MS/TP
MAC address of the device recipient on the network. Reserved for
broadcast, MS/TP number 255 is available for use as an address for
broadcasting.
• Click IP and enter the IP address and IP port number of the device
recipient on the IP Network.
• Click Raw (hexadecimal) and enter the hexadecimal MAC address of
the device recipient.
• Click Broadcast to send the event notification to multiple MAC
addresses on the network.
23. Click OK to return to the Device Recipient Rules tab.
24. Click the Add recipient rules button
recipients.

to define additional device
Continued on next page
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25. Click the Save button
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79.4

Creating a BACnet Notification
(Generic)
You create a generic BACnet notification when you want to view and configure a
BACnet notification in an external BACnet device. In BACnet, notifications are
referenced by algorithmic alarms and intrinsic alarms. When you create the generic
BACnet notification, you need to perform one of the following operations:
• Download to a device to create a notification in an external BACnet device.
• Upload from a device to upload the properties of a notification from a BACnet
device into Building Operation.

To create a BACnet notification (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface and
expand the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Alarm.
4. In the object type list, expand BACnet Alarms and select BACnet
Notification (Generic).

5. In the Name box, type a name for the notification.
6. In the Description box, type a description for the notification.
7. Click Next.
Continued on next page
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8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.

Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the notification.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
You can now configure the generic BACnet notification.
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79.5

Configuring a BACnet Notification
(Generic)
You configure a BACnet notification to define a device recipient for the notification,
prioritize event handling, and specify whether acknowledgements for the notification
are required. Prior to configuring the notification, determine if you need to create
any of the following alarm options:
• Alarm categories. For more information, see section 26.1 “Categories” on page
839.
• Alarm cause notes. For more information, see the Cause Notes topic on
WebHelp.
• Alarm action notes. For more information, see the Action Notes topic on
WebHelp.
• Alarm checklists. For more information, see the Checklists topic on WebHelp.
For more information, see section 79.1 “BACnet Notifications” on page 2879.

To configure a BACnet notification (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the he Application folder of the external device where the BACnet
notification resides.
3. Select the BACnet notification that you want to configure.
4. On the File menu, click Open.
5. Click the Presentation tab.
6. In the Category box, enter the alarm category (if any) of the alarm that you
want to reference the notification.

7. Select the alert type that the system will use when the alarm is triggered.
Continued on next page
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8. Click the User Action tab.

9. Edit the properties.
Property

Description

Cause note group

Enter the cause note group that is used by the alarm.

Action note group

Enter the action note group that is used by the alarm.

Checklist

Enter the checklist that belongs to the alarm.

When
acknowledging an
alarm

Select what actions the user has to perform when
acknowledging an alarm.

Required user
actions

Select what actions the user has to perform when any of the
listed events occur.

10. Click the Attachment tab.
Continued on next page
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11. Click the Add attachment button
to attach an object to the notification
that displays when the alarm is triggered, such as a report or chart.

12. Click the Device Recipient Rules tab.

Continued on next page
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13. Edit the properties.
Property

Description

Priority to off
normal

Enter the priority for sending the notification when a to-offnormal event state occurs. The lower the number, the
higher the priority, for example, 1 assigns a high priority for
sending the notification.

Priority to fault

Enter the priority for sending the notification when a to-fault
event state occurs. The lower the number, the higher the
priority, for example, 1 assigns a high priority for sending the
notification.

Priority to normal

Enter the priority for sending the notification when a tonormal event state occurs. The lower the number, the
higher the priority, for example, 1 assigns a high priority for
sending the notification.

Acknowledgement
required

Select one or more event states to specify whether an
acknowledgement of the notification is required when the
event state occurs. This property may be supported in third
party BACnet devices, but is not supported by Building
Operation BACnet devices.
Click to open the Device Recipient Rule dialog box where
you define a device recipient for the notification. For more
information, see section 81.107 “BACnet Notification –
Device Recipient Rule Dialog Box” on page 3155.
Click to open the Device Recipient Rule dialog box where
you modify the device recipient rules. For more information,
see section 81.107 “BACnet Notification – Device Recipient
Rule Dialog Box” on page 3155.
Click to remove a selected device recipient from the list.

Name

Indicates the devices that are receiving the notification.

14. Click the Add recipient rules button
notification.

to define a device recipient for the
Continued on next page
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15. In the Process identifier box, enter the process Id of the device recipient.
This property is device-dependent and may be supported by some BACnet
devices. However, this property is not supported by Building Operation
BACnet devices.

16. In the Confirmed notifications box, select Yes if you want a device that
goes into alarm to use the BACnet ConfirmedEventNotification Service.
This option does not control or affect alarm acknowledgements by an
operator.
Continued on next page
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17. Configure the time settings for generating notifications, for example, select All
day if you want the notifications to be sent over a 24-hour period.
After choosing either All day or entering a Start time and End time, select
one or more valid days.
18. Choose one of the following methods:
• Click Reference to identify the device recipient by referencing the
device. This selection activates the Recipient device object
reference box.
• Click Device ID to identify the device recipient by the instance number of
the BACnet device. This selection activates the Recipient device
identifier box.
• Click MAC address to identify the device recipient by the network
address of the device. Use a MAC network address when you want to
identify objects not included in the Building Operation database. This
selection activates the Network ID box.
19. In the Recipient device object reference box, enter the reference to a
BACnet device or the local BACnet Interface (if you clicked Reference for the
Recipient type).
20. In the Recipient device identifier box, enter the BACnet instance number
of the device (f you clicked Device Id for the Recipient type).
21. In the Network ID box, select one of the following options (if you clicked
MAC address for the Recipient type):
• Select Local Network to send the event notification to a device recipient
on the same network. Then enter the MAC address of the device
recipient.
If the event notification resides on two networks, such as an MS/TP
network and IP network, the system sends the event notification to a
device recipient on the IP Network.
• Select Global Broadcast to send the event notification to all devices on
all networks.
22. Select one of the following actions (if you selected Local Network for
Network ID):
• Click MS/TP and enter a number between 0 and 255 for the MS/TP
MAC address of the device recipient on the network. Reserved for
broadcast, MS/TP number 255 is available for use as an address for
broadcasting.
• Click IP and enter the IP address and IP port number of the device
recipient on the IP Network.
• Click Raw (hexadecimal) and enter the hexadecimal MAC address of
the device recipient.
• Click Broadcast to send the event notification to multiple MAC
addresses on the network.
23. Click OK to return to the Device Recipient Rules tab.
24. Click the Add recipient rules button
recipients.

to define additional device
Continued on next page
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25. Click the Save button
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79.6

BACnet Alarms
A BACnet alarm is the Building Operation equivalent of an Event Enrollment. A
BACnet alarm defines the conditions of an event and identifies the property to be
monitored.
In Building Operation, various BACnet alarm states, such as In alarm or Out of
service, display in the Status Information or Alarm View. However, there are some
Building Operation states, such as Disabled, that do not apply to BACnet objects.
A BACnet alarm also references a BACnet notification. When the value of the
monitored property meets the conditions defined by the BACnet alarm, the
referenced BACnet notification is sent to one or more device recipients and an
alarm is generated. For more information, see section 79.1 “BACnet Notifications”
on page 2879.

79.6.1

BACnet Alarm Types and Monitored Variables
Table
BACnet alarms include a number of supported objects and properties for monitored
variables.
For more information, see section 79.7 “BACnet Alarm Types and Monitored
Variables Table” on page 2900.

79.6.2

Intrinsic Alarming
With objects that support intrinsic alarming, the conditions of the event are defined
by the Alarm Configuration properties of the object. In addition, the object
references a BACnet notification. When the Value property of the object meets the
conditions defined by the Alarm Configuration properties, the referenced BACnet
notification is sent to one or more device recipients and an alarm is generated.

79.6.3

Alarm Status
Alarm Status displays the acknowledged transitions of the objects in a BACnet
device and the Buildiing Operation-based alarm states.
For more information, see the Alarm States topic on WebHelp.

79.6.4

Alarm Summary
The Alarm Summary tab displays BACnet objects if the following requirements are
met:
• Device supports the BACnet GetAlarmSummary service.
• Object is a standard BACnet object.
• Object supports the Event State property and the Notify type property.
• Notify type property is set to alarm.
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For more information, see section 81.13 “BACnet Device – Alarm Summary Tab” on
page 2987.
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79.7

BACnet Alarm Types and Monitored
Variables Table
The following table lists the alarm types along with the supported objects and
properties of the monitored variables that you can choose from when configuring a
BACnet alarm.
Table: BACnet Alarm Types and Monitored Variables Table
Alarm Type

Monitored Variable
Object

Monitored Variable
Property

Change of State

BACnet Digital Input

Value

BACnet Digital Output

Value

BACnet Digital Value

Value

BACnet Multistate Input

Value

BACnet Multistate Output

Value

BACnet Multistate Value

Value

BACnet Analog Input

Value

BACnet Analog Output

Value

BACnet Analog Value

Value

BACnet Analog Input

Value

BACnet Analog Output

Value

BACnet Analog Value

Value

BACnet Loop

Controlled Variable Value

BACnet Analog Input

Value

BACnet Analog Output

Value

BACnet Analog Value

Value

BACnet Loop

Setpoint

BACnet Analog Input

Value

BACnet Analog Output

Value

BACnet Analog Value

Value

BACnet Digital Input

Value

BACnet Digital Output

Value

Change of Value

Floating Limit

Floating Limit Setpoint
reference

Out of Range

Continued on next page
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Continued
Alarm Type

Buffer Ready

Monitored Variable
Object

Monitored Variable
Property

BACnet Digital Value

Value

BACnet Multistate Input

Value

BACnet Multistate Output

Value

BACnet Multistate Value

Value

BACnet Trend Log

(Any)

Note
Building Operation only supports BACnet alarms that reference local objects
created on the Building Operation server and consequently excludes references
to objects located on external (generic) devices.
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79.8

Creating a BACnet Alarm
You create a BACnet alarm as part of the process of creating an algorithmic alarm
for a monitored variable. After you create the alarm, you use WorkStation to
configure the alarm for the monitored variable.

To create a BACnet alarm
1. In WorkStation, in the System Tree, expand BACnet Interface and then
select Application.
2. On the File menu, point to New and then click Alarm.
3. In the object type list, select BACnet Alarm.

4. In the Name box, type a name for the alarm.
5. In the Description box, type a description for the alarm.
6. Click Next.
Continued on next page
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7. In the Instance ID box, choose one of the following options:
• Click Automatically generated to have the server generate a BACnet
instance ID for you.
• Click Manually entered if you want and then enter an Instance ID
yourself.

8. In the BACnet name box, type a BACnet name for the alarm.
Do not type a name if you want a name to be assigned for you.
9. Click Create.
You can now configure the BACnet alarm.
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79.9

Configuring a BACnet Change of State
Alarm
You configure a BACnet change of state alarm to monitor the state changes of
selected properties for digital and multistate objects in a BACnet device.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.2 “Creating a BACnet
Notification” on page 2880.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet change of state alarm
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the BACnet Interface where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
6. In the Alarm Type box, select Change of state.

Continued on next page
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7. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
8. To specify the Alarm Trigger Type, do one of the following actions:
• Click Active/Inactive if you want to specify one or both states as alarm
triggers.
• Click Value list if you want to specify a value or a list of values to be
compared to the Monitored variable before a change of state occurs,
and an alarm is triggered.
9. In the Trigger alarm when signal is equal to box, select the state that
indicates when to trigger the alarm if you clicked Active/Inactive for the
Alarm Trigger Type:
• Select Active if you want the alarm to be triggered when the state of the
Monitored variable is active.
• Select Inactive if you want the alarm to be triggered when the state of
the Monitored variable is inactive.
10. In the Monitored variable box, select the reference for the monitored
variable and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
11. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
12. Click the Save button
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79.10

Configuring a BACnet Change of Value
Alarm
You configure a BACnet change of value alarm to generate an alarm that signals a
to-normal transition. The change of value alarm occurs under the following
conditions:
• The absolute value of the monitored variable changes by an amount that is
equal to or greater than the value displayed in the Increment property.
• The condition remains constant for the number of seconds that are specified in
the Time delay property.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.2 “Creating a BACnet
Notification” on page 2880.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet change of value alarm
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the BACnet Interface where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
Continued on next page
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6. In the Alarm Type box, select Change of value.

7. In the Increment box, enter the increment by which the Monitored
variable is required to change in order to trigger the alarm.
8. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
9. In the Monitored variable box, choose the reference for the monitored
variable and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
Continued on next page
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10. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
11. Click the Save button
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79.11

Configuring a BACnet Floating Limit
Alarm
You configure a floating limit alarm when you want an alarm to be triggered when
the Monitored variable exceeds or falls below a range of values. The range is
determined by the current value of the Setpoint reference, Upper deviation limit,
Lower deviation limit, and the Deadband.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.2 “Creating a BACnet
Notification” on page 2880.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet floating limit alarm
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the BACnet Interface where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
Continued on next page
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6. In the Alarm Type box, select Floating limit.

7. In the Upper deviation limit box, enter a value to be used to calculate a
range of values that determine whether the Monitored variable deviates
from the range of values.
8. In the Lower deviation limit box, enter a value to be used to calculate a
range of values that determine whether the Monitored variable deviates
from the range of values.
9. In the Deadband box, enter a value used to calculate a range of values that
determine whether the Monitored variable deviates from the range of
values.
10. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
Continued on next page
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11. In the Setpoint reference box, select the reference for the setpoint to
calculate a range of values that determine whether the monitored variable
deviates from the range of values:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
12. In the Monitored variable box, select the reference for the monitored
variable and property, for example, an analog input or BACnet loop:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
13. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
14. Click the Save button
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79.12

Configuring a BACnet Out of Range
Alarm
You configure a BACnet out of range alarm to trigger an alarm when the monitored
variable, such as an input or value, exceeds or falls below a range of values. The
alarm triggers when the monitored variable exceeds or falls below a range of values
defined by the upper limit and lower limit, and remains at that value for the number
of seconds defined by the time delay property.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.2 “Creating a BACnet
Notification” on page 2880.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet out of range alarm
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the BACnet Interface where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
Continued on next page
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6. In the Alarm Type box, select Out of range.

7. In the Upper limit box, enter a value that the Monitored variable is
required to exceed in order to trigger the alarm.
8. In the Lower limit box, enter a value that the Monitored variable is
required to fall below in order to trigger the alarm.
9. In the Deadband box, enter a value to be used to calculate when the out of
range alarm can clear.
10. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
11. In the Monitored variable box, choose the reference for the monitored
variable and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
Continued on next page
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12. In the BACnet notification box, choose the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
13. Click the Save button
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79.13

Configuring a BACnet Buffer Ready
Alarm
You configure a buffer ready alarm for use with a BACnet trend log to monitor the
number of records entered into the log since trending began. The system generates
a buffer ready alarm when the number of records specified by the Notification
threshold property is reached, or when a BACnet notification is sent.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.2 “Creating a BACnet
Notification” on page 2880.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet buffer ready alarm
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the BACnet Interface where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
6. In the Alarm Type box, select Buffer ready.

Continued on next page
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7. In the Notification threshold box, type a percentage for the maximum
number of records that the system can store in the trend log before the alarm
triggers.
For example, set the threshold to 10% of your log size if you are setting up an
extended log to monitor an external (generic) BACnet log.
8. In the Monitored variable box, choose the reference for the BACnet trend
log and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
9. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
10. Click the Save button

.

You can now configure extended logging for a BACnet trend log to transfer records
from an external BACnet trend log to the Building Operation server. For more
information, see section 75.29 “Extended Logging for External BACnet Trend Logs
Workflow” on page 2640.
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79.14

Creating a BACnet Alarm (Generic)
You create a generic BACnet alarm when you want to view and configure a BACnet
algorithmic alarm for an external BACnet device from WorkStation. When you
create the generic BACnet alarm, you need to perform one of the following
operations:
• Download to a device to create an alarm in an external BACnet device.
• Upload from a device to upload the properties of an alarm from a BACnet
device into Building Operation.

To create a BACnet alarm (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface, and then
expand the network where the device resides.
2. Expand the device and select Application.
3. On the File menu, point to New and then click Alarm.
4. In the object type list, expand BACnet Alarms and select BACnet Alarm
(Generic).

5. In the Name box, type a name for the alarm.
6. In the Description box, type a description for the alarm.
7. Click Next.
Continued on next page
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8. Click Download to BACnet device and then choose one of the following
options:
• Click Automatically generated to have the ID generated for you.
• Click Manually entered to enter an Instance ID manually.

Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the alarm.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the alarm from the BACnet device into Building Operation.
11. Click Create.
You can now configure a generic BACnet alarm.
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79.15

Configuring a BACnet Change of State
Alarm (Generic)
You configure a BACnet change of state alarm to monitor the state changes of
selected properties for digital and multistate objects in a BACnet device.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.4 “Creating a BACnet
Notification (Generic)” on page 2889.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet change of state alarm (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the device where the alarm resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
6. In the Alarm Type box, select Change of state.

Continued on next page
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7. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
8. To specify the Alarm Trigger Type, do one of the following actions:
• Click Active/Inactive if you want to specify one or both states as alarm
triggers.
• Click Value list if you want to specify a value or a list of values to be
compared to the Monitored variable before a change of state occurs,
and an alarm is triggered.
9. In the Trigger alarm when signal is equal to box, select the state that
indicates when to trigger the alarm if you clicked Active/Inactive for the
Alarm Trigger Type:
• Select Active if you want the alarm to be triggered when the state of the
Monitored variable is active.
• Select Inactive if you want the alarm to be triggered when the state of
the Monitored variable is inactive.
10. In the Monitored variable box, select the reference for the monitored
variable and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
11. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
12. Click the Save button
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79.16

Configuring a BACnet Change of Value
Alarm (Generic)
You configure a BACnet change of value alarm to generate an alarm that signals a
to-normal transition. The change of value alarm occurs under the following
conditions:
• The absolute value of the monitored variable changes by an amount that is
equal to or greater than the value displayed in the Increment property.
• The condition remains constant for the number of seconds that are specified in
the Time delay property.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.4 “Creating a BACnet
Notification (Generic)” on page 2889.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet change of value alarm (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the BACnet Interface where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
Continued on next page
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6. In the Alarm Type box, select Change of value.

7. In the Increment box, enter the increment by which the Monitored
variable is required to change in order to trigger the alarm.
8. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
9. In the Monitored variable box, choose the reference for the monitored
variable and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
Continued on next page
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10. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
11. Click the Save button
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79.17

Configuring a BACnet Floating Limit
Alarm (Generic)
You configure a floating limit alarm when you want an alarm to be triggered when
the Monitored variable exceeds or falls below a range of values. The range is
determined by the current value of the Setpoint reference, Upper deviation limit,
Lower deviation limit, and the Deadband.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.4 “Creating a BACnet
Notification (Generic)” on page 2889.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet floating limit alarm (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of an external device where the alarm resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
Continued on next page
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6. In the Alarm Type box, select Floating limit.

7. In the Upper deviation limit box, enter a value to be used to calculate a
range of values that determine whether the Monitored variable deviates
from the range of values.
8. In the Lower deviation limit box, enter a value to be used to calculate a
range of values that determine whether the Monitored variable deviates
from the range of values.
9. In the Deadband box, enter a value used to calculate a range of values that
determine whether the Monitored variable deviates from the range of
values.
10. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
Continued on next page

04-16006-04-en, March 2015

Technical
2927

79 BACnet Notifications and Alarms
79.17 Configuring a BACnet Floating Limit Alarm (Generic)

11. In the Setpoint reference box, select the reference for the setpoint to
calculate a range of values that determine whether the monitored variable
deviates from the range of values:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
12. In the Monitored variable box, select the reference for the monitored
variable and property, for example, an analog input or BACnet loop:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
13. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
14. Click the Save button
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79.18

Configuring a BACnet Out of Range
Alarm (Generic)
You configure a BACnet out of range alarm when you want you an alarm to be
triggered when the Monitored variable exceeds or falls below a range of values. The
alarm is triggered when the Monitored variable exceeds or falls below a range of
values defined by the Upper limit and Lower limit, and remains at that value for the
number of seconds as defined by the Time delay property.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.4 “Creating a BACnet
Notification (Generic)” on page 2889.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet out of range alarm (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the external device where the alarm
resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
Continued on next page
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6. In the Alarm Type box, select Out of range.

7. In the Upper limit box, enter a value that the Monitored variable is
required to exceed in order to trigger the alarm.
8. In the Lower limit box, enter a value that the Monitored variable is
required to fall below in order to trigger the alarm.
9. In the Deadband box, enter a value to be used to calculate when the out of
range alarm can clear.
10. In the Time delay (s) box, enter the number of seconds required for the
alarm conditions to last before the BACnet Notification is sent.
11. In the Monitored variable box, choose the reference for the monitored
variable and property, for example, an input, output, or value:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
Continued on next page
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12. In the BACnet notification box, choose the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
13. Click the Save button
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79.19

Configuring a BACnet Buffer Ready
Alarm (Generic)
You configure a buffer ready alarm for use with a BACnet trend log to monitor the
number of records entered into the log since trending began. The system generates
a buffer ready alarm when the number of records specified by the Notification
threshold property is reached, or when a BACnet notification is sent.

Note
Before you configure the alarm, you need to create and configure a BACnet
notification. For more information, see section 79.4 “Creating a BACnet
Notification (Generic)” on page 2889.
For more information, see section 79.6 “BACnet Alarms” on page 2898.

To configure a BACnet buffer ready alarm (generic)
1. In WorkStation, in the System Tree, expand BACnet Interface.
2. Expand the Application folder of the device where the alarm resides.
3. In List View, select the BACnet alarm that you want to configure.
4. On the File menu, click Open.
5. Click the Alarm Trigger tab.
6. In the Alarm Type box, select Buffer ready.

Continued on next page
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7. In the Notification threshold box, type a percentage for the maximum
number of records that the system can store in the trend log before the alarm
triggers.
For example, set the threshold to 10% of your log size if you are setting up an
extended log to monitor an external (generic) BACnet log.
8. In the Monitored variable box, choose the reference for the BACnet trend
log and property:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
BACnet alarms include a number of supported objects and properties for
monitored variables. For more information, see section 79.7 “BACnet Alarm
Types and Monitored Variables Table” on page 2900.
9. In the BACnet notification box, select the reference for the BACnet
notification that generates the event:
• Select System reference to define a path-based reference to an object
or property that is currently located on the server. When selected, only the
Path field becomes editable. All the other fields become non-editable.
• Select BACnet reference to define a reference that uses the elements
of a property value (Device instance number, Object type, or Object
instance number) to identify a BACnet object or property that is not
currently on the server but may be uploaded or imported to the server
later.
10. Click the Save button

.

You can configure extended logging for a BACnet trend log to transfer records from
an external BACnet trend log to the Building Operation server. For more
information, see section 75.29 “Extended Logging for External BACnet Trend Logs
Workflow” on page 2640.
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BACnet Schedules and
Calendars

Topics
BACnet Schedules
Schedule and Supported Data Type for Binding
Creating a BACnet Calendar
Creating a BACnet Calendar (Generic)
Configuring a BACnet Calendar
Creating a BACnet Schedule
Creating a BACnet Schedule (Generic)
Configuring a BACnet Schedule
Configuring a Time Value Pair for a Schedule
Binding an Object Property to a BACnet Schedule
Modifying a Schedule Using the Text View
Modifying a Schedule Using the Graphic View

80 BACnet Schedules and Calendars
80.1 BACnet Schedules

80.1

BACnet Schedules
A BACnet schedule controls a writable property of an object by writing a value at a
specified time and date.
For example, you can create a digital schedule that turns the lights on and off in an
office area several times a week. To do this, you first configure the time span when
the schedule is active, such as from 8:00 AM to 5:00 PM. Then, you configure the
object property reference and value of the digital output for the lighting control that
the schedule controls. In the following example, the schedule turns on the lights
from 08:00 AM to 05:00 PM on Monday, Wednesday, and Friday in the office area.
For more information, see section 80.8 “Configuring a BACnet Schedule” on page
2949.

Figure: BACnet schedules overview

80.1.1

Schedule Exceptions
You can also create an exception to a schedule. For example, you configure a date
exception event to turn off the lights in the office area for an upcoming holiday.
When the schedule reads the exception event as Inactive, the lights remain off for
the duration of the exception event.
For more information, see the Adding a Date Exception Event topic on WebHelp.

80.1.2

Schedule Types
In a building automation system, you can create schedules specifically geared for
Building Operation servers, hosted devices, and hosted devices that support
BACnet Prerevision 4 schedules.
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80.1.3

Schedule and Supported Data Type for
Binding
Each BACnet schedule corresponds to a supported data type. You choose a
BACnet schedule based on the data type of the property that you want to bind.
For more information, see section 80.2 “Schedule and Supported Data Type for
Binding” on page 2937.

80.1.4

Schedule and Loop Priority for Writing
Property
In a building automation system, schedules may interact with multiple BACnet
objects that have commandable value properties and, in most cases, act
independently of BACnet services. To fine tune the automation, BACnet schedules
include a Priority for writing property that defines the priorities of the commandable
values for the BACnet objects under their control. Similarly, a BACnet Loop
program includes a Priority for writing property that defines the appropriate priority
of the program in relation to the commandable value.
For more information, see section 77.9 “Schedule and Loop Priority for Writing
Property” on page 2859.
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80.2

Schedule and Supported Data Type for
Binding
Each BACnet schedule corresponds to a supported data type. You choose a
BACnet schedule based on the data type of the property that you want to bind.

Figure: Data type (source) binds to a BACnet schedule (destination)

80.2.1

Supported Data Types for BACnet Schedules
The following table lists the BACnet schedule types that correspond to the
supported data types.
Table: BACnet Schedule and Supported Data Type for Binding

80.2.2

Schedule Type

Data Types

BACnet Analog Schedule

Analog Value or Output

BACnet Digital Schedule

Digital Value or Output

BACnet Enumerated Schedule

Digital Value or Output

BACnet Multistate Schedule

Multistate Value or Output

BACnet Integer Schedule

Analog Value

BACnet Boolean Schedule

Enable (Trend Log) or Out of Service (Points)

Binding Examples
BACnet schedule types vary according to the device or server where they are
installed. For example, Prerevision 4 Schedules only display as an option in the
Schedule Create Object Wizard for hosted devices.

Hosted devices
The following table lists the supported BACnet data types and the schedule type
that you can select when creating a schedule in a hosted device.
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Table: Hosted Device Schedule Binding Examples
Schedule Data Type
Property

Schedule Type

Example

Boolean

BACnet Boolean Schedule

The scheduled Out of service
property of an analog output
is set to the Boolean value,
True or False.

Enumerateda

BACnet Enumerated
Schedule

The scheduled Value
property of a digital output is
set to the enumerated value,
Active or Inactive.

Integer

BACnet Integer Schedule

The scheduled UTC offset
property of a device is set to
an integer, such as -780 or
780.

Real

BACnet Analog Schedule

The scheduled Value
property of an analog output
is set to a real number, such
as 55, -10, 62.5.

Unsigned

BACnet Multistate Schedule

The scheduled Value
property of a multistate
output is set to an unsigned
number, such as 1, 2, or 3.

a

Includes the specific enumerated data type, BACnetBinaryPV

Building Operation servers
The following table lists the supported BACnet data types and corresponding
schedule type property that you can select when creating a schedule in an
Automation Server or Enterprise Server.
Table: Building Operation Server Binding Examples
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Schedule Data Type
Property

Schedule Type

Example

BACnetBinaryPV

BACnet Digital Schedule

The scheduled Value
property of a digital output is
set to the enumerated value,
Active or Inactive.

Boolean

BACnet Boolean Schedule

The scheduled Out of service
property of an analog output
is set to the Boolean value,
True or False.

Enumerated

BACnet Enumerated
Schedule

Any property of an
enumerated data type, but is
not the specific enumerated
data type of
BACnetBinaryPV.
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Continued
Schedule Data Type
Property

Schedule Type

Example

Integer

BACnet Integer Schedule

The scheduled UTC offset
property of a device is set to
an integer, such as -780 or
780.

Real

BACnet Analog Schedule

The scheduled Value
property of an analog output
is set to a real number, such
as 55, -10, 62.5.

Unsigned

BACnet Multistate Schedule

The scheduled Value
property of a multistate
output is set to an unsigned
number, such as 1, 2, or 3.

Hosted device Prerevision 4 schedules
The following table lists the supported BACnet data types and the schedule type
that you can select when creating a Prerevision 4 schedule in a hosted device.
Table: Hosted Device Prerevision 4 Schedule Binding Examples
Schedule Data Type
Property

Schedule Type

Example

Boolean

BACnet Boolean Schedule

The scheduled Out of service
property of an analog output
is set to the Boolean value,
True or False.

Enumerateda

BACnet Enumerated
Schedule

The scheduled Value
property of a digital output is
set to the enumerated value,
Active or Inactive.

Integer

BACnet Integer Schedule

The scheduled UTC offset
property of a device is set to
an integer, such as -780 or
780.

Real

BACnet Real Schedule

The scheduled Value
property of an analog output
is set to a real number, such
as 55 or -10, 62.5.

Unsigned

BACnet Unsigned Schedule

The scheduled Value
property of a multistate
output is set to an unsigned
number, such as 1, 2, or 3.

a
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80.3

Creating a BACnet Calendar
You create a BACnet calendar so you can then use the calendar with a BACnet
exception schedule.

To create a BACnet calendar
1. In WorkStation, in the System Tree pane, expand BACnet Interface and
then select Application.
2. On the File menu, point to New and then click Schedule.
3. In the object type list, select BACnet Calendar.

4. In the Name box, type a name for the calendar.
5. In the Description box, type a description for the calendar.
Continued on next page
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6. Click Next.

7. In the Instance ID box, choose one of the following options:
• Click Automatically generated to have the server generate a BACnet
instance ID for you.
• Click Manually entered if you want to type an Instance ID.
8. In the BACnet name box, type a BACnet name for the calendar.
Do not type a name if you want a name to be assigned for you.
9. Click Create.
You can now configure the BACnet calendar.
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80.4

Creating a BACnet Calendar (Generic)
You create a BACnet calendar (generic) so you can use the calendar with a BACnet
exception schedule in an external BACnet device. When you create the BACnet
calendar (generic), you need to perform one of the following operations:
• Download to a device to create a calendar in an external BACnet device.
• Upload from a device to upload the properties of a calendar from a BACnet
device into Building Operation.

To create a BACnet calendar (generic)
1. In WorkStation, in the System Tree pane, expand BACnet Interface,
expand the network where the device resides, then expand the device.
2. Select Application.
3. On the File menu, point to New and then click Schedule.
4. In the object type list, select BACnet Calendar.

5. In the Name box, type a name for the calendar.
6. In the Description box, type a description for the calendar.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated.
Once created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the calendar.
Do not type a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. Click Create.
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80.5

Configuring a BACnet Calendar
You configure the BACnet calendar to delete outdated events or select the lead
object if you are creating a shadow of a lead calendar. Lead and shadow calendars
are not supported for calendar objects (generic).

To configure a BACnet calendar
1. In WorkStation, in the System Tree pane, expand BACnet Interface and
then select Application.
2. Expand the folder where the calendar resides.
If you are configuring a BACnet calendar (generic), it resides in the
Application folder of a device. If you are configuring a BACnet calendar on
the server, the calendar resides in the Application folder of the BACnet
Interface.
3. In the List View, select the calendar that you want to configure.
4. On the File menu, click Properties.
5. Click the Basic tab.

6. In the Remove past events box, select True to enable the system to
remove calendar events that are older than 60 days.
7. In the Lead object box, enter a lead object if the calendar you are creating is
meant to be a shadow (and copy) of that lead calendar.
Lead object is not an option if you are configuring a calendar object
(generic).
8. Click OK.
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80.6

Creating a BACnet Schedule
You create a BACnet schedule so you can then configure the BACnet schedule to
schedule an event. Scheduled events control writable properties, such as a Value
property, in an object. Before you create a schedule, you need to know the type of
writable property that you want to schedule. Then, you can select the appropriate
type of schedule.

To create a BACnet schedule
1. In WorkStation, in the System Tree pane, expand BACnet Interface and
then select Application.
2. On the File menu, point to New and then click Schedule.
3. In the object type list, select the type of schedule that matches the type of
property you want to schedule. For example, if you want to schedule the
Value property of an analog output, select BACnet Analog Schedule.

4. In the Name box, type a name for the schedule.
5. In the Description box, type a description for the schedule.
Continued on next page
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6. Click Next.

7. In the Instance ID box, click Automatically generated to have the server
generate a BACnet instance ID for you. Click Manually entered if you want
and then enter an Instance ID yourself.
8. In the BACnet name box, type a BACnet name for the schedule. Do not type
a name if you want a name to be assigned for you.
9. In the Priority for writing box, enter a priority at which the referenced
properties are commanded. Values here can range from 1-16 with 1 as the
highest priority and 16 as the lowest.
10. Click Create.
You can now configure the BACnet schedule.
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80.7

Creating a BACnet Schedule (Generic)
You create a BACnet schedule (generic) when you want to use a BACnet schedule
with an external BACnet device from WorkStation. When you create the BACnet
schedule (generic), you need to perform one of the following operations:
• Download to a device to create a schedule in an external BACnet device.
• Upload from a device to upload the properties of a schedule from a BACnet
device into Building Operation.

To create a BACnet schedule (generic)
1. In WorkStation, in the System Tree pane, expand BACnet Interface,
expand the network where the device resides, then expand the device.
2. Select Application.
3. On the File menu, point to New and then click Schedule.
4. In the object type list, select the type of schedule that matches the type of
property that you want to schedule. For example, if you want to schedule the
Value property of an analog output, select BACnet Analog Schedule
(Generic).

5. In the Name box, type a name for the schedule.
6. In the Description box, type a description for the schedule.
Continued on next page
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7. Click Next.

8. Click Download to BACnet device and then manually enter an Instance ID
now if you want. Otherwise, click to have the ID automatically generated. Once
created, be aware that you cannot change the object’s Instance ID.
9. In the BACnet name box, type a BACnet name for the schedule. Do not type
a name if you want a name to be assigned for you.
10. Click Upload from BACnet device if you want to upload the properties of
the point from the BACnet device into Building Operation.
11. In the Priority for writing box, enter a priority at which the referenced
properties are commanded. Values here range from 1-16 with 1 as the highest
priority and 16 as the lowest.
12. Click Create.
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80.8

Configuring a BACnet Schedule
You configure a BACnet schedule when you want to control a writable property,
such as a Value, using the schedule.

To configure a BACnet schedule
1. In WorkStation, in the System Tree pane, expand BACnet Interface and
then select Application.
2. In List View, select the schedule that you want to configure.
3. On the File menu, click Properties.
Continued on next page
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4. Click the Basic tab.

5. In the Lead object box, select a lead schedule if you are creating a shadow
schedule.
You can stop here if you are creating a shadow schedule since the shadow
schedule obtains its configuration settings from the lead schedule. You cannot
create a shadow schedule for a schedule (generic).
6. In the Remove past events box, select True to enable the system to delete
BACnet special events older than 72 hours.
7. In the Effective period box, enter the date/time range that a schedule is in
service.
Continued on next page
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8. In the Priority for writing box, enter a priority at which the referenced
properties are commanded. Values here range from 1-16, with 1 as the
highest priority and 16 as the lowest.
9. Click

to add a new object property reference controlled by the schedule.

10. In the Add reference dialog, select the path for the object property
reference as follows:
• System reference: Select this to define a path to a property or object
reference located on the server (including Generic objects, if available).
When selected, only the Path field becomes editable. All the other fields
become non-editable.
• BACnet reference: Select this to define a path to a property or object
reference located anywhere on the network. When selected, the Device
instance number, Object type, and Object instance number fields
become editable and the Path field becomes non-editable.
• Path: Select the path to the reference on the file system.
• Device instance number: Type the device number associated with the
device.
• Object type: Select the object class of an object, such as analog input.
• Object instance number: Type the object instance number associated
with the referenced object.
• Property: Enter the property identifier associated with the reference.
The system automatically fills in the device instance number, object type, and
object instance number fields for either reference path, where available.
11. In the Object property references box, select the reference and then click
to edit its properties.
12. Click

to delete the object property reference.

13. In the Default Value box, enter the value to be controlled by the schedule
when no other value is prevailing.
14. On the toolbar, click the Save button
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80.9

Configuring a Time Value Pair for a
Schedule
You configure a time value pair to modify weekly or exception events in a Building
Operation schedule or BACnet schedule.
For more information, see the Advanced View of the Schedule Editor topic on
WebHelp.

To configure a time value pair for a schedule
1. In WorkStation, in the System Tree pane, select the schedule that you want
to modify.
2. Click the Advanced tab of the editor.
3. Expand the Exceptions or Weekly folder.
4. Right click on the time period that you want to modify and click Properties.

5. Modify the properties.
Component

Description

Value

Select the value associated with the event.

Start Time

Select the hour, minutes, and seconds for the start time.

No End Time

Select to have the event last all day.

End Time

Select the hour, minutes, and seconds for the end time.

6. Click OK.
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80.10

Binding an Object Property to a BACnet
Schedule
You bind an object property to a BACnet schedule so that the schedule can control
one or more writeabe properties, such as values or outputs.
For more information, see section 80.1 “BACnet Schedules” on page 2935.

To bind an object property to a BACnet schedule
1. In WorkStation, in the System Tree pane, expand BACnet Interface.
2. Expand the Application folder where the schedule is located.
3. Select a BACnet schedule.
4. On the Actions menu, click Edit bindings.
5. In the Browser pane, select the BACnet object that you want to bind.

6. In the Binding point column, drag the BACnet object to the Object
property references box to create the binding.
7. Click the Save button
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80.11

Modifying a Schedule Using the Text
View
Use the Text View of the Advanced Schedule editor to edit specific time sequences
and break down a time value into hundredths of a second.
For more information, see the Advanced View of the Schedule Editor topic on
WebHelp.

To modify a schedule using the Text View
1. Select a schedule in the System Tree pane.
2. Click the Advanced tab of the Schedule Editor.

3. In the Schedule Event Tree, complete one of the following tasks:
• To modify an exception, expand the Exceptions folder and Priority x
folder. Then, select an exception.
• To modify a day, expand the Weekly folder and select a day.
4. Click the Text View button

.

5. Right-click on the time period that you want to modify and click Properties.
Continued on next page
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6. Edit the properties.
Component

Description

Hour

Enter the hour when you want the Object property reference
set to Value. Use the time format that matches your Windows
regional settings.
Select Any hour if you want the Object property reference
set to Value at all times.

Minute

Enter a number to set the time for Value to be written to the
property reference.

Second

Enter a number to set the time for Value to be written to the
property reference.

Hundredths

Enter a number to set the time for Value to be written to the
property reference.

Value

Enter a value to write to the property reference at the scheduled
time, such as True.

7. Click OK.
8. Click the Save button
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80.12

Modifying a Schedule Using the Graphic
View
Use the Graphic View of the Advanced Schedule editor to edit the properties of an
exception or weekly event.
For more information, see the Advanced View of the Schedule Editor topic on
WebHelp.

To modify a schedule using the Graphic View
1. Select a schedule in the System Tree pane.
2. Click the Advanced tab of the Schedule Editor.

3. In the Schedule Event Tree, choose one of the following tasks:
• To modify an exception, expand the Exceptions folder and Priority x
folder. Then, select an exception.
• To modify a day, expand the Weekly folder and select a day.
4. Click the Graphic View button

.

5. Right-click on the time period that you want to modify and click Properties.
6. Edit the properties.
Component

Description

Value

Select the value associated with the event.

Start Time

Select the hour, minutes, and seconds for the start time.

No End Time

Select to have the event last all day.

End Time

Select the hour, minutes, and seconds for the end time.

7. Click OK.
8. Click the Save button
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Topics
BACnet System Tree Icons
Interface Manager for BACnet – Basic Tab
BACnet Interface for an Automation Server – Basic Tab
BACnet Interface for an Automation Server – Advanced Tab
BACnet Interface for an Enterprise Server – Basic Tab
BACnet Interface for an Enterprise Server – Advanced Tab
BACnet Interface – Time Synchronization Recipients Tab
BACnet Time Synchronization Recipient Dialog Box
BACnet Device Properties – Basic Tab
BACnet Device Properties – Advanced Tab
BACnet Device – Time Synchronization Recipients Tab
BACnet Device – Device Address Bindings Tab
BACnet Device – Alarm Summary Tab
BACnet Device – Enrollment Summary Tab
BACnet Device – Event Information Tab
BACnet String Properties (Generic) – Basic Tab
BACnet String Properties (Generic) – Advanced Tab
BACnet Gateway Properties – Basic Tab
BACnet Diagnostics Properties – Basic Tab
BACnet Diagnostics Object Properties – Basic Tab

Specialized BACnet Device Properties – Basic Tab
Specialized BACnet Device Properties – Advanced Tab
Automation Server or Enterprise Server Hardware Folder –
Basic Tab
I/A Series (MNB) BACnet Device Properties – Basic Tab
I/A Series (MNB) BACnet Device Properties – Advanced
Tab
BBMD Properties – Basic Tab
BBMD BDT Entry Properties – Basic Tab
BACnet Learn BDT Table Dialog Box
BBMD Foreign Device Table Tab
BACnet IP Network Properties – Basic Tab
BACnet MS/TP Network Properties – Basic Tab
BACnet Network Properties – Basic Tab
Application Folder of a BACnet Interface
Application Folder of a BACnet Device
Application Folder of an I/A Series (MNB) BACnet Device
BACnet Unconfigured Devices Folder Properties – Basic
Tab
BACnet Unsolicited Alarms – Basic Tab
BACnet Analog Input Properties – Basic Tab
BACnet Analog Input Properties – Advanced Tab
BACnet Analog Output Properties – Basic Tab
BACnet Analog Output Properties – Advanced Tab
BACnet Analog Output Properties – Command Tab
BACnet Analog Value Properties – Basic Tab
BACnet Analog Value Properties – Advanced Tab
BACnet Analog Value Properties – Command Tab
BACnet Digital Input Properties – Basic Tab
BACnet Digital Input Properties – Advanced Tab

BACnet Digital Output Properties – Basic Tab
BACnet Digital Output Properties – Advanced Tab
BACnet Digital Output Properties – Command Tab
BACnet Digital Value Properties – Basic Tab
BACnet Digital Value Properties – Advanced Tab
BACnet Digital Value Properties – Command Tab
BACnet Multistate Input Properties – Basic Tab
BACnet Multistate Input Properties – Advanced Tab
BACnet Multistate Output Properties – Basic Tab
BACnet Multistate Output Properties – Advanced Tab
BACnet Multistate Output Properties – Command Tab
BACnet Multistate Value Properties – Basic Tab
BACnet Multistate Value Properties – Advanced Tab
BACnet Multistate Value Properties – Command Tab
BACnet Multistate Alarm Properties Dialog Box
BACnet Multistate Objects – State Configuration Tab
BACnet Analog Input Properties (Generic) – Basic Tab
BACnet Analog Input Properties (Generic) – Advanced Tab
BACnet Analog Output Properties (Generic) – Basic Tab
BACnet Analog Output Properties (Generic) – Advanced Tab
BACnet Analog Output Properties (Generic) – Command Tab
BACnet Analog Value Properties (Generic) – Basic Tab
BACnet Analog Value Properties (Generic) – Advanced Tab
BACnet Analog Value Properties (Generic) – Command Tab
BACnet Digital Input Properties (Generic) – Basic Tab
BACnet Digital Input Properties (Generic) – Advanced Tab
BACnet Digital Output Properties (Generic) – Basic Tab
BACnet Digital Output Properties (Generic) – Advanced Tab
BACnet Digital Output Properties (Generic) – Command Tab

BACnet Digital Value Properties (Generic) – Basic Tab
BACnet Digital Value Properties (Generic) – Advanced Tab
BACnet Digital Value Properties (Generic) – Command Tab
BACnet Multistate Input Properties (Generic) – Basic Tab
BACnet Multistate Input Properties (Generic) – Advanced Tab
BACnet Multistate Output Properties (Generic) – Basic Tab
BACnet Multistate Output Properties (Generic) – Advanced Tab
BACnet Multistate Output Properties (Generic) – Command Tab
BACnet Multistate Value Properties (Generic) – Basic Tab
BACnet Multistate Value Properties (Generic) – Advanced Tab
BACnet Multistate Value Properties (Generic) – Command Tab
BACnet Accumulator Properties (Generic) – Basic Tab
BACnet Accumulator Properties (Generic) – Advanced Tab
BACnet Averaging Properties (Generic) – Basic Tab
BACnet Averaging Properties (Generic) – Advanced Tab
BACnet Command Properties (Generic) – Basic Tab
BACnet Command Properties (Generic) – Advanced Tab
BACnet Load Control Properties (Generic) – Basic Tab
BACnet Load Control Properties (Generic) – Advanced Tab
BACnet Pulse Converter Properties (Generic) – Basic Tab
BACnet Pulse Converter Properties (Generic) – Advanced Tab
BACnet Notification Properties – Basic Tab
BACnet Notification Properties – Advanced Tab
BACnet Notification Properties (Generic) – Basic Tab
BACnet Notification Properties (Generic) – Advanced Tab
BACnet Notification – Basic Settings Tab
BACnet Notification – Presentation Tab
BACnet Notification – User Action Tab
BACnet Notification – Attachment Tab

BACnet Notification – Device Recipient Rules Tab
BACnet Notification – Device Recipient Rule Dialog Box
BACnet Alarm Properties – Basic Tab
BACnet Alarm Properties – Advanced Tab
BACnet Alarm Properties (Generic) – Basic Tab
BACnet Alarm Properties (Generic) – Advanced Tab
BACnet Buffer Ready Alarm – Alarm Trigger Tab
BACnet Change of State Alarm – Alarm Trigger Tab
BACnet Change of Value Alarm – Alarm Trigger Tab
BACnet Floating Limit Alarm – Alarm Trigger Tab
BACnet Out of Range Alarm – Alarm Trigger Tab
BACnet Calendar Properties – Basic Tab
BACnet Calendar Properties – Advanced Tab
BACnet Calendar Properties (Generic) – Basic Tab
BACnet Calendar Properties (Generic) – Advanced Tab
BACnet Schedule Properties – Basic Tab
BACnet Schedule Properties – Advanced Tab
BACnet Schedule Properties (Generic) – Basic Tab
BACnet Schedule Properties (Generic) – Advanced Tab
Add Reference Dialog Box
BACnet Prerevision 4 Schedule Properties – Basic Tab
BACnet Prerevision 4 Schedule Properties – Advanced Tab
BACnet Prerevision 4 Schedule Properties – Configuration Tab
BACnet Prerevision 4 Schedule Properties - Weekly Schedule
BACnet Prerevision 4 Schedule Properties - Active Inactive Time
Value Pair
BACnet Prerevision 4 Schedule Properties - Boolean Time Value
Pair
BACnet Prerevision 4 Schedule Properties - Enumerated Time
Value Pair

BACnet Prerevision 4 Schedule Properties - Integer Time Value
Pair
BACnet Prerevision 4 Schedule Properties - On Off Time Value
Pair
BACnet Prerevision 4 Schedule Properties - Real Time Value
Pair
BACnet Prerevision 4 Schedule Properties - Unsigned Time
Value Pair
BACnet Prerevision 4 Schedule Properties - Exception Event
BACnet Exception Event Wizard – Naming the Object Page
BACnet Trend Log Properties – Basic Tab
BACnet Trend Log Properties – Advanced Tab
BACnet Trend Log Properties (Generic) – Basic Tab
BACnet Trend Log Properties (Generic) – Advanced Tab
BACnet File Object – Basic Tab
BACnet File Object – Advanced Tab
BACnet File Properties (Generic) – Basic Tab
BACnet File Properties (Generic) – Advanced Tab
BACnet Program Properties (Generic) – Basic Tab
BACnet Program Properties (Generic) – Advanced Tab
BACnet Loop Properties – Basic Tab
BACnet Loop Properties – Advanced Tab
BACnet Loop Properties (Generic) – Basic Tab
BACnet Loop Properties (Generic) – Advanced Tab
Unresolved Device Properties – Basic Tab
Unresolved Device Properties – Advanced Tab
Unsupported Object Properties – Basic Tab
Unsupported Object Properties – Advanced Tab
Actions Menu – Device Communication Control Submenu
Actions Menu – Device Submenu – Restart Submenu

Actions Menu – Device Submenu – Time Sync Submenu
Actions Menu – Device Submenu – Communication Submenu
BACnet Associate with Device Dialog Box
BACnet Device Communication Dialog Box
BACnet Password Dialog Box
Create Object Wizard – BACnet Basic Settings Page
Create Object Wizard – IP Network Basic Settings Page
Create Object Wizard – BACnet Network BACnet Basic Settings
Page
BACnet Create Object Wizard – BACnet Basic Settings Page
BACnet Create Object (Generic) Wizard – BACnet Basic Settings
Page
BACnet Create Device Wizard – BACnet Basic Settings Page
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81.1

BACnet System Tree Icons
This table describes the BACnet System Tree icons.
Table: BACnet System Tree Icons
Icon

Description
BACnet Global Settings
Indicates the BACnet Interface Manager where the priority levels for the server
are viewed and configured. For more information, see section 81.2 “Interface
Manager for BACnet – Basic Tab” on page 2967.
BACnet Interface
Indicates a BACnet Interface for an Automation Server or Enterprise Server. For
more information, see section 73.2 “BACnet Interface” on page 2554.
Application
Indicates a BACnet application folder of a BACnet device or interface.
IP Network
Indicates an IP network. For more information, see section 74.1 “BACnet
Networks” on page 2573.
MS/TP Network
Indicates an MS/TP network. For more information, see section 74.1 “BACnet
Networks” on page 2573.
BACnet Network
Indicates a BACnet Network that is not directly connected to the local server. For
more information, see section 74.1 “BACnet Networks” on page 2573.
IO Bus
Indicates the IO bus on an Automation Server. For more information, see the I/O
Bus Elements topic on WebHelp.
BBMD
Indicates a BACnet Broadcast Management Device. For more information, see
section 81.27 “BBMD BDT Entry Properties – Basic Tab” on page 3005.
Unconfigured Devices Folder
Indicates the Unconfigured Devices folder for an Automation Server or Enterprise
Server.
Diagnostics Folder
Indicates a BACnet Diagnostics folder for an Automation Server or Enterprise
Server. For more information, see section 161.1 “System Performance
Diagnostics” on page 5637.
BACnet Device
Indicates a BACnet device.
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Icon

Description
Download required
Indicates that the contents of a BACnet device in a Building Operation server
need to be downloaded to the physical BACnet device. For more information,
see section 78.1 “BACnet Download and Upload” on page 2863.
Upload required
Indicates that the contents of a physical BACnet device need to be uploaded to
the database of an Automation Server or Enterprise Server. For more information,
see section 78.1 “BACnet Download and Upload” on page 2863.
Unresolved reference
Indicates that a path for a BACnet reference was not found yet.
BACnet Trend Log
Indicates a BACnet trend log.
BACnet Alarm
Indicates a BACnet alarm. For more information, see section 76.2 “Supported
BACnet Object Types” on page 2665.
BACnet Averaging Program
Indicates a BACnet averaging program.
BACnet Load Control Program
Indicates a BACnet load control program.
BACnet Loop
Indicates a BACnet loop.
BACnet Schedule
Indicates a BACnet schedule. For more information, see section 76.2 “Supported
BACnet Object Types” on page 2665.
BACnet Program
Indicates a BACnet program.
BACnet Gateway
Indicates a BACnet gateway that bridges the primary BACnet network to nonstandard networks. For more information, see section 74.15 “BACnet Gateway”
on page 2598.
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81.2

Interface Manager for BACnet – Basic
Tab
Use the Interface Manager to view the priority levels based on the BACnet standard.
You can also enter a default priority or force priority level on a lead server for the
BACnet system.

Figure: Basic tab

Table: Basic Tab
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Priority Level

Application

Priority 1

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 2

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 3

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 4

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.
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Priority Level

Application

Priority 5

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority 7

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 8

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 9

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 10

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 11

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 12

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 13

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 14

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 15

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Priority 16

View the value at this priority in the Command tab of a BACnet
Analog, Digital, or Multistate output or value.

Default priority
level

Enter a global default priority level for the lead server in the
BACnet system. Any saved changes to the default priority level
take effect immediately for the entire system. For more
information, see section 77.1 “BACnet Command Priorities” on
page 2849.

Force priority level

Enter a priority level for forced values for the lead server in the
BACnet system. This priority level should only be set once during
the initial system configuration. It is not recommended that you
change this setting after the system goes online.
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81.3

BACnet Interface for an Automation
Server – Basic Tab
Use the Basic tab to view and configure the basic properties of the BACnet
Interface for an Automation Server.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Status

Displays True when the Building Operation server is available
on the BACnet IP network.

System status

Displays operational when the BACnet device is operating
correctly.

Device
communication
control

Displays Enable when the local BACnet device on the server is
enabled for communication.

Backup and restore
state

Displays the current state of the backup or restore process,
such as Idle or Preparing for backup.
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Property

Description

Database revision

Displays the current revision of the database in the local
BACnet device on the server.

Local time

Displays the date and time of the device.

Daylight savings

Displays True if daylight savings time has been calculated in
the time.

UTC offset

Displays the difference in minutes between the local standard
time and Universal Coordinated Time.

Last restore time

Displays the time of the last restore on the server using BACnet
backup and restore methods.

Backup failure
timeout (s)

Enter the number of seconds of inactivity before the backup
terminates in case a failure occurs in the external workstation.

Backup preparation
time (s)

Enter the number of seconds that the server needs to prepare
the database for backup by an external workstation in the
BACnet system. Increase the time for large databases requiring
longer completion time.

Restore preparation
time (s)

Enter the number of seconds needed to prepare the device
before a restore by an external workstation in the BACnet
system.

Restore completion
time (s)

Enter the number of seconds needed to reboot the server and
load the database after a restore by an external workstation in
the BACnet system. Increase the time for large databases
requiring longer completion time.

Auto-discover subnetworks

Select Yes if you want subnetworks to be included in the
automatic sub-network discovery of the server's network.

For more information, see section 73.2 “BACnet Interface” on page 2554.
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81.4

BACnet Interface for an Automation
Server – Advanced Tab
Use the Advanced tab to view and configure the advanced properties of the
BACnet Interface for an Automation Server.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

Type a new name to change the BACnet name.

BACnet type

Displays the type, which is always device.

Model name

Displays the model name of the BACnet device.

Vendor name

Displays the manufacturer of the BACnet device.
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Property

Description

Vendor identifier

Displays the number that identifies the vendor of the BACnet
device.

Application
software version

Displays the current version of the application software that is
installed on the device.

Firmware revision

Displays the firmware version that is installed on the device.

Location

Displays only if the device supports the property. Type a
description of the location of the device, for example, Building A.

Profile name

Displays the BACnet profile name of the device.

APDU segment
timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message segment.

APDU timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message.

Number of APDU
retries

Enter the maximum number of times that an unanswered
message can be retransmitted.

Serial Number

Displays the serial number of the device.

Maximum segments Displays the maximum number of message segments that can be
accepted
received by the device.
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Segmentation
supported

Displays whether the BACnet device supports segmentation of
messages and if so, whether it supports segmented
transmissions, receptions, or both.

Protocol version

Displays the BACnet protocol version that the device supports.

Protocol revision

Displays the minor revision number of the BACnet protocol that
the device supports.

Services supported

Displays the BACnet services that the device supports.

Object types
supported

Displays the BACnet object types that the device supports.

Minimum polling
interval for local IP
network (ms)

Enter the number of milliseconds for the minimum polling interval
in all the IP networks installed on the server, for example, 1000 (1
second).

Minimum polling
interval for remote
networks (ms)

Enter the number of milliseconds for the minimum polling interval
in an installed remote BACnet network, for example, 1000.

Minimum polling
interface for
MSTPA (ms)

On the Automation Server, enter the number of milliseconds for
the minimum polling interval in an installed MS/TP COMA network,
for example, 1000.

Minimum polling
interface for
MSTPB (ms)

On the Automation Server, enter the number of milliseconds for
the minimum polling interval in an installed MS/TP COMB network,
for example, 1000.
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81.5

BACnet Interface for an Enterprise
Server – Basic Tab
Use the Basic tab to view and configure the basic properties of the BACnet
Interface for an Enterprise Server.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Status

Displays True when the Building Operation server is available
on the BACnet IP network.

System status

Displays operational when the BACnet device is operating
correctly.

Device
communication
control

Displays Enable when the local BACnet device on the server is
enabled for communication.

Backup and restore
state

Displays the current state of the backup or restore process,
such as Idle or Preparing for backup.
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Property

Description

Database revision

Displays the current revision of the database in the local
BACnet device on the server.

Local time

Displays the date and time of the device.

Daylight savings

Displays True if daylight savings time has been calculated in
the time.

UTC offset

Displays the difference in minutes between the local standard
time and Universal Coordinated Time.

Last restore time

Displays the time of the last restore on the server using BACnet
backup and restore methods.

Backup failure
timeout (s)

Enter the number of seconds of inactivity before the backup
terminates in case a failure occurs in the external workstation.

Backup preparation
time (s)

Enter the number of seconds that the server needs to prepare
the database for backup by an external workstation in the
BACnet system. Increase the time for large databases requiring
longer completion time.

Restore preparation
time (s)

Enter the number of seconds needed to prepare the device
before a restore by an external workstation in the BACnet
system.

Restore completion
time (s)

Enter the number of seconds needed to reboot the server and
load the database after a restore by an external workstation in
the BACnet system. Increase the time for large databases
requiring longer completion time.

Auto-discover subnetworks

Select Yes if you want subnetworks to be included in the
automatic sub-network discovery of the server's network.

For more information, see section 73.2 “BACnet Interface” on page 2554.
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81.6

BACnet Interface for an Enterprise
Server – Advanced Tab
Use the Advanced tab to view or configure the advanced properties of the BACnet
Interface for an Enterprise Server.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

Type a new name to change the BACnet name.

BACnet type

Displays the type, which is always device.

Model name

Displays the model name of the BACnet device.

Vendor name

Displays the manufacturer of the BACnet device.
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Property

Description

Vendor identifier

Displays the number that identifies the vendor of the BACnet
device.

Application
software version

Displays the current version of the application software that is
installed on the device.

Firmware revision

Displays the firmware version that is installed on the device.

Location

Displays only if the device supports the property. Type a
description of the location of the device, for example, Building A.

Profile name

Displays the BACnet profile name of the device.

APDU segment
timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message segment.

APDU timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message.

Number of APDU
retries

Enter the maximum number of times that an unanswered
message can be retransmitted.

Serial Number

Displays the serial number of the device.

Maximum segments Displays the maximum number of message segments that can be
accepted
received by the device.
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Segmentation
supported

Displays whether the BACnet device supports segmentation of
messages and if so, whether it supports segmented
transmissions, receptions, or both.

Protocol version

Displays the BACnet protocol version that the device supports.

Protocol revision

Displays the minor revision number of the BACnet protocol that
the device supports.

Services supported

Displays the BACnet services that the device supports.

Object types
supported

Displays the BACnet object types that the device supports.

Minimum polling
interval for local IP
network (ms)

Enter the number of milliseconds for the minimum polling interval
in all the IP networks installed on the server, for example, 1000 (1
second).

Minimum polling
interval for remote
networks (ms)

Enter the number of milliseconds for the minimum polling interval
in an installed remote BACnet network, for example, 1000.
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81.7

BACnet Interface – Time
Synchronization Recipients Tab
Use the Time Synchronization Recipients tab in the BACnet Interface to
specify a BACnet device, or network of BACnet devices, that you want to
synchronize to the local server time. Third-party devices, or BACnet devices and
networks located in different time zones, may require UTC synchronization. Acting
as a master time controller, the BACnet Interface sends Time Sync messages to
devices and networks added to one of the following recipient lists:
• Use local time to configure BACnet devices and networks located in the same
time zone as the local server, which avoids the need for periodic clock resets,
such as Daylight Savings.
• Use UTC to configure BACnet devices and networks located in different time
zones, or BACnet devices that do not have local time synchronization services.

Figure: Time Synchronization Recipients tab

Table: Time Synchronization Recipients Tab
Property

Description

Time sync
MSTP
networks

Select True if the server supports an MS/TP network. The system
automatically adds an MS/TP network to the Local time
synchronization recipients list, but does not include the network as
an item in the list.
Add Time Synch Device Recipient
Click to add a device recipient that you want to receive time updates
based on the local or UTC time of the server. For more information, see
section 75.11 “Editing a Device Recipient” on page 2621.
For Building Operation devices, such as b3s or bCXs, add the device to
either the Local time or UTC time recipients list, but not both.
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Property

Description
Edit Time Synch Device Recipient
Click to edit the time synchronization properties of a device recipient. For
more information, see section 81.8 “BACnet Time Synchronization
Recipient Dialog Box” on page 2979.
Delete Time Synch Device Recipient
Click to remove the time synchronization recipient from the list.
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81.8

BACnet Time Synchronization Recipient
Dialog Box
Use the Time Synchronization Recipient dialog box to configure recipients by
reference, device ID, or network address.

Figure: Time synchronization recipient dialog box

Table: Time Synchronization Recipient Dialog Box
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Property

Description

Reference

Click to identify the device recipient by referencing the device.

Device ID

Click to identify the device recipient by the instance number of the
BACnet device.

MAC address

Click to identify the device recipient by the network of the device. Use a
MAC and network address when you want to identify objects not
included in the Building Operation database.

Recipient
device object
reference

Enter the reference to a BACnet device.

Recipient
device
identifier

Enter the BACnet instance number of the device.
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Property

Description

Network ID

Choose one of the following options:
• Type a specific Network ID number.
• Select Global broadcast to send messages to all networks in the
BACnet system.
• Select Local Network to send a message to a device on a directly
connected network (IP or MS/TP).
Local Network, the initial IP network created by the BACnet Interface
wizard, has a network ID of zero (0). Any additional installed IP network
must have a distinct ID number in the BACnet network.
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MS/TP

Enter a number between 0 and 254 for the MS/TP address of the device
recipient on the network.

IP

Enter the IP address and port number for the IP address of the device
recipient.

Raw
(hexadecimal)

Enter the hexadecimal address for the device recipient.

Broadcast

Click to send the message to all devices on the network.
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81.9

BACnet Device Properties – Basic Tab
Use the Basic tab to view or configure the properties of a BACnet device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

System status

Displays operational when the BACnet device is operating
correctly.

Database revision

Displays the current revision of the database.

Status

Displays True when the Building Operation server is available on
the BACnet IP network.

Device changed

Displays True when objects are created, renamed, or deleted in
the device.

Local time

Displays the date and time of the device.

Daylight savings

Select True to set the device's clock to calculate the local
standard time.

UTC offset (min)

Enter the number of minutes difference between the local time
and Universal Coordinated Time.
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81.10

BACnet Device Properties – Advanced
Tab
Use the Advanced tab to view or configure the properties of a BACnet device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

Type a new name to change the BACnet name.

BACnet type

Displays the type, which is always device.

Model name

Displays the model name of the BACnet device.

Vendor name

Displays the manufacturer of the BACnet device.

Vendor identifier

Displays the number that identifies the vendor of the BACnet
device.
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Property

Description

MAC address

Displays the MAC address of the device in hexadecimal.

Application
software version

Displays the current version of the application software that is
installed on the device.

Firmware revision

Displays the firmware version that is installed on the device.

Location

Displays only if the device supports the property. Type a
description of the location of the device, for example, Building A.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

APDU segment
timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message segment.

APDU timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message.

Number of APDU
retries

Enter the maximum number of times that an unanswered
message can be retransmitted.

Maximum segments Displays the maximum number of message segments that can be
accepted
received by the device.
Maximum APDU
length accepted

Displays the maximum size of a message that the device can
accept.

Maximum master

View or enter the highest allowable address for master nodes on
an MS/TP network. Enter a number between 0 and 127. The value
affects the performance and function of your MS/TP network.
If you are viewing a device in the Hardware folder, or the
Unconfigured Devices folder, this property cannot be edited.

Maximum
information frames

View or enter the maximum number of information frames that can
be sent before the BACnet device is required to pass a token on
an MSTP network.
If you are viewing a device in the Hardware folder, or the
Unconfigured Devices folder, this property cannot be edited.
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Segmentation
supported

Displays whether the BACnet device supports segmentation of
messages and if so, whether it supports segmented
transmissions, receptions, or both.

Protocol version

Displays the BACnet protocol version that the device supports.

Protocol revision

Displays the minor revision number of the BACnet protocol that
the device supports.

Services supported

Displays the BACnet services that the device supports.

Object types
supported

Displays the BACnet object types that the device supports.
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Property

Description

Backup failure
timeout (s)

Enter the number of seconds of inactivity before the backup
terminates in case a failure occurs in the external workstation.

Last restore time

Displays the time of the last BACnet restore of the device.

Last backup time

Displays the time of the last BACnet backup of the device.

Backup
configuration files

Displays the name of the backup configuration files that provide
access to the data to back up and restore.

Backup path

Displays the path to the backup file that is stored in the file system
of the local server.
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81 BACnet Device User Interface
81.11 BACnet Device – Time Synchronization Recipients Tab

81.11

BACnet Device – Time Synchronization
Recipients Tab
Use the Time Synchronization Recipients tab on a BACnet device to
broadcast time updates to local BACnet devices residing on a subnetwork of the
device, such as an MS/TP network. Acting as a master time controller, the BACnet
device sends Time Sync messages to the recipients added to the list.

Figure: Time Synchronization Recipients tab

Table: Time Synchronization Recipients Tab
Property

Description
Add Time Sync Device Recipient
Click to add a device recipient, which will receive time updates based on
the local time of the server. For more information, see section 75.11
“Editing a Device Recipient” on page 2621.
Edit Time Synch Device Recipient
Click to edit the time synchronization properties of a device recipient. For
more information, see section 81.8 “BACnet Time Synchronization
Recipient Dialog Box” on page 2979.
Delete Time Synch Device Recipient
Click to remove the time synchronization recipient from the list.
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81 BACnet Device User Interface
81.12 BACnet Device – Device Address Bindings Tab

81.12

BACnet Device – Device Address
Bindings Tab
Use the Device Address Bindings tab to view the devices to which the device
can send messages.

Figure: Device Address Bindings tab

Table: Device Address Bindings Tab

Technical
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Property

Description

Device

Displays the BACnet name of each device.

Network ID

Displays the Network ID of the network that includes the device.
Zero (0) may be used to indicate the default network (direct
connection).

MAC address

Displays the MAC address of the device.
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81 BACnet Device User Interface
81.13 BACnet Device – Alarm Summary Tab

81.13

BACnet Device – Alarm Summary Tab
Use the Alarm Summary tab to view the alarm state and acknowledged
transitions of the objects in the device.

Figure: Alarm Summary tab

Table: Alarm Summary Tab
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Property

Description

Object

Displays the Building Operation name, BACnet name, or Object ID
of the object.

Alarm state

Displays the value of the Event state property of the object. Event
state values are device dependent.

Acknowledged
transitions

Displays whether Acknowledged transitions have been received for
to-off-normal, to-fault, or to-normal events.

Technical
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81 BACnet Device User Interface
81.14 BACnet Device – Enrollment Summary Tab

81.14

BACnet Device – Enrollment Summary
Tab
Use the Enrollment Summary tab to view the enrollment information for BACnet
devices from WorkStation and BACnet Operator Workstations.

Figure: BACnet Device – Enrollment Summary tab

Table: BACnet Device – Enrollment Summary Tab

Technical
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Property

Description

Object

Displays the name of the object.

Alarm type

Displays the type of alarm.

Alarm state

Displays the alarm state.

Priority

Displays the priority level of the alarm state.

Notification

Displays the name of the BACnet notification class that is referenced by
the alarm.
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81 BACnet Device User Interface
81.15 BACnet Device – Event Information Tab

81.15

BACnet Device – Event Information Tab
Use the Event Information tab to view the event information for BACnet devices.

Figure: BACnet Device – Event Information tab

Table: BACnet Device – Event Information Tab

04-16006-04-en, March 2015

Property

Description

Object

Displays the name of the object.

Alarm state

Displays the alarm state.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.

Notification type

Displays whether the notification is an event or alarm.

Enabled
transitions

Displays whether the device can process to-off-normal, to-fault,
or to-normal transitions.

To-off-normal
priority

Displays the priority of the to-off-normal event state notification.

To-fault priority

Displays the priority of the to-fault event state notification.

To-normal
priority

Displays the priority of the to-normal event state notification.
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81 BACnet Device User Interface
81.16 BACnet String Properties (Generic) – Basic Tab

81.16

BACnet String Properties (Generic) –
Basic Tab
Use the Basic tab to enter text to set the value of the BACnet string.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Type the text that you want to display, such as a message to users.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.
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81 BACnet Device User Interface
81.17 BACnet String Properties (Generic) – Advanced Tab

81.17

BACnet String Properties (Generic) –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the BACnet string.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Technical
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81 BACnet Device User Interface
81.18 BACnet Gateway Properties – Basic Tab

81.18

BACnet Gateway Properties – Basic Tab
Use the Basic tab to view the properties of a BACnet Gateway that does not
include a device. This type of gateway displays in the Hardware folder > BACnet
Devices > Network <n> folder where the gateway was installed. The properties are
read-only.

Figure: Basic tab

Table: Basic Tab

Technical
2994

Property

Description

MAC address

Displays the MAC address of the device in hexadecimal.

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.19 BACnet Diagnostics Properties – Basic Tab

81.19

BACnet Diagnostics Properties – Basic
Tab
Use the Basic tab to view the properties of the BACnet Diagnostics folder.

Figure: Basic tab
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81 BACnet Device User Interface
81.20 BACnet Diagnostics Object Properties – Basic Tab

81.20

BACnet Diagnostics Object Properties –
Basic Tab
Use the Basic tab to view the properties of the BACnet Network folder.

Figure: Basic tab

Technical
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81 BACnet Device User Interface
81.21 Specialized BACnet Device Properties – Basic Tab

81.21

Specialized BACnet Device Properties –
Basic Tab
Use the Basic tab to view the properties of a specialized BACnet device, such as a
Continuum Workstation.

Figure: Basic tab

Table: Basic Tab
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Property

Description

System status

Displays operational when the BACnet device is operating
correctly.

Database revision

Displays the current revision of the database.

Status

Displays True when the Building Operation server is available on
the BACnet IP network.

Device changed

Displays True when objects are created, renamed, or deleted in
the device.

Local time

Displays the date and time of the device.

Daylight savings

Select True to set the device's clock to calculate the local
standard time.

UTC offset (min)

Enter the number of minutes difference between the local time
and Universal Coordinated Time.

Technical
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81 BACnet Device User Interface
81.22 Specialized BACnet Device Properties – Advanced Tab

81.22

Specialized BACnet Device Properties –
Advanced Tab
Use the Advanced tab to view the properties of a specialized BACnet device, such
as a Continuum Workstation.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

Type a new name to change the BACnet name.

BACnet type

Displays the type, which is always device.

Model name

Displays the model name of the BACnet device.

Vendor name

Displays the manufacturer of the BACnet device.

Vendor identifier

Displays the number that identifies the vendor of the BACnet
device.

MAC address

Displays the MAC address of the device in hexadecimal.
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81 BACnet Device User Interface
81.22 Specialized BACnet Device Properties – Advanced Tab

Continued
Property

Description

Application
software version

Displays the current version of the application software that is
installed on the device.

Firmware revision

Displays the firmware version that is installed on the device.

Location

Displays only if the device supports the property. Type a
description of the location of the device, for example, Building A.

APDU segment
timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message segment.

APDU timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message.

Number of APDU
retries

Enter the maximum number of times that an unanswered
message can be retransmitted.

Maximum segments Displays the maximum number of message segments that can be
accepted
received by the device.
Maximum APDU
length accepted

Displays the maximum size of a message that the device can
accept.

Maximum master

View or enter the highest allowable address for master nodes on
an MS/TP network. Enter a number between 0 and 127. The value
affects the performance and function of your MS/TP network.
If you are viewing a device in the Hardware folder, or the
Unconfigured Devices folder, this property cannot be edited.

Maximum
information frames

View or enter the maximum number of information frames that can
be sent before the BACnet device is required to pass a token on
an MSTP network.
If you are viewing a device in the Hardware folder, or the
Unconfigured Devices folder, this property cannot be edited.
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Segmentation
supported

Displays whether the BACnet device supports segmentation of
messages and if so, whether it supports segmented
transmissions, receptions, or both.

Protocol version

Displays the BACnet protocol version that the device supports.

Protocol revision

Displays the minor revision number of the BACnet protocol that
the device supports.

Services supported

Displays the BACnet services that the device supports.

Object types
supported

Displays the BACnet object types that the device supports.

Backup failure
timeout (s)

Enter the number of seconds of inactivity before the backup
terminates in case a failure occurs in the external workstation.

Last restore time

Displays the time of the last BACnet restore of the device.

Last backup time

Displays the time of the last BACnet backup of the device.

Technical
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81 BACnet Device User Interface
81.22 Specialized BACnet Device Properties – Advanced Tab

Continued

Technical
3000

Property

Description

Backup
configuration files

Displays the name of the backup configuration files that provide
access to the data to back up and restore.

Backup path

Displays the path to the backup file that is stored in the file system
of the local server.
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81 BACnet Device User Interface
81.23 Automation Server or Enterprise Server Hardware Folder – Basic Tab

81.23

Automation Server or Enterprise Server
Hardware Folder – Basic Tab
Use the Basic tab to view the properties of the Hardware folder for an Automation
Server or Enterprise Server. The Hardware folder contains related folders, such as
Automation Server IO bus or BACnet devices. The BACnet devices folder includes
the BACnet network folders as well as the Unconfigured Devices folder. For more
information, see section 81.36 “BACnet Unconfigured Devices Folder Properties –
Basic Tab” on page 3016.

Figure: Basic tab
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81 BACnet Device User Interface
81.24 I/A Series (MNB) BACnet Device Properties – Basic Tab

81.24

I/A Series (MNB) BACnet Device
Properties – Basic Tab
Use the Basic tab to view the properties of a hosted I/A Series BACnet device.

Figure: Basic tab

Technical
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81 BACnet Device User Interface
81.25 I/A Series (MNB) BACnet Device Properties – Advanced Tab

81.25

I/A Series (MNB) BACnet Device
Properties – Advanced Tab
Use the Advanced tab to view the properties of a hosted I/A Series BACnet
device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

BACnet name

Type a new name to change the BACnet name.

BACnet type

Displays the type, which is always device.

Model name

Displays the model name of the BACnet device.

Vendor name

Displays the manufacturer of the BACnet device.

Technical
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81 BACnet Device User Interface
81.25 I/A Series (MNB) BACnet Device Properties – Advanced Tab

Continued
Property

Description

MAC address

Displays the MAC address of the device in hexadecimal.

Application
software version

Displays the current version of the application software that is
installed on the device.

Firmware revision

Displays the firmware version that is installed on the device.

Location

Displays only if the device supports the property. Type a
description of the location of the device, for example, Building A.

Vendor identifier

Displays the number that identifies the vendor of the BACnet
device.

APDU timeout (ms)

Enter the amount of time between retransmissions of an
unanswered message.

Number of APDU
retries

Enter the maximum number of times that an unanswered
message can be retransmitted.

Serial Number

Type the serial number of the IA Series BACnet device.

Maximum APDU
length accepted

Displays the maximum size of a message that the device can
accept.

Maximum master

View or enter the highest allowable address for master nodes on
an MS/TP network. Enter a number between 0 and 127. The value
affects the performance and function of your MS/TP network.
If you are viewing a device in the Hardware folder, or the
Unconfigured Devices folder, this property cannot be edited.

Maximum
information frames

View or enter the maximum number of information frames that can
be sent before the BACnet device is required to pass a token on
an MSTP network.
If you are viewing a device in the Hardware folder, or the
Unconfigured Devices folder, this property cannot be edited.

Technical
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Segmentation
supported

Displays whether the BACnet device supports segmentation of
messages and if so, whether it supports segmented
transmissions, receptions, or both.

Protocol version

Displays the BACnet protocol version that the device supports.

Protocol revision

Displays the minor revision number of the BACnet protocol that
the device supports.

Services supported

Displays the BACnet services that the device supports.

Object types
supported

Displays the BACnet object types that the device supports.

Last backup time

Displays the time of the last BACnet backup of the device.

Backup
configuration files

Displays the name of the backup configuration files that provide
access to the data to back up and restore.
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81 BACnet Device User Interface
81.25 I/A Series (MNB) BACnet Device Properties – Advanced Tab

Continued
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Property

Description

Backup path

Displays the path to the backup file that is stored in the file system
of the local server.

Technical
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81 BACnet Device User Interface
81.26 BBMD Properties – Basic Tab

81.26

BBMD Properties – Basic Tab
Use the Basic tab to view the general properties of the BBMD.

Figure: Basic tab

Technical
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81 BACnet Device User Interface
81.27 BBMD BDT Entry Properties – Basic Tab

81.27

BBMD BDT Entry Properties – Basic Tab
Use the Basic tab to view and configure the settings of a BBMD Broadcast
Distribution Table (BDT) entry, which can explicitly direct broadcast messages to a
specific IP address. For more information, see section 75.30 “BBMDs and Foreign
Devices” on page 2642.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Teach status

Displays the status of the Teach: Success or None. If
successful, the BBMD sends the BDT entry configuration to all
other BBMDs in the system.

IP address

Type the IP address of the BBMD on the subnet.

IP port number

Type the IP port number of the BBMD on the subnet.

Broadcast
distribution mask

Type the Broadcast distribution mask of the BBMD on the subnet.

Technical
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81 BACnet Device User Interface
81.28 BACnet Learn BDT Table Dialog Box

81.28

BACnet Learn BDT Table Dialog Box
Use the Learn BDT Table dialog box when you want to learn the BACnet
Broadcast Device Table from one BBMD to another BBMD.
For more information, see section 75.30 “BBMDs and Foreign Devices” on page
2642.

Figure: Learn BDT Table dialog box

Table: Learn BDT Table Dialog Box

Technical
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Property

Description

IP Address

Type the IP Address of the BBMD from which you want to copy the
configuration. The IP Address number increments for each IP interface
that is installed on the server.

IP Port
Number

Type the IP Port Number of the BBMD from which you want to copy
the configuration.
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81 BACnet Device User Interface
81.29 BBMD Foreign Device Table Tab

81.29

BBMD Foreign Device Table Tab
Use the Foreign Device Table tab to view the configuration settings of a
registered foreign device.

Figure: Foreign Device Table tab

Table: Foreign Device Table Tab
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Property

Description

IP address

Displays the IP address of a BACnet device that is registered as a
foreign device in the BACnet internetwork.

Port number

Displays the IP port number of a BACnet device that is registered
as a foreign device in the BACnet internetwork.

Time to live

Displays the number of seconds for the BACnet device to be
active as a registered foreign device in the BACnet internetwork.

Time remaining

Displays the number of remaining seconds for the BACnet device
to be active as a registered foreign device in the BACnet
internetwork.

Technical
3009

81 BACnet Device User Interface
81.30 BACnet IP Network Properties – Basic Tab

81.30

BACnet IP Network Properties – Basic
Tab
Use the Basic tab to view or change the properties of a BACnet IP network and
foreign device settings.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Online

Displays True when the Building Operation server is available on
the BACnet IP network.

Reliability

Displays any error status for a network that is configured as a
foreign device.

Out Of Service

Set to True to disable the IP network from the BACnet system.

IP address

Displays the IP address of the server represented by the
BACnet Interface.

IP port number

Displays the IP port number of the server represented by the
BACnet Interface.

Network ID

Displays the Network ID of the BACnet IP network.
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81 BACnet Device User Interface
81.30 BACnet IP Network Properties – Basic Tab

Continued
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Property

Description

Maximum APDU
length accepted

Displays the maximum size of a message that a device on the
network can accept.

IP broadcast
address

Displays the IP address used to send broadcast messages on a
BACnet IP network.

BBMD IP address

Type the IP address of the BBMD to register the network as a
foreign device with the BBMD.

BBMD port number

Enter the port number of the BBMD to register the network as a
foreign device with the BBMD.

Technical
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81 BACnet Device User Interface
81.31 BACnet MS/TP Network Properties – Basic Tab

81.31

BACnet MS/TP Network Properties –
Basic Tab
Use the Basic tab to view or configure the properties of a BACnet MS/TP network.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Online

Displays True when the Building Operation server is available on
the BACnet MS/TP network.

Reliability

Displays any error status for a network that is configured as a
foreign device.

Network ID

View or enter the Network ID of the MS/TP network. Enter a
number from 1 to 65534 that uniquely identifies the network over
the entire BACnet internetwork.

Out Of Service

Set to True to disable the IP network from the BACnet system.

RS-485 port

View or enter the path to the serial port on the Automation Server.

MAC address

View or enter the MS/TP MAC address of the Automation
Server. Enter a number between 0 and 127. Most installations use
0.
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81 BACnet Device User Interface
81.31 BACnet MS/TP Network Properties – Basic Tab

Continued
Property

Description

MSTP baud rate

View or select the MS/TP baud rate.

Enhanced mode

Select True to improve throughput when used with b3 devices.
Enhanced mode allocates more bandwidth to the Automation
Server. This setting has no effect on other (non-b3) MS/TP
devices.
Select False if you anticipate heavy communication among the
MS/TP devices, or if strict BACnet compliance is required.
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Maximum master

Enter the highest used address of the master nodes on the MS/TP
network. Enter a number between 0 and 127.

Maximum
information frames

Enter the maximum number of information frames that can be
sent before the BACnet device is required to pass a token on the
MS/TP network.

Maximum APDU
length accepted

Displays the maximum size of a message that a device on the
network can accept.

Technical
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81 BACnet Device User Interface
81.32 BACnet Network Properties – Basic Tab

81.32

BACnet Network Properties – Basic Tab
Use the Basic tab to view the properties of a BACnet network.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Network ID

Displays the Network ID.
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81 BACnet Device User Interface
81.33 Application Folder of a BACnet Interface

81.33

Application Folder of a BACnet
Interface
Use the Basic tab to view the properties of the Application folder of a BACnet
Interface.

Figure: Basic tab
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81 BACnet Device User Interface
81.34 Application Folder of a BACnet Device

81.34

Application Folder of a BACnet Device
Use the Basic tab to view the properties of the Application folder of a BACnet
device.

Figure: Basic tab
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81 BACnet Device User Interface
81.35 Application Folder of an I/A Series (MNB) BACnet Device

81.35

Application Folder of an I/A Series
(MNB) BACnet Device
Use the Basic tab to view the application folder properties of a hosted I/A Series
BACnet device.

Figure: Basic tab
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81 BACnet Device User Interface
81.36 BACnet Unconfigured Devices Folder Properties – Basic Tab

81.36

BACnet Unconfigured Devices Folder
Properties – Basic Tab
Use the Basic tab to view the properties of the Unconfigured Devices folder.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Network ID

Displays zero (0), which represents a dummy network containing
devices that are online but are not communicating properly.
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81 BACnet Device User Interface
81.37 BACnet Unsolicited Alarms – Basic Tab

81.37

BACnet Unsolicited Alarms – Basic Tab
Use the Basic tab to view the properties of unsolicited alarms that are configured
for third-party devices. Building Operation uses this folder as a placeholder for these
non-native alarms.

Figure: Basic tab
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81 BACnet Device User Interface
81.38 BACnet Analog Input Properties – Basic Tab

81.38

BACnet Analog Input Properties – Basic
Tab
Use the Basic tab to view and configure the properties of a BACnet analog input
point.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Technical
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Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.
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81 BACnet Device User Interface
81.38 BACnet Analog Input Properties – Basic Tab

Continued
Property

Description

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

Associated value Displays the value of the referenced property.
COV increment
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Enter the minimum change in the Value property that causes a COV
notification to be sent.
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81 BACnet Device User Interface
81.39 BACnet Analog Input Properties – Advanced Tab

81.39

BACnet Analog Input Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the point, view the
Intrinsic Alarm status, and configure the Intrinsic Alarm for the point.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.
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81 BACnet Device User Interface
81.39 BACnet Analog Input Properties – Advanced Tab

Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handing
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value and the
boundaries defined by the Upper Limit, Lower limit, and Deadband.
For example, if you enter 5 seconds and the Value remains outside
the Upper limit and Lower limit boundaries for a minimum of 5
seconds, the system generates a to-off-normal event.
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Deadband

Enter a range that is an offset from the low-level and high-level limits,
which defines the range where a to-normal event can be generated.
To generate a to-normal event, the value must be above the low limit
and below the high limit, minus the deadband. For generic objects,
this property is present only in analog objects from external devices
that support intrinsic reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower limit
off-normal events and to-normal events. Select High limit enable
to enable the reporting of Upper limit off-normal events and tonormal events.
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Continued
Property

Description

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Fault message
Reset message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.40

BACnet Analog Output Properties –
Basic Tab
Use the Basic tab to configure a BACnet analog output point and to associate the
point with any compatible property or output point on the Automation Server IO
module. Doing so, sets the compatible property or output point of the Automation
Server IO module. If the point is already configured, you can view the status of the
point or change the configuration.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Status flags
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Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.
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Continued
Property

Description

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

Associated value Displays the read-only value of the property that is associated with the
BACnet point.
COV increment
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Enter the minimum change in the Value property that causes a COV
notification to be sent.
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81.41

BACnet Analog Output Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the point, view the
Intrinsic Alarm status, and configure the Intrinsic Alarm for the point.

Figure: Advanced tab

Table: Advanced Tab

04-16006-04-en, March 2015

Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.
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Continued
Property

Description

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay (s)

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.
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Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.
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Continued
Property

Description

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value and the
boundaries defined by the Upper Limit, Lower limit, and Deadband.
For example, if you enter 5 seconds and the Value remains outside
the Upper limit and Lower limit boundaries for a minimum of 5
seconds, the system generates a to-off-normal event.

Deadband

Enter a range that is an offset from the low-level and high-level limits,
which defines the range where a to-normal event can be generated.
To generate a to-normal event, the value must be above the low limit
and below the high limit, minus the deadband. For generic objects,
this property is present only in analog objects from external devices
that support intrinsic reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower limit
off-normal events and to-normal events. Select High limit enable
to enable the reporting of Upper limit off-normal events and tonormal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Fault message
Reset message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.42

BACnet Analog Output Properties –
Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
modify the priority array for the BACnet analog output point. For more information,
see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish default

Enter the value to be used by the Value property when all
values in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the
present value. The present value is the highest priority with a
non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)
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Continued
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Property

Description

Priority x

Enter a priority value or Null.
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81.43

BACnet Analog Value Properties – Basic
Tab
Use the Basic tab to configure an analog value to be used as a control system
parameter in a device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Enter the value to be used as the control system parameter under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.
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Status flags

Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.
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Continued
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Property

Description

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

COV increment

Enter the minimum change in the Value property that causes a COV
notification to be sent.
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81.44

BACnet Analog Value Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the analog value,
view the Intrinsic Alarm status, and configure the Intrinsic Alarm for the analog
value.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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Continued
Property

Description

Time delay (s)

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value and the
boundaries defined by the Upper Limit, Lower limit, and Deadband.
For example, if you enter 5 seconds and the Value remains outside
the Upper limit and Lower limit boundaries for a minimum of 5
seconds, the system generates a to-off-normal event.

Deadband
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Enter a range that is an offset from the low-level and high-level limits,
which defines the range where a to-normal event can be generated.
To generate a to-normal event, the value must be above the low limit
and below the high limit, minus the deadband. For generic objects,
this property is present only in analog objects from external devices
that support intrinsic reporting.
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Continued
Property

Description

Limit enable

Select Low limit enable to enable the reporting of Lower limit
off-normal events and to-normal events. Select High limit enable
to enable the reporting of Upper limit off-normal events and tonormal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.45

BACnet Analog Value Properties –
Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
modify the priority array for the BACnet analog value. For more information, see
section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish default

Enter the value to be used by the Value property when all
values in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the
present value. The present value is the highest priority with a
non-Null value.
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Continued
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.46

BACnet Digital Input Properties – Basic
Tab
Use the Basic tab to configure a BACnet digital input point and to associate the
point with any compatible property or input point on the Automation Server IO
module. Doing so, sets the compatible property or input point of the Automation
Server IO module. If the point is already configured, you can view the status of the
point or change the configuration.

Figure: Basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

Associated value Displays the value of the referenced property.
Polarity

Select one of the following options to control the relationship between
the BACnet point and the point of the Automation Server IO module:
• Normal if you want the Associated value of True to equal
Active.
• Reverse if you want the Associated value of False to equal
Active.

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text for the
Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text for the
Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.
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81.47

BACnet Digital Input Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the point, view the
Intrinsic Alarm status, and configure the Intrinsic Alarm for the point.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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Continued
Property

Description

Time delay (s)

Enter the minimum number of seconds required before a to-offnormal event, or a to-normal event is generated based on the states
in the Value property and the Alarm value property.
For example, suppose you enter 5 seconds.
If the state in the Value property and the state in the Alarm value
property are the same for a minimum of 5 seconds, a to-off-normal
event is generated.
If the state in the Value property and the state in the Alarm value
property are not the same for a minimum of 5 seconds, a to-normal
event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Alarm value

Select the state that Value requires before an off-normal event is
triggered.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.48

BACnet Digital Output Properties –
Basic Tab
Use the Basic tab to configure a BACnet digital output point. If the point is already
configured, you can view the status of the point.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Status flags
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Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.
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Continued
Property

Description

Out of service

Select True to disassociate the Value from the physical output. Out
of service is primarily used for testing purposes.

Event state

Displays one of the following active event states associated with the
point:
• Normal when the point is not in an alarm state.
• Off Normal when the Intrinsic Alarm is configured and the
point is in an alarm state.

Associated value

Displays the read-only value of the property that is associated with
the BACnet point.

Polarity

Select one of the following options to control the relationship
between the BACnet point and the point of the Automation Server
IO module:
• Normal if you want the Associated value of True to equal
Active.
• Reverse if you want the Associated value of False to equal
Active.

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text for
the Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text for
the Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.
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81.49

BACnet Digital Output Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the digital output
point, and to verify the object ID and object type of the point.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.
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81.50

BACnet Digital Output Properties –
Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
modify the priority array for the BACnet digital output point. For more information,
see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish default

Enter the value to be used by the Value property when all
values in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the
present value. The present value is the highest priority with a
non-Null value.
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Continued
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.51

BACnet Digital Value Properties – Basic
Tab
Use the Basic tab to configure the BACnet digital value to be used as a control
system parameter in a device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Enter the value to be used as the control system parameter under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Status flags
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Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.
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Continued
Property

Description

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text for the
Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text for the
Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.
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81.52

BACnet Digital Value Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the digital value,
view the Intrinsic Alarm Status, and configure the Intrinsic Alarm for the digital value.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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Continued
Property

Description

Time delay (s)

Enter the minimum number of seconds that the Value property is
required to be different from the Alarm value property before a tooff-normal event is generated or remain the same as the Alarm
value property before a to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Alarm value

Select the state that Value requires before an off-normal event is
triggered.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.53

BACnet Digital Value Properties –
Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
configure the priority array for the BACnet digital value. For more information, see
section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish default

Enter the value to be used by the Value property when all
values in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the
present value. The present value is the highest priority with a
non-Null value.

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.53 BACnet Digital Value Properties – Command Tab

Continued
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.54

BACnet Multistate Input Properties –
Basic Tab
Use the Basic tab to configure a BACnet multistate input point and to associate
the point with any compatible property or input point on the Automation Server IO
module. Doing so, sets the compatible property or input point of the Automation
Server IO module. If the point is already configured, you can view the status of the
point or change the configuration.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.
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Continued
Property

Description

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

Reliability

Displays the reliability of the point.

Associated value Displays the value of the referenced property. If no property is
referenced, the value is zero (0). The value of the BACnet point will be
equal to the Associated value plus the Associated value offset.
Associated value Enter an offset value, which is a combination of the Associated value
offset
and Associated offset value.
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81.55

BACnet Multistate Input Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the point, view the
Intrinsic Alarm status, and configure the Intrinsic Alarm for the point.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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Continued
Property

Description

Time delay (s)

Select the minimum number of seconds required before a to-offnormal event, a to-fault event, or a to-normal event is generated
based on the state of Value and any State Id, and the settings for
Is alarm value and Is fault value.
For example, suppose you enter 5 seconds.
If Value and any State Id match for a minimum of 5 seconds, and
Is alarm value is set to Yes, a to-off-normal event is generated.
If Value and any State Id match for a minimum of 5 seconds, and
Is fault value is set to Yes, a to-fault event is generated.
If Value and any State Id do not match for a minimum of 5
seconds, and Is alarm value and Is fault value are set to No, a
to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.
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Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

State Id

Enter the State Id for which you want to set an alarm or fault alarm.

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you select
Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you select
Yes, select No for Is alarm value.

Add

Click to add an alarm or fault State Id to the list of alarm and fault
values.
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Continued
Property

Description

Edit

Click to open the Properties dialog box where you can edit the
alarm or fault configuration for a selected State Id. For more
information, see section 81.62 “BACnet Multistate Alarm Properties
Dialog Box” on page 3069.

Remove

Click to remove the State Id from the list of alarm or fault values.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.56

BACnet Multistate Output Properties –
Basic Tab
Use the Basic tab to configure a BACnet multistate output point. If the point is
already configured, you can view the status of the point.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.
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Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.
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Continued
Property

Description

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Associated value Displays the value to be read by the referenced property.
Associated value Enter an offset value, which is a combination of the Associated value
offset
and Associated offset value.
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81.57

BACnet Multistate Output Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the multistate
output point, and to verify the object ID and object type of the point.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.
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81.58

BACnet Multistate Output Properties –
Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
configure the priority array for the BACnet multistate output point. For more
information, see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish default

Enter the value to be used by the Value property when all
values in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the
present value. The present value is the highest priority with a
non-Null value.
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Continued
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.59

BACnet Multistate Value Properties –
Basic Tab
Use the Basic tab to configure the BACnet multistate value to be used as a control
system parameter in a device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Enter the value to be used as the control system parameter under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.
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Status flags

Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.
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Continued
Property

Description

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

Reliability

Displays one of the following descriptions to indicate the reliability of
the Value property:
• no fault detected
• multistate fault
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81.60

BACnet Multistate Value Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name for the multistate
value, view the Intrinsic Alarm status, and configure the Intrinsic Alarm for the
multistate value.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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Continued
Property

Description

Time delay (s)

Select the minimum number of seconds required before a to-offnormal event, a to-fault event, or a to-normal event is generated
based on the state of Value and any State Id, and the settings for
Is alarm value and Is fault value.
For example, suppose you enter 5 seconds.
If Value and any State Id match for a minimum of 5 seconds, and
Is alarm value is set to Yes, a to-off-normal event is generated.
If Value and any State Id match for a minimum of 5 seconds, and
Is fault value is set to Yes, a to-fault event is generated.
If Value and any State Id do not match for a minimum of 5
seconds, and Is alarm value and Is fault value are set to No, a
to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.
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Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

State Id

Enter the State Id for which you want to set an alarm or fault alarm.

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you select
Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you select
Yes, select No for Is alarm value.

Add

Click to add an alarm or fault State Id to the list of alarm and fault
values.
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Continued
Property

Description

Edit

Click to open the Properties dialog box where you can edit the
alarm or fault configuration for a selected State Id. For more
information, see section 81.62 “BACnet Multistate Alarm Properties
Dialog Box” on page 3069.

Remove

Click to remove the State Id from the list of alarm or fault values.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.61

BACnet Multistate Value Properties –
Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
configure the priority array for the BACnet multistate value. For more information,
see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish default

Enter the value to be used by the Value property when all
values in the priority array are set to Null.

Active command
priority

Specifies the priority level (1-16) currently controlling the
present value. The present value is the highest priority with a
non-Null value.
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Continued
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not
currently supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.62

BACnet Multistate Alarm Properties
Dialog Box
Use the Properties dialog box to configure the states of a multistate input point or
multistate value.

Figure: Basic tab

Table: Properties Dialog Box
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Property

Description

State Id

Enter the State Id for which you want to set an alarm or fault alarm.

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you select Yes,
select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you select
Yes, select No for Is alarm value.
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81.63

BACnet Multistate Objects – State
Configuration Tab
Use the State Configuration tab to create multistate input states, output states,
and value states for BACnet multistate objects.

Figure: State Configuration tab

Table: State Configuration Tab
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Property

Description

Number of
states

Enter the number of states that you want to create.

State

Displays the state Id that represents the state.

Label

Click the text and then type a description for the state number, such as
Unoccupied, Standby, or Warmup. This text is used as an enumeration
text for the Value property and related priority array values. It is visible in
graphics, in the Watch pane, and in the Properties pane.
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81.64

BACnet Analog Input Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the BACnet analog input properties for an
external device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.
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Continued
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.
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Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Set to True to decouple the Value from the associated property. If the
associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on
WebHelp.

COV increment

Enter the minimum change in the Value property that causes a COV
notification to be sent.

Update interval

Displays the maximum amount of time between updates to the Value
property when the input is not Overridden and Out of service is
False. The time value is hundredths of a second.

Minimum value

Enter the lowest value that can be reliably derived for the Value
property.

Maximum value

Enter the highest value that can be reliably derived for the Value
property.

Resolution

Displays the smallest recognizable change in the Value property.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe the
type of sensor connected to an analog input or the type of sensor
represented by an accumulator.
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81.65

BACnet Analog Input Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of the point, view the
Intrinsic Alarm Status, and configure the Intrinsic Alarm.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Time delay

Select the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Upper limit

Enter a limit that Value is required to exceed before an event is
generated.

Lower limit

Enter a limit that Value is required to fall below before an event is
generated.

Deadband

Enter the deadband which is the range the value must stay within
before a to-normal event is generated.

Limit enable

Select one or more flags to enable the reporting of off-normal events
and the return to to-normal events based on the lower limit value or
upper limit value.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.
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81.66

BACnet Analog Output Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the BACnet analog output properties for
an external device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.
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Continued
Property

Description

Value

Displays an orange button if the Associated value is not configured.
When configured, displays the current value for the point under the
following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.

Out of service

Select True to disassociate the Value from the physical output. Out
of service is primarily used for testing purposes.

Event state

Displays one of the following active event states associated with the
point:
• Normal when the point is not in an alarm state.
• Off Normal when the Intrinsic Alarm is configured and the
point is in an alarm state.

Technical
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Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured
for an object. For more information, see the Alarm States topic on
WebHelp.

Reliability

Displays the reliability of the point.

COV increment

Enter the minimum change in the Value property that causes a COV
notification to be sent. The default COV increment is .10.

Minimum value

Enter the lowest value that can be reliably used for the Value
property.

Maximum value

Enter the highest value that can be reliably used for the Value
property.

Resolution

Displays the smallest recognizable change in the Value property.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe the
type of sensor connected to an analog input or the type of sensor
represented by an accumulator.
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81.67

BACnet Analog Output Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of the point, view the
Intrinsic Alarm Status, and configure the Intrinsic Alarm.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Time delay (s)

Select the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Upper limit

Enter a limit that Value is required to exceed before an event is
generated.

Lower limit

Enter a limit that Value is required to fall below before an event is
generated.

Deadband

Enter the deadband which is the range the value must stay within
before a to-normal event is generated.

Limit enable

Select one or more flags to enable the reporting of off-normal events
and the return to to-normal events based on the lower limit value or
upper limit value.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.
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81.68

BACnet Analog Output Properties
(Generic) – Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
configure the priority array for the analog output point. For more information, see
section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in the
priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present value.
The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not currently
supported. (Read-only)
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Continued

Technical
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Property

Description

Priority x

Enter a priority value or Null.
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81.69

BACnet Analog Value Properties
(Generic) – Basic Tab
Use the Basic tab to view or configure a BACnet analog value to use as a control
system parameter for an external device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Enter the value to be used as the control system parameter under
the following conditions:
• Unforce. Displays a forced value. Enter a forced value or click
to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a Forced
status may also include a priority level setting. For more information,
see section 77.7 “Forced Priority Level” on page 2857.

Status flags
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Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page 2673.
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Continued
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Property

Description

Out of service

Set to True to decouple the Value from the associated property. If
the associated property is not configured, this property is True and
cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been configured
and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured
for an object. For more information, see the Alarm States topic on
WebHelp.

COV increment

Enter the minimum change in the Value property that causes a COV
notification to be sent.
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81.70

BACnet Analog Value Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of the analog value,
view the Intrinsic Alarm Status, and configure the Intrinsic Alarm.

Figure: Advanced tab

Table: Advanced Tab

04-16006-04-en, March 2015

Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that
you want to use to generate event notifications:
• Select System reference to define a path-based reference
to an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be
uploaded or imported to the server later. You can also use this
method to reference a BACnet object or property on an
external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Upper limit

Enter a limit that Value is required to exceed before a to-offnormal event is generated.

Lower limit

Enter a limit that Value is required to fall below before a to-offnormal event is generated.
The system generates a to-off-normal event based on Value and the
boundaries defined by the Upper Limit, Lower limit, and Deadband.
For example, if you enter 5 seconds and the Value remains outside
the Upper limit and Lower limit boundaries for a minimum of 5
seconds, the system generates a to-off-normal event.

Deadband

Enter a range that is an offset from the low-level and high-level
limits, which defines the range where a to-normal event can be
generated. To generate a to-normal event, the value must be above
the low limit and below the high limit, minus the deadband. For
generic objects, this property is present only in analog objects from
external devices that support intrinsic reporting.

Limit enable

Select Low limit enable to enable the reporting of Lower limit
off-normal events and to-normal events. Select High limit enable
to enable the reporting of Upper limit off-normal events and tonormal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the
BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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Continued
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Property

Description

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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81.71

BACnet Analog Value Properties
(Generic) – Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
configure the priority array for the analog value. For more information, see section
77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab

Technical
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Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in the
priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present value.
The present value is the highest priority with a non-Null value.

Priority 6

This priority is reserved for timer-based algorithms that are not currently
supported. (Read-only)
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Continued

04-16006-04-en, March 2015

Property

Description

Priority x

Enter a priority value or Null.
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81.72

BACnet Digital Input Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure a BACnet digital input properties for an
external device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.
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Continued
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Change of state time Displays the reliability of the point.
Change of state
count

Displays how often the Value property has changed state since
the Change of state count was last set to 0. The Change of
state count increments when the Value property has a change
of state based on an event that alters the Value property.
Enter 0 if you want to reset the Change of state count.

Time of state count
reset

Displays the date and time when the Change of state count
was last set to 0.

Elapsed active time

Displays the number of seconds that the Value property was
Active since the Elapsed active time was last set to 0.
Enter 0 if you want to reset the Elapsed active time.
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Time of active time
reset

Displays the date and time when Elapsed active time was last
set to 0.

Polarity

Select Normal or Reverse to control the relationship between
the physical state of the point and the Value property. When
Out of service is set to False, the Polarity property causes a
change to the Value property.
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Continued
Property

Description

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.

Device type
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Type a description of the device that is either connected to or
represented by the object. For example, the text could describe
the type of sensor connected to an analog input or the type of
sensor represented by an accumulator.
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81.73

BACnet Digital Input Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name for the point, view the
Intrinsic Alarm Status, and configure the Intrinsic Alarm.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.
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Continued
Property

Description

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that
you want to use to generate event notifications:
• Select System reference to define a path-based reference
to an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be
uploaded or imported to the server later. You can also use this
method to reference a BACnet object or property on an
external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

Alarm value

Select the state that Value requires before an off-normal event is
triggered.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the
BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View topic on
WebHelp.

Technical
3094

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.74 BACnet Digital Output Properties (Generic) – Basic Tab

81.74

BACnet Digital Output Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the BACnet digital output properties for an
external device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.
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Continued
Property

Description

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Change of state time Displays the reliability of the point.
Change of state
count

Displays how often the Value property has changed state since
the Change of state count was last set to 0. The Change of
state count increments when the Value property has a change
of state based on an event that alters the Value property.
Enter 0 if you want to reset the Change of state count.

Time of state count
reset

Displays the date and time when the Change of state count
was last set to 0.

Elapsed active time

Displays the number of seconds that the Value property was
Active since the Elapsed active time was last set to 0.
Enter 0 if you want to reset the Elapsed active time.
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Time of active time
reset

Displays the date and time when Elapsed active time was last
set to 0.

Polarity

Select Normal or Reverse to control the relationship between
the physical state of the point and the Value property. When
Out of service is set to False, the Polarity property causes a
change to the Value property.
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Continued
Property

Description

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.
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Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe
the type of sensor connected to an analog input or the type of
sensor represented by an accumulator.

Minimum off time

Enter the minimum number of seconds that you want the Value
property to remain Inactive following a write to the Value
property that causes the Inactive state.

Minimum on time

Enter the minimum number of seconds that you want the Value
property to remain Active following a write to the Value
property that causes the Active state.
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81.75

BACnet Digital Output Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or configure the digital output (generic) properties
for a device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Time delay (s)

Enter the minimum number of seconds that the Value property is
required to be different from the Feedback value property before a
to-off-normal event is generated or remain the same as the
Feedback value property before a to-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Feedback value

Displays the state that is required to be different from the Value
property before a to-off-normal event is generated. You can view this
state in the Alarms pane or an alarm view.
For more information, see the Add/Remove Columns Dialog Box
(Alarms) topic on WebHelp.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normaltime

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault-time

Displays the BACnet timestamp of the last to-fault transition.

To-normal-time

Displays the BACnet timestamp of the last to-normal transition.
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81.76

BACnet Digital Output Properties
(Generic) – Command Tab
Use the Command tab to enter a value for the Relinquish default and to view or
configure the priority array for the digital output point. For more information, see
section 77.1 “BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in the
priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present value.
The present value is the highest priority with a non-Null value.
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not currently
supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.77

BACnet Digital Value Properties
(Generic) – Basic Tab
Use the Basic tab to view or configure the BACnet digital value to use as a control
system parameter for an external device.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.
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Continued
Property

Description

Value

Enter the value to be used as the control system parameter
under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Change of state time Displays the reliability of the point.
Change of state
count

Displays how often the Value property has changed state since
the Change of state count was last set to 0. The Change of
state count increments when the Value property has a change
of state based on an event that alters the Value property.
Enter 0 if you want to reset the Change of state count.

Time of state count
reset

Displays the date and time when the Change of state count
was last set to 0.

Elapsed active time

Displays the number of seconds that the Value property was
Active since the Elapsed active time was last set to 0.
Enter 0 if you want to reset the Elapsed active time.

Time of active time
reset

Displays the date and time when Elapsed active time was last
set to 0.

Inactive text

Type the text that explains the Inactive state of the value, such as
Pump_Basement_Off. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Inactive) is used instead.
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Continued
Property

Description

Active text

Type the text that explains the Active state of the value, such as
Pump_Basement_On. This text is used as an enumeration text
for the Value property and related priority array values. It is
visible in graphics, in the Watch pane, and in the Properties pane.
If you leave this box empty, the default (Active) is used instead.

Technical
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Minimum off time

Enter the minimum number of seconds that you want the Value
property to remain Inactive following a write to the Value
property that causes the Inactive state.

Minimum on time

Enter the minimum number of seconds that you want the Value
property to remain Active following a write to the Value
property that causes the Active state.
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81.78

BACnet Digital Value Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of the digital value,
view the Intrinsic Alarm Status, and configure the Intrinsic Alarm.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.
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Property

Description

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.

Time delay (s)

Enter the minimum number of seconds that the Value property is
required to be different from the Alarm value property before a tooff-normal event is generated or remain the same as the Alarm
value property before a to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Alarm value

Select the state that Value requires before an event is triggered.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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81.79

BACnet Digital Value Properties
(Generic) – Command Tab
Use the Command tab to enter a value for the Relinquish default and to view the
priority array for the digital value. For more information, see section 77.1 “BACnet
Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in the
priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present value.
The present value is the highest priority with a non-Null value.
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not currently
supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.80

BACnet Multistate Input Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the BACnet multistate input properties for
an external device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.
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Property

Description

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe
the type of sensor connected to an analog input or the type of
sensor represented by an accumulator.
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81.81

BACnet Multistate Input Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of the point, view the
Intrinsic Alarm Status, and configure the Intrinsic Alarm on an external device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.
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Property

Description

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that
you want to use to generate event notifications:
• Select System reference to define a path-based reference
to an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be
uploaded or imported to the server later. You can also use this
method to reference a BACnet object or property on an
external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

State Id

Enter the State Id for which you want to set an alarm or fault alarm.

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you select
Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you
select Yes, select No for Is alarm value.
Click to add an alarm or fault State Id to the list of alarm and fault
values.
Click to open the Properties dialog box where you can edit the
alarm or fault configuration for a selected State Id. For more
information, see section 81.62 “BACnet Multistate Alarm Properties
Dialog Box” on page 3069.
Click to remove the State Id from the list of alarm or fault values.
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Property

Description

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the
BACnet notification.

Reset message
Fault message

For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.82

BACnet Multistate Output Properties
(Generic) – Basic Tab
Use the Basic tab to view or configure the BACnet multistate output properties for
an external device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Displays an orange button if the Associated value is not
configured. When configured, displays the current value for the
point under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.
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Property

Description

Status flags

Displays the condition or status of the BACnet point. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe
the type of sensor connected to an analog input or the type of
sensor represented by an accumulator.
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81.83

BACnet Multistate Output Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of the point, view the
Intrinsic Alarm Status, and configure the Intrinsic Alarm.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Time delay (s)

Enter the minimum number of seconds that the Value property is
required to be different from the Feedback value property before a
to-off-normal event is generated or remain the same as the
Feedback value property before a to-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Feedback value

Displays the state that is required to be different from the Value
property before a to-off-normal event is generated. You can view this
state in the Alarms pane or an alarm view.
For more information, see the Add/Remove Columns Dialog Box
(Alarms) topic on WebHelp.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To normal time

Displays the BACnet timestamp of the last to-normal transition.
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81.84

BACnet Multistate Output Properties
(Generic) – Command Tab
Use the Command tab to enter a value for the Relinquish default and to view the
priority array for the multistate output point. For more information, see section 77.1
“BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab

Technical
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Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in the
priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present value.
The present value is the highest priority with a non-Null value.
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Property

Description

Priority 6

This priority is reserved for timer-based algorithms that are not currently
supported. (Read-only)

Priority x

Enter a priority value or Null.
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81.85

BACnet Multistate Value Properties
(Generic) – Basic Tab
Use the Basic tab to view or configure a multistate value to use as a control system
parameter in an external BACnet device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Enter the value to be used as the control system parameter
under the following conditions:
• Unforce. Displays a forced value. Enter a forced value or
click to release the value.
• Force. Displays a non-forced value. Click to force the value.
For all BACnet inputs, a Forced condition is the same as out of
service. For more information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are commandable, a
Forced status may also include a priority level setting. For more
information, see section 77.7 “Forced Priority Level” on page
2857.

Status flags

Technical
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Displays the condition or status of the BACnet value. For more
information, see section 76.9 “BACnet Status Flags” on page
2673.

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.85 BACnet Multistate Value Properties (Generic) – Basic Tab

Continued

04-16006-04-en, March 2015

Property

Description

Out of service

Set to True to decouple the Value from the associated property.
If the associated property is not configured, this property is True
and cannot be changed.

Reliability

Displays the reliability of the point.

Event state

Displays Off Normal when intrinsic alarming has been
configured and the point is in an alarm state.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm
configured for an object. For more information, see the Alarm
States topic on WebHelp.
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81.86

BACnet Multistate Value Properties
(Generic) – Advanced Tab
Use the Advanced tab to view or change the BACnet name of a multistate value,
view the Intrinsic Alarm Status, and configure the Intrinsic Alarm on an external
device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.
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Property

Description

To-off-normal
time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Time delay

Enter the minimum number of seconds required before a to-offnormal event, or to-normal event is generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that
you want to use to generate event notifications:
• Select System reference to define a path-based reference
to an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be
uploaded or imported to the server later. You can also use this
method to reference a BACnet object or property on an
external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal and tonormal events. to-fault reporting is not supported by Building
Operation BACnet devices.

State Id

Enter the State Id for which you want to set an alarm or fault alarm.

Is alarm value

Select Yes or No to assign an alarm to the State Id. If you select
Yes, select No for Is fault value.

Is fault value

Select Yes or No to assign a fault alarm to the State Id. If you
select Yes, select No for Is alarm value.
Click to add an alarm or fault State Id to the list of alarm and fault
values.
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Property

Description
Click to open the Properties dialog box where you can edit the
alarm or fault configuration for a selected State Id. For more
information, see section 81.62 “BACnet Multistate Alarm Properties
Dialog Box” on page 3069.
Click to remove the State Id from the list of alarm or fault values.

Alarm message
Reset message
Fault message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the
BACnet notification.
For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.87

BACnet Multistate Value Properties
(Generic) – Command Tab
Use the Command tab to enter a value for the Relinquish default and to view the
priority array for the multistate value. For more information, see section 77.1
“BACnet Command Priorities” on page 2849.

Figure: Command tab

Table: Command Tab
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Property

Description

Relinquish
default

Enter the value to be used by the Value property when all values in the
priority array are set to Null.

Active
command
priority

Specifies the priority level (1-16) currently controlling the present value.
The present value is the highest priority with a non-Null value.
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Property

Description

Priority x

Enter a priority value or Null.
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81.88

BACnet Accumulator Properties
(Generic) – Basic Tab
Use the Basic tab to view the BACnet accumulator properties for an external
device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Displays the number of input pulses that accumulated since the most
recent write to the Value set property. Values can include a number
between 0 and the value of the Maximum value property.

Status flags

Displays the condition or status of the point.

Out of service

Displays True if Value cannot be changed by software programs
that are local to the BACnet device where the value resides.

Reliability

Displays the reliablity of the Value property, or the reliability of the
operation of the input represented by the accumulator.
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Property

Description

Event state

Displays the active event state of the object if the object supports
Intrinsic Alarming. Displays normal if the object does not support
Intrinsic Alarming.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured
for an object. For more information, see the Alarm States topic on
WebHelp.

Value change
time

Displays the date and time of the most recent write to the Value
change property or Value set property.

Value before
change

Displays the value of the Value property before a write to the Value
before change property or Value set property occurred.

Value set

Displays the value of the Value property when a write to the Value
set property last occurred.

Maximum value

Enter the highest value that can be reliably derived for the Value
property.

Device type

Type a description of the device that is either connected to or
represented by the object. For example, the text could describe the
type of sensor connected to an analog input or the type of sensor
represented by an accumulator.
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81.89

BACnet Accumulator Properties
(Generic) – Advanced Tab
Use the Advanced tab to view the BACnet identification properties and change the
BACnet name. You can also view and configure the Intrinsic Alarm properties.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Time delay (s)

Enter the minimum number of seconds that Pulse rate is required
to remain outside of the range specified by the Upper limit and
Lower limit before a to-off-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select one or more flags to enable the reporting of to-off-normal,
to-fault, and to-normal events.

Upper limit

Enter a value that Pulse rate is required to exceed before an an
event is generated.

Lower limit

Enter a value that Pulse rate is required to fall below before an an
event is generated.

Limit monitoring
interval (s)

Enter the number of seconds during which the value of the Pulse
rate can be determined.

Limit enable

Select one or more flags to enable the reporting of off-normal events
and the return to to-normal events based on the lower limit value or
upper limit value.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Pulse rate

Displays the number of input pulses received during the time
specified by the Limit monitoring interval.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.89 BACnet Accumulator Properties (Generic) – Advanced Tab

Continued
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Property

Description

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.
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81.90

BACnet Averaging Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the averaging properties for an external
BACnet device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Average value

Displays the average value of the samples currently stored in the
buffer window.
Displays NaN following a device restart, or until a sample is taken.
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Continued
Property

Description

Variance value

Displays the variance value of the samples currently stored in the
buffer window.
Displays NaN following a device restart, or until a sample is taken.

Minimum value

Displays the minimum value of the samples currently stored in the
buffer window.
Displays INF following a device restart, or until a sample is taken.

Minimum value
timestamp

Displays the date and time when the Minimum value was sampled.

Maximum value

Displays the maximum value of the samples currently stored in the
buffer window.
Displays -INF following a device restart, or until a sample is taken.

Maximum value
timestamp

Displays the date and time when the Maximum value was
sampled.

Attempted
samples

Displays the number of samples that have been attempted to be
collected within the Windows interval time period.
Displays 0 following a device restart, or until a sample is taken.

Valid samples

Displays the number of samples that have been collected within the
Windows interval time period.
Displays 0 following a device restart, or until a sample is taken.

Object property
reference

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.
The value of the property is sampled within the Windows interval
time period.

Window interval

Enter the number of seconds during which the values for the
Minimum value, Maximum value, and Average value are
calculated.

Window samples

Enter a number greater than zero to indicate how many samples you
want taken within the Windows interval time period.

Certain object properties may display values representing “Not a Number”, positive
infinity, or negative infinity. For more information, see the Floating Point Values NaN,
INF, and –INF topic on WebHelp.
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81.91

BACnet Averaging Properties
(Generic) – Advanced Tab
Use the Advanced tab to view the BACnet identification properties of the
averaging object, and change the BACnet name.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties, behaviors, or
requirements.
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81.92

BACnet Command Properties
(Generic) – Basic Tab
Use the Basic tab to enter a number that specifies an action list to be run by the
BACnet Command. You can also view the write status of the action list.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Enter the number that specifies an action list to be run by the BACnet
Command.

In process

Displays True when the action list is being processed.

All writes
successful

Displays True when the actions in the actions list successfully
complete.

The Action property does not display and is not configurable in this version of
Building Operation. However, you can enter a number that specifies an action list
that was configured by a workstation that supports the Action property.
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81.93

BACnet Command Properties
(Generic) – Advanced Tab
Use the Advanced tab to view the BACnet identification (generic) properties and,
optionally, change the BACnet name.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties, behaviors, or
requirements.
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81.94

BACnet Load Control Properties
(Generic) – Basic Tab
Use the Basic tab to view the properties of a Load Control object in an external
device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Displays the load shedding states of the load control object.

Status flags

Displays the condition or status of the object. When checked, the
flag indicates one or more of the following states:
• In alarm: Indicates that Event state has a condition other
than Normal.
• Fault: Indicates that the Reliability property has a value other
than no-fault-detected.
• Overridden: Indicates that a manual override on the device
has been set.
• Out of service: Remains unchecked.

State description Displays text that explains the shedding state.
Reliability
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Displays the reliablity of the Value property.
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Continued
Property

Description

Event state

Displays Normal or Fault to indicate the active event state of the
object when Intrinsic alarming is supported by the object and is
configured.
Also displays Normal when the object does not support Intrinsic
alarming.

Alarm state

Technical
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Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured
for an object. For more information, see the Alarm States topic on
WebHelp.
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81.95

BACnet Load Control Properties
(Generic) – Advanced Tab
Use the Advanced tab to view the BACnet identification properties, or change the
BACnet name. You can also view and configure the Intrinsic Alarm properties.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.
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Continued
Property

Description

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.

Time delay (s)

Enter the minimum number of seconds that the state in the Value
property is required to be before a to-off-normal or to-normal event is
generated.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select one or more flags to enable the reporting of to-off-normal,
to-fault, and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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81.96

BACnet Pulse Converter Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the properties of a Pulse Converter object
in an external device.

Figure: Basic tab
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81.96 BACnet Pulse Converter Properties (Generic) – Basic Tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or Enterprise
Server.

Value

Displays the value of the measured input.

Count

Displays the number of the input pulses derived from an input or the
value of the property refrenced by the Input reference.

Update time

Displays the date and time of the most recent change to the Count
property as a result of an accumulation of input pulses. If a change to
Count has not occurred, the date and time display wildcard values.

Count change
time

Displays the date and time of the most recent write to the Adjust value
property. If a write to the Adjust value property has not occurred, the
date and time display wildcard values.

Count before
change

Displays the value of the Count property before the most recent write to
the Adjust value property and the properties related to Adjust value.

Status flags

Displays the condition or status of the object.

Out of service

Displays False when the input is in service.

Reliability

Displays a value that indicates the reliablity of the Value property, the
Count property, or both properties. Also, indicates the reliability of the
operation of the input. The property displays one of the following values:
• no-fault-detected
• no sensor
• over range
• under range
• open loop
• shorted loop
• unreliable-other
• configuration error

Event state

Displays Normal or Fault to indicate the active event state of the object
when Intrinsic alarming is supported by the object and is configured.
Also displays Normal when the object does not support Intrinsic
alarming.

Alarm state
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Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on WebHelp.
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Continued
Property

Description

Input
reference

Choose the method for referencing the input that you want to measure:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

Scale factor

Displays the value used to compute the Value property.

Adjust value

View the value that adjusts the Value property and the Count property.
When a value is written to Adjust value, the following operations occur:
• The value of the Count before change property displays the
value of Count.
• The value of Count changes based on the following calculation:
– Divide the value of Adjust value by the value of Scale
factor.
– Disregard the remainder.
– Decrease the value of Count by the resulting value.
• The Count change time property displays the date and time of
the completion of the operations.
• The Value property is updated.
Displays 0 if no value has ever been written to Adjust value.
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COV
increment

Enter the minimum change in the Value property that causes a COV
notification to be sent.

COV period

Displays the amount of time in seconds between COV notifications.
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81.97

BACnet Pulse Converter Properties
(Generic) – Advanced Tab
Use the Advanced tab to view the BACnet identification properties and, optionally,
change the BACnet name. You can also view and configure the Intrinsic Alarm
properties.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Time delay (s)

Enter the minimum number of seconds that the Value property is
required to remain outside of the range specified by the Upper limit
and Lower limit before a to-off-normal event is generated.
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Continued
Property

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select whether you want to report the event as an alarm or event in
WorkStation.

Event enable

Select one or more flags to enable the reporting of to-off-normal,
to-fault, and to-normal events.

Upper limit

Enter a value that the Value property is required to exceed before an
an event is generated. The Value property is required to exceed the
Upper limit value for the minimum time specified in the Time
delay (s) property.

Lower limit

Enter a value that the Value property is required to fall below before
an an event is generated. The Value property is required to fall
below the Lower limit value for the minimum time specified in the
Time delay (s) property.

Deadband

Enter the deadband which is the range the value must stay within
before a to-normal event is generated.

Limit enable

Select one or more flags to enable the reporting of off-normal events
and the return to to-normal events based on the lower limit value or
upper limit value.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.
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Continued
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Property

Description

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.

To-off-normal
time

Displays the BACnet timestamp of the last to-off-normal transition.

To-fault time

Displays the BACnet timestamp of the last to-fault transition.

To-normal time

Displays the BACnet timestamp of the last to-normal transition.

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.98 BACnet Notification Properties – Basic Tab

81.98

BACnet Notification Properties – Basic
Tab
Use the Basic tab to view the number assigned to a BACnet notification.

Figure: Basic tab

Table: Basic Tab
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Property

Description

BACnet
notification

Displays the number of the BACnet notification, which is the same as the
instance number of the object.
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81.99

BACnet Notification Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name of a notification.

Figure: Advanced tab

Table: Advanced Tab

Technical
3148

Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.
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81.100

BACnet Notification Properties
(Generic) – Basic Tab
Use the Basic tab to view the number assigned to a BACnet notification object in
an external device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

BACnet
notification

Displays the number of the BACnet notification, which is the same as
the instance number of the object.
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81.101

BACnet Notification Properties
(Generic) – Advanced Tab
Use the Advanced tab to view the BACnet identification properties of the
notification (generic), and optionally, change the BACnet name.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties, behaviors, or
requirements.
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81.102

BACnet Notification – Basic Settings
Tab
Use the Basic Settings tab to view the name and object type of the notification,
and to type a description for the notification.

Figure: Basic Settings tab

Table: Basic Settings Tab
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Property

Description

Alarm type

Displays the type of the alarm object.

Name

Displays the name of the alarm object.

Description

Type a description that describes the alarm object.
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81.103

BACnet Notification – Presentation Tab
Use the Presentation tab to enter an alarm category and to select the type of alert
for a triggered alarm.

Figure: Presentation tab

Table: Presentation Tab
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Property

Description

Category

Enter the category that the alarm belongs to.

Flashing alert

Select to make the alarm row flash in the Alarms pane and Alarm Views
when the alarm is triggered.

Audible alert

Select to make the alert audible when the alarm is triggered.
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81.104

BACnet Notification – User Action Tab
Use the User Action tab to configure what you want the operator to do when
responding to a triggered alarm.

Figure: User Action tab

Table: User Action Tab
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Property

Description

Cause note group

Enter the cause note group that is used by the alarm.

Action note group

Enter the action note group that is used by the alarm.

Checklist

Enter the checklist that belongs to the alarm.

When
acknowledging an
alarm

Select what actions the user has to perform when acknowledging
an alarm.

Required user
actions

Select what actions the user has to perform when any of the
listed events occur.
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81.105

BACnet Notification – Attachment Tab
Use the Attachment tab to connect an object to the notification, such as a report
or chart. The attached object displays when the alarm is triggered.

Figure: Attachment tab

Table: Attachment Tab
Property

Description
Click to add the attachment to the alarm.
Click to remove the attachment.
Click to open the attachment that is selected in the attachment list.

Technical
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Type

Displays the object type of the attachment.

Name

Displays the name of the attachment.

Display on
alarm

Select to display the attachment when the alarm is triggered.

Path

Displays the path to the attachment in the System Tree.
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81.106

BACnet Notification – Device Recipient
Rules Tab
Use the Device Recipient Rules tab to set the priority for sending the notification
when an event state occurs, and to define whether an acknowledgement is
required. You also use the tab to add one or more device recipients to the
notification.

Figure: Device Recipient Rules tab

Table: Device Recipient Rules Tab
Property

Description

Priority to off normal Enter the priority for sending the notification when a to-offnormal event state occurs. The lower the number, the higher the
priority, for example, 1 assigns a high priority for sending the
notification.
Priority to fault

Enter the priority for sending the notification when a to-fault
event state occurs. The lower the number, the higher the priority,
for example, 1 assigns a high priority for sending the notification.

Priority to normal

Enter the priority for sending the notification when a to-normal
event state occurs. The lower the number, the higher the priority,
for example, 1 assigns a high priority for sending the notification.

Acknowledgement
required

Select one or more event states to specify whether an
acknowledgement of the notification is required when the event
state occurs. This property may be supported in third party
BACnet devices, but is not supported by Building Operation
BACnet devices.
Click to open the Device Recipient Rule dialog box where you
define a device recipient for the notification. For more information,
see section 81.107 “BACnet Notification – Device Recipient Rule
Dialog Box” on page 3155.
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Continued
Property

Description
Click to open the Device Recipient Rule dialog box where you
modify the device recipient rules. For more information, see
section 81.107 “BACnet Notification – Device Recipient Rule
Dialog Box” on page 3155.
Click to remove a selected device recipient from the list.

Name

Technical
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Indicates the devices that are receiving the notification.
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81.107

BACnet Notification – Device Recipient
Rule Dialog Box
Use the Device Recipient Rule dialog box to define a device recipient for a
BACnet notification, or to edit the properties of a device recipient.

Figure: Device recipient rule dialog box
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81.107 BACnet Notification – Device Recipient Rule Dialog Box

Table: Device Recipient Rule Dialog Box
Property

Description

Process
identifier

Enter the process Id of the device recipient. This property may be
supported in third party BACnet devices but is not used by Building
Operation BACnet devices.

Confirmed
notifications

Select Yes to send notifications using the ConfirmedEventNotification
Service, which controls notifications from a configured device. When in
alarm, the device notifies the device recipient that an event occurred and
requires a confirmation that the device recipient received the event
notification.
Select No to send notifications using the UnconfirmedEventNotification
Service, which also controls notifications from a configured device.
When in alarm, the device notifies the device recipient that an event
occurred but does not require confirmation that the device recipient
received the event notification.
The Confirmed notifications property does not control or affect
alarm acknowledgements by an operator.

Transitions

Displays whether to send to-off-normal, to-fault, or to-normal
transitions.

All day

Select if you want notifications to be generated for a 24 hour period. Use
Start time and End time if you do not select All day.

Start time

Enter the start time for sending notifications. Use Start time and End
time if you did not select All day.

End time

Enter the end time for sending notifications. Use Start time and End
time if you did not select All day.

Valid Days

Configure the time settings for generating notifications, for example,
select All day if you want the notifications to be sent over a 24-hour
period.
After choosing either All day or entering a Start time and End time,
select one or more valid days.

Recipient type Choose one of the following methods:
• Click Reference to identify the device recipient by referencing the
device. This selection activates the Recipient device object
reference box.
• Click Device ID to identify the device recipient by the instance
number of the BACnet device. This selection activates the
Recipient device identifier box.
• Click MAC address to identify the device recipient by the network
address of the device. Use a MAC network address when you want
to identify objects not included in the Building Operation database.
This selection activates the Network ID box.

Technical
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Recipient
device object
reference

Enter the reference to a BACnet device or the local BACnet Interface.
Use this property if you clicked Reference for the Recipient type.

Recipient
device
identifier

Enter the BACnet instance number of the device to specify the device
recipient. Use this property if you clicked Device Id for the Recipient
type.
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Continued
Property

Description

Network ID

If you select MAC Address for the Recipient type, follow these steps
to configure the network:
• Type a specific Network ID number, such as 25. Then, enter the
MAC address of the device recipient.
• In the MAC address box, point to
and click Global
broadcast to send messages to all networks in the BACnet
system.
• In the MAC address box, point to
and click Local Network
to send a message to a device on a directly connected network (IP
or MS/TP). Then, enter the MAC address of the device recipient.
Local Network, the initial IP network created by the BACnet Interface
wizard, has a network ID of zero (0). Any additional installed IP network
must have a distinct ID number in the BACnet network.

MAC address

Click one of the following options:
• MS/TP: Enter a number between 0 and 254 for the MS/TP
address of the device recipient on the network.
• IP: Enter the IP address and port number for the IP address of the
device recipient.
• Raw (hexadecimal): Enter the hexadecimal address for the
device recipient.
• Broadcast: Click to send the message to all devices on the
network.
Then enter the appropriate MAC address (or click Broadcast).
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81.108

BACnet Alarm Properties – Basic Tab
Use the Basic tab to view or configure the properties of a BACnet alarm.

Figure: Basic tab

Table: Basic Tab
Property

Description

Event state

Displays the active state of the alarm. Event state can display one
of the following states depending on the monitored variable and the
parameters of the alarm:
• Normal
• Off normal
• Fault

Technical
3160

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured
for an object. For more information, see the Alarm States topic on
WebHelp.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal transitions have been received.
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Continued
Property

Description

To-off-normal
time

Displays the date and time that the last event notification for a tooff-normal event was generated.

To-fault time

Displays the date and time that the last event notification for a tofault event was generated.

To-normal time

Displays the date and time that the last event notification for a tonormal event was generated.

Reliability

Displays the reliability of the point.

Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable
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Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.
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Continued
Property

Description

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.109

BACnet Alarm Properties – Advanced
Tab
Use the Advanced tab to view the BACnet identification properties, and change
the BACnet name of an alarm.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.
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81.110

BACnet Alarm Properties (Generic) –
Basic Tab
Use the Basic tab to view and configure the properties of an alarm object in an
external device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

Event state

Displays the active state of the alarm. Event state can display one
of the following states depending on the monitored variable and the
parameters of the alarm:
• Normal
• Off normal
• Fault
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Continued
Property

Description

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured
for an object. For more information, see the Alarm States topic on
WebHelp.

Acknowledged
transitions

Displays whether to-off-normal, to-fault, or to-normal
transitions have been acknowledged.

To-off-normal
time

Displays the date and time that the last event notification for a tooff-normal event was generated.

To-fault time

Displays the date and time that the last event notification for a tofault event was generated.

To-normal time

Displays the date and time that the last event notification for a tonormal event was generated.

Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation
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Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.
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Continued
Property

Description

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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81.111

BACnet Alarm Properties (Generic) –
Advanced Tab
Use the Advanced tab to view or configure the properties of an alarm object in an
external device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether to-off-normal, to-fault, or to-normal
transitions have been acknowledged.

To-off-normal
time

Displays the date and time that the last event notification for a tooff-normal event was generated.

To-fault time

Displays the date and time that the last event notification for a tofault event was generated.

To-normal time

Displays the date and time that the last event notification for a tonormal event was generated.
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81.112

BACnet Buffer Ready Alarm – Alarm
Trigger Tab
Use the Alarm Trigger tab to configure a BACnet buffer ready alarm to be used
with a trend log in a BACnet device. A buffer ready alarm is triggered when the
number of records as specified by the Notification threshold property has been
entered into the trend log since trending first started, or a BACnet notfication had
been sent.

Figure: Alarm Trigger tab

Table: Alarm Trigger Tab
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Component

Description

Alarm type

Select Buffer ready.

Notification
threshold

Enter the number of records that you want the trend log to collect before
a buffer ready event is generated.

Last notify
record

Displays the read-only integer that specifies the last sequence number
when a buffer ready alarm was sent.
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Continued
Component

Description

Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

BACnet
notification

Choose the method for referencing the input that you want to measure:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.
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81.113

BACnet Change of State Alarm – Alarm
Trigger Tab
Use the Alarm Trigger tab to configure a BACnet change of state alarm to
monitor the state changes of selected properties for digital and multistate objects in
a BACnet device.

Figure: Alarm Trigger tab

Table: Alarm Trigger Tab
Component

Description

Alarm type

Select Change of state.

Time delay (s)

Enter the number of seconds required for the alarm conditions to last
before the BACnet Notification is sent.

Alarm Trigger
Type

Click Active/Inactive if you want to specify one or both states as alarm
triggers.
Click Value list if you want to specify a value or a list of values to be
compared to the Monitored variable before a change of state occurs,
and an alarm is triggered.

Trigger alarm Select the state that indicates when to trigger the alarm if you selected
when signal is Active/Inactive for Alarm Trigger Type.
equal to
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Continued
Component

Description

Value list

In the equals to box, do one or both of the following actions if you
selected Value list for Alarm Trigger Type:
• Enter the value to be compared to the Monitored variable before
a change of state occurs, and an alarm is triggered.
• Click Add row to enter another value.
Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server. When
selected, only the Path field becomes editable. All the other fields
become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and System
References” on page 2562.
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81.114

BACnet Change of Value Alarm – Alarm
Trigger Tab
Use the Alarm Trigger tab to configure a BACnet change of value alarm to
generate an alarm that signals a to-normal transition. The change of value alarm
occurs under the following conditions:
• The absolute value of the Monitored variable changes by an amount that is
equal to or greater than the value displayed in the Increment property.
• The condition remains constant for the number of seconds that are specified in
the Time delay (s) property.

Figure: Alarm Trigger tab

Table: Alarm Trigger Tab
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Component

Description

Alarm type

Select Change of value.

Increment

Enter the minimum change in the Monitored variable property that
causes the alarm to be triggered and a notification to be sent. The
default increment is .10.

Time delay (s)

Enter the number of seconds required for the alarm conditions to last
before the BACnet Notification is sent.
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Continued
Component

Description

Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server. When
selected, only the Path field becomes editable. All the other fields
become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and System
References” on page 2562.
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81.115

BACnet Floating Limit Alarm – Alarm
Trigger Tab
Use the Alarm Trigger tab to configure a floating limit alarm. The alarm is
triggered when the Monitored variable exceeds or falls below the range of values as
determined by the current value of the Setpoint reference, Upper deivation limit,
Lower deviation limit, and the Deadband.

Figure: Alarm Trigger tab

Table: Alarm Trigger Tab
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Component

Description

Alarm type

Select Floating limit.
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Continued
Component

Description

Upper
Enter the value to be used to calculate the range of values that determine
deviation limit whether the Monitored variable deviates from the range of values.
The Setpoint reference, Upper deviation limit, Lower deviation
limit, and Deadband are used to calculate the range of values. An
alarm is triggered when the Monitored varible deviates from the range
of values.
Lower
Enter the value to be used to calculate the range of values that determine
deviation limit whether the Monitored variable deviates from the range of values.
The Setpoint reference, Upper deviation limit, Lower deviation
limit, and Deadband are used to calculate the range of values. An
alarm is triggered when the Monitored variable deviates from the
range of values.
Deadband

Enter the value to be used to calculate the range of values that determine
whether the Monitored variable deviates from the range of values.
The Setpoint reference, Upper deviation limit, Lower deviation
limit, and Deadband are used to calculate the range of values. An
alarm is triggered when the Monitored variable deviates from the
range of values.

Time delay (s)

Enter the number of seconds required for the alarm conditions to last
before the BACnet Notification is sent.

Setpoint
reference

Choose the method for referencing the setpoint that you want to monitor
for this event:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.
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Continued
Component

Description

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server. When
selected, only the Path field becomes editable. All the other fields
become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and System
References” on page 2562.
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81.116

BACnet Out of Range Alarm – Alarm
Trigger Tab
Use the Alarm Trigger tab to configure a BACnet out of range alarm. The alarm is
triggered when the Monitored variable exceeds or falls below a range of values
defined by the Upper limit and Lower limit, and remains at that value for the number
of seconds as defined by the Time delay property.

Figure: Alarm Trigger tab

Table: Alarm Trigger Tab
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Component

Description

Alarm type

Select Out of range.

Upper limit

Enter a value that the Monitored variable is required to exceed in
order to trigger the alarm and generate the event notification.

Lower limit

Enter a value that the Monitored variable is required to fall below in
order to trigger the alarm and generate the event notification.
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Continued
Component

Description

Deadband

Enter a value used to calculate when the out of range alarm can clear.
The following algorithm is used for the calculation:
• The value of the Monitored variable is less than the Upper limit
minus the Deadband and remains there for the number of
seconds as specified by the Time delay (s) property.
• The value of the Monitored variable is greater than the Lower
limit plus the Deadband and remains there for the number of
seconds as specified by the Time delay (s) property.

Time delay

Enter the number of seconds required for the alarm conditions to last
before the BACnet Notification is sent.

Monitored
variable

Choose the method for referencing the property that you want to
monitor:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server. When
selected, only the Path field becomes editable. All the other fields
become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and System
References” on page 2562.
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81.117

BACnet Calendar Properties – Basic Tab
Use the Basic tab to delete outdated BACnet calendar events, or to select a lead
calendar if you are creating a shadow of the lead calendar.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays True when the current date matches a date specified in the
calendar entry in the Date List.

Remove past
events

Select True to enable the deletion of events that are older than 60 days.

Lead object

Select a lead calendar if you are creating a shadow calendar.
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81.118

BACnet Calendar Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name of the calendar.

Figure: Advanced tab

Table: Advanced tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.
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81.119

BACnet Calendar Properties (Generic) –
Basic Tab
Use the Basic tab to view the properties of an external BACnet calendar. The
properties that display on the tab are device-dependent. Some properties may not
appear if they are not supported by the device or Building Operation.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or Enterprise
Server.

Value

Displays True when the current date matches a date specified in the
calendar entry in the Date List.
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81.120

BACnet Calendar Properties (Generic) –
Advanced Tab
Use the Advanced tab to view the BACnet identification properties, and change
the BACnet name of the calendar (generic).

Figure: Advanced tab

Table: Advanced tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties, behaviors, or
requirements.
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81 BACnet Device User Interface
81.121 BACnet Schedule Properties – Basic Tab

81.121

BACnet Schedule Properties – Basic
Tab
Use the Basic tab to view or configure the properties of a BACnet schedule.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the current value of the property referenced by the schedule.
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81 BACnet Device User Interface
81.121 BACnet Schedule Properties – Basic Tab

Continued
Property

Description

Reliability

Displays one of the following values to indicate whether the properties of
the schedule are in a consistent state:
• no-fault-detected
• configuration error
• unreliable - other

Status flags

Displays the condition or status of the BACnet schedule. When checked,
the schedule is in one or more of the following states:
• In alarm: This flag remains unchecked.
• Fault: Indicates that the Reliability property has a value other than
no-fault-detected.
• Overridden: Indicates that a mechanism of the BACnet device
has overridden the schedule, and that the Value property cannot be
changed by a BACnet service. This property is not implemented.
• Out of service: Indicates that the Out of service property is True.

Previous
transition
time

Displays the date and time when the Value property most recently
changed.

Time since
previous
transition
(min)

Displays the elapsed time in minutes or parts since the Value property
last changed.

Next
transition
value

Displays the value of the referenced property after the next transition.

Next
transition
time

Displays the date and time when the Value property will change next.

Time to next
transition
(min)

Displays the amount of time in minutes before the value changes.

Following
transition
value

Displays the Value after two changes.

Following
transition
time

Displays the date and time when the Following transition value
appears.

Time to
following
transition
(min)

Displays the amount of time in minutes before Value changes to the
Following transition value.

Out of service

Displays True when the schedule is not in service.
Displays False when the schedule iot in service.
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81.121 BACnet Schedule Properties – Basic Tab

Continued
Property

Description

Remove past
events

Select True to enable the system to delete BACnet special events older
than 72 hours. This may become necessary to conserve memory in
controllers on your system when updated exception schedules are sent
to controllers.

Effective
period

Enter the time and date to specify when you want the schedule to be
operational.

Priority for
writing

Enter a priority for writing the referenced properties. 1 is the highest
priority and 16 is the lowest.

Object
property
references

Click
to add a new object property reference controlled by the
schedule.
For more information, see section 81.125 “Add Reference Dialog Box”
on page 3189.
Click
to edit the displayed properties in the Object property
references box.
Click
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to delete the object property reference.

Default value

Enter the value to be used when no other scheduled value is in effect.

Lead object

Select a schedule to act as the lead schedule.
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81.122 BACnet Schedule Properties – Advanced Tab

81.122

BACnet Schedule Properties –
Advanced Tab
Use the Advanced tab to view or change the BACnet name of a schedule.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.
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81 BACnet Device User Interface
81.123 BACnet Schedule Properties (Generic) – Basic Tab

81.123

BACnet Schedule Properties (Generic) –
Basic Tab
Use the Basic tab to view and configure the properties of a BACnet schedule in an
external device. The properties that display on the tab are device-dependent. Some
properties may not appear if they are not supported by the device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or Enterprise
Server.
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81 BACnet Device User Interface
81.123 BACnet Schedule Properties (Generic) – Basic Tab

Continued
Property

Description

Reliability

Displays one of the following values to indicate whether the properties of
the schedule are in a consistent state:
• no-fault-detected
• configuration error
• unreliable - other

Status flags

Displays the condition or status of the BACnet schedule. When checked,
the schedule is in one or more of the following states:
• In alarm: This flag remains unchecked.
• Fault: Indicates that the Reliability property has a value other than
no-fault-detected.
• Overridden: Indicates that a mechanism of the BACnet device
has overridden the schedule, and that the Value property cannot be
changed by a BACnet service. This property is not implemented.
• Out of service: Indicates that the Out of service property is True.

Value

Displays the current value of the property referenced by the schedule.

Previous
transition
time

Displays the date and time when the Value property most recently
changed.

Time since
previous
transition
(min)

Displays the elapsed time in minutes or parts since the Value property
last changed.

Next
transition
value

Displays the value of the referenced property after the next transition.

Next
transition
time

Displays the date and time when the Value property will change next.

Time to next
transition
(min)

Displays the amount of time in minutes before the value changes.

Following
transition
value

Displays the Value after two changes.

Following
transition
time

Displays the date and time when the Following transition value
appears.

Time to
following
transition
(min)

Displays the amount of time in minutes before Value changes to the
Following transition value.

Out of service

Displays True when the schedule is not in service.
Displays False when the schedule iot in service.
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81.123 BACnet Schedule Properties (Generic) – Basic Tab

Continued
Property

Description

Effective
period

Enter the time and date to specify when you want the schedule to be
operational.

Priority for
writing

Enter a priority for writing the referenced properties. 1 is the highest
priority and 16 is the lowest.

Object
property
references

Click
to add a new object property reference controlled by the
schedule.
For more information, see section 81.125 “Add Reference Dialog Box”
on page 3189.
Click
to edit the displayed properties in the Object property
references box.
Click

Default value
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to delete the object property reference.

Enter the value to be used when no other scheduled value is in effect.
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81.124 BACnet Schedule Properties (Generic) – Advanced Tab

81.124

BACnet Schedule Properties (Generic) –
Advanced Tab
Use the Advanced tab to view the BACnet identification properties and change the
BACnet name of the schedule (generic).

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the device.

BACnet name

View the name of the BACnet object or type a new name to change the
name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties, behaviors, or
requirements.
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81 BACnet Device User Interface
81.125 Add Reference Dialog Box

81.125

Add Reference Dialog Box
Use the Add reference dialog box to create a new object property reference.

Figure: Add reference dialog box

Table: Add Reference Dialog Box
Component

Description

System reference Select this to define a path to define a path-based reference to an
object or property that is currently located on the server.
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BACnet
reference

Select this to define a reference that uses the elements of a property
value (Device instance number, Object type, or Object instance
number) to identify a BACnet object or property that is not currently
on the server but may be uploaded or imported to the server later.
You can also use this method to reference a BACnet object or
property on an external device.

Path

Enter the path to the reference on the file system.

Device instance
number

Type the device number associated with the device.

Object type

Select the object class of an object.

Object instance
number

Type the object instance number associated with the referenced
object.

Property

Enter the property identifier associated with the reference.
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81.126 BACnet Prerevision 4 Schedule Properties – Basic Tab

81.126

BACnet Prerevision 4 Schedule
Properties – Basic Tab
Use the Basic tab to view the properties of a BACnet Prerevision 4 schedule.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.

Value

Displays the value of the schedule.

Previous transition
time

Displays the date and time when the Value property most
recently changed. This proprietary property is only supported by
the b4020 controller.

Next transition time Displays the date and time for the next scheduled change to the
Value property. This proprietary property is only supported by the
b4020 controller.
Following transition Displays the date and time for a scheduled change to the Value
time
property subsequent to the date and time in the Next transition
time property. This proprietary property is only supported by the
b4020 controller.
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81 BACnet Device User Interface
81.127 BACnet Prerevision 4 Schedule Properties – Advanced Tab

81.127

BACnet Prerevision 4 Schedule
Properties – Advanced Tab
Use the Advanced tab to view the identification properties of a BACnet Prerevision
4 schedule.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.
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81.128 BACnet Prerevision 4 Schedule Properties – Configuration Tab

81.128

BACnet Prerevision 4 Schedule
Properties – Configuration Tab
Use the Configuration tab to configure a weekly BACnet Prerevision 4 schedule.
You can also configure an exception schedule.

Figure: Configuration tab
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81 BACnet Device User Interface
81.128 BACnet Prerevision 4 Schedule Properties – Configuration Tab

Table: Configuration Tab
Component

Description

Priority for
writing

Enter a number that indicates the priority for writing a value to the
referenced property. 1 is the highest and 16 is the lowest.

Object property
references

Click
to add a new object property reference controlled by the
schedule.
For more information, see section 81.125 “Add Reference Dialog
Box” on page 3189.
Click
to edit the displayed properties in the Object property
references box.
Click

to delete the object property reference.

Add (Settings)

Click to enter the referenced property of an object that you want to
schedule.

Edit (Settings)

Click to enter a different referenced property for a selected object.

Add (Effective
period)

Reserved for future use.

Edit (Effective
period)

Click to select the start date and end date for the schedule.

Add (Weekly
schedule)

Reserved for future use.

Edit (Weekly
schedule)

Click to create and configure a time and value pair for a selected day
of the week.

Add (Exception
schedule)

Click to create an exception schedule.

Edit (Exception
schedule)

Click to create and configure the time and value pair for a selected
exception schedule.

Remove (Exception Click to remove a selected exception schedule.
schedule)
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81.129 BACnet Prerevision 4 Schedule Properties - Weekly Schedule

81.129

BACnet Prerevision 4 Schedule
Properties - Weekly Schedule
Use the Basic tab of a day in a weekly schedule to modify a time and value pair.
From the Configuration tab of a Prerevision 4 schedule, you modify a Weekly
schedule by double-clicking on a day of the week to display the Properties dialog
box for the selected day.

Figure: Basic tab

Table: Basic Tab
Property

Description

Day of week

Displays the selected day of the week that you want to modify.
Click to create a time and value pair, such as an Enumerated Time Value
Pair.
Click to configure the properties of a time and value pair.
Click to remove a time and value pair from the schedule.
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81 BACnet Device User Interface
81.130 BACnet Prerevision 4 Schedule Properties - Active Inactive Time Value Pair

81.130

BACnet Prerevision 4 Schedule
Properties - Active Inactive Time Value
Pair
Building Operation does not provide a digital-specific version of an enumerated
schedule. Therefore, use a generic Enumerated Schedule to configure its object
property references with BACnet enumerated properties that include digital values
where Active = 1 and Inactive = 0.
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81.131 BACnet Prerevision 4 Schedule Properties - Boolean Time Value Pair

81.131

BACnet Prerevision 4 Schedule
Properties - Boolean Time Value Pair
Use the Basic tab to configure the time and value pair for a property reference with
the boolean datatype of true or false.

Figure: Basic tab

Table: Edit Time Value Dialog Box
Component

Description

Hour

Enter the hour when you want the Object property reference set to
Value. Use the time format that matches your Windows regional
settings.
Select Any hour if you want the Object property reference set to
Value at all times.
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Minute

Enter a number to set the time for Value to be written to the property
reference.

Second

Enter a number to set the time for Value to be written to the property
reference.

Hundredths

Enter a number to set the time for Value to be written to the property
reference.

Value

Enter a value to write to the property reference at the scheduled time,
such as True.
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81.132 BACnet Prerevision 4 Schedule Properties - Enumerated Time Value Pair

81.132

BACnet Prerevision 4 Schedule
Properties - Enumerated Time Value
Pair
Use the Basic tab to configure the time and value pair for a property reference with
a datatype of enumerated.

Figure: Basic tab

Table: Basic Tab
Property

Description

Hour

Enter the hour when you want the Object property reference set to
Value. Use the time format that matches your Windows regional
settings.
Select Any hour if you want the Object property reference set to
Value at all times.
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Minute

Enter a number to set the time for Value to be written to the property
reference.

Second

Enter a number to set the time for Value to be written to the property
reference.

Hundredths

Enter a number to set the time for Value to be written to the property
reference.

Value

Enter a value with the datatype of enumerated to be written to the
property reference at the scheduled time.
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81.133 BACnet Prerevision 4 Schedule Properties - Integer Time Value Pair

81.133

BACnet Prerevision 4 Schedule
Properties - Integer Time Value Pair
Use the Basic tab to configure the time and value pair for a property reference with
a datatype of integer.

Figure: Basic tab

Table: Basic Tab
Property

Description

Hour

Enter the hour when you want the Object property reference set to
Value. Use the time format that matches your Windows regional
settings.
Select Any hour if you want the Object property reference set to
Value at all times.
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Minute

Enter a number to set the time for Value to be written to the property
reference.

Second

Enter a number to set the time for Value to be written to the property
reference.

Hundredths

Enter a number to set the time for Value to be written to the property
reference.

Value

Enter a value with the datatype of integer to be written to the property
reference at the scheduled time.
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81.134 BACnet Prerevision 4 Schedule Properties - On Off Time Value Pair

81.134

BACnet Prerevision 4 Schedule
Properties - On Off Time Value Pair
Use the Basic tab to configure the time and value pair for a property reference with
a value of on or off.

Figure: Basic tab

Table: Basic Tab
Property

Description

Hour

Enter the hour when you want the Object property reference set to
Value. Use the time format that matches your Windows regional
settings.
Select Any hour if you want the Object property reference set to
Value at all times.
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Minute

Enter a number to set the time for Value to be written to the property
reference.

Second

Enter a number to set the time for Value to be written to the property
reference.

Hundredths

Enter a number to set the time for Value to be written to the property
reference.

Value

Select On or Off to write the value to the property reference at the
scheduled time.
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81.135 BACnet Prerevision 4 Schedule Properties - Real Time Value Pair

81.135

BACnet Prerevision 4 Schedule
Properties - Real Time Value Pair
Use the Basic tab to configure the time and value pair for a property reference with
a datatype of real.

Figure: Basic tab

Table: Basic Tab
Property

Description

Hour

Enter the hour when you want the Object property reference set to
Value. Use the time format that matches your Windows regional
settings.
Select Any hour if you want the Object property reference set to
Value at all times.

Technical
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Minute

Enter a number to set the time for Value to be written to the property
reference.

Second

Enter a number to set the time for Value to be written to the property
reference.

Hundredths

Enter a number to set the time for Value to be written to the property
reference.

Value

Enter a value with the datatype of real to be written to the property
reference at the scheduled time.
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81.136 BACnet Prerevision 4 Schedule Properties - Unsigned Time Value Pair

81.136

BACnet Prerevision 4 Schedule
Properties - Unsigned Time Value Pair
Use the Basic tab to configure the time and value pair for a property reference with
a datatype of unsigned.

Figure: Basic tab

Table: Basic Tab
Property

Description

Hour

Enter the hour when you want the Object property reference set to
Value. Use the time format that matches your Windows regional
settings.
Select Any hour if you want the Object property reference set to
Value at all times.
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Minute

Enter a number to set the time for Value to be written to the property
reference.

Second

Enter a number to set the time for Value to be written to the property
reference.

Hundredths

Enter a number to set the time for Value to be written to the property
reference.

Value

Enter a value with the datatype of unsigned to be written to the property
reference at the scheduled time.
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81 BACnet Device User Interface
81.137 BACnet Prerevision 4 Schedule Properties - Exception Event

81.137

BACnet Prerevision 4 Schedule
Properties - Exception Event
Use the Basic tab to create and configure an exception event.

Figure: Basic tab

Table: Basic Tab
Property

Description

Exception
name

Type a name for the exception event.

Exception
priority

Enter a number to specify the priority for using the exception event in
relation to other exception events.
1 is the highest priority and 16 is the lowest priority.

Period type

Select a date option to specify when to use the exception event, such as
Date Range.

Period object

Enter the criteria for the date option selected in the Period type
property.
Click to create an exception event.
Click to configure a selected exception event.
Click to remove a selected exception event.
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81.138 BACnet Exception Event Wizard – Naming the Object Page

81.138

BACnet Exception Event Wizard –
Naming the Object Page
Use the Naming the Object page to create an exception event for a BACnet
Prerevision 4 schedule.

Figure: Naming the Object page

Table: Naming the Object Page
Property

Description

Name

Type ES00001 if you are creating the first exception event.
Type ES00002 if you are creating a second exception event.
Increment the last digit each time you create an exception event.
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Location

Displays the path to the BACnet Prerevision 4 schedule.

Description

Type a description for the exception event.
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81.139 BACnet Trend Log Properties – Basic Tab

81.139

BACnet Trend Log Properties – Basic
Tab
Use the Basic tab to view and configure the properties of a BACnet trend log.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Record count

Displays the current number of records in the controller's log
buffer. Enter 0 to clear the log buffer.

Total record count

Displays the number of records that have been logged since you
created the Trend Log.
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81.139 BACnet Trend Log Properties – Basic Tab

Continued
Property

Description

Event state

Displays normal or fault to indicate the active event state of the
Trend Log. Displays normal if you have not configured intrinsic
reporting for the Trend Log.

Log enable

Select one of the following options:
• Select True to enable logging of the trended property.
• Select False to disable logging of the trended property.

Start time

Enter the date and time to start trending.

Stop time

Enter the date and time to stop trending.

Stop when full

Select one of the following options:
• Select True if you want trending to stop when the log buffer
reaches the maximum buffer size.
• Select False if you want trending to continue when the log
buffer reaches the maximum buffer size. When you select
False, and trending continues, the oldest record in the buffer
is overwritten, and the new reocrd is added when the
maximum Buffer size is reached. For example, suppose
the Buffer size is 10 records, and you select False. In this
scenario, record 11 is added to the buffer and overwrites
record 1.

Buffer size
Log device object
property

Enter the maximum number of records that can be stored in the
Trend Log buffer.
• System reference: Defines a path to a property or object
reference located on the server (including hosted objects, if
available). When selected, only the Path field becomes
editable. All the other fields become non-editable.
• BACnet reference: Using the BACnet standard method,
defines a path to a property or object reference located
anywhere on the network. When selected, the Device, Object
type, and Object instance fields become editable (except for
notification-class objects) and the Path field becomes noneditable.
• Path: Select the path to the reference on the file system.
• Device instance number: Type the device number
associated with the device.
• Object type: Select the object class of an object, such as
analog input.
• Object instance number: Type the object instance
number associated with the referenced object.
• Property: Enter the property identifier associated with the
variable.
The system automatically fills in the device, object type, and object
instance fields for either reference path, where available.
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81.139 BACnet Trend Log Properties – Basic Tab

Continued
Property

Description

Logging type

Select one of the following options:
• Select Change of Value if you want Building Operation to
add an entry to the Trend Log only when the value of the
monitored property changes. If you select Change of
Value, you also need to enter values for the following
properties:
– COV resubscription interval
– Log interval
• Select Interval if you want Building Operation to poll the
monitored property according to the time set in the Log
interval property, and then add the entry to the Trend Log.

Log interval(s)

Enter how often you want the Trend Log to poll for a value if you
selected Interval for Logging type. The frequency is days,
hours, minutes, seconds, hundredths of seconds.
Enter 0 for each interval if you selected Change of value instead
of Interval for Logging type.
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Delta

Enter a value to be used in determining that a change of value has
occurred.

COV resubscription
interval(s)

Enter the number of seconds to set the frequency of the
subscription renewals.
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81.140 BACnet Trend Log Properties – Advanced Tab

81.140

BACnet Trend Log Properties –
Advanced Tab
Use the Advanced tab to view the properties of a BACnet trend log and to
configure intrinsic reporting of a monitored property.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.

Technical
3209

81 BACnet Device User Interface
81.140 BACnet Trend Log Properties – Advanced Tab

Continued
Property

Description

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Records since
notification

Displays the number of records that have been logged since the
last BACnet event notification was sent, or since the
beginning of trending if a BACnet event notification has not
been sent.

Last notify record

Displays the number of the last record when a BACnet
notification was sent. For example, if a BACnet notification
was sent when the last trended record was 99, the number would
be 99.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal time

Displays the date and time of the last to-off-normal transition.

To-fault time

Displays the date and time of the last to-fault transition.

To-normal time

Displays the date and time of the last to-normal transition.

Notification
threshold

Enter the number of new records required to accumulate in the
Trend Log before BACnet devices are notified by the BACnet
notification. Set the number to equal 10% of the maximum
Buffer size.

BACnet notification Choose the method for referencing the intrinsic alarm object that
you want to use to generate event notifications:
• Select System reference to define a path-based reference
to an object or property that is currently located on the
server. When selected, only the Path field becomes editable.
All the other fields become non-editable.
• Select BACnet reference to define a reference that uses
the elements of a property value (Device instance number,
Object type, or Object instance number) to identify a BACnet
object or property that is not currently on the server but may
be uploaded or imported to the server later. You can also use
this method to reference a BACnet object or property on an
external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable
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Select the flags to enable the reporting of to-off-normal, tofault, and to-normal events.
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81 BACnet Device User Interface
81.141 BACnet Trend Log Properties (Generic) – Basic Tab

81.141

BACnet Trend Log Properties
(Generic) – Basic Tab
Use the Basic tab to view and configure the properties of a BACnet trend log
object in an external device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.

Record count

Displays the current number of records in the controller's log
buffer. Enter 0 to clear the log buffer.

Technical
3211

81 BACnet Device User Interface
81.141 BACnet Trend Log Properties (Generic) – Basic Tab

Continued
Property

Description

Total record count

Displays the number of records that have been logged since you
created the Trend Log.

Status flags

Displays the condition or status of the Trend Log. When checked,
the Trend Log is in one or more of the following states:
• In alarm: Indicates that Event state has a condition other
than Normal.
• Fault: Indicates that the Reliability property has a value
other than no-fault-detected.
• Overridden: The flag remains unchecked.
• Out of service: The flag remains unchecked.

Reliability

Displays no-fault-detected.

Event state

Displays normal or fault to indicate the active event state of the
Trend Log. Displays normal if you have not configured intrinsic
reporting for the Trend Log.

Log enable

Select one of the following options:
• Select True to enable logging of the trended property.
• Select False to disable logging of the trended property.

Start time

Enter the date and time to start trending.

Stop time

Enter the date and time to stop trending.

Stop when full

Select one of the following options:
• Select True if you want trending to stop when the log buffer
reaches the maximum buffer size.
• Select False if you want trending to continue when the log
buffer reaches the maximum buffer size. When you select
False, and trending continues, the oldest record in the buffer
is overwritten, and the new reocrd is added when the
maximum Buffer size is reached. For example, suppose
the Buffer size is 10 records, and you select False. In this
scenario, record 11 is added to the buffer and overwrites
record 1.

Buffer size
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Enter the maximum number of records that can be stored in the
Trend Log buffer.
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Continued
Property

Description

Log device object
property

Choose the method for referencing the property to be trended:
• Select System reference to define a path-based reference
to an object or property that is currently located on the
server.
• Select BACnet reference to define a path to a reference
that uses the elements of a property value (Device instance
number, Object type, or Object instance number) to identify a
BACnet object or property that is not currently on the server
but may be uploaded or imported to the server later. You can
also use this method to reference a BACnet object or
property on an external device.
The system automatically fills in the Device instance number,
Object type, or Object instance number for the reference path, if
available.

Logging type

Select one of the following options:
• Select Change of Value if you want Building Operation to
add an entry to the Trend Log only when the value of the
monitored property changes. If you select Change of
Value, you also need to enter values for the following
properties:
– COV resubscription interval
– Log interval
• Select Interval if you want Building Operation to poll the
monitored property according to the time set in the Log
interval property, and then add the entry to the Trend Log.

Log interval(s)

Enter how often you want the Trend Log to poll for a value if you
selected Interval for Logging type. The frequency is days,
hours, minutes, seconds, hundredths of seconds.
Enter 0 for each interval if you selected Change of value instead
of Interval for Logging type.

Delta

Enter a value to be used in determining that a change of value has
occurred.

COV resubscription
interval (s)

Enter the number of seconds to set the frequency of the
subscription renewals.

Align intervals

Displays one of the following values when the Trend Log supports
clock-aligned logging and the Logging type property is set to
COV:
• True: Indicates that clock-aligned logging is on. When
clock-aligned logging is on and the Log interval property is
set to a day, minute, hour, or second, then the start time of
trending is also aligned with the day, minute, hour, or second
of the Log interval property.
• False: Indicates that clock-aligned logging is off.
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Continued
Property

Description

Interval offset

Enter the offset in hundredths of seconds from the beginning of
the period specified for logging until the actual acquisition of a
record begins. The offset is the value of Interval offset minus the
value of the Log interval. For example, if the value of Interval offset
is 31 and the value of Log interval is 30, the offset is 1.
The Interval offset property is required for objects that support
clock-aligned logging. Therefore, use this property in conjunction
with the Align intervals property.

Trigger
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Reserved for future use.
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81.142

BACnet Trend Log Properties
(Generic) – Advanced Tab
Use the Advanced tab to view and configure the properties of a BACnet trend log
in an external device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the
device.
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Continued
Property

Description

BACnet name

View the name of the BACnet object or type a new name to
change the name.

BACnet type

Displays the type, which is always device.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, tofault, or to-normal transitions have been received.

To-off-normal time

Displays the date and time that the last event notification for a tooff-normal event was generated.

To-fault time

Displays the date and time that the last event notification for a tofault event was generated.

To-normal time

Displays the date and time that the last event notification for a tonormal event was generated.

BACnet notification Choose the method for referencing the intrinsic alarm object that
you want to use to generate event notifications:
• Select System reference to define a path-based reference
to an object or property that is currently located on the
server. When selected, only the Path field becomes editable.
All the other fields become non-editable.
• Select BACnet reference to define a reference that uses
the elements of a property value (Device instance number,
Object type, or Object instance number) to identify a BACnet
object or property that is not currently on the server but may
be uploaded or imported to the server later. You can also use
this method to reference a BACnet object or property on an
external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.
Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.
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Event enable

Select the flags to enable the reporting of to-off-normal, tofault, and to-normal events.

Notification
threshold

Enter the number of new records required to accumulate in the
Trend Log before BACnet devices are notified by the BACnet
notification. Set the number to equal 10% of the maximum
Buffer size.

Records since
notification

Displays the number of records that have been logged since the
last BACnet event notification was sent, or since the
beginning of trending if a BACnet event notification has not
been sent.
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Continued
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Property

Description

Last notify record

Displays the number of the last record when a BACnet
notification was sent. For example, if a BACnet notification
was sent when the last trended record was 99, the number would
be 99.
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81.143

BACnet File Object – Basic Tab
Use the Basic tab to view the basic properties of the Building Operation
configuration database. The BACnet File object is used to represent the Building
Operation configuration database to the BACnet network. For example, this object
can used by third-party BACnet clients during a BACnet initiated backup or restore
of the server.

Figure: Basic tab

Table: Basic Tab
Property

Description

File size

Displays the size of the data files in octets.

File access
method

Supports the STREAM_ACCESS file access method.

Modification
date

Displays the last time the BACnet File was created or written to.

File type

Displays the purpose of the data files that are described by the BACnet
File.

Archive

Displays whether the BACnet File has been saved for historical and
archival purposes, or backup purposes. One of the following values
displays:
• True indicates that the BACnet File has been saved for archival
purposes and that the data files have not been changed by internal
processes or through File Access Services since the last time the
BACnet File was archived.
• False indicates that the BACnet File has been saved for backup
purposes and that the data files have been changed by internal
processes or through File Access Services since the last time the
BACnet File was archived.
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Continued
Property

Description

Read only

Displays one of the following values to indicate whether the data files can
be changed by the BACnet AtomicWriteFile service:
• True indicates that the data files may not be changed by the
BACnet AtomicWriteFile service.
• False indicates that the data files may be changed by the BACnet
AtomicWriteFile service.
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81.144

BACnet File Object – Advanced Tab
Use the Advanced tab to to view the identification properties of the configuration
file, or change the BACnet name of the file object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.
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81.145

BACnet File Properties (Generic) – Basic
Tab
Use the Basic tab to view the properties of an external BACnet file.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or
Enterprise Server.

File size

Displays the size of the data files in octets.

File access
method

Displays the type of file access that is supported for the BACnet File.
The following two types are supported:
• STREAM_ACCESS
• RECORD_ACCESS

Modification date Displays the last time the BACnet File was created or written to.
File type

04-16006-04-en, March 2015

Displays the purpose of the data files that are described by the
BACnet File.
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Continued
Property

Description

Archive

Displays whether the BACnet File has been saved for historical and
archival purposes, or backup purposes. One of the following values
displays:
• True indicates that the BACnet File has been saved for archival
purposes and that the data files have not been changed by
internal processes or through File Access Services since the last
time the BACnet File was archived.
• False indicates that the BACnet File has been saved for
backup purposes and that the data files have been changed by
internal processes or through File Access Services since the last
time the BACnet File was archived.

Read only

Displays one of the following values to indicate whether the data files
can be changed by the BACnet AtomicWriteFile service:
• True indicates that the data files may not be changed by the
BACnet AtomicWriteFile service.
• False indicates that the data files may be changed by the
BACnet AtomicWriteFile service.

Record count
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Displays the size of the data files in records. Record count displays
the number of records only when File access method is
RECORD_ACCESS.
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81.146

BACnet File Properties (Generic) –
Advanced Tab
Use the Advanced tab to view the BACnet identification properties (generic), and
change the BACnet name of the file object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.

Technical
3223

81 BACnet Device User Interface
81.147 BACnet Program Properties (Generic) – Basic Tab

81.147

BACnet Program Properties (Generic) –
Basic Tab
Use the Basic tab to view the properties of a BACnet program (generic) and the
properties of the process that runs the BACnet program.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty
field indicates the object is executed by an Automation Server or
Enterprise Server.

Out of service

Displays one of the following values to indicate whether the
process that runs the application program is in service:
• True: Indicates that the process that runs the application
program is not in service and that the application program is
not loaded. Also, displays TRUE when Program state is
IDLE.
• False: Indicates that the process that runs the application
program is in service, and that the application program is
loaded and initialized even though the process itself may not
be running.
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Continued
Property

Description

Status flags

Displays the condition or status of the application program. When
checked, the application program is in one or more of the
following states:
• In alarm: Remains unchecked.
• Fault: Indicates that Reliability has a value other than nofault-detected.
• Overridden: Indicates that Program change, Program
state, and any other property related to the application
program cannot be changed through BACnet services.
• Out of service: Indicates that Out of service is set to
True.

Reliability

Displays one of the following values to indicate the reliability of the
properties of the application program, or the reliability of the
process that runs the application program:
• no-fault-detected
• process error
• unreliable other

Program state

Displays one of the following states to indicate the status of the
process that is running the application program:
• IDLE: Indicatest that the process is not running.
• LOADING: Indicates that the application program is being
loaded.
• RUNNING: Indicates that the process is running.
• WAITING: Indicates that the process is waiting for an
external event.
• HALTED: Indicates that the process has been halted due to
an error.

Program change

Set one of the following values to make the corresponding
program change request:
• Ready: Provides an indication that the process is ready for a
change request.
• Load: Provides a request for the application program to be
loaded if the program has not yet been loaded.
• Run: Provides a request for the process to begin running if
the process is not already running.
• Halt: Provides a request for the process to halt.
• Restart: Provides a request for the process to restart at the
initialization point.
• Unload: Provides a request for the proces to halt and
unload the application program.
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Continued
Property

Description

Reason for halt

Displays one of the following values to indicate whether the
process that runs the application program has halted, and if so,
the reason why:
• Normal: Indicates that the process has not been halted
because of an error.
• Load failed: Indicates that application program could not
finish loading and caused the process to halt.
• Internal: Indicates that the process has been halted by an
internal mechanism.
• Program: Indicates that the process has been halted by a
Program_Change request.
• Other: Indicates that the process has been halted for some
other reason.
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Description of halt

Displays a reason why the application program has been halted.

Program location

Displays a line number, program label, or section name to indicate
the location of the application program in the program code.

Instance of

Displays the name of the application program.
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81.148

BACnet Program Properties (Generic) –
Advanced Tab
Use the Advanced tab to view the BACnet identification properties, and change
the BACnet name of a program (generic) for a device.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

Type a new name to change the name of the BACnet object.

BACnet type

Displays the BACnet object type.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.
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81.149

BACnet Loop Properties – Basic Tab
Use the Basic tab to view and configure the properties of a control loop.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays the current output value of the loop algorithm.

Controlled
variable value

Displays the value of the property of the object referenced by the
Controlled variable reference property. The Controlled variable
value is compared with the Setpoint to calculate the error.

Setpoint

Enter the loop setpoint, or view the value of the property of the object
referenced by the Setpoint reference. The units need to match the
units of the Controlled variable value.

Out of service

Displays True when the loop algorithm is not in service.
Displays False when the loop algorithm is in service.
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Continued
Property

Description

Status flags

Displays the condition or status of the loop. When checked, the loop is in
one or more of the following states:
• In alarm: Indicates that Event state has a condition other than
Normal.
• Fault: Indicates that the Reliability property is present and has a
value other than no-fault-detected.
• Overridden: Indicates that Value is not changeable through
BACnet services.
• Out of service: Indicates that the Out of service property is
True.

Event state

Displays Fault when the Reliability property has a value other than No
fault detected, and the object supports intrinsic alarming.
Displays Normal when the Reliability property has a value of No fault
detected, or the object does not support intrinsic alarming.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on WebHelp.

Reliability

Displays one of the following values to indicate the reliability of the Value
property:
• No fault detected
• Open loop
• Unreliable-other

Controlled
variable
reference

Choose the method for referencing the controlled variable value:
• Select System reference to define a path to a property or object
reference located on the server (including hosted objects, if
available).
• Select Protocol reference (Advanced) to define a path to a
property or object reference located anywhere on the network.

Setpoint
reference

Choose the method for referencing the setpoint that you want to monitor
for this event:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

Bias
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Enter the bias value to be used by the loop algorithm. If the PID loop
algorithm produces a value of n, then the final value of the loop will be n
plus the value of Bias. The units need to match the units of the Value
property.
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Continued
Property

Description

Manipulated
variable
reference

Choose the method for referencing the property of the object that
receives the output of the control loop displayed in the Value property:
• Select System reference to define a path to a property located
on the server (including hosted objects, if available).
• Select Protocol reference (Advanced) to define a path to a
property located anywhere on the network.
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Update
interval (ms)

Enter how often that you want the loop algorighm to update the Value
property. Enter a time in milliseconds.

Maximum
output

Enter the maximum value that the PID algorithm can assign to the Value
property.

Minimum
output

Enter the minimum value that the PID loop algorithm can assign to the
Value property.

Action

Select Direct or Reverse to define the direct or reverse acting of the
loop.

Proportional
constant

Enter the value of the proportional gain parameter to be used by the loop
algorithm.

Integral
constant

Enter the value of the integral gain parameter to be used by the loop
algorithm.

Derivative
constant

Enter the value of the derivative gain parameter to be used by the loop
algorithm.

Priority for
writing

Enter a value between 1 and 16 to control the commandable property of
the Controlled variable reference.
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81.150

BACnet Loop Properties – Advanced
Tab
Use the Advanced tab to specify the intrinsic alarm properties for a BACnet loop.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

BACnet type

Displays the BACnet object type.

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal events have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal event.
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Continued
Property

Description

To-fault time

Displays the date and time of the last to-fault event.

To-normal time

Displays the date and time of the last to-normal event.

Error limit

Enter the absolute magnitude that the difference between the
Setpoint and Controlled variable value is required to exceed
before a to-off-normal event is generated.

Time delay(s)

Enter the minimum number of seconds that you want the system to
wait before generating a to-off-normal event or a to-normal
event.
A to-off-normal event is generated when the difference between
the Setpoint and the Controlled variable value exceeds the
boundary defined by the Error limit property.
A to-normal event is generated when the difference between the
Setpoint and the Controlled variable value remains within the
boundary defined by the Error limit property.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Alarm handling
and presentation

Select the data source for alarm handling and presentation
information. The alarm presentation settings display as three tabs
(User Action, Attachment, and Presentation) on the alarm sources
(value) as well as in the notification class. For more information, see
section 79.6 “BACnet Alarms” on page 2898.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm View for the
corresponding alarm state. The configured text is also sent to any
external BACnet clients configured as alarm recipients in the BACnet
notification.

Reset message
Fault message
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For more information, see the Alarms Pane and Alarm View topic on
WebHelp.
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81.151

BACnet Loop Properties (Generic) –
Basic Tab
Use the Basic tab to view and configure the control loop properties for an external
BACnet device.

Figure: Basic tab

Table: Basic Tab
Property

Description

Executed by

Indicates the object is executed by a BACnet device. An empty field
indicates the object is executed by an Automation Server or Enterprise
Server.

Value

Displays the current output value of the loop algorithm.

Out of service

Displays True when the loop algorithm is not in service.
Displays False when the loop algorithm is in service.
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Continued
Property

Description

Status flags

Displays the condition or status of the loop. When checked, the loop is in
one or more of the following states:
• In alarm: Indicates that Event state has a condition other than
Normal.
• Fault: Indicates that the Reliability property is present and has a
value other than no-fault-detected.
• Overridden: Indicates that Value is not changeable through
BACnet services.
• Out of service: Indicates that the Out of service property is
True.

Reliability

Displays one of the following values to indicate the reliability of the Value
property:
• No fault detected
• Open loop
• Unreliable-other

Event state

Displays Fault when the Reliability property has a value other than No
fault detected, and the object supports intrinsic alarming.
Displays Normal when the Reliability property has a value of No fault
detected, or the object does not support intrinsic alarming.

Alarm state

Displays a Building Operation alarm state that provides additional
information about an intrinsic alarm or algorithmic alarm configured for
an object. For more information, see the Alarm States topic on WebHelp.

COV
increment

Enter the minimum change in the Value property that causes a COV
notification to be sent.

Controlled
variable value

Displays the value of the property of the object referenced by the
Controlled variable reference property. The Controlled variable
value is compared with the Setpoint to calculate the error.

Controlled
variable
reference

Choose the method for referencing the controlled variable value:
• Select System reference to define a path to a property or object
reference located on the server (including hosted objects, if
available).
• Select Protocol reference (Advanced) to define a path to a
property or object reference located anywhere on the network.

Setpoint
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Enter the loop setpoint, or view the value of the property of the object
referenced by the Setpoint reference. The units need to match the
units of the Controlled variable value.
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Continued
Property

Description

Setpoint
reference

Choose the method for referencing the setpoint that you want to monitor
for this event:
• Select System reference to define a path-based reference to an
object or property that is currently located on the server.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object type,
or Object instance number) to identify a BACnet object or property
that is not currently on the server but may be uploaded or imported
to the server later. You can also use this method to reference a
BACnet object or property on an external device.
The system automatically fills in the Device instance number, Object
type, or Object instance number for the reference path, if available.

Bias

Enter the bias value to be used by the loop algorithm. If the PID loop
algorithm produces a value of n, then the final value of the loop will be n
plus the value of Bias. The units need to match the units of the Value
property.

Maximum
output

Enter the maximum value that the PID algorithm can assign to the Value
property.

Minimum
output

Enter the minimum value that the PID loop algorithm can assign to the
Value property.

Manipulated
variable
reference

Choose the method for referencing the property of the object that
receives the output of the control loop displayed in the Value property:
• Select System reference to define a path to a property located
on the server (including hosted objects, if available).
• Select Protocol reference (Advanced) to define a path to a
property located anywhere on the network.
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Update
interval (ms)

Enter how often that you want the loop algorighm to update the Value
property. Enter a time in milliseconds.

Action

Select Direct or Reverse to define the direct or reverse acting of the
loop.

Proportional
constant

Enter the value of the proportional gain parameter to be used by the loop
algorithm.

Integral
constant

Enter the value of the integral gain parameter to be used by the loop
algorithm.

Derivative
constant

Enter the value of the derivative gain parameter to be used by the loop
algorithm.

Priority for
writing

Enter a value between 1 and 16 to control the commandable property of
the Controlled variable reference.
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81.152

BACnet Loop Properties (Generic) –
Advanced Tab
Use the Advanced tab to view the BACnet loop properties (generic) for a device. If
the device supports intrinsic alarming, you can configure the alarm properties.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and instance number of the object.

BACnet type

Displays the BACnet object type.

BACnet name

View the name of the BACnet object or type a new name to change
the name.

Profile name

Displays the unique name of the profile that describes additional
characteristics of the object, such as additional properties,
behaviors, or requirements.
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Continued
Property

Description

Acknowledged
transitions

Displays whether acknowledgements for to-off-normal, to-fault,
or to-normal events have been received.

To-off-normal
time

Displays the date and time of the last to-off-normal event.

To-fault time

Displays the date and time of the last to-fault event.

To-normal time

Displays the date and time of the last to-normal event.

Error limit

Enter the absolute magnitude that the difference between the
Setpoint and Controlled variable value is required to exceed
before a to-off-normal event is generated.

Time delay(s)

Enter the minimum number of seconds that you want the system to
wait before generating a to-off-normal event or a to-normal
event.
A to-off-normal event is generated when the difference between
the Setpoint and the Controlled variable value exceeds the
boundary defined by the Error limit property.
A to-normal event is generated when the difference between the
Setpoint and the Controlled variable value remains within the
boundary defined by the Error limit property.

BACnet
notification

Choose the method for referencing the intrinsic alarm object that you
want to use to generate event notifications:
• Select System reference to define a path-based reference to
an object or property that is currently located on the server.
When selected, only the Path field becomes editable. All the
other fields become non-editable.
• Select BACnet reference to define a reference that uses the
elements of a property value (Device instance number, Object
type, or Object instance number) to identify a BACnet object or
property that is not currently on the server but may be uploaded
or imported to the server later. You can also use this method to
reference a BACnet object or property on an external device.
For more information, see section 73.7 “BACnet References and
System References” on page 2562.

Notify type

Select the type of BACnet event notification to be generated:
• Select alarm to define the event as a BACnet alarm and to
display the event in Alarm View.
• Select event to define the event as a BACnet event and to
display the event in Event View.

Event enable

Select the flags to enable the reporting of to-off-normal, to-fault,
and to-normal events.

Alarm message

Enter the text that you want to display in the Alarm text field in the
Alarm View for the corresponding alarm state.

Reset message

If a message text is received from the external device, that text is
displayed in the Alarm text field instead of the configured text.

Fault message
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81.153

Unresolved Device Properties – Basic
Tab
BACnet devices with unresolved issues reside in the Unconfigured Devices
folder.
The devices in the folder may have one or more of the following unresolved issues:
• Unspecified device identifiers
• Duplicate device identifiers
• Duplicate device names
• Other interoperability issues
To resolve the issue, you may need to use another vendor's workstation or change
the physical hardware settings on the device. You need to refer to the
manufacturer's documentation for specific instructions.
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81.154 Unresolved Device Properties – Advanced Tab

81.154

Unresolved Device Properties –
Advanced Tab
BACnet devices with unresolved issues reside in the Unconfigured Devices
folder.
The devices in the folder may have one or more of the following unresolved issues:
• Unspecified device identifiers
• Duplicate device identifiers
• Duplicate device names
• Other interoperability issues
To resolve the issue, you may need to use another vendor's workstation or change
the physical hardware settings on the device. You need to refer to the
manufacturer's documentation for specific instructions.
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81.155

Unsupported Object Properties – Basic
Tab
A BACnet device may contain objects that are not currently supported in Building
Operation. For more information, see section 76.1 “BACnet Objects and Properties”
on page 2663.
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81.156

Unsupported Object Properties –
Advanced Tab
A BACnet device may contain objects that are not currently supported in Building
Operation. For more information, see section 76.1 “BACnet Objects and Properties”
on page 2663.
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81.157

Actions Menu – Device Communication
Control Submenu
Use the Device communication control submenu to enable, disable, or limit the
communication between the BACnet Interface and other BACnet devices on the
BACnet internetwork.

Figure: Device communication control submenu

Table: Device Communication Control Submenu
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Command

Description

Enable

Select to enable communication between the BACnet Interface
and other BACnet devices on the BACnet internetwork. For more
information, see section 75.25 “Enabling BACnet Interface
Communication” on page 2636.

Disable

Select to disable communication between the BACnet Interface
and other BACnet devices on the BACnet internetwork. For more
information, see section 75.26 “Disabling BACnet Interface
Communication” on page 2637.

Disable initiation

Select to instruct the BACnet Interface to respond to requests
from other BACnet devices on the BACnet internetwork, but not
to initiate new requests. For more information, see section 75.27
“Disabling Initiation of BACnet Interface Communication” on page
2638.
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81.158

Actions Menu – Device Submenu –
Restart Submenu
Use the Restart submenu to warm start or cold start a BACnet device. For more
information, see section 75.21 “Device Communication and Diagnostics” on page
2631.

Figure: Restart submenu

Table: Restart Submenu

04-16006-04-en, March 2015

Command

Description

Warm start

Click to warm start a BACnet device. With a warm start, the device is
reset. The device retains all configuration data, run-time data, and the
values of objects. For more information, see section 75.36 “Device Cold
Start and Warm Start” on page 2650.

Cold start

Click to cold start a BACnet device. With a cold start, the device reboots
itself. Some devices may retain the object database, the object list, and
configuration information; however, depending on vendor
implementation, some devices do not retain object lists. The run-time
data is usually not preserved. For more information, see section 75.36
“Device Cold Start and Warm Start” on page 2650.
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81.159

Actions Menu – Device Submenu – Time
Sync Submenu
Use the Time sync submenu to synchronize the time between a BACnet device
and the local server. For more information, see section 75.21 “Device
Communication and Diagnostics” on page 2631.

Figure: Time sync submenu

Table: Time Sync Submenu
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Command

Description

Local

Click to set the local time of the BACnet device to the local time of the
server.

UTC

Click to set the UTC time of the BACnet device to the UTC time of the
local server.
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81.160

Actions Menu – Device Submenu –
Communication Submenu
Use the Communication submenu to enable, disable, or limit the communication
between a BACnet device and other BACnet devices on the BACnet internetwork.

Figure: Communication submenu

Table: Communication Submenu
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Command

Description

Enable

Select to enable communication between a BACnet device and other
BACnet devices on the BACnet internetwork. For more information, see
section 75.22 “Enabling BACnet Device Communication” on page 2633.

Disable

Select to disable communication between a BACnet device and other
BACnet devices on the BACnet internetwork. For more information, see
section 75.23 “Disabling BACnet Device Communication” on page 2634.

Disable
initiation

Select to instruct a BACnet device to respond to requests from other
BACnet devices on the BACnet internetwork, but not to initiate new
requests. For more information, see section 75.24 “Disabling Initiation of
BACnet Device Communication” on page 2635.
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81.161

BACnet Associate with Device Dialog
Box
Use the Associate with Device dialog box to associate a BACnet instance
number of a physical BACnet device with the BACnet device in the server.

Figure: Associate with Device dialog box

Table: Associate with Device Dialog Box
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Component

Description

Device Id

Type the BACnet instance number of the physical BACnet device that
you want to associate with the BACnet device in the server.
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81.162

BACnet Device Communication Dialog
Box
Use the Device Communication dialog box to enable, disable, or limit the
communication of a BACnet device with other BACnet devices on the BACnet
internetwork.
Table: Device Communication Dialog Box
Component

Description

Time Duration Enter the number of minutes that you want to disable or limit the
(minutes)
communication of a BACnet device with other BACnet devices on the
BACnet internetwork.
Zero (0) specifies an indefinite amount of time.
Password
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Type the vendor-supplied password. If a password is not required, leave
the box empty.
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81.163

BACnet Password Dialog Box
Use the Password dialog box to enter a password when warm starting, cold
starting, or backing up a BACnet device. A password is supplied by the vendor of
the BACnet device. However, not all devices require a password.

Figure: Backup – BACnet device dialog box

Table: Backup – BACnet Device Dialog Box
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Component

Description

Password

Type the vendor-supplied password. If a password is not required, leave
the box empty.
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81.164

Create Object Wizard – BACnet Basic
Settings Page
Use the BACnet Basic Setings page to enter a BACnet name for the BACnet
Interface.

Figure: Create Object Wizard – BACnet basic settings page

Table: Create Object Wizard – BACnet Basic Settings Page
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Property

Description

Automatically
generated

Click to have the server automatically generate a BACnet Instance ID.

Manually
entered

Click to enter an appropriate Instance ID for the BACnet interface.

BACnet name

Enter a BACnet name for the interface. Do not type a name if you want
it assigned for you.

Network ID

Keep the default Network ID, or type a Network ID for the IP network.

Choosing Automatically generated is the recommended option.
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81.165

Create Object Wizard – IP Network
Basic Settings Page
Use the IP Network basic settings page to configure the properties of a BACnet
IP network.

Figure: IP Network Basic Settings page

Table: IP Network Basic Settings Page
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Property

Description

Network ID

Enter the Network ID of the BACnet IP network, such as 1.

Defer ID
assignment

Assign the Network ID after the BACnet IP network is created.

IP address

Type the IP address for the IP network.

IP broadcast
address

Type the IP address used to send broadcast messages on a BACnet
IP network.

IP port number

Enter an IP port number, such as 47808.

04-16006-04-en, March 2015

81 BACnet Device User Interface
81.166 Create Object Wizard – BACnet Network BACnet Basic Settings Page

81.166

Create Object Wizard – BACnet
Network BACnet Basic Settings Page
Use the BACnet Basic Setings page to configure the Network ID of a BACnet
network.

Figure: BACnet basic settings page

Table: BACnet Basic Settings Page
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Property

Description

Network ID

Enter the Network ID of the BACnet network.
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81.167

BACnet Create Object Wizard – BACnet
Basic Settings Page
Use the BACnet basic settings page to create a BACnet object for a server.

Figure: BACnet basic settings page

Table: BACnet Basic Settings Page
Property

Description

Automatically
generated

Click to have the server automatically generate a BACnet Instance
ID.
Automatically generated is the recommended option.

Manually entered Click to enter an appropriate Instance ID for the BACnet object. If
you choose to manually enter an Instance ID, it must be unique
within the application for this type.
BACnet name

Type a name for the object. Do not type a name if you want a
BACnet name to be assigned.

Command
priority retain
level

Choose one of the following options:
• Warm start: The variable retains the last value set by a user or
application. However, the variable reverts to the default value for
a cold start.
• Cold start: The variable retains the last value set by a user or
application for a warm start or cold start.
• No: The variable reverts to the default value upon a restart.
This option only displays when a commandable value or output is
created.
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81.168

BACnet Create Object (Generic)
Wizard – BACnet Basic Settings Page
Use the BACnet basic settings page to specify the ID or name of a new BACnet
object in an external device.
For more information, see section 76.7 “BACnet Configuration Properties” on page
2671.

Figure: BACnet basic settings page

Table: BACnet Basic Settings Page

04-16006-04-en, March 2015

Property

Description

Download to
BACnet
device

Click to download the object and its properties from the Building
Operation database to the BACnet device.

BACnet name

Enter a BACnet name for the object. Do not type a name if you want it
assigned for you.

Upload from
BACnet
device

Click to upload an existing object and its properties from a BACnet
device to the Building Operation database.

Instance ID

Enter the instance number of the object to upload. This instance number
must exist in the device.
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81.169

BACnet Create Device Wizard – BACnet
Basic Settings Page
Use the BACnet Basic Setings page to create a new BACnet device on the
network.

Figure: BACnet basic settings page

Table: BACnet Basic Settings Page
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Property

Description

Download to
BACnet
device

Click to download properties to the BACnet device. This option
downloads the properties configured in the Building Operation database
to the BACnet device.

BACnet name

Enter a BACnet name for the object. Do not type a name if you want it
assigned for you.

Upload from
BACnet
device

Click to upload the properties of the BACnet device. This option uploads
the properties of the physical device to the database.

Instance ID

Enter the instance number of the physical device. Be sure to enter a valid
instance number.
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82 b3 BACnet Device Introduction
82.1 b3 BACnet Device Overview

82.1

b3 BACnet Device Overview
b3 BACnet devices are a family of intelligent, programmable, stand-alone devices
that provide Direct Digital Control of air handlers and systems as well as individual
terminal units: VAV boxes, fan powered induction units, unit ventilators, and heat
pumps.
Because these devices focus on individual terminal units, they are often referred to
as field controllers.

82.1.1

b3 BACnet Device Controllers and Networks
Using Building Operation, you configure a BACnet network that connects
WorkStation with SBO Automation Servers and b3 BACnet devices. Their true
peer-to-peer communication protocol provides the b3 BACnet series with the ability
to instantly communicate with an SBO Automation Server and its entire network of
controllers.
For more information, see section 82.2 “b3 BACnet Device Controllers and
Networks” on page 3256.

82.1.2

b3 BACnet Device Communication
b3 BACnet devices instantly communicate with an Automation Server and its entire
network of controllers. This communication allows the b3 BACnet devices to learn
new objects, create and manage alarms and trend logs, and share data with other
controllers.
For more information, see section 83.1 “b3 BACnet Device Communication” on
page 3267.

82.1.3

b3 BACnet Device Models and Program
Memory
There are many different models of b3 BACnet devices shipped from the factory
with the operating system preprogrammed into their program memory.
For more information, see section 84.1 “b3 BACnet Device Models and Program
Memory” on page 3427.
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82.2

b3 BACnet Device Controllers and
Networks
Using Building Operation, you configure a BACnet network that connects
WorkStation with SBO Automation Servers and b3 BACnet devices. Their true
peer-to-peer communication protocol provides the b3 BACnet series with the ability
to instantly communicate with an SBO Automation Server and its entire network of
controllers.

82.2.1

b3 BACnet Device Controllers
b3 BACnet devices focus on individual units. As a result, they are often referred to
as field controllers. b3 BACnet devices contain input and output circuitry, as well as
program and data memory, and operate as peer-to-peer devices compatible with
the Script Editor.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

82.2.2

b3 BACnet Device Networks
You configure a BACnet network that connects WorkStation with Automation
Servers and b3 BACnet devices. The Automation Servers are hardware modules
that reside at the IP-level and route messages to and from the IP-level to the
BACnet MS/TP network.
For more information, see section 82.4 “b3 BACnet Device Networks” on page
3258.
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82.3

b3 BACnet Device Controllers
b3 BACnet devices focus on individual units. As a result, they are often referred to
as field controllers. b3 BACnet devices contain input and output circuitry, as well as
program and data memory, and operate as peer-to-peer devices compatible with
the Script Editor.
For more information, see section 83.9 “Programming Language for b3 BACnet
Devices” on page 3284.
b3 BACnet devices also include local processing and I/O hardware to process input
data from sensors, execute a control task, and control actuators. In addition, all b3
BACnet devices comply with the BACnet Advanced Application Controller (B-AAC)
profile and also support BACnet trending.
Ease of installation is one of the essential elements of the b3 BACnet device. All of
the connections are removable, so you can pre-wire panels and easily service the
unit. LEDs then provide simple troubleshooting information and display
communication activity for all ports.

See the b3 and b4920 Controller Technical Reference for more information.

04-16006-04-en, March 2015

Technical
3259

82 b3 BACnet Device Introduction
82.4 b3 BACnet Device Networks

82.4

b3 BACnet Device Networks
You configure a BACnet network that connects WorkStation with Automation
Servers and b3 BACnet devices. The Automation Servers are hardware modules
that reside at the IP-level and route messages to and from the IP-level to the
BACnet MS/TP network.

Figure: Communication between WorkStation and Automation Servers

The communication between Automation Servers and b3 BACnet devices allows
the b3 BACnet devices to learn new objects, create and manage alarms and trend
logs, and share data with other controllers. Data sharing can occur between b3
BACnet MS/TP devices in the same network as well as devices in different BACnet
networks. The data sharing between BACnet devices can use change of value and
read/write data sharing depending on the function and capabilities of the BACnet
device.
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Figure: Communication between Automation Servers and b3 BACnet Devices

From WorkStation, you create a BACnet device at the Automation Server level in
the System Tree pane that identifies the Server as a BACnet device. The BACnet/IP
network associated with the device is automatically created for you. To configure a
Comm Port (A or B) on the Automation Server for MS/TP use, you can create the
BACnet MS/TP network as shown in the System Tree pane.
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Figure: Automation Server and b3 BACnet devices in the System Tree
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82.5

Creating a BACnet Interface
You create the BACnet Interface to enable the BACnet communications port on an
Enterprise Server or Automation Server.
For more information, see section 73.2 “BACnet Interface” on page 2554.

To create a BACnet Interface
1. In WorkStation, in the System Tree, select the location where you want to
create the BACnet Interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, select BACnet Interface.

4. In the Name box, type a name for the BACnet Interface.
5. In the Description box, type a description for the BACnet Interface.
6. Click Next.
7. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet interface.

Note
• If you enter an Instance ID manually, you must ensure that it is
globally unique among all the BACnet devices on the
internetwork (that is, among all the devices that it can
communicate with).
Continued on next page
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82.5 Creating a BACnet Interface

8. In the BACnet name box, type a name for the BACnet interface. Do not type
a name if you want it assigned for you.
9. In the Network ID box, enter 1, which is the universal standard for all BACnet
IP communications.
10. Click Create.
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83 b3 BACnet Device Communication and Configuration
83.1 b3 BACnet Device Communication

83.1

b3 BACnet Device Communication
b3 BACnet devices instantly communicate with an Automation Server and its entire
network of controllers. This communication allows the b3 BACnet devices to learn
new objects, create and manage alarms and trend logs, and share data with other
controllers.

83.1.1

Communication Between the AS and b3
BACnet Device
b3 BACnet devices communicate with Automation Servers. This communication
allows the b3 BACnet devices to learn new objects, create and manage alarms and
trend logs, and share data with other controllers.
For more information, see section 83.2 “Communication Between the AS and b3
BACnet Device” on page 3270.

83.1.2

b3 BACnet Device Workflows
There are three workflows for creating and configuring a b3 BACnet device.
For more information, see section 83.5 “b3 BACnet Device Workflows” on page
3275.

83.1.3

Programming Language for b3 BACnet
Devices
Using the Script Editor, you can create programs that you can then download to the
b3 BACnet device where these programs execute. The Script language is a
programming tool derived from Plain English programming in the Continuum
system.
For more information, see section 83.9 “Programming Language for b3 BACnet
Devices” on page 3284.

83.1.4

b3 BACnet Device Merge Copied Device
Content
Merge Copied Device Content streamlines and improves copy and merge content
operations since you no longer need to copy and merge content one device at a
time. Instead, you can directly copy an Infinet device in one step and then merge
that device's content with another Infinet device or group of Infinet devices. This
allows you to easily replicate objects, variables, programs and devices.
For more information, see section 83.15 “b3 BACnet Device Merge Copied Device
Content” on page 3297.
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83.1.5

b3 BACnet Device Point and Value
Configuration
Depending upon the specific controller model, b3 BACnet devices have varied
numbers of channels for analog and digital input and output sensors. A channel is
simply an area in the controller that you can physically connect to a sensor. A
sensor is a device that measures and reports on specific environmental factors,
such as temperature, humidity, water presssure, and airflow.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

83.1.6

Schedules for b3 BACnet Devices
A schedule is a sequence of events that determines when an essential event occurs
in a building automation system. For example, you use a schedule to control when
the lights or fans go on and off in a building.
For more information, see section 83.54 “Schedules for b3 BACnet Devices” on
page 3407.

83.1.7

Trend Logs for b3 BACnet Devices
You use a trend log to collect data and then store the records. A record contains a
log value or an event as well as its time stamp and an optional comment. A trend
log can log an analog variable, a digital variable, or an integer variable.
For more information, see section 83.55 “Trend Logs for b3 BACnet Devices” on
page 3408.

83.1.8

Extended Trend Logs for b3 Point and Value
Device Logs
You use an extended trend log to store log records for long periods of time without
encumbering the Automation Server's memory. The extended trend log is often
saved on a higher-level server with more storage capacity. This extra storage
capacity enables the server to store more records before overwriting the old ones.
For more information, see section 83.56 “Extended Trend Logs for b3 Point and
Value Device Logs” on page 3409.

83.1.9

Alarms for b3 BACnet Devices
You use an alarm to monitor a variable and alert you if the monitored variable
matches the configured alarm conditions. For example, an alarm can send a
notification to a specified user or user group when the alarm is triggered or force the
user that acknowledges the alarm to write a cause note. You can also configure the
alarm to flash and play a sound when triggered.
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For more information, see section 83.58 “Alarms for b3 BACnet Devices” on page
3414.
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83.2

Communication Between the AS and b3
BACnet Device
b3 BACnet devices communicate with Automation Servers. This communication
allows the b3 BACnet devices to learn new objects, create and manage alarms and
trend logs, and share data with other controllers.
In WorkStation, each Automation Server and its associated BACnet devices are
represented in the System Tree pane.

Figure: Automation Server with BACnet Devices in the System Tree pane
Number

Description
The BACnet Devices subfolder displays
the discovered BACnet networks and
devices, such as MS/TP networks, b3
BACnet devices, and other BACnet devices.
Objects in this folder are not necessarily
hosted by the Server in Building Operation.
Rather, these objects are a representation of
the BACnet networks and devices that can
communicate with the server containing this
folder.
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Continued
Number

Description
The AS1BACnet interface contains folders
and networks that hold the configuration
data for the Server and the networks and the
devices it hosts. This includes BACnet
networks, b3 BACnet devices, and other
BACnet devices.
The IP network associated with the device is
automatically created for you when you
create a BACnet device object.
In the Application folder for the b3 BACnet
device, you create inputs, outputs, values,
and programs.
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83.3

Creating a BACnet MS/TP Network
You create an MS/TP network in order to connect a b3 BACnet device or other
BACnet device to an Automation Server.
For more information, see section 74.1 “BACnet Networks” on page 2573.

To create a BACnet MS/TP network
1. In WorkStation, in the System Tree, select the BACnet Interface.
2. On the File menu, point to New and then click MSTP Network.
3. In the Name box, type a name for the MS/TP network.

4. In the Description box, type a description for the MS/TP network.
5. Click Next.
Continued on next page
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6. In the Network ID box, enter a unique number between 1 and 65534.

7. Select the Defer ID assignment check box to assign a network ID after the
MS/TP network is created.
8. In the MAC address box, enter the number that represents the Automation
Server's address on the MS/TP network.
9. In the RS-485 port box, enter the location of the serial port RS485-COMA
or RS485-COMB.
10. Click Create.
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83.4

Configuring the MS/TP Network for b3
Communication
You configure the MS/TP network to optimize its performance.
For more information, see section 83.2 “Communication Between the AS and b3
BACnet Device” on page 3270.

To configure the MS/TP Network for b3 communication
1. In WorkStation, in the System Tree pane, select the MSTP Network.
2. On the File menu, click Properties.
3. On the Basic tab, in the MSTP baud rate box, select the baud rate.

4. In the Maximum master box, enter the highest node ID that will be used on
the MS/TP network and allow for adding future devices.
5. Click OK.
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83.5

b3 BACnet Device Workflows
There are three workflows for creating and configuring a b3 BACnet device.

83.5.1

Learn b3 BACnet Device Workflow
Use this workflow to learn and configure the b3 BACnet devices at your site.
For more information, see section 83.6 “Learn b3 BACnet Device Workflow” on
page 3276.

83.5.2

Create b3 BACnet Devices with Factory
Settings Workflow
Use this workflow to create and configure new b3 BACnet devices with factory
settings in an MS/TP network using WorkStation for Projects.
For more information, see section 83.7 “Create b3 BACnet Devices with Factory
Settings Workflow” on page 3278.

83.5.3

Create Previously-Used b3 BACnet Devices
Workflow
Use this workflow to configure previously used b3 BACnet devices in an MS/TP
network using WorkStation for Projects.
For more information, see section 83.8 “Create Previously Used b3 BACnet Devices
Workflow” on page 3281.

04-16006-04-en, March 2015

Technical
3277

83 b3 BACnet Device Communication and Configuration
83.6 Learn b3 BACnet Device Workflow

83.6

Learn b3 BACnet Device Workflow
Use this workflow to learn and configure the b3 BACnet devices at your site.

Figure: Learn b3 BACnet Device Workflow

Create a b3 BACnet interface
Create a BACnet interface to enable the BACnet communications port on an
Enterprise Server or Automation Server.
For more information, see section 82.5 “Creating a BACnet Interface” on page
3261.
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Create and configure the MS/TP network
Create and configure an MS/TP network in order to connect a b3 BACnet device to
an Automation Server.
For more information, see section 83.3 “Creating a BACnet MS/TP Network” on
page 3272.
For more information, see section 83.4 “Configuring the MS/TP Network for b3
Communication” on page 3274.

Learn b3 BACnet devices
Learn b3 BACnet devices to automatically assign the node IDs and initiate
communication with devices in the MS/TP network.
For more information, see section 83.49 “Learning b3 BACnet Devices” on page
3402.

Download to a b3 BACnet Device
Download the objects in the database to a b3 BACnet device.
For more information, see section 83.51 “Downloading to a b3 BACnet Device” on
page 3404.

Create objects
Create objects such as b3 Script programs.
For more information, see section 83.11 “Creating a b3 Script Program” on page
3289.

Bind values in a program
Bind values in a b3 BACnet device Script program using Auto Binding.

Tip
When you bind a server Script program variable to a specific point in a b3 BACnet
device, rather than binding to the value property, it is recommended that you bind
the variable using priority level 1-10. The b3 firmware default for the BACnet
priority level is 10, while the Automation Server or Enterprise Server priority level
default is 16.
For more information, see the Binding Values in Script Editor Using Auto Binding
topic on WebHelp.

Save the bindings and programs
Save the bindings and programs to ensure there are no syntax errors.
For more information, see section 52.15 “Checking and Saving a Script Program”
on page 1878.

Download the program to a b3 BACnet device
Once the bindings and programs are saved, you use WorkStation to download the
program code to the b3 BACnet device where these programs execute.
For more information, see section 83.51 “Downloading to a b3 BACnet Device” on
page 3404.
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83.7

Create b3 BACnet Devices with Factory
Settings Workflow
Use this workflow to create and configure new b3 BACnet devices with factory
settings in an MS/TP network using WorkStation for Projects.

Figure: b3 BACnet device with factory settings workflow

Create a b3 BACnet device
In WorkStation for Projects, create a b3 BACnet device, choose the model number,
and enter valid numbers for the Instance and Infinet IDs.
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Note
The Infinet ID can range from 1-127, while any Instance ID based on BACnet
naming conventions is valid.
For more information, see section 84.9 “ Creating a b3 BACnet Device” on page
3440.

Create objects
Create points, values, Script programs, and other objects on the b3 BACnet device.
For more information, see section 83.18 “Creating a b3 BACnet Device Analog
Input Point” on page 3302.
For more information, see section 83.37 “Creating a b3 BACnet Device Analog
Value” on page 3370.
For more information, see section 83.11 “Creating a b3 Script Program” on page
3289.

Deploy the Automation Servers
In WorkStation for Projects, deploy the Automation Servers to the on-site server.

Caution
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
For more information, see section 6.8 “Deploy” on page 248.
For more information, see section 6.12 “Deploying a Server” on page 260.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended that you update all Automation Server communication
parameters before the deploy of the Enterprise Server.

Deploy the Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.

Important
Ensure that you have created all Automation Servers in the project before the
deploy of the Enterprise Server. You can only deploy to an empty Enterprise
Server. Any additional Automation Servers have to be created on the on-site
server.
Continued on next page
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For more information, see section 6.8 “Deploy” on page 248.

Configure the serial number for the b3 BACnet Device
Configure the serial number for the b3 BACnet device.
For more information, see the Configuring a Factory-Set b3 BACnet Device after a
Deploy topic on WebHelp.

Commission the b3 BACnet device
Commission the b3 BACnet device.
For more information, see section 83.52 “Commissioning a b3 BACnet Device” on
page 3405.

Download to the b3 BACnet device
Download the objects to the b3 BACnet device. All of the deployed objects will now
be downloaded and all other objects deleted.
For more information, see section 83.51 “Downloading to a b3 BACnet Device” on
page 3404.
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83.8

Create Previously Used b3 BACnet
Devices Workflow
Use this workflow to configure previously used b3 BACnet devices in an MS/TP
network using WorkStation for Projects.

Figure: Previously-Used b3 BACnet device workflow

Perform a b3 BACnet device Learn
In WorkStation, perform a b3 BACnet device Learn operation in the MS/TP
network.
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For more information, see section 83.49 “Learning b3 BACnet Devices” on page
3402.

Create objects
In WorkStation, create points, values, Script programs, and other objects in the b3
BACnet device.
For more information, see section 83.18 “Creating a b3 BACnet Device Analog
Input Point” on page 3302.
For more information, see section 83.37 “Creating a b3 BACnet Device Analog
Value” on page 3370.
For more information, see section 83.11 “Creating a b3 Script Program” on page
3289.

Export the devices you want to use
In WorkStation, select and export the b3 BACnet devices you want to use in
WorkStation for Projects.

Use the export file to import b3 BACnet devices
In WorkStation for Projects, use the export file to import the b3 BACnet devices
under the appropriate MS/TP network.
For more information, see section 18.7 “Import and Export of b3 Solutions” on page
566.

Note
b3 BACnet devices appear offline in the System Tree pane until you click and
drag the live device to the device in the System Tree pane.

Deploy the Automation Servers
In WorkStation for Projects, deploy the Automation Servers to the on-site server.

Caution
Ensure that you have created all domain devices and objects before the deploy of
an Automation Server. If you add devices and objects to the Automation Server
and deploy the server again, you first have to clear the database of the physical
Automation Server.
For more information, see section 6.8 “Deploy” on page 248.

Update server communication parameters
In WorkStation for Projects, update the server communication parameters for all
servers.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.

Important
It is recommended that you update all Automation Server communication
parameters before the deploy of the Enterprise Server.
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Deploy the Enterprise Server
In WorkStation for Projects, deploy the Enterprise Server.

Important
Ensure that you have created all Automation Servers in the project before the
deploy of the Enterprise Server. You can only deploy to an empty Enterprise
Server. Any additional Automation Servers have to be created on the on-site
server.
For more information, see section 6.8 “Deploy” on page 248.

Commission the b3 BACnet device
Commission the b3 BACnet device by clicking and dragging the device from the
Hardware folder to the device in the System Tree pane.

Download to a b3 BACnet device
Download the objects to the b3 BACnet device. All of the deployed objects will now
be downloaded and all of the other objects deleted.

Note
If the download process is unsuccessful due to a device commit failure, check the
serial number of the device. If the serial number is zero, open the Properties
pane for the b3 BACnet device and manually enter the serial number in the
Advanced tab. Then, try the download operation again. For more information,
see section 83.51 “Downloading to a b3 BACnet Device” on page 3404.
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83.9

Programming Language for b3 BACnet
Devices
Using the Script Editor, you can create programs that you can then download to the
b3 BACnet device where these programs execute. The Script language is a
programming tool derived from Plain English programming in the Continuum
system.

Example Program
This Script programming example includes a simple fan control program that turns
a fan on or off based upon occupancy, which is, in turn, based upon a schedule.

Figure: Script program example

Bindings to the respective occupancy input and fan output are set outside of the
Script Editor.
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83.10

Configuring Script FallThru Program
Triggers in a b3 BACnet Device
You configure triggers for Script Fall-Thru programs in the Advanced tab of a point
or system variable.

Note
• Ensure that your b3 program is on the same device as the point, value, or
system variable. You can only use b3 programs as b3 triggers.
For more information, see section 83.9 “Programming Language for b3 BACnet
Devices” on page 3284.

To configure Script Fall-Thru program triggers
1. In WorkStation, in the List View, click your b3 Script program.
2. Click the File menu and select Properties.
3. Set the FlowType to Fall-Thru.

4. Click OK.
Continued on next page
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5. In WorkStation, in the System Tree pane, select the Application folder under
the b3 BACnet device.
6. In the List View, click the point or system variable that you want to use as a
trigger.

Tip
• For example, you can choose to use a point called OCCUPPIED
that triggers a Script program to turn on a fan when a room is
occupied.

7. Click the File menu and select Properties.
Continued on next page
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8. In the Advanced tab, under Triggers, click the Add button.

Continued on next page
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9. In the Select Object dialog box, locate your Script progam and click Select
to attach the program in the Triggers field.

10. In the Advanced tab, click OK.
Now, every time the OCCUPIED point changes state, it triggers the Script program
to turn the fan on or off.
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83.11

Creating a b3 Script Program
You create a Script program to import existing program code or to program new
logic for a b3 BACnet device using Script Editor.
For more information, see section 50.10 “Script Program Instructions” on page
1581.

To create a b3 script program
1. In WorkStation, in the System Tree pane, select the folder where you want
to create the b3 script program.
2. On the File menu, point to New and then click Program.
3. In the object type list, select b3 Script Program.

4. In the Name box, type a name for the b3 script program.
5. In the Description box, type a description for the b3 script program.
6. Click Next.
Continued on next page
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7. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you.
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.

8. In the BACnet name box, type a BACnet name for the value. Do not type a
name if you want a name to be assigned for you.
9. Click Create.
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83.12

Creating a b3 Script Function
You create a b3 Script Function to import existing Script or Plain English functions
or to create new functions using the Script Editor.

To create a b3 Script Function
1. In WorkStation, in the System Tree, select the b3 device in which the function
will be created.
2. Click Application
3. From the File menu, select New, select Program.
4. Select b3 Script Function
5. In the Name box, type the name of the Function.
6. Click Create.
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83.13

Creating b3 Script Program Bindings
Before you download and execute b3 Script programs, you must bind the inputs
and outputs.
For more information, see section 83.9 “Programming Language for b3 BACnet
Devices” on page 3284.

To create b3 Script program bindings
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create program bindings.
2. Select Application.
3. In the List View, select your new b3 Script program.
4. On the File menu, point to New and then click Value.
5. In the object list, select BACnet Analog Value (Continuum).
6. In the Name box, type AV1.

7. In the Description box, type a description for the analog value.
8. Click Create.
9. Repeat steps 4-7 and create a second analog value named AV2.
10. In the List View, click your new b3 Script program.
11. On the Actions menu, click Edit Bindings.
12. In the Bindings view, select AV1 and bind that value by dragging it to the
Inputs field.
Continued on next page
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13. Select AV2 and bind that value by dragging it to the Outputs field.

Continued on next page
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14. Click the Save button
The inputs and outputs automatically appear in the Input and Output tabs in
the Script Program property grid after you save the program.
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83.14

Downloading a b3 Script Program
After you create and save b3 program bindings, you download your Script program
to a b3 BACnet device.
For more information, see section 83.9 “Programming Language for b3 BACnet
Devices” on page 3284.

To download a b3 Script program
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the new b3 Script program.
2. Select Application.
3. On the File menu, point to New and then click Program.
4. Click b3 Script Program and create your new program. For more
information, see section 50.4 “Creating a Script Program” on page 1567..
5. Select Application once more.
6. In the List View, select your new b3 Script program.
7. On the Actions menu, click Download.
8. Use the Progress view to monitor the Download command.

9. Click Close to close the Progress view.
10. In the List View, select your b3 Script program.
11. On the File menu, click Properties.
Continued on next page
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12. In the Basic tab, verify that the b3 Script program is running.

As long as it is a valid program, the program will start running immediately.
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83.15

b3 BACnet Device Merge Copied Device
Content
Merge Copied Device Content streamlines and improves copy and merge content
operations since you no longer need to copy and merge content one device at a
time. Instead, you can directly copy an Infinet device in one step and then merge
that device's content with another Infinet device or group of Infinet devices. This
allows you to easily replicate objects, variables, programs and devices.
For example, you can choose a source b3 BACnet device, copy that device, select
a target b3 BACnet device, or multi-select a group of target devices, and then
merge the content of the source device with the target. In the process, objects from
the source b3 BACnet device are merged with the target b3 based on the object
name.
In those cases where a copied object does not exist in the target b3 BACnet
device, a new object is created- as long as the source and target objects types are
the same. If the object types are different, the target object is deleted and a new
object is created with that same source object type.
These objects are not copies, but completely new objects. When an object with the
same name already exists in the target b3 BACnet device, the existing object is
overwritten by the merged object.

Tip
The properties of the merged b3 BACnet device do not change as a result of the
Merge Copied Device Content operation.
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83.16

Merging Copied Device Content in a b3
BACnet Device
You can directly copy a b3 BACnet device in one step and then merge that device's
content with another b3 device or group of b3 BACnet devices.
For more information, see section 83.15 “b3 BACnet Device Merge Copied Device
Content” on page 3297.

To merge copied device content in a b3 BACnet device
1. In WorkStation, in the System Tree pane, select the MSTP Network.
2. In the List View, select the source b3 BACnet device that you want to copy
from.

3. On the Edit menu, click Copy.
4. Select the target b3 BACnet device(s).
5. On the Actions menu, click Merge copied device content.
Continued on next page
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6. When the operation is complete, click Close.
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83.17

b3 BACnet Device Point and Value
Configuration
Depending upon the specific controller model, b3 BACnet devices have varied
numbers of channels for analog and digital input and output sensors. A channel is
simply an area in the controller that you can physically connect to a sensor. A
sensor is a device that measures and reports on specific environmental factors,
such as temperature, humidity, water presssure, and airflow.

83.17.1

Analog Point Configuration
Input channels are the connections to sensors and continually receive information
about the environment from those sensors. Output channels are then used to
control devices, like fans or pumps, or send information to those devices.

83.17.2

Multistate Point Configuration
Multistate input and output points represent one of a specific set of possible states.
The multistate point mappings for a b3 BACnet device in Building Operation and the
corresponding Continuum b3 point mappings are shown in the table that follows.
Table: b3 Multistate Point Mappings

83.17.3

New b3

Continuum b3

Input

Supervised (with selectable resistor types)

Output

Tristate (limited to Off/On/-On)

Pulsed Output

Tristate (pulse duration with On/Off/-On)

Value

Standard BACnet multistate value (with
configurable states)

Digital Point Configuration
With digital points, you can connect a channel to a physical device or hardware
input or output in only one of two states:
• Active (ON)
• Inactive (OFF)
Typically, you use these inputs to detect when a particular piece of equipment, like
a fan or pump, is running or idle. You then use outputs to control equipment and
turn the fan on or off. The Active state usually indicates the equipment is running,
while the Inactive state usually indicates the equipment is idle.
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83.17.4

Value Object Configuration
b3 BACnet device value objects are storage locations in the controller's memory.
There are five types of b3 value objects, each of which stores a unique value type.
• Analog values store numeric information.
• Digital values are used as control system parameters that have only one of two
possible states – Active (enabled) or Inactive (disabled).
• Multistate values are also used as control system parameters. However, their
values can be any one of a set that you define. For example, you can create a
multistate value object named Day of Week with a value of Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday, or Sunday.
• DateTime values store date and time information used in schedules and
timestamps.
• String values contain plain text that can include messages that are displayed to
an operator.
The setpoint is a common property for each b3 value object. You specify the
setpoint value as either true or false. When you specify True, the value contained by
the value object is retained during restart and saved to flash memory when a
backup to flash operation is performed.

04-16006-04-en, March 2015

Technical
3303

83 b3 BACnet Device Communication and Configuration
83.18 Creating a b3 BACnet Device Analog Input Point

83.18

Creating a b3 BACnet Device Analog
Input Point
You create analog input points in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device analog input point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the analog input point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Analog Input (Continuum).

5. In the Name box, type a name for the analog input point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the analog input point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the input channel you want the point to read from.

12. In the Electrical type box, select the electrical type on the input point.
13. Click Create.
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83.19

Configuring a b3 BACnet Device Analog
Input Point
You configure b3 BACnet device analog input points to act as the connection to
sensors and continually receive information about the environment from those
sensors.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device analog input point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
and then select Application.
2. In the List View, select the b3 BACnet device analog input point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Displays an orange button if the bound
value is not configured. When configured,
displays a current value for the point
under the following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays a non-forced
value. Click to force the value.
For all BACnet inputs, a Forced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

In alarm

This flag is not supported by Building
Operation b3 BACnet devices. The box
remains unchecked.

Fault

The flag is not supported by Building
Operation b3 BACnet devices. The box
remains unchecked.

Overridden

The flag is not supported by Building
Operation b3 BACnet devices. The box
remains unchecked.

Out of service

Displays a check if the point is out of
service or is not configured with a valid
I/O channel.

Out of service

Select True to indicate the object is out
of service and disconnected from the I/O
point. You can also select True when you
want to change the Value for testing
purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

COV increment

Enter the minimum change in the Value
property that causes a COV notification to
be sent.
Continued on next page
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Continued
6. Click the Advanced tab.
7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type
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Continued
Property

Description
Displays the type, which is always device.

Electrical type

Select the electrical type on the input
point.

Channel

Select the input channel you want the
point to read from.

Digital filter

Select On to remove potential noise and
fluctuations from the input point.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value
before it is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Electrical scale top

Enter the highest electrical value for the
point.

Electrical scale bottom

Enter the lowest electrical value for the
point.

Engineering scale top

Enter the highest engineering value for the
point.

Engineering scale bottom

Enter the lowest engineering value for the
point.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click OK.
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83.20

Configuring the COV Increment and the
Unit for a b3 BACnet Device Analog
Input Point
You configure the COV increment and the unit for a b3 BACnet device analog input
point to ensure that the analog input point holds the COV increment and the unit as
required by the project.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure the COV increment and the unit for a b3 BACnet
device analog input point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
and then select Application.
2. In the List View, select the b3 BACnet device analog input point.
3. On the File menu, click Properties.
4. Click the Basic tab.

5. For Value, click the Configure Settings icon

.
Continued on next page
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6. Select the Configured box that is in front of the Unit box.

7. In the Unit box, enter the unit.
8. Click OK.
Continued on next page
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9. In the COV increment box, enter the minimum change in the Value property
that causes a COV notification to be sent.

10. Click OK.
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83.21

Creating a b3 BACnet Device Analog
Output Point
You create analog output points in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device analog output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the analog output point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Analog Output (Continuum).

5. In the Name box, type a name for the analog output point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the analog output point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the output channel you want the point to write to.

12. In the Electrical type box, select the electrical type on the output point.
13. Click Create.
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83.22

Configuring a b3 BACnet Device Analog
Output Point
You configure analog output points to act as the connection to output channels and
help control devices like fans or pumps, or send information to those devices.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.The

To configure a b3 BACnet device analog output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device analog output point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Displays an orange button if the bound
value is not configured. When configured,
displays a current value for the point
under the following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays a non-forced
value. Click to force the value.
For all BACnet inputs, a Forced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Override value

Displays the override value. The Override
value takes precedence over other
values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O
point.
Displays False when the object is in
service and associated with an I/O point.

Override

Displays True or False. When the
Override is True, the output is
overridden.
Continued on next page
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Continued
Property

Description

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

COV increment

Enter the minimum change in the Value
property that causes a COV notification to
be sent. The default COV increment is
.10.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
Description

Properties

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Electrical type

Select the electrical type on the output
point.

Channel

Select the output channel you want the
point to read from.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Electrical scale top

Enter the highest electrical value for the
point.

Electrical scale bottom

Enter the lowest electrical value for the
point.

Engineering scale top

Enter the highest engineering value for the
point.

Engineering scale bottom

Enter the lowest engineering value for the
point.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.
Continued on next page
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Continued
8. Click the Command tab.
9. Edit the Command properties.

04-16006-04-en, March 2015

Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Enter the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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83.23

Configuring the COV Increment and the
Unit for a b3 BACnet Device Analog
Output Point
You configure the COV increment and the unit for a b3 BACnet device analog
output point to ensure that the analog output point holds the COV increment and
the unit as required by the project.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure the COV increment and the unit for a b3 BACnet
device analog output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device analog output point.
3. On the File menu, click Properties.
4. Click the Basic tab.

5. For Value, click the Configure Settings icon

.
Continued on next page
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6. Select the Configured box that is in front of the Unit box.

7. In the Unit box, enter the unit.
8. Click OK.
Continued on next page
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9. In the COV increment box, enter the minimum change in the Value property
that causes a COV notification to be sent.

10. Click OK.
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83.24

Configuring the Electrical Scale and the
Engineering Scale for a b3 BACnet
Device Analog Output Point
You configure the electrical scale and the engineering scale for a b3 BACnet device
analog output point to ensure that the analog output point holds the conversion
settings as required by the project.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure the electrical scale and the engineering scale for
a b3 BACnet device analog output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device analog output point.
3. On the File menu, click Properties.
Continued on next page
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4. Click the Advanced tab.

5. Under Conversion Settings, in the Electrical scale top box, enter the
highest electrical value for the analog output point.
6. In the Electrical scale bottom box, enter the lowest electrical value for the
analog output point.
7. In the Engineering scale top box, enter the highest engineering value for
the analog output point.
Continued on next page
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8. In the Engineering scale bottom box, enter the lowest engineering value
for the analog output point.

9. Click OK.
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83.25

Creating a b3 BACnet Device Multistate
Input Point
You create multistate input points in the b3 BACnet device Application folder.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device multistate input point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the multistate input point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Multistate Input (Continuum).

5. In the Name box, type a name for the multistate input point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the multistate input point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the channel where you want to put the multistate
input.

12. Click Create.
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83.26

Configuring a b3 BACnet Device
Multistate Input Point
When you configure a multistate input point, you need to specify the resistor type
for the input point in the b3 BACnet device. Resistors maintain a constant
relationship between the current flow and voltage in the electrical circuit.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device multistate input point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device multistate input point.
3. On the File menu, click Properties.
Continued on next page
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4. Click the Basic tab.
Property

Description

Value

Displays an orange button if the bound
value is not configured. When configured,
displays a current value for the point
under the following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays a non-forced
value. Click to force the value.
For all BACnet inputs, a Forced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Select True to indicate the object is out
of service and disconnected from the I/O
point. You can also select True when you
want to change the Value for testing
purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
Continued on next page
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Continued
Property

Description
alarming.

5. Click the Advanced tab.
6. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Resistor type

Select the resistor type. Resistors
maintain a constant relationship between
the current flow and voltage in the
electrical circuit.

Channel

Select the input channel you want the
point to read from.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value
before it is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want
Continued on next page
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Property

Description
the point to trigger when the value
changes.
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83.27

Creating a b3 BACnet Device Multistate
Output Point
You create multistate output points in the Application folder of the b3 BACnet
device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device multistate output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the multistate output point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Multistate Output (Continuum).

5. In the Name box, type a name for the multistate output point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the multistate output point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the channel where you want to put the multistate
output.
The multistate output occupies the assigned channel as well as the following
channel when assigned to a digital output. For example, if you assign the
multistate output to channel 1, channel 2 is also occupied.

12. Click Create.
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83.28

Configuring a b3 BACnet Device
Multistate Output Point
When you configure a b3 BACnet device multistate output point, you can toggle the
property in the LCD state box to clear an override and reset the position. This step
has the same effect as pushing the damper reset button.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device multistate output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device multistate output point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Displays an orange button if the bound
value is not configured. When configured,
displays a current value for the point
under the following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays a non-forced
value. Click to force the value.
For all BACnet inputs, a Forced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Override value

Displays the override value. The Override
value takes precedence over other
values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O
point.
Displays False when the object is in
service and associated with an I/O point.

Override

Displays True or False. When the
Override is True, the output is
overridden.
Continued on next page
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Continued
Property

Description

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

6. Click the Advanced tab.
7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Channel

Select the output channel you want the
point to read from.

LCD state

Toggle the property from Enabled to
Disabled when assigned to an actuator
output channel. You do this to clear an
override and reset the position.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
Continued on next page
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Continued
Property

Description
electrical units into engineering units.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click the Command tab.
9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Select the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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83.29

Creating a b3 BACnet Device Multistate
Pulsed Output Point
You create multistate pulsed output points in the Application folder of the b3
BACnet device.
Digital and Multistate Pulsed output points, DateTime and String values, and
program and function objects are non-BACnet proprietary object types. For more
information, see section 76.1 “BACnet Objects and Properties” on page 2663.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device multistate pulsed output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the multistate pulsed output point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select Multistate Pulsed Output.

5. In the Name box, type a name for the multistate pulsed output point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the multistate pulsed output
point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the channel where you want to put the multistate
pulsed output.

12. Click Create.
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83.30

Configuring a b3 BACnet Device
Multistate Pulsed Output Point
When you configure a b3 BACnet device multistate pulsed output point, you can
use the Value box to enter a positive floating point value and turn the output On for
that duration in seconds. Entering a negative value turns the point -On for that
duration in seconds. If you enter 3.5, that turns on the first output for 3.5 seconds
and then turns it off. Entering a value of -3 turns on the second output for 3
seconds.

Tip
Entering a value of 3267.7 permanently sets the output to On. Entering -3267.7
permanently sets the output to -On. This is similar to choosing On or -On when
configuring a standard multistate output value. Entering a value of 0 permanently
sets the output to Off.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device multistate pulsed output
point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device multistate pulsed output point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Enter the value you want for the output
point.

Override value

Displays the override value. The Override
value takes precedence over other
values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O
point.
Displays False when the object is in
service and associated with an I/O point.

Override

Displays True or False. When the
Override is True, the output is
overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Channel

Select the output channel you want the
point to read from.

LCD state

Toggle the property from Enabled to
Disabled when assigned to an actuator
output channel. You do this to clear an
override and reset the position.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click the Command tab.
Continued on next page
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9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Enter the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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83.31

Creating a b3 BACnet Device Digital
Input Point
You create digital input points in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device digital input point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the digital input point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select BACnet Digital Input (Continuum).

5. In the Name box, type a name for the digital input point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the digital input point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the input channel you want the point to read from.

12. Click Create.
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83.32

Configuring a b3 BACnet Device Digital
Input Point
You can configure a digital input point to determine whether a value is active (ON) or
inactive (OFF). Typically, you use these inputs to detect when a particular piece of
equipment, like a fan or pump, is running or idle. The Active state usually indicates
the equipment is running, while the Inactive state usually indicates the equipment is
idle.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet Device Digital Input Point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device digital input point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Displays an orange button if the bound
value is not configured. When configured,
displays a current value for the point
under the following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays a non-forced
value. Click to force the value.
For all BACnet inputs, a Forced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Select True to indicate the object is out
of service and disconnected from the I/O
point. You can also select True when you
want to change the Value for testing
purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
Continued on next page
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Continued
Property

Description
alarming.

Polarity

Select an option to control the
relationship between the physical input
and the input point of the b3 BACnet
device.
Select Normal if you want the input value
of Active to be Active and the input
value of Inactive to be Inactive.
Select Reverse if you want the input
value of Inactive to be Active and the
input value of Inactive to be Active.
These settings simply reverse the value
from the input.

Inactive text

Type the text that explains the Inactive
state of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

Active text

Type the text that explains the Active
state of the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Channel

Select the output channel you want the
point to read from.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value
before it is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.
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83.33

Creating a b3 BACnet Device Digital
Output Point
You create digital output points in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device digital output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the digital output point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object name list, select BACnet Digital Output (Continuum).

5. In the Name box, type a name for the digital output point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the digital output point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the output channel you want the point to write to.

12. Click Create.
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83.34

Configuring a b3 BACnet Device Digital
Output Point
You can configure a digital output point to control equipment and turn a fan on or
off. The Active state usually indicates the equipment is running, while the Inactive
state usually indicates the equipment is idle.

To configure a b3 BACnet device digital output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device digital output point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Description

Property

Value

Displays an orange button if the bound
value is not configured. When configured,
displays a current value for the point
under the following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays a non-forced
value. Click to force the value.
For all BACnet inputs, a Forced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Override value

Displays the override value. The Override
value takes precedence over other
values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O
point.
Displays False when the object is in
service and associated with an I/O point.

Override

Displays True or False. When the
Override is True, the output is
overridden.
Continued on next page
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Continued
Description

Property

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Polarity

Select an option to control the
relationship between the physical output
and the output point of the b3 BACnet
device.
Select Normal if you want the output
value of Active to be Active and the
output value of Inactive to be Inactive.
Select Reverse if you want the output
value of Inactive to be Active and the
output value of Inactive to be Active.
These settings simply reverse the value
from the output.

Inactive text

Type the text that explains the Inactive
state of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

Active text

Type the text that explains the Active
state of the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Channel

Select the output channel you want the
point to read from.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click the Command tab.
Continued on next page
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9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Select the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Priority 6 is reserved for the
Minimum_on and Minimum_off properties
of the object. Digital Value and Digital
Output objects in Building Operation do
not support these optional properties.
Priority 6 is read-only.

Priority x

Enter a priority value or Null.

Technical
3363

83 b3 BACnet Device Communication and Configuration
83.35 Creating a b3 BACnet Device Digital Pulsed Output Point

83.35

Creating a b3 BACnet Device Digital
Pulsed Output Point
You create digital pulsed output points in the Application folder of the b3 BACnet
device.
Digital and Multistate Pulsed output points, DateTime and String values, and
program and function objects are non-BACnet proprietary object types. For more
information, see section 76.1 “BACnet Objects and Properties” on page 2663.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device digital pulsed output point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the digital pulsed output point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, select Digital Pulsed Output.

5. In the Name box, type a name for the digital pulsed output point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the digital pulsed output point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Next.
Continued on next page
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11. In the Channel box, enter the output channel where you want the point to
write to.

12. Click Create.
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83.36

Configuring a b3 BACnet Device Digital
Pulsed Output Point
When you configure a b3 BACnet device digital pulsed output point, you can use
the Value box to enter a positive floating point value and set the output to Active for
that duration in seconds. You can only enter a positive value here.

Tip
Entering a value of 3267.7 set the output permanently to Active. Entering a value
of 0 sets the output permanently to Inactive.

To configure a b3 BACnet Device Digital Pulsed Output Point
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device digital pulsed output point.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Enter the value you want for the output
point.

Override value

Displays the override value. The Override
value takes precedence over other
values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is
in one or more of the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O
point.
Displays False when the object is in
service and associated with an I/O point.

Override

Displays True or False. When the
Override is True, the output is
overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Polarity

Select an option to control the
relationship between the physical output
and the output point of the b3 BACnet
device.
Select Normal if you want the output
value of Active to be Active and the
output value of Inactive to be Inactive.
Select Reverse if you want the output
value of Inactive to be Active and the
Continued on next page
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Continued
Property

Description
output value of Inactive to be Active.
These settings simply reverse the value
from the output.

Inactive text

Type the text that explains the Inactive
state of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

Active text

Type the text that explains the Active
state of the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Channel

Select the output channel you want the
point to read from.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click the Command tab.
Continued on next page
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9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Select the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Priority 6 is reserved for the
Minimum_on and Minimum_off properties
of the object. Digital Value and Digital
Output objects in Building Operation do
not support these optional properties.
Priority 6 is read-only.

Priority x

Enter a priority value or Null.
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83.37

Creating a b3 BACnet Device Analog
Value
You create analog values in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device analog value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the analog value.
2. Select Application.
3. On the File menu, point to New and then click Value.
4. In the object type list, select BACnet Analog Value (Continuum).

5. In the Name box, type a name for the analog value.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the analog value.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do no type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Create.
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83.38

Configuring a b3 BACnet Device Analog
Value
You configure analog values to store numeric information for the b3 BACnet device.
b3 BACnet device value objects are storage locations in the controller's memory.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device analog value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device analog value.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Enter the bound value to be used as a
control system parameter under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays non-forced value.
Click to force the value.
For all BACnet inputs, a Foced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the
control system parameter. When
checked, the point is in one or more of
the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Select True to indicate the object is out
of service and disconnected from the I/O
point. You can also select True when you
want to change the Value for testing
purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
Continued on next page
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Continued
Property

Description
alarming.

COV increment

Enter the minimum change in the Value
property that causes a COV notification to
be sent. The default COV increment is
.10.

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

6. Click the Advanced tab.
7. Edit the Advanced properties.
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.
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8. Click the Command tab.
9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Enter the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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83.39

Configuring the COV Increment and the
Unit for a b3 BACnet Device Analog
Value
You configure the COV increment and the unit for a b3 BACnet device analog value
to ensure that the analog value holds the COV increment and the unit as required by
the project.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure the COV increment and the unit for a b3 BACnet
device analog value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device analog value.
3. On the File menu, click Properties.
4. Click the Basic tab.

5. For Value, click the Configure Settings icon

.
Continued on next page
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6. Select the Configured box that is in front of the Unit box.

7. In the Unit box, enter the unit.
8. Click OK.
Continued on next page
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9. In the COV increment box, enter the minimum change in the Value property
that causes a COV notification to be sent.

10. Click OK.
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83.40

Creating a b3 BACnet Device Digital
Value
You create digital values in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device digital value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the digital value.
2. Select Application.
3. On the File menu, point to New and then click Value.
4. In the object type list, select BACnet Digital Value (Continuum).

5. In the Name box, type a name for the digital value.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the digital value.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Create.
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83.41

Configuring a b3 BACnet Device Digital
Value
You configure digital values as control system parameters that have only one of two
possible states: Active (enabled) or Inactive (disabled).
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device digital value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device digital value.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Enter the bound value to be used as a
control system parameter under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays non-forced value.
Click to force the value.
For all BACnet inputs, a Foced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the
control system parameter. When
checked, the point is in one or more of
the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Select True to indicate the object is out
of service and disconnected from the I/O
point. You can also select True when you
want to change the Value for testing
purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
Continued on next page
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Continued
Property

Description
alarming.

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

Inactive text

Type the text that explains the Inactive
state of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

Active text

Type the text that explains the Active
state of the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support
this property.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click the Command tab.
Continued on next page
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9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Select the value to be used by the Value
property when all values in the priority
array are set to Null.

Priority 6

Priority 6 is reserved for the
Minimum_on and Minimum_off properties
of the object. Digital Value and Digital
Output objects in Building Operation do
not support these optional properties.
Priority 6 is read-only.

Priority x

Enter a priority value or Null.
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83.42

Creating a b3 BACnet Device DateTime
Value
You create datetime values in the Application folder of the b3 BACnet device.
Digital and Multistate Pulsed output points, DateTime and String values, and
program and function objects are non-BACnet proprietary object types. For more
information, see section 76.1 “BACnet Objects and Properties” on page 2663.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet Device datetime value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the datetime value.
2. Select Application.
3. On the File menu, point to New and then click Value.
4. In the object type list, select DateTime Value.

5. In the Name box, type a name for the datetime value.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the datetime value.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Create.
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83.43

Configuring a b3 BACnet Device
DateTime Value
You configure datetime values to store date and time information used in schedules
and timestamps.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device datetime value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device datetime value.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Edit the Basic properties.
Property

Description

State

Select either Enabled or Disabled to
specify whether or not the value is usable

Value

Click the down arrow and calendar
displays. Then, click the date you want or
use the arrows to change the time. Any
available date and time that you select
from the displays are valid entries.
The default DateTime value is 12:00 A.M
(GMT) on December 31, 1988.

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

6. Cick the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.
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83.44

Creating a b3 BACnet Device String
Value
You create string values in the Application folder of the b3 BACnet device.
Digital and Multistate Pulsed output points, DateTime and String values, and
program and function objects are non-BACnet proprietary object types. For more
information, see section 76.1 “BACnet Objects and Properties” on page 2663.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device string value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the string value point.
2. Select Application.
3. On the File menu, point to New and then click Value.
4. In the object type list, select String Value.

5. In the Name box, type a name for the string value point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the string value point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Create.
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83.45

Configuring a b3 BACnet Device String
Value
You configure string values to hold plain text that can include messages displayed
to an operator when a setpoint is reached.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device string value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device string value.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Edit the Basic properties.
Property

Description

State

Select either Enabled or Disabled to
specify whether or not the value is usable

Value

Enter the value you want.

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

String size

Enter the size of the text string. The
minimum size is 1 character and the
maximum is 32 characters.

6. Click the Advanced tab.
Continued on next page
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7. Edit the Advanced properties.
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.
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83.46

Creating a b3 BACnet Device Multistate
Value
You create multistate values in the Application folder of the b3 BACnet device.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To create a b3 BACnet device multistate value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create the multistate value.
2. Select Application.
3. On the File menu, point to New and then click Value.
4. In the object type list, select BACnet Multistate Value (Continuum).

5. In the Name box, type a name for the multistate value point.
You can type more than 16 characters for b3 object display names and are
not restricted to using only letters, digits, and underscores.
6. In the Description box, type a description for the multistate value point.
7. Click Next.
Continued on next page
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8. Under Instance ID, generate or enter a BACnet Instance ID:
• Click Automatically generated to have the server generate a BACnet
Instance ID for you (Recommended).
• Click Manually entered to manually enter a BACnet Instance ID, and
then type an appropriate Instance ID for the BACnet object.
If you enter an Instance ID manually, you must ensure it is unique within the
application for this type.

9. In the BACnet name box, type a BACnet name for the object. Do not type a
name if you want it assigned for you.
You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the
Building Operation object name is truncated and special characters and
spaces are removed.
10. Click Create.
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83.47

Configuring a b3 BACnet Device
Multistate Value
You configure multistate values to use as control system parameters, or as any one
of a set that you define (for example, Day of Week).
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To configure a b3 BACnet device multistate value
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device and
then select Application.
2. In the List View, select the b3 BACnet device multistate value.
3. On the File menu, click Properties.
4. Click the Basic tab.
Continued on next page
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5. Edit the Basic properties.
Property

Description

Value

Enter the bound value to be used as a
control system parameter under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to
release the value.
• Force – Displays non-forced value.
Click to force the value.
For all BACnet inputs, a Foced condition
is the same as out of service. For more
information, see the Forced Values topic
on WebHelp.
For BACnet outputs and values, which
are commandable, a Forced status may
also include a priority level setting. For
more information, see section 77.7
“Forced Priority Level” on page 2857.

Status flags

Displays the condition or status of the
control system parameter. When
checked, the point is in one or more of
the following states:
• In alarm: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains
unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet
devices. The box remains
unchecked.
• Overridden: This flag is not
supported by Building Operation b3
BACnet devices. The box remains
unchecked.
• Out of service: Displays a check if
the point is out of service or the the
point is not configured with a valid
I/O channel.

Out of service

Select True to indicate the object is out
of service and disconnected from the I/O
point. You can also select True when you
want to change the Value for testing
purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
Continued on next page
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Continued
Property

Description
alarming.

6. Click the Advanced tab.
7. Edit the Advanced properties.
Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used
as the BACnet name.

BACnet type

Displays the type, which is always device.

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log
to store- up to a maximum of 32767
entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or
Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want
the point to trigger when the value
changes.

8. Click the Command tab.
Continued on next page

Technical
3400

04-16006-04-en, March 2015

83 b3 BACnet Device Communication and Configuration
83.47 Configuring a b3 BACnet Device Multistate Value

9. Edit the Command properties.
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Select the value to be used by the Value
property when all values in the priority
array are set to Null.

Prority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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83.48

Renaming b3 BACnet Device Points or
Values
You rename b3 BACnet device points or values if you wish to change the name to
something more specific, or if the point or value was initially named incorrectly.
Because the binding templates require a naming convention, you may also need to
rename a point or value to match a convention imposed after they were created.
Instead of having to delete the point or value and configure new one, you do a
rename instead.
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To rename b3 BACnet device points or values
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to rename a point or value.
2. Select Application.
3. In the List View, click the point or value you want to rename.
4. On the Edit menu, click Rename.
5. In the Object name box, type the new name.
6. Click OK.
7. In the List View, select the renamed b3 point or value to change its BACnet
name.
8. On the File menu, click Properties.
9. Click the Advanced tab.
Continued on next page
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10. In the BACnet name box, change the BACnet name to agree with the
renamed point or value's display name.

Tip
The name you enter is restricted to 16 characters, consisting of
letters, numbers, and underscores.
11. Click OK.
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83.49

Learning b3 BACnet Devices
You learn b3 BACnet devices to automatically assign the node IDs and initiate
communication with devices on the MS/TP network.

Tip
• You learn b3 BACnet devices when the devices and the Automation Server
functioning as the BACnet interface are connected and online. If the b3
BACnet devices are not physically connected to the network, it is also
possible to create and configure the devices offline in WorkStation.
For more information, see section 82.4 “b3 BACnet Device Networks” on page
3258.

To learn b3 BACnet devices
1. In WorkStation, in the System Tree pane, select the MSTP Network.
2. On the Actions menu, point to b3 devices and then click Learn.
3. When the b3 BACnet devices are learned, click Close.
Now that you have learned the devices, you can perform a download to eliminate
any old points and programs stored on the device. For more information, see
section 83.51 “Downloading to a b3 BACnet Device” on page 3404.
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83.50

Viewing Attributes and Objects
Associated with the b3 BACnet Device
Once you have created the b3 BACnet device on the MS/TP Network, you can use
the List View to see the b3 objects associated with that device.
For more information, see section 82.4 “b3 BACnet Device Networks” on page
3258.

To view attributes and objects associated with a b3 BACnet
device
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device where
you want to view attributes and objects.
2. Select Application.
3. In the List View, observe the attributes and objects associated with the b3
BACnet device.
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83.51

Downloading to a b3 BACnet Device
After a reset, you download the objects that remain in the database to the b3
BACnet device.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

To download to a b3 BACnet device
1. In WorkStation, in the System Tree pane, select the MSTP Network.
2. In the List View, select the b3 BACnet devices for which you want to
download objects.

Tip
• You can download objects to multiple devices at the same time.
3. On the Actions menu, click Download.
A decision box displays indicating that the download operation will attempt to
delete any non-Building Operation object in the device.
4. Click Yes to proceed.
5. Use the Progress view to monitor the Download command.

Note
• Download performs three steps: commission, reset, and
download objects. A status bar shows the commissioning and
download operations as they occur and lists the objects as they
are commissioned and downloaded.

6. Click Close to close the Progress view.
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83.52

Commissioning a b3 BACnet Device
You synchronize the MAC address with the value in the database by commissioning
the b3 BACnet device. This is particularly useful in those situations where the
device’s MAC address may not match the database (for example, a factory-set b3).
For more information, see section 83.17 “b3 BACnet Device Point and Value
Configuration” on page 3300.

To commission a b3 BACnet device
1. In WorkStation, in the System Tree pane, select the MSTP Network.
2. In the List View, select the b3 BACnet devices that you want to commission.

Tip
• You can commission multiple devices at the same time.
3. On the Actions menu, point to Device and then click Commission.
4. Click Close when the operation is completed.
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83.53

Resetting a b3 BACnet Device
You reset a b3 BACnet device to delete all points and programs stored on the
device and therefore clear flash memory.
For more information, see section 84.3 “b3 BACnet Device Memory” on page 3431.

To reset a b3 BACnet device
1. In WorkStation, in the System Tree pane, select the b3 BACnet device under
the MSTP Network.
2. On the Actions menu, point to Device and then click Reset.

Caution
• Use Reset with caution because this command deletes all
objects from the device and also clears flash memory.
3. Click Yes.

Objects remain in the database after the reset. You can download these objects to
the device.
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83.54

Schedules for b3 BACnet Devices
A schedule is a sequence of events that determines when an essential event occurs
in a building automation system. For example, you use a schedule to control when
the lights or fans go on and off in a building.
Controller Action

Schedule Type

b3 device with two output states, such as on Digital
or off, controls lighting
b3 device with multiple output states based
on positive and negative whole numbers,
such as off = 0, low = 1, medium = 2,
controls fan speed

Multistate

b3 device with multiple output states in real
numbers, such as 0.5, adjusts a thermostat
by 0.5 degrees.

Analog

Schedules for b3 BACnet devices are used in the same way as for other BACnet
devices in Building Operation. However, there are some differences between the
standard Building Operation schedule editor and the b3 Building Operation
schedule editor.
For example, the following properties are not available in the property grid:
• Time Since Previous Transition
• Next transition value
• Time to next transition
• Following transition value
• Time to following transition
• Remove past events
Also, b3 schedules cannot shadow a Lead Schedule.
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83.55

Trend Logs for b3 BACnet Devices
You use a trend log to collect data and then store the records. A record contains a
log value or an event as well as its time stamp and an optional comment. A trend
log can log an analog variable, a digital variable, or an integer variable.
For example, in a b3 BACnet device, you might use trend logs to monitor
temperature input values in an area of a building. You can then use the log viewing
capability in the b3 to view a trend log chart of these temperature values.
Trend logs in b3 BACnet devices are used in the same way as in other Building
Operation devices. However, there are some minor differences originating from
software considerations. For example, in a b3 BACnet device you can trend two
different ways:
• A proprietary log on the object itself (sometimes referred to as Infinity Logs).
These logs are not available for objects (BACnet or otherwise) in the Building
Operation server.
• A BACnet Trend Object referring to a BACnet property of a BACnet object.
This is very similar for BACnet objects in Building Operation servers.
There are also some differences between trend logs in b3 BACnet devices and
other BACnet devices in Building Operation. For instance, the following properties
are not available in the b3 BACnet device property grid:
• Logging Type- Set Log Interval to 0 to select COV, or any positive value to
select Interval
• Delta
Intrinsic reporting is not available for b3 BACnet devices.
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83.56

Extended Trend Logs for b3 Point and
Value Device Logs
You use an extended trend log to store log records for long periods of time without
encumbering the Automation Server's memory. The extended trend log is often
saved on a higher-level server with more storage capacity. This extra storage
capacity enables the server to store more records before overwriting the old ones.
For more information, see the Extended Trend Logs topic on WebHelp.
You configure extended trend logs in b3 BACnet devices the same way you
configure extended trend logs in other Building Operation devices. There is one
difference, however. You cannot use smart logs when configuring extended trend
logs in b3 BACnet devices.
Instead of using smart logs, you use the Maximum transfer interval property to
specify the transfer interval.

Figure: Maximum transfer interval property

You can calculate a value for the Maximum transfer interval property by using
the Log records and Log interval settings located in the Advanced tab of the b3
point or value monitored by the extended trend log.
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Figure: Log records and log interval properties

You multiply the size of the log records by the log interval to determine the transfer
interval. For example, if the size of the log records is 24 and the log interval is 1
hour, calculate the interval as follows:
24 x 1 = 24 hours
Set the transfer interval to a value less than 24 hours to obtain all of the log entries.
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83.57

Creating Extended Trend Logs to
Monitor a b3 Point or Value Device Log
You create an extended trend log to transfer records from a b3 point or value
device log.

Tip
Do not use smart logs when creating extended trend logs to monitor a b3 point or
value device log.
For more information, see section 83.56 “Extended Trend Logs for b3 Point and
Value Device Logs” on page 3409.

To create extended trend logs to monitor b3 device logs
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to create an extended trend log.
2. Select Application.
3. In the List View, select the b3 BACnet device point or value that you want to
transfer records from.
4. On the File menu, click Properties.
5. Click the Advanced tab.

Tip
An extended trend log will not transfer logs from the point or value if
the Log type is Manual.
Continued on next page
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6. Multiply the Log records by the Log interval to calculate the maximum
transfer interval.
The transfer interval is the frequency at which the extended trend log will
transfer log records from the b3 point or value.
7. In the System Tree pane, expand the b3 BACnet device.
8. Select Application.

Tip
It is not a requirement that you locate an extended trend log in the
Application folder of the b3 BACnet device. You can also create an
extended trend log elsewhere, such as an Enterprise Server.
9. On the File menu, point to New and then click Trend.
10. In the object type list, select Extended Trend Log and then click Next.
Continued on next page
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11. In the Monitored trend log box, enter the b3 point or value that you want to
transfer records from.

12. In the Smart log box, select False.
13. In the Maximum transfer interval box, select the transfer interval.

Tip
Be sure to select a transfer interval that is less than the value you
calculated in Step 6 in order to obtain all of the log entries.
14. Click Create.
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83.58

Alarms for b3 BACnet Devices
You use an alarm to monitor a variable and alert you if the monitored variable
matches the configured alarm conditions. For example, an alarm can send a
notification to a specified user or user group when the alarm is triggered or force the
user that acknowledges the alarm to write a cause note. You can also configure the
alarm to flash and play a sound when triggered.
In a b3 BACnet device, you can set the temperature in a room and then trigger an
alarm if the temperature falls below or exceeds that point. Alarms originating from
external sources, such as BACnet networks, are handled and displayed like other
Building Operation alarms.
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83.59

Creating a b3 BACnet Device Alarm
You create an alarm for a b3 BACnet device in the application folder.
For more information, see section 83.58 “Alarms for b3 BACnet Devices” on page
3414.

To create a b3 device alarm
1. In WorkStation, in the System Tree pane, expand the b3 device where you
want to create the point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, click a point type.
5. Create a new point with a value property that you can create an alarm for (for
example, a new analog input point). For more information, see section 83.18
“Creating a b3 BACnet Device Analog Input Point” on page 3302.
6. In the System Tree pane, expand the b3 BACnet device where you want to
create the alarm.
7. Select Application.
8. On the File menu, click New and then click Alarm.
9. In the alarm type list, click BACnet Alarm (Continuum).

10. In the Name box, type a name for the alarm.
11. In the Description box, type a description.
Continued on next page
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12. Click Next.

13. In the Instance ID box, click Automatically generated to have the server
generate a BACnet instance ID for you. Click Manually entered if you want
and enter the Instance ID yourself.
14. In the BACnet name box, type a BACnet name for the alarm. Do not type a
name if you want a name to be assigned for you.
15. Click Create.
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83.60

Creating a b3 BACnet Device
Notification
You create a notification for a b3 BACnet device in the application folder.
For more information, see section 83.58 “Alarms for b3 BACnet Devices” on page
3414.

To create a b3 device notification
1. In WorkStation, in the System Tree pane, expand the b3 device where you
want to create the point.
2. Select Application.
3. On the File menu, point to New and then click Point.
4. In the object type list, click a point type.
5. Create a new point with a value property that you can create an alarm for (for
example, a new analog input point). For more information, see section 83.18
“Creating a b3 BACnet Device Analog Input Point” on page 3302.
6. In the System Tree pane, expand the b3 BACnet device where you want to
create the notification.
7. Select Application.
8. On the File menu, click New and then click Alarm.
9. In the object type list, click BACnet Notification (Continuum).

10. In the Name box, type a name for the notification.
11. In the Description box, type a description for the notification.
Continued on next page
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12. Click Next.

13. In the Instance ID box, click Automatically generated to have the server
generate a BACnet instance ID for you. Click Manually entered if you want
and then enter an Instance ID yourself.
14. In the BACnet name box, type a BACnet name for the notification. Do not
type a name if you want a name to be assigned for you.
15. Click Create.
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83.61

Configuring b3 BACnet Devices after an
Import
After an import, you need to associate the device object with a live b3 BACnet
device in the Hardware folder and then download the b3 BACnet device.
For more information, see section 18.7 “Import and Export of b3 Solutions” on page
566.

To configure b3 BACnet devices after an import
1. In WorkStation, in the System Tree pane, click the BACnet Interface
folder.
2. On the File menu, click Import.
3. Navigate to the file you would like to import.
4. Click Open to import the selected file.
In this example, you import a new MSTP network with a single b3 BACnet
device.

Continued on next page
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5. Observe the newly-imported b3 BACnet device in the System Tree.
Notice the red cross through the device icon. This indicates that the device is
currently unusable.

Notice also the Advanced tab in the Properties pane of the imported b3
BACnet device. The Object ID is Null indicating once again the device is
unusable.

Continued on next page
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6. In the Hardware folder, select a b3 BACnet device that you wish to associate
with the new imported b3 BACnet device.

Note
Be aware that the associate operation only works when the b3
BACnet device has been learned at least once. For more information,
see section 83.49 “Learning b3 BACnet Devices” on page 3402.
If you have a b3 BACnet device with factory settings, perform a learn
and then delete the learned device from the MSTP network. After
doing so, discover the b3 BACnet device and associate the imported
device with the b3 BACnet device in the Hardware folder as
explained in Step 7.
Continued on next page
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7. Drag and drop the new b3 BACnet device from the Hardware folder to the
imported b3 BACnet device's icon in the MSTP Network.
Notice that the b3 BACnet device icon is now active in the System Tree.

Notice also that the imported b3 BACnet device now contains the Object ID
of the device in the Hardware folder.

Continued on next page
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8. In the System Tree, click the b3 BACnet device and right-click Download.

9. Once the download is complete, observe the operational b3 BACnet device
and its values.
For example, in the Application folder beneath the b3 BACnet device, you
can drag these b3 object values to the Watch Window and observe them as
they change.
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84.1 b3 BACnet Device Models and Program Memory

84.1

b3 BACnet Device Models and Program
Memory
There are many different models of b3 BACnet devices shipped from the factory
with the operating system preprogrammed into their program memory.

84.1.1

b3 BACnet Device Models
There are a variety of b3 BACnet device models with varying inputs, outputs,
expansion modules, and other features.
For more information, see section 84.2 “b3 BACnet Device Models” on page 3429.

84.1.2

b3 BACnet Device Program Memory
b3 BACnet devices contain program and data memory. This memory holds the
configuration data and the programs the controller uses during operation.
For more information, see section 84.3 “b3 BACnet Device Memory” on page 3431.

84.1.3

b3 BACnet Device Restart Modes
In WorkStation, you can configure how you want the b3 BACnet device to restart
after a power failure. You do so by using the RestartMode system variable, which is
automatically created when you configure the controller.
For more information, see section 84.4 “b3 BACnet Device Restart Modes” on page
3433.

84.1.4

b3 BACnet Device Supported Object Types
There are a variety of b3 BACnet device supported object types.
For more information, see section 84.5 “b3 BACnet Device Supported Object
Types” on page 3434.

84.1.5

b3 BACnet Device Device Logs
A log is a collection of point values manually set or automatically recorded, stored in
an array, and available for retrieval at a later date.
For more information, see section 84.6 “b3 BACnet Device Logs” on page 3436.
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84.1.6

b3 BACnet Device Object Names
b3 BACnet device objects have two different names:
• An object display name that shows in WorkStation
• A BACnet name that represents the object in the device
For more information, see section 84.7 “b3 BACnet Device Object Names” on page
3437.
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84.2

b3 BACnet Device Models
There are a variety of b3 BACnet device models with varying inputs, outputs,
expansion modules, and other features.
The following table describes the b3 BACnet device models used with Building
Operation.
Table: Device Models Used with Building Operation
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Model

Description

b3850

Inputs: 4 Universal, 1 Smart Sensor;
Outputs: 3 Form A, 1 Form K Tri-state; Other
Features: 1 Airflow Sensor, Expansion
Interfacea

b3851

Inputs: 4 Universal, 1 Smart Sensor;
Outputs: 3 Form A, 1 Form K Tri-state; Other
Features: Expansion Interfacea

b3853

Inputs: 4 Universal, 1 Smart Sensor:
Outputs: 3 Form A, 1 Form K Tri-state; Other
Features: 2 Airflow Sensors, Expansion
Interfacea

b3920

Inputs: 16 Universal, 1 Smart Sensor;
Outputs: 8 Form C, 8 Analog; Other
Features: Output Override Control,
Expansion Interfacea

b3865

Inputs: 4 Universal, 1 Smart Sensor;
Outputs: 3 Form A Triac, 1 Tri-state Actuator
Control; Other Features: 1 Airfow Sensor,
Built-in Actuator

b3866

Inputs: 4 Universal, 1 Smart Sensor;
Outputs: 3 Form A Triac; 1 Tri-state Actuator
Control, 2 Analog; Other Features: 1 Airflow
Sensor, Built-in Actuator

b3867

Inputs: 4 Universal, 1 Smart Sensor;
Outputs: 5 Form A Triac, 2 Analog

b3885

Inputs: 2 Universal; Outputs: 3 Form A Triac,
1 Tri-state Actuator Control; Other Features:
1 Airflow Sensor, Built-in Actuator

b3800

Inputs: 8 Universal, 1 Smart Sensor;
Outputs: 8 Form C

b3804

Inputs: 8 Universal, 1 Smart Sensor;
Outputs: 8 Form C, 4 Analog

b3810

Inputs: 8 Universal, 1 Smart Sensor;
Outputs: 8 Form C; Other Features: Output
Override Control, Expansion Interfacea
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Continued
Model

Description

b3814

Inputs: 8 Universal, 1 Smart Sensor;
Outputs: 4 Form C, 4 Analog; Other
Features: Output Override Control,
Expansion Interfacea

b3608

Inputs: 8 Universal; Outputs: None

b3624

Inputs: 24 Universal; Outputs: None

b3887

Inputs: 3 Universal, 1 Smart Sensor;
Outputs: 4 Form A Triac, 1 Form A Relay

a) b3 BACnet devices with expansion interfaces can each connect to two expansion modules. You
connect expansion modules to the b3 BACnet devices using the expansion connector located on
the bottom of the unit. You can either connect the expansion modules directly to the controller, or
connect them using a cable.

You can use different b3 BACnet controller models for specific field controller
applications. For example, there are several models that contain VAV actuators and
airflow sensors. The models that have only universal inputs, like the b3608 and
b3624, are also commonly used in security applications to monitor intrusion points.

Note
• Supported functions also vary based on the b3 model.
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84.3

b3 BACnet Device Memory
b3 BACnet devices contain program and data memory. This memory holds the
configuration data and the programs the controller uses during operation.
There are two distinct program memories in the b3: one is dedicated to the lowerlevel operation of the controller, while the other holds user-defined items such as
point data and Script programs.

84.3.1

Application Memory
Your Script programs and point data are stored in application memory. This
memory is backed up with a battery to guard against power failure.

Note
• There is no battery in the b3887 model.
The controller includes an extra flash memory for storing some of the application
data too. Flash memory is a type of memory that has the ability to retain its contents
even during a power failure. Flash does not require batteries to retain this
information.
You can command flash memory to store the configuration data contained in the
battery-backed memory as an extra insurance against loss. While including flash
memory along with battery-backed memory to hold application data can initially
seem redundant, this very redundancy makes it attractive. Although battery failure
or data corruption in memory are unlikely, periodically locking your configuration
data into flash memory provides an extra layer of protection for your data.

84.3.2

Back Up Objects to Flash Memory
You can use WorkStation to back up all of the objects in the b3 BACnet device to
flash memory. As the backup to flash operation occurs, you can then use the
FlashWRCount, LastBackup, StatusBackup, and StatusFlash system variables to
monitor the status of this operation as described in the table that follows.
Table: Backup to Flash System Variables
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Variable

Description

FlashWRCount

Stores a running tally of the number of write
operations performed on flash memory. This
variable increments each time data is written
to flash memory.

LastBackup

Indicates the last time flash memory was
written to.
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Continued
Variable

Description

StatusBackup

Specifies one of the following:
• A backup to flash is needed
(BackupNeeded).
• A backup is in process (BackingUp).
• A backup operation is finished (Backup
Done).

StatusFlash

Indicates the state of the flash memory
device as follows:
• FlashEmpty indicates there is no valid
database in flash memory.
• FlashValid indicates that a valid
database is present.
• FlashFailure indicates that an error was
encountered while trying to perform a
backup to flash. In this state, the data in
flash is unusable.

84.3.3

Flash Memory Limitations
Flash memory circuits are rated for a limited number of write operations (minimum
of 10,000 to an average expected lifetime of 100,000). In the controller, flash
memory is used for storing completed configurations. When used in this manner,
the memory should last the lifetime of the product.
The table that follows lists all of the operations that are available.
Table: Average Expected Lifetime of Flash Memory Circuits
Write to Flash

Number of Operations Available

1 time per day

27 years at minimum rating
274 years at average expected lifetime

10 times per day

2.7 years at a minimum rating
27 years a average expected lifetime

If you are concerned about exceeding the maximum number of writes, the b3
BACnet device includes an automatic software-based circuit breaker that warns
you at certain intervals.

Technical
3434

04-16006-04-en, March 2015

84 b3 BACnet Device Models and Memory
84.4 b3 BACnet Device Restart Modes

84.4

b3 BACnet Device Restart Modes
In WorkStation, you can configure how you want the b3 BACnet device to restart
after a power failure. You do so by using the RestartMode system variable, which is
automatically created when you configure the controller.
If a power failure occurs, the b3 BACnet device is reinitialized with the objects
stored in the device’s flash memory. The table that follows lists the available restart
mode settings:
Table: Available Restart Mode Settings
Setting

Description

Warm start only

Upon recovering from a reset, the b3
attempts a warm start. In a warm start, the
b3 powers up from a reset with a user
configuration in place. The user configuration
is the one that was present in the controller
and preserved due to battery-backed
memory when it was reset and/or power
was lost.Point log data is preserved. Script
programs are restarted at the same logical
line that was being interpreted when the
controller shut down, and all user points
have their values restored.
If the warm start fails, the b3 proceeds with a
cool start.

Cool start only

Upon recovering from a reset, the b3
attempts a cool start. In a cool start, the b3
powers up from reset and restores the user
configuration from flash memory. Point log
data is not restored (with the exception of
manual arrays on setpoints).
Script programs are started at their
beginning, and user points, whose setpoint
attribute has been set, have their values
restored. You can think of a cool start as a
“self reload.”
If the cool start fails, the b3 proceeds with a
cold start.

Warm to cool
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The b3 attempts a warm start. If that fails,
the b3 proceeds with a cool start. If that fails,
the b3 then proceeds with a cold start. This
is the default mode.
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84.5

b3 BACnet Device Supported Object
Types
There are a variety of b3 BACnet device supported object types.
The following table lists and describes these supported types.
Table: Supported Object Types
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Category

Object Type

Description

Command

command

Writes a set of values to a
group of object properties.

Feedback Control

loop

Creates a PID feedback loop
without manually creating or
editing Script code.

File

file

Permits read and write
access to data files
supported by the device.

Device

device

Identifies the device on the
network.

Notification

event-enrollment

Contains information
required for managing events
within a BACnet system that
can configure various events
types, such as out of range.

Point

multi-state-output

Represents the desired state
of a multiple-state process
(such as off, stage 1 cooling,
stage 2 cooling, and defrost)

Point

multi-state-input

Represents the status of a
multiple-state process, such
as a refrigerator’s on, off, and
defrost cycles.

Point

digital-output

Identifies a physical device or
hardware output used to
switch a piece of equipment
on or off.

Point

digital-input

Identifies a physical device or
hardware input that can be in
only one of two distinct
states: on or off.

Point

analog-output

Outputs analog signals, such
as voltage.

Point

analog-input

Connections on a controller
to analog sensors, for
example, voltage and
temperature.
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Category

Object Type

Description

Schedule

calendar

Specifies a set of days for
exception events in
schedules.

Value

digital-value

Identifies a digital control
parameter that can have only
one of two possible values
that you define: active or
inactive.

Value

analog-value

Identifies a floating point
number, for example,
temperature span in the
controller’s memory.

Notification

notification-class

Contains a list of devices to
be informed if an event
enrollment object determines
that a warning or alarm
message needs to be sent.

Program

program

Contains customizable
application logic.

Schedule

schedule

Contains a collection of
events that determines, for
example, when equipment
runs, processes occur,
personnel have access to an
area, doors lock, or unlock,
heating and lights are
activated.

Value

multi-state-value

Identifies general purpose
objects that are control
system parameters residing
in memory of the BACnet
device.

Trend

trend-log

Lets you configure the
logging of data about other
BACnet object properties.
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84.6

b3 BACnet Device Logs
A log is a collection of point values manually set or automatically recorded, stored in
an array, and available for retrieval at a later date.
You use the Log type property in the point’s Basic tab to specify the log type the
b3 uses to record values. There are five basic log types available in the b3.

Figure: b3 BACnet Device Log Type Settings

Table: b3 BACnet Device Log Types
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Log Type

Description

Manual

Manually logs an item using the values
supplied by a Script program.

LogInstantaneous

Stores the current value of objects at the
beginning of every interval.

LogAverage

Calculates average object values over every
interval using a weighted average algorithm.
Average values are stored at the beginning
of every interval.

LogMinimum

Compares all values over an interval and
finds the minimum value. Minimum values
are stored at the end of every interval.

LogMaximum

Compares all values over an interval and
finds the maximum value. Maximum values
are stored at the end of every interval.
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84.7

b3 BACnet Device Object Names
b3 BACnet device objects have two different names:
• An object display name that shows in WorkStation
• A BACnet name that represents the object in the device
These names have different character and length restrictions. For example, when
you create a point or value in a b3 BACnet device, you are prompted to enter a b3
object display name. You can enter more than 16 characters here and are not
restricted to using only letters, digits, and underscores.
For the BACnet name, you can enter up to 16 characters. The BACnet name
specifies how an object is identified in a b3 device and is composed solely of letters,
digits, and underscores. If you leave the BACnet name box empty, the Building
Operation object name is truncated and spaces are removed for the name to fit in
the box.
The object display name and the BACnet name are not linked, so changing one
does not modify the other. As a result, when you rename a b3 BACnet device point
or value, you need to change both the object display and BACnet names.
You rename b3 BACnet device points or values if you wish to change the name to
something more specific, or if the point or value was initially named incorrectly.
Because the binding templates require a naming convention, you may also need to
rename a point or value to match a convention imposed after they were created.
Instead of having to delete the point or value and configure new one, you do a
rename instead.
For more information, see section 83.48 “Renaming b3 BACnet Device Points or
Values” on page 3400.
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84.8

Setting Up and Viewing b3 BACnet
Device Logs
You set up logs to record every type of object that the b3 BACnet device stores.
You can then use the viewing options to view these objects as events, reports,
trend charts, or trend log lists.
For more information, see section 84.6 “b3 BACnet Device Logs” on page 3436.

To set up and view b3 BACnet device logs
1. In WorkStation, in the System Tree pane, expand the b3 BACnet device
where you want to set up and view the device log.
2. Click Application.
3. In the List View, select an analog input point.
4. On the File menu, select Properties.
5. Click the Advanced tab.
6. In the Log type box, set the log type based on how you want the b3 BACnet
device to record logs.
For more information, see section 84.6 “b3 BACnet Device Logs” on page
3436.

7. In the Log records box, enter how many values you want the log to store up to a maximum of 32767 entries.
Continued on next page
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8. In the the Log interval box, enter how frequently you want to log the value in
Days, Hours, Minutes, or Seconds.
The Last log time box displays the last time a log was recorded.
9. Click OK and the log starts recording.
10. In the List View, select your analog input point.
11. On the View menu, click Events to view log events.
12. Select View and Trend chart to view a trend log chart or View and Trend
log list to view a trend log list (in this example, a list of temperature input
values).
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84.9

Creating a b3 BACnet Device
You can create an offline b3 BACnet device, enter identifying information, and then
commission the device to make it available for network communications.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

To create a b3 BACnet device
1. In WorkStation, in the System Tree pane, select the MSTP Network where
you want to create the b3 BACnet device.
2. On the File menu, point to New and then click b3 Device.
3. In the Name box, type a name for the BACnet device.

Note
• The b3 object display Name is limited to 16 characters
consisting solely of letters, digits, and underscores.

4. In the Description box, type a description for the b3 BACnet device.
5. Click Next.
Continued on next page
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6. Under Download to BACnet device, in the Instance ID box, type a
unique instance ID for BACnet configuration and communication.

7. In the BACnet name box, type a BACnet name. Do not type a name if you
want it assigned for you.

Note
• The BACnet name is limited to 16 characters consisting solely
of letters, digits, and underscores.
8. In the Model name box, select the model name.
9. In the Infinet ID box, enter the Infinet ID for the b3 BACnet device.

Note
The Infinet ID is required for communication between different
devices. Each device is identified by its unique ID number.
10. In the Serial number box, enter the serial number for the b3 BACnet device.

Note
You can obtain the serial number from the label on the device. The
serial number is used to locate the b3 BACnet device on the MS/TP
network. When a message goes out on the network, the b3 BACnet
device responds and identifies itself as the designated device.
Continued on next page
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11. Click Create.
Now that the device is created, you need to commission the device. For more
information, see section 83.52 “Commissioning a b3 BACnet Device” on page
3405.
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84.10

Removing a b3 BACnet Device from the
Software Environment
You remove a b3 BACnet device from the environment by selecting and deleting
the BACnet device folder.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

To remove a b3 BACnet device from the software environment
1. Physically power down the device.
2. In WorkStation, in the System Tree pane, select the BACnet device folder.
3. On the Edit menu, click Delete.
4. In the Confirm Delete dialog box, click Yes.

Note
• The b3 BACnet device is no longer in the system.
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84.11

Replacing a b3 BACnet Device
If a b3 BACnet device fails, you physically replace the device and connect a new
one.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

To replace a b3 BACnet device
1. Remove the defective unit and physically connect and turn on the new b3
BACnet device.
2. In WorkStation, in the System Tree pane, click on the old b3 BACnet device.

Note
• You can use the old b3 BACnet device and its objects on the
network. You do not need to create a new device in the
software.
3. Click the File menu and select Properties.
4. In the Properties pane, select the Advanced tab.
5. In the Serial number box, enter the serial number of the replacement b3
BACnet device.

6. In the System Tree pane, click the b3 BACnet device.
7. On the Actions menu, click Device and then Commission to synchronize
all of the network information.
As the operation occurs, a Progress view displays with a status bar showing
the objects as they are commissioned.
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84.12

Deleting Objects from a b3 BACnet
Device and Automation Server
You use the Delete command to delete an object from a b3 BACnet device and
also from the Automation Server database.
For more information, see section 82.4 “b3 BACnet Device Networks” on page
3258.

To delete objects from a b3 BACnet device and Automation
Server
1. In WorkStation, in the System Tree pane, click the Application folder under
the b3 BACnet device folder.
2. In the List View, select the object you want to delete.
3. On the Edit menu, click Delete.
A Confirm delete dialog box displays asking you to confirm the deletion.

Tip
Should you attempt to delete imported points and values from a b3
BACnet device, you will receive an error and the objects will remain in
the WorkStation. You need to download these objects first and then
delete them.
4. Click Yes.
A Progress view displays showing the deletion process as it occurs.
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84.13

Connecting Expansion Modules and
Configuring the LCD Display
You connect expansion modules to b3 BACnet devices using the expansion
connector located on the bottom of the unit. You connect the expansion modules
directly to the controller, or connect them using a cable.
For more information, see section 84.6 “b3 BACnet Device Logs” on page 3436.

To connect expansion modules and configure the LCD display
1. Locate the expansion connector on the bottom of the b3 BACnet device.
2. Connect the LCD cable to this expansion connector.

3. In WorkStation, in the System Tree pane, click on the b3 BACnet device.
4. On the Actions menu, click Download to send all objects in the database to
the device.

Note
• A Progress view displays with a status bar showing the
commissioning and download operations and listing the objects
as they are commissioned and downloaded.
Continued on next page
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5. Program the LCD display by writing a Script program and binding it to the
following system variables in the b3 BACnet device.
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84.14

Backing Up a b3 BACnet Device to Flash
Memory
When you create, delete, or modify an object, the b3 BACnet device’s database is
no longer synchronized with flash memory. You back up all of the objects in the b3
BACnet device to flash memory and therefore, synchronize the two. If your b3
BACnet device loses power and the battery backup fails, you can restore these
objects from flash memory. In this way, you retain objects, even after a power loss.
For more information, see section 84.3 “b3 BACnet Device Memory” on page 3431.

To back up a b3 BACnet device to flash memory
1. In WorkStation, in the System Tree pane, select the b3 BACnet device.
2. On the Actions menu, point to Device and then click Backup to flash.
3. Use the Progress view to monitor the Backup to flash operation.
4. Click Close to close the Progress view.
5. In the System Tree pane, select the Application folder under the b3
BACnet device.
6. In the List View, select the FlashWRCount, LastBackup,
StatusBackup, and StatusFlash variables and drag them to the Watch
pane.

Continued on next page
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7. In the Watch pane, in the Value column, observe the status of the backup to
flash process.
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84.15

Selecting a Restart Mode
If a power failure occurs and the battery backup fails, the b3 BACnet device is
reinitialized with the objects stored in the device’s flash memory. You specify the
way the controller is configured to restart after a power failure.
For more information, see section 84.4 “b3 BACnet Device Restart Modes” on page
3433.

To select a restart mode
1. In WorkStation, in the System Tree pane, click the Application folder under
the b3 BACnet device.
2. In the List View, click the RestartMode system variable.
3. Click the File menu and select Properties.
4. In the Basic tab, in the Value box, select the way you want the controller to
restart after a power failure.

5. Click OK.
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84.16

Updating Firmware in a b3 BACnet
Device
You update the firmware in order to upgrade the operating system of the b3
BACnet device.
For more information, see section 82.3 “b3 BACnet Device Controllers” on page
3257.

To update firmware in a b3 BACnet device
1. In WorkStation, in the System Tree pane, select the b3 BACnet device in the
MSTP Network.
2. On the Actions menu, point to Device and then click Update firmware.
3. In the Update B3Controller File dialog box, select the update file and click
Open to send this file to the b3 BACnet device.
4. To save the results of the update to a file, click Save Results to File, select
the location, and then click OK.

5. Click Exit.
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85.1

b3 BACnet Device System Tree Icons
The following table describes the b3 BACnet device icons in the System Tree pane.
Table: b3 BACnet Device System Tree Icons
Icon

Description
b3 BACnet Device
Indicates a b3 BACnet device. For more information, see section 82.4 “b3
BACnet Device Networks” on page 3258.
IP Network
Indicates an IP network. For more information, see section 83.2 “Communication
Between the AS and b3 BACnet Device” on page 3270.
MS/TP Network
Indicates an MS/TP Network. For more information, see section 83.2
“Communication Between the AS and b3 BACnet Device” on page 3270.
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85.2

Actions Menu – Device Submenu
Use the Device submenu to manage b3 BACnet devices.

Figure: Actions Menu- Device Submenu

Table: Device Submenu
Command

Description

Associate with device

Click to assign the BACnet instance number
of an external BACnet device to a device
(generic). Do not use the command to
change the instance number of a device
(generic) that already has an assigned
instance number. For more information, see
section 81.161 “BACnet Associate with
Device Dialog Box” on page 3244.

Backup

Click to back up a BACnet device. The data
that gets backed up is device dependent.
Only some devices support the backup of
configuration properties and objects. For
more information, see section 75.39
“BACnet Backup and Restore” on page
2653.

Backup to flash

Click to back up all objects in the b3 BACnet
device to flash memory.
Flash memory allows you to store the
system configuration data contained in the
battery-backed memory as an extra
insurance against loss. For more information,
see section 84.3 “b3 BACnet Device
Memory” on page 3431.

Commission

Click to synchronize the MAC address in the
b3 BACnet device with the value in the
database.
Issuing a Commission command is
particularly useful in those situations where
the device's MAC address may not match
the database (for example, a factory-set b3).
For more information, see section 83.52
“Commissioning a b3 BACnet Device” on
page 3405.
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Continued
Command

Description

Communication

Click to open the Communication
submenu where you enable or disable the
communication of a BACnet device, or
disable the initiation of communication of a
BACnet device in the BACnet internetwork.
For more information, see section 81.160
“Actions Menu – Device Submenu –
Communication Submenu ” on page 3243.

Communication

Use the Communication submenu to
enable and disable BACnet device
communications. For more information, see
section 81.160 “Actions Menu – Device
Submenu – Communication Submenu ” on
page 3243..
Building Operation supports the BACnet
Communication Control service that controls
the ability of a device to communicate with
other devices in the BACnet network. You
use the service primarily for diagnostic
purposes. For more information, see section
75.21 “Device Communication and
Diagnostics” on page 2631..

Download configuration

Click to download the configuration
properties of a device to an external BACnet
device. For more information, see section
78.2 “BACnet Download” on page 2864.

Restart

Click to open the Restart submenu where
you warm start or cold start a BACnet
device. For more information, see section
81.158 “Actions Menu – Device Submenu –
Restart Submenu” on page 3241.

Reset

Click to open the Reset Device decision
box where you confirm you want to reset the
b3 BACnet device by deleting all of the
stored points and programs.
If a power failure occurs, the b3 BACnet
device resets with the objects stored in the
device’s flash memory. For more
information, see section 84.4 “b3 BACnet
Device Restart Modes” on page 3433.
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Restore

Click to restore a BACnet device. For more
information, see section 75.39 “BACnet
Backup and Restore” on page 2653.

Time sync

Click to synchronize the time between a
BACnet device and the local server, or to
synchronize the time between the BACnet
device and UTC time. For more information,
see section 81.159 “Actions Menu – Device
Submenu – Time Sync Submenu” on page
3242.
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Continued
Command

Description

Update firmware

Click to open the Update B3 Controller
Firmware dialog box where you upgrade
the operating system of the b3 BACnet
device. For more information, see section
85.5 “Update b3 Controller Firmware Dialog
Box” on page 3466.
The b3 BACnet device is shipped from the
factory with the operating system preprogrammed into its program memory. For
more information, see section 84.3 “b3
BACnet Device Memory” on page 3431.

Upload configuration
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Click to upload the configuration properties
of an external BACnet device to a device.
For more information, see section 78.9
“BACnet Upload” on page 2872.
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85.3

b3 BACnet Device Properties – Basic
Tab
Use the Basic tab to view and edit the properties of the b3 BACnet device.

Figure: b3 BACnet Device properties - basic tab

Table: Basic Tab
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Component

Description

Status

Displays whether the device is online or
offline.

System status

Displays whether the system is operational
or non-operational.

Database revision

Displays the current revision of the database.

Device changed

Displays True when the device status has
changed.

Update progress

Displays the number of recent attempt to
update the firmware of a device.

Update status

Displays the result of the most recent
attempt to update the firmware of a device.

Local time

Displays the local date and time.
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Continued
Component

Description

Daylight Savings

Select True to use daylight savings time.
Be sure to update daylight savings status
twice a year. Be sure also to configure the
daylight savings status to match the
Automation Server. For more information,
see the Configuring Daylight Savings
Settings for Multiple BACnet Devices topic
on WebHelp.

UTC Offset (min)

Enter the number of minutes difference
between your local time and Greenwich
Mean Time.
Be sure to configure the UTC offset to match
the Automation Server. For more
information, see the Configuring Time Zone
Settings for Multiple BACnet devices topic
on WebHelp.
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85.4

b3 BACnet Device Properties –
Advanced Tab
Use the Advanced tab to review communication and protocol status.

Figure: b3 BACnet Device properties - advanced tab
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Table: Advanced Tab
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Component

Description

Object ID

Displays the unique ID of the device on the
BACnet internetwork.

BACnet name

Type a device name for the b3 BACnet
device. The name is limited to 16 characters
consisting solely of letters, digits, and
underscores.

BACnet type

Displays the type of BACnet object.

Model name

Displays the model name of the BACnet
device.

Vendor name

Displays the name of the vendor that made
the device.

Vendor identifier

Displays the unique number that identifies
the BACnet vendor.

MAC address

Displays the MAC address number, which
uniquely identifies each node of a network.
For BACnet MS/TP protocol, numbers 1 to
127 are for master devices; numbers 128 to
254 are for slave devices.

Application software version

Displays the current revision of the
application software.

Firmware version

Displays the current revision of the firmware
from the flash memory of the field device.

Location

Type the location of the b3 BACnet device.

APDU segment timeout (ms)

Type the amount of time, in milliseconds,
between retransmission of an unanswered
message segment. The default value is 2000
milliseconds (2 seconds).

APDU timeout (ms)

Type the amount of time, in milliseconds,
between retransmission of an unanswered
message. The default value is 3000
milliseconds (3 seconds).

Number of APDU retries

Type the maximum number of times that an
unanswered message is retransmitted. The
default value is 3 times.

Enode ID

Displays the EnergyNet ID of the b3 BACnet
device's parent controller.

Infinet ID

Type the uniquely-assigned ID of the b3
BACnet device on the field bus.

Serial number

Type the serial number of the b3 BACnet
device.

Port number

Displays the COM Port (A or B) used on the
Automation Server.
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Component

Description

Segmentation supported

Displays whether the BACnet device
supports segmentation of messages and if
so, whether it supports segmented
transmissions, receptions, or both.

Maximum segments accepted

Displays the maximum number of segments
transmittable by a device and the maximum
number of segments accepted by a remote
peer device.

Maximum APDU length accepted

Displays the maximum number of octets
contained in a single indivisible application
layer protocol unit.

Maximum master

Type the highest known address for master
nodes on the MS/TP network. The values
range from 0 to 127.

Maximum information frames

Type the maximum number of information
frames that can be sent before the device
must pass the token on the MS/TP network.

Protocol version

Displays the version of the BACnet protocol
supported by this BACnet device.

Protocol revision

Displays the minor revision level of the
BACnet standard supported by this BACnet
device.

Services supported

Displays the BACnet properties that this
device supports.

Object types supported

Displays the types of BACnet objects that
this device supports.

Backup failure timeout (s)

Enter the amount of time since a backup
failure occurred.

Last restore time

Displays the time when a system restore last
took place.

Last backup time

Displays the time when a system backup last
occurred.

Backup configuration files

Displays the files defining the device's image
that you can back up.

Backup path

Displays the path for a system backup.
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85.5

Update b3 Controller Firmware Dialog
Box
Use the Update b3 controller Firmware dialog box to upgrade the operating
system of the b3 BACnet device.

Figure: Update B3 controller firmware dialog box

Table: Update B3 Controller Firmware Dialog Box
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Component

Description

Save Results to File

Saves the results of the update to a text file
(optional).

Cancel

Cancels the b3 BACnet device firmware
update.

Exit

Exits the Update B3 controller Firmware
dialog box.
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85.6

New MS/TP Network Wizard – MS/TP
Network Basic Settings Page
Use the MS/TP Network basic settings page to enter network ID, port, MAC
address, and RS-485 port information for the MS/TP Network you create.

Figure: MS/TP Network basic settings page

Table: MS/TP Network Basic Settings Page
Component

Description

Network ID

Enter the number 2 or greater here because
1 is reserved for the Automation Server’s IP
BACnet connection.

MAC address

Enter the media access control address
(unique address for each branch of the
MS/TP network).

RS-485 port

Select the location of the RS-485 serial port
COM A or COM B using the browse button
.
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85.7

New b3 BACnet Device Creation
Wizard – Basic Settings Page
Use the BACnet basic settings page to enter identifying information when
manually creating an offline b3 BACnet device.

Figure: BACnet basic settings page

Table: BACnet Basic Settings Page
Component

Description

Download to BACnet device
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Instance ID

Type an instance ID. You must enter an
instance ID for BACnet configuration and
communication.

BACnet name

Type a BACnet name for the object.

Model name

Select a b3 device model name from the
drop-down list.

Infinet ID

Type an Infinet ID for this b3 BACnet device.
The Infinet ID is required for communication
between different devices. Each controller is
identified by its unique ID number.

Serial number

Type the serial number for this b3 BACnet
device. You can obtain this number from the
label on the device.
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Component

Description

Note
• The BACnet name is limited to 16 characters consisting solely of letters,
digits, and underscores.
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85.8

New b3 BACnet Device Object Creation
Wizard – Basic Settings Page
Use the BACnet basic settings page to manually enter instance IDs and BACnet
names for the I/O points and values you create, or have Building Operation
automatically generate them for you.

Figure: BACnet basic settings page

Table: BACnet Basic Settings Page
Component

Description

Instance ID
Automatically generated

Click to have the server automatically
generate a BACnet Instance ID.
Choosing Automatically generated is the
recommended option here.

Manually entered

Click and then type an appropriate Instance
ID for the BACnet object.
If you enter an Instance ID manually, you
must ensure it is unique within the
application for this type.

BACnet name

Enter a BACnet name for the object. Do not
type a name if you want it assigned for you.

You can enter up to 16 characters consisting solely of letters, digits, and
underscores for the BACnet name. Should you leave this box empty, the Building
Operation object name is truncated and special characters and spaces are
removed.
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85.9

New BACnet Analog Input Point
(Continuum) Creation Wizard –
Continuum Basic Settings Page
Use the Continuum basic settings page to specify the channel and electrical
type for the analog input point you create.

Figure: Continuum basic settings page

Table: Continuum Basic Settings Page
Component

Description

Channel

Enter the input channel you want the point to
read from.

Electrical type

Select the electrical type. Options here
include:
• Voltage - Specifies a voltage input.
• Counter - Specifies a pulse counting
input.
• Temp (DEGF)/Temp (DEGC) - Reads
the type of value of any type of 10K
Thermistor sensor module and
converts that value to Fahrenheit or
Celsius.
• Airflow - Specifies an airflow input.
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85.10

New BACnet Analog Output Point
(Continuum) Creation Wizard –
Continuum Basic Settings Page
Use the Continuum basic settings page to specify the channel and electrical
type for the analog output point you create.

Figure: Continuum basic settings page

Table: Continuum Basic Settings Page
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Component

Description

Channel

Enter the output channel you want the point
to read from.

Electrical type

Select either voltage or current to specify the
output type. Voltage outputs a voltage.
Current outputs a current.
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85.11

New b3 BACnet Device Object Creation
Wizard – Continuum Basic Settings
Page
Use the Continuum basic settings page to enter channel numbers for the digital
or multistate I/O points you create.

Figure: Continuum basic settings page

Table: Continuum Basic Settings Page
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Component

Description

Channel

Enter the channel where you want to put the
digital or multistate input or output.

Electrical type

Displays the electrical type of the digital or
multistate input or output.
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85.12

b3 BACnet Device Analog Input
Properties – Basic Tab
Use the Basic tab to view and configure the properties of a b3 BACnet Device
analog input point.

Figure: b3 BACnet device analog input point - basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the bound value
is not configured. When configured, displays
a current value for the point under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays a non-forced value.
Click to force the value.
For all BACnet inputs, a Forced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

In alarm

This flag is not supported by Building
Operation b3 BACnet devices. The box
remains unchecked.

Fault

The flag is not supported by Building
Operation b3 BACnet devices. The box
remains unchecked.

Overridden

The flag is not supported by Building
Operation b3 BACnet devices. The box
remains unchecked.

Out of service

Displays a check if the point is out of service
or is not configured with a valid I/O channel.

Out of service

Select True to indicate the object is out of
service and disconnected from the I/O point.
You can also select True when you want to
change the Value for testing purposes.
Select False to indicate the object is in
service and associated with an I/O point.
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Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

COV increment

Enter the minimum change in the Value
property that causes a COV notification to
be sent.
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85.13

b3 BACnet Device Analog Input
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
analog input point properties.

Figure: b3 BACnet device analog input point - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.
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Property

Description

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.

Electrical type

Select the electrical type on the input point.

Channel

Select the input channel you want the point
to read from.

Digital filter

Select On to remove potential noise and
fluctuations from the input point.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value before it
is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Electrical scale top

Enter the highest electrical value for the
point.

Electrical scale bottom

Enter the lowest electrical value for the point.

Enginering scale top

Enter the highest engineering value for the
point.

Engineering scale bottom

Enter the lowest engineering value for the
point.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.14

b3 BACnet Device Analog Output
Properties – Basic Tab
Use the Basic tab to view and configure the properties of a b3 BACnet device
analog output point.

Figure: b3 BACnet device analog output point - basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the bound value
is not configured. When configured, displays
a current value for the point under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays a non-forced value.
Click to force the value.
For all BACnet inputs, a Forced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Override value

Displays the override value. The Override
value takes precedence over other values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O point.
Displays False when the object is in service
and associated with an I/O point.
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Override

Displays True or False. When the Override
is True, the output is overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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Property

Description

COV increment

Enter the minimum change in the Value
property that causes a COV notification to
be sent. The default COV increment is .10.
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85.15

b3 BACnet Device Analog Output
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
analog output point properties.

Figure: b3 BACnet device analog output point - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.
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Property

Description

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.

Electrical type

Select the electrical type on the output point.

Channel

Select the output channel you want the point
to read from.

Digital filter

Select On to remove potential noise and
fluctuations from the input point.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value before it
is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Electrical scale top

Enter the highest electrical value for the
point.

Electrical scale bottom

Enter the lowest electrical value for the point.

Enginering scale top

Enter the highest engineering value for the
point.

Engineering scale bottom

Enter the lowest engineering value for the
point.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.16

b3 BACnet Device Analog Output
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device analog output point.
For more information, see section 77.1 “BACnet Command Priorities” on page
2849.

Figure: b3 BACnet device analog output point - command tab

Table: Command Tab
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Technical
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Continued

Technical
3486

Property

Description

Relinquish default

Enter the value to be used by the Value
property when all values in the priority array
are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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85.17

b3 BACnet Device Multistate Input
Properties – Basic Tab
Use the Basic tab to view and configure the properties of a b3 BACnet Device
multistate input point.

Figure: b3 BAcnet device multistate input point - basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the bound value
is not configured. When configured, displays
a current value for the point under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays a non-forced value.
Click to force the value.
For all BACnet inputs, a Forced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Select True to indicate the object is out of
service and disconnected from the I/O point.
You can also select True when you want to
change the Value for testing purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Technical
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Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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85.18

b3 BACnet Device Multistate Input
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
multistate input point properties.

Figure: b3 BACnet device multistate input point - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

Technical
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Continued

Technical
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Property

Description

BACnet type

Displays the type, which is always device.

Resistor type

Select the resistor type. Resistors maintain a
constant relationship between the current
flow and voltage in the electrical circuit.

Channel

Select the input channel you want the point
to read from.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value before it
is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.19

b3 BACnet Device Multistate Output
Properties – Basic Tab
Use the Basic tab to view and configure the properties of a b3 BACnet device
multistate output point.

Figure: b3 BACnet device multistate output point - basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the bound value
is not configured. When configured, displays
a current value for the point under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays a non-forced value.
Click to force the value.
For all BACnet inputs, a Forced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Override value

Displays the override value. The Override
value takes precedence over other values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O point.
Displays False when the object is in service
and associated with an I/O point.

Technical
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Override

Displays True or False. When the Override
is True, the output is overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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85.20

b3 BACnet Device Multistate Output
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
multistate output point properties.

Figure: b3 BACnet device multistate output point - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.

Technical
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Continued

Technical
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Property

Description

Channel

Select the output channel you want the point
to read from.

LCD state

Toggle the property from Enabled to
Disabled when assigned to an actuator
output channel. You do this to clear an
override and reset the position.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.21

b3 BACnet Device Multistate Output
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device multistate output point.
For more information, see section 77.1 “BACnet Command Priorities” on page
2849.

Figure: b3 BACnet device multistate output point - command tab

Table: Command Tab
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Technical
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Continued

Technical
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Property

Description

Relinquish default

Select the value to be used by the Value
property when all values in the priority array
are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.

04-16006-04-en, March 2015

85 b3 BACnet Device User Interface
85.22 b3 BACnet Device Multistate Pulsed Output Properties – Basic Tab

85.22

b3 BACnet Device Multistate Pulsed
Output Properties – Basic Tab
Use the Basic tab to view and configure the properties of a b3 BACnet device
multistate pulsed output point.

Figure: b3 BACnet device multistate pulsed output point - basic tab

Table: Basic Tab
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Property

Description

Value

Enter the value you want for the output
point.

Override value

Displays the override value. The Override
value takes precedence over other values.

Technical
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Continued
Property

Description

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O point.
Displays False when the object is in service
and associated with an I/O point.

Technical
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Override

Displays True or False. When the Override
is True, the output is overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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85.23

b3 BACnet Device Multistate Pulsed
Output Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
multistate pulsed output point properties.

Figure: b3 BACnet device multistate pulsed output point - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

Technical
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Continued

Technical
3500

Property

Description

BACnet type

Displays the type, which is always device.

Channel

Select the output channel you want the point
to read from.

LCD state

Toggle the property from Enabled to
Disabled when assigned to an actuator
output channel. You do this to clear an
override and reset the position.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.24

b3 BACnet Device Multistate Pulsed
Output Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device multistate pulsed
output point. For more information, see section 77.1 “BACnet Command Priorities”
on page 2849.

Figure: b3 BACnet device multistate pulsed output point - command tab

Table: Command Tab
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Enter the value to be used by the Value
property when all values in the priority array
are set to Null.
Technical
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Continued

Technical
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Property

Description

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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85.25

b3 BACnet Device Digital Input
Properties – Basic Tab
Use the Basic tab to view and configure the properties of the b3 BACnet device
digital input point. You can set the Polarity to control the relationship between the
physical input and the input point of the b3 BACnet device.

Figure: b3 BACnet device digital input point - basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the bound value
is not configured. When configured, displays
a current value for the point under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays a non-forced value.
Click to force the value.
For all BACnet inputs, a Forced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Select True to indicate the object is out of
service and disconnected from the I/O point.
You can also select True when you want to
change the Value for testing purposes.
Select False to indicate the object is in
service and associated with an I/O point.

Technical
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Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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Continued
Property

Description

Polarity

Select an option to control the relationship
between the physical input and the input
point of the b3 BACnet device.
Select Normal if you want the input value of
Active to be Active and the input value of
Inactive to be Inactive.
Select Reverse if you want the input value
of Inactive to be Active and the input
value of Inactive to be Active.
These settings simply reverse the value from
the input.
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Inactive text

Type the text that explains the Inactive state
of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.

Active text

Type the text that explains the Active state of
the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.

Technical
3505

85 b3 BACnet Device User Interface
85.26 b3 BACnet Device Digital Input Properties – Advanced Tab

85.26

b3 BACnet Device Digital Input
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
digital input point properties.

Figure: b3 BACnet device digital input point - advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.
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Continued
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Property

Description

Channel

Select the input channel you want the point
to read from.

Format

Displays how the value appears when
viewed through an LCD.

Threshold

Enter the minimum change of value before it
is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.27

b3 BACnet Device Digital Output
Properties – Basic Tab
Use the Basic tab to view and configure the properties of a b3 BACnet device
digital output point. You can set the Polarity to control the relationship between
the physical output and the output point of the b3 BACnet device.

Figure: b3 BACnet device digital output point - basic tab
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Table: Basic Tab
Property

Description

Value

Displays an orange button if the bound value
is not configured. When configured, displays
a current value for the point under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays a non-forced value.
Click to force the value.
For all BACnet inputs, a Forced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Override value

Displays the override value. The Override
value takes precedence over other values.

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O point.
Displays False when the object is in service
and associated with an I/O point.
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Override

Displays True or False. When the Override
is True, the output is overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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Continued
Property

Description

Polarity

Select an option to control the relationship
between the physical output and the output
point of the b3 BACnet device.
Select Normal if you want the output value
of Active to be Active and the output value
of Inactive to be Inactive.
Select Reverse if you want the output value
of Inactive to be Active and the output
value of Inactive to be Active.
These settings simply reverse the value from
the output.

Technical
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Inactive text

Type the text that explains the Inactive state
of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.

Active Text

Type the text that explains the Active state of
the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.
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85.28

b3 BACnet Device Digital Output
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name for the
digital output point, view or change the Channel, or configure the Log settings.

Figure: b3 BACnet device digital output point - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.
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Continued

Technical
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Property

Description

Channel

Select the output channel you want the point
to read from.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.

04-16006-04-en, March 2015

85 b3 BACnet Device User Interface
85.29 b3 BACnet Device Digital Output Properties – Command Tab

85.29

b3 BACnet Device Digital Output
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device digital output point. For
more information, see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: b3 BACnet device digital output point - command tab

Table: Command Tab
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Select the value to be used by the Value
property when all values in the priority array
are set to Null.
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Continued

Technical
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Property

Description

Priority 6

Priority 6 is reserved for the Minimum_on
and Minimum_off properties of the object.
Digital Value and Digital Output objects in
Building Operation do not support these
optional properties. Priority 6 is read-only.

Priority x

Enter a priority value or Null.
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85.30

b3 BACnet Device Digital Pulsed Output
Properties – Basic Tab
Use the Basic tab to view and configure a b3 BACnet Device digital pulsed output
point. You can use the Polarity to control the relationship between the physical
output and the pulsed output point of the b3 BACnet device.

Figure: b3 BACnet device digital pulsed output point - basic tab

Table: Basic Tab
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Property

Description

Value

Enter the value you want for the output
point.

Override value

Displays the override value. The Override
value takes precedence over other values.

Technical
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Continued
Property

Description

Status flags

Displays the condition or status of the
BACnet point. When checked, the point is in
one or more of the following states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Displays True when the object is out of
service and disconnected from the I/O point.
Displays False when the object is in service
and associated with an I/O point.

Override

Displays True or False. When the Override
is True, the output is overridden.

Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Polarity

Select an option to control the relationship
between the physical output and the output
point of the b3 BACnet device.
Select Normal if you want the output value
of Active to be Active and the output value
of Inactive to be Inactive.
Select Reverse if you want the output value
of Inactive to be Active and the output
value of Inactive to be Active.
These settings simply reverse the value from
the output.

Inactive text

Technical
3516

Type the text that explains the Inactive state
of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.
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Property

Description

Active text

Type the text that explains the Active state of
the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.
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85.31

b3 BACnet Device Digital Pulsed Output
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name for the
digital pulsed output point, view or change the Channel, or configure the Log
settings.

Figure: b3 BACnet device digital pulsed output point - advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.
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Property

Description

Channel

Select the output channel you want the point
to read from.

Format

Displays how the value appears when
viewed through an LCD.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Conversion

Enter a conversion formula into the
Conversion field if you need to convert
electrical units into engineering units.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.32

b3 BACnet Device Digital Pulsed Output
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device digital pulsed output
point. For more information, see section 77.1 “BACnet Command Priorities” on
page 2849.

Figure: b3 BACnet device digital pulsed output - command tab

Table: Command Tab

Technical
3520

Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinqish default

Select the value to be used by the Value
property when all values in the priority array
are set to Null.
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Property

Description

Priority 6

Priority 6 is reserved for the Minimum_on
and Minimum_off properties of the object.
Digital Value and Digital Output objects in
Building Operation do not support these
optional properties. Priority 6 is read-only.

Priority x

Enter a priority value or Null.
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85.33

b3 BACnet Device Analog Value
Properties – Basic Tab
Use the Basic tab to configure an analog value. Analog values store numeric
information for the b3 BACnet device. b3 BACnet device value objects are storage
locations in the controller's memory.

Figure: b3 BACnet device analog value point - basic tab
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Table: Basic Tab
Property

Description

Value

Enter the bound value to be used as a
control system parameter under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays non-forced value.
Click to force the value.
For all BACnet inputs, a Foced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Status flags

Displays the condition or status of the
control system parameter. When checked,
the point is in one or more of the following
states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Select True to indicate the object is out of
service and disconnected from the I/O point.
You can also select True when you want to
change the Value for testing purposes.
Select False to indicate the object is in
service and associated with an I/O point.
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Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

COV increment

Enter the minimum change in the Value
property that causes a COV notification to
be sent. The default COV increment is .10.
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Continued
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Property

Description

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.
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85.34

b3 BACnet Device Analog Value
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
analog value properties.

Figure: b3 BACnet device analog value - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.

Format

Enter the minimum change of value before it
is sent to the Automation Server.
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Continued
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Property

Description

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.35

b3 BACnet Device Analog Value
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device analog value. For more
information, see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: b3 BACnet device analog value - command tab

Table: Command Tab
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.

Relinquish default

Enter the value to be used by the Value
property when all values in the priority array
are set to Null.
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Continued

Technical
3528

Property

Description

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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85.36

b3 BACnet Device Digital Value
Properties – Basic Tab
Use the Basic tab to configure a b3 BACnet device digital value. Digital values are
used as control system parameters that have only one of two possible states:
• Active (enabled)
• Inactive (disabled)

Figure: b3 BACnet device digital value - basic tab

04-16006-04-en, March 2015

Technical
3529

85 b3 BACnet Device User Interface
85.36 b3 BACnet Device Digital Value Properties – Basic Tab

Table: Basic Tab
Property

Description

Value

Enter the bound value to be used as a
control system parameter under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays non-forced value.
Click to force the value.
For all BACnet inputs, a Foced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Status flags

Displays the condition or status of the
control system parameter. When checked,
the point is in one or more of the following
states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Select True to indicate the object is out of
service and disconnected from the I/O point.
You can also select True when you want to
change the Value for testing purposes.
Select False to indicate the object is in
service and associated with an I/O point.
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Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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Property

Description

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

Inactive text

Type the text that explains the Inactive state
of the value, for example,
Pump_Basement_Off. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.

Active text

Type the text that explains the Active state of
the value, for example,
Pump_Basement_On. The text displays in
third party workstations that support the
property. WorkStation does not support this
property.
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85.37

b3 BACnet Device Digital Value
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
digital value properties.

Figure: b3 BACnet device digital value - advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.

Format

Enter the minimum change of value before it
is sent to the Automation Server.
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Property

Description

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.38

b3 BACnet Device Digital Value
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device digital value. For more
information, see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: b3 BACnet device digital value - command tab

Table: Command Tab

Technical
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.
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Property

Description

Relinquish default

Select the value to be used by the Value
property when all values in the priority array
are set to Null.

Priority 6

Priority 6 is reserved for the Minimum_on
and Minimum_off properties of the object.
Digital Value and Digital Output objects in
Building Operation do not support these
optional properties. Priority 6 is read-only.

Priority x

Enter a priority value or Null.
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85.39

b3 BACnet Device DateTime Value
Properties – Basic Tab
Use the Basic tab to configure b3 BACnet device DateTime values. DateTime
values store date and time information used in schedules and timestamps.

Figure: b3 BACnet device DateTime value - basic tab

Table: Basic Tab
Property

Description

State

Select either Enabled or Disabled to
specify whether or not the value is usable

Value

Click the down arrow and calendar displays.
Then, click the date you want or use the
arrows to change the time. Any available
date and time that you select from the
displays are valid entries.
The default DateTime value is 12:00 A.M
(GMT) on December 31, 1988.
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Property

Description

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.
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85.40

b3 BACnet Device DateTime Value
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name or other
DateTime value properties.

Figure: b3 BACnet device DateTime value - advanced tab

Table: Advanced Tab

Technical
3538

Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.
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Property

Description

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.41

b3 BACnet Device String Value
Properties – Basic Tab
Use the Basic tab to configure b3 BACnet device String values. String values
contain plain text that can include messages that are displayed to an operator.

Figure: b3 BACnet device string value - basic tab

Table: Basic Tab

Technical
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Property

Description

State

Select either Enabled or Disabled to
specify whether or not the value is usable

Value

Enter the value you want.

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.
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Property

Description

String size

Enter the size of the text string. The
minimum size is 1 character and the
maximum is 32 characters.
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85.42

b3 BACnet Device String Value
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name and other
string value properties.

Figure: b3 BACnet device string value - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.
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Property

Description

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.43

b3 BACnet Device Multistate Value
Properties – Basic Tab
Use the Basic tab to configure a b3 BACnet device multistate value. Multistate
values are used as control system parameters. However, their values can be any
one of a set that you define. For example, you can create a multistate value object
named Day of Week with a value of Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday, or Sunday.

Figure: b3 BACnet device multistate value - basic tab
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Table: Basic Tab
Property

Description

Value

Enter the bound value to be used as a
control system parameter under the
following conditions:
• Unforce – Displays a forced value.
Enter a forced value or click to release
the value.
• Force – Displays non-forced value.
Click to force the value.
For all BACnet inputs, a Foced condition is
the same as out of service. For more
information, see the Forced Values topic on
WebHelp.
For BACnet outputs and values, which are
commandable, a Forced status may also
include a priority level setting. For more
information, see section 77.7 “Forced
Priority Level” on page 2857.

Status flags

Displays the condition or status of the
control system parameter. When checked,
the point is in one or more of the following
states:
• In alarm: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Fault: This flag is not supported by
Building Operation b3 BACnet devices.
The box remains unchecked.
• Overridden: This flag is not supported
by Building Operation b3 BACnet
devices. The box remains unchecked.
• Out of service: Displays a check if the
point is out of service or the the point is
not configured with a valid I/O channel.

Out of service

Select True to indicate the object is out of
service and disconnected from the I/O point.
You can also select True when you want to
change the Value for testing purposes.
Select False to indicate the object is in
service and associated with an I/O point.
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Event state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.

Alarm state

Always displays Normal because b3
BACnet devices do not support intrinsic
alarming.
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85.44

b3 BACnet Device Multistate Value
Properties – Advanced Tab
Use the Advanced tab to view or change the b3 BACnet device name or other
multistate value properties.

Figure: b3 BACnet device multistate value - advanced tab

Table: Advanced Tab
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Property

Description

Object ID

Displays the BACnet object type and
instance number of the device.

BACnet name

Enter a BACnet name for the object. You
can enter up to 16 characters consisting
solely of letters, digits, and underscores.
Should you leave this box empty, the
Building Operation object name is used as
the BACnet name.

BACnet type

Displays the type, which is always device.
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Property

Description

Setpoint

Select either True or False. When you
specify True, the value contained by the
value object is retained during restart and
saved to flash memory when a backup to
flash operation is performed.

Format

Enter the minimum change of value before it
is sent to the Automation Server.

Log type

Select the log type the b3 BACnet device
uses to record values. There are five basic
log types available in the b3. For more
information, see section 84.6 “b3 BACnet
Device Logs” on page 3436.

Log records

Enter how many values you want the log to
store- up to a maximum of 32767 entries.

Log interval

Enter how frequently you want to log the
value in Days, Hours, Minutes, or Seconds.

Last log time

Displays the last time a log was recorded.

Triggers

Select the b3 Script program you want the
point to trigger when the value changes.
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85.45

b3 BACnet Device Multistate Value
Properties – Command Tab
Use the Command tab to enter a value for the Relinquish default, or a priority
level, and to view the priority array for the b3 BACnet device multistate value. For
more information, see section 77.1 “BACnet Command Priorities” on page 2849.

Figure: b3 BACnet device multistate value - command tab

Table: Command Tab
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Property

Description

Active command priority

Specifies the priority level (1-16) currently
controlling the present value. The present
value is the highest priority with a non-Null
value.
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Property

Description

Relinquish default

Select the value to be used by the Value
property when all values in the priority array
are set to Null.

Priority 6

Reserved for future use.

Priority x

Enter a priority value or Null.
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85.46

b3 Script Program Properties – Basic
Tab
Use the Basic tab to view and change general, configuration, runtime, and status
information about your b3 Script programs.

Figure: b3 Script program properties - basic tab

Table: Basic Tab

Technical
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Component

Description

Compilation valid

Displays whether the program compiled
successfully.

TS

Displays the number of seconds that have
elapsed since the program has been on the
current line.

TM

Displays the number of minutes that have
elapsed since the program has been on the
current line.

TH

Displays the number of hours that have
elapsed since the program has been on the
current line.
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Component

Description

TD

Displays the number of days that have
elapsed since the program has been on the
current line.

Current line

Displays the program's current line.

Line start time

Displays the program's line start time.

Error

Indicates whether the program ran
successfully or encountered an error.

Status

Displays the program status.

State

Select Enabled to enable the program.

Flow type

Select the Looping or FallThru flow type
to order the way Script program instructions
are arranged and executed.

Restart

Select True to restart a program.

Autostart

Select True to automatically start a
program.
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85.47

b3 Script Program Properties –
Advanced Tab
Use the Advanced tab to view and change BACnet information about your b3
Script programs.

Figure: b3 Script program properties - advanced tab

Table: Advanced Tab
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Component

Description

Object ID

Displays the unique ID of the b3 Script
program in the b3 BACnet device.

BACnet name

View the name of the b3 Script program in
the b3 BACnet device or type a new b3
Script program name. The b3 Script
program name is limited to 16 characters.

BACnet type

Displays the type of BACnet object.
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85.48

b3 Script Program Properties – Inputs
Tab
Use the Inputs tab to display the input bindings associated with the b3 Script
program.

Figure: b3 Script program properties - inputs tab

Table: Inputs Tab
Component

Description

[Property Name]

Set the value of the bound property. Click
the Configure Settings
icon to open
the [Property name] dialog and its Operation
tab.

04-16006-04-en, March 2015

Technical
3553

85 b3 BACnet Device User Interface
85.49 b3 Script Program Properties – Outputs Tab

85.49

b3 Script Program Properties – Outputs
Tab
Use the Outputs tab to display output bindings associated with the b3 Script
progam.

Figure: b3 Script program properties - outputs tab

Table: Outputs Tab
Component

Description

[Property Name]

Set the value of the bound property. Click
the Configure Settings
icon to open
the [Property name] dialog and its Operation
tab.
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85.50

b3 Script Program Properties –
Functions Tab
Use the Functions tab to display function bindings associated with the b3 Script
program.

Figure: b3 Script program properties - functions tab

Table: Functions Tab
Component

Description

[Function name]

Select the path of the bound function and
use the ellipsis button to select the object
and property. Click the Configure
Settings icon
to open the [Function
name] dialog and its Operation tab.
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85.51

b3 Script Function Properties – Basic
Tab
Use the Basic tab to view status information about your b3 Script function.

Figure: b3 Script function properties - basic tab

Table: Basic Tab
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Component

Description

Compilation valid

Displays whether the program compiled
successfully.
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85.52

b3 Script Function Properties –
Advanced Tab
Use the Advanced tab to view and change BACnet information about your b3
Script function.

Figure: b3 Script function properties - advanced tab

Table: Advanced Tab
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Component

Description

Object ID

Displays the unique ID of the b3 Script
function in the b3 BACnet device.

BACnet name

View the name of the b3 Script function in
the b3 BACnet device or type a new b3
Script function name. The b3 Script function
name is limited to 16 characters.

BACnet type

Displays the type of BACnet object.

Technical
3557

85 b3 BACnet Device User Interface
85.53 b3 Script Function Properties – Inputs Tab

85.53

b3 Script Function Properties – Inputs
Tab
Use the Inputs tab to display the input bindings associated with the b3 Script
function.

Figure: b3 Script program properties - inputs tab

Table: Inputs Tab
Component

Description

[Property Name]

Set the value of the bound property. Click
the Configure Settings
icon to open
the [Property name] dialog and its Operation
tab.
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85.54

b3 Script Function Properties – Outputs
Tab
Use the Outputs tab to display output bindings associated with the b3 Script
function.

Figure: b3 Script function properties - outputs tab

Table: Outputs Tab
Component

Description

[Property Name]

Set the value of the bound property. Click
the Configure Settings
icon to open
the [Property name] dialog and its Operation
tab.

04-16006-04-en, March 2015

Technical
3559

85 b3 BACnet Device User Interface
85.55 b3 Script Function Properties – Functions Tab

85.55

b3 Script Function Properties –
Functions Tab
Use the Functions tab to display function bindings associated with the b3 Script
function.

Figure: b3 Script function properties - functions tab

Table: Functions Tab
Component

Description

[Function name]

Select the path of the bound function and
use the ellipsis button to select the object
and property. Click the Configure
Settings icon
to open the [Function
name] dialog and its Operation tab.
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86 Modbus Introduction
86.1 Modbus Overview

86.1

Modbus Overview
Modbus is a master/slave protocol used for communicating with industrial
hardware. The protocol works by one master device requesting data from (or
writing data to) one or more slave devices.
In Building Operation, you can also view Modbus in client/server operation when
TCP/IP networks are used.

Note
Certain sections of this Modbus concept documentation refer only to
master/slave operation, describing Modbus devices rather than clients and
servers as would be present in client/server operation. However, these sections
also describe client/server operation (except for the obvious differences between
the two methodologies such as the framing modes). In other words, Master is
equivalent to Client and Slave is equivalent to Server.

86.1.1

Master/Slave Networks
Two master/slave network types are possible on the Automation Server or
Enterprise Server. A master network contains a single internal master and a number
of external slave devices, while a slave network contains a single external master
device and a single internal slave. All devices in master or slave networks must
conform to the Modbus protocol.
For more information, see section 86.3 “Master/Slave Networks” on page 3566.

86.1.2

Client/Server Networks
Two client/server network types are possible on the Automation Server or
Enterprise Server: A client network contains a single internal client and one or more
external server devices, while a server network contains a single internal server and
one or more external clients. All devices in client or server networks must conform
to the Modbus protocol.
For more information, see section 86.6 “ Client/Server Networks” on page 3571.

86.1.3

Modbus Interfaces
When creating a communications interface for your Modbus network in
WorkStation, you initially select one of six options under the heading of Modbus
Interface. Each of these options is either a network or an interface, but the first
selection, (Modbus Interface) is a special case that relates to an internal device.
For more information, see section 90.1 “Modbus Interfaces” on page 3639.
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86.1.4

Network Configuration
In WorkStation, each Modbus network type contains several properties that you
must configure to enable proper communications between the devices on the
network. Some properties (for example, J-Bus mode) are common to all network
types, and some other properties are specific to network type (for example, Baud
rate applies only to serial networks).
For more information, see section 89.1 “Network Configuration” on page 3633.

86.1.5

Modbus Devices
In WorkStation, you can add a representation of any physical Modbus device in a
serial or TCP network. All devices use the same device icon and are created in the
same way, regardless of network type. However, if you are using a device in a serial
network, the device is either a master device or a slave device but is simply called a
Modbus device. Similarly, when using a device in a TCP network, the device is
either a client device or a server device but is simply called a Modbus TCP device.
For more information, see section 91.1 “Modbus Devices” on page 3647.

86.1.6

Modbus Points and Values
In WorkStation, you can configure input or output points on Modbus devices to
enable read/write of values between master device and slave device or between
client and server. For example, if you wanted to read the number of kilowatts being
monitored by an electricity meter, you could set up an analog input point with the
address and function code of the register within the meter that holds the kilowatts
information.
For more information, see section 92.2 “Modbus Points and Values” on page 3664.

86.1.7

Modbus Communications
Modbus communications relate to the transfer of messages (queries and
responses) between a master device and a slave device (alternatively, between a
client device and a server device). Modbus messages are sent in a specific format
to certain registers in the addressed device. Data within the addressed register
range is either written or read by the master device, according to a specific function
code. You can also configure the read function to operate on a group of registers
(batch read).
For more information, see section 86.9 “Modbus Communications” on page 3575.

86.1.8

Modbus Connections to the Building
Operation Server
You can connect a Modbus network to a serial port or IP port on an Automation
Server or an Enterprise server.
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For more information, see section 86.13 “Modbus Connections to the Building
Operation Server” on page 3584.

86.1.9

Building Operation Server Capacities for
Modbus Networks
Modbus network perfomance is affected by the load on the Automation Server or
the Enterprise Server, therefore you must observe the capacities of your Building
Operation server to achieve optimum network performance.
For more information, see the Architectural Guidelines topic on WebHelp.
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86.2

Modbus Interface Selection Workflow
The Modbus interface selection workflow enables you to choose a workflow that
you can use to establish a Modbus interface in WorkStation, matching the physical
Modbus network you connect to the Automation Server or the Enterprise Server.
You choose the interface workflow based on your answers to pertinent questions in
the following flowchart.

Figure: Modbus interface selection flowchart
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Note
It is assumed that you have already connected your fully operational Modbus
network to the Automation Server or the Enterprise Server.
For more information, see section 86.13 “Modbus Connections to the Building
Operation Server” on page 3584.
For more information, see section 87.1 “Modbus Serial Networks” on page 3589.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.
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86.3

Master/Slave Networks
Two master/slave network types are possible on the Automation Server or
Enterprise Server. A master network contains a single internal master and a number
of external slave devices, while a slave network contains a single external master
device and a single internal slave. All devices in master or slave networks must
conform to the Modbus protocol.

86.3.1

Master/Slave Concept
In the Modbus protocol, the master/slave concept is generally applied to serial
networks. Only one device is the master. The master device always initiates and
controls communications (in the form of standard Modbus messages) between
master and slave devices. All other devices in the Modbus network are slave
devices, which only respond to commands from the master device. Each slave
device has a unique address.
For more information, see section 86.4 “Master/Slave Concept” on page 3567.

86.3.2

Master and Slave Networks
In Building Operation, you can create two types of Modbus master/slave networks
on the Automation Server or Enterprise Server: a master network (Modbus Master
Network) and a slave network (Modbus Slave Network). By default, these are
created on a serial port.
For more information, see section 86.5 “Master and Slave Networks” on page
3569.

86.3.3

Modbus Serial Networks
Building Operation supports two serial network types for Modbus: RS-232 and RS485. You can connect one RS-232 device or up to 32 RS-485 devices (without a
repeater) to a Modbus serial network. If you are connecting an Enterprise Server to
an RS-485 network, you need a proprietary RS-232-to-RS-485 converter. For
communication with serial networks, you may need to create and configure a serial
port as well as adding and configuring a serial network using standard Modbus
protocol settings. By default, Building Operation creates a single serial port for an
Enterprise Server and two serial ports for an Automation Server, but you must
configure an association between the port and your serial network.
For more information, see section 87.1 “Modbus Serial Networks” on page 3589.
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86.4

Master/Slave Concept
In the Modbus protocol, the master/slave concept is generally applied to serial
networks. Only one device is the master. The master device always initiates and
controls communications (in the form of standard Modbus messages) between
master and slave devices. All other devices in the Modbus network are slave
devices, which only respond to commands from the master device. Each slave
device has a unique address.

Figure: Modbus master/slave concept

When querying a slave device, the master device issues explicit commands to the
addressed slave device and waits a predetermined time for a reply. If the slave
device fails to respond or if the response is incorrect, the process is repeated a set
number of times. This repetition ensures that communications can be maintained in
the event of interruptions, such as electrical noise.
Each type of Modbus slave device contains certain register types into which data
values (either static or dynamic) can be stored ready for query by the master device.
Information about register types and addresses for any particular slave device is
contained in the documentation for that device. This information is referred to as a
Modbus Map. Building Operation supports read and write operation on all standard
Modbus registers (Coils, Input registers, Holding registers and Input status). For
more information, see section 91.1 “Modbus Devices” on page 3647.
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Figure: Registers in a slave device
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86.5

Master and Slave Networks
In Building Operation, you can create two types of Modbus master/slave networks
on the Automation Server or Enterprise Server: a master network (Modbus Master
Network) and a slave network (Modbus Slave Network). By default, these are
created on a serial port.
You can create a master network in which the Enterprise Server or Automation
Server is the master device, and then create slave devices to represent real devices
on an external network. This is the most common configuration.

Figure: Modbus Master Network (serial)

You can also create a slave network in which the Enterprise Server or Automation
Server acts as a slave to an external master device.
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Figure: Modbus Slave Network (serial)
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86.6

Client/Server Networks
Two client/server network types are possible on the Automation Server or
Enterprise Server: A client network contains a single internal client and one or more
external server devices, while a server network contains a single internal server and
one or more external clients. All devices in client or server networks must conform
to the Modbus protocol.

86.6.1

Client/Server Concept
In Building Operation, you can create a Modbus TCP Network or a Modbus TCP
Server, both of which, like Modbus serial networks, operate using the master/slave
concept, although the transmission method is different and the terms client and
server are used instead of master and slave. You can also have multiple clients
(masters). You can set up a network where the client reads data from a number of
servers (equivalent to a master device reading data from several slave devices in a
serial network). Alternatively, you can set up a Modbus Interface to be the server
device to an external client.
For more information, see section 86.7 “Client/Server Concept” on page 3572.

86.6.2

Client and Server Networks
In Building Operation, you can create a Modbus TCP Network on an Ethernet
network (TCP/IP). The Enterprise Server or Automation Server is the client, and you
can create TCP devices to represent real devices on an external network. You can
also create a Modbus TCP Server where the Enterprise Server or Automation
Server is the server to one or more external clients.
For more information, see section 86.8 “Client and Server Networks” on page 3573.

86.6.3

Modbus TCP Networks
You can create three TCP network types in Building Operation:
• Modbus TCP Network: contains Modbus TCP server devices responding to an
internal Modbus client on either an Automation Server or Enterprise Server.
• Modbus TCP Server: an internal Modbus Interface responds to requests from
one or more clients on the external network.
• Modbus TCP Gateway: to provide communications with serial devices from a
TCP network.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.
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86.7

Client/Server Concept
In Building Operation, you can create a Modbus TCP Network or a Modbus TCP
Server, both of which, like Modbus serial networks, operate using the master/slave
concept, although the transmission method is different and the terms client and
server are used instead of master and slave. You can also have multiple clients
(masters). You can set up a network where the client reads data from a number of
servers (equivalent to a master device reading data from several slave devices in a
serial network). Alternatively, you can set up a Modbus Interface to be the server
device to an external client.

Figure: Modbus client/server network
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86.8

Client and Server Networks
In Building Operation, you can create a Modbus TCP Network on an Ethernet
network (TCP/IP). The Enterprise Server or Automation Server is the client, and you
can create TCP devices to represent real devices on an external network. You can
also create a Modbus TCP Server where the Enterprise Server or Automation
Server is the server to one or more external clients.

Figure: Modbus TCP Network (TCP/IP)

You can also create an internal interface which acts as the server to an external
client/clients.
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Figure: Modbus Interface (TCP/IP)
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86.9

Modbus Communications
Modbus communications relate to the transfer of messages (queries and
responses) between a master device and a slave device (alternatively, between a
client device and a server device). Modbus messages are sent in a specific format
to certain registers in the addressed device. Data within the addressed register
range is either written or read by the master device, according to a specific function
code. You can also configure the read function to operate on a group of registers
(batch read).

Figure: Query and response message cycle

The function code component of the Modbus query tells the slave device whether
the operation required is Read or Write and specifies which types of register to
operate upon (for example a coil). When you configure the properties of a point and
you select a data type that is greater than one register, Building Operation selects a
function code to read/write data from/to more than one register. For example, if
configuring an analog input point to read a value from a device and you select 32bit data, Building Operation automatically requests the number of registers to read
(two in this case) and you must specify the correct function code (3 or 4) to operate
on two registers. For more information, see section 86.11 “Function Code Definition
and Selection” on page 3580.
In Building Operation, you can select the way in which data contained in the device
registers is handled mathematically. For example, you can configure the master
device to read the value of a 16-bit register (signed or unsigned) or send 32-bit real
data to a pair of registers. Building Operation can handle registers up to 64-bits in
length. For more information, see section 92.4 “Point and Value Configuration” on
page 3667.
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Figure: Data type handling in Modbus registers

Unless registers are polled as part of the Modbus batch read function (see below),
Building Operation does not read or write more than one Modbus point at a time.
For example, an analog input point configured with a 64-bit data type reads all of
the four 16-bit registers occupied by a single Modbus message, using function
code 03 or 04 (multiple register read). Similarly, an analog input point configured
with a 16-bit data type reads only one 16-bit register occupied by a single Modbus
message, using function code 03 or 04 (single register read). However, Building
Operation does not read or write to multiple registers spanning consecutive points
(except during a batch read), including digital points.
Modbus devices can communicate using either of the two serial Modbus
transmission modes:
• RTU is a binary format that requires the least number of characters for data
transmission and is the faster of the two transmission modes (and therefore
preferred).
• ASCII uses only text readable characters that require more characters per
message and is thus slower.
Some Modbus devices support either one transmission mode or the other, but not
both. However, all devices on the same network must be configured to use the
same transmission mode. For more information, see section 164.2 “Serial
Transmission Modes” on page 5661.
Two methods of message checking exist:
• Cyclic redundancy check bytes for RTU transmission mode
• Longitudinal redundancy check bytes for ASCII transmission mode

86.9.1

Modbus Addressing
In Building Operation, you can configure the addresses of Modbus devices. Within
those devices, you can also configure the addresses of registers where data is
stored.
For more information, see section 86.10 “Modbus Addressing” on page 3579.
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86.9.2

Function Code Definition and Selection
The function code tells the slave device which register to access and whether to
read from that register or write to it. The function code field of the message frame
contains two characters (in ASCII mode), or 8 binary bits (in RTU Mode) that tell the
slave device which register(s) to access and if the operation is read or write. Valid
Modbus function codes are in the range 1-255, but not all codes apply to a
particular device (and some codes are reserved for future use).
For more information, see section 86.11 “Function Code Definition and Selection”
on page 3580.

86.9.3

Modbus Batch Read Function
In a normal Modbus network, a Modbus polling device obtains data from a polled
device by sending a query message to the device and then waiting for the response
message that contains the requested value from the selected register. If data from
another register is required, the polling device sends out a new query message and
awaits the response message. This process is repeated as required until all
subscribed points values have been read. However, the Modbus batch read
function affects the way a Modbus polling device reads the points values stored
within the registers of a Modbus polled device. Instead of reading each register
individually, the batch read function reads registers in manually created groups.
When all registers in a group have been read, the response message returns
subscribed register values for the whole group.
For supported devices, a scattered read function enables non-contiguous reading
of certain Modbus registers in a single transaction.
For more information, see section 93.1 “Modbus Batch Read Function” on page
3683.

86.9.4

Device and Register Polling
In Building Operation, the Modbus plug-in contains a poll mechanism where a poll
manager manages the polling of Modbus points (called subscription variables) on
Modbus networks connected to a Building Operation server. For each network, the
poll manager operates with a poll list and a poll task.
For more information, see section 164.3 “Device and Register Polling” on page
5667.

86.9.5

Modbus Message Formats
The most basic part of any Modbus message is known as a PDU, which comprises
a 2-byte function code field and a data field. The function code field specifies the
action to perform and the data field specifies the information to be used for this
action.
For more information, see section 164.1 “Modbus Message Formats” on page
5659.
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86.9.6

Serial Transmission Modes
The Modbus serial transmission mode defines the bit contents of message fields
transmitted serially on the line and determines how information is packed into the
message fields and decoded.
For more information, see section 164.2 “Serial Transmission Modes” on page
5661.

86.9.7

Error Handling
Two methods of error checking (in addition to parity checking) are supported in
Building Operation. For RTU transmission mode, CRC is employed. For ASCII
transmission mode, LRC is used.
For more information, see section 86.12 “Error Handling” on page 3582.

86.9.8

Generic RS-485 Network Devices
This application note provides recommendations for the RS-485 interface port
configuration between the Automation Server and generic RS-485 network devices
(Modbus or MS/TP). This information is intended to supplement the instructions you
receive with the various RS-485 network devices. These guidelines focus on the
arrangement of the electrical interface to the RS-485 port in regards to biasing,
termination, cable selection, cable lengths, and cable routing. The guidelines on
maximum unit load (node count) and common mode voltage tolerance are
associated with Automation Servers with serial number of TD133954000 and later.
For more information, see the Generic RS-485 Network Devices topic on WebHelp.
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86.10

Modbus Addressing
In Building Operation, you can configure the addresses of Modbus devices. Within
those devices, you can also configure the addresses of registers where data is
stored.

86.10.1

Modbus Device Addressing
A Modbus master device does not have an address, but each slave device must
have a unique address. In WorkStation, this address is called the Device address. In
other Modbus devices, this address can be called (for example) the device ID.
You configure device addresses in the Properties dialog box for the device. Valid
device addresses range from 1-247. For more information, see section 94.5
“Modbus Device Properties – Basic Tab” on page 3712.
The Modbus master device addresses a specific slave device by placing the 8-bit
slave address in the address field of the message (RTU Mode). The address field of
the message frame contains two characters (in ASCII mode), or 8 binary bits (in
RTU Mode). When the slave device responds, it places its own address in the
address field of the response message so the master device knows which slave
device is responding.

86.10.2

Modbus Register Addressing
Within a standard Modbus device, register types are assigned numbers ranging
from 1 to 10,000. For example, ‘Coil 1’ is the first coil and ‘Holding Register 1’ is the
first holding register.
You configure register addresses in the Properties dialog box for any point that you
configure. The register addresses for different types of data are in the datasheet for
the device.
Both Modbus and J-Bus addressing modes are supported.
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86.11

Function Code Definition and Selection
The function code tells the slave device which register to access and whether to
read from that register or write to it. The function code field of the message frame
contains two characters (in ASCII mode), or 8 binary bits (in RTU Mode) that tell the
slave device which register(s) to access and if the operation is read or write. Valid
Modbus function codes are in the range 1-255, but not all codes apply to a
particular device (and some codes are reserved for future use).
In Building Operation, valid function codes are Read function codes 01, 02, 03, and
04, and Write function codes 05, 06, 15, and 16.
Table: Function Code Definition and Selection
Register
Address

86.11.1

Register/D
ata Type

Read/Write Single
Coil/Regist
er Function
Code

Multiple
Building
Coil/Regist Operation
er Function Point Type
Code

00000-9,999 Coil Status

Read

-

01

Digital

00000-9,999 Coil Status

Write

05

15

Digital

10,00119,999

Input Status

Read

-

02

30,00139,999

Input
Registers

Read

-

04

Analog or
Multistate
(Digital)

40,00149,999

Holding
Registers

Read

-

03

Analog or
Multistate
(Digital)

40,00149,999

Holding
Registers

Write

06

16

Analog or
Multistate
(Digital)

Digital

Read Function Code Selection
When configuring a Modbus point, you can set the type of data (either current
status or current value) to be read by the master device in the slave device’s logic
coils or holding/input registers, by selecting a Read function code:
• None: Disables the read function of the register.
• 01 (Read Coil Status): Obtains the current status (On or Off) of a group of
discrete output logic coils.
• 02 (Read Input Status): Obtains the current status (On or Off) of a group of
discrete input contacts.
• 03 (Read Holding Registers): Obtains the current value in one or more analog
output holding registers.
• 04 (Read Input Registers): Obtains the current value in one or more analog
input registers.
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86.11.2

Write Function Code Selection
When configuring a Modbus point, you can either force single or multiple coils to an
On or Off state or to place a specific value into one or more holding registers, by
selecting a Write function code:
• None: Disables the write function of the register.
• 05 (Write Single Coil): Forces a discrete output logic coil to a state of On or Off.
• 06 (Write Single Register): Places a specific value into an analog output holding
register.
• 15 (Write Multiple Coils): Forces multiple logic coils either On or Off.
• 16 (Write Multiple Registers): Places a specific value into multiple analog output
holding registers.
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86.12

Error Handling
Two methods of error checking (in addition to parity checking) are supported in
Building Operation. For RTU transmission mode, CRC is employed. For ASCII
transmission mode, LRC is used.

86.12.1

RTU Mode CRC Checking
Before sending a message, each Modbus device in RTU mode checks the contents
of the entire message and places a 16-bit value (two 8-bit bytes) into the last two
bytes of the message. The CRC check is applied regardless of any parity checking
method used for the individual characters of the message. While the message is
being received, the receiving device recalculates a CRC and compares the
calculated value to the actual value it received in its CRC field. If the two values are
not equal, an error is generated.

Figure: Modbus frame over serial line (RTU or ASCII)

86.12.2

ASCII Mode LRC Checking
Before sending a message, each Modbus device in ASCII mode checks the
contents of the message except for the first character (:) and the last two characters
(CR, LF). The device then places an 8-bit value into the last byte of the message.
The LRC check is applied regardless of any parity checking method used for the
individual characters of the message. While the message is being received, the
receiving device recalculates an LRC and compares the calculated value to the
actual value it received in its LRC field. If the two values are not equal, an error is
generated.
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Figure: Modbus frame over serial line (RTU or ASCII)

86.12.3

Device and Network Read and Write Errors
You can monitor communications errors occurring on Modbus devices and
networks by viewing the Output write failure and Input read failure properties
of the network or device. These properties tell you whether a read error (Input
read failure) or a write error (Output write failure) has occurred. You can then
reset the device or network to OK once you have cleared the problem that led to
the error.

86.12.4

Point Error Count
You can monitor communications errors occurring on Modbus points by viewing
the Advanced tab of any point within a master or client device. You can view the
read or write failures, and reset the count to zero when you resolve a
communications problem.
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86.13

Modbus Connections to the Building
Operation Server
You can connect a Modbus network to a serial port or IP port on an Automation
Server or an Enterprise server.

86.13.1

Automation Server Connection Options
You can connect a Modbus network to the Automation Server by way of an RS-485
serial port (COM A or COM B) or the IP port (Port 502), both of which are located at
the bottom of the device. For more information, see the Automation Servers topic
on WebHelp.

Figure: Network connection options (Automation Server)

86.13.2

Enterprise Server Connection Options
You can connect a Modbus network to the Enterprise Server by way of an RS-232
serial port (COM1) or a IP port (Port 502). One or more of each port type are usually
located at the back of the PC.
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If your Modbus network is an RS-232 serial network, connect the network directly
to one of the RS-232 ports (usually COM1 or COM2) on the PC. If your Modbus
network is an RS-485 serial network, you need to connect a proprietary RS-232-toRS-485 converter to one of the RS-232 ports and then connect the RS-485
network to the converter.

Figure: Network connection options (Enterprise Server)
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87.1

Modbus Serial Networks
Building Operation supports two serial network types for Modbus: RS-232 and RS485. You can connect one RS-232 device or up to 32 RS-485 devices (without a
repeater) to a Modbus serial network. If you are connecting an Enterprise Server to
an RS-485 network, you need a proprietary RS-232-to-RS-485 converter. For
communication with serial networks, you may need to create and configure a serial
port as well as adding and configuring a serial network using standard Modbus
protocol settings. By default, Building Operation creates a single serial port for an
Enterprise Server and two serial ports for an Automation Server, but you must
configure an association between the port and your serial network.
All devices on the network must also be configured with the same Modbus protocol
settings:
• Framing mode
• Baud rate
• Parity
• J-Bus mode
In the port settings, you might also need to ensure that the network interface name
is properly configured (for example, COM1 for an RS-232 port). For more
information, see section 86.13 “Modbus Connections to the Building Operation
Server” on page 3584.
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Figure: Modbus serial networks examples

87.1.1

Modbus Master Network
You create a new Modbus Master Network on the Enterprise Server or Automation
Server, which in this case becomes the master device.

Figure: Modbus serial network (Automation Server as master)

You can then create the devices with which the master device can communicate.
These devices are external to the server and all are slave devices. For example, a
network is set up with three electricity meters. Each meter is created and
configured as a slave device on the Metering (master) network.
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Figure: Master network with Automation Server as master device

87.1.2

Modbus Slave Network
A Modbus Slave Network provides the means for an external master device to
communicate, through a slave interface (on a serial port), to an internal Modbus
Interface on the Automation Server or Enterprise Server. For more information, see
section 90.2 “Modbus Interface” on page 3640.

Figure: Modbus Interface created on a server

If you configure the Modbus Slave Network (and associate it with a serial port), you
can set up any external Modbus master device to communicate with the internal
Modbus Interface. In this example, a Modbus Slave Network is set up on an
Enterprise Server and the external master device is configured with the same
Modbus properties as the Modbus Slave Network object.
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Figure: Slave network with external device as master device

The Modbus master device can also be an HMI device. For more information, see
section 90.2 “Modbus Interface” on page 3640.
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87.2

Modbus Master Network Workflow
The Modbus Master Network workflow enables you to create a Modbus Master
Network in Building Operation.
The following flowchart describes the basic steps required to create a Modbus
Master Network. Related information can be found in the sections after the
flowchart.

Figure: Modbus Master Network flowchart
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Create a Modbus Master Network
In WorkStation, create a Modbus Master Network under an Enterprise Server or an
Automation Server.
For more information, see section 87.9 “Creating a Modbus Master Network” on
page 3605.

Ensure a serial port is configured and allocated
In the Enterprise Server or Automation Server, ensure that a serial port is configured
and allocated to the network.
For more information, see section 104.7 “Creating an RS-232 Port” on page 4574.
For more information, see section 104.8 “Configuring a Serial Port” on page 4575.
For more information, see section 87.10 “Configuring a Modbus Master Network”
on page 3606.

Create Modbus device
In WorkStation, create a Modbus serial device under the Modbus master network.
For more information, see section 91.4 “Creating a Modbus Device” on page 3654.

Create Modbus Register Groups
If you require Modbus to operate using the batch read functionality, add register
groups to the device.
For more information, see section 93.5 “Creating a Modbus Register Group” on
page 3697.
For more information, see section 93.8 “Adding Modbus Points to a Modbus
Register Group” on page 3701.

Create Modbus points
In your device (or register group), create Modbus points.
For more information, see section 92.3 “Creating a Modbus Point” on page 3666.

Check communications
In WorkStation, check that the network and all devices and points are online. Drag
Modbus points to the Watch pane and check that their values vary in line with the
corresponding values in the physical Modbus network.
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87.3

Modbus Slave Network Workflow
The Modbus Slave Network workflow enables you to create a Modbus Slave
Network in Building Operation.
The following flowchart describes the basic steps required to create a Modbus
Slave Network. Related information can be found in the sections after the flowchart.

Figure: Modbus Slave Network flowchart

Create a Modbus Slave Network
In WorkStation, create a Modbus Slave Network under an Enterprise Server or an
Automation Server.
For more information, see section 87.7 “Creating a Modbus Slave Network” on
page 3602.

Ensure a serial port is configured and allocated
In the Enterprise Server or Automation Server, ensure that a serial port is configured
and allocated to the network.
For more information, see section 104.7 “Creating an RS-232 Port” on page 4574.
For more information, see section 104.8 “Configuring a Serial Port” on page 4575.
For more information, see section 87.8 “Configuring a Modbus Slave Network” on
page 3603.
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Create a Modbus Interface
In WorkStation, create a Modbus Interface. The Modbus Interface is the slave to a
Modbus master on the external network. The master device could be an HMI
device (tablet or similar).
For more information, see section 90.3 “Creating a Modbus Interface” on page
3642.

Create Modbus Local Registers
In the Modbus Interface, add local registers (values) for read/write access by the
external master device.
For more information, see section 92.6 “Creating a Modbus Value” on page 3677.

Check communications
In WorkStation, check that the Modbus Slave Network and the Modbus Interface
are online. Drag Modbus values to the Watch pane and check that their values vary
in line with the corresponding values in the Modbus master device.
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87.4

Creating an RS-232 Port
You create an RS-232 port on an Enterprise Server to provide an interface to
associate with an RS-232 serial network. You only need to do this when you have
more than one RS-232 network.
For more information, see section 104.6 “Port Allocation and Configuration” on
page 4572.

To create an RS-232 port
1. In WorkStation, in the System Tree pane, expand the System folder, then
expand the Ports folder.
2. Click the Serial folder.
3. On the File menu, point to New and then click RS232-COMn.
4. In the Name box, type a name for the port.

5. In the Description box, type a description for the port.
6. Click Create.
You now configure the port.
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87.5

Configuring a Serial Port
You configure a serial port (RS-232) to bring it online, ready to be associated with a
serial network. For an RS-485 port, you can only configure the Log file name.
For more information, see section 104.6 “Port Allocation and Configuration” on
page 4572.

To configure a serial port
1. In WorkStation, in the System Tree pane, select the serial port.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:

Note
• Do not use spaces in the Network interface name.
Continued on next page
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Component

Description

State

Displays the network status: Online or
Offline, or Unused (Unused means
that the port is not referenced from a
network).

Bytes transmitted

Displays the running total of bytes
transmitted through the port.

Bytes received

Displays the running total of bytes
received through the port.

Parity errors detected

Displays the running total of parity errors
detected.

Framing errors detected

Displays the running total of framing
errors detected.

Other errors detected

Displays the running total of other errors
detected (errors other than parity or
framing errors).

Network interface name

Type the name of the network interface
(read-only for an RS-485 port), which is
usually the name of the COM port that
you connect the network to. Do not use
spaces.

Log file name

Type the name of the port log file or leave
this as the default, PortLog.
For the Enterprise Server, the log file is
available in C:\ProgramData\Schneider
Electric StruxureWare\Building Operation
x.x\Enterprise Server\db\portlogs\RS232COM1.
For the Automation Server, the log file is
available in opt\tac\db\portlogs\RS485COMA.
The portlogs folder is only available if a
log has previously been started by way of
the Start log command in the port
context menu.

5. Click OK.

Note
• The Network interface name (for an RS-485 port in an
Automation Server) is pre-allocated as either /dev/tac/comporta
or /dev/tac/comportb.
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87.6

Port Allocation and Configuration
When you connect a serial network to an Automation Server or a PC running an
Enterprise Server, you must ensure that it connects by way of a serial port. First you
allocate a port to the connected network (using the interface properties), and then
you ensure that the port is correctly configured for the network (using the port
properties).
All Building Operation servers provide a Serial folder that contains one or two serial
ports by default. The number of serial ports available depends on the type of server.
In the Enterprise Server, the Serial folder contains just one RS-232 port:

Figure: RS-232 port in an Enterprise Server

If you need to add another serial port for an additional interface, you can add the
port in WorkStation (for an Enterprise Server only). Because most modern PCs have
only one serial port, you may need to an add additional physical port using an
external USB-to-Serial port converter. You may also need to configure the Network
interface name property of your additional Building Operation port to match the
name of the new physical port.
In an Automation Server, the Serial folder contains two RS-485 serial ports (one for
each available physical port on the lower screw terminals of the device):

Technical
3602

04-16006-04-en, March 2015

87 Modbus Serial Networks
87.6 Port Allocation and Configuration

Figure: RS-485 serial ports in an Automation Server

You cannot add additional ports for an Automation Server.
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87.7

Creating a Modbus Slave Network
You create a Modbus Slave Network to provide a serial interface through which a
master device on an external network communicates with an internal Modbus
Interface.
For more information, see section 87.1 “Modbus Serial Networks” on page 3589.

To create a Modbus Slave Network
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the Modbus Slave Network.
2. On the File menu, point to New and then click Interface.
3. In the object list, expand Modbus Interface and then select Modbus Slave
Network.

4. In the Name box, type a name for the Modbus Slave Network.
5. In the Description box, type a description for the Modbus Slave Network.
6. Click Create.
You now configure the Modbus Slave Network.
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87.8

Configuring a Modbus Slave Network
You configure the Modbus settings of a Modbus Slave Network to ensure that it is
compatible with any Modbus master device to be added to the network.
For more information, see section 89.1 “Network Configuration” on page 3633.

To configure a Modbus Slave Network
1. In WorkStation, in the System Tree pane, click the Modbus Slave Network
that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Network status

Displays the network status: Online or
Offline.

Framing mode

Select RTU to use Remote Terminal Unit
as the framing mode. The framing mode
must be the same for all devices on a
Modbus serial line.

Baud rate

Select the baud rate.

Parity

Select the parity.

Stop bits

Select the number of stop bits (1, 2, or
Auto). Auto enables Building Operation to
determine the number of bits based on all
the other communications parameters.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

Port reference

Enter the path of the serial port to which
the Modbus network is connected
(browse to the System – Ports folder).

Note
Standard Modbus mode applies if you leave J-Bus mode as No (the
default).
5. Click the Advanced tab.
Continued on next page
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6. Edit the advanced properties:
Component

Description

Silence characters

Select the number of silence characters
you want between each message
(normally 3.5). This is the waiting time
added after the final message character,
and determines the end of the message.
For more information, see section 164.2
“Serial Transmission Modes” on page
5661.

Transmit guard bits

Select the number of guard bits you want
to be inserted immediately after each
message data byte is transmitted
(normally 2). For more information, see
section 89.1 “Network Configuration” on
page 3633.

7. Click OK.
You can now add an external master device to the Modbus Slave Network.
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87.9

Creating a Modbus Master Network
You create a Modbus Master Network (on a serial port) to provide the facility to add
slave devices later (with the Automation Server or Enterprise Server as master).
For more information, see section 87.1 “Modbus Serial Networks” on page 3589.

To create a Modbus Master Network
1. In WorkStation, in the System Tree pane, select the Automation Server,
Enterprise Server, or folder where you want to create the Modbus Master
Network.
2. On the File menu, point to New and then click Interface.
3. In the object type list, expand Modbus Interface and then select Modbus
Master Network.

4. In the Name box, type a name for the network.
5. In the Description box, type a description for the network.
6. Click Create.
You can now configure the Modbus Master Network.
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87.10

Configuring a Modbus Master Network
You configure the Modbus settings of a Modbus master serial network to ensure
that it is compatible with any Modbus devices to be added to the network.
For more information, see section 89.1 “Network Configuration” on page 3633.

To configure a Modbus Master Network
1. In WorkStation, in the System Tree pane, select the Modbus Master
Network.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. In the Framing mode box, select the framing mode.

5. In the Baud rate box, select the baud rate.
6. In the Parity box, select the parity.
7. In the Stop bits box, select the number of stop bits.
8. In the J-Bus mode box, select Yes if you want to set the network to operate
in J-Bus mode.
Continued on next page
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9. In the Port reference box, enter the port that you want to associate with the
Modbus Master Network. The relative path
is ../System/Ports/Serial/[Port].

10. Click the Advanced tab.
Continued on next page
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11. In the Silence characters box, select the number of silence characters you
require between Modbus messages.

12. In the Transmit guard bits box, select the number of guard bits you require
after a Modbus message byte.
13. In the Receive timeout box, enter the maximum amount of time you want
the master/client device to wait before expecting a response from the
slave/server.
14. In the Point poll delay box, enter the delay you require between the end of
one poll request and the start of the next poll request.
Continued on next page
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15. In the Poll duty cycle box, select the ratio of polling time to total poll cycle
time.

16. Click OK.
You can now add a Modbus Device to the Modbus Master Network.
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88.1

Modbus TCP Networks
You can create three TCP network types in Building Operation:
• Modbus TCP Network: contains Modbus TCP server devices responding to an
internal Modbus client on either an Automation Server or Enterprise Server.
• Modbus TCP Server: an internal Modbus Interface responds to requests from
one or more clients on the external network.
• Modbus TCP Gateway: to provide communications with serial devices from a
TCP network.
You can also create an internal Modbus Interface on the Automation Server or
Enterprise Server. A Modbus Interface can respond to a master device on an
external serial network or a client device on an external TCP network (depending on
configuration). For more information, see section 90.2 “Modbus Interface” on page
3640.
For communication through TCP ports, you must configure the IP port number in
addition to standard Modbus protocol settings. For more information, see section
86.13 “Modbus Connections to the Building Operation Server” on page 3584.
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Figure: Modbus TCP Network examples

88.1.1

Modbus TCP Network
You can create a new Modbus TCP Network in an Automation Server or Enterprise
Server. In this example, the Automation Server is the client.

Figure: Modbus TCP Network created in an Automation Server
Technical
3616

04-16006-04-en, March 2015

88 Modbus TCP Networks
88.1 Modbus TCP Networks

You can then create Modbus TCP devices on the Modbus TCP Network. For
example, a network is set up with two electricity meters. Each meter is a server to
the client (the Automation Server).

Figure: Server network with Automation Server as client

88.1.2

Modbus TCP Server
You can create a new Modbus TCP Server in an Automation Server or Enterprise
Server. In this example, the Automation Server is the server.

Figure: Modbus TCP Server created in an Automation Server

You can then set up an IP port, through which one or more external clients can
communicate with the internal Modbus Interface. You must create the Modbus
Interface when you create the the Modbus TCP Server. You then create Modbus
values on the Modbus Interface. The Modbus values are accessed by the external
client. For more information, see section 90.2 “Modbus Interface” on page 3640.
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Figure: Modbus TCP Server with Automation Server as the server

88.1.3

Modbus TCP Gateway
A Modbus TCP Gateway enables the Automation Server or Enterprise server to
communicate with remote Modbus serial devices over the Ethernet, by way of an
external gateway device.
In theory, you can address up to 247 serial devices through a gateway device, but
this is subject to the limitations of the gateway device in use. For communication
through a Modbus TCP Gateway, you must configure the IP port number and IP
address of the gateway.
You create a Modbus TCP Gateway in an Automation Server or Enterprise Server.

Figure: Modbus TCP Gateway created in an Enterprise Server

You can then create serial Modbus devices on the Modbus TCP Gateway. In this
example, a network is set up with two standard Modbus devices attached to the
gateway device. Each serial device is a server to the client (the Enterprise Server).
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Figure: Modbus TCP Gateway with two serial devices
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88.2

Modbus TCP Network Workflow
The Modbus TCP Network workflow enables you to create a Modbus TCP Network
in Building Operation.
The following flowchart describes the basic steps required to create a Modbus TCP
Network. Related information can be found in the sections after the flowchart.

Figure: Modbus TCP Network flowchart
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Create a Modbus TCP Network
In WorkStation, create a Modbus TCP Network under an Enterprise Server or an
Automation Server.
For more information, see section 88.5 “Creating a Modbus TCP Network” on page
3623.

Create a Modbus TCP device
In WorkStation, create a Modbus TCP device under the Modbus TCP network.
For more information, see section 91.4 “Creating a Modbus Device” on page 3654.

Create a Modbus Register Group
If you require Modbus to operate using the batch read functionality, add a register
group to the device.
For more information, see section 93.5 “Creating a Modbus Register Group” on
page 3697.
For more information, see section 93.8 “Adding Modbus Points to a Modbus
Register Group” on page 3701.

Create Modbus points
In the device (or register group), create Modbus points.
For more information, see section 92.3 “Creating a Modbus Point” on page 3666.

Check communications
In WorkStation, check that the network and all devices and points are online. Drag
Modbus points to the Watch pane and check that their values vary in line with the
corresponding values in the physical Modbus network.
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88.3

Modbus TCP Gateway Workflow
The Modbus TCP Gateway workflow enables you to create a Modbus TCP
Gateway in Building Operation and add serial devices to the gateway.
The following flowchart describes the basic steps required to create a Modbus TCP
Gateway. Related information can be found in the sections after the flowchart.

Figure: Modbus TCP Gateway flowchart
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Create a Modbus TCP Gateway
In WorkStation, create a Modbus TCP Gateway under an Enterprise Server or an
Automation Server.
For more information, see section 88.7 “Creating a Modbus TCP Gateway” on page
3626.

Create Modbus device
In WorkStation, create a Modbus serial device under the Modbus TCP gateway.
For more information, see section 91.4 “Creating a Modbus Device” on page 3654.

Create Modbus Register Group
If you require Modbus to operate using the batch read functionality, add a register
group to the device.
For more information, see section 93.5 “Creating a Modbus Register Group” on
page 3697.
For more information, see section 93.8 “Adding Modbus Points to a Modbus
Register Group” on page 3701.

Create Modbus points
In the device (or register group), create Modbus points.
For more information, see section 92.3 “Creating a Modbus Point” on page 3666.

Check communications
In WorkStation, check that the network and all devices and points are online. Drag
Modbus points to the Watch pane and check that their values vary in line with the
corresponding values in the physical Modbus network.
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88.4

Modbus TCP Server Workflow
The Modbus TCP Server workflow enables you to create a Modbus TCP Server in
Building Operation.
The following flowchart describes the basic steps required to create a Modbus TCP
Server. Related information can be found in the sections after the flowchart.

Figure: Modbus TCP Server flowchart

Create a Modbus TCP Server
In WorkStation, create a Modbus TCP Server under an Enterprise Server or an
Automation Server.
For more information, see section 88.9 “Creating a Modbus TCP Server” on page
3629.

Create a Modbus Interface
In WorkStation, create a Modbus Interface under the same Enterprise Server or
Automation Server where you created the Modbus TCP Server.
For more information, see section 90.3 “Creating a Modbus Interface” on page
3642.

Create Modbus local registers
In the Modbus interface, create Modbus local registers.
For more information, see section 92.6 “Creating a Modbus Value” on page 3677.

Check communications
In WorkStation, check that the Modbus TCP Server and the Modbus Interface are
online. Drag Modbus points to the Watch pane and check that their values vary in
line with the corresponding values in the physical external client.
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88.5

Creating a Modbus TCP Network
You create a Modbus TCP Network so that you can later add Modbus TCP devices
to this network.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.

To create a Modbus TCP Network
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the Modbus TCP Network.
2. On the File menu, point to New and then click Interface.
3. In the object list, expand Modbus Interface and then select Modbus TCP
Network.

4. In the Name box, type a name for the Modbus TCP Network.
5. In the Description box, type a description for the Modbus TCP Network.
6. Click Create.
You now configure the Modbus TCP Network.
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88.6

Configuring a Modbus TCP Network
You change the configuration properties of a Modbus TCP Network when you want
to set the network addressing mode to J-Bus mode, or if you want to reset the
number of network read or write failures to zero.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.

To configure a Modbus TCP Network
1. In WorkStation, in the System Tree pane, select the Modbus TCP Network
that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Network status

Displays the network status: Online or
Offline.

Output write failure

Displays Failure when the writing of one
or more output values has failed on the
network. Select OK to clear the output
error flag after a successful write to all
devices.

Input read failure

Displays Failure when the reading of one
or more input values has failed on the
network. Select OK to clear the input
error flag after a successful read from all
devices.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

Note
Standard Modbus mode applies if you leave J-Bus mode as No (the
default).
5. Click OK.
6. Click the Advanced tab.
Continued on next page
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7. Edit the advanced properties:
Component

Description

Receive timeout (ms)

Enter the number of milliseconds you
want the Modbus master/client to wait for
a response to a message query (normally
2000 ms). For more information, see
section 89.1 “Network Configuration” on
page 3633.

Point poll delay (ms)

Enter the delay that you require between
the end of one poll request and the start
of the next poll request (for use only if
there are problems with
communications). For more information,
see section 89.1 “Network Configuration”
on page 3633.

Poll duty cycle (%)

Select the ratio of actual polling time to
total poll cycle time. For more information,
see section 89.1 “Network Configuration”
on page 3633.

8. Click OK.
You now add a TCP device to the Modbus TCP Network.
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88.7

Creating a Modbus TCP Gateway
You create a Modbus TCP Gateway to enable communications between an
Enterprise Server or an Automation Server and Modbus serial devices (over the
Ethernet, by way of an external gateway device).
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.

To create a Modbus TCP Gateway
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the Modbus TCP Gateway.
2. On the File menu, point to New and then click Interface.
3. In the object list, expand Modbus Interface and then click Modbus TCP
Gateway.

4. In the Name box, type a name for the Modbus TCP Gateway.
5. In the Description box, type a description.
6. Click Create.
You now configure the Modbus TCP Gateway.
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88.8

Configuring a Modbus TCP Gateway
You change the configuration properties of a Modbus TCP Gateway when you want
to set up the IP properties or change to J-Bus mode.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.

To configure a Modbus TCP Gateway
1. In WorkStation, in the System Tree pane, select the Modbus TCP Gateway
that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Network status

Displays the network status: Online or
Offline.

Output write failure

Displays Failure when the writing of one
or more output values has failed on the
network. Select OK to clear the output
error flag after a successful write to all
devices.

Input read failure

Displays Failure when the reading of one
or more input values has failed on the
network. Select OK to clear the input
error flag after a successful read from all
devices.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

IP port

Type the number of the IP port.

IP address

Type the IP address.

Note
Standard Modbus mode applies if you leave J-Bus mode as No (the
default).
5. Click OK.
6. Click the Advanced tab.
Continued on next page
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7. Edit the advanced properties:
Component

Description

Receive timeout (ms)

Enter the number of milliseconds you
want the Modbus master/client to wait for
a response to a message query (normally
2000 ms). For more information, see
section 89.1 “Network Configuration” on
page 3633.

Point poll delay (ms)

Enter the delay that you require between
the end of one poll request and the start
of the next poll request (for use only if
there are problems with
communications). For more information,
see section 89.1 “Network Configuration”
on page 3633.

Poll duty cycle (%)

Select the ratio of actual polling time to
total poll cycle time. For more information,
see section 89.1 “Network Configuration”
on page 3633.

8. Click OK.
You now create Modbus serial devices on the Modbus TCP Gateway.
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88.9

Creating a Modbus TCP Server
You create a Modbus TCP Server so that you can later add TCP clients.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.

To create a Modbus TCP Server
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the Modbus TCP Server.
2. On the File menu, point to New and then click Interface.
3. In the object list, expand Modbus Interface and then select Modbus TCP
Server.

4. In the Name box, type a name for the Modbus TCP Server.
5. In the Description box, type a description for the Modbus TCP Server.
6. Click Create.
You now configure the Modbus TCP Server.
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88.10

Configuring a Modbus TCP Server
You change the configuration properties of a Modbus TCP Server when you want
to set the network addressing mode to J-Bus mode.
For more information, see section 88.1 “Modbus TCP Networks” on page 3613.

To configure a Modbus TCP Server
1. In WorkStation, in the System Tree pane, select the Modbus TCP Server
that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Network status

Displays the network status: Online or
Offline.

IP port

Type the number of the IP port.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

Note
Standard Modbus mode applies if you leave J-Bus mode as No (the
default).
5. Click OK.
You can now use one or more Modbus TCP clients with the Modbus TCP Server.

Technical
3632

04-16006-04-en, March 2015

89

Network Configuration

Topics
Network Configuration

89 Network Configuration
89.1 Network Configuration

89.1

Network Configuration
In WorkStation, each Modbus network type contains several properties that you
must configure to enable proper communications between the devices on the
network. Some properties (for example, J-Bus mode) are common to all network
types, and some other properties are specific to network type (for example, Baud
rate applies only to serial networks).

89.1.1

Framing Mode
The Framing Mode function enables you to select either RTU or ASCII as the
method of message transmission over a Modbus serial network. As with other
network properties (baud rate, parity, and J-Bus mode), you must ensure that all
devices on the network are set to the same framing mode.
RTU framing mode has faster message transmission than ASCII framing mode, so
RTU is more common than ASCII. For this reason, RTU framing mode is the default.
For more information, see section 164.2 “Serial Transmission Modes” on page
5661.

89.1.2

Baud Rate Selection
For serial ports, the baud rate is the data rate in bits per second. In WorkStation,
you can set the baud rate in the Modbus settings section of the network setting
properties. However, you must ensure that the baud rate set at the network
matches the speed configured in all the network devices. The following baud rates
are available:
• 300
• 600
• 1200
• 2400
• 4800
• 9600
• 19200
• 38400
• 57600
• 115200

Note
Baud rate selection applies only to serial networks. You cannot select a baud rate
for devices on TCP/IP networks.
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89.1.3

Port Reference
In a Modbus serial network, the port reference links the network to the serial port.
You can select the port to be used for serial connections from the System folder.

89.1.4

Parity Checking
In WorkStation, you can select parity checking of the Modbus message data byte
(that is each character) to be Odd, Even, or No Parity:
• Odd parity means that if an odd number of data bits has been transmitted then
the transmission is successful.
• Even parity means that if an even number of data bits has been transmitted
then the transmission is successful.
• None (No Parity) means that parity bits are not transmitted or checked to find
errors. (In Building Operation, an extra Stop bit is added to the data byte in this
circumstance.)
You can set the parity in the Modbus Settings section of the network setting
properties. However, you must ensure that the parity set at the network matches
the parity configured in all of the network devices. The default parity setting is Even.

Note
Parity selection applies only to serial networks. You cannot select parity for
devices on TCP/IP networks.

89.1.5

Stop Bits
When configuring a Modbus network or interface, you can manually select the
number of stop bits, for those devices which have non-standard settings for stop
bits. The default value is Auto.

89.1.6

J-Bus Mode Selection
In a Modbus network, you can select either Modbus or J-Bus as the mode of
device addressing. Modbus is selected by default. The only difference between
Modbus and J-Bus (as far as network addressing is concerned) is that in J-Bus
mode, device addresses are one less in number than Modbus device addresses.
J-Bus should only be set for devices configured for J-Bus.

89.1.7

Silence Characters
Each Modbus message starts and ends with a number of silence characters that
you can configure if you think that message responses are slow. However, it is
normal to leave this number at the default value of 3.5. For more information, see
section 164.2 “Serial Transmission Modes” on page 5661.
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89.1.8

Receive Timeout
In normal Modbus operation, when a master device sends a query to a slave
device, the slave device provides a response. The Receive timeout is the maximum
amount of time allowed to elapse before the master increments the read/write error
count. Receive timeout applies only to master networks, that is those networks
which are master/slave or client/server:
• Modbus Master Networks
• Modbus TCP Networks
• Modbus TCP Gateways
You can change the Receive timeout value to accommodate slow responses from
Modbus devices. The default value is 2000 ms, which is sufficiently long to
accommodate responses for most devices. However, you can also shorten the
Receive timeout if, for example, you are confident that your devices have a
consistently rapid response rate and you want to speed up a network.
You can select from a Receive timeout range of 500 ms to 10,000 ms, or you can
enter your own value.

89.1.9

Point Poll Delay
In normal operation, when a Modbus device is polling various slave devices, there is
a delay between the previous response being received and the next query being
sent out. To accommodate the various turnaround times of the many different types
of Modbus devices, this delay is programmable using the Point poll delay property.
The Point poll delay property applies to the Modbus Master Network, Modbus TCP
Network, and the Modbus TCP Gateway.
You can change the Point poll delay from the default of 0 milliseconds up to a
maximum of 200 milliseconds. The default value of 0 milliseconds allows Modbus to
operate at the maximum efficiency (applying any non-zero value will introduce a
delay between each Modbus query message). The Point poll delay should be used
when problems are observed on network communications that result in Modbus
devices going offline.

89.1.10

Poll Duty Cycle
During each poll cycle, the Modbus master (or client) device polls the slave (or
server) device for a fixed period of time, after which follows a variable delay before
the next cycle. The Poll duty cycle is the amount of time spent polling divided by the
total poll cycle time. Changing the Poll duty cycle effectively varies the post-polling
delay time, and enables you to alter both Modbus network performance and how
hard the Central Processor Unit is working.
When changing the poll duty cycle, consider the following information:
• A small value of Poll duty cycle causes a slow poll rate and a low value of CPU
usage.
• A large value of Poll duty cycle causes a fast poll rate but a high value of CPU
usage.
In practice, depending on the number of networks in your system, you might select
a Poll duty cycle that optimizes both poll rate and CPU usage.
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The Default setting of Poll duty cycle means that all subscribed Modbus points are
polled as in software version 1.5. This enables you to maintain previous
performance after a software upgrade. All subscribed points are polled one at a
time with a fixed 2 ms delay (plus any Point poll delay) between each poll. The poll
sequence is then followed by a further 500 ms delay before repeating. However, by
selecting a percentage value (rather than leaving the Poll duty cycle at Default) you
have more control of the performance.

89.1.11

Transmit Guard Bits
Transmit guard bits provide a delay immediately after the end of each message data
byte transmitted from the master device. This delay provides time for the receiver
component of the slave device to recognize that the last transmitted message data
byte is complete.
You can change the number of transmit guard bits, but the default value (2) is
chosen to ensure that there are no transmission errors for most Modbus device
types. If you find that devices are regularly going offline due to transmission errors,
examine the framing errors property of the port associated with the Modbus
network. For more information, see section 108.4 “Serial Port Properties – Basic
Tab” on page 4718.
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90.1

Modbus Interfaces
When creating a communications interface for your Modbus network in
WorkStation, you initially select one of six options under the heading of Modbus
Interface. Each of these options is either a network or an interface, but the first
selection, (Modbus Interface) is a special case that relates to an internal device.

90.1.1

Modbus Interface to Building Operation Server
The term "Modbus Interface" is the generic name for the Modbus network or
interface types that you can select for creation in the System Tree pane when you
want to establish communications between the Building Operation server and your
physical Modbus network.
You can select from six different Modbus network or interface types:
• Modbus Interface
• Modbus Master Network
• Modbus Slave Network
• Modbus TCP Gateway
• Modbus TCP Server
• Modbus TCP Network

90.1.2

Modbus Interface
A Modbus Interface enables one or more external devices (master devices or
clients) to communicate with an Automation Server or Enterprise Server. The
Modbus Interface defines whether the internal device of the Enterprise Server or
Automation Server is a slave or a server (or both), depending on the network you
want to set up.
For more information, see section 90.2 “Modbus Interface” on page 3640.
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90.2

Modbus Interface
A Modbus Interface enables one or more external devices (master devices or
clients) to communicate with an Automation Server or Enterprise Server. The
Modbus Interface defines whether the internal device of the Enterprise Server or
Automation Server is a slave or a server (or both), depending on the network you
want to set up.
When the external device is a master on a serial network, the Modbus Interface acts
as a slave. Messages are passed by way of a Modbus Slave Network. For more
information, see section 87.1 “Modbus Serial Networks” on page 3589.
When the external device is a client on a TCP network, the Modbus Interface acts
as a server. Messages are passed by way of a Modbus TCP Server. For more
information, see section 88.1 “Modbus TCP Networks” on page 3613.Modbus
Slave Network
You cannot create more than one Modbus Interface on an Automation Server or an
Enterprise Server. If you do create more than one Modbus Interface on different
servers, you need to configure a different device address for each Modbus
Interface.
You can create Modbus analog, digital, and multistate values in the Modbus
Interface, and assign addresses for reading by the external master or client.

Figure: Modbus Interface options

90.2.1

General Interface Configuration
When you configure Modbus values (variables) in the local registers of a Modbus
Interface, you can configure each value to be changed programmatically by a
configured driver, such as a Function Block program or by a fieldbus other than
Modbus. You can also configure a Modbus value to be changed manually by a
user, such as a WorkStation or WebStation user, or the operator of a Human
Machine Interface (HMI) device. However, you can only configure one driver for any
given Modbus value.
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90.2.2

Configuration with HMI Device as Master
If you connect an HMI device as a master device in a Modbus Slave Network (or the
client device in a Modbus TCP Server network), and the Modbus local registers are
being driven by a fieldbus other than Modbus, you must change the mode of the
Modbus Interface so that the values in the Modbus local registers refer to usercontrolled variables in the HMI device. If you do not use an HMI device, Modbus
values are controlled programmatically using the default (Control) mode.
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90.3

Creating a Modbus Interface
You create a Modbus Interface to provide either a virtual slave to a master device in
an external serial network or a server to a client in an external TCP network.
For more information, see section 90.2 “Modbus Interface” on page 3640.

To create a Modbus Interface
1. In WorkStation, in the System Tree pane, select the Automation Server,
Enterprise Server, or the folder where you want to create the Modbus
Interface.
2. On the File menu, point to New and then click Interface.
3. In the object list, expand Modbus Interface and then select Modbus
Interface.

4. In the Name box, type a name for the Modbus Interface.
5. In the Description box, type a description for the Modbus Interface.
6. Click Create.
You now configure the Modbus Interface.
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90.4

Configuring a Modbus Interface
You configure the address of an internal Modbus Interface to ensure
communications with an external master device.
For more information, see section 90.2 “Modbus Interface” on page 3640.

To configure a Modbus Interface
1. In WorkStation, in the System Tree pane, click the Modbus Interface that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Status

Displays the Modbus Device status:
Online, Offline, or Invalid.

Device address

Enter the address of the Modbus
Interface. This address must match the
address of the external master device.

Timeout

Select the amount of time that a Modbus
Interface has to receive a valid Modbus
message from the master device/client
before the Network status is displayed as
Offline. A setting of Inhibit stops the
monitoring of incoming requests.

Mode

Select Control (the default) for external
programmatic control, or select HMI to
enable control by a Human Machine
Interface device acting as a Modbus
master (or client). For more information,
see section 90.2 “Modbus Interface” on
page 3640.

5. Click OK.
You now add Modbus values to the internal Modbus Interface.
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91.1

Modbus Devices
In WorkStation, you can add a representation of any physical Modbus device in a
serial or TCP network. All devices use the same device icon and are created in the
same way, regardless of network type. However, if you are using a device in a serial
network, the device is either a master device or a slave device but is simply called a
Modbus device. Similarly, when using a device in a TCP network, the device is
either a client device or a server device but is simply called a Modbus TCP device.
Modbus device types can include programmable logic controllers, meters, and any
device that conforms to the Modbus standard. All devices on a Modbus network
must be configured with common Modbus network parameters, such as the
transmission mode and baud rate, and a unique address. You must match these
parameters in WorkStation when setting up the system.
Data in Modbus devices is held in registers. Each register has its own address in
memory, which can be accessed by the Modbus master device for read/write
purposes. Modbus registers are typically grouped in the address ranges shown in
the following diagram:

Figure: Registers in a Modbus device

Note
The address ranges for the different register types in Modbus devices typically
start as shown in the diagram above. However, in Building Operation, the use of
function codes enables you to specify the start address of each range as 1.
You can find a Modbus map of registers within a particular Modbus device in the
manufacturer’s datasheet for that device.
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91.1.1

Discrete Output Coils
A ‘coil’ is the Modbus term used for the discrete output value of a single bit (On or
Off). A coil can be written to and read from by the Modbus master device.

91.1.2

Discrete Input Status
A discrete input status is the value (On or Off) of a single bit at an input. A discrete
input status is read-only.

91.1.3

Input Registers
An input register is a read-only register that is two bytes wide (16-bit) and can be
used for various purposes.

91.1.4

Holding Registers
Internal values in a Modbus device are stored in holding registers and can be written
to and read from by the Modbus master device. These registers are two bytes wide
(16-bit) and can be used for various purposes.

91.1.5

Device Identification
All Modbus devices that support the Modbus Read Device Identification protocol
automatically display basic device identification information in the device properties:
• Vendor name
• Product code
• Product revision
You do not have to activate device identification. When the device comes online, a
special set of registers within the device is automatically read by the master device,
and the device identification text is displayed in the relevant device property fields.
Before the first reading of the device identification registers by the master device,
the device properties are set to Null. If the device does not support the Modbus
Read Device Identification protocol, the identification property fields are blank
following the read by the master device.
The master device reads the device identification registers once, at each power up
(using function code 43). However, you can force the master device to refresh the
slave device identification information (if the slave device supports this), for example
after a device disconnection or a communications problem.
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91.1.6

Device Communications Configuration
In Building Operation, the master device must poll a slave device on the network to
establish if the device is available for communications. A Modbus message has
several essential components, such as:
• Device address
• Poll register (register address)
• Poll code (function code)
• Poll Interval: Inhibit, 1, 2, 5, 10, 15, 20, and 30

Figure: Modbus device settings

Details of all of the communication parameters are available in the device’s
documentation. When the correct parameters are entered, the device is Online as
indicated by the Status property.

Device Address
The device address is the address used by the master device in a query message
to identify a slave device on the network. You must ensure that this address is the
same as the address available in the device.
If using a TCP network, you must also specify the IP address of the device.

Poll Register
The poll register number you enter can be any valid Modbus register address. The
register address is polled by the Enterprise Server or Automation Server when no
other address is being polled, to determine if the device is online. Providing that a
valid reference is received from the device, Building Operation displays the device
status as Online even if an error or exception code is received from the device.

Poll Code
The poll code you enter is the function code to read any register in the device to
determine if the device is online. All available poll codes are therefore read only
codes. The poll code operates in the same way as the function code used when
configuring a Modbus point.

Poll Interval
The poll interval is the amount of time between polls when the selected device is
polled to determine if it is online. The default interval is 10 seconds, and can also be
set to Inhibit, in which case Online/Offline detection only occurs when a specific
request is made of the device.

Note
Inhibit is used to prevent alarms when doing offline engineering; you must
remember to remove the Inhibit function during normal operation.
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91.2

Creating a Modbus TCP Device
You create new Modbus TCP devices on a Modbus TCP Network to represent real
devices on an external Ethernet network.
For more information, see section 91.1 “Modbus Devices” on page 3647.

To create a Modbus TCP device
1. In WorkStation, in the System Tree pane, select the Modbus TCP Network
where you want to create the Modbus TCP device.
2. On the File menu, point to New and then click Modbus TCP Device.
3. In the Name box, type a name for the TCP device.

4. In the Description box, type a description.
5. Click Create.
You now configure the Modbus TCP device.
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91.3

Configuring a Modbus TCP Device
You configure a Modbus TCP Device to give it an address and to set up a register
within the device to which the client can communicate.
For more information, see section 91.1 “Modbus Devices” on page 3647.

To configure a Modbus TCP Device
1. In WorkStation, in the System Tree pane, select the Modbus TCP Device
object.
2. On the File Menu, click Properties.
3. Click the Basic tab.
Continued on next page
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4. Edit the basic properties:
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Component

Description

Status

Displays the Modbus Device status:
Online, Offline, or Invalid.

Output write failure

Displays Failure when the writing of one
or more output values has failed on the
network. Select OK to clear the output
error flag after a successful write to all
devices.

Input read failure

Displays Failure when the reading of one
or more input values has failed on the
network. Select OK to clear the input
error flag after a successful read from all
devices.

Vendor name

Displays the name of the device vendor
(for supported devices). For more
information, see section 91.1 “Modbus
Devices” on page 3647.

Product code

Displays the product code of the device
(for supported devices). For more
information, see section 91.1 “Modbus
Devices” on page 3647.

Revision number

Displays the revision number of the
device (for supported devices). For more
information, see section 91.1 “Modbus
Devices” on page 3647.

Device address

Enter the address of the Modbus TCP
Device. This address must also be
configured in the actual external device.

IP port

Type the number of the IP port.

IP address

Type the IP address of the Modbus TCP
Device.

Poll register

Enter the number of any register in the
external device/server. Register numbers
are shown on the Modbus map on the
device datasheet.

Poll code

Select the function code for the selected
poll register.

Poll interval

Select how often you want polling to
occur for the selected device/server
during communication attempts.

Non-contiguous read

Select Enabled if you want the master
(or client) device to read non-contiguous
registers (scattered read function), for
supported slave devices. For more
information, see section 93.1 “Modbus
Batch Read Function” on page 3683.
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Important
Consult the datasheet for the device to be configured. The datasheet
contains the number of the register and the code you must enter to
establish basic communications.
5. Click OK.
You now add points to the Modbus TCP Device.
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91.4

Creating a Modbus Device
You create Modbus devices on a serial Modbus Master Network or Modbus TCP
Gateway to represent physical devices.
For more information, see section 91.1 “Modbus Devices” on page 3647.

To create a Modbus device
1. In WorkStation, in the System Tree pane, select the Modbus Master
Network or Modbus TCP Gateway where you want to create the Modbus
Device.
2. On the File menu, point to New and then click Modbus Device.
3. In the Name box, type a name for the Modbus Device.

4. In the Description box, type a description for the Modbus Device.
5. Click Create.
You can now configure the Modbus Device.
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91.5

Configuring a Modbus Device
You configure a Modbus Device to give the device an address and to set up a
register within the device with which the master/client device can communicate.
For more information, see section 91.1 “Modbus Devices” on page 3647.

To configure a Modbus device
1. In WorkStation, in the System Tree pane, select the device.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. In the Device address box, enter the device address.

Caution
Ensure that each device in a network is configured with a unique
address.

Continued on next page
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5. In the Poll register box, enter the poll register.

Important
Consult the datasheet for the device to be configured. The datasheet
contains the number of the register and the code you must enter to
establish basic communications.
6. In the Poll code box, select the poll code.
7. In the Poll interval box, select how often you want the master/client to poll
the slave/server during communication attempts.
8. In the Non-contiguous read box, select Enabled if you want the master (or
client) device to read non-contiguous registers (in supported devices) in a
single transaction.

9. Click OK.

Note
• In a live system, the Device Status property starts Online and
changes to Offline if device polls fail.
You can now add points to the Modbus Device.
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91.6

Creating Multiple Modbus Devices
Using the Spreadsheet view, you can quickly create multiple Modbus devices,
which you otherwise would create one at a time in the wizard.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To create multiple Modbus devices
1. In WorkStation, in the System Tree pane, select the Modbus Master
Network where you want to create the Modbus devices.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, click New and then click Modbus.
4. In the Type column, select Modbus Device.

5. Enter the properties of the Modbus device.

Caution
Ensure that each device in a network is configured with a unique
address.

Important
Consult the datasheet for the device to be configured. The datasheet
contains the number of the register and the code you must enter to
establish basic communications.
6. Create additional Modbus devices using Steps 4-5.
Continued on next page
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Tip
You can also copy and paste cells, rows, and entire blocks.
7. On the File menu, click Save.
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91.7

Refreshing Modbus Device
Identification
You refresh the identification of a Modbus device to ensure that the device
properties display the basic identification information contained in the device
registers following a disconnection or power down of the device.
For more information, see section 91.1 “Modbus Devices” on page 3647.

To refresh Modbus device indentification
1. In WorkStation, in the System Tree pane, select the Modbus device where
you want to refresh device identification.
2. On the Actions menu, click Refresh device identification.
3. Check that the Vendor code, Product code, and Revision number
contain suitable text relating to the identity of the Modbus device.
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92.1 Point and Value Types

92.1

Point and Value Types
Building Operation supports Modbus analog, digital, and multistate points for a
device on a Modbus Master Network or a Modbus TCP device on a Modbus TCP
Network. Similarly, Modbus analog, digital, and multistate values are supported for
an internal Modbus Interface.

92.1.1

Point Types
The following Modbus point types are supported as inputs to or outputs from the
master (or client):
Table: Modbus Point Types

92.1.2

Modbus Point

Description

Modbus Analog Input Point

A point of analog origin such as voltage or
current

Modbus Analog Output Point

A point of analog origin such as voltage or
current

Modbus Digital Input Point

A point of digital origin such as Logic 1 or
Logic 0, or On or Off

Modbus Digital Output Point

A point of digital origin such as Logic 1 or
Logic 0, or On or Off

Modbus Multistate Input Point

A point of with several possible states such
as On, Off, or Auto

Modbus Multistate Output Point

A point of with several possible states such
as On, Off, or Auto

Value Types
The following Modbus value types are supported for an internal Modbus Interface
(slave or server):
• Modbus Analog Value: an analog value (input or output)
• Modbus Digital Value: a digital value (input or output)
• Modbus Multistate Value: a multistate value (input or output)
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92.2

Modbus Points and Values
In WorkStation, you can configure input or output points on Modbus devices to
enable read/write of values between master device and slave device or between
client and server. For example, if you wanted to read the number of kilowatts being
monitored by an electricity meter, you could set up an analog input point with the
address and function code of the register within the meter that holds the kilowatts
information.
Building Operation supports Modbus analog, digital, and multistate points for a
device on a Modbus Master Network or a Modbus TCP device on a Modbus TCP
Network. Similarly, Modbus analog, digital, and multistate values are supported for
an internal Modbus Interface.

92.2.1

Point Types
Table: Modbus Point Types

92.2.2

Modbus Point

Description

Modbus Analog Input Point

A point of analog origin such as voltage or
current

Modbus Analog Output Point

A point of analog origin such as voltage or
current

Modbus Digital Input Point

A point of digital origin such as Logic 1 or
Logic 0, or On or Off

Modbus Digital Output Point

A point of digital origin such as Logic 1 or
Logic 0, or On or Off

Modbus Multistate Input Point

A point of with several possible states such
as On, Off, or Auto

Modbus Multistate Output Point

A point of with several possible states such
as On, Off, or Auto

Value Types
The following Modbus value types are supported for an internal Modbus Interface
(slave or server):
• Modbus Analog Value: an analog value (input or output)
• Modbus Digital Value: a digital value (input or output)
• Modbus Multistate Value: a multistate value (input or output)
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92.2.3

Point and Value Configuration
In WorkStation, you can configure Modbus points and Modbus values in terms of
the register addressed and the function code. You can also apply a bit mask to a
16-bit (unsigned) word and specify the gain and offset to be applied to the value in
the addressed register.
For more information, see section 92.4 “Point and Value Configuration” on page
3667.
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92.3

Creating a Modbus Point
You create Modbus points to read available values from a device's registers or write
values to a device's registers.
For more information, see section 92.2 “Modbus Points and Values” on page 3664.

To create a Modbus point
1. In WorkStation, in the System Tree pane, select the Modbus device where
you want to create the Modbus point.
2. On the File menu, point to New and then click Modbus Points.
3. In the object type list, select the type of Modbus point.

4. In the Name box, type the datasheet reference name for the Modbus point.
5. In the Description box, type the datasheet reference description for the
Modbus point.
6. Click Create.
You can now configure the Modbus point.
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92.4

Point and Value Configuration
In WorkStation, you can configure Modbus points and Modbus values in terms of
the register addressed and the function code. You can also apply a bit mask to a
16-bit (unsigned) word and specify the gain and offset to be applied to the value in
the addressed register.
The configurable properties are described in the following paragraphs (not all
configurable properties apply to all points/values).

92.4.1

Register Number
The Register Number is the number (referred to the register address) of the register
from which data is requested by the master device, or to which data is written. If
data is required from more than one register, this is inherent in the type of data
selected in the Register Type property.

92.4.2

Register Type
The Register type provides the following data formats for the input or output value in
the addressed register:
Table: Data Formats in the Register Type Property
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Register Type

Range or Format

Point Type

Digital coil

Digital

Each coil address represents
a digital value

16-bit unsigned

0 to 65535

Analog/Multistate/Digital

16-bit signed

-32768 to 32767

Analog/Multistate

32-bit unsigned

0 to 4,294,967,295. Two
registers as 32-bit UINT.

Analog/Multistate

32-bit unsigned swapped

As above, but with the
register order reversed

Analog/Multistate

32-bit signed

-2,147,483,648 to
2,147,483,647. Two
registers as 32-bit SINT.

Analog/Multistate

32-bit signed swapped

As above, but with the
register order reversed

Analog/Multistate

32-bit real

IEE 754, 32-bit floating point. Analog
Most significant 16-bit word
in lower register.

32-bit real swapped

IEE 754, 32-bit floating point. Analog
Most significant 16-bit word
in higher register.

64-bit real

0 to 1.84 x 1018

Analog
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Continued
Register Type

Range or Format

Point Type

64-bit real swapped

As above, but with the
register order reversed

Analog

32-bit unsigned Mod10K

Two registers, each with
range 0-9,999. Value = Reg
1 + (Reg 2*10,000).

Analog/Multistate

32-bit unsigned Mod10K
swapped

As above, but with the
register order reversed

Analog/Multistate

32-bit signed Mod10K

To be advised

Analog/Multistate

48-bit unsigned Mod10K

Three registers, each with
range 0-9,999. Value = Reg
1 + (Reg 2*10,000) + (Reg
3*100,000,000).

Analog/Multistate

48-bit unsigned Mod10K
swapped

As above, but with the
register order reversed

Analog/Multistate

64-bit unsigned Mod10K

Four registers, each with
range 0-9,999. Value = Reg
1 + (Reg 2*10,000) + (Reg
3*100,000,000) + (Reg
4*1,000,000,000,000).

Analog/Multistate

64-bit unsigned Mod10K
swapped

As above, but with the
register order reversed

Analog/Multistate

64-bit unsigned

Analog: 0 to
4,503,599,627,370,495.
Multistate: 0 to
9,223,372,036,854,775,807

Analog/Multistate

64-bit unsigned swapped

As above, but with the
register order reversed

Analog/Multistate

64-bit signed

Analog: Analog/Multistate
4,503,599,627,370,495 to
4,503,599,627,370,495.
Multistate:
−9,223,372,036,854,775,80
8 to
9,223,372,036,854,775,807

64-bit signed swapped

As above, but with the
register order reversed

Analog/Multistate

If you select 16-bit data, only the register with the number you enter in the Register
Number property is read. If you select 32-bit, 48-bit, or 64-bit data, then two, three,
or four contiguous 16-bit words respectively are read, starting at the register with
the number you enter in the Register Number property.
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Note
• When multiple 16-bit words are read/written, the last word read/written
becomes the most significant word.
• Word swapping: In WorkStation, swapped means that the high order word is
read first.
• Not all register types (data formats) are available for all types of points. For
example, a digital input has only the digital coil and unsigned 16-bit options.

92.4.3

Read Function Code
The Read function code determines which type of register(s) are to be accessed for
data retrieval. For more information, see section 86.11 “Function Code Definition
and Selection” on page 3580.

92.4.4

Write Function Code
The Write function code determines which type of register(s) are to be accessed for
data retrieval or storage. For more information, see section 86.11 “Function Code
Definition and Selection” on page 3580.

92.4.5

Bitmask
You can choose which bits of a 16-bit (unsigned) word you want to enable for
read/write access using the Bitmask function. You can either enable any single bit,
therefore disabling the other fifteen bits of the word, or you can enable all bits of a
word within and including two checked bits (any other bits checked in between
these two bits are ignored). For example, you might want data to be read from the
high or low order bytes of a word contained in a single 16-bit register or you might
want data to be written to only one bit of a word.
In the following figure, the Modbus point called AI-HiByte is reading Bits 8 to 15 of
register 1024 of the device, with Bits 0 to 7 disabled. Similarly, the Modbus point
called AI-LoByte is reading Bits 0 to 7 of the same register (101), with Bits 8 to 15
disabled. The actual values of the high and low order bytes are 129 (10000001
binary) and 16 (00010000 binary) respectively and the value of the full 16-bit word in
register 1024 is 33040 (1000000100010000).
When writing to a device register, Building Operation reads the whole 16-bit register
before applying the mask and then changes only the masked bits (if necessary) to
provide the required value of the output object. This ensures that any unmasked
bits are not overwritten.
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Figure: Bitmask operation - using two analog inputs to read high and low order bytes of a
Modbus register

In the next figure, 16 digital input points are used to monitor the individual bits in
register 1024 of the device. In this case, only Bit 1 is true because a 1 is present
only at Bit 1 of the input.
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Figure: Bitmask operation - using 16 digital inputs to read single bits of a 16-bit register
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92.4.6

Gain and Offset
The Gain is the multiplication factor you can apply to the value to be read from or
written to a register. For example, a multiplication factor of 0.5 causes the return of
a value that is half of the value stored in an addressed register. Similarly, a
multiplication factor of 2 causes the return of a value that is twice the value stored in
the register. For example, the datasheet for a meter states that a certain register
contains a voltage value in mV. The value returned is 243087, but you may prefer to
see this value as 243.087 V, so you apply a Gain of 0.001.
The Offset is a number you can apply to change the returned value by the Offset
amount. For example, a temperature sensor always gives an inaccurate reading
one degree higher than the actual temperature; in this case you would apply an
offset of -1 to calibrate the sensor.
For analog inputs and multistate inputs, Building Operation calculates the value of
the Gain entered and then applies the Offset. For analog outputs and multistate
outputs, the Offset is applied (in this case subtracted), before the Gain is applied.
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92.5

Configuring a Modbus Point
You configure a Modbus point (on a Modbus serial device or TCP device) to read
from or write to a specific register (or registers) in a device.

Important
Modbus devices can differ considerably in the ways they can be configured.
Consult the device datasheet before configuring a point in the device.
For more information, see section 92.2 “Modbus Points and Values” on page 3664.

To configure a Modbus point
1. In WorkStation, in the System Tree pane, select the Modbus point.
2. On the File menu, click Properties.
3. Click the Basic tab.
Continued on next page
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4. For Value, click the Configure button

.

Continued on next page
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5. On the Configuration tab, select Unit and then enter the unit (with prefix).

6. Click OK.
7. In the Register number box, enter the register number.
8. In the Register type box, select the register type.
9. In the Read function code box, select the read function code.
10. In the Bit mask area, create a bitmask by selecting the appropriate check
boxes.
11. In the Gain box, enter the gain (multiplication factor).
Continued on next page
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12. In the Offset box, enter the offset.

13. Click OK.
14. Check that the Value property shows a value of the order expected.
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92.6

Creating a Modbus Value
You create Modbus Values to represent Building Operation objects.

Note
• In this context, a Modbus Value means a Modbus point (created in an internal
interface) rather than the actual value of a Modbus point.
For more information, see section 92.2 “Modbus Points and Values” on page 3664.

To create a Modbus Value
1. In WorkStation, in the System Tree pane, select the internal Modbus
Interface where you want to create the Modbus Value.
2. On the File menu, point to New and then select Modbus Local Registers.
3. In the object list, select the type of Modbus Value.
4. In the Name box, type a name for the Modbus Value.

5. In the Description box, type a description for the Modbus Value.
6. Click Create.
You now configure the Modbus Value.
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92.7

Configuring a Modbus Value
You configure a Modbus Value to bring it online and to modify its properties to suit
the required application.
For more information, see section 92.2 “Modbus Points and Values” on page 3664.

To configure a Modbus Value
1. In WorkStation, in the System Tree pane, select the Modbus Value.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Value

Displays the current value of the point.

Register number

Enter the register address of the first
register in the device from which a value
is to be read (or into which a value is to be
stored).

Register type

Select a register type. Your selection
determines the mathematical format of
the value contained in the register
selected by its register number.
Depending on your selection, this value
can occupy more than one consecutive
register.

Gain

Enter the multiplication factor you want to
apply to the value of the point as
displayed in the Value box.

Offset

Enter the offset you want to apply to the
value of the point as displayed in the
Value box.

5. Click OK.
6. Ensure that the Value box displays a value of the order expected.
You can now bind the Modbus Value, for example, to a graphic.
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92.8

Creating Multiple Modbus Points
Using the Spreadsheet view, you can quickly create multiple Modbus points,
which you otherwise would create one at a time in the wizard.

Important
Modbus devices can differ considerably in the ways they can be configured.
Consult the device datasheet before configuring a point in the device.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To create multiple Modbus points
1. In WorkStation, in the System Tree pane, select the Modbus device where
you want to create the Modbus points.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, click New and then click Modbus.
4. In the Type column, select the type of Modbus point.

5. Enter the properties of the Modbus point.

Tip
You can use the shortcut key Ctrl + U to change the engineering unit
of a value in the Spreadsheet view.
Continued on next page
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6. Create additional Modbus points using Steps 4-5.

Tip
You can also copy and paste cells, rows, and entire blocks.
7. On the File menu, click Save.
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93.1

Modbus Batch Read Function
In a normal Modbus network, a Modbus polling device obtains data from a polled
device by sending a query message to the device and then waiting for the response
message that contains the requested value from the selected register. If data from
another register is required, the polling device sends out a new query message and
awaits the response message. This process is repeated as required until all
subscribed points values have been read. However, the Modbus batch read
function affects the way a Modbus polling device reads the points values stored
within the registers of a Modbus polled device. Instead of reading each register
individually, the batch read function reads registers in manually created groups.
When all registers in a group have been read, the response message returns
subscribed register values for the whole group.
For supported devices, a scattered read function enables non-contiguous reading
of certain Modbus registers in a single transaction.

Note
• For the purposes of this description, a polling device is a master device on a
Modbus master/slave network, or a client device on a Modbus client/server
network. Similarly, a polled device is a slave device on a Modbus
master/slave network, or a server device on a Modbus client/server network.
It is recommended that you use the batch read function to group as many
subscriptions of the same type as possible in all of your Modbus devices. Register
grouping provides a dramatic saving in the time taken to poll your devices. The
following example illustrates this.

Figure: Modbus device containing two different register types
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The Modbus device contains five analog outputs and 24 digital outputs. In a normal
Modbus network where the batch read function has not been implemented, each
register is polled individually, meaning that 29 registers must be polled.
If the batch read function is implemented, the polling device sends a single query
message to all of the (subscribed) registers in each group, starting at the first
register. When all registers have been polled, the response message (containing the
values of all subscribed registers) is sent back to the polling device. In this way
polling is more efficient because all of the subscribed point values could be returned
in as few as just one message (for each group) rather than in multiple messages.
The number of messages required depends on the number of registers in the
group. For more information, see section 93.2 “Modbus Register Groups” on page
3686.
In the above example therefore, all the registers can be read in just two messages,
in approximately one fifteenth of the time it would have taken to read 29 messages.

93.1.1

Modbus Register Groups
A Modbus register group is a container where Modbus registers can be polled as a
group by a Modbus polling device. Modbus register groups can only be created
under a Modbus device, regardless of the type of network (or interface) in which the
Modbus device is contained.
For more information, see section 93.2 “Modbus Register Groups” on page 3686.

93.1.2

Grouping Guidelines
The Modbus register grouping function has a direct effect on system performance.
A poorly grouped device can easily increase the overall poll time as points, or
blocks, in each Modbus network are polled sequentially. Although the Modbus
batch read function is designed to reduce the network bandwidth by polling the
group of registers using fewer transactions, you can also enhance system
performance by understanding how grouping operates, analyzing your Modbus
network, and taking appropriate action.
For more information, see section 93.3 “ Grouping Guidelines ” on page 3691.

93.1.3

Grouping Methods
You can affect system performance by setting up one of two methods of Modbus
register grouping. You can either define the start and end Modbus points for each
group (semi-automatic grouping) or you can define all of the points in the group
(manual grouping).
For more information, see section 93.4 “Grouping Methods” on page 3694.
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93.1.4

Scattered Read
Scattered read is an enhancement to the batch read function that enables multiple,
non-contiguous slave device registers to be read in a single Modbus query. By
using the scattered read function, you can enable the Enterprise Server or
Automation Server to avoid reading a large block of contiguous registers when it is
only necessary to read a few registers. Also, using scattered read avoids the
multiple use of group function codes 03 (analog output holding registers) and 04
(analog input registers) in order to read non-contiguous registers. Group function
codes 01 (discrete output logic coils) and 02 (discrete input contacts) are not
supported for scattered read.
Scattered read is available only for supported devices, for example, Schneider
Electric branch circuit power meters with split core CTs. Furthermore, the scattered
read function applies only when the Enterprise Server or Automation Server is
operating as the master, not as as a slave. You can enable the scattered read
function in the properties of all Modbus devices. However, if a device does not
support scattered read, the device is polled by the master device in the same way
as if you had not enabled scattered read.
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93.2

Modbus Register Groups
A Modbus register group is a container where Modbus registers can be polled as a
group by a Modbus polling device. Modbus register groups can only be created
under a Modbus device, regardless of the type of network (or interface) in which the
Modbus device is contained.
In a Modbus register group, you create (or add) the Modbus points that you want to
be subscribed. You may have already created these Modbus points, in which case
you can simply drag the Modbus points into the Modbus register group container.
Ensure that the Modbus register group contains only points of the same type. You
can also create folders in a Modbus register group, in which to organize your
Modbus points.

Note
• Any points that have the same function code as the group and are within the
register address limits of the group (but are not yet manually added to the
group container), may be automatically included in the batch read function.
For more information, see section 93.3 “ Grouping Guidelines ” on page
3691.
When you create a Modbus register group, you also have the option to either
accept or override the default poll interval for the group read operation. You can do
this if you want to prioritize groups (for example, alarms and graphics) in order of
polling time.
The type of read performed by the polling device depends on the function code that
you assign to each Modbus register group. The function codes that can be used for
grouping registers for batch reads are 01, 02, 03, and 04 only. For more
information, see section 86.11 “Function Code Definition and Selection” on page
3580.

Note
• It is not possible to set up batch writes to Modbus devices.
You can create multiple Modbus register groups within a device. In the following
example in the System Tree pane, the Modbus device is part of a Modbus Master
Network, and two Modbus register groups have been created:

Figure: Modbus register group representation in WorkStation.
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Polling of registers within Modbus register groups is executed in poll blocks. There
is a limit of 125 polls per block for function codes 03 and 04, and 2000 polls per
block for function codes 01 and 02. For example, if you set up a group containing
251 subscribed analog output points (function code 03), polling will be in three
blocks (two blocks each with 125 polls, and one block with one poll). Poll blocks are
created as required by the batch read function.

Example of Modbus Register Grouping
The following illustration represents a Modbus device. Two sets of identical registers
contain 5 alarm points, and 24 status points respectively.

Figure: Modbus device containing two different register types

In the System Tree pane, two separate Modbus register groups represent the
device register sets (in this example, the points are contained in folders for
convenience). The Alarms register group contains five alarm analog output points,
and the Status register group contains 24 digital output points.
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Figure: Modbus register group representation in WorkStation.

The properties for Register Group 1 show that the batch read function is polling
registers 1, 2, 3, 4, and 5 sequentially. The group read function code of 03 (read
analog output registers) has enabled the batch read function to poll five registers of
that type (therefore five poll points are shown). The number of poll blocks shown is
just one, because there is just one set of analog registers (and the number of analog
registers being polled is less than 125).
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Figure: Example of Modbus analog register group properties

The properties for Register Group 2 show that the batch read function is polling
registers 1 to 24 sequentially. The group read function code of 01 (read digital
output registers) has enabled the batch read function to find 24 registers of that
type (therefore 24 poll points are shown). The number of poll blocks shown is just
one, because there is just one set of digital registers (and the number of digital
registers being polled is less than 2000).
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Figure: Example of Modbus digital register group properties
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93.3

Grouping Guidelines
The Modbus register grouping function has a direct effect on system performance.
A poorly grouped device can easily increase the overall poll time as points, or
blocks, in each Modbus network are polled sequentially. Although the Modbus
batch read function is designed to reduce the network bandwidth by polling the
group of registers using fewer transactions, you can also enhance system
performance by understanding how grouping operates, analyzing your Modbus
network, and taking appropriate action.
In order to be able to analyze your Modbus devices and decide how to apply any
grouping, it is useful to understand the following concepts (covered in this topic):
• The conditions under which poll blocks are formed.
• The conditions that cause exceptions to occur.
• Exceptions cause fragmentation of poll blocks.
• The Poll Interval property affects the whole group.
To gather information about your devices, consult the Modbus maps in the relevant
device datasheets, which state how Modbus points can be stored in the registers.
You can then look at the contents of your devices and decide any grouping actions
to take. Consider the following points when grouping:
• Try to ensure that as many Modbus points as possible are contained in as few
groups as possible, therefore reducing the overall time it takes the Enterprise
Server or Automation Server to read all the subscribed points in each Modbus
device.
• You can enhance network performance by choosing the method of grouping
that is most suitable for each device in your Modbus network. For more
information, see section 93.4 “Grouping Methods” on page 3694.
• You might enhance network performance by selecting a poll time for each
group that is different from the default poll time. You might also gain benefits by
grouping together points that have the same or similar poll times. For example,
you might group fast polling alarms in one group and slow polling trend logs in
another group.
• Deleting a Modbus Register Group or a group folder can cause system delays.
Modbus points are deleted one at a time before the group or folder is finally
deleted. Each time a point is deleted the groups are re-organized, which
causes delays in the Enterprise Server or Automation Server. If you have to
delete a Modbus Register Group or a folder, it is recommended that you first
delete any Modbus registers that do not affect the group range before deleting
the group.
• You can use the Modbus Register Group properties dialog box to monitor the
effect of your grouping on the number of poll blocks. You can also monitor the
Events pane to see when exceptions cause factorization to occur.
• Whether you group Modbus objects using semi-automatic or manual grouping,
poll block operation is the same for both grouping methods. The process
attempts to group all contiguous Modbus points of the same type into one
group unless an exception occurs.
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93.3.1

Poll Block Operation
The batch read function polls all the registers within the group range, starting at the
first declared register, and forms blocks called poll blocks. The number of poll
blocks is determined by the type of data within the device and the location of the
data within the device. The fewer the number of poll blocks, the faster the system
performance.
The formation of poll blocks is subject to the following basic conditions:
• All registers (at least two) for inclusion in any single block must have addresses
that lie within the specified range of the group.
• All registers for inclusion in any single block must have the same function code
as allocated to the group, and those registers must be contiguous.
• The size of any poll block is limited by the maximum address range supported
by a single read operation, that is, 250 8-bit bytes. Therefore for 16-bit analog
objects, the size of the block is limited to 125. Similarly, for digital objects (16
per register), the size of the block is limited to 2000. When the address range is
reached (analog or digital), another poll block is started.
• An exception code generated during the batch read function forces the
termination of the current poll block and the creation of another poll block
(Factorization).

93.3.2

Exception Handling
At the start of a batch read, the Enterprise Server or Automation Server reads each
register in a Modbus Register Group in turn to test for Modbus points that are
eligible for entry into the current poll block. If the register is ineligible, an exception is
generated and the current poll block is closed to further Modbus points. At this
point, a process called factorization begins, where the poll block is fragmented into
smaller blocks.
An exception can occur in the following conditions:
• The group range contains a Modbus register with an incompatible code
(exception code 01).
• The group range contains a Modbus register address that is not defined in the
device (exception code 02).
• The group range contains a Modbus device register that cannot be read via the
gateway (exception code 10 or 11).
When a point causes an exception, that point is declared offline and cannot be part
of the poll group for which it was originally intended.
Exception messages display in the Events pane.

93.3.3

Factorization
Factorization is the process that divides a poll block into sub-blocks when an
exception code is encountered. Factorization is based on any discontinuity in the
polled register address or the read function code during a Modbus batch read.
Factorization depends on the following conditions:
• The poll block has more than one declared Modbus point.
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• The exception code is 01, 02, 10 or 11. Any other exceptions place the group
poll points listed in the block to invalid (offline) mode.
When an exception code occurs, the poll block is fragmented into sub-blocks in the
following order:
1. If the block address range is sequential and the points have the same function
code, one block is created for each Modbus point.
2. If the block address range is sequential and the Modbus points have different
function codes, a new block is created for points in a contiguous address
space with the same function code,
OR
3. If the block address range is non-sequential, new blocks are created for points
in a contiguous address space with the same function code.
Sub-blocks may be further fragmented if exceptions continue to occur, until the
sub-block contains no more than one point. Any Modbus points excluded from
group polling are polled individually. After polling one cycle, the sub-blocks are
regrouped (if possible) into fewer blocks, in a process called re-factorization. During
regrouping, the offline or invalid Modbus points are excluded from the refactorization.

93.3.4

Poll Interval
The poll interval for any single Modbus point is the time interval at which that point is
read, for example 500 ms. Similarly, the group poll interval is the time interval at
which the range of registers in a Modbus Register Group is read. However, different
subscribed points in a group may have different poll intervals. Graphics points or
points in the Watch pane may subscribe at 500 ms, but trend logs may subscribe
at a longer interval (say, 1 minute), depending on the user specified log interval. The
group poll interval is always the shortest poll interval of all the points in the group.
For more information, see section 93.7 “Modbus Register Group Properties – Basic
Tab” on page 3699.
You can change the poll interval by changing the Requested group poll interval
property (zero by default). You might want to do this if for example, you think that
the group poll interval is unnecessarily short, causing data to be read much more
often than needed.
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93.4

Grouping Methods
You can affect system performance by setting up one of two methods of Modbus
register grouping. You can either define the start and end Modbus points for each
group (semi-automatic grouping) or you can define all of the points in the group
(manual grouping).
For more information, see section 93.8 “Adding Modbus Points to a Modbus
Register Group” on page 3701.
Whether you group Modbus objects using semi-automatic or manual grouping, poll
block operation is the same for both methods. The process attempts to group all
contiguous Modbus points of the same type into one group unless an exception
occurs.
The following flowchart illustrates the grouping decisions and actions you can take
once you have determined the type of grouping you want to set up in each Modbus
device.

Technical
3696

04-16006-04-en, March 2015

93 Modbus Batch Read Function
93.4 Grouping Methods

Figure: Modbus semi-automatic and manual grouping

93.4.1

Manual Grouping
Manual grouping enables you to create fixed groups of registers and to control the
way Modbus points are polled. By carefully analyzing the contents of your Modbus
devices, you might decide that you can create fewer poll groups than if using semiautomatic grouping. Manual grouping is suitable for devices with large numbers of
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points with the same function code, in contiguous address space. You might
consider manual grouping before setting up your Modbus points when planning a
new installation. For more information, see section 93.8 “Adding Modbus Points to
a Modbus Register Group” on page 3701.

93.4.2

Semi-Automatic Grouping
For devices that contain mixed point types with non-contiguous address
distribution, you might consider semi-automatic grouping. Alternatively, you might
want to try to improve the overall device read time of an existing network without
having to move all of the points in the address range into the group. By specifying
the start and end of a register group range, you enable automatic creation of
groups. The number of groups, and the size and content of the groups, is
determined by the types of points contained within the registers and whether or not
the registers are contiguous. For more information, see section 93.8 “Adding
Modbus Points to a Modbus Register Group” on page 3701.
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93.5

Creating a Modbus Register Group
You create a Modbus register group to provide a container for subscribed points.
For more information, see section 93.2 “Modbus Register Groups” on page 3686.

To create a Modbus register group
1. In WorkStation, in the System Tree pane, select the Modbus device where
you want to create the Modbus register group.
2. On the File menu, point to New and then click Modbus Register Group.

3. In the Name box, type a name for the Modbus register group.
4. In the Description box, type a description for the Modbus register group.
5. Click Create.
Now you can configure the Modbus register group.
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93.6

Configuring a Modbus Register Group
You configure the properties of a Modbus register group to set the read function
code for the group, and if required, to force a group poll interval.
For more information, see section 93.5 “Creating a Modbus Register Group” on
page 3697.

To configure a Modbus register group
1. In WorkStation, in the System Tree pane, select the Modbus register group
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Group read function code

Select the read function code applicable
to the group of registers you want the
master device or client to read.

Requested group poll interval (ms)

Enter a value if you want to override the
value of the group poll interval (below).
For more information, see section 93.3 “
Grouping Guidelines ” on page 3691.

Group poll interval (ms)

Displays the requested poll interval of the
point in the group with the fastest poll
time. For more information, see section
93.3 “ Grouping Guidelines ” on page
3691.

First register in group

Displays the Modbus register number that
defines the start of the group range.

Last register in group

Displays the Modbus register number that
defines the end of the group range.

First register being polled

Displays the current start register for an
active group poll.

Last register being polled

Displays the current end register for an
active group poll.

Number of points being polled

Displays the number of poll points in the
active group poll.

Number of blocks being polled

Displays the number of polls required to
read all the registers in the group.

5. Click OK.
Now you can add points to the Modbus register group.
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93.7

Modbus Register Group Properties –
Basic Tab
Use the Basic tab to create a group of registers in a Modbus device.

Figure: Basic tab

Table: Basic tab
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Property

Description

Group read function code

Select the read function code applicable to
the group of registers you want the master
device or client to read.

Requested group poll interval (ms)

Enter a value if you want to override the
value of the group poll interval (below). For
more information, see section 93.3 “
Grouping Guidelines ” on page 3691.

Group poll interval (ms)

Displays the requested poll interval of the
point in the group with the fastest poll time.
For more information, see section 93.3 “
Grouping Guidelines ” on page 3691.

First register in group

Displays the Modbus register number that
defines the start of the group range.
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Property

Description

Last register in group

Displays the Modbus register number that
defines the end of the group range.

First register being polled

Displays the current start register for an
active group poll.

Last register being polled

Displays the current end register for an
active group poll.

Number of points being polled

Displays the number of poll points in the
active group poll.

Number of blocks being polled

Displays the number of polls required to read
all the registers in the group.
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93.8

Adding Modbus Points to a Modbus
Register Group
You add Modbus points to a Modbus register group to include them in a Modbus
batch read. You can configure the group for semi-automatic grouping or manual
grouping.
For more information, see section 93.3 “ Grouping Guidelines ” on page 3691.

To add Modbus points to a Modbus register group
1. In WorkStation, in the System Tree pane, expand the Modbus device that
contains the Modbus register group where you want to add Modbus points.
2. You can add the Modbus points to the group two ways:
• Drag the Modbus points to the Modbus register group.
• Create new Modbus points in the Modbus register group. For more
information, see section 92.3 “Creating a Modbus Point” on page 3666.

Note
You can also drag Modbus points into any folders that you have
created in a Modbus register group.
3. For semi-automatic grouping, configure the addresses of the first and last
Modbus points in the group range. For more information, see section 93.6
“Configuring a Modbus Register Group” on page 3698.
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94.1

Modbus Icons
This section describes the icons in WorkStation that relate to Modbus networks.
Table: Modbus Icons in WorkStation
Icon

Description
Serial Port
Indicates a serial port (RS-232 or RS-485).
For more information, see section 87.1
“Modbus Serial Networks” on page 3589.
Modbus Network
Indicates a Modbus Master Network or a
Modbus Slave Network. For more
information, see section 87.1 “Modbus Serial
Networks” on page 3589.
Can also indicate a Modbus TCP Network or
Modbus TCP Server/Modbus TCP Gateway.
For more information, see section 88.1
“Modbus TCP Networks” on page 3613.
Modbus Network Offline
Indicates a Modbus network offline.
Modbus Interface
Indicates a Modbus Interface. For more
information, see section 90.2 “Modbus
Interface” on page 3640.
Modbus Interface Offline
Indicates a Modbus Interface offline.
Modbus Device
Indicates a Modbus device (Modbus Device
or Modbus TCP Device). For more
information, see section 91.1 “Modbus
Devices” on page 3647.
Modbus Device Offline
Indicates a Modbus device offline.
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94.2

Serial Port Properties – Basic Tab
Use the Basic tab to view and edit basic information about the port.

Note
There are two types of serial port: RS-232 and RS-485. Each has the same set of
properties. However, you cannot configure the Network interface name on an RS485 port. This property is fixed as one of two possible names, one for each of only
two ports.

Figure: Basic tab

Table: Basic Tab
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Component

Description

State

Displays the network status: Online or
Offline, or Unused (Unused means that
the port is not referenced from a network).

Bytes transmitted

Displays the running total of bytes
transmitted through the port.

Bytes received

Displays the running total of bytes received
through the port.
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Continued
Component

Description

Parity errors detected

Displays the running total of parity errors
detected.

Framing errors detected

Displays the running total of framing errors
detected.

Other errors detected

Displays the running total of other errors
detected (errors other than parity or framing
errors).

Network interface name

Type the name of the network interface
(read-only for an RS-485 port), which is
usually the name of the COM port that you
connect the network to. Do not use spaces.

Log file name

Type the name of the port log file or leave
this as the default, PortLog.
For the Enterprise Server, the log file is
available in C:\ProgramData\Schneider
Electric StruxureWare\Building Operation
x.x\Enterprise Server\db\portlogs\RS232COM1.
For the Automation Server, the log file is
available in opt\tac\db\portlogs\RS485COMA.
The portlogs folder is only available if a log
has previously been started by way of the
Start log command in the port context
menu.
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94.3

Modbus Master Network Properties –
Basic Tab
Use the Basic tab to view and edit basic information about the Modbus Master
Network.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Network status

Displays the network status: Online or
Offline.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
network. Select OK to clear the output error
flag after a successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the network.
Select OK to clear the input error flag after a
successful read from all devices.
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Component

Description

Framing mode

Select RTU to use Remote Terminal Unit as
the framing mode. The framing mode must
be the same for all devices on a Modbus
serial line.

Baud rate

Select the baud rate.

Parity

Select the parity.

Stop bits

Select the number of stop bits (1, 2, or Auto).
Auto enables Building Operation to
determine the number of bits based on all
the other communications parameters.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

Port reference

Enter the path of the serial port to which the
Modbus network is connected (browse to
the System – Ports folder).
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94.4

Modbus Master Network Properties –
Advanced Tab
Use the Advanced tab to view and edit advanced information about the Modbus
Master Network.

Figure: Advanced tab

Table: Advanced Tab
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Component

Description

Silence characters

Select the number of silence characters you
want between each message (normally 3.5).
This is the waiting time added after the final
message character, and determines the end
of the message. For more information, see
section 164.2 “Serial Transmission Modes”
on page 5661.

Transmit guard bits

Select the number of guard bits you want to
be inserted immediately after each message
data byte is transmitted (normally 2). For
more information, see section 89.1 “Network
Configuration” on page 3633.
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Component

Description

Receive timeout (ms)

Enter the number of milliseconds you want
the Modbus master/client to wait for a
response to a message query (normally
2000 ms). For more information, see section
89.1 “Network Configuration” on page 3633.

Point poll delay (ms)

Enter the delay that you require between the
end of one poll request and the start of the
next poll request (for use only if there are
problems with communications). For more
information, see section 89.1 “Network
Configuration” on page 3633.

Poll duty cycle (%)

Select the ratio of actual polling time to total
poll cycle time. For more information, see
section 89.1 “Network Configuration” on
page 3633.
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94.5

Modbus Device Properties – Basic Tab
Use the Basic tab to view and edit basic information about the Modbus Device.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Status

Displays the Modbus Device status: Online,
Offline, or Invalid.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
network. Select OK to clear the output error
flag after a successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the network.
Select OK to clear the input error flag after a
successful read from all devices.

Vendor name

Displays the name of the device vendor (for
supported devices). For more information,
see section 91.1 “Modbus Devices” on page
3647.
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Component

Description

Product code

Displays the product code of the device (for
supported devices). For more information,
see section 91.1 “Modbus Devices” on page
3647.

Revision number

Displays the revision number of the device
(for supported devices). For more
information, see section 91.1 “Modbus
Devices” on page 3647.

Device address

Enter the address of the Modbus Device.

Poll register

Enter the number of any register in the
external device/server. Register numbers are
shown on the Modbus map on the device
datasheet.

Poll code

Select the function code for the selected poll
register.

Poll interval

Select how often you want polling to occur
for the selected device/server during
communication attempts.

Non-contiguous read

Select Enabled if you want the master (or
client) device to read non-contiguous
registers (scattered read function), for
supported slave devices. For more
information, see section 93.1 “Modbus
Batch Read Function” on page 3683.
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94.6

Modbus Slave Network Properties –
Basic Tab
Use the Basic tab to view and edit basic information about the Modbus Slave
Network.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Network status

Displays the network status: Online or
Offline.

Framing mode

Select RTU to use Remote Terminal Unit as
the framing mode. The framing mode must
be the same for all devices on a Modbus
serial line.

Baud rate

Select the baud rate.

Parity

Select the parity.
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Component

Description

Stop bits

Select the number of stop bits (1, 2, or Auto).
Auto enables Building Operation to
determine the number of bits based on all
the other communications parameters.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

Port reference

Enter the path of the serial port to which the
Modbus network is connected (browse to
the System – Ports folder).
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94.7

Modbus Slave Network Properties –
Advanced Tab
Use the Advanced tab to view and edit advanced information about the Modbus
Slave Network.

Figure: Advanced tab

Table: Advanced Tab
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Component

Description

Silence characters

Select the number of silence characters you
want between each message (normally 3.5).
This is the waiting time added after the final
message character, and determines the end
of the message. For more information, see
section 164.2 “Serial Transmission Modes”
on page 5661.

Transmit guard bits

Select the number of guard bits you want to
be inserted immediately after each message
data byte is transmitted (normally 2). For
more information, see section 89.1 “Network
Configuration” on page 3633.
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94.8

Modbus TCP Network Properties – Basic
Tab
Use the Basic tab to view and edit basic information about the Modbus TCP
Network.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Network status

Displays the network status: Online or
Offline.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
network. Select OK to clear the output error
flag after a successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the network.
Select OK to clear the input error flag after a
successful read from all devices.
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Component

Description

J-Bus mode

Select Yes only if you want J-Bus mode
operation.
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94.9

Modbus TCP Network Properties –
Advanced Tab
Use the Advanced tab to view and edit advanced information about the Modbus
TCP Network.

Figure: Advanced tab

Table: Advanced Tab
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Component

Description

Receive timeout (ms)

Enter the number of milliseconds you want
the Modbus master/client to wait for a
response to a message query (normally
2000 ms). For more information, see section
89.1 “Network Configuration” on page 3633.

Point poll delay (ms)

Enter the delay that you require between the
end of one poll request and the start of the
next poll request (for use only if there are
problems with communications). For more
information, see section 89.1 “Network
Configuration” on page 3633.
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Component

Description

Poll duty cycle (%)

Select the ratio of actual polling time to total
poll cycle time. For more information, see
section 89.1 “Network Configuration” on
page 3633.
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94.10

Modbus TCP Gateway Properties –
Basic Tab
Use the Basic tab to view and edit basic information about the external gateway
device.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Network status

Displays the network status: Online or
Offline.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
network. Select OK to clear the output error
flag after a successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the network.
Select OK to clear the input error flag after a
successful read from all devices.
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Component

Description

J-Bus mode

Select Yes only if you want J-Bus mode
operation.

IP port

Type the number of the IP port.

IP address

Type the IP address.
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94.11

Modbus TCP Gateway Properties –
Advanced Tab
Use the Advanced tab to view and edit advanced information about the external
gateway device.

Figure: Advanced tab

Table: Advanced Tab
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Component

Description

Receive timeout (ms)

Enter the number of milliseconds you want
the Modbus master/client to wait for a
response to a message query (normally
2000 ms). For more information, see section
89.1 “Network Configuration” on page 3633.

Point poll delay (ms)

Enter the delay that you require between the
end of one poll request and the start of the
next poll request (for use only if there are
problems with communications). For more
information, see section 89.1 “Network
Configuration” on page 3633.
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Component

Description

Poll duty cycle (%)

Select the ratio of actual polling time to total
poll cycle time. For more information, see
section 89.1 “Network Configuration” on
page 3633.
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94.12

Modbus TCP Device Properties – Basic
Tab
Use the Basic tab to view and edit basic information about the Modbus TCP
Device.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Status

Displays the Modbus Device status: Online,
Offline, or Invalid.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
network. Select OK to clear the output error
flag after a successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the network.
Select OK to clear the input error flag after a
successful read from all devices.

Technical
3727

94 Modbus Device User Interface
94.12 Modbus TCP Device Properties – Basic Tab

Continued

Technical
3728

Component

Description

Vendor name

Displays the name of the device vendor (for
supported devices). For more information,
see section 91.1 “Modbus Devices” on page
3647.

Product code

Displays the product code of the device (for
supported devices). For more information,
see section 91.1 “Modbus Devices” on page
3647.

Revision number

Displays the revision number of the device
(for supported devices). For more
information, see section 91.1 “Modbus
Devices” on page 3647.

Device address

Enter the address of the Modbus TCP
Device. This address must also be
configured in the actual external device.

IP port

Type the number of the IP port.

IP address

Type the IP address of the Modbus TCP
Device.

Poll register

Enter the number of any register in the
external device/server. Register numbers are
shown on the Modbus map on the device
datasheet.

Poll code

Select the function code for the selected poll
register.

Poll interval

Select how often you want polling to occur
for the selected device/server during
communication attempts.

Non-contiguous read

Select Enabled if you want the master (or
client) device to read non-contiguous
registers (scattered read function), for
supported slave devices. For more
information, see section 93.1 “Modbus
Batch Read Function” on page 3683.
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94.13

Modbus TCP Server Properties – Basic
Tab
Use the Basic tab to view and edit basic information about the Modbus TCP
Server.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Network status

Displays the network status: Online or
Offline.

IP port

Type the number of the IP port.

J-Bus mode

Select Yes only if you want J-Bus mode
operation.
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94.14

Modbus Interface Properties – Basic
Tab
Use the Basic tab to view and edit basic information about the Modbus Interface.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Status

Displays the Modbus Device status: Online,
Offline, or Invalid.

Device address

Enter the address of the Modbus Interface.
This address must match the address of the
external master device.

Timeout

Select the amount of time that a Modbus
Interface has to receive a valid Modbus
message from the master device/client
before the Network status is displayed as
Offline. A setting of Inhibit stops the
monitoring of incoming requests.
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Component

Description

Mode

Select Control (the default) for external
programmatic control, or select HMI to
enable control by a Human Machine
Interface device acting as a Modbus master
(or client). For more information, see section
90.2 “Modbus Interface” on page 3640.
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94.15

Modbus Analog Value Properties – Basic
Tab
Use the Basic tab to view and edit basic properties of the Modbus Analog Value.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Gain

Enter the multiplication factor you want to
apply to the value of the point as displayed in
the Value box.
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Component

Description

Offset

Enter the offset you want to apply to the
value of the point as displayed in the Value
box.
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94.16

Modbus Digital Value Properties – Basic
Tab
Use the Basic tab to view and edit basic properties of the Modbus Digital Value.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.
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94.17

Modbus Multistate Value Properties –
Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Multistate
Value.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.
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Component

Description

Gain

Enter the multiplication factor you want to
apply to the value of the point as displayed in
the Value box.

Offset

Enter the offset you want to apply to the
value of the point as displayed in the Value
box.

04-16006-04-en, March 2015

94 Modbus Device User Interface
94.18 Modbus Analog Input Point Properties – Basic Tab

94.18

Modbus Analog Input Point Properties –
Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Analog Input
Point.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.
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Component

Description

Read error count

Displays the number of times the master
device/client has failed to read the register.

Write error count

Displays the number of times the master
device/client has failed to write to the
register.

Requested poll interval (ms)

Displays the register poll interval requested
by the current subscription, for example, a
point in the Watch pane.

Actual poll interval (ms)

Displays the register poll interval actually
achieved.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Read function code

Select the read function code applicable to
the registers you want the master
device/client to read.

Bit mask

Select one bit to disable all other bits. Select
more than one bit to disable all bits outside
of the word range between the two selected
bits. For example, selecting bits 1 and 5 only
is the same as selecting bits 1, 2, 3, 4 and 5.

Gain

Enter the multiplication factor you want to
apply to the value of the point as displayed in
the Value box.

Offset

Enter the offset you want to apply to the
value of the point as displayed in the Value
box.
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94.19

Modbus Analog Output Point
Properties – Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Analog Output
Point.

Figure: Basic tab
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Component

Description

Value

Displays the current value of the point.

Read error count

Displays the number of times the master
device/client has failed to read the register.

Write error count

Displays the number of times the master
device/client has failed to write to the
register.

Requested poll interval (ms)

Displays the register poll interval requested
by the current subscription, for example, a
point in the Watch pane.

Actual poll interval (ms)

Displays the register poll interval actually
achieved.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Bit mask

Select one bit to disable all other bits. Select
more than one bit to disable all bits outside
of the word range between the two selected
bits. For example, selecting bits 1 and 5 only
is the same as selecting bits 1, 2, 3, 4 and 5.

Read function code

Select the read function code applicable to
the registers you want the master
device/client to read.

Write function code

Select the write function code applicable to
the registers to which you want the master
device/client to write.

Gain

Enter the multiplication factor you want to
apply to the value of the point as displayed in
the Value box.

Offset

Enter the offset you want to apply to the
value of the point as displayed in the Value
box.
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94.20

Modbus Digital Input Point Properties –
Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Digital Input
Point.

Figure:

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.

Read error count

Displays the number of times the master
device/client has failed to read the register.
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Component

Description

Write error count

Displays the number of times the master
device/client has failed to write to the
register.

Requested poll interval (ms)

Displays the register poll interval requested
by the current subscription, for example, a
point in the Watch pane.

Actual poll interval (ms)

Displays the register poll interval actually
achieved.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Read function code

Select the read function code applicable to
the registers you want the master
device/client to read.

Bit mask

Select one bit to disable all other bits. Select
more than one bit to disable all bits outside
of the word range between the two selected
bits. For example, selecting bits 1 and 5 only
is the same as selecting bits 1, 2, 3, 4 and 5.
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94.21

Modbus Digital Output Point
Properties – Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Digital Output
Point.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.
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Component

Description

Read error count

Displays the number of times the master
device/client has failed to read the register.

Write error count

Displays the number of times the master
device/client has failed to write to the
register.

Requested poll interval (ms)

Displays the register poll interval requested
by the current subscription, for example, a
point in the Watch pane.

Actual poll interval (ms)

Displays the register poll interval actually
achieved.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Read function code

Select the read function code applicable to
the registers you want the master
device/client to read.

Write function code

Select the write function code applicable to
the registers to which you want the master
device/client to write.

Bit mask

Select one bit to disable all other bits. Select
more than one bit to disable all bits outside
of the word range between the two selected
bits. For example, selecting bits 1 and 5 only
is the same as selecting bits 1, 2, 3, 4 and 5.
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94.22

Modbus Multistate Input Point
Properties – Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Multistate Input
Point.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Value

Displays the current value of the point.
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Component

Description

Read error count

Displays the number of times the master
device/client has failed to read the register.

Write error count

Displays the number of times the master
device/client has failed to write to the
register.

Requested poll interval (ms)

Displays the register poll interval requested
by the current subscription, for example, a
point in the Watch pane.

Actual poll interval (ms)

Displays the register poll interval actually
achieved.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Read function code

Select the read function code applicable to
the registers you want the master
device/client to read.

Bit mask

Select one bit to disable all other bits. Select
more than one bit to disable all bits outside
of the word range between the two selected
bits. For example, selecting bits 1 and 5 only
is the same as selecting bits 1, 2, 3, 4 and 5.

Gain

Enter the multiplication factor you want to
apply to the value of the point as displayed in
the Value box.

Offset

Enter the offset you want to apply to the
value of the point as displayed in the Value
box.
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94.23

Modbus Multistate Output Point
Properties – Basic Tab
Use the Basic tab to view and edit basic properties of the Modbus Multistate
Output Point.

Figure: Basic tab
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Component

Description

Value

Displays the current value of the point.

Read error count

Displays the number of times the master
device/client has failed to read the register.

Write error count

Displays the number of times the master
device/client has failed to write to the
register.

Requested poll interval (ms)

Displays the register poll interval requested
by the current subscription, for example, a
point in the Watch pane.

Actual poll interval (ms)

Displays the register poll interval actually
achieved.

Register number

Enter the register address of the first register
in the device from which a value is to be read
(or into which a value is to be stored).

Register type

Select a register type. Your selection
determines the mathematical format of the
value contained in the register selected by its
register number. Depending on your
selection, this value can occupy more than
one consecutive register.

Read function code

Select the read function code applicable to
the registers you want the master
device/client to read.

Write function code

Select the write function code applicable to
the registers to which you want the master
device/client to write.

Bit mask

Select one bit to disable all other bits. Select
more than one bit to disable all bits outside
of the word range between the two selected
bits. For example, selecting bits 1 and 5 only
is the same as selecting bits 1, 2, 3, 4 and 5.

Gain

Enter the multiplication factor you want to
apply to the value of the point as displayed in
the Value box.

Offset

Enter the offset you want to apply to the
value of the point as displayed in the Value
box.
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95 NETWORK 8000 Introduction
95.1 NETWORK 8000 Overview

95.1

NETWORK 8000 Overview
The NETWORK 8000 system is a modular and integrated facility management
system.
NETWORK 8000 GCM/LCM Programmer's Manual, (F-23120).

95.1.1

NETWORK 8000 System Migration
An existing NETWORK 8000 system consisting of one or more GCMs and a Signal
head-end software package can be integrated into Building Operation servers using
the TAC I/A Series Migrator, which creates a set of import files and report files. The
NETWORK 8000 system can be integrated into Building Operation by replacing
each GCM with an Automation Server and the Signal with an Enterprise Server.
For more information, see section 95.2 “NETWORK 8000 System Migration” on
page 3750.

95.1.2

GCM Block Migration Synopsis
Most NETWORK 8000 blocks are migrated or converted directly into an
Automation Server. However, some blocks are not migrated at all.
For more information, see section 95.7 “GCM Block Migration Synopsis” on page
3764.

95.1.3

NETWORK 8000 ASD Devices
You use WorkStation to command and monitor the ASD data in the ASD devices.
Each ASD device has a fixed set of properties that can be commanded and
monitored from WorkStation.
For more information, see section 96.1 “NETWORK 8000 ASD Devices” on page
3791.

95.1.4

NETWORK 8000 LCMs
You use WorkStation to command and monitor the data in the LCMs. Each LCM
has a fixed set of properties that can be commanded from WorkStation and a fixed
set of properties that can be monitored.
For more information, see section 96.5 “NETWORK 8000 LCMs” on page 3799.
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95.2

NETWORK 8000 System Migration
An existing NETWORK 8000 system consisting of one or more GCMs and a Signal
head-end software package can be integrated into Building Operation servers using
the TAC I/A Series Migrator, which creates a set of import files and report files. The
NETWORK 8000 system can be integrated into Building Operation by replacing
each GCM with an Automation Server and the Signal with an Enterprise Server.
A GCM backup database is migrated to Building Operation using TAC I/A Series
Migrator to convert the database to an XML file. The migrated GCM database file, in
XML format, is then imported to an Automation Server. The migration supports only
GCM, versions 5.4A and 5.41A.
TAC I/A Series Migrator Guide, (F-27741)
A Signal database is also migrated to Building Operation using TAC I/A Series
Migrator to convert the database to an XML file. The migrated Signal database file,
in XML format, is then imported to an Enterprise Server.
You import one file, which is eqivalent to the GCM backup database, into a server. If
the existing system contains a Signal head-end, it is replaced by an Enterprise
Server. You use an import file to create the server database, which is complete with
the converted Signal graphics.
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Figure: NETWORK 8000 Integration

95.2.1

NETWORK 8000 Interface
When you import a migrated GCM database into a server, a single NETWORK
8000 Interface with folders and sub-folders is created. These folders contain the
migrated NETWORK 8000 objects. Only one NETWORK 8000 Interface can be
imported into a server.
For more information, see section 95.4 “NETWORK 8000 Interface” on page 3758.
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95.2.2

NETWORK 8000 Workflows
An existing NETWORK 8000 system consisting of one or more GCMs and a Signal
head-end software package can be integrated into Building Operation servers using
the TAC I/A Series Migrator, which creates a set of import files and report files. The
NETWORK 8000 system can be integrated into Building Operation by replacing
each GCM with an Automation Server and the Signal with an Enterprise Server.
For more information, see section 95.3 “NETWORK 8000 Workflows” on page
3754.

95.2.3

GCM Block Migration
The NETWORK 8000 System functionality is reproduced in Building Operation.
For more information, see section 95.5 “GCM Block Migration” on page 3760.

95.2.4

NETWORK 8000 Objects
New objects are created when GCM blocks are migrated to Building Operation. The
new objects provide the same or similar functions as the NETWORK 8000 blocks
that are being replaced by them.
For more information, see section 95.6 “NETWORK 8000 Objects” on page 3763.

95.2.5

LCMs
When you import Signal data into an Automation Server, one or more LCM device
objects are created. These LCM objects contain only the blocks for which there
were points in the Signal database. The blocks that reside in each LCM must be
learned.
For more information, see section 95.3 “NETWORK 8000 Workflows” on page
3754.

95.2.6

Migration of Engineering Units
In NETWORK 8000, both analog and digital standard engineering units (units of
measure in Building Operation) are available. NETWORK 8000 block standard
engineering units are migrated directly into the Automation Server as the
appropriate property's units of measure. However, user-defined analog and digital
engineering units are not migrated to the Automation Server.
For more information, see section 95.11 “Migration of Engineering Units” on page
3774.
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95.2.7

Schedules for NETWORK 8000
All existing GCM schedule blocks, with the exception of NEC and master
MICROZONE II schedules, are converted to Building Operation schedule objects.
For more information, see the Schedules Overview topic on WebHelp.
Object name and Building Operation identifier are converted. The object name
becomes a combination of the object name and the GCM block name with the
user-defined extension. For example, DAILY:MEW1 becomes
Schedule:DAILY:MEW1.
For more information, see section 95.16 “Schedules for NETWORK 8000” on page
3781.

95.2.8

Trends for NETWORK 8000
All NETWORK 8000 Trend blocks are converted to Building Operation Trend
objects. For more information, see the Trend Overview topic on WebHelp.
GCM Trend blocks can trend up to four input values. Building Operation Trend
objects have one input so each GCM Trend block is converted to up to four Trend
objects. Object name, identifier, and date of conversion are reported. The trend
itself with the pointers is migrated, but the trend data is not. The GCM Trend block's
user title is converted to the description of the object, which displays when you
hover your cursor over the object in the System Tree pane.
For more information, see section 95.17 “Trends for NETWORK 8000” on page
3783.

95.2.9

Alarms for NETWORK 8000
All GCM control and operation exception messages are converted to Building
Operation events and alarms if so configured.
For more information, see section 95.18 “ Alarms for NETWORK 8000” on page
3784.
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95.3

NETWORK 8000 Workflows
An existing NETWORK 8000 system consisting of one or more GCMs and a Signal
head-end software package can be integrated into Building Operation servers using
the TAC I/A Series Migrator, which creates a set of import files and report files. The
NETWORK 8000 system can be integrated into Building Operation by replacing
each GCM with an Automation Server and the Signal with an Enterprise Server.
The NETWORK 8000 workflow enables you to create the appropriate interface and
finalize the configurations.
TAC I/A Series Migrator Guide (F-27741)

95.3.1

GCM Migration
The following flowchart describes the basic steps of the GCM migration workflow.
Related information can be found in the sections following the flowchart.

Figure: GCM Migration Flowchart

Convert the GCM database
Use the TAC I/A Series Migrator to convert the GCM backup database into an XML
file.
For more information, see section 95.2 “NETWORK 8000 System Migration” on
page 3750.
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Import the GCM XML file
Import the GCM XML file into Building Operation, which creates a NETWORK 8000
Interface containing the database blocks and bindings (pointers) that were in the
GCM.
For more information, see section 18.1 “Import and Export Overview” on page 557.

Resolve database issues
Use the detailed migration reports to ensure that any issues with the database are
fixed, such as broken bindings or engineering units that could not be migrated.
Make any required changes in logic using standard procedures.
TAC I/A Series Migrator Guide (F-27741)

Configure ASD communications
Configure communications to the ASD devices so that you can command and
monitor existing data in one or more ASD devices on the Building Operation ASD
network.
For more information, see section 96.6 “Configuring ASD Communications” on
page 3802.

Confirm ASD communications
Confirm that the ASD network devices are communicating with the server by
viewing a node list.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

95.3.2

Signal Migration
Use the TAC I/A Series Migrator to convert the Signal backup database into XML
files, which are imported into a Building Operation Enterprise Server. If one or more
LCM points are in the Signal database, a database file is also created for import into
the Automation Server. This import creates an LCM device object for each LCM.
These LCM devices contain the blocks that were in the Signal database. You add
LCM blocks to each device with the Learn command.
The following flowchart describes the basic steps of the Signal migration workflow.
Related information can be found in the sections following the flowchart.
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Figure: Signal Migration Flowchart

Convert the Signal database
Use the TAC I/A Series Migrator to convert the Signal database into an XML file.
For more information, see section 95.2 “NETWORK 8000 System Migration” on
page 3750.

Technical
3758

04-16006-04-en, March 2015

95 NETWORK 8000 Introduction
95.3 NETWORK 8000 Workflows

Import the Signal XML file
Import the Signal XML file into Building Operation, which creates a server database
that is complete with the converted Signal graphics.
For more information, see section 18.1 “Import and Export Overview” on page 557.

Learn LCM blocks
Learn the blocks that reside in each LCM. The LCM objects contain only the blocks
for which there were points in the Signal database.
For more information, see section 95.9 “Learn LCM Blocks” on page 3772.

Configure LCM message routing
Use a terminal editor to modify the LCM’s INSTALL DATA so that exception
messages reach the Automation Server.
For more information, see section 96.12 “Configuring LCM Message Routing” on
page 3810.

Configure LCM communications
Configure communications to the LCM devices so that you can command and
monitor existing data in one or more LCM devices on the Building Operation LCM
network.
For more information, see section 96.7 “Configuring LCM Communications” on
page 3804.

Confirm LCM communications
Confirm that the LCM network devices are communicating with the server by
viewing a node list.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

Reset LCM blocks
Reset the internal data, such as number of changes, last time, or accumulated data,
of some blocks in the LCM.
For more information, see section 96.8 “Resetting LCM Blocks ” on page 3806.

Update Blocks or Objects
Update LCM blocks or LCM objects in WorkStation any time an LCM attribute
change was made in the LCM while it was was unable to communicate with the
Automation Server.
For more information, see section 96.9 “Updating a Block or Object” on page 3807.

Synchronize LCM date and time
Synchronize the date and time in the LCMs with the Automation Server to ensure
they are the same.
For more information, see section 96.10 “Synchronizing LCM Date and Time ” on
page 3808.
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95.4

NETWORK 8000 Interface
When you import a migrated GCM database into a server, a single NETWORK
8000 Interface with folders and sub-folders is created. These folders contain the
migrated NETWORK 8000 objects. Only one NETWORK 8000 Interface can be
imported into a server.

Figure: NETWORK 8000 Interface in the System Tree

All objects, regardless of how they are created (migrated, converted, or new), are
assigned to one of the sub-folders of the NETWORK 8000 Interface. Each
object type is assigned to only one folder. For more information, see section 95.6
“NETWORK 8000 Objects” on page 3763.
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95.4.1

Application
In the Application folder, sub-folders contain the objects that represent the
NETWORK 8000 control application. The NETWORK 8000 Interface folder
contains folders that are only created as needed when an object that resides in that
folder is created:
• Control: Contains the general purpose NETWORK 8000 Interface
controls.
• Notification: Contains the alarm and maintenance reminders that can create
Building Operation alarms.
• Points: Contains the physical and virtual points and the interconnection points
to obtain values outside the NETWORK 8000 application.
• Schedules: Contains the converted NETWORK 8000 schedules.
• Trends: Contains the converted NETWORK 8000 trends.

95.4.2

ASD Network
This folder contains all ASD devices that represent the physical ASD devices.

95.4.3

LCM Network
One or more LCM folders are created if they are part of a Signal database. For more
information, see section 95.3 “NETWORK 8000 Workflows” on page 3754.

95.4.4

NETWORK 8000 Statistics
Use the NETWORK 8000 Statistics to view general statistics for the NETWORK
8000 Interface. The statistics can be useful in debugging the performance of the
NETWORK 8000 application or the ASD or LCM networks.
For more information, see section 95.20 “Viewing NETWORK 8000 Interface
Statistics” on page 3788.
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95.5

GCM Block Migration
The NETWORK 8000 System functionality is reproduced in Building Operation.
During the NETWORK 8000 migration, the following GCM block types are either
migrated or converted:
• Controls
• Notifications
• Points
• Device
NETWORK 80000 objects are derived from NETWORK 8000 block design and
retain the functionality of the NETWORK 8000 blocks while using the WorkStation
user interface. The control, notification, and point type GCM blocks are migrated to
NETWORK 80000 objects while trend and schedule type blocks are converted to
trend and schedule objects.
Not all GCM data can be migrated to the server database. Historical data should be
extracted if needed. The current calculated pre-start and pre-stop times of the OSS
block, the calculated gains of a LOOP block, and totalization values can be
collected in block reports. For seamless optimum control, you can enter the data
into the appropriate objects.

95.5.1

Import Migrated GCM Data
You use WorkStation to import the migrated GCM database into the Automation
Server. WorkStation uses the database XML file for the import process, which then
creates a NETWORK 8000 Interface with all the migrated objects in sub-folders
under the NETWORK 8000 Interface folder.
For more information, see section 18.9 “Import and Export of GCM Solutions” on
page 569.

Note
There can be only one NETWORK 80000 Interface in a server. If you attempt to
import another interface, the system identifies import conflicts during the import
process and prevents the import from taking place. However, you can export any
group of NETWORK 80000 objects and import them into another Automation
Server with a NETWORK 80000 Interface.

95.5.2

NETWORK 8000 and Building Operation Term
Comparison
The following table lists terms used in NETWORK 8000 and their equivalent terms in
Building Operation. NETWORK 8000 GCM/LCM Programmer's Manual, (F-23120)
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NETWORK 8000 Terms

Building Operation Terms

Block

Object

Block type

Object type
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95.5.3

NETWORK 8000 Terms

Building Operation Terms

Attribute

Property

Parameter

Parameter

Input

Input group with three properties

Output

Output property

Application

NETWORK 80000 application For more
information, see section 95.4 “NETWORK
8000 Interface” on page 3758.

GCM Blocks Converted to Standard Building
Operation Objects
Some GCM blocks are converted to standard (non-NETWORK 80000) Building
Operation objects rather than being migrated. These converted blocks include
TREND and scheduling blocks:
• TREND
• WEEK
• DAILY
• HOLI
• CALEN
• OSS
This group has the equivalent functionality to the GCM blocks that they replace.
Additionally NETWORK 80000 Dpt and SlectAv objects are created as needed to
provide point data passing capability (connectivity) into the NETWORK 80000
objects.

95.5.4

Object Name
Each object has a property called object name, which is sometimes called the
display name. This property consists of a text string that defines the property. The
object name is used to identify the object wherever it is displayed in the system,
such as object dialog boxes, the System Tree pane, and drop-down lists. This
string is the same as the attribute name of the equivalent property of a GCM/LCM
block, except the GCM/LCM string is all capital letters and is limited in the
GCM/LCM to 20 characters.
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95.5.5

Property Name and Abbreviation
The NETWORK 80000 object display names are the same as the property name of
the equivalent attribute of a GCM/LCM block except the GCM/LCM string is all
capital letters. The property abbreviation is a string of up to five characters derived
from GCM block attributes that are used to identify the property within Building
Operation. For block inputs, an extension to the five character abbreviation is added
to the value (Val), constant (Par), and reference (Ref) properties. When you move the
cursor over the property name, the abbreviation for the object is shown. The
abbreviation is the name used in the path for a reference. The following list shows
examples of references.
• .../.../Control/HiLo:ORMTEMP/Sum - A reference to the summation output of
the HiLo:ORMTEMP object.
• .../.../Points/DO:EO7/DV - A reference to the digital point value of the DO:EO7
object.
The following list shows examples of referencing these objects.
• ~/NETWORK 80000 Interface/Application/Control/SlectAv:EO7/InSelRef - The
Input select reference property that references this object.
• ~/NETWORK 80000 Interface/Application/Points/AO:ORMSTART/IPr1Ref The Input priority 1 reference property that references this object.
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95.6

NETWORK 8000 Objects
New objects are created when GCM blocks are migrated to Building Operation. The
new objects provide the same or similar functions as the NETWORK 8000 blocks
that are being replaced by them.

95.6.1

NETWORK 8000 Block Migration Synopsis
Most NETWORK 8000 blocks are migrated or converted directly into an
Automation Server. However, some blocks are not migrated at all.
For more information, see section 95.7 “GCM Block Migration Synopsis” on page
3764.

95.6.2

NETWORK 8000 Object Input Properties
NETWORK 8000 object inputs provide the data that is processed by the object
function. An input can be a fixed value, NOT ACTIVE, or a pointer to an output of
another object. The values can be numbers or digital states as defined by the input
type.
For more information, see section 95.8 “NETWORK 8000 Object Input Properties”
on page 3771.

95.6.3

NETWORK 8000 Forced Value
Output values that could be overridden in the GCM blocks can be forced
(overridden) in Building Operation objects. The forced values are used by an object
referencing the output value or any display of the output value. The object continues
to calculate an output value during a force, and when that force is removed, the
latest calculated value is applied as the output value.
The primary output value is persistent during a warm reset for all point objects. This
means forced values of point objects are also maintained during a warm reset.
Forced output values of non-persistent outputs are not maintained during a warm
reset.
The AO, Apt, Dpt, and DO objects have timed overrides where a time can be set to
remove the override after a number of minutes defined by the property Override
time. Setting a value of 500,000 minutes or greater will cause the override to
remain on forever. When a value is overridden, the override time is set to five
minutes if the current value is less than five minutes. This allows you to set the
override time after setting the override value. Setting the override time first, sets the
override value to the current output value.
For more information, see the Forced Values topic on WebHelp.
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95.7

GCM Block Migration Synopsis
Most NETWORK 8000 blocks are migrated or converted directly into an
Automation Server. However, some blocks are not migrated at all.
The following table contains a synopsis of the migration path for all possible
standard blocks in a GCM and describes what happens to the blocks during the
migration process.
Table: NETWORK 8000 Block Migration Synopsis
NETWORK 8000 Block

Building Operation
Object

Comment

AI – Analog Input

AI

Migrated as a point object.
This object requires the GCS
network to function and is
not available as a block in the
ASD GCM.

AIPLC – PLC Analog Input

—

The block is not supported.

ALARM – Analog Limit Alarm Alarm

Migrated with enhanced
Building Operation alarm
reporting features.

AO – Analog Output

AO

Migrated as a point object.
This object requires the GCS
network to function as a
physical point but is always
available as a virtual point.

AOPLC – PLC Analog
Output

—

The block is not supported.

APT – Analog Point Value

Apt

Migrated as a standard point
or control object with an
enhanced reference feature
to access numeric values
outside of the NETWORK
8000 application.

BTUH – BTUH Calculator

Btuh

Migrated as a standard
control object.

CALEN – Calendar Schedule Schedule
Dpt
SlectAv
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Converted to a Building
Operation Schedule with
added Dpt and SlectAv
interface objects. SlectAV is
not always required.

COS – Change of State
Alarm

Cos

Migrated with enhanced
Building Operation alarm
reporting features.

CURVE – Curve Fit Equation

Curve

Migrated as a standard
control object.
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Continued
NETWORK 8000 Block

Building Operation
Object

Comment

DAILY – Daily Schedule

Schedule

Converted to a Building
Operation Schedule with
added Dpt and SlectAv
interface objects. SlectAV is
not always required.

Dpt
SlectAv

04-16006-04-en, March 2015

DCC – Duty Cycle Control

DccComp

Migrated to a DccComp
object if block MODE is
configured for
COMPENSATED.

DCC – Duty Cycle Control

DccFix

Migrated to a DccFix object if
block MODE is configured for
FIXED DUTY CYCLE.

DEGDA – Degree Days

DegDa

Migrated as a standard
control object.

DELAY – Delay or Pulse

Delay

Migrated as a standard
control object.

DI – Digital Input

DI

Migrated as a point object.
This object requires the GCS
network to function and is
not available as a block in the
ASD GCM.

DIPLC – PLC Digital Input

—

The block is not supported.

DO – Digital Output

DO

Migrated as a point object.
This object requires the GCS
network to function as a
physical point but is always
available as a virtual point.

DOPLC – PLC Digital Output —

The block is not supported.

DPT – Digital Point Value

Dpt

Migrated as a point object
with an enhanced reference
feature to access digital
values outside of the
NETWORK 8000 application.

EDL – Demand Limit

Edl

Migrated as a standard
control object.

EMS – Energy Man.Report

—

The block is not supported.

ENTHL – Enthalpy

EnthDew

Migrated to an EnthDew
object if the block attribute
HSSEL is configured for
DEWPOINT.

ENTHL – Enthalpy

EnthRh

Migrated to an EnthRh object
if the block attribute HSSEL
is configured for RELATIVE
HUMIDITY.
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NETWORK 8000 Block

Building Operation
Object

Comment

FLO2 – MICROFLO II

Flo

Migrated as a device object.

FLOW – Flow from Diff. Pres. Flow

Migrated as a standard
control object.

GCMR – Gets Data from
GCM

—

This block was previously
obsoleted. Not supported by
GCM version 5.4A or 5.41A.

HILO – High Low Average
Sum

Hilo

Migrated as a standard
control object.

HOLI – Holiday Schedule

ScheduleDpt

Converted to a Building
Operation Schedule with an
added Dpt interface object or
can be combined with a
migrated Week, Daily, or
OSS schedule object.

LABEL – VEO Label

—

The block is not supported.
However, User Names for
Current Status and VEO
screens are listed in the
migration report.

LCMR - Receives data from
GCM

—

This block was previously
obsoleted. Not supported by
GCM version 5.4A or 5.41A.

LIM – Lighting Interface

Lim

Migrated as a device object.

LIMIT – Limit and Compare

Limit

Migrated as a standard
control object.

LOGIC – Logic Functions

Logic

Migrated as a standard logic
object if not used as a single
invert gate.

LOGIC – Logic Functions

Invert

Migrated as an Invert object if
only used as a single invert
gate.

LOOP – PID Loop Control

Loop

Migrated as a standard
control object without the
self-tune feature.

MAILR –Get data from
MAILS

—

This block was previously
obsoleted. Not supported by
GCM version 5.41A or 5.4.

MAILS – Send data to
MAILR

—

This block was previously
obsoleted. Not supported by
GCM version 5.41A or 5.4.

MATH – Math Functions

Math

Migrated as a standard math
object for Add, Subtract,
Multiply, and Divide.
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Building Operation
Object

Comment

MATH – Math Functions

MathFilt

Migrated as a math low pass
filter object.

MATH – Math Functions

MathSqRt

Migrated as a square root
function.

MN – MicroNet Generic

Mn

Migrated as a MicroNet 2000
device object for an MNASDI or all other MicroNet
2000 devices except an MNHPFC configured as Heat
Pump/Fan Coil controller.

MN – MicroNet Generic

MnHpfc

Migrated as a MicroNet 2000
device object configured for
an MN-HPFC controller
running as a Heat Pump/Fan
Coil controller (not in satellite
mode).

MNFLO – MicroNet Flo

MnFlo

Migrated as a MicroNet 2000
device object for MN-FLO
and MN-FLO3T controllers.

MOMEN–Start/Stop

Momen

Migrated as a point object.

MTR – Maintenance
Reminder

MtrCycle

Migrated with enhanced
Building Operation alarm
reporting features if the MTR
block is configured for ON
CYCLES.

MTR – Maintenance
Reminder

MtrDays

Migrated with enhanced
Building Operation alarm
reporting features if the MTR
block is configured for
CALENDAR DAYS.

MTR – Maintenance
Reminder

MtrState

Migrated with enhanced
Building Operation alarm
reporting features if MTR
block is configured for
DIGITAL STATE.

MTR – Maintenance
Reminder

MtrTime

Migrated with enhanced
Building Operation alarm
reporting features if the MTR
block is configured for
ELAPSED TIME.

MZHP1 – MZ1 Heat Pump

—

The block is not supported.

MZONE – MICROZONE 1

—

The block is not supported.

MZRT1 – MZ1 Package
Rooftop

—

The block is not supported.
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Building Operation
Object

Comment

MZSAT – MZ1 Satellite

—

The block is not supported.

MZST1 – MZ1 Satellite 1

—

The block is not supported.

NIM – Ethernet NIM Setup

—

The block is not supported.

NSCHD – NEC Schedule
and OSS

—

The block is not supported.

OSS – Optimal Start Stop

Schedule OSS

Migrated as a standard
control object. In addition, it
is converted to a Building
Operation Schedule that the
standard control object
references.

PEM1 – Package Equip.
Module

Pem1

Migrated as a device object.

POLL – Polled Point

PollAv

Migrated as point object only
if polling an analog value
from a local LCM.

POLL – Polled Point

Apt

Converted to an Apt point if
polling an analog value NOT
from a local LCM.

POLL – Polled Point

PollDv

Migrated as point object only
if polling a digital value from a
local LCM.

POLL – Polled Point

Dpt

Converted to an Dpt point if
polling a digital value NOT
from a local LCM.

PULSE–Pulse Count

Pulse

Migrated as a point object.
This object requires the GCS
network to function and is
not available as a block in the
ASD GCM.

PWM – Dual Pulse Width
Mod.

Pwm

Migrated as a standard
control object.

RAMP – Soft Start Ramp

Ramp

Migrated as a standard
control object.

RESET – Setpoint Reset

Reset

Migrated as a standard
control object.

RGCM – Read GCM Values

—

The block is not supported.

RLCM – Read LCM Values

RlcmAv

Migrated as a point object to
read an analog value sent
from an LCM.
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Building Operation
Object

Comment

RLCM – Read LCM Values

RlcmDv

Migrated as a point object to
read a digital value sent from
an LCM.

RNET – Read Network Value RnetAv

Migrated as point object. The
block report lists the GCM
address and Slot number for
the analog value.

RNET – Read Network Value RnetDv

Migrated as point object. The
block report lists the GCM
address and Slot number for
the digital value.

SEQ – Sequencing Outputs

SeqBin

Migrated as a standard
control object if configured
for the Binary sequence.

SEQ – Sequencing Outputs

SeqLin

Migrated as a standard
control object if configured
for the Linear sequence.

SEQ – Sequencing Outputs

SeqRot

Migrated as a standard
control object if configured
for the Rotating sequence.

SGCM – Send GCM Values

Sgcm

Migrated as a device object.

SGRP -Send Group Values

—

This block was previously
obsoleted. Not supported by
GCM version 5.4A or 5.41A
and was replaced with
SGRP2.

SGRP2 -Send Group Values

Sgrp2

Migrated as a device object
for MICROZONEs, PEMs,
and LIMs.

SGRP2 -Send Group Values

Sgrp2Flo2

Migrated as a device object
for the MICROFLO II
controllers.

SLCM – Send LCM Values

—

The block is not supported.

SLECT – 2 Input Selector

SlectAv

Migrated as a standard
control object to switch
analog values.

SLECT – 2 Input Selector

SlectDv

Migrated as a standard
control object to switch
digital values.

SNET – Send Network
Values

—

The block is not supported.
Use Building Operation
services.

SYS – System Data

—

The block is not supported.
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NETWORK 8000 Block

Building Operation
Object

Comment

TOTAL – Analog Totalization

Total

Migrated as a standard
control object.

TRANS – GCM to LCM
Transfer

—

This block was previously
obsoleted. Not supported by
GCM version 5.4A or 5.41A.

TREND – Trend Data

—

Converted to up to four
Building Operation trends.

TSTAT – 2 Position Tstat

Tstat

Migrated as a standard
control object if configured
for On/Off control.

TSTAT – 2 Position Tstat

TstatFlt

Migrated as a standard
control object if configured
for floating actuator control.

VVBOX – MICROFLO

VvBox

Migrated as a device object.

WEEK – Weekly Schedule

Schedule

Converted to a Building
Operation Schedule with
added Dpt and SlectAv
interface objects. SlectAV is
not always required.

Dpt
SlectAv
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ZONE2 – MICROZONE II

Zone2

Migrated as a MICROZONE II
device object.

Z2HSC – Zone 2 Holiday

—

The block is not supported.

Z2SCH – Zone 2 Schedule

—

The block is not supported
by the Building Operation
NETWORK 8000 application.
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95.8

NETWORK 8000 Object Input
Properties
NETWORK 8000 object inputs provide the data that is processed by the object
function. An input can be a fixed value, NOT ACTIVE, or a pointer to an output of
another object. The values can be numbers or digital states as defined by the input
type.
Each object input has three properties with the same basic display name. The three
object properties have the same base name as the single GCM block attribute. For
example, the GCM CENAB block input attribute is represented in Building
Operation under the Inputs tab of the object by three properties, each named
Calculate enable and is abbreviated as Cenab. The property name is appended
with value, constant, or reference, which indicates its function:
• Calculate enable value
• Calculate enable constant
• Calculate enable reference
The object abbreviations are displayed when you hover the mouse over the
property name and are appended with Val, Par, or Ref. The following list shows the
abbreviations of the Calculate enable property:
• CenabVal
• CenabPar
• CenabRef

Value (Val)
Value is a string type property that shows the current value of the object. The string
may also indicate an out of range value or indicate that the property is not used in
the current configuration of the object.

Constant (Par)
Constant is a value that provides a fixed input value for the object. Fixed values, if
defined, always have priority over the reference input value.

Reference (Ref)
Reference is a reference input pointer that points to the output of an object that is
used as the input if the constant value is not defined.
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95.9

Learn LCM Blocks
When you import Signal data into an Automation Server, one or more LCM device
objects are created. These LCM objects contain only the blocks for which there
were points in the Signal database. The blocks that reside in each LCM must be
learned.
Each attribute of an LCM block is represented by a property in the Automation
Server block. The LCM's blocks and parameter values are read during the learn
process. The EMS, LABEL, NSCHD, and SYS blocks in the LCM are not learned.
You also use the Learn LCM command when certain configurations occur:
• When blocks are added to the LCM
• When blocks are deleted from the LCM
When you edit an LCM block using Tree Tech or a terminal editor, the server
database is updated with the changes as long as the LCM is online and the
exception print groups are correctly configured. For more information, see section
96.11 “LCM Message Routing” on page 3809.
An exception to this is when you change an input from a pointer to a constant or
vice versa, the change is not applied in the server. To update the block in the
server, delete the server block and relearn it. However, any bindings to and from the
server block will be lost. To prevent the loss of this information, record the binding
data prior to deleting the block.
When a block is added after a Learn LCM has been performed, an NETWORK
8000 Event Record event is created with a System event ID of Object
created. If one or more blocks are deleted in the LCM before a Learn LCM has
been performed, an NETWORK 8000 Event Record event is created with a
System event ID of Property changed because the inputs and parameters are
Null.
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95.10

Learning LCM Blocks
You learn LCMs to create Automation Server blocks that mirror the blocks in an
LCM.
For more information, see section 95.9 “Learn LCM Blocks” on page 3772.

To Learn LCM Blocks
1. In WorkStation, in the System Tree pane, select the LCM that you want to
learn the blocks for.
2. On the Actions menu, point to Watch pane, and then click Select
Property.
3. In the Lcm Quick filter dialog box, select Object status.

4. Click OK.
5. On the Actions menu, click Learn LCM.
6. In the Watch pane, observe the status of the Learn LCM operation.

The Object status in the Watch pane is Normal and the blocks in the LCM are
listed under the LCM.
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95.11

Migration of Engineering Units
In NETWORK 8000, both analog and digital standard engineering units (units of
measure in Building Operation) are available. NETWORK 8000 block standard
engineering units are migrated directly into the Automation Server as the
appropriate property's units of measure. However, user-defined analog and digital
engineering units are not migrated to the Automation Server.
The units that are not migrated are identified in the migration report. You can select
equivalent engineering units for these properties. For more information, see the Unit
Selection Dialog Box topic on WebHelp.
In many NETWORK 8000 blocks, a parameter attribute can be used to define the
engineering units for many other attributes. These attributes with configurable units
are converted to Building Operation properties with configurable units of measure.
The migration report shows the migrated engineering units for all properties,
including output values.
In the NETWORK 8000 blocks, the engineering units are just labels that inform you
of the correct engineering units. In Building Operation, units of measure are also
used for conversions to and from other applications. For example, the NETWORK
8000 object may calculate in Fahrenheit but the client may view the values in
Celcius as a result of Building Operation’s automatic conversion to SI units. For
more information, see the Units topic on WebHelp.

95.11.1

Analog Engineering Units
The standard NETWORK 8000 analog engineering units are converted to Building
Operation units of measure.
For more information, see section 95.12 “Analog Engineering Units” on page 3776.

95.11.2

Digital Engineering Units
The standard NETWORK 8000 digital engineering units are converted to Building
Operation properties with string names for false and true.
For more information, see section 95.13 “Digital Engineering Units” on page 3777.

95.11.3

Digital Units
Digital units indicate a status of digital outputs. The standard NETWORK 8000
digital engineering units are converted to Building Operation properties with string
names for false and true.
For more information, see section 95.14 “Digital Units” on page 3778.
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95.11.4

NETWORK 8000 Object Value Conversion by
Units
Units of measure conversion of a numeric value occurs when a property value with
a specific units type is referenced by a property with a different unit type. The
bindings between NETWORK 8000 objects do not support any numeric
conversions.
For more information, see section 95.15 “NETWORK 8000 Object Value
Conversion by Units” on page 3779.
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95.12

Analog Engineering Units
The standard NETWORK 8000 analog engineering units are converted to Building
Operation units of measure.
Table: NETWORK 8000 Standard Units to Building Operation Analog Units

Technical
3778

NETWORK 8000
Standard Units

Building Operation
Category

Building Operation
Equivalent Units
Displayed

PERCENT

Percentage

%

DEGF

Temperature

°F

DEGC

Temperature

°C

VOLT

Voltage

V

KW

Power

kW

SEC

Time

s

MIN

Time

min

CFM

Flow

ft3/min

INWC

Pressure

inH2O

GPH

Flow

USgal/min

KWH

Energy

kWh

BTUH

Power

Btuh/h

HOUR

Time

h

NONE_0

No category or unit

–

NONE_1

No category or unit

–

NONE_2

No category or unit

–

04-16006-04-en, March 2015

95 NETWORK 8000 Introduction
95.13 Digital Engineering Units

95.13

Digital Engineering Units
The standard NETWORK 8000 digital engineering units are converted to Building
Operation properties with string names for false and true.
Table: NETWORK 8000 Standard Units to Building Operation Digital Units

04-16006-04-en, March 2015

Property Type Name

Off State

On State

DvUnits

Off (false)

On (true)

DvUnitsAlmNrm

Off = Alarm

On = Normal

DvUnitsClOpn

Off = Close

On = Open

DvUnitsFaNrm

Off = Fail

On = Normal

DvUnitsHiLo

Off = High

On = Low

DvUnitsHiNrm

Off = High

On = Normal

DvUnitsLoHi

Off = Low

On = High

DvUnitsLoNrm

Off = Low

On = Normal

DvUnitsNormLo

Off = Normal

On = Low

DvUnitsNrmAlm

Off = Normal

On = Alarm

DvUnitsNrmFa

Off = Normal

On = Fail

DvUnitsNrmHi

Off = Normal

On = High

DvUnitsOpnCl

Off = Open

On = Close

DvUnitsSumWn

Off = Summer

On = Winter

DvUnitsUnocOc

Off = Unoccupied

On = Occupied

DvUnitsWnSum

Off = Winter

On = Summer
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95.14

Digital Units
Digital units indicate a status of digital outputs. The standard NETWORK 8000
digital engineering units are converted to Building Operation properties with string
names for false and true.
For example, Close (false) is displayed as the digital value. You can add digital
status to the following objects:
• DI
• DO
• Dpt
• PollDv
• RlcmDv
• RnetDv
• Pem1 physical digital inputs
For more information, see the Configure Dialog Box - Configuration Tab topic on
WebHelp.
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95.15

NETWORK 8000 Object Value
Conversion by Units
Units of measure conversion of a numeric value occurs when a property value with
a specific units type is referenced by a property with a different unit type. The
bindings between NETWORK 8000 objects do not support any numeric
conversions.
The NETWORK 8000 application supports unit conversion from other applications
using the Apt object. Binding the Analog global reference input of an Apt object to a
property of a non-NETWORK 8000 object converts the value to the engineering
units defined for the Apt. I/A Series Migrator Guide, (F-27741)

Note
The Analog global reference input of the Apt is the only NETWORK 8000
object input that supports numeric conversions. All NETWORK 8000 objects that
are bound together must have the same units of measure.
The following illustration is a representation of the values that are displayed by
WorkStation. The green objects represent non-NETWORK 8000 objects. The blue
objects represent NETWORK 8000 objects. The values shown here represent the
values displayed by Workstation with US customary units. The red values represent
incorrect values because the object is incorrectly configured with units that don't
match the other NETWORK 8000 objects that it is bound to.
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Figure: NETWORK 8000 Object Value Conversion by Units

For more information, see section 165.2 “Incorrect Values Displayed Due to Unit
Conversion” on page 5674.
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95.16

Schedules for NETWORK 8000
All existing GCM schedule blocks, with the exception of NEC and master
MICROZONE II schedules, are converted to Building Operation schedule objects.
For more information, see the Schedules Overview topic on WebHelp.
Object name and Building Operation identifier are converted. The object name
becomes a combination of the object name and the GCM block name with the
user-defined extension. For example, DAILY:MEW1 becomes
Schedule:DAILY:MEW1.
The following list shows the GCM blocks that are converted to Building Operation
schedules:
• CALEN
• DAILY
• HOLI
• WEEK
• OSS
The OSS block is both migrated and converted to objects. The block’s schedule is
converted to a Building Operation schedule while the start and stop function is
migrated to the OSS object. Dpt objects are also added to provide an interface
between the Building Operation schedules and the NETWORK 8000 objects.
In the NETWORK 8000 block applications, schedule blocks are linked together to
create a complex schedule similar to Building Operation’s schedule
object. Typically, the HOLI and CALEN event blocks are referenced by the holiday
input of a WEEK or OSS block. These block combinations are converted to a single
schedule object with the required schedule interface objects. The following table
shows how the NETWORK 8000 linked schedule blocks are converted to schedule
objects.
Block or Block
Combination

Object

Schedule Output

HOLI:XX block

Schedule:HOLI:XX

Dpt:HOLI:XX:DV

Dpt:HOLI:XX
CALEN:XX block with DV
output used

Schedule:CALEN:XX

CALEN:XX block with AV
output used

Schedule:CALEN:XX,

Dpt:CALEN:XX:DV

Dpt:CALEN:XX
SlectAV:CALEN XX:DV

Dpt:CALEN:XX
SlectAV:CALEN XX

DAILY:XX block with DV
output used

Schedule:DAILY:XX

DAILY:XX block with AV
output used

Schedule:DAILY:XX

Dpt:DAILY:XX:DV

Dpt:DAILY:XX
SlectAV:DAILY XX:DV

Dpt:DAILY:XX
SlectAV:DAILY XX

04-16006-04-en, March 2015

Technical
3783

95 NETWORK 8000 Introduction
95.16 Schedules for NETWORK 8000

Continued
Block or Block
Combination

Object

Schedule Output

WEEK:XX block with DV
output used

Schedule:WEEK:XX

Dpt:WEEK:XX:DV

Dpt:WEEK:XX

With or without the holiday
input linked to a HOLI or
CALEN block.
WEEK:XX block with AV
output used

Technical
3784

Schedule:WEEK:XX

SlectAV:WEEK:XX:AV

Dpt:WEEK:XX

With or without the holiday
input linked to a HOLI or
CALEN block.

SlectAV:WEEK:XX

OSS:XX block

Schedule:OSS:XX

With or without the holiday
input linked to a HOLI or
CALEN block.

OSS:XX

OSS:XX outputs
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95.17

Trends for NETWORK 8000
All NETWORK 8000 Trend blocks are converted to Building Operation Trend
objects. For more information, see the Trend Overview topic on WebHelp.
GCM Trend blocks can trend up to four input values. Building Operation Trend
objects have one input so each GCM Trend block is converted to up to four Trend
objects. Object name, identifier, and date of conversion are reported. The trend
itself with the pointers is migrated, but the trend data is not. The GCM Trend block's
user title is converted to the description of the object, which displays when you
hover your cursor over the object in the System Tree pane.
Because the memory was limited in the GCM, the logged data was cleared by the
program. In the case of interval trends, some GCM trends only logged the data
once and kept the full trend data until cleared. In Building Operation, trends can be
made significantly larger and clearing older data is not required. The migration
report alerts you that the logged data is not cleared. Any other inputs of the GCM
trend would have the same properties except it logs a different variable.
The Full Migration report shows successful conversions and trend conversions with
issues.

95.17.1

Conversion to a Variable Triggered Trend Log
GCM triggered Trend blocks are converted to Trend objects. The GCM trend
sampled on every change of state of a trigger input. This is converted to a Variable
Triggered Trend Log to duplicate the functionality of the GCM Trend block. A
sample is logged whenever the Trigger variable changes state.

95.17.2

Conversion to an Interval Trend Log
GCM Trend blocks that sampled inputs on an interval are converted to Interval
Trend logs. The Start condition is Variable controlled and uses the Start
variable to enable logging to duplicate the GCM's functionality.
For fixed interval logging, some GCM trend blocks used a built-in daily schedule to
start and stop logging. This schedule is not automatically converted to a Building
Operation schedule and is listed as an issue in the migration report. A Building
Operation schedule can be used with the Start variable to duplicate the
functionality.
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95.18

Alarms for NETWORK 8000
The NETWORK 8000 Alarm, Cos, MtrCycle, MtrDays, MtrState, and MtrTime
objects reproduce the functionality of the GCM ALARM, COS, and MTR blocks.
These objects are used to create alarm functions similar to that provided in a GCM.
The TAC I/A Series Migrator migrates GCM ALARM, COS, and MTR notification
blocks to Building Operation alarms, which produce alarms and events. Six Building
Operation alarms are unique to NETWORK 8000:
• Alarm
• Cos
• MtrCycle
• MtrState
• MtrTime
• MtrDays
Each of these alarms has properties converted from the NETWORK 8000 blocks,
such as alarm text, priority, and monitored value.
Alarm and maintenance time reminder messages, application and system
diagnostic messages, and user events such as a user accessing a device, value
overrides, and configuration changes become Building Operation events, and
alarms if so configured. NETWORK 8000 exception messages can be defined to be
logged as events or alarms. If the message is an alarm, the message is presented in
the Alarms pane and as an event in the Events pane. Every alarm message, force
(override), and force removed, is logged as an event. NETWORK 8000 GCM/LCM
Programmer's Manual, (F-23120).
After a warm reset of the server, no exception messages are resent. After a cold
reset of the server or a cold reset of an object, all exception messages are resent
except for the database modified message.
Alarms for NETWORK 8000 are categorized by where they originate. These alarms
may originate from field devices as system alarms, from NETWORK 8000 alarm
objects, or Building Operation alarm objects.
The standard Building Operation alarm objects can be used when greater
functionality is needed than is provided by the NETWORK 8000 Alarm and Cos
objects. For more information, see the Alarm Types topic on WebHelp.

95.18.1

Alarm Features
The NETWORK 8000 alarms provide functionality that is similar to the GCM alarms:
• The Disable Alarm input acts as a shunt variable but has an additional delay
time after the alarm is enabled. For more information, see the Shunt Variable
topic on WebHelp.
• Priority levels 1 to 15 are are coverted by the TAC I/A Series Migrator as 10 to
150. For more information, see the Priority topic on WebHelp.
• Alarms can be assigned to categories. For more information, see the
Categories topic on WebHelp.
• Alarm acknowledgement types for all NETWORK 8000 alarms are set in the
NETWORK 8000 Interface.
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For more information, see section 97.3 “NETWORK 8000 Interface – Basic
Tab” on page 3835.
For more information, see the Acknowledgement topic on WebHelp.

95.18.2

Alarm Message Text
When NETWORK 8000 exception messages are migrated to Building Operation
NETWORK 8000 alarms, the block statuses are changed to fixed messages
followed by the original user-defined messages. These user-defined text messages
can be edited in the NETWORK 8000 alarms, but the fixed portion of the message
cannot be edited. The editable text message length is unlimited in Building
Operation.
Table: NETWORK 8000 Migrated GCM Alarm Exception Message Text
GCM ALARM Block Status Message

NETWORK 8000 Alarm Object
Message

HI ALRM

High Alarm, <text message>

HI RTN

High Alarm Return

LOW ALRM

Low Alarm, <text message>

LOW RTN

Low Alarm Return

ON ALRM

On Alarm, <text message>

ON RTN

On Alarm Return

OFF ALRM

Off Alarm, <text message>

OFF RTN

Off Alarm Return

Table: NETWORK 8000 Migrated GCM MTR Alarm Exception Message Text
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GCM MTR Block Status Message

NETWORK 8000 Mtr Object Message

ELAPSED TIME

MTR Elapsed Time, <text message>

NUMBER OF CYCLES

MTR Number of Cycles, <text message>

CALENDAR DAYS

MTR Calendar Days, <text message>

DIGITAL INPUT

MTR Digital Value, <text message>
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95.19

Editing OSS Pre-Start and Pre-Stop
Values
You can edit the OSS Pre-Start and Pre-Start values. You can also enter learned
values that you recorded from the GCM prior to migration.
For more information, see section 97.255 “OSS Properties – Basic Tab” on page
4320.

To edit OSS Pre-Start and Pre-Stop values
1. In WorkStation, in the System Tree pane, select the OSS that you want to
edit.
2. On the File menu, click Properties.
3. Click the Basic tab.

4. In the Pre-Start and Pre-stop table, select the temperature.
5. Click Edit.
Continued on next page
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6. Enter a new value.

7. Click OK.
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95.20

Viewing NETWORK 8000 Interface
Statistics
View the NETWORK 8000 Interface statistics to debug the performance of the
NETWORK 8000 application or the ASD network.

To view NETWORK 8000 Interface Statistics
1. In WorkStation, in the System Tree pane, expand the server and then
expand System.
2. Expand Modules.
3. Expand NETWORK 8000 Plugin.

4. Select NETWORK 8000 Statistics.
5. On the File menu, click Properties.
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96.1 NETWORK 8000 ASD Devices

96.1

NETWORK 8000 ASD Devices
You use WorkStation to command and monitor the ASD data in the ASD devices.
Each ASD device has a fixed set of properties that can be commanded and
monitored from WorkStation.

96.1.1

Supported Devices
Building Operation supports all Network 8000 ASD devices:
• MICROZONE II
• MICROFLO II
• LIM
• PEM
• MicroNet 2000 products using the MN-ASDI integrator
For more information, see section 96.2 “ Supported Devices” on page 3793.

96.1.2

Generic RS-485 Network Devices
This application note provides recommendations for the RS-485 interface port
configuration between the Automation Server and generic RS-485 network devices
(Modbus or MS/TP). This information is intended to supplement the instructions you
receive with the various RS-485 network devices. These guidelines focus on the
arrangement of the electrical interface to the RS-485 port in regards to biasing,
termination, cable selection, cable lengths, and cable routing. The guidelines on
maximum unit load (node count) and common mode voltage tolerance are
associated with Automation Servers with serial number of TD133954000 and later.
For more information, see the Generic RS-485 Network Devices topic on WebHelp.

96.1.3

Field Device Alarms
In general, alarms originating from external sources, such as field devices, are
handled and displayed the same as other Building Operation alarms. All NETWORK
8000 alarm features are supported. The standard Building Operation alarm objects
can be used when greater functionality is needed.
For more information, see section 96.3 “Field Device Alarms” on page 3794.

96.1.4

ASD Field Device Alarm Message Text
ASD Field Device alarm messages are recorded as Building Operation events.
These messages can also be recorded as alarms, if configured to do so. The
messages appear in the Events and Alarms panes if so configured and are identified
by their System Alarm IDs.
For more information, see section 96.4 “ASD Field Device Alarm Message Text” on
page 3795.
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96.1.5

ASD and LCM Device Communication
Confirmation
You can confirm that the ASD and LCM network devices are communicating with
the server by viewing a node list. This is especially important after you migrate the
GCM database to the server and set up communications to the NETWORK 8000
devices in WorkStation. By looking at the Object Status of the devices in any of
the views, you can see whether or not the devices joined the network after you
moved the network from a GCM.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

Technical
3794

04-16006-04-en, March 2015

96 NETWORK 8000 Devices
96.2 Supported Devices

96.2

Supported Devices
Building Operation supports all Network 8000 ASD devices:
• MICROZONE II
• MICROFLO II
• LIM
• PEM
• MicroNet 2000 products using the MN-ASDI integrator

Note
The PEM devices only communicate at 9600 baud or below.
The following MicroNet 2000 products are supported:
• MN-FLO
• MN-FLO3T
• MN-HPFC
• MN-ASDI
• MN-CI programming tool
Software tools are required to program, configure, and backup the ASD devices:
• XPSI
• PSI
The following NETWORK 8000 devices are not supported in Building Operation:
• CCL GCM
• LNC
• SIM GCM
• PLC

Note
The MICROZONE and PLC require the GCS network to function and therefore are
not supported in Building Operation.
Building Operation supports the ASD device messages. For more information, see
section 95.18 “ Alarms for NETWORK 8000” on page 3784.
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96.3

Field Device Alarms
In general, alarms originating from external sources, such as field devices, are
handled and displayed the same as other Building Operation alarms. All NETWORK
8000 alarm features are supported. The standard Building Operation alarm objects
can be used when greater functionality is needed.
For more information, see the Alarm Types topic on WebHelp.
The following list describes the features of field device object alarms:
• The alarm is triggered in the field device for a diagnostic error.
• The message notification can be disabled by masking the alarm with the
Message enable property for most field device objects. The MicroNet 2000
devices use System fault enable and App error enable to mask alarms.
• The alarm text message is a predefined message for the alarm condition.
• NETWORK 8000 Interface objects have a fixed category of NETWORK 8000
system alarm.
• The priority level for groups of field device exception message types are set in
the NETWORK 8000 Interface. For more information, see section 97.4
“NETWORK 8000 Interface – ASD Tab” on page 3837.
• Alarms can be presented as audible, flashing, or both as configured by
properties in the NETWORK 8000 Interface for the different notification
message types.
• Alarm acknowledgement types for all NETWORK 8000 alarms are set in the
NETWORK 8000 Interface. For more information, see section 97.3 “NETWORK
8000 Interface – Basic Tab” on page 3835.
The category for all alarms generated by ASD devices is NETWORK 8000 system
alarm. The monitored value of the ASD device alarms is not available. ASD object
exception messages are not resent after an Automation Server warm reset.
The figure below shows the columns for generated alarms that replace the original
exception messages from the ASD device, along with standard columns.

Figure: Field Device Alarms
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96.4

ASD Field Device Alarm Message Text
ASD Field Device alarm messages are recorded as Building Operation events.
These messages can also be recorded as alarms, if configured to do so. The
messages appear in the Events and Alarms panes if so configured and are identified
by their System Alarm IDs.
Table: Table: ASD Messages For All Field Devices
System Alarm ID

Description

Leaves network Joins network

An event is recorded when the device first
joins the network and another if the device
leaves the network. Additionally, if Leaves
network alarm enable is enabled, a Leaves
Network alarm is created when the device
leaves the network and the alarm resets to a
normal state when it rejoins the network. The
device is identified in the Alarm text. For
example, (MICROZONE II controller at
address 1): MZ2:001 Leaves ASD network.
Disable (mask) messages at the device
object Messages enable property by
selecting Disable joining and leaving ASD
network messages.

Table: Table: Common ASD Messages For the Zone2, Lim and Pem1 Objects
System Alarm ID

Description

ROM failure

Calculated checksum of ROM in the device
does not match the actual checksum in the
ROM.
Disable or mask messages at the device
object Messages enable property by
selecting Disable ROM failure messages.

RAM failure

Device unable to read or write RAM.
Disable or mask messages at the device
object Messages enable property by
selecting Disable RAM failure messages.

Freeze error

The blocks in the device are not executing.
Usually due to a corrupted database.
Disable or mask messages at the device
object Messages enable property by
selecting Disable freeze failure messages.

Database initialized

The database in the device has been reset to
its initial state.
Disable or mask messages at the device
object Messages enable property by
selecting Disable database initialized
messages.
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Continued
System Alarm ID

Description

Database modified

Some properties in the database of the
device has changed.
Disable or mask messages at the device
object Messages enable property by
selecting Disable database modified
messages.

Device warm reset

Device has been reset but the contents of
RAM were not lost. The historical data has
been maintained.
Disable or mask messages at the device
object Messages enable property by
selecting Disable device reset messages.

Device cold reset

Device has been reset but the contents of
RAM were lost. All historical data is lost.
Disable or mask messages at the device
object Messages enable property by
selecting Disable device reset messages.

The Zone2 object has the common ASD messages plus the following message:
Table: Table: Messages For the Zone2 Object
System Alarm ID

Description

UI:xx diagnostic

The measured input value at UI:xx (from UI:1
to UI:8) is outside the standard range for the
configured sensor for a MICROZONE II
controller.
Disable or mask messages at the device
object Messages enable property by
selecting Disable input sensor diagnostic
messages.

The Pem1 object has the common ASD messages plus the following messages:
Table: Table: ASD Messages For the Pem1 Object
System Alarm ID

Description

AS:1 diagnostic

The Automation Server:1 input on a PEM1
controller is either open or shorted.
Disable or mask messages at the device
object Messages enable property by
selecting Disable input sensor diagnostic
messages.
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Continued
System Alarm ID

Description

AT:1 diagnostic

The AT:1 input on a PEM1 controller is either
open or shorted.
Disable or mask messages at the device
object Messages enable property by
selecting Disable input sensor diagnostic
messages.

AT:2 diagnostic

The AT:2 input on a PEM1 controller is either
open or shorted.
Disable or mask messages at the device
object Messages enable property by
selecting Disable input sensor diagnostic
messages.

The Flo2 object has the common ASD messages plus the following message:
Table: Table: Messages For the Flo2 Object
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System Alarm ID

Description

Setpoint out of range

The Remote Setpoint is enabled and out of
range.

Duct temp out of range

The Duct Temperature is enabled and out of
range.

Zone temp out of range

The zone temperature is out of range.

Device reset

The MICROFLO II controller has been reset
after the last communication with the
Automation Server.

Configuration error

The configuration settings of the controller
do not match the hardware.

Damper range error

Damper Range Error indicates the damper
has a full stroke range of less than 14° of
rotation.

Pressure error

The Velocity Pressure is out of range (-0.2 to
2.1 in. WC).

EEPROM memory error

The EEPROM Memory, which stores the
configuration, setpoint values, and
calibration values, has been corrupted.

Application modified

Something in the database of the device has
changed.
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System Alarm ID

Description

Table: Table: Message For the Mn Object
System Alarm ID

Description

EEPROM checksum error

Controller EEPROM memory checksum
error.

Table: Table: Messages For the MnFlo Object
System Alarm ID

Description

EEPROM checksum error

Controller EEPROM memory checksum
error.

Sensor input failure

The required Room Temperature input for
the controller failed.

No U-link communication

No U-Link communication to the sensor.

Application error 1

The pressure sensor in the controller failed.

Application error 2

There is a large negative pressure, greater
than –0.1 in. WC.

Application error 3

There is a large positive pressure, greater
than 2.2 in. WC.

Table: Table: Messages for the MnHfc Object
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System Alarm ID

Description

EEPROM checksum error

Controller EEPROM memory checksum
error.

Sensor input failure

The required Room Temperature input for
the controller failed.

System fault 32

Missing changeover input for a fan coil
application.

No U-link communication

No U-Link communication to the sensor.

Application error 16

Heat Setpoint is greater than the Cool
Setpoint.
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96.5

NETWORK 8000 LCMs
Each LCM has a set of programming blocks, which have a fixed set of properties
that can be commanded and monitored. You use WorkStation to command and
monitor the data in the LCMs.

96.5.1

Supported Devices
All Network 8000 LCM devices and their messages are supported in Building
Operation.
Software tools are required to program, configure, and backup the LCM devices:
• Tree Tech
• Terminal emulation software

96.5.2

Generic RS-485 Network Devices
This application note provides recommendations for the RS-485 interface port
configuration between the Automation Server and generic RS-485 network devices
(Modbus or MS/TP). This information is intended to supplement the instructions you
receive with the various RS-485 network devices. These guidelines focus on the
arrangement of the electrical interface to the RS-485 port in regards to biasing,
termination, cable selection, cable lengths, and cable routing. The guidelines on
maximum unit load (node count) and common mode voltage tolerance are
associated with Automation Servers with serial number of TD133954000 and later.
For more information, see the Generic RS-485 Network Devices topic on WebHelp.

96.5.3

LCM Device Communication Confirmation
You can confirm that the LCMs are communicating with the server by viewing a
node list. This is especially important after you migrate the GCM database to the
server and set up communications to the LCMs. By looking at the Object Status in
any of the views, you can see whether or not the devices on the LCM network
joined the network after you moved the network from the GCM to the Automation
Server.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

96.5.4

Alarms for LCMs
LCM alarms from existing LCM alarm blocks, ALARM, and COS, are by default
automatically converted to Building Operation alarms. LCM exception messages,
including MTR notifications, are converted to Building Operation events and some
can be converted to alarms. The set up for these alarms and events on the LCM tab
of the NETWORK 8000 Interface.
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To ensure that alarms and events are routed to the Automation Server, it is
important that the print groups are set up properly in the LCM. For more
information, see section 96.11 “LCM Message Routing” on page 3809.
The following list describes the features of LCM alarms:
• The message notification can be disabled by masking the alarm with the
Message enable property for most field device objects.
• The alarm text message is a predefined message for the alarm condition.
• NETWORK 8000 Interface objects have a fixed category of NETWORK 8000
system alarm.
• The priority level for groups of field device exception message types are set in
the NETWORK 8000 Interface. For more information, see section 97.5
“NETWORK 8000 Interface – LCM Tab” on page 3839.
• Alarms can be presented as audible, flashing, or both as configured by
properties in the NETWORK 8000 Interface for the different notification
message types.
• Alarm acknowledgement types for all NETWORK 8000 alarms are set in the
NETWORK 8000 Interface. For more information, see section 97.3 “NETWORK
8000 Interface – Basic Tab” on page 3835.

96.5.5

Schedules for LCMs
Existing LCM schedules can be maintained since the schedule properties can all be
modified as Building Operation properties. Migrated graphics with LCM schedules
continue to operate. Building Operation schedules may be used if the application in
the LCM is modified or if greater functionality is needed. Typically, Building
Operation schedule values can be sent to each LCM using the Sgcm in the
Automation Server and RGCM blocks in the LCM. For more information, see the
Schedules Overview topic on WebHelp.

96.5.6

Trends for LCMs
Existing LCM trends should be replaced with Building Operation trends. For more
information, see the Trend Overview topic on WebHelp.

96.5.7

LCM Exception Routing
You modify the installation data of the LCM to allow LCM exception messages to
reach the Automation Server to provide alarms, events, and updates to the server
blocks. The communication data, which includes the print groups and port
definitions, must be verified and modified if it is not correct.
For more information, see section 96.11 “LCM Message Routing” on page 3809.
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96.5.8

Learn LCM Blocks
When you import Signal data into an Automation Server, one or more LCM device
objects are created. These LCM objects contain only the blocks for which there
were points in the Signal database. The blocks that reside in each LCM must be
learned.
For more information, see section 95.9 “Learn LCM Blocks” on page 3772.

96.5.9

Block Update
The LCM block parameter and input fixed values are automatically updated when
you make a change directly in the LCM, outside of Building Operation, but only
when the LCM and Automation Server are communicating. Additionally, the LCM's
print groups must be configured to route exception messages to the Automation
Server.
When changes are made to LCM blocks while it is offline, you need to update the
Automation Server blocks when the LCM is back online. Use the Proxy update
command to read the input and parameter properties of the LCM's blocks. This
command does not change inputs from pointers to constants or vice versa, or
change engineering units. For more information, see section 96.9 “Updating a Block
or Object” on page 3807.
It is important that the print groups are set up properly in the LCM before updating
blocks. For more information, see section 96.11 “LCM Message Routing” on page
3809.
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96.6

Configuring ASD Communications
You configure communications to the ASD devices so that you can command and
monitor existing data in one or more ASD devices on the Building Operation ASD
network. If the Automation Server has been previously set up to use one of the two
RS-485 ports, you need to clear this setup prior to setting up the ASD network to
ensure the ports are unused.
For more information, see section 97.4 “NETWORK 8000 Interface – ASD Tab” on
page 3837.

To configure ASD communications
1. In WorkStation, in the System Tree pane, select the NETWORK 8000
Interface.
2. On the File menu, click Properties.
3. Click the ASD tab.

4. In the Network type box, select the baud rate.
5. In the ASD reference box, enter the RS-485 ComA serial port.
6. Click OK.
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The communication port cannot be used by another application. Setting the
Network type activates the communications. The devices on the network will
generate alarms and events as they join the network. Now you can view the list of
devices on the ASD network and confirm that they are communicating.
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96.7

Configuring LCM Communications
You configure communications to the LCM devices so that you can command and
monitor existing data in one or more LCM devices on the LCM network. If the
Automation Server has been previously set up to use one of the two RS-485 ports,
you need to clear this setup prior to setting up the LCM network to ensure the ports
are unused.
For more information, see section 97.5 “NETWORK 8000 Interface – LCM Tab” on
page 3839.

To configure LCM communications
1. In WorkStation, in the System Tree pane, select the NETWORK 8000
Interface.
2. On the File menu, click Properties.
3. Click the LCM tab.

4. In the LCM network box, select Enabled.
5. In the LCM port reference box, enter the RS-485 ComB serial port.
6. Click OK.
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The communication port cannot be used by another application. Setting the
Network type activates the communications. The devices on the network will
generate alarms and events as they join the network. Now you can view the list of
devices on the LCM network and confirm that they are communicating.
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96.8

Resetting LCM Blocks
You can reset the internal data, such as number of changes, last time, or
accumulated data, of some blocks in the LCM.

To reset LCM blocks
1. Using WorkStation, in the System Tree pane, select the LCM block to be
reset.
2. On the Actions menu, click Reset block.
This command does not affect the blocks in the Automation Server.
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96.9

Updating a Block or Object
You update a LCM block or LCM object in WorkStation anytime an LCM attribute
change was made in the LCM while it was was unable to communicate with the
Automation Server.
For more information, see section 96.5 “NETWORK 8000 LCMs” on page 3799.

To update a block or object
1. In WorkStation, in the System Tree pane, select the LCM block or LCM
object that you want to update.
2. On the Actions menu click Update properties from LCM.
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96.10

Synchronizing LCM Date and Time
You synchronize the date and time in the LCMs with the Automation Server to
ensure they are the same.

To synchronize LCM date and time
1. Using WorkStation, in the System Tree pane, select NETWORK 8000
Interface.
2. On the Actions menu, click Synchronize LCM date and time.
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96.11

LCM Message Routing
You modify the installation data of the LCM to allow LCM exception messages to
reach the Automation Server to provide alarms, events, and updates to the server
blocks. The communication data, which includes the print groups and port
definitions, must be verified and modified if it is not correct.
When verifying and modifying the print groups, you configure a maximum of two
ports. One print group is required for LCM exception messages. This print group
should be either port 1 or port 2 on the parent GCM that was replaced by the
Automation Server. The GCM port address must contain the correct network
number and GCM number of the original parent GCM, which is now the Automation
Server. You can define local port 1 on the LCM in this print group (or another) if
there is a need for a local LCM port to receive exception messages. NETWORK
8000 GCM/LCM Programmer's Manual, (F-23120).
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96.12

Configuring LCM Message Routing
You use a terminal editor to modify the LCM’s INSTALL DATA so that exception
messages reach the Automation Server.
For more information, see section 96.11 “LCM Message Routing” on page 3809.

To configure LCM message routing
1. Connect a laptop to the LCM RS232 port (local LCM port) using a DB9 to
DB25 serial cable.
2. Select the proper DTE/DCE setting.
3. Using a terminal editor, log in to the LCM and navigate to INSTALL DATA.
4. Set the LCM's EXCEPT/DIAG PRT GROUP to a print group containing the
parent GCM (Automation Server) port, which is typically print group 1.
5. Set all EXCEP PRINT FLAGS to Yes including ALARMS, MTRS, TRENDS,
OVERRIDES, ACCESS ATTEMPTS, BLOCK CONFIGS, SYSTEM CONFIGS,
BLOCK DIAGS, and SYSTEM DIAGS.
6. Remove all other print group entries that do not point to the Automation Server
or the local LCM port.
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96.13

ASD and LCM Device Communication
Confirmation
You can confirm that the ASD and LCM network devices are communicating with
the server by viewing a node list. This is especially important after you migrate the
GCM database to the server and set up communications to the NETWORK 8000
devices in WorkStation. By looking at the Object Status of the devices in any of
the views, you can see whether or not the devices joined the network after you
moved the network from a GCM.
You can confirm that the devices are communicating with the server several ways:
• Use Search
• Create a filtered Alarm View
• Create a filtered Event View
You select the network and then select the folder in System Tree view to see the
List view of devices in that folder. If the devices have been moved to another subfolder, the node list can be generated by doing a search of object of types. For
more information, see section 96.14 “Confirming ASD or LCM Communications
Using Search ” on page 3812.
Creating and using Alarm View and Event View under the device is a way for you
to focus on just the devices joining and leaving the network.
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96.14

Confirming ASD or LCM
Communications Using Search
You can confirm that ASD or LCM devices are communicating with the Building
Operation database.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

To confirm ASD or LCM communications using Search
1. In WorkStation, in the System Tree pane, select the NETWORK 8000
Interface that contains the devices you want to confirm are communicating
with the Building Operation database.
2. On the File menu, point to New and then click Search.
3. In the Name box, type a name for the Search.
4. Click Create.

5. In the System Tree pane, select the Search you created.
6. In the Search box, enter an asterisk (*).
7. In the Search View, click Advanced settings.
For more information, see the Search View topic on WebHelp.
8. In Include types, enter the types of ASD devices to be included in the
search.
9. Click the Save Search button

.
Continued on next page
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10. Add the Object status column to the view.

11. Verify that the NETWORK 8000 devices are communicating on the ASD or
LCM networks.
You can also set up an Alarms pane or Events pane in the system tree under the
ASD network object.
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96.15

Confirming ASD and LCM
Communications Using Alarm View
You can confirm that ASD LCM devices are communicating to the Building
Operation database by viewing them in an Alarm View, which you can configure to
filter for only the devices.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

To confirm ASD and LCM communications using Alarm View
1. In WorkStation, in the System Tree pane, select the NETWORK 8000
network that contains the devices you want to confirm are communicating
with the Building Operation database.
2. On the File menu, point to New and then click View.
3. In the object type list, select Alarm View.

4. In the Name box, type a name for the Alarm View.
5. In the Description box, type a description for the Alarm View.
6. Click Create.
Continued on next page
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7. In the System Tree pane, select the View you just created.

8. Enter NETWORK 8000 System Alarm in the Quick filter box.
9. Right-click the top of a column and then select the columns that you want to
display.
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96.16

Confirming ASD and LCM
Communications Using Event View
You can confirm that ASD and LCM devices are communicating to the Building
Operation database by viewing them in an Event View, which you can configure to
filter for only the devices.
For more information, see section 96.13 “ASD and LCM Device Communication
Confirmation” on page 3811.

To confirm ASD and LCM communications using Event View
1. In WorkStation, in the System Tree pane, select the NETWORK 8000
network that contains the devices you want to confirm are communicating
with the Building Operation database.
2. On the File menu, point to New and then click View.
3. In the object type list, select Event View.

4. In the Name box, enter a name for the Event View.
5. In the Description box, type a description for the Event View.
6. Click Create.
Continued on next page
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7. In the System Tree pane, select the View you just created.

8. Enter NETWORK 8000 Event Record in the Quick filter box.
9. Right-click the top of a column and then select the columns that you want to
display.
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97.1

NETWORK 8000 System Tree Icons
The following table describes the NETWORK 8000 icons in the System Tree pane.
Icon

Description
MTR
Indicates the object is a maintenance time
reminder. For more information, see section
95.18 “ Alarms for NETWORK 8000” on
page 3784.
NETWORK 8000 Interface and LCM
Devicee
Indicates the object is the imported
NETWORK 8000 or Signal database.
NETWORK 8000 Alarm
Indicates the object is a NETWORK 8000
alarm. For more information, see section
95.18 “ Alarms for NETWORK 8000” on
page 3784.
Control
Indicates the object is a NETWORK 8000
control.
Point
Indicates the object is a NETWORK 8000
point.
Device
Indicates the object is a NETWORK 8000
device.
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97.2

NETWORK 8000 ASD Network – List
View
Use the List View for the NETWORK 8000 ASD network to view all the devices on
the network and to determine if the devices are communicating with WorkStation.
Use the Quick filters to customize the view for the ASD network. For example, add
the Object status column to confirm that the devices joined the network after you
migrate the database to Building Operation.
If the ASD devices have been moved to another sub-folder, the ASD Node list can
be generated by doing a search of all object of types, Zone2, Pem1, Flo2, Mn,
MnFlo, MNhpfc, and Lim. The properties displayed should include the Name,
Object Status, Physical address, and Location. For more information, see the
Search Overview topic on WebHelp.

Figure: List View

Table: List View of the ASD Network in WorkStation
Component

Description
Name
Displays the name of the ASD devices on the
network.
Phsical address
Displays the Physical Address as set by the
DIP switches on the ASD devices.
Object status
Displays the status of the device. Normal
indicates that the ASD device is
communicating with the Automation Server
and WorkStation.
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97.3

NETWORK 8000 Interface – Basic Tab
Use the Basic tab to view and edit basic information about the NETWORK 8000
Interface and select the alarm acknowledgement types for all NETWORK 8000
alarms.

Figure: Basic tab

Table: Basic Tab
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Component

Description

NETWORK 8000 network number

Enter the NETWORK 8000 network number.
The NETWORK 8000 network number
migrated from a GCM database is usually
displayed.

GCM number

Enter the NETWORK 8000 GCM network
number. The NETWORK 8000 GCM number
migrated from a GCM database is usually
displayed.

GCM installation name

Enter the NETWORK 8000 GCM installation
number. The NETWORK 8000 GCM
installation name from a GCM database is
usually displayed.

Technical
3837

97 NETWORK 8000 User Interface
97.3 NETWORK 8000 Interface – Basic Tab

Continued

Technical
3838

Component

Description

Type of alarm acknowledgement

Select the acknowledgement type for all
NETWORK 8000 object alarms.
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97.4

NETWORK 8000 Interface – ASD Tab
Use the ASD tab to configure the ASD network and device messages.

Figure: ASD tab

Table: ASD Tab
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Component

Description

Network type

Select the network type and baud rate.

ASD port reference

Enter the communication port reference
assignment for the ASD network. To assign
the ASD network port, set ASD port
reference to
either ~/System/Ports/Serial/RS485COMA or
~/System/Ports/Serial/RS485-COMB.

Leaves network alarm

Select Enabled to have the Automation
Server record the field devices leaving the
network as events and alarms. Select
Disabled to have the Automation Server
report the field devices leaving and joining
the bus only in the event log.
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Technical
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Component

Description

Leaves network alarm presentation

Select the type of alert that occurs with each
leaves network alarm.

Leaves network priority

Enter the priority for all field device leaves
network alarms and events.

Configuration change alarm

Select Enabled to to have the Automation
Server record the field device configuration
changes as events and alarms. Select
Disabled to have the Automation Server
report the device configuration changes only
in the event log.

Configuration alarm presentation

Select the type of alert that occurs with each
configuration change alarm.

Configuration priority

Enter the alarm priority for all field
configuration change alarms and events.

Device reset alarm

Select the type of alert that occurs with each
device reset alarm.

Device reset alarm presentation

Select the type of alert that occurs with each
device reset alarm.

Device reset priority

Enter the alarm priority for all field device
reset alarms and events.

Diagnostic alarm presentation

Select the type of alert that occurs with each
leaves network alarm.

Diagnostic priority

Enter the alarm priority for all diagnostic
alarms and events.
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97.5

NETWORK 8000 Interface – LCM Tab
Use the LCM tab to configure the LCM network and device messages.

Figure: LCM tab
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Component

Description

LCM network

Select Enabled to activate the LCM
network at 19.2 KBAUD.

LCM port reference

Enter the communication port reference
assignment for the ASD network. The LCM
port reference should be set to either
~/System/Ports/Serial/RS485-COMA
or ~/System/Ports/Serial/RS485COMB.

LCM stale data Time

Enter the maximum length of time since the
last update that the current values are
considered to be stale data.
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Technical
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Component

Description

LCM Leaves network alarm

Select Enabled to have the Automation
Server record the LCM devices leaving the
network as events and alarms. Select
Disabled to have the Automation Server
report the field devices leaving and joining
the bus only in the event log.

LCM leaves network alarm
presentation

Select the type of alert that occurs with each
leaves network alarm.

LCM leaves network priority

Enter the priority for all LCM device leaves
network alarms and events.

LCM system diagnostic alarm

Select Enabled to have the Automation
Server record the LCM device configuration
changes as events and alarms. Select
Disabled to have the Automation Server
report the device configuration changes only
in the event log.

LCM system diagnostic alarm
presentation

Select the type of alert that occurs with each
system diagnostic alarm.

LCM system diagnostic priority

Enter the alarm priority for all system
diagnostic alarms and events.

LCM Alarm as alarm

Select Enabled to have the Automation
Server record the LCM block alarms as
events and alarms. Select Disabled to have
the Automation Server report the LCM block
alarms only in the event log.

Alarm block

Select the type of alert that occurs with each
LCM block alarm.

Alarm block priority

Enter the alarm priority for all LCM block
alarms and events.

LCM maintenance time reminder
alarm

Select Enabled to have the Automation
Server record the LCM block maintenance
reminders as events and alarms.
Select Disabled to have the Automation
Server report the LCM block maintenance
reminders only in the event log.

Maintenance time reminder block

Select the type of alert that occurs with each
LCM block maintenance reminder.

Maintenance time reminder block
priority

Enter the alarm priority for LCM block
maintenance reminders alarms and events.

Lcm Configuration Priority

Enter the event priority for LCM system and
block configuration change messages.

Diagnostic priority

Enter the event priority for LCM block
diagnostic messages.
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Component

Description

Override priority

Enter the event priority for override
messages from the LCM.

Access priority

Enter the event priority for NETWORK 8000
access messages from the LCM.
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97.6

Lcm Device – Basic Tab
Use the Basic tab to view and edit basic information about the LCM device.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Lcm number

Enter the physical address of the LCM
device as set by the DIP switches at the
device.

Lcm name

Displays the LCM name. Corresponds to the
INSTALL NAME of the LCM installation data.

DateTime

Displays the current date and time in the
LCM field device.

Network number

Displays the NETWORK 8000 network
number. Corresponds to the NETWORK
NUMBER of LCM the installation data.
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Component

Description

Object status

Displays the status of the device. Normal
indicates that the ASD device is
communicating with the Automation
Server. Learning objects and Learning
properties are used to indicate the status
of the LCM learn process.
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97.7

AI Properties – Basic Tab
Use the Basic tab to view information about the output property values of the AI.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Analog point value

Displays the value of the analog input point.
Corresponds to AV in the GCM AI block.

Diagnostic error

Displays On (true) when communication is
lost between Building Operation and the
GCS. Corresponds to DIAGN in the GCM AI
block.

Object status

Displays the status of the object.
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97.8

AI Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM AI
block.
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Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
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97.9

AI Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the AI.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the AI
executes its algorithm. Corresponds to
UPTIM in the GCM AI block.

GCS address

Enter the address of the GCS. Alternatively,
select Not active to use the AI as a virtual
point.
Writing this parameter causes a reset of the
object.
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Component

Description

Physical address

Enter the physical address of the physical
point. Alternatively, select Virtal to use the
AI as a virtual point. Corresponds to ADDRS
in the GCM AI block.
Writing this parameter causes a reset of the
object.
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Input type

Select Standard for predefined curves.
Select User defined for inputs that are
defined in the object. Corresponds to INTYP
in the GCM AI block.

Curve type

Select the type of scaling curve used for
standard temperature sensors. This property
is active only if the Input type is standard.
Corresponds to CUTYP in the GCM AI
block.

Volts at low value

Enter the low voltage value of the point when
the input is at its Scaled low value. This
property is active only if the Input type is
user-defined. Corresponds to VLVAL in the
GCM AI block.

Scaled low value

Enter the scaled output value for the point
when the input is at its lowest voltage input
as defined by Volts at low value. This
property is active only if the Input type is
user-defined. Corresponds to LOVAL in the
GCM AI block.

Volts at hi value

Enter the high voltage value of the point
when the input is at its Scaled hi value.
This property is active only if the Input type
is user-defined. Corresponds to VHVAL in
the GCM AI block.

Scaled hi value

Enter the scaled output value for the point
when the input is at its highest voltage input
as defined by Volts at hi value. This
property is active only if the Input type is
user-defined. Corresponds to HIVAL in the
GCM AI block.

Supply current

Select the current that is required to allow
the resistant type input device to produce a
voltage. If the voltage is developed from a
different source, select No current. This
property is active only if the Input type is
user-defined. Corresponds to SCUR in the
GCM AI block.

Offset calibration

Enter the value added (+ or -) to offset the
calculated reading of a sensor or input.
Corresponds to OFCAL in the GCM AI
block.
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Component

Description

Output maximum

Enter the maximum value accepted for the
output. Corresponds to OUTMX in the GCM
AI block.

Output minimum

Enter the minimum value accepted for the
output. Corresponds to OUTMN in the GCM
AI block.

Filter mode

Select the Filter mode to average the input
values of sampled changes. Calculations are
based on the Update time. Corresponds to
FILTR in the GCM AI block.
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97.10

Alarm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Alarm.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current alarm state

Displays the alarm condition. Corresponds
to STATE in the GCM ALARM block.

Digital value output

Displays the selected Output action versus
the alarm condition. Corresponds to DV in
the GCM ALARM block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only.
Corresponds to ONDV in the GCM ALARM
block.

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only.
Corresponds to OFFDV in the GCM ALARM
block.
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Component

Description

Object status

Displays the status of the object.
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97.11

Alarm Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the Calculate enable
input. Corresponds to CENAB in the GCM
ALARM block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
Calculate enable from another NETWORK
8000 object.

Analog input value

Displays the value of the Analog input.
Corresponds to AINP in the GCM ALARM
block.

Analog input constant

Enter a value to supply the Alarm with a
constant input.

Analog input reference

Enter a reference to get the value of the
Analog input from another NETWORK 8000
object.

Alarm limit value

Displays the value of the Alarm limit, which
becomes active if the Disable alarm input
has been Off for longer than the Enable
delay time. Corresponds to LIMIT in the
GCM ALARM block.

Alarm limit constant

Enter a value to supply the Alarm with a limit.

Alarm limit reference

Enter a reference to get the value of the
Alarm limit from another NETWORK 8000
object.

Return from alarm value

Displays the value of the Return from alarm.
Corresponds to RETRN in the GCM ALARM
block.

Return from alarm constant

Enter a value to supply the Alarm with a
constant input.

Return from alarm reference

Enter a reference to get the value of the
Return from alarm from another NETWORK
8000 object.

Disable alarm value

Displays the value of the Disable alarm. On
(true) disables the Alarm. Corresponds to
DSABL in the GCM ALARM block.

Disable alarm constant

Select On (true) to stop generating alarms.

Disable alarm reference

Enter a reference to get the value of the
Disable alarm from another NETWORK 8000
object.
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97.12

Alarm Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Alarm.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
Alarm executes its algorithm. Corresponds
to UPTIM in the GCM ALARM block.

Enable delay

Enter the time the Disable alarm input
must be Off before the Alarm begins to
monitor alarm conditions. Corresponds to
ENDLY in the GCM ALARM block.

Alarm delay

Enter the time the Analog input must be in
an alarm condition before the Alarm
generates an alarm condition. Corresponds
to ALDLY in the GCM ALARM block.

Output action

Select the Output value when Alarm is in an
alarm condition. Corresponds to ACT in the
GCM ALARM block.
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Component

Description

Priority

Enter the priority of the Building Operation
alarm.

Category

Enter the alarm category as previously
defined in the Alarm Manager.

Alarm text

Enter a text message that is part of the alarm
message.

Audible alert

Select True to enable an audible
maintenance alert.

Flashing alert

Select True to enable a flashing
maintenance alert.
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97.13

AO Properties – Basic Tab
Use the Basic tab to view information about the output property values of the AO.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab

Technical
3858

Component

Description

Analog point value

Displays the value of the Analog input point.
Corresponds to AV in the GCM AO block.

Override time

Displays the number of minutes before the
override is cleared if the AO’s Analog point
value output is in the override mode.
Corresponds to OVTIM in the GCM AO
block.
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Component

Description

Output cause

Displays which input or default value is being
used in the calculation of the output value.
The output cause does not indicate an
output override condition.
Corresponds to CAUSE in the GCM AO
block.

Diagnostic error

Displays On (true) when communication
between Building Operation and the GCS
has been lost.
Corresponds to DIAGN in the GCM AO
block.

Object status
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Displays the status of the object.
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97.14

AO Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of Calculate enable.
Corresponds to CENAB in the GCM AO
block.
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Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the value of
Calculate enable from another NETWORK
8000 object.

Input priority 1 to Input priority 8 value Displays the input priority. Corresponds to
IPR in the GCM AO block.

04-16006-04-en, March 2015

Input priority 1 to Input priority 8
constant

Enter the Input priority.

Input priority 1 to Input priority 8
reference

Enter a reference to get the Input priority
value from another NETWORK 8000 object.
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97.15

AO Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the AO.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
AO executes its algorithm. Corresponds to
UPTIM in the GCM AO block.

GCS address

Enter the address of the GCS. Alternatively,
select Not active to use the AO as a virtual
point.
Writing this parameter causes a reset of the
object.
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Component

Description

Physical address

Enter the physical address of the physical
point. Alternatively, select Virtal to use the
AO as a virtual point. Corresponds to
ADDRS in the GCM AO block.

Scaled low value

Enter a low input value required for the
output (AV) to equal the Output at low
value. Corresponds to LOVAL in the GCM
AO block.

Output at low value

Enter an output value (AV) when the highest
priority input value equals the Scaled low
value. Corresponds to OUTLV in the GCM
AO block.

Scaled hi value

Enter a high input value required for the
output (AV) to equal the Output at hi
value. Corresponds to HIVAL in the GCM
AO block.

Output at hi value

Enter the output value (AV) when the highest
priority input value equals the Scaled hi
value. Corresponds to OUTHV in the GCM
AO block.

Output maximum

Enter the maximum value accepted for the
output. Corresponds to OUTMX in the GCM
AO block.

Output minimum

Enter the minimum value accepted for the
output. Corresponds to OUTMN in the GCM
AO block.

Default input value

Enter the Default input value to the algorithm
when there are no inputs with active values.
Corresponds to DEFLT in the GCM AO
block.
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97.16

Apt Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Apt.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Analog point value

Displays the current analog value.
Corresponds to AV in the GCM APT block.

Override time

Displays the amount of time remaining if the
Analog point value output is forced.
Corresponds to OVTIM in the GCM APT
block.

Object status

Displays the status of the object.
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97.17

Apt Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Analog global value

Displays the value of the Analog global
reference.

Analog global reference

Enter a reference to get the analog value
from another object that is not a NETWORK
8000 object.
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Technical
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Component

Description

Calculate enable value

Displays the value of the Calculate enable
input. Corresponds to CENAB in the GCM
APT block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the value of
Calculate enable from another NETWORK
8000 object.

Analog input value

Displays the value of the Analog input. The
Analog point value remains at this input
value if the Analog global reference is
inactive. Corresponds to AINP in the GCM
APT block.

Analog input constant

Enter a value to supply the Apt with a
constant input.

Analog input reference

Enter a reference to get the value of the
Analog input from another NETWORK 8000
object.

Default analog value

Displays the value of the Default analog
input. The Analog point value remains at
this input value if both the Analog global
reference and the Analog input are
inactive. Corresponds to DFTAV in the GCM
APT block.

Default analog constant

Enter the Default analog input value.

Default analog reference

Enter a reference to get the Default analog
value from another NETWORK 8000 object.
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97.18

Apt Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Apt.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Apt executes its algorithm. Corresponds to
UPTIM in the GCM APT block.

Delay time

Enter the delay time that the Analog point
value will wait before using a lower priority
input when a high priority input is Null or
Abnormal. If the Analog global
reference is not valid, the Analog input
value is used. If the Analog input value is
not valid, the Default analog value is
used. Corresponds to DELAY in the GCM
APT block.
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97.19

Btuh Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Btuh.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current Analog value.
Corresponds to AV in the GCM BTUH block.

Object status

Displays the status of the object.
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97.20

Btuh Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
BTUH block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Input temperature value

Displays the value of input temperature of
the measured system. Corresponds to
INTEM in the GCM BTUH block.

Input temperature constant

Enter a value to supply a constant input
temperature to the Btuh.

Input temperature reference

Enter a reference to get the input
temperature from another NETWORK 8000
object.

Output temperature value

Displays the value of the output temperature
of the measured system. Corresponds to
OUTEM in the GCM BTUH block.

Output temperature constant

Enter a value to supply a constant output
temperature to the Btuh.

Output temperature reference

Enter a reference to get the output
temperature from another NETWORK 8000
object.

Input flow rate value

Displays the flow rate in cubic feet per
minute (ft3/min) if air, or gallons per minute
(g/min) if water. Corresponds to INFLO in the
GCM BTUH block.

Input flow rate constant

Enter a value to supply a constant input flow
rate to the Btuh.

Input flow rate reference

Enter a reference to get the input flow rate
from another NETWORK 8000 object.
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97.21

Btuh Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Btuh.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Btuh executes its algorithm. Corresponds to
UPTIM in the GCM BTUH block.

Constant

Enter a constant scale value determined by
specific heat x fluid density x 60.
Corresponds to SCALE in the GCM BTUH
block.
Writing this parameter causes a reset of the
object.
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97.22

Cos Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Cos.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current alarm state

Displays the alarm condition. Corresponds
to STATE in the GCM COS block.

Digital value output

Displays the selected Output action versus
the alarm condition. Corresponds to DV in
the GCM COS block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only. This
output is based on the selected Output
action. Corresponds to ONDV in the GCM
COS block.

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only. This
output is based on the selected Output
action. Corresponds to OFFDV in the GCM
COS block.
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Component

Description

Object status

Displays the status of the object.
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97.23

Cos Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
COS block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Digital input value

Displays the value of the digital input. The
Digital point value remains at this input
value if the Digital global reference is
inactive. Corresponds to DINP in the GCM
COS block.

Digital input constant

Enter a value to supply the Cos with a
constant digital input.

Digital input reference

Enter a reference to get the digital input from
another NETWORK 8000 object.

Normal state value

Displays the value of the Normal state.
Corresponds to NORM in the GCM COS
block.

Normal state constant

Select Off (false) to hold outputs at their
last calculated input value.

Normal state reference

Enter a reference to get the normal state
from another NETWORK 8000 object.

Disable alarm value

Displays On (true) if the Alarm is disabled.
Corresponds to DSABL in the GCM COS
block.

Disable alarm constant

Select Off (false) to hold outputs at their
last calculated input value.

Disable alarm reference

Enter a reference to get the disable alarm
from another NETWORK 8000 object.
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97.24

Cos Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Cos.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
Cos executes its algorithm. Corresponds to
UPTIM in the GCM COS block.

Enable delay

Enter the time the Disable alarm input
must be Off before the Cos begins to
monitor alarm conditions. Corresponds to
ENDLY in the GCM COS block.

Alarm delay

Enter the time the Digital input must be in
an alarm condition before the Alarm
generates an alarm condition. Corresponds
to ALDLY in the GCM COS block.

Output action

Select the Output action of Digital value
output when Cos is in an alarm
condition. Corresponds to ACT in the GCM
COS block.
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Component

Description

Priority

Enter the priority of the Building Operation
alarm.

Category

Enter the alarm category as previously
defined in the Alarm Manager.

Alarm Text

Enter a text message that is part of the alarm
message.

Audible Alert

Select True to enable an audible
maintenance alert.

Flashing Alert

Select True to enable a flashing
maintenance alert.
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97.25

Curve Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Curve.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog value.
Corresponds to AV in the GCM CURVE
block.

Object status

Displays the status of the object.
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97.26

Curve Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
CURVE block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Analog input value

Displays the value of the analog input.
Corresponds to AINP in the GCM CURVE
block.

Analog input constant

Enter a value to supply a constant analog
input to the Curve.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.27

Curve Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Curve.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Curve executes its algorithm. Corresponds
to UPTIM in the GCM CURVE block.

Output maximum

Enter the maximum output value allowed for
the Curve. Corresponds to OUTMX in the
GCM CURVE block.

Output minimum

Enter the minimum output value allowed for
the Curve. Corresponds to OUTMN in the
GCM CURVE block.

A coefficient

Enter the A coefficient value. Corresponds to
ACOE in the GCM CURVE block.

B coefficient

Enter the B coefficient value. Corresponds to
BCOE in the GCM CURVE block.
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Component

Description

C coefficient

Enter the C coefficient value. Corresponds to
CCOE in the GCM CURVE block.

D coefficient

Enter the D coefficient value.Corresponds to
DCOE in the GCM CURVE block.

E coefficient

Enter the E coefficient value. Corresponds to
ECOE in the GCM CURVE block.

F coefficient

Enter the F coefficient value. Corresponds to
FCOE in the GCM CURVE block.
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97.28

DccComp Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
DccComp.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays the value of the digital
output. Corresponds to DV in the GCM DCC
block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only. This
output is based on the selected Output
action. Corresponds to ONDV in the GCM
DCC block.

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only. This
output is based on the selected Output
action. Corresponds to OFFDV in the GCM
DCC block.

Object status

Displays the status of the object.
Technical
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97.29

DccComp Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
DCC block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get calculate enable
from another NETWORK 8000 object.

Input enable value

Displays the value of input enable.
Corresponds to ENABL in the GCM DCC
block.

Input enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Input enable value reference

Enter a reference to get the input enable
from another NETWORK 8000 object.

Compensation input value

Displays the value of compensation input.
Corresponds to COINP in the GCM DCC
block.

Compensation input constant

Enter a value to supply the DccComp with a
constant compensation input.

Compensation input reference

Enter a reference to get the compensation
enable from another NETWORK 8000
object.

Value at min duty value

Displays the minimum duty value.
Corresponds to MNDTY in the GCM DCC
block.

Value at min duty constant

Enter a value to supply the DccComp with a
constant value at minimum duty.

Value at min duty reference

Enter a reference to get the value at
minimum duty from another NETWORK
8000 object.

Value at max duty value

Displays the maximum duty value.
Corresponds to MXDTY in the GCM DCC
block.

Value at max duty constant

Enter a value to supply the DccComp with a
constant maximum duty.

Value at max duty reference

Enter a reference to get the value at
maximum duty from another NETWORK
8000 object.
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97.30

DccComp Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the DccComp.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
DccComp executes its algorithm.
Corresponds to UPTIM in the GCM DCC
block.

Minimum on time

Enter the minimum time during each period
that output is in the On (true) condition.
Corresponds to MNON in the GCM DCC
block.

Period

Enter the total time for an on time plus off
time cycle. Corresponds to PERIN in the
GCM DCC block.
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97.31

DccFix Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
DccFix.

Figure: Basic tab

Table: Basic Tab
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Componet

Description

Digital value output

Displays the value of the Digital
output. Corresponds to DV in the GCM DCC
block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only. This
output is based on the selected Output
action. Corresponds to ONDV in the GCM
DCC block.

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only. This
output is based on the selected Output
action. Corresponds to OFFDV in the GCM
DCC block.

Object status

Displays the status of the object.
Technical
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97.32

DccFix Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
DCC block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Input enable value

Displays the value of input enable.
Corresponds to ENABL in the GCM DCC
block.

Input enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Input enable reference

Enter a reference to get the input enable
from another NETWORK 8000 object.
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97.33

DccFix Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the DccFix.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
DccFix executes its algorithm. Corresponds
to UPTIM in the GCM DCC block.

Minimum on time

Enter the minimum time during each period
that output is in the On (true) condition.
Corresponds to MNON in the GCM DCC
block.

Period

Enter the total time for an on time plus off
time cycle. Corresponds to PERIN in the
GCM DCC block.
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97.34

DegDa Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
DegDa.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Heat degree day

Displays the total heating degrees for the
past day. The value, forced or not forced, is
maintained through a warm reset.
Corresponds to HDEDA in the GCM DEGDA
block.

Cool degree day

Displays the total cooling degrees for the
past day. The value, forced or not forced, is
maintained through a warm reset.
Corresponds to CDEDA in the GCM DEGDA
block.

Heat total deg day

Displays the total heating degree days since
the DegDa was initialized. The value, forced
or not forced, is maintained through a warm
reset. Corresponds to THDDA in the GCM
DEGDA block.
Technical
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Component

Description

Cool total deg day

Displays the total cooling degree days since
the object was initialized. The value, forced
or not forced, is maintained through a warm
reset. Corresponds to TCDDA in the GCM
DEGDA block.

Maximum oat

Displays the highest outdoor air temperature
detected during the last 24 hours (midnight
to midnight). The value, forced or not forced,
is maintained through a warm reset.
Corresponds to MXOAT in the GCM DEGDA
block.

Time at maximum

Displays the time that Maximum oat was at
its highest recorded value during the last 24
hours (midnight to midnight). This output is
maintained through a warm reset.
Corresponds to TIMX in the GCM DEGDA
block.

Minimum oat

Displays the lowest outdoor air temperature
detected during the last 24 hours (midnight
to midnight) to be used by the heating
degree day calculations. The value, forced or
not forced, is maintained through a warm
reset. Corresponds to MNOAT in the GCM
DEGDA block.

Time at minimum

Displays the time that Minimum oat was at
its lowest recorded value during the last 24
hours (midnight to midnight). This output is
maintained through a warm reset.
Corresponds to TIMN in the GCM DEGDA
block.

Start time

Displays the time when the object was last
reset or restarted. This output is maintained
through a warm reset. Corresponds to
STTIM in the GCM DEGDA block.

Object status

Displays the status of the object.
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97.35

DegDa Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

04-16006-04-en, March 2015

Component

Description

Calculate enable value

Displays the value of the Calculate enable
input. Corresponds to CENAB in the GCM
DEGDA block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
Calculate enable from another NETWORK
8000 object.

Initialize total value

Displays the value of the Initalize total input.
Corresponds to INIT in the GCM DEGDA
block.

Initialize total constant

Select On (true) to restart calculations of
the Heat total deg day and Cool total
deg day outputs.

Initialize total reference

Enter a reference to get the value of Initialize
total from another NETWORK 8000 object.

Outside air temp value

Displays the value of the Outside air temp
input. Corresponds to OATMP in the GCM
DEGDA block.

Outside air temp constant

Enter a value to supply the DegDa with a
constant input.

Outside air temp reference

Enter a reference to get the value of Outside
air temp from another NETWORK 8000
object.
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97.36

DegDa Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the DegDa.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
DccComp executes its algorithm.
Corresponds to UPTIM in the GCM DEGDA
block.

No heat temperature

Enter the value that no heating degree
calculations are made when the Outside
air temp input value is above this value.
Corresponds to NOHET in the GCM DEGDA
block.
Writing this parameter causes a reset of the
object.
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No cool temperature

Enter the value that no cooling degree
calculations are made when the Outside
air temp input value is below this value.
Corresponds to NOCOL in the GCM DEGDA
block.
Writing this parameter causes a reset of the
object.

Calculation interval

Select the required calculation interval used
for degree day calculations. Corresponds to
INTVL in the GCM DEGDA block.
Writing this parameter causes a reset of the
object.
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97.37

Delay Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Delay.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Pulse output

Displays the pulse output, which has an On
(true) value for a period equal to the Delay
time starting when the Digital input value
changes from Off (false) to On (true).
Corresponds to PULSE in the GCM DELAY
block.

Delay output

Displays the delayed output. The Delay
output follows the Digital input value but
is delayed by a period equal to Delay time.
Corresponds to DV in the GCM DELAY
block.

Remaining time

Displays the delay time remaining after the
start of the the delay. Corresponds to
RMTIM in the GCM DELAY block.
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Component

Description

Object status

Displays the status of the object.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.38 Delay Properties – Inputs Tab

97.38

Delay Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

04-16006-04-en, March 2015

Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
DELAY block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Digital input value

Displays the digital input value. Corresponds
to DINP in the GCM DELAY block.

Digital input constant

Enter a value to supply the Delay with a
constant input. Use for testing only.

Digital input reference

Enter a reference to get the digital input from
another NETWORK 8000 object.
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97.39

Delay Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Delay.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
DccComp executes its algorithm.
Corresponds to UPTIM in the GCM DELAY
block.

Delay time

Enter the time for the needed delay for the
Delay mode. Corresponds to DELAY in the
GCM DELAY block.

Delay mode

Select the Off delay to disable the Delay.
Corresponds to MODE in the GCM DELAY
block.
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97.40

DI Properties – Basic Tab
Use the Basic tab to view information about the output property values of the DI.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital point value

Displays the value of the Digital input
point. The value, either forced or not forced,
is maintained through a warm reset.
Corresponds to DV in the GCM DI block.

On value only

Displays On (true) when the Digital point
value is active. The value, either forced or
not forced, is maintained through a warm
reset. Corresponds to ONDV in the GCM DI
block.
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Off value only

Displays Off (false) when the Digital point
value is active. The value, either forced or
not forced, is maintained through a warm
reset. Corresponds to OFFDV in the GCM DI
block.

Diagnostic error

Displays On (true) when there is a loss of
communication between Building Operation
and the GCS. The Digital point value
displays Not active (Null) and the Object
status indicates Abnormal no
communication.
Corresponds to DIAGN in the GCM DI block.

Elapsed on time

Displays the time that the Digital point
value output is calculated to be On (true).
When the DI is reset (cold reset), this
accumulated value is reset to 0. However,
this value is maintained through a warm
reset. Corresponds to ONTIM in the GCM DI
block.
This output can be written to an assigned
value, from which the counter continues
totaling. A override time of 500,000 indicates
the override is on forever.
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Change timestamp

Displays the time of the last change of state.
When DI is reset (cold reset), this value is set
to the current time and date. However, this
timestamp is maintained through a warm
reset. Corresponds to CHTIM in the GCM DI
block.

Number of changes

Displays the number of Off (false) to On
(true) transitions. When the DI is reset (cold
reset), this accumulated value is zeroed. This
output can be written to an assigned value
and the counter starts totalizing from this
value. Corresponds to NCHGS in the GCM
DI block.

Object status

Displays the status of the object.
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97.41

DI Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the Calculate enable
input. Corresponds to CENAB in the GCM
DI block.
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Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the value of
Calculate enable from another NETWORK
8000 object.
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97.42

DI Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the DI.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
DccComp executes its algorithm.
Corresponds to UPTIM in the GCM DI block.

GCS address

Enter the address of the GCS. Alternatively,
select Not active to use the DI as a virtual
point.
Writing this parameter causes a reset of the
object.
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Continued
Component

Description

Physical address

Enter the physical address of the physical
point. Alternatively, select Virtal to use the
DI as a virtual point. Corresponds to ADDRS
in the GCM DI block.
Writing this parameter causes a reset of the
object.

Input action
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Select the action of the input point.
Corresponds to INACT in the GCM DI block.
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97.43

DO Properties – Basic Tab
Use the Basic tab to view information about the output property values of the DO.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab
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Name

Abbreviation and Description

Digital point value

Displays the value of the Digital input
point. The value, either forced or not forced,
is maintained through a warm reset.
Corresponds to DV in the GCM DO block.

Override time

Displays the number of minutes before the
override is cleared if the AO’s Analog point
value output is in the override mode.
Corresponds to OVTIM in the GCM DO
block.
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Name

Abbreviation and Description

Output cause

Displays which input or default value is being
used in the calculation of the output value.
The output cause does not indicate an
output override condition.

Diagnostic error

Displays On (true) when there is a loss of
communication between Building Operation
and the GCS. The Digital point value
displays Not active (Null) and the Object
status indicates Abnormal no
communication.

Elapsed on time

Displays the time that the Digital point
value output is calculated to be On (true).
When the DO is reset (cold reset), this
accumulated value is reset to 0. However,
this value is maintained through a warm
reset. Corresponds to ONTIM in the GCM
DO block.
This output can be written to an assigned
value, from which the counter continues
totaling. A override time of 500,000 indicates
the override is on forever.
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Change timestamp

Displays the timestamp of the last change of
state. When DI is reset (cold reset), this value
is set to the current time and date. However,
this timestamp is maintained through a warm
reset. Corresponds to CHTIM in the GCM
DO block.

Number of changes

Displays the number of Off (false) to On
(true) transitions. When the DO is reset
(cold reset), this accumulated value is
zeroed. This output can be written to an
assigned value and the counter starts
totalizing from this value. Corresponds to
NCHGS in the GCM DO block.

Object status

Displays the status of the object.
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97.44

DO Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
DO block.
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Continued
Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Force output value

Displays the force output value input.
Corresponds to FOVAL in the GCM DO
block.

Force output constant

Select either On (true) or Off (false) as the
value to force the output with Force enable
value.

Force output reference

Enter a reference to get the force output
from another NETWORK 8000 object.

Force enable value

Displays the force enable input.
Corresponds to FOENA in the GCM DO
block.

Force enable constant

Select On (true) to force the output to the
value of Force output value.

Force enable refernce

Enter a reference to get the force enable
from another NETWORK 8000 object.

Input priority 1 to Input priority 8 value Displays the input priority 1 to input priority 8
input. Corresponds to IPR1 to IPR8 in the
GCM DO block.
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Input priority 1 to Input priority 8
constant

Select either On (true) or Off (false) to
hold an input at this value.

Input priority 1 to Input priority 8
reference

Enter a reference to get the input priority 1 to
input priority 8 from another NETWORK
8000 object.
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97.45

DO Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the DO.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
DccComp executes its algorithm.
Corresponds to UPTIM in the GCM DO
block.

GCS address

Enter the address of the GCS. Alternatively,
select Not active to use the DO as a virtual
point.
Writing this parameter causes a reset of the
object.
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Continued
Component

Description

Physical address

Enter the physical address of the physical
point. Alternatively, select Virtal to use the
DO as a virtual point. Corresponds to
ADDRS in the GCM DO block.
Writing this parameter causes a reset of the
object.

04-16006-04-en, March 2015

Action

Select the relay activation state.
Corresponds to ACT in the GCM DO block.

Minimum on time

Enter the amount of time that the output’s
current value must be must be On (true)
before being allowed to turn Off (false).
Corresponds to MNON in the GCM DO
block.

Minimum off time

Enter the amount of time that the output’s
current value must be Off (false) before
being allowed to turn On (true).
Corresponds to MNOFF in the GCM DO
block.

Default input value

Select the input value used by the object’s
algorithm when all the inputs are Not active
(Null). Corresponds to DEFLT in the GCM
DO block.
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97.46

Dpt Properties – Basic Tab
Use the Basic tab to view information about the Dpt output property values.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Digital point value

Displays the current Digital value.
Corresponds to DV in the GCM DPT block.

Override time

Displays the amount of time remaining if the
Digital point value output is forced.
Corresponds to OVTIM in the GCM DPT
block.

On value only

Displays the same output as the Digital
point value output, except On (true) is the
only active state. The output and forcible
values are maintained through a warm reset.
Corresponds to ONDV in the GCM DPT
block.
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Component

Description

Off value only

Displays the same output as the Digital
point value output, except Off (false) is the
only active state. The output and forcible
values are maintained through a warm reset.
Corresponds to OFFDV in the GCM DPT
block.

Object status

Displays the status of the object.
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97.47

Dpt Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Digital global value

Displays the digital global reference value.

Digital global reference

Enter a reference to get the digital value from
another object that is not a NETWORK 8000
object.
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
DPT block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Digital input value

Displays the value of the digital input. The
Digital point value remains at this input
value if the Digital global reference is
inactive. Corresponds to DINP in the GCM
DPT block.

Digital input constant

Enter a value to supply the Dpt with a
constant digital input.

Digital input reference

Enter a reference to get the value of the
digital input from another NETWORK 8000
object.

Default digital input value

Displays the value of the default digital input.
The Digital point value remains at this
input value if both the Digital global
reference and the Digital input are
inactive. Corresponds to DFTDV in the GCM
DPT block.

Default digital input constant

Enter the a value to supply a constant default
digital input.

Default digital input reference

Enter a reference to get the default digital
value from another NETWORK 8000 object.
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97.48

Dpt Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Dpt.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
Dpt executes its algorithm. Corresponds to
UPTIM in the GCM DPT block.

Delay time

Enter the delay time that the Digital point
value will wait before using a lower priority
input when a high priority input is Null or
Abnormal. If the Digital global
reference is not valid, the Digital input
value is used. If the Digital input value is
not valid, the Default digital value is used.
Corresponds to DELAY in the GCM DPT
block.
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97.49

EDL Properties – Basic Tab
Use the Basic tab to view information about the output property values of the EDL.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Demand

Displays the current power rate calculated
from the Watt meter or Pulse count
inputs. Corresponds to PULSE in the GCM
EDL block.

Demand setpoint

Displays the current demand setpoint.
Corresponds to DMDSP in the GCM EDL
block.

Peak demand

Displays the current peak demand during
the given demand interval for the current
shift. This property is reset at the change of
shifts unless the Number of shifts is 1.
Then it is reset at the Start time shift.
Corresponds to PKDMD in the GCM EDL
block.
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Component

Description

Peak demand time

Displays the timestamp for when the Peak
demand occurred. Corresponds to PKTIM
in the GCM EDL block.

Setpoint 1

Displays the current setpoint for shift 1. If this
is the active shift, the Demand setpoint
value equals this value. Corresponds to SP1
in the GCM EDL block.

Setpoint 2

Displays the current setpoint for shift 2. This
is active if the Number of Shifts is greater
than 1 and then the Demand setpoint
value equals this value. Corresponds to SP2
in the GCM EDL block.

Setpoint 3

Displays the current setpoint for shift 3. This
is active if the Number of Shifts is greater
than 2 and then the Demand setpoint
value equals this value. Corresponds to SP3
in the GCM EDL block.

Setpoint 4

Displays the current setpoint for shift 4. This
is active if the Number of Shifts is greater
than 3 and then the Demand setpoint
value equals this value. Corresponds to SP4
in the GCM EDL block.

Number of loads shed

Displays the number of loads that are
currently being shed. Corresponds to SHED
in the GCM EDL block.

All loads shed

Displays On (true) when the Number of
loads shed equals the Number of loads.
Corresponds to ALLSD in the GCM EDL
block.

Total:00

Displays the kWh amount used between 0
and 15 minutes after the hour. Corresponds
to TOT00 in the GCM EDL block.

Total:15

Displays the kWh amount used from 15 to
29 minutes past the hour if Demand
interval is 5 or 15 minutes. Corresponds to
TOT15 in the GCM EDL block.

Total:30

Displays the kWh amount used from 30 to
44 minutes past the hour if Demand
interval is 30 minutes. Corresponds to
TOT30 in the GCM EDL block.

Total:45

Displays the kWh amount used from 45 to
59 minutes past the hour if Demand
interval is 60 minutes. Corresponds to
TOT45 in the GCM EDL block.
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Component

Description

Sample output

Displays On (true) just after the hour for at
least 5 minutes. During this time, the
totalization output values are frozen.
Corresponds to SAMPL in the GCM EDL
block.

Object status

Displays the status of the object.
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97.50

EDL Properties – Priority Slots Tab
Use the Priority Slots tab to view information about the priority output values of
the EDL.

Figure: Priority Slots tab

Table: Priority Slots Tab
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Component

Description

Priority slot 1

Displays the value of Priority slot 1. To shed
a load, this output must be Off (false).
Corresponds to PSL1 in the GCM EDL
block.

Priority slot 2 through 64

Displays the value of the Priority slot. The
property exists if Loads is greater than one
number less than the slot number. To shed a
load, this output must be Off (false).
Corresponds to PSL1 through PSL64 in the
GCM EDL block.
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97.51

EDL Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the Calculate enable
input. Corresponds to CENAB in the GCM
EDL block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
Calculate enable from another NETWORK
8000 object.

Shed enable value

Displays the load shed enable value.
Corresponds to SHENA in the GCM EDL
block.

Shed enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Shed enable reference

Enter a reference to get the value of Shed
enable from another NETWORK 8000
object.

Watt meter value

Displays the wattage value when Meter
select selects Watt meter. Corresponds
to WAMET in the GCM EDL block.

Watt meter constant

Enter a value to supply the EDL with a
constant wattage input.

Watt meter reference

Enter a reference to get the watt meter value
(wattage) from another NETWORK 8000
object.

Pulse rate value

Displays the pulse rate value when Meter
select selects Watt meter. Corresponds
to PLRAT in the GCM EDL block.

Pulse rate constant

Enter a value to supply the EDL with a
constant input.

Pulse rate reference

Enter a reference to get the meter pulse rate
from another NETWORK 8000 object.

Pulse count value

Displays the pulse count value when Meter
select selects Pulse meter. Corresponds
to PLCOU in the GCM EDL block.

Pulse count constant

Enter a value to supply the EDL with a
constant input.

Pulse count reference

Enter a reference to get the pulse meter
count from a NETWORK 8000 object, such
as Pulse.

Initialize setpoints value

Displays the value of Initialize setpoints.
Corresponds to INISP in the GCM EDL
block.

Initialize setpoints constant

Select On (true) to reset shift setpoints,
Setpoint 1 to Setpoint 4, to the Reset
setpoint (x) values.

Initialize setpoints reference

Enter a reference to get the value of Initialize
shift setpoints from another NETWORK
8000 object.
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Component

Description

Reset setpoint 1 value

Displays the starting setpoint value for the
first shift. Corresponds to RSP1 in the GCM
EDL block.

Reset setpoint 1 constant

Enter a value to supply the EDL with a
constant input.

Reset setpoint 1 reference

Enter a reference to get the value of Reset
setpoint 1 from another NETWORK 8000
object.

Reset setpoint 2 value

Displays the starting setpoint value for the
second shift and is active if the Number of
shifts is greater than 1. Corresponds to
RSP2 in the GCM EDL block.

Reset setpoint 2 constant

Enter a value to supply the EDL with a
constant input.

Reset setpoint 2 reference

Enter a reference to get the value of Reset
setpoint 2 from another NETWORK 8000
object.

Reset setpoint 3 value

Displays the starting setpoint value for the
second shift and is active if the Number of
shifts is greater than 2. On a reset or
Initialize setpoints command, the
demand setpoint for this shift is reset to this
value. Corresponds to RSP3 in the GCM
EDL block.

Reset setpoint 3 constant

Enter a value to supply the EDL with a
constant input.

Reset setpoint 3 reference

Enter a reference to get the value of Reset
setpoint 3 from another NETWORK 8000
object.

Reset setpoint 4 value

Displays the starting setpoint value for the
second shift and is active if the Number of
shifts is greater than 3. Corresponds to
RSP4 in the GCM EDL block.

Reset setpoint 4 constant

Enter a value to supply the EDL with a
constant input.

Reset setpoint 4 reference

Enter a reference to get the value of Reset
setpoint 4 from another NETWORK 8000
object.
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97.52

EDL Properties – Load Status Inputs
Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
Because this object has 64 Load status properties, the properties are divided
between two tabs. This tab applies to Load status 1 through 32.

Figure: Load Status Inputs tab
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Component

Description

Load Status 1 value to Load Status 32
value

Displays the feedback status for loads 1 to
32. Load status 2 to Load status 32
exists when Loads is greater than 1.
Corresponds to LD1 to LD32 in the GCM
EDL block.

Load Status 1 constant to Load Status
32 constant

Select On (true) to hold the feedback status
at a constant value.

Load Status 1 reference to Load
Status 32 reference

Enter a reference to get the value of Load
status 1 to Load status 32 from another
NETWORK 8000 object.
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EDL Properties – Load Status Inputs 2
Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
Because this object has 64 Load status properties, the properties are divided
between two tabs. This tab applies to Load status 33 through 64.

Figure: Load Status Inputs 2 tab
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Component

Description

Load Status 33 value to Load Status
64 value

Displays the feedback status for loads 33 to
64. Load status 33 to Load status 64
exist when Loads is greater than 32.
Corresponds to LD33 to LD64 in the GCM
EDL block.

Load Status 33 constant to Load
Status 64 constant

Select On (true) or Off (false) to hold the
feedback status at a constant value.

Load Status 33 reference to Load
Status 64 reference

Enter a reference to get the value of Load
status 33 to Load status 64 from another
NETWORK 8000 object.
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97.54

EDL Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the EDL.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
EDL executes its algorithm. Corresponds to
UPTIM in the GCM EDL block.
Writing this parameter causes a reset of the
object.

Linear rotate select

Select the type of shed and restore
sequence of operation. Corresponds to
MODE in the GCM EDL block.
Writing this parameter causes a reset of the
object.
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Component

Description

Load rotate time

Enter the Load rotate time for the outputs to
remain in a fixed shed pattern before the
outputs are reconfigured (shifted) to the next
load shed configuration. This property is
active if Linear rotate select selects
Rotate. Corresponds to ROTIM in the GCM
EDL block.

Interstage delay

Enter the delay for the EDL to wait before
shedding or restoring the next load.
Corresponds to DELAY in the GCM EDL
block.

Meter select

Select the type of power meter that is being
monitored. Corresponds to MTSEL in the
GCM EDL block.
Writing this parameter causes a reset of the
object.

Pulse power constant

Enter the constant value for each change of
state of the power company’s meter relay.
This property is active if the Meter select is
Pulse meter. Corresponds to PWCON in
the GCM EDL block.

Number of shifts

Enter the number of blocks of time the day is
to be split. Corresponds to SHFTS in the
GCM EDL block.
Writing this parameter causes a reset of the
object.
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Start time shift 1 hour

Enter the hour the first shift starts. The start
time includes Start time shift 1 minutes.
Corresponds to STS1 in the GCM EDL
block.

Start time shift 1 minutes

Select the minutes past the hour the first
shift starts.

Start time shift 2 hour

Enter the hour the second shift starts. The
start time includes Start time shift 2
minutes and is active if the Number of
shifts is greater than 1. Corresponds to
STS2 in the GCM EDL block.

Start time shift 2 minutes

Select the minutes past the hour the second
shift starts. This is active if the Number of
shifts is greater than 1.

Start time shift 3 hour

Enter the hour the third shift starts. The start
time includes Start time shift 3 minutes
and is active if the Number of shifts is
greater than 2. Corresponds to STS3 in the
GCM EDL block.
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Component

Description

Start time shift 3 minutes

Select the minutes past the hour the third
shift starts. This is active if the Number of
shifts is greater than 2.

Start time shift 4 hour

Enter the hour the fourth shift starts. The
start time includes Start time shift 4
minutes and is active if the Number of
shifts is greater than 3. Corresponds to
STS4 in the GCM EDL block.

Start time shift 4 minutes

Select the minutes past the hour the fourth
shift starts. This is active if the Number of
shifts is greater than 3.

Maximum setpoint 1

Enter the upper limit of the floating setpoint
for shift number 1. Corresponds to MXSP1
in the GCM EDL block.

Maximum setpoint 2

Enter the upper limit of the floating setpoint
for shift number 2. This is active if the
Number of shifts is greater than
1. Corresponds to MXSP2 in the GCM EDL
block.

Maximum setpoint 3

Enter the upper limit of the floating setpoint
for shift number 3. This is active if the
Number of shifts is greater than
2. Corresponds to MXSP3 in the GCM EDL
block.

Maximum setpoint 4

Enter the upper limit of the floating setpoint
for shift number 4. This is active if the
Number of shifts is greater than
3. Corresponds to MXSP4 in the GCM EDL
block.

Demand interval

Select the size of the sliding window, over
which the Peak demand is calculated. It is
usually set to the power company’s demand
interval. Corresponds to DEINT in the GCM
EDL block.
Writing this parameter causes a reset of the
object.
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Sliding window

Enter the size of the sliding window, over
which the current Demand is calculated. If
shedding or restoring occurs, it is based on
this Demand value. Corresponds to SLWIN
in the GCM EDL block.

Deadband

Enter the size, in kW consumption, the
largest load to be shed in the list of priority
slots. Corresponds to DB in the GCM EDL
block.
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Number of loads

Enter the number of loads that may be shed
by this EDL. Corresponds to LOADS in the
GCM EDL block.
Writing this parameter causes a reset of the
object.

04-16006-04-en, March 2015

Technical
3933

97 NETWORK 8000 User Interface
97.55 EnthlDew Properties – Basic Tab

97.55

EnthlDew Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
EnthlDew.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Enthalpy value

Displays the value of the enthalpy input
point. Corresponds to AV in the GCM
ENTHL block.

Wet bulb temperature

Displays the calculated wet bulb
temperature. Corresponds to WBULB in the
GCM ENTHL block.

Dewpoint temp

Displays the dewpoint temperature.
Corresponds to DEWPT in the GCM ENTHL
block.

Object Status

Displays the status of the object.
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EnthlDew Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
ENTHL block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Dry bulb temp value

Displays the value of the dry bulb
temperature input. Corresponds to DBULB
in the GCM ENTHL block.

Dry bulb temp constant

Enter a value to supply a constant dry bulb
temperature.

Dry bulb temp reference

Enter a reference to get the value of dry bulb
temperature from another NETWORK 8000
object.

Dewpoint input value

Displays the value of the dewpoint input.
Corresponds to DEWIN in the GCM ENTHL
block.

Dewpoint input constant

Enter a value to supply a constant dewpoint
temperature.

Dewpoint input reference

Enter a reference to get the value of
dewpoint from another NETWORK 8000
object.

Barometric press English value

Displays the value of the English barometric
pressure input. This input is active if the
engineering units for Dry bulb temp value
is °F. Corresponds to BPRIN in the GCM
ENTHL block.

Barometric press English constant

Enter a value to supply the EnthlDew with a
constant English barometric presure input.

Barometric press English reference

Enter a reference to get the value of English
barometric pressure from another
NETWORK 8000 object.

Barometric press Metric value

Displays the value of the metric barometric
pressure input. This input is active if the
engineering units for Dry bulb temp value
is °C. Corresponds to BPRMM in the GCM
ENTHL block.

Barometric press Metric constant

Enter a value to supply the EnthlDew with a
constant metric barometric pressure input.

Barometric press Metric reference

Enter a reference to get the value of metric
barometric pressure from another
NETWORK 8000 object.
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97.57

EnthlDew Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the EnthlDew.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
EnthlDew executes its algorithm.
Corresponds to UPTIM in the GCM ENTHL
block.
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97.58

EnthlRh Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
EnthlRh.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Enthalpy value

Displays the value of the enthalpy input
point. Corresponds to AV in the GCM
ENTHL block.

Wet bulb temperature

Displays the calculated wet bulb
temperature. Corresponds to WBULB in the
GCM ENTHL block.

Dewpoint temp

Displays the dewpoint temperature.
Corresponds to DEWPT in the GCM ENTHL
block.

Object Status

Displays the status of the object.
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97.59

EnthlRh Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
ENTHL block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Dry bulb temp value

Displays the value of the dry bulb
temperature input. Corresponds to DBULB
in the GCM ENTHL block.

Dry bulb temp constant

Enter a value to supply a constant dry bulb
temperature.

Dry bulb temp reference

Enter a reference to get the value of dry bulb
temperature from another NETWORK 8000
object.

Relative humidity value

Displays the value of the relative humidity
input. Corresponds to RH in the GCM
ENTHL block.

Relative humidity constant

Enter a value to supply the EnthlRH with a
constant relative humidity input.

Relative humidity reference

Enter a reference to get the value of relative
humidity from another NETWORK 8000
object.

Barometric press English value

Displays the value of the English barometric
pressure input. This input is active if the
engineering units for Dry bulb temp value
is °F. Corresponds to BPRIN in the GCM
ENTHL block.

Barometric press English constant

Enter a value to supply the EnthlRH with a
constant English barometric presure input.

Barometric press English reference

Enter a reference to get the value of English
barometric pressure from another
NETWORK 8000 object.

Barometric press Metric value

Displays the value of the metric barometric
pressure input. This input is active if the
engineering units for Dry bulb temp value
is °C. Corresponds to BPRMM in the GCM
ENTHL block.

Barometric press Metric constant

Enter a value to supply the EnthlRH with a
constant metric barometric pressure input.

Barometric press Metric reference

Enter a reference to get the value of metric
barometric pressure from another
NETWORK 8000 object.
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97.60

EnthlRh Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the EnthlRh.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
EnthlRh executes its algorithm. Corresponds
to UPTIM in the GCM ENTHL block.
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97.61

Flo2 Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Flo2.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Zone temp

Displays the current zone temperature at the
sensor. Corresponds to ZNTMP in the GCM
FLO2 block.

Duct temp

Displays the current duct temperature at the
sensor. This sensor can optionally be used
as a satellite point. The property is active if
the Duct temp enable is not disabled.
Corresponds to DTTMP in the GCM FLO2
block.

Box flow

Displays the air flow rate into the VAV
box. The property is active if Pressure type
is configured for pressure independent
operation. Corresponds to FLOW in the
GCM FLO2 block.
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Component

Description

Damper position

Displays the percent of travel between the
full closed and full open positions.
Corresponds to DMPOS in the GCM FLO2
block.

Percent aux act

Displays the percentage of the external
actuator output. The property is active if
DO3 function is configured for an external
actuator. Corresponds to PCAUX in the
GCM FLO2 block.

Analog output 1

Displays the percentage of the analog
output. The property is active if Control
type is not COOLING. Corresponds to
AO1ST in the GCM FLO2 block.

Velocity pressure

Displays the measured pressure of the VAV
box. The property is active if Pressure type
is PRESSURE INDEPENDENT.
Corresponds to VPRES in the GCM FLO2
block.

DO1 status

Displays the status of digital output 1 on the
VAV device. The property is active if Output
type is not NO OUTPUTS
PIC/PDC. Corresponds to DO1ST in the
GCM FLO2 block.

DO2 status

Displays the status of digital output 2 on the
VAV device. The property is active if Output
type is not NO OUTPUTS PIC/PDC.
Corresponds to DO2ST in the GCM FLO2
block.

DO3 status

Displays the status of digital output 3 on the
VAV device. The property is active if Output
type is not NO OUTPUTS PIC/PDC.
Corresponds to DO3ST in the GCM FLO2
block.

DO4 status

Displays the status of digital output 4 on the
VAV device. The property is active if Output
type is not NO OUTPUTS
PIC/PDC. Corresponds to DO4ST in the
GCM FLO2 block.

Digital input status

Displays the status of the digital input on the
MICROFLO II device. Corresponds to DISTS
in the GCM FLO2 block.

Object status

Displays the status of the object.
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97.62

Flo2 Properties – Control Values Tab
Use the Control Values tab to view information about the control output property
values of the Flo2.

Figure: Control Values tab

Table: Control Values Tab
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Component

Description

Control cool setpt

Displays the active cooling setpoint.
Corresponds to CLSP in the GCM FLO2
block.

Control heat setpt

Displays the active reheat and morning
warmup setpoint. Corresponds to HTSP in
the GCM FLO2 block.

Control par fan sp

Displays the parallel fan flow setpoint. The
property is active if Control type is
PARALLEL FAN. Corresponds to PFNSP
in the GCM FLO2 block.
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Component

Description

Control max flow/pos

Displays the active maximum cooling flow or
position, which limits the flow or position
achieved. Control min flow/pos has
priority over Control max flow/pos.
Corresponds to MXFLO in the GCM FLO2
block.

Control min flow/pos

Displays the active minimum cooling flow or
position, which limits the lowest flow or
position achieved. Corresponds to MNFLO
in the GCM FLO2 block.

Flow/pos setpoint

Displays the active flow setpoint. Flow/pos
setpoint indicates two times the flow
setpoint when the damper is in a forced
open mode. Corresponds to FLOSP in the
GCM FLO2 block.

Remote sp

Displays the setpoint of the wall
thermostat. The property is active if Remote
sp enable is ENABLED. Corresponds to
REMSP in the GCM FLO2 block.

Override time

Displays the remaining override time after
activation by the pushbutton on the wall
thermostat. Corresponds to OVTIM in the
GCM FLO2 block.

Occupancy status

Displays On (true) for any occupied mode
(EMS or local) and for the morning warmup
mode. Corresponds to OCCST in the GCM
FLO2 block.

Box type

Displays the configuration of the MICROFLO
II device hardware. Corresponds to BXTYP
in the GCM FLO2 block.

Control status

Displays the status of the device.
Corresponds to CTSTS in the GCM FLO2
block.

Diagnostic type

Displays the current diagnostics.
Corresponds to DIAG in the GCM FLO2
block.
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Flo2 Properties – Command Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Command Inputs tab

Table: Command Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
FLO2 block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Warm start value

Displays the warm start value. Each time this
value changes to On (true) the MICROFLO
II device is re-initialized. Corresponds to
WRMST in the GCM FLO2 block.

Warm start constant

Select On (true) to initiate a reset of the
MICROFLO II device.

Warm start reference

Enter a reference to restart the MICROFLO II
device from another NETWORK 8000
object.

Force damper open value

Displays force damper open. This does not
function if Force damper close value is
On (true). Corresponds to FOPN in the
GCM FLO2 block.

Force damper open constant

Select On (true) to force the damper open.

Force damper open reference

Enter a reference to force the damper open
from another NETWORK 8000 object.

Force damper close value

Displays the force damper close value. The
input does not function if Force damper
open is On (true). This input is active
whenever Building Operation is
communicating to the MICROFLO II device
and does not depend on the EMS control
input. Corresponds to FCLS in the GCM
FLO2 block.

Force damper close constant

Select On (true) to force the damper
closed.

Force damper close reference

Enter a reference to force the damper closed
from another NETWORK 8000 object.

Force damper to max value

Displays force damper to maximum. The
does not function if Force damper to min
value is On (true). Corresponds to FMX in
the GCM FLO2 block.

Force damper to max constant

Select On (true) to force the damper to
maximum position.

Force damper to max reference

Enter a reference to force the damper to
maximum from another NETWORK 8000
object.

Force damper to min value

Displays force damper to minimum. The
does not function if Force damper to max
value is On (true).Corresponds to FMN in
the GCM FLO2 block.
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Force damper to min constant

Select On (true) to force the damper to
minimum position.

Force damper to min reference

Enter a reference to force the damper to
minimum from another NETWORK 8000
object.

Heat disable value

Displays reheat control disable. Corresponds
to HTDIS in the GCM FLO2 block.

Heat disable constant

Select On (true) to disable all reheat
control.

Heat disable reference

Enter a reference to disable reheat from
another NETWORK 8000 object.

DO1 sat command value

Displays the DO1 satellite command. This
input is active only if DO1 function is
SATELLITE. Corresponds to DO1CD in the
GCM FLO2 block.

DO1 sat command constant

Select either On (true) or Off (false) to
hold DO1 status at this value.

DO1 sat command reference

Enter a reference to get the DO1 satellite
command from another NETWORK 8000
object.

DO2 sat command value

Displays the DO2 satellite command. This
input is active only if DO2 function is
SATELLITE. Corresponds to DO2CD in the
GCM FLO2 block.

DO2 sat command constant

Select either On (true) or Off (false) to
hold DO2 status at this value.

DO2 sat command reference

Enter a reference to get the DO2 satellite
command from another NETWORK 8000
object.

DO3 sat command value

Displays the DO3 satellite command. This
input is active only if DO3 function is
SATELLITE. Corresponds to DO3CD in the
GCM FLO2 block.

DO3 sat command constant

Select either On (true) or Off (false) to
hold DO3 status at this value.

DO3 sat command reference

Enter a reference to get the DO3 satellite
command from another NETWORK 8000
object.

DO4 sat command value

Displays the DO4 satellite command. This
input is active only if DO4 function is
SATELLITE. Corresponds to DO4CD in the
GCM FLO2 block.
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DO4 sat command constant

Select either On (true) or Off (false) to
hold DO4 status at this value.

DO4 sat command reference

Enter a reference to get the DO4 satellite
command from another NETWORK 8000
object.
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Flo2 Properties – EMS Inputs Tab
Use the EMS Inputs tab to view or configure the EMS input properties of the
object. This tab contains a property group for each input of the object. Each input
group has three properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference property
to determine the operation of the object. If the constant property is Null, the
reference property determines the operational value. If both the constant and the
reference properties are null, the input value is Not active (Null).
The EMS inputs are used when control setpoints should be derived from Building
Operation rather than locally at the MICROFLO II device. When Building Operation
is communicating with the MICROFLO II device and EMS control value is On (true)
all of the EMS inputs can be used.

Figure: EMS Inputs tab
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Component

Description

EMS control value

Displays On (true) if the MICROFLO II
device operates from the EMS setpoints.
Displays Off (false) when the local
setpoints are used. Corresponds to EMSCO
in the GCM FLO2 block.

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

EMS occupied mode value

Displays the EMS occupied mode.
Corresponds to EOCCM in the GCM FLO2
block.

EMS occupied mode constant

Select On (true) to command the
MICROFLO II device to occupied mode.

EMS occupied mode reference

Enter a reference to get the EMS occupied
mode from another NETWORK 8000 object.

EMS reverse action value

Displays the EMS cooling loop reverse
command. Morning warmup mode, either
from local or EMS control, has priority over
this input. Corresponds to EREVA in the
GCM FLO2 block.

EMS reverse action constant

Select On (true) to command the
MICROFLO II device to use reverse action
cooling.

EMS reverse action reference

Enter a reference to get the EMS reverse
action from another NETWORK 8000 object.

EMS morning warmup value

Displays the EMS morning warmup
command. Corresponds to EMWAM in the
GCM FLO2 block.

EMS morning warmup constant

Select On (true) to command the
MICROFLO II device to use morning
warmup.

EMS morning warmup reference

Enter a reference to get the EMS morning
warmup value from another NETWORK
8000 object.

EMS AO1 sat command value

Displays the EMS AO1 satellite command.
This input is active only if AO1 function is
configured for SATELLITE. Corresponds to
EAO1 in the GCM FLO2 block.

EMS AO1 sat command constant

Enter a value to supply a constant AO1
satellite command.

EMS AO1 sat command reference

Enter a reference to get the EMS AO1
satellite command from another NETWORK
8000 object.
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EMS cool setpt value

Displays the EMS occupied cooling setpoint.
Corresponds to ECLSP in the GCM FLO2
block.

EMS cool setpt constant

Enter a value to supply a constant cooling
setpoint.

EMS cool setpt reference

Enter a reference to get the EMS cool
setpoint from another NETWORK 8000
object.

EMS heat setpt value

Displays the EMS occupied reheat (and
morning warmup) setpoint. Corresponds to
EHTSP in the GCM FLO2 block.

EMS heat setpt constant

Enter a value to supply a constant heating
setpoint.

EMS heat setpt reference

Enter a reference to get the EMS heat
setpoint from another NETWORK 8000
object.

EMS par fan sp value

Displays the parallel fan setpoint. This input
is active if Control type is Parallel fan.
Corresponds to EFNSP in the GCM FLO2
block.

EMS par fan sp constant

Enter a value to supply a constant parallel
fan setpoint.

EMS par fan sp reference

Enter a reference to get the EMS parallel fan
setpoint from another NETWORK 8000
object.

EMS max flow/pos value

Displays the EMS occupied maximum flow
(for pressure independent) or maximum
position (for pressure dependent) value.
Corresponds to EFLMX in the GCM FLO2
block.

EMS max flow/pos constant

Enter a value to supply a constant maximum
flow/pos.

EMS max flow/pos reference

Enter a reference to get the EMS maximum
flow/pos from another NETWORK 8000
object.

EMS min flow/pos value

Displays the EMS occupied minimum flow
(for pressure in dependent), or minimum
position (for pressure dependent).
Corresponds to EFLMN in the GCM FLO2
block.

EMS min flow/pos constant

Enter a value to supply a constant minimum
flow/pos.
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EMS min flow/pos reference

Enter a reference to get the EMS minimum
flow/pos from another NETWORK 8000
object.

EMS unocc cool setpt value

Displays the EMS unoccupied cooling
setpoint. Corresponds to EUCSP in the
GCM FLO2 block.

EMS unocc cool setpt constant

Enter a value to supply a constant
unoccupied cool setpoint.

EMS unocc cool setpt reference

Enter a reference to get the EMS
unoccupied cool setpoint from another
NETWORK 8000 object.

EMS unocc heat setpt value

Displays the EMS unoccupied heating
setpoint. Corresponds to EUHSP in the
GCM FLO2 block.

EMS unocc heat setpt constant

Enter a value to supply a constant
unoccupied heat setpoint.

EMS unocc heat setpt reference

Enter a reference to get the EMS
unoccupied heat setpoint from another
NETWORK 8000 object.
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Flo2 Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Flo2.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Flo2 executes its algorithm. Corresponds to
UPTIM in the GCM FLO2 block.
Writing this parameter causes a reset of the
object.

Physical address

Enter the physical address of the
MICROFLO II device as set by the DIP
switches at the device. Corresponds to
ADDR in the GCM FLO2 block.
Writing this parameter causes a reset of the
object.

Message enable

Technical
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Select the messages that are to be disabled
from the MICROFLO II device. Corresponds
to EXENA in the GCM FLO2 block.
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Flo2 Properties – Controller
Configuration Tab
Use the Controller Configuration tab to view the MICROFLO II device
configuration.

Figure: Controller Configuration tab

Table: Controller Configuration Tab
Component

Description

Group number

Displays the group number used by
SgrpFlo2 to broadcast commands to all
MICROFLO II devices in that group.
Corresponds to GROUP in the GCM FLO2
block.
Writing this parameter causes a reset of the
object.
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Temperature units

Displays the temperature units of measure
configured in the device. Corresponds to
TUNIT in the GCM FLO2 block.

Pressure type

Displays the terminal box pressure type
configured in the device. Corresponds to
PTYPE in the GCM FLO2 block.
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Component

Description

Output type

Displays the output hardware type
configured in the device, this must match the
hardware of the device. Corresponds to
OTYPE in the GCM FLO2 block.

Control type

Displays the terminal box control sequence
configured in the device. Corresponds to
CTYPE in the GCM FLO2 block.

Reheat sequence

Displays the reheat control type configured
in the device. Corresponds to RHSEQ in the
GCM FLO2 block.

DO1 function

Displays the DO1 use configured in the
device. Corresponds to DO1FN in the GCM
FLO2 block.

DO2 function

Displays the DO2 use configured in the
device. Corresponds to DO2FN in the GCM
FLO2 block.

DO3 function

Displays the DO3 use configured in the
device. Corresponds to DO3FN in the GCM
FLO2 block.

DO4 function

Displays the DO4 use configured in the
device. Corresponds to DO1FN in the GCM
FLO2 block.

AO1 function

Displays the AO1 use configured in the
device. Corresponds to AO1FN in the GCM
FLO2 block.

Actuator rotation

Displays the main damper actuator rotation
configured in the device. Corresponds to
ROTAT in the GCM FLO2 block.

Digital input enable

Displays the usage for the digital input
configured in the device. Corresponds to
DENAB in the GCM FLO2 block.

Unocc min flow/pos

Displays the damper minimum position in
unoccupied mode configured in the device.
Corresponds to UFLMN in the GCM FLO2
block.

Remote sp enable

Displays the damper minimum position
configured in the device. Corresponds to
RSPEN in the GCM FLO2 block.

Duct temp enable

Displays the duct temperature input
configured in the device. Corresponds to
DITPEN in the GCM FLO2 block.

Cool integral gain

Displays the cooling control loop integral
gain configured in the device. Corresponds
to CLINT in the GCM FLO2 block.
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Heat integral gain

Displays the heating control loop integral
gain configured in the device. Corresponds
to HTINT in the GCM FLO2 block.

Ext. act travel time

Displays the external damper actuator travel
time configured in the device. Corresponds
to EXTIM in the GCM FLO2 block.

Aux. act travel time

Displays the auxiliary damper actuator travel
time configured in the device. Corresponds
to AXTIM in the GCM FLO2 block.

Zone temp offset cal

Displays the zone temperature offset
configured in the device. Corresponds to
ZNCAL in the GCM FLO2 block.

Duct temp offset cal

Displays the duct temperature offset
configured in the device. Corresponds to
DTCAL in the GCM FLO2 block.

Remote sp offset cal

Displays the remote temperature setpoint
offset configured in the device. Corresponds
to SPCAL in the GCM FLO2 block.

Flow offset cal

Displays the flow calibration offset
configured in the device. Corresponds to
FLOFF in the GCM FLO2 block.

Cool tr

Displays the cooling loop throttling range
configured in the device. Corresponds to
CLTR in the GCM FLO2 block.

Heat tr

Displays the heating loop throttling range
configured in the device. Corresponds to
HTTR in the GCM FLO2 block.

Warmup changeover

Displays the morning-warmup-initiate
setpoint configured in the device.
Corresponds to WMCHG in the GCM FLO2
block.

Override on time

Displays the override time setting for the wall
thermostat configured in the device.
Corresponds to OVONT in the GCM FLO2
block.

Flow calibration

Displays the airflow measuring station
calibration value configured in the device.
Corresponds to FLCAL in the GCM FLO2
block.

Reheat min flow/pos

Displays the reheat flow (or position) setpoint
configured in the device. Corresponds to
RHMNF in the GCM FLO2 block.
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Maximum cool setpt

Displays the occupied maximum cooling
setpoint configured in the device.
Corresponds to MXCSP in the GCM FLO2
block.

Minimum cool setpt

Displays the occupied minimum cooling
setpoint configured in the device.
Corresponds to MNCSP in the GCM FLO2
block.

Maximum heat setpt

Displays the maximum heating and morning
warmup setpoint configured in the device.
Corresponds to MXHSP in the GCM FLO2
block.

Minimum heat setpt

Displays the minimum heating and morning
warmup setpoint configured in the device.
Corresponds to MNHSP in the GCM FLO2
block.

Local cool setpt

Displays the occupied cooling setpoint
configured in the device. Corresponds to
LCLSP in the GCM FLO2 block.

Local heat sp offset

Displays the local (not EMS) setpoint offset
for heating configured in the device. The
local heating setpoint (or morning warmup
setpoint) is the Local cool setpt minus the
Local heat sp offset. Corresponds to
LSPOF in the GCM FLO2 block.

Local max flow/pos

Displays the local (not EMS) maximum flow
(or position), required for cooling, configured
in the device. Corresponds to LMXFL in the
GCM FLO2 block.

Local min flow/pos

Displays the local (not EMS) minimum flow
(or position), required for cooling, configured
in the device. Corresponds to LMNFL in the
GCM FLO2 block.

Local par fan sp

Displays the local (not EMS) occupied
maximum cooling setpoint configured in the
device. Corresponds to LFNSP in the GCM
FLO2 block.

Par fan hysteresis

Displays the parallel fan hysteresis setpoint
configured in the device. The parallel fan offpoint is Control par fan sp plus the Par
fan hysteresis. Corresponds to FANHY in
the GCM FLO2 block.

Local unocc cool sp

Displays the local (not EMS) unoccupied
cooling setpoint configured in the device.
Corresponds to LUCSP in the GCM FLO2
block.
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Local unocc heat sp

Displays the local (not EMS) unoccupied
reheat setpoint configured in the device.
Corresponds to LUHSP in the GCM FLO2
block.
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Flow Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Flow.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Flow output

Displays the calculated flow. Corresponds to
AV in the GCM FLOW block.

High flag

Displays On (true) whenever the Input
pressure exceeds the Pressure
maximum value. Corresponds to HIFLG in
the GCM FLOW block.

Low flag

Displays On (true) whenever the Input
pressure is less than the Pressure
minimum value. Corresponds to LOFLG in
the GCM FLOW block.

Static pres hi flag

Displays On (true) whenever the Static
pressure exceeds the Static pres
maximum value. Corresponds to SHIFL in
the GCM FLOW block.
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Static pres low flag

Displays On (true) whenever the Static
pressure is less than the Static pres
minimum value. Corresponds to SLOFL in
the GCM FLOW block.

Object status

Displays the status of the object.
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Flow Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
FLOW block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Input pressure value

Displays the pressure when using a
differential pressure input. Corresponds to
INPRE in the GCM FLOW block.

Input pressure constant

Enter a value to provide the Flow with a
constant differential pressure. This prevents
reading the value of a sensor.

Input pressure reference

Enter a reference to get the differential
pressure from another NETWORK 8000
object.

Static pressure value

Displays the pressure when using a static
pressure input. Corresponds to STPRE in
the GCM FLOW block.

Static pressure constant

Enter a value to provide the Flow with a
constant static pressure. This prevents
reading the value of a sensor.

Static pressure reference

Enter a reference to get the static pressure
from another NETWORK 8000 object.
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Flow Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Flow.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Flow executes its algorithm. Corresponds to
UPTIM in the GCM FLOW block.

Pressure maximum

Enter the maximum Input pressure that is
used for flow calculations. If the Input
pressure exceeds Pressure maximum,
the output High flag is On (true). If
Pressure maximum is less than
Pressure minimum, the Object status is
Abnormal no input. Corresponds to
PRMX in the GCM FLOW block.

Pressure minimum

Enter the minimum Input pressure that is
used for flow calculations. Corresponds to
PRMN in the GCM FLOW block.
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Static pres maximum

Enter the maximum Static pressure that is
used for flow calculations. If the Input
pressure exceeds Pressure maximum,
the output High flag is On (true). If
Pressure maximum is less than
Pressure minimum, the Object status is
Abnormal no input. Corresponds to
SPRMX in the GCM FLOW block.

Static pres minimum

Enter the minimum Static pressure that is
used for flow calculations. Corresponds to
SPRMN in the GCM FLOW block

CV flow constant

Enter the scale constant for calculating flow.
NETWORK 8000 GCM/LCM Programmer’s
Manual, (FM 23120).
Writing this parameter causes a reset of the
object.
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HiLo Properties – Basic Tab
Use the Basic tab to view information about the output property values of the HiLo.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Highest value

Displays the highest current input value.
Corresponds to HIVAL in the GCM HILO
block.

High cause

Displays which input has the highest value.
Corresponds to HICAU in the GCM HILO
block.

Lowest value

Displays the lowest current input value.
Corresponds to LOVAL in the GCM HILO
block.

Low cause

Displays which input has the lowest value.
Corresponds to LOCAU in the GCM HILO
block.
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Average value

Displays the average of all inputs.
Corresponds to AVG in the GCM HILO
block.

Summation

Displays the sum of all inputs. Corresponds
to SUM in the GCM HILO block.

Object status

Displays the status of the object.
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HiLo Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
HILO block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Analog input 1 to Analog input 8 value

Displays the value of the analog input.
Corresponds to CENAB in the GCM HILO.

Analog input 1 to Analog input 8
constant

Enter a value to supply the HiLo with a
constant analog input.

Analog input 1 to Analog input 8
reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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HiLo Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the HiLo.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
HiLo executes its algorithm. Corresponds to
UPTIM in the GCM HILO block.

Number of inputs

Enter the number of inputs to be used by the
HiLo. Corresponds to NOFIN in the GCM
HILO block.
Writing this parameter causes a reset of the
object.

Input minimum

Technical
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Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value. Corresponds to INMN in
the GCM HILO block.
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Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value. Corresponds to INMX in
the GCM HILO block.
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Invert Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Invert.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays the current digital value.
Corresponds to DV in the GCM LOGIC
block.

On value only

Displays the same output as the Digital
value output, except On (true) is the only
active state. Corresponds to ONDV in the
GCM LOGIC block.

Off value only

Displays the same output as the Digital
value output, except Off (false) is the only
active state. Corresponds to OFFDV in the
GCM LOGIC block.

Object status

Displays the status of the object.
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Invert Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
INVERT block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Digital input, value

Displays the value of the digital input.
Corresponds to DINP1 in the GCM INVERT
block.

Digital input, constant

Enter a value to supply the Invert with a
constant digital input.

Digital input, reference

Enter a reference to get the digital input
reference from another NETWORK 8000
object.
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Invert Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Invert.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Invert executes its algorithm. Corresponds to
UPTIM in the GCM LOGIC block.

Invert input 1

Select Invert to invert the input value.
Corresponds to INVT1 in the GCM LOGIC
block.

Action output

Select Invert to invert the output result.
Corresponds to INOUT in the GCM LOGIC
block.
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LcmAI Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmAI.

Figure: Basic tab

Table: Basic Tab
Property

Description

Analog point value

Displays the value of the analog input point.
Corresponds to AV in the LCM AI block.

Diagnostic error

Displays On (true) whenever the input value
is out of range.
Corresponds to DIAGN in the LCM AI block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM AI
block.
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LcmAI Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmAI.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM AI block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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LcmAI Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmAI.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmAI executes its algorithm.
Corresponds to UPTIM in the LCM AI block.

Physical address local point

Enter the physical address of the physical
point. Alternatively, select Virtual to use the
AI as a virtual point.
Corresponds to ADDRS in the LCM AI block.

Engineering units

Displays the engineering units of LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM AI block.
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Property

Description

Input type

Select Standard for predefined curves.
Select User defined for inputs that are
defined in the object.
Corresponds to INTYP in the LCM AI block.

Curve type

Select the type of scaling curve used for
standard temperature sensors. This property
is active only if the Input type is standard.
Corresponds to CUTYP in the LCM AI block.

Volts at low value

Enter the low voltage value of the point when
the input is at its Scaled low value. This
property is active only if the Input type is
user-defined.
Corresponds to VLVAL in the LCM AI block.

Scaled low value

Enter the scaled output value for the point
when the input is at its lowest voltage input
as defined by Volts at low value. This
property is active only if the Input type is
user-defined.
Corresponds to LOVAL in the LCM AI block.

Volts at hi value

Enter the high voltage value of the point
when the input is at its Scaled hi value.
This property is active only if the Input type
is user-defined.
Corresponds to VHVAL in the LCM AI block.

Scaled hi value

Enter the scaled output value for the point
when the input is at its highest voltage input
as defined by Volts at hi value. This
property is active only if the Input type is
user-defined.
Corresponds to HIVAL in the LCM AI block.

Supply current

Select the current that is required to allow
the resistant type input device to produce a
voltage. If the voltage is developed from a
different source, select No current. This
property is active only if the Input type is
user-defined.
Corresponds to SCUR in the LCM AI block.

Offset calibration

Enter the value added (+ or –) to offset the
calculated reading of a sensor or input.
Corresponds to OFCAL in the LCM AI block.

Output maximum

Enter the maximum value accepted for the
output.
Corresponds to OUTMX in the LCM AI
block.
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Property

Description

Output minimum

Enter the minimum value accepted for the
output.
Corresponds to OUTMN in the LCM AI
block.

Filter mode

Select the Filter mode to average the input
values of sampled changes. Calculations are
based on the Update time.
Corresponds to FILTR in the LCM AI block.
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97.79

LcmAlarm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmAlarm.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current alarm state

Displays the alarm condition.
Corresponds to STATE in the LCM ALARM
block.

Digital value output

Displays the selected Output action versus
the alarm condition.
Corresponds to DV in the LCM ALARM
block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only.
Corresponds to ONDV in the LCM ALARM
block.
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Property

Description

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only.
Corresponds to OFFDV in the LCM ALARM
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM ALARM
block.
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97.80

LcmAlarm Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmAlarm.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM ALARM
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Property

Description

Analog input constant

Enter a value to supply LcmAlarm with a
constant input for testing.
Corresponds to AINP in the LCM ALARM
block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Alarm limit constant

Enter a value to set the alarm limit.
Corresponds to LIMIT in the LCM ALARM
block.

Alarm limit pointer

Displays a NETWORK 8000 input pointer
string.

Return from alarm constant

Enter a value to set the alarm return limit.
Corresponds to RETRN in the LCM ALARM
block.

Return from alarm pointer

Displays a NETWORK 8000 input pointer
string.

Disable alarm constant

Select On (true) to stop generating alarms.
Corresponds to DSABL in the LCM ALARM
block.

Disable alarm pointer
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Displays a NETWORK 8000 input pointer
string.
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97.81

LcmAlarm Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmAlarm.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmAlarm executes its algorithm.
Corresponds to UPTIM in the LCM ALARM
block.

Engineering units

Displays the units of measure for LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM ALARM
block.
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Property

Description

Alarm priority

Enter the priority for the NETWORK 8000
exception messages. In StruxureWare, the
priority of the alarm or event is defined on the
LCM tab of the NETWORK 8000
Interface. One priority is defined for all
alarms, and another priority is defined for all
maintenance reminders.
Corresponds to PRIOR in the LCM ALARM
block.

Print group

Enter the print group as defined in the LCM.
For more information, see section 96.5
“NETWORK 8000 LCMs” on page 3799.
Corresponds to PRINT in the LCM ALARM
block.

Enable delay

Enter the time the Disable alarm input
must be Off before LcmAlarm begins to
monitor alarm conditions.
Corresponds to ENDLY in the LCM ALARM
block.

Alarm delay

Enter the number of minutes that Analog
input must be in an alarm condition before
an alarm is generated.
Corresponds to ALDLY in the LCM ALARM
block.

Output action

Select the Output value when LcmAlarm is in
an alarm condition.
Corresponds to ACT in the LCM ALARM
block.

Alarm message text

Enter a text message that is part of the alarm
message.
Corresponds to MESSG in the LCM ALARM
block.
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LcmAO Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmAO.

Figure: Basic tab

Table: Basic Tab
Property

Description

Analog point value

Displays the value of the analog output point.
Corresponds to AV in the LCM AO block.

Override time

Displays the number of minutes before the
override is cleared if the AO’s Analog point
value output is in the override mode.
Corresponds to OVTIM in the LCM AO
block.

Output cause

Displays which input or default value is being
used in the calculation of the output value.
The output cause does not indicate an
output override condition.
Corresponds to CAUSE in the LCM AO
block.
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Continued
Property

Description

Diagnostic error

Displays On (true) when communication
between Building Operation and the GCS
has been lost.
Corresponds to DIAGN in the LCM AO
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM AO
block.

Technical
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97.83

LcmAO Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmAO.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM AO
block.

Calculate enable pointer

04-16006-04-en, March 2015

Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Input priority 1 constant to Input
priority 8 constant

Enter the Input priority.
Corresponds to IPR1 to IPR8 in the LCM AO
block.

Input priority 1 pointer to Input priority Displays a NETWORK 8000 input pointer
8 pointer
string.

Technical
3990
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97.84

LcmAO Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmAO.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmAO executes its algorithm.
Corresponds to UPTIM in the LCM AO
block.

Physical address local point

Enter the address of the physical point.
Alternatively, select Virtual to use the AO as
a virtual point.
Corresponds to ADDRS in the LCM AO
block.

Engineering units

Displays the units of measure for LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM AO block.
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Continued
Property

Description

Scaled low value

Enter the low input value required for the
Analog point value to equal the Output
at low value.
Corresponds to LOVAL in the LCM AO
block.

Output at low value

Enter the Analog point value produced
when the highest priority input value equals
the Scaled low value.
Corresponds to OUTLV in the LCM AO
block.

Scaled high value

Enter the high input value required for the
Analog point value to equal the Output
at high value.
Corresponds to HIVAL in the LCM AO block.

Output at high value

Enter the Analog point value produced
when the highest priority input value equals
the Scaled high value.
Corresponds to OUTHV in the LCM AO
block.

Output maximum

Enter the maximum value accepted for the
output.
Corresponds to OUTMX in the LCM AO
block.

Output minimum

Enter the minimum value accepted for the
output.
Corresponds to OUTMN in the LCM AO
block.

Default input value

Enter the value used when there are no
inputs having active values.
Corresponds to DEFLT in the LCM AO
block.

Technical
3992
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97.85

LcmApt Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmApt.

Figure: Basic tab

Table: Basic Tab
Property

Description

Analog point value

Displays the analog output value.
Corresponds to AV in the LCM APT block.

Override time

Displays the amount of time remaining if the
Analog point value output is forced.
Corresponds to OVTIM in the LCM APT
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM APT
block.

Technical
3994
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97.86

LcmApt Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmApt.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM APT
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input constant

Enter a value to supply the LcmApt with a
constant input.
Corresponds to AINP in the LCM APT block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Default analog value constant

Enter the value of the Default analog input.
The Analog point value remains at this input
value if the Analog input is inactive.
Corresponds to DFTAV in the LCM APT
block.

Default analog value pointer

Technical
3996

Displays a NETWORK 8000 input pointer
string.
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97.87

LcmApt Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmApt.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmApt executes its algorithm.
Corresponds to UPTIM in the LCM APT
block.

Engineering units

Displays the units of measure for LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM APT
block.
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Continued
Property

Description

Delay time

Enter the delay that the Analog point
value will wait before using Default
analog value when the input is Null or
Abnormal.
Corresponds to DELAY in the LCM APT
block.

Technical
3998
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97.88

LcmBtuh Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmBtuh.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current Analog value.
Corresponds to AV in the LCM BTUH block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM BTUH
block.
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97.89

LcmBtuh Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmBtuh.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM BTUH
block.

Calculate enable pointer

Technical
4000

Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Input temperature constant

Enter a value to supply a constant system
input temperature to the LcmBtuh.
Corresponds to INTEM in the LCM BTUH
block.

Input temperature pointer

Displays a NETWORK 8000 input pointer
string.

Output temperature constant

Enter a value to supply a constant system
output temperature to the LcmBtuh.
Corresponds to OUTEM in the LCM BTUH
block.

Output temperature pointer

Displays a NETWORK 8000 input pointer
string.

Input flow rate constant

Enter a value to supply a constant system
input flow rate to the LcmBtuh.
Corresponds to INFLO in the LCM BTUH
block.

Input flow rate pointer
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Displays a NETWORK 8000 input pointer
string.
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97.90

LcmBtuh Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmBtuh.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmBtuh executes its algorithm.
Corresponds to UPTIM in the LCM BTUH
block.

Input engineering units

Displays the units of measure for input
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to IUNIT in the LCM BTUH
block.

Technical
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Continued
Property

Description

Output engineering units

Displays the units of measure for output
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM BTUH
block.

Constant

Enter a constant scale value determined by
specific heat x fluid density x 60.
Writing this parameter causes a reset of the
object.
Corresponds to SCALE in the LCM BTUH
block.

04-16006-04-en, March 2015

Technical
4003

97 NETWORK 8000 User Interface
97.91 LcmCalen Properties – Basic Tab

97.91

LcmCalen Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmCalen.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the current digital value of the
schedule.
Corresponds to DV in the LCM CALEN
block.

On value only

Displays the Digital value output, with the
On (true) and Not active (Null) states only.
Corresponds to ONDV in the LCM CALEN
block.

Off value only

Displays the Digital value output, with the
Off (false) and Not active (Null) states only.
Corresponds to OFFDV in the LCM CALEN
block.

Technical
4004
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Continued
Property

Description

Current analog value

Displays the current analog value of the
schedule either On time analog value or
Off time analog value.
Corresponds to AV in the LCM CALEN
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM CALEN
block.
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97.92

LcmCalen Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmCalen.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Force not active constant

Select On (true) to force all the outputs to
Not active (Null).
Corresponds to NOACT in the LCM CALEN
block.

Force not active pointer

Technical
4006

Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Disable constant

Select On (true) to force the schedule to the
Off state.
Corresponds to DISAB in the LCM CALEN
block.

Disable pointer

Displays a NETWORK 8000 input pointer
string.

On time analog value constant

Enter the Current analog value used
when the schedule is on.
Corresponds to ONVAL in the LCM CALEN
block.

On time analog value pointer

Displays a NETWORK 8000 input pointer
string.

Off time analog value constant

Enter the Current analog value used
when the schedule is off.
Corresponds to OFVAL in the LCM CALEN
block.

Off time analog value pointer
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Displays a NETWORK 8000 input pointer
string.
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97.93

LcmCalen Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmCalen.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmCalen executes its algorithm.
Corresponds to UPTIM in the LCM CALEN
block.

Engineering units

Displays the units of measure for properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM CALEN
block.

On date

Set the date for the schedule to turn on.
Corresponds to ONDAT in the LCM CALEN
block.

Technical
4008
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Continued
Property

Description

On time

Set the time for the normal schedule to turn
on.
Corresponds to ONTIM in the LCM CALEN
block.

Off date

Set the date for the schedule to turn off.
Corresponds to OFDAT in the LCM CALEN
block.

Off time

Set the time for the normal schedule to turn
off.
Corresponds to OFTIM in the LCM CALEN
block.

Occurrence mode

Select Repeat every year for this schedule
to occur every year.
Corresponds to MODE in the LCM CALEN
block.
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97.94

LcmCos Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmCos.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current alarm state

Displays the alarm condition.
Corresponds to STATE in the LCM COS
block.

Digital value output

Displays the selected Output action versus
the alarm condition.
Corresponds to DV in the LCM COS block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only. This
output is based on the selected Output
action.
Corresponds to ONDV in the LCM COS
block.

Technical
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Continued
Property

Description

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only. This
output is based on the selected Output
action.
Corresponds to OFFDV in the LCM COS
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM COS
block.
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97.95

LcmCos Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmCos.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM COS
block.

Calculate enable pointer

Technical
4012

Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Digital input constant

Enter a value to supply LcmCos with a
constant digital input.
Corresponds to DINP in the LCM COS
block.

Digital input pointer

Displays a NETWORK 8000 input pointer
string.

Normal state constant

Select either Off (false) or On (true), for
the state that is normal and produces no
alarm.
Corresponds to NORM in the LCM COS
block.

Normal state pointer

Displays a NETWORK 8000 input pointer
string.

Disable alarm constant

Select Off (false) to disable alarms.
Corresponds to DSABL in the LCM COS
block.

Disable alarm pointer
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Displays a NETWORK 8000 input pointer
string.
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97.96

LcmCos Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmCos.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmCos executes its algorithm.
Corresponds to UPTIM in the LCM COS
block.

Alarm priority

Enter the priority for the NETWORK 8000
exception. In StruxureWare, the priority of
the alarm or event is defined on the LCM tab
of the NETWORK 8000 Interface. One
priority is defined for all alarms, and another
priority is defined for all maintenance
reminders.
Corresponds to PRIOR in the LCM COS
block.

Technical
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Continued
Property

Description

Print group

Enter the print group as defined in the LCM.
For more information, see section 96.5
“NETWORK 8000 LCMs” on page 3799.
Corresponds to PRINT in the LCM COS
block.

Enable delay

Enter the time the Disable alarm input
must be Off before LcmCos begins to
monitor alarm conditions.
Corresponds to ENDLY in the LCM COS
block.

Alarm delay

Enter the time the Digital input must be in
an alarm condition before the LcmAlarm
generates an alarm condition.
Corresponds to ALDLY in the LCM COS
block.

Output action

Select the Output action of Digital value
output when LcmCos is in an alarm
condition.
Corresponds to ACT in the LCM COS block.

Alarm message text

Enter a text message that is part of the alarm
message.
Corresponds to MESSG in the LCM COS
block.
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97.97

LcmCurve Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmCurve.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current analog value.
Corresponds to AV in the LCM CURVE
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM CURVE
block.

Technical
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97.98

LcmCurve Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmCurve.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM CURVE
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input constant

Enter a value to supply a constant analog
input to the LcmCurve.
Corresponds to AINP in the LCM CURVE
block.

Analog input pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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97.99

LcmCurve Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmCurve.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmCurve executes its algorithm.
Corresponds to UPTIM in the LCM CURVE
block.

Engineering units

Displays the units of measure for properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM CURVE
block.

Output maximum

Enter the maximum output value allowed for
the LcmCurve.
Corresponds to OUTMX in the LCM CURVE
block.
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Continued
Property

Description

Output minimum

Enter the minimum output value allowed for
the LcmCurve.
Corresponds to OUTMN in the LCM CURVE
block.

A coefficient

Enter the A coefficient value.
Corresponds to ACOE in the LCM CURVE
block.

B coefficient

Enter the B coefficient value.
Corresponds to BCOE in the LCM CURVE
block.

C coefficient

Enter the C coefficient value.
Corresponds to CCOE in the LCM CURVE
block.

D coefficient

Enter the D coefficient value.
Corresponds to DCOE in the LCM CURVE
block.

E coefficient

Enter the E coefficient value.
Corresponds to ECOE in the LCM CURVE
block.

F coefficient

Enter the F coefficient value.
Corresponds to FCOE in the LCM CURVE
block.

Technical
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97.100

LcmDaily Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDaily.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the current digital value of the
schedule.
Corresponds to DV in the LCM DAILY block.

On value only

Displays the Digital value output, using
the On (true) and not active (Null) states
only.
Corresponds to ONDV in the LCM DAILY
block.

Off value only

Displays the Digital value output, using
the Off (false) and not active (Null) states
only.
Corresponds to OFFDV in the LCM DAILY
block.

04-16006-04-en, March 2015

Technical
4021

97 NETWORK 8000 User Interface
97.100 LcmDaily Properties – Basic Tab

Continued
Property

Description

Current analog value

Displays the current analog value of the
schedule.
Corresponds to AV in the LCM DAILY block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DAILY
block.

Technical
4022
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97.101

LcmDaily Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDaily.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Force not active constant

Select On (true) to force all the outputs to
Not active (Null).
Corresponds to NOACT in the LCM DAILY
block.

Force not active pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Disable constant

Select On (true) to force the schedule to the
Off state.
Corresponds to DISAB in the LCM DAILY
block.

Disable pointer

Displays a NETWORK 8000 input pointer
string.

On time analog value constant

Enter the Current analog value that is
produced when the schedule is on.
Corresponds to ONVAL in the LCM DAILY
block.

On time analog value pointer

Displays a NETWORK 8000 input pointer
string.

Off time analog value constant

Enter the Current analog value that is
produced when the schedule is off.
Corresponds to OFVAL in the LCM DAILY
block.

Off time analog value pointer

Technical
4024

Displays a NETWORK 8000 input pointer
string.
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97.102

LcmDaily Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmDaily.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDaily executes its algorithm.
Corresponds to UPTIM in the LCM DAILY
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM DAILY
block.

On time

Enter the time for the normal schedule to
turn on.
Corresponds to ONTIM in the LCM DAILY
block.

04-16006-04-en, March 2015

Technical
4025

97 NETWORK 8000 User Interface
97.102 LcmDaily Properties – Parameters Tab

Continued
Property

Description

Off time

Enter the time for the normal schedule to
turn off.
Corresponds to OFTIM in the LCM DAILY
block.

Technical
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97.103

LcmDcc Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDcc.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the value of the digital output.
Corresponds to DV in the LCM DCC block.

On value only

Displays the Digital value output with the
On and Not active (Null) states only. This
output is based on the selected Output
action.
Corresponds to ONDV in the LCM DCC
block.
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Continued
Property

Description

Off value only

Displays the Digital value output with the
Off and Not active (Null) states only. This
output is based on the selected Output
action.
Corresponds to OFFDV in the LCM DCC
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DCC
block.
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97.104

LcmDcc Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDcc.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM DCC
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Input enable constant

Select Off (false) to prevent duty cycle
control and keep outputs On (true).
Corresponds to ENABL in the LCM DCC
block.

Input enable pointer

Displays a NETWORK 8000 input pointer
string.

Compensation input constant

Enter a duty cycle compensation value.
Corresponds to COINP in the LCM DCC
block.

Compensation input pointer

Displays a NETWORK 8000 input pointer
string.

Value at min duty constant

Enter a Compensation input value at
which the duty cycle is at minimum on time.
Corresponds to MNDTY in the LCM DCC
block.

Value at min duty pointer

Displays a NETWORK 8000 input pointer
string.

Value at max duty constant

Enter a Compensation input value at
which the duty cycle is at maximum (100%)
on time.
Corresponds to MXDTY in the LCM DCC
block.

Value at max duty pointer

Technical
4030

Displays a NETWORK 8000 input pointer
string.
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97.105

LcmDcc Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmDcc.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDcc executes its algorithm.
Corresponds to UPTIM in the LCM DCC
block.

Control mode

Select Compensated to vary the on and off
time based on the Compensation input
value.
Corresponds to MODE in the LCM DCC
block.

Minimum on time

Enter the minimum time during each period
that the output is in the On (true) condition.
Corresponds to MNON in the LCM DCC
block.
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Continued
Property

Description

Period

Enter the total time for an on time plus off
time cycle.
Corresponds to PERIN in the LCM DCC
block.
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97.106

LcmDegDa Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDegDa.

Figure: Basic tab

Table: Basic Tab
Property

Description

Heat degree day

Displays the total heating degrees for the
past day. This value, forced or not forced, is
maintained through a warm reset.
Corresponds to HDEDA in the LCM DEGDA
block.

Cool degree day

Displays the total cooling degrees for the
past day. This value, forced or not forced, is
maintained through a warm reset.
Corresponds to CDEDA in the LCM DEGDA
block.
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Continued
Property

Description

Heat total deg day

Displays the total heating degree days since
the LcmDegDa was initialized. This value,
forced or not forced, is maintained through a
warm reset.
Corresponds to THDDA in the LCM DEGDA
block.

Cool total deg day

Displays the total cooling degree days since
the object was initialized. This value, forced
or not forced, is maintained through a warm
reset.
Corresponds to TCDDA in the LCM DEGDA
block.

Maximum oat

Displays the highest outdoor air temperature
detected during the last 24 hours (midnight
to midnight). This value, forced or not forced,
is maintained through a warm reset.
Corresponds to MXOAT in the LCM DEGDA
block.

Time at maximum

Displays the time at which Maximum
oat was at its highest recorded value during
the last 24 hours (midnight to midnight). This
output is maintained through a warm reset.
Corresponds to TIMX in the LCM DEGDA
block.

Minimum oat

Displays the lowest outdoor air temperature
detected during the last 24 hours (midnight
to midnight), to be used by the heating
degree day calculations. This value, forced
or not forced, is maintained through a warm
reset.
Corresponds to MNOAT in the LCM DEGDA
block.

Time at minimum

Displays the time at which Minimum oat
was at its lowest recorded value during the
last 24 hours (midnight to midnight). This
output is maintained through a warm reset.
Corresponds to TIMN in the LCM DEGDA
block.

Start time

Displays the time when the object was last
reset or restarted. This output is maintained
through a warm reset.
Corresponds to STTIM in the LCM DEGDA
block.

Technical
4034

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.106 LcmDegDa Properties – Basic Tab

Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DEGDA
block.
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97.107

LcmDegDa Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDegDa.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM DEGDA
block.

Calculate enable pointer

Technical
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Displays a NETWORK 8000 input pointer
string.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.107 LcmDegDa Properties – Inputs Tab

Continued
Property

Description

Initialize total constant

Select On (true) to restart calculations of
the Heat total deg day and Cool total
deg day outputs.
Corresponds to INIT in the LCM DEGDA
block.

Initialize total pointer

Displays a NETWORK 8000 input pointer
string.

Outside air temp constant

Enter a value to supply the LcmDegDa with a
constant input.
Corresponds to OATMP in the LCM DEGDA
block.

Outside air temp pointer
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Displays a NETWORK 8000 input pointer
string.
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97.108

LcmDegDa Properties – Parameters
Tab
Use the Parameters tab to view and edit the configuration properties of
LcmDegDa.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDegDa executes its algorithm.
Corresponds to UPTIM in the LCM DEGDA
block.

Engineering units

Displays the units of measure for LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM DEGDA
block.
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Continued
Property

Description

No heat temperature

Enter the Outside air temp input value
above which no heating degree calculations
are made.
Writing this parameter causes a reset of the
object.
Corresponds to NOHET in the LCM DEGDA
block.

No cool temperature

Enter the Outside air temp input value
below which no cooling degree calculations
are made.
Writing this parameter causes a reset of the
object.
Corresponds to NOCOL in the LCM DEGDA
block.

Calculation interval

Select the calculation interval used for
degree day calculations.
Writing this parameter causes a reset of the
object.
Corresponds to INTVL in the LCM DEGDA
block.
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97.109

LcmDelay Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDelay.

Figure: Basic tab

Table: Basic Tab
Property

Description

Pulse output

Displays the pulse output, which has an On
(true) value for a period equal to the Delay
time starting when the Digital input value
changes from Off (false) to On (true).
Corresponds to PULSE in the LCM DELAY
block.

Delay output

Displays the delayed output. The Delay
output follows the Digital input value but
the change to On (true) is delayed by a
period equal to Delay time if Delay mode
is On delay, or change to Off (false) is
delayed by a period equal to Delay time if
Delay mode is Off delay.
Corresponds to DV in the LCM DELAY
block.
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Continued
Property

Description

Remaining time

Displays the delay time remaining after the
start of the delay.
Corresponds to RMTIM in the LCM DELAY
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DELAY
block.
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97.110

LcmDelay Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDelay.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM DELAY
block.

Calculate enable pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Digital input constant

Enter a value to supply the LcmDelay with a
constant input. Use for testing only.
Corresponds to DINP in the LCM DELAY
block.

Digital input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.111

LcmDelay Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmDelay.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDelay executes its algorithm.
Corresponds to UPTIM in the LCM DELAY
block.

Delay time

Enter the time for the needed delay for the
Delay mode.
Corresponds to DELAY in the LCM DELAY
block.

Delay mode

Select Off delay to delay the Delay output
transition to Off (false).
Corresponds to MODE in the LCM DELAY
block.
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97.112

LcmDI Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDI.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital point value

Displays the value of the digital input point.
Corresponds to DV in the LCM DI block.

On value only

Displays On (true) with the On and Not
active (Null) states only.
Corresponds to ONDV in the LCM DI block.

Off value only

Displays Off (false) with the Off and Not
active (Null) states only.
Corresponds to OFFDV in the LCM DI
block.
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Continued
Property

Description

Diagnostic error

Displays On (true) when there is a loss of
communication between Building Operation
and the GCS. The Digital point value
displays Not active (Null) and the Object
status indicates Abnormal no
communication.
Corresponds to DIAGN in the LCM DI block.

Elapsed on time

Displays the time that the Digital point
value output is calculated to be On (true).
When the DI is reset (cold reset), this
accumulated value is reset to 0. However,
this value is maintained through a warm
reset.
This output can be written to an assigned
value, from which the counter continues
totaling. A override time of 500,000 indicates
the override is on forever.
Corresponds to ONTIM in the LCM DI
block.

Change timestamp

Displays the time of the last change of state.
When DI is reset (cold reset), this value is set
to the current time and date. However, this
timestamp is maintained through a warm
reset.
Corresponds to CHTIM in the LCM DI block.

Number of changes

Displays the number of Off (false) to On
(true) transitions. When the DI is reset (cold
reset), this accumulated value is zeroed. This
output can be written to an assigned value
and the counter starts totaling from this
value.
Corresponds to NCHGS in the LCM DI
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DI
block.
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97.113

LcmDI Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDI.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM DI
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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97.114

LcmDI Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmDI.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDI executes its algorithm.
Corresponds to UPTIM in the LCM DI block.

Physical address local point

Enter the address of the physical point.
Alternatively, select Virtual to use the DI as
a virtual point.
Writing this parameter causes a reset of the
object.
Corresponds to ADDRS in the LCM DI
block.
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Continued
Property

Description

Engineering units

Displays the units of measure of LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM DI block.

Input action

Select the action of the input point.
Corresponds to INACT in the LCM DI block.
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97.115

LcmDO Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDO.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital point value

Displays the value of the digital point.
Corresponds to DV in the LCM DO block.

Override time

Displays the number of minutes before the
override is cleared if the AO’s Analog point
value output is in the override mode.
Corresponds to OVTIM in the LCM DO
block.

Output cause

Displays which input or default value is being
used in the calculation of the output value.
The output cause does not indicate an
output override condition.
Corresponds to CAUSE in the LCM DO
block.
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Continued
Property

Description

Diagnostic error

Displays On (true) when an error is
detected.
Corresponds to DIAGN in the LCM DO
block.

Elapsed on time

Displays the time that the Digital point
value output is calculated to be On (true).
This output can be written to an assigned
value, from which the counter continues
totaling. A override time of 500,000 indicates
the override is on forever.
Corresponds to ONTIM in the LCM DO
block.

Change timestamp

Displays the timestamp of the last change of
state.
Corresponds to CHTIM in the LCM DO
block.

Number of changes

Displays the number of Off (false) to On
(true) transitions. When the DO is reset
(cold reset), this accumulated value is
zeroed. This output can be overridden to an
assigned value and the counter starts
totaling from this value.
Corresponds to NCHGS in the LCM DO
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DCC
block.
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97.116

LcmDO Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDO.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM DO
block.

Calculate enable pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Force output value constant

Select either On (true) or Off (false) as the
value to force the output with Force enable
value.
Corresponds to FOVAL in the LCM DO
block.

Force output value pointer

Displays a NETWORK 8000 input pointer
string.

Force enable constant

Select On (true) to force the output to the
value of Force output value.
Corresponds to FOENA in the LCM DO
block.

Force enable pointer

Displays a NETWORK 8000 input pointer
string.

Input priority 1 to Input priority 8
constant

Select either On (true) or Off (false) to
hold an input at this value.
Corresponds to IPR1 to IPR8 in the LCM DO
block.

Input priority 1 to Input priority 8
pointer
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Displays a NETWORK 8000 input pointer
string.
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97.117

LcmDO Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmDO.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDcc executes its algorithm.
Corresponds to UPTIM in the LCM DO
block.

Physical address local point

Enter the address of the physical point.
Alternatively, select Virtual to use the DO as
a virtual point.
Writing this parameter causes a reset of the
object.
Corresponds to ADDRS in the LCM DO
block.

Technical
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Continued
Property

Description

Engineering units

Displays the units of measure of LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM DO
block.

Action

Select the relay activation state.
Corresponds to ACT in the LCM DO block.

Minimum on time

Enter the amount of time that the output’s
current value must be On (true) before
being allowed to turn Off (false).
Corresponds to MNON in the LCM DO
block.

Minimum off time

Enter the amount of time that the output’s
current value must be Off (false) before
being allowed to turn On (true).
Corresponds to MNOFF in the LCM DO
block.

Default input value

Select the input value used by the object’s
algorithm when all the inputs are Not active
(Null).
Corresponds to DEFLT in the LCM DO
block.
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97.118

LcmDpt Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmDpt.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital point value

Displays the current Digital value.
Corresponds to DV in the LCM DPT block.

Override time

Displays the amount of time remaining if the
Digital point value output is forced.
Corresponds to OVTIM in the LCM DPT
block.

Technical
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM DPT
block.
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97.119

LcmDpt Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmDpt.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM DPT
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Digital input constant

Enter a value to supply the LcmDpt with a
constant digital input.
Corresponds to DINP in the LCM DPT block.

Digital input pointer

Displays a NETWORK 8000 input pointer
string.

Default digital input constant

Enter the value of the Default digital
input. The Digital point value remains at this
input value if the Digital input is inactive.
Corresponds to DFTDV in the LCM DPT
block.

Default digital input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.120

LcmDpt Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmDpt.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmDpt executes its algorithm.
Corresponds to UPTIM in the LCM DPT
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM DPT
block.

Technical
4060

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.120 LcmDpt Properties – Parameters Tab

Continued
Property

Description

Delay time

Enter the delay time that the Digital point
value will wait before using a lower priority
input when a high priority input is Null or
Abnormal. If the Digital global
reference is not valid, the Digital input
value is used. If the Digital input value is
not valid, the Default digital value is used.
Corresponds to DELAY in the LCM DPT
block.
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97.121

LcmEDL Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmEDL.

Figure: Basic tab

Table: Basic Tab
Property

Description

Demand

Displays the current power rate calculated
from the Watt meter or Pulse count
inputs.
Corresponds to DMD in the LCM EDL block.

Demand setpoint

Displays the current demand setpoint.
Corresponds to DMDSP in the LCM EDL
block.
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Continued
Property

Description

Peak demand

Displays the current peak demand during
the given demand interval for the current
shift. This property is reset at the change of
shifts unless the Number of shifts is 1.
Then it is reset at the Start time shift.
Corresponds to PKDMD in the LCM EDL
block.

Peak demand time

Displays the timestamp for when the Peak
demand occurred.
Corresponds to PKTIM in the LCM EDL
block.

Setpoint 1

Displays the current setpoint for shift 1. If this
is the active shift, the Demand setpoint
value equals this value.
Corresponds to SP1 in the LCM EDL block.

Setpoint 2

Displays the current setpoint for shift 2. This
is active if the Number of shifts is greater
than 1 and then the Demand setpoint
value equals this value.
Corresponds to SP2 in the LCM EDL block.

Setpoint 3

Displays the current setpoint for shift 3. This
is active if the Number of shifts is greater
than 2 and then the Demand setpoint
value equals this value.
Corresponds to SP3 in the LCM EDL block.

Setpoint 4

Displays the current setpoint for shift 4. This
is active if the Number of shifts is greater
than 3 and then the Demand setpoint
value equals this value.
Corresponds to SP4 in the LCM EDL block.

Number of loads shed

Displays the number of loads that are
currently being shed.
Corresponds to SHED in the LCM EDL
block.

All loads shed

Displays On (true) when the Number of
loads shed equals the Number of loads.
Corresponds to ALLSD in the LCM EDL
block.

Total :00

Displays the kWh amount used between 0
and 15 minutes after the hour.
Corresponds to TOT00 in the LCM EDL
block.
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Continued
Property

Description

Total :15

Displays the kWh amount used from 15 to
29 minutes past the hour if Demand
interval is 5 or 15 minutes.
Corresponds to TOT15 in the LCM EDL
block.

Total: 30

Displays the kWh amount used from 30 to
44 minutes past the hour if Demand
interval is 30 minutes.
Corresponds to TOT30 in the LCM EDL
block.

Total: 45

Displays the kWh amount used from 45 to
59 minutes past the hour if Demand
interval is 60 minutes.
Corresponds to TOT45 in the LCM EDL
block.

Sample output

Displays On (true) just after the hour for at
least 5 minutes. During this time, the
totalization output values are frozen.
Corresponds to SAMPL in the LCM EDL
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM EDL
block.
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97.122

LcmEDL Properties – Priority Slots Tab
Use the Priority Slots tab to view information about the priority output values of
the LcmEDL.

Figure: Priority Slots tab

Table: Priority Slots Tab
Property

Description

Priority slot 1

Displays the value of Priority slot 1. To shed
a load, this output must be Off (false).
Corresponds to PSL1 in the LCM EDL block.

Priority slot 2 through Priority slot 64

Displays the value of the Priority slot. The
property exists if Number of loads is
greater than one number less than the slot
number. To shed a load, this output must be
Off (false).
Corresponds to PSL2 to PSL64 in the LCM
EDL block.
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97.123

LcmEDL Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmEDL.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM EDL
block.

Calculate enable pointer
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string.
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Property

Description

Shed enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to SHENA in the LCM EDL
block.

Shed enable pointer

Displays a NETWORK 8000 input pointer
string.

Watt meter constant

Enter a value to supply the EDL with a
constant wattage input.
Corresponds to WAMET in the LCM EDL
block.

Watt meter pointer

Displays a NETWORK 8000 input pointer
string.

Pulse rate constant

Enter a value to supply the EDL with a
constant input.
Corresponds to PLRAT in the LCM EDL
block.

Pulse rate pointer

Displays a NETWORK 8000 input pointer
string.

Initialize setpoints constant

Select On (true) to reset shift setpoints,
Setpoint 1 to Setpoint 4, to the Reset
setpoint 1 to Reset setpoint 4 values.
Corresponds to INISP in the LCM EDL
block.

Initialize setpoints pointer

Displays a NETWORK 8000 input pointer
string.

Reset setpoint 1 constant

Enter a value to supply the EDL with a
constant input.
Corresponds to RSP1 in the LCM EDL
block.

Reset setpoint 1 pointer

Displays a NETWORK 8000 input pointer
string.

Reset setpoint 2 constant

Enter a value to supply the EDL with a
constant input.
Corresponds to RSP2 in the LCM EDL
block.

Reset setpoint 2 pointer

Displays a NETWORK 8000 input pointer
string.

Reset setpoint 3 constant

Enter a value to supply the EDL with a
constant input.
Corresponds to RSP3 in the LCM EDL
block.
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Property

Description

Reset setpoint 3 pointer

Displays a NETWORK 8000 input pointer
string.

Reset setpoint 4 constant

Enter a value to supply the EDL with a
constant input.
Corresponds to RSP4 in the LCM EDL
block.

Reset setpoint 4 pointer
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string.
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97.124

LcmEDL Properties – Load Status
Inputs Tab
Use the Load Status Inputs tab to view or change the input property values of
LcmEDL.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.
Because the LcmEDL has 64 Load status properties, the properties are divided
between two tabs. This tab applies to Load statuses 1 through 32.

Figure: Load Status Inputs tab

Table: Load Status Inputs Tab
Property

Description

Load status 1 constant to Load status
32 constant

Select On (true) to hold the feedback status
at a constant value.
Corresponds to LD1 to LD32 in the LCM
EDL block.
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Property

Description

Load status 1 pointer to Load status
32 pointer

Displays a NETWORK 8000 input pointer
string.
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97.125

LcmEDL Properties – Load Status
Inputs 2 Tab
Use the Load Status Inputs 2 tab to view or change the input property values of
LcmEDL.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.
Because the LcmEDL has 64 Load status properties, the properties are divided
between two tabs. This tab applies to Load statuses 33 through 64.

Figure: Load Status Inputs 2 tab

Table: Load Status Inputs 2 Tab
Property

Description

Load status 33 constant to Load status Select On (true) or Off (false) to hold the
64 constant
feedback status at a constant value.
Corresponds to LD33 to LD64 in the LCM
EDL block.
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Property

Description

Load status 33 pointer to Load status
64 pointer

Displays a NETWORK 8000 input pointer
string.
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97.126

LcmEDL Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmEDL.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmEDL executes its algorithm.
Writing this parameter causes a reset of the
object.
Corresponds to UPTIM in the LCM EDL
block.

Linear rotate select

Select the type of shed and restore
sequence of operation.
Writing this parameter causes a reset of the
object.
Corresponds to MODE in the LCM EDL
block.
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Continued
Property

Description

Load rotate time

Enter the Load rotate time for the outputs to
remain in a fixed shed pattern before the
outputs are reconfigured (shifted) to the next
load shed configuration. This property is
active if Linear rotate select selects
Rotate.
Corresponds to ROTIM in the LCM EDL
block.

Interstage delay

Enter the delay for the EDL to wait before
shedding or restoring the next load.
Corresponds to DELAY in the LCM EDL
block.

Meter select

Select the type of power meter that is being
monitored.
Writing this parameter causes a reset of the
object.
Corresponds to MTSEL in the LCM EDL
block.

Pulse power constant

Enter the constant value for each change of
state of the power company’s meter relay.
This property is active if the Meter select is
Pulse meter.
Corresponds to PWCON in the LCM EDL
block.

Number of shifts

Enter the number of blocks of time into
which the day is to be split.
Corresponds to SHFTS in the LCM EDL
block.

Start time shift 1

Type the start time for the first shift in hh:mm
24-hour format.
Corresponds to STS1 in the LCM EDL block.

Start time shift 2

Type the start time for the second shift in
hh:mm 24-hour format. This start time is
active only if the Number of shifts is
greater than 1.
Corresponds to STS2 in the LCM EDL block.

Start time shift 3

Type the start time for the third shift in
hh:mm 24-hour format. This start time is
active only if the Number of shifts is
greater than 2.
Corresponds to STS3 in the LCM EDL block.
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Property

Description

Start time shift 4

Type the start time for the fourth shift in
hh:mm 24-hour format. This start time is only
active if the Number of shifts is greater
than 3.
Corresponds to STS4 in the LCM EDL block.

Maximum setpoint 1

Enter the upper limit of the floating setpoint
for shift number 1.
Corresponds to MXSP1 in the LCM EDL
block.

Maximum setpoint 2

Enter the upper limit of the floating setpoint
for shift number 2. This field is active only if
the Number of shifts is greater than 1.
Corresponds to MXSP2 in the LCM EDL
block.

Maximum setpoint 3

Enter the upper limit of the floating setpoint
for shift number 3. This field is active only if
the Number of shifts is greater than 2.
Corresponds to MXSP3 in the LCM EDL
block.

Maximum setpoint 4

Enter the upper limit of the floating setpoint
for shift number 4. This field is active only if
the Number of shifts is greater than 3.
Corresponds to MXSP4 in the LCM EDL
block.

Demand interval

Select the size of the sliding window, over
which the Peak demand is calculated. The
size of the sliding window is usually set to the
power company’s demand interval.
Writing this parameter causes a reset of the
object.
Corresponds to DEINT in the LCM EDL
block.

Sliding window

Enter the size of the sliding window, over
which the current Demand is calculated.
Shedding or restoring is based on this
Demand value.
Corresponds to SLWIN in the LCM EDL
block.

Deadband

Enter the size, in kW consumption, of the
largest load to be shed in the list of priority
slots.
Corresponds to DB in the LCM EDL block.
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Continued
Property

Description

Number of loads

Enter the number of loads that may be shed
by this EDL.
Writing this parameter causes a reset of the
object.
Corresponds to LOADS in the LCM EDL
block.
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97.127

LcmEnthl Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmEnthl.

Figure: Basic tab

Table: Basic Tab
Property

Description

Enthalpy value

Displays the value of the enthalpy input
point.
Corresponds to AV in the LCM ENTHL
block.

Web bulb temperature

Displays the calculated wet bulb
temperature.
Corresponds to WBULB in the LCM ENTHL
block.

Dewpoint temp

Displays the dewpoint temperature.
Corresponds to DEWPT in the LCM ENTHL
block.
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Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM ENTHL
block.

Technical
4078

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.128 LcmEnthl Properties – Inputs Tab

97.128

LcmEnthl Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmEnthl.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM ENTHL
block.

Calculate enable pointer
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string.
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Property

Description

Dry bulb temp constant

Enter a value to supply the LcmEnthl with a
constant dry bulb temperature.
Corresponds to DBULB in the LCM ENTHL
block.

Dry bulb temp pointer

Displays a NETWORK 8000 input pointer
string.

Relative humidity constant

Enter a value to supply the LcmEnthl with a
constant relative humidity input.
Corresponds to RH in the LCM ENTHL
block.

Relative humidity pointer

Displays a NETWORK 8000 input pointer
string.

Dewpoint input constant

Enter a value to supply a constant dewpoint
temperature.
Corresponds to DEWIN in the LCM ENTHL
block.

Dewpoint input pointer

Displays a NETWORK 8000 input pointer
string.

Barometric press English constant

Enter a value to supply the LcmEnthl with a
constant English barometric presure input.
Corresponds to BPRIN in the LCM ENTHL
block.

Barometric press English pointer

Displays a NETWORK 8000 input pointer
string.

Barometric press Metric constant

Enter a value to supply the LcmEnthl with a
constant metric barometric pressure input.
Corresponds to BPRMM in the LCM ENTHL
block.

Barometric press Metric pointer
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97.129

LcmEnthl Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmEnthl.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmEnthl executes its algorithm.
Corresponds to UPTIM in the LCM ENTHL
block.

Input engineering units

Displays the units of measure of LCM input
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to IUNIT in the LCM ENTHL
block.
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Property

Description

Output engineering units

Displays the units of measure of LCM output
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to OUNIT in the LCM ENTHL
block.

Humidity sensor

Select Relative humidity or Dewpoint
input sensor type.
Corresponds to HSSEL in the LCM ENTHL
block.
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97.130

LcmFlow Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmFlow.

Figure: Basic tab

Table: Basic Tab
Property

Description

Flow output

Displays the calculated flow.
Corresponds to AV in the LCM FLOW block.

High flag

Displays On (true) whenever the Input
pressure exceeds the Pressure
maximum value.
Corresponds to HIFLG in the LCM FLOW
block.

Low flag

Displays On (true) whenever the Input
pressure is less than the Pressure
minimum value.
Corresponds to LOFLG in the LCM FLOW
block.
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Property

Description

Static pres hi flag

Displays On (true) whenever the Static
pressure exceeds the Static pres
maximum value.
Corresponds to SHIFL in the LCM FLOW
block.

Static pres low flag

Displays On (true) whenever the Static
pressure is less than the Static pres
minimum value.
Corresponds to SLOFL in the LCM FLOW
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM FLOW
block.
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97.131

LcmFlow Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmFlow.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM FLOW
block.

Calculate enable pointer
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string.
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Property

Description

Input pressure constant

Enter a value to provide the Flow with a
constant differential pressure input. This
prevents reading the value from a sensor.
Corresponds to INPRE in the LCM FLOW
block.

Input pressure pointer

Displays a NETWORK 8000 input pointer
string.

Static pressure constant

Enter a value to provide the Flow with a
constant static pressure input. This prevents
reading the value from a sensor.
Corresponds to STPRE in the LCM FLOW
block.

Static pressure pointer
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97.132

LcmFlow Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmFlow.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmFlow executes its algorithm.
Corresponds to UPTIM in the LCM FLOW
block.

Input engineering units

Displays the units of measure of input
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to IUNIT in the LCM FLOW
block.
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Property

Description

Output engineering units

Displays the units of measure of output
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to OUNIT in the LCM FLOW
block.

Pressure maximum

Enter the maximum Input pressure value
that is used for flow calculations. If the Input
pressure exceeds Pressure maximum,
the output High flag is On (true). If
Pressure maximum is less than
Pressure minimum, the Object status is
Abnormal no input.
Corresponds to PRMX in the LCM FLOW
block.

Pressure minimum

Enter the minimum Input pressure that is
used for flow calculations.
Corresponds to PRMN in the LCM FLOW
block.

Static pres maximum

Enter the maximum Static pressure that is
used for flow calculations. If the Input
pressure exceeds Pressure maximum,
the output High flag is On (true). If
Pressure maximum is less than
Pressure minimum, the Object status is
Abnormal no input.
Corresponds to SPRMX in the LCM FLOW
block.

Static pres minimum

Enter the minimum Static pressure that is
used for flow calculations.
Corresponds to SPRMN in the LCM FLOW
block.

CV flow constant

Enter the scale constant for calculating flow.
NETWORK 8000 GCM/LCM Programmer’s
Manual, (FM 23120)
Writing this parameter causes a reset of the
object.
Corresponds to SCALE in the LCM FLOW
block.
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97.133

LcmHiLo Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmHiLo.

Figure: Basic tab

Table: Basic Tab
Property

Description

Highest value

Displays the highest current input value.
Corresponds to HIVAL in the LCM HILO
block.

High cause

Displays the input that has the highest value.
Corresponds to HICAU in the LCM HILO
block.

Lowest value

Displays the lowest current input value.
Corresponds to LOVAL in the LCM HILO
block.
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Property

Description

Low cause

Displays the input that has the lowest value.
Corresponds to LOCAU in the LCM HILO
block.

Average value

Displays the average of all inputs.
Corresponds to AVG in the LCM HILO block.

Summation

Displays the sum of all inputs.
Corresponds to SUM in the LCM HILO
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM HILO
block.
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97.134

LcmHiLo Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmHiLo.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM HILO
block.

Calculate enable pointer
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string.
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Property

Description

Analog input 1 to Analog input 8
constant

Enter a value to supply the LcmHiLo with a
constant analog input.
Corresponds to AINP1 to AINP8 in the LCM
HILO block.

Analog input 1 to Analog input 8
pointer
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97.135

LcmHiLo Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmHiLo.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmHiLo executes its algorithm.
Corresponds to UPTIM in the LCM HILO
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM HILO
block.

Number of inputs

Enter the number of inputs to be used by the
LcmHiLo.
Corresponds to NOFIN in the LCM HILO
block.
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Property

Description

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value.
Corresponds to INMN in the LCM HILO
block.

Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value.
Corresponds to INMX in the LCM HILO
block.
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97.136

LcmHoli Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmHoli.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the current digital value of the
schedule.
Corresponds to DV in the LCM HOLI block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM HOLI
block.

04-16006-04-en, March 2015

Technical
4095

97 NETWORK 8000 User Interface
97.137 LcmHoli Properties – Inputs Tab

97.137

LcmHoli Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmHoli.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Force not active constant

Select On (true) to force all the outputs to
Not active (Null).
Corresponds to NOACT in the LCM HOLI
block.

Force not active pointer
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Property

Description

Disable constant

Select On (true) to force the schedule to the
Off state.
Corresponds to DISAB in the LCM HOLI
block.

Disable pointer
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97.138

LcmHoli Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmHoli.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmHoli executes its algorithm.
Corresponds to UPTIM in the LCM HOLI
block.

Number of holidays

Enter the number of holidays to be
scheduled.
Corresponds to NOFHO in the LCM HOLI
block.

Changeover time

Enter the time of day when the scheduled
holiday becomes active and the time when it
becomes inactive.
Corresponds to CHTIM in the LCM HOLI
block.
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Continued
Property

Description

Start date 1

Enter the date on which the first holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA1 in the LCM HOLI
block.

Duration 1

Enter the number of days the first holiday is
active.
Corresponds to DUR1 in the LCM HOLI
block.

Start date 2

Enter the date on which the second holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA2 in the LCM HOLI
block.

Duration 2

Enter the number of days the second holiday
is active.
Corresponds to DUR2 in the LCM HOLI
block.

Start date 3

Enter the date on which the third holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA3 in the LCM HOLI
block.

Duration 3

Enter the number of days the third holiday is
active.
Corresponds to DUR3 in the LCM HOLI
block.

Start date 4

Enter the date on which the fourth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA4 in the LCM HOLI
block.

Duration 4

Enter the number of days the fourth holiday
is active.
Corresponds to DUR4 in the LCM HOLI
block.

Start date 5

Enter the date on which the fifth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA5 in the LCM HOLI
block.

Duration 5

Enter the number of days the fifth holiday is
active.
Corresponds to DUR5 in the LCM HOLI
block.

04-16006-04-en, March 2015

Technical
4099

97 NETWORK 8000 User Interface
97.138 LcmHoli Properties – Parameters Tab

Continued
Property

Description

Start date 6

Enter the date on which the sixth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA6 in the LCM HOLI
block.

Duration 6

Enter the number of days the sixth holiday is
active.
Corresponds to DUR6 in the LCM HOLI
block.

Start date 7

Enter the date on which the seventh holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA7 in the LCM HOLI
block.

Duration 7

Enter the number of days the seventh
holiday is active.
Corresponds to DUR7 in the LCM HOLI
block.

Start date 8

Enter the date on which the eighth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA8 in the LCM HOLI
block.

Duration 8

Enter the number of days the eighth holiday
is active.
Corresponds to DUR8 in the LCM HOLI
block.

Start date 9

Enter the date on which the ninth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA9 in the LCM HOLI
block.

Duration 9

Enter the number of days the ninth holiday is
active.
Corresponds to DUR9 in the LCM HOLI
block.

Start date 10

Enter the date on which the tenth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA10 in the LCM HOLI
block.

Duration 10

Enter the number of days the tenth holiday is
active.
Corresponds to DUR10 in the LCM HOLI
block.
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Continued
Property

Description

Start date 11

Enter the date on which the eleventh holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA11 in the LCM HOLI
block.

Duration 11

Enter the number of days the eleventh
holiday is active.
Corresponds to DUR11 in the LCM HOLI
block.

Start date 12

Enter the date on which the twelfth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA12 in the LCM HOLI
block.

Duration 12

Enter the number of days the twelfth holiday
is active.
Corresponds to DUR12 in the LCM HOLI
block.

Start date 13

Enter the date on which the thirteenth
holiday starts, in the format mm-dd-yyyy.
Corresponds to SDA13 in the LCM HOLI
block.

Duration 13

Enter the number of days the thirteenth
holiday is active.
Corresponds to DUR13 in the LCM HOLI
block.

Start date 14

Enter the date on which the fourteenth
holiday starts, in the format mm-dd-yyyy.
Corresponds to SDA14 in the LCM HOLI
block.

Duration 14

Enter the number of days the fourteenth
holiday is active.
Corresponds to DUR14 in the LCM HOLI
block.

Start date 15

Enter the date on which the fifteenth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA15 in the LCM HOLI
block.

Duration 15

Enter the number of days the fifteenth
holiday is active.
Corresponds to DUR15 in the LCM HOLI
block.
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Continued
Property

Description

Start date 16

Enter the date on which the sixteenth holiday
starts, in the format mm-dd-yyyy.
Corresponds to SDA16 in the LCM HOLI
block.

Duration 16

Enter the number of days the sixteenth
holiday is active.
Corresponds to DUR16 in the LCM HOLI
block.
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97.139

LcmLimit Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmLimit.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current analog value of
LcmLimit, based on the configuration and
inputs.
Corresponds to AV in the LCM LIMIT block.

High input flag

Displays On (true) when the input is greater
than Input maximum and has not returned
to a value less than Input maximum minus
Hysteresis.
Corresponds to HIFLG in the LCM LIMIT
block.
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Continued
Property

Description

Low input flag

Displays On (true) when the input is less
than Input minimum value and has not
returned to a value greater than Input
minimum plus Hysteresis.
Corresponds to LOFLG in the LCM LIMIT
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM LIMIT
block.
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97.140

LcmLimit Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmLimit.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM LIMIT
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input constant

Enter a value to supply the LcmLimit with a
constant analog input.
Corresponds to AINP in the LCM LIMIT
block.

Analog input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.141

LcmLimit Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmLimit.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmLimit executes its algorithm.
Corresponds to UPTIM in the LCM LIMIT
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM LIMIT
block.

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value.
Corresponds to INMN in the LCM LIMIT
block.
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Continued
Property

Description

Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value.
Corresponds to INMX in the LCM LIMIT
block.

Hysteresis

Enter the value used to determine the values
at which High input flag and Low input
flag return to Off (false).
Corresponds to HYST in the LCM LIMIT
block.
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97.142

LcmLogic Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmLogic.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the current calculated digital value.
Corresponds to DV in the LCM LOGIC
block.

On value only

Displays the Digital value output, with the
On and Not active (Null) states only.
Corresponds to ONDV in the LCM LOGIC
block.

Off value only

Displays the Digital value output, with the
Off and Not active (Null) states only.
Corresponds to OFFDV in the LCM LOGIC
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM LOGIC
block.
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97.143

LcmLogic Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmLogic.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM LOGIC
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Digital input 1 to Digital input 8
constant

Enter a value to supply the LcmLogic with a
constant digital input.
Corresponds to DINP1 to DINP8 in the LCM
LOGIC block.

Digital input 1 to Digital input 8 pointer Displays a NETWORK 8000 input pointer
string.
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97.144

LcmLogic Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmLogic.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmLogic executes its algorithm.
Corresponds to UPTIM in the LCM LOGIC
block.

Number of inputs

Enter the number of inputs to be used in the
logic function.
Writing this parameter causes a reset of the
object.
Corresponds to NOFIN in the LCM LOGIC
block.
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Continued
Property

Description

Function select

Select the logic function to be executed by
LcmLogic.
Writing this parameter causes a reset of the
object.
Corresponds to ANDOR in the LCM LOGIC
block.

Invert input 1 to Invert input 8

Select Invert to invert the input before it is
used by the main logical function of
LcmLogic.
Corresponds to INVT1 to INVT8 in the LCM
LOGIC block.

Action output

Select Invert to invert the output before it is
used by the main logical function of
LcmLogic.
Corresponds to INOUT in the LCM LOGIC
block.
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97.145

LcmLoop Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmLoop.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current analog value of the PID
control algorithm.
Corresponds to AV in the LCM LOOP block.

Calculated sp

Displays the present setpoint value.
Corresponds to CALSP in the LCM LOOP
block.

Hi limit flag

Displays On (true) whenever the Analog
input exceeds the Input maximum value.
Corresponds to HIFLG in the LCM LOOP
block.
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Continued
Property

Description

Lo limit flag

Displays On (true) whenever the Analog
input is less than the Input minimum
value.
Corresponds to LOFLG in the LCM LOOP
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM LOOP
block.

Self tune loop gains
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Displays the actual PID loop gains when the
LCM LOOP block is in the self tune mode.
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97.146

LcmLoop Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmLoop.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM LOOP
block.

Calculate enable pointer
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string.
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Continued
Property

Description

Analog input constant

Enter a fixed value of the controlled item.
Corresponds to AINP in the LCM LOOP
block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Setpoint constant

Enter a fixed value of the setpoint input.
Corresponds to SP in the LCM LOOP block.

Setpoint pointer

Displays a NETWORK 8000 input pointer
string.

Throttling range constant

Enter the constant value of the throttling
range.
Corresponds to TR in the LCM LOOP block.

Throttling range pointer

Displays a NETWORK 8000 input pointer
string.

Setpt reset enable constant

Select On (true) to enable the setpoint to be
changed (reset) by the Reset inp low
value, Setpt at low value, Reset inp hi
value, and Setpt at hi value.
Corresponds to SRENA in the LCM LOOP
block.

Setpt reset enable pointer

Displays a NETWORK 8000 input pointer
string.

Reset control input constant

Enter the reset control input value. This
disrupts reset of the setpoint.
Corresponds to RINP in the LCM LOOP
block.

Reset control input pointer

Displays a NETWORK 8000 input pointer
string.

Ramp enable constant

Select On (true) to enable the output soft
start ramp action.
Corresponds to RAENA in the LCM LOOP
block.

Ramp enable pointer

Displays a NETWORK 8000 input pointer
string.

Force not active constant

Select On (true) to set the outputs to Not
active (Null).
Corresponds to NOACT in the LCM LOOP
block.

Force not active pointer
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Displays a NETWORK 8000 input pointer
string.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.146 LcmLoop Properties – Inputs Tab

Continued
Property

Description

Control enable constant

Select On (true) to enable Loop control.
Select Off (false) to have the output equal
the Output minimum value.
Corresponds to COENA in the LCM LOOP
block.

Control enable pointer

Displays a NETWORK 8000 input pointer
string.

Output maximum constant

Enter a value that the output cannot be more
than.
Corresponds to OUTMX in the LCM LOOP
block.

Output maximum pointer

Displays a NETWORK 8000 input pointer
string.

Output minimum constant

Enter a value that the output cannot be less
than.
Corresponds to OUTMN in the LCM LOOP
block.

Output minimum pointer

Displays a NETWORK 8000 input pointer
string.

Enable gain change constant

Select On (true) to enable the self tune
feature.
Corresponds to ENCHG in the LCM LOOP
block.

Enable gain change pointer
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97.147

LcmLoop Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmLoop.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmLoop executes its algorithm.
Corresponds to UPTIM in the LCM LOOP
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNIT in the LCM LOOP
block.
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Continued
Property

Description

Input maximum

Enter the maximum value accepted for
Analog input value for calculation. When
exceeded, the Hi limit flag output is On
(true).
Corresponds to INMX in the LCM LOOP
block.

Input minimum

Enter the minimum value accepted for
Analog input value for calculation. When
exceeded, the Lo limit flag output is On
(true).
Corresponds to INMN in the LCM LOOP
block.

Setpoint maximum

Enter the maximum value accepted for
Setpoint.
Corresponds to SPMX in the LCM LOOP
block.

Setpoint minimum

Enter the minimum value accepted for
Setpoint.
Corresponds to SPMN in the LCM LOOP
block.

Tr maximum

Enter the maximum value accepted as
Throttling range value.
Corresponds to TRMX in the LCM LOOP
block.

Tr minimum

Enter the minimum value accepted as
Throttling range value.
Corresponds to TRMN in the LCM LOOP
block.

Action

Select Direct to cause an increase in the
input to increase the output.
Corresponds to ACT in the LCM LOOP
block.

Integral gain

Enter the amount of integral term, in repeats
per minute. Enter 0 for no integral action, or
any value up to 2.0 for maximum integral.
Corresponds to IGAIN in the LCM LOOP
block.

Der gain

Enter the amount of derivative gain (rate), in
minutes. Enter 0 for no derivative action, or
any value up to 12.0 for maximum
derivative.
Corresponds to DERV in the LCM LOOP
block.
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Continued
Property

Description

Output ref

Enter a percentage value, 0 to 100, of the
output value when the input value is at
setpoint.
Corresponds to OUREF in the LCM LOOP
block.

Ramp select

Select Soft start ramp to cause the Loop
output to ramp up after a cold reset as
defined by Ramp start value and Ramp
time properties.
Corresponds to RASEL in the LCM LOOP
block.
Writing this parameter causes a reset of the
object.

Ramp start value

Enter a value of the object output when the
ramp is disabled. This is the output value at
which ramping action starts when the object
is reset. Active if Ramp select is set to Soft
start ramp.
Corresponds to RSTVA in the LCM LOOP
block.

Ramp time

Enter the time (rate) for the ramp action, to
go from 0 to 100%. The rate is not affected
by changes in the Ramp start value. The
range is 1.0 to 180.0 minutes. Active if
Ramp select is set to Soft start ramp.
Corresponds to RATIM in the LCM LOOP
block.

Setpt reset select

Select Setpoint reset to calculate a
setpoint using a reset schedule. Select No
setpoint reset to use the constant
Setpoint input value.
Corresponds to RESEL in the LCM LOOP
block.
Writing this parameter causes a reset of the
object.

Reset input units

Displays the units of measure of the setpoint
reset properties in the LCM LOOP block.
Corresponds to RUNIT in the LCM LOOP
block.

Reset inp low value

Enter the value for the minimum Reset
control input allowed. Active if Setpt
reset select is set to Setpoint reset.
Corresponds to RLOVA in the LCM LOOP
block.

Technical
4122

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.147 LcmLoop Properties – Parameters Tab

Continued
Property

Description

Setpt at low value

Enter the Setpoint value when the Reset
control input equals the Reset inp low
value. Active if Setpt reset select is set to
Setpoint reset.
Corresponds to RSPLO in the LCM LOOP
block.

Reset inp hi value

Enter the value for the maximum Reset
control input allowed. Active if Setpt
reset select is set to Setpoint reset.
Corresponds to RHIVA in the LCM LOOP
block.

Setpt at hi value

Enter the Setpoint value when the Reset
control input equals the Reset inp hi
value. Active if Setpt reset select is set to
Setpoint reset.
Corresponds to RSPHI in the LCM LOOP
block.
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97.148

LcmMath Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmMath.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current analog value, based on
the function selected.
Corresponds to AV in the LCM MATH block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM MATH
block.
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97.149

LcmMath Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmMath.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM MATH
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input 1 constant

Enter a value to supply the LcmMath with a
constant analog input.
Corresponds to AINP1 in the LCM MATH
block.

Analog input 1 pointer

Displays a NETWORK 8000 input pointer
string.

Analog input 2 constant

Enter a value to supply the LcmMath with a
constant analog input.
Corresponds to AINP2 in the LCM MATH
block.

Analog input 2 pointer
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Displays a NETWORK 8000 input pointer
string.
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97.150

LcmMath Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmMath.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmMath executes its algorithm.
Corresponds to UPTIM in the LCM MATH
block.

Engineering units

Displays the units of measure of LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to UNITS in the LCM MATH
block.
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Continued
Property

Description

Output minimum

Enter the minimum value accepted for the
output. Output minimum has priority over
Output maximum with no Abnormal
condition reported.
Corresponds to OUTMN in the LCM MATH
block.

Output maximum

Enter the maximum value accepted for the
output.
Corresponds to OUTMX in the LCM MATH
block.

Function select

Select the function that LcmMath is to
perform. Dividing by zero causes the output
to go to Output maximum.
Corresponds to FUNCT in the LCM MATH
block.

Filter constant

Enter a constant filter value for the LcmMath.
Corresponds to FILTR in the LCM MATH
block.
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97.151

LcmMomen Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmMomen.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital point value

Displays the digital output state.
Corresponds to DV in the LCM MOMEN
block.

Diagnostic error

Displays On (true) when an error is
detected.
Corresponds to DIAGN in the LCM MOMEN
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM
MOMEN block.
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97.152

LcmMomen Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmMomen.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Disable pulse constant

Select On (true) to disable the pulse control
of the physical point.
Corresponds to DSABL in the LCM MOMEN
block.

Disable pulse pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Digital input constant

Enter a value to supply a constant digital
input.
Corresponds to DINP in the LCM MOMEN
block.

Digital input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.153

LcmMomen Properties – Parameters
Tab
Use the Parameters tab to view and edit the configuration properties of
LcmMomen.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmMomen executes its algorithm.
Corresponds to UPTIM in the LCM MOMEN
block.

Physical address local point

Enter the address of the physical point.
Alternatively, select Virtual to use
LcmMomen as a virtual point.
Corresponds to ADDRS in the LCM MOMEN
block.
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Continued
Property

Description

Start stop select

Select Start pulse to cause a pulse when
the Digital input value changes to On
(true).
Corresponds to SSSEL in the LCM MOMEN
block.
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97.154

LcmMtr Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmMtr.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays On (true) when the MTR block is in
the active mode and returns to Off (false) at
the next MTR block execution after the alarm
message has been successfully sent.
Corresponds to DV in the LCM MTR block.

Total run time

Displays the total hours since Start time
during which Digital input value is On. This
output value is maintained through a warm
reset.
Corresponds to RNTIM in the LCM MTR
block.
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Continued
Property

Description

Total on cycles

Displays the total cycles that are counted,
beginning at the Start time, when Digital
input value is On. This output value is
maintained through a warm reset.
Corresponds to CYCLE in the LCM MTR
block.

Remaining days

Displays the difference between the total
number of days since Start time and the
total days in Calendar days limit. This
output value is maintained through a warm
reset.
Corresponds to RMDAY in the LCM MTR
block.

Remaining hours

Displays the difference between the
Elapsed time limit and Total run time.
Corresponds to RMHRS in the LCM MTR
block.

Remaining cycles

Indicates the difference between the On
cycles and the Total on cycles value.
Corresponds to RMCYC in the LCM MTR
block.

Start time

Displays a timestamp indicating when
calculations began. This timestamp is reset
whenever an MTR message is sent. This
output value is maintained through a warm
reset.
Corresponds to STTIM in the LCM MTR
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM MTR
block.
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97.155

LcmMtr Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmMtr.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM MTR
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Digital input constant

Select On (true) and save changes, then
select Off (false) and save changes, to
increment the number of Total on cycles.
Use this only when testing the operation of
LcmMtr. Select Null when not in use.
Corresponds to DI in the LCM MTR block.

Digital input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.156

LcmMtr Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmMtr.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmMtr executes its algorithm.
Corresponds to UPTIM in the LCM MTR
block.

Maintenance reminder type

Select On cycles to count off-to-on cycles.
Select Elapsed time to measure time.
Select Calendar days to count days.
Select Digital state to create an Mtr
message on an occurrence of an event.
Corresponds to MTTYP in the LCM MTR
block.
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Continued
Property

Description

Elapsed time limit

Enter the number of hours that must elapse
before sending an MTR alarm message.
Corresponds to ETLIM in the LCM MTR
block.

On cycles

Enter the number of change-of-state cycles
that must occur before sending an MTR
alarm message.
Corresponds to ONLIM in the LCM MTR
block.

Calendar days limit

Enter the number of days that must elapse
before sending an MTR alarm message.
Corresponds to DALIM in the LCM MTR
block.

Print group

Enter the print group as defined in the LCM.
For more information, see section 96.5
“NETWORK 8000 LCMs” on page 3799.
Corresponds to PRINT in the LCM MTR
block.

Maintenance message

Enter a text message that is part of the alarm
message.
Corresponds to MESSG in the LCM MTR
block.
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LcmOSS Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmOSS.

Figure: Basic tab

Table: Basic Tab
Property

Description

Control enable

Displays the AHU control enable value. The
output is On (true) between the optimum
start time and the optimum stop time.
Corresponds to COENA in the LCM OSS
block.

Damper enable

Displays the AHU damper enable value. The
output is On (true) between the scheduled
occupancy time and the scheduled vacancy
time.
Corresponds to DAENA in the LCM OSS
block.
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Continued
Property

Description

Fan enable

Displays the AHU fan enable value. The
output is On (true) between the optimum
start time and the scheduled vacancy time.
Corresponds to FAENA in the LCM OSS
block.

Heat enable flag

Displays the AHU heat enable value. The
output is On (true) between the optimum
start time and the optimum stop time if the
LcmOSS is in heating mode.
Corresponds to HENFL in the LCM OSS
block.

Cool enable flag

Displays the AHU cool enable value. The
output is On (true) between the optimum
start time and the optimum stop time if the
OSS is in cooling mode.
Corresponds to CENFL in the LCM OSS
block.

Last start time

Displays the date and time of the last
calculated optimum start time, independent
of whether it was for heating or cooling. This
timestamp value is maintained through a
warm reset.
Corresponds to STRTM in the LCM OSS
block.

Time until start

Displays the time remaining before the
optimum start outputs are calculated to
change to ON, independent of whether it is
for heating or cooling.
Corresponds to TMSTR in the LCM OSS
block.

Last stop time

Displays the date and time of the last
calculated optimum stop time, typically for
the previous day, independent of whether it
was for heating or cooling. This timestamp
value is maintained through a warm reset.
Corresponds to STPTM in the LCM OSS
block.

Time until stop

Displays the time remaining before the
output is calculated to change to OFF,
independent of whether it was for heating or
cooling.
Corresponds to TMSTP in the LCM OSS
block.
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Continued
Property

Description

Heat start time

Displays the minutes of early start before
scheduled occupancy time. You can force
this value during checkout or as an
emergency measure.
Corresponds to HTSTR in the LCM OSS
block.

Heat stop time

Displays the minutes of early stop before
scheduled vacancy time. You can force this
value during checkout or as an emergency
measure.
Corresponds to HTSTP in the LCM OSS
block.

Cool start time

Displays the minutes of early start before
scheduled occupancy time. You can force
this value during checkout or as an
emergency measure.
Corresponds to CLSTR in the LCM OSS
block.

Cool stop time

Displays the minutes of early stop before
scheduled vacancy time. You can force this
value during checkout or as an emergency
measure.
Corresponds to CLSTP in the LCM OSS
block.

Table temperature

Displays the current outdoor air temperature
range in which the LCM OSS block is
operating.
Corresponds to TBTMP in the LCM OSS
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM OSS
block.
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97.158

LcmOSS Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmOSS.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM MTR
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Force output value constant

Select On (true) to force outputs to the
value of Force enable.
Corresponds to FOVAL in the LCM OSS
block.

Force output value pointer

Displays a NETWORK 8000 input pointer
string.

Force enable constant

Select On (true) or Off (false) to force
outputs to this value using Force output
value.
Corresponds to FOENA in the LCM OSS
block.

Force enable pointer

Displays a NETWORK 8000 input pointer
string.

Space temperature constant

Enter a value to set the controlled space
temperature. This prevents the normal
operation.
Corresponds to SPACE in the LCM OSS
block.

Space temperature pointer

Displays a NETWORK 8000 input pointer
string.

Setpoint constant

Enter a value to set the space temperature
setpoint.
Corresponds to SP in the LCM OSS block.

Setpoint pointer

Displays a NETWORK 8000 input pointer
string.

Outside air temp constant

Enter a value to set the outside air
temperature. This prevents the normal
operation.
Corresponds to OAT in the LCM OSS block.

Outside air temp pointer

Displays a NETWORK 8000 input pointer
string.

Holiday schedule

Select On (true) to use Occupancy time
for holiday and Vacancy time for
holiday to determine start and stop times
for holidays.
Corresponds to HOSCH in the LCM OSS
block.

Holiday schedule pointer

04-16006-04-en, March 2015

Displays a NETWORK 8000 input pointer
string.

Technical
4145

97 NETWORK 8000 User Interface
97.158 LcmOSS Properties – Inputs Tab

Continued
Property

Description

Heat enable constant

Select On (true) to enable the optimum
start/stop for heating.
Corresponds to HENA in the LCM OSS
block.

Heat enable pointer

Displays a NETWORK 8000 input pointer
string.

Cool enable constant

Select On (true) to enable the optimum
start/stop for cooling.
Corresponds to CENA in the LCM OSS
block.

Cool enable pointer

Displays a NETWORK 8000 input pointer
string.

Freeze table constant

Select On (true) to freeze the values in the
OSS block's Pre-Start/Pre-Stop table and to
prevent the optimal start/stop algorithm from
changing values in the Pre-Start/Pre-Stop
table based on current performance.
Corresponds to FRTAB in the LCM OSS
block.

Freeze table pointer
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97.159

LcmOSS Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmOSS.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmOSS executes its algorithm.
Corresponds to UPTIM in the LCM OSS
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM OSS
block.
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Property

Description

Max prestart time

Enter the maximum number of minutes that
the outputs can be turned on before
scheduled occupancy (optimum start). If no
optimum start is desired, set this value to 0.
Writing this parameter causes a reset of the
object.
Corresponds to MXSTA in the LCM OSS
block.

Max prestop time

Enter the maximum number of minutes that
the outputs can be turned off before
scheduled vacancy (optimum stop). If no
optimum stop is desired, then set this value
to 0.
Writing this parameter causes a reset of the
object.
Corresponds to MXSTP in the LCM OSS
block.

Heat changeover temp

Enter the outdoor air temperature changeover point for OSS heating mode. Outdoor
air temperatures below this point allow the
heating mode to be active.
Corresponds to HCHGO in the LCM OSS
block.

Cool changeover temp

Enter the outdoor air temperature changeover point for OSS cooling mode. Outdoor
air temperatures above this point allow the
cooling mode to be active.
Corresponds to CCHGO in the LCM OSS
block.

Comfort zone

Enter half the space temperature span that is
considered acceptable for comfort. The
allowed comfort zone will then be equal to a
temperature span of setpoint minus
Comfort zone to setpoint plus Comfort
zone.
Corresponds to COMFT in the LCM OSS
block.

Max response delay

Enter the maximum time after the output is
changed to On that the Space
temperature value is expected to change
by at least 0.5°.
Corresponds to MXDLY in the LCM OSS
block.
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LcmOSS Properties – WeeklySchedule
Tab
Use the WeeklySchedule tab to view and edit the occupancy and vacancy times
for weekdays and holidays in LcmOSS.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Occupancy time for Monday

Enter the Monday occupancy time in 24
hour format.
Corresponds to OCCMO in the LCM OSS
block.

Vacancy time for Monday

Enter the Monday vacancy time in 24 hour
format.
Corresponds to VACMO in the LCM OSS
block.

04-16006-04-en, March 2015

Technical
4149

97 NETWORK 8000 User Interface
97.160 LcmOSS Properties – WeeklySchedule Tab

Continued
Property

Description

Occupancy time for Tuesday

Enter the Tuesday occupancy time in 24
hour format.
Corresponds to OCCTU in the LCM OSS
block.

Vacancy time for Tuesday

Enter the Tuesday vacancy time in 24 hour
format.
Corresponds to VACTU in the LCM OSS
block.

Occupancy time for Wednesday

Enter the Wednesday occupancy time in 24
hour format.
Corresponds to OCCWE in the LCM OSS
block.

Vacancy time for Wednesday

Enter the Wednesday vacancy time in 24
hour format.
Corresponds to VACWE in the LCM OSS
block.

Occupancy time for Thursday

Enter the Thursday occupancy time in 24
hour format.
Corresponds to OCCTH in the LCM OSS
block.

Vacancy time for Thursday

Enter the Thursday vacancy time in 24 hour
format.
Corresponds to VACTH in the LCM OSS
block.

Occupancy time for Friday

Enter the Friday occupancy time in 24 hour
format.
Corresponds to OCCFR in the LCM OSS
block.

Vacancy time for Friday

Enter the Friday vacancy time in 24 hour
format.
Corresponds to VACFR in the LCM OSS
block.

Occupancy time for Saturday

Enter the Saturday occupancy time in 24
hour format.
Corresponds to OCCSA in the LCM OSS
block.

Vacancy time for Saturday

Enter the Saturday vacancy time in 24 hour
format.
Corresponds to VACSA in the LCM OSS
block.
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Continued
Property

Description

Occupancy time for Sunday

Enter the Sunday occupancy time in 24 hour
format.
Corresponds to OCCSU in the LCM OSS
block.

Vacancy time for Sunday

Enter the Sunday vacancy time in 24 hour
format.
Corresponds to VACSU in the LCM OSS
block.

Occupancy time for holiday

Enter the holiday occupancy time in 24 hour
format.
Corresponds to OCCHO in the LCM OSS
block.

Vacancy time for holiday

Enter the holiday vacancy time in 24 hour
format.
Corresponds to VACHO in the LCM OSS
block.
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LcmPoll Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmPoll.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the value of the analog output when
the Data type is Analog value.
Corresponds to AV in the LCM POLL block.

Digital value output

Displays the value of the digital point. when
the Data type is Digital value.
Corresponds to DV in the LCM POLL block.

Diagnostic error

Displays On (true) when communication is
lost between StruxureWare and the LCM.
Corresponds to DIAGN in the LCM POLL
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM POLL
block.
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LcmPoll Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmPoll.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM POLL
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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97.163

LcmPoll Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmPoll.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmPoll executes its algorithm.
Corresponds to UPTIM in the LCM POLL
block.

Node address

Displays the logical NETWORK 8000
address of the device from which to request
the data.
Corresponds to NOADD in the LCM POLL
block.

Output name

Display the block attribute name of the
requested data.
Corresponds to NAME in the LCM POLL
block.
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Continued
Property

Description

Data type

Display either Analog value or Digital
value for the data type.
Corresponds to DATYP in the LCM POLL
block.

Analog engineering units

Displays the engineering units of LCM
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to AUNIT in the LCM POLL
block.

Digital engineering units

Displays the On string and Off string of the
LCM digital properties having configurable
units. Non-standard, user-defined LCM
digital units appear as Null.
Corresponds to DUNIT in the LCM POLL
block.
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97.164

LcmPulse Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmPulse.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current point value

Displays a running average (over one minute)
of the pulses per second multiplied by
Scaled constant.
Corresponds to AV in the LCM PULSE
block.

Pulse count total

Displays total pulses since the initialization of
the object. This output value is maintained
through a warm reset.
Corresponds to TOTAL in the LCM PULSE
block.
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Continued
Property

Description

Scaled hourly total

Displays the previous hour's total pulses,
multiplied by Scaled constant. This output
value is maintained through a warm reset.
Corresponds to SCTOT in the LCM PULSE
block.

Diagnostic error

Displays On (true) when communication is
lost between StruxureWare and the GCS.
Corresponds to DIAGN in the LCM PULSE
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM PULSE
block.
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LcmPulse Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmPulse.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM PULSE
block.

Calculate enable pointer
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97.166

LcmPulse Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmPulse.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmPulse executes its algorithm.
Corresponds to UPTIM in the LCM PULSE
block.

Physical address local point

Enter the address of the physical pulse input
point. Alternatively, select Virtual to use the
LcmPulse as a virtual point.
Corresponds to ADDRS in the LCM PULSE
block.
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Continued
Property

Description

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM PULSE
block.

Scaled constant

Enter the scaled value represented by one
pulse.
Corresponds to SCALE in the LCM PULSE
block.

Output maximum

Enter the maximum value limit for the output.
Corresponds to OUTMX in the LCM PULSE
block.

Output minimum

Enter the minimum value limit for the output.
Corresponds to OUTMN in the LCM PULSE
block.

04-16006-04-en, March 2015

Technical
4161

97 NETWORK 8000 User Interface
97.167 LcmPwm Properties – Basic Tab

97.167

LcmPwm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmPwm.

Figure: Basic tab

Table: Basic Tab
Property

Description

Increase

Displays the digital output used to drive open
(increase) a device.
Corresponds to INC in the LCM PWM block.

Decrease

Displays the digital output used to drive
close (decrease) a device.
Corresponds to DEC in the LCM PWM
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM PWM
block.
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97.168

LcmPwm Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmPwm.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM PWM
block.

Calculate enable pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input constant

Enter a value to supply a constant analog
input to the Pwm.
Corresponds to AINP in the LCM PWM
block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Force increase constant

Select On (true) to force Increase to On
(true) and Decrease to Off (false).
Corresponds to FOINC in the LCM PWM
block.

Force increase pointer

Displays a NETWORK 8000 input pointer
string.

Force decrease constant

Select On (true) to force Decrease to On
(true) and Increase to Off (false).
Corresponds to FODEC in the LCM PWM
block.

Force decrease pointer
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Displays a NETWORK 8000 input pointer
string.
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97.169

LcmPwm Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmPwm.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmPwm executes its algorithm.
Corresponds to UPTIM in the LCM PWM
block.

Device time

Enter the time that it takes the actuator to
run from one end of its stroke to the other
end (under load conditions). Use the
direction of travel that takes the longest time.
Corresponds to TIME in the LCM PWM
block.
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4166

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.169 LcmPwm Properties – Parameters Tab

Continued
Property

Description

Deadband

Enter the desired amount near the 50%
value at which the outputs do not call for an
increase or decrease.
Corresponds to DEADB in the LCM PWM
block.
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97.170

LcmRamp Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmRamp.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current analog output value.
Corresponds to AV in the LCM RAMP block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM RAMP
block.
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97.171

LcmRamp Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmRamp.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM RAMP
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Ramp enable constant

Select On (true) to enable the ramp
function.
Corresponds to ENABL in the LCM RAMP
block.

Ramp enable pointer

Displays a NETWORK 8000 input pointer
string.

Force not active constant

Select On (true) to reset the Current analog
value to the Ramp start value. Select Off
(false) to resume ramping.
Corresponds to NOACT in the LCM RAMP
block.

Force not active pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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97.172

LcmRamp Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmRamp.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmRamp executes its algorithm.
Corresponds to UPTIM in the LCM RAMP
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM RAMP
block.

Ramp off value

Enter the output value when Ramp enable
is Off (false).
Corresponds to RMPOF in the LCM RAMP
block.

04-16006-04-en, March 2015

Technical
4171

97 NETWORK 8000 User Interface
97.172 LcmRamp Properties – Parameters Tab

Continued
Property

Description

Ramp start value

Enter the output value of the first calculation
after Ramp enable is changed to On
(true) or when Force not active changes
to Off (false) or Not active (Null).
Corresponds to RMPST in the LCM RAMP
block.

Ramp final value

Enter the output value to be used when the
calculation has completed the ramp
function.
Corresponds to RMPFI in the LCM RAMP
block.

Ramp time

Enter the time for the output to ramp from
the Ramp start value to the Ramp final
value.
Corresponds to RMPTI in the LCM RAMP
block.
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97.173

LcmReset Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmReset.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the analog output value.
Corresponds to AV in the LCM RESET
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM RESET
block.
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97.174

LcmReset Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmReset.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM RESET
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input constant

Enter a value to supply a constant analog
input to the LcmReset.
Corresponds to AINP in the LCM RESET
block.

Analog input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.175

LcmReset Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmReset.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmReset executes its algorithm.
Corresponds to UPTIM in the LCM RESET
block.

Input engineering units

Displays the units of measure of input
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to IUNIT in the LCM RESET
block.

Technical
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Continued
Property

Description

Output engineering units

Displays the units of measure of output
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to OUNIT in the LCM RESET
block.

Input low value

Enter the Analog input value required to
drive Current analog value equal to
Output at low value.
Corresponds to LOVAL in the LCM RESET
block.

Output at low value

Enter the desired value of Current analog
value when Analog input value equals the
Input low value.
Corresponds to LOCAL in the LCM RESET
block.

Input high value

Enter the Analog input value required to
drive Current analog value equal to
Output at hi value.
Corresponds to HIVAL in the LCM RESET
block.

Output at hi value

Enter the value for Current analog value
when Analog input value equals the Input
high value.
Corresponds to HICAL in the LCM RESET
block.

Output maximum

Enter the maximum value limit for the output.
Corresponds to OUTMX in the LCM RESET
block.

Output minimum

Enter the minimum value limit for the output.
Corresponds to OUTMN in the LCM RESET
block.
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97.176

LcmRgcm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmRgcm.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the current analog output value
when the Data type is Analog value.
Corresponds to AV in the LCM RGCM block.

Digital value output

Displays the value of the digital point when
the Data type is Digital value.
Corresponds to DV in the LCM RGCM
block.

Diagnostic error

Displays On (true) when communication is
lost between the Automation Server and the
LCM.
Corresponds to DIAGN in the LCM RGCM
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM RGCM
block.
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97.177

LcmRgcm Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmRgcm.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Default analog input constant

When Data type is Analog value, enter a
value to supply a constant default analog
input if communication to the Automation
Server is lost or if the value becomes
ABNORMAL in the Automation Server.
Corresponds to DFTAV in the LCM RGCM
block.

Default analog input pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Default digital input constant

When Data type is Digital value, enter a
value to supply a constant default digital
input if communication to the Automation
Server is lost or if the value goes
ABNORMAL in the Automation Server.
Corresponds to DFTDV in the LCM RGCM
block.

Default digital input pointer
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Displays a NETWORK 8000 input pointer
string.
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97.178

LcmRgcm Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmRgcm.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmRgcm executes its algorithm.
Corresponds to UPTIM in the LCM RGCM
block.

Data type

Displays the Analog value or Digital
value data type of the block.
Corresponds to DATYP in the LCM RGCM
block.

Analog slot number

Enter the assigned slot address of the
analog value being received when the Data
type is Analog value.
Corresponds to AVNUM in the LCM RGCM
block.
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Continued
Property

Description

Analog engineering units

Displays the engineering units of LCM output
properties having configurable units. Nonstandard, user-defined LCM units appear as
Null.
Corresponds to AUNIT in the LCM RGCM
block.

Digital slot number

When Data type is Digital value, enter the
assigned slot address of the digital value
being received.
Corresponds to DVNUM in the LCM RGCM
block.

Digital engineering units

Displays the On string and Off string of the
LCM digital properties having configurable
units. Non-standard, user-defined LCM
digital units appear as Null.
Corresponds to AUNIT in the LCM RGCM
block.
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97.179

LcmSeq Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmSeq.

Figure: Basic tab

Table: Basic Tab
Property

Description

Number of stages on

Displays the number of outputs that are On
(true).
Corresponds to ONSTG in the LCM SEQ
block.

All on flag

Displays On (true) when all active outputs
are On (true).
Corresponds to ALLON in the LCM SEQ
block.

All off flag

Displays On (true) when all active outputs
are Off (false).
Corresponds to ALLOF in the LCM SEQ
block.
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Continued
Property

Description

Vernier output

Displays the value of the vernier, an analog
output modulating between digital stages, if
Vernier select is set to Vernier.
Corresponds to VERN in the LCM SEQ
block.

Stage 1 to Stage 10

Displays the digital value of the output.
Corresponds to DV1 to DV10 in the LCM
SEQ block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM SEQ
block.

On value only 1 to On value only 10

Displays the same state as the matching
stage output, except On (true) is the only
active state. Off produces a (Null) output
value.
Corresponds to ON1 to ON10 in the LCM
SEQ block.

Off value only 1 to Off value only 10

Displays the same state as the matching
stage output, except Off (false) is the only
active state. On produces a (Null) output
value.
Corresponds to OFF1 to OFF10 in the LCM
SEQ block.
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97.180

LcmSeq Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmSeq.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM SEQ
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Force output value constant

Select the on/off state to use when forcing
the outputs using Force all outputs value.
Corresponds to FOVAL in the LCM SEQ
block.

Force output value pointer

Displays a NETWORK 8000 input pointer
string.

Force all outputs constant

Select On (true) to force all the assigned
stage outputs to the Force output value.
Corresponds to FOUTS in the LCM SEQ
block.

Force all outputs pointer

Displays a NETWORK 8000 input pointer
string.

Analog input constant

Enter a value to supply a constant analog
input.
Corresponds to AINP in the LCM SEQ block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Rotate stages constant

Select Off (false) to rotate to the next
configuration.
Corresponds to ROSTG in the LCM SEQ
block.

Rotate stages pointer
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Displays a NETWORK 8000 input pointer
string.
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97.181

LcmSeq Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmSeq.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmSeq executes its algorithm.
Corresponds to UPTIM in the LCM SEQ
block.

Input high value

Enter the maximum input value at which all
active outputs are On (true).
Writing this parameter causes a reset of the
object.
Corresponds to INHI in the LCM SEQ block.

Input low value

Enter the minimum input at which all active
outputs are Off (false).
Corresponds to INLO in the LCM SEQ block.
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Continued
Property

Description

Number of stages

Enter the number of active outputs.
Writing this parameter causes a reset of the
object.
Corresponds to NSTGS in the LCM SEQ
block.

Sequencing mode

Select either Linear, Rotating, or Binary
sequencing mode. Writing this parameter
causes a reset of LcmSeq.
Corresponds to MODE in the LCM SEQ
block.

Interstage delay on

Enter the delay time required after the
LcmSeq's outputs change, before the next
On stage (greater output) can be
commanded On (true).
Corresponds to DELON in the LCM SEQ
block.

Interstage delay off

Enter the delay time required after the
LcmSeq's outputs change, before the next
Off stage (greater output) can be
commanded Off (false).
Corresponds to DELOF in the LCM SEQ
block.

Vernier select

Select Vernier to use a modulating analog
output between the digital output stages for
either Linear or Rotating mode. Writing
this parameter causes a reset of LcmSeq.
Corresponds to VERNR in the LCM SEQ
block.

Restart value

Select the initial condition of the active
outputs when LcmSeq is reset or on a
power-up condition.
Corresponds to RESTA in the LCM SEQ
block.

Sequence start

Select Linear start to have the outputs of
the Rotating sequencing mode start with
stage 1 at On (true) after all the stages have
been commanded Off (false). Writing this
parameter causes a reset of LcmSeq.
Corresponds to SEQST in the LCM SEQ
block.

Load rotate time

Enter the time allowed for the outputs to
remain in a fixed configuration before the
outputs are shifted to the next configuration.
Corresponds to ROTIM in the LCM SEQ
block.
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97.182

LcmSlcm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmSlcm.

Figure: Basic tab

Table: Basic Tab
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM SLCM
block.
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97.183

LcmSlcm Properties – Digital Inputs Tab
Use the Digital Inputs tab to view or change the digital input property values of
LcmSlcm.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Digital Inputs tab

Table: Digital Inputs Tab
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Property

Description

Digital input 1 to Digital input 32
constant

Displays the constant digital input.

Digital input 1 to Digital input 32
pointer

Displays a NETWORK 8000 input pointer
string.

Corresponds to DIN1 to DIN32 in the LCM
SLCM block.
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97.184

LcmSlcm Properties – Digital Inputs 2
Tab
Use the Digital Inputs 2 tab to view or change the digital input property values of
LcmSlcm.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Digital Inputs 2 tab

Table: Digital Inputs 2 Tab
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Property

Description

Digital input 33 to Digital input 64
constant

Displays the constant digital input.

Digital input 33 to Digital input 64
pointer

Displays a NETWORK 8000 input pointer
string.

Corresponds to DIN33 to DIN64 in the LCM
SLCM block.
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97.185

LcmSlcm Properties – Analog Inputs
Tab
Use the Analog Inputs tab to view or change the analog input property values of
LcmSlcm.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Analog Inputs tab

Table: Analog Inputs Tab
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Property

Description

Analog input 1 to Analog input 4
constant

Displays the constant analog input.

Analog input 1 to Analog input 4
pointer

Displays a NETWORK 8000 input pointer
string.

Corresponds to AIN1 to AIN4 in the LCM
SLCM block.
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97.186

LcmSlcm Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmSlcm.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmSlcm executes its algorithm.
Corresponds to UPTIM in the LCM SLCM
block.

Analog value slots

Displays the number of analog slots required
to send values to the Automation Server.
Corresponds to AVS in the LCM SLCM
block.

Digital value slots

Displays the number of digital slots required
to send values to the Automation Server.
Corresponds to DVS in the LCM SLCM
block.
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97.187

LcmSlect Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmSlect.

Figure: Basic tab

Table: Basic Tab
Property

Description

Current analog value

Displays the value of the analog output when
Data type is Analog value.
Corresponds to AV in the LCM SLECT
block.

Digital value output

Displays the value of the digital point when
Data type is Digital value.
Corresponds to DV in the LCM SLECT
block.
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Continued
Property

Description

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM SLECT
block.
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97.188

LcmSlect Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmSlect.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM SLECT
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input 1 constant

Enter a value to supply a constant analog
input when Data type is Analog value.
Corresponds to AINP1 in the LCM SLECT
block.

Analog input 1 pointer

Displays a NETWORK 8000 input pointer
string.

Analog input 2 constant

Enter a value to supply a constant analog
input when Data type is Analog value.
Corresponds to AINP2 in the LCM SLECT
block.

Analog input 2 pointer

Displays a NETWORK 8000 input pointer
string.

Digital input 1 constant

Enter a value to supply a constant digital
input when Data type is Digital value.
Corresponds to DINP1 in the LCM SLECT
block.

Digital input 1 pointer

Displays a NETWORK 8000 input pointer
string.

Digital input 2 constant

Enter a value to supply a constant digital
input when Data type is Digital value.
Corresponds to DINP2 in the LCM SLECT
block.

Digital input 2 pointer

Displays a NETWORK 8000 input pointer
string.

Input select constant

Select Off (false) to pass input 1 value to
the output or select On (true) to pass input
2 value to the output.
Corresponds to INSEL in the LCM SLECT
block.

Input select pointer
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Displays a NETWORK 8000 input pointer
string.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.189 LcmSlect Properties – Parameters Tab

97.189

LcmSlect Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmSlect.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmSlect executes its algorithm.
Corresponds to UPTIM in the LCM SLECT
block.

Data type

Displays the type of data chosen in the LCM
SLECT block, either Analog value or
Digital value.
Corresponds to DATYP in the LCM SLECT
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM SLECT
block.
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Continued
Property

Description

Input minimum

Enter the lowest analog input value
accepted. Actual input values can be lower,
but are limited to this value.
Corresponds to INMN in the LCM SLECT
block.

Input maximum

Enter the highest analog input value
accepted. Actual input values may be higher,
but are limited to this value.
Corresponds to INMX in the LCM SLECT
block.

Technical
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97.190

LcmTotal Properties – Basic Tab
Use the Basic tab to view information about the output property values of
LcmTotal.

Figure: Basic tab

Table: Basic Tab
Property

Description

Total

Displays accumulated total value since Start
time.
Corresponds to TOTAL in the LCM TOTAL
block.

Hourly total

Displays the hourly total updated at the
change of the hour, according to the system
time clock.
Corresponds to HRTOT in the LCM TOTAL
block.

Start time

Displays the timestamp when LcmTotal was
last initialized.
Corresponds to STTIM in the LCM TOTAL
block.
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Continued
Property

Description

Elapsed time

Displays the elapsed hours since Start time
and returns to 0 (zero) when the total is
initialized.
Corresponds to ELTIM in the LCM TOTAL
block.

Maximum value

Displays the maximum value since LcmTotal
was last initialized.
Corresponds to MXVAL in the LCM TOTAL
block.

Maximum time

Displays the timestamp of the occurrence of
the Maximum value.
Corresponds to MXTIM in the LCM TOTAL
block.

Minimum value

Displays the minimum value since the
LcmTotal was last initialized.
Corresponds to MNVAL in the LCM TOTAL
block.

Minimum time

Displays the timestamp of the occurrence of
the Minimum value.
Corresponds to MNTIM in the LCM TOTAL
block.

Exceeded limit flag

Displays On (true) whenever the Total
output equals or exceeds the Totalization
limit.
Corresponds to EXLIM in the LCM TOTAL
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM TOTAL
block.
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97.191

LcmTotal Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmTotal.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM TOTAL
block.

Calculate enable pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Analog input constant

Enter a value to supply a constant analog
input to LcmTotal.
Corresponds to AINP in the LCM TOTAL
block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Initialize total constant

Select On (true) to initialize the outputs.
Corresponds to INTOT in the LCM TOTAL
block.

Initialize total pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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97.192

LcmTotal Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmTotal.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmTotal executes its algorithm.
Corresponds to UPTIM in the LCM TOTAL
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM TOTAL
block.

Constant

Enter the value of each count or multiplier for
analog values.
Corresponds to CONST in the LCM TOTAL
block.
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Continued
Property

Description

Restart value

Enter the value of the Total output after the
Initialize total input changes from Off
(false) to On (true).
Corresponds to REVAL in the LCM TOTAL
block.

Totalization limit

Enter the value, if equaled or exceeded, that
causes the Exceeded limit flag output to
be On (true).
Corresponds to TOLIM in the LCM TOTAL
block.

Calculation select

Select Analog value to total an analog
value at each update. Select Counter
value to calculate based on a counter such
as a number-of-changes or total type
outputs.
Corresponds to CASEL in the LCM TOTAL
block.
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97.193

LcmTrend Properties – Basic Tab
Use the Basic tab to view information about the output property values of
LcmTrend.

Figure: Basic tab

Table: Basic Tab
Property

Description

Table full

Displays On (true) when Select
continuous or once is Once and the
number of samples taken equal the Total
samples.
Corresponds to TAFUL in the LCM TREND
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM TREND
block.
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97.194

LcmTrend Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmTrend.
Unlike other LCM input properties, the input properties of LcmTrend are valid only
as pointers because it is not possible to set a constant in the LCM's TREND block.
The pointer value property displays the NETWORK 8000 block's input pointer string
or Empty if no pointer has been entered or Not active if the pointer has been
removed.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Enable input constant

Select Off (false) to stop sampling values.
Corresponds to ENABL in the LCM TREND
block.

Enable input pointer

Technical
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Sample input constant

Select On (true) to create a sample input.
This property is displayed when Sample
mode is either Change of state or
Change – off to on.
Corresponds to SAINP in the LCM TREND
block.

Sample input pointer

Displays a NETWORK 8000 input pointer
string.

Print input constant

Select On (true) to cause the trend report to
be sent to the selected Print Group.
Corresponds to PRINP in the LCM TREND
block.

Print input pointer

Displays a NETWORK 8000 input pointer
string.

Reset trend data constant

Select On (true) to clear all sampled data.
Corresponds to RTRDA in the LCM TREND
block.

Reset trend data pointer

Displays a NETWORK 8000 input pointer
string.

Input 1 to Input 4

Displays a NETWORK 8000 input pointer
string to the property being sampled by the
trend.
Corresponds to INP1 to INP4 in the LCM
TREND block.
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97.195

LcmTrend Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmTrend.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmTrend executes its algorithm.
Corresponds to UPTIM in the LCM TREND
block.

User title

Enter a user-defined trend report name.
Corresponds to TITLE in the LCM TREND
block.
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Continued
Property

Description

Number of inputs

Displays the number of inputs to be used by
the trend.
Writing this parameter causes a reset of the
object.
Corresponds to NOFIN in the LCM TREND
block.

Total samples

Enter the total number of samples to be
taken for the trend.
Corresponds to SMPLS in the LCM TREND
block.

Sample mode

Select how the samples are taken for the
trend.
Corresponds to SMODE in the LCM TREND
block.

Sample rate in seconds

Enter the sample rate when Sample mode
is set to Fixed interval – Seconds.
Corresponds to SRSEC in the LCM TREND
block.

Sample rate in minutes

Enter the sample rate when Sample mode
is set to Fixed interval – Minutes.
Corresponds to SRMIN in the LCM TREND
block.

Sample rate in hours

Enter the sample rate when Sample mode
is set to Fixed interval – Hours.
Corresponds to SRHRS in the LCM TREND
block.

Select start stop time

Select Start stop time for sampling only
over a fixed time interval.
Corresponds to SSSTI in the LCM TREND
block.

On time

Enter the time at which the sampling begins.
Corresponds to START in the LCM TREND
block.

Stop time

Enter the time at which the sampling ends.
Corresponds to STOP in the LCM TREND
block.

Select continuous or once

Enter Continuous so that the newest
samples overwrite the oldest samples stored
in the trend.
Corresponds to TMODE in the LCM TREND
block.
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Continued
Property

Description

Select reporting mode

Select Automatic to print a trend report
whenever the total number of samples
equals the Total samples value.
Corresponds to RMODE in the LCM TREND
block.

Print on reset

Select Print to print a trend report whenever
LcmTrend is reset.
Corresponds to PONRE in the LCM TREND
block.

Print Group

Enter the print group as defined in the LCM.
For more information, see section 96.5
“NETWORK 8000 LCMs” on page 3799.
Corresponds to PRINT in the LCM TREND
block.

Samples per page

Enter the number of samples to be printed
on each page in the trend report.
Corresponds to SAMPG in the LCM TREND
block.

Input type 1 to Input type 4

Enter Analog input, Digital input, or
Cause to define the type of data to be
sampled for an input.
Corresponds to INTY1 to INTY4 in the LCM
TREND block.
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97.196

LcmTstat Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmTstat.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the current calculated digital value
when On off control is selected for On-off
or floating mode.
Corresponds to DV in the LCM TSTAT
block.

On value only

Displays the same output as the Digital
value output, with the On (true) and Not
active (Null) states only.
Corresponds to ONDV in the LCM TSTAT
block.
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Continued
Property

Description

Off value only

Displays the same output as the Digital
value output, with the Off (false) and Not
active (Null) states only.
Corresponds to OFFDV in the LCM TSTAT
block.

Drive open

Displays On (true) when driving the
actuator or valve towards the full open
position for Floating control.
Corresponds to OPEN in the LCM TSTAT
block.

Drive close

Displays On (true) when driving the
actuator or valve towards the full close
position for Floating control.
Corresponds to CLOSE in the LCM TSTAT
block.

Input high flag

Displays On (true) whenever Analog input
exceeds the Input maximum value.
Corresponds to HIFLG in the LCM TSTAT
block.

Input low flag

Displays On (true) whenever Analog input
is less than the Input minimum value.
Corresponds to LOFLG in the LCM TSTAT
block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM TSTAT
block.
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97.197

LcmTstat Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmTstat.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
Corresponds to CENAB in the LCM TSTAT
block.

Calculate enable pointer

04-16006-04-en, March 2015

Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Setpoint constant

Enter a value to supply a constant setpoint.
Corresponds to SP in the LCM TSTAT block.

Setpoint pointer

Displays a NETWORK 8000 input pointer
string.

Analog input constant

Enter a value to supply a constant analog
input.
Corresponds to AINP in the LCM TSTAT
block.

Analog input pointer

Displays a NETWORK 8000 input pointer
string.

Input differential constant

Enter a value to supply a constant input
differential.
Corresponds to INDIF in the LCM TSTAT
block.

Input differential pointer
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Displays a NETWORK 8000 input pointer
string.
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97.198

LcmTstat Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of LcmTstat.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmTstat executes its algorithm.
Corresponds to UPTIM in the LCM TSTAT
block.

Engineering units

Displays the units of measure for properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM TSTAT
block.

On-Off or floating mode

Select On off control for single output On
and Off control or Floating control for
floating actuator control.
Corresponds to MODE in the LCM TSTAT
block.
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Continued
Property

Description

Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value.
Corresponds to INMX in the LCM TSTAT
block.

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value.
Corresponds to INMN in the LCM TSTAT
block.

Setpoint maximum

Enter the maximum value accepted as a
setpoint input, for calculation within the
algorithm.
Corresponds to MAXSP in the LCM TSTAT
block.

Setpoint minimum

Enter the minimum value accepted as a
setpoint input, for calculation within the
algorithm.
Corresponds to MINSP in the LCM TSTAT
block.

Minimum differential

Enter the lowest differential value accepted.
Actual input differential values may be lower,
but are limited to this value.
Corresponds to MNDIF in the LCM TSTAT
block.

Anticipation action

Select Action on to add a derivative or
anticipation feature to the LcmTstat
algorithm to reduce the magnitude of the
temperature swings.
Writing this parameter causes a reset of the
object.
Corresponds to ANTIC in the LCM TSTAT
block.

Output action

Select Direct to cause an increase in the
input to increase the output.
Corresponds to ACT in the LCM TSTAT
block.
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97.199

LcmWeek Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
LcmWeek.

Figure: Basic tab

Table: Basic Tab
Property

Description

Digital value output

Displays the current digital value of the
schedule.
Corresponds to DV in the LCM WEEK block.

On value only

Displays the Digital value output when
the state is On (true) or Not active (Null).
Corresponds to ONDV in the LCM WEEK
block.

Off value only

Displays the Digital value output when
the state is Off (false) or Not active (Null).
Corresponds to OFFDV in the LCM WEEK
block.
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Continued
Property

Description

Current analog value

Displays the current analog value of the
schedule.
Corresponds to AV in the LCM WEEK block.

Object status

Displays the status of the object. Initially
displays Stale data until current values are
retrieved from the LCM. The current value
(static) is also displayed when the window is
refreshed. LCM networks with many devices
may require a second refresh.
Corresponds to OBJSTS in the LCM WEEK
block.

Technical
4220

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.200 LcmWeek Properties – Inputs Tab

97.200

LcmWeek Properties – Inputs Tab
Use the Inputs tab to view or change the input property values of LcmWeek.
For each input, either a changeable constant value or a pointer value is displayed:
• The constant value property displays the current fixed input value in the LCM
block. The value will be Null if the property in the LCM block is Not active.
• The pointer value property displays the NETWORK 8000 block's input pointer
string or Empty if no input value exists.

Figure: Inputs tab

Table: Inputs Tab
Property

Description

Force not active constant

Select On (true) to force all outputs to the
Not Active state (Null).
Corresponds to NOACT in the LCM WEEK
block.

Force not active pointer
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Displays a NETWORK 8000 input pointer
string.
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Continued
Property

Description

Disable constant

Select On (true) to force the schedule to the
Off state.
Corresponds to NOACT in the LCM WEEK
block.

Disable pointer

Displays a NETWORK 8000 input pointer
string.

Holiday input constant

Select On (true) to enable the holiday
schedule.
Corresponds to HOLID in the LCM WEEK
block.

Holiday input pointer

Displays a NETWORK 8000 input pointer
string.

On time analog value constant

Enter the Current analog value to be
used when the schedule is on.
Corresponds to ONVAL in the LCM WEEK
block.

On time analog value pointer

Displays a NETWORK 8000 input pointer
string.

Off time analog value constant

Enter the Current analog value to be
used when the schedule is off.
Corresponds to OFVAL in the LCM WEEK
block.

Off time analog value pointer
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Displays a NETWORK 8000 input pointer
string.
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97.201

LcmWeek Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of
LcmWeek.

Figure: Parameters tab

Table: Parameters Tab
Property

Description

Update time

Enter the minimum frequency at which
LcmWeek executes its algorithm.
Corresponds to UPTIM in the LCM WEEK
block.

Engineering units

Displays the units of measure of properties
having configurable units. Non-standard,
user-defined LCM units appear as Null.
Corresponds to UNITS in the LCM WEEK
block.

Active on days

Select the days of the week on which the
daily schedule is active.
Corresponds to ACTDA in the LCM WEEK
block.
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Continued
Property

Description

On time

Enter the time for the normal schedule to
turn on.
Corresponds to ONTIM in the LCM WEEK
block.

Off time

Enter the time for the normal schedule to
turn off.
Corresponds to OFTIM in the LCM WEEK
block.

Holiday on time

Enter the time for the holiday schedule to
turn on.
Corresponds to HONTI in the LCM WEEK
block.

Holiday off time

Enter the time for the holiday schedule to
turn off.
Corresponds to HOFTI in the LCM WEEK
block.
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97.202

LIM Properties – Basic Tab
Use the Basic tab to view information about the output property values of the LIM.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Object status

Displays the status of the object.

Override switch 1 to 14

Displays the output value of the override
switch. Corresponds to OV1 to OV14 in the
GCM LIM block.
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97.203

LIM Properties – Relay Outputs Tab
Use the Relay Outputs tab to view information about the relay output property
values of the LIM.

Figure: Relay Outputs tab

Table: Relay Outputs Tab
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Component

Description

Relay output 1 to Relay output 48

Displays the relay status of RO1 to RO48.
Corresponds to RO1 through RO48 in the
GCM LIM block.
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LIM Properties – Window Values Tab
Use the Window Values tab to view information about the output property values
of the LIM.

Figure: Window Values tab

Table: Window Values Tab
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Component

Description

Window dv1 to Window dv24

Displays the digital value of the attribute
assigned to the input at the WINDD block in
the LIM device. Corresponds to DV1 to
DV24 in the GCM LIM block.

Window av1 to Window av24

Displays the analog value of the attribute
assigned to the input at the WINDA block in
the LIM device. Corresponds to AV1 to
AV24 in the GCM LIM block.
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LIM Properties – Digital Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Digital Inputs tab

Table: Digital Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
LIM block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

EMS control value

Displays On (true) when the EMS control is
on. Corresponds to EMSCO in the GCM LIM
block.

EMS control constant

Enter a value to supply the LIM with a
constant EMS control.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

EMS dv1 to EMS dv24 value

Displays the corresponding digital value in
the LIM’s EMSD block. This input is active
only when Building Operation is
communicating to the LIM device and the
EMS control input is On (true).
Corresponds to DIN1 to DIN24 in the GCM
LIM block.

EMS dv1 to EMS dv24 constant

Enter a value to supply the LIM with a
constant EMS dv1 to EMS dv24.

EMS dv1 to EMS dv24 reference

Enter a reference to get the EMS dv1 to
EMS dv24 from another NETWORK 8000
object.
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97.206

LIM Properties – Analog Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Analog Inputs tab

Table: Analog Inputs Tab
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Component

Description

EMS av1 to EMS av24 value

Displays the value of the EMS av1 to EMS
av24 input. This input is active only when
Building Operation is communicating to the
LIM device and the EMS control value is
On (true). Corresponds to AIN1 through
AIN24 in the GCM LOGIC block.
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Component

Description

EMS av1 to EMS av24 constant

Enter a value to supply the Invert with a
constant EMS av1 to EMS av24 value.

EMS av1 to EMS av24 reference

Enter a reference to get the EMS av1 to EMS
av24 reference from another NETWORK
8000 object.
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97.207

LIM Properties – Parameters Tab
Use the Parameters tab to view and edit the configuration properties of the LIM.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
LIM executes its algorithm. Corresponds to
UPTIM in the GCM LIM block.

Physical address

Enter the physical address of the LIM device
as set by the DIP switches at the device.
Corresponds to ADDR in the GCM LIM
block.
Writing this parameter causes a reset of the
object.

Num of EMS digital

Enter the number of EMS digital inputs of the
LIM that are active. Corresponds to NUMDI
in the GCM LIM block.
Writing this parameter causes a reset of the
object.
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Component

Description

Num of EMS analog

Enter the number of EMS analog inputs of
the LIM that are active. Corresponds to
NUMAI in the GCM LIM block.
Writing this parameter causes a reset of the
object.

Num of win digital

Enter the number of digital window values of
the LIM that are active. Corresponds to
NUMDV in the GCM LIM block.
Writing this parameter causes a reset of the
object.

Num of win analog

Enter the number of analog window values
of the LIM that are active. Corresponds to
NUMAV in the GCM LIM block.
Writing this parameter causes a reset of the
object.

Number of relay outs

Enter the number of relay status outputs that
have active values received from the LIM
device. Corresponds to NUMRO in the GCM
LIM block.
Writing this parameter causes a reset of the
object.

Number of ovrd switches

Enter the number of override switch object
outputs that have active values received
from the LIM device. Corresponds to
NUMOV in the GCM LIM block.
Writing this parameter causes a reset of the
object.

Message enable
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Select the messages that are to be disabled
from the LIM device. Corresponds to EXENA
in the GCM LIM block.
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97.208

Limit Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Limit.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog value of the
Limit, based on the configuration and inputs.
Corresponds to AV in the GCM LIMIT block.

High input flag

Displays On (true) when the input is greter
than Input maximum and has not returned
to a value less than Input maximum minus
Hysteresis. Corresponds to HIFLG in the
GCM LIMIT block.

Low input flag

Displays On (true) when the input is less
than Input minimum value and has not
returned to a value greater than Input
minimum plus Hysteresis. Corresponds
to LOFLG in the GCM LIMIT block.

Object status

Displays the status of the object.
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97.209

Limit Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

04-16006-04-en, March 2015

Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
LIMIT block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Analog input value

Displays the value of the analog input.
Corresponds to AINP in the GCM LIMIT
block.

Analog input constant

Enter a value to supply the Limit with a
constant analog input.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.210

Limit Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Limit.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Limit executes its algorithm. Corresponds to
UPTIM in the GCM LIMIT block.

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value. Corresponds to INMN in
the GCM LIMIT block.

Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value. Corresponds to INMX in
the GCM LIMIT block.

Hysteresis

Enter the value used to determine the values
at which High input flag and Low input
flag return to Off (false). Corresponds to
HYST in the GCM LIMIT block.
Technical
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97.211

Logic Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Logic.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays the current calculated digital value.
Corresponds to DV in the GCM LOGIC
block.

On value only

Displays the Digital value output, except
On (true) is the only active state.
Corresponds to ONDV in the GCM LOGIC
block.

Off value only

Displays the Digital value output, except
Off (false) is the only active state.
Corresponds to OFFDV in the GCM LOGIC
block.

Object status

Displays the status of the object.
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97.212

Logic Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
LOGIC block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWOK 8000 object.

Digital input 1 to digital input 8 value

Displays the digital inputs used by the Logic.
Corresponds to DINP1 to DINP8 in the GCM
LOGIC block.

Digital input 1 to digital input 8
constant

Enter a value to supply the Logic with a
constant digital input.

Digital input 1 to digital input 8
reference

Enter a reference to get the digital input
reference from another NETWOK 8000
object.
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97.213

Logic Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Logic.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Logic executes its algorithm. Corresponds to
UPTIM in the GCM LOGIC block.

Number of inputs

Enter the number of inputs to be used in the
logic function. Corresponds to NOFIN in the
GCM LOGIC block.
Writing this parameter causes a reset of the
object.

Function select

Select the logic function to be executed by
the Logic. Corresponds to ANDOR in the
GCM LOGIC block.
Writing this parameter causes a reset of the
object.
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Component

Description

Invert input 1 to Invert input 8

Select Invert to invert the input before being
used by the main logical function of the
Logic. Corresponds to INVT1 to INVT8 in the
GCM LOGIC block.

Action output

Select Invert to invert the output before
being used by the main logical function of
the Logic. Corresponds to INOUT in the
GCM LOGIC block.
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97.214

Loop Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Loop.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Analog point value

Displays the current analog value of the PID
control algorithm. Corresponds to AV in the
GCM LOOP block.

Calculated sp

Displays the present setpoint value.
Corresponds to CALSP in the GCM LOOP
block.

Hi limit flag

Displays On (true) whenever the Analog
input exceeds the Input maximum value.
Corresponds to HIFLG in the GCM LOOP
block.

Lo limit flag

Displays On (true) whenever the Analog
input is less than the Input minimum
value. Corresponds to LOFLG in the GCM
LOOP block.
Technical
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Component

Description

Object status

Displays the status of the object.
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97.215

Loop Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Property

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
LOOP block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
4245

97 NETWORK 8000 User Interface
97.215 Loop Properties – Inputs Tab

Continued

Technical
4246

Property

Description

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Analog input value

Displays the value of the analog input (the
controlled item). Corresponds to AINP in the
GCM LOOP block.

Analog input constant

Enter a fixed value of the controlled item.

Analog input reference

Enter a reference to get the the analog input
value from another NETWORK 8000 object.

Setpoint input value

Displays the value of the setpoint.
Corresponds to SP in the GCM LOOP block.

Setpoint input constant

Enter a value of the setpoint input.

Setpoint input reference

Enter a reference to get the setpoint input
value from another NETWORK 8000 object.

Throttling range value

Displays the value of the throttling range.
Corresponds to TR in the GCM LOOP block.

Throttling range constant

Enter the constant value of the throttling
range.

Throttling range reference

Enter a reference to get the throttling range
value from another NETWORK 8000 object.

Setpt reset enable value

Displays the value of setpoint reset enable.
Corresponds to SRENA in the GCM LOOP
block.

Setpt reset enable constant

Select On (true) to enable the setpoint to be
changed (reset) by the Reset inp low
value, Setpt at low value, Reset inp hi
value, and Setpt at hi value.

Setpt reset enable reference

Enter a reference to get the setpoint reset
enable value from another NETWORK 8000
object.

Reset control input value

Displays the value of reset control.
Corresponds to RINP in the GCM LOOP
block.

Reset control input constant

Enter the reset control input value. This
disrupts reset of the setpoint.

Reset control input reference

Enter a reference to get the reset control
enable value from another NETWORK 8000
object.

Ramp enable value

Displays the value of the ramp enable.
Corresponds to RAENA in the GCM LOOP
block.
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Property

Description

Ramp enable constant

Select On (true) to enable the output soft
start ramp action.

Ramp enable reference

Enter a reference to get the ramp enable
value from another NETWORK 8000 object.

Force not active value

Displays the value of force not active.
Corresponds to NOACT in the GCM LOOP
block.

Force not active constant

Select On (true) to set the outputs to Not
active (Null).

Force not active reference

Enter a reference to get the force not active
value from another NETWORK 8000 object.

Control enable value

Displays the value of control enable.
Corresponds to COENA in the GCM LOOP
block.

Control enable constant

Select On (true) to enable Loop control.
Select Off (false) to have the output equal
the Output minimum value.

Control enable reference

Enter a reference to get the control enable
value from another NETWORK 8000 object.

Output maximum value

Displays the value of output maximum.
Corresponds to OUTMX in the GCM LOOP
block.

Output maximum constant

Enter a value that the output cannot be more
than.

Output maximum reference

Enter a reference to get output maximum
value from another NETWORK 8000 object.

Output minimum value

Displays the value of output minimum.
Corresponds to OUTMN in the GCM LOOP
block.

Output minimum constant

Enter a value that the output cannot be less
than.

Output minimum reference

Enter a reference to get the output minimum
value from another NETWORK 8000 object.
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97.216

Loop Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Loop.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
Loop executes its algorithm. Corresponds to
UPTIM in the GCM LOOP block.

Input maximum

Enter the maximum value accepted for
Analog input value for calculation. When
exceeded, the Hi limit flag output is On
(true). Corresponds to INMX in the GCM
LOOP block.

Input minimum

Enter the minimum value accepted for
Analog input value for calculation. When
exceeded, the Lo limit flag output is On
(true). Corresponds to INMN in the GCM
LOOP block.
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Component

Description

Setpoint maximum

Enter the maximum value accepted for
Setpoint. Corresponds to SPMX in the
GCM LOOP block.

Setpoint minimum

Enter the minimum value accepted for
Setpoint.Corresponds to SPMN in the
GCM LOOP block.

Tr maximum

Enter the maximum value accepted as
Throttling range value. Corresponds to
TRMX in the GCM LOOP block.

Tr minimum

Enter the minimum value accepted as
Throttling range value. Corresponds to
TRMN in the GCM LOOP block.

Action

Select Direct action (0) to cause an
increase in the input to increase the output.
Corresponds to ACT in the GCM LOOP
block.

Integral gain

Enter the amount of integral term in repeats
per minute. Enter 0.0 for no integral action,
up to 2.0 for maximum integral.
Corresponds to IGAIN in the GCM LOOP
block.

Der gain

Enter the amount of derivative gain (rate) in
minutes. Enter 0.0 for no derivative action,
up to 12.0 for maximum derivative.
Corresponds to DERV in the GCM LOOP
block.

Output ref

Enter a value of percentage of 0 to 100 of
the output value when the input value is at
setpoint. Corresponds to OUREF in the
GCM LOOP block.

Ramp select

Select Soft start ramp (1) to cause the
Loop output to ramp up after a cold reset as
defined by Ramp start value and Ramp
time properties. Corresponds to RASEL in
the GCM LOOP block.
Writing this parameter causes a reset of the
object.

Ramp start value
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Enter a value of the object output when the
ramp is disabled. This is the output value at
which ramping action starts when the object
is reset. Active if Ramp select is set to Soft
start ramp. Corresponds to RSTVA in the
GCM LOOP block.
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Component

Description

Ramp time

Enter the time (rate) for the ramp action to go
from 0 to 100%. The rate is not affected by
changes in the Ramp start value. The
range is 1.0 to 180.0 minutes. Active if
Ramp select is set to Soft start ramp.
Corresponds to RATIM in the GCM LOOP
block.

Setpt reset select

Select Setpoint reset (1) to calculate a
setpoint using a reset schedule. Select No
setpoint reset (0) to use constant Setpoint
input value. Corresponds to RESEL in the
GCM LOOP block.
Writing this parameter causes a reset of the
object.
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Reset inp low value

Enter the value for the minimum Reset
control input allowed. Active if Setpt
reset select is set to Setpoint reset (1).
Corresponds to RLOVA in the GCM LOOP
block.

Setpt at low value

Enter the Setpoint value when the Reset
control input equals the Reset inp low
value. Active if Setpt reset select is set to
Setpoint reset. Corresponds to RSPLO in
the GCM LOOP block.

Reset imp hi value

Enter the value for the maximum Reset
control input allowed. Active if Setpt
reset select is set to Setpoint reset (1).
Corresponds to RHIVA in the GCM LOOP
block.

Setpt at hi value

Enter the Setpoint value when the Reset
control input equals the Reset inp hi
value. Active if Setpt Reset Select is set
to Setpoint reset. Corresponds to RSPHI
in the GCM LOOP block.
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97.217

Math Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Math.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog value based on
the function selected. Corresponds to AV in
the GCM MATH block.

Object status

Displays the status of the object.
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97.218

Math Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays On (true) when Math is
functioning. Corresponds to CENAB in the
GCM MATH block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Analog input 1 value

Displays the value of the analog input 1.
Corresponds to AINP1 in the GCM MATH
block.

Analog input 1 constant

Enter a value to supply Math with a constant
input.

Analog input 1 reference

Enter a reference to get the analog input
from another NETWORK 8000 object.

Analog input 2 value

Displays the value of the analog input 2.
Corresponds to AINP2 in the GCM MATH
block.

Analog input 2 constant

Enter a value to supply Math with a constant
input.

Analog input 2 reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.219

Math Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of Math.

Figure: Parameters tab

Table: Parameters Tab
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Name

Abbreviation and Description

Update time

Enter the minimum frequency at which Math
executes its algorithm. Corresponds to
UPTIM in the GCM MATH block.

Output maximum

Enter the maximum value accepted for the
output. Corresponds to OUTMX in the GCM
MATH block.

Output minimum

Enter the minimum value accepted for the
output. Output minimum has priority over
Output maximum with no Abnormal
condition reported. Corresponds to OUTMN
in the GCM MATH block.
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Name

Abbreviation and Description

Function select

Select the function that Math is to perform.
Dividing by zero causes the output to go to
Output maximum. Corresponds to FUNCT in
the GCM MATH block.
Writing this parameter causes a reset of the
object.
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97.220

MathFilt Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MathFilt.

Figure: Basic tab

Table: Basic Tab
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Name

Description

Current analog value

Displays the current analog value.
Corresponds to AV in the GCM MATH block.

Object status

Displays the status of the object.
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97.221

MathFilt Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Compnent

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
MATH block.

Calculate enable constant

Select On (true) to hold outputs at their last
calculated input value.

Technical
4257

97 NETWORK 8000 User Interface
97.221 MathFilt Properties – Inputs Tab

Continued

Technical
4258

Compnent

Description

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Analog input 1 value

Displays the value of the analog input 1.
Corresponds to AINP1 in the GCM MATH
block.

Analog input 1 constant

Enter a value to supply the MathFilt with a
constant analog input.

Analog input 1 reference

Enter a reference to get the analog input1
from another NETWORK 8000 object.
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97.222

MathFilt Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MathFilt.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
MathFilt executes its algorithm. Corresponds
to UPTIM in the GCM MATH block.

Output minimum

Enter the lowest limit accepted for the
output. Corresponds to OUTMN in the GCM
MATH block.

Output maximum

Enter the highest limit accepted for the
output. Corresponds to OUTMX in the GCM
MATH block.

Filter constant

Enter a constant filter value for the MathFilt.
Corresponds to FILTR in the GCM MATH
block.
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97.223

MathSqRt Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MathSqRt.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog value.
Corresponds to AV in the GCM MATH block.

Object status

Displays the status of the object.
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97.224

MathSqRt Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

04-16006-04-en, March 2015

Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
MATH block.

Calculate enable constant

Select On (true) to hold outputs at their last
calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Analog input 1 value

Displays the value of the analog input 1.
Corresponds to AINP1 in the GCM MATH
block.

Analog input 1 constant

Enter a value to supply the MathSqRt with a
constant analog input.

Analog input 1 reference

Enter a reference to get the analog input1
from another NETWORK 8000 object.
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97.225

MathSqRt Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MathSqRt.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
MathFilt executes its algorithm. Corresponds
to UPTIM in the GCM MATH block.

Output minimum

Enter the lowest limit accepted for the
output. Corresponds to OUTMN in the GCM
MATH block.

Output maximum

Enter the highest limit accepted for the
output. Corresponds to OUTMX in the GCM
MATH block.
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97.226

Mn Properties – Basic Tab
Use the Basic tab to view information about the output property values of the Mn.

Figure: Basic tab

Table: Basic Tab
Component

Description

System fault

Displays the system faults the MicroNet
2000 device is reporting. Corresponds to
FAULT in the GCM MN block.
MicroNet VAV Controller Reference Manual,
(F-25720)

Application error

Displays the application errors the MicroNet
2000 Controller is reporting. Corresponds to
ERROR in the GCM MN block.
MicroNet VAV Controller Reference Manual,
(F-25720)

Technical
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Controller device type

Displays the MicroNet 2000 device type.
Corresponds to TYPE in the GCM MN block.

Object status

Displays the status of the object.
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97.227

Mn Properties – Digital Outputs Tab
Use the Digital Outputs tab to view information about the relay output property
values of the MN-xxx device.

Figure: Digital Outputs tab

Table: Digital Outputs Tab
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Component

Description

Digital output 1 to Digital output 16

Displays the digital output status of DV1 to
DV16. The active outputs are determined by
Num of digital out. Corresponds to DV1
through DV16 in the GCM MN block.
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97.228

Mn Properties – Analog Outputs Tab
Use the Analog Outputs tab to view information about the analog output property
values of the MN-xxxx device.

Figure: Analog Outputs tab

Table: Analog Outputs Tab
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Component

Description

Analog output 1 to Analog output 16

Displays the analog output status of AV1 to
AV16. The active outputs are determined by
Num of analog out. Corresponds to AV1
through AV16 in the GCM MN block.
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97.229

Mn Properties – Digital Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Digital Inputs tab

Table: Digital Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
MN block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

EMS control value

Displays On (true) if the MN device
operates from the EMS commands. Displays
Off (false) when the local commands are
used. Corresponds to EMSCO in the GCM
MN block.

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

Digital input 1 to Digital input 16 value Displays the value of the digital input 1 to
digital input 16. This input is active only when
Building Operation is communicating to the
MicroNet 2000 device and EMS control
value input is On (true). Corresponds to
DIN1 to DIN16 in the GCM MN block.

Technical
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Digital input 1 to Digital input 16
constant

Select On (true) to provide an on input
command.

Digital input 1 to Digital input 16
reference

Enter a reference to get the digital input
command from another NETWORK 8000
object.
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Mn Properties – Analog Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Analog Inputs tab

Table: Analog Inputs Tab
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Component

Description

Analog input 1 to Analog input 8 value

Displays the value of the analog input 1 to
analog input 16. This input is active only
when Building Operation is communicating
to the MicroNet 2000 device and EMS
control value is On (true). Corresponds
to AIN1 to AIN16 in the GCM MN block.
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Technical
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Component

Description

Analog input 1 to Analog input 8
constant

Enter a value to provide an analog input
value.

Analog input 1 to Analog input 8
reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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Mn Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Mn.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
MN executes its algorithm. Corresponds to
UPTIM in the GCM MN block.
Writing this parameter causes a reset of the
object.

Physical address

Enter the physical address of the MicroNet
2000 device as set by the DIP switches at
the device. Corresponds to ADDR in the
GCM MN block.
Writing this parameter causes a reset of the
object.
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Description

Engineering Units

Select Deg C to convert temperature units
being sent or received from the integrator. All
units of measure for properties on the
Analog outputs tab should match this to
prevent conversion errors.

Num of digital in

Enter the number of digital in values of the
MN that are active. Corresponds to NUMDI
in the GCM MN block.
Writing this parameter causes a reset of the
object.

Num of analog in

Enter the number of analog in values of the
MN that are active. Corresponds to NUMAI
in the GCM MN block.
Writing this parameter causes a reset of the
object.

Num of digital out

Enter the number of digital out values of the
MN that are active. Corresponds to NUMDO
in the GCM MN block.
Writing this parameter causes a reset of the
object.

Num of analog out

Enter the number of analog out values of the
MN that are active. Corresponds to NUMAO
in the GCM MN block.
Writing this parameter causes a reset of the
object.

System fault enable

Select the system fault messages that are to
be disabled from the MicroNet 2000 device.
Corresponds to FAENA in the GCM MN
block.

App error enable

Select the application error messages that
are to be disabled from the MicroNet 2000
device. Corresponds to APENA in the GCM
MN block.
Writing this parameter causes a reset of the
object.
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MnFlo Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MnFlo.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Occupancy mode

Displays On (true) when the device is in
occupied mode or the morning warmup
mode. Corresponds to OCCST in the GCM
MNFLO block.

DO1 status

Displays the status of the first digital output.
Corresponds to DO1ST in the GCM MNFLO
block.

DO2 status

Displays the status of the second digital
output. Corresponds to DO2ST in the GCM
MNFLO block.

DO3 status

Displays the status of the third digital output.
Corresponds to DO3ST in the GCM MNFLO
block.

Technical
4273

97 NETWORK 8000 User Interface
97.232 MnFlo Properties – Basic Tab

Continued
Component

Description

Zone temp

Displays the current zone temperature from
the MicroNet 2000 VAV device.
Corresponds to ZNTMP in the GCM MNFLO
block.

Box flow

Displays the current air flow measured by the
MicroNet 2000 VAV device. Corresponds to
FLOW in the GCM MNFLO block.

Cool output

Displays the current demand for cooling.
Corresponds to CLOUT in the GCM MNFLO
block.

Heat output

Displays the current demand for heating.
Corresponds to HTOUT in the GCM MNFLO
block.

Aux temp

Displays the current temperature from an
auxiliary MicroNet Sensor connected to the
device. Corresponds to AXTMP in the GCM
MNFLO block.

Velocity pressure

Displays the current velocity pressure
measured by MicroNet 2000 device.
Corresponds to VPRES in the GCM MNFLO
block.

Override time

Displays the remaining occupied override
time of the MicroNet 2000 VAV device
initiated by the override button on the
sensor. Corresponds to OVTIM in the GCM
MNFLO block.

Control status

Displays the current controlling status of the
MicroNet 2000 VAV device. Corresponds to
CTSTS in the GCM MNFLO block.
MicroNet VAV device Reference Manual, (F25720)

System fault

Displays which system faults the MicroNet
2000 device is reporting. Corresponds to
FAULT in the GCM MNFLO block.
MicroNet VAV Controller Reference Manual,
(F-25720)

Application error

Displays which system faults the MicroNet
2000 Controller is reporting. Corresponds to
ERROR in the GCM MNFLO block.
MicroNet VAV Controller Reference Manual,
(F-25720)

Object status
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Displays the status of the object.
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MnFlo Properties – Setpoints Tab
Use the Setpoints tab to view the setpoint properties of the MnFlo. The setpoints
are dynamic values (variables) calculated by the MnFlo.
Setpoint values are variables with real-time inputs to the control object. The
Setpoints tab shows the source of all real-time data that is feeding the MnFlo. This
tab provides a quick method to view the inputs used by the MnFlo.

Figure: Setpoints tab

Table: Setpoints Tab
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Component

Description

Cool setpoint

Displays the active cooling setpoint.
Corresponds to CLSP in the GCM MnFLO
block.

Heat setpoint

Displays the active heating setpoint.
Corresponds to HTSP in the GCM MnFLO
block.

Unocc heat setpt

Displays the unoccupied heating setpoint.
Corresponds to UHTSP in the GCM MnFLO
block.
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Component

Description

Maximum flow

Displays the maximum flow setpoint.
Corresponds to MXFLO in the GCM MnFLO
block.

Minimum flow

Displays the minimum flow setpoint.
Corresponds to MNFLO in the GCM MnFLO
block.

Reheat minimum flow

Displays the active reheat minimum flow
setpoint. Corresponds to RHMNF in the
GCM MnFLO block.

Unocc minimum flow

Displays the unoccupied minimum flow
setpoint. Corresponds to UNMNF in the
GCM MnFLO block.

Flow setpoint

Displays the active calculated flow setpoint.
Corresponds to FLOSP in the GCM MnFLO
block.
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MnFlo Properties – Command Inputs
Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Command Inputs tab

Table: Command Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
MNFLO block.
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Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Force damper open value

Displays the value of the EMS force damper
open command. This is active when EMS
control value is On (true). Corresponds
to FOPN in the GCM MNFLO block.

Force damper open constant

Select On (true) to force the damper to the
open position. This has a higher priority than
Force damper close value.

Force damper open reference

Enter a reference to get the force damper
open from another NETWORK 8000 object.

Force damper close value

Displays the EMS force damper close
command. This is active when EMS
control value is On (true). Corresponds
to FCLS in the GCM MNFLO block.

Force damper close constant

Select On (true) to force the damper to the
close position. This has a higher priority than
Force damper to max flow value.

Force damper close reference

Enter a reference to get the force damper
close from another NETWORK 8000 object.

Force damper to max flow value

Displays the EMS force damper to maximum
command. This is active when EMS control
is On (true). Corresponds to FMX in the
GCM MNFLO block.

Force damper to max flow constant

Select On (true) to force the damper to the
maximum flow position. This has a higher
priority than Force damper to min flow
value.

Force damper to max flow reference

Enter a reference to get the force damper to
maximum from another NETWORK 8000
object.

Force damper to min flow value

Displays the EMS force damper to minimum
value when EMS control is On (true).
Corresponds to FMN in the GCM MNFLO
block.

Force damper to min flow constant

Select On (true) to force the damper to the
minimum flow position. This has a higher
priority than Force to reheat min value.

Force damper to min flow reference

Enter a reference to get the force damper to
minimum from another NETWORK 8000
object.
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Description

Force to reheat min value

Displays the EMS reheat minimum flow
command. This is active when EMS control
is On (true). Corresponds to FRHMN in the
GCM MNFLO block.

Force to reheat min constant

Select On (true) to force the damper to the
reheat minimum flow position.

Force to reheat min reference

Enter a reference to get the force to reheat
minimum from another NETWORK 8000
object.

DO1 sat command value

Displays the EMS DO1 satellite command
value. This input is active if the DO1 function
is configured for satellite in the MN-FLO-xxx
device and when EMS control value is On
(true). Corresponds to DO1CD in the GCM
MNFLO block.

DO1 sat command constant

Select either On (true) or Off (false) to
hold DO1 status at this value.

DO1 sat command reference

Enter a reference to get the DO1 satellite
command from another NETWORK 8000
object.

DO2 sat command value

Displays the EMS DO2 satellite command
value. This input is active only if the DO2
function is configured for satellite in the MNFLO-xxx device and when EMS control
value is On (true). Corresponds to DOSCD
in the GCM MNFLO block.

DO2 sat command reference

Select either On (true) or Off (false) to
hold DO2 status at this value.

DO2 sat command reference

Enter a reference to get the DO2 satellite
command from another NETWORK 8000
object.

DO3 sat command value

Displays the EMS DO3 satellite command
value. This input is active only if the DO3
function is configured for satellite in the MNFLO-xxx device and when EMS control
value is On (true). Corresponds to DO3CD
in the GCM MNFLO block.

DO3 sat command

Select either On (true) or Off (false) to
hold DO3 status at this value.

DO3 sat command constant reference Enter a reference to get the DO3 satellite
command from another NETWORK 8000
object.
Clear overrides value
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Displays the EMS clear overrides command.
This is active when EMS control value is
On (true). Corresponds to CLOVR in the
GCM MNFLO block.
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Component

Description

Clear overrides constant

Select On (true) to clear and inhibit all EMS
overrides when EMS control value is On
(true).

Clear overrides reference

Enter a reference to get the clear overrides
from another NETWORK 8000 object.

Heat disable value

Displays the EMS heat disable command.
This is active when EMS control is On
(true). Corresponds to HTDIS in the GCM
MNFLO block.

Heat disable constant

Select On (true) to disable all reheat control
when EMS control value is On (true).

Heat disable reference

Enter a reference to get the heat disable
from another NETWORK 8000 object.
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MnFlo Properties – EMS Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: EMS Inputs tab

Table: EMS Inputs Tab
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Component

Description

EMS control value

Displays On (true) if the MN-FLO-xxx
device operates from the EMS setpoints.
Displays Off (false) when the local
commands are used. Corresponds to
EMSCO in the GCM MNFLO block.
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Component

Description

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

EMS morning warmup value

Displays the EMS morning warmup
command when EMS control value is On
(true). Corresponds to EMWAM in the GCM
MN block.

EMS morning warmup constant

Select On (true) to command the MicroNet
2000 VAV device to use morning warmup.

EMS morning warmup reference

Enter a reference to get the EMS morning
warmup from another NETWORK 8000
object.

EMS occupied mode value

Displays the EMS occupied mode when
EMS control value is On (true).
Corresponds to EOCCM in the GCM MN
block.

EMS occupied mode constant

Select On (true) to command the MicroNet
2000 VAV device to occupied mode.

EMS occupied mode reference

Enter a reference to get the EMS occupied
mode from another NETWORK 8000 object.

EMS cool setpt value

Displays the EMS occupied cooling setpoint
when EMS control value is On (true).
Corresponds to ECLSP in the GCM MN
block.

EMS cool setpt constant

Enter a value to supply a constant cooling
setpoint.

EMS cool setpt reference

Enter a reference to get the EMS cool
setpoint from another NETWORK 8000
object.

EMS heat setpt value

Displays the EMS occupied heating setpoint
when EMS control value is On (true).
Corresponds to EHTSP in the GCM MN
block.

EMS heat setpt constant

Enter a value to supply a constant heating
setpoint.

EMS heat setpt reference

Enter a reference to get the EMS heat
setpoint from another NETWORK 8000
object.

EMS unocc heat setpt value

Displays the EMS unoccupied heating
setpoint when EMS control value is On
(true). Corresponds to EHUSP in the GCM
MN block.
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Component

Description

EMS unocc heat setpt constant

Enter a value to supply a constant
unoccupied heat setpoint.

EMS unocc heat setpt reference

Enter a reference to get the EMS
unoccupied heat setpoint from another
NETWORK 8000 object.

EMS max flow value

Displays the EMS maximum flow value
setpoint. This is active when EMS control
value is On (true). Corresponds to EFLMX
in the GCM MN block.

EMS max flow constant

Enter a value to supply a constant maximum
flow setpoint.

EMS max flow reference

Enter a reference to get the EMS maximum
flow from another NETWORK 8000 object.

EMS min flow value

Displays the EMS minimum flow value
setpoint. This is active when EMS control
value is On (true). Corresponds to EFLMN
in the GCM MN block.

EMS min flow constant

Enter a value to supply a constant minimum
flow setpoint.

EMS min flow reference

Enter a reference to get the EMS minimum
flow from another NETWORK 8000 object.

EMS reheat min flow value

Displays the EMS reheat minimum flow
setpoint. This is active when EMS control
value is On (true). Corresponds to ERHMN
in the GCM MN block.

EMS reheat min flow constant

Enter a value to supply a constant reheat
minimum flow setpoint.

EMS reheat min flow reference

Enter a reference to get the EMS reheat
minimum flow from another NETWORK
8000 object.

EMS unocc min flow value

Displays the EMS unoccupied minimum flow
setpoint. This is active when EMS control
value is On (true). Corresponds to EUCMF
in the GCM MN block.

EMS unocc min flow constant

Enter a value to supply a constant
unoccupied minimum flow setpoint.

EMS unocc min flow reference

Enter a reference to get the EMS
unoccupied minimum flow from another
NETWORK 8000 object.
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MnFlo Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MnFlo.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
MnFlo executes its algorithm. Corresponds
to UPTIM in the GCM MNFLO block.

Physical address

Enter the physical address of the MicroNet
VAV device as set by the DIP switches at the
device. Corresponds to ADDR in the GCM
MNFLO block.
Writing this parameter causes a reset of the
object.

System fault enable

Technical
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Select the system fault messages that are to
be disabled from the MicroNet VAV device.
Corresponds to FAENA in the GCM MNFLO
block.
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Component

Description

App error enable

Select the application error messages that
are to be disabled from the MicroNet VAV
device. Corresponds to APENA in the GCM
MNFLO block.
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MnHpfc Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MnHpfc.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Occupied mode

Displays On (true) when the device is in
occupied mode or the morning warmup
mode. Corresponds to DV1 in the GCM MN
block.

DO1 status

Displays the status of the first digital output.
Corresponds to DV2 in the GCM MN block.

DO2 status

Displays the status of the second digital
output. Corresponds to DV3 in the GCM MN
block.

DO3 status

Displays the status of the third digital output.
Corresponds to DV4 in the GCM MN block.
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DI1 status

Displays the status of the digital input.
Corresponds to DV5 in the GCM MN block.

Room temp

Displays the room temperature measured at
the MN-SDK sensor. Corresponds to AV1 in
the GCM MN block.

Temp 2

Displays the analog input from a MN-SDT
Sensor at UM Link address 2. Corresponds
to AV2 in the GCM MN block.

Cooling output

Displays the cooling output in the point
values data store in the MN-HPFC device.
Corresponds to AV3 in the GCM MN block.

Heating output

Displays the heating output in the point
values data store in the MN-HPFC device.
Corresponds to AV4 in the GCM MN block.

Cool setpoint

Displays the current cool setpoint in the
control values data store in the MN-HPFC
device. Corresponds to AV5 in the GCM MN
block.

Heat setpoint

Displays the current heat setpoint in the
control values data store in the MN-HPFC
device. Corresponds to AV6 in the GCM MN
block.

Unoccupied cool sp

Displays the current unocc cooling setpoint
in the control values data store in the MNHPFC device. Corresponds to AV7 in the
GCM MN block.

Unoccupied heat sp

Displays the current unocc heat setpoint in
the control values data store in the MNHPFC device. Corresponds to AV8 in the
GCM MN block.

Override timer

Displays the override timer value in the
control status data store in the MN-HPFC
device. Corresponds to AV9 in the GCM MN
block.

Control status

Displays the control status value in the
control status data store in the MN-HPFC
device. Corresponds to AV10 in the GCM
MN block.

System fault

Displays which system faults the MicroNet
2000 device is reporting. Corresponds to
FAULT in the GCM MN block.
MicroNet Heat Pump and Fan Coil
Reference Manual, (F-26174)
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Application error

Displays which application errors the
MicroNet 2000 device is reporting.
Corresponds to ERROR in the GCM MN
block.
MicroNet Heat Pump and Fan Coil Controller
Reference Manual, (F-26174)
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Controller device type

Displays the MicroNet 2000 device device
type. Corresponds to CTYPE in the GCM
MN block.

Object status

Displays the status of the object.
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MnHpfc Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
MN block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

EMS control value

Displays On (true) if the MICROFLO II
device operates from the EMS commands.
Displays Off (false) when the local
commands are used. Corresponds to
EMSCO in the GCM MN block.

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

Occupied mode value

Displays the EMS occupied mode
command. This is active when EMS
control value is On (true). Corresponds
to DIN1 in the GCM MN block.

Occupied mode constant

Select On (true) to command the MicroNet
2000 device to occupied mode.

Occupied mode reference

Enter a reference to get the occupied mode
from another NETWORK 8000 object.

Changeover value

Displays the EMS heat/cool changeover
command. This is active when EMS
control value is On (true). Corresponds
to DIN2 in the GCM MN block.

Changeover constant

Select On (true) to command the MicroNet
2000 device to changeover.

Changeover reference

Enter a reference to get the changeover from
another NETWORK 8000 object.

Lock out cool value

Displays the EMS disable cooling command.
This is active when EMS control value is
On (true). Corresponds to DIN3 in the GCM
MN block.

Lock out cool constant

Select On (true) to command the MicroNet
2000 device to disable cooling.

Lock out cool reference

Enter a reference to get the lock out cool
from another NETWORK 8000 object.

Lock out heat value

Displays the EMS disable heating command.
This is active when EMS control value is
On (true). Corresponds to DIN4 in the GCM
MN block.

Lock out heat constant

Select On (true) to command the MicroNet
2000 device to disable heating.

Lock out heat reference

Enter a reference to get the lock out heat
from another NETWORK 8000 object.
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Description

Clear overrides value

Displays the EMS clear overrides command.
This is active when EMS control value is
On (true). Corresponds to DIN5 in the GCM
MN block.

Clear overrides constant

Select On (true) to clear and inhibit all EMS
overrides when EMS control value is On
(true).

Clear overrides reference

Enter a reference to get the clear overrides
from another NETWORK 8000 object.

BAS cool setpoint value

Displays the EMS occupied cooling setpoint.
Corresponds to AIN1 in the GCM MN block.

BAS cool setpoint constant

Enter a value to supply a constant cooling
setpoint.

BAS cool setpoint reference

Enter a reference to get the BAS cool
setpoint from another NETWORK 8000
object.

BAS heat setpoint value

Displays the EMS occupied heating setpoint.
This is active when EMS control value is
On (true). Corresponds to AIN2 in the GCM
MN block.

BAS heat setpoint constant

Enter a value to supply a constant heating
setpoint.

BAS heat setpoint reference

Enter a reference to get the BAS heat
setpoint from another NETWORK 8000
object.

BAS unocc cool SP value

Displays the EMS unoccupied cooling
setpoint. This is active when EMS control
value is On (true). Corresponds to AIN3 in
the GCM MN block.

BAS unocc cool SP constant

Enter a value to supply a constant
unoccupied cool setpoint.

BAS unocc cool SP reference

Enter a reference to get the BAS unoccupied
cool setpoint from another NETWORK 8000
object.

BAS unocc heat SP value

Displays the EMS unoccupied heating
setpoint. This is active when EMS control
value is On (true). Corresponds to AIN4 in
the GCM MN block.

BAS unocc heat SP constant

Enter a value to supply a constant
unoccupied heat setpoint.

BAS unocc heat SP reference

Enter a reference to get the BAS unoccupied
heat setpoint from another NETWORK 8000
object.

Technical
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97.239

MnHpfc Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MnHpfc.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
MnFlo executes its algorithm. Corresponds
to UPTIM in the GCM MN block.
The frequency at which the object executes
its algorithm. The range = 1 to 240 seconds.
Default value = 15 seconds.

Physical address

Enter the physical address of the MicroNet
2000 device as set by the DIP switches at
the device. Corresponds to ADDR in the
GCM MNFLO block.
Writing this parameter causes a reset of the
object.

Technical
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Component

Description

System fault enable

Select the system fault messages that are to
be disabled from the MicroNet VAV device.
Corresponds to FAENA in the GCM MN
block.

App error enable

Select the application error message to
disable it from the MicroNet VAV device.
Corresponds to APENA in the GCM MN
block.

Technical
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Momen Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
momen.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab

Technical
4294

Component

Description

Digital point value

Displays the digital output state.
Corresponds to DV in the GCM MOMEN
block.

Diagnostic error

Displays On (true) if there is a loss of
communication between the Automation
Server and the GCS. Corresponds to DIAGN
in the GCM MOMEN block.

Object status

Displays the status of the object.
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97.241

Momen Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Disable pulse value

Displays the value of the disable pulse input.
Corresponds to DISABL in the GCM
MOMEN block.
Technical
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Continued

Technical
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Component

Description

Disable pulse constant

Select On (true) to disable the pulse control
of the physical point. This does not disable
Digital point value.

Disable pulse reference

Enter a reference to get the disable pulse
from another NETWORK 8000 object.

Digital input value

Displays the digital input value. Corresponds
to DIPN in the GCM MOMEN block.

Digital input constant

Enter a value to supply a constant digital
input.

Digital input reference

Enter a reference to get the digital input from
another NETWORK 8000 object.
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97.242

Momen Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Momen.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Momen executes its algorithm. Corresponds
to UPTIM in the GCM MOMEN block.

GCS address

Enter the address of the GCS. Alternatively,
select Not active to use the Momen as a
virtual point.
Writing this parameter causes a reset of the
object.

04-16006-04-en, March 2015

Technical
4297

97 NETWORK 8000 User Interface
97.242 Momen Properties – Parameters Tab

Continued

Technical
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Component

Description

Physical address

Enter the physical address of the physical
point. Alternatively, select Virtual to use the
Momen as a virtual point. Corresponds to
ADDRS in the GCM MOMEN block.

Start stop select

Select Start pulse to cause a pulse when
the Digital input value changes to On
(true). Corresponds to SSSEL in the GCM
MOMEN block.
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97.243

MtrCycle Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MtrCycle.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays On when MtrCycle is in an MTR
active mode and returns to Off at the next
MtrCycle execution after the alarm message
has been successfully sent. Corresponds to
DV in the GCM MTR block.

Total on cycles

Displays the total cycles counted when
Digital input value is On since Start
time. This output value is maintained
through a warm reset. Corresponds to
CYCLE in the GCM MTR block.

Remaining cycles

Indicates the difference between the On
Cycles and the Total on cycles values.
This output value is maintained through a
warm reset. Corresponds to RMCYC in the
GCM MTR block.
Technical
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Continued
Component

Description

Start time

Displays a timestamp indicating when
calculations began. This timestamp is reset
whenever an MTR message is sent. This
output value is maintained through a warm
reset.
Corresponds to STTIM in the GCM MTR
block.

Object status

Technical
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Displays the status of the object.
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97.244

MtrCycle Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable.
Corresponds to CENAB in the GCM Loop
block.

Technical
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Continued
Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value. Corresponds to
CENAB in the GCM Loop block.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
Corresponds to CENAB in the GCM Loop
block.

Technical
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Digital input value

Displays the value of the digital input.
Corresponds to DI in the GCM MTR block.

Digital input constant

Select ON, save changes, and then select
Off. Save the changes to increment the
number of Total on cycles. This should be
used only for testing the operation. Set to
Null when not in use. Corresponds to DI in
the GCM MTR block.

Digital input reference

Enter a reference to get the value of the
digital input from another NETWORK 8000
object. Corresponds to DI in the GCM MTR
block.
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97.245

MtrCycle Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MtrCycle.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
MtrCycle executes its algorithm.
Corresponds to UPTIM in the GCM MTR
block.

On cycles

Enter the number of change-of-state cycles
that must occur before sending an MTR
alarm message. Corresponds to ONLIM in
the GCM MTR block.

Priority

Enter the priority of the Building Operation
alarm.

Category

Enter the alarm category as previously
defined in the Alarm Manager.

Technical
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Continued

Technical
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Component

Description

Alarm Text

Enter a text message that is part of the alarm
message.

Audible alert

Select True to enable an audible
maintenance alert.

Flashing alert

Select True to enable a flashing
maintenance alert.
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97.246

MtrDays Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MtrDays.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays On when MtrDays is in an MTR
active mode and returns to Off at the next
MtrDays execution after the alarm message
has been successfully sent. Corresponds to
DV in the GCM MTR block.

Remaining days

Displays the difference between total-days
since Start time and Calendar days
limit. This output value is maintained
through a warm reset. Corresponds to
RMDAY in the GCM MTR block.

Technical
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Continued
Component

Description

Start time

Displays a timestamp indicating when
calculations began. This timestamp is reset
whenever an MTR message is sent. This
output value is maintained through a warm
reset.
Corresponds to STTIM in the GCM MTR
block.

Object status

Technical
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Displays the status of the object.
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97.247

MtrDays Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
MTR block.

Technical
4307

97 NETWORK 8000 User Interface
97.247 MtrDays Properties – Inputs Tab

Continued
Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value. Corresponds to
CENAB in the GCM MTR block.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
Corresponds to CENAB in the GCM MTR
block.

Technical
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97.248

MtrDays Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MtrDays.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
MtrDays executes its algorithm.
Corresponds to UPTIM in the GCM MTR
block.

Calendar days limit

Enter the number of days that must elapse
before sending an MTR alarm message.
Corresponds to DATIM in the GCM MTR
block.

Priority

Enter the priority of the Building Operation
alarm.

Category

Enter the alarm category as previously
defined in the Alarm Manager.

Technical
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Continued

Technical
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Component

Description

Alarm text

Enter a text message that is part of the alarm
message.

Audible alert

Select True to enable an audible
maintenance alert.

Flashing alert

Select True to enable a flashing
maintenance alert.
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97.249

MtrState Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MtrState.

Figure: Basic tab

Table: Basic Tab
Component

Description

Digital value output

Displays On when MtrState is in an MTR
active mode and returns to Off at the next
MtrState execution after the alarm message
has been successfully sent. Corresponds to
DV in the GCM MTR block.

Start time

Displays a timestamp indicating when
calculations began. This timestamp is reset
whenever an MTR message is sent. This
output value is maintained through a warm
reset.
Corresponds to STTIM in the GCM MTR
block.

Object status
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Displays the status of the object.
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97.250

MtrState Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs tab

Technical
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
Loop block.
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Continued
Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value. Corresponds to
CENAB in the GCM MTR block.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
Corresponds to CENAB in the GCM MTR
block.
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Digital input value

Displays the value of the digital input.
Corresponds to DI in the GCM MTR block.

Digital input constant

Select On (true) to trigger a state MTR
alarm. This should be used only for testing
operations. Corresponds to DI in the GCM
MTR block.

Digital input reference

Enter a reference to get the value of the
digital input from another NETWORK 8000
object. Corresponds to DI in the GCM MTR
block.

Technical
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97.251

MtrState Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MtrState.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
MtrState executes its algorithm.
Corresponds to UPTIM in the GCM MTR
block.

Priority

Enter the priority of the Building Operation
alarm.

Category

Enter the alarm category as previously
defined in the Alarm Manager.

Alarm text

Enter a text message that is part of the alarm
message.

Audible alert

Select True to enable an audible
maintenance alert.
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Component

Description

Flashing alert

Select True to enable a flashing
maintenance alert.

Technical
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97.252

MtrTime Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
MtrTime.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Digital value output

Displays On when MtrTime is in an MTR
active mode and returns to Off at the next
MtrTime execution after the alarm message
has been successfully sent. Corresponds to
DV in the GCM MTR block.

Total run time

Displays the total-hours since Start time
that Digital input value is on. This output
value is maintained through a warm reset.
Corresponds to RNTIM in the GCM MTR
block.

Remaining hours

Displays the difference between the
Elapsed time limit and Total run time.
This output value is maintained through a
warm reset. Corresponds to RMHRS in the
GCM MTR block.
04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.252 MtrTime Properties – Basic Tab

Continued
Component

Description

Start time

Displays a timestamp indicating when
calculations began. This timestamp is reset
whenever an MTR message is sent. This
output value is maintained through a warm
reset.
Corresponds to STTIM in the GCM MTR
block.

Object status
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Displays the status of the object.
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97.253

MtrTime Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of the Calculate enable.
Corresponds to CENAB in the GCM Loop
block.
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Continued
Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value. Corresponds to
CENAB in the GCM Loop block.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
Corresponds to CENAB in the GCM Loop
block.
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Digital input value

Displays the value of the digital input. When
the value is Off, the elapsed time is not
accumulated. Corresponds to DI in the GCM
MTR block.

Digital input constant

Select On (true) to accumulate elapsed
time continuously. Corresponds to DI in the
GCM MTR block.

Digital input reference

Enter a reference to get the value of the
Digital input from another NETWORK 8000
object. Corresponds to DI in the GCM MTR
block.

Technical
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97.254

MtrTime Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the MtrTime.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
MtrTime executes its algorithm.
Corresponds to UPTIM in the GCM MTR
block.

Elapsed time limit

Enter the number of hours that must elapse
before sending an MTR alarm message.
Corresponds to ETLIM in the GCM MTR
block.

Priority

Enter the priority of the Building Operation
alarm.

Category

Enter the alarm category as previously
defined in the Alarm Manager.
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Component

Description

Alarm text

Enter a text message that is part of the alarm
message.

Audible alert

Select True to enable an audible
maintenance alert.

Flashing alert

Select True to enable a flashing
maintenance alert.

Technical
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97.255

OSS Properties – Basic Tab
Use the Basic tab to view information about the output property values of the OSS.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Control enable

Displays the AHU control enable value. The
output is On (true) between the optimum
start time and the optimum stop time.
Corresponds to COENA in the GCM OSS
block.

Damper enable

Displays the AHU damper enable value. The
output is On (true) between the scheduled
occupancy time and the scheduled vacancy
time. Corresponds to DAENA in the GCM
OSS block.

Fan enable

Displays the AHU fan enable value. The
output is On (true) between the optimum
start time and the scheduled vacancy time.
Corresponds to FAENA in the GCM OSS
block.
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Component

Description

Heat enable flag

Displays the AHU heat enable value. The
output is On (true) between the optimum
start time and the optimum stop time if the
OSS is in heating mode. Corresponds to
HENFL in the GCM OSS block.

Cool enable flag

Displays the AHU cool enable value. The
output is On (true) between the optimum
start time and the optimum stop time if the
OSS is in cooling mode. Corresponds to
CENFL in the GCM OSS block.

Last start time

Displays the date and time of the last
calculated optimum start time, independent
of whether it was for heating or cooling. This
timestamp value is maintained through a
warm reset. Corresponds to STRTM in the
GCM OSS block.

Time until start

Displays the time remaining before the
optimum start outputs are calculated to
change to ON, independent of whether it is
for heating or cooling. Corresponds to
TMSTR in the GCM OSS block.

Last stop time

Displays the date and time of the last
calculated optimum stop time, typically for
yesterday, independent of whether it was for
heating or cooling. This timestamp value is
maintained through a warm reset.
Corresponds to STPTM in the GCM OSS
block.

Time until stop

Displays the time remaining before the
output is calculated to change to OFF,
independent of whether it was for heating or
cooling. Corresponds to TMSTP in the GCM
OSS block.

Heat start time

Displays the minutes of early start before the
scheduled occupancy time. The minutes
value comes from the Pre-Start/Pre-Stop
table. Corresponds to HTSTR in the GCM
OSS block.

Heat stop time

Displays the minutes of early stop before the
scheduled un-occupancy time. The minutes
value comes from the Pre-Start/Pre-Stop
table. Corresponds to HTSTP in the GCM
OSS block.

Cool start time

Displays the minutes of early start before the
scheduled occupancy time. The minutes
value comes from the Pre-Start/Pre-Stop
table. Corresponds to CLSTP in the GCM
OSS block.

Technical
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Description

Cool stop time

Displays the minutes of early stop before the
scheduled un-occupancy time. The minutes
value comes from the Pre-Start/Pre-Stop
table. Corresponds to CLSTP in the GCM
OSS block.

Table temperature

Displays the current outdoor air temperature
range in which the OSS block is operating.
Corresponds to TBTMP in the GCM OSS
block.

Object status

Displays the status of the object.

Use the OSS Pre-Start and Pre-Stop list to manually enter or edit values.
Table: OSS Basic tab – Pre-Start/Pre-Stop Table

Technical
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Component

Description

Temperature

Displays the outside air temperatures from 50 to 146 in 4 degree increments.

Pre-Start Heat

Displays the current optimum start time in
minutes for the given outside air temperature
when heating is enabled.

Pre-Start Cool

Displays the current optimum start time in
minutes for the given outside air temperature
when cooling is enabled.

Pre-Stop Heat

Displays the current optimum stop time in
minutes for the given outside air temperature
when heating is enabled.

Pre-Stop Cool

Displays the current optimum stop time in
minutes for the given outside air temperature
when cooling is enabled.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.256 OSS Properties – Schedule Reference Tab

97.256

OSS Properties – Schedule Reference
Tab
Use the Schedule Reference tab to connect the OSS object to the Building
Operation Schedule.

Figure: Schedule Reference tab

Table: Schedule Reference Tab

04-16006-04-en, March 2015

Component

Description

Current present value

Displays the value of a Digital schedule
that is linked to this OSS to provide
scheduling.

Schedule present value reference

Enter a reference to the Value property of
the Digital schedule associated with this
OSS.

Time to next value

Displays the next transition time of a Digital
schedule that is linked to this OSS to
provide scheduling.

Technical
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Technical
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Component

Description

Time to next reference

Enter a reference to the Time to next
transition property of the Digital
schedule associated with this OSS.
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97.257

OSS Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
OSS block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Force output value

Displays the value of the force output value
input. Corresponds to FOVA in the GCM
FLOW block.

Force output value constant

Select On (true) to force outputs to the
value of Force enable value.

Force output value reference

Enter a reference to get the value of force
enable from another NETWORK 8000
object.

Force enable value

Displays the value of the force enable input.
Corresponds to FOENA in the GCM FLOW
block.

Force enable constant

Select On (true) or Off (false) to force
outputs to this value using Force output
value.

Force enable reference

Enter a reference to get the value of force
enable from another NETWORK 8000
object.

Space temperature value

Displays the temperature of the air in the
controlled space. Corresponds to SPACE in
the GCM FLOW block.

Space temperature constant

Enter a value to set the controlled space
temperature. This prevents the normal
operation.

Space temperature reference

Enter a reference to get the controlled space
temperature from another NETWORK 8000
object.

Setpoint value

Displays the setpoint for the desired
temperature in the controlled space. If this
value is Not active (Null), the object
calculates the length of the start and stop
periods, based on observations of the Space
temperature input value. Corresponds to SP
in the GCM FLOW block.

Setpoint constant

Enter a value to set the space temperature
setpoint.

Setpoint reference

Enter a reference to get the controlled space
setpoint from another NETWORK 8000
object.

Outside air temp value

Displays the value of outside air temperature.
Corresponds to OAT in the GCM FLOW
block.
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Component

Description

Outside air temp constant

Enter a value to set the outside air
temperature. This prevents the normal
operation.

Outside air temp reference

Enter a reference to get the outside air
temperature from another NETWORK 8000
object.

Heat enable value

Displays the value of the heat enable input,
which triggers the OSS to operate in
optimum start/stop heating mode.
Corresponds to HENA in the GCM FLOW
block.

Heat enable constant

Select On (true) to enable the optimum
start/stop for heating.

Heat enable reference

Enter a reference to get the heat enable from
another NETWORK 8000 object.

Cool enable value

Displays the value of the cool enable input,
which triggers the OSS to operate in
optimum start/stop cooling mode.
Corresponds to CENA in the GCM FLOW
block.

Cool enable constant

Select On (true) to enable the optimum
start/stop for cooling.

Cool enable reference

Enter a reference to get the cool enable from
another NETWORK 8000 object.

Freeze table value

Displays the value of freeze table signal. If
this input is Off (false), the OSS adjusts the
values in the Pre-Start/Pre-Stop table to
match the building envelope characteristics.
Corresponds to FRTAB in the GCM FLOW
block.

Freeze table constant

Select On (true) to freeze the values in the
Pre-Start/Pre-Stop table.

Freeze table reference

Enter a reference to get the freeze table from
another NETWORK 8000 object.
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97.258

OSS Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the OSS.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
OSS executes its algorithm. Corresponds to
UPTIM in the GCM OSS block.

Max prestart time

Enter the maximum number of minutes that
the outputs can be turned on before
scheduled occupancy (optimum start). If no
optimum start is desired, set this value to 0.
Corresponds to MXSTA in the GCM OSS
block.
Writing this parameter causes a reset of the
object.

Technical
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Component

Description

Max prestop time

Enter the maximum number of minutes that
the outputs can be turned off before
scheduled vacancy (optimum stop). If no
optimum stop is desired, then set this value
to 0. Corresponds to MXSTP in the GCM
OSS block.
Writing this parameter causes a reset of the
object.
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Heat changeover temp

Enter the outdoor air temperature changeover point for OSS heating mode. Outdoor
air temperatures below this point allow the
heating mode to be active. Corresponds to
HTCHGO in the GCM OSS block.

Cool changeover temp

Enter the outdoor air temperature changeover point for OSS cooling mode. Outdoor
air temperatures above this point allow the
cooling mode to be active. Corresponds to
CCHGO in the GCM OSS block.

Comfort zone

Enter one half the space temperature span
that is considered acceptable for comfort.
The allowed comfort zone will then be equal
to a temperature span of setpoint minus
Comfort zone to setpoint plus Comfort
zone. Corresponds to COMFT in the GCM
OSS block.

Max response delay

Enter the maximum time after the output is
changed to On that the Space
temperature value is expected to change
by at least 0.5°. Corresponds to MXDLY in
the GCM OSS block.
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97.259

Pem1 Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Pem1.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Digital input 1

Displays the DV value from the DI:1 block in
the PEM1 device. Corresponds to DI1 in the
GCM PEM1 block.

Digital input 2

Displays the DV value from the DI:2 block in
the PEM1 device. Corresponds to DI2 in the
GCM PEM1 block.

Setpoints input 1

Displays the OUT value from the AS:1 block
in the PEM1 device. Corresponds to AS1 in
the GCM PEM1 block.

Temperature input 1

Displays the OUT value from the AT:2 block
in the PEM1 device. Corresponds to AT1 in
the GCM PEM1 block.
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Component

Description

Temperature input 2

Displays the OUT value from the AT:2 block
in the PEM1 device. Corresponds to AT2 in
the GCM PEM1 block.

Voltage input 1

Displays the OUT value from the AV:1 block
in the PEM1 device. Corresponds to V1 in
the GCM PEM1 block.

Digital output 1 to Digital output 4

Displays the digital output value from the
corresponding DO block in the PEM1
device. Corresponds to DO1 to DO4 in the
GCM PEM1 block.

Analog output 1 to Analog output 4

Displays the analog output value from the
corresponding AO block in the PEM1 device.
Corresponds to AO1 to AO4 in the GCM
PEM1 block.

Object status

Displays the status of the object.
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97.260

Pem1 Properties – Window Values Tab
Use the Window Vaues tab to view the output values of the Pem1.

Figure: Window Values tab

Table: Window Values Tab

Technical
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Component

Description

Window dv1 to Window dv2

Displays the digital value of the attribute
assigned to the respective input at the
WINDO block in the PEM1 device.
Corresponds to DV1 to DV2 in the GCM
PEM1 block.

Window av1 to Window av4

Displays the analog value of the attribute
assigned to the respective input at the
WINDO block in the PEM1 device.
Corresponds to AV1 to AV4 in the GCM
PEM1 block.
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97.261

Pem1 Properties – Digital Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Digital Inputs tab

Table: Digital Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
PEM1 block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

EMS control value

Displays On (true) if the PEM device
operates from the EMS setpoints. Displays
Off (false) when the local setpoints are
used. Corresponds to EMSCO in the GCM
PEM1 block.

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

EMS dv1 to EMS dv4 value

Displays the EMS dv1 to EMS dv4
command values. This is active if EMS
control value is On (true). Corresponds
to EMSDV1 to EMSDV4 in the GCM PEM1
block.

EMS dv1 to EMS dv4 constant

Select either On (true) or Off (false) to
hold EMS dv1 value to EMS dv4 value at
this value.

EMS dv1 to EMS dv4 reference

Enter a reference to get the EMS digital value
1 to digital value 16 from another NETWORK
8000 object.
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97.262

Pem1 Properties – Analog Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Analog Inputs tab

Table: Analog Inputs Tab
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Component

Description

EMS av1 to EMS av16 value

Displays the EMS av1 to EMS av16
command values. Active if EMS control
value is On (true). Corresponds to AIN1 to
AIN16 in the GCM PEM1 block.
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Technical
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Component

Description

EMS av1 to EMS av16 constant

Enter a value to hold analog 1 to analog 16
input at a constant value.

EMS av1 to EMS av16 reference

Enter a reference to get the EMS analog
value 1 to analog value 16 from another
NETWORK 8000 object.
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97.263

Pem1 Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the OSS.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
OSS executes its algorithm. Corresponds to
UPTIM in the GCM PEM1 block.
Enter the minimum frequency at which the
object executes its algorithm.

Physical address

Enter the physical address of the PEM
device as set by the DIP switches at the
device. Corresponds to ADDR in the GCM
PEM1 block.
Writing this parameter causes a reset of the
object.

Message enable
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Select the messages that are to be disabled
from the PEM device. Corresponds to
EXENA in the GCM PEM1 block.
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97.264

PollAv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
PollAv.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Current analog value

Displays the current analog value.
Corresponds to AV in the GCM POLL block.

Diagnostic error

Displays On (true) when communication is
lost between Building Operation and the
LCM. Corresponds to DIAGN in the GCM
POLL block.

Object status

Displays the status of the object.
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97.265

PollAv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM POLL
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
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97.266

PollAv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the PollAv.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
PollAv executes its algorithm. Corresponds
to UPTIM in the GCM POLL block.

LCM address

Enter the physical address of the LCM as
indicated by its DIP switch settings.
Corresponds to NOADD in the GCM POLL
block.

Output name

Enter the name of the LCM block output
attribute to be polled from the LCM.
Corresponds to NAME in the GCM POLL
block. The format is LcmXXX:XXX/XX. For
example, LcmHiLo:T4/AV.
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97.267

PollDv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
PollDv.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Digital value output

Displays the current digital value.
Corresponds to DV in the GCM POLL block.

Diagnostic error

Displays On (true) when communication is
lost between Building Operation and the
LCM. Corresponds to DIAGN in the GCM
POLL block.

Object status

Displays the status of the object.
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97.268

PollDv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

04-16006-04-en, March 2015

Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM POLL
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.269 PollDv Properties – Parameters Tab

97.269

PollDv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the PollDv.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
PollDv executes its algorithm. Corresponds
to UPTIM in the GCM POLL block.

LCM address

Enter the physical address of the LCM as
indicated by its DIP switch settings.
Corresponds to NOADD in the GCM POLL
block.

Output name

Enter the name of the LCM block output
attribute to be polled from the LCM.
Corresponds to NAME in the GCM POLL
block. The format is LcmXXX:XXX/XX. For
example, LcmHiLo:T4/DV.
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97.270

Pulse Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Pulse.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab
Component

Description

Current point value

Displays a running average (over one minute)
of the pulses per second multiplied by
Scaled constant. Corresponds to AV in
the GCM PULSE block.

Pulse count total

Displays total pulses since the initialization of
the object. Corresponds to TOTAL in the
GCM PULSE block.
This output value is maintained through a
warm reset.

Technical
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Scaled hourly total

Displays the previous hours total pulses
multiplied by Scaled constant.
Corresponds to SCTOT in the GCM PULSE
block.
This output value is maintained through a
warm reset.
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Diagnostic error

Displays On (true) when communication is
lost between Building Operation and the
GCS. Corresponds to DIAGN in the GCM
PULSE block.

Object status

Displays the status of the object.
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97.271

Pulse Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM PULSE
block.
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Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.
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97.272

Pulse Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Pulse.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Pulse executes its algorithm. Corresponds to
UPTIM in the GCM PULSE block.

GCS address

Enter the address of the GCS. Alternatively,
select Not active to use the Pulse as a
virtual point.
Writing this parameter causes a reset of the
object.
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Description

Physical address

Enter the physical address of the physical
point. Alternatively, select Virtual to use the
Pulse as a virtual point. Corresponds to
ADDRS in the GCM PULSE block.

Scaled constant

Enter the scaled value represented by one
pulse. Corresponds to SCALE in the GCM
PULSE block.

Output maximum

Enter the maximum value limit for the output.
Corresponds to OUTMX in the GCM PULSE
block.

Output minimum

Enter the minimum value limit for the output.
Corresponds to OUTMN in the GCM PULSE
block.
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97.273

Pwm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Pwm.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Increase

Displays the digital output used to drive open
(increase) a device. Corresponds to INC in
the GCM PWM block.

Decrease

Displays the digital output used to drive
close (decrease) a device. Corresponds to
DEC in the GCM PWM block.

Object status

Displays the status of the object.
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97.274

Pwm Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM PWM
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Analog input value

Displays the value of the analog input.
Corresponds to AINP in the GCM PWM
block.

Analog input constant

Enter a value to supply a constant analog
input to the Pwm.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.

Force increase value

Displays the value of the force increase.
Corresponds to FOINC in the GCM PWM
block.

Force increase constant

Select On (true) to force Increase to On
(true) and Decrease to Off (false).

Force increase reference

Enter a reference to get the force increase
from another NETWORK 8000 object.

Force decrease value

Displays the value of force decrease.
Corresponds to FODEC in the GCM PWM
block.

Force decrease constant

Select On (true) to force the Decrease to
On (true) and the Increase to Off (false).

Force decrease reference

Enter a reference to get the force decrease
from another NETWORK 8000 object.
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97.275

Pwm Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Pwm.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Pwm executes its algorithm. Corresponds to
UPTIM in the GCM PWM block.

Device time

Enter the time that it takes the actuator to
run from one end of its stroke to the other
end (under load conditions). Use the
direction of travel that takes the longest time.
Corresponds to TIME in the GCM PWM
block.
Writing this parameter causes a reset of the
object.
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Deadband

Enter the desired amount around the 50%
value in which the outputs do not call for an
increase or decrease. Corresponds to
DEADB in the GCM PWM block.
Writing this parameter causes a reset of the
object.
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97.276

Ramp Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Ramp.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog output value.
Corresponds to AV in the GCM RAMP block.

Object status

Displays the status of the object.
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97.277

Ramp Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
RAMP block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Ramp enable value

Displays the value of the ramp enable.
Corresponds to ENABL in the GCM RAMP
block.

Ramp enable constant

Select On (true) to enable the ramp
function.

Ramp enable reference

Enter a reference to get the ramp enable
from another NETWORK 8000 object.

Force not active value

Displays the value of force not active.
Corresponds to NOACT in the GCM RAMP
block.

Force not active constant

Select On (true) to reset the Current
analog value to the Ramp start value.
Select Off (false) to resume ramping.

Force not active reference

Enter a reference to get the force not active
from another NETWORK 8000 object.

Technical
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97.278

Ramp Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Ramp.

Figure: Parameters tab

Table: Parameters Tab

Technical
4362

Component

Description

Update time

Enter the minimum frequency at which the
Ramp executes its algorithm. Corresponds
to UPTIM in the GCM RAMP block.

Ramp off value

Enter the output value when Ramp enable
is Off (false). Corresponds to RMPOF in the
GCM RAMP block.

Ramp start value

Enter the output value of the first calculation
after the Ramp enable is changed to On
(true) or when the Force not active
changes to Off (false) or Not active
(Null). Corresponds to RMPST in the GCM
RAMP block.
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Component

Description

Ramp final value

Enter the output value for when the
calculation has completed the ramp
function. Corresponds to RMPFI in the GCM
RAMP block.

Ramp time

Enter the time for the output to ramp from
the Ramp start value to the Ramp final
value. Corresponds to RMPTI in the GCM
RAMP block.

Technical
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97.279

Reset Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Reset.

Figure: Basic tab

Table: Basic Tab

Technical
4364

Component

Description

Current analog value

Displays the current analog output value.
Corresponds to AV in the GCM RESET
block.

Object status

Displays the status of the object.
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97.280

Reset Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
RESET block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Analog input value

Displays the value of the analog input.
Corresponds to ANIP in the GCM RESET
block.

Analog input constant

Enter a value to supply a constant analog
input to the Reset.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.281

Reset Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Reset.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Reset executes its algorithm. Corresponds
to UPTIM in the GCM RESET block.

Input low value

Enter the Analog input value required to
drive Current analog value equal to
Output at low value. Corresponds to
LOVAL in the GCM RESET block.

Output at low value

Enter the desired value of Current analog
value when Analog input value equals
the Input low value. Corresponds to
LOCAL in the GCM RESET block.

Input high value

Enter the Analog input value required to
drive Current analog value equal to
Output at hi value. Corresponds to HIVAL
in the GCM RESET block.
Technical
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Component

Description

Output at hi value

Enter the desired value of Current analog
value when Analog input value equals
the Input high value. Corresponds to
HICAL in the GCM RESET block.

Output maximum

Enter the maximum value limit for the output.
Corresponds to OUTMX in the GCM RESET
block.

Output minimum

Enter the minimum value limit for the output.
Corresponds to OUTMN in the GCM RESET
block.
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97.282

RlcmAv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
RlcmAv. The RlcmAv receives one analog value from a SLCM block in an LCM.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog output value.
Corresponds to AV in the GCM RLCM block.

Diagnostic error

Displays On (true) when communication is
lost between Building Operation and the
LCM. Corresponds to DIAGN in the GCM
RLCM block.

Object status

Displays the status of the object.

Technical
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97.283

RlcmAv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab

Technical
4370

Component

Description

Default analog input value

Displays the value of the default analog
input. Corresponds to DFTAV in the GCM
RCLM block.
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Component

Description

Default analog input constant

Enter a value to supply a constant default
analog input if communication to the LCM is
lost or if the value goes ABNORMAL in the
LCM.

Default analog input reference

Enter a reference to get the value of default
analog input from another NETWORK 8000
object.

Technical
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97.284

RlcmAv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the RlcmAv.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab

Technical
4372

Component

Description

Update time

Enter the minimum frequency at which the
RlcmAv executes its algorithm. Corresponds
to UPTIM in the GCM RCLM block.

LCM number

Enter the local LCM address from where the
data is being sent. Corresponds to LCM in
the GCM RCLM block.

Analog slot number

Enter the assigned slot address of the
analog value being received. Corresponds to
AVNUM in the GCM RCLM block.
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97.285

RlcmDv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
RlcmDv. The RlcmDv receives one digital value from a SLCM block in an LCM.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays the current digital output value.
Corresponds to DV in the GCM RLCM
block.

Diagnostic error

Displays On (true) when communication is
lost between Building Operation and the
LCM. Corresponds to DIAGN in the GCM
RLCM block.

Object status

Displays the status of the object.

Technical
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97.286

RlcmDv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab

Technical
4374

Component

Description

Default digital input value

Displays the value of the default digital input.
Corresponds to DFTDV in the GCM RCLM
block.
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Component

Description

Default digital input constant

Enter a value to supply a constant default
digital input if communication to the LCM is
lost or if the value goes ABNORMAL in the
LCM.

Default digital input reference

Enter a reference to get the value of default
digital input from another NETWORK 8000
object.

Technical
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97.287

RlcmDv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the RlcmDv.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
RlcmDv executes its algorithm. Corresponds
to UPTIM in the GCM RCLM block.

LCM number

Enter the local LCM address from where the
data is being sent. Corresponds to LCM in
the GCM RCLM block.

Digital slot number

Enter the assigned slot address of the digital
value being received. Corresponds to
DVNUM in the GCM RCLM block.
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97.288

RnetAv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
RnetAv.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Current analog value

Displays the current analog output value.
Corresponds to AV in the GCM RNET block.

Diagnostic error

Displays On (true) when the value received
is not a valid NETWORK 8000 interface
numeric value such as a Null value.
Corresponds to DIAGN in the GCM RNET
block.

Object status

Displays the status of the object.

Technical
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97.289

RnetAv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
4378

Component

Description

Analog global value

Displays the value of the analog global input.

Analog global reference

Enter a reference to get the analog value
from another object that is not a NETWORK
8000 object.
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
RNET block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Default analog input value

Displays the value of the default digital input.
Corresponds to DFTAV in the GCM RNET
block.

Default analog input constant

Enter a value to supply a constant default
analog input if communication to the LCM is
lost or if the value goes ABNORMAL in the
LCM.

Default analog input reference

Enter a reference to get the value of default
analog input from another NETWORK 8000
object.

Technical
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97.290

RnetAv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the RnetAv.

Figure: Parameters tab

Table: Parameters Tab

Technical
4380

Component

Description

Update time

Enter the minimum frequency at which the
RnetAv executes its algorithm. Corresponds
to UPTIM in the GCM RNET block.
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97.291

RnetDv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
RnetDv.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays the current digital output value.
Corresponds to DV in the GCM RNET block

Diagnostic error

Displays On (true) when the value received
is not a valid NETWORK 8000 interface
numeric value such as a Null value.
Corresponds to DIAGN in the GCM RNET
block.

Object status

Displays the status of the object.

Technical
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97.292

RnetDv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
4382

Component

Description

Digital global value

Displays the value of the digital global input.

Binary global reference

Enter a reference to get the binary value from
another object that is not a NETWORK 8000
object.
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
RNET block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Default digital input value

Displays the value of the default digital input.
Corresponds to DFTDV in the GCM RNET
block.

Default digital input constant

Enter a value to supply a constant default
digital input if communication to the LCM is
lost or if the value goes ABNORMAL in the
LCM.

Default digital input reference

Enter a reference to get the value of default
digital input from another NETWORK 8000
object.

Technical
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97.293

RnetDv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the RnetDv.

Figure: Parameters tab

Table: Parameters Tab

Technical
4384

Component

Description

Update time

Enter the minimum frequency at which the
RnetDv executes its algorithm. Corresponds
to UPTIM in the GCM RNET block.

04-16006-04-en, March 2015

97 NETWORK 8000 User Interface
97.294 SeqBin Properties – Basic Tab

97.294

SeqBin Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
SeqBin.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Number of stages on

Displays the number of outputs that are On
(true). Corresponds to ONSTG in the GCM
SEQ block.

All on flag

Displays On (true) when all active outputs
are On (true). Corresponds to ALLON in the
GCM SEQ block.

All off flag

Displays On (true) when all active outputs
are Off (false). Corresponds to ALLOF in
the GCM SEQ block.

Stage 1 to Stage 10

Displays the digital value of the output.
Corresponds to DV1 to DV10 in the GCM
SEQ block.

Technical
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Technical
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Component

Description

Object status

Displays the status of the object.

On value only 1 to On value only 10

Displays the same state as the matching
Stage output, except On (true) is the only
active state. Off produces a (Null) output
value. Corresponds to ON1 to ON10 in the
GCM SEQ block.

Off value only 1 to Off value only 10

Displays the same state as the matching
Stage output, except Off (false) is the only
active state. On produces a (Null) output
value. Corresponds to OFF1 to OFF10 in the
GCM SEQ block.
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97.295

SeqBin Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM SEQ
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Force output value

Displays the force output value input.
Corresponds to FOVAL in the GCM SEQ
block.

Force output value constant

Select the on/off state to use when forcing
the outputs using Force all outputs
value.

Force output value reference

Enter a reference to get the force output
from another NETWORK 8000 object.

Force all outputs value

Displays the force all outputs input.
Corresponds to FOUTS in the GCM SEQ
block.

Force all outputs constant

Select On (true) to force all the assigned
stage outputs to the Force output value.

Force all outputs reference

Enter a reference to get the force all outputs
from another NETWORK 8000 object.

Analog input value

Displays the value of the control signal input.
Corresponds to AINP in the GCM SEQ
block.

Analog input constant

Enter a value to supply a constant analog
input.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.296

SeqBin Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the SeqBin.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
SeqBin executes its algorithm. Corresponds
to UPTIM in the GCM SEQ block.

Input high value

Enter the maximum input value at which all
active outputs are On (true). Corresponds
to INHI in the GCM SEQ block.
Writing this parameter causes a reset of the
object.

Input low value

Enter the minimum input at which all active
outputs are Off (false). Corresponds to
INLO in the GCM SEQ block.
Writing this parameter causes a reset of the
object.
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Component

Description

Number of stages

Enter the number of active outputs.
Corresponds to NSTGS in the GCM SEQ
block.
Writing this parameter causes a reset of the
object.

Interstage delay on

Enter the delay time required after the
SeqBin's outputs change, before the next on
stage (greater output) can be commanded
On (true). Corresponds to DELON in the
GCM SEQ block.

Interstage delay off

Enter the delay time required after the
SeqBin's outputs change, before the next off
stage (greater output) can be commanded
Off (false). Corresponds to DELOF in the
GCM SEQ block.

Restart value

Select the initial condition of the active
outputs when the SeqBin is reset or on a
power-up condition. Corresponds to RESTA
in the GCM SEQ block.
Writing this parameter causes a reset of the
object.

Technical
4390
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97.297

SeqLin Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
SeqLin.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Number of stages on

Displays the number of outputs that are On
(true). Corresponds to ONSTG in the GCM
SEQ block.

All on flag

Displays On (true) when all active outputs
are On (true). Corresponds to ALLON in the
GCM SEQ block.

All off flag

Displays On (true) when all active outputs
are Off (false). Corresponds to ALLOF in
the GCM SEQ block.

Vernier output

Displays the value of the vernier, an analog
output modulating between digital stages, if
Vernier select is set to Vernier.
Corresponds to VERN in the GCM SEQ
block.
Technical
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Technical
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Component

Description

Stage 1 to Stage 10

Displays the digital value of the output.
Corresponds to DV1 to DV10 in the GCM
SEQ block.

Object status

Displays the status of the object.

On value only 1 to On value only 10

Displays the same state as the matching
stage output, except On (true) is the only
active state. Off produces a (Null) output
value. Corresponds to ON1 to ON10 in the
GCM SEQ block.

Off value only 1 to Off value only 10

Displays the same state as the matching
stage output, except Off (false) is the only
active state. On produces a (Null) output
value. Corresponds to OFF1 to OFF10 in the
GCM SEQ block.
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97.298

SeqLin Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM SEQ
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
4393

97 NETWORK 8000 User Interface
97.298 SeqLin Properties – Inputs Tab

Continued

Technical
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Force output value

Displays the force output value input.
Corresponds to FOVAL in the GCM SEQ
block.

Force output value constant

Select the on/off state to use when forcing
the outputs using Force all outputs
value.

Force output value reference

Enter a reference to get the force output
from another NETWORK 8000 object.

Force all outputs value

Displays the force all outputs input.
Corresponds to FOUTS in the GCM SEQ
block.

Force all outputs constant

Select On (true) to force all the assigned
stage outputs to the Force output value.

Force all outputs reference

Enter a reference to get the force all outputs
from another NETWORK 8000 object.

Analog input value

Displays the value of the control signal input.
Corresponds to AINP in the GCM SEQ
block.

Analog input constant

Enter a value to supply a constant analog
input.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.299

SeqLin Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the SeqLin.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
SeqLin executes its algorithm. Corresponds
to UPTIM in the GCM SEQ block.

Input high value

Enter the maximum input value at which all
active outputs are On (true). Corresponds
to INHI in the GCM SEQ block.
Writing this parameter causes a reset of the
object.

Input low value

Enter the minimum input at which all active
outputs are Off (false). Corresponds to
INLO in the GCM SEQ block.
Writing this parameter causes a reset of the
object.
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Continued
Component

Description

Number of stages

Enter the number of active outputs.
Corresponds to NSTGS in the GCM SEQ
block.
Writing this parameter causes a reset of the
object.

Interstage delay on

Enter the delay time required after the
SeqLin's outputs change, before the next on
stage (greater output) can be commanded
On (true). Corresponds to DELON in the
GCM SEQ block.

Interstage delay off

Enter the delay time required after the
SeqLin's outputs change, before the next off
stage (greater output) can be commanded
Off (false). Corresponds to DELOF in the
GCM SEQ block.

Vernier select

Select Vernier to use a modulating analog
output between the digital output stages.
Corresponds to VERNR in the GCM SEQ
block.
Writing this parameter causes a reset of the
object.

Restart value

Select the initial condition of the active
outputs when the SeqLin is reset or on a
power-up condition. Corresponds to RESTA
in the GCM SEQ block.
Writing this parameter causes a reset of the
object.

Technical
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97.300

SeqRot Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
SeqRot.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Number of stages on

Displays the number of outputs that are On
(true). Corresponds to ONSTG in the GCM
SEQ block.

All on flag

Displays On (true) when all active outputs
are On (true). Corresponds to ALLON in the
GCM SEQ block.

All off flag

Displays On (true) when all active outputs
are Off (false). Corresponds to ALLOF in
the GCM SEQ block.

Vernier output

Displays the value of the vernier, an analog
output modulating between digital stages, if
Vernier select is set to Vernier.
Corresponds to VERN in the GCM SEQ
block.
Technical
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Continued

Technical
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Component

Description

Stage 1 to Stage 10

Displays the digital value of the output.
Corresponds to DV1 to DV10 in the GCM
SEQ block.

Object status

Displays the status of the object.

On value only 1 to On value only 10

Displays the same state as the matching
stage output, except On (true) is the only
active state. Off produces a (Null) output
value. Corresponds to ON1 to ON10 in the
GCM SEQ block.

Off value only 1 to Off value only 10

Displays the same state as the matching
stage output, except Off (false) is the only
active state. On produces a (Null) output
value. Corresponds to OFF1 to OFF10 in the
GCM SEQ block.
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97.301

SeqRot Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM SEQ
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Technical
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Continued

Technical
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Force output value

Displays the force output value input.
Corresponds to FOVAL in the GCM SEQ
block.

Force output value constant

Select the on/off state to use when forcing
the outputs using Force all outputs
value.

Force output value reference

Enter a reference to get the force output
from another NETWORK 8000 object.

Force all outputs value

Displays the force all outputs input.
Corresponds to FOUTS in the GCM SEQ
block.

Force all outputs constant

Select On (true) to force all the assigned
stage outputs to the Force output value.

Force all outputs reference

Enter a reference to get the force all outputs
from another NETWORK 8000 object.

Analog input value

Displays the value of the control signal input.
Corresponds to AINP in the GCM SEQ
block.

Analog input constant

Enter a value to supply a constant analog
input.

Analog input reference

Enter a reference to get the analog input
from another NETWORK 8000 object.

Rotate stages value

Displays the value of rotate stages input.
Corresponds to ROSTG in the GCM SEQ
block.

Rotate stages constant

Select Off (false) to rotate to the next
configuration.

Rotate stages reference

Enter a reference to get the rotate stages
from another NETWORK 8000 object.
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97.302

SeqRot Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the SeqRot.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
SeqRot executes its algorithm. Corresponds
to UPTIM in the GCM SEQ block.

Input high value

Enter the maximum input value at which all
active outputs are On (true). Corresponds
to INHI in the GCM SEQ block.
Writing this parameter causes a reset of the
object.

Input low value
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Enter the minimum input at which all active
outputs are Off (false). Corresponds to
INLO in the GCM SEQ block.
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Continued
Component

Description

Number of stages

Enter the number of active outputs.
Corresponds to NSTGS in the GCM SEQ
block.
Writing this parameter causes a reset of the
object.

Interstage delay on

Enter the delay time required after the
SeqRot's outputs change, before the next
on stage (greater output) can be
commanded On (true). Corresponds to
DELON in the GCM SEQ block.

Interstage delay off

Enter the delay time required after the
SeqRot's outputs change, before the next
off stage (greater output) can be
commanded Off (false). Corresponds to
DELOF in the GCM SEQ block.

Vernier select

Select Vernier to use a modulating analog
output between the digital output stages.
Corresponds to VERNR in the GCM SEQ
block.

Restart value

Select the initial condition of the active
outputs when the SeqRot is reset or on a
power-up condition. Corresponds to RESTA
in the GCM SEQ block.

Sequence start

Select Linear start to have the outputs of
the SeqRot start with stage 1 at On (true)
after all the stages have been commanded
Off (false). Corresponds to SEQST in the
GCM SEQ block.
Writing this parameter causes a reset of the
object.

Load rotate time

Technical
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Enter the time allowed for the outputs to
remain in a fixed configuration before the
outputs are shifted to the next configuration.
Corresponds to ROTIM in the GCM SEQ
block.
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97.303

Sgcm Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Sgcm. The Sgcm sends up to four analog values and sixty-four digital values to the
LCMs on the LCM network. RGCM blocks in the LCM are used to receive the
values.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Object status

Displays the status of the object.

Technical
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97.304

Sgcm Properties – Digital Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
Because this object has 64 Digital input properties, the properties are divided
between two tabs. This tab applies to Digital inputs 1 through 32.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Digital Inputs tab
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Table: Digital Inputs Tab
Component

Description

Digital input 1 to Digital input 32 value Displays the value of digital input 1 to digital
input 32. Corresponds to DIN1 to DIN32 in
the GCM SGCM block.
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Digital input 1 to Digital input 32
constant

Enter a value to supply a constant digital
input.

Digital input 1 to Digital input 32
reference

Enter a reference to get the value of digital
input from another NETWORK 8000 object.
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97.305

Sgcm Properties – Digital Inputs 2 Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
Because this object has 64 Digital input properties, the properties are divided
between two tabs. This tab applies to Digital inputs 33 through 64.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Digital Inputs 2 tab

Table: Digital Inputs 2 Tab

Technical
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Component

Description

Digital input 33 to Digital input 64
value

Displays the value of digital input 33 to digital
input 64. Corresponds to DIN33 to DIN64 in
the GCM SGCM block.

Digital input 33 to Digital input 64
constant

Enter a value to supply a constant digital
input.

Digital input 33 to Digital input 64
reference

Enter a reference to get the value of digital
input from another NETWORK 8000 object.
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97.306

Sgcm Properties – Analog Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Analog Inputs tab

Table: Analog Inputs Tab
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Component

Description

Analog input 1 to Analog input 4 value

Displays the value of analog input 1 to
analog input 4. Corresponds to AIN1 to ANI4
in the GCM SGCM block.
Technical
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Continued

Technical
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Component

Description

Analog input 1 to Analog input 4
constant

Enter a value to supply a constant analog
input.

Analog input 1 to Analog input 4
reference

Enter a reference to get the value of anlog
input from another NETWORK 8000 object.
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97.307

Sgcm Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Sgcm.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
Sgcm executes its algorithm. Corresponds
to UPTIM in the GCM SGCM block.

Analog value slots

Enter the number of analog slots required to
send values to the LCMs. Corresponds to
AVS in the GCM SGCM block.

Digital value slots

Enter the number of digital slots required to
send values to the LCMs. Corresponds to
DVS in the GCM SGCM block.
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97.308

Sgrp2 Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Sgrp2.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Broadcast status

Displays On (true) when Broadcast
enable is On (true) and Group number is
not zero. Corresponds to BCSTS in the
GCM SGRP2 block.

Object status

Displays the status of the object.
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97.309

Sgrp2 Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Broadcast enable value

Displays On (true) when broadcasting is
enabled. Corresponds to BCENA in the
GCM SGRP2 block.

Broadcast enable constant

Select Off (false) to stop broadcasting
values to ASD devices.

Technical
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Continued

Technical
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Component

Description

Broadcast enable reference

Enter a reference to get the broadcast
enable from another NETWORK 8000
object.

High priority value

Displays the send group high priority state.
Corresponds to HIPRI in the GCM SGRP2
block.

High priority constant

Select On (true) to allow this send group to
broadcast at high priority.

High priority reference

Enter a reference to get the high priority from
another NETWORK 8000 object.

Digital input 1 to Digital input 8 value

Displays the value of the digital input.
Corresponds to DIN1 to DIN8 in the GCM
SGRP2 block.

Digital input 1 to Digital input 8
constant

Select the on/off state if needing to force the
input to a constant state.

Digital input 1 to Digital input 8
reference

Enter a reference to get the digital input from
another NETWORK 8000 object.

Analog input 1 to Analog input 2 value

Displays the value of the analog input.
Corresponds to AIN1 to AIN2 in the GCM
SGRP2 block.

Analog input 1 to Analog input 2
constant

Enter a value if needing to force the input to
a constant value.

Analog input 1 to Analog input 2
reference

Enter a reference to get the analog input
from another NETWORK 8000 object.
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97.310

Sgrp2 Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of Sgrp2.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which
Sgrp2 executes its algorithm. Corresponds
to UPTIM in the GCM SGRP2 block.

Controller device type

Select the type of ASD field devices that the
Sgrp2 communicates with. Corresponds to
CTYPE in the GCM SGRP2 block.

Group number

Enter the number of the group that the
Sgrp2 communicates with. Corresponds to
GROUP in the GCM SGRP2 block.

Technical
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97.311

SgrpFlo2 Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
SgrpFlo2.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Broadcast status

Displays On (true) when Broadcast
enable is On (true) and Group number is
not zero. Corresponds to BCSTS in the
GCM SGRP2 block.

Object status

Displays the status of the object.
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97.312

SgrpFlo2 Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Broadcast enable value

Displays On (true) when broadcasting is
enabled. Corresponds to BCENA in the
GCM SGRP2 block.

Broadcast enable constant

Select Off (false) to to stop broadcasting
values to ASD devices.
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Component

Description

Broadcast enable reference

Enter a reference to get the broadcast
enable from another NETWORK 8000
object.

High priority value

Displays the send group high priority state.
Corresponds to HIPRI in the GCM SGRP2
block.

High priority constant

Select On (true) to allow this send group to
broadcast at high priority.

High priority reference

Enter a reference to get the high priority from
another NETWORK 8000 object.

Force damper open value

Displays force damper open. This does not
function if Force damper close value is
On (true). Corresponds to FOPN in the
GCM SGRP2 block.

Force damper open constant

Select On (true) to force the damper open.

Force damper open reference

Enter a reference to force the damper open
from another NETWORK 8000 object.

Force damper close value

Displays force damper open. This does not
function if Force damper open value is
On (true). Corresponds to FCLS in the
GCM SGRP2 block.

Force damper close constant

Select On (true) to force the damper
closed.

Force damper close reference

Enter a reference to force the damper closed
from another NETWORK 8000 object.

Force damper to max value

Displays force damper to maximum. This
does not function if Force damper to min
value is On (true). Corresponds to FMX in
the GCM SGRP2 block.

Force damper to max constant

Select On (true) to force the damper to
maximum position.

Force damper to max reference

Enter a reference to force the damper to
maximum from another NETWORK 8000
object.

Force damper to min value

Displays force damper to minimum. This
does not function if Force damper to max
value is On (true). Corresponds to FMN in
the GCM SGRP2 block.

Force damper to min constant

Select On (true) to force the damper to
minimum position.

Force damper to min reference

Enter a reference to force the damper to
minimum from another NETWORK 8000
object.
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97.313

SgrpFlo2 Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of SgrpFlo2.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which
SgrpFlo2 executes its algorithm.
Corresponds to UPTIM in the GCM SGRP2
block.

Group number

Enter the number of the group that the
SgrpFlo2 communicates with. Corresponds
to GROUP in the GCM SGRP2 block.
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97.314

SlectAv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
SlectAv.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Current analog value

Displays the value of the analog output.
Corresponds to AI in the GCM SLECT block.

Object status

Displays the status of the object.
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97.315

SlectAv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM SLECT
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Analog input 1 value

Displays the value of analog input 1.
Corresponds to AINP1 in the GCM SLECT
block.

Analog input 1 constant

Enter a value to supply a constant analog
input.

Analog input 1 reference

Enter a reference to get the value of the
analog input from another NETWORK 8000
object.

Analog input 2 value

Displays the value of analog input 2.
Corresponds to AINP2 in the GCM SLECT
block.

Analog input 2 constant

Enter a value to supply a constant analog
input.

Analog input 2 reference

Enter a reference to get the analog input
from another NETWORK 8000 object.

Input select value

Displays the value of input select.
Corresponds to INSEL in the GCM SLECT
block.

Input select constant

Select Off (false) to pass Analog input 1
value to Analog point value or select On
(true) to pass Analog input 2 value to
Analog point value.

Input select reference

Enter a reference to get the input select from
another NETWORK 8000 object.
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97.316

SlectAv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the SlectAv.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
SlectAv executes its algorithm. Corresponds
to UPTIM in the GCM SLECT block.

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value. Corresponds to INMN in
the GCM SLECT block.

Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value. Corresponds to INMX in
the GCM SLECT block.
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97.317

SlectDv Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
SlectDv.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Digital value output

Displays the value of the digital point.
Corresponds to DV in the GCM SLECT
block.

Object status

Displays the status of the object.
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97.318

SlectDv Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM SLECT
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Technical
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Digital input 1 value

Displays the value of digital input 1.
Corresponds to DINP1 in the GCM SLECT
block.

Digital input 1 constant

Enter a value to supply a constant digital
input.

Digital input 1 reference

Enter a reference to get the value of the
digital input from another NETWORK 8000
object.

Digital input 2 value

Displays the value of digital input 2.
Corresponds to DINP1 in the GCM SLECT
block.

Digital input 2 constant

Enter a value to supply a constant digital
input.

Digital input 2 reference

Enter a reference to get the value of the
digital input from another NETWORK 8000
object.

Input select value

Displays the value of input select.
Corresponds to INSEL in the GCM SLECT
block.

Input select constant

Select Off (false) to select Digital input 1
to Digital point value or select On (true)
to pass Digital input 2 value to Digital
point value.

Input select reference

Enter a reference to get the input select from
another NETWORK 8000 object.
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97.319

SlectDv Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the SlectDv.

Figure: Parameters tab

Table: Parameters Tab
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Component

Description

Update time

Enter the minimum frequency at which the
SlectDv executes its algorithm. Corresponds
to UPTIM in the GCM SLECT block.
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97.320

Total Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Total.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Total

Displays accumulated total value since Start
time. Corresponds to TOTAL in the GCM
TOTAL block.

Hourly total

Displays the hourly total updated at the
change of the hour according to the system
time clock. Corresponds to HRTOT in the
GCM TOTAL block.

Start time

Displays the timestamp when the Total was
last initialized. Corresponds to STTIM in the
GCM TOTAL block.

Elapsed time

Displays the elapsed hours since Start time
and returns to 0 when the total is initialized.
Corresponds to ELTIM in the GCM TOTAL
block.
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Component

Description

Maximum value

Displays the maximum value since the Total
was last initialized. Corresponds to MXVAL
in the GCM TOTAL block.

Maximum time

Displays the timestamp of the occurrence of
the Maximum value. Corresponds to
MXTIM in the GCM TOTAL block.

Minimum value

Displays the minimum value since the Total
was last initialized. Corresponds to MNVAL
in the GCM TOTAL block.

Minimum time

Displays the timestamp of the occurrence of
the Minimum value. Corresponds to
MNTIM in the GCM TOTAL block.

Exceeded limit flag

Displays On (true) whenever the Total
output equals or exceeds the Totalization
limit. Corresponds to EXLIM in the GCM
TOTAL block.

Object status

Displays the status of the object.
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97.321

Total Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of calculate enable.
Corresponds to CENAB in the GCM TOTAL
block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the value of
calculate enable from another NETWORK
8000 object.

Analog input value

Displays the value of the analog input.
Corresponds to AINP in the GCM TOTAL
block.

Analog input constant

Enter a value to supply a constant analog
input.

Analog input reference

Enter a reference to get the value of the
analog input from another NETWORK 8000
object.

Initialize total value

Displays the value of the initialize total.
Corresponds to INTOT in the GCM TOTAL
block.

Initialize total constant

Select On (true) to initialize the outputs.

Initialize total reference

Enter a reference to get the value of initialize
total from another NETWORK 8000 object.
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97.322

Total Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Total.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
Total executes its algorithm. Corresponds to
UPTIM in the GCM TOTAL block.

Constant

Enter the value of each count or multiplier for
analog values. Corresponds to CONST in
the GCM TOTAL block.

Restart value

Enter the value of the Total output after the
Initialize total input changes from Off
(false) to On (true). Corresponds to
REVAL in the GCM TOTAL block.

Totalization limit

Enter the value, if equaled or exceeded, that
causes the Exceeded limit flag output to
be On (true). Corresponds to TOLIM in the
GCM TOTAL block.
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Component

Description

Calculation select

Select Analog value to total an analog
value at each update. Select Counter
value to calculate based on a counter such
as a number-of-changes or total type
outputs. Corresponds to CASEL in the GCM
TOTAL block.
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97.323

Tstat Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Tstat.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Digital value output

Displays the current calculated digital value
of the object. Corresponds to DV in the
GCM TSTAT block.

On value only

Displays the same output as the Digital
value output, except On (true) is the only
active state. Corresponds to ONDV in the
GCM TSTAT block.

Off value only

Displays the same output as the Digital
value output, except Off (false) is the only
active state. Corresponds to OFFDV in the
GCM TSTAT block.
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Component

Description

Input high flag

Displays On (true) whenever the Analog
input exceeds the Input maximum value.
Corresponds to HIFLG in the GCM TSTAT
block.

Input low flag

Displays On (true) whenever the Analog
input is less than the Input minimum
value. Corresponds to LOFLG in the GCM
TSTAT block.

Object status

Displays the status of the object.
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97.324

Tstat Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
TSTAT block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Setpoint value

Displays the value of the setpoint.
Corresponds to SP in the GCM TSTAT
block.

Setpoint constant

Enter a value to supply a constant setpoint.

Setpoint reference

Enter a reference to get the setpoint input
from another NETWORK 8000 object.

Analog input value

Displays the value of the analog input (the
controlled item). Corresponds to AINP in the
GCM TSTAT block.

Analog input constant

Enter a value to supply a constant analog
input.

Analog input reference

Enter a reference to get the the analog input
from another NETWORK 8000 object.

Input differential value

Displays the value of the input differential.
Corresponds to INDIF in the GCM TSTAT
block.

Input differential constant

Enter a value to supply a constant input
differential.

Input differential reference

Enter a reference to get the input differential
from another NETWORK 8000 object.

Technical
4435

97 NETWORK 8000 User Interface
97.325 Tstat Properties – Parameters Tab

97.325

Tstat Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Tstat.

Figure: Parameters tab

Table: Parameters Tab

Technical
4436

Component

Description

Update time

Enter the minimum frequency at which the
Tstat executes its algorithm. Corresponds to
UPTIM in the GCM TSTAT block.

Input maximum

Enter the highest input value accepted.
Actual input values may be higher, but are
limited to this value. Corresponds to INMX in
the GCM TSTAT block.

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value. Corresponds to INMN in
the GCM TSTAT block.

Setpoint maximum

Enter the maximum value accepted as a
setpoint input for calculation within the
algorithm. Corresponds to MAXSP in the
GCM TSTAT block.
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Component

Description

Setpoint minimum

Enter the minimum value accepted as a
setpoint input for calculation within the
algorithm. Corresponds to MINSP in the
GCM TSTAT block

Minimum differential

Enter the lowest differential value accepted.
Actual input differential values may be lower,
but are limited to this value. Corresponds to
MNDIF in the GCM TSTAT block.

Anticipation action

Select Action on to add a derivative or
anticipation feature to the Tstat algorithm to
reduce the magnitude of the temperature
swings. Corresponds to ACTIC in the GCM
TSTAT block.
Writing this parameter causes a reset of the
object.

Output action
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Select Direct to cause an increase in the
input to increase the output. Corresponds to
ACT in the GCM TSTAT block.
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97.326

TstatFlt Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
TstatFlt.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Drive open

Displays On (true) when driving the
actuator or valve towards the full open
position. Corresponds to OPEN in the GCM
TSTAT block.

Drive close

Displays On (true) when driving the
actuator or valve towards the full close
position. Corresponds to CLOSE in the GCM
TSTAT block.

Input high flag

Displays On (true) whenever the Analog
input exceeds the Input maximum value.
Corresponds to HIFLG in the GCM TSTAT
block.
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Component

Description

Input low flag

Displays On (true) whenever the Analog
input is less than the Input minimum
value. Corresponds to LOFLG in the GCM
TSTAT block.

Object status

Displays the status of the object.
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97.327

TstatFlt Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Inputs tab

Table: Inputs Tab

Technical
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
TSTAT block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
value from another NETWORK 8000 object.

Setpoint value

Displays the value of the setpoint.
Corresponds to SP in the GCM TSTAT
block.

Setpoint constant

Enter a value to supply a constant setpoint.

Setpoint reference

Enter a reference to get the setpoint input
value from another NETWORK 8000 object.

Analog input value

Displays the value of the analog input (the
controlled item). Corresponds to AINP in the
GCM TSTAT block.

Analog input constant

Enter a value to supply a constant analog
input.

Analog input reference

Enter a reference to get the the analog input
value from another NETWORK 8000 object.

Input differential value

Displays the value of the input differential.
Corresponds to INDIF in the GCM TSTAT
block.

Input differential constant

Enter a value to supply a constant input
differential.

Input differential reference

Enter a reference to get the input differential
from another NETWORK 8000 object.
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97.328

TstatFlt Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the TstatFlt.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
Tstat executes its algorithm. Corresponds to
UPTIM in the GCM TSTAT block.

Input maximum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value. Corresponds to INMX in
the GCM TSTAT block.

Input minimum

Enter the lowest input value accepted.
Actual input values may be lower, but are
limited to this value. Corresponds to INMN in
the GCM TSTAT block.

Setpoint maximum

Enter the maximum value accepted as a
setpoint input for calculation within the
algorithm. Corresponds to MAXSP in the
GCM TSTAT block.
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Component

Description

Setpoint minimum

Enter the minimum value accepted as a
setpoint input for calculation within the
algorithm. Corresponds to MINSP in the
GCM TSTAT block.

Minimum differential

Enter the lowest differential value accepted.
Actual input differential values may be lower,
but are limited to this value. Corresponds to
MNDIF in the GCM TSTAT block.

Output action

Select Direct to cause an increase in the
input to increase the output. Corresponds to
ACT in the GCM TSTAT block.
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97.329

VvBox Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
VvBox.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Basic tab

Table: Basic Tab

Technical
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Cpmponent

Description

Zone temperature

Displays the current zone temperature at the
sensor. Corresponds to ZNTMP in the GCM
VVBOX block.

Supply duct temp

Displays the current supply duct
temperature at the sensor if the warm up
sensor is installed. Corresponds to DTTEM
in the GCM VVBOX block.
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Cpmponent

Description

Box flow

Displays the air flow rate into the VAV
box. The property is active if Pressure type
is configured for pressure independent
operation. Corresponds to FLOW in the
GCM VVBOX block.

Damper position

Displays the percent of travel between the
full closed and full open positions. This
property is active if Pressure type is
pressure dependent. Corresponds to POS in
the GCM VVBOX block.

Hot water valve pos

Displays the amount of flow through the hot
water valve. This property is active if the hot
water valve is active. Corresponds to
HWPOS in the GCM VVBOX block.

Induction damper

Displays the percent of travel of the induction
damper. This property is active if the
induction damper is active. Corresponds to
IDPOS in the GCM VVBOX block.

Diagnostic type

Displays the diagnostic type number.
Corresponds to DGTYP in the GCM VVBOX
block.

Box type

Displays the configuration of the MICROFLO
device. Corresponds to BXTYP in the GCM
VVBOX block.

Option type

Displays the decimal equivalent of the binary
number described by the function switch
settings for switch positions 4, 5, 6, 7, and 8
with switch position 8 representing the least
significant bit. Corresponds to OPTYP in the
GCM VVBOX block.

Object status

Displays the status of the object.
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97.330

VvBox Properties – Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Inputs tab

Table: Inputs Tab

Technical
4446

Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
VVBOX block.
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Component

Description

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000 object.

Direct reverse value

Displays the value of the direct reverse input.
Corresponds to DIREV in the GCM VVBOX
block.

Direct reverse constant

Select On (true) to change over from
cooling to heating.

Direct reverse reference

Enter a reference to get the direct reverse
from another NETWORK 8000 object.

Force damper value

Displays the force damper value. Works in
conjunction with the Damper position
value to allow a manual or programmed
override. Corresponds to FODMP in the
GCM VVBOX block.

Force damper constant

Select On (true) to force the damper to be
driven to the value of the Damper position
value.

Force damper reference

Enter a reference to get the force damper
from another NETWORK 8000 object.

Damper position value

Displays the damper position command
value. Corresponds to DMPOS in the GCM
VVBOX block.

Damper position constant

Enter a value of damper position when
forcing the damper with Force damper
value.

Damper position reference

Enter a reference to get the damper position
from another NETWORK 8000 object.

Warm start value

Displays the warm start value. Each time this
value changes to On (true) the MICROFLO
II device is re-initialized. Corresponds to
WRSTA in the GCM VVBOX block.

Warm start constant

Select On (true) to initiate a reset of the
MICROFLO II device.

Warm start reference

Enter a reference to restart the MICROFLO II
device from another NETWORK 8000
object.

EMS control value

Displays On (true) if the MICROFLO II
device is operating from the EMS setpoints.
Displays Off (false) when the local
commands are used. Corresponds to
EMSCO in the GCM VVBOX block.

Technical
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Description

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000 object.

EMS zone temp setpt value

Displays the EMS zone temperature setpoint
when EMS control value is On (true).
Corresponds to EZNSP in the GCM VVBOX
block.

EMS zone temp setpt constant

Enter a value to supply a constant zone
temperature setpoint.

EMS zone temp setpt reference

Enter a reference to get the EMS zone
temperature setpoint from another
NETWORK 8000 object.

EMS reheat setpoint value

Displays the EMS reheat setpoint when EMS
control value is On (true). Corresponds to
ERHSP in the GCM VVBOX block.

EMS reheat setpoint constant

Enter a value to supply a constant reheat
setpoint.

EMS reheat setpoint reference

Enter a reference to get the EMS reheat
setpoint from another NETWORK 8000
object.

EMS aux fan setpt value

Displays the EMS auxiliary fan setpoint when
EMS control value is On (true).

EMS aux fan setpt constant

Enter a value to supply a constant EMS
auxiliary fan setpoint.

EMS aux fan setpt reference

Enter a reference to get the EMS auxiliary fan
setpoint from another NETWORK 8000
object.

Occupied mode value

Displays the occupied mode. Corresponds
to OCCMD in the GCM VVBOX block.

Occupied mode constant

Select On (true) to command the
MICROFLO II device to occupied mode.

Occupied mode reference

Enter a reference to get the occupied mode
from another NETWORK 8000 object.

EMS flow/pos maximum value

Displays the highest value that flow (or
position of damper on PD devices) can
achieve under EMS control. Corresponds to
EMSMX in the GCM VVBOX block.

EMS flow/pos maximum constant

Enter a value to supply a constant maximum
flow (or position of damper on PD devices).

EMS flow/pos maximum reference

Enter a reference to get the EMS maximum
flow (or position of damper on PD devices)
from another NETWORK 8000 object.
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Component

Description

EMS flow/pos minimum value

Displays the lowest value that flow (or
position of damper on PD devices) can
achieve under EMS control. Corresponds to
EMSMN in the GCM VVBOX block.

EMS flow/pos maximum constant

Enter a value to supply a constant minimum
flow (or position of damper on PD devices).

EMS flow/pos maximum reference

Enter a reference to get the EMS minimum
flow (or position of damper on PD devices)
from another NETWORK 8000 object.
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97.331

VvBox Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the VvBox.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Parameters tab

Table: Parameters Tab

Technical
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Component

Description

Update time

Enter the minimum frequency at which the
VvBox executes its algorithm. Corresponds
to UPTIM in the GCM VVBOX block.

Cvv number

Enter the physical address of the device as
indicated by its DIP switch settings.
Corresponds to CVVNU in the GCM VVBOX
block.

Pressure type

Select the MICROFLO device pressure type.
This must match the controller model.
Corresponds to PRES in the GCM VVBOX
block.
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Component

Description

Control type

Select the MICROFLO control mode. Must
match the controller DIP switch
setting. Corresponds to CTYPE in the GCM
VVBOX block.

Setpoint maximum

Enter the maximum value that is used as an
input value at the EMS zone temp setpt
input. Corresponds to SPMX in the GCM
VVBOX block.

Setpoint minimum

Enter the minimum value that is used as an
input value at the EMS zone temp setpt
input. Corresponds to SPMN in the GCM
VVBOX block.

Flow/position calib

Enter the scale constant value for maximum
flow or position. Corresponds to CAL in the
GCM VVBOX block.

EMS reheat maximum

Enter the maximum value that is used as an
input value at the EMS reheat setpoint
input. Corresponds to RHMX in the GCM
VVBOX block.

EMS reheat minimum

Enter the minimum value that is used as an
input value at the EMS reheat setpoint
input. Corresponds to RHMN in the GCM
VVBOX block.

Message enable

Select the error messages that are to be
disabled from the MICROFLO device.
Corresponds to EXENA in the GCM VVBOX
block.
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97.332

VvBox Properties – Setpoints Tab
Use the Setpoints tab to view the setpoint properties of the VvBox. The setpoints
are dynamic values (variables) calculated by the VvBox.
Setpoint values are variables with real-time inputs to the control object. The
Setpoints tab shows the source of all real-time data that is feeding the MnFlo. This
tab provides a quick method to view the inputs used by the VvBox.
This object may appear in a migrated GCM database. However, communications to
the physical device or physical point are not supported in the current release of
Building Operation. This applies to LCM, GCS, and MICROFLO devices.

Figure: Setpoints tab

Table: Setpoints Tab

Technical
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Component

Description

Local temp setpt

Displays the local setpoint in the MICROFLO
device. Corresponds to LTPSP in the GCM
VVBOX block.

Local reheat setpt

Displsys the reheat temperature setpoint.
Corresponds to LRHSP in the GCM VVBOX
block.
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Component

Description

Local fan setpt

Displays the fan start temperature setpoint
for fan-powered boxes with parallel fan
operation. Corresponds to LFNSP in the
GCM VVBOX block.

Local max flow/pos

Displays the maximum flow potentiometer
reading that is calculated from the scale
constant entered at Flow/position calib.
Corresponds to LOCMX in the GCM VVBOX
block.

Local min flow/pos

Displays the minimum flow potentiometer
reading that is calculated from the scale
constant entered at Flow/position calib.
Corresponds to LOCMN in the GCM VVBOX
block.
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97.333

Zone2 Properties – Basic Tab
Use the Basic tab to view information about the output property values of the
Zone2.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

Digital output 1 to Digital output 8

Displays the value of the digital output of the
DO:1 to DO:8 blocks in the MICROZONE II
device. Corresponds to DO1 to DO8 in the
GCM ZONE2 block.

Analog output 1 to Analog output 4

Displays the value of the analog output of the
AO:1 to AO:4 blocks in the MICROZONE II
device. Corresponds to AO1 to AO4 in the
GCM ZONE2 block.

Object status

Displays the status of the object.
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97.334

Zone2 Properties – UI Values Tab
Use the UI Values tab to view and configure the universal input property values of
the Zone2. Each universal input (UI) group has both an analog and digital value. The
Universal input must be configured to match the application in the MICROZONE II
device.

Figure: UI Values tab

Table: UI Values Tab
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Component

Description

Universal input 1 to universal input 8
value

Displays the value of universal input 1 to
universal input 8.

UI digital value 1 to UI digital value 8

Displays the universal input digital value 1 to
digital value 8. This input is active if the type
assigned to Input type UI1 to UI8 is digital.
Corresponds to UIDV1 to UIDV8 in the GCM
ZONE2 block.

UI analog 1 to UI analog 8

Displays the universal input analog value 1 to
analog value 8. This input is active if the type
assigned to Input type UI1 to UI8 is
analog. Corresponds to UIAV1 to UIAV8 in
the GCM ZONE2 block.
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97.335

Zone2 Properties – Window Values Tab
Use the Window Values tab to view information about the output property values
of the Zone2.

Figure: Window Values tab

Table: Window Values Tab
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Component

Description

Window dv1 to Window dv8

Displays the digital value of the attribute
assigned to the input at the WINDD block in
the MICROZONE II device. Corresponds to
DV1 to DV8 in the GCM ZONE2 block.

Window av1 to Window av8

Displays the analog value of the attribute
assigned to the input at the WINDA block in
the MICROZONE II device. Corresponds to
AV1 to AV24 in the GCM ZONE2 block
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97.336

Zone2 Properties – Digital Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Digital Inputs tab

Table: Digital Inputs Tab
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Component

Description

Calculate enable value

Displays the value of the calculate enable
input. Corresponds to CENAB in the GCM
ZONE2 block.

Calculate enable constant

Select Off (false) to hold outputs at their
last calculated input value.
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Component

Description

Calculate enable reference

Enter a reference to get the calculate enable
from another NETWORK 8000. object.

EMS control value

Displays On (true) if the MICROZONE II
device operates from the EMS setpoints.
Displays Off (false) when the local
commands are used. Corresponds to
EMSCO in the GCM ZONE2 block.

EMS control constant

Select On (true) to use the EMS setpoints.

EMS control reference

Enter a reference to get the EMS control
from another NETWORK 8000. object.

EMS Dv1 to EMS Dv8 value

Displays the EMS digital input 1 command to
digital input 8 command. This input is active
only when Building Operation is
communicating to the MICROZONE II device
and EMS control value input is On
(true). Corresponds to DIN1 to DIN8 in the
GCM ZONE2 block.

EMS Dv1 to EMS Dv8 constant

Select On (true) or Off (false) to command
Dv1 to Dv8 at this value.

EMS Dv1 to EMS Dv8 reference

Enter a reference to get the digital input
command from another NETWORK 8000.
object.
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97.337

Zone2 Properties – Analog Inputs Tab
Use the Inputs tab to view or configure the input properties of the object. This tab
contains a property group for each input of the object. Each input group has three
properties: value, constant, and reference.
The value property shows the current operational input value, which is not dynamic.
The constant property must be either Null or a fixed value, which is used by the
object. The reference input is Null or contains a pointer to an output value. The
constant input has priority over the reference property. Therefore, the constant
must be configured as Null rather than any value, in order for the reference
property to determine the operation of the object. If the constant property is Null,
the reference property determines the operational value. If both the constant and
the reference properties are null, the input value is Not active (Null).

Figure: Analog Inputs tab
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Table: Analog Inputs Tab
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Component

Description

EMS Av1 to EMS Av8 value

Displays the EMS analog input 1 command
to analog input 8 command. This input is
active only when Building Operation is
communicating to the MICROZONE II device
and EMS control value is On
(true). Corresponds to AIN1 to AIN8 in the
GCM ZONE2 block.

EMS Av1 to EMS Av8 constant

Enter a value to command Av1 to Av8 at this
value.

EMS Av1 to EMS Av8 reference

Enter a reference to get the analog input
command from another NETWORK 8000
object.
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97.338

Zone2 Properties – Parameters Tab
Use the Parameters tab to view and edit the properties of the Zone2.

Figure: Parameters tab

Table: Parameters Tab
Component

Description

Update time

Enter the minimum frequency at which the
Zone2 executes its algorithm. Corresponds
to UPTIM in the GCM ZONE2 block.

Physical address

Enter the physical address of the
MICROZONE II device as indicated by its
DIP switch settings. Corresponds to ADDR
in the GCM ZONE2 block.
Writing this parameter causes a reset of the
object.

Input type UI1 to Input type UI8

Select the type of input configured as UI1
(Universal Input 1) to UI8 at the MICROZONE
II device. Corresponds to TYUI1 to TYUI8 in
the GCM ZONE2 block.
Writing this parameter causes a reset of the
object.
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Continued
Component

Description

Num of EMS digital

Enter the number of active EMS digital
inputs. Corresponds to NUNDI in the GCM
ZONE2 block.
Writing this parameter causes a reset of the
object.

Num of EMS analog

Enter the number of active EMS analog
inputs. Corresponds to NUMAI in the GCM
ZONE2 block.
Writing this parameter causes a reset of the
object.

Num of win digital

Enter the number of digital values from the
WINDO2:1 block 1 in the MICROZONE II
device that are displayed as outputs of the
zone2. Corresponds to NUNDV in the GCM
ZONE2 block.
Writing this parameter causes a reset of the
object.

Num of win analog

Enter the number of analog values from the
WINDO2:1 block 1 in the MICROZONE II
device that are displayed as outputs of the
Zone2. Corresponds to NUNAV in the GCM
ZONE2 block.
Writing this parameter causes a reset of the
object.

Message enable

Select the error messages that are to be
disabled from the MICROZONE II device.
Corresponds to EXENA in the GCM ZONE2
block.
Writing this parameter causes a reset of the
object.
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97.339

NETWORK 8000 Statistics Dialog Box –
Basic Tab
Use the Basic dialog box to view standard runtime performance statistics for the
NETWORK 8000 objects.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Number of standard objects

Displays the number of standard runtime
NETWORK 8000 objects. Standard objects
include the NETWORK 8000’s alarm,
control, and point objects.

Average standard loop processing
time

Displays the number of microseconds to
process all standard runtime NETWORK
8000 objects once. The running average is
calculated on the objects over a 60 second
period. The runtime object engine evaluates
objects every second.
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Component

Description

Maximum standard loop processing
time

Displays the maximum number of
microseconds to process all standard
runtime NETWORK 8000 objects once. The
maximum process time is the largest loop
processing time observed since the
controller started.

Standard loop count

Displays the processing count of the number
of times all the standard NETWORK 8000
objects have been executed. The processing
count is a running count of loop executions
since the controller started.

Number of message objects

Displays the number of ASD network
message objects.

Average message loop processing
time

Displays the number of microseconds to
process all ASD network objects once. The
running average is calculated on the objects
over a 30 second period. The average will be
understated if the number of message
objects is small and the object update times
are large. The average includes the time
spent processing an object’s update time to
check if the object should be executed.

Maximum message loop processing
time

Displays the maximum number of
microseconds to process all ASD network
message objects once.

Message loop processing count

Displays the processing count of the number
of times all the NETWORK 8000 network
objects have been executed.

Number of priority message objects

Displays the number of ASD network high
priority message objects. The high priority
objects include the Pem1 and Zone2 objects
with a Physical address of 247 or greater.

Average priority message loop
processing time

Displays the number of microseconds to
process all ASD network priority message
objects once. The running average is
calculated on the objects over a 30 second
period.

Maximum priority message loop
processing time

Displays the maximum number of
microseconds to process all ASD network
priority message objects once.

Priority message loop processing
count

Displays the processing count of the number
of times all the NETWORK 8000 priority
network objects have been executed.

Average message response time

Displays the average time in microseconds
to receive a response from an ASD device.

Maximum response time

Displays the maximum time in microseconds
to receive a response from an ASD device.
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Component

Description

Tx count

Displays the number of network packets
sent.

Rx count

Displays the number of network packets
received.

Packet frame errors

Displays the number of split packets or
packets received in error. Split packets track
the number of times that a received packet is
split across more than one physical I/O
request.

Active

Displays True to indicate that the
accumulation of statistical data is enabled.
This option is currently always enabled.

Reset statistics

Select True to set all the accumulated
statistical data to zero. The value will revert
back to False after the values are cleared.
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97.340

NETWORK 8000 Statistics Dialog Box –
LCM Tab
Use the LCM dialog box to view the statistics of the LCM networks.

Figure: LCM tab

Table: LCM Tab

Technical
4466

Component

Description

Number of objects

Displays the number of LCM block objects.

Average message response time

Displays the average number in
microseconds to receive the message
response from an LCM request.

Maximum message response time

Displays the maximum number of
microseconds to receive the message
response from an LCM request.

Lcm loop count

Displays the processing count of the number
of times all the LCM block objects have been
executed. The processing count is a running
count of loop executions since the controller
started.
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Component

Description

Maximum Lcm device response time

Displays the maximum time in microseconds
to receive an acknowledgement response
from an LCM.

Packet frame errors

Displays the number of split packets,
packets received in error, or timeouts.
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97.341

NETWORK 8000 Statistics Dialog Box –
Block List Sort Tab
Use the Block List Sort dialog box to view the statistics that are a result of sorting
the standard runtime NETWORK 8000 objects. Objects are sorted by order of
execution to optimize references to property values in other objects.

Figure: Block List Sort tab

Table: Block List Sort Tab
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Component

Description

Number of standard objects

Displays the total number of standard
runtime NETWORK 8000 objects that do not
communicate on a RS-485 network.
Standard objects include the NETWORK
8000's alarm, control, and point objects.

Total number of sorts

Displays the total number of sorts requested.
Sorts are implicitly requested when the
update time or property references are
changed in an object. Objects are sorted to
optimize references to property values in
other objects.
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Component

Description

Last sort time

Displays the time in microseconds to sort the
standard block runtime list time.

Max sort time

Displays the maximum time in microseconds
used to sort the block runtime list.

Last property reference update time

Displays the time to update depth of
references to properties in children objects
when updating a chain of multiple property
references for a given object.

Max property references update time

Displays the maximum time in microseconds
to update property references in children
objects.

Last full reference update time

Displays the time to update depth of
property references in all children objects
when updating a chain of multiple property
references for all objects.

Dump block list

Select True to dump the NETWORK 8000
objects in the sorted order of object
execution. The list contains the object name,
update time, and depth of the property
references. The block list is sent to the trace
log as configured in
Server1/System/Modules/Trace/Trace
Settings. The trace.log can be obtained by
the Get trace log/Trace
settings/Actions/Main Menu option.

Reset block sort statistics

Select True to set all the accumulated
statistical data to zero. The value reverts
back to False after the values are cleared
and the property grid window is refreshed.

Technical
4469

98

I/NET Introduction

Topics
I/NET Overview
I/NET Integration
I/NET Workflow
I/O Server
I/NET Seven Application
I/NET Seven Editors
I/NET Message Routing
Launching I/NET Seven as an Application
Logging On to the I/NET System

98 I/NET Introduction
98.1 I/NET Overview

98.1

I/NET Overview
I/NET is an integrated building management system that uses software and a mix of
hardware to provide environmental control, access control, and energy
management solutions. I/NET uses a proprietary, token-passing communication
protocol, operating in a tiered LAN architecture.
Taps, NetPlus Routers (NPRs), and Xenta 527/527-NPRs are the gateways that
allow Building Operation to gain access into the I/NET system and communicate
with I/NET devices.
For more information, see the I/NET product documentation available on the
Schneider Electric Buildings Business Extranet (http://buildings.schneiderelectric.com).

98.1.1

I/NET Integration
I/NET integrates with Building Operation at the Enterprise Server level. The main
components used for integrating Building Operation with the I/NET system are the
I/O Server, the I/NET Seven host application, and the INET Interface.
For more information, see section 98.2 “I/NET Integration ” on page 4473.

98.1.2

I/NET Workflow
In the System Tree pane, you create the INET interface under the Enterprise
Server. When the physical I/NET device is connected to the Enterprise Server, you
use the Device Discovery view to create the I/NET device in the System Tree
pane.
For more information, see section 98.3 “I/NET Workflow” on page 4476.

98.1.3

INET Interface
The INET Interface establishes the connection between the Enterprise Server and
I/O Server. The Enterprise Server becomes a client of I/O Server. The INET interface
allows you to discover I/NET devices on the I/NET system and add them to the
Enterprise Server database pane.
For more information, see section 99.1 “INET Interface” on page 4487.

98.1.4

I/NET Devices
In Building Operation, I/NET device is the family name for the following devices that
are supported in Building Operation:
• Routers
• Site devices
• SubLAN devices
• MR devices (all HVAC)
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For more information, see section 100.1 “I/NET Devices” on page 4493.
For more information, see the I/NET product documentation available on the
Schneider Electric Buildings Business Extranet (http://buildings.schneiderelectric.com).

98.1.5

I/NET Points
I/NET points are integrated into Building Operation as points. When you upload the
device configuration to the Enterprise Server, the configuration and point
information are created in the System Tree pane. You edit and command the points
as needed, using WorkStation and I/NET Seven editors. You can also bind the
I/NET points to other Building Operation objects, such as graphics, trends and
values. In addition, you can receive I/NET alarms, control I/NET points with Building
Operation schedules, and create I/NET specific trends based on I/Net points.
For more information, see section 101.1 “I/NET Points” on page 4509.

98.1.6

I/NET Graphics
You use I/NET Seven to convert I/NET Seven graphics to a TGML format, which is
compatible with Building Operation. You can move converted graphics to your
Building Operation project and begin using the graphics immediately. You can also
edit these graphics using Building Operation Graphics Editor.
For more information, see section 102.1 “I/NET Graphics” on page 4529.
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98.2

I/NET Integration
I/NET integrates with Building Operation at the Enterprise Server level. The main
components used for integrating Building Operation with the I/NET system are the
I/O Server, the I/NET Seven host application, and the INET Interface.
With these components, you can use Building Operation to create and configure
I/NET objects, monitor and control I/NET point values, and receive I/NET point trend
data.
When you view I/NET points in Building Operation, each point appears as a variable
that can be used much like any other type of variable. However, when you highlight
an I/NET point variable, some of the menu commands that become available in
WorkStation are I/NET-specific. If you select one of these commands, it typically
opens an I/NET Seven editor.
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Figure: INET integration architecture

98.2.1

Basic Support for Security Applications
Alarms, events, intruder detection devices, and door status information are visible
from Building Operation. However, all card holder (Individuals) related objects and
data, access rights and functions (such as door control, badging, and video
integration) require the operator to use the I/NET Host software.
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98.2.2

Gateway Support
Gateways (such as ICI or Xenta 913) in use at I/NET sites continue to operate. The
I/NET objects that represent third-party devices can be viewed from Building
Operation.

98.2.3

I/O Server
Enterprise Server integrates with I/NET Seven using a supporting program called
I/O Server. I/O Server provides bidirectional communication between the Enterprise
Server and the I/NET Seven database in the SQL Server. I/O Server routes
messages for alarms, events, and transactions as well as point states and values.
For more information, see section 98.4 “I/O Server” on page 4478.

98.2.4

I/NET Seven Application
You use the I/NET Seven application to configure I/NET objects in WorkStation and
to engineer your I/NET system. The I/NET Seven application provides all the
functionality found in the standard I/NET seven software product.
For more information, see section 98.5 “I/NET Seven Application” on page 4479.

98.2.5

INET Interface
The INET Interface establishes the connection between the Enterprise Server and
I/O Server. The Enterprise Server becomes a client of I/O Server. The INET interface
allows you to discover I/NET devices on the I/NET system and add them to the
Enterprise Server database pane.
For more information, see section 99.1 “INET Interface” on page 4487.
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98.3

I/NET Workflow
The I/NET workflow enables you to create an INET Interface and discover I/NET
devices on the I/NET network. You can then edit and command I/NET points and
convert I/NET graphics to Building Operation TGML files.
The following flowchart describes the basic steps of the workflow. Related
information can be found in the sections after the flowchart.

Figure: INET flowchart

Create an INET Interface
In WorkStation, create an INET Interface in the Enterprise Server.
For more information, see section 99.2 “Creating an INET Interface” on page 4489.

Connect I/NET devices
Connect your I/NET network to the Enterprise Server by way of a Xenta 527 or 527NPR device.
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Discover the I/NET devices
In WorkStation, discover the I/NET devices on the I/NET network.
For more information, see section 100.2 “Discovering an I/NET Device” on page
4494.

Edit or Command the variables
Edit and command the variables as needed, using WorkStation and I/NET Seven
editors.
For more information, see section 101.5 “Editing an I/NET Point” on page 4518.
For more information, see section 101.6 “Commanding an I/NET Point” on page
4519.

Manually upload the device configuration
If any changes that have occurred within I/NET since the devices were first added,
manually upload devices at any time to update Building Operation.
For more information, see section 100.4 “Uploading an I/NET Device’s
Configuration” on page 4496.

Convert I/Net graphics to Building Operation TGML files
Convert any I/NET graphics that are needed in Building Operation to TGML files,
being careful to maintain the proper folder hierarchy. These files are used when
configuring I/NET in Enterprise Server.
For more information, see section 102.3 “Converting I/NET Graphics to TGML” on
page 4538.
For more information, see section 102.4 “ Moving Converted I/NET Graphics to
WorkStation in a Batch” on page 4540.
For more information, see section 102.5 “ Moving Converted I/NET Graphics to
WorkStation Manually” on page 4541.
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98.4

I/O Server
Enterprise Server integrates with I/NET Seven using a supporting program called
I/O Server. I/O Server provides bidirectional communication between the Enterprise
Server and the I/NET Seven database in the SQL Server. I/O Server routes
messages for alarms, events, and transactions as well as point states and values.
I/O Server also collects trend data from field devices and sends this data to its
clients. Any of I/O Server’s clients that are running at the time trend data is collected
receives the trend data immediately. Otherwise, I/O server stores the trend data in
an SQL table for later transfer to its clients. I/O Server must be running in order for
its clients to receive I/NET Seven trend data.

98.4.1

I/O Server Clients
Each I/NET Seven host workstation in your system has its own I/O server. Each I/O
Server has at least two clients: the I/NET Seven host application itself and the AMT
application that is used to view I/NET Seven alarms, messages, and transactions.
When you add an I/NET Interface to an Enterprise Server, the Enterprise Server also
becomes a client of the workstation’s I/O Server.
Clients on the workstation rely on I/O Server for communication purposes.
Therefore, I/O Server must be running in order for your local clients to share data
with each other. To allow the local clients to share data with remote clients (that is,
clients running on other workstations), each remote client’s I/O server must also be
running.
The sharing of data among local and remote clients will also depend on how you
configure message routing within your I/NET Seven system. For more information,
see section 98.7 “I/NET Message Routing” on page 4482.

98.4.2

I/O Server as a Windows Service
You can configure I/O Server to run as a Windows service. This is the
recommended configuration for a workstation that integrates I/NET with an
Enterprise Server. When I/O Server is configured to run as a service, I/O Server
starts running at Windows startup and continues to run for as long as Windows is
running. By having I/O Server always running, you make it possible for clients (local
and remote) to continually receive I/NET Seven messages and point data. Trend
data is also continually collected from I/NET field devices thus reducing the
occurance of gaps in your trend collections.
I/NET Seven’s Getting Started Guide (TCON298) describes how you can configure
the I/O Server settings.
I/NET Seven's Operator Guide (TCON299) describes how you can configure I/O
Server to run as a Windows service.
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98.5

I/NET Seven Application
You use the I/NET Seven application to configure I/NET objects in WorkStation and
to engineer your I/NET system. The I/NET Seven application provides all the
functionality found in the standard I/NET seven software product.

Figure: I/NET application screen

98.5.1

I/NET Seven Editors
Some of the editors that you use to configure I/NET objects in WorkStation are
native I/NET Seven editors. These editors provide a familiar interface for users and
engineers involved in integrating I/NET with Building Operation. The I/NET Seven
application running as a background task allows these editors to launch
automatically in response to commands and menu selections issued from within
WorkStation.
For more information, see section 98.6 “I/NET Seven Editors” on page 4480.

98.5.2

I/NET Message Routing
Messages provide information about events occurring within the I/NET system. In
I/NET, a message can be generated when a point changes state, when an alarm
occurs, when a user signs on to a host or field device, or when virtually any change
takes place in the system. In Building Operation, I/NET messages are displayed as
events and alarms (depending on the message type).
For more information, see section 98.7 “I/NET Message Routing” on page 4482.
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98.6

I/NET Seven Editors
Some of the editors that you use to configure I/NET objects in WorkStation are
native I/NET Seven editors. These editors provide a familiar interface for users and
engineers involved in integrating I/NET with Building Operation. The I/NET Seven
application running as a background task allows these editors to launch
automatically in response to commands and menu selections issued from within
WorkStation.
In addition to the I/NET Seven editors that can be used directly from WorkStation,
you can also use the I/NET Seven application to access other I/NET seven editors.
For more information, see section 98.8 “Launching I/NET Seven as an Application”
on page 4483.
Table: Native I/NET Seven Editors
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I/NET Seven Editor

Description

Alarm Configuration

Defines how alarms from the selected point
is distributed.

Point Configuration

Configures the selected I/NET point.

Calculation

Defines a calculation that will control the
selected point’s value.

Event Definition

Defines an event that, if occurs at the
selected point, will initiate a particular
response.

Trend Sampling

Configures data collection from the point.
Collected data can then to be used in a
graph or printed in a report.

Runtime

Defines how runtime information is collected
from the selected discrete point.

Point Control

Allows you to manually control or test the
selected point.

Temperature Control

Defines a control scheme for the HVAC
system based on the selected discrete
point’s value.

Time Schedule Editor

Configures an independent, master, or slave
time schedule for the selected discrete point.

Override Billing

Available for discrete output (DO) points that
reside in a 7750 controller. Allows you to
define how specific equipment points can be
overriden using a touch-tone phone or
discrete switch, and how these overrides
can be tracked for billing purposes.

Unitary Control

Available for analog output (AO) and discrete
output (DO) points that reside in a 7760
controller. Defines parameter settings and
identifies sources and destinations used by
algorithms built into unitary controllers.
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Description

Lighting Circuit

Available for discrete output (DO) points that
reside in a 7780 controller. Allows you to
define parameters for a lighting circuit.

Lighting Zone

Available for discrete output (DO) points that
reside in a 7780 controller. Allows you to
define parameters for a lighting zone.

Elevator

Available for any door point that is defined as
an elevator. Works in conjunction with I/NET
access control parameters and personnel
schedules to control access to elevator
floors.

Door

Available for any discrete output (DO) that
meets the criteria to be a I/NET door point.
Allows you to add or modify a door
extension on the selected point.

Equipment Mapping

Allows you to bill tenants for override energy
use. Specifies the load size of the
equipment, the base load, and the
percentage that can be assessed to each
zone.

Alarm Inhibit

Available for analog input (AI), digital input
(GI), discrete alarm (DA), and discrete
monitor (DM) points. Prevents nuisance
alarms that may occur when a piece of
equipment is off.
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98.7

I/NET Message Routing
Messages provide information about events occurring within the I/NET system. In
I/NET, a message can be generated when a point changes state, when an alarm
occurs, when a user signs on to a host or field device, or when virtually any change
takes place in the system. In Building Operation, I/NET messages are displayed as
events and alarms (depending on the message type).
In order to receive I/NET messages in Building Operation, you must properly
configure message routing in I/NET Seven. More specifically, the I/NET Seven host
and AMT applications on your workstation must be configured to receive
messages. This allows Enterprise Server running on your workstation to also receive
I/NET messages.
I/NET Seven’s Technical Reference Guide (TCON300) describes how you can
configure message routing in I/NET.
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98.8

Launching I/NET Seven as an
Application
You launch I/NET Seven to use it as an I/NET system engineering tool. For example,
to add a new point to an I/NET device, you must use the I/NET Seven application.
For more information, see section 98.5 “I/NET Seven Application” on page 4479.

To launch I/NET Seven
1. In WorkStation, in the System Tree pane, select the I/NET Interface.
2. On the Action menu, click Launch INET.
Depending on how I/NET Seven is configured, you may be required to log on to the
I/NET system. For more information, see section 98.9 “Logging On to the I/NET
System” on page 4484.
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98.9

Logging On to the I/NET System
Use this procedure to log on to the I/NET system to securely access the I/NET
system.
For more information, see section 98.5 “I/NET Seven Application” on page 4479.

To log on to the I/NET system
1. In WorkStation, in the System Tree pane, select the I/NET Interface.
2. On the Action menu, click Launch INET.
3. Select the Current Windows User box to log on using your Windows user
account. In this case, the Operator name and Host password field
become inactive and you can skip to step 6.

4. In the Operator Name box, type your operator name.
5. In the Host password box, type the host password.
6. Click OK.
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99.1

INET Interface
The INET Interface establishes the connection between the Enterprise Server and
I/O Server. The Enterprise Server becomes a client of I/O Server. The INET interface
allows you to discover I/NET devices on the I/NET system and add them to the
Enterprise Server database pane.
You can create only one INET Interface on an Enterprise Server. The interface
makes I/NET objects accessible to the Building Operation user.
For more information, see section 99.2 “Creating an INET Interface” on page 4489.

04-16006-04-en, March 2015

Technical
4489

99 I/NET Interface
99.1 INET Interface

Figure: INET Interface
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99.2

Creating an INET Interface
You create an INET interface on an Enterprise Server in order to make I/NET objects
accessible to Building Operation when the server is physically connected to an
I/NET device.
For more information, see section 99.1 “INET Interface” on page 4487.

To create an INET interface
1. In WorkStation, in the System Tree pane, select the server where you want
to create the I/NET interface.
2. On the File menu, point to New and then click Interface.
3. In the object list, select INET Interface.

4. In the Name box, type a name for the INET interface.
5. In the Description box, type a description for the INET interface.
6. Click Create.
You can now configure the INET Interface. For more information, see section 99.3
“Configuring an INET Interface” on page 4490.
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99.3

Configuring an INET Interface
You configure an INET interface to define the interface and its properties.
For more information, see section 99.1 “INET Interface” on page 4487.

To configure an INET interface
1. In WorkStation, in the System Tree pane, select the INET interface.
2. In the INET Interface properties, enter the INET Global device scan
rate.

3. Enter the INET Global point scan rate.
4. Click OK.
You can now discover I/NET devices that you can add to the INET interface. For
more information, see section 100.2 “Discovering an I/NET Device” on page 4494.
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100.1

I/NET Devices
In Building Operation, I/NET device is the family name for the following devices that
are supported in Building Operation:
• Routers
• Site devices
• SubLAN devices
• MR devices (all HVAC)
You can recreate the hierarchy of your I/NET scheme in Building Operation by
creating and configuring hosts, links and sites in the I/NET Interface.

Note
You can only create and configure hosts, links, or sites on an Enterprise Server.

100.1.1

Hosts
Hosts are workstations that run I/NET Seven software to monitor, control, and
report on all aspects of the building management system. The host software allows
you to perform programming, record keeping, and system communication with
I/NET controllers, and ultimately, your control equipment. Hosts may be linked
together on a host LAN or an Ethernet LAN.
Hosts connect to the host LAN through specialized communication devices called
taps. A host LAN supports host taps and link taps. Each host tap can connect to a
workstation directly, or indirectly through a modem.
Hosts can communicate with many external devices, including other Hosts, NPRs,
Xenta 527/527-NPRs, taps, and controllers.

100.1.2

Links
Hosts communicate with controller LANs through links. A link may represent a
hardware device (for example, a tap, NPR, or Xenta 527/527-NPR). It may also
represent a distributed link (a single link address that is being shared among
multiple NPRs or Xenta 527/527-NPRs).

100.1.3

Sites
A site is one or more controllers connected to a controller LAN. Sites connect to
hosts by way of site taps and link taps.
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100.2

Discovering an I/NET Device
You discover an I/NET device to create the device in the INET interface in the
System Tree pane. You can discovery an online device that is physically connected
to the Enterprise Server field bus, or an offline device for which you have a stored
SAV file.
For more information, see section 99.1 “INET Interface” on page 4487.

To discover an I/NET device
1. In WorkStation, in the System Tree pane, select the server where you want
to discover I/NET devices.
2. Click the Device Discovery view.

3. In the Select device type box, select INET devices.
4. Drag the I/NET device or its SAV file from the Device Discovery view to the
INET Interface in the System Tree pane.
The I/NET device’s configuration is automatically uploaded. For more information,
see section 100.4 “Uploading an I/NET Device’s Configuration” on page 4496.
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100.3

I/NET Device Configuration and Point
Information
When you add an I/NET DCU to Building Operation, configuration information for
the device is uploaded automatically from the I/NET system on the Enterprise
Server. If the device contains points, configuration information associated with the
points is also retrieved and corresponding point objects are created in Building
Operation.
Besides the automatic upload that occurs when you add an I/NET device to
Building Operation, you can also manually initiate an upload. This can be useful for
updating Building Operation with any changes that may have occurred within I/NET
since the last time information was uploaded for the device.
As the configuration and point information is being uploaded to Building Operation,
the I/NET system is queried for a corresponding SAV file. If the necessary SAV file is
found, it is compared to the online device to determine if the file is up to date. If the
file is up to date, or if the device being uploaded is currently offline, the SAV file
serves as the source of configuration and point data during the upload. This results
in the fastest possible upload completion time.
If no SAV file is found for the device, or if the SAV file is not up to date, data is
uploaded directly from the online device. This results in a slower upload completion
time.
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100.4

Uploading an I/NET Device’s
Configuration
You manually retrieve an I/NET device's configuration from the I/NET Seven system
when an I/NET device is out of sync. When an I/NET device is out of sync with the
INET Interface, a
overlay is displayed on the device's icon. Uploading the
device's configuration puts the device back in sync.
For more information, see section 100.3 “I/NET Device Configuration and Point
Information” on page 4495.

To upload a I/NET device’s configuration
1. In WorkStation, in the System Tree pane, expand the INET Interface and
select an I/NET device.
2. On the Actions menu, click Upload.
3. In the List View, verify that the points residing in the I/NET device have been
uploaded.

You can further configure the I/NET device from within WorkStation. For more
information, see section 100.5 “Configuring an I/NET Device” on page 4497.
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100.5

Configuring an I/NET Device
You configure an I/NET device to meet the unique needs of your site. An I/NET
device configuration is uploaded from I/NET. You can modify the configuration,
such as changing the Point scan rate if the default setting of 5 seconds is not
wanted.
For more information, see section 99.1 “INET Interface” on page 4487.

To configure an I/NET device
1. In WorkStation, in the System Tree pane, select the I/NET device.
2. On the File menu, click Properties.
3. Edit the device properties:
Property

Description

Status

Displays Online while the device is
successfully communicating with Building
Operation.

DCU Name

Enter a descriptive name for the I/NET
device. This name does not affect the
device's name in I/NET.

Model Number

Select the model number of the I/NET
device.

Link Number

Enter the link address that leads to the
I/NET controller LAN.

Station Number

Enter the station address of the device on
the I/NET controller LAN.

Number of Stations

Enter the number of station addresses
used by the device.

Time Synchronization

Select how often you want the clock in
the I/NET device to synchronize with the
clock in the Enterprise Server.

DCU Scan rate

Enter how often you want to poll the
device for online/offline status updates.
Enter 0 to scan this device at the global
DCU scan rate defined for the INET
Interface.

Point scan rate

Enter how often you want to poll each
signal in the device. Enter 0 to scan to
scan signals in this device at the global
point scan rate defined for the INET
Interface.

4. Click OK.
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100.6

Creating an I/NET Host
You create an I/NET host in Building Operation to receive alarms associated with
that host.
For more information, see section 99.1 “INET Interface” on page 4487.

To create an I/NET host
1. In WorkStation, in the System Tree pane, select the System folder under
the INET Interface.
2. On the File menu, point to New and then click Host.

3. In the Name box, type a name for the host.
4. In the Description box, type a description for the host.
5. Click Create.
You can further configure the I/NET host in WorkStation. For more information, see
section 100.7 “Configuring an I/NET Host ” on page 4499.
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100.7

Configuring an I/NET Host
You configure an I/NET host in Building Operation to define its host number.
For more information, see section 99.1 “INET Interface” on page 4487.

To configure an I/NET host
1. In WorkStation, in the System Tree pane, select the I/NET host you want to
configure.
2. In the Host properties dialog box, in the Host number box, enter the host
number.

3. Click OK.
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100.8

Creating an I/NET Link
You create an I/NET link in Building Operation to receive alarms associated with that
link.
For more information, see section 99.1 “INET Interface” on page 4487.

To create an I/NET link
1. In WorkStation, in the System Tree pane, select the System folder under
the INET Interface.
2. On the File menu, point to New and then click Link.

3. In the Name box, type a name for the link.
4. In the Description box, type a description for the link.
5. Click Create.
You can further configure the I/NET link in WorkStation. For more information, see
section 100.9 “Configuring an I/NET Link ” on page 4501.
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100.9

Configuring an I/NET Link
You configure an I/NET link in Building Operation to define its link number.
For more information, see section 99.1 “INET Interface” on page 4487.

To configure an I/NET link
1. In WorkStation, in the System Tree pane, select the I/NET link you want to
configure.
2. In the Link properties dialog box, in the Link number box, enter the link
number.

3. Click OK.
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100.10

Creating an I/NET Site
You create an I/NET site in Building Operation to receive alarms associated with
that site.
For more information, see section 99.1 “INET Interface” on page 4487.

To create an I/NET site
1. In WorkStation, in the System Tree pane, expand the System folder under
the INET Interface.
2. Select the link where you want to create the site.
3. On the File menu, point to New and then click Site.
4. In the Name box, type a name for the site.

5. In the Description box, type a description for the site.
6. Click Create.
You can further configure the I/NET site in WorkStation. For more information, see
section 100.11 “Configuring an I/NET Site ” on page 4503.
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100.11

Configuring an I/NET Site
You configure an I/NET site in Building Operation to define its link and site number.
For more information, see section 99.1 “INET Interface” on page 4487.

To configure an I/NET site
1. In WorkStation, in the System Tree pane, select the I/NET site you want to
configure.
2. In the Site properties dialog box, in the Link number box, enter the link
number.

3. In the Site number box, enter the site number.
4. Click OK.
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100.12

Updating an I/NET Device's Firmware
Use this procedure to update the firmware in an I/NET device. During this
procedure, an I/NET Seven editor launches and you can download factory
firmware, a saved I/NET device database, or both. This is equivalent to the Software
Restore and Station Restore functions in I/NET Seven.
For more information, see section 99.1 “INET Interface” on page 4487.

To update the firmware in an I/NET device
1. In WorkStation, in the System Tree pane, select the I/NET device.
2. On the Actions menu, click Update firmware.
3. In the I/NET Seven editor, download firmware, a database, or both to the
I/NET device.
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100.13

Updating a SubLAN Device's Firmware
Use this procedure to update the firmware in a device that is connected to an I/NET
device’s subLAN. During this procedure, an I/NET Seven editor launches, allowing
you to download factory firmware, a saved I/NET device database, or both. This is
equivalent to the Software Restore and Station Restore functions in I/NET Seven.
For more information, see section 99.1 “INET Interface” on page 4487.

To update a subLAN device's firmware
1. In WorkStation, in the System Tree pane, select the I/NET device.
2. On the Actions menu, click Update SubLAN device firmware.
3. In the I/NET Seven editor, download firmware, a database, or both to a device
on the subLAN of the I/NET device.
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100.14

Creating a Backup of an I/NET Device’s
Database
Use this procedure to save a copy of an I/NET device’s database to restore the
device at a later time. The resulting backup is stored in the SAV directory defined in
I/NET Seven. The backup function described in this procedure is equivalent to the
Station Save function in I/NET Seven.
For more information, see section 99.1 “INET Interface” on page 4487.

To create a backup of an I/NET device’s database
1. In WorkStation, in the System Tree pane, expand the INET Interface and
then select the I/NET device.
2. On the Actions menu, click Backup.
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101.1 I/NET Points

101.1

I/NET Points
I/NET points are integrated into Building Operation as points. When you upload the
device configuration to the Enterprise Server, the configuration and point
information are created in the System Tree pane. You edit and command the points
as needed, using WorkStation and I/NET Seven editors. You can also bind the
I/NET points to other Building Operation objects, such as graphics, trends and
values. In addition, you can receive I/NET alarms, control I/NET points with Building
Operation schedules, and create I/NET specific trends based on I/Net points.

101.1.1

I/NET Point Types and Representation
I/NET points exist as analog, digital, discrete, or pulsed types. They are displayed
within devices in WorkStation after integration.
For more information, see section 101.2 “I/NET Point Types and Representation”
on page 4510.

101.1.2

I/NET Point Bindings
You can bind graphics, programs, trends, schedules, and values to I/NET points in
Building Operation. The I/NET point property to use for creating these bindings
differs depending on the purpose of the binding and the type of I/NET point being
used.
For more information, see section 101.3 “I/NET Point Bindings” on page 4512.

101.1.3

I/NET Alarms, Schedules and Trends
In Building Operation, you can receive and acknowledge I/NET alarms, control
I/NET schedules, and create trends on I/NET integrated points.
For more information, see section 101.7 “I/NET Alarms, Schedules, and Trends” on
page 4520.
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101.2

I/NET Point Types and Representation
I/NET points exist as analog, digital, discrete, or pulsed types. They are displayed
within devices in WorkStation after integration.
There are ten possible point types available in I/NET:
• Analog input (AI)
• Analog output (AO)
• Discrete input (DI)
• Discrete output (DO)
• Discrete alarm (DA)
• Discrete monitor (DM)
• Discrete control (DC)
• Digital input (GI)
• Digital output (GO)
• Pulsed input (PI)
The format for the address is LLSSPPBB. The LL digits indicate on which link the
point resides (from link 00 to link 99). The SS digits indicate on which station the
point resides (from station 00 to station 63). The PP digits indicate the point number
assigned to the point (from 00 to 32). The BB digits indicate the bit offset of the
point (from 00 to 09).
The following graphics show the same I/O point in Resident I/O Point editor and in
WorkStation.

Figure: I/NET points in Resident I/O Point editor
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Figure: I/NET points in Workstation
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101.3

I/NET Point Bindings
You can bind graphics, programs, trends, schedules, and values to I/NET points in
Building Operation. The I/NET point property to use for creating these bindings
differs depending on the purpose of the binding and the type of I/NET point being
used.
Keep these basic guidelines in mind when binding to I/NET points:
• I/NET output points, such as AO, GO, DO, and DC, can be controlled from
Building Operation manually from the Properties pane or automatically from a
schedule or program.
• I/NET input points, such as AI, DI, GI, and PI can only be controlled from
Building Operation manually. Because these points represent field inputs, you
cannot control these points using Building Operation programs or schedules.
• The Manual and Test properties of I/NET points can only be controlled from
Building Operation manually. For safety reasons, you cannot control these
properties using Building Operation programs or schedules.
• All I/NET point types can be bound to Building Operation trends.
• When using an I/NET point to drive the value of a Building Operation point, the
Requested transfer rate defined on the point binding is not honored.
Instead, the value is transferred at the Point scan rate interval defined for the
device containing the I/NET point.
The following table provides a list of the properties available on I/NET points.
Table: I/NET Point Bind Values
Name

Type

Value

Read/Write

Alarm

Boolean

False=Non alarm Read only

DA, DI, DO, DC,
DM, AI, AO, GI,
GO

True=Alarm
AlarmAck

Boolean

Boolean
False=Do
nothing

INET Point
Types

Read/Write

DA, DI, DO, DC,
DM, AI, AO, GI,
GO

Read only

DA, DI, DO, DC,
DM, AI, AO, GI,
GO

False=Acknowle Read only
dged

DA, DI, DO, DC,
DM, AI, AO, GI,
GO

True=Send
acknowledgmen
t
AlarmInhibit

Boolean

False=Not
inhibited
True=Inhibited

CondNotAck

Boolean

True=Not
acknowledged
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Continued
Name

Type

Value

Read/Write

INET Point
Types

GrphPntState

Binary

0 = (none)

Read only

DA, DI, DO, DC,
DM, AI, AO, GI,
GO, PI

1 = A (alarm)
2 = I (inhibit)
3 = T (test)
4 = M (manual)
5 = O (old)
Manual

Boolean

False=Not
manual
True=Manual

OldData

Boolean

False=Comms
good

Read/write from DO, DC, AO, GO
Properties pane.
Read only
everywhere else.
Read only

DA, DI, DO, DC,
DM, AI, AO, GI,
GO, PI

Read only

DA, DI, DO, DC,
DM, AI, AO, GI,
GO, PI

True=Comms
bad
PntStatFlag

Binary

0x04 = Manual
0x08 = Old Data
0x10 =
Unacknowledge
d
0x20 = Alarm
Inhibit
0x40 = Alarm
0x80 = Test

PvControl

Binary

Quiescent
value=Null

Write only

DO, DC

PvText

Text

Point state
description

Read only

DA, DI, DO, DC,
DM

Status

Boolean

False=Offline

Read only

DA, DI, DO, DC,
DM, AI, AO, GI,
GO, PI

Read/write from
Properties
dialog. Read
only everywhere
else.

DA, DI, DO, DC,
DM, AI, AO, GI,
GO, PI

AO/GO =
Read/write

DA, DI, DO, DC,
DM, AI, AO, GI,
GO, PI

True=Online
Test

Boolean

False=Test off
True=Test on

Value

Discrete =
Binary
Analog = Float
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Name

Type

Value

Read/Write

INET Point
Types

Value Property Binding
For all INET point types, you can bind to the point’s Value property in order to use
the I/NET point’s value as an input to another object in Building Operation. For AO
(analog output) and GO (digital output) points, you can bind the point’s Value
attribute to the output of a Building Operation object in order to write a new value to
the INET point.

PvControl Property Binding
For DO (discrete output) and DC (discrete control) points, you can bind the point’s
PvControl attribute to the output of a Building Operation object in order to write a
new value to the INET point. No Building Operation program or schedule can write a
value to an INET output that is operating in Manual mode.

I/NET Input Points Binding
I/NET input points, such as AI, DI, GI, and PI points, cannot be controlled by
programs or schedules in Building Operation. These points are controlled by the
point scanner in the field controller. You can manually place these types of points in
Manual mode in order to manually send a value to the point.

Converted I/NET Graphics Binding
When you convert INET graphics to TGML, binding information is embedded in the
resulting TGML files. When you bring the TGML files into Building Operation, the
bindings associated with objects contained within the graphic are created
automatically.
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101.4

Configuring an I/NET Point
You configure an I/NET point in Building Operation to meet the unique needs of
your site. For example, you can place a point in test by selecting Test to True.
For more information, see section 99.1 “INET Interface” on page 4487.

To configure an I/NET point
1. In WorkStation, in the System Tree pane, select the I/NET point.
Continued on next page
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2. Edit the I/NET point properties:
Property

Description

Status

Displays Online when the I/NET point is
successfully communicating with Building
Operation.

Test

Select True to place the point in test
mode. Displays True when test mode is
on for the point.

Old Data

Displays True when the value of the point
did not get updated during the most
recent polling cycle. In this case, the
point’s value is old and should not be
considered valid.

Alarm

Displays True when the point is in alarm.

Alarm Acknowledge

Select True to acknowledge an alarm on
the point.

Alarm Inhibit

Displays True when the point has an
alarm inhibit extension.

Unacknowledged

Displays True when at least one alarm
condition has occurred at the point and
has not been acknowledged.

Point status flag

Displays a checkmark next to any point
status condition that is true. For example,
if a checkmark is displayed for Manual,
the point is in manual mode.

Manual

Select True to place the point in manual
mode. Displays True when the manual
mode is on.

I/NET Point address

Displays the 8-digit address assigned to
the I/NET point. For more information, see
section 101.1 “I/NET Points” on page
4509.

Point Type

Displays the type of point. For more
information, see section 101.1 “I/NET
Points” on page 4509.

Tri-state

Displays True when the discrete output
is configured for three-state operation.
Tri-state DO points are typically only used
for door points to support the door’s
Lock, Unlock, and Secure states.

Value

Displays the value of the point as of the
most recent successful polling cycle.

Present Value Text

Displays the state description associated
with the present value of the discrete
point.
Continued on next page
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Continued
Property

Description

Control Value

Enter a value you wish to issue to the
selected output point in order to manually
control connected equipment.

3. Click Apply.
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101.5

Editing an I/NET Point
Use this procedure to edit an I/NET point or to add or modify point extensions. The
point extensions that are available during this procedure depend on the type of
I/NET point you have selected in WorkStation.
For more information, see section 98.6 “I/NET Seven Editors” on page 4480.

To edit an I/NET point
1. In WorkStation, in the System Tree pane, select the I/NET point.
2. On the Actions menu, point to Edit and then click a command:
• Click Point Configuration to edit the point.
• Click Calculation to add or modify a calculation extension.
• Click Event to add or modify an event definition extension.
• Click Trend Configuration to add or modify a trend configuration
extension.
• Click Alarm Inhibit to add or modify an alarm inhibit extension.
3. In the I/NET Seven editor, edit the point or point extension.
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101.6

Commanding an I/NET Point
Use this procedure to send a command to an I/NET point.
For more information, see section 98.6 “I/NET Seven Editors” on page 4480.

To command an I/NET point
1. In WorkStation, in the System Tree pane, select the I/NET device.
2. In the List View, select an I/NET point.
3. On the Action menu, point to Commands and then click a command:
• Click Acknowledge to place the I/NET point in automatic control.
• Click Test On to place the I/NET point in test mode.
• Click Test Off to take the I/NET point out of test mode.
• Click Point Control to launch I/NET’s native point control editor.
• Click Alarm Configuration to set message routing parameters for the
selected I/NET point.
4. In the I/NET Seven editor, edit the selected point.

04-16006-04-en, March 2015

Technical
4521

101 I/NET Points
101.7 I/NET Alarms, Schedules, and Trends

101.7

I/NET Alarms, Schedules, and Trends
In Building Operation, you can receive and acknowledge I/NET alarms, control
I/NET schedules, and create trends on I/NET integrated points.

101.7.1

Alarms for I/NET Devices
An I/NET alarm can result from many types of events that can occur within the
I/NET system. For example, if an I/NET point’s value exceeds its high or low limit, it
could cause an alarm.
For more information, see section 101.8 “Alarms For I/NET Devices” on page 4521.

101.7.2

Schedules for I/NET Devices
You use the I/NET Seven Time Schedule editor to create built-in schedules that
reside locally in I/NET points. You can also create Building Operation schedules to
control I/NET points.
For more information, see section 101.9 “Schedules For I/NET Devices” on page
4522.

101.7.3

Trends for I/NET Devices
I/NET Seven’s native trends do not convert to Building Operation trends. Building
Operation provides its own functions that allow you to create trend logs and trend
charts based on the historic values of a variable. In addition to Building Operation's
standard trending functions, you can also create I/NET-specific trends. These are
also referred to as I/NET trends but they are not the trends that are native to I/NET
Seven.
For more information, see section 101.10 “Trends For I/NET Devices” on page
4523.
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101.8

Alarms For I/NET Devices
An I/NET alarm can result from many types of events that can occur within the
I/NET system. For example, if an I/NET point’s value exceeds its high or low limit, it
could cause an alarm.
In order to receive an I/NET alarm in Building Operation, the following conditions
must be met:
• The alarm must be routed to I/NET Seven AMT at the PC that is running the
Enterprise Server.
• The I/NET object (such as host, link, site, or point) associated with the alarm
must exist in the INET Interface in the System Tree pane.
When an I/NET alarm gets acknowledged in I/NET Seven, it also becomes
acknowledged in Building Operation. Acknowledging an alarm in Building Operation
also causes the alarm to become acknowledged in I/NET Seven. Purging an alarm
from I/NET Seven on the PC that is running the Enterprise Server also causes the
alarm to be removed from Building Operation.
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101.9

Schedules For I/NET Devices
You use the I/NET Seven Time Schedule editor to create built-in schedules that
reside locally in I/NET points. You can also create Building Operation schedules to
control I/NET points.
The main difference between each type of schedule is described below:
• I/NET Seven schedule: When you create an I/NET Seven schedule for an I/NET
point, the schedule resides in the device and continues to control the I/NET
point when the connection between the PC and the device is closed.
• Building Operation schedule: When you create a Building Operation schedule,
the schedule resides in the server. You bind the Building Operation schedule to
an I/NET point in an I/NET device to control the point’s value. The connection
between the Building Operation server and the I/NET device must be
maintained in order for the Building Operation schedule to continue to control
the point.
I/NET schedules do not convert to Building Operation schedules. I/NET Seven
schedules and Building Operation schedules work independently of one another.
For this reason, care should be taken to avoid creating opposing schedules.
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101.10

Trends For I/NET Devices
I/NET Seven’s native trends do not convert to Building Operation trends. Building
Operation provides its own functions that allow you to create trend logs and trend
charts based on the historic values of a variable. In addition to Building Operation's
standard trending functions, you can also create I/NET-specific trends. These are
also referred to as I/NET trends but they are not the trends that are native to I/NET
Seven.
An advantage of using I/NET trends is that data from an I/NET point can be
collected and stored by I/O Server regardless of whether or not the Enterprise
Server is running. When the Enterprise Server is running, trend data from the I/NET
device is transmitted to the Building Operation database as it is being collected.
When the Enterprise Server is not running, I/O Server continues to collect and store
trend data from the point. The next time the Enterprise Server runs, stored I/NET
trend data ia transferred to the Building Operation database and new I/NET trend
samples are again transmitted to the Building Operation database as they are
collected.

101.10.1

Trend Sampling Extensions
In order to have an I/NET device collect and store trend data from a point, the point
must be configured with a trend sampling extension. You can add a trend sampling
extension to an I/NET variable from WorkStation using the I/NET Seven trend
sampling editor. As you add this extension to the point, you will be presented with
I/NET Seven’s native trend sampling editor. I/NET Seven’s documentation
describes how you can use this editor to add the trend sampling extension to the
point. For more information, see section 101.5 “Editing an I/NET Point” on page
4518.

101.10.2

Trend Data Routing
The Enterprise Server is capable of receiving any I/NET trend data that is being
routed to the I/NET Seven host application running on the same workstation. I/O
Server running on this workstation is responsible for collecting and distributing trend
data to its clients.
I/O Server uses the SevenTrends routing settings defined in a point’s trend
sampling extension, as well as those defined for the I/NET Seven host application,
to determine what trend data it needs to collect. As I/O Server collects trend data
from devices, it distributes this data immediately to its on-line clients. For any off-line
clients, I/O Server stores the trend data in an SQL database table for later
distribution. When the Enterprise Server contains an I/NET Interface, it is a client of
I/O Server and can therefore receive the collected I/NET trend data. For more
information, see section 101.11 “Creating an I/NET Trend” on page 4524.
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101.11

Creating an I/NET Trend
You create an I/NET trend to keep a running log of sampled values from an I/NET
point.
For more information, see section 101.10 “Trends For I/NET Devices” on page
4523.

To create an I/NET trend
1. In WorkStation, in the System Tree pane, select the INET Interface where
you want to create the I/NET trend.
2. On the File menu, point to New and then click the type of trend you want to
create.
3. In the Name box, type a name for the trend.

4. In the Description box, type a description for the trend.
5. Click Create.
You can now configure the trend. For more information, see section 101.12
“Configuring an I/NET Trend” on page 4525.
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101.12

Configuring an I/NET Trend
Use this procedure to configure an I/NET trend. The I/NET point you assign to this
trend must already have a Trend Sampling extension.
For more information, see section 101.10 “Trends For I/NET Devices” on page
4523.

To configure an I/NET trend
1. In WorkStation, in the System Tree pane, select the I/NET trend you want to
configure.
2. In the Value properties dialog box, in the Point To Trend box, click the
browse button

.

Continued on next page
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3. In the Select Object dialog box, expand INET Network and then expand
the INET device.

4. Select the I/NET point to trend.
5. Click Select.
6. In the Value properties dialog box, in the Log size box, enter the number of
values you want to be included in the trend.
7. In the properties dialog box, click OK.
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102 I/NET Graphics
102.1 I/NET Graphics

102.1

I/NET Graphics
You use I/NET Seven to convert I/NET Seven graphics to a TGML format, which is
compatible with Building Operation. You can move converted graphics to your
Building Operation project and begin using the graphics immediately. You can also
edit these graphics using Building Operation Graphics Editor.

102.1.1

I/NET Graphics Conversion
Building Operation and I/NET Seven use different graphic engines. Not all objects or
attributes of the original I/NET Seven graphic convert to the same type of object or
attribute in Building Operation.
For more information, see section 102.2 “I/NET Graphics Conversion” on page
4532.

102.1.2

Folder Hierarchy
One feature of I/NET Seven graphic pages is their ability to link to each other using
page markers. Linked files can be grouped into a single folder or they can be
spread out among multiple folders at different directory levels. If you are converting
I/NET graphic files that contain page markers (or files that are the target of page
markers), you must maintain the relative paths between these graphics when you
use them in WorkStation. This allows the graphics in WorkStation to properly link to
each other.
Before you begin converting I/NET graphics to TGML, you should observe the
folder structure of where the original graphic files reside. The same folder structure
is required in WorkStation to ensure proper linking between graphics. In
WorkStation, you can create a top level folder in which any other necessary folders
will reside. The name you assign to this top-level folder does not affect the linking of
converted graphics.
Within the top-level folder, you can create the necessary folder hierarchy in two
ways:
• Manually create a hierarchy by observing the folder structure of the original
graphic files and duplicating that structure in WorkStation. Use this method of
creating a hierarchy when you will use the manual method of moving graphics
to WorkStation.
• Allow the hierarchy to be created automatically by moving graphics to
WorkStation in batches.
If a graphic contains no links to other graphics, and it is not the target of another
graphic, you can place it anywhere in the folder hierarchy.
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Figure: Relative folder hierarchy

102.1.3

Graphic Conversion Workflow
Converting I/NET Seven graphics to a TGML format has two basic steps.

Figure: I/NET conversion workflow

Convert I/NET Seven Graphic
Use I/NET Seven to convert I/NET graphic pages to TGML files that you can bring
into Building Operation. You can convert I/NET graphic page files one at a time or in
batches. As each file is converted, the resulting TGML file is placed in the output
directory you specify. For more information, see section 102.3 “Converting I/NET
Graphics to TGML” on page 4538.

Move Converted Graphic to Enterprise Server Database
You can move converted graphics from Windows Explorer to Enterprise Server
database two ways:
• Manual method: Create a folder hierarchy in WorkStation. Drag TGML files
from Explorer window to the appropriate folder in the System Tree pane. If
you intend to move converted graphics into WorkStation manually, then you
need to manually create a folder hierarchy within Workstation. For more
information, see section 102.5 “ Moving Converted I/NET Graphics to
WorkStation Manually” on page 4541.
• Import metnod: Create a graphics folder and then import the graphics to that
folder. The Batch importer creates folders in the System Tree pane. The
batch importer automatically creates folders within Building Operation to
duplicate any hierarchy found to exist within the Explorer folder specified as the
source of TGML files. The batch importer then imports the TGML files and
Technical
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automatically creates the necessary graphic objects at the appropriate
locations within that Building Operation folder hierarchy. For more information,
see section 102.4 “ Moving Converted I/NET Graphics to WorkStation in a
Batch” on page 4540.
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102.2

I/NET Graphics Conversion
Building Operation and I/NET Seven use different graphic engines. Not all objects or
attributes of the original I/NET Seven graphic convert to the same type of object or
attribute in Building Operation.
The following table describes how each object/attribute is converted from I/NET
Seven to TGML.
Table: Conversion Handling
Original Object /
Attribute

Resulting Object /
Attribute

Conversion Notes

Font

Font

For any text that uses the
“System” font, the typeface
converts to Lucida Sans. For
all other text, the typeface is
retained.
All font sizes are retained.
However, text in converted
graphics appears smaller in
Building Operation than the
original text appeared in
I/NET Seven.
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Grid

N/A

Not applicable. The Building
Operation Graphics Editor
provides its own grid
functions.

Backdrop

Layer

The bitmap used as a
backdrop in an I/NET graphic
converts to a layer in the
Building Operation graphic.
The setting of I/NET’s
“Stretch to fit” property
determines the size and
shape of the converted
image.

Window Fill

Layer Fill

The foreground color defined
for the window fill is retained.
Any pattern or hatch setting
defined for the window fill is
not retained.
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Continued
Original Object /
Attribute

Resulting Object /
Attribute

Conversion Notes

Page Marker

Component

The resulting component
contains a TextBox and a
Link object.
In order for the link to work
correctly, the target graphic
must be given the same
name in Building Operation
that it had in I/NET Seven,
without the file extension. For
example, a file named
“Summary.gpg” in I/NET
Seven must be named
Summary in Building
Operation.
In Building Operation, you
must be sure to maintain the
same paths between linked
graphics that existed in I/NET
Seven. For example, if a
page marker in I/NET Seven
links to
“/MyFolder/Page1.GPG”,
then the graphic named
Page1 in Building Operation
must reside in a folder
named “MyFolder”.

Door

Component

The contents of the resulting
component depends on how
the door’s Display Options
are configured in I/NET
Seven:
• Value only: The
component contains a
TextBox that binds to
the PvText property of a
signal.
• Icon only: The
component contains an
image and a bind to the
PvText property of a
signal.
• Icon plus value: The
component contains an
image and a TextBox
that binds to the PvText
property of a signal.
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Continued
Original Object /
Attribute

Resulting Object /
Attribute

Conversion Notes

Tool Marker

Component

The resulting component
contains a script used to
execute the appropriate
action when the user clicks
on the component in Building
Operation. The other
contents of the component
depends on how the tool
marker’s Display Options are
configured in I/NET Seven:
• Label only: The
component contains a
TextBox with the text of
the label.
• Icon and label: The
component contains an
image of the icon and a
TextBox with text of the
label.
• Graphic symbols: The
component contains a
group of objects
(shapes and/or images)
that make up the
graphic symbol.

Dial Marker

Component

The component contains a
script used to execute the
appropriate action when the
user clicks on the
component in Building
Operation. The other
contents of the component
depends on how the dial
marker’s Display Options are
configured in I/NET Seven:
• Label only: The
component contains a
TextBox with the text of
the label.
• Icon and label: The
component contains an
image of the icon and a
TextBox with text of the
label.
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Continued
Original Object /
Attribute

Resulting Object /
Attribute

Conversion Notes

CCTV Marker

Component

The contents of the resulting
component depends on how
the CCTV marker’s Display
Options are configured in
I/NET Seven:
• Label only: The
component contains a
TextBox with the text of
the label.
• Icon only: The
component contains an
image of the icon.
• Icon and label: The
component contains an
image of the icon and a
TextBox with text of the
label.
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DDC Modules

Component

The component contains a
script used to execute the
appropriate action when the
user clicks on the
component in Building
Operation. The component
also contains an image of the
icon.

DDC Lines

Component

–

ASC Marker

Component

–

Text Box

Text Box

The text size is maintained.
However, the text appears
smaller in Building Operation.
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Continued
Original Object /
Attribute

Resulting Object /
Attribute

Conversion Notes

Point

Component

The contents of the resulting
component depends on how
the point’s Display Options
are configured in I/NET
Seven:
• Value only: The
component contains a
TextBox that binds to
the PvText property of a
signal.
• Icon only: The
component contains an
image and a bind to the
PvText property of a
signal.
• Icon plus value: The
component contains an
image and a TextBox
that binds to the PvText
property of a signal.
• Graphic symbols: The
component contains an
image for each defined
state of the point and a
bind to the DigitalState
property of a signal.
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Line

Line

Rounded line ends convert to
flat line ends.

Polyline

Polyline

Rounded line ends convert to
flat line ends.

Free Pen

Polyline

Rounded line ends convert to
flat line ends.

Polygon

Polyline

Rounded line ends convert to
flat line ends.

Rectangle

Rectangle

A rectangle converts to a
rectangle.

Rounded Rectangle

Rectangle

The resulting rectangle will
have a RadiusX and RadiusY
value appropriate to acheive
the necessary corner
curvatures.

Square

Rectangle

All sides of the resulting
rectangle will be of equal
length.

Ellipse

Ellipse

The resulting elipse will retain
the height and width of the
original I/NET object.
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Continued
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Original Object /
Attribute

Resulting Object /
Attribute

Conversion Notes

Circle

Ellipse

The resulting elipse will have
equal height and width
values.

Arc

Arc

Rounded line ends convert to
flat line ends.

Chord

Chord

A chord converts to a chord.

Pie

Pie

A pie converts to a pie.

Curve

Curve

Rounded line ends convert to
flat line ends.

Image

Image

An image converts to an
image.
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102.3

Converting I/NET Graphics to TGML
You convert I/NET graphics to TGML so you can use them in Building Operation.
For more information, see section 102.1 “I/NET Graphics” on page 4529.

To convert I/NET graphics to TGML
1. In WorkStation, in the System Tree pane, select the INET Interface.
2. On the Actions menu, click Convert graphics.
3. In the list of I/NET graphic files, use the checkboxes in the Select column to
select files to include in the conversion.

4. In the Source box, enter the path to the I/NET graphic files you want to
convert.
5. Clear Look in subfolders to exclude the subfolders that are beneath the
source path.
6. Clear Over-write existing files to prevent existing files from being
overwritten.
7. Select Log conversions to generate a log file during the conversion.
TGMLConversionLog.txt is created at the location specified by the
Destination parameter if any files get converted.
8. Select Symbols to show only symbol files in the list of I/NET graphics.
9. Select Add point status to include a status indicator to the immediate right
of all I/NET points that are shown in a graphic. Status indicators show an M
when a point is in manual mode, a T when a point is in test mode, an A when a
point is in alarm, and an I when a point is alarm inhibited.
Continued on next page
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10. If you are using I/NET version 2.44A or later, select Right click menu to add
right-click menu functionality to the resulting TGML graphics. Within Building
Operation, you will then have the ability to right-click point objects in the
resulting graphics in order to display a menu of point-specific commands.
11. In the Destination box, enter the location for the resulting TGML output files.
12. In the INET Interface path box, enter the path to where the INET interface
is located in WorkStation. This setting affects the bindings that get defined for
objects in the resulting TGML file(s). If you accepted the default name when
you created the I/NET interface in WorkStation, this path is typically /Server
1/INET Interface/.
13. Click Convert.
14. Click Close.
You can now move the resulting TGML files to WorkStation. For more information,
see section 102.4 “ Moving Converted I/NET Graphics to WorkStation in a Batch”
on page 4540.
For more information, see section 102.5 “ Moving Converted I/NET Graphics to
WorkStation Manually” on page 4541.

04-16006-04-en, March 2015

Technical
4541

102 I/NET Graphics
102.4 Moving Converted I/NET Graphics to WorkStation in a Batch

102.4

Moving Converted I/NET Graphics to
WorkStation in a Batch
After I/NET graphics are converted to TGML, you can move them from Windows
Explorer to the appropriate folder in the System Tree pane as a batch. This process
maintains the original hierarchy.
For more information, see section 102.1 “I/NET Graphics” on page 4529.

To move converted I/NET graphics to WorkStation in a batch
1. In WorkStation, in the System Tree pane, select the INET Interface.
2. On the File menu, point to New, and then click Inet Graphics.
3. In the Name box, enter a name for the folder.

4. In the Description box, enter a description for the folder.
5. Click Create.
6. Select the new graphics folder.
7. On the Actions menu, click Data Import.
8. In the Browse dialog box, select the folder containing the converted graphics
and then click OK.
9. Close the Data Import dialog box.
You can also use the manual method to move graphics to WorkStation. For more
information, see section 102.5 “ Moving Converted I/NET Graphics to WorkStation
Manually” on page 4541.
You can use the graphic as it is or modify it using the Graphics Editor. For more
information, see section 23.1 “Graphics Editor Overview” on page 789.
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102.5

Moving Converted I/NET Graphics to
WorkStation Manually
After I/NET graphics are converted to TGML, you can manually move them from
Windows Explorer to the appropriate folder in the System Tree pane.
For more information, see section 102.1 “I/NET Graphics” on page 4529.

To move converted I/NET graphics to WorkStation
1. In WorkStation, in the System Tree pane, determine where you want to store
converted I/NET graphics. If necessary, create a new folder for this purpose.
2. In Windows Explorer, locate the TGML files that were created during an I/NET
graphic conversion process.
3. Select the TGML files in Windows Explorer and drag them to the appropriate
folder in the System Tree pane.
You can also use the batch method to move graphics to WorkStation. For more
information, see section 102.4 “ Moving Converted I/NET Graphics to WorkStation
in a Batch” on page 4540.
You can use the graphic as it is or modify it using the Graphics Editor. For more
information, see section 23.1 “Graphics Editor Overview” on page 789.
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103.1

INET Interface Properties – Basic Tab
Use the Basic tab to view and edit basic information about the interface. For more
information, see the General Properties – Basic Tab topic on WebHelp.

Figure: INET Interface Properties

Table: INET Interface properties
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Property

Description

INET Global device scan rate

Enter how often you want to poll all the I/NET
devices for online/offline status. You can use
the property settings of each INET device to
define unique scan rates.

INET Global point scan rate

Enter how often you want to poll INET
signals for updates. By default, all INET
devices use this global point scan rate
setting. You can use the property settings of
each INET device to define unique scan
rates.
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103.2

INET Host Properties – Basic Tab
Use the Basic tab to view and edit properties of the selected I/NET host.

Figure: I/NET host properties pane

Table: INET host properties pane

Technical
4548

Property

Description

Status

Displays Online when the device is
communicating with Building Operation.

Host number

Enter the number of the host.
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103.3

INET Link Properties – Basic Tab
Use the Basic tab to view and edit properties of the selected I/NET link.

Figure: I/NET link properties pane

Table: INET link properties pane
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Property

Description

Status

Displays Online when the device is
communicating with Building Operation.

Link number

Enter the number of the link.
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103.4

INET Site Properties – Basic Tab
Use the Basic tab to view and edit properties of the selected I/NET site.

Figure: I/NET site properties pane

Table: INET site properties pane
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Property

Description

Status

Displays Online when the device is
communicating with Building Operation.

Link number

Enter the number of the link.

Site number

Enter the number of the site.
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103.5

INET Device Properties – Basic Tab
Use the Basic tab to view and edit properties of the device.

Figure: INET device properties

Table: I/NET Device Properties
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Property

Description

Status

Displays Online while the device is
successfully communicating with Building
Operation.

DCU Name

Enter a descriptive name for the I/NET
device. This name does not affect the
device's name in I/NET.

Model Number

Select the model number of the I/NET
device.

Link Number

Enter the link address that leads to the I/NET
controller LAN.

Station Number

Enter the station address of the device on
the I/NET controller LAN.

Technical
4551

103 I/NET User Interface
103.5 INET Device Properties – Basic Tab

Continued

Technical
4552

Property

Description

Number of Stations

Enter the number of station addresses used
by the device.

Time Synchronization

Select how often you want the clock in the
I/NET device to synchronize with the clock in
the Enterprise Server.

DCU Scan rate

Enter how often you want to poll the device
for online/offline status updates. Enter 0 to
scan this device at the global DCU scan rate
defined for the INET Interface.

Point scan rate

Enter how often you want to poll each signal
in the device. Enter 0 to scan to scan signals
in this device at the global point scan rate
defined for the INET Interface.
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103.6

INET Point Properties – Basic Tab
Use the Basic tab to view and edit basic information about the I/NET point.

Figure: I/NET Point Properties – Basic tab

Table: I/NET Point Properties – Basic tab
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Property

Description

Status

Displays Online when the I/NET point is
successfully communicating with Building
Operation.

Test

Select True to place the point in test mode.
Displays True when test mode is on for the
point.

Old Data

Displays True when the value of the point
did not get updated during the most recent
polling cycle. In this case, the point’s value is
old and should not be considered valid.

Alarm

Displays True when the point is in alarm.

Alarm Acknowledge

Select True to acknowledge an alarm on
the point.
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Property

Description

Alarm Inhibit

Displays True when the point has an alarm
inhibit extension.

Unacknowledged

Displays True when at least one alarm
condition has occurred at the point and has
not been acknowledged.

Point status flag

Displays a checkmark next to any point
status condition that is true. For example, if a
checkmark is displayed for Manual, the
point is in manual mode.

Manual

Select True to place the point in manual
mode. Displays True when the manual
mode is on.

I/NET Point address

Displays the 8-digit address assigned to the
I/NET point. For more information, see
section 101.1 “I/NET Points” on page 4509.

Point Type

Displays the type of point. For more
information, see section 101.1 “I/NET
Points” on page 4509.

Tri-state

Displays True when the discrete output is
configured for three-state operation.
Tri-state DO points are typically only used for
door points to support the door’s Lock,
Unlock, and Secure states.
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Value

Displays the value of the point as of the most
recent successful polling cycle.

Present Value Text

Displays the state description associated
with the present value of the discrete point.

Control Value

Enter a value you wish to issue to the
selected output point in order to manually
control connected equipment.
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103.7

INET Point Properties – Extensions Tab
Use the INET Point Extensions tab to view extensions that have been added to
the I/NET point.

Figure: I/NET Point Properties – Extensions tab

Table: I/NET Point Properties – Extensions tab
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Property

Description

Active Extensions

Displays a list of I/NET point extensions. A
checkmark next to an extension indicates
that the selected point has that extension.

Graphic point state

Displays an M when the point is in manual
mode, a T when the point is in test mode, an
A when the point is in alarm, and an I when
the point is alarm inhibited.
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103.8

INET Trend Properties – Basic Tab
Use the Basic tab to view and edit properties of the selected I/NET trend.

Figure: I/NET trend properties pane

Table: INET trend properties pane
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Property

Description

Point To Trend

Enter the I/NET point to use as the basis for
the trend log. Only an I/NET point that is
already configured to collect the necessary
trend data can be selected.

Log size

Enter the maximum number of values to
include in the trend log. If the I/NET device
contains more trend values than the number
you define here, only the most recent trend
values will be included in the trend log.
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103.9

Actions Menu – Commands Submenu
Use the Commands submenu to issue a command to the selected I/NET point.

Figure: Commands submenu

Table: Commands submenu
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Command

Description

Manual

Click Manual to take the selected I/NET
point out of automatic control and place it in
manual control.

Automatic

Click Automatic to take the selected I/NET
point out of manual control and place it in
automatic control.

Test On

Click Test On to place the selected I/NET
point in test mode. This mode isolates the
selected point from external hardware,
allowing you to verify controller operation for
the selected point without affecting or using
the external hardware. This also allows you
to manually enter states/values for the point.

Test Off

Click Test Off to take the selected I/NET
point out of test mode.

Point Control

Click Point Control to launch I/NET’s
native point control editor.

Alarm Configuration

Click Alarm Configuration to set
message routing parameters for the selected
I/NET point.
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103.10

Actions Menu – Edit Submenu
Use the Edit submenu to change the configuration of an I/NET point or to configure
point extensions on the point. For more information, see section 98.6 “I/NET Seven
Editors” on page 4480.

Figure: Edit submenu

Table: Edit submenu
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Command

Description

Point Configuration

Click Point Configuration to launch the
I/NET point configuration editor appropriate
for the selected point type. For more
information, see section 101.4 “Configuring
an I/NET Point” on page 4515.

Calculation

Click Calculation to add or modify a
calculation extension at the selected I/NET
point. The equation you define in this
extension is used to set the point’s value.

Event

Click Event to add or modify an event
definition extension at the selected I/NET
point. This extension can cause an Event
Sequence to take place or an Event action to
be broadcast in I/NET as a result of a
defined condition at the point.
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Command

Description

Trend Configuration

Click Trend Configuration to add or
modify a trend sampling extension at the
selected I/NET point. This extension allows
I/NET to collect trend data from the point.
Collected trend data can then be used within
Building Operation. For more information,
see section 101.10 “Trends For I/NET
Devices” on page 4523.

Runtime

Click Runtime to add or modify a runtime
extension at the selected I/NET point. This
extension allows I/NET to collect runtime
data from the point. Collected runtime data
can then be used within Building Operation.

Time Schedule

Click Time Schedule to add or modify a
time schedule extension at the selected DC
or DO point. This extension allows I/NET to
turn the point on or off based on a schedule.

Temperature Control

Click Temperature Control to add or
modify a temperature control extension at
the selected DC or DO point. This extension
allows I/NET to turn the point on or off based
on temperature inputs, setpoints, and other
control parameters.

Elevator

Click Elevator to add or modify an elevator
extension at the selected door point. This
extension allows I/NET to work in
conjunction with access control parameters
and personnel schedules to control access
to elevator floors.

Door

Click Door to add or modify a door
extension at the selected DO point. This
extension allows the DO point to control a
door.

Door ATS

Click Door ATS to add or modify an
automatic time schedule for the selected
door point. This extension allows you to
define schedules for controlling the door.
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104 MicroNet Introduction
104.1 MicroNet Overview

104.1

MicroNet Overview
MicroNet provides control of Heating, Ventilation, and Air Conditioning (HVAC)
devices such as fan coil units, heat pumps, rooftop units, boilers, and air handling
units
A MicroNet system might contain a single, standalone controller and a sensor, or
multiple MicroNet controllers can be networked to provide control in larger
buildings. All MicroNet controllers are fully configurable and variants exist to take
advantage of three different network protocols. The controllers are easily and
quickly set up using the VisiSat Configuration Tool (known hereafter as VisiSat).
For more information, refer to the MicroNet System Overview and the VisiSat
Engineering Guide.

104.1.1

MicroNet Workflow
To integrate a MicroNet network into Building Operation, you create a MicroNet
Interface in WorkStation and then import an XML file created in VisiSat. The XML file
is a list of MicroNet objects and points called an update file. You may have to import
the update file several times, re-programming each time.
For more information, see section 104.2 “MicroNet Workflow” on page 4563.

104.1.2

MicroNet Interface
MicroNet Interfaces enable MicroNet communication in Building Operation. A
MicroNet Interface is where MicroNet subnets, devices, and objects are created
after you have imported an update file. When you configure a MicroNet interface,
you select the network protocol that matches the type of MicroNet network that you
want to integrate into Building Operation.
For more information, see section 105.1 “MicroNet Interface” on page 4589.

104.1.3

MicroNet Networks
MicroNet network refers to the network protocol that you select when you configure
a MicroNet Interface in the System Tree pane, and represents the physical network
that you connect to your Building Operation Server.
For more information, see section 105.2 “MicroNet Networks” on page 4590.

104.1.4

MicroNet Devices
MicroNet devices are a family of stand-alone or networked devices that provide
direct control in a building's HVAC control system. All of the MicroNet devices that
are supported by Building Operation are fully programmable, using a set of control
objects in device memory. Before you can use a device in a network, you program
the control objects using VisiSat and then download the VisiSat program into the
device.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
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104.1.5

MicroNet Objects
Imported MicroNet objects are either standard or special objects contained within
MicroNet devices.
For more information, see section 107.1 “MicroNet Objects” on page 4623.
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104.2

MicroNet Workflow
To integrate a MicroNet network into Building Operation, you create a MicroNet
Interface in WorkStation and then import an XML file created in VisiSat. The XML file
is a list of MicroNet objects and points called an update file. You may have to import
the update file several times, re-programming each time.
When using VisiSat, IP Tunneling enables you to connect to your MicroNet network
by way of the Ethernet. In VisiSat, you add selected objects and points to a points
gallery, which contains points lists. A points list forms the basis for the update file
that you export to Building Operation. The update file is in Extensible Markup
Language. After the initial import, you can make further changes in VisiSat and then
reimport just the changes. There is no need to import the whole VisiSat scheme
again, which takes longer.
In Building Operation, you select the update file that you want to import by
specifying the path of the update file in the properties of the MicroNet Interface
object. For more information, see section 104.12 “Update Files” on page 4581.
In the System Tree pane, the import process creates a MicroNet tree structure
under the MicroNet interface. The MicroNet tree structure matches the VisiSat
project configuration, and is a graphical representation of the VisiSat project. The
tree structure contains the same subnets, devices, objects, and points that are
present in the exported points gallery. For more information, see section 104.4
“MicroNet Representation in Building Operation” on page 4569.
When integration is complete, you can view and interact with the MicroNet system
in WorkStation. For example, you can monitor changing values, set alarms and
trends, and change writable values.
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Figure: MicroNet network integration into Building Operation

104.2.1

Integration Flowchart
The integration flowchart provides an overview of the process that you might use
when integrating a MicroNet network into Building Operation.
For more information, see section 104.3 “Integration Flowchart” on page 4567.
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104.2.2

MicroNet Representation in Building Operation
When you integrate a MicroNet network into Building Operation, you create a new
MicroNet Interface in WorkStation and then import an XML file created in VisiSat.
The XML file is a list of MicroNet objects and points called an update file. After a
successful data import, the representation of the MicroNet network in the System
Tree pane contains the same network structure that exists in the physical MicroNet
network.
For more information, see section 104.4 “MicroNet Representation in Building
Operation” on page 4569.

104.2.3

MicroNet Interface Creation
You create a MicroNet interface to enable MicroNet communication in Building
Operation.
For more information, see section 104.5 “MicroNet Interface Creation” on page
4571.

104.2.4

Port Allocation and Configuration
When you connect a serial network to an Automation Server or a PC running an
Enterprise Server, you must ensure that it connects by way of a serial port. First you
allocate a port to the connected network (using the network properties), and then
you ensure that the port is correctly configured for the network (using the port
properties).
For more information, see section 104.6 “Port Allocation and Configuration” on
page 4572.

104.2.5

IP Tunneling
IP tunneling provides communication between the VisiSat server and the Building
Operation server controlling the MicroNet network. With IP tunneling enabled, you
can make reiterative changes to objects and points in your MicroNet devices and
regenerate new update files.
For more information, see section 104.10 “IP Tunneling” on page 4578.

104.2.6

VisiSat Programming
You use VisiSat to program your MicroNet devices. From VisiSat, you create and
then export a list of MicroNet objects and points. In Building Operation, you import
these objects and points to populate the MicroNet interface in the System Tree
pane.
For more information, see section 104.11 “VisiSat Programming” on page 4579.
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104.2.7

Update Files
An update file is an XML file that contains some or all of the data that eventually
represents the subnet, device, and object structure of the MicroNet network when
imported into Building Operation. An update file is created when you export a
VisiSat points list.
For more information, see section 104.12 “Update Files” on page 4581.

104.2.8

Data Import
When you import an update file into Building Operation, the MicroNet network is
created in the System Tree pane. As soon as you have established communications
between Building Operation and the physical MicroNet network, you can then see
MicroNet points changing dynamically in Building Operation.
For more information, see section 104.13 “Data Import” on page 4583.
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104.3

Integration Flowchart
The integration flowchart provides an overview of the process that you might use
when integrating a MicroNet network into Building Operation.
A typical MicroNet integration process might involve the following steps:
• Install Building Operation and VisiSat on the PC running the Enterprise Server,
or install and commission an Automation Server. For more information, see the
Installation Overview topic on WebHelp. Refer to the VisiSat Engineering Guide.
• Connect a MicroNet network to the Building Operation system. For more
information, see section 105.10 “MicroNet Network Connectivity” on page
4600.
• Create a MicroNet interface interface and configure the interface for the
network protocol. For more information, see section 105.4 “Creating a
MicroNet Interface” on page 4592.
• Allocate and configure a port for the network. For more information, see
section 104.6 “Port Allocation and Configuration” on page 4572. For more
information, see section 104.8 “Configuring a Serial Port” on page 4575.
• Set up IP tunneling so that you can work in WorkStation and program VisiSat
on the same PC. For more information, see section 105.5 “Configuring a
MicroNet Interface” on page 4593. Refer to the VisiSat Engineering Guide.
• Program the VisiSat scheme. For more information, see section 104.11
“VisiSat Programming” on page 4579.
• Create a points list in VisiSat. For more information, see section 104.12
“Update Files” on page 4581.
• Export the VisiSat points list (the update file). Refer to the VisiSat Engineering
Guide.
• Import the update file to Building Operation. For more information, see section
104.14 “Importing MicroNet Network Data into Building Operation” on page
4584.
• Re-program in VisiSat and reimport as necessary. For more information, see
section 104.11 “VisiSat Programming” on page 4579.
The following flowchart summarizes the integration process.

04-16006-04-en, March 2015

Technical
4569

104 MicroNet Introduction
104.3 Integration Flowchart

Figure: MicroNet integration flowchart
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104.4

MicroNet Representation in Building
Operation
When you integrate a MicroNet network into Building Operation, you create a new
MicroNet Interface in WorkStation and then import an XML file created in VisiSat.
The XML file is a list of MicroNet objects and points called an update file. After a
successful data import, the representation of the MicroNet network in the System
Tree pane contains the same network structure that exists in the physical MicroNet
network.
Depending on the number and types of MicroNet devices deployed in the physical
network, the MicroNet interface in Building Operation comprises the following types
of object:
• Subnets: a subnet exists for each network management device (MicroNet
Manager Interface or Touch Screen). The subnet inherits an address number
from the address allocation in VisiSat.
• Device: a device represents any MicroNet device. The device inherits an
address number from the address allocation in VisiSat.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
• Special objects: any of five different types of complex MicroNet objects.
For more information, see section 107.5 “Special Objects” on page 4629.
• Standard objects (points): any of the remaining 41 different types of MicroNet
objects.
For more information, see section 107.4 “Standard Objects” on page 4627.
The following figure displays a MicroNet scheme in VisiSat, using the NCP protocol.
The scheme comprises a MicroNet Touchscreen and two MN 50 Series devices.

04-16006-04-en, March 2015

Technical
4571

104 MicroNet Introduction
104.4 MicroNet Representation in Building Operation

Figure: A MicroNet NCP network in VisiSat

The next figure displays the architecture of the imported MicroNet network in
Building Operation, and the System Tree displays a single subnet created by the
MicroNet Touchscreen (Subnet 2). The two devices on Subnet 2 are Device 5
(corresponding to the MN550, with address 2/5) and Device 8 (corresponding to
the MN650, with address 2/8).

Figure: A MicroNet interface in Building Operation
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104.5

MicroNet Interface Creation
You create a MicroNet interface to enable MicroNet communication in Building
Operation.
When configuring a new MicroNet interface, you select the protocol: NCP, SNP, or
ARCNET.
For more information, see section 105.4 “Creating a MicroNet Interface” on page
4592.
The interface that you create does not initially represent the physical MicroNet
network connected to your server, because the interface has no subnets or devices
attached. When you implement a MicroNet data import (when you import an update
file), the MicroNet interface inherits the subnets, devices, and objects or points
contained in the update file.
For more information, see section 104.13 “Data Import” on page 4583.
To ensure that Building Operation can communicate with your physical MicroNet
network, you must configure the communications properties of the MicroNet
interface in WorkStation.
The communications properties include basic options, such as the network baud
speed, and whether a network manager is present on the external network. In
addition, you must allocate and configure a port through which the physical network
can communicate.
For more information, see section 104.6 “Port Allocation and Configuration” on
page 4572.
You must also configure the path (or at least be aware of the default path) to an
XML file, which contains the structure of the MicroNet network you need to import.
For more information, see section 108.3 “MicroNet Interface Properties – Advanced
Tab” on page 4716.
You can also view the network online or offline status, and reset the read and write
status after a network communications failure.
For more information, see section 108.2 “MicroNet Interface Properties – Basic
Tab” on page 4714.
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104.6

Port Allocation and Configuration
When you connect a serial network to an Automation Server or a PC running an
Enterprise Server, you must ensure that it connects by way of a serial port. First you
allocate a port to the connected network (using the interface properties), and then
you ensure that the port is correctly configured for the network (using the port
properties).
All Building Operation servers provide a Serial folder that contains one or two serial
ports by default. The number of serial ports available depends on the type of server.
In the Enterprise Server, the Serial folder contains just one RS-232 port:

Figure: RS-232 port in an Enterprise Server

If you need to add another serial port for an additional interface, you can add the
port in WorkStation (for an Enterprise Server only). Because most modern PCs have
only one serial port, you may need to an add additional physical port using an
external USB-to-Serial port converter. You may also need to configure the Network
interface name property of your additional Building Operation port to match the
name of the new physical port.
In an Automation Server, the Serial folder contains two RS-485 serial ports (one for
each available physical port on the lower screw terminals of the device):
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Figure: RS-485 serial ports in an Automation Server

You cannot add additional ports for an Automation Server.
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104.7

Creating an RS-232 Port
You create an RS-232 port on an Enterprise Server to provide an interface to
associate with an RS-232 serial network. You only need to do this when you have
more than one RS-232 network.
For more information, see section 104.6 “Port Allocation and Configuration” on
page 4572.

To create an RS-232 port
1. In WorkStation, in the System Tree pane, expand the System folder, then
expand the Ports folder.
2. Click the Serial folder.
3. On the File menu, point to New and then click RS232-COMn.
4. In the Name box, type a name for the port.

5. In the Description box, type a description for the port.
6. Click Create.
You now configure the port.
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104.8

Configuring a Serial Port
You configure a serial port (RS-232) to bring it online, ready to be associated with a
serial network. For an RS-485 port, you can only configure the Log file name.
For more information, see section 104.6 “Port Allocation and Configuration” on
page 4572.

To configure a serial port
1. In WorkStation, in the System Tree pane, select the serial port.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:

Note
• Do not use spaces in the Network interface name.
Continued on next page
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Component

Description

State

Displays the network status: Online or
Offline, or Unused (Unused means
that the port is not referenced from a
network).

Bytes transmitted

Displays the running total of bytes
transmitted through the port.

Bytes received

Displays the running total of bytes
received through the port.

Parity errors detected

Displays the running total of parity errors
detected.

Framing errors detected

Displays the running total of framing
errors detected.

Other errors detected

Displays the running total of other errors
detected (errors other than parity or
framing errors).

Network interface name

Type the name of the network interface
(read-only for an RS-485 port), which is
usually the name of the COM port that
you connect the network to. Do not use
spaces.

Log file name

Type the name of the port log file or leave
this as the default, PortLog.
For the Enterprise Server, the log file is
available in C:\ProgramData\Schneider
Electric StruxureWare\Building Operation
x.x\Enterprise Server\db\portlogs\RS232COM1.
For the Automation Server, the log file is
available in opt\tac\db\portlogs\RS485COMA.
The portlogs folder is only available if a
log has previously been started by way of
the Start log command in the port
context menu.

5. Click OK.

Note
• The Network interface name (for an RS-485 port in an
Automation Server) is pre-allocated as either /dev/tac/comporta
or /dev/tac/comportb.
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104.9

Launching VisiSat from Building
Operation
You launch VisiSat from Building Operation when you need to program a VisiSat
project from the same PC where you installed Building Operation.

To launch VisiSat from Building Operation
1. In WorkStation, in the System Tree pane, right-click any MicroNet interface.
2. Click Launch VisiSat.
3. Select a project.

4. Click OK.
You can now program the VisiSat project.
Refer to the VisiSat 2.1 Engineering Guide (MicroNet)
Refer to the VisiSat 1.2 Engineering Guide (SNP, IAC)
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104.10

IP Tunneling
IP tunneling provides communication between the VisiSat server and the Building
Operation server controlling the MicroNet network. With IP tunneling enabled, you
can make reiterative changes to objects and points in your MicroNet devices and
regenerate new update files.
To enable IP tunneling, you must ensure that the IP port number in the VisiSat
server is the same as the VisiSat port number in the MicroNet interface.
It is important to set up the correct port numbers in WorkStation and in the VisiSat
server for successful communication to take place. The port number is 7001 by
default, but this number may be in use at some sites, in which case you must use
another number. If you need to change the VisiSat port number in the MicroNet
interface properties in WorkStation, you must also change the IP port number in the
VisiSat server to be the same.
Refer to the VisiSat Engineering Guide.
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104.11

VisiSat Programming
You use VisiSat to program your MicroNet devices. From VisiSat, you create and
then export a list of MicroNet objects and points. In Building Operation, you import
these objects and points to populate the MicroNet interface in the System Tree
pane.
For more information, see section 104.12 “Update Files” on page 4581.
VisiSat is graphically orientated software used to design and build HVAC schemes
in devices on MicroNet networks. In an ordinary MicroNet network, a VisiSat server
resides on the PC to which the MicroNet network connects. When you integrate the
MicroNet network into a Building Operation system, VisiSat runs on an the same PC
as the Enterprise Server. IP tunneling enables communication between the two
applications.
The following illustration shows a basic VisiSat scheme in a MicroNet device. You
create the objects and points in an environment called Bubbleland.

Figure: VisiSat objects and points within in a MicroNet device
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You may find it necessary to re-program your VisiSat scheme several times to
achieve the required MicroNet network in Building Operation.

Important
You develop Building Operation and VisiSat in parallel to ensure that the
integration of your MicroNet network is successful. You must upgrade to the
latest version of VisiSat 2.1 Configuration Tool (Version 2.1.185.0 or later) before
you can successfully integrate your MicroNet scheme into Building Operation.
Refer to the VisiSat Engineering Guide.
For more information, see section 104.10 “IP Tunneling” on page 4578.
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104.12

Update Files
An update file is an XML file that contains some or all of the data that eventually
represents the subnet, device, and object structure of the MicroNet network when
imported into Building Operation. An update file is created when you export a
VisiSat points list.
When you import an update file into Building Operation, the contents of the update
file may cause the following database modifications:
• Building Operation creates any new points added to the update file (but not
previously present in Building Operation).
• Building Operation deletes any points deleted from the update file (if previously
present in Building Operation). Building Operation also removes any references
or bindings relating to the deleted point and unsubscribes any pre-existing
subscriptions.
• Building Operation modifies any points modified in the update file (if previously
present in Building Operation) and preserves any references, bindings, or
subscriptions relating to the modified point.
• If you delete MicroNet devices in VisiSat, Building Operation deletes the
MicroNet devices and all their child objects. If a MicroNet device folder in
Building Operation contains locally created child objects (for example,
shortcuts, math objects, trend logs, or alarms), Building Operation deletes
those child objects on import of the update file.
Changes apply to certain objects and points:
• MicroNet objects and points
• Alarm points added, changed, or deleted in the VisiSat points gallery
• Trend Log points added, changed, or deleted in the VisiSat points gallery

Tip
When you create the points list in VisiSat, you should choose object names that
are suitable for use in Building Operation. The name of an object or point in
Building Operation is the same as the name of the VisiSat object or point from
which it derives. Although you can rename objects in Building Operation, if you
subsequently import a new update file, the update file overwrites the object
names.
In addition, you cannot import 'illegal' text strings, characters, or values (for
example, trailing spaces in text fields) into Building Operation property fields.

104.12.1

Update File Export
In VisiSat, when you have completed programming a VisiSat scheme and you have
created an update file for import in Building Operation, you can export the update
file to a suitable location for importing into Building Operation.
You can choose whether to import the complete XML file or just the most recent
changes.
For more information, see section 104.2 “MicroNet Workflow” on page 4563.
Refer to the VisiSat Engineering Guide.
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104.12.2

Update File Path
The update file path is the location where you store the XML file you create in
VisiSat for MicroNet data import. When you create the file, you must save it in a
location that Building Operation can access.
When you initiate a data import in WorkStation, Building Operation looks at the file
location you set up in the MicroNet interface advanced properties and imports the
update file from there. By default, the path is C:\Satchwell\Projects.
For more information, see section 104.13 “Data Import” on page 4583.
Once you have set up the file location, Building Operation always looks at the same
location each time you initiate a data import, until you change the file location.
However, if you change this location, you must remember to save the new location
or the data import will fail.
Refer to the VisiSat Engineering Guide.
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104.13

Data Import
When you import an update file into Building Operation, the MicroNet network is
created in the System Tree pane. As soon as you have established communications
between Building Operation and the physical MicroNet network, you can then see
MicroNet points changing dynamically in Building Operation.
You normally import an update file after you have finished a phase of programming
in VisiSat. The update file that you import may constitute a complete MicroNet
network, or it may be only a partial MicroNet network. You set this option in VisiSat
when you create the update file.
For more information, see section 104.12 “Update Files” on page 4581.
You also must ensure that the path of the update file that you want to import is
present in the location specified in the advanced interface properties.
For more information, see section 108.3 “MicroNet Interface Properties – Advanced
Tab” on page 4716.
For more information, see section 104.12 “Update Files” on page 4581.
Building Operation creates a trace file (Trace.txt) which contains details of all the
events occuring during the data import. This includes a record of the number of
times that you import data to the same network (you can reset this to any value).
You can use this trace file for information and diagnostic purposes, and you can
also choose the file location of the trace file.
By default, the path of the trace file is C:\ProgramData\Schneider Electric Buildings
AB\StruxureWare x.x\Schneider Electric StruxureWare\Trace.txt.
You can also choose to disable the trace, in which case the trace file contains only
the basic data that you see in the Data Import dialog box.
For more information, see section 117.4 “Data Import Dialog Box” on page 4957.

104.13.1

Functions Available After Import
After you have imported a MicroNet update file into Building Operation, there are a
limited number of functions available to you regarding MicroNet subnets, devices,
and points.
For more information, see section 104.15 “Functions Available After Import” on
page 4585.
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104.14

Importing MicroNet Network Data into
Building Operation
You import MicroNet data into a MicroNet network in Building Operation to create
or upgrade a structure of MicroNet devices, objects, and points.

To import MicroNet network data into Building Operation
1. In WorkStation, in the System Tree pane, right-click the MicroNet interface
that you want to update and select Data Import.
2. Monitor the import process.
Message or Button

Description

Trace will be sent to:

Displays the path to the location of the
trace file.

Source:

Displays the path to the location of the
update file.

Full URL:

Displays the path to the location of the
update file, plus (if applicable) extra
diagnostic information for Schneider
Electric engineers.

Import

Click to import data following further
VisiSat programming.

3. Click Close.

Note
• Ensure that the Advanced properties of the interface contain
the correct address of the update file.
• The extent of the data that you import is dependent on whether
you select “Force Complete Export” when exporting the
update file in VisiSat. Refer to the VisiSat Engineering Guide.
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104.15

Functions Available After Import
After you have imported a MicroNet update file into Building Operation, there are a
limited number of functions available to you regarding MicroNet subnets, devices,
and points.
The following table indicates the import functions available and the relevant menu
commands that you can apply to the four possible levels within the heirarchy of an
imported MicroNet network.
Table: Import and Modify Functions in a MicroNet Hierarchy
Function

04-16006-04-en, March 2015

Command

Network

Subnet

Device

Point

Import
objects

Data Import

Yes

No (except as No (except as No (except as
children)
children)
children)

Create

New

Yes

No

No

No

Rename

Rename

Yes

No

No

No

Update
(generic
properties)

Open

Yes

Yes

Yes

Yes

Delete

Delete

Yes

No

No

No

Cut

Cut

Yes

No

No

No

Copy

Copy

Yes

Paste

Paste

Yes

No

No

No

Move

Move

Yes

No

No

No

Paste as
shortcut

Paste as
shortcut

Yes

Yes

Yes

Yes

Yes (shortcut Yes (shortcut Yes (shortcut
creation only) creation only) creation only)
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Topics
MicroNet Interface
MicroNet Networks
Configuring a MicroNet Subnet
Creating a MicroNet Interface
Configuring a MicroNet Interface
MicroNet Network Protocols
NCP Networks
SNP Networks
ARCNET Networks
MicroNet Network Connectivity
Connectivity – Automation Server
NCP or SNP using a Serial Link
ARCNET to Automation Server using an MNMI
Connectivity – Enterprise Server
NCP or SNP using an RS-232 to RS-485 Converter
NCP or SNP using a USB to RS-485 Converter
NCP using a Serial Link and MNMI
SNP using a Serial Link and MIU
ARCNET to Enterprise Server using an MNMI
MicroNet Network Communications

Read or Write Failure
Receive Timeout
Online or Offline Monitoring
Error Count
Poll Interval

105 MicroNet Networks
105.1 MicroNet Interface

105.1

MicroNet Interface
MicroNet Interfaces enable MicroNet communication in Building Operation. A
MicroNet Interface is where MicroNet subnets, devices, and objects are created
after you have imported an update file. When you configure a MicroNet interface,
you select the network protocol that matches the type of MicroNet network that you
want to integrate into Building Operation.
You can select from three types of MicroNet network protocol:
• NCP
• SNP
• ARCNET
When you have created and configured a MicroNet interface, you can then import
an update file that you create in VisiSat. For more information, see section 104.12
“Update Files” on page 4581.
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105.2

MicroNet Networks
MicroNet network refers to the network protocol that you select when you configure
a MicroNet Interface in the System Tree pane, and represents the physical network
that you connect to your Building Operation Server.
Each device contains one or more MicroNet objects, and each object contains one
or more MicroNet points. Each MicroNet object or point in Building Operation
derives from a corresponding object or point in the imported XML file.

105.2.1

MicroNet Network Protocols
Building Operation provides support for the integration of two protocols that use
MicroNet MN 50 Series controllers, and for one protocol that uses older SNP and
Intelligent Advanced Controller devices.
For more information, see section 105.6 “MicroNet Network Protocols” on page
4596.

105.2.2

MicroNet Network Connectivity
A number of different connectivity options exist to enable you to physically connect
your MicroNet network to Building Operation by way of an Automation Server or an
Enterprise Server.
For more information, see section 105.10 “MicroNet Network Connectivity” on page
4600.

105.2.3

MicroNet Network Communications
If you control your MicroNet network using an Automation Server, WorkStation
communicates with the Automation Server across the Ethernet using TCP/IP
protocols, and addressing is by IP address. If you control your MicroNet network
using an Enterprise Server on the same PC where VisiSat is installed, addressing is
by Localhost.
For more information, see section 105.20 “MicroNet Network Communications” on
page 4610.
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105.3

Configuring a MicroNet Subnet
You configure a MicroNet subnet to reset any read or write failure indicators. You
can also see the subnet address (which matches the address of the relevant subnet
master device on the external network).
For more information, see section 104.4 “MicroNet Representation in Building
Operation” on page 4569.

To configure a MicroNet subnet
1. In WorkStation, in the System Tree pane, select the subnet you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Subnet

Displays the address of the subnet. The
subnet address displayed is the address
of the subnet master (for example, a
MicroNet Manager Interface) after a data
import.

Network status

Displays the online or offline status of the
network.

Output write failure

Displays Failure when the writing of one
or more output values has failed on the
MicroNet network. Select OK to reset
after a successful write to all devices.

Input read failure

Displays Failure when the reading of one
or more input values has failed on the
MicroNet network. Select OK to reset
after a successful read from all devices.

5. Click OK.
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105.4

Creating a MicroNet Interface
You create a MicroNet interface so that a MicroNet network structure can be
imported later.
For more information, see section 104.5 “MicroNet Interface Creation” on page
4571.

To create a MicroNet interface
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the MicroNet Interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, select MicroNet Interface.

4. In the Name box, type a name for the MicroNet Interface.
5. In the Description box, type a description for the MicroNet Interface.
6. Click Create.
You now configure the MicroNet Interface.
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105.5

Configuring a MicroNet Interface
You configure a MicroNet interface to ensure proper communications between
Building Operation and the MicroNet network.
For more information, see section 104.5 “MicroNet Interface Creation” on page
4571.

To configure a MicroNet interface
1. In WorkStation, in the System Tree pane, click the MicroNet interface that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
Continued on next page
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4. Edit the basic properties:
Property

Description

Network status

Displays whether the selected interface is
online or offline.

Output write failure

Displays the result of one or more
attempts by Building Operation to write to
a device on the MicroNet network. You
can reset to OK following failure. For
more information, see section 104.5
“MicroNet Interface Creation” on page
4571.

Input read failure

Displays the result of one or more
attempts by Building Operation to read
from a device on the MicroNet network.
You can reset to OK following failure. For
more information, see section 104.5
“MicroNet Interface Creation” on page
4571.

IP port

Enter the IP port number for MicroNet
networks. If you are using IP tunneling,
use the default (7001) unless this port
number is already allocated. For more
information, see section 104.10 “IP
Tunneling” on page 4578.

Port reference

Enter the path of the serial port to which
you connect the MicroNet network. You
will find the port (if created) in the
System/Ports folder - you may need to
create a port. For more information, see
section 104.7 “Creating an RS-232 Port”
on page 4574. For more information, see
section 104.6 “Port Allocation and
Configuration” on page 4572.

Protocol

Select the MicroNet network protocol.

Baud rate

Select the data transmission rate of the
physical network. Consult the data sheets
of the network devices if necessary.

MNMI present

Select Yes if a MicroNet Manager
Interface heads the network.

Broadcast time interval

Enter how often (in minutes) you want the
Building Operation server to broadcast
time updates to the network.

Broadcast subnet

Select Yes to enable the Building
Operation server to broadcast the subnet
address to the network at regular
intervals.

Receive timeout (ms)

Enter the number of milliseconds you
want the Building Operation server to wait
for a response from a device (normally
2000 ms). For more information, see
Continued on next page
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Continued
Property

Description
Section 4.5 “Receive Timeout” on page
123.

Point poll delay (ms)

Enter the delay you require between the
end of one poll request and the start of
the next poll request.

5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Update file

Enter the path to the XML update file that
contains the MicroNet network structure.
For more information, see section 104.12
“Update Files” on page 4581.

Update number

Displays the number of times you have
imported data to the MicroNet interface.
For more information, see section 104.13
“Data Import” on page 4583.

Trace file

Enter the path of the trace file. For more
information, see section 104.13 “Data
Import” on page 4583.

Enable trace

Select True to enable the trace. For more
information, see section 104.13 “Data
Import” on page 4583.

7. Click OK.
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105.6

MicroNet Network Protocols
Building Operation provides support for the integration of two protocols that use
MicroNet MN 50 Series controllers, and for one protocol that uses older SNP and
Intelligent Advanced Controller devices.

105.6.1

NCP Networks
A MicroNet NCP network contains MicroNet devices that use the Native
Communications Protocol. An NCP network has a default communications speed
of 9.6k baud (configurable for MN 50 series) and can host up to 20 sub-networks
(subnets) with 63 devices each communicating in a polled-response mode.
For more information, see section 105.7 “NCP Networks” on page 4597.

105.6.2

SNP Networks
An SNP network contains older products that use the Satchwell Networking
Protocol: SNP Networking Protocol devices and Intelligent Advanced Controllers
(IAC). Building Operation supports the use of some variants of SNP and IAC devices
in an SNP network.
For more information, see section 105.8 “SNP Networks” on page 4598.

105.6.3

ARCNET Networks
ARCNET is a peer-to-peer, high-performance network, created by using devices
that use the Attached Resource Computer Network protocol, and a MicroNet
Manager Interface (MNMI).
For more information, see section 105.9 “ARCNET Networks” on page 4599.
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105.7

NCP Networks
A MicroNet NCP network contains MicroNet devices that use the Native
Communications Protocol. An NCP network has a default communications speed
of 9.6k baud (configurable for MN 50 series) and can host up to 20 sub-networks
(subnets) with 63 devices each communicating in a polled-response mode.
An NCP network uses screened RS-485 twisted-pair cabling in a daisy-chain bus
topology. You can employ either a MicroNet Manager Interface or a Touch Screen
at the head of the network as the polling device.
Building Operation supports the use of NCP variants of MicroNet devices and
MicroNet 50 Series devices in an NCP network.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
You use VisiSat (version 2.1) to configure all MicroNet devices on an NCP network.
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105.8

SNP Networks
An SNP network contains older products that use the Satchwell Networking
Protocol: SNP Networking Protocol devices and Intelligent Advanced Controllers
(IAC). Building Operation supports the use of some variants of SNP and IAC devices
in an SNP network.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
An SNP network can operate at speeds of up to 1200 baud (MMC), 4800 baud
(IAC 400, and 600), and 9600 baud (IAC 420). Data is transmitted or received over
the network as ASCII characters representing hexadecimal values.
The maximum length of an SNP main network is 1000m, containing up to 31
devices and one subnet device. However, each subnet can also contain up to 31
devices, at maximum length of 1000m.
You use VisiSat (version 2.0) to configure all MicroNet devices on an SNP network.
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105.9

ARCNET Networks
ARCNET is a peer-to-peer, high-performance network, created by using devices
that use the Attached Resource Computer Network protocol, and a MicroNet
Manager Interface (MNMI).
Building Operation supports the use of ARCNET variants of MicroNet devices and
MicroNet 50 Series devices in an ARCNET network.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
You must use a MicroNet Manager Interface to connect the ARCNET network to
the Building Operation server.
An ARCNET communications network has a communications speed of 156k baud
and can host up to 95 devices per subnet (and up to 31 subnets using ARCNET
Routers). An ARCNET network uses screened RS-485 twisted-pair cabling. The
network speed between the MNMI and the ARCNET network is 9600 baud by
default.
Peer-to-peer communications enables devices on an ARCNET network to send
parameter values from one device to another over the network by using the
Network Variable (NVTx and NVRx) control objects in VisiSat. Typical data shared
between devices includes overrides, non-critical sensor data and monitor points.
The network protocol is token passing. Only the node that has the token can send a
message, after which the node must give up the token. This token-passing method
means that the network performance and speed can be calculated. Performance is
deterministic.

04-16006-04-en, March 2015

Technical
4601

105 MicroNet Networks
105.10 MicroNet Network Connectivity

105.10

MicroNet Network Connectivity
A number of different connectivity options exist to enable you to physically connect
your MicroNet network to Building Operation by way of an Automation Server or an
Enterprise Server.

105.10.1

Connectivity - Automation Server
You can connect an NCP or SNP MicroNet network to an Automation Server using
either of the two serial RS-485 ports. If you want to connect an ARCNET network,
you must use a MicroNet Manager Interface.
For more information, see section 105.11 “Connectivity – Automation Server” on
page 4601.

105.10.2

Connectivity - Enterprise Server
You can connect an NCP or SNP MicroNet network to a PC running an Enterprise
Server, by way of the serial RS-232 port or a USB port. If you want to connect an
ARCNET network, you must use a MicroNet Manager Interface between the PC
and the ARCNET network.
For more information, see section 105.14 “Connectivity – Enterprise Server” on
page 4604.
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105.11

Connectivity – Automation Server
You can connect an NCP or SNP MicroNet network to an Automation Server using
either of the two serial RS-485 ports. If you want to connect an ARCNET network,
you must use a MicroNet Manager Interface.

Note
The Automation Server does not support the use of Auto dial remote sites.

105.11.1

NCP or SNP using a Serial Link
You can connect a MicroNet NCP network or an SNP network to a serial COM port
of the Automation Server (COM A or COM B).

Tip
NCP or SNP networks do not require an MNMI or an MIU. You can remove these
when connecting a MicroNet network to the Automation Server.
For more information, see section 105.12 “NCP or SNP using a Serial Link” on page
4602.

105.11.2

ARCNET using an MNMI
You can connect a MicroNet ARCNET network to the Automation Server by way of
a MicroNet Manager Interface and a proprietary RS-232 to RS-485 converter.
For more information, see section 105.13 “ARCNET to Automation Server using an
MNMI” on page 4603.
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105.12

NCP or SNP using a Serial Link
You can connect a MicroNet NCP network or an SNP network to a serial COM port
of the Automation Server (COM A or COM B).
Building Operation supports the NCP variants of Standard MicroNet and MicroNet
MN50 Series. Building Operation also supports SNP and IAC networks and their
devices.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
Connection details are contained in the hardware section for the Automation
Server. For more information, see the Automation Servers topic on WebHelp.

Figure: NCP or SNP connection to an Automation Server using an RS-485 serial link.
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105.13

ARCNET to Automation Server using an
MNMI
You can connect a MicroNet ARCNET network to the Automation Server by way of
a MicroNet Manager Interface and a proprietary RS-232 to RS-485 converter.
You connect the RS-232 to RS-485 converter to the MNMI at PL3, and to the
Automation Server by way of the COM A port.
Building Operation supports the ARCNET variant devices of Standard MicroNet and
MicroNet MN50 Series networks. For more information, see section 106.1
“MicroNet Devices” on page 4619.
Port connection details are contained in the hardware section for the Automation
Server. For more information, see the Automation Servers topic on WebHelp.

Figure: ARCNET connection to an Automation Server using an MNMI and an RS-232 to
RS-485 converter
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105.14

Connectivity – Enterprise Server
You can connect an NCP or SNP MicroNet network to a PC running an Enterprise
Server, by way of the serial RS-232 port or a USB port. If you want to connect an
ARCNET network, you must use a MicroNet Manager Interface between the PC
and the ARCNET network.

105.14.1

NCP or SNP using an RS-232 to RS-485
Converter
You can use a proprietary RS-232-to-RS-485 converter to connect a MicroNet
NCP network or a SNP network (using SNP or IAC devices) to the PC running
Enterprise Server. The converter connects to the COM port.
For more information, see section 105.15 “NCP or SNP using an RS-232 to RS485 Converter” on page 4605.

105.14.2

NCP or SNP using a USB to RS-485 Converter
You can connect to a MicroNet NCP or SNP network to the PC running Enterprise
Server by way of a proprietary USB to RS-485 converter. The converter connects to
a USB port.
For more information, see section 105.16 “NCP or SNP using a USB to RS-485
Converter” on page 4606.

105.14.3

NCP using a Serial Link and MNMI
You can connect a MicroNet NCP network to the PC running Enterprise Server by
way of a MicroNet Manager Interface.
For more information, see section 105.17 “NCP using a Serial Link and MNMI” on
page 4607.

105.14.4

SNP using a Serial Link and MIU
You can connect a MicroNet SNP network (using SNP or IAC devices) to the PC
running Enterprise Server by way of a Modem Interface Unit.
For more information, see section 105.18 “SNP using a Serial Link and MIU” on
page 4608.

105.14.5

ARCNET using an MNMI
You can connect a MicroNet ARCNET network to a PC running Enterprise Server
by way of a MicroNet Manager Interface.
For more information, see section 105.19 “ARCNET to Enterprise Server using an
MNMI” on page 4609.
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105.15

NCP or SNP using an RS-232 to RS-485
Converter
You can use a proprietary RS-232-to-RS-485 converter to connect a MicroNet
NCP network or a SNP network (using SNP or IAC devices) to the PC running
Enterprise Server. The converter connects to the COM port.
You connect the converter to the PC COM port, and to the 3-wire, RS-485
network. For more information, see section 105.1 “MicroNet Interface” on page
4589.
Building Operation supports the NCP variants of Standard MicroNet and the
MicroNet MN50 Series. Building Operation also supports SNP and IAC networks
and their devices.
For more information, see section 106.1 “MicroNet Devices” on page 4619.

Figure: NCP or SNP connection to a PC running Enterprise Server using an RS-232 to
RS-485 Converter.
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105.16

NCP or SNP using a USB to RS-485
Converter
You can connect to a MicroNet NCP or SNP network to the PC running Enterprise
Server by way of a proprietary USB to RS-485 converter. The converter connects to
a USB port.
Building Operation supports the NCP variants of Standard MicroNet and MicroNet
MN50 Series. Building Operation also supports SNP and IAC networks and their
devices.
For more information, see section 106.1 “MicroNet Devices” on page 4619.

Figure: NCP or SNP connection to a PC running Enterprise Server using a converter
connected to a USB port
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105.17

NCP using a Serial Link and MNMI
You can connect a MicroNet NCP network to the PC running Enterprise Server by
way of a MicroNet Manager Interface.
You connect PL3 or PL4 of the MNMI to the serial COM (RS-232) port of the PC,
using a null modem cable.
Building Operation supports the NCP variants of Standard MicroNet and MicroNet
MN50 Series.
For more information, see section 106.1 “MicroNet Devices” on page 4619.

Figure: NCP connection to a PC running Enterprise Server using a MNMI connected to a
serial port
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105.18

SNP using a Serial Link and MIU
You can connect a MicroNet SNP network (using SNP or IAC devices) to the PC
running Enterprise Server by way of a Modem Interface Unit.
You connect the MIU to the serial COM (RS-232) port of the PC.
Building Operation supports SNP and IAC networks and their devices.

Figure: SNP connection to a PC running Enterprise Server using an MIU connected to a
serial port

For more information, see section 106.1 “MicroNet Devices” on page 4619.
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105.19

ARCNET to Enterprise Server using an
MNMI
You can connect a MicroNet ARCNET network to a PC running Enterprise Server
by way of a MicroNet Manager Interface.
You connect the MNMI to a MicroNet ARCNET network by way of a 3-wire, serial,
RS-485 interface, and to a PC running Enterprise Server by way of the COM port.
Building Operation supports the ARCNET variant devices of Standard MicroNet and
MicroNet MN50 Series networks. For more information, see section 106.1
“MicroNet Devices” on page 4619.

Figure: ARCNET connection to a PC running Enterprise Server using an MNMI
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105.20

MicroNet Network Communications
If you control your MicroNet network using an Automation Server, WorkStation
communicates with the Automation Server across the Ethernet using TCP/IP
protocols, and addressing is by IP address. If you control your MicroNet network
using an Enterprise Server on the same PC where VisiSat is installed, addressing is
by Localhost.
The Automation Server connects directly to a MicroNet device LAN (or a SNP
device LAN) by way of an RS-485 serial link. If you are integrating a MicroNet
ARCNET network, the network connects to the Automation Server by way of a
MicroNet Manager Interface (MNMI) and an RS-232 to RS-485 converter.
Using the Automation Server, you can access the MicroNet system from a web
browser on any PC connected to the Ethernet.
If you are using a PC running Enterprise Server to control your MicroNet network,
you first convert the RS-232 PC output to RS-485 (but not if you are using an MNMI
or an MIU). You can also convert a PC USB output to RS-485. If you are integrating
a MicroNet ARCNET network, the network connects to the Enterprise Server by
way of a MicroNet Manager Interface (MNMI).
Building Operation also has a number of facilities to assist you in the event of
communications difficulties. These are described in the following paragraphs.

105.20.1

Read or Write Failure
A read or write failure message is displayed in the status information properties of a
network, subnet or device, as result of one or more failed attempts by Building
Operation to read from or write to a subnet or device on the MicroNet network.
For more information, see section 105.21 “Read or Write Failure” on page 4612.

105.20.2

Receive Timeout
When a Building Operation server reads data from or writes data to a MicroNet
device, the Receive timeout is the maximum amount of time allowed to elapse
before the server increments the read or write error count.
For more information, see section 105.22 “Receive Timeout” on page 4613.

105.20.3

Time Synchronization
You can configure the Building Operation server to broadcast time synchronization
messages to your MicroNet network. You can also set the frequency of the time
synchronization messages.
You can also configure the Building Operation server to broadcast subnet numbers
(node addresses) to your MicroNet network.
For more information, see section 108.2 “MicroNet Interface Properties – Basic
Tab” on page 4714.
For more information, see section 105.5 “Configuring a MicroNet Interface” on page
4593.
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105.20.4

Online or Offline Monitoring
You can view the online or offline status of a MicroNet network, subnet, or device by
viewing its icon in the System Tree pane or by selecting its basic tab.
For more information, see section 105.23 “Online or Offline Monitoring” on page
4614.

105.20.5

Error Count
The error count occurs if the Building Operation server fails to read from or write to
an object or a point, and increments at each failure. You can use this function to
assist in troubleshooting communications failures.
For more information, see section 105.24 “Error Count” on page 4615.

105.20.6

Poll Interval
The poll interval is the amount of time between polls when the selected device is
polled to determine if it is online.
For more information, see section 105.25 “Poll Interval” on page 4616.

105.20.7

Generic RS-485 Network Devices
This application note provides recommendations for the RS-485 interface port
configuration between the Automation Server and generic RS-485 network devices
(Modbus or MS/TP). This information is intended to supplement the instructions you
receive with the various RS-485 network devices. These guidelines focus on the
arrangement of the electrical interface to the RS-485 port in regards to biasing,
termination, cable selection, cable lengths, and cable routing. The guidelines on
maximum unit load (node count) and common mode voltage tolerance are
associated with Automation Servers with serial number of TD133954000 and later.
For more information, see the Generic RS-485 Network Devices topic on WebHelp.
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105.21

Read or Write Failure
A read or write failure message is displayed in the status information properties of a
network, subnet or device, as result of one or more failed attempts by Building
Operation to read from or write to a subnet or device on the MicroNet network.
You can reset the status of the network, subnet, or device so that it no longer
indicates a read or write failure. You might want to reset the status after addressing
the cause of the failure, to check if the problem persists.
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105.22

Receive Timeout
When a Building Operation server reads data from or writes data to a MicroNet
device, the Receive timeout is the maximum amount of time allowed to elapse
before the server increments the read or write error count.
You can change the Receive timeout value to accommodate slow responses to or
from MicroNet devices. The default value is 2000 ms, which is sufficiently long to
enable successful reads/writes to or from most devices. However, you can also
shorten the Receive timout if, for example, you are confident that your devices have
a consistently rapid response rate and you want to speed up a network.
You can select from a Receive timeout range of 500 ms to 10,000 ms, or you can
enter your own value.
For more information, see section 105.24 “Error Count” on page 4615.
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105.23

Online or Offline Monitoring
You can view the online or offline status of a MicroNet interface, subnet, or device
by viewing its icon in the System Tree pane or by selecting its basic tab.
An overlay icon indicates if the MicroNet interface, subnet, or device is offline.
You cannot change the online or offline status, and the only displayed value (other
than Online or Offline) is Invalid. Invalid means that the interface, subnet, or device
has never been configured.
The following rules apply regarding the online or offline status of MicroNet
interfaces, subnets and devices:
• If a MicroNet device is offline, all MicroNet points in the device are also offline.
• If a MicroNet subnet is offline, all MicroNet devices in the subnet are also
offline.
• If a MicroNet interface is offline, all MicroNet subnets in the interface are also
offline.
• If a MicroNet point is offline, the offline indication is present in all parent objects
up to and including the interface.
• If all devices in a subnet are offline, the subnet is also offline.
• If all subnets in a MicroNet interface are offline, the interface is also offline.

Technical
4616

04-16006-04-en, March 2015

105 MicroNet Networks
105.24 Error Count

105.24

Error Count
The error count occurs if the Building Operation server fails to read from or write to
an object or a point, and increments at each failure. You can use this function to
assist in troubleshooting communications failures.
You can reset the error count by selecting zero. For example, you think you have
cleared a communications failure, but you now want to reset the count to zero to
see if the fault is still present.
For more information, see section 105.22 “Receive Timeout” on page 4613.
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105.25

Poll Interval
The poll interval is the amount of time between polls when the selected device is
polled to determine if it is online.
The default interval is 10 seconds, but you can select how often you want polling to
occur for the selected device during communication attempts. You can also inhibit
the poll interval, in which case online or offline detection will only occur when a
specific request is made of the device.
You can view the requested and actual poll intervals. For more information, see
section 108.9 “Standard Object Properties – Advanced Tab” on page 4725.
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106.1

MicroNet Devices
MicroNet devices are a family of stand-alone or networked devices that provide
direct control in a building's HVAC control system. All of the MicroNet devices that
are supported by Building Operation are fully programmable, using a set of control
objects in device memory. Before you can use a device in a network, you program
the control objects using VisiSat and then download the VisiSat program into the
device.
In Building Operation, MicroNet device is the family name for the following devices:
• Standard MicroNet devices: MN300, MN440, MN500, MN620, MN LCD, MN
Touch Screen, and MicroNet Manager Interface.
• MN 50 Series: MN350, MN450, MN550, MN650, MN LCD, MN Touch Screen,
and MicroNet Manager Interface.
• SNP and Intelligent Advanced Controller devices: MMC3601, MMC4601,
IAC400, IAC420, IAC600, IAC Touch Screen, and Modem Interface Unit.
• Unifact: URC2201, URC1201.
• Unifact Pro: URC-40N-100, URC-41N-10x, URC-50N-100, and URC-51N10x.
All these devices are supported in Building Operation. For more information, see the
MicroNet System Overview and the MicroNet datasheets.

04-16006-04-en, March 2015

Technical
4621

106 MicroNet Devices
106.2 Configuring a MicroNet Device

106.2

Configuring a MicroNet Device
You configure a MicroNet device to change the poll interval and to reset any read or
write failure indicators. You can also ensure that the node address matches the
node address of a MicroNet device on the external network.
For more information, see section 104.4 “MicroNet Representation in Building
Operation” on page 4569.

To configure a MicroNet device
1. In WorkStation, in the System Tree pane, select the device you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Status

Displays the online or offline status of the
device.

Output write failure

Displays Failure when the writing of one
or more output values has failed on the
MicroNet network. Select OK to reset
after a successful write to all devices.

Input read failure

Displays Failure when the reading of one
or more input values has failed on the
MicroNet network. Select OK to reset
after a successful read from all devices.

Node

Displays the node number (the address)
of the device in the subnet.

Device ID

Displays the type of MicroNet device
selected.

Poll interval

Select how often you want polling to
occur for the selected device during
communication attempts.

5. Click OK.
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107.1

MicroNet Objects
Imported MicroNet objects are either standard or special objects contained within
MicroNet devices.
Building Operation reads and writes values and properties for MicroNet objects.
You can read the values and properties of imported MicroNet objects, but you can
only change the values and properties of objects where supported in VisiSat.
Building Operation supports the following value and property types:
• Text
• Numeric
• Enumerated
• Time and Date
Where values or properties are writeable, Building Operation validates the input
value and rejects any invalid or inappropriate settings.

107.1.1

Standard Objects
MicroNet standard objects are those which have points that you can create
individually when you create a points list in VisiSat for export to Building Operation.
For more information, see section 107.4 “Standard Objects” on page 4627.

107.1.2

Special Objects
MicroNet special objects are those objects that can export multiple points
simultaneously to the VisiSat points list due to the complexity of the object. It is
normal to export multiple points in this way.
For more information, see section 107.5 “Special Objects” on page 4629.

107.1.3

Object Enumerations
You can view the current value of any selected MicroNet point in the Value property
on the Basic properties tab. Usually the value property is a numeric value, time
value, or a string, and you can enter values that you think are appropriate. The icon
displayed for each point type indicates what type of value the point has. The Value
property of some points, however, offers a selection of different named values
called “enumerations”. For example, the units of the Stopwatch object has the
enumerations Seconds, Minutes, Hours, and Days.
For more information, see section 107.32 “Object Enumerations” on page 4684.

107.1.4

MicroNet Alarms, Schedules, Trend Logs
The alarms, schedules, and trend logs properties of MicroNet points are configured
in VisiSat and therefore any further user control is limited once the objects are
imported into Building Operation.
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For more information, see section 107.40 “MicroNet Alarms, Schedules, Trend
Logs” on page 4706.

107.1.5

Data Types
Building Operation displays each MicroNet point value as one of three data types:
• Analog data
• Digital data
• Not Active
For more information, see section 107.37 “Data Types” on page 4703.

107.1.6

MicroNet Point Data Storage
VisiSat stores each MicroNet point in a numbered table in a device, and table
numbers are unique to their devices. Points can be stored in any table, there is no
particular data storage structure.
For more information, see section 107.41 “MicroNet Point Data Storage” on page
4708.
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107.2

Configuring a MicroNet Point
You configure a MicroNet point to change its Value property.
For more information, see section 104.1 “MicroNet Overview” on page 4561.

To configure a MicroNet point
1. In WorkStation, in the System Tree pane, select the point you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Value

Enter a numeric or time value, or select an
enumeration. In some circumstances you
cannot change the value. For more
information, see section 107.32 “Object
Enumerations” on page 4684.

5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click OK.
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107.3

Viewing VisiSat Properties of a Point or
Object
You view the VisiSat properties of a point or object to understand the storage of the
point or object in its MicroNet device.
For more information, see section 108.10 “Standard Object Properties – VisiSat
Tab” on page 4727.

To view VisiSat properties of a point or object
1. In WorkStation, in the System Tree pane, select the point or object you want
to view.
2. On the File menu, click Properties.
3. Click the VisiSat tab.
4. View the VisiSat properties:
Property

Description

Native type

Displays the native format of the data for
the object or point.

Table number

Displays the number of the table (where
the data is stored) in the device. Table
numbers are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top
of the table where the first byte of the
data is stored.

Non-volatile

Displays whether the value of the object
or point is stored in permanent memory
(True if permanent).

Maximum value

Displays the maximum possible value of
the object or point.

Minimum value

Displays the minimum possible value of
the object or point.

5. Click OK.
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107.4

Standard Objects
MicroNet standard objects are those which have points that you can create
individually when you create a points list in VisiSat for export to Building Operation.
For more information, see section 107.1 “MicroNet Objects” on page 4623.
Building Operation supports the following standard objects:
• Alarm
• Alarm - x50
• Analog Monitor
• Analog Output
• Analog Reference
• Average
• Binary Decoder
• Clock (IAC & MN)
• Comparator
• Counter
• Delay
• Differentiator
• Digital Input
• Digital Monitor
• Digital Output
• Digital Switch
• Digital Reference
• Event Log
• Float Monitor
• Float Reference
• Hysteresis
• Lighting
• Limiter
• Logging
• Logic Block
• NVRx
• NVTx
• Priority Input Select
• Priority Value Select
• Programmable Logic Gate
• Pulse Input
• Pulse Pair
• PWM (Pulse Width Modulator)
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• Rate Limiter
• Rotation
• Scaler
• S-Link (MN300 & MN50)
• Step Driver
• Stopwatch
• Threshold
• Universal Input
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107.5

Special Objects
MicroNet special objects are those objects that can export multiple points
simultaneously to the VisiSat points list due to the complexity of the object. It is
normal to export multiple points in this way.
Building Operation supports special objects as described in the following
paragraphs.
For more information, see section 107.1 “MicroNet Objects” on page 4623.

107.5.1

Lookup Tables
A Look Up Table object converts a changing analog value at the input to a different
analog value at the output. Building Operation supports MicroNet Lookup tables
and MMC Lookup tables.
For more information, see section 107.6 “Lookup Tables” on page 4631.

107.5.2

Holiday Schedules
Building Operation supports two different types of MicroNet holiday schedule;
Holiday Schedule for MicroNet devices, and IAC Holiday Schedule for IAC and SNP
devices.
For more information, see section 107.10 “Holiday Schedules” on page 4639.

107.5.3

Time Schedules
You can import three types of MicroNet time schedule into Building Operation;
MicroNet Time Schedules, IAC Time Schedules, and Optimiser Time Schedules.
For more information, see section 107.13 “Time Schedules” on page 4644.

107.5.4

Optimiser
The Optimiser provides both ‘optimum start/stop’ and ‘boost’ control based on the
sensed temperature, impending scheduled action, and target setpoint.
For more information, see section 107.17 “Optimiser” on page 4648.

107.5.5

Control Loops
Building Operation supports two control loops:
• A single stage control loop used in NCP and ARCNET networks (PID Control)
• A two-stage control loop used in SNP networks (Two-Stage PID Control)
Both control loop types provide proportional (P), proportional plus integral (PI), or
proportional plus integral plus derivative (PID) control.
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For more information, see section 107.25 “Control Loops” on page 4662.
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107.6

Lookup Tables
A Look Up Table object converts a changing analog value at the input to a different
analog value at the output. Building Operation supports MicroNet Lookup tables
and MMC Lookup tables.

107.6.1

MicroNet Lookup Tables
You can configure each input and output property of the lookup table. This permits
non-linear scaling of any analog value to a set of units, for instance, pressure. If you
do not want to configure all eleven inputs and outputs, you must select a Not Active
(---) after the last required pair. Selecting a Not Active in a pair terminates the look
up and the lookup table excludes the Not Active pair and all subsequent pairs. You
must configure a minimum of two inputs and two outputs. For more information,
see section 107.37 “Data Types” on page 4703.

107.6.2

MMC Lookup Tables
An MMC lookup table operates like a MicroNet lookup table. However, in an MMC
device, the lookup tables are used for compensator curves and output reset. For
more information, see the VisiSat 1.2 Engineering Guide.
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107.7

Configuring a Lookup Table
You configure a lookup table to map input values to output value.

To configure a lookup table
1. In WorkStation, in the System Tree pane, select the lookup table that you
want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties. For more information, see the General and
References Properties topic on WebHelp.
5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click the Inputs tab.
Continued on next page
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8. Edit the inputs properties:
Property

Description

Input 1

Enter the pair 1 input analog value.

Input 2

Enter the pair 2 input analog value.

Input 3

Enter the pair 3 input analog value.

Input 4

Enter the pair 4 input analog value.

Input 5

Enter the pair 5 input analog value.

Input 6

Enter the pair 6 input analog value.

Input 7

Enter the pair 7 input analog value.

Input 8

Enter the pair 8 input analog value.

Input 9

Enter the pair 9 input analog value.

Input 10

Enter the pair 10 input analog value.

Input 11

Enter the pair 11 input analog value.

9. Click the Outputs tab.
10. Edit the outputs properties:
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Property

Description

Output 1

Enter the pair 1 output analog value.

Output 2

Enter the pair 2 output analog value.

Output 3

Enter the pair 3 output analog value.

Output 4

Enter the pair 4 output analog value.

Output 5

Enter the pair 5 output analog value.

Output 6

Enter the pair 6 output analog value.

Output 7

Enter the pair 7 output analog value.

Output 8

Enter the pair 8 output analog value.

Output 9

Enter the pair 9 output analog value.

Output 10

Enter the pair 10 output analog value.

Output 11

Enter the pair 11 output analog value.
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11. Click OK.
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107.8

Configuring an MMC Compensator
Curve
You configure an MMC compensator curve to map input values to output value.

To configure an MMC compensator curve
1. In WorkStation, in the System Tree pane, select the compensator curve that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties. For more information, see the General and
References Properties topic on WebHelp.
5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click the X tab.
8. Edit the X properties:
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Property

Description

1

Enter the X1 temperature value.

2

Enter the X2 temperature value.

3

Enter the X3 temperature value.
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9. Click the Y tab.
10. Edit the Y properties:
Property

Description

1

Enter the Y1 temperature value.

2

Enter the Y2 temperature value.

3

Enter the Y3 temperature value.

11. Click OK.
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107.9

Configuring an MMC Output Reset
Lookup Table
You configure an MMC output reset lookup table to map input values to output
value.

To configure an MMC output reset Lookup table
1. In WorkStation, in the System Tree pane, select the MMC output reset
lookup table that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties. For more information, see the General and
References Properties topic on WebHelp.
5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click the X tab.
Continued on next page
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8. Edit the X properties:
Property

Description

1

Enter the X1 percentage value.

2

Enter the X2 percentage value.

3

Enter the X3 percentage value.

4

Enter the X4 percentage value.

5

Enter the X5 percentage value.

6

Enter the X6 percentage value.

9. Click the Y tab.
10. Edit the Y properties:
Property

Description

1

Enter the Y1 percentage value.

2

Enter the Y2 percentage value.

3

Enter the Y3 percentage value.

4

Enter the Y4 percentage value.

5

Enter the Y5 percentage value.

6

Enter the Y6 percentage value.

11. Click OK.
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107.10

Holiday Schedules
Building Operation supports two different types of MicroNet holiday schedule;
Holiday Schedule for MicroNet devices, and IAC Holiday Schedule for IAC and SNP
devices.
The two types of holiday schedule are similar, but the methods of creating
exceptions are different.
Both holiday schedule types enable you to create an exception by specifying a start
date and an end date for each holiday period. During a holiday period, the digital
output is on. A holiday schedule runs only while enabled.
For both types of holiday schedule, you can configure only one exception, either for
a single day, or a range of contiguous dates.
For a (MicroNet) Holiday Schedule, you configure the exception using the Calendar
Editor. For more information, see the Calendar Editor Overview topic on WebHelp.
For an IAC Holiday Schedule, you specify the start day in a specific week, and the
end day in a specific week.
For more information, see section 108.29 “Holiday Schedule Properties – Basic
Tab” on page 4752.
You can disable the Holiday Schedule object using the Enable schedule property.
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107.11

Configuring a Holiday Schedule
You configure an exception for a holiday schedule by specifying a date or date
range.
For more information, see section 107.10 “Holiday Schedules” on page 4639.

To configure a Holiday Schedule
1. In WorkStation, in the System Tree pane, select the holiday schedule that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Holiday period active

Displays the holiday period state (Yes if
holiday period active).

Enable schedule

Select Yes if you want to enable the
holiday schedule. For more information,
see section 107.36 “Special Object
Enumerations” on page 4699.

5. Click the Advanced tab.
6. Edit the advanced properties:
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.
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7. Click OK.
8. Add either a date calendar event or a date range calendar event.
For more information, see the Adding a Date Calendar Event topic on
WebHelp.
For more information, see the Adding a Date Range Calendar Event topic on
WebHelp.

Note
• For MicroNet schedules, you can add only one exception (either
one date calendar event, or one date range calendar event.
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107.12

Configuring an IAC Holiday Schedule
You configure an exception for a holiday schedule by specifying a date or date
range.
For more information, see section 107.10 “Holiday Schedules” on page 4639.

To configure an IAC Holiday Schedule
1. In WorkStation, in the System Tree pane, select the holiday schedule that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Enable schedule

Select Yes if you want to enable the
holiday schedule. For more information,
see section 107.36 “Special Object
Enumerations” on page 4699.

Start week number

Enter the week number in which you want
the holiday period to begin.

Start day

Select the day of the week when you
want the holiday period to begin.

End week number

Enter the week number (1 to 53) in which
you want the holiday period to end.

End day

Select the day of the week when you
want the holiday period to end.

Holiday period active

Displays the holiday period state (Yes if
holiday period active).
For more information, see the Special
Object Enumerations topic on WebHelp.

5. Click the Advanced tab.
Continued on next page
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6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click OK.
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107.13

Time Schedules
You can import three types of MicroNet time schedule into Building Operation;
MicroNet Time Schedules, IAC Time Schedules, and Optimiser Time Schedules.
A time schedule is used to control digital loads or enable setpoints based on timeof-day and day-of-week operation. A time schedule must reference real time in
order to function (by way of the Clock object).

107.13.1

MicroNet and IAC Time Schedules
Building Operation supports time schedule objects for MicroNet and IAC devices.
The two time schedule objects are slightly different. Both time schedules are 7-day
schedules with two programmable on periods, but the MicroNet time schedule has
additional outputs to control an optimiser. However, you should not use a MicroNet
time schedule for optimiser control in Building Operation, instead use the dedicated
optimiser time schedule.
For more information, see section 107.16 “MicroNet and IAC Time Schedules” on
page 4647.

107.13.2

Optimiser Time Schedule
The Optimiser uses its own seven-day, two-event-per-day time schedule to
establish occupancy times.
For more information, see section 107.23 “Optimiser Time Schedule” on page
4660.
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107.14

Configuring a Time Schedule
You configure a time schedule to ensure that the schedule performs as required by
the project.
For more information, see section 107.13 “Time Schedules” on page 4644.

To configure a time schedule
1. In WorkStation, in the System Tree pane, select the time schedule that you
want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. View the basic properties (read only):
Property

Description

Value

Displays the time schedule status.
For more information, see section 107.36
“Special Object Enumerations” on page
4699.

5. Click the Advanced tab.
6. Edit the advanced properties (as relevant):
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click OK.
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107.15

Adding an Event to a MicroNet Time
Schedule
You add an event to a MicroNet time schedule to set when the event is to regularly
occur. This procedure also applies to an optimiser time schedule.
For more information, see section 107.16 “MicroNet and IAC Time Schedules” on
page 4647.

To add an event to a MicroNet time schedule
1. In WorkStation, in the System Tree pane, select the time schedule or
optimiser time schedule that you want to configure.
2. Click the Schedule Editor tab.
3. On the Basic Schedule Editor toolbar, click the New Schedule Event
button

.

4. Select the day of the week on which you want the event to occur.
5. Select All Day if the event is to be on or off all day.
6. In the End Time column, type an end time for the event.
7. In the Start Time column, type a start time for the event.

Note
• You can only have one (on-off) entry per day for an optimiser
time schedule, and two (on-off) entries per day for MicroNet and
IAC time schedules.
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107.16

MicroNet and IAC Time Schedules
Building Operation supports time schedule objects for MicroNet and IAC devices.
The two time schedule objects are slightly different. Both time schedules are 7-day
schedules with two programmable on periods, but the MicroNet time schedule has
additional outputs to control an optimiser. However, you should not use a MicroNet
time schedule for optimiser control in Building Operation, instead use the dedicated
optimiser time schedule.
The Time Schedule object consists of seven schedules, one for each day of the
week. Each day has four separate switching nodes, of which only one node is on at
any given time.
For MicroNet devices only, four additional outputs define the four programmed
switching times of the switching nodes.
The next day's switching times are output when the current day’s fourth time switch
is off.
The Time Schedule object only runs when enabled. Typically, the Time Schedule
object connects to an output node of the clock module.
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107.17

Optimiser
The Optimiser provides both ‘optimum start/stop’ and ‘boost’ control based on the
sensed temperature, impending scheduled action, and target setpoint.
Optimum start means that the object determines the optimum time to switch on the
HVAC equipment so that the setpoint is achieved by the start of the occupancy
period. Optimum stop means the object determines the optimum time to switch Off
the HVAC equipment before the end of the occupancy period without sacrificing
comfort. Boost control is a digital override that is On only during an ‘advance start’
(typically before normal occupancy) for use in a ‘morning warmup’ scenario.
The Optimiser uses its own seven-day, two-event-per-day time schedule to
establish occupancy times. You can configure the Optimiser for either heating or
cooling action and for the disabling of optimum stop control.
Inputs to the Optimiser enable the use of an adjustable setpoint and the influence of
the outside air temperature, plus the ability to disable a self-learning action and
detect the presence (or loss) of a clock. If the controlled area does not reach the
occupancy setpoint temperature, self-learning automatically adjusts optimum start
configuration properties over several days. In this way the characteristics of the
building are ‘learned’ to gain greater accuracy. Other configuration properties
include two preheat levels and selection of a linear or logarithmic algorithm.
Three outputs provide digital on or off control of start or stop loads (Plant), digital
(Boost) control of a normally modulated actuator. An analog output that indicates
time remaining before occupancy ends after an issued optimum stop (Early
Rundown).

107.17.1

Optimiser Parameter Block
The Optimiser Parameter Block contains all the properties necessary for you to
configure and to monitor the status of the Optimiser.
For more information, see section 107.18 “Optimiser Parameter Block” on page
4649.

107.17.2

Optimiser Histogram
Each day, the Optimiser tracks the setpoint achievement time, and logs the
occurrence into one of the 25 possible ten-minute periods that span from two hours
early to two hours late. The ongoing collection of these occurrences forms a
histogram that you can review using the Histogram Data tab in the object
properties.
For more information, see section 107.20 “Optimiser Histogram” on page 4654.

107.17.3

Optimiser Time Schedule
The Optimiser uses its own seven-day, two-event-per-day time schedule to
establish occupancy times.
For more information, see section 107.23 “Optimiser Time Schedule” on page
4660.
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107.18

Optimiser Parameter Block
The Optimiser Parameter Block contains all the properties necessary for you to
configure and to monitor the status of the Optimiser.

107.18.1

Configuration
When configuring optimiser parameters, you can:
• Configure two preheat levels, Advanced and Design.
• Select either heating or cooling action.
• Control the amount of self-learning (0 to 100%, typically 10%). If the controlled
area does not reach the occupancy setpoint temperature, self-learning
automatically adjusts Optimum On configuration properties over several days,
so that the characteristics of the building are ‘learned’ to gain greater accuracy.
• Disable self-learning.
• Adjust the occupancy setpoint or use the influence of the outside air
temperature instead.
• Select either a linear or logarithmic optimiser algorithm.
• Disable the Optimum Off control.
• Set the Optimum Off run down time and adjust the Optimum Off setpoint.
In the Parameters tab, you can click a point and change the value, or you can
rename the point. To display the Properties dialog for a point, you double-click the
point, or you can select the point and then click the Edit button. In addition, you can
add new points to the set of parameters (and remove them).
For more information, see section 108.42 “Optimiser Parameter Block Properties –
Parameters Tab” on page 4771.

107.18.2

Status
When configuring the Optimiser, you can monitor the Status properties. However,
you cannot change any of the property values (although you can rename each
property).
For more information, see section 108.39 “Optimiser Parameter Block Properties –
Basic Tab” on page 4767.
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107.19

Configuring the Optimiser Parameter
Block
You configure Optimiser parameters to modify the behavior of the optimiser.
For more information, see section 107.17 “Optimiser” on page 4648.

To configure the optimiser parameter block
1. In WorkStation, in the System Tree pane, select the optimiser that you want
to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
Continued on next page
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4. Edit the basic properties (you can only modify the description, not the value):
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Property

Description

Actual Setpoint

Displays the current temperature setpoint
in use by the Optimiser.

Early Optimum Off

Displays the value at the Early
Rundown output.

Learning Enabled

Displays the Optimiser learning status.

Main Sensor

Displays the current temperature value at
the Main Sensor input.

Next Change Due Day

Displays the day of the next calculated
change of state, which occurs at the time
indicated by Next Change Due Time
property value, otherwise displays
Waiting (no change due within one day).

Next Change Due Time

Displays the time of the next calculated
change of state, occurring on the day
indicated by the Next Change Due Day
property value.

Optimiser Running

Displays if the Optimiser is running at the
Clock Present input.

Optimiser Status

Displays the current internal state of the
Optimiser. For more information, see
section 107.36 “Special Object
Enumerations” on page 4699.

Optimiser Time

Displays the current time as seen by the
Optimiser.

Optimum Off Influence

Displays the amount of time (in minutes)
to subtract from the calculated Optimum
off time, supplied to the Optimiser
through the Rundown Influence input
(Optimum off time is earlier).

Optimum On Influence

Displays the amount of time combined
with the calculated Optimum on time,
supplied to the Optimiser through the
Influence input. This value subtracts
from the Optimum on time ( Optimum
on time is earlier).

Remote Setpoint

Displays the current temperature setpoint
value at the Remote Set Value input (if
used).

Schedule Mode

Displays the current schedule portion in
which the Optimiser is running. For more
information, see section 107.36 “Special
Object Enumerations” on page 4699.
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5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click the Parameters tab.
Continued on next page
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8. Edit the parameters properties:
Property

Description

Advanced Preheat

Enter the number of minutes per °C
(difference between the setpoint and
sensed input) that you want to switch the
plant output on earlier than the
occupancy start time, following a day of
no occupancy. If you have enabled
Learning, this value may adjust
automatically.

Design Preheat

Enter the number of minutes per °C
(difference between the setpoint and
sensed input) that you want to switch the
plant output on earlier than the
occupancy start time.

Learning

Select the self learning feature. For more
information, see section 107.17
“Optimiser” on page 4648.

Learning Ratio

Enter the percentage of adjustment
permitted to the current Design
Preheat/Advanced Preheat values by
the self learning routine.

Occupancy Setpoint

Enter the occupancy setpoint you want to
use when the Remote Set Value input
is disconnected or Not Active.

Optimiser Algorithm

Select the algorithm type for use in
optimization.

Optimiser Direction

Select the type of optimiser. If you select
Cooling, the time when the main sensor
value falls to the setpoint (Remote
Setpoint) determines the occupancy
time.

Optimum Off

Select whether the Optimum Off
rundown feature is enabled (independent
of the optimum on routine).

Optimum Off Rundown Time

Enter the rundown time (used in the
optimiser algorithm) for an Optimum Off
function. If you enable learning, this value
adjusts automatically.

Optimum Off Setpoint

Enter the Optimum Off rundown
temperature setpoint used in the
algorithm to calculate the Optimum Off
time.

Edit

Click to display the properties of a
selected parameter.

9. Click OK.
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107.20

Optimiser Histogram
Each day, the Optimiser tracks the setpoint achievement time, and logs the
occurrence into one of the 25 possible ten-minute periods that span from two hours
early to two hours late. The ongoing collection of these occurrences forms a
histogram that you can review using the Histogram Data tab in the object
properties.
Generally, if the histogram shape balances towards the right (that is, achieving
setpoint too late), this is acceptable if the occupants are not complaining, as energy
is being saved. If the histogram balances towards the left (that is, achieving
temperature too early), then you can take action to correct this. For example, either
manually adjust the Design Preheat time or increase the Learning Ratio.
You can clear all the data in contained in an optimiser histogram by using the Clear
Histogram command on the histogram context menu.
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107.21

Configuring an Optimiser Histogram
You configure the Optimiser Histogram to ensure that the histogram performs as
required by the project. You cannot configure early and late properties (read only).
For more information, see section 107.20 “Optimiser Histogram” on page 4654.

To configure an optimiser histogram
1. In WorkStation, in the System Tree pane, select the optimiser histogram that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the General and References properties:
Component

Description

Name

Displays the name of the object.

Description

Type a description that explains what the
object is used for.

Type

Displays the object type that defines the
properties of the object.

Foreign address

Displays the address to a non-Building
Operation device, for example a BACnet
device.

Modified

Displays the date and time when the
object was last modified.

Note 1

Type text that you display in a graphic or
use when searching for the object.

Note 2

Type text that you display in a graphic or
use when searching for the object.

Validation

Select the validation status of the object
to keep track of which objects have
passed or failed the validation.

5. Click the Advanced tab.
Continued on next page

04-16006-04-en, March 2015

Technical
4657

107 MicroNet Objects
107.21 Configuring an Optimiser Histogram

6. Edit the advanced properties:
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.
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7. Click the Early tab and observe the early properties:
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Property

Description

>= 120 mins early

Displays (for the time increment shown)
the number of logged occurrences where
the setpoint was achieved earlier than
scheduled.

110 mins early

As above

100 mins early

As above

90 mins early

As above

80 mins early

As above

70 mins early

As above

60 mins early

As above

50 mins early

As above

40 mins early

As above

30 mins early

As above

20 mins early

As above

10 mins early

As above

On Time

Displays the number of logged
occurrences where the setpoint was
achieved as scheduled (within a 20
minute span, neither greater than 10
minutes early nor 10 minutes late).
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8. Click the Late tab and observe the late properties:
Property

Description

10 mins late

Displays (for the time increment shown)
the number of logged occurrences where
the setpoint was achieved later than
scheduled.

20 mins late

As above

30 mins late

As above

40 mins late

As above

50 mins late

As above

60 mins late

As above

70 mins late

As above

80 mins late

As above

90 mins late

As above

100 mins late

As above

110 mins late

As above

>= 120 mins late

As above

9. Click OK.
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107.22

Clearing an Optimiser Histogram
You clear an optimiser histogram to enable the start of a new optimiser histogram.
For more information, see section 107.20 “Optimiser Histogram” on page 4654.

To clear an optimiser histogram
1. In WorkStation, in the System Tree pane, right-click the optimiser histogram
that you want to clear, and then click Clear Histogram.
2. On the File menu, click Properties.
3. Click the Early and Late tabs to ensure that the histogram is clear.
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107.23

Optimiser Time Schedule
The Optimiser uses its own seven-day, two-event-per-day time schedule to
establish occupancy times.

Caution
When programming your VisiSat scheme for export to Building Operation, you
should not use an external time schedule to control an optimiser (even though it is
possible to do so in VisiSat). Instead, you should only use the Optimiser Time
Schedule.
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107.24

Configuring an Optimiser Time
Schedule
You configure the Optimiser Time Schedule to ensure that the schedule performs
as required by the project.
For more information, see section 107.23 “Optimiser Time Schedule” on page
4660.

To configure an optimiser time schedule
1. In WorkStation, in the System Tree pane, select the optimiser time schedule
that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. View the basic properties (read only):
Property

Description

Value

Displays the time schedule status.
For more information, see section 107.36
“Special Object Enumerations” on page
4699.

5. Click the Advanced tab.
6. Edit the advanced properties (as relevant):
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click OK.
You can now add an event to the optimiser time schedule.
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107.25

Control Loops
Building Operation supports two control loops:
• A single stage control loop used in NCP and ARCNET networks (PID Control)
• A two-stage control loop used in SNP networks (Two-Stage PID Control)
Both control loop types provide proportional (P), proportional plus integral (PI), or
proportional plus integral plus derivative (PID) control.

107.25.1

PID Control
The PID Control loop provides single loop control based on a sensed input and a
control setpoint. You can configure loop action as either direct (cooling) or reverse
(heating). The loop algorithm produces a control output as an analog value from 0
to 100%, plus a digital output On whenever any output is produced.
For more information, see section 107.26 “PID Control” on page 4663.

107.25.2

Two-Stage PID Control
Two-Stage PID Control provides two-stage proportional (P), proportional plus
integral (PI), or proportional plus integral plus derivative (PID) control, and is used in
MicroNet SNP networks only. The values you set in the object properties determine
the type of control.
For more information, see section 107.30 “Two-Stage PID Control” on page 4676.
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107.26

PID Control
The PID Control loop provides single loop control based on a sensed input and a
control setpoint. You can configure loop action as either direct (cooling) or reverse
(heating). The loop algorithm produces a control output as an analog value from 0
to 100%, plus a digital output On whenever any output is produced.
The setpoint input connects to an output that represents a user adjustable setpoint,
for example, a Universal Input object/Scaler object combination that reads a
potentiometer and produces a setpoint value. If connected, the value at the setpoint
input overrides the configured setpoint property.
You can use the PID Control loop singly or in combination with other PID Control
loops. You can disable Integral and/or derivative action by setting the Integral Action
Time and/or Derivative Action Time to zero (0).
For example, an air handler application may use three coordinated PID Control
loops for modulation of a heating coil, mixing damper, and cooling coil, with all
loops referencing the same discharge air temperature but having different setpoints.
When cascaded in this manner, only one loop can be active at a time. Control
passes between the loops to ensure a smooth transition from one loop to the next.
Each PID Control loop includes properties that permit an override of the output to a
programmable level. Three status properties report the current loop input
(controlled process), setpoint, and output.
The output slew rate functions as a rate-limiter for any change, and is
recommended whenever multiple control loops connect together to prevent
simultaneous opening of opposing valves or dampers.
You can initiate a special auto-tuning sequence. However, this is not necessary in
most applications.

107.26.1

Control Loop Algorithm
The algorithm used by the PID Control loop is as follows:
• u(t) = Proportional (t) + Integral (t) + Derivative (t)
• Proportional (t) = e (t) / PB
• Integral (t) = Integral (t-1) + Proportional (t) x Ts/Ti
• Derivative (t) = Td/ (Ts x PB) x [e (t) - e (t-1)]
where:
• e = error
• PB = Proportional Band - the amount of input (process) change required for a 0
to 100% change in output.
• Ts = Sample time (not configurable, set by cycle time).
• Ti = Integral Action Time - the time taken for the integral contribution to the
control output to equal that of the proportional contribution. Defines the loop
integral gain.
• Td = Derivative Action Time - used in rate control (dampening) to prevent
overshoot and is useful on fast acting systems with high gains or fast control
response.
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The (0 to 100%) control output of the control loop’s algorithm is typically connected
to the input of either an analog output object, or a pulse pair or pulse width
modulation object for actuator (valve or damper) control.

107.26.2

Control Loop Override
You can override a PID Control loop to a constant (programmable) output level. The
override allows direct control of the loop output, and is the only way the output of
the control loop can fall below the value specified in the Minimum Output Level
property.

Note
• An On at the Control Disable input does not cause the output to drop below
the configured Minimum Output Level.
The Minimum Output Level is typically used to establish a minimum position for
outside air intake.
The override starts when you set Output Override to Yes and ends when you set it
to No (the default).

107.26.3

PID Control Loop Configuration
In the Parameters tab, you can click a point and change the value, or you can
rename the point. To display the Properties dialog for a point, you double-click the
point, or you can select the point and then click the Edit button. In addition, you can
add new points to the set of parameters (and remove them).
For more information, see section 107.27 “PID Control Loop Configuration” on
page 4665.
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107.27

PID Control Loop Configuration
In the Parameters tab, you can click a point and change the value, or you can
rename the point. To display the Properties dialog for a point, you double-click the
point, or you can select the point and then click the Edit button. In addition, you can
add new points to the set of parameters (and remove them).
When configuring a PID Control loop, you select either heating or cooling and then
manually set up the method of control. If required, you can initiate an automatic set
up (auto-tune).

107.27.1

Loop Action
You can set the control loop action as either reverse (heating) or direct (cooling), by
way of the Stage Type property.
• Reverse acting (the default) means that the object’s output decreases (towards
0%) as the input to the control loop increases.
• Direct acting means that the object’s output increases (towards 100%) as the
input to the control loop object increases.

107.27.2

Proportional (P) Control
For proportional control only, you should set both Integral Action Time and
Derivative Action Time to 0.
Proportional control always has some offset from the setpoint because the
correction (loop output) is always directly proportional to the magnitude of the
setpoint error. The loop stabilizes with a setpoint offset equal to the loss or gain of
the ‘disturbance’ on the process. The most critical configuration property is
Proportional Band, which corresponds to the loop’s throttling range (throttling
range is the change in process variable resulting from a full scale change of the
output). Proportional Band is expressed in the engineering units of the process
variable (for example, degrees if using a temperature loop).Loop output change is
linear and inversely proportional to the size of the Proportional Band. This means
that the change in loop output is greater when the Proportional Band is smaller, and
less when the Proportional Band is larger. Narrowing the Proportional Band may
reduce the offset from setpoint, but typically causes constant oscillation above and
below the setpoint. The default Proportional Band is 40.

107.27.3

Proportional plus Integral (PI) Control
PI control eliminates the setpoint offset by reacting not only to the magnitude of the
error (the proportional part), but also to the integral of the error. In other words, PI
control reacts to the magnitude of the error multiplied by the amount of time that the
error exists, as follows:
• By responding to the presence of error in the control loop.
• By relating the magnitude of the control to that of the error.
• By responding to the error over time to achieve zero error at the setpoint.
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The two property settings Proportional Band and Integral Action Time determine PI
control. Integral Action Time is the time taken (in seconds) for the integral
contribution to the control output to equal that of the proportional contribution.
The Derivative Action Time property is not used in PI control and you should set it to
0 (the default).
For example, a control loop has a proportional band of 10 and an integral action
time of 30 seconds. If a sudden load disturbance results in a setpoint error (offset)
of 2, the output due to proportional action is 20%. Integral action increments the
loop output over the 30 seconds time span such that the sum of the increments is
eventually 20%. As the thereby moving the controlled process closer to setpoint. As
the process approaches the setpoint, the offset decreases and so the rate of
increments decreases.
When using PI control, you must carefully choose the Integral Action Time and
Proportional Band values to minimize overshoot, often present in modulating
control loops. Overshoot refers to a control loop’s tendency to overcompensate for
an error condition, causing a new error in the opposite direction. In some instances,
control loop overshoot can repeat itself in an oscillating fashion.

107.27.4

Proportional plus Integral plus Derivative (PID)
Control
The PID control method is useful with fast-acting systems where it is necessary to
have high gains for the proportional and integral terms in the loop. High gain means
a fast control response, but may result in substantial overshoot or undershoot. To
counter this, derivative action determines the rate of response and the polarity of
the control error. If the error is reducing quickly, then the derivative action attempts
to slow down the rate of response, thereby preventing overshoot.
In the PID Control loop, derivative time is available in the Derivative Action Time
property, expressed in seconds. Because the derivative action is working on a ‘rate
of change’ it is a sampled property. The frequency of sampling (and therefore the
length of time a particular derivative level is maintained) is dependent on the
Derivative Resolution property, which represents a rate change in (process control)
units per second x 10.
For example, for a temperature loop, a value of 20 represents a rate change of 2
degrees per second. The derivative action is recalculated only when the absolute
rate of change of error exceeds the configured Derivative Resolution. In this way,
Derivative Resolution acts as a ‘noise filter’, preventing unnecessary derivative
action. You should normally leave Derivative Resolution at 0.6 (the default).

107.27.5

Auto-tuning
You can command a control loop to perform an auto-tune sequence that results in
the output toggling in a two-position or relay fashion for a period of time to measure
system oscillation. Based on this ‘closed-loop’ response and the setting of autotune properties, the tuning algorithm makes automatic adjustments to the
configuration properties for Proportional Band, Integral Action Time, and Derivative
Action Time (if you set the PI/PID property to 1).
You initiate auto-tuning by way of a context menu option (available when you select
the PID Control loop).
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Auto-tune works only if the system is in a steady-state condition (near setpoint with
minimal output changes) before you initiate auto-tune. Typically, you can achieve
this using the ‘loose’ loop setup. Alternatively, you can override the loop to a fixed
value and initiate auto-tune after a steady-state condition. However, in this case, the
adjusted properties may not be as useful because the loop may be tuned to an
atypical operation point.
You need only configure four auto-tune properties before initiating a basic auto-tune
of the loop:
• Loop Type
• PI/PID
• Relay Amplitude
• Tight Tuning
The following table describes the user properties of the Auto-tune facility:
Table: Auto-tune Properties
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Property

Setting

Bias Threshold

This threshold is compared against an
internally computed Bias Level, recalculated
after each output On/Off oscillation, and then
internally divided by 10. When the Bias Level
is below the Bias Threshold value for four
consecutive oscillation periods, the autotune routine ends, and new loop property
values are automatically computed. An
advanced user option.

Loop Type

Based on this setting, the control loop sets
the appropriate Relay Hysteresis, Bias Level,
Relay Amplitude and Tuning Timeout
properties.

PI/PID

For more information, see section 107.32
“Object Enumerations” on page 4684.

Relay Amplitude

The output alternates in an On/Off fashion at
this amplitude. For example, if the Relay
Amplitude is 20% and the base level of the
output was 30% when an auto-tune was
initiated, the output oscillates between 10%
and 50%.

Relay Hysteresis

The output toggles from On to Off and from
Off to On when outside of this deadband to
produce a relay-type oscillation. Expressed
in terms of the controlled process, e.g.
temperature, etc. Advanced option.

Tight Tuning

In most cases, ‘loose’ tuning provides
adequate control and more stable tuning
over the complete control range (0 to 100%).
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Continued
Property

Setting

Tuning Timeout

Defines the maximum time, in seconds, an
Auto-tune can remain active after initiation. If
within this time period the relay output
oscillation has not repeated four consecutive
cycles inside the Bias Threshold, the Autotune sequence terminates without changing
any configuration properties. An advanced
user option.

For more information, see section 107.29 “Auto-tuning a PID Control Loop” on
page 4673.
New configuration properties for Proportional Band, Integral Action Time, and
Derivative Action Time (for loop type 2) are automatically written when the auto-tune
sequence concludes.
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107.28

Configuring a PID Control Loop
You configure a PID Control loop to set how the loop behaves when controlling the
subject hardware.
For more information, see section 107.25 “Control Loops” on page 4662.

To configure a PID Control Loop
1. In WorkStation, in the System Tree pane, select the PID Control loop you
want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Bias Level

Displays the internally computed autotune output bias that is compared against
the configured Bias Threshold during
an auto-tune routine. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.

Calculated Setpoint

Displays the current loop setpoint value.

Control Input

Displays the current loop input level value.

Control Output

Displays the current loop output level
value.

Edit

Click to display the properties of a
selected parameter.

5. Click the Advanced tab.
Continued on next page
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6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point
in the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved
by the current subscription.

7. Click the Parameters tab.
Continued on next page
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8. Edit the configuration properties:
Property

Description

Derivative Action Time

Enter the loop derivative time in seconds.
A value of 0 (default) disables the
derivative time. For more information, see
section 107.26 “PID Control” on page
4663.

Derivative Resolution

Enter the Derivative Resolution . For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Integral Action Time

Enter the integral action time in seconds.
A value of 0 disables integral action. For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Minimum Output Level

Enter the minimum output level (from 0 to
100%) during any non-override control.
For more information, see section 107.26
“PID Control” on page 4663.

Output Override

Select Yes to override the control loop.
For more information, see section 107.26
“PID Control” on page 4663.

Output Slew Rate

Enter a value to match the number of
seconds the output-controlled actuator or
device (valve or damper) needs to travel
full stroke. For more information, see
section 107.25 “Control Loops” on page
4662.

Override Level

Enter the output level percentage you
want to maintain during an override. For
more information, see section 107.26
“PID Control” on page 4663.

Proportional Band

Enter the loop proportional band. For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Setpoint

Enter the setpoint you want to use for the
control algorithm (to which the input
(process) is compared). For more
information, see section 107.26 “PID
Control” on page 4663.

Stage Type

Select the type of loop action. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.

Bias Threshold

Enter an output bias threshold. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.
Continued on next page
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Continued
Property

Description

Loop Type

Select the loop type controlled by the PID
Control loop. For more information, see
section 107.32 “Object Enumerations” on
page 4684.
For more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

PI/PID

Select as appropriate to the loop type
selected. For more information, see
section 107.32 “Object Enumerations” on
page 4684.
For more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Relay Amplitude

Enter the amount of output swing you
want to use during the auto-tune. For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Relay Hysteresis

Enter the process deadband you want to
apply above (and below) the base level
(process starting point) during the autotune routine. For more information, see
section 107.27 “PID Control Loop
Configuration” on page 4665.

Tight Tuning

Select Yes to apply tight tuning during
the auto-tune process. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.

Edit

Click to display the properties of a
selected parameter.

9. Click OK.
You can now auto-tune the PID Control loop.
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107.29

Auto-tuning a PID Control Loop
You auto-tune a PID Control loop to automatically set the key configuration
properties of the loop.
For more information, see section 107.27 “PID Control Loop Configuration” on
page 4665.

To Auto-tune a PID Control loop
1. In WorkStation, in the System Tree pane, select the PID control loop you
want to auto-tune.
2. On the File menu, click Properties.
3. Click the Parameters tab.
Continued on next page
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4. Edit the Auto-tune properties:
Property

Description

Derivative Action Time

Enter the loop derivative time in seconds.
A value of 0 (default) disables the
derivative time. For more information, see
section 107.26 “PID Control” on page
4663.

Derivative Resolution

Enter the Derivative Resolution . For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Integral Action Time

Enter the integral action time in seconds.
A value of 0 disables integral action. For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Minimum Output Level

Enter the minimum output level (from 0 to
100%) during any non-override control.
For more information, see section 107.26
“PID Control” on page 4663.

Output Override

Select Yes to override the control loop.
For more information, see section 107.26
“PID Control” on page 4663.

Output Slew Rate

Enter a value to match the number of
seconds the output-controlled actuator or
device (valve or damper) needs to travel
full stroke. For more information, see
section 107.25 “Control Loops” on page
4662.

Override Level

Enter the output level percentage you
want to maintain during an override. For
more information, see section 107.26
“PID Control” on page 4663.

Proportional Band

Enter the loop proportional band. For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Setpoint

Enter the setpoint you want to use for the
control algorithm (to which the input
(process) is compared). For more
information, see section 107.26 “PID
Control” on page 4663.

Stage Type

Select the type of loop action. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.

Bias Threshold

Enter an output bias threshold. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.
Continued on next page
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Continued
Property

Description

Loop Type

Select the loop type controlled by the PID
Control loop. For more information, see
section 107.32 “Object Enumerations” on
page 4684.
For more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

PI/PID

Select as appropriate to the loop type
selected. For more information, see
section 107.32 “Object Enumerations” on
page 4684.
For more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Relay Amplitude

Enter the amount of output swing you
want to use during the auto-tune. For
more information, see section 107.27
“PID Control Loop Configuration” on page
4665.

Relay Hysteresis

Enter the process deadband you want to
apply above (and below) the base level
(process starting point) during the autotune routine. For more information, see
section 107.27 “PID Control Loop
Configuration” on page 4665.

Tight Tuning

Select Yes to apply tight tuning during
the auto-tune process. For more
information, see section 107.27 “PID
Control Loop Configuration” on page
4665.

Edit

Click to display the properties of a
selected parameter.

Note
• For a minimal auto-tune, you only need to configure Loop Type,
PI/PID, Relay Amplitude, and Tight Tuning. All other properties
are for advanced use only.
5. Right-click the PID control loop you want to auto-tune and select Tune Now.
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107.30

Two-Stage PID Control
Two-Stage PID Control provides two-stage proportional (P), proportional plus
integral (PI), or proportional plus integral plus derivative (PID) control, and is used in
MicroNet SNP networks only. The values you set in the object properties determine
the type of control.
Both control stages have independent programmable deadzones (Occupied,
Relaxed, and Night). The size of each deadzone is dependent on the current control
module. By default, Occupied periods have the smallest deadzones, then Relaxed,
and then Night.
The required setpoint is provided by a fixed resistor for standalone applications, or
you can use an adjustable sensor for a variable remote setpoint.
You can limit the setpoint using the setpoint minimum and maximum properties.
This is useful for limiting the range of an adjustable sensor to a few degrees. Twostage PID control provides separate Stage 1 and Stage 2 value outputs, as well as
three state outputs which indicate the currently active stage (Deadzone, Stage 1 or
Stage 2).
The loop provides the facility to 'shift' or 'reset' the setpoint by means of the +/reset input. The setpoint is calculated by the formula:
• Setpoint = programmed set value (or value from adjustable sensor) + (input
voltage * Reset Ratio), where the Reset Ratio is one tenth of one unit per volt
input. A negative Reset Ratio may be programmed if required.
Normally, the PID control loop output is determined by the state of the control
module override inputs (typically driven by a Time Schedule module).
If Two-Stage PID Control is in use, the ramp speed must be longer than the actual
stroke time of the actuators, otherwise, both valves may be open at the same time.
This is particularly important when using pulsed pairs. If you set the ramp speeds to
zero, the outputs move instantaneously to the required value.

107.30.1

Control Loop Algorithm
The control algorithm used is of the form:
• u(t) = Proportional (t) + Integral (t) + Derivative (t) + Boost (t)
• Proportional (t) = e(t)/Pb
• Integral (t) = Integral (t-1) + Proportional (t) * Ts/Ti
• Derivative (t) = Td/(Ts*Pb) * (e(t) - e(t-1))
• Boost (t) = 0% or 100% (if required)
Where:
• e = Error
• Pb = proportional band
• Ts = Sample Time
• Ti = Integral Time
• Td = Derivative Time
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107.30.2

Deadzones
When using integral action, it is vital to understand that the control outputs are not
necessarily zero when operating in the deadzones (although both stages are never
active simultaneously). When control moves into the deadzone, the currently active
stage maintains its current integral action level. This ensures that the device does
not continuously dip in and out of the deadzone, and effectively control at the
deadzone boundary as a result. However, while in the deadzone, there is no
change in the control action, so the level of control is effectively zero.
If the control leaves the deadzone in the same direction from which it entered, the
integral action level is merely topped up, rather than regenerated from scratch. If the
control leaves the deadzone in the opposite direction to entry, the first action is to
reduce the existing integral action level before bringing in the required stage. This
can often result in the regaining of the deadzone state, thus save unnecessary
modulation of the other output.
If the control module changes (that is, the deadzone width changes), the integral
level reduces to zero. For example, control is in the deadzone in a control module
with a narrow deadzone, which then changes to a wider deadzone. The control
point then settles towards the edge of the deadzone instead of staying at the same
point as the point of entry.
When selecting the integral action method, consider the following information:
• Mode A provides integral control, taking into account the current deadzone
widths.
• Mode B controls to the calculated setpoint, providing the choice of economy
(Mode A) or comfort (Mode B) control.
• Mode B may be more suitable where deadzones are wide.

107.30.3

Boost
When using an occupied time schedule, you can effect control in either the Stage 1
or Stage 2 direction using the Boost In Occ Period 1 and Boost In Occ Period 2
properties. This provides 100% control action to the Stage 1 or Stage 2 control
outputs as appropriate. With integral dumping turned off, boost terminates when
the set value is reached, at which point ordinary control resumes. With integral
dumping turned on, boost terminates when the deadzone is reached. The default is
for boost not to be applied.
The Ovr to Boost input can override the device into boost at any time, and keep it in
boost until the setpoint is reached, after which normal control resumes. Before
subsequent boost overrides can be applied, the boost state must be removed. If
the boost state is removed before boost termination, boost is cancelled and the
control action reverts to its normal level.
If a control loop is overridden to the boost condition and the schedule mode
changes, the boost condition continues until termination is reached.

107.30.4

Single-Stage Control
If you require a single control stage only, it is advisable to set the unused stage
parameters as follows:
• Proportional band = 10000
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• Integral Action Time = 0 (off)
• Derivative action time = 0 (off)
• Ramp Time = 0

107.30.5

Control State Indication
The control module provides three state outputs which indicate the current mode of
control. The outputs represent Stage 1, Stage 2, and deadzone but must be viewed
in combination. When a control module is not in use (that is, no control input) the
state outputs are undefined.
Table: Control State Indication
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Stage 1

Deadzone

Stage 2

Active Stage

Notes

On

Off

Off

Stage 1

Control below
Stage 1
deadzone.

On

On

Off

Stage 1

Control above
Stage 1
deadzone or
boosting while in
deadzone
(integral
dumping off
only).

Off

On

Off

Deadzone

Device at
setpoint (integral
dumping off), or
in deadzone
(integral
dumping on).
This output also
comes on
momentarily as
the device
changes active
stage from
Stage 1 to Stage
2.

Off

On

On

Stage 2

Control below
Stage 2
deadzone or
boosting while in
deadzone
(integral
dumping off
only).

Off

Off

On

Stage 2

Control above
Stage 2
deadzone.
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107.31

Configuring a Two-Stage PID Control
Loop
You configure a Two-Stage PID Control loop to set how the loop behaves when
controlling the subject hardware.
For more information, see section 107.25 “Control Loops” on page 4662.

To configure a Two-Stage PID Control loop
1. In WorkStation, in the System Tree pane, select the PID Control loop that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
Continued on next page
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4. Edit the basic properties:
Property

Description

Boost

Displays On if the loop is in a boost
condition.

Control Direction

Displays the control direction: 0 =
deadzone, 1 = heating, 2 = cooling.

Current Control Map

Displays the current control map: 0 =
deadzone, 2 = Stage 1, 3 = Stage 1
deadzone, 4 = Stage 2 deadzone, 5 =
Stage 2.

Current Input

Displays the current value at the sensor
input.

Current Setpoint

Displays the current setpoint value.

Derivative Level

Displays the derivative control output
level.

Integral Level

Displays the integral control output level.

Lower Deadzone

Displays the lower deadzone value.

Proportional Level

Displays the proportional control output
level.

Required Stage

Displays the stage of the control map
targeted, where: 0 = deadzone, 1 =
heating, 2 = cooling.

Reset Setting

Displays the reset value. For more
information, see section 107.30 “TwoStage PID Control” on page 4676.

RPW Setting

Displays the current setting at the
adjustable sensor input.

Schedule Mode

Displays the current control mode, as
determined by the override inputs.
The order of priority of the modes is
Night, Relaxed, Occupied (starting
with the highest priority).

Stage 1 Level

Displays the current value at the Stage 1
heating output.

Stage 2 Level

Displays the current value at the Stage 2
cooling output.

Target Control Map

Displays the target control map: 0 =
deadzone, 2 = Stage 1, 3 = Stage 1
deadzone, 4 = Stage 2 deadzone, 5 =
Stage 2.

Total Control Level

Displays the combined PID control level.
Continued on next page
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Continued
Property

Description

Upper Deadzone

Displays the upper deadzone value.

5. Click the Advanced tab.
6. Edit the advanced properties:
Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the
value of the point. For more information,
see section 105.24 “Error Count” on page
4615.

7. Click the VisiSat tab.
8. Edit the VisiSat properties:
Property

Description

Native type

Displays the native format of the data for
the object or point.

Table number

Displays the number of the table (where
the data is stored) in the device. Table
numbers are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top
of the table where the first byte of the
data is stored.

9. Click the Parameters tab.
Continued on next page
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10. Edit the parameters:
Property

Description

Boost in Occ. Period 1

Select Yes to boost in Occupancy Period
1.

Boost in Occ. Period 2

Select Yes to boost in Occupancy Period
2.

Boost Stage

Select 2 to boost in the Stage 2 direction.

IA Dumping

Select On to use integral dumping. Not
recommended.

IA Method

Select the integral action method. For
more information, see section 107.30
“Two-Stage PID Control” on page 4676.

Override

Select No Override or one of four
override modes. For more information,
see section 107.36 “Special Object
Enumerations” on page 4699.

Reset Ratio

Enter the Reset ratio if required. Used
with the +/- Reset input to 'shift' or 'reset'
the setpoint. For more information, see
section 107.30 “Two-Stage PID Control”
on page 4676.

Sample Time

Enter the sample time. If you set the
sample time to 0, the control algorithm
samples as quickly as the software
scheduler allows (typically 100ms). For
more information, see section 107.30
“Two-Stage PID Control” on page 4676.

Setpoint

Enter the required setpoint. The
adjustable sensor input (RPW, if used)
has priority.

Setpoint max.

Enter the maximum value of the setpoint.

Setpoint min.

Enter the minimum value of the setpoint.

Stage 1/2 DA Time

Enter the derivative action time.

Stage 1/2 Deadzone Night

Enter the Night deadzone. For more
information, see section 107.30 “TwoStage PID Control” on page 4676.

Stage 1/2 Deadzone Occupied

Enter the Occupied deadzone.

Stage 1/2 Deadzone Relaxed

Enter the Relaxed deadzone.

Stage 1/2 IA Time

Enter the integral action time. You can
turn off the integral action by setting the
integral action time to zero.

Stage 1/2 Proportional Band

Enter the proportional band.
Continued on next page
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Continued
Property

Description

Stage 1/2 Ramp Time

Enter the ramp time. For more
information, see section 107.30 “TwoStage PID Control” on page 4676.

Edit

Click to display the properties of a
selected parameter.

11. Click OK.
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107.32

Object Enumerations
You can view the current value of any selected MicroNet point in the Value property
on the Basic properties tab. Usually the value property is a numeric value, time
value, or a string, and you can enter values that you think are appropriate. The icon
displayed for each point type indicates what type of value the point has. The Value
property of some points, however, offers a selection of different named values
called “enumerations”. For example, the units of the Stopwatch object has the
enumerations Seconds, Minutes, Hours, and Days.
The enumerations displayed upon import of a MicroNet network are the ones you
select in VisiSat before you export a points list. In most points where an
enumeration exists, you can select a different enumeration if so required, but some
point values are ‘greyed out’, preventing you from changing the enumeration. In
these cases, it is also impossible to change the enumeration in VisiSat.
The enumerations tables list the points which use enumerations, the objects with
which they associate, and the enumerations used within each point.

107.32.1

MicroNet Enumerations
MicroNet enumerations are the enumerations that display in the Values property of
MicroNet points. Some enumerations are read-only.
For more information, see section 107.33 “MicroNet Enumerations” on page 4685.

107.32.2

IAC Enumerations
IAC enumerations are the enumerations that display in the Values property of
points within SNP and IAC devices. Some enumerations are read-only.
For more information, see section 107.34 “IAC Enumerations” on page 4692.

107.32.3

Unifact Pro Enumerations
Unifact Pro enumerations are the enumerations that display in the Values property
of Unifact Pro points. Some enumerations are read-only.
For more information, see section 107.35 “Unifact Pro Enumerations” on page
4697.

107.32.4

Special Object Enumerations
Special object enumerations are the enumerations that display within points in
special objects. Not all special objects have points that contain enumerations within
the Values property in the Basic tab. Some enumerations are read-only.
For more information, see section 107.36 “Special Object Enumerations” on page
4699.
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107.33

MicroNet Enumerations
MicroNet enumerations are the enumerations that display in the Values property of
MicroNet points. Some enumerations are read-only.
The MicroNet devices referred to are the standard MicroNet devices and the MN 50
Series devices.
For more information, see section 106.1 “MicroNet Devices” on page 4619.

Note
• Some points can be present in some MicroNet devices but not others.
Table: Alarm x50
Point
Alarm Acknowledge (Alarms 1, 2 & 3)

Enumeration
• Off
• On

Alarm Type

• Digital
• Analog

Automatic Acknowledgement (Alarms 1, 2 &
3)

• No

Enable (Alarms 1, 2 & 3)

• Off

• Yes

• On
Invert Alarm Output (Alarms 1, 2 & 3)

• No
• Yes

Trigger Type (Alarms 1, 2 & 3)

• Low
• High

Table: Analog Ouput
Point
Override Enabled

Enumeration
• No
• Yes
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Point

Enumeration

Table: Clock
Point
Re-Synch Day

Enumeration
• Every day
• Monday
• Tuesday
• Wednesday
• Thursday
• Friday
• Saturday
• Sunday

Summer Adjust Month

• January
• February
• March
• April
• May
• June
• July
• August
• September
• October
• November
• December

Winter Adjust Month

• January
• February
• March
• April
• May
• June
• July
• August
• September
• October
• November
• December
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Point

Enumeration

Table: Counter
Point
Both Edges

Enumeration
• No
• Yes

Table: Delay
Point

Enumeration

Edge

• Falling
• Rising

Re-Trigger

• No
• Yes

Type

• Hold off
• Hold on

Table: Differentiator
Point
Input x

Enumeration
• No Polarity
• Low-High
• High-Low

Table: Digital Output
Point
Override State

Enumeration
• Auto
• On
• Off

Rising/Falling/Both

• Rising
• Falling
• Rise and Fall
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Point

Enumeration

Table: Digital Switch
Point
Default State

Enumeration
• Off
• On
• Not Active

Switch Type

• 1:1
• 2:1
• 1:2

Table: Lighting
Point
Override

Enumeration
• Auto
• On
• Off

Table: Logging
Point
Enabled

Enumeration
• Disabled
• Enabled

Log Full

• No
• Yes

Table: MNMI
Point
PL3 PW req’d

Enumeration
• No
• Yes

PL4 PW req’d

• No
• Yes

Time Lost

• No
• Yes
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Point

Enumeration

Table: MN TouchScreen
Point
Alarm Banner

Enumeration
• Disabled
• Enabled

Buzzer

• Disabled
• Enabled

Date Format

• UK
• USA

Time Master

• No
• Yes

Table: S-Link Sensor (MN 50 Series)
Point
Connection Status

Enumeration
• None
• Occupancy Timer

Display Override Timer

• None
• Occupancy Timer
• Emergency Heat Timer

Emergency Heat Status

• Off
• On

Fan Display Current Mode

• None
• Fan Off
• Fan Off
• Speed 1
• Speed 2
• Speed 3
• Fan Auto

Fan Icons

• None
• Auto/On
• Auto/Three Speed
• Off/Three Speed
• Auto/Off/Three Speed
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Continued
Point
Mode Display Current Mode

Enumeration
• None
• Mode Off
• Mode Heat
• Mode Cool
• Mode Auto

Mode Icons

• None
• Auto/Heat/Cool
• Auto/Heat/Cool/Off

Occupancy Override Status

• Off
• On

Show Fan Override

• Off
• On

Slink Monitor n Type

• None
• Heat

Slink SP n Units

• None
• Celsius
• Fahrenheit
• Percent

Units

• Celsius
• Fahrenheit

Table: S-Link Sensor (MN300 Only)
Point

Enumeration

Units

• Celsius
• Fahrenheit

Table: State Reference
Point
State

Enumeration
• Off
• On
• Not Active
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Point

Enumeration

Table: Stopwatch
Point

Enumeration

Units

• Seconds
• Minutes
• Hours
• Days

Table: Universal Input
Point
Analog Units (1 & 2)

Enumeration
• Celsius
• Fahrenheit
• Ohms
• Lux
• Percent

Latch Input

• Not Latched
• On Rising Edge
• On Falling Edge

Toggle

• Off
• On

Units

• Celsius
• Fahrenheit
• Ohms
• Lux
• Percent
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107.34

IAC Enumerations
IAC enumerations are the enumerations that display in the Values property of
points within SNP and IAC devices. Some enumerations are read-only.
For more information, see section 106.1 “MicroNet Devices” on page 4619.

Note
• Some points can be present in some IAC devices but not others.
Table: Alarm
Point
Alarm Status

Enumeration
• No alarm
• Alarm present
• Alarm accepted
• Alarm acknowledged

Table: Analog Ouptut
Point
Override Enabled

Enumeration
• No
• Yes

Table: Clock
Point
In Summer

Enumeration
• No
• Yes

Re-Synch Day

• Every day
• Monday
• Tuesday
• Wednesday
• Thursday
• Friday
• Saturday
• Sunday
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Continued
Point
Summer Adjust Day

Enumeration
• Monday
• Tuesday
• Wednesday
• Thursday
• Friday
• Saturday
• Sunday

Winter Adjust Day

• Monday
• Tuesday
• Wednesday
• Thursday
• Friday
• Saturday
• Sunday

Table: Counter
Point
Both Edges

Enumeration
• No
• Yes

Table: Delay
Point
Delay Edge

Enumeration
• Falling
• Rising

Delay Re-Trigger

• No
• Yes

Delay Type

• Hold off
• Hold on
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Point

Enumeration

Table: Digital Output
Point
Current State

Enumeration
• Off
• On

Override State

• Auto
• On
• Off

Table: Lighting
Point
Override

Enumeration
• Auto
• On
• Off

Table: Logging
Point
Logging

Enumeration
• Disabled
• Disabled

Log Full?

• No
• Yes

Table: Pulsed-pair
Point
Action (Actuator)

Enumeration
• Stopped
• Decrementing
• Incrementing
• Decrement
• Increment
• Stop
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Point

Enumeration

Table: State Reference
Point
State

Enumeration
• Off
• On

Table: Stopwatch
Point
Time Units

Enumeration
• Seconds
• Minutes
• Hours
• Days

Table: TouchScreen
Point
Alarm Banner

Enumeration
• Disabled
• Enabled

Baud rate

• 1200
• 4800

Date Format

• UK
• USA

Sub LAN Baud rate

• 1200
• 4800

Table: Universal Input
Point
Analog Units

Enumeration
• Celcius
• Fahrenheit
• Ohms
• Lux
• Percent

UI Digital Latch Input

• No
• Yes
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Continued
Point
UI Digital State

Enumeration
• Off
• On

Table: Null Controller Outputs
Point
Null Controller outputs

Enumeration
• No
• Yes
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107.35

Unifact Pro Enumerations
Unifact Pro enumerations are the enumerations that display in the Values property
of Unifact Pro points. Some enumerations are read-only.
The Unifact Pro devices referred to are the URC-41N-10x and URC-51N-10x series
devices.
For more information, see section 106.1 “MicroNet Devices” on page 4619.
Table: Unifact Pro Enumerations
Point
Fire Override

Enumeration
• No
• Yes

Fan Speed Option

• On/Off
• 3 Speed

Yes/No

• No
• Yes

Actuator Type

• PWM
• Pulsed-Pair

Control Loop Mode

• Comfort
• Economy
• Night
• Fire Override

Controller Action

• Heating
• Cooling

Heater Config

• Config A
• Config B
• N/A

PWM Cooling Actuator Output

• Incrementing
• Decrementing
• Stop

PWM Heating Actuator Output

• Incrementing
• Decrementing
• Stop

Pulsed Pair Cooling Actuator Output

• Stopped
• Decrementing
• Incrementing
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Continued
Point
Pulsed Pair Heating Actuator Output

Enumeration
• Stopped
• Decrementing
• Incrementing

Temperature Source

• T-Type
• S-Link
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107.36

Special Object Enumerations
Special object enumerations are the enumerations that display within points in
special objects. Not all special objects have points that contain enumerations within
the Values property in the Basic tab. Some enumerations are read-only.
You can employ special objects in MicroNet devices, MN 50 Series devices, and
IAC devices. Some named special objects in one device type are different from the
a special object in another device type (for example Holiday Schedules).
For more information, see section 107.5 “Special Objects” on page 4629.
Table: Holiday Schedule (IAC)
Point
Enable schedule

Enumeration
• No
• Yes

Start week number
Start day

1 to 53
• Monday
• Tuesday
• Wednesday
• Thursday
• Friday
• Saturday
• Sunday

End week number
End day

1 to 53
• Monday
• Tuesday
• Wednesday
• Thursday
• Friday
• Saturday
• Sunday

Holiday period active

• No
• Yes

Table: Holiday Schedules (MN)
Point
Enable schedule

Enumeration
• No
• Yes
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Continued
Point
Holiday period active

Enumeration
• No
• Yes

Table: Optimiser (IAC and MicroNet)
Point
Learning

Enumeration
• Disabled
• Enabled

Learning enabled

• Off
• On

Optimiser algorithm

• Linear
• Logarithmic

Optimiser direction

• Heating
• Cooling

Optimiser running

• No
• Yes

Optimiser status

• Waiting = Waiting for Optimum on in
the current morning. Both digital
outputs Off.
• Boosting = Optimum on, before
occupancy time (or after if the setpoint
has not been achieved.) Both digital
outputs On.
• Terminate boost = Setpoint achieved.
Optimiser Plant Output On only.
• Run down = Plant Output turned off in
the occupancy period to coast to
setpoint at occupancy end. Both digital
outputs off.
If the Optimiser Main Sensor value is
below setpoint (Heating) or above
setpoint (Cooling), the Early Rundown
output remaining occupancy minutes.
• Wait = Waiting for the following day’s
occupancy on time.
• Wait, Boost, Terminate and Run_down
= Same as previous, except during the
preceding night.

Optimum off

• Disabled
• Enabled
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Continued
Point
Schedule mode

Enumeration
• Before Occupancy = morning
• During Occupancy = day
• After Occupancy = night

Table: PID Control (MN)
Point
Override

Enumeration
• No
• Yes

Loop Type

• Boiler (= Boiler with mixing valve relatively fast system with high load
disturbances, PI control (no derivative)).
• HWS (= Domestic hot water system
heat exchanger - fast response
systems, PID control).
• Heating/Cooling Coil (= Heating or
cooling coils, for example- medium and
slow response systems, PI control).

PI/PID

• PI (=Proportional plus Integral)
• PID (=Proportional plus Integral and
Derivative)

Stage Type

• Reverse Acting (=Heating)
• Direct Acting (=Cooling)

Tight Tuning

• No (=Underdamped or Loose)
• Yes (=Tight)

Table: Time Schedule
Point
Time Schedule

Enumeration
• On
• Off

Table: Two-Stage PID Control (IAC)
Point
Boost

Enumeration
• Off
• On
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Continued
Point
Boost in Occ Period 1

Enumeration
• No
• Yes

Boost in Occ Period 2

• No
• Yes

IA Dumping

• Off
• On

IA Method

• Mode A
• Mode B

Override

• No Override
• Occupied 1
• Relaxed
• Occupied 2
• Night

Schedule Mode

• No Override
• Occupied 1
• Relaxed
• Occupied 2
• Night
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107.37

Data Types
Building Operation displays each MicroNet point value as one of three data types:
• Analog data
• Digital data
• Not Active

107.37.1

Analog Data
The full range for any analog data value is from -10,000 (minimum) to 10,000
(maximum).
For more information, see section 107.38 “Analog Data” on page 4704.

107.37.2

Digital Data
Digital values have only two valid states, Off or On, which are represented with
values 0 or 1 respectively. The digital values are the same for digital inputs or
outputs, and digital properties.

107.37.3

Not Active
A Not Active value (---) represents an undefined or null value. In a MicroNet device,
a Not Active value is equal to the value 32767. Building Operation considers any
input to a VisiSat object left unconnected (the default state, with no assigned
pointer to an object output) as Not Active.
For more information, see section 107.39 “Not Active” on page 4705.
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107.38

Analog Data
The full range for any analog data value is from -10,000 (minimum) to 10,000
(maximum).
Building Operation processes all analog inputs and outputs as 32-bit, single
precision, floating-point data values. This translates to six-digit decimal precision
when processing small values. Selected analog inputs and outputs may limit to
smaller data ranges (for example, from 0 to 100 or from 0 to 10,000) depending on
the particular object type.
All analog class configuration and status or command properties are processed as
integer data within the full data range, which is from -10,000 to 10,000. Selected
analog properties limit to smaller ranges, for example, from 0 to 100 or from 0 to
10,000 depending on the particular object type.
Note: Analog properties are read and written as integer values only.
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107.39

Not Active
A Not Active value (---) represents an undefined or null value. In a MicroNet device,
a Not Active value is equal to the value 32767. Building Operation considers any
input to a VisiSat object left unconnected (the default state, with no assigned
pointer to an object output) as Not Active.
The Not Active state is handled differently (by algorithms) in most types of objects.
An object can produce a Not Active output if one or more inputs has a Not Active
state or if some abnormal condition occurs. With some objects, an input with a Not
Active state is evaluated the same as zero (0) value. Other object types have inputs
that ignore Not Active.
Refer to individual object descriptions for details on how Not Active values affect
any particular object, including the circumstances under which the object produces
a Not Active output (or outputs).
Refer to the VisiSat Engineering Guide for further information.
In VisiSat, status (read-only) properties of objects display Not Active (---) under the
following conditions:
• The application is not downloaded to the device.
• VisiSat is offline with the device network.
• VisiSat is online with the network, but the device is offline.
• The VisiSat object(s) have received Not Active as inputs.
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107.40

MicroNet Alarms, Schedules, Trend Logs
The alarms, schedules, and trend logs properties of MicroNet points are configured
in VisiSat and therefore any further user control is limited once the objects are
imported into Building Operation.
For more information, see the VisiSat Engineering Guide.
When integrating a MicroNet network into Buildings Operation, all existing alarms
parameters, schedules, and trend logs are imported within the MicroNet update file.
For more information, see section 104.12 “Update Files” on page 4581.

107.40.1

Alarms for MicroNet Devices
You can set certain alarm parameters for MicroNet points that you import into
Building Operation within the update file. You enable and set these alarm
parameters in the VisiSat Points Gallery (in the Alarms tab of the MicroNet point).
When you import a MicroNet point with alarm parameters enabled into your
MicroNet interface, the MicroNet point has a Building Operation alarm which you
can view, change and acknowledge.
You can set the following alarms parameters for MicroNet points:
• Alarm limits.
• Alarm time delay.
• Alarm messages and priority.
In Building Operation, you can create an alarm on a MicroNet point that you have
not enabled for alarm in VisiSat. However such an alarm could be overwritten if you
import a fresh update file.

107.40.2

Schedules for MicroNet Devices
Building Operation supports MicroNet schedules that are created in VisiSat and
contained in MicroNet devices. The MicroNet schedules are within the update file
that you import to create a MicroNet network in Building Operation. You can view
and change MicroNet schedules in WorkStation in a similar way to how you would
view and change other Building Operation schedules. For more information, see
section 107.13 “Time Schedules” on page 4644. For more information, see section
107.10 “Holiday Schedules” on page 4639.

107.40.3

Trend Logs for MicroNet Devices
You can set certain trend log parameters for MicroNet points that you import into
Building Operation within the update file. You enable and set these trend log
parameters in the VisiSat Points Gallery (in the Trend Logs tab of the MicroNet
point). When you import a MicroNet point with trend log parameters enabled into
your MicroNet interface, the MicroNet point has a Building Operation trend log that
you can chart, and associate with extended trend logs.
You can set the following trend log parameters for MicroNet points:
• Trend log name, type, and interval.
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• Number of logging values.
• Clear when enabled.
In Building Operation, you can create trend logs on MicroNet points that you have
not enabled for trend logging in VisiSat. However all such trend logs could be
overwritten if you import a fresh update file.
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107.41

MicroNet Point Data Storage
VisiSat stores each MicroNet point in a numbered table in a device, and table
numbers are unique to their devices. Points can be stored in any table, there is no
particular data storage structure.
The first byte of any point’s data is stored in a location offset from the top of the
table (offset 0 = top of table).
For example, the following figure shows the basic properties of three MicroNet
points called UART0, UART1, and UART2 (all are points in the MicroNet Manager
Interface device):

Figure: Example of contiguous point data in a table

All three points are stored in Table number 17. Each point occupies two bytes of
data in the table, and in this instance they are stored contiguously:
• UART0 point data is stored at the top of the table (offset 0).
• UART1 point data is stored in the next available table location (offset 2 bytes).
• UART2 point data is stored in the next available table location (offset 4 bytes).
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108.1

MicroNet System Tree Icons
This section describes the icons in WorkStation that relate to MicroNet interfaces.
Table: MicroNet Icons
Icon

Description
MicroNet Interface
Indicates a MicroNet Interface
MicroNet Interface
Indicates a MicroNet Interface (offline)
MicroNet Subnet
Indicates a subnet, headed by a MicroNet
Manager Interface or Touch Screen
MicroNet Subnet
Indicates a subnet, headed by a MicroNet
Manager Interface or Touch Screen (offline)
MicroNet Device
Indicates a MicroNet device on an interface
or subnet
MicroNet Device
Indicates a MicroNet device on an interface
or subnet (offline)
MicroNet Special Object
Indicates a MicroNet Special Object
IAC Holiday Schedule
Indicates an IAC Holiday Schedule
Holiday Schedule or Time Schedule
Indicates a Holiday Schedule or Time
Schedule
MicroNet Analog Point
Indicates a MicroNet Analog Point
MicroNet Integer Point
Indicates a MicroNet Integer Point
MicroNet String Point
Indicates a MicroNet String Point
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108.2

MicroNet Interface Properties – Basic
Tab
Use the Basic tab to view and edit the MicroNet interface communication and
status information properties.

Figure: Basic tab

Table: Basic tab
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Property

Description

Network status

Displays whether the selected interface is
online or offline.

Output write failure

Displays the result of one or more attempts
by Building Operation to write to a device on
the MicroNet network. You can reset to OK
following failure. For more information, see
section 104.5 “MicroNet Interface Creation”
on page 4571.

04-16006-04-en, March 2015

108 MicroNet User Interface
108.2 MicroNet Interface Properties – Basic Tab

Continued
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Property

Description

Input read failure

Displays the result of one or more attempts
by Building Operation to read from a device
on the MicroNet network. You can reset to
OK following failure. For more information,
see section 104.5 “MicroNet Interface
Creation” on page 4571.

IP port

Enter the IP port number for MicroNet
networks. If you are using IP tunneling, use
the default (7001) unless this port number is
already allocated. For more information, see
section 104.10 “IP Tunneling” on page 4578.

Port reference

Enter the path of the serial port to which you
connect the MicroNet network. You will find
the port (if created) in the System/Ports
folder - you may need to create a port. For
more information, see section 104.7
“Creating an RS-232 Port” on page 4574.
For more information, see section 104.6
“Port Allocation and Configuration” on page
4572.

Protocol

Select the MicroNet network protocol.

Baud rate

Select the data transmission rate of the
physical network. Consult the data sheets of
the network devices if necessary.

MNMI present

Select Yes if a MicroNet Manager Interface
heads the network.

Broadcast time interval

Enter how often (in minutes) you want the
Building Operation server to broadcast time
updates to the network.

Broadcast subnet

Select Yes to enable the Building Operation
server to broadcast the subnet address to
the network at regular intervals.

Receive timeout (ms)

Enter the number of milliseconds you want
the Building Operation server to wait for a
response from a device (normally 2000 ms).
For more information, see Section 4.5
“Receive Timeout” on page 123.

Point poll delay (ms)

Enter the delay you require between the end
of one poll request and the start of the next
poll request.
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108.3

MicroNet Interface Properties –
Advanced Tab
Use the Advanced tab to view and edit the MicroNet interface update properties.

Figure: Advanced tab

Table: Advanced tab
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Property

Description

Update file

Enter the path to the XML update file that
contains the MicroNet network structure. For
more information, see section 104.12
“Update Files” on page 4581.

Update number

Displays the number of times you have
imported data to the MicroNet interface. For
more information, see section 104.13 “Data
Import” on page 4583.

Trace file

Enter the path of the trace file. For more
information, see section 104.13 “Data
Import” on page 4583.
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Property

Description

Enable trace

Select True to enable the trace. For more
information, see section 104.13 “Data
Import” on page 4583.
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108.4

Serial Port Properties – Basic Tab
Use the Basic tab to view and edit basic information about the port.

Note
There are two types of serial port: RS-232 and RS-485. Each has the same set of
properties. However, you cannot configure the Network interface name on an RS485 port. This property is fixed as one of two possible names, one for each of only
two ports.

Figure: Basic tab

Table: Basic Tab

Technical
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Component

Description

State

Displays the network status: Online or
Offline, or Unused (Unused means that
the port is not referenced from a network).

Bytes transmitted

Displays the running total of bytes
transmitted through the port.

Bytes received

Displays the running total of bytes received
through the port.
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108.4 Serial Port Properties – Basic Tab

Continued
Component

Description

Parity errors detected

Displays the running total of parity errors
detected.

Framing errors detected

Displays the running total of framing errors
detected.

Other errors detected

Displays the running total of other errors
detected (errors other than parity or framing
errors).

Network interface name

Type the name of the network interface
(read-only for an RS-485 port), which is
usually the name of the COM port that you
connect the network to. Do not use spaces.

Log file name

Type the name of the port log file or leave
this as the default, PortLog.
For the Enterprise Server, the log file is
available in C:\ProgramData\Schneider
Electric StruxureWare\Building Operation
x.x\Enterprise Server\db\portlogs\RS232COM1.
For the Automation Server, the log file is
available in opt\tac\db\portlogs\RS485COMA.
The portlogs folder is only available if a log
has previously been started by way of the
Start log command in the port context
menu.
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108.5

Data Import Dialog Box
Use the Data Import dialog box to monitor the progress of a data import, and to
import data after further VisiSat programming.

Figure: Data import dialog box

Table: Data Import Dialog Box

Technical
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Message or Button

Description

Trace will be sent to:

Displays the path to the location of the trace
file.

Source:

Displays the path to the location of the
update file.

Full URL:

Displays the path to the location of the
update file, plus (if applicable) extra
diagnostic information for Schneider Electric
engineers.

Import

Click to import data following further VisiSat
programming.
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108.6

Subnet Properties – Basic Tab
Use the Basic tab to view and edit the subnet address and status information
properties.

Figure: Basic tab

Table: Basic tab
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Property

Description

Subnet

Displays the address of the subnet. The
subnet address displayed is the address of
the subnet master (for example, a MicroNet
Manager Interface) after a data import.

Network status

Displays the online or offline status of the
network.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
MicroNet network. Select OK to reset after a
successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the MicroNet
network. Select OK to reset after a
successful read from all devices.
Technical
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108.7

MicroNet Device Properties – Basic Tab
Use the Basic tab to view the device status information and edit the configuration
settings.

Figure: Basic tab

Table: Basic tab
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Property

Description

Status

Displays the online or offline status of the
device.

Output write failure

Displays Failure when the writing of one or
more output values has failed on the
MicroNet network. Select OK to reset after a
successful write to all devices.

Input read failure

Displays Failure when the reading of one or
more input values has failed on the MicroNet
network. Select OK to reset after a
successful read from all devices.

Node

Displays the node number (the address) of
the device in the subnet.
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Continued
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Property

Description

Device ID

Displays the type of MicroNet device
selected.

Poll interval

Select how often you want polling to occur
for the selected device during
communication attempts.

Technical
4725

108 MicroNet User Interface
108.8 Standard Object Properties – Basic Tab

108.8

Standard Object Properties – Basic Tab
Use the Basic tab to view and change the value of a standard object or point.

Figure: Basic tab

Table: Basic tab
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Property

Description

Value

Enter a numeric or time value, or select an
enumeration. In some circumstances you
cannot change the value. For more
information, see section 107.32 “Object
Enumerations” on page 4684.
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108.9

Standard Object Properties – Advanced
Tab
Use the Advanced tab to view and set the communications error counts of an
object or a point within any object, and to view subscription data.
Objects generally do not show subscription data.

Figure: Advanced tab

Table: Advanced tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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Continued
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Property

Description

Requested poll interval (ms)

Displays the poll interval requested by the
current subscription, for example, a point in
the Watch pane.

Actual poll interval (ms)

Displays the poll interval actually achieved by
the current subscription.
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108.10

Standard Object Properties – VisiSat
Tab
Use the VisiSat tab to view the configuration settings of a MicroNet Standard
object.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Continued
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Property

Description

Non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).

Maximum value

Displays the maximum possible value of the
object or point.

Minimum value

Displays the minimum possible value of the
object or point.
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108.11

Lookup Table Properties – Basic Tab
Use the Basic tab to view and edit the general and object-reference properties of a
lookup table. For more information, see the General Properties – Basic Tab topic on
WebHelp.

Figure: Basic tab
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108.12

Lookup Table Properties – Advanced
Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.13

Lookup Table Properties – VisiSat Tab
Use the VisiSat tab to view the configuration settings of a Lookup Table.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.

Non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).
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Continued
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Property

Description

Maximum value

Displays the maximum possible value of the
object or point.

Minimum value

Displays the minimum possible value of the
object or point.
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108.14

Lookup Table Properties – Inputs Tab
Use the Inputs tab to view and edit the Lookup table input properties.

Figure: Inputs tab

Table: Inputs tab
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Property

Description

Input 1

Enter the pair 1 input analog value.

Input 2

Enter the pair 2 input analog value.

Input 3

Enter the pair 3 input analog value.

Input 4

Enter the pair 4 input analog value.

Input 5

Enter the pair 5 input analog value.

Input 6

Enter the pair 6 input analog value.

Input 7

Enter the pair 7 input analog value.

Input 8

Enter the pair 8 input analog value.

Input 9

Enter the pair 9 input analog value.
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Continued
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Property

Description

Input 10

Enter the pair 10 input analog value.

Input 11

Enter the pair 11 input analog value.
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108.15

Lookup Table Properties – Outputs Tab
Use the Outputs tab to view and edit the Lookup table output properties.

Figure: Outputs tab

Table: Outputs tab
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Property

Description

Output 1

Enter the pair 1 output analog value.

Output 2

Enter the pair 2 output analog value.

Output 3

Enter the pair 3 output analog value.

Output 4

Enter the pair 4 output analog value.

Output 5

Enter the pair 5 output analog value.

Output 6

Enter the pair 6 output analog value.

Output 7

Enter the pair 7 output analog value.

Output 8

Enter the pair 8 output analog value.

Output 9

Enter the pair 9 output analog value.
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Continued
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Property

Description

Output 10

Enter the pair 10 output analog value.

Output 11

Enter the pair 11 output analog value.
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108.16

MMC Compensator Curve Properties –
Basic Tab
Use the Basic tab to view and edit the general and object-reference properties of
an MMC compensator curve. For more information, see the General Properties –
Basic Tab topic on WebHelp.

Figure: Basic tab
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108.17

MMC Compensator Curve Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.18

MMC Compensator Curve Properties –
VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of an MMC
compensator curve.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Continued
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Property

Description

Non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).

Maximum value

Displays the maximum possible value of the
object or point.

Minimum value

Displays the minimum possible value of the
object or point.
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108.19

MMC Compensator Curve Properties –
X Tab
Use the X tab to view and edit the X properties of an MMC compensator curve.

Figure: X tab

Table: X tab
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Property

Description

1

Enter the X1 temperature value.

2

Enter the X2 temperature value.

3

Enter the X3 temperature value.
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108.20

MMC Compensator Curve Properties – Y
Tab
Use the Y tab to view and edit the Y properties of an MMC compensator curve.

Figure: Y tab

Table: Y tab
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Property

Description

1

Enter the Y1 temperature value.

2

Enter the Y2 temperature value.

3

Enter the Y3 temperature value.
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108.21

MMC Output Reset Lookup Table
Properties – Basic Tab
Use the Basic tab to view and edit the general and object-reference properties of
an MMC output reset lookup table. For more information, see the General
Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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108.22

MMC Output Reset Lookup Table
Properties – Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.23

MMC Output Reset Lookup Table
Properties – VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of an MMC output
reset lookup table.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Property

Description

Non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).

Maximum value

Displays the maximum possible value of the
object or point.

Minimum value

Displays the minimum possible value of the
object or point.
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108.24

MMC Output Reset Lookup Table
Properties – X Tab
Use the X tab to view and edit the X properties of an MMC output reset lookup
table.

Figure: X tab

Table: X Tab
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Property

Description

1

Enter the X1 percentage value.

2

Enter the X2 percentage value.

3

Enter the X3 percentage value.

4

Enter the X4 percentage value.

5

Enter the X5 percentage value.

6

Enter the X6 percentage value.
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108.25

MMC Output Reset Lookup Table
Properties – Y Tab
Use the Y tab to view and edit the Y properties of an MMC output reset lookup
table.

Figure: Y tab

Table: Y Tab
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Property

Description

1

Enter the Y1 percentage value.

2

Enter the Y2 percentage value.

3

Enter the Y3 percentage value.

4

Enter the Y4 percentage value.

5

Enter the Y5 percentage value.

6

Enter the Y6 percentage value.
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108.26

MicroNet Schedule Editor View
Use the MicroNet Schedule Editor view to create or edit one or more time
schedule events.

Note
You can create or edit a maximum of two schedule events per day for a MicroNet
time schedule, but only one schedule event per day for an IAC time schedule or
an Optimiser time schedule.

Figure: MicroNet Schedule Editor view

Table: MicroNet Schedule Editor View
Number

Description
View toolbar
Displays the toolbar to manage schedules.
Event grid
Displays schedule events in graphic view.
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108.27

MicroNet Schedule Editor Toolbar
Use the MicroNet Schedule Editor toolbar to manage MicroNet Schedules.
Table: MicroNet Schedule Editor Toolbar
Button

Description
New schedule event
Click to create a new MicroNet schedule
event.
Edit schedule events
Click to edit a selected event.
Delete
Click to delete events in the schedule.
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108.28

MicroNet Schedule Event Properties
Dialog Box
Use the Schedule Event Properties dialog box in the Schedule Editor to create
an event for any MicroNet time schedule.

Figure: Schedule Event Properties dialog box

Table: Schedule Event Properties Dialog Box
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Property

Description

Days of week

Select the days of the week that apply to this
schedule.

All day

Select All Day for an all day event.

Add Entry

Click to add a line to the Times and values
box.

Delete Entry

Click to delete an entry from the Times and
values box.
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108.29

Holiday Schedule Properties – Basic Tab
Use the Basic tab to view the holiday schedule status information and edit the
configuration settings.

Figure: Basic tab

Table: Basic tab
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Property

Description

Holiday period active

Displays the holiday period state (Yes if
holiday period active).

Enable schedule

Select Yes if you want to enable the holiday
schedule. For more information, see section
107.36 “Special Object Enumerations” on
page 4699.
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108.30

Holiday Schedule Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.31

Holiday Schedule Properties – VisiSat
Tab
Use the VisiSat tab to view the VisiSat configuration settings of a MicroNet Holiday
schedule.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Continued
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Property

Description

Is non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).
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108.32

MicroNet Calendar Editor View
Use the MicroNet Calendar Editor view to set a single calendar event for the
MicroNet holiday schedule.

Figure: MicroNet Calendar Editor view

Table: MicroNet Calendar Editor View
Number

Description
Click to hide or show the date of the single
event included in the calendar. For more
information, see the Calendar Events topic
on WebHelp.
Use the Calendar Editor toolbar to add or
delete the calendar event. For more
information, see the Calendar Editor Toolbar
topic on WebHelp.
Select the year you want the calendar to
display.
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Continued
Number

Description
Click to scroll the calendar one month at the
time.
Displays the calendar for the selected
twelve-month period with the date(s) for the
calendar event shown in blue. For more
information, see the Calendar Editor
Overview topic on WebHelp.
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108.33

Time Schedule Properties – Basic Tab
Use the Basic tab to view the status of the time schedule or optimiser time
schedule.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays the time schedule status.
For more information, see section 107.36
“Special Object Enumerations” on page
4699.
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108.34

Time Schedule Properties – Advanced
Tab
Use the Advanced tab to view and set the communications error counts of the
MicroNet Schedule or Optimiser Time Schedule.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.35

Time Schedule Properties – VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of a MicroNet time
schedule or an Optimiser time schedule.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Continued
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Property

Description

Is non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).

Max. periods/day

Displays the maximum number of on/off
periods that you can configure.

Merge adjacent periods

Displays whether adjacent on/off periods are
merged.
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108.36

IAC Holiday Schedule Properties – Basic
Tab
Use the Basic tab to view and configure the IAC holiday schedule.

Figure: Basic tab

Table: Basic tab
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Property

Description

Enable schedule

Select Yes if you want to enable the holiday
schedule. For more information, see section
107.36 “Special Object Enumerations” on
page 4699.

Start week number

Enter the week number in which you want
the holiday period to begin.

Start day

Select the day of the week when you want
the holiday period to begin.

End week number

Enter the week number (1 to 53) in which
you want the holiday period to end.
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Continued
Property

Description

End day

Select the day of the week when you want
the holiday period to end.

Holiday period active

Displays the holiday period state (Yes if
holiday period active).
For more information, see section 107.36
“Special Object Enumerations” on page
4699.
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108.37

IAC Holiday Schedule Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.38

IAC Holiday Schedule Properties –
VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of an IAC Holiday
schedule.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Continued
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Property

Description

Is non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).
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108.39

Optimiser Parameter Block Properties –
Basic Tab
Use the Basic tab to view the Optimiser Parameter Block non-configurable status
information and to change the name of any status property.

Figure: Basic tab

Table: Basic tab
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Property

Description

Actual Setpoint

Displays the current temperature setpoint in
use by the Optimiser.

Early Optimum Off

Displays the value at the Early Rundown
output.

Learning Enabled

Displays the Optimiser learning status.

Main Sensor

Displays the current temperature value at the
Main Sensor input.
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Property

Description

Next Change Due Day

Displays the day of the next calculated
change of state, which occurs at the time
indicated by Next Change Due Time
property value, otherwise displays Waiting
(no change due within one day).

Next Change Due Time

Displays the time of the next calculated
change of state, occurring on the day
indicated by the Next Change Due Day
property value.

Optimiser Running

Displays if the Optimiser is running at the
Clock Present input.

Optimiser Status

Displays the current internal state of the
Optimiser. For more information, see section
107.36 “Special Object Enumerations” on
page 4699.

Optimiser Time

Displays the current time as seen by the
Optimiser.

Optimum Off Influence

Displays the amount of time (in minutes) to
subtract from the calculated Optimum off
time, supplied to the Optimiser through the
Rundown Influence input (Optimum off
time is earlier).

Optimum On Influence

Displays the amount of time combined with
the calculated Optimum on time, supplied
to the Optimiser through the Influence
input. This value subtracts from the
Optimum on time ( Optimum on time is
earlier).

Remote Setpoint

Displays the current temperature setpoint
value at the Remote Set Value input (if
used).

Schedule Mode

Displays the current schedule portion in
which the Optimiser is running. For more
information, see section 107.36 “Special
Object Enumerations” on page 4699.
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108.40

Optimiser Parameter Block Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.41

Optimiser Parameter Block Properties –
VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of an Optimiser
parameter block.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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108.42

Optimiser Parameter Block Properties –
Parameters Tab
Use the Parameters tab to view and edit the Optimiser configurable properties.

Figure: Parameters tab

Table: Parameters tab
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Property

Description

Advanced Preheat

Enter the number of minutes per °C
(difference between the setpoint and sensed
input) that you want to switch the plant
output on earlier than the occupancy start
time, following a day of no occupancy. If you
have enabled Learning, this value may
adjust automatically.

Design Preheat

Enter the number of minutes per °C
(difference between the setpoint and sensed
input) that you want to switch the plant
output on earlier than the occupancy start
time.

Technical
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Continued

Technical
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Property

Description

Learning

Select the self learning feature. For more
information, see section 107.17 “Optimiser”
on page 4648.

Learning Ratio

Enter the percentage of adjustment
permitted to the current Design
Preheat/Advanced Preheat values by
the self learning routine.

Occupancy Setpoint

Enter the occupancy setpoint you want to
use when the Remote Set Value input is
disconnected or Not Active.

Optimiser Algorithm

Select the algorithm type for use in
optimization.

Optimiser Direction

Select the type of optimiser. If you select
Cooling, the time when the main sensor
value falls to the setpoint (Remote
Setpoint) determines the occupancy time.

Optimum Off

Select whether the Optimum Off rundown
feature is enabled (independent of the
optimum on routine).

Optimum Off Rundown Time

Enter the rundown time (used in the
optimiser algorithm) for an Optimum Off
function. If you enable learning, this value
adjusts automatically.

Optimum Off Setpoint

Enter the Optimum Off rundown
temperature setpoint used in the algorithm
to calculate the Optimum Off time.

Edit

Click to display the properties of a selected
parameter.
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108.43

Optimiser Histogram Properties – Basic
Tab
Use the Basic tab to view and edit the general and object-reference properties of
an optimiser histogram. For more information, see the General Properties – Basic
Tab topic on WebHelp.

Figure: Basic tab

04-16006-04-en, March 2015

Technical
4775

108 MicroNet User Interface
108.44 Optimiser Histogram Properties – Advanced Tab

108.44

Optimiser Histogram Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.45

Optimiser Histogram Properties –
VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of an Optimiser
Histogram.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Technical
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Property

Description

Non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).

Maximum value

Displays the maximum possible value of the
object or point.

Minimum value

Displays the minimum possible value of the
object or point.
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108.46

Optimiser Histogram Properties – Early
Tab
Use the Early tab to view optimiser histogram early settings.

Figure: Early tab

Table: Early Tab
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Property

Description

>= 120 mins early

Displays (for the time increment shown) the
number of logged occurrences where the
setpoint was achieved earlier than
scheduled.

110 mins early

As above

100 mins early

As above

90 mins early

As above

80 mins early

As above

70 mins early

As above
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Property

Description

60 mins early

As above

50 mins early

As above

40 mins early

As above

30 mins early

As above

20 mins early

As above

10 mins early

As above

On Time

Displays the number of logged occurrences
where the setpoint was achieved as
scheduled (within a 20 minute span, neither
greater than 10 minutes early nor 10 minutes
late).
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108.47

Optimiser Histogram Properties – Late
Tab
Use the Late tab to view optimiser histogram late settings.

Figure: Late tab

Table: Late Tab
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Property

Description

10 mins late

Displays (for the time increment shown) the
number of logged occurrences where the
setpoint was achieved later than scheduled.

20 mins late

As above

30 mins late

As above

40 mins late

As above

50 mins late

As above

60 mins late

As above

70 mins late

As above
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Continued
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Property

Description

80 mins late

As above

90 mins late

As above

100 mins late

As above

110 mins late

As above

>= 120 mins late

As above
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108.48

Optimiser Time Schedule Properties –
Basic Tab
Use the Basic tab to view the Optimiser Time Schedule status.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays the time schedule status.
For more information, see section 107.36
“Special Object Enumerations” on page
4699.
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108.49

Optimiser Time Schedule Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.50

Optimiser Time Schedule Properties –
VisiSat Tab
Use the VisiSat tab to view the configuration settings of an Optimiser time
schedule.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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Property

Description

Is non-volatile

Displays whether the value of the object or
point is stored in permanent memory (True if
permanent).

Max. periods/day

Displays the maximum number of on/off
periods that you can configure.

Merge adjacent periods

Displays whether adjacent on/off periods are
merged.
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108.51

PID Control Properties – Basic Tab
Use the Basic tab to view PID control non-configurable status information.

Figure: Basic tab

Table: Basic tab
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Property

Description

Bias Level

Displays the internally computed auto-tune
output bias that is compared against the
configured Bias Threshold during an autotune routine. For more information, see
section 107.27 “PID Control Loop
Configuration” on page 4665.

Calculated Setpoint

Displays the current loop setpoint value.

Control Input

Displays the current loop input level value.

Control Output

Displays the current loop output level value.

Edit

Click to display the properties of a selected
parameter.
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108.52

PID Control Properties – Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.53

PID Control Properties – VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of a PID Control
Object.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.

Technical
4789

108 MicroNet User Interface
108.54 PID Control Properties – Parameters Tab

108.54

PID Control Properties – Parameters
Tab
Use the Parameters tab to view and edit PID Control configurable parameters.

Figure: Parameters tab

Table: Parameters tab
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Property

Description

Derivative Action Time

Enter the loop derivative time in seconds. A
value of 0 (default) disables the derivative
time. For more information, see section
107.26 “PID Control” on page 4663.

Derivative Resolution

Enter the Derivative Resolution . For
more information, see section 107.27 “PID
Control Loop Configuration” on page 4665.
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Continued
Property

Description

Integral Action Time

Enter the integral action time in seconds. A
value of 0 disables integral action. For more
information, see section 107.27 “PID Control
Loop Configuration” on page 4665.

Minimum Output Level

Enter the minimum output level (from 0 to
100%) during any non-override control. For
more information, see section 107.26 “PID
Control” on page 4663.

Output Override

Select Yes to override the control loop. For
more information, see section 107.26 “PID
Control” on page 4663.

Output Slew Rate

Enter a value to match the number of
seconds the output-controlled actuator or
device (valve or damper) needs to travel full
stroke. For more information, see section
107.25 “Control Loops” on page 4662.

Override Level

Enter the output level percentage you want
to maintain during an override. For more
information, see section 107.26 “PID
Control” on page 4663.

Proportional Band

Enter the loop proportional band. For more
information, see section 107.27 “PID Control
Loop Configuration” on page 4665.

Setpoint

Enter the setpoint you want to use for the
control algorithm (to which the input
(process) is compared). For more
information, see section 107.26 “PID
Control” on page 4663.

Stage Type

Select the type of loop action. For more
information, see section 107.27 “PID Control
Loop Configuration” on page 4665.

Bias Threshold

Enter an output bias threshold. For more
information, see section 107.27 “PID Control
Loop Configuration” on page 4665.

Loop Type

Select the loop type controlled by the PID
Control loop. For more information, see
section 107.32 “Object Enumerations” on
page 4684.
For more information, see section 107.27
“PID Control Loop Configuration” on page
4665.
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Continued
Property

Description

PI/PID

Select as appropriate to the loop type
selected. For more information, see section
107.32 “Object Enumerations” on page
4684.
For more information, see section 107.27
“PID Control Loop Configuration” on page
4665.
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Relay Amplitude

Enter the amount of output swing you want
to use during the auto-tune. For more
information, see section 107.27 “PID Control
Loop Configuration” on page 4665.

Relay Hysteresis

Enter the process deadband you want to
apply above (and below) the base level
(process starting point) during the auto-tune
routine. For more information, see section
107.27 “PID Control Loop Configuration” on
page 4665.

Tight Tuning

Select Yes to apply tight tuning during the
auto-tune process. For more information,
see section 107.27 “PID Control Loop
Configuration” on page 4665.

Edit

Click to display the properties of a selected
parameter.

04-16006-04-en, March 2015

108 MicroNet User Interface
108.55 Two-Stage PID Control Properties – Basic Tab

108.55

Two-Stage PID Control Properties –
Basic Tab
Use the Basic tab to view the two-stage PID Control non-configurable properties.

Figure: Basic tab

Table: Basic tab
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Property

Description

Boost

Displays On if the loop is in a boost
condition.

Control Direction

Displays the control direction: 0 = deadzone,
1 = heating, 2 = cooling.

Current Control Map

Displays the current control map: 0 =
deadzone, 2 = Stage 1, 3 = Stage 1
deadzone, 4 = Stage 2 deadzone, 5 = Stage
2.

Current Input

Displays the current value at the sensor
input.

Current Setpoint

Displays the current setpoint value.
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Property

Description

Derivative Level

Displays the derivative control output level.

Integral Level

Displays the integral control output level.

Lower Deadzone

Displays the lower deadzone value.

Proportional Level

Displays the proportional control output
level.

Required Stage

Displays the stage of the control map
targeted, where: 0 = deadzone, 1 = heating,
2 = cooling.

Reset Setting

Displays the reset value. For more
information, see section 107.30 “Two-Stage
PID Control” on page 4676.

RPW Setting

Displays the current setting at the adjustable
sensor input.

Schedule Mode

Displays the current control mode, as
determined by the override inputs.
The order of priority of the modes is Night,
Relaxed, Occupied (starting with the
highest priority).
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Stage 1 Level

Displays the current value at the Stage 1
heating output.

Stage 2 Level

Displays the current value at the Stage 2
cooling output.

Target Control Map

Displays the target control map: 0 =
deadzone, 2 = Stage 1, 3 = Stage 1
deadzone, 4 = Stage 2 deadzone, 5 = Stage
2.

Total Control Level

Displays the combined PID control level.

Upper Deadzone

Displays the upper deadzone value.
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108.56

Two-Stage PID Control Properties –
Advanced Tab
Use the Advanced tab to view and set the communications error counts of the
object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Read error count

Displays the number of times the Building
Operation server has failed to read the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.

Write error count

Displays the number of times the Building
Operation server has failed to write the value
of the point. For more information, see
section 105.24 “Error Count” on page 4615.
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108.57

Two-Stage PID Control Properties –
VisiSat Tab
Use the VisiSat tab to view the VisiSat configuration settings of a Two-Stage PID
Control Object.

Figure: VisiSat tab

Table: VisiSat Tab
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Property

Description

Native type

Displays the native format of the data for the
object or point.

Table number

Displays the number of the table (where the
data is stored) in the device. Table numbers
are device specific.

Data size

Displays the number of bytes the data
occupies in the table.

Offset

Displays the number of bytes from the top of
the table where the first byte of the data is
stored.
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108.58

Two-Stage PID Control Properties –
Parameters Tab
Use the Parameters tab to view and edit two-stage PID control configuration and
stage settings.
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Figure: Parameters Tab

Table: Parameters Tab
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Property

Description

Boost in Occ. Period 1

Select Yes to boost in Occupancy Period 1.
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Property

Description

Boost in Occ. Period 2

Select Yes to boost in Occupancy Period 2.

Boost Stage

Select 2 to boost in the Stage 2 direction.

IA Dumping

Select On to use integral dumping. Not
recommended.

IA Method

Select the integral action method. For more
information, see section 107.30 “Two-Stage
PID Control” on page 4676.

Override

Select No Override or one of four override
modes. For more information, see section
107.36 “Special Object Enumerations” on
page 4699.

Reset Ratio

Enter the Reset ratio if required. Used with
the +/- Reset input to 'shift' or 'reset' the
setpoint. For more information, see section
107.30 “Two-Stage PID Control” on page
4676.

Sample Time

Enter the sample time. If you set the sample
time to 0, the control algorithm samples as
quickly as the software scheduler allows
(typically 100ms). For more information, see
section 107.30 “Two-Stage PID Control” on
page 4676.

Setpoint

Enter the required setpoint. The adjustable
sensor input (RPW, if used) has priority.

Setpoint max.

Enter the maximum value of the setpoint.

Setpoint min.

Enter the minimum value of the setpoint.

Stage 1/2 DA Time

Enter the derivative action time.

Stage 1/2 Deadzone Night

Enter the Night deadzone. For more
information, see section 107.30 “Two-Stage
PID Control” on page 4676.

Stage 1/2 Deadzone Occupied

Enter the Occupied deadzone.

Stage 1/2 Deadzone Relaxed

Enter the Relaxed deadzone.

Stage 1/2 IA Time

Enter the integral action time. You can turn
off the integral action by setting the integral
action time to zero.

Stage 1/2 Proportional Band

Enter the proportional band.

Stage 1/2 Ramp Time

Enter the ramp time. For more information,
see section 107.30 “Two-Stage PID Control”
on page 4676.
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Property

Description

Edit

Click to display the properties of a selected
parameter.
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109 Sigma Introduction
109.1 Sigma Overview

109.1

Sigma Overview
Sigma is a building management system that comprises controller device and
communications components which can be applied to a variety of environmental
and building control services. The system components are seamlessly linked by a
suite of user interface and control software called Satchwell Sigma.
Satchwell Sigma is hereafter referred to as Sigma.
Sigma can monitor and control equipment such as boiler and air handling units,
access control systems, distributed power systems, and manufacturing (or other
process) equipment.
The Sigma software comprises a server (known as the Sigma server) and one or
more clients. A number of different software options exist to enable Sigma to run on
a variety of different hardware platforms, however the Satchwell Sigma Standard
Edition is the only option that is supported for Building Operation.
For more information, refer to the Satchwell Sigma Software Overview data sheet
(DS 13.101).

109.1.1

Sigma Workflow
To integrate a Sigma network into Building Operation, you create a Sigma Interface
in WorkStation and then import data from the Sigma server. The data import
process examines all the Sigma objects in the Sigma server. If you see error, event,
or warning messages during a data import process, you may need to import Sigma
data several times, re-programming in Sigma each time.
For more information, see section 109.2 “Sigma Workflow” on page 4803.

109.1.2

Sigma Interface
A Sigma Interface is the software representation of your external Sigma network in
the System Tree pane. However, the Sigma Interface does not contain your Sigma
network structure prior to a data import, merely a folder structure. After you have
imported Sigma data, the Sigma Interface is where Sigma devices and objects are
established.
For more information, see section 109.10 “Sigma Interface” on page 4817.

109.1.3

Sigma Networks
Sigma network refers to the physical Sigma network that you connect to your
Enterprise Server PC by way of an Ethernet connection, and from which data is
ultimately read when you import Sigma data into your Building Operation Sigma
Interface. A Sigma network typically comprises a backbone LAN comprising Sigma
routers (DNNs), and a number of controller LANs, each headed by a DNN.
For more information, see section 109.15 “Sigma Networks” on page 4827.
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109.1.4

Sigma Devices
Sigma devices are a family of networked devices that provide either direct control or
routing functions in the Sigma building management system. All of the Sigma
controlling devices (commonly termed controllers) that are supported by Building
Operation are fully programmable, using the Sigma software at a Sigma client.
Before you can use a controller in a Sigma network, you program the control
objects using Sigma and then download the object into the controller. Routing
devices (DNNs) play no part in system control but you configure them with address
and other data as part of the Sigma system setup.
For more information, see section 110.1 “Sigma Devices” on page 4833.

109.1.5

Sigma Objects
A Sigma Interface contains various Sigma container objects and imported Sigma
objects. The Sigma objects that you import into Building Operation are the objects
contained within Sigma controlling devices such as a UNC632.
For more information, see section 111.1 “Sigma Objects” on page 4847.
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109.2

Sigma Workflow
To integrate a Sigma network into Building Operation, you create and configure a
Sigma Interface in WorkStation and then import Sigma data from the Sigma server.
You may have to import data several times, re-programming in Sigma each time.
In the System Tree pane, the import process creates a Sigma tree structure under
the Sigma Interface. The Sigma tree structure matches the Sigma project
configuration, and is a graphical representation of the Sigma project. The tree
structure contains the same controllers and objects that are present in the Sigma
server. For more information, see section 109.10 “Sigma Interface” on page 4817.
When integration is complete, you can view and interact with the Sigma system in
WorkStation. For example, you can monitor changing values, set alarms and logs,
and change writable values.
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Figure: Sigma integration into Building Operation

109.2.1

Integration Flowchart
The integration flowchart provides an overview of the process that you might use
when integrating a Sigma network into Building Operation.
For more information, see section 109.3 “Integration Flowchart” on page 4806.
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109.2.2

Sigma Interface Creation
Creating a Sigma Interface enables you to import Sigma data and interact with your
Sigma network in WorkStation. You cannot create more than one Sigma Interface
on an Enterprise Server.
For more information, see section 109.4 “Sigma Interface Creation” on page 4808.

109.2.3

Sigma Data Import
To create a representation of your Sigma network in Building Operation, you import
Sigma data from the Sigma server to a Sigma Interface in WorkStation. When you
have established communications between Building Operation and the physical
Sigma network, you can see Sigma values changing dynamically in the Sigma
Interface. Whenever you execute a Sigma data import, you force the data importer
function to extract data automatically from the Sigma server and populate your
Sigma Interface.
For more information, see section 109.5 “Sigma Data Import” on page 4809.

109.2.4

Sigma Programming
You use Sigma System Manager (at a Sigma client) to make Sigma programming
changes, and then download the changes to the relevant Sigma controllers. When
you have completed Sigma programming, you import your Sigma control changes
to the Sigma Interface in Building Operation.
For more information, see section 109.9 “Sigma Programming” on page 4816.
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109.3

Integration Flowchart
The integration flowchart provides an overview of the process that you might use
when integrating a Sigma network into Building Operation.
A typical Sigma integration process might involve the following steps:
• Add the Enterprise Server to the list of servers in the Sigma System Setup.
• Prepare the Sigma network physically, and configure as required during the
integration.
• Connect the Sigma network to the Enterprise Server. For more information, see
section 109.15 “Sigma Networks” on page 4827.
• Install Building Operation (with the Enterprise Server on a different PC to that of
the Sigma server). For more information, see the Installation Overview topic on
WebHelp.
• Create and configure a Sigma Interface. For more information, see section
109.11 “Creating a Sigma Interface” on page 4819.
• Import Sigma data to Building Operation. For more information, see section
109.7 “Importing Sigma Data into Building Operation” on page 4813.
• Re-program Sigma and re-import as necessary. For more information, see
section 109.9 “Sigma Programming” on page 4816.
The following flowchart summarizes the integration process.
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Figure: Sigma integration flowchart
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109.4

Sigma Interface Creation
Creating a Sigma Interface enables you to import Sigma data and interact with your
Sigma network in WorkStation. You cannot create more than one Sigma Interface
on an Enterprise Server.
For more information, see section 109.11 “Creating a Sigma Interface” on page
4819.
When configuring a Sigma Interface, you must specify basic communications
settings such as the IP address of the Sigma server computer, and then (after initial
data import), the IP address and server number of the Enterprise Server computer.
These basic settings should match the settings that are already set up in the
Networks and Devices settings in your Sigma System Manager.
For more information, see section 109.12 “Configuring a Sigma Interface” on page
4820.
The interface that you create does not initially represent the physical Sigma network
connected to your server. The interface folder structure is essentially empty and
ready for you to import Sigma data. When you implement a Sigma data import, the
Sigma Interface is populated with the same Sigma objects that are contained in the
Sigma server (controllers, objects, graphics, log sets, segments, and text reports).
For more information, see section 109.10 “Sigma Interface” on page 4817.
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109.5

Sigma Data Import
To create a representation of your Sigma network in Building Operation, you import
Sigma data from the Sigma server to a Sigma Interface in WorkStation. When you
have established communications between Building Operation and the physical
Sigma network, you can see Sigma values changing dynamically in the Sigma
Interface. Whenever you execute a Sigma data import, you force the data importer
function to extract data automatically from the Sigma server and populate your
Sigma Interface.
You import Sigma data during initial Sigma integration and after you have finished a
phase of programming in Sigma. You can import Sigma data to any one of three
locations in the Sigma Interface:
• The Sigma Interface (when you want to import Sigma controllers and their
objects only).
• The Graphics folder (when you want to import Sigma graphics only). After the
initial multiple graphics import, you can also reimport graphics one-at-a-time.
When you have finished your graphics data import, it is recommended that you
make further changes using the Building Operation Graphics TGML editor.
• The Log Sets folder (when you want to import Sigma log sets only).

Tip
The first time that you import Sigma data, you must import to the Sigma Interface
before importing to the Graphics folder or Log Sets folder.
During the data import, you are informed of the progress of the data import, and
whether there are any conversion warnings or errors. Building Operation creates a
trace file that contains details of all the events occuring during the data import. You
can use this trace file for information and diagnostic purposes, and you can also
view the location to which the trace file is sent. The trace file is available in basic
(default) and detailed format.
Depending on the type of data import you select, the following three destinations
are possible for the trace file:
• C:\ProgramData\Schneider Electric StruxureWare\Building Operation
1.5\DataImport\Trace.DataImport.Sigma Interface.txt.
• C:\ProgramData\Schneider Electric StruxureWare\Building Operation
1.5\DataImport\Trace.DataImport.Graphics.txt.
• C:\ProgramData\Schneider Electric StruxureWare\Building Operation
1.5\DataImport\Trace.DataImport.Log Sets.txt.
For more information, see section 117.4 “Data Import Dialog Box” on page 4957.

Note
When importing Sigma controller and log set data for the first time, it is important
not to configure any Sigma Interface properties except the Import host property
(the address of the Sigma server) on the Basic tab. If you configure the Server
number and IP address properties (of the Enterprise Server) at this stage,
Building Operation will connect to the Sigma network and begin to receive logs
Continued on next page
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and alarms it cannot yet utilize, and therefore generate unnecessary log
messages and events. After the controller and log set data imports are complete,
you can then configure the server number and IP address of the Enterprise Server
(and any other properties that you need to change).
Each time you re-program Sigma at the Sigma client, the programming changes are
available to be read by the data import process. At each data import to Building
Operation, the following database modifications generally apply:
• Building Operation creates any new objects added during Sigma reprogramming (but not previously present in Building Operation).
• Building Operation deletes any objects (and their child objects) deleted during
Sigma re-programming (if previously present in Building Operation). Building
Operation also removes any references or bindings relating to the deleted
objects and unsubscribes any pre-existing subscriptions.
• Building Operation modifies any objects modified during Sigma reprogramming (if previously present in Building Operation) and preserves any
references, bindings, or subscriptions relating to the modified objects.

109.5.1

Partial Data Imports
When you import data at the Sigma Interface level, the data imported is sourced
from all Sigma controllers, or from one or more selected controllers. If you do not
select specific controllers for data import, data from all controllers is imported by
default. You select the controllers in the Sigma Interface properties. In the default
situation, in the event of a further data import, all the Sigma devices in WorkStation
are overwritten (assuming that none of the Sigma controllers are removed from the
Sigma system). However, if a Sigma controller is removed prior to a data import,
that corresponding device in WorkStation is not deleted, but remains as it was
before the data import.
For more information, see section 109.6 “Partial Data Imports” on page 4812.

109.5.2

Data Importer Conversion Warning Messages
The Data Import dialog box may display warning messages informing you of the
findings of the data importer during the import process, and of any actions taken by
the data importer. You can continue with the data import and accept the
consequences, but it is recommended that you cancel the data import and then
make suitable changes in Sigma to rectify the situation before a subsequent data
import.
For more information, see section 171.1 “Data Importer Conversion Warning
Messages” on page 5727.

109.5.3

Data Importer Conversion Error Messages
The Data Import dialog box may display error messages resulting from the findings
of the data importer during the import process. You can continue with the data
import and accept the consequences, but it is recommended that you cancel the
data import and make suitable changes in Sigma to rectify the situation before a
subsequent data import.
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For more information, see section 171.2 “Data Importer Conversion Error
Messages” on page 5731.

109.5.4

Data Importer Conversion Failed Messages
During a data import, the Data Import dialog box may display a message informing
you about a conversion failure. We recommend that you rectify the situation in
Sigma before a subsequent data import.
For more information, see section 171.3 “Data Importer Conversion Failed
Messages” on page 5733.

109.5.5

Graphics Error Messages in the Trace File
The graphics trace file might contain error messages relating to graphics errors
during a graphics data import. In each case, the trace file identifies a specific
graphic that you can examine to help determine the cause of the graphics error
message.
For more information, see section 171.4 “Graphics Error Messages in the Trace
File” on page 5734.

109.5.6

Functions Available After Import
After you have imported Sigma data into a Sigma Interface, there are a limited
number of functions available to you regarding Sigma folders, devices and objects,
graphics, log sets, and text reports.
For more information, see section 109.8 “Functions Available after Import” on page
4814.
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109.6

Partial Data Imports
When you import data at the Sigma Interface level, the data imported is sourced
from all Sigma controllers, or from one or more selected controllers. If you do not
select specific controllers for data import, data from all controllers is imported by
default. You select the controllers in the Sigma Interface properties. In the default
situation, in the event of a further data import, all the Sigma devices in WorkStation
are overwritten (assuming that none of the Sigma controllers are removed from the
Sigma system). However, if a Sigma controller is removed prior to a data import,
that corresponding device in WorkStation is not deleted, but remains as it was
before the data import.
If you need to delete a Sigma device in WorkStation following a data import, you
can do so by first deleting the device, but then you need to delete all of the device's
object shortcuts in the relevant segments folders. An alternative method is to
remove all the Sigma objects from the controller in Sigma (but not the controller
itself), then do a data import, after which only the empty device remains in
WorkStation, which you can easily remove.
If you select specific controllers for data import, only data relevant to those specific
controllers is imported. Any Sigma devices that existed in the Sigma Interface prior
to the data import remain as they were before data import. This mechanism
removes the need for you to re-import large quantities of data from a substantial
Sigma system, allowing you to import only the data that is changed.
Each time a controller is imported, all of the objects contained within that controller
are also imported, and they overwrite any corresponding objects in the matching
device in WorkStation. If any objects within the matching device in WorkStation are
removed in Sigma as a result of Sigma re-programming, they are also removed in
the WorkStation matching device on a further data import.
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109.7

Importing Sigma Data into Building
Operation
You import Sigma data into a Sigma Interface to create or upgrade a representation
of your Sigma network in Building Operation.
For more information, see section 109.5 “Sigma Data Import” on page 4809.

To import Sigma data into Building Operation
1. In WorkStation, in the System Tree pane, right-click the Sigma Interface,
Graphics folder, or Log Sets folder where you want to import data, and then
click Data Import.

Tip
You can also reimport any one selected graphic after the first
graphics import.
2. Monitor the import process.
Message or Button

Description

Trace will be sent to:

Displays the path to the location of the
trace file. For more information, see
section 109.5 “Sigma Data Import” on
page 4809.

Source:

Displays the path to the Sigma server and
folder where data import update
information is contained.

Full URL:

Displays the path to the source of data
import update information.

Import

Click to import data following further
programming in your Sigma system.

3. Click Close.

04-16006-04-en, March 2015

Technical
4815

109 Sigma Introduction
109.8 Functions Available after Import

109.8

Functions Available after Import
After you have imported Sigma data into a Sigma Interface, there are a limited
number of functions available to you regarding Sigma folders, devices and objects,
graphics, log sets, and text reports.
The following table shows the menu command applicability within a Sigma Interface
after importing data from the Sigma server.
Table: Import and Modify Functions in a Sigma Interface
Command

Sigma
Folders

Data import

As children

New

Change of
Value Log
Set folder
Interval Log
Set folder

Devices/
Slots

Objects

As children As children

Graphics

Log
Sets

Text
Reports/
Groups

Yes

Yes

No

Global
Values
Devices
only

Global
values and
shortcuts
in
Segments
folders only

Yes

Yes

No/Yes

Yes/No

Global
values only

Yes

Yes

No/Yes

Yes

Yes

Yes

Yes

Yes

Yes/No

Global
values only

Yes

Yes

No/Yes

No

No

No

No

No

Extended
Logs folder
Graphics
subfolder
Segments
subfolder
Rename

Log Sets
subfolders
Graphics
subfolders
Segments
subfolders

Open
Delete

Yes
Log Sets
subfolders
Extended
Logs folders
Graphics
subfolders
Segments
subfolders

Cut
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Continued
Command

Copy

Sigma
Folders
Graphics
subfolders
Extended
Logs folders

Devices/
Slots

Objects

Graphics

Log
Sets

Text
Reports/
Groups

Shortcut
creation
only

Shortcut
creation
only

Yes

Yes

Shortcut
creation
only/Yes

No

No

Yes

Yes

No/Yes

No

No

Yes

No

No/Yes

Yes

Yes

Yes

Yes

Yes

Segments
subfolders
Otherwise
shortcut
creation only
Paste

Log Set
subfolder
Extended
Logs folders
Graphics
subfolders
Segments
subfolders

Move

Graphics
subfolders
Extended
Logs folders
Segments
subfolders

Paste as
shortcut

04-16006-04-en, March 2015

Yes

Technical
4817

109 Sigma Introduction
109.9 Sigma Programming

109.9

Sigma Programming
You use Sigma System Manager (at a Sigma client) to make Sigma programming
changes, and then download the changes to the relevant Sigma controllers. When
you have completed Sigma programming, you import your Sigma control changes
to the Sigma Interface in Building Operation.
For more information, see section 109.2 “Sigma Workflow” on page 4803.
The System Manager enables you to create and modify segments and objects that
specify the Sigma control scheme. Segments are containers (folders) that contain
other segments or objects, and can represent different parts of the Sigma
hierarchy, for example, a graphical location (at the high level) or a Sigma controller
(at the low level). Objects specify the controller inputs, controller outputs, and the
processing between inputs and outputs. During Sigma programming, you
download the segments and objects that you have created to the Sigma controllers
in your Sigma network.
You edit segments and objects in the Object Editor, which is opened from the
System Manager. There are various setup options for objects, located on different
Object Editor tabs.
The hierarchical structure of your Sigma control scheme is displayed in a tree
structure known as the Object Index. Information relating to objects is displayed in
the Main Pane to the right of the Object Index.

Figure: Programming in Sigma

You may find it necessary to re-program your Sigma scheme several times to
achieve the required Sigma Interface in Building Operation.
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109.10

Sigma Interface
A Sigma Interface is the software representation of your external Sigma network in
the System Tree pane. However, the Sigma Interface does not contain your Sigma
network structure prior to a data import, merely a folder structure. After you have
imported Sigma data, the Sigma Interface is where Sigma devices and objects are
established.
When you integrate a Sigma network into Building Operation, you create and
configure a Sigma Interface under an Enterprise Server in the System Tree pane.
For more information, see section 109.4 “Sigma Interface Creation” on page 4808.
When you have created and configured the Sigma Interface, you can then import
Sigma data from the Sigma server. The Sigma Interface is one of three main
locations where you can import Sigma data. For more information, see section
109.5 “Sigma Data Import” on page 4809.

109.10.1

Sigma Representation
A Sigma Interface contains a standard group of five folders that contain all Sigma
objects after a Sigma data import:
• Controllers: a container for all configured Sigma controller objects
• Graphics: a container for all imported Sigma graphics (empty prior to a
graphics-specific import)
• Log Sets: a container for all imported log sets (empty prior to a Log Setsspecific import)
• Segments: a container for segments, matching the structure in the Sigma client
(empty prior to the initial import)
• Text Reports: contains four built-in Sigma text reports and three diagnostics
text reports
For more information, see section 109.13 “Sigma Representation” on page 4823.

109.10.2

Object Types
The Sigma Interface contains the following types of object:
• Devices (in the Controllers folder): A device represents any Sigma controller.
UNC496, UNC596, UNC696, and UNC796 controllers are displayed with child
objects that represent the relevant configured card slots. Each controller
inherits an IP address from the address allocation in the Sigma server. For
more information, see section 110.1 “Sigma Devices” on page 4833.
• Objects (in devices and folders): These objects represent any of 16 different
types of Sigma hardware and software objects. Sigma objects also contain
child objects such as contingency logs and alarms. However, some Sigma
objects can also contain special child objects such as time extensions or an
edge trigger pulse. For more information, see section 111.4 “Sigma Hardware
Objects” on page 4854. For more information, see section 111.8 “Sigma
Software Objects” on page 4859.
• Objects (in the Log Sets, Graphics, and Text Reports folders): These objects
represent imported and locally generated log records and graphics, and built-in
Sigma text reports.
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All objects are represented by an appropriate icon. For more information, see
section 117.3 “Sigma System Tree Icons” on page 4955.
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109.11

Creating a Sigma Interface
You create a Sigma Interface so that a Sigma scheme can be imported later.
For more information, see section 109.4 “Sigma Interface Creation” on page 4808.

To create a Sigma Interface
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the Sigma Interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, select Sigma Interface.

4. In the Name box, type a name for the Sigma Interface.
5. In the Description box, type a description for the Sigma Interface.
6. Click Create.
You now configure the Sigma Interface.

04-16006-04-en, March 2015

Technical
4821

109 Sigma Introduction
109.12 Configuring a Sigma Interface

109.12

Configuring a Sigma Interface
You configure a Sigma Interface to ensure proper communications between
Building Operation and the Sigma network.

Tip
Before importing data for the first time, just configure the Import host property
(on the Basic tab). Configuring all properties before the first data import causes
the generation of superfluous log messages and events. For more information,
see section 109.5 “Sigma Data Import” on page 4809.
For more information, see section 109.4 “Sigma Interface Creation” on page 4808.

To configure a Sigma Interface
1. In WorkStation, in the System Tree pane, click the Sigma Interface.
2. On the File menu, click Properties.
3. Click the Basic tab.
Continued on next page
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4. Edit the basic properties:
Property

Description

Server number

Enter the server number of the Enterprise
Server computer. This is the number that
you configured in the Networks and
Devices section of Sigma System Setup.

IP address

Type the IP address of the computer
where the Enterprise Server (containing
the Sigma Interface) is installed.

Subnet mask

Type the subnet mask for the Enterprise
Server network adaptor IP address.

Controllers

Leave the field blank if you want to import
data from all Sigma controllers, otherwise
type the node number of the Sigma
controller from which you want to import
data. If you want to import data from
more than one controller (but not all
controllers), type the node numbers of the
controllers, separated by a comma. To
import a range of controllers, use a dash
(for example 100-200 includes all
controllers with node numbers between
100 and 200).

Import host

Type the IP address (or network name) of
the Sigma server computer.

Trace file

Displays the path to the trace file.
For more information, see section 109.5
“Sigma Data Import” on page 4809.

Trace

Select Detailed if you want to ensure
that the detailed version of the log sets
trace file is generated on data import.
For more information, see section 109.5
“Sigma Data Import” on page 4809.

Communication status

Displays the status of the
communications between the Enterprise
Server computer and the Sigma controller
network.

Communication error text

Displays the text generated when a
communications error occurs between
the Enterprise Server computer and the
Sigma controller network.

5. Click the Advanced tab.
Continued on next page
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6. Edit the advanced properties:
Property

Description

Ping attempts

Enter the number of times you want the
interface to ping an offline device before
the device is set to offline status.

Checking period

Select how often you want the interface
to check devices.

Maximum concurrent checks

Enter 10 if the network does not contain
any DNNs, otherwise leave at the default
of 1.

Maximum checks per minute

Enter the maximum number of device
checks per minute.

Response timeout

Select the amount of time you want the
interface to wait for a response from a
device before timing out. If pre-ARM7
Sigma controllers are interfaced, select
1.5 seconds.

Alarm priority

Select the priority for the alarm that is
raised indicating that a device is offline (1
is the highest priority).

Alarm flashing

Select True if you want device status
alarms to flash.

Alarm audible

Select True if you want device status
alarms to sound an audible alert.

Communication timeout

Select the time to wait for any Sigma data
communications before timing out.

Trace communications

Select True to enable the creation of a
hexadecimal display of network
communications data. For Schneider
Electric use only.

Import port

Type the port number used by the Sigma
server to communicate (as set in Sigma's
SetupSvr.exe)

Source file

Type the path to an alternative XML file if
you do not wish to use data from the
Sigma server (for Schneider Electric use
only).

Import in progress

Do not change - used by the data import
function.

7. Click OK.
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109.13

Sigma Representation
A Sigma Interface contains a standard group of five folders that contain all Sigma
objects after a Sigma data import:
• Controllers: a container for all configured Sigma controller objects
• Graphics: a container for all imported Sigma graphics (empty prior to a
graphics-specific import)
• Log Sets: a container for all imported log sets (empty prior to a Log Setsspecific import)
• Segments: a container for segments, matching the structure in the Sigma client
(empty prior to the initial import)
• Text Reports: contains four built-in Sigma text reports and three diagnostics
text reports

Figure: Sigma Interface representation in Building Operation before Sigma data import

After all Sigma data is successfully imported, the representation of the Sigma
network in the System Tree pane contains the same network structure that exists in
the physical Sigma network.

109.13.1

Controllers
The following example comprises a collection of objects under two main controllers
(N109 and N853) in (left) a Sigma client, and (right) in WorkStation:
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Figure: Object representation in a Sigma client and in WorkStation

After a data import, the Sigma Interface is populated with the same objects as in the
Sigma server.
However, objects in the Controllers folder are renamed to include the Sigma object
number. For example, the object called "Chiller Fault" in Sigma becomes "0007 Chiller Fault" in Building Operation. This ensures that if any duplicate object names
exist in a Sigma controller, only unique names exist in the Controllers folder after
data import.
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109.13.2

Segments
The next figure displays the segment structure. Segments are arranged
alphabetically at each level from top to bottom (you cannot rearrange the order).
Each segment contains shortcuts to the Sigma objects:

Figure: Segment representation in the System Tree pane

The names of the shortcuts in the Segments folder are the same as the Sigma
object names, except where duplicate objects exist in a Sigma controller. For
example, if three separate objects are each called "Temp1" in UNC 123, the second
and third instances of "Temp1" are renamed in the Building Operation segment to
"Temp1_2" and "Temp1_3" to ensure that the object names are unique. To avoid
the automatic renaming of object duplicates, it is recommended that you ensure
that object names are unique within each Sigma controller before data import.
You can add new segments to the imported segments structure if required. You
might want to do this if you wanted to create local shortcuts.
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109.14

Creating a Segment
You create a segment to provide a container in which to create shortcuts to Sigma
objects.
For more information, see section 109.13 “Sigma Representation” on page 4823.

To create a segment
1. In WorkStation, in the System Tree pane, select the Segments folder.
2. On the File menu, point to New and then select Segment.
3. In the Name box, type a name for the segment.

4. In the Description box, type a description for the segment.
5. Click Create.
You now add Sigma object shortcuts to the segment.
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109.15

Sigma Networks
Sigma network refers to the physical Sigma network that you connect to your
Enterprise Server PC by way of an Ethernet connection, and from which data is
ultimately read when you import Sigma data into your Building Operation Sigma
Interface. A Sigma network typically comprises a backbone LAN comprising Sigma
routers (DNNs), and a number of controller LANs, each headed by a DNN.
The Sigma network is represented in the System Tree pane as Sigma devices and
objects, after you configure a Sigma Interface and import Sigma data from the
Sigma server.
DNNs are not represented in the Building Operation System Tree pane (nor are they
represented in the Sigma System Manager Main Pane).

109.15.1

Sigma Network Protocols
A Sigma network can utilize up to three types of network protocols: Ethernet LAN,
ARCNET LAN, and Sigma LAN. Ethernet LAN is generally used for the backbone
LAN. ARCNET LANs, Sigma LANs, and Ethernet LANs can be used
interchangeably (in pairs) to form dual-redundant LANs that interconnect Sigma
controllers.
However, some physical preparation is required before connecting your Sigma
network to Building Operation, refer to the next section (Sigma Network
Connectivity).
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Figure: Examples of Sigma network protocols

An Ethernet backbone or controller LAN allows speeds from 10Mbps to 1000Mbps
depending on Ethernet type and distance.
A Sigma (controller) LAN fixed at 19.2kbps - always the secondary LAN - is enabled
when primary LAN (Ethernet or ARCNET) is disabled. A Sigma LAN is based on the
EIA-485 standard where all nodes share a common twisted-pair cable.
An ARCNET backbone or controller LAN allows speeds of 156Kbps to 5Mbps,
depending on LAN length and cable type.

109.15.2

Sigma Network Connectivity
You connect your Sigma network to an Enterprise Server PC only, by way of the
standard Ethernet network adaptor RJ45 socket, or by using either a PCI network
adapter (suitable for some older Operating Systems) or a USB-to-Ethernet adapter.
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Before connecting your Sigma network and the Enterprise Server PC, you need to
ensure that the Sigma network is physically prepared for the Sigma integration due
to some restrictions:
• Autodial is not supported in Building Operation. You must ensure that all
Autodial controllers are addressed way of Internet Protocol.
• There can be only two servers in the system: the Enterprise Server and one
Sigma server.
• ARCNET networks connected to the Enterprise Server are not supported. You
must ensure that all ARCNET network connections are removed from the
Sigma server (although you can use an ARCNET network if it is a subnet of a
DNN on the Ethernet).
• Sigma secondary LANs are not supported by Building Operation. You must
disable these secondary LANs at the Sigma client.
For more information relating to physical and configuration changes required when
connecting a Sigma network to Building Operation, refer to the Sigma to
StruxureWare Building Operation Transition Guide.
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110.1

Sigma Devices
Sigma devices are a family of networked devices that provide either direct control or
routing functions in the Sigma building management system. All of the Sigma
controlling devices (commonly termed controllers) that are supported by Building
Operation are fully programmable, using the Sigma software at a Sigma client.
Before you can use a controller in a Sigma network, you program the control
objects using Sigma and then download the object into the controller. Routing
devices (DNNs) play no part in system control but you configure them with address
and other data as part of the Sigma system setup.
In Building Operation, Sigma device is the family name for the following devices:
• Universal Network Controllers: UNC532, UNC532K, UNC632, UNC496,
UNC596, UNC696, and UNC796.
• Integration Controllers: IC ASIC, IC Carrier, IC Fidelio, IC LonWorks, IC
MN2000, IC Modbus/JBUS, IC MQuay, IC SNP, IC Unifact Pro, IC Wormald,
IC York, IC GenDDE, and IC Gen OPC.
All these devices are supported in Building Operation. For more information, see the
Sigma System Overview and the Sigma datasheets.
All devices have a unique number in Building Operation, as set up in Sigma.

110.1.1

Global Values Device
A global values device is a virtual device for containing global values. You can
create one (and only one) global values device in a Sigma Interface and then create
global values within it.
You can create the following types of global values in a global values device:
• Virtual analog input
• Virtual analog output
• Virtual digital input
• Virtual digital output
A global value enables you to write a value in a Sigma controller object to another
Building Operation object, or to write a Building Operation object value into an
object in a Sigma controller. For example, you might want to reuse the value from
an outside air temperature sensor (connected to a Sigma controller) in an object in a
different Building Operation interface such as Modbus. Reusing Sigma values in
other Building Operation objects is known as Globals from Sigma. Similarly, reusing
external Building Operation values in Sigma objects is known as Globals to Sigma.
For more information, see section 115.1 “Global Values” on page 4923.

110.1.2

Controller Diagnostics
Each Sigma controller in a Sigma Interface contains a Diagnostics folder that
provides statistical information about the controller, and the current time and date
within the controller. An additional Sigma diagnostics facility (available via menu
commands) enables you to retime controllers or to set controllers online again after
being offline.
For more information, see section 110.3 “Controller Diagnostics” on page 4836.
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110.1.3

Device Monitoring
Device Monitoring is similar to the Device Monitoring facility in Sigma, where you
can choose the controllers that you want to be monitored by the Sigma server. In
Building Operation, all controllers in the Sigma Interface are enabled for device
monitoring by default, and are monitored by the Enterprise Server. The Device
Monitoring facility regularly checks each controller to determine the online or offline
status of that controller. If the controller is enabled for device monitoring and a
change of status occurs, the change of status is displayed in the device properties
Basic tab. If that controller is not enabled for device monitoring, the displayed status
of the controller remains as it was prior to the change of status.
For more information, see section 110.10 “Device Monitoring” on page 4844.
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110.2

Configuring a Sigma Device
You configure a Sigma device to identify the device to the Sigma Interface and to
enable or disable device monitoring. You can also view port properties.
For more information, see section 110.1 “Sigma Devices” on page 4833.

To configure a Sigma device
1. In WorkStation, in the System Tree pane, select the Sigma device that you
want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Device number

View (or enter for a virtual device) the
number of the Sigma device.

Ports
Click the
buttton to view the
properties of the selected device port.
Device monitoring

Select Disabled to disable device
monitoring for this device.
For more information, see section 110.10
“Device Monitoring” on page 4844.

5. Click OK.
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110.3

Controller Diagnostics
Each Sigma controller in a Sigma Interface contains a Diagnostics folder that
provides statistical information about the controller, and the current time and date
within the controller. An additional Sigma diagnostics facility (available via menu
commands) enables you to retime controllers or to set controllers online again after
being offline.

110.3.1

Controller Time
Controller Time enables you to view the current time and date within a selected
controller.
For more information, see section 117.10 “Controller Time Properties – Basic Tab”
on page 4964.

110.3.2

Log Set Statistics
Log Set Statistics enable you to view numerical information about Sigma log
records (log sets).
For more information, see section 110.6 “Log Set Statistics” on page 4840.

110.3.3

Network Communications Statistics
Network communication statistics enable you to view statistical information about
one or all controllers:
• Numbers of bytes, data packets, and subscriptions sent and received
• Numbers of alarms and logs received
• Numbers of object file operations
• Numbers of globals and duplicate alarms
• Message queue debugging information
For more information, see section 110.7 “Network Communication Statistics” on
page 4841.

110.3.4

Node Statistics
Node Statistics enable you to view the statistics of a Sigma controller. Node
statistics are part of each controller's diagnostics facility in Building Operation, and
relate directly to the relevant part of the Comms Stats facility in Sigma Diagnostics.
For more information, see section 110.9 “Node Statistics” on page 4843.
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110.3.5

Sigma Diagnostics
The Sigma diagnostics facility is available at each controller and provides three
functions:
• Retiming one or more controllers to the time and date of the Enterprise Server if
the time and date displayed in the Controller Time properties (see above) is not
correct for whatever reason. For more information, see section 110.4 “Retiming
a Controller” on page 4838.
• Setting the communications status of one or more controllers to Online. You
may want to do this after a controller is reinstated following power down or
disconnection from the network. For more information, see section 110.10
“Device Monitoring” on page 4844. For more information, see section 110.5
“Setting a Controller Online” on page 4839.
• Creation of Sigma diagnostics text reports. For more information, see section
128.13 “Sigma Diagnostics Text Reports” on page 5342.
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110.4

Retiming a Controller
You retime a controller to set the time and date to the time and date of the
Enterprise Server.
For more information, see section 110.3 “Controller Diagnostics” on page 4836.

To retime a controller
1. In WorkStation, in the System Tree pane, expand the Sigma Interface.
2. Expand the Controllers folder and then expand the controller that you want
to retime.
3. Expand the Diagnostics folder and then select Controller Time.
4. On the Actions menu, click Retime.
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110.5

Setting a Controller Online
You set a controller on line to re-establish communications between the Enterprise
Server and the controller following an offline event (this procedure is typically used
to bring the controller online again without having to wait for the next poll by the
Device Monitor).
For more information, see section 110.3 “Controller Diagnostics” on page 4836.

To set a controller online
1. In WorkStation, in the System Tree pane, expand the Sigma Interface.
2. Expand the Controllers folder and then select the controller that you want to
set online.
3. On the Actions menu, select Sigma diagnostics and then click Set
online.
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110.6

Log Set Statistics
Log Set Statistics enable you to view numerical information about Sigma log
records (log sets).
The log set statistics available for any controller relate directly to the View Logging
Servers command and the View Logging Objects command in the Sigma
Diagnostics facility at the Sigma server.
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110.7

Network Communication Statistics
Network communication statistics enable you to view statistical information about
one or all controllers:
• Numbers of bytes, data packets, and subscriptions sent and received
• Numbers of alarms and logs received
• Numbers of object file operations
• Numbers of globals and duplicate alarms
• Message queue debugging information
If required, you can reset all the network statistics cumulative values back to zero.
Normally these values are only set to zero when the Enterprise Server starts.

04-16006-04-en, March 2015

Technical
4843

110 Sigma Devices
110.8 Resetting Network Communication Statistics

110.8

Resetting Network Communication
Statistics
You reset network communications statistics to restore controller or network
cumulative communications values back to zero.
For more information, see section 110.7 “Network Communication Statistics” on
page 4841.

Resetting network communication statistics
1. In WorkStation, in the System Tree pane, expand your Sigma Interface.
2. In the Sigma Interface or in a controller Diagnostics folder, select Networks
Communication Statistics.
3. On the Actions menu, click Reset statistics.
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110.9

Node Statistics
Node Statistics enable you to view the statistics of a Sigma controller. Node
statistics are part of each controller's diagnostics facility in Building Operation, and
relate directly to the relevant part of the Comms Stats facility in Sigma Diagnostics.
The following node statistics are available for viewing in the object:
• Ports: Port 1 is the configured port for all Sigma controllers. The port statistics
describe the network connected to the port.
• Entity Buffers: The buffers described relate to the Application, Session, and
Transport layers of the 7-layer Open Systems Interconnection (OSI) networking
model, upon which the Sigma software is based.
• Data Buffers: the data buffer numbers relate to the 30 byte buffer, 200 byte
buffer, and the 1000 byte buffer.
• Message Queues: the message queues numbers relate to the numbers of
message buffers queued in the Sigma, Ethernet, or ARCNET LANs, and the
Application and Transport layers.
• Data Queues: the data queues numbers relate to the numbers of data buffers
in the Sigma LAN.
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110.10

Device Monitoring
Device Monitoring is similar to the Device Monitoring facility in Sigma, where you
can choose the controllers that you want to be monitored by the Sigma server. In
Building Operation, all controllers in the Sigma Interface are enabled for device
monitoring by default, and are monitored by the Enterprise Server. The Device
Monitoring facility regularly checks each controller to determine the online or offline
status of that controller. If the controller is enabled for device monitoring and a
change of status occurs, the change of status is displayed in the device properties
Basic tab. If that controller is not enabled for device monitoring, the displayed status
of the controller remains as it was prior to the change of status.
If a controller is switched off or becomes disconnected from the network, or if the
Enterprise Server cannot communicate with the controller over the network, the
controller is marked as Offline and objects cannot be displayed. When the controller
is turned on again (or re-connected), the Device Monitoring process recognizes that
the controller is back online, and re-enables the controller by setting its Status
property to Online. However, there can be a delay before the Device Monitoring
process re-checks a particular device, so you may want to force the controller to
Online so that you can verify if it is really connected and working again, without the
delay. If you do force the controller (and its Status property) to Online, and the
controller is still switched off, disconnected or otherwise faulty, the controller Status
property reverts to Offline after one or two minutes, and all objects are displayed
with red offline icons. For more information, see section 110.5 “Setting a Controller
Online” on page 4839.
You can change device monitoring settings at the Sigma Interface properties. For
more information, see section 109.12 “Configuring a Sigma Interface” on page
4820.

Technical
4846

04-16006-04-en, March 2015

111

Sigma Objects

Topics
Sigma Objects
Sigma Values and Reasons for State
Configuring a Sigma Object
Sigma Hardware Objects
Analog Output
Digital Output
Creating a Digital Output Edge Trigger Pulse
Sigma Software Objects
Control Object
Configuring a Control Stage
Holiday Schedule
Optimizer
Configuring an Optimizer
Setpoint Adjust Object
Configuring a Setpoint Adjust Object
Rotation Object
Configuring a Rotation Object
Programmable Object
Configuring a Programmable Object
Sigma Time Schedules

Adding an Event to a Sigma Time Schedule
Overriding a Time Schedule
Time Extensions
Editing a Time Extension

111 Sigma Objects
111.1 Sigma Objects

111.1

Sigma Objects
A Sigma Interface contains various Sigma container objects and imported Sigma
objects. The Sigma objects that you import into Building Operation are the objects
contained within Sigma controlling devices such as a UNC632.
There are 16 Sigma standard objects comprising two groups, one group containing
seven hardware objects, and another group containing nine software objects. All
hardware and software objects have a Value property and various other properties.
Generally, you cannot change the properties of Sigma objects, but you can force
the Value property of most hardware and software objects to a different value if
required. Additionally, some objects have child objects containing properties that
you can change.
In addition to the 16 Sigma hardware and software objects, other imported objects
include Sigma graphics, log sets, contingency logs, and alarms.
Global value objects are created directly in a special virtual device in WorkStation.

111.1.1

Sigma Hardware Objects
Hardware objects monitor or control the hardware in the Sigma system. Each
hardware object is associated with one input/output channel of a particular Sigma
controller.
For more information, see section 111.4 “Sigma Hardware Objects” on page 4854.

111.1.2

Sigma Software Objects
Software objects provide specialized functions within a Sigma controller by
analyzing or controlling other object types. They do not relate directly to any
hardware in the Sigma system.
For more information, see section 111.8 “Sigma Software Objects” on page 4859.

111.1.3

Graphics
You can import graphics from the Sigma server. The imported graphics are in the
native TGML format, converted from the original Sigma format (.swc). You can also
create new Building Operation TGML graphics in the Graphics folder. You can
delete imported graphics and those that you have imported. Before importing
graphics, you can impose restrictions on graphics file sizes to prevent delays during
import. Some features of Sigma graphics are not supported after import into
WorkStation.
For more information, see section 112.1 “Graphics” on page 4883.
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111.1.4

Log Sets
A Log Set is a log configuration that contains one or more Sigma objects selected
for historical logging. Log sets may be set up in Sigma and imported into a special
folder (Log Sets) in the Sigma Interface, but you can also create new log sets (and
delete them) in the same folder. You can send and retrieve log sets to and from
Sigma controllers.
For more information, see section 113.1 “Log Sets” on page 4891.

111.1.5

Contingency Logs
Contingency logging provides an instant recent history of Sigma objects. No Sigma
pre-configuration is required, although you can modify the default contingency
logging settings of an object in Sigma. In WorkStation, you can modify the default
contingency logging settings within the contingency log associated with each
imported Sigma object. By default, all Sigma objects (except optimizer and standby
generator) are enabled for contingency logging.
For more information, see section 113.10 “Contingency Logs” on page 4903.

111.1.6

Sigma Text Reports
Sigma text reports contain information relating to objects within Sigma controllers.
For more information, see section 128.8 “Sigma Text Reports” on page 5335.

111.1.7

Global Values
A global value enables you to write a value in a Sigma controller object to another
Building Operation object, or to write a Building Operation object value into an
object in a Sigma controller. For example, you might want to reuse the value from
an outside air temperature sensor (connected to a Sigma controller) in an object in a
different Building Operation interface such as Modbus. Reusing Sigma values in
other Building Operation objects is known as Globals from Sigma. Similarly, reusing
external Building Operation values in Sigma objects is known as Globals to Sigma.
For more information, see section 115.1 “Global Values” on page 4923.

111.1.8

Alarms
Building Operation supports alarms contained within imported Sigma objects. The
properties for most Sigma alarms are derived from the configurations selected in
the Alarms card (or Alarms 1 and Alarms 2 cards) for objects in the Sigma Object
Editor. You can configure some of these properties in Building Operation
(depending on object type) - the properties of all alarmed Sigma objects are
available to view or configure as child objects of the associated alarmed Sigma
object. If routed to the Enterprise Server, Sigma alarms are displayed (when active)
in the Alarms pane, and can be managed (with restrictions) like other Building
Operation alarms. Additionally, you can apply alarm specific manual overrides on
alarmed Sigma objects, for example alarm enable, and edit alarm.
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For more information, see section 116.1 “Alarms” on page 4939.

111.1.9

Time Extensions
A time extension extends the duration of the normal running period of an object. In
WorkStation, you can set the time extension to take effect at every (off) switching
time, or once only, at the next (off) switching time. Time extensions can be applied
to analog outputs, digital outputs, optimizers, time schedules, setpoint adjust, and
rotation objects.

111.1.10

Sigma Values and Reasons for State
A Sigma value can be a numeric value, enumeration, or a string (depending on
object type), and for most objects you can force a different value if required.
The value contained in the Value property of each Sigma object is conditional upon
the configuration of that object and associated objects in Sigma, and also upon
user selections in Sigma. These different conditions provide a "Reason" property in
Building Operation that relates directly to the RFS code displayed when you display
an object's information in the Sigma Main Pane. You cannot change the Reason
property in Building Operation.
For more information, see section 111.2 “Sigma Values and Reasons for State” on
page 4850.
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111.2

Sigma Values and Reasons for State
A Sigma value can be a numeric value, enumeration, or a string (depending on
object type), and for most objects you can force a different value if required.
The value contained in the Value property of each Sigma object is conditional upon
the configuration of that object and associated objects in Sigma, and also upon
user selections in Sigma. These different conditions provide a "Reason" property in
Building Operation that relates directly to the RFS code displayed when you display
an object's information in the Sigma Main Pane. You cannot change the Reason
property in Building Operation.
The following table shows the data types and sample enumerations for each of the
Sigma object values. Floating point values range from 1.7 × 10–308 to 1.7 × 10+308
(approximately), with up to 15 digits precision. Integer values are in the range 2,147,483,648 to 2,147,483,647. The PRG string value is derived from the
programmable string type of object. The enumerations available for display in the
Value property of any particular object depend on the Short Text configurations set
up for the object in Sigma, so they can vary between installations.
Table: Sigma Values
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Object

Data Type or Enumerations in Value
Property

DO

Digital enumerations, for example On, Off

DI

Digital enumerations, for example Start, Stop

AO

Floating point number

AI

Floating point number

CAL

Floating point number

TIM

Digital enumerations, for example Time. On,
Time. Off

HOL

Digital enumerations, for example Holiday,
Not Holiday

OPT

Enumerations, for example + Optimum off, +
Run-up, + Occupancy (nine states)

SPA

Floating point number

CTL

Floating point number

ROT

Integer

DDY

Floating point number

PLS

Floating point number

MET

Integer

SBG

Integer

PRG

String, floating point number, or digital value
of On or Off
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Object

Data Type or Enumerations in Value
Property

The following table shows the Reasons for State for the Sigma objects. The first five
Reasons for State can occur for several different types of object (depending on
available options in the Sigma Object Editor Manual menu). The remaining Reasons
for State are generally specific to object type.
Table: Sigma Reasons for State
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Reasons for State

Sigma Object in Building
Operation

Sigma RFS

Inhibit

General, as applicable

INH

None

General, as applicable

NIL

Manual

General, as applicable

MAN

Auto

General, as applicable

AUTO

Set to value

General, as applicable

MAN

Maximum

CAL

MAX

Minimum

CAL

MIN

Mean

CAL

MEAN

Power up level

AO

PU

High priority action

AO

HA

Load shedding

AO

LS

Low priority action

AO

LA

Optimizer

AO

OPT

Time schedule

AO

TIM

Standard control

AO

STD

Power up level

DO

PU

High priority action

DO

HA

Load shedding

DO

LS

Low priority action

DO

LA

Optimizer

DO

OPT

Time schedule

DO

TIM

Minimum on/off

DO

MIN

Rotation

DO

ROT
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Continued
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Reasons for State

Sigma Object in Building
Operation

Sigma RFS

Load cycling

DO

CYC

Pulsing active

DO

PLS

Hysteresis

DO

XREF

High priority action

ROT

HA

Load shedding

ROT

LS

Low priority action

ROT

LA

Control

ROT

CTL

Optimizer

ROT

OPT

Standard control

ROT

STD

Fixed

SPA

FIX

Time schedule

SPA

TIM

Optimizer

SPA

OPT

Setpoint adjust

CTL

SPA

Run up

OPT

RU

Run down

OPT

RD

Frost protection

OPT

FP

High temp. protect

OPT

HT

Low limit

OPT

LL

High limit

OPT

HL

Grid available

SBY

GRD

Standby running

SBY

SBS

Standby running in overload

SBY

SBO

No mains

SBY

NMRFS

Holiday

TIM

HOL

Core schedule

TIM

CORE

Time extension

AO, DO, TIM, OPT

EXT

Error

As occurs

ERR
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111.3

Configuring a Sigma Object
You configure a Sigma object to force a value change and to view or change other
properties (where possible).
For more information, see section 111.2 “Sigma Values and Reasons for State” on
page 4850.

To configure a Sigma object
1. In WorkStation, in the System Tree pane, select the object that you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Value

Displays the object value.

5. Click OK.
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111.4

Sigma Hardware Objects
Hardware objects monitor or control the hardware in the Sigma system. Each
hardware object is associated with one input/output channel of a particular Sigma
controller.

111.4.1

Analog Input
An analog input is used to measure temperature, pressure, position, level and other
similar conditions. Measurements are made via a sensor attached to a Sigma input
channel which generates a continuous signal proportional to the condition being
monitored. Conversion of values is performed through a lookup table stored in the
Sigma controller.

111.4.2

Analog Output
An analog output provides an analog output signal in the range 0 to 10 Volts. This
signal can be used to drive devices such as valve or damper position actuators. The
conversion of values is performed through a lookup table stored in the Sigma
controller.
For more information, see section 111.5 “Analog Output” on page 4856.

111.4.3

Digital Input
A digital input monitors a digital input from a device such as a switch, contact, or a
relay, which indicates the status of equipment. The contact is either open (logic ON)
or closed (logic OFF).

111.4.4

Digital Output
A digital output has a value ON or OFF and can be used to control hardware, via a
plant controlling relay. The output can either be maintained (that is, the associated
relay is held permanently open or closed), or in the form of a pulse (where the
associated relay only operates for a specific time period). You can create positive or
negative going edge trigger pulses (if an edge trigger pulse is already configured in
Sigma).
For more information, see section 111.6 “Digital Output” on page 4857.

111.4.5

Meter
The purpose of a meter is to switch off non-essential electrical loads to avoid
exceeding electricity consumption limits agreed with the supply authority. The meter
monitors the power consumption rate of plant equipment. If the meter senses that
the projected total energy consumed in the metering period might overshoot a predefined target, electrical loads controlled by the analog output, digital output, and
rotation objects are shed.
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111.4.6

Pulse Counter
A pulse counter counts pulses at a regular interval and determines a current value
by dividing the total by a scaling factor specified in the configuration parameters.
Reports can be produced and an alarm can be activated when the current total
exceeds a specified limit. Pulse counters can only be allocated numbers in the
range 81 to 92 (x96 controllers) and 81 to 90 (x32 controllers).

111.4.7

Standby Generator
A standby generator monitors whether the electrical power is coming from the grid
mains, or a standby generator. In the event of a loss of mains power followed by the
substitution of a standby generator, the standby generator ensures an orderly
reinstatement of equipment without overloading the generator.

04-16006-04-en, March 2015

Technical
4857

111 Sigma Objects
111.5 Analog Output

111.5

Analog Output
An analog output provides an analog output signal in the range 0 to 10 Volts. This
signal can be used to drive devices such as valve or damper position actuators. The
conversion of values is performed through a lookup table stored in the Sigma
controller.
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.6

Digital Output
A digital output has a value ON or OFF and can be used to control hardware, via a
plant controlling relay. The output can either be maintained (that is, the associated
relay is held permanently open or closed), or in the form of a pulse (where the
associated relay only operates for a specific time period). You can create positive or
negative going edge trigger pulses (if an edge trigger pulse is already configured in
Sigma).
The digital output can be also be in the form of a sequence of pulses over a specific
period of time (for example, for the safe control of a steam valve), if the Pulse Start
function is configured in Sigma.
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.7

Creating a Digital Output Edge Trigger
Pulse
You create an edge trigger pulse to provide either a positive going pulse (Pulse
Start) or a negative going pulse (Pulse Stop) at the digital output.
For more information, see section 111.6 “Digital Output” on page 4857.

To create a digital output edge trigger pulse
1. In WorkStation, in the System Tree pane, expand the digital output.
2. Select the edge trigger pulse.
3. On the Actions menu, click Pulse Start (positive going pulse), or Pulse
Stop (negative going pulse).
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111.8

Sigma Software Objects
Software objects provide specialized functions within a Sigma controller by
analyzing or controlling other object types. They do not relate directly to any
hardware in the Sigma system.

111.8.1

Calculation Object
A calculation object provides a maximum, minimum or average (mean) value of up
to seven analog inputs. A typical application is to control the temperature of a large
room by installing several temperature sensors and controlling on the average
value. The output is normally used to provide an input to an optimizer or control
object, where the input is often required to be the lowest of a number of inputs (low
temperature limit, for example) or the mean of several inputs (such as temperature
sensors in a room). Analog totalization may be applied to the output value of the
calculation.

111.8.2

Control Object
A control object is used to control the plant by referencing a primary input and a
setpoint value. The primary input is from an analog input and is the actual value of
the factor being controlled. The setpoint value is the required value, which may be
from a setpoint adjust object or a fixed internal value. The control object processes
the difference between the setpoint value and the primary input (the error term) to
produce an output related to the correction required (the scaled error term). This
output is then responded to by an analog output, rotation, or programmable object.
The form of the response is determined within that object, but is typically to control
a valve or motor.
For more information, see section 111.9 “Control Object” on page 4862.

111.8.3

Degree Day
A degree day provides a means of monitoring heat energy consumption in relation
to outside air temperature conditions over a period.
A degree day is the daily difference between a user defined base temperature and
the 24-hour averaged outside air temperature, when this falls below the base
temperature. The base temperature is the outside air temperature at or above
which no heating is needed. For example, if the base temperature is 15.5ºC and the
average outside air temperature for the day is 14.5 ºC, this is 1 degree day. If the
average for the next day is 12 ºC this is 3.5 degree days, giving a total for the two
days of 4.5 degree days. These figures are accumulated and then reported at
intervals and related to the fuel consumption for the period.
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111.8.4

Holiday Schedule
A holiday schedule is used to override time schedules defined in time schedule
during holiday periods. The holiday schedule is stored and actioned in the
controller, so a failure of the communications network does not prevent control of
equipment at the designated times. A holiday schedule is On when during one of its
defined holiday periods, otherwise it is Off.
You can add single dates and date ranges to a holiday schedule. For more
information, see the Calendar Events topic on WebHelp.

Note
You cannot add a calculated date to a Sigma holiday schedule.

111.8.5

Optimizer
Optimizers are set up to enable minimum use of energy to control building
temperatures. Optimizers work by turning heating and cooling systems on and off
at optimal times to maintain comfortable room temperatures when needed, and
also protect the building against extreme temperatures when unoccupied.
For more information, see section 111.12 “Optimizer” on page 4866.

111.8.6

Programmable Object
A programmable object is a means of achieving results that cannot readily be
obtained using other object types. A programmable object does not have a fixed
set function. Instead, it provides customized control functions by use of a
programming language similar to Basic.
The following list shows three examples of general applications:
• Calculations upon object values to provide rapid display of power cost figures,
efficiencies, etc.
• Exotic forms of object control. For example, a programmable object might
provide pump sequencing, enthalpy control, lighting control, chilled water
reset, discharge temperature reset.
• Special monitoring features and generation of reports under a complex
combination of circumstances.

111.8.7

Rotation
A rotation object enables controlled handling of up to nine digital outputs. The
rotation value represents the number of digital outputs to be switched on.
For more information, see section 111.16 “Rotation Object” on page 4872.
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111.8.8

Setpoint Adjust
A setpoint adjust object normally works in conjunction with a control object to
modulate the output of a plant, for example valves, boilers and fans. The output
represents the required value of the plant being controlled.
For more information, see section 111.14 “Setpoint Adjust Object” on page 4869.

111.8.9

Time Schedule
A time schedule enables you to create, display and manage events. There are three
types of time schedules:
• Standard: Defines exact on and off time periods for a schedule
• Relative: Defines offsets to be applied to a standard time schedule
• Calendar: Defines calendar periods to which the time schedules in a standard
time schedule apply.
For more information, see section 111.20 “Sigma Time Schedules” on page 4876.
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111.9

Control Object
A control object is used to control the plant by referencing a primary input and a
setpoint value. The primary input is from an analog input and is the actual value of
the factor being controlled. The setpoint value is the required value, which may be
from a setpoint adjust object or a fixed internal value. The control object processes
the difference between the setpoint value and the primary input (the error term) to
produce an output related to the correction required (the scaled error term). This
output is then responded to by an analog output, rotation, or programmable object.
The form of the response is determined within that object, but is typically to control
a valve or motor.
Three types of control are available:
• Proportional control
• Integral control
• Differential control (also known as derivative control)

Proportional Control
With proportional control, the output of the control object is controlled linearly within
the range 0 to 100%. You set a gain value that determines the range of primary
input values (relative to the setpoint value) required to produce an output in the
range 0 to 100%. The difference between the setpoint and the primary input values
is called the error term. The resulting output percentage is called the scaled error
term. The primary input value range over which the output increases from 0-100%
is known as the proportional band.
When the setpoint value equals the primary input value (the error term is zero) the
output value is maintained at 0% (the scaled term is zero). As the primary input
moves away from the setpoint value, the scaled error output percentage increases.
This is used by the controlled device to correct the primary input.

Integral control
With integral control, the proportional scaled error term (see above) is applied as the
input to an integrator. This produces an integral term contribution to the control
object output.
You set the time taken by the integral term to rise from zero to the scaled error term
value. The integration time constant determines how rapidly the integral term
reduces long term errors. A large value gives stable control but a slow response,
and a small value gives a fast response (although too small a constant may cause
the plant to hunt).
Integral control is useful for ensuring that any small offsets in the error term are
removed. With proportional action, a small error term may not produce sufficient
response in the control object output to achieve an improvement. With integral
control, the error continues to sum within the integrator, progressively increasing
the integral term until the error term is corrected to zero.
The integral term can be output from the control object on its own or combined with
the proportional scaled error term and/or the differential term.

Differential Control
With differential (derivative) control, the proportional scaled error term (see above) is
applied as the input to a differentiator. This produces a differential term contribution
to the control object output.
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Caution
You should take great care when using differential control. If incorrectly
configured, differential control can result in an unstable control programme.
The differentiator takes the difference between successive samples of the scaled
error term, and then divides the difference by the derivative time that you specify.
The result is a corrective differential term whose size is proportional to the difference
between the samples, and inversely proportional to the derivative time.
The differential term is therefore a measure of the rate of change of the scaled error
term. For example:
• If the change in error is zero, the differential term is zero.
• If the rate of change of the scaled error term is X % per second and the
derivative time is set to 1 second, then the differential term is X %.
In general, a longer derivative time produces a smaller corrective action, and a
shorter derivative time produces a larger corrective action.
The differential term can be output from the control object on its own, or combined
with the proportional scaled error term and/or the integral term.

Multi-Stage Control Objects
You can configure up to five control objects and link them together to form a multistage control processor.
In a typical application, such as the control of room temperature (see Proportional
Control, above), you link two control objects together. One stage senses the
temperature fall below the setpoint value to produce an error term to increase
heating. The other stage senses the temperature rise above the setpoint value to
produce an error term to increase cooling.

Note
It is not normal for heating and cooling control to be active at the same time.
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111.10

Configuring a Control Stage
You configure a control stage to minimize the error between the primary control
input and the required setpoint.
For more information, see section 111.9 “Control Object” on page 4862.

To configure a control stage
1. In WorkStation, in the System Tree pane, select the object that you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Proportional

Select Disabled if you want the control
stage output to be based on integral and
differential control. For more information,
see section 111.9 “Control Object” on
page 4862.

Gain

Enter the gain for the control stage. For
more information, see section 111.9
“Control Object” on page 4862.

Integral time (s)

Enter the integral time for the control
stage. For more information, see section
111.9 “Control Object” on page 4862.

Derivative time (s)

Enter the derivative time for the control
stage. For more information, see section
111.9 “Control Object” on page 4862.

Value

Displays the object value.

Reason

Displays the reason for the quantity, state,
or enumeration contained in the Value
box. For more information, see section
111.2 “Sigma Values and Reasons for
State” on page 4850.

Reason path

Displays the path to the object causing
the current quantity, state, or
enumeration.

5. Click OK.
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111.11

Holiday Schedule
A holiday schedule is used to override time schedules defined in time schedule
during holiday periods. The holiday schedule is stored and actioned in the
controller, so a failure of the communications network does not prevent control of
equipment at the designated times. A holiday schedule is On when during one of its
defined holiday periods, otherwise it is Off.
You can add single dates and date ranges to a holiday schedule. For more
information, see the Calendar Events topic on WebHelp.

Note
You cannot add a calculated date to a Sigma holiday schedule.
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111.12

Optimizer
Optimizers are set up to enable minimum use of energy to control building
temperatures. Optimizers work by turning heating and cooling systems on and off
at optimal times to maintain comfortable room temperatures when needed, and
also protect the building against extreme temperatures when unoccupied.
In Building Operation, you can configure four different optimizer types:
• Optimizer Heating Linear
• Optimizer Heating Logarithmic
• Optimizer Cooling Linear
• Optimizer Cooling Logarithmic
An optimizer does not control equipment directly, but provides software switching
instructions for digital output, rotation and analog outputs.
In WorkStation, you can force any one of nine optimizer states (enumerations):
• Heating and cooling off (+ Optimum off).
• Heating run-up (+ Run-up).
• Heating occupancy (+ Occupancy A).
• Heating run-down (+ Run-down B).
• High temperature limit protection (+ Temp. LimitA).
• Cooling run-up (- Run-up).
• Cooling occupancy (- Occupancy A).
• Cooling run-down (- Run-down B).
• Low temperature limit protection (- Temp. LimitA).
An optimizer also has a secondary value equal to the number of minutes until the
next predicted switching time. If this is unknown, it assumes the maximum value
(65535 minutes). This value may be read by a programmable object.
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.13

Configuring an Optimizer
You configure an optimizer to set the occupancy temperature limits and the low
temperature protection requirements.
For more information, see section 111.12 “Optimizer” on page 4866.

To configure an optimizer
1. In WorkStation, in the System Tree pane, expand the optimizer that you
want to configure.
2. Select the optimizer type (heating or cooling).
3. On the File menu, click Properties.
4. Click the Basic tab.
5. If you are configuring a heating optimizer (linear or logarithmic), edit the Basic
properties:
Property

Description

Minimum space temperature at
occupancy (°C)

Enter the minimum temperature that must
be attained in the space by the time of
occupancy.

End-of-occupancy low limit (°C)

Enter the minimum temperature permitted
in the space at the end of occupancy.

Plant start temperature (°C)

Enter the temperature at which you want
the heating system to turn on for low
temperature protection.

Plant stop temperature (°C)

Enter the temperature at which you want
low temperature protection to cease.

6. If you are configuring a cooling optimizer (linear or logarithmic), edit the Basic
properties:
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Property

Description

Maximum space temperature at
occupancy (°C)

Enter the maximum temperature
permitted in the space at the start of
occupancy.

End-of-occupancy high limit (°C)

Enter the maximum temperature
permitted in the space at the end of
occupancy.

Plant start temperature (°C)

Enter the temperature at which you want
the heating system to turn on for low
temperature protection.

Plant stop temperature (°C)

Enter the temperature at which you want
low temperature protection to cease.
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7. Click OK.
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111.14

Setpoint Adjust Object
A setpoint adjust object normally works in conjunction with a control object to
modulate the output of a plant, for example valves, boilers and fans. The output
represents the required value of the plant being controlled.
The setpoint adjust output value is the arithmetic sum of up to four input values:
• Primary (setpoint) value: A fixed value according to the states of various
controlling factors. This is the output value if the other, compensation, values
are not selected by the user.
• Secondary compensation: A user-defined variable offset value calculated from
the value of a secondary input.
• Wind compensation: An offset value to correct for wind cooling effect.
• Sun compensation: A negative offset value to correct for solar heating effect.
The resulting, corrected, output value is then used as the reference to the primary
input of the associated control object. The control object, in turn, provides an
output related to the correction required.
In WorkStation, you can adjust the secondary input properties of a setpoint adjust
object, provided that a secondary value object is nominated in Sigma. The
properties of the secondary input in WorkStation relate directly to the SPA
Secondary Value properties in Sigma. For more information, see the Sigma Online
Help.
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.15

Configuring a Setpoint Adjust Object
You configure a setpoint adjust object to force value changes, and if required, to set
up a secondary input.
For more information, see section 111.14 “Setpoint Adjust Object” on page 4869.

To configure a setpoint adjust object
1. In WorkStation, in the System Tree pane, select the setpoint adjust object.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Fixed value

Enter a floating point value, REM or AFLO
to TFLO.

Value (° C)

Click Force and then select the required
digital value.

5. Click OK.
6. If the setpoint adjust object uses a secondary input, expand the setpoint
adjust object and then select the secondary input object.
7. On the File menu, click Properties.
8. Click the Basic tab.
Continued on next page
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9. Edit the Basic properties:
Property

Description

Setpoint value

Enter the setpoint value at Changeover 1.
For more information, see section 111.8
“Sigma Software Objects” on page 4859.

Changeover 1

Enter the secondary input value for
Changeover 1.

Changeover 2

Enter the secondary input value for
Changeover 2.

Ratio 1

Enter the gradient for secondary input
values less than Changeover 2.

Ratio 2

Enter the gradient for secondary input
values between Changeover 1 and
Changeover 2.

Ratio 3

Enter the gradient for secondary input
values greater than Changeover 1.

10. Click OK.
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111.16

Rotation Object
A rotation object enables controlled handling of up to nine digital outputs. The
rotation value represents the number of digital outputs to be switched on.
The rotation value can be determined by a number of factors as follows:
• The value of a control object.
• Whether a time schedule is in its On or Off state.
• The state of an optimizer.
• Whether the load group with which the object is associated should be shed.
• A manual selection to default value.
A rotation object has a secondary value, which is the number of the lead load
group. The rotation object monitors the state of its digital outputs to determine the
total numbers that are on. The action taken depends upon how that total compares
with the rotation value. If the total equals the rotation value no change is made to
current state of the digital outputs. If the total is less than the rotation value, objects
are turned On, starting with the next object in the rotation sequence. If the total
exceeds the rotation value, objects are turned Off, starting with the next object in
the rotation sequence.
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.17

Configuring a Rotation Object
You configure a Rotation object to force a value change and to change the lead
load.
For more information, see section 111.16 “Rotation Object” on page 4872.

To configure a Rotation object
1. In WorkStation, in the System Tree pane, select the object that you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Value

Displays the object value.

Lead load number

Enter the number of the lead load.

5. Click OK.
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111.18

Programmable Object
A programmable object is a means of achieving results that cannot readily be
obtained using other object types. A programmable object does not have a fixed
set function. Instead, it provides customized control functions by use of a
programming language similar to Basic.
The following list shows three examples of general applications:
• Calculations upon object values to provide rapid display of power cost figures,
efficiencies, etc.
• Exotic forms of object control. For example, a programmable object might
provide pump sequencing, enthalpy control, lighting control, chilled water
reset, discharge temperature reset.
• Special monitoring features and generation of reports under a complex
combination of circumstances.
The following three types of programmable objects may be presented in a Sigma
controller object, depending on the program within the object:
• Programmable analog
• Programmable string
• Programmable enumerated
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.19

Configuring a Programmable Object
You configure a programmable object to force value changes.
For more information, see section 111.18 “Programmable Object” on page 4874.

To configure a programmable object
1. In WorkStation, in the System Tree pane, select the programmable object.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Float value

Click Force and then enter the required
float value.

Digital value

Click Force and then select the required
digital value.

5. Click OK.
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111.20

Sigma Time Schedules
A time schedule enables you to create, display and manage events. There are three
types of time schedules:
• Standard: Defines exact on and off time periods for a schedule
• Relative: Defines offsets to be applied to a standard time schedule
• Calendar: Defines calendar periods to which the time schedules in a standard
time schedule apply.
You can add events to Sigma time schedules. For more information, see section
111.21 “Adding an Event to a Sigma Time Schedule” on page 4877.
You can also override a time schedule to be temporarily on or temporarily off, until
the next off or on time respectively. For more information, see section 111.22
“Overriding a Time Schedule” on page 4878.

Note
You cannot configure Sigma Time Schedules from WebStation.
You can enable a time extension for this object in Sigma. For more information, see
section 111.23 “Time Extensions” on page 4879.
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111.21

Adding an Event to a Sigma Time
Schedule
You add an event to a Sigma time schedule to set when the event is to regularly
occur.
For more information, see section 111.20 “Sigma Time Schedules” on page 4876.

To add an event to a Sigma time schedule
1. In WorkStation, in the System Tree pane, select the time schedule that you
want to configure.
2. Click the Basic tab.
3. On the Basic Schedule Editor toolbar, click the New Schedule Event
button

.

4. Select the day of the week on which you want the event to occur.
5. Select All Day if the event is to be on or off all day.
6. In the Start Time column, type a start time for the event.
7. In the End Time column, type an end time for the event.
8. In the Value box, select whether you want the event to be On or Off.
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111.22

Overriding a Time Schedule
You override a time schedule to temporarily change the state of the time schedule.
For more information, see section 111.20 “Sigma Time Schedules” on page 4876.

To override a time schedule
1. In WorkStation, in the System Tree pane, select the time schedule that you
want to override.
2. On the Actions menu, click Temporary On or Temporary Off, as
required.
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111.23

Time Extensions
A time extension extends the duration of the normal running period of an object. In
WorkStation, you can set the time extension to take effect at every (off) switching
time, or once only, at the next (off) switching time. Time extensions can be applied
to analog outputs, digital outputs, optimizers, time schedules, setpoint adjust, and
rotation objects.
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111.24

Editing a Time Extension
You edit a time extension to modify the operation and extension period parameters
contained in certain types of objects.
For more information, see section 111.23 “Time Extensions” on page 4879.

To edit a time extension
1. In WorkStation, in the System Tree pane, expand the object that contains
the time extension that you want to edit.
2. Select the time extension.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Edit the Basic properties:
Property

Description

Operation

Select how often you want the time
extension to occur.
For more information, see section 111.23
“Time Extensions” on page 4879.

Period

Type the time period of the interval
(applies when Every is selected in the
Operation selection).

6. Click OK.
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112.1

Graphics
You can import graphics from the Sigma server. The imported graphics are in the
native TGML format, converted from the original Sigma format (.swc). You can also
create new Building Operation TGML graphics in the Graphics folder. You can
delete imported graphics and those that you have imported. Before importing
graphics, you can impose restrictions on graphics file sizes to prevent delays during
import. Some features of Sigma graphics are not supported after import into
WorkStation.
The Graphics folder is one of three main locations where you can import Sigma
data (in this case, for graphics only). You can monitor the progress of the data
import and set the properties of an associated trace file. You can also re-import
individual graphics at the Graphics folder or any of its subfolders. For more
information, see section 109.5 “Sigma Data Import” on page 4809.
When you initiate a data import, Sigma graphics are converted from the Sigma Web
Control format (.swc) to the TGML format used in Building Operation. The
conversion process operates on all of the (.swc) files contained in the
C:\Sigma\Data\Graphics\Drawings folder and sub-folders on the Sigma server PC.
The conversion process occurs on the Sigma server and the files are converted one
at a time by way of HTTP.

Note
The C:\Sigma\Data\Graphics\Drawings folder is the default folder for .swc
graphics files after initial installation of Sigma. You can change the data path (that
is, the "C:\Sigma\Data" part) after running SetupSvr.exe at the Sigma server.
When you import Sigma graphics, the conversion to TGML can cause some Sigma
graphics to become very large and therefore take a long time to convert. This may
cause the data importer to display a conversion failure message. However, before
importing graphics, you can restrict the data import content to files below a
specified size, and prevent the import of larger files. The default file size limit is set at
50MB, but you can change this limit in the Graphics folder properties. You should
also consider reducing the file size of larger images used by Sigma graphics to keep
the import process to a reasonable time. For more information, see section 117.64
“Graphics Folder Properties – Basic Tab” on page 5041.
For more information, see section 171.3 “Data Importer Conversion Failed
Messages” on page 5733.
When you have imported the Sigma graphics, you should then make any further
graphics changes using the TGML Graphics editor. For more information, see
section 34.1 “TGML Overview” on page 1015.
A summary of the level of support of Sigma graphics features is contained in the
following table:
Table: Sigma Graphics Support in Building Operation
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Feature

Feature Type

Support

Alarm

Command

Non-critical alarms on text
shape have flashing
red/black text instead of
steady black text with a
flashing black border.
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Feature

Feature Type

Support

Angle

Command

Full support.

Animate

Command

Can cause very large TGML
files. Could be enhanced to
re-size. Built-in animations
are not supported (except for
Spin).

Avi

Command

No support planned.

Bar

Command

Full support.

Bitmap

Command

Full support.

Chain

Command

Full support.

Color

Command

Full support.

Condition

Command

Full support.

Feedback

Command

Full support.

Menu

Command

If the Menu command is
present (or any other
command using an object),
the standard Building
Operation context menu
appears on a mouse rightclick. There is no control over
which items appear and
there is no way to disable the
menu.

Name

Command

When the data importer is
used to import graphics, the
Sigma name string is used
for the description of the
graphic object.

Picture

Command

Full support.

Piecewise

Command

Full support.

Scale/Label/Move

Command

Full support.
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Continued
Feature

Feature Type

Support

SetValue

Command

A SetValue command with
temp on/off, alarm
enable/disable, or dialog
option results in the default
mini Building Operation
property page appearing on
a left click and the command
menu on a right click.
The property page can
change the value.
The context menu has the
alarm enable/disable and
temp on/off options.
The range of values is not
supported.

Slider

Command

Transparent shapes are filled
with the background color.

Spin

Command

Full support.

Text

Command

Full support.

Arc

Shape

Full support.

Ellipse

Shape

Full support.

Horizontal/Vertical Line

Shape

Full support.

Line

Shape

Simple lines in Building
Operation do not have
rounded ends, but are
squared off.

Polygon

Shape

Full support.

Rectangle

Shape

Full support.

Round Rectangle

Shape

Full support.

Text

Shape

Full support.

Font

Right Click

TGML does not support both
underscore and strikethrough. If both are specified,
only strike-through is
displayed.

Line Styles

Right Click

Full support.

Name (of Shape)

Right Click

Shapes with no user-defined
name are given a generated
name to assist with error
reporting.
Continued on next page
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Continued
Feature

Feature Type

Support

Shape Fill

Right Click

Pattern fills are replaced with
gradient fills (no support
available in TGML for pattern
fills).

Label

Right Click

Full support.

Associations (Primary Value,
Secondary Value, and RFS)

N/A

Primary, Secondary, RFS,
Mnemonic and Alarm State,
Primary Text, Secondary
Text and RFS Text are all
supported as bindings.
Alarm status has limited
support.

Note
The background color of imported Sigma graphics does not print correctly in
Building Operation and always prints as white, regardless of original color.
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112.2

Configuring the Graphics Folder
You configure the Graphics folder to view the path of the trace file, and to determine
the maximum size of any graphic held within the Graphics folder.
For more information, see section 112.1 “Graphics” on page 4883.

Note
This procedure refers to the main Graphics folder that is created when you create
a Sigma Interface, not graphics subfolders that you may subsequently create.

To configure the Graphics folder
1. In WorkStation, in the System Tree pane, expand the Sigma Interface and
click the Graphics folder.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Trace file

Displays the path to the trace file.

File size limit (MB)

Enter the maximum size of any converted
graphics file during a graphics import.

5. Click OK.
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113.1

Log Sets
A Log Set is a log configuration that contains one or more Sigma objects selected
for historical logging. Log sets may be set up in Sigma and imported into a special
folder (Log Sets) in the Sigma Interface, but you can also create new log sets (and
delete them) in the same folder. You can send and retrieve log sets to and from
Sigma controllers.
The Log Sets folder is one of three main locations where you can import Sigma data
(in this case, for log sets only). You can monitor the progress of the data import and
set the properties of an associated trace file. For more information, see section
109.5 “Sigma Data Import” on page 4809.
A log set comprises one or more logs, and a folder that contains one extended
trend log for (and associated with) each log. Logs and their associated extended
trend logs are automatically created (or modified) whenever you import log sets.
However, if you create a new log set in WorkStation, the new log set folder contains
only an empty Extended Trend Logs folder, and you must then create one or more
logs and the same number of extended trend logs. You then manually associate
each log with the corresponding extended trend log. You can then download the
log sets to the relevant Sigma controller.
When you create or amend a log set in WorkStation, you must send the log set (that
is, the log configuration) to the relevant controllers. However, the Sigma system
setup is obviously not affected. You can retrieve the values logged in the controller
as a result of sending the log set, and you can view the values in a trend log chart or
trend log list in WorkStation.
You can delete log sets imported from a Sigma controller as well as log sets that
you create in WorkStation (but you cannot delete the main Log Sets folder in which
you create or import log sets). However, if you want to delete just a single log from
within a log set, you must first delete the associated extended trend log.

Important
Use Sigma logging (Log Sets) rather than the native trend log facility in Building
Operation, for the following reasons:
• Native trend logs use subscriptions. This reduces the number of
subscriptions available for the display of graphics or the number of objects
than can be displayed in the Watch window. Each controller supports a
limited number of subscriptions (approximately 200).
• Native logging ceases when the Enterprise Server is shut down (Sigma
logging is done within the controller, therefore logging is maintained if the
Enterprise Server is down).
• A controller sends all changes of a subscribed value to the Enterprise Server.
If a value changes frequently but the associated trend log period is much less
frequent, many values are sent unnecessarily, wasting resources.

Tip
When you create a log set in Building Operation, the next available log set number
is automatically allocated to the log set. However, this information is not passed
back to the Sigma server, and if you then wish to add further log configurations in
Sigma, you must be careful to use log configuration numbers that do not conflict
with those in Building Operation (if you do, an error message informs you that an
overwrite will occur during import). Furthermore, it is possible to create duplicate
Continued on next page
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log objects in Building Operation when configuring log sets in both Building
Operation and Sigma. For these reasons, it is recommended that you do all of
your log set configuration in Building Operation after the initial data import to the
Log Set folder.

113.1.1

Log Set Types and Configuration
There are two log set types. Each type enables you to determine when data is
logged:
• Change of value log set: data is logged when the object value changes by a
specified tolerance (configurable).
• Interval log set: data is logged at timed intervals (configurable).
You can configure the following advanced features of all log sets:
• The type of log storage and what action needs to be taken if logging fails.
• A period of log activation.
• Whether logging is controlled by a cross-reference object and the action to be
taken if the cross-reference object is unavailable.

113.1.2

Logs
For each log, you can set the number of values to be logged, and the path to the
logged variable.

113.1.3

Log Set Workflow
The log set workflow enables you to set up a log set in Building Operation.
For more information, see section 113.2 “Log Set Workflow” on page 4893.
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113.2

Log Set Workflow
The log set workflow enables you to set up a log set in Building Operation.
The following flowchart describes the basic steps required to create and configure a
log set. Related information can be found in the sections after the flowchart.

Figure: Log Set Workflow

Create and configure log set
Create and configure a log set. For more information, see section 113.4 “Creating a
Log Set” on page 4896.

Create and configure log
Create and configure a log. For more information, see section 113.6 “Creating a
Log” on page 4899.

Create and configure extended trend log
Create and configure an extended trend log. For more information, see the Creating
an Extended Trend Log topic on WebHelp.

Associate log with extended trend log
Associate the log with an extended trend log log. For more information, see section
113.8 “Associating a Log with an Extended Trend Log” on page 4901.
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Send log set to controller
Send the log set to the Sigma controller. For more information, see section 113.9
“Sending Log Sets and Retrieving Logged Values” on page 4902.
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113.3

Configuring the Log Sets Folder
You configure the Log Sets folder to select the trace type, and to view the trace file
path.
For more information, see section 113.1 “Log Sets” on page 4891.

To configure the Log Sets folder
1. In WorkStation, in the System Tree pane, select the Log Sets folder.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Trace file

Displays the path to the trace file.

Trace

Select Detailed if you want to ensure
that the detailed version of the log sets
trace file is generated on data import.

5. Click OK.

04-16006-04-en, March 2015

Technical
4897

113 Sigma Logging
113.4 Creating a Log Set

113.4

Creating a Log Set
You create a log set to log one or more Sigma objects in Building Operation.
For more information, see section 113.1 “Log Sets” on page 4891.

To create a log set
1. In WorkStation, in the System Tree pane, select the Log Sets folder.
2. On the File menu, point to New and then select the type of log set you
require.
3. In the Name box, type a name for the log set.

4. In the Description box, type a description for the log set.
5. Click Create.
You now configure the log set.
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113.5

Configuring a Log Set
You configure a log set to apply parameters relevant to the log set type.
For more information, see section 113.1 “Log Sets” on page 4891.

To configure a log set
1. In WorkStation, in the System Tree pane, select the log set that you want to
configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Log value

Select Secondary if you want to log the
secondary value.

Tolerance

Enter the amount by which the object
value must vary before the value is
logged.

Interval unit

Select the units for the log set interval.

Interval time

Enter the log set interval time.

Interval offset (s)

Enter the log set interval offset (in
seconds).

5. Click the Advanced tab.
Continued on next page
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6. Edit the advanced properties:
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Property

Description

Log storage type

Select the method of log storage.

When log space is full

Select Circular storage if you want the
oldest logged data to be overwritten
when the controller data buffer is full.

Log priority number

Enter the log priority number.

Log deferred

Select True if you want the log set to be
deferred.

Activation period enabled

Select True if you want the log set to be
activated between two selected dates
only.

Activation start time

Select the activation start time (start time
is applicable only if an activation period is
enabled).

Activation stop time

Select the activation stop time (stop time
is applicable only if an activation period is
enabled).

Log control object

Enter the path to the cross-reference
object that controls when logging is to
occur.

Log control reversed

Select True if you require the value of the
cross-reference object to be reversed.

Action on unavailable

Select Stop if you require logging to stop
when the cross-reference object is not
available.
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113.6

Creating a Log
You create a log to log a Sigma object in Building Operation.
For more information, see section 113.1 “Log Sets” on page 4891.

To create a log
1. In WorkStation, in the System Tree pane, expand the Log Sets folder.
2. Select the log set folder where you want to create the log.
3. On the File menu, point to New and then click Log.
4. In the Name box, type a name for the log.

5. In the Description box, type a description for the log.
6. Click Create.
You now configure the log.
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113.7

Configuring a Log
You configure a log to change the number of log samples, or to select the logged
object.
For more information, see section 113.1 “Log Sets” on page 4891.

To configure a log
1. In WorkStation, in the System Tree pane, expand your Sigma interface.
2. In the Log Sets folder, select the log.
3. On the File menu, click Properties.
4. Click the Basic tab.
5. Edit the Basic properties:
Property

Description

Number of values

Enter the number of logged values you
want the extracted data to contain.

Logged variable

Enter the path to the logged object.

6. Click OK.

Technical
4902

04-16006-04-en, March 2015

113 Sigma Logging
113.8 Associating a Log with an Extended Trend Log

113.8

Associating a Log with an Extended
Trend Log
You associate a Sigma log with an extended trend log to enable the extended trend
log to store records of the Sigma log.
For more information, see section 113.1 “Log Sets” on page 4891.

To associate a log with an extended trend log
1. In WorkStation, in the System Tree pane, expand the Log Sets folder.
2. In the relevant log set, select the extended trend log where you want to create
the association.
3. On the File menu, click Properties.
4. In the Monitored trend log box, enter the path to the Sigma log.

5. Click OK.
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113.9

Sending Log Sets and Retrieving
Logged Values
You send log sets to transfer log configurations that you have created in
WorkStation to the relevant Sigma controllers.
You retrieve logged values so you can display the values of the log(s) that you
configured in WorkStation.
For more information, see section 113.1 “Log Sets” on page 4891.

To send log sets or retrieve logged values
1. In WorkStation, in the System Tree pane, expand the Sigma Interface.
2. Expand the Log Sets folder and then select a log set that you created in
WorkStation.
3. On the Actions menu, select either Send log set or Retrieve logged
values as appropriate.
You can now view any retrieved log values in either a new trend log list or in a new
trend log chart.
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113.10

Contingency Logs
Contingency logging provides an instant recent history of Sigma objects. No Sigma
pre-configuration is required, although you can modify the default contingency
logging settings of an object in Sigma. In WorkStation, you can modify the default
contingency logging settings within the contingency log associated with each
imported Sigma object. By default, all Sigma objects (except optimizer and standby
generator) are enabled for contingency logging.
In WorkStation, you can view the contingency log chart and a contingency log list
for any object that is enabled for contingency logging. A contingency log chart is a
special trend chart that displays a fixed number of previous log samples, and has a
one hour visible time span (instead of an infinite number of samples and a five
minute visible time span for an ordinary trend chart). For example, an object has a
log size of 221 and an interval of 900 seconds. The contingency log chart of the
object displays the value of each of the 221 samples, going backwards in time,
starting from the time at which the contingency log chart started. Because the
interval between samples is 900 seconds, the total time span of the contingency log
chart x-axis is 221 x 900 seconds (55.25 hours). Similarly, the associated
contingency log list displays the time stamp and value of the same 221 samples (in
tabular format) over the same time period.
For more information, see section 113.11 “Viewing a Contingency Log Chart or
List” on page 4904.

04-16006-04-en, March 2015

Technical
4905

113 Sigma Logging
113.11 Viewing a Contingency Log Chart or List

113.11

Viewing a Contingency Log Chart or List
You view a contingency log chart or list to observe the recent history of a Sigma
object.
For more information, see section 113.10 “Contingency Logs” on page 4903.

To view a contingency log chart or list
1. In WorkStation, in the System Tree pane, select a Sigma object.
2. On the Actions menu, select View and then click Contingency log chart
or Contingency log list.
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113.12

Configuring a Contingency Log
You configure a contingency log to enable or disable logging or to change the log
sample settings.
For more information, see section 113.10 “Contingency Logs” on page 4903.

To configure a contingency log
1. In WorkStation, in the System Tree pane, select the contingency log that you
want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Logging

Select Enabled to enable contingency
logging for the object selected.

Log size

Enter the log size (number of log samples)
required.

Interval (s)

Enter the interval required between log
samples.

5. Click OK.
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114.1

Sigma Text Reports
Sigma text reports contain information relating to objects within Sigma controllers.
A Sigma Interface in the System Tree pane contains four built-in text reports. You
cannot create additional instances of the built-in text reports (nor delete the built-in
reports).
Three additional text reports (in the Diagnostics folder) enable you to extract
diagnostics data relating to Log Set and Node Statistics, and Controller time.

114.1.1

Sigma Active Alarms Report
A Sigma Active Alarms text report displays information from Sigma objects that are
in the active state.
For more information, see section 128.9 “Sigma Active Alarms Report” on page
5336.

114.1.2

Sigma Hours Run Report
A Sigma Hours Run text report provides information from Sigma objects that hold
hours totalization values.
For more information, see section 128.10 “Sigma Hours Run Report” on page
5337.

114.1.3

Sigma Plant Review Report
A Sigma Plant Review text report displays Sigma object condition information.
For more information, see section 128.11 “Sigma Plant Review Report” on page
5338.

114.1.4

Sigma Report Text Report
A Sigma Report text report displays property information from Sigma objects.
For more information, see section 128.12 “Sigma Report Text Report” on page
5340.

114.1.5

Sigma Diagnostics Text Reports
Sigma diagnostics text reports enable you to display diagnostics information from
one or more Sigma controllers. Three built-in diagnostics text reports are available.
For more information, see section 128.13 “Sigma Diagnostics Text Reports” on
page 5342.
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114.2

Sigma Active Alarms Report
A Sigma Active Alarms text report displays information from Sigma objects that are
in the active state.
You can generate a Sigma Active Alarms report by dragging any of the following
objects from the System Tree pane into the Sigma Active Alarms Report view:
• Sigma Interface
• Controllers folder
• Sigma controller
• Segments or subsegment folder
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
In this System Tree pane example, three Sigma objects within controller 109 are in
the active alarm state:

Figure: Three Active Alarms in controller 109

The corresponding report displays the three active alarms:

Figure: Active Alarms report for controller 109
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114.3

Sigma Hours Run Report
A Sigma Hours Run text report provides information from Sigma objects that hold
hours totalization values.
You can generate a Sigma Hours Run report by dragging objects that contain
totalization values into the Sigma Hours Run report. You can drag the following
object types:
• Sigma Interface
• Controllers folder
• Sigma controller
• Segments or sub-segment folder
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
In the following text report example, object 0026 has a totalization value of 65,313
(in addition to other relevant properties):

Figure: Sigma Hours Run report on an analog input

The totalization value in the report relates to the value displayed in the Totalization
value property of the object dialog box:

Figure: Analog object Totalization value
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114.4

Sigma Plant Review Report
A Sigma Plant Review text report displays Sigma object condition information.
The plant review report displays all objects that exhibit any of the following
conditions, and all conditions that apply:
• ALM: Alarm
• HRA: Totalization (hours run) alarm
• MAN: Manual mode
• MAH: Manual alarm inhibit
• PCS: Precancelled totalization (service interval) alarm
• TE: Time extension
• SPO: Scan priority=0
• DEF: Object returning default value
• SAI: Optimizer with self-adaption inhibited
You can generate a Sigma Plant Review report by dragging any of the following
objects from the System Tree pane into the Sigma Plant Review report view:
• Sigma Interface
• Controllers folder
• Sigma controller
• Segments or subsegment folder
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
For example, controller 853 includes three rotation objects, each with a time
extension:
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Figure: Rotation objects with time extensions

The plant review report for controller 853 contains just the three rotation objects,
each displaying the Time Extension (TE) condition:

Figure: Plant Review report for controller 853
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114.5

Sigma Report Text Report
A Sigma Report text report displays property information from Sigma objects.
You can generate a report by dragging Sigma objects into the report view. You can
drag objects at Sigma object level and above. The properties displayed for each
object depend on the configuration in the Sigma controller. Some, but not
necessarily all object properties, are displayed in the report.
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
In the example shown below, object 39 includes an Alarm 1 Window and an Alarm
2 Window:

Figure: Sigma object containing alarm windows

The following figure is the Sigma Report text report for object 0039:

Figure: Sigma Report text report for a single Sigma object

The properties displayed relate to the properties dialog boxes for the Sigma object
and the two associated alarms. The object dialog box contains the alarm status,
object value, and the reason for the value, as shown in the report.
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Figure: Sigma object status information

The dialog boxes for the Alarm 1 and Alarm 2 windows display the configuration
settings and the alarm priority contained in the report.

Figure: Alarm configuration settings for Alarm 1 Window in object 0039

Figure: Alarm configuration settings for Alarm 2 Window in object 0039
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114.6

Sigma Diagnostics Text Reports
Sigma diagnostics text reports enable you to display diagnostics information from
one or more Sigma controllers. Three built-in diagnostics text reports are available.
You can access Sigma diagnostics text reports from any Sigma controller object or
from the Sigma Text Reports folder.

114.6.1

Sigma Diagnostics Controller Time Report
The Diagnostics Controller Time report displays the instantaneous time and date
values within one or more Sigma controllers. You generate the report by dragging
an individual controller into the report view, or by dragging the controllers folder if
you want the time and date for all controllers to be displayed. The following example
report displays the values in controller 109:

Figure: Diagnostics Controller Time report for controller 109

114.6.2

Sigma Diagnostics Log Set Statistics Report
The Diagnostics Log Set Statistics report displays the log set values within one or
more Sigma controllers. The following example is a text report for controller 853:

Figure: Diagnostics Log Set Statistics report for controller 853

The log set parameters in the text report correspond directly to the basic Log Set
Statistics properties:
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Figure: Log Set Statistics basic properties

114.6.3

Sigma Diagnostics Node Statistics Report
The Diagnostics Node Statistics report displays the values within one or more
Sigma controllers. The following example report displays the values in controller
109:

Figure: Diagnostics Node Statistics report for controlller 109

The parameters in the Diagnostics Node Statistics report correspond to the
properties displayed in the Node Statistics properties tabs.
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Figure: Node Statistics properties tabs
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114.7

Creating a Sigma Diagnostics Text
Report
You create a Sigma diagnostics text report to view a textual representation of a
controller's diagnostic properties.
For more information, see section 128.13 “Sigma Diagnostics Text Reports” on
page 5342.

To create a Sigma diagnostics text report
1. In WorkStation, in the System Tree pane, select the Sigma controller where
you want to create the text report.
2. On the Actions menu, point to Sigma diagnostics and then click
Diagnostic reports.
3. Select the diagnostic report type.

You can now view the Sigma diagnostics text report, containing the relevant
controller diagnostics information.
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115.1

Global Values
A global value enables you to write a value in a Sigma controller object to another
Building Operation object, or to write a Building Operation object value into an
object in a Sigma controller. For example, you might want to reuse the value from
an outside air temperature sensor (connected to a Sigma controller) in an object in a
different Building Operation interface such as Modbus. Reusing Sigma values in
other Building Operation objects is known as Globals from Sigma. Similarly, reusing
external Building Operation values in Sigma objects is known as Globals to Sigma.
You enable the transfer of global values by setting up a global protocol that
provides the communications mechanism for the transfer of global values between
Building Operation and Sigma controllers. First you create a virtual device in
Building Operation, and then you create virtual analog or digital global values (to
carry the object value) within the virtual device.
Global values communicate with Sigma controllers using broadcast addresses on
the private IP network.

Important
Although it is possible, to do so, do not use ordinary Building Operation bindings
to connect values between Sigma global objects and other Building Operation
objects, for the following reasons:
• Creating an ordinary Building Operation binding creates an additional,
unnecessary subscription binding that is wasteful of network and controller
resources. By creating a global value, you use a global protocol, which is far
more efficient.
• A Sigma controller is limited in the number of subscriptions it can handle.
Using a global value reduces the chance of the controller subscription limit
being exceeded.
• If you attempt to connect Building Operation values to Sigma values using
ordinary Building Operation bindings, this will not work because the Sigma
values are read only.
You can create the following types of global values in a global values device:
• Virtual analog input
• Virtual analog output
• Virtual digital input
• Virtual digital output

115.1.1

Global Values in Sigma
In Sigma, you create a global value by specifying the UNC and object number of the
required value in the properties of an object in the controller where the value is
required to be reused. In the following example, the outside air temperature value in
the analog input in Controller 24 is being reused by optimizers in Controller 46 and
Controller 58.
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Figure: Sigma global value reused multiple times in Sigma

115.1.2

Global Values from Sigma
You can reuse global values that already exist in Sigma by extending their values to
other Building Operation objects.
For more information, see section 115.2 “Global Values from Sigma” on page 4925.

115.1.3

Global Values to Sigma
You can reuse global values that are external to Sigma (for example, a MicroNet
object, or a generic Building Operation object) to transfer a value to Sigma.
For more information, see section 115.3 “Global Values to Sigma” on page 4927.

115.1.4

Global Values Workflows
The global values workflows enable you to set up global values from Sigma and
global values to Sigma.
For more information, see section 115.4 “Global Values Workflows” on page 4929.
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115.2

Global Values from Sigma
You can reuse global values that already exist in Sigma by extending their values to
other Building Operation objects.
The following figure shows an outside air temperature value in Sigma being reused
in a MicroNet controller. In the Sigma Interface, you use an imported Sigma object
(in this case, an analog input) as the Sigma global value. You then create a virtual
analog output, and bind it two ways, firstly by using a reference to the Sigma global
value, secondly by creating a normal binding to the Building Operation object (in this
case, a MicroNet object). In this way, the Sigma global value is transferred to the
MicroNet object.

Figure: Global value from Sigma reused in MicroNet

The next figure represents the above example in the System Tree pane.
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Figure: Global value from Sigma reused in MicroNet (System Tree pane representation)
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115.3

Global Values to Sigma
You can reuse global values that are external to Sigma (for example, a MicroNet
object, or a generic Building Operation object) to transfer a value to Sigma.
In the following diagram, an imported MicroNet analog input is bound to a virtual
analog input global value in the Sigma Interface. Only one binding is required
(between the MicroNet object and the virtual Sigma object). However, when using
Globals to Sigma, you must also edit all Sigma objects that require the global value
and ensure that they cross-refer to the device number and object number of the
virtual object. In this case, two different optimizers each cross-refer to the virtual
controller (device number 9007) and its global value object number (23).

Figure: Global value from MicroNet reused in Sigma controllers

Note
To avoid conflict with any other Enterprise Server that might be on the same
private network, do not use the default value of 9000 for the virtual controller
device number.
The next figure represents the above example in the System Tree pane.

04-16006-04-en, March 2015

Technical
4929

115 Global Values
115.3 Global Values to Sigma

Figure: Global value from MicroNet reused in Sigma controller (System Tree pane
representation)

Technical
4930

04-16006-04-en, March 2015

115 Global Values
115.4 Global Values Workflows

115.4

Global Values Workflows
The global values workflows enable you to set up global values from Sigma and
global values to Sigma.

115.4.1

Global Values from Sigma
Use the following flowchart to connect a global value from Sigma to a non-Sigma
object. Related information can be found in the sections after the flowchart.

Figure: Global Value from Sigma workflow

Create and configure virtual device
Create a Global Values (virtual) device in the Controllers folder. Configure the device
number. For more information, see section 115.5 “Creating a Global Values Device”
on page 4932.

Create and configure virtual global value (AO or DO)
Create an analog output global value (or a digital output global value as appropriate)
in the global values device. For more information, see section 115.7 “Creating a
Global Value” on page 4934.
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Create reference from virtual global value to Sigma global object
Create a reference from the virtual global value to the Sigma global object that you
want to reuse. For more information, see section 115.8 “Configuring a Global Value”
on page 4936.

Bind virtual global value to non-Sigma object
Create a bind between the virtual global value and the non-Sigma object. For more
information, see section 15.3 “Binding Values Manually” on page 416.

Check that values match
Check that the value of the non-Sigma object matches that of the Sigma global
object (in Sigma).

115.4.2

Global Values to Sigma
Use the following flowchart to connect a non-Sigma object to one or more Sigma
objects. Related information can be found in the sections after the flowchart.

Figure: Global Value to Sigma workflow
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Create and configure virtual device
Create a Global Values (virtual) device in the Controllers folder. Configure the device
number. For more information, see section 115.5 “Creating a Global Values Device”
on page 4932.

Create and configure virtual global value
Create an analog input global value (or a digital input global value as appropriate) in
the global values device. Configure the object number. For more information, see
section 115.7 “Creating a Global Value” on page 4934.

Bind virtual global value to non-Sigma object
Create a bind between the virtual global value and the non-Sigma object that you
want to reuse. For more information, see section 15.3 “Binding Values Manually” on
page 416.

Refer (in Sigma) to virtual global value from relevant objects
In Sigma, ensure that the objects that you want to receive the Sigma global value
contain cross-references to the controller and object number of the virtual global
value.

Check that values match
In Sigma, check that the values of any relevant Sigma objects match that of the
non-Sigma object.
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115.5

Creating a Global Values Device
You create a global values device to provide a container for global values.
For more information, see section 115.1 “Global Values” on page 4923.

To create a global values device
1. In WorkStation, in the System Tree pane, select the Sigma Interface and
then select the Controllers folder.
2. On the File menu, point to New and then click Global Values.

3. In the Name box, type a name for the global values device.
4. In the Description box, type a description for the global values device.
5. Click Create.
You now configure the global values device.
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115.6

Configuring a Global Values Device
You configure a global values device to identify the device to the Sigma interface.
For more information, see section 115.3 “Global Values to Sigma” on page 4927.

To configure a global values device
1. In WorkStation, in the System Tree pane, select the global values device that
you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Device number

Enter the device number. For more
information, see section 115.3 “Global
Values to Sigma” on page 4927.

5. Click OK.
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115.7

Creating a Global Value
You create a global value to provide a virtual link that transfers a value between a
Sigma object and a Building Operation object.
For more information, see section 115.1 “Global Values” on page 4923.

To create a global value
1. In WorkStation, in the System Tree pane, select the Sigma Interface and
then expand the Controllers folder.
2. Select the Global Values device.
3. On the File menu, point to New and then select an analog or digital input (or
output).

4. In the Name box, type a name for the global value.
5. In the Description box, type a description for the global value.
Continued on next page
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6. Click Next (applies only to analog or digital inputs).

7. Select an object number for the global analog input or digital input global
value.
8. Click Create.
You now configure the global value.
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115.8

Configuring a Global Value
You configure a global value to change its values and the object number.
For more information, see section 115.1 “Global Values” on page 4923.

To configure a global value
1. In WorkStation, in the System Tree pane, select the global value that you
want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the Basic properties:
Property

Description

Value

Displays the global value of the source
object when a binding is present. Do not
enter a value before binding (the value will
be overwritten by the binding).

Secondary Value

Displays the global secondary value of the
source object when a binding is present.
Do not enter a value before binding (the
value will be overwritten by the binding).

Sigma Reference Object

Enter the path of the Sigma object from
which you want data to be obtained. The
values of the referenced object fill the
Value and any Secondary Value
property fields for output global values.
This property is not applicable to analog
and digital input values.

5. Click OK.
6. Edit the Advanced properties (analog and digital input global values only):
Property

Description

Object number

Enter the unique object number.

7. Click OK.
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116.1

Alarms
Building Operation supports alarms contained within imported Sigma objects. The
properties for most Sigma alarms are derived from the configurations selected in
the Alarms card (or Alarms 1 and Alarms 2 cards) for objects in the Sigma Object
Editor. You can configure some of these properties in Building Operation
(depending on object type) - the properties of all alarmed Sigma objects are
available to view or configure as child objects of the associated alarmed Sigma
object. If routed to the Enterprise Server, Sigma alarms are displayed (when active)
in the Alarms pane, and can be managed (with restrictions) like other Building
Operation alarms. Additionally, you can apply alarm specific manual overrides on
alarmed Sigma objects, for example alarm enable, and edit alarm.

116.1.1

Alarm Types
The following table shows the possible Sigma alarm types in Building Operation,
and the objects with which they are associated.
Table: Sigma Alarm Types in Building Operation
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Alarm Type

Associated Object Types

Alarm 1 High Limit

Analog input, calculation

Alarm 1 Low Limit

Analog input, calculation

Alarm 1 Window

Analog input, calculation

Alarm 1 Cross-reference

Analog input, calculation

Alarm 2 High Limit

Analog input, calculation

Alarm 2 Low Limit

Analog input, calculation

Alarm 2 Window

Analog input, calculation

Alarm 2 Cross-reference

Analog input, calculation

Alarm Cross-reference

Digital input

Alarm Open Closed

Digital input

Hardware Alarm

Analog input

Meter Alarm

Meter

Programmable Alarm

Programmable

Pulse Alarm

Pulse

Totalization & Alarm

Analog input and calculation (limit alarms).
Digital input and digital output (hours run
alarms).
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Alarm Type

116.1.2

Associated Object Types

Alarm Creation and Acknowledgement
You can create a Building Operation alarm for a non-alarmed Sigma object, as you
would for any other object type. However, a Building Operation alarm is not
displayed as a child of a Sigma object, but as a separate alarm object in the System
Tree pane. You can change the type of acknowledgement for Building Operation
alarms, depending on your requirements. For more information, see the
Acknowledgement topic on WebHelp.
You can acknowledge Sigma alarms as you would acknowledge ordinary Building
Operation alarms. However, for imported Sigma objects, you are restricted to the
acknowledgement type that you set up in Sigma (Configure - Controls in the Sigma
Alarm Manager). You cannot change the acknowledgement setting in Building
Operation. For more information, see section 117.55 “Alarm Properties – Alarm
Tab” on page 5032.

116.1.3

Routing of Alarms
Prior to Sigma integration to Building Operation, all Sigma alarms are routed by way
of Routesets to the Sigma Server. Before importing controller data to the Enterprise
Server, you can configure the Sigma Routesets (in Sigma) so that alarms are also
routed to the Enterprise Server. If you only wish to import data from one or more
(but not all) controllers, you can configure the Sigma Interface to discard all alarms
that originate in controllers that are not included in the partial data import. For more
information, see section 117.2 “Sigma Interface Properties – Advanced Tab” on
page 4953.

116.1.4

Alarm Enable, Inhibit, and Edit
You can enable, inhibit or edit certain Sigma alarms for a selected object.
For more information, see section 116.3 “Enabling or Inhibiting an Alarm” on page
4945.
For more information, see section 116.2 “Configuring a Sigma Alarm” on page
4943.

116.1.5

Audible Alarm Warnings
Building Operation supports audible warnings for imported Sigma alarms. The
audible alarm warning is set up in Sigma (in the Beep Priorities section of the Sigma
Alarm Manager). However, you cannot choose whether to enable or disable the
audible alarm warning in Building Operation. For more information, see section
117.55 “Alarm Properties – Alarm Tab” on page 5032.
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116.1.6

Precancellation and Cancellation of Hours
Limit Alarms
For Totalization alarms, you can prevent any of the totalization hours limit alarms
from occurring before the hours total limit for the alarm is reached (and later
reinstate the limit alarm, if required). You can also cancel a limit alarm permanently.
The limit alarms referred to are configured in the Totalization card of the digital input
and digital output objects (in Sigma). However, there is no feedback from Building
Operation when you make any of these cancel or precancel manual overrides
(whereas the Sigma system provides feedback for manual overrides). For more
information, see section 116.4 “Precancelling or Cancelling an Hours Limit Alarm”
on page 4946.

116.1.7

Alarm Status
The general alarm status of any imported Sigma object is displayed in the object's
properties. The general alarm status is affected by the status of any alarms that are
contained within the object. In the following example, a digital input (configured with
an Open-Closed alarm in Sigma) is displayed in the System Tree pane with the
alarm contained within the digital input:

Figure: Alarm within a digital input

In this example, the alarm is active, as shown in the Alarm status property of the
alarm:

Figure: Alarm status of an alarm

The value of the Alarm status property affects the general alarm status of the object
(also active in this example):
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Figure: General alarm status

The following alarm status types are possible (but are read only):
• N – Inactive
• * - Active
• M - Manual inhibit
• T - Transient inhibit
• I - Inhibit
• Not configured
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116.2

Configuring a Sigma Alarm
You configure a Sigma alarm to set the triggering criteria, and the alarm priority.
For more information, see section 116.1 “Alarms” on page 4939.

To configure a Sigma alarm
1. In WorkStation, in the System Tree pane, expand the alarmed object, then
click the Sigma alarm that you want to configure.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Property

Description

Alarm status

Displays the status of the alarm. For more
information, see section 116.1 “Alarms”
on page 4939.

Totalization value

Displays the value of the totalized object
(AI and CAL).

Totalization value (h)

Displays the run time in hours (DO and
DI).

Low limit

Enter the lowest value the monitored
variable can decrease to before the alarm
is triggered.

High limit

Enter the highest value the monitored
variable can increase to before the alarm
is triggered.

Priority

Select the priority for the alarm configured
for this object.

Limit 1

Displays the first hours run totalization
limit.

Limit 2

Displays the second hours run totalization
limit.

Limit 3

Displays the third hours run totalization
limit.

Reset

Displays the totalization limit reset value.

5. Click the Advanced tab.
Continued on next page
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6. Edit the advanced properties:
Property

Description

Hysteresis

Enter the hysteresis value for this alarm.

Alarm transient time

Select the length of time the object must
be in alarm condition before the alarm is
activated.

Clear transient time

Select the length of time the object must
be out of alarm condition before the alarm
is cleared.

7. Click OK.
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116.3

Enabling or Inhibiting an Alarm
You enable an alarm to ensure that the alarm displays in the Alarms pane when
active. You inhibit an alarm to prevent the alarm from displaying in the Alarms pane
when active.
For more information, see section 116.1 “Alarms” on page 4939.

Enabling or inhibiting an alarm
1. In WorkStation, in the System Tree pane, expand your Sigma Interface.
2. Select the alarmed object.
3. On the Actions menu, select either Alarm enable or Alarm inhibit as
appropriate.
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116.4

Precancelling or Cancelling an Hours
Limit Alarm
You precancel an hours limit alarm to ensure that the alarm does not display when
the hours totalization limit is reached. You reinstate the hours limit alarm to reverse a
precancellation. You cancel an hours limit alarm to ensure that the hours limit alarm
never displays.
For more information, see section 116.1 “Alarms” on page 4939.

Precancelling or cancelling an hours limit alarm
1. In WorkStation, in the System Tree pane, expand your Sigma interface.
2. Expand the digital input or digital output and then click Totalization &
Alarm.
3. On the Actions menu, click Hours Precancel limit for Limit 1, 2, or 3, as
required. Alternatively, click Hours cancel limit for Limit 1, 2, or 3, as
required.
4. To reinstate a precancelled alarm, on the Actions menu, click Hours
reinstate limit for Limit 1, 2, or 3, as required.
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117.1

Sigma Interface Properties – Basic Tab
Use the Basic tab to edit the Sigma Interface configuration and data import
settings, and to view status information properties.

Figure: Basic tab

Table: Basic Tab
Property

Description

Communication status

Displays the status of the communications
between the Enterprise Server computer
and the Sigma controller network.

Communication error text

Displays the text generated when a
communications error occurs between the
Enterprise Server computer and the Sigma
controller network.

Server number

Enter the server number of the Enterprise
Server computer. This is the number that
you configured in the Networks and Devices
section of Sigma System Setup.
For more information, see section 109.2
“Sigma Workflow” on page 4803.
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Continued
Property

Description

IP address

Type the IP address of the computer where
the Enterprise Server (containing the Sigma
Interface) is installed.

Subnet mask

Type the subnet mask for the Enterprise
Server network adaptor IP address.

Controllers

Leave the field blank if you want to import
data from all Sigma controllers, otherwise
type the node number of the Sigma
controller from which you want to import
data. If you want to import data from more
than one controller (but not all controllers),
type the node numbers of the controllers,
separated by a comma. To import a range of
controllers, use a dash (for example 100-200
includes all controllers with node numbers
between 100 and 200).

Import host

Type the IP address (or network name) of the
Sigma server computer.

Trace file

Displays the path to the trace file.
For more information, see section 109.5
“Sigma Data Import” on page 4809.

Trace

Select Detailed if you want to ensure that
the detailed version of the log sets trace file
is generated on data import.
For more information, see section 109.5
“Sigma Data Import” on page 4809.
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117.2

Sigma Interface Properties – Advanced
Tab
Use the Advanced tab to edit the Sigma Interface device monitoring and advanced
data import settings.

Figure: Advanced tab

Table: Advanced Tab
Property

Description

Ping attempts

Enter the number of times you want the
interface to ping an offline device before the
device is set to offline status.
For more information, see section 110.10
“Device Monitoring” on page 4844.
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Checking period

Select how often you want the interface to
check devices.

Maximum concurrent checks

Enter 10 if the network does not contain any
DNNs, otherwise leave at the default of 1.
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Continued
Property

Description

Maximum checks per minute

Enter the maximum number of device
checks per minute.

Response timeout

Select the amount of time you want the
interface to wait for a response from a device
before timing out. If pre-ARM7 Sigma
controllers are interfaced, select 1.5
seconds.

Alarm priority

Select the priority for the alarm configured
for this object.

Alarm flashing

Select True if you want device status alarms
to flash.

Alarm audible

Select True if you want device status alarms
to sound an audible alert.

Communication timeout (ms)

Select the time to wait for any Sigma data
communications before timing out.

Trace communications

Select True to enable the creation of a
hexadecimal display of network
communications data. For Schneider Electric
use only.

Discard alarms from unknown devices Select True to prevent event messages for
alarms originating from controllers that are
not included in the Sigma Interface.
For more information, see section 116.1
“Alarms” on page 4939.
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Import port

Type the port number used by the Sigma
server to communicate (as set in Sigma's
SetupSvr.exe)

Source file

Type the path to an alternative XML file if you
do not wish to use data from the Sigma
server (for Schneider Electric use only).

Import in progress

Do not change - used by the data import
function.
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117.3

Sigma System Tree Icons
This section describes the icons in WorkStation that relate to a Sigma Interface.
Table: Sigma System Tree Icons
Icon

Description
Sigma Interface
Indicates a Sigma Interface.
Sigma Device
Indicates a Sigma device.
Sigma Device slot
Indicates a card slot in a Sigma x96 device.
Global Values device
Indicates a device for Sigma global values.
Digital Input (DI)
Indicates a Sigma digital input.
Digital Output (DO)
Indicates a Sigma digital output.
Edge Trigger Pulse
Indicates an edge trigger pulse for a digital
output.
Analog Input (AI)
Indicates a Sigma analog input.
Analog Output (AO)
Indicates a Sigma analog output.
Calculation (CAL)
Indicates a Sigma calculation.
Time Schedule (TIM)
Indicates a Sigma time schedule.
Holiday (HOL)
Indicates a Sigma holiday schedule.
Optimizer (OPT)
Indicates a Sigma optimizer.
Optimizer Heating
Indicates an optimizer heating (logarithmic or
linear).
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Continued
Icon

Description
Optimizer Cooling
Indicates a optimizer cooling (logarithmic or
linear).
Setpoint Adjust (SPA)
Indicates a Sigma setpoint adjust object.
Secondary Input
Indicates a secondary input for a setpoint
adjust object.
Control (CTL)
Indicates a Sigma control object or control
stage.
Rotation (ROT)
Indicates a Sigma rotation object.
Degree Day (DDY)
Indicates a Sigma degree day.
Pulse Counter (PLS)
Indicates a Sigma pulse counter.
Meter (MET)
Indicates a Sigma meter.
Standby Generator (SBG)
Indicates a Sigma standby generator.
Programmable (PRG)
Indicates a Sigma programmable object.
Contingency Log
Indicates a contingency log.
Time Extension
Indicates a Time Extension (in AO, DO, OPT,
ROT, SPA or TIM).
Alarm
Indicates a Sigma alarm.
Graphic
Indicates a graphic (Sigma or otherwise).
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117.4

Data Import Dialog Box
Use the Data Import dialog box to monitor the progress of a data import, and to
import data after further programming in your Sigma system.

Figure: Data Import dialog box

Table: Data Import Dialog Box
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Message or Button

Description

Trace will be sent to:

Displays the path to the location of the trace
file. For more information, see section 109.5
“Sigma Data Import” on page 4809.

Source:

Displays the path to the Sigma server and
folder where data import update information
is contained.

Full URL:

Displays the path to the source of data
import update information.

Import

Click to import data following further
programming in your Sigma system.
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117.5

Actions Menu - Sigma Diagnostics
Submenu
Use the Sigma diagnostics submenu to select commands relating to selected
Sigma controllers.
Table: Actions Menu - Sigma Diagnostics Submenu
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Property

Description

Retime

Click to set the time and date of controllers
to the time and date of the Enterprise Server.

Set online

Click to re-establish communications
between the Enterprise Server and
controllers following an offline event.

Diagnostic reports

Click to enable the selection of a Sigma
diagnostic text report.
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117.6

Controllers Folder Properties – Basic
Tab
Use the Basic tab to view or configure the properties of the Controllers folder. For
more information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.7

Sigma Device Properties – Basic Tab
Use the Basic tab to view the device status information and edit the configuration
settings.

Figure: Basic tab

Table: Basic Tab
Property

Description

Status

Displays Offline when the device is not
communicating with the Enterprise Server.

Response time (ms)

Displays the amount of time for the device to
respond to a device monitoring ping.

Device number

View (or enter for a virtual device) the number
of the Sigma device.

Ports
Click the
buttton to view the properties
of the selected device port.
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Name

Displays the name of the device port.

Port number

Displays the number of the device port.
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Continued
Property

Description

IP address

Displays the IP address of the device port.

Mode

Displays the communications mode of the
device port.

Device monitoring

Select Disabled to disable device
monitoring for this device.
For more information, see section 110.10
“Device Monitoring” on page 4844.
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117.8

Device Port Properties – Basic Tab
Use the Basic tab to view the basic properties of a Sigma device port.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Port number

Displays the number of the device port.

IP address

Displays the IP address of the device port.

Subnet mask

Displays the subnet mask of the device port.

Mode

Displays the communications mode of the
device port.

Baud

Displays the baud rate for the network.
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117.9

Diagnostics Folder Properties – Basic
Tab
Use the Basic tab to view or configure the properties of a diagnostics folder. For
more information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.10

Controller Time Properties – Basic Tab
Use the Basic tab to view the controller time and date.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Controller time and date

Displays the time and date settings in the
selected controller. For more information,
see section 110.3 “Controller Diagnostics”
on page 4836.
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117.11

Log Set Statistics Properties – Basic
Tab
Use the Basic tab to view the log set statistics for a controller.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Object list

Displays a list of objects to use on a text
report.

Log buckets

Displays the number of log buckets (the
number of servers multiplied by the number
of log sets).

Used log records

Displays the number of log sets in use (the
number of servers multiplied by the number
of objects).

Free log records

Displays the number of available log sets.

Log records to send

Displays the number of log sets awaiting
transmission.
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Property

Description

Object log set list

Displays a list of object numbers and log set
numbers in two columns, object number
first.

04-16006-04-en, March 2015

117 Sigma User Interface
117.12 Network Communication Statistics Properties – Basic Tab

117.12

Network Communication Statistics
Properties – Basic Tab
Use the Basic tab to view the basic properties of a Network Communication
Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Bytes sent

Displays the number of bytes sent to the
controller device.

Bytes received

Displays the number of bytes received from
the controller device.
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Property

Description

Bytes sent per second

Displays the number of bytes sent per
second to the controller device.

Bytes received per second

Displays the number of bytes received per
second from the controller device.

Bytes sent per minute

Displays the number of bytes sent per
minute to the controller device.

Bytes received per minute

Displays the number of bytes received per
minute from the controller device.

Peak bytes sent per second

Displays the maximum number of bytes sent
per second to the controller device.

Peak bytes received per second

Displays the maximum number of bytes
received per second from the controller
device.
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Network Communication Statistics
Properties – Packets Tab
Use the Packets tab to view the packets properties of a Network Communication
Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Packets tab

Table: Packets Tab
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Property

Description

Packets sent

Displays the number of packets sent to the
controller.

Packets received

Displays the number of packets received
from the controller.
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Property

Description

Packets sent per second

Displays the number of packets sent per
second to the controller.

Packets received per second

Displays the number of packets received per
second from the controller.

Packets sent per minute

Displays the number of packets sent per
minute to the controller.

Packets received per minute

Displays the number of packets received per
minute from the controller.

Peak packets sent per second

Displays the maximum number of packets
sent per second to the controller.

Peak packets received per second

Displays the maximum number of packets
received per second from the controller.
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117.14

Network Communication Statistics
Properties – Subscriptions Tab
Use the Subscriptions tab to view the subscriptions properties of a Network
Communication Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Subscriptions tab

Table: Subscriptions Tab
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Property

Description

Subscription requests sent

Displays the number of subscription
requests sent to the controller.

Subscriptions received

Displays the number of subscriptions
received from the controller.
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Property

Description

Subscription packets sent

Displays the number of subscription packets
sent to the controller.

Subscription refresh requests

Displays the number of subscription refresh
requests sent to the controller.

Subscriptions received per second

Displays the number of subscriptions
received per second from the controller.

Subscription requests sent per
second

Displays the number of subscription
requests sent per second to the controller.

Subscription requests received per
minute

Displays the number of subscription
requests received per minute from the
controller.

Subscriptions received per minute

Displays the number of subscriptions
received per minute from the controller.

Peak subscriptions received per
second

Displays the maximum number of
subscriptions received per second from the
controller.

Peak subscription requests sent per
second

Displays the maximum number of
subscription requests sent per second to the
controller.
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117.15

Network Communication Statistics
Properties – Alarms Tab
Use the Alarms tab to view the alarms properties of a Network Communication
Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Alarms tab

Table: Alarms Tab

04-16006-04-en, March 2015

Property

Description

Alarms received

Displays the number of alarms received from
the controller.

Alarms per second

Displays the number of alarms per second
received from the controller.
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Property

Description

Peak alarms per second

Displays the maximum number of alarms per
second received from the controller.

Alarms per minute

Displays the number of alarms per minute
received from the controller.

Reports received

Displays the number of Sigma reports
received from the controller.

System messages received

Displays the number of system messages
received from the controller.
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117.16

Network Communication Statistics
Properties – Logs Tab
Use the Logs tab to view the logs properties of a Network Communication
Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Logs tab

Table: Logs Tab
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Property

Description

Logs received

Displays the number of log sets received by
the Enterprise Server.
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117.17

Network Communication Statistics
Properties – File Operations Tab
Use the File Operations tab to view the file operations properties of a Network
Communication Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: File Operations tab

Table: File Operations Tab
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Property

Description

Short writes

Displays the number of configuration
protocol messages written to the record of
an object during an object parameter
change (for example, when changing an
alarm limit).
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Property

Description

Short reads

Displays the number of configuration
protocol messages read from part of the
record of an object (for example, an alarm
limit).

File writes

Displays the total number of configuration
protocol messages written to an object
when completely re-writing the record of that
object.

File reads

Displays the total number of configuration
protocol messages read from the entire
record of an object.

Technical
4979

117 Sigma User Interface
117.18 Network Communication Statistics Properties – Advanced Tab

117.18

Network Communication Statistics
Properties – Advanced Tab
Use the Advanced tab to view the advanced properties of a Network
Communication Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Global values received

Displays the number of global values
received at the Enterprise Server.

Duplicate alarms

Displays the number of detected duplicate
alarms.
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117.19

Network Communication Statistics
Properties – Debug Tab
Use the Debug tab to view the debug properties of a Network Communication
Statistics object.

Note
Network Communication Statistics object properties apply to all controllers if the
object is under the Controllers folder, or to an individual controller if the object is
under the Diagnostics folder of a Sigma controller.

Figure: Debug tab

Table: Debug Tab
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Property

Description

Messages in queue

Displays the number of messages waiting to
be sent to the controller.

Top-level applicable entities

Displays the number of active
communication messages.
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Property

Description

Total top-level applicable entities

Displays the total number of active
communication messages ever created.
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117.20

Node Statistics Properties – Basic Tab
Use the Basic tab to view the basic properties of a Node Statistics object.

Figure: Basic tab

Table: Basic Tab

04-16006-04-en, March 2015

Property

Description

Zone

Displays the Sigma zone where the device is
located.

Device serial number

Displays the hardware address (the MAC
address) of the device.

Device type

Displays the Sigma device type.

Device ID

Displays the node number of the device.

Maximum ports

Displays the maximum number of ports for
the device.

Default server number

Displays the node number of the default
Sigma server.
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Property

Description

Default server IP

Displays the IP address of the default Sigma
server.

Boot image

Displays the date, version number, and
checksum of the boot firmware image.

Active image

Displays the date, version number, and
checksum of the active firmware image.

Dormant image

Displays the date, version number, and
checksum of the dormant firmware image.

Adjacent nodes

Displays the numbers of the physical nodes
at either side of the referenced controller in
the Sigma LAN.
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117.21

Node Statistics Properties – Ports Tab
Use the Ports tab to view the ports properties of a Node Statistics object.

Figure: Ports tab

Table: Ports Tab
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Property

Description

BAS port

Displays the port number, IP address,
subnet mask, network type, network speed,
online or offline status, Maximum Transfer
Unit (MTU), and the serial port statistics of
the BAS port.

Port 1

Displays the port number, IP address,
subnet mask, network type, network speed,
online or offline status, Maximum Transfer
Unit (MTU), and the port statistics (not used
for Sigma in Building Operation) of Port 1.

Port 2

Not used for Sigma in Building Operation.

Port 3

Not used for Sigma in Building Operation.
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Property

Description

Port 4

Not used for Sigma in Building Operation.

Port 5

Displays the port number, IP address,
subnet mask, network type, network speed,
online or offline status, Maximum Transfer
Unit (MTU), and the serial port statistics (not
used for Sigma in Building Operation) of Port
5.

Port 6

Displays the port number, IP address,
subnet mask, network type, network speed,
online or offline status, Maximum Transfer
Unit (MTU), and the serial port statistics (not
used for Sigma in Building Operation) of Port
6.
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117.22

Node Statistics Properties – Entity
Buffers Tab
Use the Entity Buffers tab to view numbers of entity buffer properties for a Node
Statistics object.

Figure: Entity Buffers tab

Table: Entity Buffers Tab
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Property

Description

Application layer – buffers currently
containing entities

Displays the number of buffers that are
currently in use, saving entities in the
Application layer.

Application layer – maximum buffers
used so far

Displays the maximum number of buffers
that have been reached so far to save
entities in the Application layer.

Application layer – total buffers
allocated for entities

Displays the total number of buffers that
have been allocated to save entities in the
Application layer.
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Property

Description

Session layer – buffers currently
containing entities

Displays the number of buffers that are
currently in use, saving entities in the
Session layer.

Session layer – maximum buffers used Displays the maximum number of buffers
so far
that have been reached so far to save
entities in the Session layer.
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Session layer – total buffers allocated
for entities

Displays the total number of buffers that
have been allocated to save entities in the
Session layer.

Transport layer – buffers currently
containing entities

Displays the number of buffers that are
currently in use, saving entities in the
Transport layer.

Transport layer – maximum buffers
used so far

Displays the maximum number of buffers
that have been reached so far to save
entities in the Transport layer.

Transport layer – total buffers
allocated for entities

Displays the total number of buffers that
have been allocated to save entities in the
Transport layer.
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117.23

Node Statistics Properties – Data
Buffers Tab
Use the Data Buffers tab to view the data buffers properties of a Node Statistics
object.

Figure: Data Buffers tab

Table: Data Buffers Tab
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Property

Description

30 bytes buffer - number of free
buffers

Displays the number of unused buffers in the
30 bytes buffer.

30 bytes buffer - number of checked
buffers

Displays the number of checked buffers in
the 30 bytes buffer.

30 bytes buffer - lowest number of
free buffers reached

Displays the lowest number of unused
buffers in the 30 bytes buffer.

30 bytes buffer - total number of
buffers allocated

Displays the total number of buffers
allocated in the 30 bytes buffer.

200 bytes buffer - number of free
buffers

Displays the number of unused buffers in the
200 bytes buffer.
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Property

Description

200 bytes buffer - number of checked
buffers

Displays the number of checked buffers in
the 200 bytes buffer.

200 bytes buffer - lowest number of
free buffers reached

Displays the lowest number of unused
buffers in the 200 bytes buffer.

200 bytes buffer - total number of
buffers allocated

Displays the total number of buffers
allocated in the 200 bytes buffer.

1000 bytes buffer - number of free
buffers

Displays the number of unused buffers in the
1000 bytes buffer.

1000 bytes buffer - number of
checked buffers

Displays the number of checked buffers in
the 1000 bytes buffer.

1000 bytes buffer - lowest number of
free buffers reached

Displays the lowest number of unused
buffers in the 1000 bytes buffer.

1000 bytes buffer - total number of
buffers allocated

Displays the total number of buffers
allocated in the 1000 bytes buffer.
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117.24

Node Statistics Properties – Message
Queues Tab
Use the Message Queues tab to view the message queues properties of a Node
Statistics object.

Figure: Message Queues tab

Table: Message Queues Tab
Property

Description

Sigma LAN – buffers currently
containing messages

Displays the number of buffers in the Sigma
LAN queue that currently contain messages.

Sigma LAN – total buffers allocated for Displays the total number of buffers in the
messages
Sigma LAN queue that have been allocated
for messages.
Network general – buffers currently
containing messages
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Displays the number of buffers in the
Network general queue that currently
contain messages.
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Property

Description

Network general – total buffers
allocated

Displays the total number of buffers in the
Network general queue that have been
allocated for messages.

Network serial port – buffers currently Displays the number of buffers in the
containing messages
Network serial port queue that currently
contain messages.

Technical
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Network serial port – total buffers
allocated for messages

Displays the total number of buffers in the
Network serial port queue that have been
allocated for messages.

Port 1 – buffers currently containing
messages

Displays the number of buffers in the Port 1
queue that currently contain messages.

Port 1 – total buffers allocated for
messages

Displays the total number of buffers in the
Port 1 queue that have been allocated for
messages.

Port 5 – buffers currently containing
messages

Displays the number of buffers in the Port 5
queue that currently contain messages.

Port 5 – total buffers allocated for
messages

Displays the total number of buffers in the
Port 5 queue that have been allocated for
messages.

Port 6 – buffers currently containing
messages

Displays the number of buffers in the Port 6
queue that currently contain messages.

Port 6 – total buffers allocated for
messages

Displays the total number of buffers in the
Port 6 queue that have been allocated for
messages.

Transport – buffers currently
containing messages

Displays the number of buffers in the
Transport queue that currently contain
messages.

Transport – total buffers allocated for
messages

Displays the total number of buffers in the
Transport queue that have been allocated for
messages.

Application – buffers currently
containing messages

Displays the number of buffers in the
Application queue that currently contain
messages.

Application – total buffers allocated
for messages

Displays the total number of buffers in the
Application queue that have been allocated
for messages.
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117.25

Node Statistics Properties – Data
Queues Tab
Use the Data Queues tab to view the data queues properties of a Node Statistics
object.

Figure: Data Queues tab

Table: Data Queues Tab
Property

Description

Sigma LAN – buffers currently
containing data

Displays the number of buffers currently
containing data in the Sigma LAN.

Sigma LAN – total buffers allocated for Displays the total number of buffers
data
allocated for data in the Sigma LAN.
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117.26

x96 Device Slot Properties – Basic Tab
Use the Basic tab to configure and view the general properties. For more
information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.27

Analog Input Properties – Basic Tab
Use the Basic tab to view or configure the properties of an analog input.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Totalization value

Displays the value of the totalized object (AI
and CAL).

General alarm status

Displays the general alarm status. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm priority

Select the priority for the alarm configured
for this object.
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Property

Description

Alarm status

Displays the status of the alarm. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm status 1

Displays the status of Alarm 1. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm status 2

Displays the status of Alarm 2. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm status totalization

Displays the status of the totalized alarm. For
more information, see section 116.1
“Alarms” on page 4939.
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Analog Output Properties – Basic Tab
Use the Basic tab to view or configure the properties of an analog output.

Figure: Basic tab

Table: Basic Tab

04-16006-04-en, March 2015

Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.
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117.29

Digital Input Properties – Basic Tab
Use the Basic tab to view or configure the properties of a digital input.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Totalization value (h)

Displays the run time in hours (DO and DI).

General alarm status

Displays the general alarm status. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm priority

Select the priority for the alarm configured
for this object.
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Property

Description

Alarm status

Displays the status of the alarm. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm status totalization

Displays the status of the totalized alarm. For
more information, see section 116.1
“Alarms” on page 4939.

Technical
4999

117 Sigma User Interface
117.30 Digital Output Properties – Basic Tab

117.30

Digital Output Properties – Basic Tab
Use the Basic tab to view or configure the properties of a digital output.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.

Totalization value (h)

Displays the value of the totalized object (AI
and CAL).

General alarm status

Displays the general alarm status. For more
information, see section 116.1 “Alarms” on
page 4939.
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Property

Description

Alarm priority

Select the priority for the alarm configured
for this object.

Alarm status totalization

Displays the status of the totalized alarm. For
more information, see section 116.1
“Alarms” on page 4939.
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117.31

Control Properties – Basic Tab
Use the Basic tab to configure the general properties of a control object. For more
information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.32

Control Stage Properties – Basic Tab
Use the Basic tab to view or configure the properties of a control stage.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.

Proportional

Select Disabled if you want the control
stage output to be based on integral and
differential control. For more information, see
section 111.9 “Control Object” on page
4862.
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Property

Description

Gain

Enter the gain for the control stage. For more
information, see section 111.9 “Control
Object” on page 4862.

Integral time (s)

Enter the integral time for the control stage.
For more information, see section 111.9
“Control Object” on page 4862.

Derivative time (s)

Enter the derivative time for the control
stage. For more information, see section
111.9 “Control Object” on page 4862.
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117.33

Degree Day Properties – Basic Tab
Use the Basic tab to view or configure the properties of a degree day object.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value (°CDays)

Displays the object value.

Previous value (°CDays)

Displays the secondary value (the total
number of degree days accumulated for the
previous period).

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.
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117.34

Edge Trigger Pulse Properties – Basic
Tab
Use the Basic tab to view the properties of an edge trigger pulse. For more
information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.35

Calculation Object Properties – Basic
Tab
Use the Basic tab to view or configure the properties of a calculation object.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Totalization value

Displays the value of the totalized object (AI
and CAL).

General alarm status

Displays the general alarm status. For more
information, see section 116.1 “Alarms” on
page 4939.
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Property

Description

Alarm priority

Select the priority for the alarm configured
for this object.

Alarm status 1

Displays the status of Alarm 1. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm status 2

Displays the status of Alarm 2. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm status totalization

Displays the status of the totalized alarm. For
more information, see section 116.1
“Alarms” on page 4939.
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117.36

Time Schedule Properties – Basic Tab
Use the Basic tab to view or configure the properties of a Sigma time schedule.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Next switch time

Displays the time and date at which the next
transition takes place.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.
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117.37

Time Extension Properties – Basic Tab
Use the Basic tab to view or configure the properties of a time extension.

Figure: Basic tab

Table: Basic Tab
Property

Description

Operation

Select how often you want the time
extension to occur.
For more information, see section 111.23
“Time Extensions” on page 4879.

Period

Technical
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Type the time period of the interval (applies
when Every is selected in the Operation
selection).
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117.38

Holiday Schedule Properties – Basic Tab
Use the Basic tab to view or configure the properties of a holiday schedule.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.
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117.39

Schedule Editor View
Use the Sigma Schedule Editor view to create or edit Sigma time schedule
events.

Figure: Sigma Schedule Editor view

Table: Sigma Schedule Editor View
Number

Description
Schedule Editor toolbar
Use the toolbar to manage schedules. For
more information, see the Basic Schedule
Editor Toolbar topic on WebHelp.
Event grid
Displays schedule events in graphic view.
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117.40

Sigma Schedule Event Properties Dialog
Box
Use the Schedule Event Properties dialog box in the Schedule Editor to create
an event for a Sigma time schedule.

Figure: Schedule Event Properties dialog box

Table: Schedule Event Properties dialog box
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Property

Description

Days of week

Select the days of the week that apply to this
schedule.

All day

Select All Day for an all day event.

Add Entry

Click to add a line to the Times and values
box.

Delete Entry

Click to delete an entry from the Times and
values box.
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117.41

Meter Properties – Basic Tab
Use the Basic tab to view or configure the properties of a meter.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value (kVA)

Displays the demand so far in the current
metering period.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.

Maximum demand limit (kVA)

Displays the maximum demand limit set by
the energy provider.

Target demand (kVA)

Displays the demand limit for control
purposes.
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Property

Description

Energy consumed (kVAh)

Displays the measured energy consumption
so far in the current metering period.

Maximum remaining energy (kVAh)

Displays the energy remaining (up to the
maximum demand limit).

Expired period (min)

Displays the expired period.

Instantaneous load (kVA)

Displays the instantaneous load.

Maximum target load (kVA)

Displays the maximum target load.

Average load (kVA)

Displays the average load so far in the
current metering period.
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117.42

Optimizer Properties – Basic Tab
Use the Basic tab to view or configure the properties of a Sigma optimizer.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.

Room temperature (°C)

Displays the room temperature in the
occupied area.

Outside temperature (°C)

Displays the outside temperature.
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Property

Description

Next switch time

Displays the time and date at which the next
transition takes place.

Predicted rate (°C/h)

Displays the predicted rate of temperature
change.

Last slope correction (°C/h)

Displays the last value of slope correction.

Technical
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117.43

Optimizer Heating Linear Properties –
Basic Tab
Use the Basic tab to configure the heating properties of a linear optimizer.

Figure: Basic tab

Table: Basic Tab

Technical
5018

Property

Description

Minimum space temperature at
occupancy (°C)

Enter the minimum temperature that must
be attained in the space by the time of
occupancy.

End-of-occupancy low limit (°C)

Enter the minimum temperature permitted in
the space at the end of occupancy.

Plant start temperature (°C)

Enter the temperature at which you want the
heating system to turn on for low
temperature protection.

Plant stop temperature (°C)

Enter the temperature at which you want low
temperature protection to cease.
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117.44

Optimizer Heating Logarithmic
Properties – Basic Tab
Use the Basic tab to configure the heating properties of a logarithmic optimizer.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Minimum space temperature at
occupancy (°C)

Enter the minimum temperature that must
be attained in the space by the time of
occupancy.

End occupancy low limit (°C)

Enter the minimum temperature permitted in
the space at the end of occupancy.

Plant start temperature (°C)

Enter the temperature at which you want the
heating system to turn on for low
temperature protection.

Plant stop temperature (°C)

Enter the temperature at which you want low
temperature protection to cease.

Technical
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117.45

Optimizer Cooling Linear Properties –
Basic Tab
Use the Basic tab to configure the cooling properties of a linear optimizer.

Figure: Basic tab

Table: Basic Tab

Technical
5020

Property

Description

Maximum space temperature at
occupancy (°C)

Enter the maximum temperature permitted in
the space at the start of occupancy.

End-of-occupancy high limit (°C)

Enter the maximum temperature permitted in
the space at the end of occupancy.

Plant start temperature (°C)

Enter the temperature at which you want the
heating system to turn on for high
temperature protection.

Plant stop temperature (°C)

Enter the temperature at which you want
high temperature protection to cease.
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117.46

Optimizer Cooling Logarithmic
Properties – Basic Tab
Use the Basic tab to configure the cooling properties of a logarithmic optimizer.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Maximum space temperature at
occupancy (°C)

Enter the maximum temperature permitted in
the space at the start of occupancy.

End occupancy high limit (°C)

Enter the maximum temperature permitted in
the space at the end of occupancy.

Plant start temperature (°C)

Enter the temperature at which you want the
heating system to turn on for high
temperature protection.

Plant stop temperature (°C)

Enter the temperature at which you want
high temperature protection to cease.

Technical
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117.47

Pulse Counter Properties – Basic Tab
Use the Basic tab to view or configure the properties of a pulse counter object.

Figure: Basic tab

Table: Basic Tab

Technical
5022

Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Instantaneous rate

Displays the difference in value between two
samples divided by the time between the
two samples.

General alarm status

Displays the general alarm status. For more
information, see section 116.1 “Alarms” on
page 4939.
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Property

Description

Alarm priority

Select the priority for the alarm configured
for this object.

Alarm status

Displays the status of the alarm. For more
information, see section 116.1 “Alarms” on
page 4939.

Technical
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117.48

Rotation Object Properties – Basic Tab
Use the Basic tab to view or configure the properties of a rotation object.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays the object value.
For more information, see section 111.16
“Rotation Object” on page 4872.

Technical
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Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.

Lead load number

Enter the number of the lead load.
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117.49

Setpoint Adjust Properties – Basic Tab
Use the Basic tab to view or configure setpoint adjust properties.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays the object value.
For more information, see section 111.14
“Setpoint Adjust Object” on page 4869.
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Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

Reason path

Displays the path to the object causing the
current quantity, state, or enumeration.

Fixed value

Enter a floating point value, REM or AFLO to
TFLO.

Technical
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117.50

Secondary Input Properties – Basic Tab
Use the Basic tab to configure the properties of a secondary input to a setpoint
adjust object.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Setpoint value

Enter the setpoint value at Changeover 1.
For more information, see section 111.8
“Sigma Software Objects” on page 4859.

Changeover 1

Enter the secondary input value for
Changeover 1.

Changeover 2

Enter the secondary input value for
Changeover 2.

Ratio 1

Enter the gradient for secondary input values
less than Changeover 2.

Ratio 2

Enter the gradient for secondary input values
between Changeover 1 and Changeover 2.
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Property

Description

Ratio 3

Enter the gradient for secondary input values
greater than Changeover 1.

Technical
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117.51

Standby Generator Properties – Basic
Tab
Use the Basic tab to view or configure the properties of the standby generator.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Value

Displays the object value.

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.
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117.52

Programmable Object Properties –
Basic Tab
Use the Basic tab to view or configure the properties of a programmable object.

Figure: Basic tab

Table: Basic Tab
Property

Description

Value

Displays the value of the programmable
object.

Programmable text

Displays the programmed text string.
(Programmable string object only.)

Float value

Click Force and then enter the required float
value.
(Programmable analog object only.)

Digital value
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Click Force and then select the required
digital value.
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Property

Description

Reason

Displays the reason for the quantity, state, or
enumeration contained in the Value box.
For more information, see section 111.2
“Sigma Values and Reasons for State” on
page 4850.

General alarm status

Displays the general alarm status. For more
information, see section 116.1 “Alarms” on
page 4939.

Alarm priority

Select the priority for the alarm configured
for this object.
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Sigma Object Properties – Advanced
Tab
Use the Advanced tab to view the advanced properties of a Sigma object.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Graphic

Displays the path to an associated Sigma
graphic.
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117.54

Alarm Properties – Basic Tab
Use the Basic tab to view the alarm status information and edit the configuration
settings.

Figure: Basic tab (Alarm 1 Window properties shown)

Table: Basic Tab (All Possible Properties Shown)

Technical
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Property

Description

Alarm status

Displays the status of the alarm. For more
information, see section 116.1 “Alarms” on
page 4939.

Totalization value

Displays the value of the totalized object (AI
and CAL).

Totalization value (h)

Displays the run time in hours (DO and DI).

Priority

Select the priority for the alarm configured
for this object.

Low limit

Enter the lowest value the monitored variable
can decrease to before the alarm is
triggered.
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Property

Description

High limit

Enter the highest value the monitored
variable can increase to before the alarm is
triggered.

Limit 1

Displays the first hours run totalization limit.

Limit 2

Displays the second hours run totalization
limit.

Limit 3

Displays the third hours run totalization limit.

Reset

Displays the totalization limit reset value.

Technical
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117.55

Alarm Properties – Alarm Tab
Use the Alarm tab to view or change the alarm properties of a Sigma alarm.

Figure: Alarm tab

Table: Alarm Tab
Propery

Description

Type of acknowledgement

Displays the type of acknowledgement
configured.
For more information, see the
Acknowledgement topic on WebHelp.
For more information, see section 116.1
“Alarms” on page 4939.

Audible alert

Displays False if the alarm is not configured
to be audible when active.
For more information, see section 116.1
“Alarms” on page 4939.

Technical
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117.56

Alarm Properties – Advanced Tab
Use the Advanced tab to change the advanced properties (if applicable) of a
Sigma alarm.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Hysteresis

Enter the hysteresis value for this alarm.

Alarm transient time

Select the length of time the object must be
in alarm condition before the alarm is
activated.

Clear transient time

Select the length of time the object must be
out of alarm condition before the alarm is
cleared.

Technical
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117.57

Contingency Log Properties – Basic Tab
Use the Basic tab to edit the contingency log settings.

Figure: Basic tab

Table: Basic Tab

Technical
5036

Property

Description

Logging

Select Enabled to enable contingency
logging for the object selected.

Log size

Enter the log size (number of log samples)
required.

Interval (s)

Enter the interval required between log
samples.
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Global Values Device Properties – Basic
Tab
Use the Basic tab to configure the number of the virtual device.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Device number

Enter the device number. For more
information, see section 115.3 “Global
Values to Sigma” on page 4927.

Technical
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117.59

Analog Input Global Value Properties –
Basic Tab
Use the Basic tab to view or configure the properties of an analog input global
value.

Figure: Basic tab

Table: Basic Tab

Technical
5038

Property

Description

Value

Displays the global value of the source
object when a binding is present. Do not
enter a value before binding (the value will be
overwritten by the binding).

Secondary Value

Displays the global secondary value of the
source object when a binding is present. Do
not enter a value before binding (the value
will be overwritten by the binding).

04-16006-04-en, March 2015

117 Sigma User Interface
117.60 Analog Output Global Value Properties – Basic Tab

117.60

Analog Output Global Value
Properties – Basic Tab
Use the Basic tab to view or configure the basic properties of an analog output
global value.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the global value.

Secondary value

Displays the global secondary value.

Sigma reference object

Enter the path of the Sigma object from
which you want data to be obtained. The
values of the referenced object fill the Value
and any Secondary Value property fields
for output global values.

Technical
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117.61

Digital Input Global Value Properties –
Basic Tab
Use the Basic tab to view or configure the basic properties of a digital input global
value.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Value

Displays the global digital value of the source
object when a binding is present. Do not
enter a value before binding (the value will be
overwritten by the binding).

Secondary value

Displays the global secondary value of the
source object when a binding is present. Do
not enter a value before binding (the value
will be overwritten by the binding).
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117.62

Digital Output Global Value Properties –
Basic Tab
Use the Basic tab to view or configure the properties of a digital output global
value.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Value

Displays the global value.

Secondary value

Displays the global secondary value.

Sigma reference object

Enter the path of the Sigma object from
which you want data to be obtained. The
values of the referenced object fill the Value
and any Secondary Value property fields
for output global values.

Technical
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117.63

Analog and Digital Input Global Value
Properties – Advanced Tab
Use the Advanced tab to configure the object number of an analog or digital input
global value.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Object number

Enter the unique object number.
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Graphics Folder Properties – Basic Tab
Use the Basic tab to configure the properties of the Graphics folder.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Trace file

Displays the path to the trace file.

File size limit (MB)

Enter the maximum size of any converted
graphics file during a graphics import.

Technical
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117.65

Graphics Subfolder Properties – Basic
Tab
Use the Basic tab to view or configure the properties of a Graphics subfolder. For
more information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab

Technical
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117.66

Graphics Item Context Menu
Use the context menu on an item in a Sigma graphic to view Sigma alarm histories
and contingency log data, and to control Sigma objects referenced to that item.

Figure: Graphics item context menu

Table: Graphics Item Context Menu
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Property

Description

Edit Properties

Click to edit the property bound to the
graphic item.

View

Click to open the View submenu, where you
can view Sigma alarm histories and
contingency log charts and lists. For more
information, see section 117.68 “Graphics
Item Context Menu – View Submenu” on
page 5046.

Commands

Click to open the Commands submenu,
where you can select commands relating to
referenced Sigma objects. For more
information, see section 117.67 “Graphics
Item Context Menu – Commands Submenu”
on page 5044.

Technical
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117.67

Graphics Item Context Menu –
Commands Submenu
Use the Commands submenu to select commands relating to referenced Sigma
objects.

Figure: Graphics item context menu – commands submenu

Table: Graphics Item Commands Submenu - Sigma

Technical
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Property

Description

Edit all properties

Click to display all available properties tabs
for the object.

Alarm enable

Click to enable the Sigma Alarm.

Alarm inhibit

Click to inhibit the Sigma Alarm.

Edit Alarm

Click to display the properties for a Sigma
Alarm.

Edit Alarm 1

Click to display the properties for Sigma
Alarm 1.

Edit Alarm 2

Click to display the properties for Sigma
Alarm 2.

Edit cooling linear

Click to display the properties for a Sigma
linear cooling optimizer.

Edit cooling logarithmic

Click to display the properties for a Sigma
logarithmic cooling optimizer.

Edit heating linear

Click to display the properties for a Sigma
linear heating optimizer.

Edit heating logarithmic

Click to display the properties for a Sigma
logarithmic heating optimizer.

Edit schedule

Click to display the schedule editor or
calendar editor (as relevant).

Edit secondary input

Click to display the properties for a
secondary input to a Sigma Setpoint Adjust
object.

Edit time extension

Click to display the properties for a Sigma
Time Extension.
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Property

Description

Hours cancel limit 1

Click to prevent the generation of the next
totalization alarm for Limit 1 (like precancel,
except that you cannot later reinstate the
generation of the next Limit 1 totalization
alarm).

Hours cancel limit 2

Click to prevent the generation of the next
totalization alarm for Limit 2 (like precancel,
except that you cannot later reinstate the
generation of the next Limit 2 totalization
alarm).

Hours cancel limit 3

Click to prevent the generation of the next
totalization alarm for Limit 3 (like precancel,
except that you cannot later reinstate the
generation of the next Limit 3 totalization
alarm).

Hours precancel limit 1

Click to prevent the generation of the next
totalization alarm for Limit 1.

Hours precancel limit 2

Click to prevent the generation of the next
totalization alarm for Limit 2.

Hours precancel limit 3

Click to prevent the generation of the next
totalization alarm for Limit 3.

Hours reinstate limit 1

Click to reverse the effects of clicking Hours
precancel limit 1.

Hours reinstate limit 2

Click to reverse the effects of clicking Hours
precancel limit 2.

Hours reinstate limit 3

Click to reverse the effects of clicking Hours
precancel limit 3.

Pulse start

Click to generate a Digital Output pulse
lasting for the duration of the rising edge
setting in Sigma.

Pulse stop

Click to generate a Digital Output pulse
lasting for the duration of the falling edge
setting in Sigma.

Temporary off

Click to override a Sigma Time Schedule
object until the next scheduled ON time.

Temporary on

Click to override a Sigma Time Schedule
object until the next scheduled OFF time.
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117.68

Graphics Item Context Menu – View
Submenu
Use the View submenu to view Sigma alarm histories and contingency logs.

Figure: Graphics item context menu – view submenu

Table: Graphics Item Context Menu – View Submenu

Technical
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Property

Description

Alarm history

Click to display the event history viewer for a
Sigma object.

Contingency log chart

Click to display a contingency log chart for a
Sigma object.

Contingency log list

Click to display a contingency log list for a
Sigma object.
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117.69

Log Sets Folder Properties – Basic Tab
Use the Basic tab to configure the properties of a log sets folder.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Trace file

Displays the path to the trace file.

Trace

Select Detailed if you want to ensure that
the detailed version of the log sets trace file
is generated on data import.

Technical
5049

117 Sigma User Interface
117.70 Change of Value Log Set Folder Properties – Basic Tab

117.70

Change of Value Log Set Folder
Properties – Basic Tab
Use the Basic tab to view or configure the basic properties of a Change of Value
log set folder.

Figure: Basic tab

Table: Basic Tab

Technical
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Property

Description

Log set number

Displays the Sigma log set number.

Log value

Select Secondary if you want to log the
secondary value.

Tolerance

Enter the amount by which the object value
must vary before the value is logged.
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117.71

Change of Value Log Set Folder
Properties – Advanced Tab
Use the Advanced tab to configure the advanced properties of a Change of Value
log set folder.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

Log storage type

Select the method of log storage.

When log space is full

Select Circular storage if you want the
oldest logged data to be overwritten when
the controller data buffer is full.

Log priority number

Enter the log priority number.

Log deferred

Select True if you want the log set to be
deferred.

Activation period enabled

Select True if you want the log set to be
activated between two selected dates only.
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Property

Description

Activation start time

Select the activation start time (start time is
applicable only if an activation period is
enabled).

Activation stop time

Select the activation stop time (stop time is
applicable only if an activation period is
enabled).

Log control object

Enter the path to the cross-reference object
that controls when logging is to occur.

Log control reversed

Select True if you require the value of the
cross-reference object to be reversed.

Action on unavailable

Select Stop if you require logging to stop
when the cross-reference object is not
available.
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117.72

Interval Log Set Folder Properties –
Basic Tab
Use the Basic tab to view or configure the properties of an Interval log set folder.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Log set number

Displays the Sigma log set number.

Log value

Select Secondary if you want to log the
secondary value.

Interval unit

Select the units for the log set interval.

Interval time

Enter the log set interval time.

Interval offset (s)

Enter the log set interval offset (in seconds).
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117.73

Interval Log Set Folder Properties –
Advanced Tab
Use the Advanced tab to configure the advanced properties of an Interval log set
folder.

Figure: Advanced tab

Table: Advanced Tab

Technical
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Property

Description

Log storage type

Select the method of log storage.

When log space is full

Select Circular storage if you want the
oldest logged data to be overwritten when
the controller data buffer is full.

Log priority number

Enter the log priority number.

Log deferred

Select True if you want the log set to be
deferred.

Activation period enabled

Select True if you want the log set to be
activated between two selected dates only.
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Property

Description

Activation start time

Select the activation start time (start time is
applicable only if an activation period is
enabled).

Activation stop time

Select the activation stop time (stop time is
applicable only if an activation period is
enabled).

Log control object

Enter the path to the cross-reference object
that controls when logging is to occur.

Log control reversed

Select True if you require the value of the
cross-reference object to be reversed.

Action on unavailable

Select Stop if you require logging to stop
when the cross-reference object is not
available.
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117.74

Extended Logs Folder Properties –
Basic Tab
Use the Basic tab to view or configure the properties of an extended logs folder.
For more information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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Log Properties – Basic Tab
Use the Basic tab to view the device status information and edit the configuration
settings.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Number of values

Enter the number of logged values you want
the extracted data to contain.

Logged variable

Enter the path to the logged object.
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117.76

Segments Folder Properties – Basic Tab
Use the Basic tab to view or configure the properties of a segments folder. For
more information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.77

Segments Subfolder Properties – Basic
Tab
Use the Basic tab to view or configure the properties of a segment folder.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Graphic

Displays the path to an associated Sigma
graphic.
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117.78

Text Reports Folder Properties – Basic
Tab
Use the Basic tab to view or configure the properties of the text reports folder. For
more information, see the General Properties – Basic Tab topic on WebHelp.

Figure: Basic tab
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117.79

Text Report Properties – Basic Tab
Use the Basic tab to view and edit basic information about any text report.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Objects per batch

Enter the maximum number of objects you
want Building Operation to process in each
batch. The limit is 32767. For more
information, see section 128.2 “Text
Reports” on page 5326.

Display report path

Select True to display the path of the report
in the text report view. For more information,
see section 130.4 “Text Report View” on
page 5362.

Time stamp

Select True to enable the display of the time
and date at which you create the text report.

Display trace

Select True to display a diagnostics trace in
the text report view. For more information,
see section 128.2 “Text Reports” on page
5326.
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118 Web Services
118.1 Web Services Overview

118.1

Web Services Overview
Web Services are programmable applications accessible from standard Internet
protocols. You can use Web Services to consume information, such as temperature
from a weather service.
Building Operation servers can use SOAP, Simple XML, Script Web Services, and
EcoStruxure Web Services to consume information. You create a Web Service
interface in a Building Operation server to enable the server to be a client of the
Web Service and consume information from the Web Service.
Building Operation servers can also serve information to another EcoStruxure
system using the EcoStruxure Web Services standard.

118.1.1

Web Services
Web Services is a way to translate information in XML format so that it can be
understood by Building Operation servers and displayed in WorkStation. When you
create a Web Service interface, you can add XML elements from the server
providing the Web Service. The XML elements are then translated into values in an
Enterprise Server or an Automation Server.
For more information, see section 118.2 “Web Services ” on page 5064.

118.1.2

EcoStruxure Web Services
EcoStruxure Web Services allows seamless sharing of operational data, including
alarms and historical information, between Building Operation software from
different Schneider Electric Business Units.
For more information, see section 121.1 “EcoStruxure Web Services” on page
5113.
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118.2

Web Services
Web Services is a way to translate information in XML format so that it can be
understood by Building Operation servers and displayed in WorkStation. When you
create a Web Service interface, you can add XML elements from the server
providing the Web Service. The XML elements are then translated into values in an
Enterprise Server or an Automation Server.
When you create the Web Service interface, you can also select the content of the
XML element, the attribute or the whole XML node. Selecting a node can be useful if
you, for example, want to use a Script program to parse the XML code.

Figure: Web Service interface in Building Operation

When the XML element is translated into a Building Operation value, the value can
be used as any other value in Building Operation. The value can be connected to an
alarm, it can be logged, it can be presented in a graphic or in at trend log list or a
trend chart. The value can also have its unit changed and it can be forced.
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Figure: An XML element translated into a value in Building Operation

There are three ways to translate the XML element, each with their own specific
interface:
• Simple XML Web Service
• SOAP Web Service
• Script Web Service

118.2.1

Script Web Services
Web Services are designed to support interoperable, machine-to-machine
interaction over a network. As a result, it makes perfect sense to use a Web Service
from a programming language, such as Script. For more information, see section
53.1 “Script Web Services” on page 1917.

118.2.2

Simple XML Web Service
The Simple XML Web Service is used for REST and standard XML files. For more
information, see section 118.4 “Creating a Simple XML Web Service Interface” on
page 5072.

118.2.3

SOAP Web Service
The SOAP Web Service interface in Building Operation is used for SOAP. SOAP
requires a URL to the Web Service itself and a WSDL file. The WSDL file defines the
operation parameters in SOAP. For more information, see section 118.3 “Creating a
SOAP Web Service Interface” on page 5068.
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118.2.4

Limitations
The XML response, that is the XML file information sent to Building Operation, has
some limitations:
• The limit for the whole XML response is 100 kb, which includes manually
created values.
• The limit for a string value is 10 kb, which includes manually created values.
• The maximum number of values created in the Web Server interface is 200.
• The recommended limit for XML elements in the Web Service interface is 100
XML elements at a polling rate of 60 seconds.
• The recommended number of Web Service interfaces in an Automation Server
is 2.

Limitations regarding Simple XML Web Service
Only values within quotes in the XML file can be read by the Wizard. Values within
angle brackets cannot be read by the Wizard.
For more information, see section 120.1 “The Create Web Service Values Page in
the Wizard is Empty” on page 5109.

Limitations regarding SOAP Web Service
Ensure the WSDL-file meets these criteria:
• does not import other WSDL-files
• is in DOC style (RPC is not supported)
• does not contain array parameters.
For more information, see section 120.2 “SOAP Web Service Interface Cannot be
Created” on page 5110.

118.2.5

Manually Created Values
Even if Building Operation automatically creates all the select values from the XML
file on the server providing the Web Service it is sometimes necessary to create new
values manually in the Building Operation Web Service interface. For example, if the
XML element presents a float value without any decimal separator, Building
Operation correctly interprets this as a multistate value.
However, if the value displays, for example a temperature, it is more convenient to
have this as an analog value in Building Operation. In this case you add a new
analog value in the Building Operation Web Service interface and connect it to the
XML element using the XPath Editor. For more information, see section 118.5
“Adding a New Value to the Web Service Interface ” on page 5075.

Note
The manually created value will get a default value until the first polling.
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118.2.6

Time Stamp Values
XML elements with text strings that are formatted according to ISO 8601 are
translated to Time Stamp values if they are selected when you create the Web
Service interface. The time stamp values can be used to show date and time, for
example, in graphics that present other information from the Web Server providing
the Web Service.
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118.3

Creating a SOAP Web Service Interface
You create a SOAP Web Service interface so you can consume information from a
SOAP Web Service.
For more information, see section 118.2 “Web Services ” on page 5064.

Note
The values in the Web Server interface get a default value until the first polling.

To create a SOAP web service interface
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create a Web Service.
2. On the File menu, point to New and then click Interface.
3. In the object type list, expand Web Service and then click SOAP Web
Service.

4. In the Name box, type a name for the SOAP Web Service.
5. In the Description box, type a description for the SOAP Web Service.
6. Click Next.
Continued on next page
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7. In the Enter the file path or URL to a WSDL file box, enter the path or
URL to the WSDL file.

8. Click Get operations.
9. In the Username box, type the username if the WSDL file needs
authentication.
10. In the Password box, type the password if the WSDL file needs
authentication.
11. In the Operation list select the SOAP operation.
12. Select the SOAP operation parameters if applicable.
13. Click Next.
Continued on next page
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14. In the Service URL box, type the URL to the server providing the Web
Service.

15. In the Polling interval box, enter the polling interval.

Caution
Do not use too short of a polling interval. Too many polling requests
can overload the server that provides the Web Service.
16. In the Username box, type the username if the server providing the Web
Service needs authentication.
17. In the Password box, type the password if the server providing the Web
Service needs authentication.
18. In the Alarm enabled box, select True to send an alarm if Building Operation
cannot connect to the server providing the web service.
19. In the Number of retries before alarm, enter how many times Building
Operation tries to connect to the server providing the Web Service before an
alarm is triggered.
20. In the Retry interval box, enter the interval in seconds between the retries
from Building Operation to connect to the server providing the Web Service.
21. In the Alarm priority box, enter the alarm priority.
22. Click Next.
Continued on next page
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23. In the Create Web Service value list, select the values you want to add to
the Building Operation Web Service interface.

24. Click Create.
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118.4

Creating a Simple XML Web Service
Interface
You create a Simple XML Web Service interface in Building Operation so you can
consume information from a Simple XML Web Service.
For more information, see section 118.2 “Web Services ” on page 5064.

To create a simple XML web service interface
1. In WorkStation, in the System Tree pane, select the server or folder or where
you want to create the Simple XML Web Service interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, expand Web Service and then click Simple XML
Web Service.

4. In the Name box, type a name for the Simple XML Web Service interface.
5. In the Description box, type a description for the Simple XML Web Service
interface.
6. Click Next.
Continued on next page
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7. In the Service URL box, type the URL to the server providing the Web
Service.

8. In the Polling interval box, enter the polling interval in seconds.

Caution
Do not use too short of a polling interval. Too many polling requests
can overload the server that provides the Web Service.
9. In the Username box, type the username if the server providing the Web
Service needs authentication.
10. In the Password box, type the password if the server providing the Web
Service needs authentication.
11. In the Alarm enabled box, select True to send an alarm if Building
Operation cannot connect to the server providing the Web Service.
12. In the Number of retries before alarm, enter how many times Building
Operation tries to connect to the server providing the Web Service before an
alarm is triggered.
13. In the Retry interval box, enter the interval in seconds between the retries
from Building Operation to connect to the server providing the Web Service.
14. In the Alarm priority box, enter the alarm priority.
15. Click Next.
Continued on next page
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16. In the Create Web Service values list, select the values you want to add to
the Building Operation Web Service interface.

17. Click Create.

Note
The values in the Web Service interface have a default value until the first polling.
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118.5

Adding a New Value to the Web Service
Interface
You add a new value to the Web Service Interface if you want to change a value
from one object type to another object type.
For more information, see section 118.2 “Web Services ” on page 5064.

To add a new value to the web service interface
1. In WorkStation, in the System Tree pane, select the Web Service interface.
2. On the File menu, point to New and then click Value.
3. On the object list, select the value.
4. In the Name box, type a name for the value.

5. In the Description box, type a description for the value.
6. Click Next.
Continued on next page
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7. In the Select XPath list, select the XPath to the value you want to add to
Building Operation.

8. Click Create.
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118.6

Changing the XPath for a Value
You change the XPath if you want the XPath to point to another XML element.
For more information, see section 118.2 “Web Services ” on page 5064.

To change the XPath for a value
1. In WorkStation, in the System Tree pane, in the WebService interface, select
the value.
2. On the File menu, click Properties.
3. Click Advanced.

4. Click the Browse button

.
Continued on next page
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5. In the XPath Editor, select the value in the element.

6. Click OK.
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119.1 SOAP Web Service – Basic tab

119.1

SOAP Web Service – Basic tab
Use the Basic tab to view and edit the SOAP web service.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Status

Displays the status of the server providing
the Web Service.

Last updated

Displays the last time Building Operation
retrieved any information from the server
providing the Web Service.

Service URL

Type the URL to the server providing the
Web Service.

Operation

Displays the SOAP Operation.
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Property

Description

Operation parameters

The Operation Parameters are defined by
the WSDL-file and varies depending on the
selected SOAP Operation.

Username

Type the username if the server that
provides the Web Services requires a
username for authentication.

Password

Type the password if the server that
provides the Web Service requires a
password for authentication.

Confirm Password

Confirm the password to avoid that Building
Operation sends a system alarm due to
wrong password when trying to connect to
the server providing the Web Service.

Polling interval (s)

Enter the polling interval in seconds.

Polling enabled

Select to enable the polling function.

Alarm enabled

Select to enable Building Operation to send
a system alarm if Building Operation cannot
connect to the server providing the Web
Services.

No of retries before alarm

Enter the number of times Building
Operation tries to connect to the server
providing the Web Services before an alarm
is triggered.

Retry interval (s)

Enter the retry interval in seconds.

Alarm priority

Enter the priority level of the alarm.
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119.2

SOAP Web Service – Advanced Tab
Use the Advanced tab to view the XML-response.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XML-reponse

Displays the XML response. Read-only.

Technical
5085

119 Web Services User Interface
119.3 SOAP Web Service Wizard – Select SOAP Operation Page

119.3

SOAP Web Service Wizard – Select
SOAP Operation Page
Use the Select SOAP Operation page to configure the SOAP Web Service.

Figure: Select SOAP operation page

Table: Select SOAP Operation Page
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Property

Description

Enter the file path or URL to WSDL
file.

Enter the file path or URL to the WSDL file.

Get operations

Click to get the SOAP Operations from the
WSDL file.

Username

Type the username if the WSDL-file requires
a username for authentication.

Password

Type the password if the WSDL-file requires
a password for authentication.

Operation

Select the SOAP Operation.

Operation parameter

The Operation Parameters are defined by
the WSDL-file and varies depending on the
selected SOAP Operation.
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119.4

SOAP Web Service Wizard - Connection
Information Page
Use the Connection information page to establish the connection to the server
providing the SOAP Web Service.

Figure: Connection information page

Table: Connection Information Page
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Property

Description

Service URL

Type the URL to the server providing the
Web Service.

Polling interval

Enter the polling interval in seconds.

Username

Type the username if the server that
provides the Web Services requires a
username for authentication.

Password

Type the password if the server that
provides the Web Service requires a
password for authentication.

Alarm enabled

Select to enable Building Operation to send
a system alarm if Building Operation cannot
connect to the server providing the Web
Services.

Number of retries before alarm

Enter the number of times Building
Operation tries to connect to the server
providing the Web Services before an alarm
is triggered.
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Property

Description

Retry interval

Enter the retry interval in seconds.

Alarm priority

Enter the priority level of the alarm.
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119.5

SOAP Web Service Wizard – Create
Web Service Values
Use the Create Web Service values page to create the values that is used by
Building Operation.

Figure: Create web service values

Table: Create Web Service Values
Component

Description
Click to select all Web Service values.
Click to deselect all Web Service values.

[Filter]
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Use Quick Filter to filter out the Web Service
values you want to add to Building
Operation.
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119.6

Simple XML Web Service – Basic Tab
Use the Basic tab to view or edit the XML Web Services.

Figure: Basic tab

Table: Basic Tab
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Property

Description

Status

Displays the status of the server providing
the Web Service.

Last updated

Displays the last time Building Operation
retrieved any information from the server
providing the Web Service.

Service URL

Type the URL to the server providing the
Web Service.

Username

Type the username if the server that
provides the Web Services requires a
username for authentication.

Password

Type the password if the server that
provides the Web Service requires a
password for authentication.
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Continued
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Property

Description

Confirm Password

Confirm the password to avoid that Building
Operation sends a system alarm due to
wrong password when trying to connect to
the server providing the Web Service.

Polling interval (s)

Enter the polling interval in seconds.

Polling enabled

Select to enable the polling function.

Alarm enabled

Select to enable Building Operation to send
a system alarm if Building Operation cannot
connect to the server providing the Web
Services.

No of retries before alarm

Enter the number of times Building
Operation tries to connect to the server
providing the Web Services before an alarm
is triggered.

Retry interval (s)

Enter the retry interval in seconds.

Alarm priority

Enter the priority level of the alarm.
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119.7

Simple XML Web Service – Advanced
Tab
Use the Advanced tab to view the XML-response.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XML Response

Displays the XML response. Read-only.
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119.8

Simple XML Web Service Wizard –
Connection Information
Use the Connection information page to establish the connection to the server
providing the XML Web Service

Figure: Connection information page

Table: Connection Information Page
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Property

Description

Service URL

Type the URL to the server providing the
Web Service.

Polling interval

Enter the polling interval in seconds.

Username

Type the username if the server that
provides the Web Services requires a
username for authentication.

Password

Type the password if the server that
provides the Web Service requires a
password for authentication.

Alarm enabled

Select to enable Building Operation to send
a system alarm if Building Operation cannot
connect to the server providing the Web
Services.

Number of retries before alarm

Enter the number of times Building
Operation tries to connect to the server
providing the Web Services before an alarm
is triggered.
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Property

Description

Retry interval

Enter the retry interval in seconds.

Alarm priority

Enter the priority level of the alarm.
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119.9

Simple XML Web Service Wizard –
Create Web Service Values
Use the Create Web Service values page to create the values that is used by
Building Operation.

Figure: Create Web Service values page

Table: Create Web Service Values Page
Property

Description
Click to select all Web Service values.
Click to deselect all Web Service values.

[Filter]
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Use Quick Filter to filter out the Web Service
values you want to add to Building
Operation.
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119.10

Web Service Analog Value Properties –
Basic Tab
Use the Analog Value properties dialog box to view or configure an analog value.

Figure: Analog value

Table: Analog Value
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Property

Description

Force

Click to force a value. For more information,
see the Forced Values topic on WebHelp.
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119.11

Web Service Analog Value Properties –
Advanced Tab
Use the Advanced tab to change a Web Service value's XPath.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XPath

Click to open the XPath Editor to edit a
value's XPath. For more information, see
section 119.21 “XPath Editor” on page
5105.
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119.12

Web Service Multistate Value
Properties – Basic Tab
Use the Multistate Value properties dialog box to view or configure a multistate
value.

Figure: Multistate value

Table: Multistate Value
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Property

Description

Force

Click to force a value. For more information,
see the Forced Values topic on WebHelp.
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119.13

Web Service Multistate Value
Properties – Advanced Tab
Use the Advanced tab to change a Web Service value's XPath.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XPath

Click to open the XPath Editor to edit a
value's XPath. For more information, see
section 119.21 “XPath Editor” on page
5105.
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119.14

Web Service Digital Value Properties –
Basic Tab
Use the Digital Value properties dialog box to view or configure a digital value.

Figure: Digital value

Table: Digital Value
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Property

Description

Force

Click to force a value. For more information,
see the Forced Values topic on WebHelp.
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119.15

Web Service Digital Value Properties –
Advanced Tab
Use the Advanced tab to change a Web Service value's XPath.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XPath

Click to open the XPath Editor to edit a
value's XPath. For more information, see
section 119.21 “XPath Editor” on page
5105.

Technical
5101

119 Web Services User Interface
119.16 Web Service String Value Properties – Basic Tab

119.16

Web Service String Value Properties –
Basic Tab
Use the String Value properties dialog box to view or configure a string value.

Figure: String value

Table: String Value
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Property

Description

Force

Click to force a value. For more information,
see the Forced Values topic on WebHelp.
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119.17

Web Service String Value Properties –
Advanced Tab
Use the Advanced tab to change a Web Service value's XPath.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XPath

Click to open the XPath Editor to edit a
value's XPath. For more information, see
section 119.21 “XPath Editor” on page
5105.
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119.18

Web Service Time Stamp Value
Properties – Basic Tab
Use the Time Stamp Value properties dialog box to view or configure a time
stamp value.

Figure: Time stamp value

Table: Time Stamp Value
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Property

Description

Value

Enter a date and time
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119.19

Web Service Time Stamp Value
Properties – Advanced Tab
Use the Advanced tab to change a Web Service value's XPath.

Figure: Advanced tab

Table: Advanced Tab
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Property

Description

XPath

Click to open the XPath Editor to edit a
value's XPath. For more information, see
section 119.21 “XPath Editor” on page
5105.
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119.20

Create Web Service Value Wizard –
Select XPath Page
Use the Select XPath page to select the XPath to the value you create in a Web
Service interface.

Figure: Select XPath page

Table: Select XPath Page
Component

Description
Click to collapse the XML tree.
Click to expand the XML tree.
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XPath

Displays the address to the selected XMLelement.

Value

Displays the value in the selected XMLelement.
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119.21

XPath Editor
Use the XPath Editor to change the path to the XML-element in the value in the
Web Service interface in Building Operation.

Figure: XPath Editor

Table: XPath Editor Dialog Box
Component

Description
Click to collapse the XML tree.
Click to expand the XML tree.
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XPath

Displays the address to the selected XMLelement.

Value

Displays the value in the selected XMLelement.
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The Create Web Service Values Page in the Wizard is
Empty
SOAP Web Service Interface Cannot be Created

120 Web Services Troubleshooting
120.1 The Create Web Service Values Page in the Wizard is Empty

120.1

The Create Web Service Values Page in
the Wizard is Empty
The Create Web Service Values page in the Wizard is empty when you create a
Simple XML Web Service interface. If the values in the XML-file on the Web Service
server are within quotation marks they cannot be selected in the Create Wizard.

120.1.1

Solution
• Create the Simple XML Web Service interface. Ignore the fact that the Create
Web Service Values page is empty. Add the values on the Web Service Server
to your Simple XML Web Service interface using the XPath editor. For more
information, see section 118.5 “Adding a New Value to the Web Service
Interface ” on page 5075.

120.1.2
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120.2

SOAP Web Service Interface Cannot be
Created
The following error dialog is displayed.

Figure: Error parsing WSDL file

Ensure the WSDL-file meets these criteria:
• does not import other WSDL-files
• is in DOC style (RPC is not supported)
• does not contain array parameters.

120.2.1

Solution
• Download and edit the WSDL-file in a text editing tool such as notepad. Use
the edited file when you create the SOAP Web Service interface.

120.2.2

Solution
• Use Scripts and create a Script Web Service interface. For more information,
see section 53.2 “Script Web Services Workflow” on page 1919.
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Configuring the EcoStruxure Web Service Server
Filtering the Hardware Folder by Path
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Filter Alarms Using the Alarm Event Types Object
Common EcoStruxure Web Service Object Properties
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121 Corporate Web Services
121.1 EcoStruxure Web Services

121.1

EcoStruxure Web Services
EcoStruxure Web Services allows seamless sharing of operational data, including
alarms and historical information, between Building Operation software from
different Schneider Electric Business Units.
Building Operation can act in two ways regarding EcoStruxure Web Service: as a
server or as a client.

121.1.1

EcoStruxure Web Service Server
When Building Operation is an EcoStruxure Web Service server, it exposes objects,
such as values, to another EcoStruxure system that is an EcoStruxure Web Service
client. The EcoStruxure Web Service client can read and change values on the
Building Operation system depending on the configuration of the Building Operation
server.
For more information, see section 121.2 “EcoStruxure Web Service Server” on
page 5114.

121.1.2

EcoStruxure Web Service Client
When Building Operation is an EcoStruxure Web Service client, it consumes values
and trend logs from an EcoStruxure Web Service server. Depending on the
configuration of the EcoStruxure Web Service server, you might also be able to read
and write values, or acknowledge alarms tripped on the EcoStruxure Web Service
server system.
For more information, see section 121.7 “EcoStruxure Web Service Client” on page
5126.
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121.2

EcoStruxure Web Service Server
When Building Operation is an EcoStruxure Web Service server, it exposes objects,
such as values, to another EcoStruxure system that is an EcoStruxure Web Service
client. The EcoStruxure Web Service client can read and change values on the
Building Operation system depending on the configuration of the Building Operation
server.

121.2.1

Visibility of Folders and Object Types
When Building Operation is an EcoStruxure Web Service server, you can decide
what you want to expose to the EcoStruxure Web Service client. The best way to
do this is to create a domain or account used by the client. Domains and accounts
make it possible to specify the folders or objects you want to expose to the
EcoStruxure Web Service client. For more information, see the User Account
Management Overview topic on WebHelp.
In addition to a domain or account, you can use filters to decide what you want to
expose to the EcoStruxure Web Services client. For more information, see section
121.5 “Filtering the Hardware Folder by Path” on page 5119.

121.2.2

Client User Access
You can also configure the EcoStruxure Web Server in Building Operation to specify
what the users' of the EcoStruxure Web Service server are allowed to do on your
system. The default is that the users of the EcoStruxure Web Services client can
browse the system, read values, write values, force values, acknowledge alarms,
and collect records. However, you can change any of these settings. For example,
you can allow the EcoStruxure Web Service client users to browse the system and
acknowledge alarms, but not read, write, or force values.
For more information, see section 121.3 “Visibility of Folders and Object Types ” on
page 5115.
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121.3

Visibility of Folders and Object Types
The configuration for the EcoStruxure Web Service Server is done using the Control
Panel.
In the Filter Hardware Folder tab you can filter on paths or object types.

Figure: Filter hardware folder

121.3.1

Path Filter
Using the Filter Hardware Folder you can filter the folders that you do not want to
expose to the users of the EcoStruxure Web Service client.
As default everything is exposed. To use the filter you have to add a new Path filter.
The Path filter is then edited so that the selected folder is hidden for the user of the
EcoStruxure Web Service client.

Figure: The folders Building A and Building B are hidden for the users of the EcoStruxure
Web Service client in this example.

You can also hide different types of objects for the users of the EcoStruxure Web
Service client if you know the name of the object type in your system.
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121.3.2

Object Type Filter
You filter the Hardware folder by object type when you want to hide a specific type
of object in your system from an EcoStruxure Web Service client.
The object types that you filter on are identified by their system defined object
type's name. The system defined object types name, which is used internally by
the Building Operation server. For example, an analog value has the system defined
name "value.server.AV", and an Out of range alarm object has the system defined
name "alarm.OutOfRangeAlarm".
The EcoStruxure Web Service webservice.cws.consume.BaseObject is default and
cannot be changed.

Figure: An object type filter that hides all analog values, server.value.AV
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121.4

Configuring the EcoStruxure Web
Service Server
Use this procedure to configure you EcoStruxure Web Service server.
For more information, see section 121.2 “EcoStruxure Web Service Server” on
page 5114.

To configure the EcoStruxure Web Service Server
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click EWS Server Configuration.
Continued on next page
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4. In the Enforce secure communication list, select Enabled if you only
want to communicate using the https protocol.

5. In the Browse list select True to allow the EcoStruxure Web Service client to
browse your database.
6. In the Serve Value list select True to allow the EcoStruxure Web Service
client to get values from your system.
7. In the Value Write Mode list select Read/Write to allow the EcoStruxure
Web Service client to read and write values in your system.
8. In the Serve Alarm list select True to allow the EcoStruxure Web Service
client to receive alarms from your system.
9. In the Alarm Acknowledge list select Yes to allow a user on the
EcoStruxure Web Service client system to acknowledge alarms.
10. In the Serve History list select True to allow the EcoStruxure Web Service
client to collect trend log information from your system.
11. Save the settings.
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121.5

Filtering the Hardware Folder by Path
You filter the Hardware folder when you want to hide something in your Building
Operation system from an EcoStruxure Web Service client.
For more information, see section 121.2 “EcoStruxure Web Service Server” on
page 5114.

To filter the Hardware folder by path
1. On the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click EWS Server Configuration.
Continued on next page
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4. Click Filter Hardware Folder.

5. Under Filter Hardware Folder By Path, click Add

.

6. In the Name box, enter a name for the filter.

7. In the Description box, enter a description for the filter.
8. Click Create.
9. In the Name column, select the newly created path filter.
10. Click Edit

.
Continued on next page
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11. In the Path box, click Browse.

12. Select the folder or object you want to hide.
13. Click Select.
14. Click OK.
15. On the File menu, click Save.
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121.6

Filtering the Hardware Folder by Object
Type
You filter the Hardware folder by object type when you want to hide a specific type
of object in your Building Operation system from an EcoStruxure Web Service
client.
For more information, see section 121.3 “Visibility of Folders and Object Types ” on
page 5115.

To filter the Hardware folder by object type
1. In the System Tree pane, select an object of the type you want to hide.
2. On the File menu, click Properties.
3. Click General Information.
4. In the Type box, place the cursor over the visible object type name to display
the tooltip that contains the server object type name.

5. Record the server object type name.
6. On the Tools menu, click Control Panel.
Continued on next page
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7. On the Control Panel toolbar, select the server.

8. Click EWS Server Configuration.
9. Click Filter Hardware Folder.

Continued on next page

04-16006-04-en, March 2015

Technical
5125

121 Corporate Web Services
121.6 Filtering the Hardware Folder by Object Type

10. Under Filter Hardware Folder By ObjectType, click Add

.

11. In the Name box, enter a name for the filter.

12. In the Description box, enter a description for the filter.
13. Click Create.
14. In the Name column, select the newly created path filter.
15. Click Edit

.

16. In the ObjectType box, type the name of the object.

Continued on next page
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17. Click OK.
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121.7

EcoStruxure Web Service Client
When Building Operation is an EcoStruxure Web Service client, it consumes values
and trend logs from an EcoStruxure Web Service server. Depending on the
configuration of the EcoStruxure Web Service server, you might also be able to read
and write values, or acknowledge alarms tripped on the EcoStruxure Web Service
server system.
EcoStruxure Web Service can be used when you want to supervise a site in a
remote area, such as a transformer station. If the transformer station supports
EcoStruxure Web Service, you can add the alarms from the transformer station to
your own system. Another use is to collect trend log information from other systems
at your own site that supports EcoStruxure Web Service, for example energy
consumptions.
After you have created an EcoStruxure Web Service interface in Building Operation,
you can navigate the remote EcoStruxure Web Service server in the Hardware
Folder, under EcoStruxure Web Service, in your system. You can select any object
from the remote EcoStruxure Web Service server and create that object in your
Building Operation server. You can create one object, such as a value. You can also
create multiple objects, such as a folder and all its contents or a server and its
contents.
The number and type of the objects that you can navigate to is defined by the
remote EcoStruxure Web Service system.
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Figure: EcoStruxure Web Service interface in the hardware folder and in Building
Operation

An EcoStruxure Web Service with only a part of the objects from the remote system
can look like this:
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Figure: An EcoStruxure Web Service system with only one value created from the remote
system.
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121.7.1

Filter Alarms Using the Alarm Event Types
Object
All alarms that the remote EcoStruxure Web Service server decided to expose to
the EcoStruxure Web Service client are sent to the EcoStruxure Web Service client.
This is the default setting when you have created an EcoStruxure Web Service client
system. You can filter alarms using the Alarm Event Types object to reduce the
number of alarms from the remote EcoStruxure Web Service server.
For more information, see section 121.9 “Filter Alarms Using the Alarm Event Types
Object” on page 5132.

121.7.2

EcoStruxure Web Service Alarm Item
The EcoStruxure Web Service alarm item is a representation of an alarm on an
EcoStruxure Web Service. The alarm item is automatically created when you host
an EcoStruxure Web Service alarm on your system.
For more information, see section 121.8 “EcoStruxure Web Service Alarm Item” on
page 5131.

121.7.3

History Item
The History Item represents a trend log on the remote EcoStruxure Web Service
server. The values in this trend log can be transferred periodically using polling.
The polling is by default disabled when you create the EcoStruxure Web Service
server. Before you enable polling, consider the impact on communications in your
system. Many History items with polling enabled and short intervals might stress
communication.
To be able to poll from the remote EcoStruxure Web Service server, you have to
enable polling.
For more information, see section 121.13 “Enabling History Polling” on page 5140.

121.7.4

Common EcoStruxure Web Service Object
Properties
All EcoStruxure Web Service objects have a set of common properties that are
related to the communication between the EcoStruxure Web Service client and the
and the remote EcoStruxure Web Service server.
For more information, see section 121.10 “Common EcoStruxure Web Service
Object Properties” on page 5134.

121.7.5

Forced Values
You can force a value on the hosted system if the hosted system uses EcoStruxure
WebService server 1.2 or higher. Forcing and releasing a forced values works in the
same way as in Building Operation.
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For more information, see the Forced Values topic on WebHelp.

121.7.6

Host Values in Graphics and Watch Panes
You can host objects that are only present in a graphic or watch pane. This can be
useful when the hosted system contains a lot of objects but the important objects
are included in a graphic or a watch pane.
For example, the hosted system contains 500 different values from different part of
the system. You are only interested in the temperature values that measure the
temperature in the computer hall. To host all values will take a lot of time and
identifying the values that are related to the computer hall might be difficult. But the
administrator of the hosted system has placed all values from the computer hall in a
graphic. So instead of hosting all values you can host the graphic and get all the
values.
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121.8

EcoStruxure Web Service Alarm Item
The EcoStruxure Web Service alarm item is a representation of an alarm on an
EcoStruxure Web Service. The alarm item is automatically created when you host
an EcoStruxure Web Service alarm on your system.
The EcoStruxure alarm item can be configured in the same way as a Building
Operation alarm. But, you cannot make any changes to the conditions that trigger
the alarm.
You can override priority, messages, and categories generated in the EcoStruxure
Web Service alarm and replace them with new messages and categories in the
EcoStruxure Web Service alarm in the EcoStruxure Web Service client.
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121.9

Filter Alarms Using the Alarm Event
Types Object
All alarms that the remote EcoStruxure Web Service server decided to expose to
the EcoStruxure Web Service client are sent to the EcoStruxure Web Service client.
This is the default setting when you have created an EcoStruxure Web Service client
system. You can filter the Alarm Event Types object to filter and reduce the number
of alarms from the remote EcoStruxure Web Service server.
The Alarm Event Types object is created when you create an EcoStruxure Web
Service Interface. The Alarm Event Types object is located in the Hardware folder in
the System folder. To see the Alarm Event Types object in the System Tree pane,
you have to show non-presentation objects.

Figure: The Alarm Event Types object is located in the EcoStruxure Web Service folder
after you have created the EcoStruxure Web Service interface.

To use filtering you create the Alarm Event Types object.
When the Alarm Event Types object is created, it contains all the categories of
alarms from the remote EcoStruxure Web Service server. You can then disable the
alarm categories that you do not want.
To understand the meaning of the alarm categories, you have to contact the
administrator of the remote EcoStruxure Web Service server.
The Alarm Event Types object with the Low priority alarm and System alarm
categories enabled. The category Priority 1 alarm is not enabled and will not be
seen in your EcoStruxure Web Service client system.
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Figure: The Alarm Event Types object with the Low priority alarm and System alarm
categories enabled.

For more information, see section 121.14 “Filtering Alarms by Category” on page
5141.
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121.10

Common EcoStruxure Web Service
Object Properties
All EcoStruxure Web Service objects have a set of common properties that are
related to the communication between the EcoStruxure Web Service client and the
and the remote EcoStruxure Web Service server.
The EcoStruxure Web Service objects follow the EcoStruxure Web Service
standard, so they differ from their equivalent objects in Building Operation. When
you create an EcoStruxure Web Service system, Building Operation automatically
creates all the necessary objects.
You can also create objects directly in your system and, using the EcoStruxure Web
Service identity of the objects in the remote EcoStruxure Web Service system;
connect the objects to the objects on the remote system.

121.10.1

EcoStruxure Web Service Identity
All objects on the remote system are identified by their EcoStruxure Web Service
identity. If you know the objects EcoStruxure Web Service identity, you can change
the EcoStruxure Web Service identity or create an EcoStruxure Web Service object
and add the identity afterwards.
When you create an EcoStruxure Web Service object online, all identities of the
objects on the remote system are added to the EcoStruxure Web Service objects in
the system automatically.

121.10.2

State
The EcoStruxure Web Service State (EWS State) defines the state of the object on
the remote EcoStruxure Web Service system.
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State

Definition

Good

The communication between the
EcoStruxure Web Service client and the
remote EcoStruxure Web Service server is
working and the value is true.

Uncertain

The communication between the
EcoStruxure Web Service client and the
remote EcoStruxure Web Service server is
working but the value might be a database
value, and not a value from the sensor.

Forced

The value on the remote EcoStruxure Web
Service server is forced.

Offline

The device that collects the value on the
remote EcoStruxure Web Service server is
offline.
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Continued
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State

Definition

Error

Other type of error, for example, the
EcoStruxure Web Service identity on the
object on the remote EcoStruxure Web
Service server might have been changed or
the username and the password to access
the remote system has been changed.
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121.11

Creating an EcoStruxure Web Service
Interface
You create an EcoStruxure Web Service interface to enable communication with
another EcoStruxure System.
For more information, see section 121.7 “EcoStruxure Web Service Client” on page
5126.

To create an EcoStruxure Web Service interface
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create an EcoStruxure Web Service interface.
2. On the File menu, point to New and then click Interface.
3. In the object type list, expand Web Service and then click EcoStruxure
Web Service.

4. In the Name box, type a name for the EcoStruxure Web Service interface.
5. In the Description box, type a description for the EcoStruxure Web Service
Interface.
6. Click Next.
Continued on next page
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7. In the EWS Server box, type the URL to the EcoStruxure server.

8. In the Protocol box, select the protocol.
9. In the EWS Comm Port box, select the port.
10. In the User name box, type the user name.
11. In the Password box, type the password.
12. In the Confirm Password box, type the password again.
13. Click Create.
Active alarms tripped in the remote EcoStruxure Web Service system are visible in
your system at the next polling.
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121.12

Creating an EcoStruxure Web Service
Object
Use this procedure to create an EcoStruxure Web Service object in the Building
Operation server that you can use to edit and log values from the remote
EcoStruxure Web Service server.
For more information, see section 121.7 “EcoStruxure Web Service Client” on page
5126.

To create an EcoStruxure Web Service object
1. In WorkStation, in the System Tree pane, expand the Hardware folder.
2. In the EcoStruxure Web Services folder, expand the EcoStruxure Web
Service interface and then select the EcoStruxure object on the remote
system.

3. On the Actions menu, click Host EWS Object.
Continued on next page
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4. In the Select EWS Interface dialog box, select the EcoStruxure Web
Service interface.

5. Click Select.
The created objects are placed under the EcoStruxure Web Service interface.

04-16006-04-en, March 2015

Technical
5141

121 Corporate Web Services
121.13 Enabling History Polling

121.13

Enabling History Polling
You enable history polling when you want to receive history information from the
remote EcoStruxure Web Service server.
For more information, see section 121.7 “EcoStruxure Web Service Client” on page
5126.

To enable history polling
1. In WorkStation, in the System Tree pane, expand the EcoStruxure Web
Service interface.
2. Select the history object you want to enable history polling for.
3. On the File menu, click Properties.

4. In the History Polling box, select Enable.
5. Click OK.

Technical
5142

04-16006-04-en, March 2015

121 Corporate Web Services
121.14 Filtering Alarms by Category

121.14

Filtering Alarms by Category
You disable alarms from the EcoStruxure Web Service server so you receive only
the alarms that you want.
For more information, see section 121.7 “EcoStruxure Web Service Client” on page
5126.

To filter alarms by category
1. In WorkStation, in the System tree pane, expand the Hardware folder.
2. In the EcoStruxure Web Services folder, expand the EcoStruxure interface
and select Alarm Event Types.

3. On the Action menu, click Host EWS Objects.
4. Select the EcoStruxure Web Service interface.
5. Click Select.
6. In the System Tree pane, select the Alarm Event Types object you just
created.
7. On the File menu, click Properties.
Continued on next page
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8. Select the alarm category you do not want to receive and click Edit

.

9. Select No.

10. Click OK.
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122.1

EcoStruxure Web Service Interface
Properties – Basic Tab
Use the Basic tab to view or configure an EcoStruxure Web Service interface.

Figure: EcoStruxure Web Service interface properties – basic tab

Table: EcoStruxure Web Service Interface Properties – Basic Tab
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Property

Description

Status

Displays Online when the remote
EcoStruxure Web Service server is
communicating.

Last updated

Displays the last time Building Operation
retrieved any information from the remote
EcoStruxure Web Service server.

User name

Type the user name for the EcoStruxure
Web Service server.

Password

Type the password for the EcoStruxure Web
Service server.

Confirm Password

Type the password again.
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Continued
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Property

Description

Service URL

Type the URL to the remote server providing
the EcoStruxure Web Service.

Enable Communication

Select Disable to stop communication with
the remote EcoStruxure Web Service server.

Server EWS Version

Displays the EcoStruxure Web Service
server version.

Value Polling

Select Disable to stop the polling values
from the remote EcoStruxure Web Service
server.

Value Poll Interval (s)

Select the polling interval in seconds.

Alarm Polling

Select Disable to stop the polling of alarms
from the remote EcoStruxure Web Service
server.

Alarm Poll Interval (s)

Select the polling interval in seconds.

Filter Priority From

Enter the priority of the alarm to filter from.

Filter Priority To

Enter the priority of the alarm to filter to.

Alarm Enabled

Select Disable to stop Building Operation
from sending a system alarm if it cannot
connect to the remote EcoStruxure Web
Service server.

No of Retries Before Offline

Enter the number of times Building
Operation tries to connect to the remote
EcoStruxure Web Service server before an
alarm is triggered.

Retry Interval (s)

Enter the retry interval in seconds.

Alarm Priority

Enter the priority level of the system alarm
sent if the EcoStruxure Web Service server is
not communicating.
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122.2

EWS Server Properties – Basic Tab
Use the Basic tab to view or change the EcoStruxure Web Service server's
identity.

Figure: EcoStruxure Web Service server – basic tab

Table: EcoStruxure Web Service Server – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

Technical
5149

122 Corporate Web Services User Interface
122.3 EWS Device Properties – Basic Tab

122.3

EWS Device Properties – Basic Tab
Use the Basic tab to view or change the EWS Id of an EcoStruxure Web Service
device.

Figure: EcoStruxure Web Service device properties – basic tab

Table: EcoStruxure Web Service Device Properties – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.
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122.4

EWS Structure Properties – Basic Tab
Use the Basic tab to view or change the EcoStruxure Web Service structure's
identity.

Figure: EWS structure – basic tab

Table: EWS Structure – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.
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122.5

EWS Folder Properties – Basic Tab
Use the Basic tab to view or change the EcoStruxure Web Service folder's identity.

Figure: EWS folder – basic tab

Table: EWS Folder – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.
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122.6

EWS Integer Value Properties – Basic
Tab
Use the Basic tab to view or configure an EcoStruxure Web Service integer value.

Figure: EWS Integer value – basic tab

Table: EWS Integer Value – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.
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Property

Description

Value

Displays the value of the object on the
remote EcoStruxure Web Service server. For
more information, see section 121.10
“Common EcoStruxure Web Service Object
Properties” on page 5134.

Force value

Click to force the value of the object on the
remote EcoStruxure Web Service server. For
more information, see the Forced Values
topic on WebHelp.

EWS Writeable

Displays the read or write status of the
object on the remote EcoStruxure Web
Service server at the time it was created in
Building Operation. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS State

Displays the state of the object on the
remote EcoStruxure Web Service server.
This cannot be edited. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.
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122.7

EWS String Value Properties – Basic
Tab
Use the Basic tab to view or configure an EcoStruxure Web Service string value.

Figure: EWS String value – basic tab

Table: EWS String Value – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.
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Property

Description

Value

Displays the value of the object on the
remote EcoStruxure Web Service server. For
more information, see section 121.10
“Common EcoStruxure Web Service Object
Properties” on page 5134.

Forced value

Click to force the value of the object on the
remote EcoStruxure Web Service server. For
more information, see the Forced Values
topic on WebHelp.

EWS Writeable

Displays the read or write status of the
object on the remote EcoStruxure Web
Service server at the time it was created in
Building Operation. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS State

Displays the state of the object on the
remote EcoStruxure Web Service server.
This cannot be edited. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.
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122.8

EWS Long Value Properties – Basic Tab
Use the Basic tab to view or configure an EcoStruxure Web Service long value.

Figure: EWS Long value – basic tab

Table: EWS Long Value – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.

Value

Displays the value of the object on the
remote EcoStruxure Web Service server. For
more information, see section 121.10
“Common EcoStruxure Web Service Object
Properties” on page 5134.
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Property

Description

Forced value

Click to force the value of the object on the
remote EcoStruxure Web Service server. For
more information, see the Forced Values
topic on WebHelp.

EWS Writeable

Displays the read or write status of the
object on the remote EcoStruxure Web
Service server at the time it was created in
Building Operation. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS State

Displays the state of the object on the
remote EcoStruxure Web Service server.
This cannot be edited. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.
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122.9

EWS DateTime Value Properties – Basic
Tab
Use the Basic tab to view or configure an EcoStruxure Web Service DateTime
value.

Figure: EWS DateTime value – basic tab

Table: EWS DateTime Value – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.
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Property

Description

Value

Displays the value of the object on the
remote EcoStruxure Web Service server. For
more information, see section 121.10
“Common EcoStruxure Web Service Object
Properties” on page 5134.

EWS Writeable

Displays the read or write status of the
object on the remote EcoStruxure Web
Service server at the time it was created in
Building Operation. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS State

Displays the state of the object on the
remote EcoStruxure Web Service server.
This cannot be edited. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.
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122.10

EWS Boolean Value Properties – Basic
Tab
Use the Basic tab to view or configure an EcoStruxure Web Service boolean value.

Figure: EWS Boolean value – basic tab

Table: EWS Boolean Value – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.
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Property

Description

Value

Displays the value of the object on the
remote EcoStruxure Web Service server. For
more information, see section 121.10
“Common EcoStruxure Web Service Object
Properties” on page 5134.

Forced value

Click to force the value of the object on the
remote EcoStruxure Web Service server. For
more information, see the Forced Values
topic on WebHelp.

EWS Writeable

Displays the read or write status of the
object on the remote EcoStruxure Web
Service server at the time it was created in
Building Operation. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS State

Displays the state of the object on the
remote EcoStruxure Web Service server.
This cannot be edited. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.
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122.11

EWS Double Value Properties – Basic
Tab
Use the Basic tab to view or configure an EcoStruxure Web Service double value.

Figure: EWS double value properties – basic tab

Table: EWS Double Value Properties – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.
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Property

Description

Value

Displays the value of the object on the
remote EcoStruxure Web Service server. For
more information, see section 121.10
“Common EcoStruxure Web Service Object
Properties” on page 5134.

Force value

Click to force the value of the object on the
remote EcoStruxure Web Service server. For
more information, see the Forced Values
topic on WebHelp.

EWS Writeable

Displays the read or write status of the
object on the remote EcoStruxure Web
Service server at the time it was created in
Building Operation. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS State

Displays the state of the object on the
remote EcoStruxure Web Service server.
This cannot be edited. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.
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122.12

EWS History Item Properties – Basic
Tab
Use the Basic tab to view or configure an EcoStruxure Web Service history item.

Figure: EWS History item – basic tab

Table: EWS History Item – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Type

Displays the type of the object on the remote
EcoStruxure Web Service server. This
cannot be edited. For more information, see
section 121.10 “Common EcoStruxure Web
Service Object Properties” on page 5134.
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Property

Description

Value Item Id

Displays the EcoStruxure Web Service
identity of the monitored value on the remote
system. For more information, see section
121.10 “Common EcoStruxure Web Service
Object Properties” on page 5134.

History Polling

Select to enable polling of historical data
from the remote EcoStruxure Web Service
system.

History Poll Interval

Enter the poll interval in seconds.

Initial Timespan

Enter the time span of the first collection of
records.

Log Size

Enter the number of records of the Building
Operation history item.

Log Buffer

Used only to present unit in the EcoStruxure
Web Service context.
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122.13

EWS Alarm Item Properties – Basic Tab
Use the Basic tab to view or configure an EcoStruxure Web Service alarm item.

Figure: EWS Alarm item – basic tab

Table: EWS Alarm Item – Basic Tab
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Property

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Alarm State

Displays the alarm state of the alarm object
on the remote system. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS ValueItemId

Displays the EcoStruxure Web Service
identity of the monitored value on the remote
system. For more information, see section
121.10 “Common EcoStruxure Web Service
Object Properties” on page 5134.
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Property

Description

Override message

Select to override the alarm message that
originates in the alarm from the EcoStruxure
Web Service server.

Alarm message

Type the message to display when the alarm
on the EcoStruxure Web Service server is
triggered.

Reset message

Type the message to display when the alarm
on the EcoStruxure Web Service server is
reset.

Override priority

Select to override the alarm priority that
originates in the alarm from the EcoStruxure
Web Service server.

Alarm priority

Enter the priority level that is displayed when
the alarm on the EcoStruxure Web Service
server is triggered.

Reset priority

Enter the priority level that is displayed when
the alarm on the EcoStruxure Web Service
server is reset.
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122.14

EWS Alarm Item Properties – Advanced
Tab
Use the Advanced tab to configure an EcoStruxure Web Service alarm item.

Figure: EWS Alarm Item properties – advanced tab

Table: EWS Alarm Item Properties – Advanced Tab
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Component

Description

Flashing alert

Select to display a flashing alert in the Alarms
pane and the Alarm Views when the alarm is
triggered.

Audible alert

Select to make an audible alert when the
alarm is triggered.

Override category

Select to override the alarm category that
originates in the alarms from the
EcoStruxure server.

Category

Enter the category that the alarm belongs to.

Cause note group

Enter the cause note group that is used by
the alarm.
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Continued
Component

Description

Action note group

Enter the action note group that is used by
the alarm.

Checklist

Enter the checklist that belongs to the alarm.

Checklist required

Select to force the user to check each step
in the checklist before the alarm can be
acknowledged.
Edit

(Action Requirements)

Click to open the property pane of the
selected user action where you edit the user
action. For more information, see the User
Action Properties topic on WebHelp.
Add

(Attachments)

Click to start the Attachment Wizard where
you can add an attachment. For more
information, see section 9.11 “Create Object
Wizard – Naming the Object Page” on page
322.
Edit

(Attachments)

Click to open the property pane of the
selected attachment where you configure
the attachment. For more information, see
the Attachment Properties topic on
WebHelp.
Remove

(Attachments)
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Click to remove an attachment that is
connected to the alarm.
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122.15

EWS Alarm Item – Configuration Tab
Use the Configuration tab to view or configure an EcoStruxure Web Service
alarm item.

Figure: EWS Alarm Item – Configuration tab

Table: EWS Alarm Item – Configuration Tab
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Component

Description

EWS Id

Displays the EcoStruxure Web Service
identity of the object on the remote
EcoStruxure Web Service server. For more
information, see section 121.10 “Common
EcoStruxure Web Service Object Properties”
on page 5134.

EWS Alarm state

Displays the alarm state of the alarm object
on the remote system. For more information,
see section 121.10 “Common EcoStruxure
Web Service Object Properties” on page
5134.

EWS Value Item Id

Displays the EcoStruxure Web Service
identity of the monitored value on the remote
system. For more information, see section
121.10 “Common EcoStruxure Web Service
Object Properties” on page 5134.

Technical
5171

122 Corporate Web Services User Interface
122.16 EWS Alarm Item - Presentation Tab

122.16

EWS Alarm Item - Presentation Tab
Use the Presentation tab to configure and view the presentation of the
EcoStruxure Web Service alarm item.

Figure: EWS Alarm Item - Presentation tab

Table: EWS Alarm Item - Presentation Tab
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Property

Description

Override message

Select to override the alarm message that
originates in the alarm from the EcoStruxure
Web Service server.

Alarm message

Type the message to display when the alarm
on the EcoStruxure Web Service server is
triggered.

Reset message

Type the message to display when the alarm
on the EcoStruxure Web Service server is
reset.

Override priority

Select to override the alarm priority that
originates in the alarm from the EcoStruxure
Web Service server.

Alarm priority

Enter the priority level that is displayed when
the alarm on the EcoStruxure Web Service
server is triggered.

Reset priority

Enter the priority level that is displayed when
the alarm on the EcoStruxure Web Service
server is reset.
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Property

Description

Override category

Select to override the alarm category that
originates in the alarms from the
EcoStruxure server.

Category

Enter the category that the alarm belongs to.

Flashing alert

Select to display a flashing alert in the Alarms
pane and the Alarm Views when the alarm is
triggered.

Audible alert

Select to make an audible alert when the
alarm is triggered.
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122.17

Alarm Event Types Properties
Use the Basic tab to view and filter alarm categories when Building Operation is an
EcoStruxure Web Service client.

Figure: Alarm event types

Table: Alarm Event Types
Property

Description

Name

Displays the name of the alarm categories
on the EcoStruxure Web Service server.

Enabled

Click Yes to recieve this alarm category from
the EcoStruxure Web Service server.
Click to add a new category to the filter.

Add
Edit

Remove
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Click to open the Edit dialog to recieve the
alarm category from the EcoStruxure Web
Service server.
Click to remove an alarm category from the
filter.
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122.18

Alarm Event Types Configuration
Settings Dialog
You enable alarm events types to receive alarms from the hosted EcoStruxure Web
Service server.

Figure: Alarm event types configuration settings dialog

Table: Alarm Event Types Configuration Settings Dialog
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Property

Description

Configuration Settings

Select enable to receive alarms of the
selected category from the hosted
EcoStruxure Web Service server.
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122.19

EWS Server Configuration – Basic Tab
Use the EWS Server Configuration basic tab to configure the operations that
Building Operation provides to an EcoStruxure system.

Figure: EWS server configuration – basic tab

Table: EWS Server Configuration – Basic Tab
Property

Description

Enforce secure communication

Select Enable to use only HTTPS protocol
for secure communication, rather than HTTP
and HTTPS.

Browse

Select True to allow the EcoStruxure Web
Service client to browse your database.
If you select True for Browse and select
False for Serve Value, the users of the
EcoStruxure Web Service client can browse
the EcoStruxure Web Service server but
cannot see the values.

Server Value
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Select True to allow the EcoStruxure Web
Service client to get values from your
system.
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Property

Description

Value Write Mode

Select Read/Write to allow the
EcoStruxure Web Service client to read and
write values in your system.

Serve Alarm

Select True to allow the EcoStruxure Web
Service client to receive alarms from your
system.

Alarm Acknowledge

Select Yes to allow a user on the
EcoStruxure Web Service client to
acknowledge alarms.

Serve History

Select True to allow the EcoStruxure Web
Service client to collect trend log information
from your system.
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122.20

EWS Server Configuration – Filter
Hardware Folder Tab
Use the Filter Hardware Folder tab to filter what you want to expose to another
EcoStruxure System when Building Operation is an EcoStruxure Web Service
server.

Figure: Filter hardware folder

Table: Filter Hardware Folder
Property

Description

Name

Displays the name of the hardware filter.

Path

The path to the folder you want to display to
an EcoStruxure Web Service client.

Add

Click to open the Create New Object
Wizard where you create a new filter.

Edit

Click to open the properties dialog and edit
the hardware filter.
Click to remove a hardware filter.

Remove
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Continued
Property

Description

Name

Displays the name of the object type filter.

ObjectType

Displays the object type name.

Add

Edit

Click to open the Create New Object
Wizard where you create a new object type
filter.
Click to open the properties dialog and edit
the selected object type filter.
Click to remove the object type.

Remove
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122.21

EWS Consume Configuration Properties
Use the EcoStruxure Consume Configuration Properties to configure
timeouts.

Figure: EWS consume configuration

Table: EWS Consume Configuration Properties
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Property

Description

Receive Timeout

Enter the time the consuming EcoStruxure
server waits for a request to be
acknowledged.

Sent Timeout

Enter the time the consuming EcoStruxure
Web Service server waits for a request to be
sent .

Connect Timeout

Enetr the time the consuming EcoStruxure
Web Service server waits before the
connection has been acknowledged. This
timeout terminates the connection if the
server is offline or disconnected.
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122.22

Create Object EcoStruxure Web Service
Wizard – Connection Information
Use the Connection Information dialog box to configure the EcoStruxure Web
Service interface connection.

Figure: Connection information

Table: Connection Information
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Property

Description

EWS Server

Type the URL to the remote EcoStruxure
server.

Protocol

Select the protocol.

EWS Comm Port

Enter the communication port.

EWS Path

Type the EWS path.

User name

Type the user name for the EcoStruxure
Web Service server.

Password

Type the password for the EcoStruxure Web
Service server.

Confirm Password

Type the password again.
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123 Security
123.1 Security Overview

123.1

Security Overview
Building Operation has a number of features that helps you increase the security in
your system.

123.1.1

Firewall
You can configure the devices that are allowed to communicate with the
Automation Server to prevent connection attempts from unauthorized devices. The
IP addresses of the devices that are allowed to communicate with the Automation
Server are added to the whitelist.
For more information, see section 123.3 “Firewall” on page 5189.

123.1.2

Password Policy
You can increase the password security by setting up a password policy that
defines how passwords must be created by the users.
For more information, see section 123.6 “Password Policy” on page 5193.

123.1.3

Automatic Log Off
The automatic logoff function makes it possible for the system to automatically log
off a user after a specified time of inactivity.
For more information, see the Automatic Logoff topic on WebHelp.

123.1.4

Security Banner
A security banner is displayed when a user enters a secure system. The security
banner notifies the user of the legal rights connected to the use of the information in
the secure system.
For more information, see section 123.8 “Security Banner ” on page 5196.

123.1.5

Certificates
Building Operation supports certificates. Certificates are electronic credentials that
are used to certify the identities of computers, and other entities on a network.
For more information, see section 123.10 “Certificates” on page 5198.

123.1.6

Encrypted Communication
To increase the security of your data, you can disable incoming HTTP
communication and allow only high security communication.
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For more information, see section 123.16 “Encrypted Communication” on page
5211.

123.1.7

Web Server Access Logging
You can log all web server HTTP access to the Enterprise Server.
For more information, see section 123.21 “Web Server Access Logging” on page
5219.

123.1.8

Automation Server Remote System Logging
You can log all successful and unsuccessful attempt to log on to your Automation
Server.
For more information, see section 123.23 “Automation Server Remote System
Logging” on page 5222.

123.1.9

SmartStruxure Connect
To prevent data transfer over the cloud server, you can disable the transfer of
system information and crash information of the Enterprise Server and its
Automation Servers.
For more information, see the Connect Agent topic on WebHelp.

123.1.10

DIACAP
The DoD Information Assurance Certification and Accreditation Process (DIACAP) is
a United States Department of Defense (DoD) process that means to ensure that
companies and organizations apply risk management to information systems.
For more information, see section 123.2 “DIACAP” on page 5185.
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123.2

DIACAP
The DoD Information Assurance Certification and Accreditation Process (DIACAP) is
a United States Department of Defense (DoD) process that means to ensure that
companies and organizations apply risk management to information systems.
Use the following information as you work towards making your system consistent
with DIACAP.

123.2.1

Files with SGID or SUID Bits Set
The owner, group-owner, mode, ACL, and location of files with setuid bit or setgid
bit must be documented using site-defined procedures.
This affects the following Linux files:
Permissions Owner Group Path
SUID files:
-rws--x--x root root /usr/bin/
-rws--x--x root root /usr/bin/
SGID files:
All files in the following directorires:
drwsxrws--- app app /var/sbo/db/
drwsxrws--- app app /var/sbo/db_backup/
drwsxrws--- app app /var/sbo/webstation/

123.2.2

Accounts
Make sure to create accounts with the appropriate access rights and command
execution permissions. For more information, see the User Account Management
Overview topic on WebHelp.
Users are normally organized in groups. For more information, see the User
Accounts and User Account Groups topic on WebHelp.
Control the user's permission to access different parts of the system using Software
permissions. For more information, see the Software Permissions topic on
WebHelp.
New domains should be set up so that they do not have access to the Local
Domain. For more information, see the Domains topic on WebHelp.
Do not use the anonymous guest log on in WebStation. For more information, see
the Guest Log On in WebStation topic on WebHelp.

123.2.3

Disable HTTP
Disable HTTP so that only HTTPS can be used for communication. For more
information, see section 123.17 “Disabling Incoming HTTP Communication” on
page 5212.
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123.2.4

High Security Encryption
Use only high security encryption. For more information, see section 123.18
“Disabling MD5 Encryption” on page 5214.

123.2.5

Web Services and EcoStruxure Web Service
The EcoStruxure Web Service does not work when high encryption mode is used
due to the use of the MD5 algorithm. You can still use an Automation Server or
Enterprise Server as EcoStruxure Web Service server if you use HTTPS for
communication. For more information, see section 121.1 “EcoStruxure Web
Services” on page 5113.
Do no connect to any SOAP or Simple XML Web Service server in your system if
you do not use HTTPS for communication. For more information, see section 118.2
“Web Services ” on page 5064.

123.2.6

Software Version on the Automation Server
Check the software version on the Automation Server using Device Administrator or
WorkStation to understand which features are available on the Automation Server.
For more information, see section 123.25 “Checking the Software Version on the
Automation Server Using Device Administrator” on page 5225.
For more information, see section 123.26 “Checking the Software Version on the
Automation Server Using WorkStation” on page 5226.

123.2.7

Authenticated Network Time
Using authenticated network time decreases the risk that someone tampers with
the time setting. For more information, see the Synchronizing Time Settings on
Multiple Automation Servers topic on WebHelp.

123.2.8

Disable Dynamic Domain Name Service
Updates
For more information, see section 123.29 “Disable Dynamic Domain Name System
(DNS) Updates” on page 5229.

123.2.9

Disable Dynamic Host Configuration Protocol
For more information, see section 3.19 “Configuring an Automation Server to Use
DHCP” on page 162.
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123.2.10

Domain Name Service Configuration
For more information, see section 3.18 “Setting the Automation Server IP Address”
on page 160.

123.2.11

CA Certificate Installation
Add and activate CA certificates on your Automation Server or Enterprise Server.
For more information, see section 123.11 “Adding a Certificate” on page 5199.
For more information, see section 123.13 “Activating a Certificate” on page 5206.

123.2.12

Web Server Ports
The ports used by WebStation to communicate with an Enterprise Server or an
Automation Server can be changed. For more information, see section 13.2
“Configuring the Automation Server TCP/IP Settings and Ports” on page 394.

123.2.13

Password Policies
For more information, see section 123.7 “Configuring the Password Policy” on page
5194.

123.2.14

DoD Logon Banner
For more information, see section 123.9 “Adding a Security Banner ” on page 5197.

123.2.15

Disable Error Reporting to Schneider Electric
Connect Agent is the service that runs along with the Enterprise Server to collect
and transfer system information and crash information of multiple servers
(Enterprise Server and Automation Servers attached to it). The information is sent to
Schneider Electric.
To disable the Connect Agent function, use the procedure Configuring Connect
Agent Settings and set Enable system information transfer and Enable
crash information transfer to False. For more information, see the Configuring
Connect Agent Settings topic on WebHelp.

123.2.16

Enable Automation Server Remote Logging
You can remotely transfer the system log from your Automation Server.
For more information, see section 123.24 “Enabling Automation Server Remote
System Logging” on page 5223.
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123.2.17

Enable Access Logging for SNMP
SNMP for managing Automation Servers is not recommended. However, if for
some reason you still want to use SNMP for managing Automation Servers, be sure
to log the SNMP access. For more information, see section 123.27 “Enabling
Access Logging for SNMP” on page 5227.

123.2.18

IP Whitelist Configuration
Use the whitelist in the Firewall to make sure that only authorized IP addresses are
allowed to connect to the Automation Server. For more information, see section
123.4 “Adding a Device to the Whitelist” on page 5190.

123.2.19

Disable SNMP
SNMP for managing Automation Servers is not recommended. It is disabled by
default. Make sure that SNMP is not enabled. For more information, see section
123.30 “Disabling SNMP for Managing an Automation Server” on page 5230.
SNMP Notification for alarms can be used.

123.2.20

SSH Lockout Time
You can set the lock out time to infinity so that that a user only has three
unsuccessful log on attempts. For more information, see section 123.19 “Setting
the SSH Console Lockout Time” on page 5216.
Only a user with administrator rights can unlock the lock out time.

123.2.21

Enable Access Logging for HTTP
You can log all web server HTTP access to the Automation Server and Enterprise
Server.
For more information, see section 123.22 “Enabling Web Server Access Logging”
on page 5220.

123.2.22

Virus Protection Routines
The Automation Server does not use an automatic virus protection tool.
To mitigate the computer virus vulnerabilities, any standard type documentation file
(Word, Excel, HTML) must be scanned by a virus scanner tool prior to uploading
onto an Automation Server.
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123.3

Firewall
You can configure the devices that are allowed to communicate with the
Automation Server to prevent connection attempts from unauthorized devices. The
IP addresses of the devices that are allowed to communicate with the Automation
Server are added to the whitelist.
The devices IP addresses are specified in the whitelist by their IP addresses or by
specifying an address mask that includes the devices address. This makes it
possible to add a mask of IP addresses to the whitelist using CIDR notation. The
whitelist can be edited at any time.
The default whitelist, 0.0.0.0/0, allows all devices to communicate with the
Automation Server. When you add devices to the whitelist, only the devices on the
whitelist can communicate.
The maximum allowed size of a whitelist is 2048 bytes, approximately 100 devices.

Caution
When you start to add devices to the whitelist using a network connection, make
sure that you add the computer you are using to the whitelist. If you do not add
the computer you are using to the whitelist, you lock yourself out from the
Automation Server.
If you lock yourself out, you can connect to, Automation Server using the USB
and then reset the whitelist. For more information, see section 3.11 “Connecting
to an Automation Server Using the USB Device Port” on page 153.
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123.4

Adding a Device to the Whitelist
You add a device to the whitelist so that it can communicate with the Automation
Server.
For more information, see section 123.3 “Firewall” on page 5189.

Caution
When you start to add devices to the whitelist using a network connection, make
sure that you add the computer you are using to the whitelist. If you do not add
the computer you are using to the whitelist, you lock yourself out from the
Automation Server.
If you lock yourself out, you can connect to, Automation Server using the USB
and then reset the whitelist. For more information, see section 3.11 “Connecting
to an Automation Server Using the USB Device Port” on page 153.

To add a device to the whitelist
1. In Device Administrator, select the Automation Server.
2. On the View menu, click Properties.
3. Click the Firewall tab.
Continued on next page
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4. In the Whitelist box, type the IP numbers. A whitespace is required between
every IP address in the list.

Tip
To add a complete subnet of IP addresses, add the subnet
according to the CIDR network prefix notation syntax.
If you use the addressing as in the screen capture above, the
following devices have access to the Automation Server:
10.158.232.18, 10.158.236.9, and the devices with the addresses
138.96.58.0, that is 138.96.58.0 to 138.96.58.255.
5. Click OK.
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123.5

Removing a Device from the Whitelist
You remove devices from the whitelist when you no longer want them to
communicate with the Automation Server.
For more information, see section 123.3 “Firewall” on page 5189.

To remove a device from the whitelist
1. In Device Administrator, select the Automation Server.
2. On the View menu, click Properties.
3. Click the Firewall tab.
4. Remove the device from the whitelist.
5. Click OK.

Tip
If you want to clear the whole list, click Reset whitelist and then
click OK.
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123.6

Password Policy
You can increase the password security by setting up a password policy that
defines how passwords must be created by the users.
For example, you can set the number of characters in the password, the number of
upper case and lower case characters that must be included in the password, and
how many days that the password can be used before the user needs to change it.
Password policy uses the Lead and Shadow Relationship. The Password policy
settings are sent to all attached servers in the system and can only be edited on the
lead server.
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123.7

Configuring the Password Policy
You configure the password policy to increase the password security on your
system.
For more information, see section 123.6 “Password Policy” on page 5193.

To configure the password policy
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. Click Password policy.
Continued on next page
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5. In the Password Policy dialog, configure the password policy.

6. Click the Save button
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123.8

Security Banner
A security banner is displayed when a user enters a secure system. The security
banner notifies the user of the legal rights connected to the use of the information in
the secure system.
The banner is displayed for all users that enter the system regardless of their
domains or rights and regardless of if they enter using WorkStation or WebStation.

Important
WebStation users are logged off from WebStation when they reload a page if they
are a member of a group where the group members are automatically logged off
and the security banner is displayed.
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123.9

Adding a Security Banner
You add a security banner to your system to notify the user that the user is entering
a secure system.
For more information, see section 123.8 “Security Banner ” on page 5196.

To add a security banner
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. In the Display Security Banner box, select On.
5. Click Edit banner.
6. Type the text you want to display in the security banner.
7. Click OK.
8. Click Save
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123.10

Certificates
Building Operation supports certificates. Certificates are electronic credentials that
are used to certify the identities of computers, and other entities on a network.
Building Operations supports both self-signed certificates and certificates issued by
a certificate authority. Certificates cannot be added in projects using the Project
Configuration Server. Certificates are included in a backup and restored on the
restored Enterprise Server or Automation Server.
You can add an existing certificate or generate a certificate. You then activate the
certificate.
The access to the certificate management in Building Operation can be set so that
certificates can only be handled by authorized users.

123.10.1

Default Certificates
Building Operation uses a default certificate that only supports encryption. The
default certificate is installed by default on all Enterprise Server and Automation
Servers. When a user logs on to a server, the user is notified in the Security
certificate risk dialog box that the certificate cannot be validated.
The user must click trust to continue to log on to the system. This dialog box cannot
be turned off. The warning is displayed each time the user log on.

123.10.2

Self-Signed Certificate
You can activate a self-signed certificate in Automation Server and Enterprise
Server. The self-signed certificate can be generated in Building Operation or in
another tool.
When Building Operation is used to generate self-signed certificates, certificates
can be generated for one or many servers at the same time.
When the user logs on to the Building Operation server with an activated self-signed
certificate the user is notified if the certificate is not valid. In this case the user can
choose to always trust the certificate. If trusted, the self-signed certificate's public
key is stored in the certificate list in Windows. The next time the user logs on to the
Building Operation server, Windows recognizes the certificate and the user can log
on without trusting the certificate again.

123.10.3

CA Certificates
Building Operation supports CA certificates, certificates issued by a certificate
authority. The supported file format is PEM. Each certificate can include up to three
separate files.

123.10.4

Status of Certificate
The user can check the status of the certificate by clicking the lock in WorkStation
or WebStation.
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123.11

Adding a Certificate
You add a certificate to your system to increase security.
For more information, see section 123.10 “Certificates” on page 5198.

To add a certificate
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. Click Certificate.
Continued on next page
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5. Click the Show/Hide Certificate settings button

.

6. Select the server where you want to add the certificate.
7. Click Manage Certificate.
8. Click the Add certificate button

.

9. Click Add existing certificate.
10. In the Name box, enter a name for the certificate.
Continued on next page
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11. In the Description box, enter a description.

12. In the Host certificate box, enter the host certificate.
13. In the Intermediate Certificate box, enter the intermediate certificate.
14. In the Private key box, enter the private key.
15. In the Password box, enter the password.
16. Click OK.
Now that you have added a certificate, you need to activate the certificate for it to
be in effect.
For more information, see section 123.13 “Activating a Certificate” on page 5206.
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123.12

Generating a Certificate
Generate a self-signed certificate to improve the security in your system.
For more information, see section 123.10 “Certificates” on page 5198.

Note
Generating a certificate may take some time. This is particularly true when you
batch generate certificate for many Automation Servers at one time.

To generate a certificate
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. Click Certificates.
Continued on next page
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5. Click the Show/Hide Certificate settings button

.

6. Select the servers in the server list.
7. Click Manage Certificate.
8. Click Generate certificate.

Continued on next page

04-16006-04-en, March 2015

Technical
5205

123 Security
123.12 Generating a Certificate

9. In the Name box, type a name for the certificate.

10. In the Description box, type a description.
11. In the Common name box, type the DNS address or IP address of the
server where the certificate is used.
12. Select Use IP/DNS from communication settings to automatically
collect the IP address or DNS address from the communication setting on the
server and add it to the certificate.
13. In the Email address box, type the email address to the person or unit that
is responsible for the certificate.
14. In the Organizational unit box, type the organizational unit responsible for
the certificate.
15. In the Organization box, type the name of the organization responsible for
the certificate.
16. In the Country box, select the country.
17. In the Valid from box, displays the time when the certificate starts. This date
is always the current date.
18. In the Valid to box, enter the date when the certificate expires.
19. In the Password box, enter a password.
20. In the Confirm password box, type the password again.
21. Click OK.
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Now that you have added a certificate, you need to activate the certificate for it to
be in effect.
For more information, see section 123.13 “Activating a Certificate” on page 5206.
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123.13

Activating a Certificate
You activate a certificate so it is in effect.
For more information, see section 123.10 “Certificates” on page 5198.

To activate a certificate
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. Click Certificates.
5. Click the Show/Hide Certificate settings button

.

6. Click on the server in the server list.
Continued on next page
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7. In the Certificate list, select the certificate you want to activate.

8. Click the Save button

.

The certificate is activated immediately after you have saved the setting.
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123.14

Removing a Certificate
You remove certificates that you do not want to use anymore.
For more information, see section 123.10 “Certificates” on page 5198.

To remove a certificate
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. Click Certificates.
5. Click the Show/Hide Certificate settings button

.

6. In the server list, select the servers.
7. Click Manage Certificates.
8. Select the certificate you want to remove.
Continued on next page
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9. Click the Remove certificate button

.

10. In the Confirm Delete dialog box, click Yes.
11. Click Close.
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123.15

Checking the Status of the Certificate
You can check the status of the certificate in WorkStation and WebStation.

To check the status of the cerificate
1. In WorkStation, click the lock in the Status bar. In WebStation, click the lock in
the Address field and then click View Certificates.
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123.16

Encrypted Communication
To increase the security of your data, you can disable incoming HTTP
communication and MD5 encryption.

123.16.1

Disable HTTP Communication
HTTP communication is disabled to increase the security of your system. Only the
incoming HTTP communication is affected, so disabling HTTP communication does
not affect Building Operation as an EcoStruxure web service server. An
EcoStruxure web service client can still receive information from a server where
HTTP communication is disabled.
When HTTP is disabled, HTTPS must be used. In this case all communication
between Building Operation servers and client like WebStation and WorkStation
must use HTTPS.

123.16.2

Disable MD5 Encryption
If you want the Building Operation servers to use only strong algorithms for
encryption, such as AES128 and SHA256, you have to disable MD5 encryption.
MD5 encryption must be disabled for you to use Federal Information Processing
Standards (FIPS).

123.16.3

Redirect Web Client to HTTPS
You can force users to only use HTTPS when they access an Enterprise Server or
Automation Server using WebStation.
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123.17

Disabling Incoming HTTP
Communication
You disable incoming HTTP communication to increase the data security of your
system.
For more information, see section 123.16 “Encrypted Communication” on page
5211.

To disable incoming HTTP communication
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

Continued on next page
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4. Select Disable incoming HTTP communication.

5. Click the Save button
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123.18

Disabling MD5 Encryption
You disable MD5 encryption when you want the Building Operation servers to use
only strong algorithms for encryption.
For more information, see section 123.16 “Encrypted Communication” on page
5211.

To disable MD5 encryption
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

Continued on next page
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4. Select Disable MD5 encryption.

5. Click the Save button
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123.19

Setting the SSH Console Lockout Time
You can set a lockout time on the SSH Console to prevent brute-force attacks.

To set the SSH Console Lockout Time
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

4. In the Release SSH lockout after list, select the lockout time for the SSH
Console Program.
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123.20

Redirecting Web Clients to HTTPS
To increase the security, you redirect HTTP communication to HTTPS when users
access an Enterprise Server or Automation Server using WebStation.
For more information, see section 123.16 “Encrypted Communication” on page
5211.

To redirect web clients to HTTPS
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

Continued on next page
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4. Select Redirect web clients to HTTPS.

5. Click the Save button
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123.21

Web Server Access Logging
You can log all web server HTTP access to the Enterprise Server.
The log on traffic is logged in the httpaccess.log file at this location:
C:\ProgramData\Schneider Electric StruxureWare\Building Operation
1.6\Enterprise Server\db\logs
The log is not created until you enable web server access logging.
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123.22

Enabling Web Server Access Logging
You enable web server access logging to log all web server HTTP access.
For more information, see section 123.21 “Web Server Access Logging” on page
5219.

To enable web server access logging
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

Continued on next page
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4. Select Enable web server access logging.

5. Click the Save button
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123.23

Automation Server Remote System
Logging
You can log all successful and unsuccessful attempt to log on to your Automation
Server.
The log on attempts are sent from the Automation Server to a server that handles
system logs. Two different protocols can be used to send the log on attempts:
• TCP
• UDP
The Automation Server remote system logging uses a Lead shadow relationship.
That means that the setting you do on an Enterprise Server is transferred to all
Automation Servers connected to the Enterprise Server. If you log on to the
Automation Server that acts as a shadow to a lead Enterprise Server, you cannot
change the Automation Server remote system logging on the Automation Server.
For more information, see the Lead and Shadow Relationship topic on WebHelp.
A stand-alone Automation Server can be configured to store logs on a central
location.
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123.24

Enabling Automation Server Remote
System Logging
You enable Automation Server remote system logging to log all log on attempts to
the Automation Server.
For more information, see section 123.23 “Automation Server Remote System
Logging” on page 5222.

To enable Automation Server remote system logging
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.
3. Click Security Settings.

Continued on next page
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4. Click Enable remote system logging.

5. Select the protocol.
6. In the Address box, type the IP address to the server where the log is stored.
7. In the Port box, type the port that is used by the server where the log is
stored.
8. Click the Save button

Technical
5226

.

04-16006-04-en, March 2015

123 Security
123.25 Checking the Software Version on the Automation Server Using Device Administrator

123.25

Checking the Software Version on the
Automation Server Using Device
Administrator
You check the software version on the Automation Server to understand which
features are available on the Automation Server.
For more information, see the Automation Servers topic on WebHelp.

To check the software version on the Automation Server using
Device Administrator
1. Connect to the Automation Server using IP or USB.
2. In Device Administrator, view the version number in the Software version
column.
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123.26

Checking the Software Version on the
Automation Server Using WorkStation
You check the software version on the Automation Server to understand which
features are available on the Automation Server.
For more information, see the Automation Servers topic on WebHelp.

To check the software version on the Automation Server using
WorkStation
1. Log on to the Automation Server.
2. In the System Tree pane, select the Automation Server.
3. Click Properties.
4. Click the Basic tab.
5. In the Configuration Information field, view the version number in the
Software version box.
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123.27

Enabling Access Logging for SNMP
You log all access using SNMP to be able to analyze the SNMP traffic.
For more information, see the Automation Servers topic on WebHelp.

Enable access logging for SNMP
1. In the Device Administrator, select the Automation Server.
2. On the View menu, click Network Settings.
3. Click the SNMP Configuration tab.
4. Select Enable logging to log all access attempts to the SNMP server in the
System log.
5. Click Save.

04-16006-04-en, March 2015

Technical
5229

123 Security
123.28 Disabling Dynamic Host Configuration Protocol (DHCP)

123.28

Disabling Dynamic Host Configuration
Protocol (DHCP)
You disable Dynamic Host Configuration Protocol (DHCP) because it does not
include any mechanism for authentication.
For more information, see section 3.6 “Automation Server” on page 142.

To disable Dynamic Host Configuration Protocol (DHCP)
1. In the Device Administrator, select the Automation Server.
2. On the View menu, click Network Settings.
3. Clear Enable DHCP .
4. Click Save.
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123.29

Disable Dynamic Domain Name System
(DNS) Updates
Disable Dynamic Domain Name System (DNS) updates to increase security.
For more information, see section 3.6 “Automation Server” on page 142.

To disable dynamic Domain Name System (DNS) updates
1. In Device Administrator, shift+right-click and then click Console.
2. In the Console program, type setip, and then press Enter.
3. Type admin (the password to the Automation Server) and then press enter.
4. In the Enable dynamic DNS update line, type No.
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123.30

Disabling SNMP for Managing an
Automation Server
Disable SNMP for managing an Automation Servers to increase the security.
For more information, see section 123.2 “DIACAP” on page 5185.

To disable SNMP for managing an Automation Server
1. In Device Administrator, select the Automation Server.
2. On the View menu, click Network Settings.
3. Click the SNMP Configuration tab.
4. Clear Enable SNMP queries.
5. Clear Enable SNMP traps.
6. Click Save.
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Topics
Password Policy Manager
Password Rules Dialog Box
Security Certificate Risk Dialog Box
Certificates Tab
Manage Certificates Dialog Box
Add Certificate Dialog Box
Generate Certificate Dialog Box
Edit Banner – Dialog Box
Security Settings – Control Panel

124 Security User Interface
124.1 Password Policy Manager

124.1

Password Policy Manager
Use the Password Policy Manager dialog box to set the password policy.

Figure: Password policy manager

Table: Password Policy Manager
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Component

Description

Minimum number of hours between
password changes

Enter the minimum number of hours
between password changes.

Days until password expires

Select to limit the days a password is in
effect and select the number of days until it
expires.
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Component

Description

Number of consecutive unique
passwords before reuse

Enter the number of passwords that have to
be different before you can use the same
password again.

Number of characters different from
last password

Enter the number of characters that must be
different from the characters in the last
password.

Do not allow more than three
repeating identical characters

Select to not allow more that three repeating
identical characters .

Minimum number of characters

Enter the minimum number of characters
allowed in a password.

Minimum of lowercase (small)
characters

Enter the minimum number of lowercase
characters allowed in a password.

Minimum number of uppercase
(capitalized) characters

Enter the minimum numbers of uppercase
characters allowed in a password changes.

Minimum number of numeric
characters

Enter the minimum of numeric characters
allowed in a password.

Numeric character must be inside
password

Select to only allow numeric characters in a
password.

Minimum number of special
characters

Enter the minimum number of special
characters allowed in a password.

Special character must be inside
password

Select to only allow special characters in a
password.

Special character allowed

Enter the special characters that are allowed
in a password.

Default characters

Click to return to the default special
characters.

Total minimum password length

Displays the total minimum number of
character that must be used in a password.
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124.2

Password Rules Dialog Box
Use the Password Rules dialog box to display the rules you have to follow to
create a new password.

Figure: Password rules dialog box dialog box

Figure: Invalid password change dialog box

Table: Password Rules Dialog Box
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Component

Description

[List]

Displays the password rules.
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124.3

Security Certificate Risk Dialog Box
Use the Security certificate risk dialog box to proceed if the certificate is not
valid.

Figure: Security certificate risk

Table: Security Certificate Risk
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Component

Description

Certificate details

Click to view information regarding the
certificate.

Always trust this certificate

Select if you want to trust the certificate.

Trust certificate

Click to temporarily trust the certificate and
log on to the server.

Cancel

Click to leave the log on dialog box without
entering the server.
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124.4

Certificates Tab
Use the Certificates tab to manage certificates.

Figure: Certificates tab

Table: Certificates Tab
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Property

Description

[Server list]

Select the server.

Server

Displays the address to the selected server.

Address

Displays the IP address to the selected
server.

Certificate list

Select the certificate you want to use for the
selected server.

Manage Certificate

Click to open the Manage Certificates
dialog box.
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124.5

Manage Certificates Dialog Box
Use the Manage Certificates dialog box to add, generate, or remove certificates
from your system.

Figure: Manage certificates dialog box

Table: Manage Certificates Dialog Box
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Component

Description

Quick filter

Enter a word or a character to filter on. For
more information, see the Quick Filter topic
on WebHelp.

Add certificate

Click to add or generate certificates.

Remove certificate

Click to remove the selected certificates.
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124.6

Add Certificate Dialog Box
Use the Add Certificate dialog box to add a certificate to your system.

Figure: Add certificate dialog box

Table: Add Certificate Dialog Box
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Component

Description

Name

Enter the name of the certificate.

Description

Enter a description of the certificate.

Host certificate

Enter the host certificate.

Intermediate Certificate

Enter the intermediate certificate.

Private key

Enter the private key.

Password

Type the password of the certificate.

Technical
5241

124 Security User Interface
124.7 Generate Certificate Dialog Box

124.7

Generate Certificate Dialog Box
Use the Generate Certificate dialog box to generate a self-signed certificate.

Figure: Generate certificate dialog box

Table: Generate Certificate Dialog Box
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Component

Description

Name

Enter the name of the certificate.

Description

Enter a description of the certificate.

Common name

Enter the certificates common name

Use IP/DNS from communication
settings

Select to use the IP address or the DNS
address from the communication settings in
the Automation Server or Enterprise Server.

Email address

Enter the email address to the the person
responsible for the certificate.

Organizational unit

Enter the organizational unit responsible for
the certificate.

Organization

Enter the organization responsible for the
certificate.
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Component

Description

Locality

Enter the location of the organization or
person who is responsible for the certificate.

Country

Select the country.

Valid from

Displays the date from when the certificates
is valid. This date is always the current date.

Valid to

Enter the last date the certificate is valid.
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124.8

Edit Banner – Dialog Box
Use the Edit Banner dialog box to enter the text you want to display when a user
enters a secure system.

Figure: Edit Banner dialog box
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Component

Description

Text:

Enter the text you want to display for a user
that enters a secure system
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124.9

Security Settings – Control Panel
Use the Security Manger options on Control Panel to increase the security of
your system.

Figure: Security manager control panel
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124.9 Security Settings – Control Panel

Table: Security Manager Control Panel
Component

Description

Protocol Status

Displays validation and approval of the
protocols.
Communication protocols valid and
improved.
Secure communication protocol is not in
use between server and client.
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Disable incoming http communication

Select to disable incoming HTTP
communication. For more information, see
section 123.16 “Encrypted Communication”
on page 5211.

Redirect web clients to https

Select to redirect web clients to https. For
more information, see section 123.16
“Encrypted Communication” on page 5211.

Disable MD5 Encryption

Select to disable MD5 encryption. For more
information, see section 123.16 “Encrypted
Communication” on page 5211.

Enable web server access logging

Select to log all web server HTTP access to
the Enterprise Server. For more information,
see section 123.21 “Web Server Access
Logging” on page 5219.

Enable remote system logging

Select to log all log on attempts on an
Automation Server. For more information,
see section 123.23 “Automation Server
Remote System Logging” on page 5222.

Protocol

Select the protocol to be used when sending
log on attempts on the Automation Server.
For more information, see section 123.23
“Automation Server Remote System
Logging” on page 5222.

Address

Type the IP address to the server that is
logging the log on attempts on the
Automation Server. For more information,
see section 123.23 “Automation Server
Remote System Logging” on page 5222.

Port

Type the port number used by the server
that is logging the log on attempts on the
Automation Server. For more information,
see section 123.23 “Automation Server
Remote System Logging” on page 5222.

Certificates

Click to open the Certificates manager.
For more information, see section 123.10
“Certificates” on page 5198.

Password policy

Click to open the Password policy dialog
where you configure the password policy.
For more information, see section 123.6
“Password Policy” on page 5193.
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Component

Description

Display Security Banner

Select On to display a security banner at log
on. For more information, see section 123.8
“Security Banner ” on page 5196.

Edit Banner

Click to open the Edit Banner dialog box to
edit the security banner. For more
information, see section 124.8 “Edit
Banner – Dialog Box” on page 5242.

SSH Console Lockout after

Select the time when the SSH lockout is
released. For more information, see section
146.1 “The Device Administrator Console
Program” on page 5489.

Connect Agent Settings

Click to open the Connect Agent
Settings dialog box where you configure
the transfer of system information and crash
information of the Enterprise Server and its
Automation Servers. For more information,
see the Configuring Connect Agent Settings
topic on WebHelp.
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Prepare for Conversion
Vista and Building Operation System Architecture
Differences
Vista Conversion Workflow
Vista Database Analysis
Key File
Analyzing the Vista Database Export File
Analyzing the Vista Database File Using a Sub-Project
Filtering Projects and Sub-Projects
Vista to SBO Conversion
Partially Converted Objects
Converting the Vista Database Export File
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125 TAC Vista Conversion
125.1 Vista Conversion Overview

125.1

Vista Conversion Overview
To assess whether or not to convert a Vista system to Building Operation, you run
an analysis of the Vista database export file to get information on the potential
outcome of a conversion. The analysis is performed on Transition Portal. If the
analysis confirms that the Vista database is suitable for conversion, you can convert
the database in TAC Vista to SBO Conversion Tool.
On Transition Portal, you upload the Vista database export file and start the
analysis. An analysis report and a conversion key are generated when the analysis
is performed. The purpose of the analysis report is to help you assess whether or
not the Vista database is suitable for conversion. Once you have decided to convert
the database, you use TAC Vista to SBO Conversion Tool to perform the
conversion. Some manual engineering work is required to get the database in the
condition you want before importing it on site.
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125.1 Vista Conversion Overview

Figure: Vista Conversion Flow

You have to decide on the final Building Operation system architecture early on. For
example, whether or not to use Automation Servers, and if so, how many, or
whether to connect the LonWorks network directly to an Enterprise Server. The final
system has to comply with the architectural guidelines for Building Operation. For
more information, see the Architectural Guidelines 1.6 topic on WebHelp.
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125.1.1

Prepare for Conversion
On the computer where the conversion and engineering work is done, you have to
do some preparations before converting the Vista database.
For more information, see section 125.2 “Prepare for Conversion” on page 5253.

125.1.2

Vista and Building Operation System
Architecture Differences
There are differences between the system architecture in a Vista system and a
Building Operation system. Some of these differences are supported by TAC Vista
to SBO Conversion Tool. Some differences require manual engineering work for the
system to function as expected.
For more information, see section 125.3 “Vista and Building Operation System
Architecture Differences” on page 5254.

125.1.3

Vista Conversion Workflow
Use the Vista conversion workflow to convert a Vista database export file into
Building Operation.
For more information, see section 125.4 “Vista Conversion Workflow” on page
5255.

125.1.4

Vista Database Analysis
You analyze the Vista database export file to get information on the potential
outcome of a conversion.
For more information, see section 125.5 “Vista Database Analysis ” on page 5257.

125.1.5

Vista to SBO Conversion
You use TAC Vista to SBO Conversion Tool to convert a Vista database export file
to Building Operation. You have to run the TAC Vista to SBO Conversion Tool
version that matches the Building Operation version to which you are planning to
convert. The Building Operation version has to be identical to the version the
analysis was made for.
For more information, see section 125.10 “Vista to SBO Conversion” on page 5270.

125.1.6

Revision Table
The revision table shows the supported objects for a specific Building Operation
version and TAC Vista to SBO Conversion Tool version.
For more information, see section 125.15 “Revision Table” on page 5279.
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125.1 Vista Conversion Overview

125.1.7

Manual Vista Conversion Engineering Work
Some manual engineering work is necessary when a conversion of the Vista
database has been done. The manual engineering work is done in Building
Operation WorkStation.
For more information, see section 125.14 “Manual Vista Conversion Engineering
Work” on page 5277.
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125.2

Prepare for Conversion
On the computer where the conversion and engineering work is done, you have to
do some preparations before converting the Vista database:
• Install Building Operation including WorkStation
• Add the certificates that are necessary to communicate on the HTTPS protocol
• Install TAC Vista to SBO Conversion Tool
• Install the Enterprise Server or Automation Server you are converting to
• Make sure you have access to the conversion key file generated on Transition
Portal when the analysis of the database was performed
• If third-party devices require a DRF kit, install the DRF kit on the target system

Important
The default Building Operation Certificate is not supported.
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125.3

Vista and Building Operation System
Architecture Differences
There are differences between the system architecture in a Vista system and a
Building Operation system. Some of these differences are supported by TAC Vista
to SBO Conversion Tool. Some differences require manual engineering work for the
system to function as expected.
Vista Servers can either handle a number of LonWorks networks or a single large
LonWorks network, but not both. When a system becomes large, additional
computer-based Vista Servers are added and the load is distributed among the
servers. There can be other reasons to use several Vista Servers.
A Building Operation system has maximum one Enterprise Server. You can expand
the system by adding Automation Servers. A Building Operation system typically
has more functionality running in embedded devices than Vista does. This means
that when you convert a Vista system to Building Operation, the functionality has to
move from the computer level to the embedded level. TAC Vista to SBO Conversion
Tool supports this difference in system architecture.
When you convert a Vista system to Building Operation, the converted system has
to comply with the architectural guidelines for Building Operation. For more
information, see the Architectural Guidelines 1.6 topic on WebHelp.
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125.4

Vista Conversion Workflow
Use the Vista conversion workflow to convert a Vista database export file into
Building Operation.

Figure: Vista conversion workflow
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125.4 Vista Conversion Workflow

Export the database from Vista
You export the database or part of the database that you want to convert to
Building Operation from TAC Vista. It is recommended that you include both the
physical and the related logical structure in the database export. For more
information, see section 125.3 “Vista and Building Operation System Architecture
Differences” on page 5254.

Analyze the Vista database export file
On Transition Portal, analyze the TAC Vista database export file for information on
what is possible to convert and what is not.
For more information, see section 125.7 “Analyzing the Vista Database Export File”
on page 5260.

Prepare for conversion
Install the appropriate software and certificates, create the servers in WorkStation,
and ensure that you have the correct conversion key file.
For more information, see section 125.2 “Prepare for Conversion” on page 5253.

Convert the Vista database export file
Convert the TAC Vista database export file to a target Building Operation Enterprise
Server or Automation Server.
For more information, see section 125.12 “Converting the Vista Database Export
File” on page 5273.

Perform the manual conversion engineering work
Perform the manual TAC Vista conversion engineering work.
For more information, see section 125.14 “Manual Vista Conversion Engineering
Work” on page 5277.

Export the converted database using TAC Vista to SBO Conversion
Tool
On the off-site computer, export the converted database using TAC Vista to SBO
Conversion Tool.
For more information, see section 125.13 “Exporting the Database Using TAC Vista
to SBO Conversion Tool” on page 5274.

Note
If the conversion is done directly on site, no export is necessary.

Import the converted database in Building Operation
If you perform the conversion on a dedicated engineering computer off site, import
the converted database to the on-site system.
For more information, see section 18.27 “Importing a Solution” on page 594.
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125.5

Vista Database Analysis
You analyze the Vista database export file to get information on the potential
outcome of a conversion.
The database analysis is done on Transition Portal. On Transition Portal, you create
projects and, optionally, sub-projects to which you upload the TAC Vista database
export files. You need to make a decision on whether or not to use sub-projects
since sub-projects cannot be added when a transition has been uploaded to a
project. The purpose of the projects and sub-projects is to make it easy to manage
the uploaded files and the Vista database analysis reports.

Important
• After you upload a Vista database export file to a project, you cannot create
sub-projects below this project.
• After you upload a Vista database export file to a sub-project, you cannot
upload Vista database export files to the project in which the sub-project is
stored.
You upload a Vista database export file to the Transition Portal and start the
analysis. When the analysis is completed, a .zip file is generated and can be
downloaded from the project or sub-project on the Transition Portal. The .zip file
contains two files:
• Vista to SBO Analysis Report
• A conversion key file

125.5.1

Analysis Report
The analysis report contains information on the potential outcome of a conversion.
The purpose of the report is to give you information to help make an assessment on
whether or not the database is suitable for conversion.
The report is in .HTML format and is opened in a web browser.

Note
• In Internet Explorer, you have to allow blocked content to access all the
functions of the report.
The report has two parts:
• Summary
• Details
The Summary part lists the objects grouped by potential conversion status: objects
that will be converted, objects that will be partially converted, and objects that will
not be converted.
The Details part lists all objects grouped by object type and their potential
conversion status. The Details part also contains information on why some object
types will be partially converted or not converted.
You can print the report. When printing, you have to expand the sections you want
to include in the printout.
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125.5 Vista Database Analysis

For more information, see section 125.23 “Vista to SBO Analysis Report” on page
5293.

125.5.2

Key File
The conversion key file is included in the .zip file generated on Transition Portal
when a Vista database export file is analyzed and is required by TAC Vista to SBO
Conversion Tool. The purpose of the conversion key file is to ensure that the
following versions are identical:
• Building Operation version the analysis is performed for
• TAC Vista to SBO Conversion Tool version
• Building Operation version the Vista database is converted to
For more information, see section 125.6 “Key File” on page 5259.
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125.6

Key File
The conversion key file is included in the .zip file generated on Transition Portal
when a Vista database export file is analyzed and is required by TAC Vista to SBO
Conversion Tool. The purpose of the conversion key file is to ensure that the
following versions are identical:
• Building Operation version the analysis is performed for
• TAC Vista to SBO Conversion Tool version
• Building Operation version the Vista database is converted to
You can download the .zip file containing the key file from Transition Portal.
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125.7

Analyzing the Vista Database Export
File
You analyze the Vista database export file to get a report on Vista items that
potentially can be converted, partially converted, and cannot be converted into
Building Operation. Depending on how you want to organize the Vista database
export file analyses on Transition Portal, you can either add the upload to a project
or to a sub-project.
For more information, see section 125.5 “Vista Database Analysis ” on page 5257.

To analyze the Vista database export file
1. Open a web browser and log on to the Exchange Download Center.
2. Enter the address to Tansition Portal:
https://buildingsdownloads.schneider-electric.com/transition-portal
3. Click Add Project.

Continued on next page
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125.7 Analyzing the Vista Database Export File

4. In the Project Name box, type a name for the project.

5. In the Organization box, select the organization you belong to.
6. In the Description box, type a description of the project.
7. Click Save.
8. Click Add Upload.

Note
You can add additional uploads to a project once it has been saved.
Continued on next page
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125.7 Analyzing the Vista Database Export File

9. In the Description box, type a description of the transition.

10. In the Conversion Type box, select VISTA.

11. In the SBO Version box, select the SBO version you are considering
converting to.
12. Click Choose File.
13. In the Open dialog box, enter the path to the Vista database export .zip file
you want to analyze, and then click Open.
14. Click OK to start upload the file and start the analysis.
15. Click Save.
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On the Transition Portal Projects page, you can view the project details and
download a .zip file containing the analysis report and the conversion key file
required to perform the conversion.
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125.8

Analyzing the Vista Database File Using
a Sub-Project
You analyze the Vista database file to get a report on Vista items that potentially can
be converted into Building Operation, that can be partially converted, and items that
cannot be converted. Depending on how you want to organize the Vista database
export file analyses on Transition Portal, you can either add the upload to a project
or to a sub-project.
For more information, see section 125.5 “Vista Database Analysis ” on page 5257.

To analyze the Vista database file using a sub-project
1. Open a web browser and log on to the Exchange Download Center.
2. In the web browser, enter the address to Tansition Portal:
https://buildingsdownloads.schneider-electric.com/transition-portal
3. Click Add Project.

Continued on next page
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4. In the Project Name box, type a name for the project.

5. In the Organization box, select the organization you belong to.
6. In the Description box, type a description of the project.
7. Click Save.
8. Click Add Sub-Project.
Continued on next page
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125.8 Analyzing the Vista Database File Using a Sub-Project

9. In the Name box, type a name for the sub-project.

10. In the Description box, type a description of the sub-project.
11. Click OK.

Note
You can add additional sub-projects to a project once it has been
saved.
Continued on next page
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12. On the Sub-Project Name row, click Add.

Note
You can add additional uploads to a sub-project once it has been
saved.
13. In the Description box, type a description of the upload.

Continued on next page
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14. In the Conversion Type box, select Vista.

15. In the SBO Version box, select the SBO version for which you want to make
the analysis.
16. Click Choose File.
17. In the Open dialog box, browse to the Vista database export file (.zip) and
click Open.
18. Click OK to upload the TAC Vista database file and start the analysis.
19. Click Save.
On the Transition Portal Projects page, you can view the project details and
download a .zip file containing the analysis report and the conversion key file
required to perform the actual conversion.
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125.9

Filtering Projects and Sub-Projects
You filter the projects on Transition Portal to find the projects and projects
containing sub-projects that are relevant for you.

To filter projects and sub-projects
1. Open a web browser and log on to the Exchange Download Center.
2. In the web browser, enter the address to Tansition Portal:
https://buildingsdownloads.schneider-electric.com/transition-portal
3. In the Filter By All Columns box, enter one or several words or numbers to
filter on.

4. In the Filter By Last Modified Date box, enter dates to filter on a specific
time span when the project or sub-project was last modified.

Note
If you leave the date boxes empty, the filter searches through all
projects and sub-projects.
Transition Portal lists all projects that match the filter conditions and all projects
containing sub-projects that match the filter conditions.
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125.10

Vista to SBO Conversion
You use TAC Vista to SBO Conversion Tool to convert a Vista database export file
to Building Operation. You have to run the TAC Vista to SBO Conversion Tool
version that matches the Building Operation version to which you are planning to
convert. The Building Operation version has to be identical to the version the
analysis was made for.
It is recommended that you perform the conversion and make the manual
conversion engineering work on a dedicated engineering computer so that you can
test the system before importing it on site. You export the converted database
using TAC Vista to SBO Conversion Tool to include the neuron IDs from Vista. You
then import the database to the on-site system. If you perform the conversion on a
computer in the on-site system, you convert and deploy at the same time.
From TAC Vista to SBO Conversion Tool, you log on to the Building Operation
system you are converting the database to using the same user credentials you use
when logging on to the server in the on-site system.

Important
• It is recommended that you convert one Vista network at a time, including the
logical side into an Enterprise Server.
• You can convert maximum five networks into an Enterprise Server.
• You can convert maximum one network into an Automation Server.
For more information, see section 125.2 “Prepare for Conversion” on page 5253.

125.10.1

Certificates
You have to add the certificates that are necessary to communicate on the HTTPS
protocol.

Important
The default Building Operation certificate is not supported by TAC Vista to SBO
Conversion Tool.
For more information, see section 123.10 “Certificates” on page 5198.

125.10.2

Key File
The conversion key file generated on Transition Portal is required by TAC Vista to
SBO Conversion Tool when you start the actual conversion.
For more information, see section 125.6 “Key File” on page 5259.

125.10.3

Conversion Report
When you run a conversion, TAC Vista to SBO Conversion Tool generates a
conversion report with information on the actual outcome of the conversion.
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The report is in .HTML format and is opened in a web browser. The report has two
parts:
• Summary
• Details

Note
• In Internet Explorer, you have to allow blocked content to access all the
functions of the report.
You can print the report. When printing, you have to expand the sections you want
to include in the printout.
For more information, see section 125.25 “Vista to SBO Conversion Report” on
page 5298.

125.10.4

Partially Converted Objects
When you have performed a conversion of a Vista database export file, there can be
several reasons why an object has been partially converted.
For more information, see section 125.11 “Partially Converted Objects” on page
5272.

125.10.5

Database Export
If the manual engineering work is done on a dedicated engineering computer, you
export the database generated from the conversion file to a file that can be
imported to the on-site system. When you export the database from TAC Vista to
SBO Conversion Tool, the export file includes the entire database, including the
Neuron IDs from the Vista database export file.
For more information, see section 125.13 “Exporting the Database Using TAC Vista
to SBO Conversion Tool” on page 5274.

125.10.6

Revision Table
The revision table shows the supported objects for a specific Building Operation
version and TAC Vista to SBO Conversion Tool version.
For more information, see section 125.15 “Revision Table” on page 5279.
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125.11

Partially Converted Objects
When you have performed a conversion of a Vista database export file, there can be
several reasons why an object has been partially converted:
• The object contains user-defined units.
• The network interface type was changed during conversion.
• Object bindings refer to an object type that is not supported or not found.
• For Xenta Servers, only the LonWorks configuration conversion is supported.
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125.12

Converting the Vista Database Export
File
You perform the conversion of the Vista database export file to convert the Vista
database into a target Enterprise Server or Automation Server. TAC Vista to SBO
Conversion Tool requires a conversion key file to perform the conversion.
For more information, see section 125.10 “Vista to SBO Conversion” on page 5270.

To convert the Vista database export file
1. Make sure you have added the certificates that are necessary to communicate
on the HTTPS protocol.
2. If third-party LonWorks devices are used on the Building Operation system
you are converting into, make sure that the required DRF kits for the thirdparty LonWorks devices have been installed.
3. On the engineering computer, make sure the Enterprise Server service is
started or the Automation Server physcially is installed and connected to the IP
network before you start the conversion.
4. Start TAC Vista to SBO Conversion Tool.
5. In the SBO Server box, type the address of the Enterprise Server or
Automation Server to which you want to convert the TAC Vista database
export file.

Important
• You use the WorkStation logon address, for example, localhost,
IP number, or DNS name.
• Only HTTPS logon is supported. If you are not using the default
port, you have to include the HTTPS port in the address, for
example, localhost:455
6. In the User name box, type the name of the user account you want to use to
log on to the Enterprise Server or Automation Server.
7. In the Password box, type the password of the user account you are using to
log on to the Enterprise Server or Automation Server.
8. In the Vista database export file box, enter the path of the export file.
9. In the Conversion key file box, enter the path of the conversion key file.
10. In the Output folder box, enter the path to the folder where you want to save
the conversion report.
11. Click the Convert button.
12. Click OK.
If you perform the conversion on a dedicated engineering computer off site, the
Vista database is converted and imported into the Enterprise Server or Automation
Server on the engineering computer from which you export the database and then
import it in the on-site system. If you perform the conversion on a computer in the
on-site system, no export or import is necessary.
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125.13

Exporting the Database Using TAC Vista
to SBO Conversion Tool
You export the Enterprise Server or Automation Server database using TAC Vista to
SBO Conversion Tool on the engineering computer to get a database export file
that you can import into an Enterprise Server or an Automation Server in the on-site
system.
For more information, see section 125.10 “Vista to SBO Conversion” on page 5270.

To export the database using TAC Vista to SBO Conversion
Tool
1. On the engineering computer, make sure the Building Operation Enterprise
Server service is started or the Automation Server is physcially installed and
connected to the IP network before you start the export.
2. Start TAC Vista to SBO Conversion Tool.
3. In the SBO Server box, enter the address of the Enterprise Server or
Automation Server on the engineering computer or the computer in the on-site
system.

Important
• You use the WorkStation logon address, for example, localhost,
IP number, or DNS name.
• Only HTTPS logon is supported. If you are not using the default
port, you have to include the HTTPS port in the address, for
example, localhost:455
Continued on next page
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4. In the User name box, enter the name of the user account you want to use to
log on to the Enterprise Server or Automation Server.
5. In the Password box, enter the password of the user account you are using
to log on to the Enterprise Server or Automation Server.
6. Click the SBO Export button.
Continued on next page
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7. Select a folder and enter a name for the database export .XML file.

8. Click Save.
9. Click OK.
A database export file, generated from the conversion file, is generated and can be
imported into the on-site system. For more information, see section 18.27
“Importing a Solution” on page 594.

Technical
5278

04-16006-04-en, March 2015

125 TAC Vista Conversion
125.14 Manual Vista Conversion Engineering Work

125.14

Manual Vista Conversion Engineering
Work
Some manual engineering work is necessary when a conversion of the Vista
database has been done. The manual engineering work is done in Building
Operation WorkStation.
The Vista Conversion Report contains information that is useful when starting the
manual engineering work.
The manual engineering work includes, for example:
• Fixing bindings and links that were broken during the conversion
• Changing scripts in Graphics and Menta if they are using alarm state, OVR, or
time schedule
• The 'Alarm status' property (ASTATE) has different values in Building Operation
than in TAC Vista. Edit TGML graphics to take care of the discrepancy after a
conversion.
• Create a function block program that takes care of value conversions between
Vista and Building Operation
• Check user-defined units. User-defined units are not converted.
• Add objects that could not be converted, for example, trend logs

Alarm status enumeration
Alarm objects in Vista and Building Operation both provide a value indicating their
status. In Vista systems, this value is often bound to graphics to show current
status and can also be bound to other types of object, for example, Menta or
Function Block programs.
The alarms status numeric values are not identical in Vista and in Building
Operation.
Table: Alarm status enumeration
Value

Vista Server

Xenta Server

Building
Operation

0

Normal

Normal

Normal

1

Alarm

Reset

Alarm

2

-

Alarm

Acknowledged

3

-

Acknowledged

Reset

4

Acknowledged

-

Disabled*

5

-

-

-

6

Blocked

Blocked

-

* Disabled state in Building Operation corresponds to Blocked state in TAC Vista.
The Xenta Server values are converted to Vista Server values when a Xenta Server
alarm is transferred to Vista Server.
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TAC Vista to SBO Conversion Tool is not capable of doing the modifications
required for the alarm state functionality to be maintained. This has to be done
manually. Changing the consumer of the value, often TGML graphics or Menta
programs, is probably the best solution. You could also consider running the status
through a Function Block or Script program that does the conversion and change
the bindings. The latter would leave the graphics and programs unchanged.
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125.15

Revision Table
The revision table shows the supported objects for a specific Building Operation
version and TAC Vista to SBO Conversion Tool version.
Table: Revision Table
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TAC Vista

Enterprise Server

Automation
Server

Conversion tool
version

Vista Server

Folder

Folder

1.6.0.50000

Folder

Folder

Folder

1.6.0.50000

Shortcut

Shortcut

Shortcut

1.6.0.50000

Value - Analog

Analog Value

Analog Value

1.6.0.50000

Value - Binary

Digital Value [6]

Digital Value [6]

1.6.0.50000

Value - Multistate

Multistate Value

Multistate Value

1.6.0.50000

Value - String

String value

String value

1.6.0.50000

Graphic - TGML

Graphic [1]

Graphic [1]

1.6.0.50000

Graphic - TGML Standard Graphic
(Shortcut)

Graphic [2]

Graphic [2]

1.6.0.50000

Change of State

Change of State
Alarm [3]

Change of State
Alarm [3]

1.6.0.50000

Change of State with Out of Range Alarm
high and low limit
[3]

Out of Range Alarm
[3]

1.6.0.50100

Notes

Document

Document

1.6.0.50100

Communication Port
- Loytec

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Communication Port
- Xenta 911

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

TAC Xenta 901
Network - Modem

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

TAC Xenta PP
Network - Modem

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 511

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 527

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 555

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000
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TAC Vista

Enterprise Server

Automation
Server

Conversion tool
version

Xenta Server 701

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 711

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 721

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 731

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

Xenta Server 913

LonWorks Interface

LonWorks Local FT10 Interface

1.6.0.50000

LonWorks Network

LonWorks Network

LonWorks Network

1.6.0.50000

TAC Xenta Group

Folder

Folder

1.6.0.50000

LonWorks Group

Folder

Folder

1.6.0.50000

TAC Xenta 280

ProgrammableXenta

ProgrammableXenta

1.6.0.50000

TAC Xenta 300

ProgrammableXenta

ProgrammableXenta

1.6.0.50000

TAC Xenta 400

ProgrammableXenta

ProgrammableXenta

1.6.0.50000

LonWorks Device

LonWorks Device

LonWorks Device

1.6.0.50000

3rd Party LonWorks
Device

LonWorks Device [4]

LonWorks Device [4]

1.6.1.50001

SNVT

SNVT

SNVT

1.6.0.50000

TAC Xenta
280/300/400 NonSNVT signals

Property [5]

Property [5]

1.6.0.50000

[1] Regarding TGML bindings, we support the resolution of bindings to objects for
the 'Value' (PV), 'Description' (DESCR), 'Alarm status' (ASTATE) and 'Name'
(NAME) properties as well as 'SNVT object' properties from TAC Lonworks devices.
Note that the Alarm status property (ASTATE) has different values in Building
Operation than in TAC Vista and TGML graphics needs to be manually edited to
take care of this discrepancy after conversion.
[2] Standard TGML graphics are shortcuts in TAC Vista and are converted to
Building Operation as a full copy of the original graphic with the bindings and links
re-routed.
[3] [3] For 'Change of State' object the alarm control, linked video, graphic, report,
notes, or trend chart definition will not be converted to Building Operation. If any of
these definitions set the object will be set as partially converted.
[4] [4] For 3rd party LonWorks devices any corresponding DRF-kits needs to be
installed prior to performing the actual conversion on the target computer.
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[5] The Lon Network structure in Building Operation for TAC Xenta 280/300/400
differs from TAC Vista and non-SNVT signal objects are represented as properties
in Building Operation. Regarding TGML bindings in this case we can only resolve
TGML bindings made to the Value property (PV) of the non-SNVT signal if the signal
is represented as a property in Building Operation. Regarding TGML links in this
case we can not resolve shortcuts made to non-SNVT objects if they are
represented as a properties in Building Operation. Instead we currently make the
shortcut point to the object holding the property in Building Operation.
[6] For Binary Value object the paired texts will not be converted to Building
Operation. If paired texts definition changed from default then the object will be set
as partially converted.
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125.16

Transition Portal
Use Transition Portal to upload Vista database export files for analysis and
manage projects, sub-projects, analysis reports, and to generate conversion keys
to be used when converting the Vista database export files to Building Operation.
You can also download TAC Vista to SBO Conversion Tool using the link on
Transition Portal.

Figure: Transition Portal

Table: Transition Portal
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Component

Description

Filter By All Columns

Enter one or more words in the name of a
project to search for the project.

Filter By Last Modified Date

Select dates in between which a project or
sub-project was modified to search for the
project.

Clear Filters

Click to clear the filter conditions you have
entered.

Add Project

Click to add a project. For more information,
see section 125.17 “Transition Portal Project Page” on page 5284.
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Component

Description

Project Name

Lists the projects that you have added to
Transition Portal with the most recent project
at the top. Click the name to open a project
where you can add sub-projects or
transitions to an existing project. For more
information, see section 125.20 “Transition
Portal - Project Page Uploads” on page
5288.
If the project contains sub-projects, you can
add transitions to a sub-project. For more
information, see section 125.21 “Transition
Portal - Project Page Sub-Projects” on page
5290.

Organization

Displays the organization you belong to.

No. of Sub-Projects

Lists the number of sub-projects you have
added to the project on the specific row.

No. of Uploads

Lists the number of analyses you have
performed on a project.

Last Modified On

Displays the date when the project was last
modified.

Actions

Click Edit to edit the name and description
of the project on the specific row.

Total Items

Lists the total number of projects.

Page Size

Click to select the number of projects to
display per page.
Click to jump to the first page.
Click to jump to the previous page.
Click to jump to the next page.
Click to jump to the last page.
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Export Projects to Excel

Click to export project information to an
Excel file for all projects based on certain
criteria, such as the identity of the person
who created the project and the date of
creation.

Display Important Files and FAQ
Section

Click to display a link to TAC Vista to SBO
Conversion Tool download, an FAQ section,
and related links.
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125.17

Transition Portal - Project Page
Use Transition Portal - Project page to add projects, sub-projects and uploads
to Transition Portal .

Figure: Project page

Table: Transition Portal - Project Page
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Component

Description

Project Name

Type a name for the project.

Organization

Displays the organization you belong to.

Description

Type a description for the project.

Add Sub-Project

Click to open a page where you add subprojects to the project. For more information,
see section 125.18 “Add Sub-Project to
Project Dialog Box ” on page 5286.

Add Upload

Click to upload a Vista database export file
to the Project to run an analysis. For more
information, see section 125.19 “Add
Upload to Project Dialog Box ” on page
5287.

Save

Click to save the project.
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Component

Description

Cancel

Click to cancel the operation.

Display Important Files and FAQ
Section

Click to display a link to TAC Vista to SBO
Conversion Tool download, an FAQ section,
and related links.
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125.18

Add Sub-Project to Project Dialog Box
Use the Add Sub-Project to Project dialog box to add a sub-project to a
project.

Figure: Add Sub-Project to Project dialog box

Table: Add Sub-Project to Project Dialog Box
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Component

Description

Name

Type a name for the sub-project.

Description

Type a description for the sub-project.

OK

Click to add the sub-project to the project.

Cancel

Click to cancel the operation.
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125.19

Add Upload to Project Dialog Box
Use the Add Upload to Project dialog box to upload a Vista database export file
to the project.

Figure: Add Upload to Project dialog box

Table: Add Upload to Project Dialog Box

04-16006-04-en, March 2015

Component

Description

Description

Type a description for the upload.

Conversion Type

Select Vista to determine the type of
analysis you want to start.

SBO Version

Select the Building Operation version for
which you want to start the analysis.

Choose File

Click to select the Vista database export file
you want to upload.

OK

Click to start the upload and analysis of the
Vista database export file.

Cancel

Click to cancel the operation.

Technical
5289

125 TAC Vista Conversion
125.20 Transition Portal - Project Page Uploads

125.20

Transition Portal - Project Page Uploads
Use Transition Portal - Project page Uploads to add an upload to a saved
project, to change the description of a project and to refresh the page if the status
of an upload does not display as expected.

Figure: Project page - Uploads

Table: Transition Portal - Project Page - Uploads
Component

Description

Project

Displays the name of the project.

Organization

Displays the organization you belong to.

Last Modified

Displays the date when the project was last
modified.

Add Upload

Click to upload a Vista database export file
to the Project to run an analysis. For more
information, see section 125.19 “Add
Upload to Project Dialog Box ” on page
5287.

Update Description(s)

Not available. Click in the Description
column to edit a description.
Click to refresh the page if the status column
does not display 'COMPLETED' when you
have uploaded a Vista database export file
for analysis.
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Description

Displays the description of the project.

Related Uploads

Not applicable for Vista.

Conversion Type

Displays the type of analysis performed on
the uploaded file. For Vista database export
files, the column contents should display
VISTA.
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Component

Description

SBO Version

Displays the Building Operation version for
which the analysis was performed.

Server Name

Not applicable for Vista.

Status

Displays the status of the analysis on the
specific row.

Uploaded Files

Click to download the uploaded Vista
database export file. The download link
displays to the bottom left of the page.

Report

Click to download the analysis report file,
including the conversion key file. The
download link displays to the bottom left of
the page.

Page Size

Click to select the number of projects to
display per page.
Click to jump to the first page.
Click to jump to the previous page.
Click to jump to the next page.
Click to jump to the last page.
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Back to Projects

Click to return to the Transition Portal main
page.

Display Important Files and FAQ
Section

Click to display a link to TAC Vista to SBO
Conversion Tool download, an FAQ section,
and related links.
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125.21

Transition Portal - Project Page SubProjects
Use Transition Portal - Project page Sub-Projects to add an upload to a
saved sub-project, to change the description of a project and to refresh the page if
the status does not display as expected.

Figure: Project page - Sub-Projects

Table: Transition Portal - Project page Sub-Projects
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Component

Description

Project

Displays the name of the project.

Organization

Displays the organization you belong to.

Last Modified

Displays the date when the project was last
modified.

Add Sub-Project

Click to add a sub-project to the project. For
more information, see section 125.18 “Add
Sub-Project to Project Dialog Box ” on page
5286.

Sub-Project Name

Click the sub-project name to open a page
where you can add transitions to the subproject or update the sub-project
description.

Description

Displays the description of the sub-project.

No. of Uploads

Lists the number of Vista database export file
uploads you have made to a sub-project.

Actions

Click Edit to edit the name or description of
the sub-project.

Back to Projects

Click to return to the Transition Portal main
page. For more information, see section
125.16 “Transition Portal” on page 5282.
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Component

Description

Display Important Files and FAQ
Section

Click to display a link to TAC Vista to SBO
Conversion Tool download, an FAQ section,
and related links.
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125.22

Transition Portal - Sub-Project Page
Uploads
Use the Sub-Project Uploads page to upload a Vista database export file to a subproject and to update the sub-project description.

Figure: Sub-Project Uploads page

Table: Sub-Project Uploads Page
Component

Description

Project

Displays the name of the sub-project.

Organization

Displays the organization you belong to.

Sub-Project

Displays the name of the sub-project.

Last Modified

Displays the date when the sub-project was
last modified.

Add Upload

Click to upload a Vista database export file
to the sub-project to run an analysis. For
more information, see section 125.19 “Add
Upload to Project Dialog Box ” on page
5287.

Update Description(s)

Click to type a new description for the subproject.
Click to refresh the page if the status column
does not display 'COMPLETED' when you
have uploaded a Vista database export file
for analysis.
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Back to Project:[Project name]

Click to return to the Project page where you
can add sub-projects. For more information,
see section 125.21 “Transition Portal Project Page Sub-Projects” on page 5290.

Display Important Files and FAQ
Section

Click to display a link to TAC Vista to SBO
Conversion Tool download, an FAQ section,
and related links.
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125.23

Vista to SBO Analysis Report
Use the Vista to SBO Analysis Report to view the potential outcome of a Vista
to Building Operation conversion. The purpose of the report is to provide
information to help you make an assessment on whether or not the database is
suitable for conversion.

Figure: Vista to SBO Analysis Report
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Table: Vista to SBO Analysis Report
Component

Description

Date

Displays the date the analysis report was
generated.

Vista export file

Displays the name of the
Vista database export .zip file
on which the analysis was
performed.

Project name

Displays the name of the
project to which the Vista
database export file was
uploaded.

Sub-project name

Displays the name of the
sub-project to which the
Vista database export file
was uploaded.

Complexity

Displays the complexity
rating of the Vista database
export file, where 0
corresponds to an empty
database and each object in
the database adds 1
complexity point.

SBO version

Displays the Building
Operation version the
analysis was performed for.

Conversion Tool revision Displays the Vista to SBO
Conversion Tool revision that
matches the Building
Operation version the
analysis was performed for.

Technical
5296

Vista to SBO Analysis Summary

Displays a summary on the status of the
analysis.

Details

Click to display the details page of the Vista
to SBO Analysis Report.

Vista to SBO Analysis Details

Displays details on the status of the analysis.

WebHelp: Vista to SBO Analysis
Report

Click to display Help on the Vista to SBO
Analysis Report.

Links list

Click a link to display the specific list of
objects.

Expand/Collapse All

Click to expand or collapse all the details
lists on the page.

Expand/Collapse

Click to expand a collapsed details list or
collapse an expanded details list.

Top

Click to display the top of the details page.

04-16006-04-en, March 2015

125 TAC Vista Conversion
125.23 Vista to SBO Analysis Report

Continued

04-16006-04-en, March 2015

Component

Description

Vista objects that will be converted

Displays a list of objects that potentially will
be converted.

Vista objects that will be partially
converted

Displays a list of objects that potentially will
be partially converted. For more information,
see section 125.11 “Partially Converted
Objects” on page 5272.

Vista objects that are not supported

Displays a list of objects that are not
supported and are not likely to be converted.
For more information, see section 125.14
“Manual Vista Conversion Engineering Work”
on page 5277.
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125.24

TAC Vista to SBO Conversion Tool
Use TAC Vista to SBO Conversion Tool to convert Vista database export files
to Building Operation and, if needed, to perform an export of the database when
the manual engineering work has been completed.

Figure: TAC Vista to SBO Conversion Tool

Table: TAC Vista to SBO Conversion Tool
Component

Description

SBO Server

On a dedicated engineering computer, enter
the localhost HTTPS address.
On a site computer, enter the HTTPS
address of the Enterprise Server or
Automation Server.

User name
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Enter the name of the user account you want
to use to log on to the Enterprise Server or
Automation Server.
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Component

Description

Password

Enter the password of the user account you
are using to log on to the Enterprise Server
or Automation Server.

SBO Export

Click to export the converted database using
TAC Vista to SBO Conversion Tool when the
manual engineering work on the database is
completed. For more information, see
section 125.14 “Manual Vista Conversion
Engineering Work” on page 5277.

Vista database export file

Enter the path to the Vista database export
file you want to convert.

Conversion key file

Enter the path to the conversion key file. For
more information, see section 125.6 “Key
File” on page 5259.

Output folder

Enter the path to the folder where you want
to save the conversion report. For more
information, see section 125.25 “Vista to
SBO Conversion Report” on page 5298.

Convert

Click to convert the Vista database export
file to Building Operation. For more
information, see section 125.12 “Converting
the Vista Database Export File” on page
5273.

Stop

Click to stop the conversion.

Open report

Click to open Windows Explorer where you
enter the path to the conversion report. For
more information, see section 125.25 “Vista
to SBO Conversion Report” on page 5298.

About

Press to read general information, license
agreement, and technical information about
the product.

Close

Click to close the program.
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125.25

Vista to SBO Conversion Report
Use the Vista to SBO Conversion Report to view the actual outcome of a Vista
to Building Operation conversion.
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Figure: TAC Vista to SBO Conversion Report
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Table: Vista to SBO Conversion Report
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Component

Description

Date

Displays the date the conversion report was
generated.

Vista export file

Displays the name of the Vista database
export .zip file on which the conversion was
performed.

Project name

Displays the name of the project to which
the Vista database export file was uploaded.

Sub-project name

Displays the name of the sub-project to
which the Vista database export file was
uploaded.

SBO version

Displays the Building Operation version the
conversion was performed for.

Conversion Tool revision

Displays the TAC Vista to SBO Conversion
Tool revision that matches the Building
Operation version the conversion was
performed for.

Vista to SBO Conversion Summary

Displays a summary on the status of the
conversion.

Details

Click to display the details page of the Vista
to SBO conversion Report.

Vista to SBO Conversion Details

Displays details on the status of the
conversion.

WebHelp: Vista to SBO Conversion
Report

Click to display Help on the Vista to SBO
Conversion Report.

Links list

Click a link to display the specific list of
objects.

Expand/Collapse All

Click to expand or collapse all the details
lists on the page.

Expand/Collapse

Click to expand a collapsed details list or
collapse an expanded details list.

Top

Click to display the top of the details page.

Successfully converted objects

Displays a list of objects that were
successfully converted.

Vista objects already exist in SBO

Displays a list of objects whose names
already exist in the Building Operation
database. For more information, see section
125.14 “Manual Vista Conversion
Engineering Work” on page 5277.

Partially converted objects

Displays a list of objects that were partially
converted. For more information, see section
125.11 “Partially Converted Objects” on
page 5272.
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Continued

04-16006-04-en, March 2015

Component

Description

Failed converted objects

Displays a list of objects that were not
converted. For more information, see section
125.14 “Manual Vista Conversion
Engineering Work” on page 5277.

Broken references

Displays a list of objects whose references
are broken. For more information, see
section 125.14 “Manual Vista Conversion
Engineering Work” on page 5277.

Vista objects that are not supported

Displays a list of objects that are not
supported in Building Operation. For more
information, see section 125.14 “Manual
Vista Conversion Engineering Work” on page
5277.

Neuron IDs for converted devices

Displays a list of Neuron IDs for the
converted devices.

Groups and Users

Displays the mapping between Vista user
groups and the Vista users that are
members of that group. Vista groups and
users are not converted.
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Copying from Spreadsheet View to MS Excel

126 Spreadsheet View
126.1 Spreadsheet Overview

126.1

Spreadsheet Overview
You use the Spreadsheet view to create and edit multiple objects and to save time.
For example, working through the steps in the wizard to create each I/O module
and then again to create each channel takes a lot of time. Instead, you can set up
the entire I/O configuration in the Spreadsheet view with all objects and properties
in full view. You can copy and paste within and between the Spreadsheet view and
MS Excel.

126.1.1

Configuration Types
You can set up the following configuration types in the Spreadsheet view:
• Values
• Folders
• I/O modules
• I/O points
• Alarms
• Trend logs
• Modbus devices
• Modbus points
• Modbus values
To create or edit values, alarms, or trend logs, you select a server or a folder in the
System Tree pane, and then open the Spreadsheet view. The Spreadsheet view
displays the configuration in that location. If there is more than one configuration
type (for example, values, alarms, trend logs), the different configurations open in
separate tabs. You can also set up a configuration of a type that is not already in the
System Tree pane.
To create or edit I/O modules, you open the Spreadsheet view on the I/O bus. To
create or edit I/O points, you open the Spreadsheet view on the I/O module that you
want to configure. To create or edit Modbus devices, values, and points, you open
the Spreadsheet view on the Modbus Interface, network, or device that you want to
configure.

Note
• You can create a maximum of 27 I/O modules in one spreadsheet.
• You can create a maximum of 544 rows in one spreadsheet.
• Engineering units are automatically converted to your local settings when you
copy and paste cells.
• To successfully save a row in the spreadsheet, a type for the object must be
selected.
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126.1 Spreadsheet Overview

126.1.2

Autofill
When you select a cell, there is a little square handle in the bottom right side of the
cell. You can drag that handle up or down to autofill the column with the content of
the selected cell. If you press Ctrl while dragging the handle, new rows are created
for the autofill instead of overwriting the existing rows in the column. If you autofill
the Type column, some other columns are autofilled as well with default content.

Figure: Autofill

Note
• You cannot use autofill to create I/O points and define their type.

126.1.3

Navigation
The Tab key is used in WorkStation to navigate between user interfaces. In the
Spreadsheet view, the Tab key and Shift + Tab moves you left and right among
the spreadsheet cells. If you are in the first cell or in the last cell of the spreadsheet,
you navigate out of the Spreadsheet view.
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Continued

126.1.4

126.1.5

126.1.6

Navigation keys

Action

Tab

Move to the right one cell.

Shift + Tab

Move to the left one cell.

Home

Move to the first cell in the row.

Ctrl + Home

Move to the first row in the column.

End

Move to the last cell in the row.

Ctrl + End

Move to the last row in the column.

Enter

Move one cell down.

Arrow keys (up, down, left, right)

Move between cells.

Selection
Selection keys

Action

Shift + arrow keys

Make a rectangular selection of cells.

Shift + Home

Select to the beginning of row.

Shift + End

Select to the end of the row.

Ctrl + A

Select all.

Editing
Key

Action

Any key

Overwrite previous content in cell.

F2

Activate editing mode in cell.

Enter

Validate editing and move one cell down.

Esc

Return to prior content.

Shortcut Keys
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Shortcut keys

Action

Ctrl + T

Start Spreadsheet view.
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Continued
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Shortcut keys

Action

F2

Edit cell.

Ctrl + C

Copy.

Ctrl + V

Paste.

Ctrl + X

Cut.

Ctrl + Shift + C

Copy column headers.

Ctrl + F

Quick filter.

Ctrl + U

Change unit.

Ctrl + Z

Cancel.

Del

Delete.
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126.2

Creating Multiple Objects
Using the Spreadsheet view, you can quickly create multiple objects, such as I/O
modules, I/O points, values, alarms, and trend logs.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To create multiple objects
1. In WorkStation, in the System Tree pane, select where you want to create
the objects.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, click the
objects you want to set up.

button and select which type of

Note
• The content of an I/O bus, I/O module, a Modbus interface, or a
Modbus device opens up directly in the Spreadsheet view.
4. In the first row of the Type column, select the object type.

Continued on next page
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126.2 Creating Multiple Objects

5. Enter the rest of the properties, as you would do in the corresponding wizard.

Tip
You can use the shortcut key Ctrl + U to change the engineering unit
of a value in the Spreadsheet view.
6. Create additional objects using Steps 4-5.

Tip
• You can also copy and paste cells, rows, and entire blocks.
7. On the File menu, click Save.
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126.3

Configuring Multiple Objects
Using the Spreadsheet view, you can quickly configure collections of objects,
such as I/O modules, I/O points, values, alarms, and trend logs, objects that you
otherwise would configure one at a time in their respective property dialog boxes.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

Configuring Multiple Objects
1. In WorkStation, in the System Tree pane, select the collection of objects that
you want to configure.
2. On the Actions menu, click Edit in spreadsheet.
3. In the Spreadsheet view, edit the objects.

Tip
You can use the shortcut key Ctrl + U to change the engineering unit
of a value in the Spreadsheet view.
4. On the File menu, click Save.
A progress view indicates that Building Operation is saving your changes. If a
problem occurs, the save is cancelled and an error message is displayed.
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126.4

Copying from MS Excel to Spreadsheet
View
You can copy cells, rows, or an entire worksheet from Microsoft Excel and then
paste the data into the Spreadsheet view in WorkStation.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

Tip
• The columns and the format of the cells, such as enumerations (date, time,
and so on) and language, must match the setup in the Spreadsheet view.

To copy from MS Excel to Spreadsheet view
1. In WorkStation, in the System Tree pane, select the server, the I/O bus, the
I/O module, or the folder where you want to paste data.
2. On the Actions menu, click Edit in spreadsheet.
3. Open the MS Excel spreadsheet from where you want to copy data.
4. Select the data that you want to paste to the WorkStation Spreadsheet
view.
5. Press CTRL-C.

Continued on next page
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6. In WorkStation, in the Spreadsheet view, select the cell or the rows where
you want to paste the data.
7. Press CTRL-V.

8. On the File menu, click Save.
The pasted data is saved in the WorkStation Spreadsheet view. If any of the data
would have been invalid according to cell formatting, column order, or just missing
data, a dialog box would have notified you about it. For example, the paste included
an invalid value in the Type column because of an empty input type.

In case of invalid data, you can either go back to MS Excel, correct the data, copy
and paste it again, or you could insert it anyways and correct the data in the
Spreadsheet view.
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126.5

Copying from Spreadsheet View to MS
Excel
You can copy column headers, cells, and rows from the Spreadsheet view in
WorkStation and then paste the data into an MS Excel spreadsheet.
For more information, see section 126.1 “Spreadsheet Overview” on page 5305.

To copy from Spreadsheet view to MS Excel
1. In WorkStation, in the System Tree pane, select the server, the I/O bus, the
I/O module, or the folder where you want to copy data.
2. On the Actions menu, click Edit in spreadsheet.
3. Right-click anywhere in the Spreadsheet view, and then select Copy
column headers.

4. Open a new MS Excel spreadsheet.
Continued on next page
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5. Press CTRL-V.

6. In WorkStation, in the Spreadsheet view, select the cells or the rows that
you want to paste into the MS Excel spreadsheet.
7. Press CTRL-C.
8. In the MS Excel spreadsheet, select where you want to paste the data, and
then press CTRL-V.

9. Save the MS Excel spreadsheet.
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127 Spreadsheet View User Interface
127.1 Spreadsheet View

127.1

Spreadsheet View
You use the Spreadsheet view to create and edit multiple objects. For more
information, see section 126.1 “Spreadsheet Overview” on page 5305.

Figure: Spreadsheet view

Table: Spreadsheet View
Number

Description
Type the filter criteria to filter the spreadsheet
rows.
Select the object Type that you want to
configure.
Click to change the engineering unit of a
selection in the spreadsheet.
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Continued
Number

Description
The cells depend on the configuration type
spreadsheet that you have opened (for
example, alarm, value, trend log, or I/O) and
adapt to the object types that you select.
Click New to open a Folder, Alarm,
Value, Trend, Modbus, or an IO
spreadsheet.
Click on existing Folder, Alarm, Value,
Trend, Modbus, or IO tabs to switch
between configuration types.
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127.2

Failed to Paste Data Dialog Box
Use the Failed to paste data dialog box to either continue the paste operation,
by pasting the valid property values into the Spreadsheet view, or cancel the paste
operation. You can copy the information on the invalid property values to the
clipboard.

Figure: Failed to paste data dialog box

Table: Failed to Paste Data Dialog Box
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Component

Description

Object

Displays the name of the object that contains
a property that cannot be pasted into the
Spreadsheet view. For more information, see
section 127.1 “Spreadsheet View” on page
5319.

Property name

Displays the name of the property that
cannot be pasted into the Spreadsheet view.
For more information, see section 127.1
“Spreadsheet View” on page 5319.

Error message

Displays information on why the paste
operation failed.

Invalid value

Displays the invalid property value.

Copy to clipboard

Click to copy the information to the
clipboard.
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Continued
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Component

Description

Yes

Click to continue the paste operation, by
pasting the valid property values into the
Spreadsheet view.

No

Click to cancel the paste operation.
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128 Text Reports
128.1 Text Reports Overview

128.1

Text Reports Overview
A text report provides a simple and quick method of obtaining a customized view of
object property attributes.

128.1.1

Text Reports
A text report contains, in textual format, the attributes of selected properties of an
object (or a number of objects). Each text report is displayed in its own text report
view in the Work area when you drag-and-drop an object or a group of objects into
the text report view.
A filter within each text report allows only selected object attributes to be displayed
in the text report. However, you cannot edit filters; currently, the only types of
reports available are preconfigured, built-in text reports where each filter is
dedicated to a report type.
For more information, see section 128.2 “Text Reports” on page 5326.

128.1.2

Types of Text Reports
Building Operation has text reports that you can generate for objects within I/A
Series devices and Sigma controllers.
For more information, see section 128.3 “Types of Text Reports” on page 5328.

128.1.3

Text Report Groups
A text report group enables you to bring together all the objects that you want to
include in a text report. This enables you to generate a single text report on several
diverse objects.
For more information, see section 129.1 “Text Report Groups” on page 5353.
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128.2

Text Reports
A text report contains, in textual format, the attributes of selected properties of an
object (or a number of objects). Each text report is displayed in its own text report
view in the Work area when you drag-and-drop an object or a group of objects into
the text report view.
To obtain a text report, you first create a text report in a server or folder in the
System Tree pane. You select that text report to display it in the text report view.
You then drag an object to that report view to display the attributes of that object.
In this example, an MNL-V2RV3 has been dragged to an I/A Series Flow Balance
Report view.

Figure: Example text report

The text report view contains specific attributes of objects contained within the
selected device. However, the text report view does not report on all properties of
the selected device. The attributes displayed depend on the type of text report. In
this case, the attributes that are displayed for the selected device are the flow
balance properties, which are part of the Advanced properties:

Figure: I/A Series VAV flow balance properties selected for text report

The example report contains all of the attributes of the flow balance properties. For
example, in the Flow Balance Information properties, the property called Minimum
flow setpoint (l/s) has three attributes:
• Name = Minimum flow setpoint
• Value = 21
• Unit = l/s
Each of these attributes is displayed in the report as the following line:
Minimum flow setpoint 21.00 l/s
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You can drag multiple objects into a text report view to generate different text
reports for several different objects. In this case, the reports appear one after
another in the same text report view. If however, you want to generate a single
report on several objects at the same time, there are two ways of doing this:
• Create a text report group and then generate the report from the text report
group. For more information, see section 129.1 “Text Report Groups” on page
5353.
• Place all the relevant objects (or a shortcut for each object) into a folder and
drag the folder to the text report view.
If your text report sources a large number of objects (regardless of the method you
use to generate the report), you can configure the text report so that Building
Operation processes objects in convenient batches rather than all objects at one
attempt. In this way, you can see each batch as it is being processed and you can
estimate how long the report is likely to take to complete. For more information, see
section 128.15 “Configuring a Text Report” on page 5346.
All formatting for the report, such as the color of the text and column separation, is
determined by the report filter.
After you have created a text report, you can print it, you can save it to a text file,
and you can clear it.
If you generate a text report without clearing the previous text report, the latest text
report is added to the previous text report.
A number of built-in text reports are available to enable you to generate custom text
reports for certain object types. For more information, see section 128.3 “Types of
Text Reports” on page 5328.
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128.3

Types of Text Reports
Building Operation has text reports that you can generate for objects within I/A
Series devices and Sigma controllers.

128.3.1

I/A Series Text Reports
I/A Series text reports contain information relating to objects within I/A Series
controllers.
For more information, see section 128.4 “I/A Series Text Reports” on page 5329.

128.3.2

Sigma Text Reports
Sigma text reports contain information relating to objects within Sigma controllers.
For more information, see section 128.8 “Sigma Text Reports” on page 5335.
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128.4

I/A Series Text Reports
I/A Series text reports contain information relating to objects within I/A Series
controllers.
You can create and delete multiple instances of up to three different types of I/A
Series text reports.

128.4.1

I/A Series Flow Balance Report
An I/A Series Flow Balance Report provides flow balance information for MNL
LonWorks VAV devices.
For more information, see section 128.5 “I/A Series Flow Balance Report” on page
5330.

128.4.2

I/A Series S-Link Calibration Report
An I/A Series S-Link Calibration Report provides S-Link calibration information for all
MNL LonWorks devices that you can create in Building Operation.
For more information, see section 128.6 “I/A Series S-Link Calibration Report” on
page 5331.

128.4.3

I/A Series Analog Input Calibration Report
An I/A Series Analog Input Calibration Report provides analog input calibration
information for analog input object types in MNL LonWorks devices.
For more information, see section 128.7 “I/A Series Analog Input Calibration
Report” on page 5332.
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128.5

I/A Series Flow Balance Report
An I/A Series Flow Balance Report provides flow balance information for MNL
LonWorks VAV devices.
You can generate an I/A Series Flow Balance Report by dragging one of the
following I/A Series Variable Air Volume controllers from the System Tree pane into
the I/A Series Flow Balance Report view:
• MNL-V1RV3
• MNL-V2RV3
• MNL-V3RV3
You can also generate an I/A Series Flow Balance Report by dragging a LonWorks
network into the I/A Series Flow Balance Report view, when the network contains
one or more I/A Series Variable Air Volume controllers. In this case, a report is
generated for each Variable Air Volume controller in the network.
An I/A Series Flow Balance Report contains the flow balance information extracted
from the Advanced properties of the device:

Figure: I/A Series VAV flow balance properties
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128.6

I/A Series S-Link Calibration Report
An I/A Series S-Link Calibration Report provides S-Link calibration information for all
MNL LonWorks devices that you can create in Building Operation.
You can generate an I/A Series S-Link Calibration Report by dragging any of the
MNL series controllers from the System Tree pane into the I/A Series S-Link
Calibration Report view.
You can also generate an I/A Series S-Link Calibration Report by dragging an I/A
Series network into the I/A Series S-Link Calibration Report view, when the network
contains one or more MNL controllers. In this case, a report is generated for each
controller in the network.
An I/A Series S-Link Calibration Report contains the S-Link Sensor and S-Link
Sensor calibration information extracted from the Advanced properties of the
device:

Figure: MNL controller S-Link sensor properties
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128.7

I/A Series Analog Input Calibration
Report
An I/A Series Analog Input Calibration Report provides analog input calibration
information for analog input object types in MNL LonWorks devices.
You can generate an I/A Series Analog Input Calibration Report by dragging any of
the following objects from the System Tree pane into the I/A Series Analog Input
Calibration Report view:
• Analog Input Temperature Fahrenheit
• Analog Input Temperature Celsius
• Analog Input Voltage
• Analog Input Milliamps
• Analog Input Resistance
You can also generate an I/A Series Analog Input Calibration Report by dragging an
I/A Series device or LonWorks network into the I/A Series Analog Input Calibration
Report view, when the device or network contains one or more of the relevant
analog inputs. In this case, a report is generated for each qualifiying analog input in
the device or network.
An I/A Series Analog Input Calibration Report contains the analog input sensor
status information extracted from the Basic properties of the analog input:
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Figure: Analog input value property

The report also contains the analog input sensor calibration information from the
analog input object's Advanced properties:
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Figure: Analog input offset calibration properties
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128.8

Sigma Text Reports
Sigma text reports contain information relating to objects within Sigma controllers.
A Sigma Interface in the System Tree pane contains four built-in text reports. You
cannot create additional instances of the built-in text reports (nor delete the built-in
reports).
Three additional text reports (in the Diagnostics folder) enable you to extract
diagnostics data relating to Log Set and Node Statistics, and Controller time.

128.8.1

Sigma Active Alarms Report
A Sigma Active Alarms text report displays information from Sigma objects that are
in the active state.
For more information, see section 128.9 “Sigma Active Alarms Report” on page
5336.

128.8.2

Sigma Hours Run Report
A Sigma Hours Run text report provides information from Sigma objects that hold
hours totalization values.
For more information, see section 128.10 “Sigma Hours Run Report” on page
5337.

128.8.3

Sigma Plant Review Report
A Sigma Plant Review text report displays Sigma object condition information.
For more information, see section 128.11 “Sigma Plant Review Report” on page
5338.

128.8.4

Sigma Report Text Report
A Sigma Report text report displays property information from Sigma objects.
For more information, see section 128.12 “Sigma Report Text Report” on page
5340.

128.8.5

Sigma Diagnostics Text Reports
Sigma diagnostics text reports enable you to display diagnostics information from
one or more Sigma controllers. Three built-in diagnostics text reports are available.
For more information, see section 128.13 “Sigma Diagnostics Text Reports” on
page 5342.
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128.9

Sigma Active Alarms Report
A Sigma Active Alarms text report displays information from Sigma objects that are
in the active state.
You can generate a Sigma Active Alarms report by dragging any of the following
objects from the System Tree pane into the Sigma Active Alarms Report view:
• Sigma Interface
• Controllers folder
• Sigma controller
• Segments or subsegment folder
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
In this System Tree pane example, three Sigma objects within controller 109 are in
the active alarm state:

Figure: Three Active Alarms in controller 109

The corresponding report displays the three active alarms:

Figure: Active Alarms report for controller 109
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128.10

Sigma Hours Run Report
A Sigma Hours Run text report provides information from Sigma objects that hold
hours totalization values.
You can generate a Sigma Hours Run report by dragging objects that contain
totalization values into the Sigma Hours Run report. You can drag the following
object types:
• Sigma Interface
• Controllers folder
• Sigma controller
• Segments or sub-segment folder
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
In the following text report example, object 0026 has a totalization value of 65,313
(in addition to other relevant properties):

Figure: Sigma Hours Run report on an analog input

The totalization value in the report relates to the value displayed in the Totalization
value property of the object dialog box:

Figure: Analog object Totalization value
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128.11

Sigma Plant Review Report
A Sigma Plant Review text report displays Sigma object condition information.
The plant review report displays all objects that exhibit any of the following
conditions, and all conditions that apply:
• ALM: Alarm
• HRA: Totalization (hours run) alarm
• MAN: Manual mode
• MAH: Manual alarm inhibit
• PCS: Precancelled totalization (service interval) alarm
• TE: Time extension
• SPO: Scan priority=0
• DEF: Object returning default value
• SAI: Optimizer with self-adaption inhibited
You can generate a Sigma Plant Review report by dragging any of the following
objects from the System Tree pane into the Sigma Plant Review report view:
• Sigma Interface
• Controllers folder
• Sigma controller
• Segments or subsegment folder
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
For example, controller 853 includes three rotation objects, each with a time
extension:
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Figure: Rotation objects with time extensions

The plant review report for controller 853 contains just the three rotation objects,
each displaying the Time Extension (TE) condition:

Figure: Plant Review report for controller 853
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128.12

Sigma Report Text Report
A Sigma Report text report displays property information from Sigma objects.
You can generate a report by dragging Sigma objects into the report view. You can
drag objects at Sigma object level and above. The properties displayed for each
object depend on the configuration in the Sigma controller. Some, but not
necessarily all object properties, are displayed in the report.
For more information, see section 128.16 “Viewing a Text Report” on page 5347.
In the example shown below, object 39 includes an Alarm 1 Window and an Alarm
2 Window:

Figure: Sigma object containing alarm windows

The following figure is the Sigma Report text report for object 0039:

Figure: Sigma Report text report for a single Sigma object

The properties displayed relate to the properties dialog boxes for the Sigma object
and the two associated alarms. The object dialog box contains the alarm status,
object value, and the reason for the value, as shown in the report.
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Figure: Sigma object status information

The dialog boxes for the Alarm 1 and Alarm 2 windows display the configuration
settings and the alarm priority contained in the report.

Figure: Alarm configuration settings for Alarm 1 Window in object 0039

Figure: Alarm configuration settings for Alarm 2 Window in object 0039
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128.13

Sigma Diagnostics Text Reports
Sigma diagnostics text reports enable you to display diagnostics information from
one or more Sigma controllers. Three built-in diagnostics text reports are available.
You can access Sigma diagnostics text reports from any Sigma controller object or
from the Sigma Text Reports folder.

128.13.1

Sigma Diagnostics Controller Time Report
The Diagnostics Controller Time report displays the instantaneous time and date
values within one or more Sigma controllers. You generate the report by dragging
an individual controller into the report view, or by dragging the controllers folder if
you want the time and date for all controllers to be displayed. The following example
report displays the values in controller 109:

Figure: Diagnostics Controller Time report for controller 109

128.13.2

Sigma Diagnostics Log Set Statistics Report
The Diagnostics Log Set Statistics report displays the log set values within one or
more Sigma controllers. The following example is a text report for controller 853:

Figure: Diagnostics Log Set Statistics report for controller 853

The log set parameters in the text report correspond directly to the basic Log Set
Statistics properties:
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Figure: Log Set Statistics basic properties

128.13.3

Sigma Diagnostics Node Statistics Report
The Diagnostics Node Statistics report displays the values within one or more
Sigma controllers. The following example report displays the values in controller
109:

Figure: Diagnostics Node Statistics report for controlller 109

The parameters in the Diagnostics Node Statistics report correspond to the
properties displayed in the Node Statistics properties tabs.
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Figure: Node Statistics properties tabs
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128.14

Creating a Text Report
You create a text report to view an object's property attributes textually. You can
also create a text report group in which to combine objects before generating a text
report.
For more information, see section 128.2 “Text Reports” on page 5326.

To create a text report
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the text report.
2. On the File menu, point to New and then click Text Report.
3. In the object type list, select the text report type.

4. In the Name box, type a name for the text report.
5. In the Description box, type a description for the text report.
6. Click Create.
You can now configure the text report.

04-16006-04-en, March 2015

Technical
5347

128 Text Reports
128.15 Configuring a Text Report

128.15

Configuring a Text Report
You configure a text report to set the way in which objects are handled by Building
Operation when a text report is generated. You can also determine if the report path
and/or a diagnostics trace is displayed in the report.
For more information, see section 128.2 “Text Reports” on page 5326.

To configure a text report
1. In WorkStation, in the System Tree pane, select the text report.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Objects per batch

Enter the maximum number of objects
you want Building Operation to process in
each batch. The limit is 32767. For more
information, see section 128.2 “Text
Reports” on page 5326.

Display report path

Select True to display the path of the
report in the text report view. For more
information, see section 130.4 “Text
Report View” on page 5362.

Time stamp

Select True to enable the display of the
time and date at which you create the text
report.

Display trace

Select True to display a diagnostics trace
in the text report view. For more
information, see section 128.2 “Text
Reports” on page 5326.

You can now generate a text report.
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128.16

Viewing a Text Report
You view a text report when you want to see textual information relating to an
object's property attributes.
For more information, see section 128.2 “Text Reports” on page 5326.

To view a text report
1. In WorkStation, in the System Tree pane, select a text report to display the
text report view in the Work area.
2. In the System Tree pane, drag the relevant object, folder, or text report
group to the text report view.
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128.17

Clearing a Text Report
You clear a text report when you want to remove the text report from the text report
view.

To clear a text report
1. In WorkStation, in any text report view, generate a text report. For more
information, see section 128.16 “Viewing a Text Report” on page 5347.
2. On the text report view toolbar, click the Clear button
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128.18

Printing a Text Report
You print a text report when you want to create a hardcopy of your text report.

To print a text report
1. In WorkStation, generate the text report that you want to print.
2. On the text report view toolbar, click the Print button

.

3. Select a printer.

4. Click Print.
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128.19

Exporting a Text Report
You export a text report to a text document (or a rich text format document) when
you want to save an electronic copy of your text report.

To export a text report
1. In WorkStation, generate the text report that you want to export.
2. On the text report view toolbar, click the Export button

.

3. Browse to the folder to which you want to export the text report.
4. In the Save as type box, select either Text Documents (.txt) or Rich text
document (.rtf).

5. In the File name box, type a name for the report.
6. Click Save.
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129 Text Report Groups
129.1 Text Report Groups

129.1

Text Report Groups
A text report group enables you to bring together all the objects that you want to
include in a text report. This enables you to generate a single text report on several
diverse objects.
You configure a text report group by adding, one by one, all the objects that you
want to include in the text report. For example, you might want to include objects
from different systems such as BACnet or Modbus, and the selected objects can
be remote from each other, for example, in different folders. You then choose the
type of text report you want to display in the Work area when you generate the
report. This is known as the Default text report for the group. You can generate a
grouped object report simply by clicking on the text report group object. The
generated text report view replaces any other view displayed in the Work area.

Note
Although you can include any type of Building Operation object in a text report
group, the resultant text report view is restricted by the number of text report
types available. Currently, all text report types relate to I/A Series LonWorks
Devices and Sigma only.
You can also generate a report for the group of added objects by dragging the text
report group object into a selected text report view (in the same way as you would
drag a single object or folder). If the text report view already contains a text report,
the group report is added after the previous text report.
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129.2

Creating a Text Report Group
You create a text report group in which to combine objects before generating a text
report relating to multiple objects.
For more information, see section 128.1 “Text Reports Overview” on page 5325.

To create a text report group
1. In WorkStation, in the System Tree pane, select the server or folder where
you want to create the text report group.
2. On the File menu, point to New and then click Text Report.

Note
If you are creating a text report group in a Sigma interface, point to
New and then click Text Report Object, and ignore the next step.

3. In the object type list, select Text Report Group.
4. In the Name box, type a name for the text report group.
5. In the Description box, type a description for the text report group.
6. Click Create.
You can now configure the text report group.
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129.3

Configuring a Text Report Group
You configure a text report group to source multiple objects for a text report. You
also select a default text report for the generation of the report.
For more information, see section 129.1 “Text Report Groups” on page 5353.

To configure a text report group
1. In WorkStation, in the System Tree pane, select the text report group.
2. On the File menu, click Properties.
3. Click the Basic tab.
4. Edit the basic properties:
Component

Description

Object list

Click Add, and then select an object in
the System Tree pane. Repeat until all
the required objects are in the list.
To delete an object, clear the adjacent
check box, and then click OK.

Default text report

Enter a text report object that is in the
System Tree pane.

You can now view a text report from the text report group.
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129.4

Viewing a Text Report from a Text
Report Group
You view a text report from a text report group when you want to view a text report
derived from multiple objects.
For more information, see section 128.1 “Text Reports Overview” on page 5325.

To view a text report from a text report group
1. Ensure that the text report group object is fully configured. For more
information, see section 129.3 “Configuring a Text Report Group” on page
5355.
2. In WorkStation, in the System Tree pane, click the text report group to
display the text report view in the Work area.
You can now view the text report.
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130 Text Reports User Interface
130.1 Text Reports Icons

130.1

Text Reports Icons
This section describes icons that relate to text reports.
Table: Text Reports Icons
Icon

Description
Text report
Indicates a text report.
Text report group
Indicates a text report group.
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130.2

Text Report Properties – Basic Tab
Use the Basic tab to view and edit basic information about any text report.

Figure: Basic tab

Table: Basic Tab
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Component

Description

Objects per batch

Enter the maximum number of objects you
want Building Operation to process in each
batch. The limit is 32767. For more
information, see section 128.2 “Text
Reports” on page 5326.

Display report path

Select True to display the path of the report
in the text report view. For more information,
see section 130.4 “Text Report View” on
page 5362.

Time stamp

Select True to enable the display of the time
and date at which you create the text report.

Display trace

Select True to display a diagnostics trace in
the text report view. For more information,
see section 128.2 “Text Reports” on page
5326.
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130.3

Text Report Group Properties – Basic
Tab
Use the Basic tab to add objects to the text report group, and to specfy a default
text report to be used for the generation of the report.

Figure: Basic tab

Table: Basic Tab
Component

Description

Object list

Click Add, and then select an object in the
System Tree pane. Repeat until all the
required objects are in the list.
To delete an object, clear the adjacent check
box, and then click OK.

Default text report
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Enter a text report object that is in the
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130.4

Text Report View
Use the text report view to generate text reports by dragging an object from the
System Tree pane.

Figure: Text report view

Table: Text Report View
Number

Description
Text report
Click to display the report view for this text
report in the Work area. For more
information, see section 128.2 “Text
Reports” on page 5326.
Object on which text report is based
Drag to the text report view.
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Continued
Number

Description
Text report view toolbar
Use the toolbar to print, clear, and export
text reports. For more information, see
section 130.5 “Text Report View Toolbar” on
page 5364.
Report text
An example of a text report.
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130.5

Text Report View Toolbar
Use the Text Report View toolbar to print, clear, and export text reports.
Table: Text Report View Toolbar
Button

Description
Print text report button
Click to open the printer dialog box. For
more information, see section 128.18
“Printing a Text Report” on page 5349.
Clear text report button
Click to clear the currently displayed text
report from the text report view. For more
information, see section 128.17 “Clearing a
Text Report” on page 5348.
Export text report button
Click to open the Save As dialog box. For
more information, see section 128.19
“Exporting a Text Report” on page 5350.
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131 Installation Troubleshooting
131.1 Enterprise Server does not Start

131.1

Enterprise Server does not Start
The Enterprise Server does not start and the Enterprise Server Windows service
status remains stopped.

131.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check if the Enterprise Server is running, if not start the Enterprise Server
Windows service.
For more information, see the Starting the Server Windows Service topic on
WebHelp.
• Open the Enterprise Server log for information about the problem.
For more information, see the Viewing Enterprise Server System Log topic on
WebHelp.
• If one of the following strings are written in the Enterprise Server Log, the port
used by the Enterprise Server conflicts with other software in your network:
– nsp.csc.webserver.WebServer Startup failure: Bad configuration of ports,
certificates
– nsp.csc.webserver.WebServer Net Exception: Address already in use:
x.x.x.x:80
x.x.x.x represents the IP address and 80 the port number used by the
Enterprise Server
For more information, see section 5.6 “Configuring Server Port Settings” on
page 208.
• Check the Enterprise Server address to the License Server. You can view the
address in the License Administrator or Enterprise Server log.
For more information, see the Configuring the Address to the License Server
topic on WebHelp.
• Make sure that the License Server, to which the Enterprise Server is directed,
contains an available network license, or a local license is activated.
For more information, see the Viewing Activated Licenses topic on WebHelp.
• Repair, reinstall, or upgrade the current Enterprise Server Installation.
For more information, see the Repairing the Enterprise Server topic on
WebHelp.
For more information, see the Reinstalling the Enterprise Server topic on
WebHelp.
For more information, see the Upgrading the Enterprise Server topic on
WebHelp.
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132 Alarms Troubleshooting
132.1 Alarm Is Not Displayed in the Alarms Pane and Alarm View

132.1

Alarm Is Not Displayed in the Alarms
Pane and Alarm View
An alarm is triggered and is in alarm state, but the alarm is not indicated in the
Alarms pane and Alarm View.

132.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the alarm is not hidden in the Alarms pane and Alarm View.
For more information, see the Showing a Hidden Alarm in the Alarm View topic
on WebHelp.
• Ensure that the Alarms pane and Alarm View filter are configured to show the
alarm.
For more information, see the Creating a Filtered Alarm View topic on
WebHelp.
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132.2 Event Is Not Displayed in the Events Pane and Event View

132.2

Event Is Not Displayed in the Events
Pane and Event View
You cannot find an event in the Events pane and Event View.

132.2.1

Solution
Make sure the Events pane and Event View are not filtered in a way that hides the
event.

To create a filtered Event View
1. In WorkStation, in the System Tree pane, select the folder or Building
Operation server where you want to create the event.
2. On the File menu, point to New and then click View.
3. In the object type list, click Event View.

4. In the Name box, type a name for the Event View.
5. In the Description box, type a description for the Event View.
6. Click Create.
7. In the System Tree pane, select the Event View that you want to add an
event filter to.
8. On the Actions menu, click Edit Event Filter.
Continued on next page
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9. In the Select Conditions dialog box, click the Add Condition button
and select a condition.

10. Enter the settings of the condition.

Tip
You can add several event view conditions to specify when to write
the event view.
11. Click the Add row button

to add another condition of the same type.

12. Click OK.
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132.3

Notification E-mail Is Not Received
An alarm is triggered, but no E-mail notification is received.

132.3.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check the settings of the Building Operation server E-mail configuration.
For more information, see section 4.6 “Selecting the Schneider Electric E-mail
Server for E-mail Notifications” on page 181.
For more information, see section 4.7 “Selecting and Specifying an E-mail
Server for E-mail Notifications” on page 183.
• Check the receiver E-mail address of the notification.
For more information, see the Creating an E-mail Notification topic on
WebHelp.
• Make sure the notification condition is properly configured.
For more information, see the Creating an E-mail Notification topic on
WebHelp.
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132.4

The Alarm Is Disabled and Cannot Be
Enabled
You are trying to enable an alarm in the Alarms pane or Alarm View that seems to
be disabled, without any result.

132.4.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• There might be a shunt variable connected to alarm that disables the alarm.
For more information, see the Editing the Shunt Variable topic on WebHelp.
• Verify that the alarm is properly configured with monitored variable and
triggering values.
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132.5

User Cannot Be Assigned to an Alarm
You want to select a user for an alarm assignment but it doesn’t work because the
user does not seem to exist in the system.

132.5.1

Solution
You are probably logged on to a lower tier server and the user account that you are
trying to assign the alarm to is located on a higher server in your server hierarchy.
To access the account, you have to log on to the server where the assignment is
located or to another server higher in the hierarchy.
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132.6

A Category Cannot Be Edited
You want to edit a category but it does not work.

132.6.1

Solution
You are probably logged on to a lower tier server and the category you are trying to
edit is located on a higher server in your server hierarchy. To access the category,
you have to log on to the server where it is located, or to another server higher in the
hierarchy.
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132.7

Cause Note Cannot Be Edited
You want to edit a cause note but it doesn’t work.

132.7.1

Solution
You are probably logged on to a lower tier server and the cause note you are trying
to edit is located on a higher server in your server hierarchy. To access the cause
note, you have to log on to the server where it is located, or to another server higher
in the hierarchy.
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132.8

Action Note Cannot Be Edited
You want to edit an action note but it does not work.

132.8.1

Solution
You are probably logged on to a lower tier server and the action note you are trying
to edit is located on a higher server in your server hierarchy. To access the action
note, you have to log on to the server where it is located, or to another server higher
in the hierarchy.
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132.9

Checklist Cannot Be Edited
You want to edit a checklist but it doesn’t work.

132.9.1

Solution
You are probably logged on to a lower tier server and the checklist you are trying to
edit is located on a higher server in your server hierarchy. To access the checklist,
you have to log on to the server where it is located, or to another server higher in the
hierarchy.
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133 Alarms Deep Technical Reference
133.1 Hidden Alarms with Normal State

133.1

Hidden Alarms with Normal State
Alarms with normal state are not manually displayed in the Alarms pane and Alarm
Views. The exception is when you hide an alarm and the hidden alarm goes back to
normal state. If you choose to display hidden objects in the Alarms pane and Alarm
Views, the alarm is presented with normal state. Once the alarm with normal state is
unhidden it is removed from the Alarms pane and Alarm Views.
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133.2 Basic Evaluation State

133.2

Basic Evaluation State
The alarm property “Basic evaluation state“ together with the current alarm state
and the acknowledgement type are the factors that determine the state transitions
of an alarm. For more information, see the Acknowledgement topic on WebHelp.
When a monitored variable steps outside the configured normal criteria for an alarm
the “Basic evaluation state“ is changed from False to True. When the problem that
cause the problem is correct and the monitored variable returns to the normal range
of the alarm, the Basic evaluation state is changed back to False.
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134 Trends Troubleshooting
134.1 Trend Log Does Not Start Record Due to the Start Condition

134.1

Trend Log Does Not Start Record Due
to the Start Condition
The trend log does not start recording according to the defined start condition. This
problem can appear on interval trend logs or change of value trend logs.

134.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the start condition settings are correct.
For more information, see the Configuring the Interval of an Interval Trend Log
topic on WebHelp.
For more information, see the Configuring a Change of Value Trend Log topic
on WebHelp.
• Ensure that the trend log is enabled.
For more information, see the Enabling a Trend Log topic on WebHelp.
• If the start condition is set to Time controlled, ensure that the server clock
where the trend log is located is correctly adjusted.
For more information, see the Changing the Time Zone of an Enterprise Server
or Automation Server topic on WebHelp.
For more information, see the Configuring Locale Regional Settings topic on
WebHelp.
For more information, see the Manually Changing the Automation Server Time
and Date topic on WebHelp.
• Connect the trend log to a trend log list or trend chart to verify if any values are
recorded. If no values are recorded, try tracking down the problem through a
trend log event such as The log is not configured or Sample was
missed.
For more information, see the Creating a Trend Log List topic on WebHelp.
For more information, see the Creating a Trend Chart that Monitors a Trend
Log Series topic on WebHelp.
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134.2 Meter Trend Log Calculation Fails

134.2

Meter Trend Log Calculation Fails
The calculation of a meter trend log does not make sense. For example, the
consumption calculation of a meter trend log is not equivalent to the real
consumption.

134.2.1

Solution
Check the data in the Manage replacement of meter dialog box. If data is
missing or does not properly match the values of the meter, the calculation fails
when the meter rollover or is replaced.

To manage replacement of a meter
1. In WorkStation, in the System Tree pane, select the meter trend log you
want to manage.
2. On the Actions menu, click Manage Meter.
3. In the End time box, enter the end time of the old meter. Preferably the time
when the meter is replaced.

4. In the End value box, type the value of the old meter when it was replaced.
5. In the Start time box, enter the time when the new meter is installed.
6. In the Start value box, type the current value of the new meter when it was
installed.
7. In the Meter constant box, type the constant of the new meter. For
example, if the meter counts in kilo (103) type 1000.
8. In the Min value box, type the first value of the new meter when it rolls over.
Continued on next page
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9. In the Max value box, type the last value of the new meter before it rolls over.

10. Click OK.
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134.3 Missing Trend Log Records

134.3

Missing Trend Log Records
The trend log is missing records:
• No recorded data in the trend log
• No symmetry to the data

134.3.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Decrease the interval or delta of the trend log.
For more information, see the Configuring the Interval of an Interval Trend Log
topic on WebHelp.
For more information, see the Configuring a Meter Trend Log topic on
WebHelp.
For more information, see the Configuring a Change of Value Trend Log topic
on WebHelp.
• If the trend log is a variable triggered trend log, check that the trigger variable
correctly switches between the true and false states.
For more information, see the Configuring a Variable Triggered Trend Log topic
on WebHelp.
• Connect the trend log to a trend log list or trend chart to verify if any values are
recorded. If no values are recorded, try tracking down the problem through
trend log event such as The log is not configured or Sample was
missed.
For more information, see the Creating a Trend Log List topic on WebHelp.
For more information, see the Creating a Trend Chart that Monitors a Trend
Log Series topic on WebHelp.
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134 Trends Troubleshooting
134.4 Illogical or Missing Records in the Trend Log List

134.4

Illogical or Missing Records in the Trend
Log List
The records in the trend log list seem to be illogical or are missing.

134.4.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Sort the trend log list in terms of the value or time by clicking the trend log
column titles.
• Refresh the trend log list.
For more information, see the Refreshing a Trend Log List topic on WebHelp.
• If a calculation is connected to the trend log list, check the length of the
calculation period. Calculation periods that are too short can result in periods
without records to calculate.
For more information, see the Attaching a Calculation Method to a Trend Log
List topic on WebHelp.
For more information, see the Configuring a Trend Log List topic on WebHelp.
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134 Trends Troubleshooting
134.5 Trend Chart Does Not Show Trend Log Series

134.5

Trend Chart Does Not Show Trend Log
Series
The trend chart is empty and does not show the series of recorded trend log values.

134.5.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the trend chart is connected to a trend log and the trend log is
enabled.
For more information, see the Configuring a Trend Chart topic on WebHelp.
For more information, see the Enabling a Trend Log topic on WebHelp.
• Ensure that the series is not hidden or placed behind another series.
For more information, see the Hiding a Series in a Trend Chart topic on
WebHelp.
For more information, see the Changing the Display Order of the Series topic
on WebHelp.
• Configure the span for the x-axis and y-axis.
For more information, see the Manually Configuring the Y-Axis Scale topic on
WebHelp.
For more information, see the Automatically Configuring the Y-Axis Scale topic
on WebHelp.
For more information, see the Configuring the X-Axis with a Relative Time Span
topic on WebHelp.
For more information, see the Configuring X-Axis with an Absolute Time Span
topic on WebHelp.
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134 Trends Troubleshooting
134.6 Interrupted Series in the Trend Chart

134.6

Interrupted Series in the Trend Chart
The series is interrupted and empty white spaces are displayed where values are
expected. The trend chart does not contain any events that would explain this kind
of behavior.

Figure: Trend chart with white spaces.

134.6.1

Solution
Ensure that the calculation period of an attached series is long enough to collect
records to calculate. No records to calculate results in unknown values that are
illustrated as white spaces in the trend chart.
For more information, see the Attaching a Calculation Method to a Trend Chart
Series topic on WebHelp.
For more information, see the Editing the Trend Chart Settings topic on WebHelp.
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134 Trends Troubleshooting
134.7 Trend Chart Y-Axis has Scale Problems

134.7

Trend Chart Y-Axis has Scale Problems
The trend chart presents recorded values with such a big range between each span
on the y-axis that an oscillating series is displayed as a straight line.

134.7.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Scroll the trend chart backwards to see if a single record diverges from the
normal. If so, manually edit the record to a more expected value and refresh
the trend chart.
For more information, see the Scrolling the X-Axis in Small Steps topic on
WebHelp.
For more information, see the Editing or Comment a Trend Log Record topic
on WebHelp.
For more information, see the Refreshing the Trend Chart topic on WebHelp.
• If the trend chart y-axis is not auto scaled, manually configure the y-axis scale.
For more information, see the Manually Configuring the Y-Axis Scale topic on
WebHelp.
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134.8 Trend Chart Live Update does not Work

134.8

Trend Chart Live Update does not Work
The trend chart is not automatically updated with the latest records.

134.8.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Activate the Live update function.
For more information, see the Activating Trend Chart Live Update topic on
WebHelp.
• Set the trend chart time zone to Local time.
For more information, see the Configuring the Trend Chart Time Zone Mode
topic on WebHelp.
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134 Trends Troubleshooting
134.9 Records Are Not Transferred to the Extended Trend Log

134.9

Records Are Not Transferred to the
Extended Trend Log
Records are overwritten in the trend log before they are transferred to the extended
trend log.

134.9.1

Solution
Enable the Smart log or lower the Threshold value. You can also use the Force
transfer command to manually start a transfer.
For more information, see the Manually Transferring Records to the Extended Trend
Log topic on WebHelp.
For more information, see the Configuring an Extended Trend Log topic on
WebHelp.
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134.10 Cannot Delete Trend Log or Its Container

134.10

Cannot Delete Trend Log or Its
Container
You are not allowed to delete a trend log nor to delete the folder or server that
contains a trend log object. The following message is displayed; Operation
failed: Can't delete or detach log monitored by an extended trend log.

134.10.1

Solution
Before deleting the trend log, you have to delete the extended trend log that is
connected to the trend log. You can not delete a server or folder that contains a
trend log without deleting the connected extended trend log. This problem also
occurs if you are trying to delete an IO variable that has an extended trend log
connected to its implicit trend log.

To delete an object
1. In WorkStation, in the System Tree pane, select the object you want to
delete.
2. On the Edit menu, click Delete.
3. Select if you want to keep references in other object(s) to the object you
selected to delete.
4. Click Show references to see the affected references.
5. In the Confirm Delete dialog box, click Yes.
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135

Trends Deep Technical
Reference

Topics
Trend Log Tick
Block Transfer
Smart Log

135 Trends Deep Technical Reference
135.1 Trend Log Tick

135.1

Trend Log Tick
Every time a trend log stores records equivalent to ten percent of its capacity, the
trend log sends a tick to the extended trend log. The extended trend log properties
Threshold and Smart log use these ticks to keep track of the trend log status.
For example, an extended trend log has the Threshold property set to 40%. This
means that the extended trend log transfers new records from the connected trend
log after every fourth tick.
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135 Trends Deep Technical Reference
135.2 Block Transfer

135.2

Block Transfer
When the extended trend log triggers a transfer, all records to transfer are collected
into a block. If blocks from different trend logs are transferred to extended trend
logs located on the same server, the server places the blocks in a Round Robin
queue. Round Robin means that 200-300 records are divided from the first block
and transferred to its target extended trend log. When the records are transferred,
the block with its remaining records is placed last in the queue. This process
continues until all records in a block are transferred and the empty block is removed
from the queue.
For example, an extended trend log triggers a transfer of 800 records from the
Yellow trend log. At the same time, another extended trend log located on the same
server triggers a transfer of records from the Blue trend log. The two incoming
blocks are queued by the server with the yellow block first. According to the Round
Robin process, 200 records from the yellow block are transferred to the yellow
extended trend log. The block with remaining 600 records is placed last in the
queue. Now, 200 records from the blue block are transferred, when this is done the
block with remaining records is placed last in the queue. This process continues
until all blocks are transferred to its corresponding extended trend log.

Figure: When transferring records from a trend log to an extended trend log the records
are divided in blocks and queued according to the Round Robin process.

Transferring a big chunk of records without this orderliness could choke the system
and disturb other functions that also require system resources or bandwidth. Using
the block transfer method increases the probability that each piece of information is
collected and transferred to the extended trend log.
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135.3 Smart Log

135.3

Smart Log
The Smart log algorithm adjusts the transfer threshold according to many variables,
such as the frequency of new records, the maximum number of records of the
trend log, and the transfer time.
When you create an extended trend log, the extended trend log starts automatically
transferring all stored records from the connected trend log. During this initial
transfer, Smart log calculates the proper transfer threshold using the time it took to
transfer the records and the time between two ticks. Smart log adjusts the
threshold in steps of ten percentages. With high bandwidth and a long duration
between two ticks the Smart log can tune the transfer threshold to maximum eighty
percent, equal to eight ticks between each transfer. If the trend log starts to record
values more rapidly than Smart log predicted, the transfer threshold is automatically
decreased. The lowest transfer threshold is ten percent. Smart log does not turn
down the transfer threshold to an unnecessary low level.
All records to transfer are queued according to the Round Robin process. Smart
log has three transfer priority levels: Background, Normal, and Panic. The
Background queue consists of records that are transferred for the first time to
extended trend logs that just have been created. When the extended trend log is
synchronized with its connected trend log and all records are transferred, Smart log
has collected all necessary variables to calculate a suitable transfer threshold. The
next transfer triggered by the transfer threshold is given Normal priority. Records in
the Background queue have to wait to be transferred until all records with Normal
priority are transferred.
A trend log that starts recording values more rapidly and risks overwriting records
before they are transferred to the extended trend log, is given the Panic priority by
Smart log. Records with Panic priority are dedicated all bandwidth and the blocks in
the Normal queue or Background queue are on hold. When Smart log has
transferred all records in the Panic queue, records with Normal priority are
transferred.
Extended trend logs come out of panic mode when they have caught up with the
fetching of records. Extended trend logs are very rarely in Panic mode. In the
unlikely scenario that all extended trend logs are in Panic mode then that is handled
according to the Round Robin process.
Panic mode could occur for an extended trend log, for example, if the interval trend
log it monitors has a roll-over time of 1 day and has logged 80% of its capacity
without the extended trend log having fetched any records. This is an extremely rare
scenario. In this case, Panic mode would mean that the extended trend log has
about 5 hours to start fetching data.
For example: A Building Operation system consists of four Automation Servers:
Spade, Diamond, Heart, and Club. The Automation Servers are connected to an
Enterprise Server where an extended trend log for each trend log is located.
Normally Smart log transfers the records from Spade, Diamond, and Heart in a
regular pace. The records are divided into blocks and queued according to the
Round Robin process. The records from the newly created Club Automation Server
are placed in the lower prioritized Background queue. When all records with Normal
priority are transferred, Smart log starts to transfer the records that are waiting in
the Background queue. Suddenly the trend log on the Heart Automation Station
starts recording values at such a speed that if the records of the Heart trend log are
queued with the other trend logs, the Heart trend log records are presumably
overwritten before they are transferred to the extended trend log. Smart log
prevents the overwrite by moving the Heart records to the highest priority, Panic.
The blocks in the Normal queue have to wait until the last block in the Panic queue
is transferred.
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135 Trends Deep Technical Reference
135.3 Smart Log

Figure: Smart log prioritize the records to transfer in three levels. Panic is the highest level
and Background is the lowest.

If you perform a Force Transfer on an extended trend log that is already
transferring, the records to transfer are moved up to a higher priority level.
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136 Schedules Troubleshooting
136.1 Using Schedules to Control BACnet Multistate Objects

136.1

Using Schedules to Control BACnet
Multistate Objects
Building Operation and BACnet multistate schedules provide values for BACnet
multistate outputs and multistate values. Schedules have a different range of
possible values than the multistate outputs and values they control. While
schedules can have a value of zero, BACnet multistate objects can only contain
integers, positive whole numbers not including zero.

136.1.1

Solution
Configure exceptions, weekly events, and the default value with values other than
zero.
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136 Schedules Troubleshooting
136.2 Exception Event Does Not Delete

136.2

Exception Event Does Not Delete
An exception event you deleted in the Basic Schedule Editor Event grid does not
delete from the Calendar overview or the Advanced Schedule Editor. In the Basic
Schedule Editor Calendar Overview, the dates from the deleted exception event are
highlighted in blue. In the Advanced Schedule Editor, the exception event has been
deleted from the time value periods, but still remains in the Schedule event tree and
are highlighted in blue in the Calendar overview.

136.2.1

Solution
Deleting the exception event from the Advanced Schedule Editor will remove the
exception event from the Advanced Schedule Editor Schedule event tree. Then,
toggle from the Advanced Schedule Editor to the Basic Schedule Editor to see the
blue highlighting from the Calendar overviews are removed too.
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Access to
User Session Has Expired
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137 User Management Troubleshooting
137.1 Wrong Domain, User Name or Password

137.1

Wrong Domain, User Name or Password
When logging on to WorkStation, you get the error message Wrong domain, user
name or password.

137.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Make sure you entered the correct user name, password, and domain name.
The user name, password, and domain names are case sensitive.
For more information, see the Logging on to WorkStation using your Windows
Credentials topic on WebHelp.
For more information, see the Logging on to WorkStation as another Windows
User topic on WebHelp.
For more information, see the Logging on to WorkStation as a StruxureWare
User topic on WebHelp.
• Make sure the server you want to log on to is available.
For more information, see section 137.2 “Server is not Available” on page
5412.
• If you cannot log in with your administration account, contact Schneider
Electric to reset the password. For more information, see the Resetting the
Administrator Password topic on WebHelp.

04-16006-04-en, March 2015

Technical
5413

137 User Management Troubleshooting
137.2 Server is not Available

137.2

Server is not Available
When logging on to WorkStation, you get the error message “Server is not
available”.

137.2.1

Solutions
The server could be starting up and that is why the server is not available. Wait a
minute and then log on again.
For more information, see the Logging on to WorkStation as a Windows Account
User topic on WebHelp.
For more information, see the Logging on to WorkStation as a StruxureWare User
topic on WebHelp.
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137.3 Failed to Establish Connection

137.3

Failed to Establish Connection
When logging on to an Enterprise Server through WorkStation, you get the error
message “Failed to establish connection”.

137.3.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check the Enterprise Server address to the License Server.
For more information, see the Configuring the Address to the License Server
topic on WebHelp.
• Make sure that the License Server, to which the Enterprise Server is directed,
contains an available license or an activated local license.
For more information, see the Viewing Activated Licenses topic on WebHelp.
• Restart the Enterprise Server Windows service.
For more information, see section 5.9 “Restarting the Server Windows Service”
on page 211.

04-16006-04-en, March 2015

Technical
5415

137 User Management Troubleshooting
137.4 User Account has been Disabled

137.4

User Account has been Disabled
When logging on to WorkStation, you get the error message “User Account has
been Disabled”.

137.4.1

Solution
Enable the user account.

To enable a disabled user account
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

Continued on next page
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137 User Management Troubleshooting
137.4 User Account has been Disabled

3. Click Account management.

4. In the Domain list, select the domain the user account belongs to.
5. In the User Accounts list, select the user account.
6. Click Summary.
Continued on next page
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137 User Management Troubleshooting
137.4 User Account has been Disabled

7. In the Disabled box, select False to enable the account.

8. Click the Save button

.

For more information, see the Enabling a Disabled User Account topic on WebHelp.
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137.5 User Account Has Expired

137.5

User Account Has Expired
When logging on to WorkStation, you get the error message “User Account has
Expired”.

137.5.1

Solution
Contact the system administrator.

To remove the expiration date for a user account
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click Account management.
Continued on next page
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137 User Management Troubleshooting
137.5 User Account Has Expired

4. In the Domain list, select the domain the user account belongs to.

5. In the User Accounts list, select the user account.
6. Click Summary.
7. In the Expires on boxes, remove the date and time settings for the account.

8. Click the Save button

Technical
5420

.

04-16006-04-en, March 2015

137 User Management Troubleshooting
137.6 Your Account Has Insufficient Permissions to Use the System

137.6

Your Account Has Insufficient
Permissions to Use the System
When logging on to WorkStation, you get the error message “Your account has
insufficient permissions to use the system. Contact your administrator”.

137.6.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• You have to be a member of at least one user account group to log on to
WorkStation.
For more information, see the Adding a User Account to an Account Group
topic on WebHelp.
• Contact the system administrator to make sure you have at least Read
permission to one branch in the System Tree.
For more information, see the Assigning Software Permissions to a User
Account topic on WebHelp.
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137.7 Logon Button Greyed Out

137.7

Logon Button Greyed Out
When you try to log on to WorkStation, the Log on button is grayed out.

137.7.1

Solution
To log on to Building Operation you have to enter a server to log on to.
For more information, see the Logging on to WorkStation as another Windows User
topic on WebHelp.
For more information, see the Logging on to WorkStation as a StruxureWare User
topic on WebHelp.
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137.8 Cannot Close WorkStation

137.8

Cannot Close WorkStation
When you try to log off from WorkStation, the Log Off command is grayed out on
the File menu.

137.8.1

Solution
Ensure that you are not a member of a user account group with the May close
user interface checkbox cleared on the user account group Policies tab.

To enable a group of users to exit WorkStation
1. In WorkStation, on the Tools menu, click Control Panel.
2. On the Control Panel toolbar, select the server.

3. Click Account management.
Continued on next page
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137 User Management Troubleshooting
137.8 Cannot Close WorkStation

4. In the Domain list, select the domain the user account group belongs to.

5. In the User Account Groups list, select the user account group.
6. Click Policies.
7. Select the May close User Interface box.

8. Click the Save button
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137.9 Workspace Layout Changes Have Disappeared

137.9

Workspace Layout Changes Have
Disappeared
The changes you made to a workspace are not there the next time you open the
workspace.

137.9.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Log off from WorkStation, any changes you make to the layout becomes
effective the next time you log on to WorkStation.
For more information, see the Logging Off WorkStation topic on WebHelp.
For more information, see the Logging on to WorkStation as another Windows
User topic on WebHelp.
For more information, see the Logging on to WorkStation as a StruxureWare
User topic on WebHelp.
• Log on Building Operation from the same WorkStation computer as the one
you used when you made the changes. Layout changes are stored locally and
are only applied when you log on to the workstation you used to make the
changes.
• You cannot change the layout of a workspace if you are logged on with a
Windows account.
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137.10 Can not Access Servers or Folders that You Earlier had Access to

137.10

Can not Access Servers or Folders that
You Earlier had Access to
You can access servers or folders that you earlier had access to.

137.10.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that your user account has not expired or is disabled.
For more information, see the Enabling a Disabled User Account topic on
WebHelp.
For more information, see the Setting an Expiration Date for a User Account
topic on WebHelp.
• Ensure that your user account or user account group has the proper software
permissions, which are required to access and read the content of servers or
folders. If the name of the server or folder has been changed, you have to
reconfigure the path permission or undo the name change.
For more information, see the Editing the Software Permissions of a User
Account topic on WebHelp.
For more information, see the Editing the Software Permissions of a User
Account Group topic on WebHelp.
For more information, see section 3.10 “Renaming a Server” on page 152.
For more information, see the Renaming a Folder or Object topic on WebHelp.
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137.11 User Session Has Expired

137.11

User Session Has Expired
When your computer has been inactive for more than 360 minutes, you are logged
off from WorkStation and WorkStation for Projects.

137.11.1

Solution
Log on to WorkStation or WorkStation for Projects again.
For more information, see the Logging on to WorkStation using your Windows
Credentials topic on WebHelp.
For more information, see the Logging on to WorkStation as another Windows User
topic on WebHelp.
For more information, see the Logging on to WorkStation as a Building Operation
User topic on WebHelp.
For more information, see section 5.14 “Logging on to WorkStation for Projects” on
page 222.
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137.12 Windows Group Name List Is Empty

137.12

Windows Group Name List Is Empty
The Windows group name list is empty and does not display any Windows
Active Directory groups due to permission problems or restricted access in the
Windows Active Directory.

137.12.1

Solution
Ensure that the necessary access and permissions are set up on the Windows
Domain:
• Contact the domain administrator to find out more about the permissions and
restricted access in the Windows Active Directory.
• The account running the Enterprise Server service has to be a member of a
user group in the Windows Active Directory
• The account running the Enterprise Server service has to have List content
access to the Windows Domain object.
• The account running the Enterprise Server service has to have Enumerate
Entire SAM Domain access to the SAM server object in the System folder on
the Windows Domain controller.
• The account running the Enterprise Server service has to be a member of the
Access Control List (ACL) on the Windows Domain controller.
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138 WorkStation Troubleshooting
138.1 Cannot Mass Create Trend Logs or Alarms

138.1

Cannot Mass Create Trend Logs or
Alarms
After selecting the objects or properties that you want to mass create trend logs or
alarms for, the Create Object wizard does not open.

138.1.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the alarm or trend log is suitable for the selected objects or
properties. If no alarm or trend log is suitable for your combination of objects or
properties, the Create Object wizard does not open. For more information, see
the Object or Property Variable Type topic on WebHelp..
• Ensure that the selected objects or properties have the same unit or no defined
unit. If you have selected objects or properties with different units, the Create
Object wizard does not open. For more information, see the Mass Create Unit
Managing topic on WebHelp.
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138.2 Main Menu Cannot be Displayed

138.2

Main Menu Cannot be Displayed
A detailed description of the problem including information about when the problem
occurred, under what circumstances it appears etc.
When describing the problem, you can use body texts, notes, graphics, lists, and
xrefs to conceptual information etc.

138.2.1

Solution
A description of the possible solution to the problem. Always start the solution
descriptions with a verb.
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139 Licensing Troubleshooting
139.1 Unable to Check Out License

139.1

Unable to Check Out License
Though the license server contains available licenses, the WorkStation, client tool,
or Enterprise Server fails to check out the necessary license.

139.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.

Note
• If critical, activate a local license before you start troubleshooting. For more
information, see the Activating a Local License topic on WebHelp.
• Check the WorkStation or Enterprise Server address to the license server.
Make sure you have added an 'at' sign (@) in front of the license server host
address or DNS name.
For more information, see the Configuring the Address to the License Server
topic on WebHelp.
• Restart the license server.
For more information, see the Restarting the License Server topic on WebHelp.
• If you have removed a local license that is similar to the license you are trying to
check out, restart the computer or server.
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139 Licensing Troubleshooting
139.2 Problem with the Licenses on the License Server

139.2

Problem with the Licenses on the
License Server
Licenses on the license server are missing or seem to be broken.

139.2.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Restart the license server.
For more information, see the Restarting the License Server topic on WebHelp.
• Restore the license server if you have a backup.
For more information, see the Restoring Licenses topic on WebHelp.
• Reset the license server.
For more information, see the Resetting the License Server topic on WebHelp.
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139.3

Network Licenses are Broken
Licenses on a license server are indicated as broken licenses in the License
Administrator.

139.3.1

Solution
Something has happened to the license server, or the licenses on the server, that
breaks the strict license policy. For more information, see the License Repair topic
on WebHelp.

To repair a network license
1. In License Administrator, click the Licenses view.
2. Select the network license that you want to repair.

3. On the Licenses toolbar, click the Repair license button

.
Continued on next page
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4. Click Yes.

5. Click Close.

6. Click Restart now, to restart the license server and make the repaired
licenses available for checkout.

The license is now repaired and available to be checked out.
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139.4

Unable to Activate or Return a License
The activation or return transaction of a license fails.

139.4.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check the connection to the Internet and the local area network.
• Open the Transaction Error dialog box for further information.
For more information, see section 139.5 “Opening the Transaction Error Dialog
Box” on page 5438.
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139.5 Opening the Transaction Error Dialog Box

139.5

Opening the Transaction Error Dialog
Box
If an activation or transaction fails, you open a dialog box that contains the error
information. This information is helpful when you are troubleshooting.

To open the transaction error dialog box
1. In the License Administrator, Activation Progress dialog box, double-click the
license that failed to activate.

2. View the description of the problem that caused the activation or return to fail.

3. Click OK.
The error dialog box shown in this example occurs when the Internet connection
fails.
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139.6

Cannot Access lmadmin, License Server
Manager
The lmadmin web interface to configure the license server is not accessible.

139.6.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the License Server is running.
For more information, see the Starting the License Server topic on WebHelp.
• Ensure that the port to access lmadmin is not conflicting with other
applications or blocked by your firewall. The default port number is 8888. If
necessary, change the port number to lmadmin.
For more information, see the Changing lmadmin License Server Manager Port
Number topic on WebHelp.
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139.7

The License Server does not
Automatically Restart
The license server unxpectly stops and does not automatically restart. Licensed
Building Operation software does not start if it can not check out a license from the
license server.

139.7.1

Solution
By configuring the license server to automatically restart itself if it stops, you shorten
the down time and the need for immediate manual interaction.

To configure the license server recovery settings
1. On the license server, open the Service management console.

Note
In Windows, open the Run dialog box and type services.msc.
2. Right-click Building Operation License Server.

Continued on next page
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3. Select Properties.
4. Click the Recovery tab.

5. In the First failure box, select Restart the Service.
6. In the Second failure box, select Restart the Service.
7. In the Subsequent failures box, select Restart the Service.
8. Click OK.
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140 Licensing Deep Technical Reference
140.1 Trusted Storage

140.1

Trusted Storage
Building Operation uses the advantages of trusted storage technology. Trusted
storage is a secure encrypted storage area on the client’s disk drive where only
approved applications are allowed to read and write.
Data removed or copied from a trusted storage can not be read on other
computers. The trusted storage locks licenses to the system and prevents illegal
transfer to other systems. For more information, see the License Repair topic on
WebHelp.
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140.2 License Activation Server Registry Key

140.2

License Activation Server Registry Key
The address to the License Activation Server is not editable in the License
Administrator but is stored in the registry on the license server:
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric\StruxureWare
x.x\License Administrator\TACLAS, where x.x is the version number.

Caution
• The address to the License Activation Server should only be edited in advice
with Schneider Electric.

Note
Start the License Activation Server address with http://. For example,
http://licensing.tac.com
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140.3

Stored License Server Addresses
The addresses to the license servers on a WorkStation or Enterprise Server are
stored in two registry keys.
When adding a license server address trough the License Administrator, the license
address is stored in the register key:
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric\StruxureWare\License
Administrator\TACLIC_LICENSE_FILE.
When a WorkStation or Enterprise Server successfully checks out a network license
from a license server, the license server address is written in the register key:
• Windows Server 2008 and Windows Server 2012:
HKEY_CURRENT_USESR\Software\FLEXlm License
Manager\TACLIC_LICENSE_FILE = @localhost
• Windows 7 and Windows 8.1: HKEY_CURRENT_USESR\Software\FLEXlm
License Manager\TACLIC_LICENSE_FILE = @localhost
If you remove a license server address from the License Administrator the change
only affects the registry key: ...\License Administrator\TACLIC_LICENSE_FILE. The
license server address is not removed in the register key: ..\FLEXlm License
Manager\TACLIC_LICENSE_FILE. The consequent is that though the license server
address is removed in License Administration, the WorkStation or Enterprise Server
can keep checking out licenses from the license server.
To stop the WorkStation or Enterprise Server checking out licenses from a license
server you can:
• Disconnect the license server from the network
• Change the network address to the license server
• Remove the address to the license server from the WorkStation or Enterprise
Server registry key FLEXlm License Manager\TACLIC_LICENSE_FILE. You
have to do this for each Windows user account, in the registry.
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141 Localization Troubleshooting
141.1 WorkStation does not Display Correct Values

141.1

WorkStation does not Display Correct
Values
Values in WorkStation lack decimals or the units of measure are not as expected,
such as inches rather than centimeters.

141.1.1

Solution
All values in WorkStation are localized by the operating system regional settings on
which WorkStation is installed.

To change regional settings
1. Close all Building Operation-related applications.
2. For more information on how to change the regional settings, please refer to
the manufacturer’s manual for the operating system.
Next time WorkStation starts, the new regional settings are used.
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141.2

Enterprise Server does not Synchronize
its Clock
The Enterprise Server does not seem to synchronize its clock with the network time
servers that are defined in the WorkStation.

Figure: Enterprise Server date and time tab.

141.2.1

Solution
The network time server address in the Enterprise Server Date & Time view
configures the network time server addresses for connected shadow Automation
Servers, not the Enterprise Server itself. The Enterprise Server network time server
addresses are configured through the operating system.

To configure the Enterprise Server and WorkStation date and
time
1. Close all Building Operation-related applications.
2. For more information on how to adjust the date and time, refer to the
manufacturer’s manual for the operating system.

Note
The time zone settings for an Enterprise Server are configured through
WorkStation and not the operating system.
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141.3

Incorrect Time Stamps in WorkStation
Alarms and logs have incorrect time stamps. This problems occurs when you
change time zone settings in your Windows operating system and then do not
restart WorkStation.

141.3.1

Solution
Restart WorkStation.
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141.4

Delta Temperature Conversion is
Incorrect
When converting the delta of a temperature from Celsius to Fahrenheit or from
Fahrenheit to Celsius, the converted value is incorrect.
This error occurs if the delta variable has a unit of ˚C or ˚F rather than ∆˚C or ∆˚F.

141.4.1

Solution
Ensure that the unit of the delta variable is ∆˚C or ∆˚F.

Figure: The unit category Temperature Diff in the Unit selection dialog box.

Note
Units are converted automatically depending on your regional settings. To display
the original unit of a value you can open the Unit Selection property of the object.
For more information, see the Units topic on WebHelp.

To add or change a unit and prefix for a value
1. In WorkStation, in the System Tree pane, select the value or point you want
to configure.
2. On the File menu, click Properties.
Continued on next page
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3. Click the Value Configuration button

.

Continued on next page
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4. Select the Configured box that is in front of the Unit box.

5. In the Unit box, click the Browse button

.

6. Select the unit.

Continued on next page
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7. In the Prefix box, select the prefix of the unit.
8. Click Select.
9. In the Value dialog box, click OK.
10. In the Properties dialog box, click OK.
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142 Connect Agent Troubleshooting
142.1 System and crash information not available on Connect storage server

142.1

System and crash information not
available on Connect storage server
If proxy setting is configured, system and crash information is not available on
Connect storage server.

142.1.1

Solution
Run the command BITSADMIN in cmd.exe as administrator and then restart the
Connect Agent service.

For more information on BITSADMIN command, refer following links:
http://msdn.microsoft.com/en-us/library/aa362813(v=vs.85).aspx
http://myserverissick.com/2010/05/how-to-set-proxy-settings-for-the-localsystemand-networkservice-accounts
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143 WebReports Troubleshooting
143.1 WebReports Read Failure

143.1

WebReports Read Failure
You cannot log on to WebReports with a web browser or not see any data when
running reports.

143.1.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check the Struxure Ware Reporting Agent Log to verify that the Reports Server
is connecting to the Enterprise Server properly. If you see connection
problems, verify that the Enterprise Server IP address is correct in the
configuration file, 'SE.WebReports.StruxureWareReportingAgent.exe.config'.
For more information, see section 10.4 “Enterprise Server Properties –
Network Tab” on page 349.
• Check that the Reports Server performs reads properly. Open SQL Server
Management Studio and run a query 'Select top 100 rows' for
StruxureWareReportsDB table, 'dbo.tbEventLogs'. Type the query 'order by
starttime desc.'. Check to make sure reads are occurring after the upgrade. If
you have made many Extended Trend Logs in your system, the initial
Enterprise Server read may take over an hour. You will not see an entry in the
dbo.tbEventLogs table until a read is complete.
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143.2

Authentication Failed
When you save the password for the SystemReportsService user account, you get
the error message "Authentication failed. Could not connect to ES".

143.2.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the password is the same in the Enterprise Server and the Reports
Server.
For more information, see the Changing Password for the
SystemReportsService User Account topic on WebHelp.
For more information, see the Configuring the SystemsReportsService User
Account Password using WebReports Administrator topic on WebHelp.
• Ensure that the Enterprise Server is running.
• Ensure that the password is not expired or disabled.
For more information, see the Enabling a Disabled User Account topic on
WebHelp.
For more information, see the Setting an Expiration Date for a User Account
topic on WebHelp.
• Ensure that the user account is associated to the Reports Administrators
group.
For more information, see the Adding a User Account to a User Account Group
topic on WebHelp.
• Ensure that the user account is not associated with a group with 'No Access'
permission. Ensure that the user account or user account group has the
proper software permissions, which are required to access and read the
content of servers. If the name of the server has been changed, you have to
reconfigure the path permission or undo the name change.
For more information, see the Editing the Software Permissions of a User
Account Group topic on WebHelp.
For more information, see the Editing the Software Permissions of a User
Account topic on WebHelp.
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143.3

Could not Connect to Reports Database
While saving the password in Reports Server for SystemReportsService user
account, you get the error message "Could not Connect to Reports Database".

143.3.1

Solution
• Ensure that the Reports database server is running.
• Ensure that SQL server service is running and the DataSource is correct in the
configuration file, 'SE.WebReports.StruxureWareReportingAgent.exe.config'.
For more information, see section 10.4 “Enterprise Server Properties –
Network Tab” on page 349.
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144 Project Configuration Server Troubleshooting
144.1 WorkStation for Projects User Account has been Disabled

144.1

WorkStation for Projects User Account
has been Disabled
When logging on to WorkStation for Projects, you get the error message “User
Account has been Disabled”.

144.1.1

Solution
Enable the user account.
For more information, see section 5.22 “Enabling a WorkStation for Projects User
Account” on page 232.
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144.2

WorkStation for Projects User Account
Has Expired
When logging on to WorkStation for Projects, you get the error message “User
Account has Expired”.

144.2.1

Solution
Contact the system administrator.
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144.3

Project Configuration Server does not
Start
The Project Configuration Server does not start.

144.3.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check if the Project Configuration Server is running. If it not is running, start the
Project Configuration Server Windows service.
For more information, see section 5.9 “Restarting the Server Windows Service”
on page 211.
For more information, see section 5.8 “Starting the Project Configuration
Server Windows Service” on page 210.
• Open the Project Configuration Server log for information about the problem.
For more information, see section 145.1 “Project Configuration Server System
Log” on page 5483.
• If one of the following strings are written in the Project Configuration Server log,
the port used by the Project Configuration Server conflicts with other software
in your network:
– nsp.csc.webserver.WebServer Startup failure: Bad configuration of ports,
certificates
– nsp.csc.webserver.WebServer Net Exception:Address alreday in
use:x.x.x.x:81
x.x.x.x represents the IP address and 81 the port number used by the Project
Configuration Server.
For more information, see section 145.1 “Project Configuration Server System
Log” on page 5483.
For more information, see section 5.6 “Configuring Server Port Settings” on
page 208.
• Reinstall the current Project Configuration Server installation.
For more information, see section 5.11 “Reinstalling the Project Configuration
Server” on page 215.
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144.4

User Session Has Expired
When your computer has been inactive for more than 360 minutes, you are logged
off from WorkStation and WorkStation for Projects.

144.4.1

Solution
Log on to WorkStation or WorkStation for Projects again.
For more information, see the Logging on to WorkStation using your Windows
Credentials topic on WebHelp.
For more information, see the Logging on to WorkStation as another Windows User
topic on WebHelp.
For more information, see the Logging on to WorkStation as a Building Operation
User topic on WebHelp.
For more information, see section 5.14 “Logging on to WorkStation for Projects” on
page 222.
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144.5

Server is Starting Up
When logging on to the Project Configuration Server through WorkStation for
Projects, you get the error message "The server is currently starting up and cannot
accept your log on. Try again later".

144.5.1

Solution
Wait a minute and then log on again.
For more information, see section 5.14 “Logging on to WorkStation for Projects” on
page 222.
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144.6

Failed to Establish Connection
When logging on to a Project Configuration Server through WorkStation for
Projects, you get the error message “Failed to establish connection”.

144.6.1

Solution
• Restart the Project Configuration Server Windows service.
For more information, see section 5.9 “Restarting the Server Windows Service”
on page 211.
• Check the port settings in the Software Administrator.
For more information, see section 5.6 “Configuring Server Port Settings” on
page 208.
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144.7

Lead-Shadow Reference Server
Communication Problems
Lead-shadow reference communication does not work between an Automation
Server and the Enterprise Server.

144.7.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the communication address to the Enterprise Server is correct. The
address should be either an IP address or a fully qualified domain name (host
name plus domain name) such as es1.universityx.edu.
For more information, see section 4.4 “Updating Communication Parameters”
on page 179.
For more information, see section 4.9 “Updating Project Configuration Server
Communication Parameters” on page 187.
• If you have deployed both the Enterprise Server and the Automation Server,
and changed the server communication setting on the Automation Server
afterwards, you may have to reset the Automation Server with a warm start.
For more information, see the Reset Functions topic on WebHelp.
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144.8

Failed Deploy of Server
A deploy of a server failed. For more information, see section 6.8 “Deploy” on page
248.

144.8.1

Solution
An error message is presented when the deploy fails. Possible solutions are listed
below. Choose the appropriate solution to resolve the problem.
• The on-site server is not empty. Reinstall the on-site Enterprise Server or
upgrade the physical Automation Server with a new database.
For more information, see the Reinstalling the Enterprise Server topic on
WebHelp.
For more information, see the Uploading and Upgrading an Automation Server
topic on WebHelp.
• You have exceeded the amount of LonWorks network objects according to
Building Operation rules. such as:
- You have associated the LonWorks network with more than one LonWorks
interface
- You have created more than 5 LonWorks networks on an Enterprise Server
and more than one local node on one of these networks.
- You have created more than one LonWorks network or local node on an
Automation Server.
- You have created more than 4096 network variables on a local node.
- You have created more than 30 Xenta groups on a LonWorks network.
- You have given a Xenta device a non unique name or a name consisting of
more than 20 characters.
Ensure to have the correct amount of LonWorks network objects.
For more information, see section 145.2 “Project Configuration Server
Validation” on page 5484.
• Ensure to have the correct amount of LonWorks networks.
• Bindings are not configured following LonWorks Standard best practices.
Follow best practices.
Echelon website
• An update monitor or a propagation trigger is created on the wrong type of
network variable, or on a device network variable.
For more information, see section 57.17 “Creating an Update Monitor” on page
2086.
For more information, see section 57.18 “Creating a Propagation Trigger” on
page 2087.
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144.9

Project Not Visible
The project is not visible in the WorkStation for Projects - Projects view after you
have moved the project database from another computer.

144.9.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Press the F5 function key in the Projects view.
• Restart the Project Configuration Server Windows service.
For more information, see section 5.9 “Restarting the Server Windows Service”
on page 211.
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145 Project Configuration Server Deep Technical Reference
145.1 Project Configuration Server System Log

145.1

Project Configuration Server System
Log
The Project Configuration Server system log contains events logged by the Project
Configuration Server. Examples of logged events are start up sequence, port
settings, failures, run time, and current server status.
The log can be found in the db, database folder, in the Projects folder, e.g.
C:\...ProgramData\Schneider Electric StruxureWare\Building
Operation\Projects\Project NN\db\logs.
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145.2 Project Configuration Server Validation

145.2

Project Configuration Server Validation
In an online server, built-in Building Operation product support, such as LonWorks,
handles object validations. A sub-set of that validation is, however, done in
WorkStation. These validations do not occur in the same way in Project
Configuration Server, when setting up your project.
In Project Configuration Server there is no server validation active at all. The
validation is not executed in Project Configuration Server. However, the sub-set of
the server validation is active, and in this case done in Workstation for Projects. This
is the same client side validation as in an online system. The complete server
validation is done in the online server during deploy.
For more information, see section 144.8 “Failed Deploy of Server ” on page 5478.

Figure: LonWorks Project engineering validation

145.2.1

LonWorks and Project Configuration Server
Validation
Keep the following points in mind regarding the validation of LonWorks devices and
objects:
• During configuration of a LonWorks project only a WorkStation for Project
validation is done, which makes it important not to exceed the amount of
LonWorks devices and objects according to Building Operation rules for a
successful deploy.
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145.2 Project Configuration Server Validation

Architectural Guidelines
• During configuration of bindings, ensure that LonWork Standards are followed
for a succesful deploy.
Echelon website
• After deployment to a Building Operation server, LonWorks handles the
validation of networks, interfaces and the major parts of LonWorks bindings.
Also the amount of objects are validated during a deploy, such as the amount
of Enterprise and Automation Servers, local nodes, devices, network variables,
Xenta groups, and devices.

Important
Ensure that propagation triggers and update monitors are created on the local
node, and on the correct network variable types, for a succesful deploy.
For more information, see section 57.11 “Propagation Trigger” on page 2077.
For more information, see section 57.10 “Update Monitor” on page 2076.

Note
Xenta groups are created from the folders with LonWorks Xenta devices in PCS
at deploy. Every 30 devices in a folder will be assigned to its own Xenta group.

145.2.2

BACnet and Project Configuration Server
Validation
Keep the following points in mind regarding the validation of BACnet devices and
objects:
• During configuration on the Project Configuration Server, BACnet devices and
objects follow a broad-based set of validation rules that are supported in
WorkStation, such as uniqueness checking of devices and object IDs.
• After deployment to a Building Operation server, BACnet handles the validation
of networks and interfaces, and fills in any available data, such as BACnet
object names or object IDs. Subsequent validation occurs when third-party
devices perform validation on objects and properties downloaded to them
according to their own rules. The BACnet download and upload processes
also resolve bindings, where possible.
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146 Device Administrator Deep Technical Reference
146.1 The Device Administrator Console Program

146.1

The Device Administrator Console
Program
If you are connected to an Automation Server through the USB port, or through an
IP network, you can use the Console program to perform special tasks. The
Console program uses Secure Shell (SSH) to communicate with the Automation
Server.
When you start the Console program, you are prompted to login as admin or root.
After that you are asked to supply the corresponding password.
You start the console program by shift+right-click and then click Console.

146.1.1

Log on Using admin
The password for admin log on is the same as for admin in the general Building
Operation configuration.
An admin user is given permission to execute only a limited number of commands,
including:
• ifconfig to determine the current IP address
• setip to set the hostname, a new IP address, or to request a dynamic IP
address through the DHCP protocol

146.1.2

Login Using root
Contact Product Support Services if you believe you need root level access.

146.1.3

Lockout Time
After three unsuccessful attempts to log on to the Automatic Server using the
Secure Shell (SSH) protocol, the Automation Server is locked and no new log on
attempts using SSH can be made until the lockout time has expired.
The lockout time is set in the Control Panel in WorkStation.
The lockout does not affect users that log on to the Automation Server using
WorkStation or WebStation.
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147 Automation Server Deep Technical Reference
147.1 Automation Server Principles

147.1

Automation Server Principles
The Automation Server runs a Linux based system in a microprocessor with
peripheral hardware that can be graphically shown in a block diagram:.

Figure: Automation Server hardware block diagram

147.1.1

CPU and Memory
The CPU is an Atmel AT91RM9200 System-on-Chip processor, which includes
interface for SDRAM, NAND-Flash, SD Flash Card, USB-Host, USB-Device,
Ethernet, UARTS, SPI, and general purpose I/O pins.
The volatile memory consists of an SDRAM module of 128 MByte and is used for
program execution and volatile storage.
The non-volatile memory consists of an embedded 4 GByte NAND-Flash SD-card
for main program storage. One part of this memory is used to save variables and
other important information (data retention) at power failure.
There is also a 4 Mbit DataFlash memory used for booting code and certain product
information.
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147.1 Automation Server Principles

147.1.2

Data Retention
The Automation Server is equipped with a powerful backup capacitor that will
provide power for at least 4.5 seconds after a power failure. This time is sufficient
for saving data in the non-volatile storage and performing a controlled shut-down of
the operating system.
The switch-over to the backup capacitor is automatic. A signal is also sent to the
processor that a power failure has occurred.

147.1.3

Device Addressing
When a Building Operation device is connected it automatically gets an address (a
‘slot’) between 1 and 32. The address is defined by the position, so if a device is
replaced the new device will get the same address as the old.
The logic for the addressing resides in the backplane, mounted in the bottom of the
terminal base of each device. For more information, see the Backplane Power and
Addressing topic on WebHelp.
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147 Automation Server Deep Technical Reference
147.2 Device Administrator USB Hubs

147.2

Device Administrator USB Hubs
If you want to upgrade the firmware of several Automation Servers with the Device
Administrator as a batch job, it may be convenient to use USB hubs. Example: In
the factory or in qualification labs.
However, not all hubs have the capacity to handle this scenario.
Tested and approved: Targus ACH82EU, with a maximum of seven USB
connections.
Tested, but not approved: Deltaco, Trust

04-16006-04-en, March 2015

Technical
5497

147 Automation Server Deep Technical Reference
147.3 License Information

147.3

License Information
The Automation Server is a Linux-based embedded system that consists of several
software components. The basics of a Linux system are the kernel, the C library,
and basic system utilities such as the login process and the shell.
These are used under GPL – GNU Public License and various Open Source
licenses.
The Persistent Memory driver is GPL contaminated and thus released under the GP
license.
In accordance with the GPL, you may request the relevant code for up to three
years from the date of original purchase of this product. The code will be supplied
on CD free of charge, though there will be a small fee to cover the cost of the CD,
plus shipping and handling.
For further information on the GNU GPL licenses, please visit
http://www.gnu.org/licenses and, for the complete GPL texts,
http://www.gnu.org/licenses/gpl-2.0.txt and http://www.gnu.org/licenses/gpl3.0.html
To request a CD copy, please e-mail us at info@buildings.schneider-electric.com
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Topics
Binding Does Not Work

148 Bindings Troubleshooting
148.1 Binding Does Not Work

148.1

Binding Does Not Work
The binding does not seem to work, update, or is simply gone.

148.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the network communication parameters are up-to-date. If not, the
source will be offline towards the destination property.
For more information, see section 4.4 “Updating Communication Parameters”
on page 179.
• Configure the polling of the binding. Maybe the binding is set to update too
seldom.
For more information, see section 15.8 “Configuring the Value Transfer Interval”
on page 428.
• Ensure that the binding exists. The binding may accidently have been
overwritten.
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149

Import and Export
Troubleshooting

Topics
Non-exportable Objects
Name Conflicts During Import
Container Conflicts During Import
Import Button Not Available
Import Finished with Warnings
Import Failed
Binding Template Name Is Not Intuitive
Cannot Export BACnet System Objects
Cannot Import BACnet Notification References
Cannot Preserve Trend Object Bindings During Import
Supporting Objects Already Exist
Cannot Import Supporting Objects for Alarms
Cannot Export User Management System Objects
Cannot Import LonWorks Solution

149 Import and Export Troubleshooting
149.1 Non-exportable Objects

149.1

Non-exportable Objects
When exporting a solution, Building Operation does not export some system
objects and properties. For example, you cannot export the System folder, or
object properties like device IDs. If a system object or folder is mistakenly included
in an export selection, the export process provides an Export Preview area, which
lists the non-exportable objects. The export proceeds but the non-exportable
object is not included in the export file. For more information, see section 18.25
“Exportable and Non-exportable Objects” on page 590.
If you create your own objects and folders within a system folder, you can export
them separately to the corresponding system folder on the targeted server, for
example, System – Alarms.

Note
Runtime values and properties are not exported.

149.1.1

Solution
Proceed with the export as previewed, or cancel the export entirely. If you cancel
the export, select only user-created objects and repeat the export process.
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149 Import and Export Troubleshooting
149.2 Name Conflicts During Import

149.2

Name Conflicts During Import
If you try to import an object into a container that already contains an object with the
same name as the imported object, Building Operation replaces the name of the
imported object. For example, you want to import a power meter named "Power
Meter 1" into a Modbus Master Network Interface that already contains a power
meter named "Power Meter 1". In this case Building Operation renames the
imported power meter "Power Meter 1_2". The renaming prevents overwriting the
existing object. You cannot modify the system-generated names during the import.
But, when the import is completed you can rename the imported object again.
The objects that is renamed during the import are displayed in the warning(s) tab in
the Import dialog box.

Figure: Name conflicts during Import
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149 Import and Export Troubleshooting
149.2 Name Conflicts During Import

Name conflicts can also occur if the import file contains any Custom object types. If
the target server already contains the Custom object type, as determined by its
name, a name conflict is indicated. In this case, a warning is displayed that the
Custom object type will not be imported and the server's Custom object type will be
used.

Tip
In a hierarchical system, any objects nested under top-level objects do not need
renaming during import. Similarly, any top level objects with unique names in the
import file keep their original names.

149.2.1

Solutions
Use one of the following options if there is a name conflict:
• Click Copy to clipboard if you want to save the conflicts for later resolution.
• Click Import to accept the system generated name. You can change the
name later.
• Click Cancel, then modify the selected server location name and import the
solution again.
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149 Import and Export Troubleshooting
149.3 Container Conflicts During Import

149.3

Container Conflicts During Import
During an import, a preview conflict message can display if you attempt to import
objects to a container or server that does not support the object. If this happens,
the system prevents the import from taking place and makes the Import button
unavailable.

Figure: Container conflicts during Import

For example, if you export a device configured specifically for a BACnet-based
Automation Server and then import the file to a LON-based Automation Server that
does not support that BACnet device type, the system detects an object type
mismatch. Specifically, BACnet devices are different from LON devices so the
import process cannot import this device type to the selected location (container).
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149 Import and Export Troubleshooting
149.3 Container Conflicts During Import

149.3.1

Solution
If there is a container conflict, click Copy to clipboard to paste the information to
a text editor and click Cancel. Use the New command to view the list of objects
that can be created in any given server location. Import the solution that contains
creatable objects into a container that can accept the solution.
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149 Import and Export Troubleshooting
149.4 Import Button Not Available

149.4

Import Button Not Available
The Import button on the Import dialog box is not available because of a container
conflict. This conflict occurs when an object in the solution cannot be accepted by
the destination container.

Figure: Import button not available

149.4.1

Solution
Click Copy to clipboard to paste the information into a text editor for later
resolution and then click Cancel. Import the solution to a different container that
can accept the solution.
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149 Import and Export Troubleshooting
149.5 Import Finished with Warnings

149.5

Import Finished with Warnings
The imported solution finishes but with warnings.

Figure: Import finished with warnings

149.5.1

Solution
Do any of the following.
• Click Show details to view information details and try to resolve the problem.
• Click Copy to clipboard and paste into a text editor if you want to save the
warnings for later resolution.
• Click Close to end the import operation.
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149 Import and Export Troubleshooting
149.6 Import Failed

149.6

Import Failed
The Failed to import message displays.

Figure: Import failed

149.6.1

Solution
In the Import dialog box, click Show details and view the error messages. After
resolving the errors or conflicts, import the solution again.
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149 Import and Export Troubleshooting
149.7 Binding Template Name Is Not Intuitive

149.7

Binding Template Name Is Not Intuitive
In product versions prior to 1.2, binding templates were automatically assigned a
non-intuitive unique name which was not visible. This name is included in the
export. Imports display this non-intuitive name in the Import dialog box.

Figure: Binding Template names in the Import Preview in Import dialog box

149.7.1

Solution
Proceed with the import of the binding templates to the Binding Templates folder.
After the import process is completed, you can rename the object with a more
meaningful name. You can use the Binding Templates view to decide on a
name.
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149 Import and Export Troubleshooting
149.8 Cannot Export BACnet System Objects

149.8

Cannot Export BACnet System Objects
Some objects that you select for export may not be exportable because they are
used internally by Building Operation. For example, you cannot export an
Application folder, which is a system object. However, you can export multiple usercreated objects that are located within an Application folder.

149.8.1

Solution
Export user-created objects that are located in the Application folder and then
import these objects to an Application folder on another Building Operation server.
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149 Import and Export Troubleshooting
149.9 Cannot Import BACnet Notification References

149.9

Cannot Import BACnet Notification
References
The BACnet Notification may include a reference to a BACnet Interface or device.
During an import, a BACnet Notification reference may not be valid. If this happens,
the import continues with a warning message, but the reference will not be created.

149.9.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• To avoid losing references to a BACnet Interface or device during an import,
make sure that the Building Operation name for the BACnet Interface or device
is the same on both the source and targeted servers prior to the import. Use
the Rename command on the Edit menu to change the name, if necessary.

• To avoid losing references to a BACnet Workstation in a BACnet Notification
during an import, complete the following tasks prior to the import:
– Use the Rename command on the Edit menu to change the name of the
BACnet Workstation, if indicated.
– Host the BACnet Workstation on the targeted server. For more
information, see section 75.3 “Discovering a BACnet Device” on page
2607.
• To reassign lost references to a BACnet Interface in a BACnet Notification after
an import, follow these steps:
– Open the BACnet Notification on the targeted server by clicking the Edit
Device Recipient Rule button.
– In the Recipient device object reference box, enter the correct
BACnet Interface or device for the BACnet Notification on the targeted
server. For more information, see section 81.107 “BACnet Notification –
Device Recipient Rule Dialog Box” on page 3155.
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149 Import and Export Troubleshooting
149.9 Cannot Import BACnet Notification References
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149 Import and Export Troubleshooting
149.10 Cannot Preserve Trend Object Bindings During Import

149.10

Cannot Preserve Trend Object Bindings
During Import
To preserve bindings during an import, you include all objects for a Trend solution in
the same export file, or create or import trend objects in a particular order.

149.10.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Include all trend objects within the same export or import process.
• Create or import all trend objects in this order:
– Trend logs
– Internal or external Trend logs in field devices
– Extended trend logs
– Trend viewers
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149 Import and Export Troubleshooting
149.11 Supporting Objects Already Exist

149.11

Supporting Objects Already Exist
Supporting objects that already exist in the server are not imported. The objects
that are not imported are listed in the warning(s) tab in the Import dialog box. By
clicking Import, you can still import all other objects except for the ones listed in the
warning(s) tab.

Figure: Supporting objects already exist.

149.11.1

Solution
If you want the already existing supporting objects to be part of the import, click
Cancel. Then you rename or delete the supporting objects on the server from where
you export or on the server to which you import. Then import the solution again.
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149 Import and Export Troubleshooting
149.12 Cannot Import Supporting Objects for Alarms

149.12

Cannot Import Supporting Objects for
Alarms
In a multi-server configuration, you cannot import supporting objects for Alarms that
were exported from a standalone Building Operation server to any lower tier
Automation Server. For example, you cannot export checklists and cause notes
that were created on a standalone Enterprise Server to a lower tier Automation
Server that was created under a top level server.

149.12.1

Solution
Recreate the supporting objects on the top server. After creation, they are
automatically copied to the connected tier level servers. For more information, see
the Alarm Objects in Multiple Servers topic on WebHelp.
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149 Import and Export Troubleshooting
149.13 Cannot Export User Management System Objects

149.13

Cannot Export User Management
System Objects
You cannot export any system objects that are used internally by Building
Operation. For example, the Local domain is a system object designed primarily for
local server log-on activities.
In addition, there are several system objects within the Local folder that cannot be
exported:
• Groups folder. This system folder contains the default Administrators and
Reports Administrators user account groups, which are used internally by
Building Operation. Therefore, you cannot export these groups. However, you
can create your own user account groups and export them within their own
domain.
• Users folder. This system folder contains the default admin and
SystemReportsService user accounts, which are used internally by Building
Operation. For example, Building Operation uses the admin account to grant
users direct access to Automation Servers from the Device Administrator. If
you create admin accounts in other domains, the admin privileges may differ
significantly.
• Workspaces folder. This system folder contains the predefined Administration,
Engineering, and System default workspaces created for the Local domain that
cannot be exported. However, you can create your own workspaces in the
Local domain that can be exported.

149.13.1

Solution
In the Domains folder, follow these steps:
• Create a domain, for example, the ACME domain.
• Add user-created user accounts, user account groups, and workspaces to this
domain.
• Export the entire ACME domain.
• Import the entire ACME domain to the Domains folder of the targeted location.
If you create your own objects and folders within a system folder, you can export
them separately to the the corresponding system folder on the targeted server, for
example, System – Domains. For more information, see section 149.1 “Nonexportable Objects” on page 5503.
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149 Import and Export Troubleshooting
149.14 Cannot Import LonWorks Solution

149.14

Cannot Import LonWorks Solution
When the solution is imported to the same server as it was exported from, the
import may fail if the solution includes bindings to and from devices outside the
exported solution, where StruxureWare detects an unintentional binding conflict.

149.14.1

Solution
Make sure all bound objects are included when exporting a LonWorks solution, or
simply select library mode when exporting to identify and resolve binding conflicts.
For more information, see section 18.24 “Export Library Mode” on page 589.
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150

I/O Troubleshooting

Topics
I/O Module Incorrectly Configured
Input Point Not Functioning Correctly
Output Point Not Functioning Correctly
Device Address Changed
Blacklisted Device Detected
High CPU Usage and Slow System Response Time

150 I/O Troubleshooting
150.1 I/O Module Incorrectly Configured

150.1

I/O Module Incorrectly Configured
The I/O module status LED is not a solid green and the module status in the
Properties pane is not Configured. The I/O module is offline, in Low power, or
Bootloader modes, is Out of tolerance (24V out of tolerance), or contains an error.
Also, the module ID is not set correctly, a module mismatch exists, or the I/O point
does not exist on a channel other than Null.

150.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through the solution until the problem is resolved.
• Ensure that the I/O module is online by verifying that the Comm status
property is set to Online.
Check also that the I/O module is securely connected to the Automation Server
and that the module ID is set to the position occupied by the I/O module.
For more information, see section 20.9 “Moving an I/O Module” on page 627.
• Ensure that the type of physical I/O module matches the type of module
assigned to it (that is, the module in the I/O Bus folder with the same module
ID).
When the I/O module type does not match the type created in the database,
the Module type mismatch property is True.
For more information, see section 20.20 “Correcting a Module Type Mismatch”
on page 646.
• Ensure that the Comm status of the unconfigured I/O module is set to
Online and that the Module type mismatch is False. If so, confirm that at
least one point in the module is assigned a channel other than 0.
Right-click the I/O module, select the I/O wiring list, and verify that at least one
point is assigned a channel.
• Ensure that the Module status is not set to Low power. If the status is Low
power, recover the I/O module.
For more information, see section 20.18 “Setting and Recovering an I/O
Module from Low Power” on page 642.
• Ensure that the Module status is not set to Bootloader. If the status is
Bootloader, update the module firmware to the current version.
For more information, see section 20.8 “Updating I/O Module Firmware” on
page 625.
• Ensure that the Module status is not set to 24v out of Tolerance.
If the status is 24v out of Tolerance, the power supplied to the I/O module
may have dropped below ~19 VDC.
• Ensure that the Module status is not set to Unreliable. If the status is
Unreliable, the I/O module has detected an error.
For more information, see section 21.17 “Reviewing the Reliability of I/O Point
Values” on page 693.
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150 I/O Troubleshooting
150.2 Input Point Not Functioning Correctly

150.2

Input Point Not Functioning Correctly
The parent I/O module is Configured and online. However, the input point is not
functioning correctly. The module status is Unconfigured, the input point is offline,
unreliable, forced, or configured incorrectly (for example, wrong point type, wrong
channel, incorrect units, scaling, or threshold). Also, the input channel is miswired,
or the I/O module is defective.

Note
• When the input point is not functioning correctly, the problem is usually that
the value is not in the expected range or does not update properly.

150.2.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the Comm status of the input point is set to Online and that the
parent I/O module is Configured and Online.
Check also that the I/O module is securely connected to the Automation Server
and that the module ID is set to the position occupied by the I/O module.
For more information, see section 20.9 “Moving an I/O Module” on page 627.
• Ensure that the point’s Reliability is set to Reliable.
Check the wiring of the input point and verify that the Lower and Upper
reliability level are set correctly if the Value is over range or under range. Ensure
also that the Module status of the parent I/O module is configured correctly.
For more information, see section 21.17 “Reviewing the Reliability of I/O Point
Values” on page 693.
• Ensure that the input point is not forced.
When a point is forced, the Force property is True and the Forced button is
highlighted.
Ensure that the value of an I/O point is configured correctly if the value does not
change.
Verify also that point type, Channel number, scaling parameters, Units, and
Threshold are set correctly. The point’s value does not change until the input
delta exceeds the Threshold.
• Verify that the input is wired correctly.
• Test the I/O module hardware by applying the appropriate stimulus to the input
and verifying that the point’s value is correct.
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150 I/O Troubleshooting
150.3 Output Point Not Functioning Correctly

150.3

Output Point Not Functioning Correctly
The parent I/O module is Configured and online. However, the output point is not
functioning correctly. The module status is Unconfigured, the output point is
offline, unreliable, forced or manually overridden, or configured incorrectly (for
example, wrong point type, wrong channel, incorrect units, scaling, threshold, or
bindings). Also, the output channel is miswired, or the I/O module is defective.

Note
• When the output point is not functioning correctly, the problem is usually that
the value is not being set, the physical output value does not change, or the
value does not change with the requested value.

150.3.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the Comm status of the output point is set to Online and that
the parent I/O module is Configured and Online.
Check also that the I/O module is securely connected to the Automation Server
and that the module ID is set to the position occupied by the I/O module.
For more information, see section 20.9 “Moving an I/O Module” on page 627.
• Ensure that the point’s Reliability is set to Reliable.
Verify also that the Module status property of the parent I/O module is
configured correctly.
For more information, see section 21.17 “Reviewing the Reliability of I/O Point
Values” on page 693.
• Ensure that the value changes with the Requested value. If the value does not
change, verify that the point is not being forced or overridden.
When a point is manually overridden, the Override state property is True.
When a point is forced, the Force property is True and the Forced button is
highlighted.
For more information, see section 21.19 “Forcing Input Values” on page 696.
• Ensure that the value of an I/O point is configured correctly if the value does not
change.
Verify also that point type, Channel number, scaling parameters, Units, and
Threshold are set correctly. The point’s value does not change until the input
delta exceeds the Threshold.
• Verify that the output is wired correctly.
• Test the I/O module hardware by connecting a Digital Multimeter to the output
if I/O module contains the manual override (-H) option. Manually override the
different output values and verify that the Digital Multimeter displays the
overridden values.
Test the hardware by forcing the output to different values and verifying that the
Digital Multimeter displays the forced values.
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150 I/O Troubleshooting
150.4 Device Address Changed

150.4

Device Address Changed
The backplane address changes on an online, physical I/O module, most likely due
to a terminal base hardware failure. The I/O module then sends an error to the
Automation Server which produces an updated module status and a system alarm
for each physical I/O module reporting the address change. The Automation Server
also remembers which serial numbers reported a device address change and
compiles a "blacklist" of these modules.

150.4.1

Solution
In this state, the Automation Server is still communicating with the I/O module, so
control and configuration of the device will continue uninterrupted until either the
Automation Server or I/O module is power-cycled. This error indicates a serious
problem that you need to resolve by replacing the terminal base and using the
acknowledge command in the I/O Module Management Tool.
For more information, see section 20.26 “Resolving I/O Module Device Address
Changed and Blacklisted Device Detection Errors” on page 657.
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150 I/O Troubleshooting
150.5 Blacklisted Device Detected

150.5

Blacklisted Device Detected
A physical I/O module is rediscovered on the I/O bus with a serial number
corresponding to an I/O module on the Automation Server's blacklist. The physical
device is rediscovered because the physical module is disconnected and then
reconnected, or the Automation Server is restarted or power-cycled. When this
rediscovery occurs, the software module's status is set to Blacklisted device
detected and a system alarm is reported for the software module.

150.5.1

Solution
When a Blacklisted device detected error is reported, the Automation Server
no longer communicates with the I/O module. You must resolve this problem as
follows:
• Open the I/O module management tool
• Find the I/O module with the lowest address whose serial number is blacklisted
• Replace the lowest slot ID terminal base reporting the error as well as the
terminal base preceding this slot ID
• Use the acknowledge command to remove the blacklisted device detected
state
For more information, see section 20.26 “Resolving I/O Module Device Address
Changed and Blacklisted Device Detection Errors” on page 657.
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150 I/O Troubleshooting
150.6 High CPU Usage and Slow System Response Time

150.6

High CPU Usage and Slow System
Response Time
When I/O modules report the Value property with its highest resolution, the system
processes every single fluctuation every time the Value changes. With a large
number of inputs and outputs, the Automation Server may need a significant
amount of CPU bandwidth to process them. As a result, you may observe high
system CPU usage and slow system response time.

150.6.1

Solutions
Improve system performance by setting the threshold to a higher value that is still
acceptable for your application. For more information, see section 21.27 “Threshold
Settings for I/O Points” on page 712.
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Topics
Units Categories Mismatch when Saving a Graphic

151 Graphics Troubleshooting
151.1 Units Categories Mismatch when Saving a Graphic

151.1

Units Categories Mismatch when Saving
a Graphic
This error occurs if you have bound an improperly configured alarm to a graphic, in
this case, a mismatching unit.

Note
• The error occurs even when you use bindning view.
For example, you have created an alarm and bound its monitored variable in unit
Celsius that belong to the Temperature category. In Graphics Editor, you have
created a graphic, added text to the graphic, and added a binding. In WorkStation
you have edited the binding of the graphic, bound the alarm state to the graphic
binding and saved the graphic. You have then changed the variable unit, for
example, to ohms.
The result is that the alarm is disabled and sends an alarm text saying "Disabled
Cause" = system. A system alarm is created and tells you that the alarm unit is
wrong.
It is not possible to save the graphic in Graphics Editor or remove the binding
between the text and the alarm state if you have:
• bound the graphic containing a certain unit to a variable of a different unit
category
• changed the original variable unit category to one that does not match the unit
of the graphic

151.1.1

Solution
Locate the monitored variable and change its unit to any unit in the alarm unit
category. Alternatively,you can changee the alarm unit or remove the binding
between the alarm and the monitored variabl.
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152

Function Block
Troubleshooting

Topics
Function Block Displayed in Red Frame
Unable to Compile or Simulate
Constant Already Defined
Faulty Block Centered and Selected
Illegal Closed Loop Has Been Detected
Redefined Identifier
Undefined Constant
Block Must Have a Name
Public Constant Not Supported in Expression Blocks
Public Constant Used More Than Once
Public Constant Identifier Is in Use Already
Public Constant Not Used
Node Name Too Long
Division by Zero, Numerical Overflow
The maximum number of Alarm blocks is exceeded in the
function block program
Unable to Access the Edit Menu

152 Function Block Troubleshooting
152.1 Function Block Displayed in Red Frame

152.1

Function Block Displayed in Red Frame
The function block is displayed in a red frame in the diagram window. This occurs
when you have placed the block where there is not enough free space.

152.1.1

Solution
Move the block to a free space.
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152 Function Block Troubleshooting
152.2 Unable to Compile or Simulate

152.2

Unable to Compile or Simulate
It is not possible to compile or simulate a function block program. You may have
deleted a constant that is used in the function block diagram.
A warning dialog box is displayed when you try to compile the function block
program, and the block with the missing constant is automatically selected.

152.2.1

Solution
Recreate the constant by editing the block.
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152 Function Block Troubleshooting
152.3 Constant Already Defined

152.3

Constant Already Defined
When you load a macro to a function block program, new constants – public and
non public – are added to the Constants table. Duplicate constants are not added
to the Constants table. The old value is preserved and the message “Constant
already defined” is displayed. One of the blocks where the constant is defined is
centered and selected.

152.3.1

Solution
Create a module of the first instance of the macro you want to use. You can also
locate and rename one of the duplicate constants.
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152.4 Faulty Block Centered and Selected

152.4

Faulty Block Centered and Selected
During FBD compilation, that is, when going from Edit mode to Simulation mode in
Function Block Editor, there is a syntax error check. Any faulty block is selected and
centered.

152.4.1

Solution
Correct the faulty function block or connection.
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152.5 Illegal Closed Loop Has Been Detected

152.5

Illegal Closed Loop Has Been Detected
Error message appears if none of the blocks have an internal status that retains its
value from the previous loop. A selection rectangle is positioned over one of the
blocks in the feedback loop.

152.5.1

Solution
Add at least one block with an internal status that retains its value from the previous
loop.
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152.6 Redefined Identifier

152.6

Redefined Identifier
The error occurs when two blocks, whose output have been defined as a public
signal, have the same identifier.

152.6.1

Solution
Change the name of one of the blocks.
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152.7 Undefined Constant

152.7

Undefined Constant
The error occurs when a constant identifier is used in a function block without
having been defined in the Constants table.

152.7.1

Solution
Add the constant identifier to the Constants table.
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152.8 Block Must Have a Name

152.8

Block Must Have a Name
The error occurs when the output signal of a public function block has not been
given a name (identifier).

152.8.1

Solution
Name the public function block.
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152.9 Public Constant Not Supported in Expression Blocks

152.9

Public Constant Not Supported in
Expression Blocks
Public constants are not permitted in Expression blocks.

152.9.1

Solution
Convert the constant to an input that you connect to a PVB/PVI/PVR block. You
can also use an internal (non-public) constant.
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152.10 Public Constant Used More Than Once

152.10

Public Constant Used More Than Once
The error message is displayed when public constants are used in several function
block parameters at the same time.

152.10.1

Solution
Define different constant names for each function block parameter if they need to
be public, or use an internal (non-public) constant.
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152 Function Block Troubleshooting
152.11 Public Constant Identifier Is in Use Already

152.11

Public Constant Identifier Is in Use
Already
The error message is displayed when a signal identifier exists simultaneously with a
public constant and a public signal.

152.11.1

Solution
Rename the constant or define it as internal (non-public).
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152.12 Public Constant Not Used

152.12

Public Constant Not Used
The error message is displayed when you have defined a public constant and then
not used it as a function block parameter.

152.12.1

Solution
Delete the public constant from the Constant table or define it as internal (nonpublic).
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152.13 Node Name Too Long

152.13

Node Name Too Long
The error message is displayed when the name of the node is too long.

152.13.1

Solution
Rename the node with a shorter string.
The maximum number of characters is 20.
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152.14 Division by Zero, Numerical Overflow

152.14

Division by Zero, Numerical Overflow
Logical function block program error.

152.14.1

Solution
Reconstruct your function block program or change faulty values in the function
blocks.
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152.15 The maximum number of Alarm blocks is exceeded in the function block program

152.15

The maximum number of Alarm blocks
is exceeded in the function block
program
The function block program contains more than 127 Alarm blocks. The problem
must be solved before the function block program can be generated.

152.15.1

Solution
The function block program cannot contain more than 127 Alarm blocks. If it does,
split the function block program into several with no more than 127 Alarm blocks in
each.
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152.16 Unable to Access the Edit Menu

152.16

Unable to Access the Edit Menu
You cannot open the Edit menu in Simulation mode.

152.16.1

Solution
Change from Simulation mode to Edit mode.
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Compiler error contains no error text
Runtime error contains no error number

153 Script Troubleshooting
153.1 Compiler error contains no error text

153.1

Compiler error contains no error text
The compiler error number displayed in the Check pane has no accompanying error
text.

153.1.1

Solution
Use the error number in the compiler error table to find the appropriate error text.
For more information, see section 52.3 “Script Compiler Errors” on page 1859.
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153.2 Runtime error contains no error number

153.2

Runtime error contains no error number
The runtime error displayed in the Check pane has no error number.

153.2.1

Solution
Use the error text in the runtime error table to troubleshoot the problem.
For more information, see section 52.4 “Script Runtime Errors” on page 1862.
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154 LonWorks Troubleshooting
154.1 Packet Errors

154.1

Packet Errors
In the Diagnostics tab of a local node or a device, there is a Packet errors box that
displays the last encountered error in the form of a three digit code.

Solution
Packet error codes are listed in the table below with descriptions.
Table: Packet Errors
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Code

Description

130

nv_length_mismatch

131

nv_msg_too_short

132

eeprom_write_fail

133

bad_address_type

134

preemption_mode_timeout

135

already_preempted

136

sync_nv_update_lost

137

invalid_resp_alloc

138

invalid_domain

139

read_past_end_of_msg

140

write_past_end_of_msg

141

invalid_addr_table_index

142

incomplete_msg

143

nv_update_on_output_nv

144

no_msg_avail

145

illegal_send

146

unknown_PDU

147

invalid_nv_index

148

divide_by_zero

149

invalid_appl_error

150

memory_alloc_failure

151

write_past_end_of_net_buffer

152

appl_cs_error
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Continued
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Code

Description

153

cnfg_cs_error

154

invalid_xcvr_reg_addr

155

xcvr_reg_timeout

156

write_past_end_of_appl_buffer

157

io_ready

158

self_test_failed

159

subnet_router

160

Authentication_mismatch

161

self_inst_semaphore_set

162

read_write_semaphore_set

163

appl_signature_bad

164

router_firmware_version_mismatch
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154.2 LonWorks Device Communication Problems

154.2

LonWorks Device Communication
Problems
Communication problems on the network almost always lead to erratic behavior
and strange results. Hardware errors aside, the problems most often appear when
the subnet/node addresses collide.

154.2.1

Solutions
The solutions are listed in order. The solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check that all cables in the network are firmly connected and not damaged.
• Make sure that all physical devices on the network have been defined as
objects in the System Tree pane and have been correctly commissioned.
• Make sure there are no subnet/node address conflicts. For more information,
see section 59.10 “Detecting Subnet/Node Conflicts” on page 2126.
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154.3 Corrupt LonWorks Bindings

154.3

Corrupt LonWorks Bindings
Bindings in the LonWorks network have become corrupt.

154.3.1

Solution
Rebind the LonWorks network. For more information, see section 59.9 “Rebinding
a LonWorks Network” on page 2125.
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154.4 LonWorks Device Out of Sync

154.4

LonWorks Device Out of Sync
A LonWorks device can be out of sync for the following reasons:
• The device is in Invalid state. (The device status is unknown. It has not been
commissioned or has been decommissioned.)
• Bindings were updated while the device was in DB mode and no Commission
has been done since.
• The domain table was updated while the device was in DB mode and no
Commission has been done since.
• The device configuration (CP values) was updated while the device was in DB
mode.
• An NXE file was downloaded and no upload or download configuration was
done.

154.4.1

Solutions
To get the device in sync, use one of the following solutions:
• For any of the three first reasons above: Commission the device. For more
information, see section 56.6 “Commissioning a LonWorks Device” on page
2014.
• For the last two reasons above: Download Configuration for the device. For
more information, see section 56.8 “Downloading the LonWorks Device
Configuration ” on page 2017., or
Upload Configuration for the device. For more information, see section 56.9
“Uploading the LonWorks Device Configuration ” on page 2018..
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154.5 LonWorks Interface is Offline

154.5

LonWorks Interface is Offline
The LonWorks interface can be offline for the following reasons:
• The NIC Legacy Driver is not running as a service.
• The NIC Legacy Driver is not properly set up.

154.5.1

Solutions
To troubleshoot the offline interface, try the following solutions:
• In the L-Config Tool (LConfig), in the Advanced settings, set the NIC Legacy
Driver to run as a service. For more information and other configuration issues,
visit the LOYTEC website.
• In Windows Services, start the LoytecSrv service. To make sure the service is
always running when you restart the Enterprise Server, select Automatic as
Startup type in the LoytecSrv properties.
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154.6 Configuring of LonWorks Device using LNS Plug-in Fails Due to Missing Device Template

154.6

Configuring of LonWorks Device using
LNS Plug-in Fails Due to Missing Device
Template
You attempt to configure a LonWorks device using an LNS Plug-in but the process
fails to complete due to missing device template.

154.6.1

Solution
Ensure that the device template for the LNS Plug-in is installed in LNS. For more
information, see section 56.30 “Importing a Device Template in LNS” on page
2056.
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155 LonWorks Deep Technical Reference
155.1 LonTalk Addressing Overview

155.1

LonTalk Addressing Overview
The communication principles in Building Operation follow the standards and
recommendation from LonMark International. For details, see the LonMark
International web site.
A LonWorks network is built by connecting one or more channels. A channel is the
physical transport medium to which the devices are connected, for example a
twisted pair cable. In the example below, L1, L2, and L3 could be different channels
on the same network.
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155.1 LonTalk Addressing Overview

Figure: LonTalk Addressing Overview

The channel only provides a way for devices to send and receive data, which is not
enough to configure a network. The device also needs information about its unique
identity and where it belongs in the network. Therefore, the devices are given
unique node addresses and the networks are divided in domains and subnets.
Bindings can then be used to define how information should be transferred
between devices.
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155 LonWorks Deep Technical Reference
155.1 LonTalk Addressing Overview

155.1.1

Domain, Subnet and Node
The LonTalk protocol uses a hierarchic address structure with domain, subnet and
node (DSN) addresses. In this way you can address a specific node, all nodes in a
subnet, or an entire domain.

Domain
A domain is a logical collection of nodes on one or more channels. In Building
Operation, a domain is typically the same as a network.
Normally, LON Communication can only take place between devices in the same
domain, but in Building Operation communication between domains, or networks,
can be done. In Building Operation, a binding between domains is handled by an
Building Operation server, which controls the communication between the
domains.

Subnet
A subnet is a logical collection of up to 127 nodes within a domain. Up to 255
subnets can exist within one domain. The subnet is given an unique id within the
domain.

Node
A node is an external device or a local node connected to a network. Every node
within a subnet is given an unique node id within the subnet.

155.1.2

LonWorks D/S/N Addressing
The Domain ID for all Building Operation LonWorks objects are set to 18 (0x12).
A LonWorks network or a LonWorks network folder can contain one or more
subnet IDs.
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155.1 LonTalk Addressing Overview

Figure: LonWorks D/S/N addressing

LonWorks networks, network folders and devices are addressed as follows:
• A LonWorks network always contains subnet 254.
• The server and the optional local node has subnet/node 254/1.
• LonWorks devices in a LonWorks network is assigned subnet 254 and the next
free node ID within the subnet until all node IDs on the subnet are used.
• When the first LonWorks device is created in a LonWorks network folder, a
new subnet ID is assigned for the folder. All devices in that folder are assigned
the same subnet and the next free node ID within the subnet until all node IDs
on the subnet are used.
• When all node IDs on the subnet on a LonWorks network or a LonWorks
network folder are used and a new device is created, a new subnet ID is
assigned and used for the device.
• If all devices on a subnet are deleted, the subnet ID is released.
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155.1 LonTalk Addressing Overview

155.1.3

LonWorks Domains in Building Operation
In Building Operation, all nodes are given a DSN address that are stored in their
domain tables.
When a LonWorks network is created, it is automatically assigned two domains that
are stored in its domain table: Domain_0 and Domain_1.

Figure: Domain table in a LonWorks Network

Domain_0 is used to store the ID of the network’s domain. Domain_1 is a zero-bit
domain and is used when scanning networks objects on other domains, for
example when discovering network objects or listening to service pins.
When a device or local node is created, it is automatically assigned two DSN
addresses in its domain table.

Figure: Domain tables in a LonWorks Device or local node

One row stores the device´s DSN address that is created from it´s network’s domain
id and subnet id followed by a node id. The other (Id 0) is for the zero-bit domain,
used when listening to queries from other domains, or when sending service pin.

155.1.4

Addressing over ECS
The ECS is an extension to the Lon standard EIA 709. ECS contains various
commands to extend the features of the LonTalk protocol, like using extended
address tables.
Building Operation supports the use of ECS on devices that has this feature
enabled. The local nodes on the Automation Server and the Enterprise Server can
also use ECS.
Building Operation supports the following functions over ECS:
• Update domain
• Leave domain
• Update address
• Update NV selector table
• Update NV alias table
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155.2 Customized DRF kit in Externally Managed LonWorks Network

155.2

Customized DRF kit in Externally
Managed LonWorks Network
Customized DRF kits can be used in externally managed LonWorks networks when
any not defined LonWorks device functional profile needs to be interpreted for use
in an LNS controlled network, in order to make it possible to create Building
Operation bindings to the network variables. The third party functional profile is
translated with the customized DRF kit into structured network variables - UNVT,
such as a string ascii network variable with 31 bytes is translated to a UNVT with
representations of set value variables.
This feature makes it possible to interpret any NV to a UNVT without any use of
another decoder. As an example, a string_ascii NV converted to an UNVT below.

Figure: Example str_ascii converted to UNVT

It is necessary to import the customized DRF kits before creating the variable types
on the local node. For more information, see section 56.13 “Importing a Device
Template” on page 2024.
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155.3 Configuration Property Flags

155.3

Configuration Property Flags
Each configuration property on a device can specify optional flags that are used to
notify a network tool of if and when a configuration property can be modified. These
flags are optional and normally received from the device template when creating the
device. If a configuration property is declared without any flags, a network tool can
assume that the configuration property can be modified at any time.
The configuration property flags can be viewed in the properties for a Configuration
Property. For more information, see section 60.25 “Configuration Parameters and
Network Variable Properties – Basic Tab” on page 2170.
Table: Configuration Property Flags
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Flag

Description

Is constant

Specifies a configuration property that can
never be changed by a network tool. If the
device-specific flag is not set, also specifies
a CP that can never be changed by the
device application; if the device-specific flag
is set, the device application can change the
constant CP. Also specifies that the CP is
implemented in a read-only value file for CPs
implemented within configuration files on
devices that contain both a writable value file
and a read-only value file. However, network
tools can write such configuration properties
when they reside in a value file - on a device
that does not implement a read-only value
file - as long as the value is not changed. A
network tool can do this as part of an update
to another CP adjacent to the constant
value. CPs with the Constant flag but without
the Device-Specific flag can be assumed to
have the same value on all devices using the
same standard program ID.

Technical
5575

155 LonWorks Deep Technical Reference
155.3 Configuration Property Flags

Continued
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Flag

Description

Is device specific

Specifies a configuration property that must
always be read from the device—if
available—instead of relying upon the value
in the device interface file or a value stored in
a network database. A device-specific CP
can be set by the device implementing the
CP, by another device, or by a passive
configuration tool. Network management
tools must never change a device-specific
CP value except as a side effect of a new
program download, device
recommissioning, or device replacement. A
device-specific CP can be used for a CP that
must be exclusively managed by the device,
another device, and/or a passive
configuration tool, such as a setpoint that is
updated by a local operator interface on the
device, or a minor version number that varies
from device to device. A device-specific
passive configuration tool, or a user of a
generic passive configuration tool, can
determine that a CP is device-specific even
though it is not documented as such in the
device interface. A network Device Interfaces
management tool can include an interface to
communicate such a determination to the
network management tool—however, this is
not required. If this determination is not
communicated to a network management
tool, it is likely that the network management
tool overwrites a device-specific CP with a
stale value when a device is recommissioned
or replaced.

Modify only during manufacturing

Specifies a factory setting that can be read
or written when the device is manufactured,
but is not normally (or ever) modified in the
field. In this way, a standard installation tool
can be used during manufacture to calibrate
a device, while a field installation tool would
observe the flag in the field and prevent
modification of the value, or optionally
require a password to modify the value.
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Flag

Description

Is object disabled

Specifies that a network tool must disable
the functional block containing the
configuration property, take the device
offline, or ensure that the functional block is
already disabled or the device is already
offline, before modifying the configuration
property. This flag or the Device-Offline flag
is recommended for a configuration property
implemented within a configuration file with
direct memory read/write access if the
application requires update notification or if
the application cannot tolerate updates from
the network at the same time the application
is reading the configuration property. A
network tool can select not to disable a
functional block before modifying a
configuration property with the FB-Disabled
flag if that device is already offline and can
be updated while offline. This is allowed
because an offline device has all its
functional blocks implicitly disabled, and
because a functional block cannot be
directly disabled when the device is already
offline.

Is offline at change

Specifies that a network tool must take this
device offline, or ensure the device is already
offline, before modifying the configuration
property. This flag or the FB-Disabled flag is
recommended for a configuration property
implemented within a configuration file with
direct memory read/write access if the
application requires update notification or if
the application cannot tolerate updates from
the network at the same time the application
is reading the configuration property. This
flag should not be used for configuration
properties implemented within configuration
files that are accessed with FTP, and
network tools should ignore this flag for such
configuration properties. This is because a
device cannot transfer configuration property
values with FTP while offline. In fact, an
offline application must be placed into the
online state for the duration of any FTP
configuration property operations.

Is resetting after change

Specifies that a network tool must reset the
device after changing the value of the
configuration property. If multiple
modifications of configuration properties are
being made at the same time, then one reset
can be completed instead of having to reset
the device the same number of times as
Reset-flagged configuration properties were
modified.
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156 Xenta LonWorks Device Troubleshooting
156.1 Xenta Device Out of Sync

156.1

Xenta Device Out of Sync
A Xenta 280/300/401 LonWorks device can indicate it is out of sync, for any of the
reasons listed below. For more information, see section 67.1 “Xenta Icons” on page
2331.
Often, Device Configuration parameters are involved. In the text below, they are
referred to as set A and set B. For more information, see section 64.3 “Device
Configuration Parameters” on page 2281.
1. The Xenta device is in the Invalid state.
2. An NV has been added/removed.
3. The Xenta device SNVT bindings were updated while it was in database mode.
4. The Xenta device domain table was updated while it was in database mode.
5. The Xenta device image was updated but no NV has been added/removed.
6. DST settings update failed. For more information, see the Time and Time Zone
Configuration in Automation Server topic on WebHelp.
7. A parameter (of set A) was updated while the device was in database mode, or
offline.
8. A Public Output Value parameter (of set B) was updated while the device was in
database mode, or offline.
9. The automatic device update of SNVT bindings (item 3), or the domain table (item
4) has failed, even if the device was online.
10. The Xenta schedules are updated but not synchronized with the device.

156.1.1

Solution
In the Property Grid for the device, on the Basic tab, check the three Status
boxes for the need of:
• Commissioning
• Device configuration download
• Application download
• Schedule download
Depending on the case, perform one of the following commands to get the Xenta
device into sync:
• Commission.
• Commission with Download Application.
• Commission (with optional Download Application), Download Device
Configuration, or Upload Device Configuration.
• Download Device Configuration, or Upload Device Configuration.
These conditions imply the following rules for Xenta groups:
• When you add a Xenta group member to a Xenta group, or rename the
member, all members in the Xenta group will be out of sync.
• When you remove a Xenta group member from a group, all members in the
Xenta group will be out of sync.
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156.1 Xenta Device Out of Sync

• When you update one Xenta group member (the Menta application is updated)
only that Xenta group member will be out of sync.
• When you add or delete a Xenta group, all other Xenta devices on the same
LonWorks network will be out of sync.
• When you rename a Xenta group master, all Xenta devices in that group will be
out of sync.
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156.2 Xenta I/O Device Communication Problems

156.2

Xenta I/O Device Communication
Problems
If no values appear on the physical input/output of a Xenta I/O device, it can seem
like a general communication problem. The reason, however, may be that the I/O
device has not been identified with a service pin operation.

156.2.1

Solution
Check the Neuron ID of the I/O device and commission the device if necessary.

To check the Neuron ID of a Xenta I/O device
1. In the System Tree pane, locate the IO folder belonging to the Xenta device.
2. In the List View, click on the specific I/O device.
3. On the Basic tab, in the Device information area, check that the Neuron
ID box shows a valid ID.
If the Neuron ID is 000000000000, the device needs to be commissioned. For more
information, see section 62.9 “Identifying a Xenta I/O Module” on page
2240.Commissioning a Xenta I/O Module
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156.3 Xenta Trend Log Problems

156.3

Xenta Trend Log Problems
If the Xenta trend logs do not work properly, one reason can be that correct time
values have not been set in the live server, before the application was downloaded.

156.3.1

Solution
If correct time values have not been set, the trend log configuration has to be reset.

To reset a faulty trend log
1. Set the correct local time and time zone in the live server.
2. Set the correct DST.
3. Design a dummy application with an empty trend log configuration.
4. Download the dummy application to remove the current trend log
configuration.
5. Download the correct application to re-install the correct trend log
configuration, based on the correct local time and DST values.
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156.4 Xenta Schedule Synchronization Problems

156.4

Xenta Schedule Synchronization
Problems
You are experiencing synchronization problems or receive a system alarm after
editing a Xenta 280/300/401 LonWorks device schedule referenced to one or
several Xenta Central schedules.
A Xenta 280/300/401 LonWorks device schedule can be out of sync with a
referenced Xenta Central schedule for any of the reasons listed below:
• A Xenta 280/300/401 LonWorks device upload. The Xenta 280/300/401
LonWorks device schedule settings referenced from a Xenta Central schedule
will be overwritten with a Xenta 280/300/401 LonWorks device upload.
• Xenta 280/300/401 LonWorks device schedule event time and day entries
have been edited in Menta Editor.
• Number of allowed entries set to fewer in Menta Editor for the Xenta
280/300/401 LonWorks device schedule than in the assigned Xenta Central
schedule.
• The allowed amount of events set in the Xenta 280/300/401 LonWorks device
have been exceeded in an assigned Xenta Central schedule.

156.4.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Reassign the Xenta Central schedule in the Xenta 280/300/401 LonWorks
device schedule.
For more information, see section 66.15 “Assigning a Xenta Central Schedule”
on page 2322.
• Manually ensure that the Xenta 280/300/401 LonWorks device schedule and
the Xenta Central event time and day entries are synchronized.
For more information, see section 66.6 “Editing a Schedule for a Xenta
LonWorks Device” on page 2302.
For more information, see section 66.11 “Editing a Weekly Event in a Xenta
Schedule” on page 2313.
For more information, see section 66.12 “Editing an Exception Event in a Xenta
Schedule” on page 2316.
• Ensure that the amount of events in the Xenta Central Schedule not are
exceeding the set amount allowed in the Xenta 280/300/401 LonWorks device
schedule.
For more information, see section 66.13 “Deleting a Weekly Event from a Xenta
Schedule” on page 2319.
For more information, see section 66.14 “Deleting an Exception Event from a
Xenta Schedule” on page 2320.
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156.5 Error in Retrieving Xenta LonWorks Device Trend Log Data

156.5

Error in Retrieving Xenta LonWorks
Device Trend Log Data
You are experiencing problems retrieving trend log data from a Xenta 280/300/401
LonWorks device and receive a system alarm. When Building Operation reads a
trend log from a Xenta device, the Xenta device sometimes gets into an error state
and never stops sending data to Building Operation.

156.5.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Decommission and disconnect the physical Xenta 280/300/401 LonWorks
device from the Automation Server. Use a modular jack to reset the Xenta
280/300/401 LonWorks device. TAC Xenta 280/300/401 Product Manual.
Commission the device again.
For more information, see section 56.7 “Decommissioning a LonWorks Device”
on page 2016.
For more information, see section 56.3 “Configuring a LonWorks Device ” on
page 2009.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
• Decommission and disconnect the physical Xenta 280/300/401 LonWorks
device from the Automation Server and replace it with a new Xenta
280/300/401 LonWorks device.
For more information, see section 59.3 “Replacing an Online LonWorks
Device” on page 2115.
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157.1 Xenta Progress Error Texts

157.1

Xenta Progress Error Texts
If something goes wrong when you download and/or commission a Xenta device,
Building Operation issues an error message. The error texts are listed below with
some additional explanation.

157.1.1

157.1.2

157.1.3

Commission Errors
Text

Explanation

Invalid program id

Unexpected program id. You may have
selected the wrong device.

No LonWorks stack

Incorrect driver, or no contact with physical
Lon port.

Commission failed

Communication error or unexpected data
received.

Device Type Errors
Text

Explanation

Wrong device type

The MTA file says one type, for example
Xenta 401, but is downloaded to another, for
example Xenta 401:C.

Wrong device version

The system software version in the Xenta
device is too low for the requested operation
(normally Commission and download).

MTA Parsing Errors
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Text

Explanation

Object create error

The MTA file may be corrupt or have too
many objects. There may also be a hardware
error.

Allocate flash error

The MTA file may be corrupt or have too
many objects. There may also be a hardware
error.

IO module save error

The selected Device Type name does not
correspond with the physical device.

Version error

The system software version in the Xenta
device is too low for the requested operation
(normally Commission and download).
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Text

Explanation

Application name error

The MTA file may be corrupt or have too
many objects. There may also be a hardware
error.

Abbreviation error

The MTA file may be corrupt or have too
many objects. There may also be a hardware
error.

Type error

An error in the selection of the used "device
type name".

Source file error

An error in the source file name of the
application.

Signal error

A Public Signal has an incorrect definition.

Alarm text error

An error in the Alarm Text section.

Time schedule error

An error in the received Time Schedule
definitions.

IO module error

An error in the declaration of used IO
modules definitions.

Cycle time error

An error in the received Cycle Time
definition.

Code error

An error in the main code section (the
"yellow block" section) in the received MTA
image.

Daylight saving timeerror

An error in the DST (Daylight saving time)
definition in the received MTA image.

Checksum error

A Checksum error in the main checksum in
the received MTA image.

End of file error

An error found in the OP-panel section in the
received MTA image.

SNVT error

Errors found in the SNVT declaration section
in the received MTA image.

SNVT CRC error

Checksum error in the SNVT-section in the
received MTA image.

Author error

An error found in the "author" section in the
received MTA image.

Blueprint error

An error found in the Network Image (the
"BluePrint file").

No blueprint file

The Network Image (the "BluePrint file") is
not included in the downloaded image.

Trend log out of ram

Out of RAM memory. Trend log definitions
too large.
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Text

Explanation

Trend log out of flash

Out of flash memory. The MTA file is too
large.

Trend log too many

Too many TrendLog definitions in the Image
file.

Trend log error in definition

Some error in the Trend log definition.

Trend log parse error

Error in the TrendLog data image.

Image too big

The image (mainly the MTA file) is too large.
Reduce the application.

Reset before parsed

The device performed a physical reset during
parsing. A new attempt is made.

Self destruct performed

The "reset-dongle" was manually used to
erase the application from the device.

Memory allocation error

Memory space not enough for intended
disposition.

Device name not network unique

New device has the same name as an
existing device. Change name.
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157.2

Xenta SNVT Support
In Building Operation for Xenta devices, there is support for the SNVTs listed below.
You create the SNVTs in a Xenta device, inside Menta in Xenta 280/300/400 Menta
mode. If you try to create a SNVT in Menta that is not supported you will get a
warning.
1. alarm
2. alarm_2
3. amp
4. amp_f
5. amp_mil
6. angle
7. angle_deg
8. angle_vel
9. btu_f
10. char_ascii
11. chlr_status
12. config_src
13. count
14. count_32
15. count_f
16. count_inc
17. count_inc_f
18. currency
19. date_day
20. dev_c_mode
21. dev_fault
22. dev_maint
23. dev_status
24. elapsed_tm
25. elec_kwh
26. elec_kwh_l
27. elec_whr_f
28. ent_opmode
29. ent_state
30. enthalpy
31. fire_test
32. flow
33. flow_f
34. flow_mil
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35. flow_p
36. freq_f
37. freq_hz
38. freq_kilohz
39. hvac_emerg
40. hvac_mode
41. hvac_override
42. hvac_status
43. length_mil
44. lev_disc
45. lev_cont
46. lev_cont_f
47. lev_percent
48. lux
49. magcard
50. mass_f
51. motor_state
52. muldiv
53. multiplier
54. object_request
55. object_status
56. occupancy
57. press
58. power
59. power_f
60. power_kilo
61. ppm
62. ppm_f
63. preset
64. press_f
65. press_p
66. pwr_fact
67. pwr_fact_f
68. reg_val
69. reg_val_ts
70. res_f
71. rpm
72. sblnd_state
73. scene
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74. scene_cfg
75. setting
76. state
77. state_64
78. speed
79. speed_f
80. str_asc
81. str_int
82. switch
83. temp
84. temp_f
85. temp_p
86. temp_setpt
87. time_f
88. time_hour
89. time_min
90. time_sec
91. time_stamp
92. tod_event
93. vol
94. vol_f
95. vol_kilo
96. volt
97. volt_f
98. zerospan
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157.3

Xenta Trend Log Online Parameters
A number of trend log parameters are editable as online parameters. This can be
done in the Menta Trend Log definition or among the Xenta Trend Log
Configuration Settings.

157.3.1

Editable Online Parameters
• Logged signal* ****: The logged point. The point must be a public signal in the
current application.
• Log interval****: The required time between loggings.
• Log space****: Log space in the Xenta.
• Circular Log ****: True** or False (Non-circular).
• Activate: The way to activate the logging. The options are Manual - Off, Manual
- On, and Automatic.
• Start time: The chosen date and time for starting the log. Start time applies to
both of the cases Activate = Manual - On and Activate = Auomatic.
• Start variable***: Public variable in the current application, used to control an
automatically activated logging.
• No stop if logically activated****: True or False. Select True to inhibit the
stopping of a log activated by a logical variable when the variable is no longer
true. The logging continues until stopped manually, or the log is full when the
non-circular log option is selected.
• Clear log at start: True or False. Select True to clear the trend log when it is
activated.
*You can browse for this signal. Public signals in the Xenta device in which the trend
log resides are permitted as Logged signals. The signal unit is displayed in the
Trend log definition dialog in Menta.
**The number of records in a circular log is at least "Log space" divided by "Log
interval".
***You can browse for this signal. Public signals in the Xenta device in which the
trend log resides are permitted as Start variables.
****If you change this parameter you will erase the trend log. Building Operation
issues a warning before it allows the parameter to be changed.
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158.1 BinaryInPls Object’s Pulse Rate Forced Value Changes to 0 (zero)

158.1

BinaryInPls Object’s Pulse Rate Forced
Value Changes to 0 (zero)
In the BinaryInPls I/O point, you forced a value for Pulse rate in the Basic tab, but
now this value has changed to 0 (zero).
This can occur whenever the Pulse rate forced value is overridden by either of the
following two conditions, both of which take precedence:
• The Reset outputs value was changed from Off to On.
• The BinaryInPls object was reset by the logic in the MNL device’s application.

158.1.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that Reset outputs on the Advanced tab is Off.
• Use WorkPlace Tech Monitor to determine why the MNL device's application
reset the BinaryInPls I/O point, and then make the appropriate corrections.
For more information, see section 70.15 “WorkPlace Tech Monitor” on page
2415.
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158.2 MNL-800 Sensor Object's Temperature Forced Value Reverts to 32768

158.2

MNL-800 Sensor Object's Temperature
Forced Value Reverts to 32768
You assign and then download to an MNL-800 LonWorks device an application in
which an S–Link sensor has been defined. In the Sensor object, you force a new
value for Temperature in the Basic tab but then you observe that the value
reverts to 32768.
This can occur when an S-Link sensor has not been connected to the MNL-800
device since the MNL-800 was last reset.

158.2.1

Solution
After downloading an application to an MNL-800 device, ensure that you can force
a temperature value to the Sensor object by connecting an S-Link sensor to the
MNL-800 for a length of time sufficient for the device to recognize the sensor. Once
that is accomplished, you can either leave the sensor connected or disconnect it
from the device. If you disconnect the S-Link sensor, the problem will recur if the
MNL-800 device is reset again.
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158.3 Delayed Update of Override Status Icon

158.3

Delayed Update of Override Status Icon
You set or clear the override of a point property but the force button does not
update from Force value to Forced, or Forced to Force value, within the
normal timespan.
This problem can result from either of two causes:
• The override was set or cleared using TAC I/A Series Pocket I/A.
For more information, see section 71.10 “Forceable MNL I/O Point Properties”
on page 2436.
• The MNL device was reset by a power interruption or some other cause.

158.3.1

Solution
Allow approximately one minute for the override status to finish updating. If the
status does not update, close and then reopen the properties view to refresh the
display.
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158.4 Forced Output Value of Input Object Reverts to Previous Value

158.4

Forced Output Value of Input Object
Reverts to Previous Value
You select an input I/O point, then in the Basic tab you enter a new value for the
Value property, and then force the value. Viewing the application in WorkPlace
Tech Monitor, you connect a monitor tag to the input object’s Value property, and
then see that it updates immediately. However, you also see that the Value
property in WorkStation has reverted to the previous value.
For more information, see section 71.10 “Forceable MNL I/O Point Properties” on
page 2436.
This problem can occasionally occur with the properties displayed for input I/O
points, in WorkStation, while the forced value updates normally at the object in the
WorkPlace Tech application, as well as in the Watch pane in WorkStation.

158.4.1

Solution
Close and then reopen the I/O point's Basic tab to refresh the display and view the
current, forced value.
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158.5 ASCII Character SNVT Displays Value of ÿ in Place of NA Value

158.5

ASCII Character SNVT Displays Value of
ÿ in Place of NA Value
An application for an MNL-800 device contains an NCI, NVI, or NVO object of the
type nci_char_ascii in which the Initial Value property is set to a value of NA. You
assign this application to an MNL-800 LonWorks device and then discover that the
Value property for a SNVT type ASCII character displays a value of ÿ instead of
the expected NA value.
This problem is caused by the way the NA value for this SNVT type is represented in
Building Operation. It is normal function for the Value property of a SNVT type
ASCII character to display a value of ÿ to represent NA.

Figure: Wrong Value Displayed for ASCII Character SNVT

158.5.1

Solution
If you do not need a value of NA for the Value property, open the application in
WorkPlace Tech Editor and then use the nci_char_ascii object's Properties dialog
box to enter a value other than NA for the Initial Value property.
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158.6 Cannot Change Configuration Property Value of MNL I/O Point or S-Link Sensor Point

158.6

Cannot Change Configuration Property
Value of MNL I/O Point or S-Link Sensor
Point
In the Advanced tab of an MNL I/O point or S-Link sensor point, you attempt to
change the value of a configuration property but an error message is displayed,
stating Cannot write to this pointer property, it is controlled by the
device.
For more information, see section 72.2 “Properties of I/O Points, Sensor Object,
and S-Link Sensor Points – Advanced Tab” on page 2466.
This problem occurs when you attempt to change an MNL I/O point or S-Link
sensor point's configuration property that is connected to another object by a
pointer in the WorkPlace Tech application.
You can find information on the use of pointers in WorkPlace Tech applications in
WorkPlace Tech Tool documentation. WorkPlace Tech Tool 4.0 Engineering Guide
(F-27254)

158.6.1

Solution
After closing the error message, click the Cancel button
to revert the change.
Do not attempt to change a configuration property of an MNL I/O point or S-Link
sensor point if, in the WorkPlace Tech application, that property is connected to
another object by a pointer.
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158.7 Cannot Change Limits in Setpoint S-Link Sensor Point

158.7

Cannot Change Limits in Setpoint SLink Sensor Point
In a Setpoint S-Link sensor point, you attempt to change the Maximum limit or
Minimum limit value but then an error message is displayed, stating The set
point limits are invalid.
This problem occurs when a Setpoint object's Enable limit property is set to On
and you attempt to set Maximum limit to a value lower than Minimum limit, or
Minimum limit to a value higher than Maximum limit.
For more information, see section 72.39 “Setpoint Properties – Advanced Tab” on
page 2531.

158.7.1

Solution
On the Advanced tab of a Setpoint S-Link sensor point, ensure that the
Maximum limit is set higher than the Minimum limit, or that the Minimum
limit is set lower than the Maximum limit.
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158.8 Some MNL-800 I/O Point and S-Link Sensor Point Properties Indicate Communication Error

158.8

Some MNL-800 I/O Point and S-Link
Sensor Point Properties Indicate
Communication Error
In an MNL-800 device, you change the Sensor type property on the Advanced
tab of an AnalogInR, AnalogInTC, or AnalogInTF I/O point. Next, you download the
configuration properties to the device and then reset the device. You observe that
some properties of the device's I/O points and S-Link sensor points now indicate a
communication error. This problem can occur when, in the MNL-800 device's
WorkPlace Tech application, the Reset input of a Binary Input object is connected
to a constant.

158.8.1

Solution
In the WorkPlace Tech application of an MNL-800 device, do not connect the Reset
input of a Binary Input object to a constant. If you observe the communication error
described above, check the WorkPlace Tech application and then remove any
constants from the Reset input of Binary Input objects.

To remove a constant from a Binary Input object's Reset input
1. In the Applications view, select the MNL-800 application and then click the
Edit an application button

.

For more information, see section 70.10 “Editing an MNL LonWorks
Application Type” on page 2408.
2. In WorkPlace Tech Editor, remove any constants that are linked to the Reset
inputs of Binary Input objects and then save the application.
3. In WorkStation, download the application to the MNL-800 device.
For more information, see section 70.13 “Downloading an MNL LonWorks
Application Type” on page 2413.
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158.9 Commissioning or Communication Faults Occur After Using Service Pin to Decommission MNL LonWorks Device

158.9

Commissioning or Communication
Faults Occur After Using Service Pin to
Decommission MNL LonWorks Device
A standard MNL LonWorks device or MNL-800 device had been previously
commissioned in Building Operation, and you decommissioned this device by
pressing and holding its service pin for 8 seconds or more. When you later attempt
to recommission this device, one of two problems occurs:
• The commissioning process fails to complete.
• Commissioning appears to be successful but then the MNL device does not
communicate properly. Investigation reveals that the device’s D/S/N address is
not set.
When you decommission an MNL device outside of Building Operation by pressing
its service pin, the device’s domain table is cleared and the device state is set to
Unconfigured. Attempts to recommission this device fail because the device’s
D/S/N address is not set.

158.9.1

Solution
If this problem occurs, decommission and then recommission the MNL device to
restore its D/S/N address.
For more information, see section 56.7 “Decommissioning a LonWorks Device” on
page 2016.
For more information, see section 69.7 “Commissioning an MNL-800 LonWorks
Device” on page 2383.
WorkPlace Tech Editor and Monitor Engineering Guide Supplement (F-27745)

Important
If there is a possibility that the application was downloaded to the MNL device
outside of Building Operation, you must resynchronize the device’s application
with the Building Operation database. To do this, perform a download in
WorkStation.
For more information, see section 70.13 “Downloading an MNL LonWorks
Application Type” on page 2413.
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158.10 Commissioning Faults Occur After Using Third-Party Tool to Commission or Decommission MNL LonWorks Device

158.10

Commissioning Faults Occur After
Using Third-Party Tool to Commission
or Decommission MNL LonWorks Device
Working with an MNL LonWorks device that was commissioned within Building
Operation, you use a third-party tool outside of Building Operation to commission or
decommission the device. When you later attempt to recommission this device
again in Building Operation, one of two problems occur:
• The commissioning process fails to complete.
• Commissioning appears to be successful but then the MNL device does not
communicate properly. Investigation reveals that the device’s D/S/N address is
not set.

158.10.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Decommission and then recommission the MNL device.
For more information, see section 56.7 “Decommissioning a LonWorks Device”
on page 2016.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.7 “Commissioning an MNL-800
LonWorks Device” on page 2383.
• Query all the devices on the network trunk using a LonWorks tool, such as
NodeUtil. View each device's configuration status and D/S/N address, and
then correct any discrepancies.
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158.11 Commissioning of MNL–800 Device Fails Due to Older Firmware Revision

158.11

Commissioning of MNL–800 Device
Fails Due to Older Firmware Revision
You attempt to commission an MNL-800 device but the process fails during the
application download phase.
This problem can occur when the device has an earlier firmware revision, as
indicated in the Progress view and in an error message that is displayed, stating
The firmware revision in this device is not supported. Building Operation
does not recognize a device as an MNL–800 device if the device has a firmware
revision earlier than 2.0.
For more information, see section 69.1 “MNL LonWorks Devices” on page 2375.

Figure: Commissioning of MNL–800 device fails at application download phase due to
older firmware revision

158.11.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Replace the MNL-800 device with one that has firmware revision V2.0 or
higher.
• Upgrade the device’s firmware to revision V2.0 by installing EPROM MNEA810-200, according to the installation instructions included with the EPROM.
• Integrate the device into Building Operation, using the procedure for
introducing older MNL devices to the system.
For more information, see the Older MNL LonWorks Device Workflow topic on
WebHelp.
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158.12 Downloading Application to MNL LonWorks Device Fails Due to Wrong Device Type

158.12

Downloading Application to MNL
LonWorks Device Fails Due to Wrong
Device Type
You attempt to download an application to a standard MNL LonWorks device or an
MNL-800 LonWorks device, but the process fails to complete because the MNL
device is the wrong hardware type.
This problem can occur whenever you create or commission an MNL device but the
physical device with which you generate the service pin does not match the
hardware type of the device object in the Building Operation database. This is
indicated in the Progress view, and an error message that is displayed, stating
The Application type does not match the device type.

Figure: Downloading application to MNL LonWorks device fails due to wrong device type

158.12.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• If the physical MNL device is correct, delete the device object in the System
Tree pane and then create a new device with a hardware type that matches
the physical device.
For more information, see the Deleting an Object topic on WebHelp.
For more information, see section 56.2 “Creating a LonWorks Device” on page
2007.
For more information, see section 69.2 “Creating an MNL-800 LonWorks
Device” on page 2377.
• If the device object in WorkStation is correct, decommission the physical MNL
device and replace it with one having the correct hardware type.
For more information, see section 59.3 “Replacing an Online LonWorks
Device” on page 2115.

Technical
5610

04-16006-04-en, March 2015

158 MNL LonWorks Troubleshooting
158.13 Downloading Application to MNL LonWorks Device Fails Due to Older Firmware Revision

158.13

Downloading Application to MNL
LonWorks Device Fails Due to Older
Firmware Revision
You attempt to download an application to a standard MNL LonWorks device or an
MNL-800 device, but the process fails to complete.
This problem can occur when the device has an earlier firmware revision, as
indicated in the Progress view and in an error message that is displayed, stating
The firmware revision in this device is not supported. Building Operation
does not recognize a device as an MNL device if a standard MNL device has a
firmware revision earlier than 4.1, or when an MNL-800 device has a firmware
revision earlier than 2.0.
For more information, see section 69.1 “MNL LonWorks Devices” on page 2375.

Figure: Downloading application to MNL LonWorks device fails due to unsupported
firmware revision

158.13.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.

Standard MNL devices
• Integrate the device into Building Operation, using the procedure for
introducing standard LonWorks devices to the system.
For more information, see section 56.13 “Importing a Device Template” on
page 2024.

MNL-800 devices
• Replace the device with a standard MNL device that has a firmware revision
4.1 or later, or with an MNL-800 device that has a firmware revision 2.0 or later.
For more information, see section 59.3 “Replacing an Online LonWorks
Device” on page 2115.
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158.13 Downloading Application to MNL LonWorks Device Fails Due to Older Firmware Revision

• Upgrade the older MNL-800 device's firmware to revision 2.0 by installing
EPROM MNEA-810-200, according to the installation instructions included
with the EPROM.
• Integrate the device into Building Operation, using the procedure for
introducing standard LonWorks devices to the system.
For more information, see section 56.13 “Importing a Device Template” on
page 2024.
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158.14 Cannot Assign Application Using New Command

158.14

Cannot Assign Application Using New
Command
You select a device in the System Tree. In the File menu you point to New and
then click an application name. An error message is displayed, stating
Applications cannot be assigned using the New command.
This problem occurs when you attempt to use the File menu's New command to
assign an application to an MNL device. This problem also occurs if you select a
device and then click New in the shortcut menu.

158.14.1

Solution
Select the MNL device in the System Tree. In the Actions menu, point to MNL
and then click Assign application. Follow the Assign Application Wizard to assign
an application to the device.
For more information, see section 72.47 “Actions Menu – MNL Submenu” on page
2545.
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158 MNL LonWorks Troubleshooting
158.15 Commissioning or Downloading of MNL LonWorks Device Fails Due to Communications Error

158.15

Commissioning or Downloading of MNL
LonWorks Device Fails Due to
Communications Error
While commissioning or downloading an MNL LonWorks device, the process fails
to complete. An error message is displayed, stating A communications error
has occurred.
This problem occurs when the MNL device is not connected to the LonWorks
network.

Figure: Download fails due to communications error (MNL–800 shown)

158.15.1

Solution
Locate the MNL device that is disconnected from the LonWorks network and then
reconnect the device. Confirm in WorkStation that communications with the device
has been re-established and then try commissioning or downloading again.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks Devices”
on page 2382.
For more information, see section 69.5 “Downloading Configuration Properties to
an MNL LonWorks Device” on page 2381.
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158.16 MNL LonWorks Device Out of Sync with Database After Server Restore

158.16

MNL LonWorks Device Out of Sync with
Database After Server Restore
You restore a server database in a system containing MNL LonWorks devices. The
System Tree pane indicates that all LonWorks devices in the server must be
commissioned and have their device configurations downloaded. However, there is
no indication whether the MNL devices also need to be synchronized with the
restored server database.

158.16.1

Solution
Determine whether an MNL device must be synchronized with the restored server
database by checking if changes were made to the device's application or
configuration since the time when the database backup was created.
For more information, see section 68.7 “Synchronize MNL LonWorks Devices after
Server Restore” on page 2371.
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158 MNL LonWorks Troubleshooting
158.17 Command Inactive for MNL LonWorks Device

158.17

Command Inactive for MNL LonWorks
Device
While working with an MNL LonWorks device in WorkStation, you discover that a
command is inactive.
This problem occurs when the condition of the MNL device does not allow the
command to be performed.

158.17.1

Solution
Select the most applicable case from the following and work through the solution in
that case to resolve the problem.
• Assign application command is inactive: This problem occurs when an
application is already assigned to the MNL device. Delete the application in the
device object and then assign a different application to the device.
For more information, see the Deleting an Object topic on WebHelp.
For more information, see section 70.12 “Assigning an MNL LonWorks
Application ” on page 2412.
• Backup flow balance information command is inactive: This problem
occurs when the MNL device is not commissioned. Commission the device.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
• Backup S-Link offsets command is inactive: This problem occurs when the
MNL device is not commissioned. Commission the device.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
• Commission command is inactive: This problem occurs when the MNL
device does not have an assigned application. Assign an application to the
MNL device.
For more information, see section 70.12 “Assigning an MNL LonWorks
Application ” on page 2412.
• Download application command is inactive: This problem occurs when the
MNL device does not have an assigned application or is not commissioned.
Assign an application to the MNL device and then commission the device.
For more information, see section 70.12 “Assigning an MNL LonWorks
Application ” on page 2412.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
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158 MNL LonWorks Troubleshooting
158.17 Command Inactive for MNL LonWorks Device

• Download configuration properties command is inactive: This problem
occurs when the MNL device is not commssioned or an application has not
been downloaded to the device. Commission the MNL device and then
download an application to the device.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
For more information, see section 70.13 “Downloading an MNL LonWorks
Application Type” on page 2413.
• Reset device command is inactive: This problem occurs when the MNL
device is not commissioned. Commission the device.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
• Restore flow balance information command is inactive: This problem
occurs when the MNL device is not commissioned. Commission the device.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
• Restore S-Link offsets command is inactive: This problem occurs when the
MNL device is not commissioned. Commission the device.
For more information, see section 56.6 “Commissioning a LonWorks Device”
on page 2014.
For more information, see section 69.6 “Commission MNL-800 LonWorks
Devices” on page 2382.
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158.18 Dragging Discovered MNL LonWorks Device to System Tree Pane Does Not Acquire Neuron ID

158.18

Dragging Discovered MNL LonWorks
Device to System Tree Pane Does Not
Acquire Neuron ID
You drag a discovered standard MNL LonWorks device from the Device
Discovery view to an MNL device in the System Tree pane but you are not able
to obtain the Neuron ID of the discovered device and associate it with the existing
device.
This problem occurs when the discovered MNL device is in an unconfigured state.
An unconfigured MNL device does not have model number or firmware revision
displayed in the Device Discovery view.
For more information, see section 69.1 “MNL LonWorks Devices” on page 2375.

158.18.1

Solution
In the Device Discovery view, note the Neuron ID of the discovered MNL device.
Select the existing MNL device in the System Tree pane and then in the File
menu, select Properties. On the Basic tab, either enter the Neuron ID of the
discovered MNL device into the Neuron ID property or click the Browse button
to enter the Neuron ID using the service pin method.
For more information, see section 56.3 “Configuring a LonWorks Device ” on page
2009.

Tip
The recommended method for commissioning an existing MNL LonWorks device
in the System Tree pane is to use the Commission Device Wizard. This method
ensures that the MNL device is configured.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.
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158.19 Dragging Discovered MNL LonWorks Device to System Tree Pane Does Not Create New MNL Device

158.19

Dragging Discovered MNL LonWorks
Device to System Tree Pane Does Not
Create New MNL Device
You drag a discovered standard MNL LonWorks device from the Device
Discovery view to a LonWorks network in the System Tree pane but the new
MNL device is not created.
This problem occurs when the discovered MNL device is in an unconfigured state.
An unconfigured MNL device does not have model number or firmware revision
displayed in the Device Discovery view.
For more information, see section 69.1 “MNL LonWorks Devices” on page 2375.

158.19.1

Solution
Use the Create Object Wizard to create the MNL device in the LonWorks network.
This method ensures that the MNL device is configured.
For more information, see section 56.2 “Creating a LonWorks Device” on page
2007.

Tip
The recommended method for commissioning an existing MNL LonWorks device
in the System Tree pane is to use the Commission Device Wizard. This method
ensures that the MNL device is configured.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.
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158 MNL LonWorks Troubleshooting
158.20 MNL LonWorks Device Needs Commissioning Following Deletion of LonWorks Device

158.20

MNL LonWorks Device Needs
Commissioning Following Deletion of
LonWorks Device
After deleting a LonWorks device, the System Tree pane indicates that one of the
remaining MNL LonWorks devices must be commissioned.
This problem can occur when a LonWorks device that is part of a group binding is
deleted and then one of the remaining devices is unable to respond to the network
management requests to update its bindings.

158.20.1

Solution
Manually recommission the MNL device.
For more information, see section 69.6 “Commission MNL-800 LonWorks Devices”
on page 2382.
For more information, see section 56.6 “Commissioning a LonWorks Device” on
page 2014.

Technical
5620

04-16006-04-en, March 2015

158 MNL LonWorks Troubleshooting
158.21 Name Conflicts During MNL LonWorks Solution Import

158.21

Name Conflicts During MNL LonWorks
Solution Import
You begin to import an MNL LonWorks solution and a name conflict occurs.
When a name conflict occurs while importing an MNL LonWorks solution, proceed
with caution. Any Application objects that are created will be based on the
existing application type on the target server, not the applicaton type in the solution
file. Because of this, any differences between the existing application type and the
application type in the solution file will result in Application objects that are
different from those on the source server.
For more information, see section 149.2 “Name Conflicts During Import” on page
5504.

158.21.1

Solution
Before proceeding with the import process, make sure that the existing application
type on the target server is identical to the application type in the solution file, so
that any Application objects created during the import will also be identical to
those in the solution file.
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159 MNL LonWorks Deep Technical Reference
159.1 Source File Error

159.1

Source File Error
You attempt to download an application to an MNL LonWorks device but the
process fails to complete. An error message is displayed, stating There is a
source file error.
This problem can occur whenever the application's hex file is invalid. During an
application download, the system validates the size of the hex file and stops the
download process if the file size is outside the minimum or maximum limit. The outof-range file size typically indicates that a corrupted hex file was generated when the
application was created in WorkPlace Tech Editor.

159.1.1

Solution
Make no more attempts to download the application. In WorkPlace Tech Editor,
recreate the application and then download the application to the MNL device.
For more information, see section 70.7 “Creating an MNL LonWorks Application
Type” on page 2401.
For more information, see section 70.13 “Downloading an MNL LonWorks
Application Type” on page 2413.
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160 BACnet Device Troubleshooting
160.1 A BACnet Schedule Does Not Change Value or Run at Specified Time

160.1

A BACnet Schedule Does Not Change
Value or Run at Specified Time
Schedules always operate according to the local time of the device. If the time, time
zone, or other related time property of a device is set incorrectly, or is set differently
than the time properties on the server, the timing or operation of a BACnet schedule
is affected. You may, for example, set a schedule value to change at a specified
time, but the value does not change, or the schedule does not run at a specified
time.

160.1.1

Solution
Ensure that the following time properties are set correctly and match in both the
device and the server:
• Time zone
• Local time
• UTC offset
• Daylight savings
You can view the time properties of the server on the Date and Time tab of the
server. If the device supports the time properties, you can view the time properties
on the Properties page of the device.
If the properties show incorrect values, for example, an incorrect time, or the
propeties on the device and server do not match, correct each property on the
device and the server. Then, synchronize the time between the device and the
server using the BACnet Time Sync command. To change the time properties on a
device, refer to the vendor's instructions.
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160 BACnet Device Troubleshooting
160.2 A Copied Object (Generic) Does Not Operate and Shows Property Errors

160.2

A Copied Object (Generic) Does Not
Operate and Shows Property Errors
An object (generic) copied from the Application folder of a device to the Application
folder of another device does not function properly, and property errors display. For
example, a BACnet notification does not notify the device recipients, and property
errors regarding the notification display in WorkStation.

160.2.1

Solution
Use the BACnet Download command with the copied object (generic) to dowload
the properties to the BACnet device.
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160.3 BACnet Point Value Does Not Change

160.3

BACnet Point Value Does Not Change
When a BACnet device or application writes to a commandable property that is
controlled by a higher priority level than the level configured for the point, the value
of a BACnet point does not change, as expected. This problem can also occur
when two priority levels, which are configured with the same priority level, write to
the same commandable value. If this happens, the last write command is
processed.

160.3.1

Solution
Make sure that there is no higher command priority level than the one configured for
the point (or the same priority level) writing to the value. For more information, see
section 77.2 “Commandable Properties and Objects” on page 2852.

04-16006-04-en, March 2015

Technical
5631

160 BACnet Device Troubleshooting
160.4 Default Priority Level Change

160.4

Default Priority Level Change
If you change the Default priority level after the system is engineered and
operational, stale values may be retained in the array location associated with the
previous default.

160.4.1

Solution
Verify the current Default priority level and then manually remove the stale values
from the affected BACnet devices and applications. For more information, see
section 81.2 “Interface Manager for BACnet – Basic Tab” on page 2967.
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160.5 Unspecified Device Identifier

160.5

Unspecified Device Identifier
Several BACnet devices are shipped from the factory with the unspecified device
identifier of 4194303. Building Operation places these discovered devices in the
Unconfigured Devices folder of the online server and indicates that there is an
issue with the identifier.

160.5.1

Solution
Change the device's identifier according to the manufacturer's instructions, which
may include using a configuration tool or changing some physical hardware
settings.
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160.6 Duplicate Device Identifier

160.6

Duplicate Device Identifier
The system sounds an alarm when two devices with the same device Id are
discovered. You can locate one of the two devices in the Unconfigured Devices
folder of the online server (.../System/Hardware/BACnet devices/Unconfigured
Devices).

160.6.1

Solution
Change the device's identifier according to the manufacturer's instructions, which
may include using a configuration tool or changing some physical hardware
settings.

Tip
Devices that reside in the Unconfigured Devices folder of the online server
need to be examined so you can determine how to correct an interoperability
issue, such as a duplicate device identifier or device name.
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160.7 Routing Loops

160.7

Routing Loops
BACnet requires a single communication path between any two devices. A routing
loop occurs when you mistakenly add a second path, which may cause messages,
especially broadcast messages used for device and network discovery, to be
retransmitted many times. In turn, the increased message transmission degrades
network performance. The system may also trigger alarms when there is a duplicate
network ID or device ID. By default, all BACnet IP devices use UDP/IP port 47808.

160.7.1

Solutions
The solutions are listed in order. The solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Carefully set up the communication paths between devices, especially when
configuring more than one BACnet IP network on a Building Operation server.
• Make sure that the port is not used by another Building Operation server or
BACnet device when opening a second network on a different UDP/IP port
number.
• Make sure that a BBMD or Foreign Device registration does not reference an IP
network, which is already part of the BACnet internetwork (connected through
a BACnet router).
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160 BACnet Device Troubleshooting
160.8 Broadcast Storms

160.8

Broadcast Storms
Broadcast storms or excessive broadcast traffic occur when multiple BBMDs exist
on the same IP subnet in the BACnet network. As a result, the BACnet network
may become sluggish.

160.8.1

Solution
Make sure that you create each BBMD on a different IP subnet to avoid creating
multiple communication paths between the subnets.
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161 BACnet Deep Technical Reference
161.1 System Performance Diagnostics

161.1

System Performance Diagnostics
Use the diagnostic objects located in the Diagnostics folder of the System Tree
(Server/System/Modules/BACnet devices/Diagnostics) to identify and improve
performance issues on a server. There is a diagnostic object for each BACnet
network type: IP, Local, and Remote, plus two Automation Server objects, MSTPA
(MS/TP COMA) and MSTPB (MS/TP COMB). These objects display polling
statistics for a network, which is especially useful if the network is running a large
graphic or numerous polled variables. For more information, see section 74.1
“BACnet Networks” on page 2573.

Figure: BACnet Diagnostics folder

If the number of polled variables, system memory, and CPU usage is high, as
shown, improve system performance by completing these tasks:
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161 BACnet Deep Technical Reference
161.1 System Performance Diagnostics

Table: Diagnostics Tasks
Task

Description

View polling and COV statistics Evaluate the data on polled variables on each BACnet
network currently installed on the server. For more
information, see section 74.13 “Diagnosing Polled
Variables on a BACnet Network” on page 2594.

Technical
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View system resources usage

View the system resources usage of the server to detect a
potential system load. For more information, see section
3.25 “Displaying CPU and System Memory Usage” on
page 169.

Improve system performance

Fine-tune polling intervals. For more information, see
section 74.14 “Optimizing System Performance Using
BACnet Polling Intervals” on page 2597.
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162 b3 BACnet Device Troubleshooting
162.1 Backup Needed Message Displays

162.1

Backup Needed Message Displays
The “Backup needed” message displays in the Value field for the StatusBackup
system variable. This message indicates that the b3 BACnet device's database is
no longer synchronized with its flash memory.

162.1.1

Solution
Back up all of the objects in the b3 BACnet device to flash memory. For more
information, see section 84.14 “Backing Up a b3 BACnet Device to Flash Memory”
on page 3448..
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Topics
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163 Modbus Troubleshooting
163.1 Error Count Not Zero

163.1

Error Count Not Zero
The Read error count or Write error count property of a Modbus point is
shown as non-zero:

Figure: Error count not zero

This can occur in the following circumstances:
• The system has not been properly set up (points on master device/client
devices).
• Communications have failed after set up.
• A break has occurred in message transmission.
An error count occurs each time the master device/client makes a failed attempt to
communicate with the slave/server. To assist in diagnosis, you can reset the count
to zero each time you try to resolve the problem. After the problem is resolved, you
do not need to set the count to zero for the system to function properly.

163.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check other points on the same device for a non-zero error count. If all points
have a non-zero error count, check if the device is offline.
For more information, see section 163.10 “Serial Device Status Offline” on
page 5654.
For more information, see section 163.5 “Modbus TCP Device Status Offline”
on page 5649.
• If only one point has a non-zero error count, check if the device has an Input
read failure or Output write failure error. For more information, see
section 163.9 “Read or Write Failure” on page 5653.
• Check the network for communications failure, for example, serial or TCP
network connections. For more information, see the Automation Servers topic
on WebHelp.
• Check that the register number addressed exists in the device.
• Increase the number of Silence characters in the network Advanced properties.
For example, try increasing to 10, and if the fault clears, reduce the number of
characters slightly until just above the level at which the fault occurs.
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163 Modbus Troubleshooting
163.2 Modbus Interface Status Offline

163.2

Modbus Interface Status Offline
The Status property in the Basic tab of a Modbus Interface is shown as Offline:

Figure: Status offline

This can occur if the Building Operation server does not receive a valid message
from the master device/client within the timeout period (as set in the Basic tab of
the Modbus Interface). This is not necessarily a problem as the Modbus Interface
comes back online the next time a message is received.
This problem can also occur if the input message has failed completely, for
example, if the master device or client has gone offline for any reason.

163.2.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Set the Timeout to a more suitable time period for your application, or set it to
Inhibit. For more information, see section 90.4 “Configuring a Modbus
Interface” on page 3643.
• Ensure that the external master device/client is online.
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163.3 Modbus Point Has Unexpected Value

163.3

Modbus Point Has Unexpected Value
The Value property of a Modbus point is different than the expected value:

Figure: Point has unexpected value

This can occur if a point setting is incorrectly configured.

163.3.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that all the following point settings are appropriate for the value
expected:
– Register number (select from datasheet Modbus map)
– Register type (select according to numeric format required)
– Read function code
– Write function code (register must be writable)
– Bitmask (ensure that any mask applied is correctly set)
– Gain and Offset
For more information, see section 92.5 “Configuring a Modbus Point” on page
3673.
• Ensure that the following network settings (if applicable to network type) match
those of the device:
– Parity
– J-Bus mode (J-Bus address is one less than standard Modbus address)
For more information, see section 87.10 “Configuring a Modbus Master
Network” on page 3606.
For more information, see section 87.8 “Configuring a Modbus Slave Network”
on page 3603.
For more information, see section 88.6 “Configuring a Modbus TCP Network”
on page 3624.
For more information, see section 88.8 “Configuring a Modbus TCP Gateway”
on page 3627.
For more information, see section 88.10 “Configuring a Modbus TCP Server”
on page 3630.
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163 Modbus Troubleshooting
163.4 Modbus Point Value Has Red Indicator

163.4

Modbus Point Value Has Red Indicator
The Value property of a Modbus point is shown with a red indicator, indicating that
the current value is not available:

Figure: Value property has red indicator

This can occur in the following circumstances:
• The port or network is offline
• The device is offline.
• Communications have failed.
• One or more point settings are incorrect, for example, register address out of
range or wrong function code.
• The J-Bus setting is incorrect.

163.4.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first (depending on whether you are using a serial or a TCP network). Work through
each solution until the problem is resolved.
• Ensure that the port is online. For more information, see section 163.12 “Serial
Port Status Offline” on page 5656.
• Ensure that the network is online. For more information, see section 163.11
“Serial Network Status Offline” on page 5655.
• Ensure that the serial device is online. For more information, see section
163.10 “Serial Device Status Offline” on page 5654.
• Ensure that the TCP network is online. For more information, see section 163.8
“Modbus TCP Network Status Offline” on page 5652.
• Ensure that the Modbus TCP device is online. For more information, see
section 163.5 “Modbus TCP Device Status Offline” on page 5649.
• Ensure that there are no read or write errors. For more information, see section
163.9 “Read or Write Failure” on page 5653.
• Ensure that sensible settings are entered in the point’s Configuration
Settings dialog box. A setting of None for a function code is a valid option but
prevents read (and write) access to the point.
• Ensure that the J-Bus setting is correct.

Note
If the poll point receives an exception or no valid response for up to 100
consecutive requests, polling is stopped for 30 minutes and then retried every 30
minutes until the reason for the failure is resolved. For more information, see
section 164.3 “Device and Register Polling” on page 5667.

Technical
5650

04-16006-04-en, March 2015

163 Modbus Troubleshooting
163.5 Modbus TCP Device Status Offline

163.5

Modbus TCP Device Status Offline
The Status property of a Modbus TCP Device is shown as Offline:

Figure: Server status offline

This can occur in the following circumstances:
• The network is offline.
• The device is physically disconnected from the network.
• The actual device IP address or port number does not match that entered in
Building Operation.

163.5.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the (external) device is properly connected to the Modbus TCP
Network by Ethernet cable and switched on.
• Ensure that the (external) device’s IP address and port number entered in
WorkStation is correct. For more information, see section 91.3 “Configuring a
Modbus TCP Device” on page 3651.
• Check the status of another external device (if available) to determine if the fault
occurs at more than one device. For more information, see section 91.3
“Configuring a Modbus TCP Device” on page 3651.
• Check the network status. If the network is offline, its devices are also offline.
For more information, see section 91.3 “Configuring a Modbus TCP Device” on
page 3651.
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163 Modbus Troubleshooting
163.6 Modbus TCP Gateway Status Offline

163.6

Modbus TCP Gateway Status Offline
The Network status property of a Modbus TCP Gateway is shown as Offline:

Figure: Network status offline

This can occur in the following circumstances:
• The gateway device is physically disconnected from the server.
• One or more of the gateway properties are incorrect.
• All items on the network are offline.

163.6.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the Modbus gateway device is properly connected to the server
and that all devices are switched on. For more information, see the Automation
Servers topic on WebHelp.
• Ensure that the Modbus gateway properties are correct: J-Bus mode, IP port,
and IP address. For more information, see section 88.8 “Configuring a Modbus
TCP Gateway” on page 3627.
• Ensure that the properties of all serial devices are correct. For more
information, see section 91.5 “Configuring a Modbus Device” on page 3655.
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163.7

Modbus TCP Server Status Offline
The Network status property of a Modbus TCP Server is shown as Offline:

Figure: Network status offline

This can occur if no connected clients are sending queries within the Timeout
setting.

163.7.1

Solution
None. The network status will become online again when queries are being
received.
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163.8

Modbus TCP Network Status Offline
The Network status property of a Modbus TCP Network is shown as Offline:

Figure: Network status offline

This can occur in the following circumstances:
• All items on the network are offline.
• The network is physically disconnected from the server.
• The device IP port number and IP address is incorrect (single device on the
network).

163.8.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the Modbus network is properly connected to the server and that
all devices are switched on. For more information, see the Automation Servers
topic on WebHelp.
• For a single device on the network, ensure that the actual device IP port
number and IP address match the IP port number and IP address settings in
the device Basic properties tab. For more information, see section 91.3
“Configuring a Modbus TCP Device” on page 3651.
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163.9

Read or Write Failure
The Status property of a network or the Status property of a device is shown as
‘Online’, but the Output write failure or Input read failure property of a
Modbus network or device is shown as Failure:

Figure: Read or write failure

An input read failure or an output write failure can occur for several different
reasons, normally because the Register number entered in a point’s
Configuration Settings properties does not match the register number of the
intended register in the actual device. For example, the master device (or client) is
addressing the wrong register (or a register that does not exist within the device)
and may not be able to read (Input read failure) or write (Output write failure)
data as expected. This type of error can occur if the properties of a point are not set
up correctly after installation of a new device.
Other reasons for Input read failure or Output write failure errors can include
wrong function code, wrong J-Bus mode setting, wrong data, or out-of-range data.

163.9.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the register number specified in the point’s Configuration
Settings properties is identical to the register number required in the actual
device (consult the Modbus map for the device). Reset the Input read failure
or Output write failure from Failure to OK. For more information, see
section 92.7 “Configuring a Modbus Value” on page 3678.
• Ensure that the function code specified in the point’s Configuration
Settings properties is appropriate to the register type addressed in the actual
device (consult the Modbus map for the device). Reset the Input read failure
or Output write failure from Failure to OK. For more information, see
section 92.7 “Configuring a Modbus Value” on page 3678.
• Ensure that the register type specified in the point’s Configuration Settings
properties is appropriate to the register type addressed in the actual device
(consult the Modbus map for the device). Reset the Input read failure or
Output write failure from Failure to OK. For more information, see section
92.7 “Configuring a Modbus Value” on page 3678.
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163.10

Serial Device Status Offline
The Status property of a serial Modbus device is shown as Offline:

Figure: Device status offline

This can occur in the following circumstances:
• The device is physically disconnected from the network.
• The Modbus device settings selected in WorkStation are different from the
Modbus settings configured in the device.
• The Modbus network settings selected in WorkStation are different from the
Modbus settings configured in the device.

163.10.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the device is properly connected to the Modbus serial network and
switched on. For more information, see section 87.1 “Modbus Serial Networks”
on page 3589.
• Ensure that the device address entered in WorkStation is correct.
For more information, see section 91.5 “Configuring a Modbus Device” on
page 3655.
For more information, see section 90.4 “Configuring a Modbus Interface” on
page 3643.
• Ensure that all Modbus network settings match the network settings
configured in the device (consult the device’s datasheet for the correct settings
to use).
For more information, see section 87.10 “Configuring a Modbus Master
Network” on page 3606.
For more information, see section 87.8 “Configuring a Modbus Slave Network”
on page 3603.
• Check the status of another device (if available) to determine if the fault occurs
at more than one device.
• Check the port status. If the port is offline, the network and its devices are also
offline. For more information, see section 104.8 “Configuring a Serial Port” on
page 4575.
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163.11

Serial Network Status Offline
The Network status property of a Modbus serial network is shown as Offline:

Figure: Network status offline

This only occurs if all devices on the network fail to respond to a poll, for example, if
the network’s Modbus settings do not match the settings of the devices in the
network, or if you have not associated a serial port with the network. For more
information, see section 87.1 “Modbus Serial Networks” on page 3589.

163.11.1

Solution
Ensure that the Modbus settings Framing mode, Baud rate, Parity, J-Bus, and
Stop Bits are correct for the network object and that the Port reference
property is correct. Ensure also that each of the devices on the network are
configured to the same parameters (refer to the device datasheets).
• For more information, see section 87.10 “Configuring a Modbus Master
Network” on page 3606.
• For more information, see section 87.8 “Configuring a Modbus Slave Network”
on page 3603.
• For more information, see section 91.5 “Configuring a Modbus Device” on
page 3655.
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163.12

Serial Port Status Offline
The State property of a serial port is shown as Offline:

Figure: Port state property offline

The port name does not match the port type that the network is connected to.

163.12.1

Solution
Ensure that Network interface name matches the port type to which the
network is connected. For example, COM1 or COM2 (for the Enterprise Server).
Spaces are not allowed. For more information, see section 104.8 “Configuring a
Serial Port” on page 4575.

Figure: Port state property online
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164.1 Modbus Message Formats

164.1

Modbus Message Formats
The most basic part of any Modbus message is known as a PDU, which comprises
a 2-byte function code field and a data field. The function code field specifies the
action to perform and the data field specifies the information to be used for this
action.
The function code determines access to register(s):
• The type of register(s) accessed.
• Whether data is read from or written into the register(s).
The data field specifies:
• The address of the first register upon which the read/write operation takes
place.
• The range of registers to be accessed.
• The actual data content to be read or written.
Hence the number of bytes in the data field can vary, depending on the message
content. For more information, see section 86.11 “Function Code Definition and
Selection” on page 3580.

Figure: Modbus Protocol Data Unit

For communications over a serial line, you can choose either of two types of serial
framing modes: RTU mode and ASCII mode. The Modbus PDU is preceded by a 1
or 2-byte device address (depending on the framing mode). Two bytes at the end of
the message provide error checking (check sum):
• In RTU mode, the two checksum bytes provide a cyclic redundancy check.
• In ASCII mode, the two checksum bytes provide a longitudinal redundancy
check.
The format of the Modbus PDU remains the same regardless of your choice of serial
message transmission (RTU or ASCII). For more information, see section 164.2
“Serial Transmission Modes” on page 5661.
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Figure: Modbus frame over serial line (RTU or ASCII)

For communications over TCP/IP, the PDU is preceded by a Modbus Application
Protocol header (MBAP) which is seven bytes long and is IP specific. The final byte
of the MBAP header contains the identifier of the server (or slave device) on the TCP
network.

Figure: Modbus frame over TCP/IP

Note
• RTU or ASCII transmission mode selection (that is, the framing mode) is only
available in serial networks. You cannot select a framing mode for a TCP
Network.
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164.2

Serial Transmission Modes
The Modbus serial transmission mode defines the bit contents of message fields
transmitted serially on the line and determines how information is packed into the
message fields and decoded.
The Modbus protocol uses two different serial transmission modes: RTU mode and
ASCII mode. In WorkStation, you can select either one of these modes in the
Framing mode section of the network properties.
To ensure that all devices on a Modbus serial line can communicate with each
other, you must set the transmission mode (and serial port parameters, for example
baud rate and parity) to be the same for all devices.
Any 2-digit hexadecimal value transmitted in RTU mode uses one 8-bit byte. The
same 2-digit hexadecimal value transmitted in ASCII mode requires two 7-bit bytes.
Hence the RTU mode is more compact and has better data throughput than ASCII
mode for the same baud rate. In the following example, the value 6D (Hex) is
transmitted in a single 8-bit byte in RTU mode.

Figure: Single 8-bit byte in RTU mode

However, in this example, for 6D (Hex) to be transmitted in ASCII mode, two bytes
are required: the first byte to transmit the ASCII character ‘6’ (that is, 36 Hex) and
the second byte to transmit the ASCII character ‘D’ (44 Hex).
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Figure: Two 7-bit bytes in ASCII mode

For both RTU and ASCII transmission modes, the least significant bit of a message
is transmitted first.
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164.2.1

RTU Transmission Mode Message Data Byte
Format
RTU is an 8-bit binary coding system with hexadecimal characters 0-9 and A-F.
When devices are set up to communicate on a Modbus network using RTU mode,
each 8–bit byte in a message contains two 4–bit hexadecimal characters.
Each RTU mode message must be transmitted in a continuous stream.
The RTU mode message byte has the following format:
• 1 start bit
• 8 data bits, least significant bit sent first
• 1 bit for even/odd parity; no bit for no parity
• 1 stop bit if parity is used; 2 bits if parity is not used

Figure: Example message data byte in RTU transmission mode

164.2.2

RTU Transmission Mode Message Frame
Format
In RTU mode, the transmitting device places the message data bytes into an RTU
message frame, which has a known start point and a known end point. In this way,
devices that receive a new frame can start at the beginning of a message and know
when the message is completed.
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Messages are started and ended by at least 3.5 character lengths of ‘silence’.
Networked devices continuously monitor the network for this silent interval. When
such an interval is received by a device, it decodes the first field of the message (the
address) to determine if it is the addressed device. Following the last character
transmitted, a similar silent interval of at least 3.5 character lengths marks the end of
the message and a new message can begin (you can change this silent interval in
the Modbus network properties to take account of slow message responses).
The entire message must be transmitted as a continuous stream. If a silent interval
of more than 1.5 character lengths occurs during the message transmission, the
receiving device removes the incomplete message and assumes that the next byte
is the address field of a new message.

Figure: RTU transmission mode message frame format

164.2.3

ASCII Transmission Mode Message Data Byte
Format
ASCII is a hexadecimal coding system with ASCII characters 0–9 and A–F. When
devices are set up to communicate on a Modbus network using ASCII mode, each
ASCII character in a message requires one 7-bit byte. An interval of up to one
second can elapse between characters (unless a longer timeout has been
configured) without errors being generated.
The ASCII mode message byte has the following format:
• 1 start bit
• 7 data bits, least significant bit sent first
• 1 bit for even/odd parity; no bit for no parity
• 1 stop bit if parity is used; 2 bits if parity is not used
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Figure: Example message data bytes in ASCII transmission mode

164.2.4

ASCII Transmission Mode Message Frame
Format
In ASCII mode, the transmitting device places the message data bytes into an ASCII
message frame, which has a known start point and a known end point. An ASCII
message frame must start with a colon (:) and end with the two characters ‘Carriage
Return – Line Feed’ (CR, LF).
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Modbus networked devices continuously monitor the network for the colon
character. When the colon character is received, each device decodes the next
character until it detects the CRLF character pair. During the message transmission,
any interval of greater than one second between message characters means that
an error has occurred.

Figure: ASCII transmission mode message frame format
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164.3

Device and Register Polling
In Building Operation, the Modbus plug-in contains a poll mechanism where a poll
manager manages the polling of Modbus points (called subscription variables) on
Modbus networks connected to a Building Operation server. For each network, the
poll manager operates with a poll list and a poll task.

164.3.1

Poll Manager
The poll manager:
• Manages the polling of devices and device registers in connected Modbus
networks.
• Adds, changes, or deletes variables in the poll list.

164.3.2

Poll List
The poll list is a list of all subscription variables in a connected Modbus network.

164.3.3

Poll List Management
The poll task runs in the background and performs the following functions:
• Collects data from subscribed variables in the network.
• Takes requests from the poll manager to make changes to the poll list. This
mechanism provides the synchronization needed between the poll task and
the poll manager.
• Keeps a record of all devices on the network. The poll task also monitors
devices on the network for communication problems by executing device polls.
• Initiates two types of poll, a data poll and a device poll:
– A data poll is a Modbus enquiry to read point data contained in a Modbus
device register (the Poll register). Data polls are only successful if
communications between the Building Operation server and the Modbus
device are established.
– A device poll is a Modbus enquiry that determines if a device is online by
detecting a response to the poll. Any response to the poll, even an
exception response, is sufficient to establish online status. Device polls
occur at user-defined intervals (the Poll interval) and then only when there
are no active data polls for registers on the device (or in the event of poll
failures). If all devices on the network are offline, the network status is set
to offline and a system alarm is generated. Basic device identification
(Vendor Name, Product Code, and Product Revision) is supported using
function code 43. For more information, see section 91.1 “Modbus
Devices” on page 3647.
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– A data poll failure is reported to the device and a device poll takes place to
establish that the device is online. Any device that fails this poll is placed
offline; all poll points associated with the device are also put offline and
polling is disabled.
– A device that goes offline generates a system alarm. Subsequent device
polls are carried out on the device until there is a successful device poll
and the device is then placed online. When the device is online, all poll
points are restored to the online state and data polling is re-enabled.
• Monitors the status of polled data values on the network. Each poll point
maintains a count of failures that is reset following a successful poll. When
three or more failures are detected, the poll point is marked as offline but
continues to be polled. If the failure count exceeds 100, or if the poll point
receives an exception code 1 (Illegal Function) or 2 (Illegal Data Address), then
the point is not polled again except for one of the following reasons:
– The poll point definition is modified.
– The poll point subscription is destroyed and recreated.
– A time period of 30 minutes elapses. After the 30 minute delay, a single
poll attempt occurs every 30 minutes until polling is successful.
Read and write failure counters are updated and are available to the user
(Output write failure and Input write failure).
• Maintains diagnostic data of the devices and registers being polled.
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164.4

Modbus Poll Duty Cycle
The Modbus Poll Duty Cycle is a configurable property that enables you to change
the percentage of the time a Modbus master (or client) device is polling its slave
(server) devices. The poll duty cycle is a feature in all Modbus master and client
networks in Building Operation.
Each poll cycle comprises a period of time spent polling followed by a configurable
post-poll delay. The polling time comprises a whole number of poll requests and is
never less than 100 ms.
The following figure shows the relationship between the polling time and the postpoll delay:

Figure: Modbus polling cycle

The poll duty cycle is modified by changing the post-poll delay as shown in the
following formula:
Poll duty cycle % = Polling time x 100/(Post-poll delay + Polling time)
You can select the percentage duty cycle in the range 5% to 100%. If you leave the
poll duty cycle at the Default selection, all subscribed Modbus points are polled as
in software version 1.5. For more information, see section 89.1 “Network
Configuration” on page 3633.
When changing the poll duty cycle, be aware that you should not allow the
StruxureWare system CPU usage to exceed 60%. For more information, see the
Architectural Guidelines 1.5 topic on WebHelp.
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165.1 Cannot Import a Second GCM Database

165.1

Cannot Import a Second GCM Database
If you attempt to import a second GCM database, the system renames the second
NETWORK 8000 Interface before the import and then attempts to complete the
import. However, the system identifies that a second NETWORK 8000 Interface is
not valid and stops the import.

Figure: Import dialog box

165.1.1

Solution
Delete the existing NETWORK 8000 Interface and then import the new GCM
database. Only one NETWORK 8000 Interface can reside on an Automation Server.
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165.2

Incorrect Values Displayed Due to Unit
Conversion
After migration of a GCM database into Building Operation, some NETWORK 8000
objects display incorrect values. This problem can occur when the units of measure
are not the same between bound NETWORK 8000 objects. The units of measure
between bound NETWORK 8000 objects must be the same.

165.2.1

Solution
Ensure the units of measure are the same for the NETWORK 8000 objects that are
bound together.
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165.3

Cannot Bind a Global Reference Point
When you attempt to bind a global reference point within the NETWORK 8000
Interface and save the changes, the error message, “A local NETWORK 8000
property cannot be bound to this global reference point” is displayed.

165.3.1

Solution
Attach the global value to a point that is not contained within the local NETWORK
8000 Interface container. If you need to attach an analog point to the selected point
you use the analog input and attach the point at the Analog input reference. For
a digital point, you use the digital input and attach the point at the Digital input
reference.
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165.4

Entered Property Value Exceeds
Specified Limits
When you enter a value for an Analog input constant on an object’s Input tab
that is outside the range that is specified on the Parameters tab, the error
message, “The entered value exceeds the specified limits for this property” is
displayed.

165.4.1

Solution
Ensure the value that is being entered is correct. If it is, then modify the limits for the
property on the Parameters tab.
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165.5

Duplicate Device Address
When you create a new device with the address of an existing device of the same
type, the error message, "This device address has been used" is displayed.

165.5.1

Solution
Verify the device address and make appropriate modifications to the address.
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165.6

ASD and LCM Networks Cannot be
Configured to Same Automation Server
Serial Port
When you deploy a configuration with conflicting serial port allocations, the deploy
succeeds. However, the error message, "The ASD and LCM networks cannot be
configured to the same Automation Server serial port. Reconfigure and enable the
ports to resolve the conflict." is displayed. An error is also generated in the targeted
server.

165.6.1

Solution
Reconfigure and enable the ports in the Automation Server to resolve the conflict
and then learn the Automation Server back into the Project Configuration Server.
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165.7

Automation Server Serial Port Assigned
to ASD Network Already Allocated
When you deploy a configuration with conflicting serial port allocations, the deploy
succeeds. However, the error message, "The Automation Server serial port
assigned to the ASD network is already allocated. Reassign the ports to resolve the
conflict." is displayed. An error is also generated in the targeted server.

165.7.1

Solution
Reassign the port in the Automation Server to resolve the conflict and then learn the
Automation Server back into the Project Configuration Server.
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165.8

ASD Port Reference is Invalid
When you attempt to enable an ASD port without assigning a port reference, the
error message, “An ASD port reference is required when the network is enabled” is
displayed.

165.8.1

Solution
Assign a valid port reference before enabling the port.
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165.9

ASD Port Reference Path is Invalid
When you attempt to assign an ASD port reference that is already assigned to the
LCM port, the error message, “An ASD port reference is present but the path is not
valid” is displayed.

165.9.1

Solution
Select the ASD port reference for the actual connected port. If this port has already
been assigned to another reference, then delete that reference first.
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165.10

ASD Port Reference Cannot be
Changed
When you attempt to change or select an ASD port that is already in use or
allocated, the error message, “The ASD port reference cannot be changed while in
use” is displayed.

165.10.1

Solution
Disable the port before attempting to change the port reference.
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165.11

ASD Port Reference Cannot be
Assigned
When you attempt to assign an ASD port that is already assigned, the error
message, “The port selected for the ASD is already allocated” is displayed.

165.11.1

Solution
Select the ASD port reference for the actual connected port. If this port has already
been assigned to another reference, then delete that reference first.
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165.12

Automation Server Serial Port Assigned
to LCM Network Already Allocated
When you deploy a configuration with conflicting serial port allocations, the deploy
succeeds. However, the error message, "The Automation Server serial port
assigned to the LCM network is already allocated. Reconfigure and enable the
ports to resolve the conflict." is displayed. An error is also generated in the targeted
server.

165.12.1

Solution
Reassign the port in the Automation Server to resolve the conflict and then learn the
Automation Server back into the Project Configuration Server.
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165.13

LCM Port Reference is Invalid
When you attempt to enable the LCM port without assigning a port reference, the
error message, “An LCM port reference is required when the network is enabled” is
displayed.

165.13.1

Solution
Assign a valid port reference before enabling the port.
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165.14

LCM Port Reference Path is Invalid
When you attempt to assign an LCM port reference that is already assigned to the
ASD port, the error message, “An LCM port reference is present but the path is not
valid” is displayed.

165.14.1

Solution
Select the LCM port reference for the actual connected port. If this port has already
been assigned to another reference, then delete that reference first.
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165.15

LCM Port Reference Cannot be
Changed
When you attempt to change or select an LCM port that is already in use or
allocated, the error message, “The LCM port reference cannot be changed while in
use” is displayed.

165.15.1

Solution
Disable the port before attempting to change the port reference.
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165.16

LCM Port Reference Cannot be
Assigned
When you attempt to assign an LCM port that is already assigned, the error
message, “The port selected for the LCM is already allocated” is displayed.

165.16.1

Solution
Select the LCM port reference for the actual connected port. If this port has already
been assigned to another reference, then delete that reference first.
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165.17

LCM Block or LCM Object Does Not
Update
After you make a change in the LCM and you observe that one or more values are
incorrect in the Automation Server, it indicates a communications or print group
setting problem. Or, if you make a change in the LCM during a time when you know
that communications between the Automation Server and the LCM is down, the
values will not update in the Automation Server.
There are two causes for which the LCM block or LCM Object will not update:
• The LCM and Automation Server are not communicating.
• The LCM print groups are not set up to allow routing of messages to the
Automation Server.

165.17.1

Solution
Ensure that the LCM communications are configured and that the print groups in
the LCM are properly set up.
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165 NETWORK 8000 Troubleshooting
165.18 LCM Properties Do Not Update in Graphic or Watch Pane

165.18

LCM Properties Do Not Update in
Graphic or Watch Pane
When you view a graphic containing an LCM property or view an LCM property in
the Watch pane, you note that in both places, the displayed properties do not
update. The properties may indicate “invalid” or “null”.
This can occur if the LCM number property, which is set to the physical address
of the LCM device, is changed while LCM properties are displayed in a graphic or
the Watch pane. For example, you import a GCM database into Building Operation,
creating a NETWORK 8000 Interface that includes an LCM trunk with devices.
Next, while you are displaying an LCM property in a graphic or in the Watch pane,
you change the LCM number property of the associated LCM device, at which
time the displayed property stops updating.
For more information, see the How Graphics Work topic on WebHelp.
For more information, see the Watch Pane and Watch View topic on WebHelp.
For more information, see section 96.5 “NETWORK 8000 LCMs” on page 3799.

165.18.1

Solution
If you change the LCM number property while LCM properties are displayed in a
graphic or the Watch pane, restore operation by resetting the Automation Server.
For more information, see the Reset Functions topic on WebHelp.
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165.19 Cannot Delete an LCM Device Object or LCM Block

165.19

Cannot Delete an LCM Device Object or
LCM Block
When you attempt to delete an LCM device object or an LCM block while an LCM
learn is in progress, an error notice is displayed:
• Deletion of LCM device object is not permitted during an LCM learn operation.
• Deletion of LCM block is not permitted during an LCM learn operation.

165.19.1

Solution
Ensure the LCM learn operation has completed before attempting to delete the
LCM Device object or an LCM block associated with that LCM device object.
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165.20 Maximum Number of LCM Device Objects Exceeded

165.20

Maximum Number of LCM Device
Objects Exceeded
When you attempt to create more than 31 LCM device objects, the error message,
“The maximum number of LCM device objects has been exceeded” is displayed.

165.20.1

Solution
Ensure that there are no more than 31 NETWORK 8000 LCM devices attached to
the Automation Server. If more LCM devices are required, additional Automation
Server systems must be added to support them.
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166 NETWORK 8000 Deep Technical Reference
166.1 Delta Time

166.1

Delta Time
Use Delta time as a troubleshooting aid. Delta time is a property that each
NETWORK 8000 object uses to monitor its runtime. If an object has its Update
time set to 5, it should execute every 5 seconds. Delta time will indicate the
actual runtime whether that be 5 seconds or some time longer than that.
Delta time is an observable hidden property. While WorkStation is connected to
the Automation Server, select the object you want to view. On the File menu, click
Properties. With the Properties box open, press the Alt key and left-click the thin
space immediately below the Basic tab and above the General Information
group title bar.

Figure: Hidden properties selection.

Scroll down to Delta time.
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166 NETWORK 8000 Deep Technical Reference
166.1 Delta Time

Figure: Delta time property.

If there is a large difference (delta) between the set time of block execution and the
actual time, it can indicate a problem. It is likely that the device processor is not able
to keep up with all its processing tasks. You can verify this by viewing the
Automation Server CPU usage.
Click Close to exit the hidden property.
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167 I/NET Troubleshooting
167.1 I/NET Events are Not Showing Up in WorkStation

167.1

I/NET Events are Not Showing Up in
WorkStation
Events generated in I/NET are not displayed in WorkStation.

167.1.1

Solution
Use message masks in I/NET to route events to the PC. For more information, see
the description of System Messages in TCON300, I/NET Seven Technical
Reference Guide.
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Object Error Count not Zero

168 MicroNet Troubleshooting
168.1 Data Import dialog displays ‘Unable to read’ message

168.1

Data Import dialog displays ‘Unable to
read’ message
The data importer displays a message similar to the following:
Unable to read \\...\ExportXML_Files\Update file.xml

168.1.1

Solution
Enter the correct update file path name in the MicroNet interface Advanced
properties.
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168 MicroNet Troubleshooting
168.2 Data Import dialog displays 'Type not found' message

168.2

Data Import dialog displays 'Type not
found' message
During a data import, one or more 'Type not found' messages are displayed.

Figure: Type not found errors in Data Import dialog

168.2.1

Solution
Before importing the MicroNet network, ensure that correct range values are
configured in VisiSat. For more information, see section 169.1 “VisiSat Point Upper
and Lower Limits” on page 5711.
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168 MicroNet Troubleshooting
168.3 Data import fails after changing Update file path

168.3

Data import fails after changing Update
file path
When attempting a data import, the following message is displayed:
“Changes made on server are in conflict with active non-saved
changes”

168.3.1

Solution
Save the update file path name before attempting a data import.
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168.4 Read or Write Failure

168.4

Read or Write Failure
The Status Information for a MicroNet interface, subnet, or device displays Failure
for either Output write failure or Input read failure.
This is the result of one or more failed attempts by Building Operation to read from
or write to a subnet or device on the MicroNet interface.

168.4.1

Solution
Ensure that the Network status property of the MicroNet interface, subnet, or
device displays Online. When Online, select OK to reset.
For more information, see section 168.5 “Status Information displays Offline” on
page 5707.

Note
• Resetting the read or write failure to OK simply provides a means of
confirming future communications failures, and will not on its own fix a
communications fault.
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168.5 Status Information displays Offline

168.5

Status Information displays Offline
The Status Information for a MicroNet interface, subnet, or device displays Offline.

This can occur because the MicroNet interface communications settings are
incorrect, or the MicroNet network is physically disconnected from the Building
Operation server.

168.5.1

Solution
Ensure that the MicroNet interface communications settings are correct.
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168.6 Object Error Count not Zero

168.6

Object Error Count not Zero
A Comms Error property of an object or point is not zero, due to one or more read
or write errors.

168.6.1

Solution
Ensure that the network, subnet and devices are all on line and that there are no
read or write errors, then reset the count.
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169 MicroNet Deep Technical Reference
169.1 VisiSat Point Upper and Lower Limits

169.1

VisiSat Point Upper and Lower Limits
When setting up a points list in VisiSat, you can change the upper and lower limits
of each point. The following VisiSat point properties dialog box is an example of
where you can change the limits:

Figure: VisiSat point upper and lower limits

Generally, there is no need to change the limits. However, if you do change the
limits to a non-supported pair and then generate and import your MicroNet .xml file
into Building Operation, an error message is displayed in the Data Import dialog
box. The following data import message contains an example of a non-supported
limit pair:
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169.1 VisiSat Point Upper and Lower Limits

Figure: Point limits error during data import

To resolve these limit issues, if you change a point's limit value pair in VisiSat, only
use limit value pairs that are within the point's original limits and that relate to the
following valid limit pairs:
• n10000p10000
• n10000p10000niu
• n10000p10000r
• n1000p1000
• n1000p1000niu
• n1000p1000r
• n100p100
• n100p100r
• n12p12
• n273p327_67
• n273p327_67r
• n3p3
• n3p3r
• n40p1000
• n40p10000
• n40p120
• n40p150
• n40p150niu
• n40p302
• n40p40
• n40p40r
• n40p55
• n5p50
Technical
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• p0_4p10
• p0_4p10r
• p0_4p4
• p0_4p4r
• p0_5p3
• p0_5p3r
• p0_5p3_5
• p0_5p3_5r
• p10p24
• p10p24r
• p10p35
• p15p30
• p15p30r
• p1p1000
• p1p10000
• p1p12
• p1p127
• p1p150
• p1p2
• p1p254
• p1p255
• p1p31
• p1p53
• p1p600
• p1p99
• p1p999
• p21p35
• p21p35r
• p250p9750
• p5p50
• zp1
• zp10
• zp100
• zp1000
• zp10000
• zp10000niu
• zp10000r
• zp1000r
• zp100niu
04-16006-04-en, March 2015
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• zp100r
• zp10r
• zp12
• zp15
• zp15r
• zp1r
• zp23
• zp2359
• zp249
• zp2490
• zp255
• zp3
• zp30
• zp31
• zp32767
• zp3600
• zp4
• zp40
• zp40r
• zp49
• zp499
• zp4r
• zp50
• zp500
• zp5000
• zp59
• zp60
• zp600
• zp65535
• zp99
• zp999
• zp999r
Where:
‘n’ = negative
‘p’ = positive
‘z’ = zero
‘r’ = ‘real’ value, i.e. stored as 8 bit ‘double’
‘niu’ – ‘not in use’ is valid, usually as a value if -1 or 255
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Examples:
n40p150 - integer-based range from -40 to +150.
n40p150niu - integer-based range from -40 to +150, additionally allowing NIU
(255)
zp255 – integer-based range from zero to 255
p0_4p10r – double-based range from 0.4 to 10.0

Note
When you change the limits of a point in VisiSat, it is still possible to change the
value of the point in WorkStation beyond these limits after a data import.
However, any changes in value in WorkStation (beyond the limits you set in
VisiSat) are not sent to the MicroNet controller.
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170 Sigma Troubleshooting
170.1 Data Import Dialog Box Displays 'Failed to connect to server' Message

170.1

Data Import Dialog Box Displays 'Failed
to connect to server' Message
During a data import, the 'Failed to connect to server' message is displayed.

170.1.1

Solution
Ensure that the Sigma Interface Import host property contains the correct
address or name of the Sigma server.
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170 Sigma Troubleshooting
170.2 Data Import Dialog Box Displays 'Failed to create trace file' Message

170.2

Data Import Dialog Box Displays 'Failed
to create trace file' Message
During a data import, the 'Failed to create trace file' message is displayed.

170.2.1

Solution
Ensure that the Data Import dialog box is not already open.
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170 Sigma Troubleshooting
170.3 Data Import Dialog Box Displays Conversion Warning Message

170.3

Data Import Dialog Box Displays
Conversion Warning Message
During a data import, one or more 'Conversion Warnings:' messages are displayed.

170.3.1

Solution
Either accept the warning and continue to import, or cancel the import process and
modify Sigma parameters to ensure that the Data Import dialog box does not
display import warnings. For more information, see section 171.1 “Data Importer
Conversion Warning Messages” on page 5727.
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170 Sigma Troubleshooting
170.4 Data Import Dialog Box Displays Conversion Error Message

170.4

Data Import Dialog Box Displays
Conversion Error Message
During a data import, one or more 'Conversion Error:' messages are displayed.

170.4.1

Solution
Cancel the import process and rectify the error. For more information, see section
171.2 “Data Importer Conversion Error Messages” on page 5731.
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170 Sigma Troubleshooting
170.5 Data Import Dialog Box Displays Conversion Failed Message

170.5

Data Import Dialog Box Displays
Conversion Failed Message
During a data import, one or more 'Conversion failed:' messages are displayed.

170.5.1

Solution
Cancel the import process and make modifications in Sigma, or change import
properties. For more information, see section 171.3 “Data Importer Conversion
Failed Messages” on page 5733.
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171 Sigma Deep Technical Reference
171.1 Data Importer Conversion Warning Messages

171.1

Data Importer Conversion Warning
Messages
The Data Import dialog box may display warning messages informing you of the
findings of the data importer during the import process, and of any actions taken by
the data importer. You can continue with the data import and accept the
consequences, but it is recommended that you cancel the data import and then
make suitable changes in Sigma to rectify the situation before a subsequent data
import.

171.1.1

General Warning Messages
The following table contains possible warning messages and the actions that you
can take to ensure that the warning messages do not display during subsequent
data imports.
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Conversion Warning
Message Example

Cause

Action Required

Modem found. Ignoring
controller: 'Controller name'.
Zone name: 'Zone name'

Building Operation does not
support dial-up (PSTN)
zones.

Re-engineer zones to use IP
addressing.

PSTN not supported in port
config for port 'Port number'

Building Operation does not
support PSTN.

Either ignore or reconfigure
port in Node tab.

Not converting network type
19K2 for 'name'

Serial (PPP) configured for a
controller.

Ignore.

Ignoring BAS node 'BAS
xnn' Device number: n

Building Operation does not
support BAS and ignores
BAS devices.

Upgrade all BAS controllers
to Sigma.

Programmable object is
returning short text in
addition to returning a string.
Conversion will be
approximate. 'Object name'a
(Unc, Obj)b

Multiple return statements in
the Programmable object.
See next table for more
details about programmable
objects.

Either accept the warning or
revise the object in Sigma.
See next table for more
details.

Unable to determine units for Space temp object not
optimiser as space temp
configured.
object is not set (Unc, Obj).
Defaulting to short text n

Configure space temp
object.

Unable to determine units for Input object not of the
optimiser due to type of
expected type.
space temp object. Type is:
44 (Unc, Obj). 'Type'.
Defaulting to short text n

Ignore.

Unable to determine units for Incorrect Space temp object
optimizer as space temp
reference.
object data not obtainable
(Unc, Obj). Defaulting to
short text n

Configure space temp object
reference.
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Continued
Conversion Warning
Message Example

Cause

Action Required

Removed invalid character in Control characters not
mnemonic 'Mnemonic'
supported and were
removed.

None.

Converting object title from
'Object name' to 'Object
name 2' to make it unique in
the segment 'Segment
name' Previous entry causes
duplicate.

Identical object or segment
titles in a segment are not
supported; duplicates are
renamed.

Either accept that duplicates
will be renamed, or rename
them in Sigma before import.

Converting segment title
from 'Segment name' to
'Segment name 2' to make it
unique in the segment
'Segment name'

Identical object or segment
titles in a segment are not
supported; duplicates are
renamed.

Either accept that duplicates
will be renamed, or rename
them in Sigma before import.

Ignoring unsupported logset Only Change of Value and
type 'Logset type name'. Log Interval log sets are
Set name 'Log Set name'
supported.

Ignore.

a) Messages are generalized.
b) Unc = Controller number, Obj = Object number.

171.1.2

Programmable Object Warning Messages
A property in Building Operation can either display a string, an enumeration of
strings or a numeric value. In Sigma, the RETURN value for a programmable object
can be any of three types (see Items 1 to 3 in the following table) depending on
which RETURN statement is executed. Each RETURN type provides a different
type of programmable object in Building Operation after a data import.
However, if more than one return statement type exists in a programmable object in
Sigma, the conversion program can only select one of the three types of RETURN
statement, forcing the conversion of only one type of programmable object. A
conversion warning is displayed each time multiple RETURN statements are
encountered, before you can proceed with the data import.
Items 4, 5, 6, and 7 show the type of programmable object that is created in
Building Operation for each possible multiple return statement combination. In item
4, for example, a programmable analog object is always created, and the returned
short text value will be numeric rather than a text string.
The information provided in the message enables you to identify the object. You can
then decide whether to modify the program to resolve the conversion warning.
The following table provides information about programmable object return
statements.
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Item

Return Statement

Conversion

Warning

1

RETURN ''abc''

Programmable string None
object, Value =
string.
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Continued
Item

Return Statement

Conversion

Warning

2

RETURN VIA TEXT
NNN VALUE nnn.nn

Programmable
analog object, Value
= floating point
number.

None

3

RETURN TRUE/
FALSE or

Programmable
enumerated object,
Value = strings from
short text table.

None

RETURN TEXT 61
4

Return statements 1 Programmable
and 2 in combination analog object.

Programmable object
has RETURN VIA in
addition to returning
a string. Conversion
will be approximate.
'Object name'a (Unc,
Obj)b

5

Return statements 1 Programmable
and 3 in combination enumerated object.

Programmable object
is returning short text
in addition to
returning a string.
Conversion will be
approximate. 'Object
name' (Unc, Obj)

6

Return statements 2 Programmable
and 3 in combination analog object.

Programmable object
has RETURN VIA in
addition to returning
other short text.
Conversion will be
approximate. 'Object
name' (Unc, Obj)

7

Return statements 1, Programmable
2 and 3 in
analog object.
combination

Programmable object
is returning short text
in addition to
returning a string.
Conversion will be
approximate. 'Object
name' (Unc, Obj)

a) messages are generalized.
b) Unc = Controller number, Obj = Object number.

Impact on Graphics
When a graphic displays the primary short text value of a programmable object,
only one kind of return statement has an impact on what is displayed. For the
combination of return statements shown in item 4 of the above table, for example,
the graphic only displays a numeric value because the programmable object is an
analog type. The return statement that has a string value (e.g. RETURN 'abc')
therefore never affects the graphic.
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Similarly, the combination of return statements shown in item 5 never causes the
display of the string value in a graphic; only enumerated short text strings are shown
because the short text RETURN statement (e.g. RETURN TEXT 61) is always
selected for this combination.

Impact on Text Reports
When you create a text report, the following occurs:
• Item 4: if a short text number is returned, the RETURN VIA result is displayed,
otherwise, the string value is displayed.
• Item 5: if a short text number is returned, the RETURN TEXT result is displayed,
otherwise, the string value is displayed.
• Item 6: the numeric value is always shown. If the RETURN TEXT statement is
executed, the resulting display shows 100 or 0 depending on the current
status of the object. This is determined by the optional true/false parameter. If
true/false is omitted, the parameter defaults to false, which has a value of 0.
• Item 7: This is a combination of the previous items. Only the numeric value is
displayed (unless there is no short text, in which case the string value is
shown).

Manual Override
If the programmable object is manually set to on or off, Sigma displays the short
texts 460 or 461 (which have default text values of 'on' or 'off'). In Building
Operation, this only works well for the enumerated programmable object type,
where the text 'on' or 'off' will be displayed correctly.
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171.2

Data Importer Conversion Error
Messages
The Data Import dialog box may display error messages resulting from the findings
of the data importer during the import process. You can continue with the data
import and accept the consequences, but it is recommended that you cancel the
data import and make suitable changes in Sigma to rectify the situation before a
subsequent data import.
The following table contains possible error messages and the actions that you can
take to ensure that the error messages do not display during subsequent data
imports.
Conversion Error
Message

Cause

Unable to find equivalent for Data importer cannot find a
unit 'unit' in
mapping for a Sigma short
C:\Sigma\Data\XmlExport\un text value.
its.txt. Property name
'Property'. Objecta (Unc,
Obj)b. Short text number: n.

Action Required
Ensure that the file
C:\Sigma\Data\XmlExport\un
its.txt contains a mapping for
the short text value, using
one or both of the following
solutions:
• Add a new short text
mapping to the units.txt
file.
• Modify (in Sigma) all
instances of the short
text (identified in the
warning message) to
match an existing
mapping. Refer to
instructions contained
in the units.txt file.

Problem finding unit: Not a
valid NSP unit:

Data importer cannot find a
valid Building Operation unit
for a particular short text
mapping.

Index entry to point that does Index entry has no
not exist in point file.
corresponding object in
Shortcut not created. 'Object Sigma.
name' (Unc, Obj)
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Ensure that the mapping for
the short text value in
C:\Sigma\Data\XmlExport\un
its.txt contains a valid unit
that Building Operation can
use. Refer to instructions
contained in the units.txt file.
Resolve with SigmaX.

Object has no slot
configured. Ignoring
Mnemonic (Obj - 'Object
name')

Slot in the (x96) controller not Assign the slot in the Sigma
configured.
x96 controller.

Optimiser has linear and
logarithmic settings.
Conversion will not be
correct. 'Object name' (Unc,
Obj)

Linear and Logarithmic
operation not supported for
the same object.

Reconfigure optimiser as
either linear or logarithmic,
not both.
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Continued
Conversion Error
Message

Cause

Action Required

Backup terminal can't be
zero for 'Device name'.
Device number 'Device
number'

The Backup Server is not
configured for the specified
controller.

Configure the Backup Server
number in Sigma System
Setup.

Object type mismatch
Object database corruption.
problem between index.rec
and pntfle.rec 'Type' should
be equal to 'Type' for 'Object
name' (Unc, Obj)

Resolve with SigmaX.

Checking control object
stage, failed to find object
(Unc, Obj)

Object database corruption.

Resolve with SigmaX.

Reference object item for
missing object/controller
(Unc, Obj) in logset 'logset
name'

Object not found in the
index, possibly deleted.

Recreate object or configure
the log set.

Ignoring logset item for
missing object/controller
(Unc, Obj) in logset 'logset
name'

Object not found in the
index, possibly deleted.

Recreate object or configure
the log set.

a) Messages are generalized
b) Unc = Controller number, Obj = Object number.
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171.3

Data Importer Conversion Failed
Messages
During a data import, the Data Import dialog box may display a message informing
you about a conversion failure. We recommend that you rectify the situation in
Sigma before a subsequent data import.
The following table contains possible conversion failure messages and the actions
that you can take to ensure that conversion failure messages do not occur during
subsequent data imports.
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Conversion Failed
Message

Description

Action Required

Conversion failed:
Converted graphic
exceeded maximum size

Sigma graphic conversion
has created a graphic that is
larger than the size specified
in the Graphics folder
properties.

Increase the size limit
specified in the Graphics
folder properties, or reduce
the size of the Sigma
graphic.
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171.4

Graphics Error Messages in the Trace
File
The graphics trace file might contain error messages relating to graphics errors
during a graphics data import. In each case, the trace file identifies a specific
graphic that you can examine to help determine the cause of the graphics error
message.
The path of the graphics trace file is C:\ProgramData\Schneider Electric
StruxureWare\Building Operation 1.5\DataImport\Trace.DataImport.Graphics.txt.
The following table contains possible error messages and the actions that you can
take to ensure that the error messages do not display during subsequent data
imports.
Example

Cause

Action Required

Object or controller not found The configuration data for the Either:
(Unc, Obj) (For 'Shape')
controller has not been found
• Modify the specified
within the sigma database.
graphic to use an
The bind is still effective.
existing object
or
• Create the object in
Sigma.
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Potentially conflicting
commands acting on object
visibility. (For 'Shape')

Multiple incompatible
commands configured on a
shape.

Simplify the commands for
the shape.

Bitmap not found:
Folder\Bitmap filename (For
'Shape')

Bitmap file for the shape
does not exist in Sigma.

Ensure that bitmap file exists
in Sigma.

Control characters removed
from string. (For 'Shape')

Control characters not
Verify that the text is
supported and were
acceptable with characters
removed from the shape text removed.
strings

Unknown font (For 'Shape')
Invalid font structure.

Invalid font structure.

Verify that font used is
acceptable.

Failed to convert command
(Command name): Problem
description (For 'Shape')

Command Type
property/Object type
combination not supported.

Reconfigure the command
with a supported type.

Failed to convert command
(piecewise): No scheme
defined. Ignoring (For
'Shape')

Piecewise command has
been added to a nonscheme shape.

Ensure that the shape with
the Piecewise command is
part of a scheme.

Ignoring unsupported state
test in FeedBack -1 (For
'Shape')

Either 'alarm state' or 'reason Reconfigure Feedback
for state' is not found in state command or relevant object.
list.

Color command not
supported on a shape with
no color.

Shape that the command is
on is transparent.

Ignore.
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Continued
Example

Cause

Action Required

Ignoring chain to self.

Chain command refers to
itself.

Ignore.

Alarm State 'Alarm State
name' not supported
(Feedback and Condition
commands)

The specified Alarm State is
not supported.

Reconfigure
Feedback/Condition
command.

RFS state 'Reason'
not supported
(Feedback and
Condition
commands)

The specified Reason Reconfigure
for State is not
Feedback/Condition
supported.
command.

Brush style 'Style name' not
supported

Sigma line style not
supported.

Reconfigure shape with a
supported line style.

Removing text command
from non text shape. (For
'Shape')

Text command does not
work on shapes.

None.

Removing angle command
on invalid variable. (For
'Shape')

Invalid variable for the
command.

None.

Removing animate
command on invalid shape.

Invalid shape for the
command. Animate
command only works on
rectangles and ellipses.

None.

Removing bar command on
invalid shape

Invalid shape for the
None.
command. Bar command
only works on rectangles and
ellipses.

Removing bitmap command
on invalid shape.

Invalid shape for the
command. Bitmap
command only works on
rectangles, ellipses and
schemes.

None.

Removing color command
on invalid shape.

Invalid shape for the
command. Color command
only works on rectangles,
ellipses and polygons.

None.

Removing path command on Invalid shape for the
invalid shape.
command. Path command
only works on lines and
schemes.
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None.

Removing picture command
on invalid shape.

Invalid shape for the
None.
command. Picture command
only works on rectangles,
ellipses and schemes.

Removing text command
from non text shape.

Text command does not
work on shapes.

None.
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Example

Cause

Action Required

Removing spin command
from non text shape.

Spin command is not
appropriate on schemes.

None.
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172.1 Backup and Restore Alarms

172.1

Backup and Restore Alarms
The following table lists the default backup and restore alarm messages.
Table: Backup and Restore Alarms
Message

Cause

Server not restarted. Backup in
progress.

This message displays if you initiate a software-based
request (warm start, cold start, or factory reset) while
a backup is in progress.

Server not restarted. Restore in
progress.

This message displays if you initiate a software-based
request (warm start, cold start, or factory reset) while
a restore is in progress.

Failure retrieving backup set from
remote server.

This message displays if the Enterprise Server cannot
fetch a backup set from the Automation Server.

Failure restoring server database.

This message displays when the backup set is
incompatible (wrong software version), corrupted, or
invalid.

Failure backing up server database. This message displays if you try to initiate a backup
while a backup is in progress.
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172.2 Copying a Backup Set from One Enterprise Server to Another

172.2

Copying a Backup Set from One
Enterprise Server to Another
You can manually copy a backup set from one Enterprise Server to another and
then restore the server with this backup set. This procedure is particularly helpful
when you need to replace an Enterprise Server with a new unit. Copying an
Enterprise Server backup set is a four-step process.
Table: Copying a Backup Set from one Enterprise Server to Another Overview
Step

Procedure

Saving the backup set to a file
location

Save a valid Enterprise Server backup set to a file
location on your WorkStation PC.
For more information, see the Copying an Enterprise
Server Backup Set to WorkStation topic on
WebHelp.

Locating the local backup directory

Locate the backup set on the source Enterprise
Server.
For more information, see the Locating the Local
Backup Path on the Enterprise Server topic on
WebHelp.

Copying the backup set to the
targeted server

Copy the backup set to the LocalBackup folder
located within the db_backup folder on the
Enterprise Server.
For more information, see the Copying a Backup
Set to the Enterprise Server Local Directory topic on
WebHelp.

Restoring the server

Use this backup set to restore the Enterprise Server.
For more information, see the Restoring a Server
Manually topic on WebHelp.

Note
Building Operation does not list any backup sets as restore points for the
Enterprise Server if the backup sets are placed in the wrong folder. Be sure to
copy the backup set to the LocalBackup folder.
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173.1 Backup and Restore Issues

173.1

Backup and Restore Issues
Backup of a server is a snapshot of the historical database and/or the configuration
data. If the backup is used to restore a server in a running system, you must be
aware that the difference between the restored backup status and the current
system status may be great.
Consider, for example the following:
• Controller ouput values may have changed.
• Input values almost certainly differ.
• Configuration data may have been changed.
• Trend logs and events data will be missing for the down period.
• Extended trend logs will miss data, not only for the down period, but also for
certain time intervals before and after this period.
• If the server is replaced, the IP address is different.
• Even if the control values have not changed, the controlled equipment may
have changed position.
• The control system requires time to settle.
The consequences of some of these issues can be adjusted, but not all.

Caution
In a multi-server system, the impact of a server restore is difficult to predict until
the restore process completes and the server restarts. Take manual control of
any output points that could potentially damage equipment before restoring the
server. If disconnecting the physical outputs is not possible, restore the server
using a trusted restore file that will turn on/off the outputs predictably and safely.
In this way, you avoid the possibility of incurring any unexpected physical
outcomes or injuries.
Below is a short description on some of these issues.

173.1.1

Controller Output Values
If the restore is made on a server which acts as a controller great care must be
taken when control is resumed. Manual overrides may have to be checked or
removed.

173.1.2

Input Values
Check that no input values have gone offline.

173.1.3

Configuration Data
If configuration data have been modified in other parts of the network, you may
have to recommission or download to the restored server.
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173.1 Backup and Restore Issues

173.1.4

Trend Logs and Events Data
When an Automation Server is restored an event is noted in the log, "Log database
restored". If there are Extended Trend Logs connected on another server, they will
send a request to clear the Trend Logs, and the log will note instead "Log reset by
extended trend log".
For more information, see section 173.2 “Extended Trend Logs and Automation
Server Restore” on page 5745.

173.1.5

Extended Trend Logs
When an Automation Server has one or several trend logs that are connected to
extended trend logs in another server, the restore operation on the Automation
Server will affect the contents of the extended trend log.
For more information, see section 173.2 “Extended Trend Logs and Automation
Server Restore” on page 5745.

173.1.6

IP Address Change
If the server gets its IP address from a DHCP (Dynamic Host Configuration Protocol)
server, it may get a new IP address when it is restored. This may affect other nodes
of the network.
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173.2 Extended Trend Logs and Automation Server Restore

173.2

Extended Trend Logs and Automation
Server Restore
When an Automation Server has one or several trend logs that are connected to
extended trend logs in another server, the restore operation on the Automation
Server will affect the contents of the extended trend log.
There are cases when you need to restore an AS from an earlier backup, but this
may have some side effects.
The records logged since the latest transfer to the extended trend log and up until
the restore are permanently lost.
When an AS has been restored from a backup, it is unaware of the trend log
records that have been transferred to the extended trend log from the time when
the backup was made and up until the time of restore.
All records in a trend log have unique IDs. Thus, record IDs must not be duplicated
in the extended trend log. Should a restored AS start logging and use the last
record ID of the backup, the extended trend log will not write any records until the
connected AS trend log has reached the last record ID transferred to the extended
trend log. This could mean major data loss.
To avoid a situation where logs on the AS uses log record IDs that have already
been transferred to the extended trend log, the AS clears all trend logs connected
to extended trend logs. This is done when the extended trend log notes that
communication has been reestablished. Then the AS starts recording, beginning
from the last record ID that was sent to the extended trend log. The AS log gets a
"Trend database restored" event to make it aware of its restored condition. A
"Trend log reset" event is notedin the ES log.
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Figure: Situation when the Extended Trend Log transfer was made after an Automation
Server backup
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173.2 Extended Trend Logs and Automation Server Restore

Figure: Situation when the Extended Trend Log transfer was made before an Automation
Server backup
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173.3 Diagnosing Backup or Restore Issues

173.3

Diagnosing Backup or Restore Issues
You check the server revision, backup date, and backup content of backup sets to
diagnose backup and restore issues.
For more information, see the Backup Sets topic on WebHelp.

To diagnose backup or restore issues
1. In WorkStation, on the Tools menu, click Control panel.
2. On the Control Panel toolbar, select the server.

3. Click Backup Sets.
Continued on next page
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173.3 Diagnosing Backup or Restore Issues

4. In the List View, double-click one of the following folders:
• Select Local if you are logged onto either an Enterprise Server or
Automation Server and want to view the local backup sets.
• Select AS Archives if you are logged onto an Enterprise Server and
want to view the Automation Server backup sets. If there are several
folders, select a particular Automation Server subfolder.

5. Select the backup set that you want to diagnose.
6. On the File menu, click Properties.
7. In the Basic tab, view the current server backup information.
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Property

Description

Server revision

Displays the software version of the Automation Server or the
Enterprise Server at the time the backup took place.

Backup date

Displays the date and time of the backup set.

Backup content

Select the type of data that you want to back up.

Technical
5751

173 Backup and Restore Troubleshooting
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173.4

Restore Incomplete Due to Network
Connectivity Loss
A restore of an Automation Server is incomplete. As a result, Building Operation
displays a “Restore has failed” error message in the Enterprise Server trace log. The
problem can occur when there is a loss of network connectivity between the
Enterprise Server and the Automation Server. Specifically, a lower tier Automation
Server may not receive the requested backup set from the Enterprise Server.

173.4.1

Solution
Log onto the Enterprise Server in WorkStation and verify that the Automation Server
is online. Then perform the restore operation again. For more information, see
section 173.5 “Checking the Online Status of an Automation Server” on page 5751.
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173.5 Checking the Online Status of an Automation Server

173.5

Checking the Online Status of an
Automation Server
You use this procedure to verify that an Automation Server is online or offline.
For more information, see section 4.2 “Server Status” on page 177.

To check the online status of an Automation Server
1. In WorkStation, in the System Tree pane, expand the Enterprise Server
folder, for example, Server 1.
2. Expand the Servers folder.
3. Verify the Automation Server status:
• The server icon displays if the server is online.
• A red symbol displays in the server icon if the server is offline.

4. View the alarm status.
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173.6 No Restore Files Display After Backup

173.6

No Restore Files Display After Backup
You cannot find any Automation Server backup sets listed in the Restore Options
dialog box. This problem can occur when there is a loss of network connectivity
between an Enterprise Server and Automation Server during a backup.

173.6.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Log onto the Enterprise Server in WorkStation and verify that the Automation
Server backup set is stored in the AS Archives folder. If so, make sure that the
Automation Server is online. For more information, see section 173.5
“Checking the Online Status of an Automation Server” on page 5751.
• Log onto the Enterprise Server in WorkStation and verify that the Automation
Server is online. Then back up the Automation Server to create a new backup
set that will display in the Restore Options dialog box. For more information,
see the Backing Up Servers Manually topic on WebHelp.
• Log onto the Automation Server in WorkStation and import a backup set to
replace the missing or corrupted backup set. Then restore the Automation
Server. For more information, see the Importing a Backup Set to an
Automation Server topic on WebHelp.
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173.7

Renamed Automation Server Makes
Backup Sets Unavailable
You cannot find the backup sets for an Automation Server. This problem can occur
if you delete, recreate, and then rename an Automation Server on the Enterprise
Server. After a rename, Building Operation displays only the backup sets that refer
to the newly renamed server in the Restore Options dialog box. The backup sets
made with the previous name of the Automation Server do not display.
The Restore Options dialog box only displays valid backup sets that are stored in
the AS Archives folder. Therefore, the Automation Server name and subfolder name
must match. For more information, see the Backing Up Servers Manually topic on
WebHelp.

173.7.1

Solution
After renaming the Automation Server, back up the server. You can restore the
server using this backup set. For more information, see the Restoring a Server topic
on WebHelp.Restoring a Server Manually
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173.8 Incorrect Date Stamp on Backup Set

173.8

Incorrect Date Stamp on Backup Set
A backup set has an incorrect date stamp. This problem occurs when you do not
set the date and time on an Automation Server to the current time.

173.8.1

Solution
In the Date and Time tab of the Automation Server, enter the correct date and time
manually or synchronize these settings using a network time server. In addition, be
sure to set the correct time zone. When finished, you can back up the server. For
more information, see the Manually Changing the Automation Server Time and Date
topic on WebHelp.
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173.9 Power Failure Occurs During Backup

173.9

Power Failure Occurs During Backup
The power fails while a server is backing up and the system displays a “Failed
backup” message in the Event view.

173.9.1

Solution
Initiate a new backup when the power resumes and the server goes back online.
For more information, see the Backing Up Servers Manually topic on
WebHelp.Backing Up a Server Manually
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173.10 Automation Server Remains Offline After Restore

173.10

Automation Server Remains Offline
After Restore
An Automation Server remains offline after the Enterprise Server is restored and a
"Server offline" alarm displays in the Alarms pane. This problem can occur if the
Automation Server is disconnected from the network, or deleted from the Enterprise
Server after the backup occurs but prior to the restore.

173.10.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is solved.
• Enter a Ping command from a Command Window prompt on the PC where
the Enterprise Server is installed to verify that the Automation Server is
physically connected and responsive. If the server is disconnected (unplugged)
from the network, restore the connection and ping again to see if the network
connectivity resumes.
• In WorkStation, log onto the Enterprise Server and verify that the Automation
Server is absent from the Servers folder. Recreate the Automation Server using
the same server name to restore the connections. For more information, see
section 3.7 “Creating an Automation Server” on page 146.
• In WorkStation, log onto the Enterprise Server and verify that the Automation
Server is present in the Servers folder in the System tree. Delete the
Automation Server server from the Servers folder. Using the same server
name, manually recreate the Automation Server to restore the connections.
• Run the Repair server communication command from the Advanced
Actions menu to restore the connections between the Enterprise Server and
the Automation Server. For more information, see section 4.3 “Repairing Server
Communication ” on page 178.
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173.11 Similar Restore Points Display in Restore Options Dialog

173.11

Similar Restore Points Display in
Restore Options Dialog
When you log on to an Enterprise Server in WorkStation, similarly named backup
sets may display in the Restore Options dialog box. This problem occurs if you
create a backup set for an Automation Server with the same name as an existing
Automation Server backup set. As a safeguard, the system automatically appends
a date stamp to distinguish one identically named backup set from another. For
more information, see the Manual Backups topic on WebHelp.
If you try to import a backup set to a server with the same name as an existing
backup set, a warning message displays. If you click Yes, the imported backup set
overwrites the other.

Figure: Restore Options dialog box

Tip
To view the different time stamps for each similarly named file, you expand the
Name column in the Restore Options dialog box. For more information, see the
Restore Options Dialog Box topic on WebHelp.

173.11.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is solved.
• Delete any similarly named backup sets that are stored on the Enterprise
Server. For more information, see the Deleting a Backup Set from the
Enterprise Server topic on WebHelp.
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173.11 Similar Restore Points Display in Restore Options Dialog

• Rename any similarly named backup sets that are stored on the Enterprise
Server. For more information, see the Locating the Local Backup Path on the
Enterprise Server topic on WebHelp.
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173.12

Duplicate Backup Set Names in Multiserver Systems
Duplicate backup set names can occur if you log on directly to an Automation
Server in WorkStation to create a backup. The system cannot check for identical
backup names because only one backup set is stored locally at any given time on
an Automation Server. As the Enterprise Server fetches (copies and stores) the
latest Automation Server backup file and an identically named file is discovered, the
system automatically appends an extended date (year, month, and day) and
military-based time stamp to differentiate the backup set names to avoid accidental
overwriting.

173.12.1

Solution
Before restoring an Automation Server, view the extended date and time of a
similarly named backup set to ensure the right backup set is selected.

To check for duplicate backup set names
1. In WorkStation, log on to the Enterprise Server.
2. In the System Tree pane, expand the Servers folder.
3. Right click on an Automation Server and click Restore.
4. Expand the Name column to view the extended date and time.
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173.13 Backup Set Text is Red

173.13

Backup Set Text is Red
The backup set is displayed in red in the Restore Options Dialog box.

173.13.1

Solution
The Backup sets are color coded:
• Black text indicates that the backup set is compatible with the current version
of the server. The system highlights the selection in blue.
• Red text indicates that the backup set is incompatible with the current version
of the server. The system highlights the selection in red.
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173.14 Automation Server Duplication Failed

173.14

Automation Server Duplication Failed
When you attempt to create an Automation Server from a backup set, the error
message, “Transfer of backup set to new server has failed.", "Failed to send
configuration generation command to the new server.", "Failed to add new server
from backup set.", or “New server is online but configuration generation failed." is
displayed.

173.14.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• If the Automation Server has been restored with the duplicated backup set
configuration but not added to the Enterprise Server, add the Automation
Server to the multi-server configuration. You cannot add a new Automation
Server in a multi-server configuration, using a locally stored backup set, if the
locally stored backup set and the Automation Server do not have the same
password.
For more information, see section 3.7 “Creating an Automation Server” on
page 146.
• If the backup set contains a BACnet solution, export the BACnet solution
before you create the backup set for duplication. You then create a new
backup set, create a new Automation Server from the backup set, and import
the BACnet solution in the new Automation Server.
For more information, see section 18.8 “Import and Export of BACnet
Solutions” on page 567.
For more information, see the Backing Up Servers Manually topic on WebHelp.
For more information, see section 3.8 “Creating an Automation Server from a
Backup Set” on page 148.
• Ensure that you use a backup set with the correct version and server type.
For more information, see section 3.8 “Creating an Automation Server from a
Backup Set” on page 148.
• The Automation Server is online with the old configuration. Repeat the
procedure.
For more information, see section 3.8 “Creating an Automation Server from a
Backup Set” on page 148.
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173.15 Timeout Reached While Waiting for New Server to Come Online

173.15

Timeout Reached While Waiting for
New Server to Come Online
When you attempt to create an Automation Server from a backup set, the error
message, “Timeout reached while waiting for new server to come online." is
displayed. Probable cause can be a too slow network connection to the
Automation Server. However, it is possible that the server duplication operation
succeeded.

173.15.1

Solution
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check the text in Note2 in Server Object Properties. If the note states
"Database Cloned 20xx-xx-xx xx:xx:xx;" with a correct timestamp, the
duplication has been successful. You then manually add the Automation
Server to the Enterprise Server.
For more information, see section 3.7 “Creating an Automation Server” on
page 146.
• Contact Product Support Services if the Automation Server does not respond.
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173.16 Wrong User ID or Password

173.16

Wrong User ID or Password
When you attempt to create an Automation Server from a backup set, the error
message, “Wrong user id or password." is displayed. Probable cause can be that
you have used a backup set with a different password than for the new server to be
added. However, it is possible that the server duplication operation succeeded.

173.16.1

Solution
Check the text in Note2 in Server Object Properties. If the note states "Database
Cloned 20xx-xx-xx xx:xx:xx;" with a correct timestamp, the duplication has been
successful. You then manually add the Automation Server to the Enterprise Server.
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173.17 Disk Space Problem after Automation Server Upgrade

173.17

Disk Space Problem after Automation
Server Upgrade
After some time using Device Administrator to upgrade Automation Servers, the
local disk is full. Too many Automation Server backup sets may be the reason the
disk is full. When you upgrade an Automation Server with Device Administrator, the
backup set is stored on the local disk.

173.17.1

Solution
Delete all but the latest generated backup set in the folder
'C:\ProgramData\Schneider Electric StruxureWare\Building Operation 1.x\Device
Administrator\Backups\TDnnnnn' for each Automation Server.

Important
Ensure that Device Administrator not is running any operations.

Note
Ensure to keep all backup sets necessary for Product Support Services
reference.
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174 Archive Troubleshooting
174.1 Archive Directory Does Not Exist

174.1

Archive Directory Does Not Exist
When you attempt to create an archive to a location that has not been created, has
been deleted, or was moved, the "Archive directory does not exist!" message is
displayed.

174.1.1

Solution
Ensure that the path to the archive folder is valid.
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175 Hardware Troubleshooting
175.1 General Hardware Configuration Problem

175.1

General Hardware Configuration
Problem
The Automation Server or its I/O modules respond erratically or not at all.

175.1.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that all the devices are connected in the correct order:
Position 1: Power supply
Position 2: Automation Server
Positions 3 to 32: I/O modules and additional power supplies
For more information, see the DIN mounting topic on WebHelp.
• Ensure that there is only one Automation Server on the I/O bus, and that it is in
position 2.
• Ensure that the total power consumption for each power supply is not
exceeded.
For more information, see the Power Budget topic on WebHelp.
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175.2 No Communication with Automation Server

175.2

No Communication with Automation
Server
The Automation Server does not respond to any type of communication.

175.2.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the Automation Server has completed any firmware updates,
because no communication is possible before the update finishes.
For more information, see the Uploading and Upgrading an Automation Server
topic on WebHelp.
For more information, see the Downloading an Upgraded Database to
Automation Server topic on WebHelp.
• Ensure that the Automation Server has a correct IP address and host name.
For more information, see section 3.17 “Identifying the Automation Server IP
Address” on page 159.
• Find out if the Automation Server IP address has been modified. If the IP
address has been assigned with the DHCP function, this address may have
been changed by the DHCP server. To avoid this problem, use the fully
qualified domain name instead of the dynamic IP address to connect to the
Automation Server.
For more information, see section 3.17 “Identifying the Automation Server IP
Address” on page 159.
• Ensure that the Automation Server has been correctly installed onto a terminal
base TB-AS-W1, in position 2 on the I/O bus. Other terminal base types will not
work.
For more information, see the Installing an Electronics Module on a Terminal
Base topic on WebHelp.
• Ensure that no pins in the electronics module have been bent when connected
to the Terminal Base.
Particularly, check the pins connecting to the backplane of the Terminal Base.
Check the two different positions (left and right) of the female 6x2 connector on
the backplane to distinguish the Terminal Base for the power supply from the
other devices.
For more information, see the Backplane Board topic on WebHelp.
• Restore the Automation Server firmware, if you suspect that it has been
damaged.
For more information, see section 3.21 “Restoring the Software of a Damaged
Automation Server” on page 164.
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175.3

No Communication with I/O Module
One or more I/O modules do not respond to any type of communication.

175.3.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the I/O module has been correctly installed onto a Terminal Base of
the correct type, in position 3 or higher on the I/O bus. Other Terminal Base
types will not work.
For more information, see the Installing an Electronics Module on a Terminal
Base topic on WebHelp.
• Ensure that the I/O module has been assigned a Module number 3-32 that
corresponds to its position 3-32 on the I/O bus. When a new module is created
it is automatically assigned the Module no. 0 which is an invalid number, and
so you must assign a valid number to the module.
For more information, see section 22.5 “I/O Modules in the Work Area” on
page 724.
• Ensure that no pins in the I/O module have been bent when connected to the
Terminal Base.
Particularly, check the pins connecting to the backplane of the Terminal Base.
Note also the two different positions (left and right) of the female 6x2 connector
on the backplane to distinguish the Terminal Base for the power supply from
the other devices.
For more information, see the Backplane Power and Addressing topic on
WebHelp.
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175.4

Incorrect I/O Values
One or more I/O values are incorrect.

175.4.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Ensure that the HAND/AUTO/OFF override switches are set to the intended
position for the outputs.
For more information, see the Override Switches and Potentiometers topic on
WebHelp.
• Ensure that the potentiometers for analog outputs that use the HAND switch
position are set to the intended values.
For more information, see the Override Switches and Potentiometers topic on
WebHelp.
• Ensure that the input types are correctly set. This is particularily important for
the thermistor input types.
For more information, see the New Input Point Configuration Wizard – Basic
Settings Page topic on WebHelp.
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175.5

Power Supply Overload
The PS-24V status LED indicates a power overload by turning red, and the power
supply shuts down.

175.5.1

Solutions
The solutions are listed in order: the solution most likely to fix the problem is listed
first. Work through each solution until the problem is resolved.
• Check if you have exceeded the total I/O Bus addressing power limits. For
more information, see the Power Budget topic on WebHelp.
• If the power limit has been exceeded, insert another power supply in a suitable
position among the devices to reduce the power load on the original power
supply. See the illustration below.
• If you have NOT exceeded the power limits, inspect for failed I/O modules. A
failed module could be drawing too much current and sending the power
supply into overcurrent protection mode.
• Remove/replace failed or less important I/O modules until power consumption
has decreased to an acceptable level.

Figure: I/O Bus Addressing and Power Limits
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